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Chapter 1: Getting Started With PowerWorld 

  

This chapter provides the essential information you need to start using PowerWorld Simulator.  

The following material is included: 
• About this Manual 
• Introduction to PowerWorld Simulator 
• Introduction to Simulator Add-on Tools 
• What’s New in Version 13 
• Getting Help 
• PowerWorld Interface 
• Toolbars 
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About this Manual 

  

PowerWorld Simulator includes comprehensive, context-sensitive on-line help in addition to a 
printed manual. Using the on-line help is strongly recommended, since it provides features not 
available in a printed manual, such as the ability to jump to another topic. Furthermore, the 
on-line help is likely to be the more up-to-date reference as program updates are issued. 
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Introduction to PowerWorld Simulator 

  

PowerWorld® Simulator (Simulator) is a power system simulation package designed from the 
ground up to be user-friendly and highly interactive. Simulator has the power for serious 
engineering analysis, but it is also so interactive and graphical that it can be used to explain 
power system operations to non-technical audiences. With Version 13 we’ve made Simulator 
more powerful, more visual, and easier to use.  

Simulator consists of a number of integrated products. At its core is a comprehensive, robust 
Power Flow Solution engine capable of efficiently solving systems of up to 100,000 buses. This 
makes Simulator quite useful as a stand-alone power flow analysis package. Unlike other 
commercially available power flow packages, however, Simulator allows the user to visualize 
the system through the use of full-color animated oneline diagrams complete with zooming 
and panning capability. System models can be either modified on the fly or built from scratch 
using Simulator’s full-featured graphical case editor. Transmission lines can be switched in (or 
out) of service, new transmission or generation can be added, and new transactions can be 
established, all with a few mouse clicks. Simulator’s extensive use of graphics and animation 
greatly increases the user’s understanding of system characteristics, problems, and 
constraints, as well as of how to remedy them. 

The base package of Simulator is capable of solving power systems comprised of up to 
100,000 buses. The base package also contains all the tools necessary to perform integrated 
economic dispatch, area transaction economic analysis, power transfer distribution factor 
(PTDF) computation, short circuit analysis, and contingency analysis. All of the above features 
and tools are easily accessible through a consistent and colorful visual interface. These 
features are so well integrated that you will be up and running within minutes of installation. 

In addition to the features of the base Simulator package, various add-on tools are available. 
Please see Introduction to Simulator Add-On Tools for more information. 
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Introduction to Simulator Add-On Tools 

  

In addition to the features of the base Simulator package, various add-on tools are available. 
A brief introduction to each follows:  

Voltage Adequacy and Stability Tool (PVQV) 

The purpose of the PVQV add-on is to allow the user to analyze the voltage stability 
characteristics of a system. After the PVQV simulation is complete, the user can graph various 
system parameters. For more information, see the PVQV Overview. 

Optimal Power Flow Tool (OPF) 

The purpose of an OPF is to minimize an objective (or cost) function . In Simulator OPF the 
Linear Programming OPF algorithm (LP OPF) determines the optimal solution by iterating 
between solving a standard power flow and solving a linear program to change the system 
controls thereby removing any limit violations. For more information see the OPF Overview. 

Security Constrained Optimal Power Flow Tool (SCOPF) 
The OPF tool minimizes an objective function (usually total operation cost) by changing 
different system controls while meeting power balance constraints and enforcing base case 
operating limits. The SCOPF tool takes it one step further by considering contingencies that 
may arise during system operation and ensuring that in addition to minimizing the objective 
function, no unmanageable contingency violations occur. For more information see the SCOPF 
Overview. 

Available Transfer Capability Analysis Tool (ATC) 
ATC analysis determines the maximum MW transfer possible between two parts of a power 
system without violating any limits. For more information see the ATC Analysis Overview. 

Transient Stability (TS) 
Transient Stability analysis allows the analysis of system dynamic response to a fault on the 
system. The Transient Stability module has not yet been released with version 13. 

PowerWorld Simulator Automation Server (SimAuto) 

SimAuto provides PowerWorld customers the ability to access PowerWorld Simulator 
functionality within a program written externally by the user. The Simulator Automation Server 
acts as a COM object, which can be accessed from various programming languages that have 
COM compatibility. Examples of programming tools with COM compatibility are Borland® 
Delphi, Microsoft® Visual C++, Microsoft® Visual Basic, and Matlab® (among others). For 
more information on SimAuto, see the SimAuto Overview. 
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What's New 

Web links to previous version information: Version 12 Version 11  Version 10  Version 9 
 Version 8  Version 7  Version 6 
  

Simulator Version 13 contains a number of major new features and several smaller 
enhancements designed to improve the performance and convenience of the package.  
• User Interface  

o New Model Explorer allows fast navigation through all case information displays 
without needing to open multiple windows. 

o Toolbars and Menus have been replaced with Microsoft's new Ribbon interface to 
group related actions together for fast navigation and selection. 

o Generally all the user interface dialogs now obey the Windows XP and Windows 
Vista Themes (look and feel) settings. 

• Auxiliary Files and Display Auxiliary Files  
o New Export Format Description allows quick creation of auxiliary files with specified 

object types and fields. Each object type may be custom filtered. 
o Modified reading of an AUX file to now allow the creation of a new object if a 

required field is specified, but the required field is blank. Also, added better error 
messaging to the log when an object has blank values for required fields to better 
alert the user of the problem. 

o Added support for several kinds of objects that previously could only be defined 
using SUBDATA sections. 

 ContingencyElement objects represent the <SubData CTGElement> sections 
for all Contingency objects. 

 ViolationCTG objects represent the <SubData LimitViol> sections for all 
Contingency objects. 

 CTGElementBlockElement objects represent the <SubData CTGElement> 
sections for all CTGElementBlock objects. 

 GlobalContingencyActionsElement objects represent the <SubData 
CTGElement> section for the GlobalContingencyActions object. 

 PostPowerFlowActionsElement objects represent the <SubData 
CTGElement> section for the PostPowerFlowActions object 

 InterfaceElement objects represent the <SubData InterfaceElement> 
sections for all Interface objects. 

 PartPoint objects represent the <SubData PartPoint> sections for all 
Injection Group objects. 

 ReactiveCapability objects represent the <SubData ReactiveCapability> 
sections for all Gen objects. 

 MTDCBus, MTDCConverter, MTDCTransmissionLine objects represent their 
respective SubData sections for all MTDCRecord objects. 

o Added support for calling specific sub-types of PartPoints via script commands. 
These include PartPointGen, PartPointInjectionGroup, PartPointLoad, and 
PartPointShunt. These special object types then give you access to a combination of 
all the PartPoint fields and specific device fields simultaneously. 

o Added support for calling specific sub-types of InterfaceElements via script 
commands. These include InterfaceElementBranch, InterfaceElementBranchClose, 
InterfaceElementBranchOpen, InterfaceElementDCLine, InterfaceElementGen, 
InterfaceElementInjectionGroup, InterfaceElementInterface, InterfaceElementLoad, 
and InterfaceElementMSLine. These special object types then give you access to a 
combination of all the InterfaceElement fields and specific device fields 
simultaneously. 

http://www.powerworld.com/features/NewTwelve.asp�
http://www.powerworld.com/features/NewEleven.asp�
http://www.powerworld.com/features/NewTen.asp�
http://www.powerworld.com/features/NewNine.asp�
http://www.powerworld.com/features/NewEight.asp�
http://www.powerworld.com/features/NewSeven.asp�
http://www.powerworld.com/features/NewSix.asp�
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o Added the ability to store the Advanced Sort as part of the DataGrid Auxiliary file 
section. 

• Auxiliary File SCRIPT and SimAuto Changes  
o Changes throughout to support the use of object labels. If you give all your objects 

a unique label then the same auxiliary files can work for multiple cases regardless 
of bus numbering. 

o New and modified script commands  
 DeleteIncludingContents(*) Use this to delete objects of a particular type 

and other objects that these contain. 
 New optional parameter to the SaveData(*) script command to specify sort 

order. 
 CalculateTLRMultipleElement(*) 
 SaveDataWithExtra(*) 
 SaveDataUsingExportFormat(*) 
 ExitProgram 
 ExportOnelineAsShapeFile(*) 
 CalculateRXBGFromLengthConfigCondType(*) 
 DetermineShortestPath() and DeterminePathDistance() 
 New optional parameter "ApplyTransfer" to the ATCDetermineATCFor(*) to 

set system state to the calculated transfer level. 
• Available Transfer Capability (ATC) Enhancements 

o Added better handling of degenerate cases in ATC such as when an injection group 
runs out of injection. 

o Added a new option to iterate on a failed contingency. These options perform 
iteratations of the power flow solution to find the transfer level at which the 
contingency fails. 

• Case Information Displays  
o Most Case Information Displays are viewed through the Model Explorer. 
o The right-click local menu of case information displays has been standardized to be 

consistent across all case information displays. The menu mimics the Case 
Information Toolbar directly. 

o New option to "Send to Open Office" which mimics the "Send to Excel" feature. 
o There is now a new "Is Blank" and "Not is Blank" condition comparison for 

Advanced Filters. 
o Added option to highlight rows if their Selected? field is YES. 
o Added option to show a hint describing the field when you hover over a column 

heading. 
o Display/Column Options  

 Available fields are grouped in folders by category making the navigation of 
the large number of available fields much easier. 

 Special folders are available providing you an easy summary of the key and 
required fields 

 Option to show variable names alongside traditional field names 
 Fields identified by data type (string, integer, floating point) 
 Automatically show hints to better let you know what the fields actually 

show. 
• Connection Analysis Tools (Graph Theory)  

o Added two new tools Determine Path Distances to Buses... and Determine Shortest 
Path Between which help calculate topological distances between parts of the 
network. These tools allow you to define a specific distance measure for each 
branch (X, Z, Length, number of Nodes, or a specified field), and also operating on 
Buses, Substations, Areas, Zone, Super Areas and Injection Groups. 

• Contingency Analysis Enhancements  
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o Added ability to view all contingency definitions in a single combined table case 
information display giving you possibility of using a single DATA section to define 
contingencies, or even using copy/paste to/from a spreadsheet to define your 
contingencies. 

o Added ability to view all contingency violations in a single combined table case 
information display. Also gives ability to define using a DATA section or using 
copy/paste to/from a spreadsheet. 

o Pan to object on oneline when selecting a limit violation in the contingency tool. 
• Data Objects  

o There is now no limit on the number of Custom Expressions defined for each object 
type. 

o Added ability to specify the number of custom floating points, integers, and strings 
that each type of object has using the Custom Field Descriptions. You can also give 
names and column headings to the fields. 

o New supplemental data object type. 
o Improved storage of interfaces to accommodate large numbers of interfaces. 

• Dialogs  
o Most device dialogs now have a Custom Tab which contains access to all custom 

singles, floating points, and integer values, as well as the Memo and Selected? field 
for each object. 

o Added the Branches Tab to the Multi-Section Line Information Dialog to list all the 
individual branches in the multi-section line. 

o On the Equivalencing Dialog, a feature was added to "Merge Shunts" across low 
impedance branches. This was done because we have continued to see strange 
input data with very large bus shunt values at either end of low impedance 
branches. (For example +10,000 MW at the FROM end and -10,000 MW at the TO 
end). The Merge Shunts button helps clean up this data. 

• File Formats  
o PowerWorld Binary File (PWB) version 13  

 Option to perform the case autosave in Run Mode. 
o PowerWorld Auxiliary File (AUX) support  

 User prompt when saving the Limit Monitoring Settings from the Limit 
Monitoring Settings dialog to determine whether to use primary or secondary 
key fields or labels for identifying elements. 

 Extensive support added for writing to auxiliary file using object labels. If you 
define labels for all your important devices such as generator, loads, and 
branches and these labels do not change between models, then you can 
create AUX files that work with different topologies. 

o PTI RAW file support  
 Allow opening a RAW file with options instead of opening with defaults only. 

o GE EPC file support 
 Automatically set the option for sharing of generator vars across groups of 

buses during remote regulation appropriately when reading an EPC file. 
• Geographic Data Views 

o Quickly create graphical representations of buses, generators, loads, switched 
shunts, substations, areas, zones, super areas, transmission lines, and injection 
groups. 

o Latitude and longitude coordinates specified with buses and substations are used to 
place the objects geographically on the display. (The latitude and longitude 
information must be specified in order to use this feature.) 

o Object attributes such as color, size, rotation rate, rotation angle, and visibility can 
easily be formatted based on element field values. 
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o Different element types can be combined on a common display by using a 
previously saved PWD file as a starting template. 

o Geographic borders can be included on the display when inserting new objects. 
• Oneline Diagrams  

o Completed the support for viewing of all objects on the oneline diagram in 3D 
mode. Also enhanced the ability to specify 3D Stacks and Stack Slices. 

o Enhanced GIS Support  
 Identify closest facilities to a selected point. 
 Geographic data view. 

o Can now select by region using an ellipse or a polygon. Also modified so that 
holding the CTRL key forces the Ellipse or Rectangle region selection to be centered 
on the initial click. Also modified so that holding the SHIFT key forces the Ellipse or 
Rectangle region selection to be a Circle or Square. 

o Added new Copy Format and Paste Format feature. 
o Allow field prefixes to be edited for selected objects. 
o Contouring: Dialog only shows object types that occur on the oneline. 
o Rotate through onelines specified in the keyboard shortcuts in a "slideshow". 
o Added more shapes for the display of breakers. 
o Added ability to specify a generator field which appears inside each generator 

symbol. 
o Added new GIS Tool for clicking on a oneline and returning a list of the closest 

facilities to that point 
• Optimal Power Flow Enhancements  

o New Add-on Tool to simulate Ancillary Services Reserve Markets. 
o Generator and Load reserve controls include spinning, regulating, and supplemental 

reserves. 
o Area and Zonal constraints include regulating, contingency and operation reserves 

modeled by demand curves. 
• Power Flow Solution  

o Added better ability to handle areas that span multiple islands when using area 
interchange. 

o Allow specification of metered end for two-terminal and multi-terminal DC line 
records. 

o Under rare circumstances it's possible for a transformer controlling it's FROM bus to 
have a negative voltage to tap sensitivity. It doesn't make sense for the transformer 
to attempt to change its tap in this situation, therefore Simulator will not anymore. 

• PV and QV Curve Enhancements 
o Added new options for exporting results to a text file. 
o For critical scenarios that are critical because an inadequate voltage was found, we 

now report the bus and voltage of the lowest inadequate voltage. 
• Sensitivity Calculations 

o When using a Super Area as a buyer or seller in the ATC, PTDF, TLR, and voltage 
senstivities the area participation factors defined for the super areas are used to 
calculate appropriate sensitivities.  

• Time Step Simulation Enhancements  
o Added support for auxiliary file commands to run, stop and solve single points. 
o Added state reset when resetting the simulation. 
o Added support for schedule subscriptions for interfaces. 
o Time format throughout Simulator is now compatible with the Windows locale 

(regional settings). 
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Help 

  

On-line help is available in PowerWorld Simulator via the Help ribbon group on the Window 
ribbon tab, or by pressing the F1 key on many dialogs and displays. Context-sensitive help is 
available on the oneline diagrams. To obtain object specific help, position the mouse over the 
object in question on the oneline and press the F1 key. 

Sample power flow cases and other information are available at the PowerWorld web site: 
http://www.powerworld.com/ 

Contact technical support at support@powerworld.com for answers to your questions 
regarding any PowerWorld product. Or call us at (217) 384-6330. 

PowerWorld Corporation 
2001 S. First Street 

Suite 203 
Champaign, IL 61820 
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Contact Information 

  

PowerWorld Corporation 

2001 South First Street 

Champaign, IL 61820 

  

Phone: (217) 384-6330 

Fax: (217) 384-6329 

Toll Free: (877) 748-7840 - U.S. and Canada only 

  

General Information: info@powerworld.com 

Technical Support: support@powerworld.com 

Sales: sales@powerworld.com 

  

www.powerworld.com 
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Windows Basics 

  

Simulator 13 runs under all Windows 95 and later operating systems. Since much of the 
interaction between Simulator and the user is accomplished by using the mouse, we have 
designed the interface to obey consistent conventions for mouse usage. In general, the left-
mouse button is used to affect some sort of immediate change or control over a power system 
element, while the right mouse button is used to gain more information about a power system 
element or to view a list of available options. More details on  are provided throughout this 
manual. 
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PowerWorld Simulator: Getting Started 

  

The key to using Simulator is to recognize that it has two distinct modes Edit Mode and Run 
Mode. The Edit Mode is used to construct new simulation cases or to modify existing cases, 
while the Run Mode is used to perform the actual power system simulation. You can easily 
switch between the modes using the Edit Mode and Run Mode buttons in the Mode ribbon 
group. 

If you are new to Simulator and seek a quick means of familiarizing yourself with it, we 
recommend starting with the tutorials; see Creating a New Case or Starting with an Existing 
Case 

Sample cases are provided with the software in the "Sample Cases" directory. If you’re 
interested in learning by doing, you may wish to just open one of the sample cases and try the 
different Simulator features. 
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Edit Mode Introduction 

  

The Edit Mode is used to create a new case or to modify existing cases. To switch to Edit 
Mode, click on the Edit Mode button in the Mode ribbon group on any of the ribbon tabs.  
  

Here is a sampling of things you can do in Edit Mode: 
• Create a new case; see New Case for details.  
• Create a new oneline diagram; see New Oneline for details.  
• Add new components graphically to an existing case; see Draw ribbon tab. 
• Modify the appearance of the oneline objects; see Formatting ribbon group for details. 
• View and modify a case using non-graphical lists displays; see Case Information Displays 

for details. 
• Equivalence a case; see Equivalencing for details. 
• Append a subsystem to an existing case; see Appending a Case for details.  

  
For more details on the Edit Mode please see Edit Mode Overview.  
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Run Mode Introduction 

  

The Run Mode is used to solve a single Power Flow Solution, run one of the available load flow 
tools, or run a time-domain simulation of the power system. To access the Run Mode, click on 
the Run Mode button in the Mode group of the Simulator Ribbon. 

The key menu associated with the Run Mode is the Simulation menu. This menu allows you to 
perform a single Power Flow Solution (however, it is quicker to use the Quick Access toolbar). 
   

Other key components of the Run Mode include: 
• The oneline diagrams, which allow you to view the case graphically. See Oneline Diagram 

Overview for details. 
• The Case Information Displays, which allow you to view the entire power system case 

using list displays. See Case Information Displays for details.  
• Dialogs to change the simulation options and the Power Flow Solution. See Simulation 

Options for details. 
• Scaling to allow easy variation in the load, shunts, and generation at any number of buses. 

See Scaling for details.  
• Contouring, which shows a color contour representing the variation in any power system 

parameter across a system. See Contouringfor details.  
• Transfer distribution factor calculations. See Power Transfer Distribution Factors for 

details. 
• Perform a fault analysis. See Fault Analysis for details. 
• Run Transfer Capability studies. 
• Perform an Optimal Power Flow (OPF) or Security Constrained Optimal Power Flow 

(SCOPF) analysis. 
• Generate PV and QV curves. 
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Script Mode Introduction 

  

The Script Mode is used to access the Script Command window. Simulator scripting allows a 
method of grouping multiple commands for sequential processing by Simulator. From the 
Script Command Execution window, the user can manually enter script commands for 
processing, or load an auxiliary file containing multiple script commands and data modification 
commands. 

Some features in Simulator are available exclusively in either RUN mode or EDIT mode. This 
functionality is preserved in the script language, but with the addition of a submode feature. 
Submodes determine which script commands can be called. Only those commands available to 
the current submode can be executed. You will always be in one of the submodes when 
executing a script. If the Script Command Execution Dialog is opened from Edit Mode, 
Simulator defaults to the EDIT, CASE submode. If the Script Command Execution Dialog is 
opened from Run Mode (or when a script is initially started), Simulator defaults to the RUN, 
POWERFLOW submode. 

To switch submodes, use the EnterMode (mode or submode) script command. The following 
list includes the submodes available to each of the Simulator modes. Click on the links below 
to see the actions available to each mode and/or submode. 

Edit Mode 
• Case Submode 

Run Mode 
• PowerFlow Submode 
• Contingency Submode 
• ATC Submode 
• Fault Submode 
• PV Submode 
• QV Submode 

There are also a number of general script actions that can be executed in any of the 
submodes. See Script General Actions for more details. 
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Message Log 

  

The Message Log displays detailed results of each Power Flow Solution, chronicling the 
solution process iteration by iteration. It also reports messages raised by Simulator in 
performing various operations, such as opening or validating a case. The Message Log can be 
helpful when you run into problems solving a particular simulation case. The Message Log is 
not used with Viewer.  

To display the Message Log, go to the Tools ribbon tab, and click the button Log on the 
Log ribbon group. This button is also available on the Add Ons ribbon tab. 

Right-clicking on the Message Log displays its local menu. To change the font characteristics 
of the log, select Change Font. To suppress or change color of certain messages associated 
with the power flow case select either Suppress Messages or Color Messages and then 
the desired message whose characteristics want to change. You can find certain text by 
clicking on Find, and then entering the text in the dialog displayed. Also, you can highlight all 
the text in the log, or inversely unselect all the highlighted text by clicking on Select All, or 
Unselect All, respectively. To print or copy the contents to the Windows clipboard of a 
highlighted section of the message log, select Print Selection or Copy Selection to 
Clipboard. You can also clear the contents of the log by selecting Clear Window. Lastly, 
you will find some log options available, such as Change Maximum Lines, Disable 
Logging, Disable Time Stamp, and Save Log to File options which allow automatically 
saving the log to a file during load flow analysis. 
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Custom and Memo Display 

  

The Custom tab is now available on many dialogs and displays in Simulator. The purpose of 
the custom tab is to allow the user to add their own custom information and comments to 
data and objects in the load flow case. Simply switch to the Memo or Custom page on a 
display and start typing in the memo box, or add values or text in the custom fields. The 
information added to these memo pages is stored with the objects in the load flow case and 
saved to PWB files. 

The custom fields section allows access to setting and changing the values for custom fields 
that have been defined for the bus. Defining custom fields is detailed in Custom Field 
Descriptions. 

The custom section also contains a Selected? check box. This is a special field that is 
associated with most objects in Simulator. In many of the places where filtering is allowed, 
filtering can be done based on the Selected? field. Additional information about this field can 
be found under the Set Selected Field topic. 

The memo section of the dialog is simply a location to log information about the bus. Any 
information entered in the memo box will be stored with the case when the case is saved to a 
PWB file. 
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Status Bar 

  

The Status Bar is displayed across the bottom of the PowerWorld Simulator window. The left-
most field of the status bar displays the current Simulator mode (Edit or Run). The remaining 
fields vary depending on which mode of operation Simulator is currently in. The status bar 
displays Tool Tips when the cursor is positioned over a toolbar button or menu item. The tool 
tip is also shown next to the cursor after a short time delay. 

Edit Mode 
The Edit Mode status bar displays the Screen Coordinates of the cursor when positioned over a 
oneline diagram. 
  

 
Edit Mode Status Bar 

Run Mode 
The left side of the Run Mode status bar displays simulation status ("Solution Animation 
Stopped" or "Solution Animation Running"), AC or DC depending on solution options and the 
Difference Flows status ("Current Case", "Base Case", or "Difference Case"). 
  

 
Run Mode Status Bar (Left Side) 
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Ribbons User Interface 

  

PowerWorld's user interface consists of a ribbon across the top of the program. Important 
terminology regarding the ribbon is depicted in the images below. 

 
  

Ribbon  The entire strip across the top is called the ribbon 

Ribbon 
Tab 

The ribbon consists of several ribbon tabs which group together features of the 
software that are used together. Their are seven ribbons which have their own 
purposes and own help topics listed as follows. 
• Case Information Ribbon Tab: primarily used to navigate and look through all 

the data in your model. 
• Draw Ribbon Tab: primarily used to draw new oneline diagrams or edit 

existing onelines by adding, moving, formatting, or resizing existing oneline 
objects. Most of the options on the Draw ribbon tab are only available in Edit 
Mode. 

• Onelines Ribbon Tab: primarily used after you have already created a oneline 
diagram. This ribbon provides features for customizing the appearance of 
your oneline diagram. 

• 9Options Ribbon Tab: all of the buttons on this ribbon are also available on 
one of the other ribbons, however this ribbon brings all the options in the 
software into one place.  

• Tools Ribbon Tab: this ribbon provides access to all of the analysis tools that 
are available in the base package of PowerWorld Simulator. You will use this 
ribbon when you are performing power flow analysis, contingency analysis, 
or using the sensitivities tools for instance. 

• Add Ons Ribbon Tab: this ribbon provides access to all the add-on tools 
available for Simulator including the OPF, SCOPF, ATC, and PVQV tools. If 
you have not purchased these tools then the options will be grayed out. 

• Windows Ribbon Tab: this ribbon provides access to customizing the 
Windows in the User Interface. It also has some information reading help 
topics . 

The goal in designing these ribbons was to create several task specific ribbons 
which represent the various ways that the software is used. Our hope is that you 
will not spend a lot of time flipping back and forth between ribbons. If you find 
yourself doing this please contact PowerWorld Corporation to help us make the 
software better for the future. 
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Ribbon 
Group 

Inside a particular ribbon tab, there are around 4 to 7 groupings called ribbon 
groups. The following image shows three ribbon groups (Individual Insert, 
Select, and Formatting) with various buttons and menus available. 

ribbon groups join sets of buttons and menus that are related to one another. 
The large buttons and icons are used to draw attention to the most commonly 
used features of the software. All features are still available through drop-down 
menus in the same manner as was available previously. Our design goal in 
creating and laying out the ribbons was to provide the new user with insight 
about using the software, while at the same time giving the experienced user 
quick access to common features. 

  Large Button 

  Large Button 

Menu 

  Small Button 

With Caption 
  Small Button 

Menu 
  Small Button 

without Caption 
 

  Menu 

Only Caption 

 

  
 

Help 
Button 

 

  

Clicking the help button on the right edge of the ribbon brings up this online help 

  

Quick 
Access 
Toolbar 

The quick access toolbar at the top left of the ribbon (near the Application 
Button) contains small buttons with no caption that are always visible. For more 
information about how to use and customize this see the Quick Access Toolbar 
help. 
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Applicati
on Title 
Bar 

Applicati
on 
Button 

 

Click on this to bring up the Application File Menu shown below. For more 
information about using the Application File Menu see the Application File Menu 
help. 
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Quick Access Toolbar 

  

The Ribbon Quick Access Toolbar provides you with quick access to the most frequently used 
buttons. These buttons are found in the top left portion of the Ribbon just to the right of the 
Application Button. The default buttons that appear in the Quick Access Toolbar are shown in 
the figure below. 

 
The six default buttons are as follows from left to right. 
• Save Case 
• Open Auxiliary File 
• Model Explorer 
• Message Log 
• Single Solution 
• Simulator Options 

The Quick Access Toolbar can also be customized very simply. If you find a button that you 
would like quicker access to, simply right-click on the button and then choose Add to Quick 
Access Toolbar. The small icon version of the button will then immediately appear up in the 
Quick Access Toolbar. This is depicted in the image below. 

 
The Quick Access Toolbar can also be modified to show the Toolbar Below the Ribbon 
providing more space for specifying buttons. 

Also experiment with Showing the Quick Access Toolbar below the Ribbon or Minimizing the 
Ribbon. 

  



Getting Started With PowerWorld 

23 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Add Ons Ribbon Tab 

  
The Add Ons ribbon consists of buttons and menus that access to the various Simulator Add 
On Tools. The ribbon is shown below when configured for the OPF, SCOPF, PVQV, ATC add on 
tools. 

 
 The Tools ribbon is broken into six ribbon groups 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Log Ribbon Group 

Abort  

Terminates the current Power Flow Solution. If the application is performing a timed 
simulation, pressing the abort button will pause the simulation. See PowerWorld 
Simulation Control  for more details. 

Log 

Toggles the display of the message log window. The log window shows what is going 
on with the Power Flow Solution process and may prove useful when you are trying 
to track down a problem with a non-converging model. 

Script 

Opens the Script dialog, which can be used to call script commands or open auxiliary 
files containing script commands and data modifications. Note that the drop-down 
next to the Script button give convenient access to the Quick Auxiliary Files. 

 Optimal Power Flow (OPF) Ribbon Group 

Primal LP  

Click this button to solve the OPF. A more detailed description of what this does is 
found in the topic OPF LP Primal. 

Security Constrained OPF 

Click this button to open the Security Constrained OPF Dialog. 

OPF Options and Results 

Click this button to open the OPF Options and Results Dialog. 

OPF Case Info Menu 

The OPF Case Info Menu provides direct access to several case information displays 
that show default columns related to input and ouptut of the Optimal Power Flow. 
Instead of using this menu, PowerWorld encourages you leave the Model Explorer 
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open and navigate using the Explore Pane on the Model Explorer. All of these options 
are available under the Optimal Power Flow folder on the Model Explorer. 

 
 PV and QV Curve (PVQV) Ribbon Group  

PV Curves  

Click this button to open the PV Curves dialog. 

QV Curves 

Click this button to open the QV Curves dialog. 

Refine Model 

Click this button to open the Refine Model Dialog. 

Transient Stability (TS) Ribbon Group  

Transient Stability 

Click this button to open the Transient Stability Dialog. 

Stability Case Info Menu 

The OPF Case Info Menu provides direct access to several case information displays 
that show default columns related to input and ouptut of the Transient Stability Tool. 
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  Available Transfer Capability Ribbon Group  

Available Transfer Capability 

Click this button to open the Available Transfer Capability Dialog. 
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Case Information Ribbon Tab 

  
The Case Information ribbon consists of buttons and menus that provide access to the 
information about the power system model. The ribbon is shown below 

 
  

 The Case Information ribbon is broken into four ribbon groups 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Case Information Ribbon Group 

Model Explorer  

 Opens the Model Explorer giving access to all the case information displays for 
the model. 

Area/Zone Filters    

Opens the Area/Zone/Owner Filters display which allows filtering of the case 
information displays by Area, Zone, and Owner. 

Menus for Network, Aggregation, and Filters, Expression, Etc 

These three menus all perform the same action as opening the Model Explorer, 
except that they automatically set the Explore Pane of the Model Explorer to show the 
respective case information display. Instead of using these menus, PowerWorld 
encourages you leave the Model Explorer open and navigate using the Explore Pane 
on the Model Explorer. 
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Case Data Ribbon Group 

Simulator Options  

Opens the Simulator Options Dialog. 

Case Description 

Opens the Case Description Dialog. 

Case Summary 

Opens the Case Summary Dialog. 

Custom Case Info 

Opens the Custom Case Information Display 

Power Flow List  

Opens the Power Flow List 

Quick Power Flow List  
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Opens the Quick Power Flow List 

AUX Export Format Desc  

Opens the Auxiliary File Export Format Description Dialog for Power System Objects. 

Views Ribbon Group 

Bus View 

Opens the Bus View Oneline which provides a graphical display which allows you to 
quickly browse information about a bus and everything connect to that bus. 

Substation View 

Opens the Substation View Oneline which provides a graphical display which allows 
you to quickly browse information about a bus and everything connect to that 
substation. 

Open Windows Menu 

The Open Windows Menu provides a convenient method of switching between open 
windows. This includes User Interface Dialogs, Case Information Displays, and 
Oneline diagrams. 
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Draw Ribbon Tab 

  

The Draw ribbon tab is primarily used to draw new oneline diagrams or edit existing onelines 
by adding, moving, formatting, or resizing existing oneline objects. Most of the options on the 
Draw ribbon tab are only available in Edit Mode. The Draw ribbon tab is shown below. 

 
   

The Draw ribbon consists of seven ribbon groups described as follows 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Quick Insert Ribbon Group 

The Quick Insert ribbon group contains buttons for creating a oneline diagram for a 
system model you have already read into Simulator. If you are building out your 
network (or even substation, area, or zone diagram), then using the Insert Palettes 
along with the Auto Insert routines is most efficient. For detailed help see the Quick 
Insert ribbon group. If you would instead like help on inserting a single object on your 
oneline diagram see the see the Individual Insert ribbon group topic. 

Individual Insert Ribbon Group  

The Individual Insert ribbon group contains menus which provide access to buttons for 
inserting individual oneline objects to the oneline diagram. If you are building out your 
network (or even substation, area, or zone diagram), then it is much more efficient to 
use the Quick Insert ribbon group. However, for complete access to all objects including 
those that can not be "quick - inserted", see the help under the Individual Insert ribbon 
group topic. 

Select Ribbon Group  

The Select ribbon group contains options to help select multiple oneline objects 
simultaneously. For more detailed help see the Selection ribbon group topic for more 
detailed help. 

Formatting Ribbon Group 

The Format ribbon group contains options for formatting the selected objects on your 
active oneline. For more detailed help see the Formatting ribbon group topic for more 
detailed help. 

Clipboard Ribbon Group 

The Clipboard ribbon group contains options for copying and pasting oneline display 
objects. For more detailed help see the Clipboard ribbon group topic for more detailed 
help. 
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 Zoom Ribbon Group 

The Zoom ribbon group contains buttons for navigating a oneline diagram. For more 
detailed help see the Zoom ribbon group topic 
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Clipboard Ribbon Group 

  

The Clipboard ribbon group contains options for copying and pasting oneline objects while 
your are in Edit Mode. It also provides access to the Undo drawing feature. This ribbon group 
is on the Draw ribbon tab. The Group is shown below. 

 

 
Undo 

The Undo command is used in the edit mode to undo the last change made on the 
oneline diagram. The Undo command will only undo graphical changes, and will not 
undo any data changes in the power system model. See Relationship Between Display 
Objects and the Power System Model for information on the display/model 
relationships. 

Paste 

The paste command copies the contents of the paste buffer (if any) onto the display 
at the current cursor location. Use the Paste command from the Edit Menu. Note 
that the paste buffer may contain both display objects and the underlying power 
system records. When pasting, the display objects are pasted regardless of whether 
an identical display object already exists on the oneline. In contrast, duplicate power 
system records are never pasted. This is because, for example, it is acceptable to 
have two display objects referring to the same generator, but the generator exists 
only as a single entity in the power system model. See Relationship Between Display 
Objects and the Power System Model for further details. 

Paste Special 

Paste Special works the same as Paste, however it will also show a dialog asking the 
you to choose between  

Absolute Coordinates : objects will be pasted using the exact same x/y coordinate 
as the copied objects had. This is useful when copying objects between two different 
oneline diagrams which contain the same geographic background. 

Coordinates Relative to Cursor : objects will be pasted relative to cursor instead 
of using the exact x/y coordinates as the copied objects. 

Copy 

The Copy Command copies the currently selected object(s) into the paste buffer 
without deleting them. For power system objects, such as buses, generators or 
transmission lines, you are given an option of whether to copy just the display 
object(s), or copy both the display object(s) and their underlying power system 
records. See Relationship Between Display Objects and the Power System Model for 
further explanation of these choices. To copy only the display object(s) and never the 
power system records from now on, select the Always Copy Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog. 
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Cut 

The Cut Command is used in the Edit Mode to delete the currently selected object(s). 
To delete a set of objects, first select the objects. Then select the Cut command from 
the Edit Menu. For power system objects, such as buses, generators or transmission 
lines, you are given an option of whether to delete just the display object(s), or 
delete both the display object(s) and their underlying power system records. See 
Relationship Between Display Objects and the Power System Model for further 
explanation of these choices. To delete only the display object(s) and never the 
power system records from now on, select the Always Delete Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog.  

Unlike Delete, Cut also copies the selection into the paste buffer. 

Delete 

The Delete Command is used in the Edit Mode to delete the currently selected 
object(s). To delete a set of objects, first select the objects. Then select the Delete 
command from the Edit menu. For power system objects, such as buses, generators 
or transmission lines, you are given an option of whether to delete just the display 
object(s), or delete both the display object(s) and their underlying power system 
records. See Relationship Between Display Objects and the Power System Model for 
further explanation of these choices. To delete only the display object(s) and never 
the power system records from now on, select the Always Delete Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog.  

Unlike Cut, Delete does not copy the selection into the paste buffer. 
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Formatting Ribbon Group 

  

The Formatting ribbon group contains options for formatting the selected objects on your 
active oneline. This group is on the Draw ribbon tab and its options are available only in Edit 
mode. The options allow you to control such display object attributes as font, color, line styles, 
zoom-dependent visibility, and display layer level. The group is shown below. 

  

  

A description of the actions on this group are as follows. 

Refresh Anchors 

Invokes a command to refresh anchors on all oneline objects. 

 Format Buttons  

Clicking any of these five buttons will open the Format Dialog. Each of the buttons opens 
the Format dialog to a specific tab on the Format Dialog, but they all ultimately open the 
same dialog. 

Font  

Select this option to change the font with which the selected objects are displayed. 
The Font Tab of the Format Selection Dialog is displayed. 

Line/Fill 

Select this option to change the line thickness and style with which a display object is 
drawn, or the fill color for closed shapes. The Line/Fill Tab of the Format Selection 
Dialog is displayed. 

Levels/Layers 

Select this option to change the stack level of an object, the layer the object is 
contained in, and optional settings for when an object should resize. The 
Levels/Layers Tab of the Format Selection Dialog is displayed. 

Display/Size 

Simulator can change the attributes of the way multiple objects are displayed using 
this option, which opens the Display/Size page of the Format Selection Dialog. The 
size of the objects can be adjusted, as well as the orientation of the object(s) from 
their terminal buses. Objects can also be Anchored to their terminal buses or devices, 
or marked as Immobile, meaning the object(s) cannot be moved on the oneline 
diagram. 

Field 

Select this option to change the attributes related to object text fields which are 
selected. The Field Tab of the Format Selection Dialog is displayed. 

Copy Format and Paste Format Buttons 
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The button on the left is the Copy Format button. After selecting an object this will copy all 
the format properties of that object into an internal buffer. When you then subsequently 
select other objects, you can click on the button on the right which is the Paste Format 
button. Clicking the Paste Format button will bring up the Paste Format Dialog. 

 Send to Back, Bring to Front Buttons 

After selecting a group of oneline objects using any of the methods described on the Select 
ribbon group, you may then click the Send to Back button to cause all the objects selected 
to move to underneath other objects. Click the Bring to Front button to bring objects to 
the top.  

The Send to Back and Bring to Front menu options govern the visibility of display objects 
that occupy the same screen stack level. All objects have an associated screen stack level, 
which may be one of Base, Background, Middle, or Top. Objects having a screen stack level 
of Top obscure all objects having stack levels of Middle, Background, or Base that occupy 
the same region of the screen. They may or may not obscure objects having the same stack 
level of Top depending on the order in which the objects having the same stack level are 
drawn. Selecting Send to Back for a selected object will cause it to be obscured by all other 
same-level objects that occupy its location. Selecting Bring to Front for a selected object will 
cause it to be drawn above all other same-level objects that occupy the same region of the 
screen. The Send to Back and Bring to Front menu options govern relative placement of 
objects only within stack levels. The Send to Back and Bring to Front options do not affect 
the relative placement of objects having different stack levels. 

Alignment Menu 

The alignment menu provides access to the Alignment Dialog and direct access to options to 
align the selected objects as specified in the menu items. 

Grouping Menu 

Grouping is only available for background oneline objects (background lines, ellipses, text, 
etc...). This menu provides button to Group and Un-Group objects. 

Layers Menu  

The Layers Menus provide access for opening the Define Layers Dialog for the presently 
active oneline diagram. 

Underneath the button for defining layers is a list of the presently defined layers. You may 
check or uncheck the various layers to hide or show the objects in those layers. 
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Individual Insert Ribbon Group 

  

The Individual Insert ribbon group contains menus which provide access to buttons for 
inserting individual oneline objects to the oneline diagram. If you are building out your 
network (or even substation, area, or zone diagram), then it is much more efficient to use the 
Quick Insert Group. The Individual Insert group is shown below. 

 
The six menus available on the group categorize the objects that can be placed on the oneline 
diagrams. A summary of what is in each menu is described blow along with a picture of each 
of the six menus. 

Network Menu 

The objects in this menu represent network model objects. Generally these represent actual 
physical devices such as a generator or transmission line. They are similar to the model 
objects found in the Network Folder on the Explore Pane of the Model Explorer. 

Aggregation Menu 

The objects in this menu represent model objects that represent an aggregation of other 
model objects such as interfaces or injection groups. They are similar to the data objects 
found in the Aggregation Folder on the Explore Pane of the Model Explorer. 

Background Menu 

The objects in this menu represent objects that are only background text and do not link to 
any of the objects you would look at in the Model Explorer. Some of the objects link to 
external objects such as documents, but not to elements of the model. 

Pies/Gauges Menu 

The objects in this menu represent pie charts or gauges which link to the model data found 
in the Model Explorer 

Field Menu 

The objects in this menu represent fields which link to the model data found in the Model 
Explorer 

Indication Menu 

The objects in this menu represent indications of status or flow for objects that are found in 
the model data found in the Model Explorer 
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Quick Insert Ribbon Group 

  

The Quick Insert ribbon group contains buttons for creating a oneline diagram for a system 
model you have already read into Simulator. If you are building out your network (or even 
substation, area, or zone diagram), then using the Insert Palettes along with the Auto Insert 
routines is most efficient. If you would instead like help on inserting a single object on your 
oneline diagram see the Individual Insert ribbon group topic. Both of the ribbon groups are on 
the Draw ribbon tab. The Quick Insert ribbon group is shown as follows. 

 

 

Show Insert Palette for Menu 

Choosing any of the items in the Show Insert Palette for Menu 
will open up its respective Insert Palette. This Insert palettes 
show a list of all objects that are already shown on the oneline 
diagram as well as a list of objects which are not. For more 
information see the Using the Insert Palettes help topic. 

 

 Show Insert Palette for Menu 

The first six options are used to automatically insert network 
display objects that are connected to bus objects that have 
already been drawn on the oneline.  

Lines : Shows the Automatically Insert Lines Dialog 

Interfaces : Shows the Automatically Insert Interfaces Dialog 

Generators : Shows the Automatically Insert Generators 
Dialog 

Loads : Shows the Automatically Insert Loads Dialog 

Switched Shunts : Shows the Automatically Insert Switched 
Shunts Dialog 

Lines, Gens, Loads, Shunts : Shows a dialog for auto-
inserting lines, generators, loads, and shunts simultaneously. 

  

The next four options provide methods for adding pie charts, 
fields, circuit breakers and line flow objects around objects that 
have already been drawn on the oneline diagram. 

Line Flow Pie Charts : Select this to automatically insert line 
flow pie charts on the transmission lines or transformers 
objects that are selected. 

Circuit Breakers : Select this to automatically insert circuit 
breakers on the transmission lines or transformers objects that 



Getting Started With PowerWorld 

38 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

are selected. 

Line Flow Objects : Select this option to automatically insert 
line flow objects on the transmission lines or transformers 
objects that are selected. 

Add Fields Around : Select this option to insert fields around 
the presently selected objects. It will then bring up the 
Inserting and Placing Multiple Display Objects Dialog 

  

The follow two options provide a mechanism for auto-inserting 
bus or substation oneline objects. You must have geographic 
longitude/latitude information in order to use these options. 

Buses : Shows the Automatically Insert Buses Dialog 

Substations : Shows the Automatically Insert Substations 
Dialog 

  

The last two options provide a mechanism for inserting 
background lines that represent geographic borders or from a 
Shapefile. 

Borders : Shows the Automatically Insert Borders Dialog 

Insert GIS Data From Shapefile : Shows the Shapefile 
Import Dialog 
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Select Ribbon Group 

  

The Select ribbon group contains options to help select multiple oneline objects simulateously. 
The features in this topic are only available when you are in Edit Mode. This ribbon group is on 
the Draw ribbon tab. The Group is shown below.  

 
The features available on this ribbon group are described below. 

Select by Criteria  

Click on the Select by Criteria button to open the Select by Criteria Dialog. On oneline 
diagrams of even a modest size, this is an extremely useful feature and PowerWorld highly 
encourages you to use this feature. 

Select Region 

Use to select all objects in a particular region of the oneline. When the Region Type is 
Rectangle or Ellipse, then after clicking the button, click and hold the left mouse button 
on the oneline at the point where you would like to begin the selection. Then, drag the 
mouse to size the selection shape. Finally, let go of the mouse button once every object you 
need to select has been selected by the selection rectangle. When the Region Type is 
Polygon, then after clicking this button single click on your oneline diagram for each vertex 
of the polygon. Finally, finish the selection by double-clicking the mouse after which all 
objects inside your polygon will be selected. 

Depending on the Select Mode below, every object located entirely Inside the region, or if 
you have chosen Touching, then every object inside or partially touched will be selected. 
Selected objects will have handles appear indicating that they have been selected. 

Region Type 

Specify a Rectangle, Polygon, or Ellipse. This controls the shape used to select objects 
on the oneline diagram when using the Select Region button above. 

Select Mode 

This combo box specifies how the Select Region  button above works. Choose Inside in 
order to select only the objects completely inside the selection rectangle. Choose Touching 
in order to select every object either partially touched by or completely inside the selection 
rectangle. 

  

There are also other ways to select multiple objects 
• You can also select multiple objects manually by holding down the SHIFT key which 

clicking on objects in Edit Mode. This will also add to your selection. 
• If you hold down the SHIFT and CTRL keys simultaneously and then click on your oneline 

diagram and select a region it has the same affect as click on the Select Region button 
and selecting a region on your oneline 
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Onelines Ribbon Tab 

  

The Onelines ribbon tab generally consists of buttons and menus that provide access to 
modifying the appearance of a oneline diagram you have already created. For access to 
features regarding adding, moving, resizing, and formatting objects, see the Draw ribbon tab. 
The Oneline ribbon is shown below. 

 
  

The Options ribbon consists of buttons and menus that provide access to customizing the 
software options. The ribbon is shown below. 

 Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Active Ribbon Group 

The Active ribbon group contains basic methods for customizing the appearance of 
basic analysis tools for customizing an existing oneline diagram. For more detailed help 
see the Active ribbon group topic 

Zoom Ribbon Group 

The Zoom ribbon group contains buttons for navigating a oneline diagram. For more 
detailed help see the Zoom ribbon group topic 

General Options Ribbon Group 

Dynamic Formatting Menu 

This menu provides access to setting the Dynamic Formatting Options that apply to 
the active oneline, as well as formatting that applies to all onelines and Case 
Information Displays.  

 
Custom Hint Values 

Provides access to setting the Custom Hint Values that apply to all oneline objects.. 

Default Drawing Values 

Provides access to the Default Drawing Values. 

Toggle Full Screen 

Click this button to cause the presently active oneline to be toggled to full screen. 
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Keyboard Shortcuts  

Click on this button to open the dialog for defining Keyboard Shortcuts which allow 
you to open a oneline or auxiliary file directly from a function key. 

 Views Ribbon Group 

Bus View 

Opens the Bus View Oneline which provides a graphical display which allows you to 
quickly browse information about a bus and everything connect to that bus. 

Substation View 

Opens the Substation View Oneline which provides a graphical display which allows 
you to quickly browse information about a bus and everything connect to that 
substation. 

Open Windows Menu 

The Open Windows Menu provides a convenient method of switching between open 
windows. This includes User Interface Dialogs, Case Information Displays, and 
Oneline diagrams. 
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Active Ribbon Group 

  

The Active ribbon group contains basic methods for customizing the appearance of basic 
analysis tools for customizing an existing oneline diagram. 

 
  

Oneline Display Options  

Opens the Oneline Display Options Dialog. 

Contouring and Menu 

Click the top part of the button to open the Contouring Dialog. 

Otherwise, click the drop-down to provide direct access to many of the Contouring Options. 
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GIS Tools Menu 

Provides access to many Geographic Information System related tools that have been built 
into the software. 

 
Insert GIS Data From Shapefile : Opens the Shapefile Import dialog. 
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Export Oneline as Shapefile : Choose this to Export the Oneline as a Shapefile. 

Populate Lon,Lat with Display X,Y : Choose this to populate the Bus records latitude 
and longitude information based on the locations on the present oneline diagram. For more 
information see the Populate help topic. 

Closest Facilities to Point : Choose this to bring up the Closest Facility to Point feature. 

Great Circle Distance : Choose this to calculate the Great Circle Distance between two 
points. 

Insert Measure Line : Provides access to the Insert Measure Line Feature. 

Delete All Measure Lines : Provides access to the Delete All Measure Lines feature. 

List Displays Menu 

Contains access to several ways of viewing the oneline objects inside of "case information 
displays". Of course instead of seeing case information, you instead see information about 
the oneline objects. 

 
All Display Objects: Opens the Display Explorer providing access to all objects on the 
active oneline. 

Unlinked Display Objects : Opens the Unlinked Display Objects Dialog. 

Ony Selected Display Opbjects : Opens the Display Explorer providing access to objects 
on the active oneline, but defaults that explorer to only show the presently selected objects. 

Browse Open Onelines: Brings up the Browse Open Onelines dialog. 

Display Objects Export Format Description : Opens a Display Objects Export Format 
Description dialog. 

Layers Menu 

The Layers Menus provide access for opening the Define Layers Dialog for the presently 
active oneline diagram.  

Underneath the button for defining layers is a list of the presently defined layers. You may 
check or uncheck the various layers to hide or show the objects in those layers. 
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Save View 

Choose this option to open the Save Views Dialog. 

2D View / 3D View 

Toggle between 2D and 3D to change the presently active oneline between the 2D and 3D 
modes. 
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Zoom Ribbon Group 

  

The Zoom Ribbon Group is on both the Onelines ribbon tab and the Draw ribbon tab. To 
display large detailed power systems, Simulator’s onelines possess zooming and panning 
capabilities. The Zoom Ribbon Group enables you to prescribe a zoom level either by directly 
specifying a zoom value or by selecting a rectangular region of the diagram on which to focus. 
There is also a button to open a dialog box from which you can select a bus on which to 
center the display. See Zooming and Panning for more information. 

 
  

This toolbar contains the following several buttons for zooming the presently active oneline. 
• Zoom Area In /Out : The top two buttons can be clicked to zoom or out on a particular 

area of the oneline. When you click these buttons, the cursor will change to a cross-hair 
waiting for you to choose the region to zoom into (or out of) 

• Zoom In / Out : The middle two buttons can be clicked to change your mouse into a 
zooming tool. After choosing the button with a plus sign, each time you click on the 
oneline you will zoom in on that location. When choosing the button with a negative sign 
you will zoom out instead. 

• Present Zoom Level: the number represents the present zoom level and can be 
manually changed to modify the zoom level. 

• Show Full : Automatically zooms and pans the presently active oneline diagram so that 
all objects on the oneline diagram can be seen. 

• Find: Provide access to the Find Object on Oneline Dialog 
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Options Ribbon Tab 

  
The Options ribbon consists of buttons and menus that provide access to customizing the 
software options. All of the buttons on this ribbon are also available on one of the other 
ribbons, however this ribbon brings all the options in the software into one place. The ribbon 
is shown below. 

 
  

The Options ribbon is broken into four ribbon groups 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Case Options Ribbon Group 

Simulator Options   

Opens the Simulator Options Dialog. 

Misc. Power Flow Menu 

Provides more direct access to some miscellaneous options that are also found on the 
Opens the Simulator Options Dialog. 

Solution Menu 

Provides more direct access to some options related to the power flow solution 
algorithm. These options are all also available on the Simulator Options Dialog. 

Case Info Options Menu 

Provides more direct access to some options related to the appearance of case 
information displays. These options are all also available on the Case Information 
Display Options on the Simulator Options Dialog. 

Oneline Options Ribbon Group 

Oneline Display Options 

Opens the Oneline Display Options Dialog. 

Pie Chart Menu 

Provides more direct access to options related to Pie Charts. These options are all 
also available on the Oneline Display Options Dialogon the Pie Charts/Gauges page. 

Animation Menu 

Provides more direct access to options related to Animated Arrows. These options are 
all also available on the Oneline Display Options Dialog on the Animated Flows page. 

Thumb Nail Menu 
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Provides more direct access to options related to Thumb Nail View. These options are 
all also available on the Oneline Display Options Dialog on the ThumbNail View page. 

 Draw Grid Menu 

Provides more direct access to options related to the Draw Grid. These options are all 
also available on the Oneline Display Options Dialog. 

 Misc. Options Menu 

Provides more direct access to miscellaneous options related to oneline diagrams. 
These options are all also available on the Oneline Display Options Dialog. 

 Saved Options Menu 

 This menu provides direct access to the for toggling between different sets of 
options. These different sets of options are defined on the Oneline Display Options 
Dialog by clicking on the Save Options to Case button on that dialog.. 

General Options Ribbon Group 

Dynamic Formatting Menu 

This menu provides access to setting the Dynamic Formatting Options that apply to 
the active oneline, as well as formatting that applies to all onelines and Case 
Information Displays.  

Custom Hint Values 

Provides access to setting the Custom Hint Values that apply to all oneline objects.. 

Default Drawing Values 

Provides access to the Default Drawing Values. 

Toggle Full Screen 

Click this button to cause the presently active oneline to be toggled to full screen. 

Keyboard Shortcuts  

Click on this button to open the dialog for defining Keyboard Shortcuts which allow 
you to open a oneline or auxiliary file directly from a function key. 
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Tools Ribbon Tab 

  

The Tools ribbon consists of buttons and menus that provide access to the analysis tools that 
come with all versions of PowerWorld Simulator. Note: Features related to the various add-on 
tools including OPF, SCOPF, PVQV Curve, and ATC are found on the Add Ons ribbon tab. The 
tools ribbon is shown below 

 
  

The Tools ribbon is broken into six ribbon groups 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Log Ribbon Group 

Abort  

Terminates the current Power Flow Solution. If the application is performing a timed 
simulation, pressing the abort button will pause the simulation. See PowerWorld 
Simulation Control  for more details. 

Log 

Toggles the display of the message log window. The log window shows what is going 
on with the Power Flow Solution process and may prove useful when you are trying 
to track down a problem with a non-converging model. 

Script 

Opens the Script dialog, which can be used to call script commands or open auxiliary 
files containing script commands and data modifications. Note that the drop-down 
next to the Script button give convenient access to the Quick Auxiliary Files. 

Power Flow Tools Ribbon Group 

This group represents the basic solution actions for solving the power flow.  

For more detailed help see the Power Flow Tools ribbon group topic. 

Run Mode Ribbon Group 

The Edit Mode Ribbon Group contains basic analysis tools that are only available in Run 
Mode. 

 For more detailed help see the Run Mode ribbon group topic. 

Other Tools Ribbon Group 

The Edit Mode Ribbon Group contains basic analysis tools that are normally available in 
both Run Mode, and Edit Mode. 
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 For more detailed help see the Other Tools ribbon group topic. 

Edit Mode Ribbon Group 

The Edit Mode ribbon group contains basic analysis tools that are only available in Edit 
Mode. 

 For more detailed help see the Edit Mode ribbon group topic. 
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Edit Mode Ribbon Group 

  

The Edit Mode ribbon group contains basic analysis tools that are o`nly available in Edit Mode. 
The Group is shown below. 

  

 

  

Equivalencing 

Click this button to open the Equivalencing Dialog. 

Modify Case Menu 

 The Modify Case Menu contains actions related to modifying the network model. 

Tap Transmission Line: Opens the Tap Transmission Line Dialog. 

Move Bus Equipment: Opens the Move Bus Equipment Dialog. 

Split Bus: Open the Split Bus Dialog. 

Merge Buses: Opens the Merge Buses Dialog. 

List of Unused Bus Numbers: Clicking this button to get a list of unused bus numbers in 
the model.  

Append Case: Provides access to opening a case while appending. 

Renumber Menu 

The Renumber Menu contains actions related to renumbering data in the model. 

Renumber Areas/Zones/Substations: Opens the Renumber Areas, Zones and 
Substations Dialog. 

Renumber Buses: Opens the Renumber Buses Dialog. 
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Other Tools Ribbon Group 

  

The Other Tools ribbon group contains basic analysis tools that are normally available in both 
Run Mode and Edit Mode. The group is shown below. 

 
Model Explorer 

Opens the Model Explorer giving access to all the case information displays for the model. 

Limit Monitoring Settings 

Opens the Limit Monitoring Settings Dialog. 

Scale Case 

Opens the System Scaling Dialog. 

Connections Menu 

The Connection Menus contains actions related to analyzing the interconnectedness of the 
network model. These may be considered Graph Theory routines.  

 
Determine Path Distances to Buses: Opens the Determine Patch Distances from Buses 
or Group Dialog. 

Determine Shortest Path Between: Opens the Determine Shortest Path Between Dialog. 

Facility Analysis: Open the Facility Analysis Dialog. 

Branches that Create Islands: Opens the Branches that Create Islands Dialog. 

Other Menu 

The Other Menu contains other miscellaneous features. 



Getting Started With PowerWorld 

53 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

 
Governor Power Flow: Opens the Governor Power Flow Dialog. 

Set Generator Part. Factors: Opens the Set Generator Participation Factors Dialog 

Set Selected Field for Network Cut: Opens the Set Selected Field for Network Cut Dialog 

Set Selected From Selection: When a selection is chosen in Edit Mode, click this to set 
the Selected? field to YES for that selection. 

Charts Menu: The Charts menu is only available in Run Mode. It provides access to various 
charts including the Area ACE Chart, Area Load and Generation Chart, Area Losses Chart, 
Area MW Transactions Chart, and Area Average Cost Chart. 
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Run Mode Ribbon Group 

  

The Run Mode ribbon group contains basic analysis tools that are only available in Run Mode. 
The group is shown below. 

 
  

Contingency Analysis 

Click this button open the Contingency Analysis Dialog providing access to the automated 
processing of a list of contingencies. 

Sensitivities Menu 

The Sensitivities Menu contains a list that provides access to all the sensitivity calculations 
available. 

 
Power Transfer Distribution Factors (PTDFs) opens its associated dialog. 

TLR Sensitivities / Generation Shift Factors opens its associated dialog. 

Flow and Voltage Sensitivities opens its associated dialog. 

Loss Sensitivities opens its associated dialog. 

Difference Flows Menu 
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Difference Flows: Opens the Difference Flows Dialog 

Present Topological Differences From Base Case: Opens the Present Topological Differences 
From Base Case Dialog. 

The remaining options  in this menu all replicate the same behavior available on the 
Difference Flows Dialog. For more details so that dialog. 

Fault Analysis 

Click this button to open the Fault Analysis Dialog. 

Time Step Simulation 

Click this button to open the Time Step Simulation Dialog. 

Line Loading Replicator 

Click this button to open the Line Loading Replicator Dialog. 
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Power Flow Tools Ribbon Group 

  

The main function of the PowerWorld Simulator is to simulate the operation of an 
interconnected power system. The simulation is accomplished by selecting Single Solution – 
Full Newton from either the Quick Access Toolbar or the Power Flow Tools ribbon group 
on the Tools ribbon tab. This activity performs a single Power Flow Solution. See Solving the 
Power Flow for more information.  

  

The following tasks are also available from the Power Flow Tools ribbon group on the Tools 
ribbon tab.  

 
Single Solution – Full Newton   

The main function of the PowerWorld Simulator is to simulate the operation of an 
interconnected power system. The simulation is accomplished by selecting Single Solution 
– Full Newton from the Power Flow Tools ribbon group on the Tools ribbon tab. This 
activity performs a single Power Flow Solution. See Solving the Power Flow for more 
information. Also note that if presently in Edit Mode, you wil be automatically taken to Run 
Mode when choosing this. 

 Simulator Options 

When choosing any of the solution methods, the options as specified in the Simulator 
Options will affect what calculation is performed. solves the power flow using the either the 
Full Newton AC load flow or the DC Approximation load flow, as specified in the Simulator 
Options. 

Play Button 

Click this button to cause repeated solutions of the system and to cause the animation of 
oneline diagrams 

Pause/Stop Button 

Click this button to stop the action of the Play button. 

Restore Menu 

The Restore menu offers option to either Restoring a Previous Solution or a Restore a 
Previous State 

Sometimes a power flow attempt won't converge to 
a solution. When this occurs, the voltages and angles calculated by the solution engine will 
not satisfy the real and reactive power balance constraints at each bus. Then, the state 
currently stored in memory will not be an actual system operating point. It is often very 
difficult to coax the system to solve once it has failed to converge. 
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To help you recover from a solution attempt that has failed to converge (both timed 
simulations and single solutions), Simulator offers you two options. 

After Simulator solves a system successfully, it will store the voltages and angles it found 
in memory. If the changes that you then make to the system result in a system that 
can't be solved, you can select Restore > Last Successful Solution from the Power 
Flow Tools ribbon group on the Tools ribbon tab to reload the results of the last 
converged solution. After reloading this information, Simulator will re-solve the system 
and refresh all displays. 

In addition to restoring the last converged solution, Simulator also gives you the ability 
to restore the state of the system as it was just prior to the unsuccessful solution 
attempt. This can be thought of as "un-doing" the effect of the solution attempt. Before 
attempting a solution, Simulator stores the state of the system in memory. If it solves 
the power flow successful, Simulator will discard this pre-solution state. However, it the 
power flow fails to converge, Simulator will keep the state in memory. To recover it, 
select Restore > State Before Solution Attempt from the Power Flow Tools 
ribbon group on the Tools ribbon tab. Simulator will replace the non-converged post-
solution state with the pre-solution state and refresh the displays. You can then play with 
the system to try to make it easier to solve. 

If you are working with large systems, you should be aware that saving these system 
states can consume a lot of memory. Therefore, Simulator offers you the option to 
disable one of both of these features. To do this, select Simulator Options from the 
Case Options ribbon group on the Options ribbon tab to open the Simulator Options 
Dialog, and then go to the Storage sub-tab of the Solution tab. You will see two 
checkboxes there that can be modified to control whether or not these extra system 
states are saved. 

  

Solve Menu 

 
Single Solution – Full Newton   

The main function of the PowerWorld Simulator is to simulate the operation of an 
interconnected power system. The simulation is accomplished by selecting Single 
Solution – Full Newton from the Power Flow Tools ribbon group on the Tools 
ribbon tab, or from the Quick Access Toolbar. This activity performs a single Power 
Flow Solution. See Solving the Power Flow for more information. Also note that if 
presently in Edit Mode, you wil be automatically taken to Run Mode when choosing 
this. 

Polar NR Power Flow 

This perform a Newton Rhapson power flow solution using polar coordinates instead 
of rectangular coordinates as is normally done in Simulator. 

DC Power Flow 
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This automatically change the Simulator Options to use the DC Approximation and 
then immediately performs the DC power flow solution. 

Reset to Flat Start  

Select Solve > Reset to Flat Start from the Power Flow Tools ribbon group on 
the Tools ribbon tab to initialize the Power Flow Solution to a "flat start." A flat start 
sets all the voltage magnitudes and generator setpoint voltages to 1.0 per unit and all 
the voltage angles to zero. Usually, a flat start should be used only if the power flow 
is having problems converging. You can also use the flat start option on the Simulator 
Options Dialog to initialize every solution from a flat start. 

Robust Solution Process 

The Robust Solution Process provides a method to attempt to reach a solution when 
the standard load flow (Newton-Raphson) solution fails. The robust process performs 
a solution in a series of steps. 

First, the robust solution will turn off all controls in the case. Then the load flow will 
be solved using a fast decoupled power flow. If the fast decoupled power flow 
reaches a solution, Simulator then immediately solves the load flow using the 
Newton-Raphson load flow, still keeping the controls turned off. If the Newton-
Raphson solution is also successful, Simulator will begin adding controls back into the 
solution process, one type of control at a time. Thus the generator MVAR controls are 
added back in, and the load flow is resolved. Then the switched shunt controls are 
restored, and the load flow is again resolved. Simulator will continue in this manner 
by reintroducing next the LTC control, followed by the area interchange control, and 
lastly the phase shifter control. Furthermore, when reintroducing the phase shifter 
control, the controls are added one at a time for each phase shifter, with a load flow 
solution occurring after each. 
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Window Ribbon Tab 

  

The Window ribbon consists of buttons and menus that provide access to customizing the 
windows in the user interface. It also provides access to help topics and topics regarding the 
Auxiliary File Format. The ribbon is shown below. 

 
  

The Case Information ribbon is broken into four ribbon groups 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Window Ribbon Group 

Open Windows Menu  

The Open Windows Menu provides a convenient method of switching between open 
windows. This includes User Interface Dialogs, Case Information Displays, and 
Oneline diagrams. 

 
Switch to Free-Floating Windows 

Choosing this option toggles Simulator from containing all diagrams within the 
Simulator program shell to all windows related to Simulator being free-floating on 
your display. 

Refresh Displays 

Redraws (refreshes) each of the open windows. Simulator usually automatically 
refreshes the open windows as necessary. However, this action allows you to trigger 
the refresh when you want it. 

Ribbon Settings Menu 

This menu contains options for customizing your ribbon. 
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Ribbon Colors : You can change the color scheme to either Blue, Silver or Black 

Legacy Menus : Choose to Hide or Show a special Menus ribbon tab. The Menus 
ribbon tab mimics the menu and toolbar structure that existed in older versions of 
Simulator.  

Tile 

Rearranges the open oneline diagrams such that the total window area is divided 
equally among all of them and each is completely visible. 

Cascade 

Rearrange all open windows such that all they appear on top of each other while 
leaving the title bars visible. 

Toggle Full Screen 

Toggle full screen makes the currently selected diagram window switch to full screen 
mode. Full screen mode will dedicate the screen to the window, with all other 
windows, including the Simulator menus and toolbars, to be hidden. To get back to 
normal mode, right-click on the diagram in full screen mode and select Toggle Full 
Screen from the popup menu. 

Help Ribbon Group 

Contents 

Opens the Simulator Options Dialog. 

Set Help File 

Opens the Case Description Dialog. 

About 

Click this to open the About Dialog. The About dialog contains information about the 
software as well as showing you the Build Data of your version of Simulator. 
PowerWorld release patch version of Simulator on our website. These patch versions 
are named by date and is shown on the About Dialog. 

PowerWorld Website 

Click this to open your default web browser to the PowerWorld Corporation Website. 

Check for Updates 

This button will open the PowerWorld website to the patch download page. You will 
be required to enter your Account Username and Product ID (password) to check for 
and download patches for your version of Simulator. 

Auxiliary File Ribbon Group 

Load Auxiliary  

Choose this option to load an Auxiliary File. 

Load Display Auxiliary File 

Choose this option to load a Display Auxiliary File to append to the active oneline. 

Auxiliary File Format 

Opens the Bus View Oneline which provides a graphical display which allows you to 
quickly browse information about a bus and everything connect to that bus. 

Export Display Object Fields Menu and Export Case Object Fields Menu 
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Choose these options to export a list of fields for each type of object in a case (or a 
Oneline Display). The list also indicates which fields are key fields and required fields 
for each object. You can output this list of fields as either a text file or into Excel. 
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Chapter 2: Using Oneline Diagrams 

  

Simulator has been designed to be both highly graphical and interactive. The key to making 
effective use of Simulator lies in understanding the oneline diagrams. This chapter provides 
essential information on how to use and customize onelines. 

The following material is included: 
• Oneline Diagram Overview 
• Oneline Tools and Options 
• Printing Oneline Diagrams 
• Relationship Between Display Objects and the Power System Model 
• GIS Tools 
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Oneline Diagram Overview 

  

The purpose of the oneline diagram is to show information about the power system 
graphically. Such displays are called oneline diagrams (onelines) because the actual three-
phase power system components are represented using a single line. Simulator onelines 
"come alive" via: 
• Animation 
• Contouring 
• Zooming and panning capability and 
• Conditional display of objects 

Additionally, a key aspect of Simulator is the ease with which it allows the user to examine and 
modify many of the shown on the oneline diagram.  

The user may open any number of oneline diagrams, including multiple copies of the same 
oneline. 
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Relationship Between Display Objects and the Power System Model 

  

Display Object:  

An item shown on a oneline diagram. Display objects typically have an associated model 
object. Examples include buses, transmission lines, transformers, generators and loads. 
Display objects not associated with a model object are called unlinked objects. 

Model Object:  

A power system element contained in a case. 

  

A key strength of the Simulator is its ability to allow users to manipulate a power system 
model graphically. This capability greatly simplifies the work involved in developing or 
maintaining a power system case for both novice and advanced users. However, it is 
important to keep in mind the distinction between the shown on the onelines and the actual 
power system model, consisting of model objects. A key concept is that any number of display 
objects, including none at all, can be associated with a single model element. 

Simulator uses a bus-oriented model. In other words, the model objects are either the buses 
themselves, objects that are radially attached to a bus (i.e., loads, generators and switched 
shunts), or objects that join two buses (i.e., transmission lines, transformers or dc lines). As 
long as there is a one-to-one mapping between display objects and model objects, the 
distinction between the two could be made entirely transparent to the user.  

It is reasonable, and often quite useful, to use more than one display object to represent a 
single model object. For example, by using the Conditional display of objects feature, two bus 
display objects could be used on a single oneline to represent the same bus. One bus might be 
visible over a particular zoom range, while another, with perhaps a different size/thickness, is 
visible over another range. Alternatively, the same bus could be represented using display 
objects drawn on separate onelines.  

An ambiguity arises when the user uses the Cut command to delete an object. Is he or she 
deleting just the Display Object or both the Display Object and the Model Object? To alleviate 
the problem, Simulator prompts you when you are deleting a display object with an associated 
model object to delete both the Display Object and its associated model object record, delete 
just the display object, or cancel the delete.  

In addition, there is no requirement that model objects have a corresponding display object. 
Thus, you could use the oneline diagram to show just a fraction of the total system buses and 
other devices. You can use the Case Information menu to view the model objects directly 
regardless of whether or not they are shown on a oneline. 
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Oneline Local Menu 

  

The local menu provides access to a number of options and tools directly from the oneline. To 
display the local menu, position the cursor on an empty portion of the oneline then click the 
right mouse button. While most options are always available on the popup menu, a few 
options are only available on the popup menu in run mode.  
  

Find Object on Oneline (Edit and Run Modes) 

Displays the Find Object on Oneline tab of the Zoom, Pan, and Find Objects dialog.  

Oneline Display Options (Edit and Run Modes)  

Displays the Oneline Display Options  dialog. This dialog allows you to customize the 
appearance of the oneline.  

Pan/Zoom Control (Edit and Run Modes)  

Displays the Zoom/Pan tab of the Zoom, Pan, and Find Objects dialog. 

Area Information Dialog (Edit and Run Modes)  

Displays the Area Information Dialog for the bus nearest the cursor when the local menu 
was opened 

Contouring (Run Mode Only) 

Displays the Contour Options Dialog. This dialog allows you to contour the system voltage 
magnitudes or angles.  

Difference Flows (Run Mode Only) 

Displays the Difference Flows Dialog. This dialog is used to compare two power system 
operating points. 

Toggle Flow Visualization (Run Mode Only) 

Switches the oneline's animated flows between displaying actual flows and power transfer 
distribution factors. 

Dynamic Formatting (Active Oneline) (Edit and Run Modes in Oneline Diagrams) 

Displays the Dynamic Formatting Dialog. This dialog is used to change the rendering of 
objects in oneline diagrams according to the state of the represented object in the power 
system. 

Dynamic Formatting (All Views) (Edit and Run Modes in Bus and Substation Views) 

Displays the Dynamic Formatting Dialog. This dialog is used to change the rendering of 
objects in bus and substation views according to the state of the represented object in the 
power system. 

All Display Objects (Edit and Run Modes) 

Opens the Display Object case information display, showing all the objects contained in the 
oneline diagram. 

Only Selected Display Objects (Edit Mode Only) 

Opens the Display Object case information display, showing only the currently selected 
objects in the oneline diagram, by automatically checking the Show Only Objects 
Selected on Display box. 

Load Display Auxiliary File (Edit and Run Modes) 
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Loads a display auxiliary file. 

Edit Screen Layers (Edit and Run Modes) 

Opens the Screen Layers case information display. 

Show Layer (Edit and Run Modes) 

Allows activation of any saved screen layer. 

Print Oneline (Edit and Run Modes) 

Sends a copy of the oneline diagram to the printer. Selecting this option has the same affect 
as selecting File, Print Oneline from the main menu. See Printing Oneline Diagrams for 
more information. 

Copy Image to Clipboard (Edit and Run Modes) 

Copies the oneline file into the Windows clipboard using the Windows Metafile format 
(*.wmf). You can then paste the oneline into another program, such as a word processor. 
See Copying Onelines to Other Programs for details.  

Export Image to File (Edit and Run Modes)  

Saves a copy of the entire oneline diagram image to a file. Oneline image files can be saved 
in bitmap (*.BMP), Windows Metafile (*.WMF, .EMF), or JPEG format (.jpg). 

Toggle Full Screen (Run Mode Only) 

Sets the oneline diagram display window to full screen size. This option hides all toolbars 
and status bars. To return the window to normal, right-click on the oneline diagram and un-
check the Full Screen option. 

Embed a Display (Run Mode Only) 

Clicking on this option allows you to open another oneline diagram (or the same one) and 
embed the new display inside the existing display. You can choose what percentage size the 
embedded display should be, and where within the existing window the embedded window 
should be placed. 

Save/Edit/Delete View (Edit and Run Modes) 

Displays the Save View Level Dialog. This dialog is used to set defined locations on the 
oneline for recalling specific views from a list of saved views. 

Go To View (Edit and Run Modes) 

Allows the user to go to a specific location and zoom level on the oneline by choosing from a 
list of saved views. This option does nothing if no views are saved. 

Form Control > (Edit and Run Modes) 

Options on this submenu allow you to resize the window, shift the window, or close the 
window. 
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Oneline Display Options Dialog 

  

The Oneline Display Options dialog allows you to customize the display of the oneline diagram. 
You can access this display by right-clicking anywhere on an empty portion of a oneline and 
selecting Oneline Display Options from the resulting oneline local menu.  

This dialog can also be display by going to the Options ribbon tab and choosing Oneline 
Display Options from the Oneline Options ribbon group.  

This dialog houses several tabbed pages that govern various aspects of the oneline display. 
See Animated Flows, Display Object Options, Display Options, Grid/Highlight Unlinked Objects, 
Geography/Coordinates, Memo, Movie, Pie Charts / Gauges, Thumbnail View, or Substations 
for information on the respective tabs. 
  

Save Options to Case 

Of important note is the general option at the bottom of this dialog labeled Save Options 
to Case. What this allows you to do is define a set of oneline options in the dialog, and then 
save that definition of options in the case by giving the definition a name. Once you have 
named that set of options, you can recall it later by coming back to this dialog and choosing 
the name from the list of option set names that appears near the bottom of the dialog. You 
can define as many different sets of custom options as you wish. You can also use an option 
set saved with the case when you create a oneline view using the Save Views dialog. 

Also note that once you have defined these sets of Saved Oneline Options, you can then 
quickly apply them to the active oneline diagram by using the Saved Options Menu on the 
Options ribbon tab. 
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Display Options 

  

Display Detail 

The Display Detail box allows you to control how much information is shown on the oneline 
display. This option is available only in run mode. All elements on a oneline diagram are 
automatically visible in edit mode. There are four choices for run mode detail filtering: 

Minimal Show the oneline background, branch circuit breakers, generator MW output, and 
load MW/MVR.  

Moderate Show all Minimal information, along with bus voltages and all line flow pie charts.  

Complete Show all information.  

Custom Selecting this option and then clicking the Set… button opens the Custom Detail 
Dialog, which allows you to customize the oneline diagram to hide objects that do not meet 
your desired specifications. This dialog looks and works very similar to the Select By Criteria 
tool, allowing you to choose objects filtered by area, zone, voltage, and screen layer. 

Of course, in order for a certain display object to appear, it must have been placed there by 
the person who designed the oneline. 

Emphasize Specific Objects 

This option allows you to choose to "emphasize" desired elements on a oneline diagram. 
The emphasis is in the form of the emphasized elements being in full color, with de-
emphasized elements being muted colors. 

To choose emphasis of certain elements, first check the box labeled Do Emphasis. When 
you first check this box, it will open the Emphasis Filter dialog, which looks and works very 
similar to the Select By Criteria tool. You can choose the oneline elements you wish to 
emphasize, and include filtering by area, zone, voltage, and screen layer. 

The degree of emphasis (muting of de-emphasized elements) can be controlled by the 
Emphasis Amount slide bar. 

Background Color 

Select Change Background Color to select a different color for the oneline diagram 
background color. Select the Set as Default Background Color option to set the 
background color as the default for all oneline diagrams. 

Use Absolute Values for MW Line Flows 

If checked, this option will cause all MW flow text fields for lines to be displayed as the 
absolute value of the flow. Otherwise, the MW flow text fields will be positive near the 
source end of the line and negative near the sink end of the line. 

Use Absolute Values for Mvar Line Flows 

If checked, this option will cause all Mvar flow text fields for lines to be displayed as the 
absolute value of the flow. Otherwise, the Mvar flow text fields will be positive near the 
source end of the line and negative near the sink end of the line. 

Use Absolute Values for MW Interface Flows 

If checked, this option will cause all MW flow text fields for interfaces to be displayed as the 
absolute value of the flow. Otherwise, the MW flow text fields will be positive near the 
source end of the interface and negative near the sink end of the interface. 

Enable Mouse Wheel Zooming 

When this box is checked, zooming can be done with a mouse wheel. The default is off. 



Using Oneline Diagrams 

69 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Show Oneline Hints 

When this box is checked, hovering the cursor over an object will briefly display information 
about the object in a popup hint. 

Visualizing Out-of-Service Elements 

Out-of-service elements can have optional visualization settings that makes them "stand 
out" in relation to in-service devices on the oneline diagram. The options for out-of-service 
devices includes Use Dashed Lines, Draw and X Through Off-Line Generators, and 
Blink. Additional controls for the Blink option are available, for setting the blink interval and 
color. Any combination of these options can be used for out-of-service elements, although 
the X option only applies to out-of-service generators. 

Browsing Path for Oneline Diagrams 

This option applies when you have Oneline Links included on a oneline diagram. Rather than 
specify the full path and name of a oneline diagram as a oneline link, you can specify the file 
name only. When the link is clicked in Run Mode, Simulator will check all directories listed 
here, in order, to try and find the oneline file name stored with the link. 
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Pie Chart/Gauge Options 

  

Show Pie Charts/Gauges in Run Mode 

When this option is checked, the pie charts and line gauges will be visible during Run Mode. 
Otherwise, they will be visible only during Edit Mode. 

Only Show Pie Charts/Gauges if relevant data exists 

The relevancy of pie charts and gauges depends on the style of the pie chart or gauge. For 
MVA, MW, Mvar and Amp styles, the pie charts are considered irrelevant if the limits on the 
line or interface are 0. For max percent loading under contingency, the pie chart is irrelevant 
if no violation(s) under contingency occurred on the element. For the PTDF style, the pie 
chart is invalid if the PTDF value has not been calculated for the line or interface. 

  

The options for pie charts and gauges are split into four sections, discussed in the additional 
topics: 

Pie Charts/Gauges: Lines 

Pie Charts/Gauges: Interfaces 

Pie Charts/Gauges: Pie Chart/Gauge Styles 

Pie Charts/Gauges: General Options 

  

Many of these same options are available on the Pie Chart menu found on the Options ribbon 
tab. 
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Animated Flows Options 

  

The fields on the Animated Flows page of the Oneline Display Options dialog are used to 
customize the appearance of the animated flows on the oneline diagram. 

  

Show Flow Symbols 

Determines whether power flows are animated on the onelines. If this option is not checked, 
then no flow symbols appear on the oneline. 

Show Flows On 

Allows you to choose whether or not to display animated flows individually on Branch, Load, 
Generator and Shunt objects. Uncheck the box(es) for the objects that you do not wish to 
display animated flows. 

Base Flow Scaling on 

Animated flows on onelines may depict either actual power flows or power transfer 
distribution factors, depending on what you choose here. You can also choose to animate 
both the MW and MVAR flows or the MW and PTDF flows simultaneously. The Custom Float 
1 option allows user specification of a value to depict in the flow animation. To use this 
option, values should be entered in the Custom Floating Point 1 field for the appropriate 
devices. 

Animate 

This option determines whether or not the flow arrows are mobile or stationary on the 
oneline diagram. Unchecking this box will cause the flow arrows to remain stationary on the 
diagram. 

Scale Speed of Flow 

Checking this box will cause the arrows to flow at a speed proportional to the represented 
quantity. When it is not checked, all of the flows will be at the same speed. 

Scale Size of Flow  

If checked, the size of the animation symbols will vary to represent the magnitude of flow 
on the element (respective of the Animation Parameter.) Otherwise, the symbol size will 
be the same on all devices regardless of the magnitude represented. 

Reset Animated Flow Offsets 

This button allows the user to reset the animated flows to start at a specified offset position. 
Mostly this would be used to reset the offset to 0, which would cause the animated flows to 
start at the beginning of the line or element. Since the animation moves the flow arrows 
every time the load flow is resolved, resetting flows to a specific offset could be useful for 
comparing different load flow solutions by looking at differences in the animated flow 
objects. 

Set Size, Density, and Reference Values for this oneline 

Simulator detects the current zoom level and object parameters of the selected oneline 
diagram, and automatically adjusts the animation settings in an attempt to optimize the 
animation quality. 

Size 

Determines the relative size of the animated flows on the devices. Increasing this number 
increases the size of the flow symbols. This field may range from 1 to 999. 
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Density 

Determines the relative density of the animated flows on the devices. Increasing this value 
causes Simulator to display a greater number of flow symbols per unit distance on the 
oneline. This value may range from 1 to 999.  

Scaling Based on  

Determines whether the size and speed of animated flows represent actual flow or 
percentage loading. This option applies only to transmission lines and transformers as flows 
on other devices, such as loads and generators, always represent actual flow.  

Max. Zoom Level to Scale Size 

As a oneline is zoomed, the animated flow symbols increase in size. The value of Max. Zoom 
Level to Scale Size caps the size of the animated flows so that zooming beyond this level 
results in no further increase to the size of the flow symbols. 

Maintain Density above Maximum Zoom Level 

As a oneline is zoomed, the animated flow symbols decrease in density. Checking this box 
maintains the density of the animated flows after the maximum zoom level has been 
reached. 

Minimum Size in Pixels for In-service Elements 

Allows the specification of a minimum size for the animated flow objects for power systems 
elements that are in-service. The flow objects are sized based on the flow through the 
element. For elements with very small flows, it is often difficult to see the flow objects, and 
the minimum size can be set to make these flow objects more visible. The larger the 
minimum size value becomes, the more uniform the flow objects will become as elements 
are no longer sized based on their actual flow but rather the minimum size.  

Reference Values for Scaling 

Maximum flow reference for sizing the animated flows. The lower the MVA reference, the 
larger the animated flows appear on the oneline diagram as the actual flow value is 
compared to the reference value for scaling. 

Symbol Shape 

Simulator can display animated flows using directional arrows, circles, squares, or triangles. 

Animation Rate 

If the oneline animation is too fast or too slow, the animation rate can be adjusted by 
moving the slide bar. 

Symbol Fill Color  

Shows the fill color used for the animated flows if Use Fill Color is checked. Double-click on 
these fields to change the colors of the six different types of animated flows. 

Use Fill Color 

Checked if animated flow symbols should be filled using the Fill Color. 

Show PTDF Counter Flow 

Check this option if you wish for PTDF values that are in the opposite direction of the actual 
flow to be displayed using a different symbol color when visualizing PTDFs. 

  

Many of these same options are available on the Animation Menu found on the Options ribbon 
tab. 
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Thumbnail View 

  

The thumbnail view allows the user to see an overview of the oneline diagram in a smaller 
window in a specified location on the oneline diagram. The thumbnail view is useful when the 
user has zoomed in to a specific area of the oneline diagram, but still wants to see what part 
of the system they are observing on a larger scale as they pan around the diagram. The other 
application is to observe a more detailed part of the system in the thumbnail view as the user 
moves the cursor over the oneline diagram. The thumbnail view is not visible by default, but 
can be set up and displayed from the Oneline Display Options dialog. The options for the 
thumbnail view are: 
  

Show ThumbNail View 

If checked, the thumbnail view will be visible in the specified corner of the oneline diagram. 

Size of ThumbNail View 

The size of the thumbnail view as a percentage of the size of the oneline diagram. 

Zoom level of Thumbnail View 

The amount to multiply the oneline diagram zoom level for display in the thumbnail view. 
The higher the multiplier, the more of the diagram you will see in the thumbnail view. You 
can instead indicate that the thumbnail view should display the diagram at a specified zoom 
level rather than a dynamically scaled zoom level based on the current diagram's zoom level. 

Location 

Choose the location on the oneline diagram in which the thumbnail view is to appear. 

Border Width in Pixels 

The pixel thickness of the border around the thumbnail view. 

Background Color 

If Use One-line Background Color is checked, the thumbnail background color will be 
the same as the oneline diagram. If it is not checked, then a different thumbnail background 
color can be selected by clicking on the colored box next to the Use Custom Background 
Color label. 

Thumbnail view follows mouse cursor 

This setting is very useful when is combined with the Zoom Level. Using a low multiplier and 
checking the Thumbnail view follows mouse cursor box will show a more detailed part of the 
system over which the cursor is being moved. 

Percent Transparent 

This setting allows you to make the thumbnail window completely opaque, completely 
transparent, or some measure in between. The more transparent the thumbnail window, the 
more detail of the underlying oneline diagram is visible through the thumbnail window. 

  

Many of these same options are available on the Thumb Nail options menufound on the 
Options ribbon tab. 
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Thumb Nail Menu 

  

The Thumbnail View Options quick menu provides access to most of the options contained in 
the Thumbnail View Options dialog in an individual manner through menu commands. Select 
the Thumb Nail option from the Oneline Options ribbon group on the Options ribbon tab to 
access the menu. 

  

 
  

This quick menu contains the following default buttons, in order from top to bottom: 
• Show thumbnail on the screen 
• Thumbnail location on the screen 
• Size of Thumbnail View, as a percentage of the window size 
• Zoom out type (divide or zoom level) 
• Zoom out factor, defining the ratio of the diagram seen in the thumbnail relative to what is 

visible in the diagram itself. 
• Enable/Disable Thumbnail View to follow mouse cursor 
• Enable/Disable Using the Same Background as the main window 
• Background Color, if not the same as the main window 
• Line width of the border around the thumbnail window 
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Display Object Options 

  

General Options (All) Tab 

  

Percent of Injection Group/Owner object height used by name 

This option allows the user to specify the height of the name with respect to the rectangle of 
the injection group graphical objects. 

Display Circuit Breakers in Generators, Loads and Switched Shunts 

Uncheck this box to hide circuit breakers from appearing in generators, loads, and switched 
shunts. If this option is checked, the user can use in Display breakers on… to select 
individually what elements can display circuit breakers. 

Display Rotors in Generators 

Uncheck this box to hide the rotors of the generators. 

Change in Gen Rotor Angle per Refresh (degrees) 

This value specifies the change in the rotor angle every time the animated flows refresh. 
This means that the greater the angle value, the faster the rotor will seem to rotate when 
the oneline is animated. 

Show Field Inside Generator 

Fields can be shown inside generator objects. Select a field from the drop-down box or use 
the Find button to search through the list of fields available for a generator. Set the field to 
No Field to not display any field inside generator objects. Set the Digits and Decimals for 
floating point fields. Adjust the Relative Font Size to change the size of the font relative to 
the generator object size. To ensure that the field fits entirely inside each generator object, 
check the option to Dynamically decrease the font size so that the field fits inside 
the generator.  

Multi-Section Line Display Objects 

Intermediate Bus Rotation Angle 

Normally, the intermediate buses are perpendicular to the line. The value entered here 
can rotate the intermediate bus with respect to the original position. Therefore, a value 
of 0 degrees, will keep the intermediate buses perpendicular to the line, while a value of 
90 degrees will set the intermediate buses aligned to the line. 

Intermediate Bus Relative Size 

This option is actually a multiplier for the size of the intermediate buses specified for 
each multi-section display object. 

Bus Field Voltage Option 

This option allows the user to specify in which units the bus fields with Bus Voltage as type 
of field will be displayed. This setting is only valid when the type of field selected is Bus 
Voltage in the Bus Field Information dialog. Choosing a voltage field in the Select Field will 
return the voltage value in the specific units of the field. 

  

Circuit Breakers Tab 

  

Circuit Breaker Display Objects > Normally Closed  
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This section is used to specify the colors for all the circuit breakers normally closed in the 
oneline diagram. The colors that can be modified are the border and fill colors for presently 
closed and open circuit breakers. In order to change a color, click on the color box or on the 
Change button. Check Use Fill to use the specified fill color. 

Circuit Breaker Display Objects > Normally Open 

This section is used to specify the colors for all the circuit breakers normally open in the 
oneline diagram. The colors that can be modified are the border and fill colors for presently 
closed and open circuit breakers. In order to change a color, click on the color box or on the 
Change button. Check Use Fill to use the specified fill color. 

Shape 

Specify the shape of circuit breakers on transmission lines and transformers. The breakers 
shown on loads, generators, and switched shunts will always be the default rectangle shape.  
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Substation Display Options 

  

The Substations tab of the Oneline Display Options dialog provides parameters for 
customizing the appearance of Substation display objects. This tab is only available if the case 
contains at least one substation. 

The upper right-hand corner of the Substation page displays a template of the substation 
object’s appearance in terms of locations or "zones" where information can be displayed on 
the object. The rest of the page can be used to describe the appearance of the object and the 
information that appears in the substation objects. 
  

Upper % of Height 

This percentage indicates how much of the object is populated by the "upper" zone of the 
object. This includes the Upper Field, Upper Left (UL) and Upper Right (UR). As you 
decrease this percentage, the upper zone will get smaller, increasing the Identifer (middle) 
zone automatically, and vice-versa if you increase the percentage of the upper zone. 

Identifier % of Height 

This is the percentage of the height of the substation object that is occupied by the identifier 
or "middle" zone. This is the substation identifier section of the object. 

Lower % of Height 

This is the percentage of the substation object that is occupied by the "lower" zone of the 
object. This includes the Lower Field, Lower Left (LL) and Lower Right (LR). Unlike the 
previous two percentages, this percentage cannot be directly modified. Instead, it is 
automatically determined based on the settings of the Upper and Identifier percentages. 

Left % of Width 

This percentage indicates how much of the object is populated by the "left" zone of the 
object. This includes the Upper Left (UL) and Lower Left (LL). As you decrease this 
percentage, the left zone will get smaller, increasing the Identifier (middle) zone 
automatically, and vice-versa of you increase the percentage of the left zone. 

Identifier % of Width 

This is the percentage of the width of the substation object that is occupied by the identifier 
or "middle" zone. This is the substation identifier section of the object. 

Right % of Width 

This percentage indicates how much of the object is populated by the "right" zone of the 
object. This includes the Upper RIght (UR) and Lower Right (LR). As you decrease this 
percentage, the right zone will get smaller, increasing the Identifier (middle) zone 
automatically, and vice-versa of you increase the percentage of the right zone. 

Buffer Percent 

The buffer width for the height settings provide a buffer zone of the percentage width 
specified horizontally between the Identifier section and the upper / lower field sections. 
Similarly, the buffer width for the left and right width fields indicates a percentage buffer 
vertically between the upper / lower field zones and the four corner zones. 

Substation Identifier 

Choose how the identifier will be displayed for the substation. Choose to display by name, 
by number, or by combinations of name and number. The identifier will be displayed in the 
Identifier or "middle" zone of the substation object. 
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Shape 

Select the shape used for substations that are not overriding the Substation Layout Settings. 

What should be done when identifier text does not fit inside the width 

As the name of this option suggest, you can choose how the text in the identifier section of 
the object should be modified if resizing of the substation object causes the text to be too 
large for the modified size. 

Extra Substation Fields 

These four fields, two of which are represented as the Upper Field and Lower Field on the 
template, can be customized to display any substation field of your choosing. Use the drop-
down arrow of the appropriate box to choose a field, or use the Find button to pull up a list 
of fields to choose from. Once the field has been chosen, set the digits and number of 
decimal places for the field. 

Upper-Left Symbol (UL) 

Choose what symbol to display in the upper-left zone of the substation object. You can 
choose from None, Switched Shunt, Generator, Number of Buses, and Load. If the 
substation contains at least one type of the chosen object, a symbol representing that type 
of object will be displayed in the Upper-Left location of the object to indicate such a 
presence. By default, the Upper-Left zone will display the Generator symbol. 

Upper-Right Symbol (UR) 

Choose what symbol to display in the upper-right zone of the substation object. You can 
choose from None, Switched Shunt, Generator, Number of Buses, and Load. If the 
substation contains at least one type of the chosen object, a symbol representing that type 
of object will be displayed in the Upper-Right location of the object to indicate such a 
presence. By default, the Upper-Right zone will display the Load symbol. 

Lower Left Symbol (LL) 

Choose what symbol to display in the lower-left zone of the substation object. You can 
choose from None, Switched Shunt, Generator, Number of Buses, and Load. If the 
substation contains at least one type of the chosen object, a symbol representing that type 
of object will be displayed in the Lower-Left location of the object to indicate such a 
presence. By default, the Lower-Left zone will display the number of buses in the substation. 

Lower-Right Symbol (LR) 

Choose what symbol to display in the lower-right zone of the substation object. You can 
choose from None, Switched Shunt, Generator, Number of Buses, and Load. If the 
substation contains at least one type of the chosen object, a symbol representing that type 
of object will be displayed in the Lower-Right location of the object to indicate such a 
presence. By default, the Lower-Right zone will display the Switched Shunt symbol. 
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Oneline Animation 

  

An important feature of PowerWorld Simulator is its support of animated onelines. The use of 
efficient display algorithms allow animation rates that are typically greater than several times 
per second, even on large cases and on onelines with a significant number of objects. The 
extensive use of animation makes the display "come alive" so that system conditions can be 
ascertained more easily. 

In Simulator, animation is started from Run Mode by selecting the Play button in the Power 
Flow Tools ribbon group on the Tools ribbon tab. In Viewer, animation is started 
automatically when you load a case.  

The animation can be controlled and customized from the Animated Flows Tab of the Oneline 
Display Options dialog. To access this dialog, select Oneline Display Options from the 
Oneline Options ribbon group on the Options ribbon tab, or right-click on an empty area of 
the oneline diagram and select Oneline Display Options from the resulting local menu.  
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Copying Onelines to Other Programs 

  

The onelines can be easily copied to other programs. This allows you to add PowerWorld 
onelines to your word processor documents or slide presentations. The simplest way to copy a 
oneline diagram to another program is to use the Windows Clipboard. This is accomplished as 
follows: 
• In Simulator or Viewer, zoom and/or pan the display to the portion of the oneline diagram 

you would like to copy. 
• Right-click on an empty portion of the oneline to display the local menu. 
• Select Copy Image to Clipboard menu item. This places a copy of the oneline into the 

Window's clipboard. 
• In the other program, use Paste or Paste Special to copy the contents of the clipboard 

into that program. The oneline is pasted into the program using the Metafile format. 

In addition, oneline diagrams can also be saved as image files by right-clicking on an empty 
portion of the diagram and choosing Export Image to File. 
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Display Explorer 

  

The Display Objects case information display presents data describing each graphical object in 
the oneline diagram. This display functions in the exact same manner as the Model Explorer 
and is thus called the Display Explorer instead. The Display Explorer contains Case 
Information Displays and therefore can be used in a manner consistent with all other case 
information displays. It has a case information toolbar from which you can print, copy, and 
modify its records as well as view the information dialog of its associated power system object 
if it has any. You can also sort the object records by clicking on the heading of the field by 
which you want to sort. Additionally, when Simulator is in Edit Mode, the toolbar Records 
menu allows you to remove existing objects from the oneline diagram.  

To show the Display Objects case information display, go to the Onelines ribbon tab, then on 
the Active ribbon group select List Display > All Display Objects. 
  

As mentioned above, the Display Explorer functions identically to the Model Explorer. The only 
differences in functionality are due to additional options found on the bottom left of the dialog. 
This offers the following additional features. 

Show Only Objects Selected 

By checking this box, only the selected display objects currently selected in the oneline 
diagram will be shown. 

How to List Grouped Objects 

This specifies how to list grouped objects if there are any in the oneline diagram. The 
choices are to list individually the components of the group, to list only the groups, or to list 
both the individual elements and the groups. If there are not grouped objects in the oneline 
diagram, this control is disabled. 

Save Complete Display to AXD 

By clicking this button, all the objects that are shown in the case information display will be 
saved to a display auxiliary file. 

  By default, the display object records case information display contains the following fields: 

Type 

The type of display object. 

X/Longitude Location, Y/Latitude Location 

The x and y coordinates of the object’s location. 

Layer Name  

The layer name to which the display object is assigned. 

Layer Shown, Selectable in Edit Mode, Low Zoom Level, High Zoom Level 

These fields only display information about the layer to which the display object belongs. 
Therefore, the values for these fields can only be modified through the Screen Layer case 
information dialog or the Screen Layer dialog. 

Anchored 

This field indicates whether or not the display object is an anchored object. If the display 
object can not be an anchored object, then the field is empty. 

Font Size 

For text objects, this field shows the font size. 
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Supplemental Data 

  

Supplemental Data can be used to identify display objects that do not represent power system 
elements. User defined data types can be created and linked to display objects for use in 
filtering, dynamic formatting, Select by Criteria, and custom hints.  

Supplemental Classification Definition 

A Supplemental Classification is used to group Supplemental Data records into categories. As 
an example, if using Supplemental Data records to identify geographical borders, a 
Supplemental Classification could be Country. Each Supplemental Data record uses exactly 
one Supplemental Classification record. 

Supplemental Classification records are defined by one key field: 

Name 

This field uniquely identifies the classification and cannot be blank. 

Supplemental Data Definition 

Supplemental data records are defined by two required key fields: 

Classification 

This is the Supplemental Classification Name. This field cannot be blank. 

Name 

This is a unique identifier used to further define the Classification. If using supplemental 
data records to identify geographical borders, the Name could be United States to go 
with a Classification of Country. This field cannot be blank. 

In addition to the Classification and Name, geographic information, expressions, and custom 
strings, integers, and floating point values can be assigned to supplemental data records. 
This information can be entered in the Supplemental Data Case Information Display 
discussed below. 

Displaying Supplemental Data Records 

Supplemental Data records are displayed in the Supplemental Data Case Information Display 
found under Case Information > Other Data > Supplemental Data. This display 
consists of two tabs, Supplemental Classification and Supplemental Data. The table 
on the Supplemental Classification tab lists all of the Classifications that have been defined. 
The table on the Supplemental Data tab lists all of the Supplemental Data records that have 
been defined and provides the means for creating new Supplemental Data records 
AND Supplemental Classification records. Supplemental Classification records cannot be 
created under the Supplemental Classification tab.  

Creating Supplemental Data Records 

To create a new Supplemental Data record, from the Supplemental Data tab, right-click 
on the table and choose Insert from the local menu. The Define Supplemental Data 
dialog will open.  
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Either select an existing Classification from the drop-down box or create a new 
Classification by clicking New. (If creating a new Classification,another dialog box will open 
with a prompt for the Classification Name.) Type in a Name for the record. To create the 
record and close the dialog click OK. To create the record without closing the dialog click 
Save.To exit the dialog without creating the record click Cancel. 

Linking Display Objects to Supplemental Data 

Display objects that cannot be linked to a power system element can be linked to a 
Supplemental Data record. These display objects include Background Line, Background 
Rectangle, Background Ellipse, Background Picture, Text, Case Information Memo, Oneline 
Field, Oneline Link, Document Link, Memo Text, and Generic Model Field.  

Linking any of these objects to supplemental data must be done through the Display 
Explorer found under Onelines > All Display Objects. From the Explore tab, choose 
the display object type to link. If they are not already displayed, the Supplemental Data 
Classification and Supplemental Data Name fields must be added to the list of fields in 
the table. Simply enter the appropriate Classification and Name in the fields to link a 
particular display object to a Supplemental Data record.  

Once a display object is linked to a supplemental data record, the information in the 
supplemental data record can be used to filter, dynamically format, Select by Criteria, and 
display custom hints for that display object. 

Because there is no requirement to link display objects that cannot be linked to power 
system elements to supplemental data records, these objects will not be highlighted along 
with other unlinked elements when they are not linked to a supplemental data record. 

Automatic Linking of Supplemental Data When Inserting Geographic Information  

Background objects (lines and ellipses) created from inserting objects from borders included 
with Simulator and shapefiles can be linked automatically to supplemental data records.  

When auto inserting borders included with Simulator, the option to Automatically link 
county and state borders to supplemental data needs to be checked for this to occur. 

When inserting background objects from shapefiles, there are several options that need to 
be set for proper linking to supplemental data. These options are available on the Identify 
tab of the GIS Shapefile Data Dialog. 
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Supplemental Data Fields on Onelines 

  

Supplemental Data Field objects represent information about Supplemental Data records. The 
information that can be represented in these fields is the same in either Edit or Run Mode.  

Supplemental Data Fields can be added to a oneline while in Edit Mode from Draw > Field > 
Supplemental Data Field. After selecting this option, move the cursor to the location on the 
oneline where the new field should be placed and left-click. The Supplemental Data Field 
Options dialog will open.  

The Supplemental Data Field Options dialog can be used to modify the properties of 
individual supplemental data fields on the diagram. This dialog contains the following fields: 

Classification 

Select the Supplemental Classification from the drop-down list of available classifications. 

Name 

Select the Name of the Supplemental Data record from the drop-down list of available 
names. This list is populated with the appropriate names based on the selected 
Classification. 

Total Digits in Field 

Total number of digits to show in the field. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Value 

The current value of the field being displayed. 

Rotation Angle in Degrees 

The angle at which the text will be displayed on the diagram. 

Type of Field 

Select a field from the drop-down list of available fields or click Find Field to search through 
the list of available fields. 

  

Select OK to close the dialog and save the changes, or click Cancel to close the dialog 
without saving the changes.  
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Movie Maker 

  

Simulator version 13 no longer contains a built-in movie maker tool. Instead, PowerWorld 
Corporation recommends other movie making tools that can be used from outside of 
Simulator. Please refer to the PowerWorld website at 
www.powerworld.com/support/videocapture.asp for references to these third party movie 
tools. 
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Map Projections 

  

Background on Map Projections 

In order to create a map of a spherical object such as the Earth it is first necessary to 
convert the Earth coordinates of latitude and longitude into a two-dimensional coordinate 
system needed for a map. This conversion from the spherical coordinates of latitude and 
longitude to some xy Cartesian coordinate system is called a map projection. Mapmakers 
and mathematicians throughout history have invented many map projections. For each map, 
the mapmaker must decide which projection will look best for his or her purposes. This will 
depend on what part of the globe is being drawn, the size of the area being drawn, and the 
shape of the object being drawn. In general, map projections fall into three standard 
classes: cylindrical, conical, and planar. For a complete analysis of the topic of map 
projections see reference 1. 

For maps of North America, PowerWorld supports a Simple Conic map projection which is 
described below. 

For maps of the entire Earth, PowerWorld supports a Mercator projection which is described 
below. 

Simple Equidistant Conic Map Projection 

For maps made of the 48 conterminous states in the United States, maps are often made 
using one of the conical map projections. These projections can be recognized by the 
constant latitude lines that are seen as arcs. When looking at the U.S./Canadian border in 
the western United States, you will see that it curves on maps made using a conical 
projection, even though this is a constant latitude border. Several conical projections exist 
including the Albers Equal-Area Projection, Lambert Conformal Projection, and Simple 
Equidistant Projection. They can be visualized as taking the globe and placing a cone over it 
as shown in Figure 1 and then using this to map the coordinates to the xy plane shown at 
the right. Constant longitude lines are seen as straight lines and constant latitude lines are 
seen as arcs on the resulting map. 
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The equations for converting back and forth between (longitude,latitude) and (x,y) using the 
simple equidistant projection are described next. These equations are taken from reference 
1. 

First, you must specify seven values that are parameters of the mapping: 

 
For these values, the following variables are defined: 

 
Then given a latitude = ϕ and a longitude = λ, calculate the x and y coordinate using 

 
And given an x and y coordinate, calculate the latitude(ϕ) and longitude(λ) using 

 
Figure 2 shows more clearly what some of these variables are. 
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Maps made using PowerWorld's built-in map borders for North America use the following 
parameters: 

 
These numbers were thus set to be the default map projection numbers within PowerWorld. 
This projection will work well for the one-line diagrams with PowerWorld Corporation has 
created on the same standard background. 

Mercator Projection Use in PowerWorld 

For the Mercator Projection, PowerWorld assumes R = 30700.0 units. From this, given a 
latitude = ϕ and a longitude = λ, calculate the x and y coordinate using 

 
And given an x and y coordinate, we calculate the latitude(ϕ) and longitude(λ) using 
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Great Circle Distance Dialog 

  

To find the Great Circle Distance between any two points of longitude, latitude, select GIS 
Tools > Great Circle Distance from the Active ribbon group on the Onelines ribbon tab 
and the Great Circle Distance Dialog will be displayed. This can be done in Edit or Run Mode. 

The Great Circle Distance Dialog allows the calculation of distance between two points of 
longitude, latitude. The Great Circle Distance Calculation assumes that the earth is a sphere 
and makes no adjustments for the actual flattening of the earth. The two longitude, latitude 
points can either be entered manually for any two valid points or can be chosen from valid 
longitude, latitude values stored with either buses or substations. Valid longitude values are 
between -180 and 180 degrees. Valid latitude values are between -90 and 90 degrees. The 
calculated distance is given in either kilometers or miles. 

From Location 

Click the Choose From Location button to choose either the location of a bus or 
substation as the From Location. The Latitude (degrees) and Longitude (degrees) 
entries for the From Location will be filled in with the latitude, longitude information that is 
stored with the chosen element in the case data. These entries are not based on the 
location of a display object, if one exists, of the chosen element. If the element does not 
have valid geographic information stored, the values that are entered for the latitude, 
longitude will not be valid.  

The Latitude, Longitude entries can also be entered manually. 

To Location 

Click the Choose To Location button to choose either the location of a bus or substation 
as the To Location. The Latitude (degrees) and Longitude (degrees) entries for the 
To Location will be filled in with the latitude, longitude information that is stored with the 
chosen element in the case data. These entries are not based on the location of a display 
object, if one exists, of the chosen element. If the element does not have valid geographic 
information stored, the values that are entered for the latitude, longitude will not be valid.  

The Latitude, Longitude entries can also be entered manually.  

Units 

Choose the units in which to report the calculated distance.  

Calculate Distance 

Click this button to calculate the distance in the chosen Units between the From Location 
and the To Location. The calculated distance will appear in the box above the button. Error 
in input data will be returned if there is a problem with any of the latitude, longitude 
information. 
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Great Circle Distance Calculation 

  

The Great Circle Distance Calculation allows the calculation of distance between two points of 
longitude, latitude. The Great Circle Distance Calculation assumes that the earth is a sphere 
and makes no adjustments for the actual flattening of the earth.  

The calculation consists of the following parameters: 

 
The distance in kilometers between the starting and ending location is determined from the 
following equation: 

 
This calculation is used with several GIS tools to determine the distance between two locations 
or facilities on a diagram. 
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Populate Lon,Lat with Display X,Y 

  

To populate the longitude,latitude fields of buses and substations with the locations of 
corresponding display objects converted to longitude,latitude using the selected projection, go 
to the Onelines ribbon tab, then on the Active ribbon group choose  GIS Tools > Populate 
Lon,Lat with Display X,Y.   

The Populate Lon,Lat with Display X,Y Dialog will be displayed.  This can be done in either Edit 
or Run Mode.  The dialog will show which map projection is currently in use for the oneline.  
Users should be careful to not change the map projection once one has been established so 
that all objects on the oneline are consistently using the same projection.  If no projection has 
been set, the dialog shows None (x,y) as the Map Projection, selecting a map projection will 
establish that map projection as the current oneline map projection.   

  

Map Projection 

None (x,y) 

No map projection is in use.   

North American (simple conic) 

This projection is better when dealing with longitude, latitude points in North America.  
This is the projection that has been used in Simulator for years in defining geographic 
borders and placing then on a oneline. 

Entire World (Mercator) 

This projection is better when dealing with longitude, latitude points spread throughout 
the world.  

  

Click Populate Longitude,Latitude to complete the conversion.  The longitude, latitude 
values converted from display x, y coordinates can be viewed on the bus and substation case 
information displays or the information dialogs. 
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Geography/Coordinates 

  

The option is available to display screen coordinates in longitude, latitude instead of x,y. This 
option can be set by selecting Oneline Display Options from the Onelines ribbon tab or the 
Options ribbon tab. The following options are located under the Geography/Coordinates 
category.  
  

Map Projection in Use 

The map projection indicates which projection has been selected for inserting objects on the 
oneline. Users should be careful to not change a projection once one has been established. 
Otherwise, there is the risk that different objects will be inserted with different projections. 

Show longitude, latitude coordinates when showing x, y coordinates 

When this option is checked and a map projection other than None (x,y) is selected, 
longitude, latitude coordinates will be displayed anywhere that x,y screen coordinates are 
normally displayed. This option will only be enabled when a map projection other than None 
(x,y) has been selected. 
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Shape File Import 

  

Simulator allows you to import ESRI shapefiles (*.shp/*.dbf pairs) as a group of background 
lines or points on a oneline diagram. There are several locations where you may open the GIS 
Shapefile Import Dialog.  
• Go to the Onelines ribbon tab, then on the Active ribbon group choose GIS Tools > 

Insert GIS Data from Shapefile.  
• Go to the Draw ribbon tab, then on the Individual Insert ribbon group choose 

Background > Insert GIS Data from Shapefile 
• Go to the Draw ribbon tab, then on the Quick Insert ribbon group choose Auto Insert > 

Insert GIS Data from Shapefile 

The GIS Shapefile Data Dialog has the following sections: 

Control 

Modify 

Identify 

Format 

Shape List 
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GIS Shapefile Data: Control 

  

This is the first page of the GIS Shapefile Data dialog. The control page contains the controls 
for reading a shapefile into Simulator and provides some basic information on the shapes read 
from the file. 

Read in Shapefile 

Pressing this button will allow you to choose a shapefile and will load it into Simulator for 
placement on the currently selected oneline diagram. 

Save Shapefile 

Clicking this button will save to file the shapefile information currently loaded in memory. 
This option is useful if making changes to shape format attributes or eliminating certain 
shapes from those read in and then saving these changes in the shapefile format. 

Shapefile Information 

Once the shapefile has been loaded into memory, this section will be populated with general 
information on the number of shapes loaded, and the maximum and minimum X and Y 
values (usually in longitude and latitude.) 

Transfer Shapefile Objects to Oneline 

If you are ready to place the shapes on the oneline diagram, but want to continue working 
with existing shapes or read more shapes from another file, press the Transfer Shapes to 
Oneline and Clear button. This will keep the dialog open following the transfer. It also 
gives you options of what should happen to the current shapes in memory after you have 
transferred them to the diagram. You can choose to clear only the shapes that were 
transferred, all of the shapes, or none of the shapes. The first choice relates to options you 
have on the Shapefile Objects page regarding whether or not to transfer certain shapes 
from the shapefile to the diagram. 

Insert Into Layer 

Before transferring the shapes to the oneline diagram, you can choose which layer the 
shapes should be assigned to. If you wish to place the shapes into a new undefined layer, 
click on the Define Layer button to access the Screen Layers table. 

Transfer Shapes to Oneline and Close 

If you wish to transfer the currently loaded shapes to the oneline and close the dialog 
(clearing the shapes from memory), press this button to complete the process. 



Using Oneline Diagrams 

98 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

GIS Shapefile Data: Identify 

  

After using the Control page to read in shapes from a shapefile but before placing them on the 
diagram, identification options can be specified on the Identify page. 

Identification String for Display Auxiliary Files 

Shapefile shapes are created as background objects when added to a diagram. If using 
display auxiliary files to create or edit diagrams, objects must be uniquely identified. 
Because background objects typically do not link to an object in the power flow case, and 
therefore have no other unique means of identification, a unique ID string must be assigned 
to objects created via shapefiles. This unique identifier populates the Auxiliary ID field 
used in display auxiliary files and can be viewed from the Display Explorer. 

Prefix  
Optionally, a prefix can be concatenated with the selected Attribute to further identify 
the shape. 

Attribute 

The drop-down box is populated with the fields that are available with the .dbf file. 
Choose a field whose value will be used to uniquely identify the shape. By default, the 
Record Number of the shape is used for identification if no other Attribute is selected. 

Suffix 

Optionally, a suffix can be concatenated with the selected Attribute to further identify the 
shape. 

Linkage to Supplemental Data 

Background objects created from shapefiles can be linked to Supplemental Data records for 
purposes of further identifying the objects. This is useful when applying filters, applying 
dynamic formatting, using Select By Criteria, or defining custom hints with display objects 
created from shapefiles. 

Link Display Objects to Supplemental Data 
Check this box to link the background objects created from shapefile shapes to 
Supplemental Data records. 

Supplemental Classification 

Select an existing Supplemental Classification from the drop-down box or click New to 
create a new Supplemental Classification. 

Attribute for Supplemental Data Name 

Select an Attribute from the drop-down box. The list of attributes is populated from the 
fields that are available in the .dbf file. For each unique Attribute value, a supplemental 
data record will be created with the chosen Supplemental Classification and with its 
Name set to the Attribute value. 



Using Oneline Diagrams 

99 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

GIS Shapefile Data: Modify 

  

After using the Control page to read in shapes from a shapefile but before placing them on the 
diagram, the Modify page can be used to modify the XY attributes of the shapes. 

Map Projection 

There are two map projections you can choose from when placing the shapes onto a oneline 
diagram. The choices are: 

• North American (simple conic) 
• Entire World (Mercator) 

Once you have selected which projection to use, click on the Convert to Specified Map 
Projection button to process the conversion on the shapes currently in memory. 

Shift/Scale Shapefile X/Y Data 

You also have the option to shift the XY coordinates of shapes or scale them by scalar 
values. To shift shapes, enter scalar shift values for the X value and Y value and press the 
Shift XY Data button. To scale the XY coordinates, enter scalar scaling factors for the X 
and Y value, and press the Scale XY Data button. 

  



Using Oneline Diagrams 

100 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

GIS Shapefile Data: Format 

  

After using the Control page to read in shapes from a shapefile but before placing them on the 
diagram, the Format page can be used to modify the appearance attributes of the shapes. 

Change Shape Format Characteristics 

Point Size 

The size of points read from the shapefile can be adjusted when transferred to the 
oneline diagram. 

Line/Border Thickness 

Choose the pixel thickness of the shapefile lines when transferred to the oneline 
diagram. 

Line/Border Color 

Set the line color of the shapefile lines when transferred to the oneline diagram. 

Fill Color for Points/Polygons 

Set the fill color of the shapefile points and polygons when transferred to the oneline 
diagram. The box labeled Use Fill Color must be checked as well. 

Stack Level 

Indicate which stack level should be applied to the shapes when they are transferred to 
the oneline diagram. 

Immobile 

Check this box if you wish for the shape file objects to be immobile once they are 
transferred to the oneline diagram. This will prevent you from inadvertently selecting and 
moving the shapefile objects on the oneline diagram while in Edit mode. 

Set all shape format attributes to the values above 

Once you have finished changing the format settings for the shapes, press this button to 
apply them for the transfer of shapes to the oneline diagram. 

Automatic Color Mapping 

Available Attributes 

To customize the shapefile shapes based on a field value read from the .dbf file, select 
an attribute from the list. 

Color Map 

Select a color map to apply to the selected attribute. To modify existing or create new 
color maps, click on the Modify Color Maps button. The color of the object will then be 
based on where its selected attribute value maps to the selected color map. 

Change Border Color, Change Fill Color 

These two boxes allow you to choose if the color map selected should apply to the 
border color, the fill color, or both. 

Change Color Based on Attribute/Color Map 

Once you have finished setting the color map for a selected attribute, press this button 
to apply the settings before the transfer of shapes to the oneline diagram. 
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GIS Shapefile Data: Shape List 

  

After using the Control page to read in shapes from a shapefile but before placing them on the 
diagram, the Shape List page can be used to flag shapes for inclusion in the transfer and 
customize the appearance attributes of specific shapes. 

This page will be blank until you have actually read a shapefile into memory. Once you have 
done so, you will see a list of all shapes read from the file. The table allows you to customize 
the appearance and attributes of a specific shape, similar to the options on the Format page. 

In addition, you also can choose to include or exclude shapes from the transfer to the oneline 
diagram. This gives you the greatest flexibility for hand-picking which shapes you want to add 
to a oneline diagram. 
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Shapefile Database Record Dialog 

  

The Shapefile Database Record dialog is available by selecting Show Shapefile Fields… 
from the local popup menu (obtained by right-clicking on a display object) of any display 
object that was created from a shapefile. This menu option will not be available for display 
objects that were not created from a shapefile. This dialog provides information read from the 
database file (.dbf) associated with the shapefile from which the display object was created. 
Each time that this dialog is displayed, the database file is read to fill in the field information. 
The field information is not stored in the PowerWorld display file (.pwd) so the associated 
database file must be available for this information to be displayed.  
  

File Name 

This is the path and name of the database file (.dbf) associated with the shapefile from 
which the display object was created.  

Record Number 

This is the record number of the display object within the shapefile. 

List of Fields 

This list details the fields and values belonging to the given record number in the database 
file.  

Edit Oneline Browsing Path 

Select this option to update the Oneline Browsing Path. This browsing path will be used to 
search all listed directories for the database file specified in File Name if it cannot be found 
in the directory specified with  the File Name. 
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Export Oneline As Shapefile 

  

Display objects can be exported into shapefile formats (.shp/.dbf pairs) by going to the 
Onelines ribbon tab, then in the Active ribbon group, choosing GIS Tools >  Export Oneline 
as Shapefile. This will open the Select Objects and Fields to Export Dialog, which is similar to 
the Select by Criteria Dialog.  
  

The dialog is used to select one type of display object to export to the shapefile and the 
criteria used to select which specific objects will be included in the export.  
  

Selecting Areas and Zones 

Use the Area and Zone fields to select the areas and zones in which to select display 
objects. Ranges of area and zone numbers can be entered in the usual way, or the All 
Areas or All Zone boxes can be checked to select all areas and all zones respectively. The 
Areas and Zones tab pages can also be used to select the areas and zones in which to 
select display objects.  

Selecting Voltage Levels 

Specify the max and min voltage levels using the boxes that are provided, keeping in mind 
that all voltages are in kV. The All Voltages box can be checked to include all voltages 
without requiring the specification of a voltage range.  

Selecting Layers 

All layers can be selected by choosing the All option for Layers. If specific layers are to be 
selected, the Range option should be selected and the Layers tab should be used to check 
and uncheck specific layers in which to select display objects.  

Type of Drawing Object 

Select the type of object to export in the Type of Drawing Object dropdown box. 
Alternatively, the Find… button next to the dropdown can be used to select the object type 
from a list of available object types. 

Filter 

The Filter dropdown box provides a list of filters available for the selected Type of Drawing 
Object. The Find… button next to this dropdown can be used to find a filter or define a new 
filter for the selected object type. Filter options will not be enabled when an object type that 
does not allow filtering is selected.  

Selecting Fields 

The Fields list will be populated for object types that have associated fields. The selected 
fields will be written to the database file (.dbf) along with the value of the field. When the 
Specified option is selected, individual fields can be chosen by checking the box next to 
specific fields. When the All option is selected, then all fields associated with the selected 
type of object will be included in the database file. When the Show Only Commonly Used 
Fields option is checked, only those fields that are deemed to be commonly used will be 
displayed in the list. To show all fields associated with the selected object type, uncheck this 
box. Use the Check All and Uncheck All buttons to check all or uncheck all of the fields.  

Advanced Selection Criteria 

If only objects that are currently visible on the display (due to layering, etc.) are to be 
selected, check the box labeled Select only currently visible objects. If some display 
objects have been selected prior to opening the dialog, an advanced selection option 
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becomes available. If the box labeled Use as a filter on presently selected objects is 
checked, the criteria chosen in the dialog will only affect the previously selected objects. In 
other words, only the objects that were previously selected AND that match the chosen 
criteria will remain selected when exporting to the shapefile. 

Export Coordinates in Longitude,Latitude 

If a valid map projection has been selected for displaying display object coordinates in 
longitude,latitude, then the option to Export coordinates in longitude,latitude will be 
enabled. (A valid map projection can be set with the Map Projection in Use Option found in 
the Geography/Coordinates category of the Oneline Display Options dialog.) By default, the 
Export coordinates in longitude,latitude option will be checked when it is enabled. When 
checked, the coordinates of the display objects will be exported to the shapefile in 
longitude,latitude instead of PowerWorld Simulator x,y coordinates.  

Saving Shapefile Export Descriptions 

Shapefile Export Description settings can be saved with the case by clicking Save As to save 
with a new name or Save to save with the current name. This will allow the quick recovery 
of settings that may have been previously used. Use the Rename button to rename an 
already saved set or the Delete button to remove a previously saved set of criteria. If 
Shapefile Export Description sets have been saved, they can be exported to an auxiliary file 
by choosing Save to AUX file. The Load from AUX file button will load an entire auxiliary 
file regardless of whether it contains Shapefile Export Descriptions or not.  

Saving the Shapefile 

After all criteria have been set, click OK. A dialog will open prompting for the name of the 
file to save. Enter a file name and click Save. The type of file that is specified in the dialog 
is a shapefile with .shp extension, however, three files will be saved. All files will have the 
name specified in the save dialog, but the extensions will be .shp, .dbf, and .shx.  
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Insert Measure Line 

  

Distances between display objects can be approximated by inserting a measure line on the 
display. A measure line is similar to a background line. It can be drawn as a straight line 
between two points or as a line with many vertices and segments. By default, a measure line 
is drawn as a yellow line with a pixel thickness of 4.  
  

To insert a measure line go to the Onelines ribbon tab, then on the Active ribbon group 
choose GIS Tools > Insert Measure Line. Then position the mouse cursor on the display 
where the line should begin and click and release the left mouse button. Move the mouse to 
the desired termination point of the first line segment. A straight segment will follow the 
mouse movements. Click and release the left mouse button to complete the line segment and 
to prepare for drawing the next segment, or double-click if this is the last line segment. To 
draw a freehand shape rather than a series of straight line segments, click and hold the left 
mouse button where the freehand shape begins and drag the mouse to trace the desired 
shape (while holding the left mouse button down). Release the left mouse button to complete 
the section of the freehand shape. At this point, either another freehand section or a straight 
line segment can be added. When all desired freehand and straight line segments have been 
added, double-click the left mouse button to complete the line.  
  

To change the shape of the line, first left click on the line to select it. Handles will appear at 
each vertex. A vertex can be moved by holding the left mouse button down and dragging the 
vertex to a new location. To remove a vertex, hold down the CTRL key and then click the 
vertex you would like to delete. To add a vertex, hold down the CTRL key and then click on 
the line where the new vertex should be added. Note that freehand lines are nothing more 
than a continuous series of vertices. 
  

Once the measure line has been added to the display, the length of the line can be displayed 
by right-clicking on the line and selecting Measure Length… from the local menu. The units 
of the length are dependent on the map projection in use and whether the option to Show 
longitude,latitude coordinates when showing x,y coordinates is checked on the 
Oneline Display Options dialog. If the map projection in use is something other than x,y and 
the option to show longitude,latitude coordinates is checked, the length will be given in miles 
and kilometers. Otherwise, the length will be given in Simulator units. The Great Circle 
Distance calculation is used to determine the distance between vertices on the line to 
determine the approximate length in miles and kilometers.  
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Delete All Measure Lines 

  

All measure lines can be deleted from the display. To do this go to the Onelines ribbon tab, 
then on the Active ribbon group choose GIS Tools >  Delete All Measure Lines. 
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Path Distances from Bus or Group 

  

 To access the Determine Path Distances from Bus or Group dialog go to the Tools ribbon tab, 
and choose Connections > Determine Path Distances to Bus  from the Other Tools 
ribbon group. The Determine Path Distances from Bus or Group dialog provides a way to 
calculate how far electrically every bus in the system is from a particular starting point. 

After clicking the Calculate button, all buses that are part of the start element will be labeled 
internally as being a path distance zero. Then a calculation will be done that determines for 
each bus in the system the shortest total path length in getting from each bus to the Start 
Element. Buses that cannot reach the Start Element will be flagged with a very large distance 
(by default 10,000). The results of the calculation will then be copied into the Bus Field 
specified under the Bus Field to Populate option. The results will be displayed in a case 
information display at the bottom of the dialog. 

The options on the dialog are described below.   

Start Element Type and Element 

Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection 
Group. Then use the object chooser to choose the particular object to be the starting 
element. For more help on the object choose see the Find Dialog Basics. 

Distance Measure 

Choose the distance measure that will be used to determine distances between nodes. Each 
branch will be treated as having a length based on the choice below. Note: negative values 
are not allowed, therefore negative values will be treated as extremely small lengths 
instead. 

  X the per unit series reactance.  
  |Z| the magnitude of the series impedance (based on the per unit series 

reactance and resistance) 
  Length the Length Field for each branch  
  Number of 

Nodes 
Length of 1.0 is used for all branches 

  Other When choosing Other, click the Find.. button to choose any numeric field of 
a branch 

Lines to Process 

Regardless of the Distance Measure above, you can choose which branches allowed to be 
traversed when finding the shortest path. 

  All All branches are allowed to be traversed 
  Only 

Closed 
Only branches that are presently closed can be traversed 

  Filter Only branches that meet the Advanced Filter specified can be traversed . Click 
Define... to choose or create an advanced filter. 

  Selected Only branches whose Selected? field is set to YES can be traversed 

Bus Field to Populate 

Choose a field into which the resulting path distances will be copied. It is recommended that 
you use the custom floating point or integer fields for this purpose. 
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Closet Facilities to Point 

  

To produce a list of display objects and their distance from a point selected on the one-line 
diagram, go to the Onelines ribbon tab, then on the Active ribbon group choose GIS Tools 
> Closest Facilities to Point. After selecting this option, the mouse cursor will become a 
crosshair. Move the cursor to a location on the diagram and left-click. A dialog will open listing 
all of the display objects and their distance from the selected point in ascending distance from 
the point. 

Select to Show Display Objects of Type 

This allows the option of showing all display objects in one list or only listing objects of a 
particular type. 

Distance 

This field is listed by default with the display objects. This shows the distance between a 
given display object and the selected point. The location of the selected point is given by the 
X/Longitude and Y/Latitude fields on the dialog. The location of a given object is 
provided by the X/Longitude Location and Y/Latitude Location fields with the display 
object. The units of the distance is given in the Units field on the dialog.  

X/Longitude and Y/Latitude 

Each display object listed has a corresponding X/Longitude Location and Y/Latitude 
Location field. The X/Longitude and Y/Latitude fields given on the dialog provide the 
location of the point that was selected on the diagram. The fields on the dialog can also be 
manually adjusted to determine the distance between the display objects and a given 
coordinate. 

All of the fields that give the location of either the display object or the point selected on the 
diagram are given in x,y coordinates if a valid map projection is not selected or the option to 
show coordinates in longitude, latitude is not selected. Otherwise, the coordinates will be 
longitude, latitude. Both of these options can be set from the Oneline Display Options dialog 
in the Geography/Coordinates category. 

Units 

This indicates the units that the distance is in. The units will be in PowerWorld units if a valid 
map projection is not selected or the option to show coordinates in longitude, latitude is not 
selected. Otherwise, the units will be in either miles or kilometers. To display the distance in 
miles, the option to use the English Measurement System must be selected on the 
PowerWorld Simulator Options dialog under the Environment category. Select Metric (SI) 
as the Measurement System to display the distance in kilometers.  

Recalculate Distances 

Click this button to recalculate distances after changing the coordinates of the selected point 
by entering new values for the X/Longitude or Y/Latitude fields. 
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Oneline Screen Coordinates 

  

Onelines can be any size and can contain any number of objects. The size and position of 
objects on the screen are specified in terms of x-y "oneline screen coordinates." When the 
zoom level is 100% the size of the oneline in screen coordinates is 100 by 100. More 
generally, the size of the oneline is 1002 divided by the zoom level in both the x and y 
directions. 

The default screen center is the point (50,50) but this can be easily changed (See Oneline 
Panning and Zooming.) Negative screen coordinates are allowed. Usually you will not have to 
be concerned about an object's location in screen coordinates. 

The Status Bar displays the current cursor screen coordinates while in Edit Mode. 
  

 
Status Bar Showing Screen Coordinates 
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Oneline Zooming and Panning 

  

All oneline diagrams permit zooming and panning. Zooming and panning are very important 
tools for building and investigating large oneline diagrams that occupy more than a single 
screen of viewing area. Moreover, the display of various objects can be set to depend on the 
zoom level. See Oneline Conditional Display of Objects for more information on this feature. 
  

The following mechanisms are provided for zooming or panning a oneline: 

Zooming on Onelines 

Zooming involves adjusting the oneline diagram's display area by changing the magnification 
of the view. Zoom in on a oneline to have the screen display less of the complete oneline 
diagram, and zoom out on a oneline to have the screen display more of the complete 
oneline diagram.  

To zoom on a oneline diagram using the keyboard, follow these instructions: 

• Use CTRL-up arrow to zoom in  
• Use CTRL-page up to zoom in quickly 
• Use CTRL-down arrow to zoom out  
• Use CTRL-page down to zoom out quickly 
• The Zoom ribbon group offers additional zooming options: 
• Use the Zoom in on Area button of the Zoom ribbon group to select a region on which 

to zoom. 
• Use the Show Full button of the Zoom ribbon group to zoom the display out to show 

the entire oneline. 
• Use the Find button of the Zoom ribbon group to display the Pan/Zoom Dialog. 
• Use the Save View button of the Active ribbon group to display the Save View Dialog, 

or click on the drop down arrow on the Save View button to choose from a list of saved 
views. 

• Use the Rectangular Zoom Selector to select a section of the diagram to zoom into 
using a selection box. After clicking button (symbolized with a magnifying glass over a 
dashed rectangle,) left click and hold the mouse button down on the diagram, drag the 
mouse to select part of the diagram inside a box, then release the mouse button. 
Simulator will zoom into the region selected inside the box.  

Panning on onelines 

Panning moves the screen's focus point around the oneline diagram. You can pan left, right, 
up, or down to view different portions of the complete oneline diagram.  

To pan around the oneline using the keyboard, follow these instructions: 

• Use the arrow keys to move in the desired direction 
• Use page up to move up quickly 
• Use page down to move down quickly 
• Use the Home key to move left quickly 
• Use the End key to move right quickly 
• Left-click and hold the mouse button down anywhere on the background of the 

diagram. Make sure you do not click on an object on the diagram. While holding the left 
mouse button down, drag the mouse in any direction to "drag" the diagram in that 
direction. 

You can also use the Pan/Zoom Dialog to pan to a specific location, or even to a specific 
bus. You can display the Pan/Zoom Dialog either by pressing the Find button on the Zoom 
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ribbon group of the Onelines ribbon tab or by selectingPan/Zoom Control from the 
oneline diagram's local menu. 
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Save View Level Dialog 

  

The Save View Level Dialog is used to save an (x,y) location and zoom level, contour 
description, and/or hidden layer application for a oneline diagram in an easily accessible list for 
quick recall and application to the diagram. This dialog can be called by selecting the 
Save/Edit/Delete View option from the oneline local menu.  

You can also define a new layer by going to the Onelines ribbon tab, then on the Active ribbon 
group choose Save View > Save View. 

Recalling a saved view can be done by either right-clicking on the background to access the 
oneline local menu and choosing a view from the Go To View list, or by clicking on the drop 
down arrow on the Save View button and selecting a view from the resulting list. Selecting a 
saved view automatically moves the oneline diagram location to the (x,y) coordinates and 
zoom level, applies a stored contour, and/or applies hidden layers stored with the selected 
view. 
  

This dialog can be used for creating a new view, editing an existing view, or deleting an 
existing view. The Save View Level Dialog has the following options: 

View Name 

This is the name that the view will be stored under in the saved view list. This must be a 
unique name for each view saved with the oneline diagram. By default this field is blank. To 
edit an existing view, choose the desired view from the drop down list. 

Save Display Information in View 

When checked, the view will store an x-y coordinate and zoom level to associate with the 
view. When the view is selected for display, the diagram will center on the x-y coordinate at 
the defined zoom level. 

X-Coordinate 

The x-coordinate for the view. This value will default to the current x-coordinate for the 
oneline diagram, or will change to a saved value if a saved view is chosen from the View 
Name drop down list. This value can be modified by the user. 

Y-Coordinate 

The y-coordinate for the view. This value will default to the current y-coordinate for the 
oneline diagram, or will change to a saved value if a saved view is chosen from the View 
Name drop down list. This value can be modified by the user. 

Zoom Level 

The zoom level for the view. This value will default to the current zoom level for the oneline 
diagram, or will change to a saved value if a saved view is chosen from the View Name 
drop down list. This value can be modified by the user. 

Save Contour Information in View 

If a contour is being displayed when the view is created, you can choose to save the contour 
information with the view by checking this box. Saving a contour with a view will display 
that contour when you switch to that view. You also have the option of saving a blank 
contour with the view. This is indicated by a Contour Object of ‘None’ and a Contour Field of 
‘None.’ If you save a blank contour, no contour will be displayed when switching to that 
view. If you don’t save any contour with the view, then any existing contour will be applied 
when switching to that view. 

Contour Object 
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This section displays the type of object the stored contour pertains to. This field cannot be 
changed from this location. 

Contour Field 

Displays the type of value the stored contour pertains to. This field cannot be changed from 
this location. 

Link to Oneline Display Options Settings 

In the Oneline Display Options in Simulator, you can save various sets of options with a case 
for quickly recalling oneline diagram settings by name. This option allows you to include a 
custom defined option set by name with the current view. Note that you first must have 
created and saved a custom set of options for a diagram from the Oneline Display Options 
dialog before this option on the Save Views dialog will be enabled. 

Save Hidden Layers 

Since Simulator allows the use of layers to display or hide objects on the diagram, views also 
can optionally store the layer settings when the view is created. The window below this 
checkbox will list the layers that are presently hidden on the diagram. When this view is 
recalled, the layers in this list will be hidden if they were stored with the view. 

Save 

This button will save a new view or modify the values for an existing view of the name in 
the View Name field. 

Delete 

This button will delete the currently open view from the saved view list. The dialog 
information will default to the saved view information of the previous view in the list. 

OK 

This button will save a new view or modify the values of an existing view of the name in the 
View Name field, and will close the Save View Level Dialog. 

Save to AXD 

By clicking this button, all the views will be saved to a display auxiliary file. 

Load from AXD 

This button will load all the views saved in a display auxiliary file. 
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Window Ribbon Tab 

  

The Window ribbon consists of buttons and menus that provide access to customizing the 
windows in the user interface. It also provides access to help topics and topics regarding the 
Auxiliary File Format. The ribbon is shown below. 

 
  

The Case Information ribbon is broken into four ribbon groups 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Window Ribbon Group 

Open Windows Menu  

The Open Windows Menu provides a convenient method of switching between open 
windows. This includes User Interface Dialogs, Case Information Displays, and 
Oneline diagrams. 

 
Switch to Free-Floating Windows 

Choosing this option toggles Simulator from containing all diagrams within the 
Simulator program shell to all windows related to Simulator being free-floating on 
your display. 

Refresh Displays 

Redraws (refreshes) each of the open windows. Simulator usually automatically 
refreshes the open windows as necessary. However, this action allows you to trigger 
the refresh when you want it. 

Ribbon Settings Menu 

This menu contains options for customizing your ribbon. 
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Ribbon Colors : You can change the color scheme to either Blue, Silver or Black 

Legacy Menus : Choose to Hide or Show a special Menus ribbon tab. The Menus 
ribbon tab mimics the menu and toolbar structure that existed in older versions of 
Simulator.  

Tile 

Rearranges the open oneline diagrams such that the total window area is divided 
equally among all of them and each is completely visible. 

Cascade 

Rearrange all open windows such that all they appear on top of each other while 
leaving the title bars visible. 

Toggle Full Screen 

Toggle full screen makes the currently selected diagram window switch to full screen 
mode. Full screen mode will dedicate the screen to the window, with all other 
windows, including the Simulator menus and toolbars, to be hidden. To get back to 
normal mode, right-click on the diagram in full screen mode and select Toggle Full 
Screen from the popup menu. 

Help Ribbon Group 

Contents 

Opens the Simulator Options Dialog. 

Set Help File 

Opens the Case Description Dialog. 

About 

Click this to open the About Dialog. The About dialog contains information about the 
software as well as showing you the Build Data of your version of Simulator. 
PowerWorld release patch version of Simulator on our website. These patch versions 
are named by date and is shown on the About Dialog. 

PowerWorld Website 

Click this to open your default web browser to the PowerWorld Corporation Website. 

Check for Updates 

This button will open the PowerWorld website to the patch download page. You will 
be required to enter your Account Username and Product ID (password) to check for 
and download patches for your version of Simulator. 

Auxiliary File Ribbon Group 

Load Auxiliary  

Choose this option to load an Auxiliary File. 

Load Display Auxiliary File 

Choose this option to load a Display Auxiliary File to append to the active oneline. 

Auxiliary File Format 

Opens the Bus View Oneline which provides a graphical display which allows you to 
quickly browse information about a bus and everything connect to that bus. 

Export Display Object Fields Menu and Export Case Object Fields Menu 
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Choose these options to export a list of fields for each type of object in a case (or a 
Oneline Display). The list also indicates which fields are key fields and required fields 
for each object. You can output this list of fields as either a text file or into Excel. 
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Oneline Conditional Display of Objects 

  

Along with supporting zooming and panning, the onelines permit the conditional display of 
objects. That is, it is possible to specify display objects so they are visible only at particular 
zooming ranges. This enables the oneline to show additional details as the user zooms in and 
fewer details when the user zooms out.  

Please note that the zoom levels are defined as percentages. If you want an object to display 
only between 50% and 150%, you must select 50 and 150 as the zoom level boundaries. 

This option is available by assigning objects on the diagram to a Layer. Layers can be defined 
and set to objects on the Format Multiple Objects dialog. 
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Keyboard Short Cut Actions Dialog 

  

The Keyboard Short Cut Actions dialog allows the user to associate a keyboard shortcut to a 
determined oneline diagram, and even to a particular view of that diagram. When the 
keyboard shortcut is pressed, the oneline diagram is opened (if it was closed) and brought to 
the front. When a view is also associated, then the user is taken to such a view. 

To open the Keyboard Short Cut Actions Dialog, select  Keyboard Shortcuts on the General 
Options ribbon group of the Options ribbon tab. These General Options are also available on 
the Oneline ribbon tab. 

The dialog has the following controls: 

Keyboard Shortcuts 

Lists all the keyboard shortcuts. When selecting a keyboard shortcut, it will show the oneline 
and the view associated to the selected keyboard shortcut. If your keyboard has an extra 
row of function keys, then you can check the box labeled Include F13-F24. If a shortcut 
has been defined for the respective key, then it will be highlighted and a string will 
summarize the action of the shortcut 

Clear All 

Clicking this button will delete all the associations of all the listed shortcuts. 

Save Shortcut 

Click this button after entering a oneline diagram and eventually a view so they can be 
associated with the selected keyboard shortcut. 

Delete Shortcut 

Click this button to delete the associations of the selected keyboard shortcut with any 
oneline diagram and view. 

Create Shortcut 

This indicates the keyboard shortcut to which the below actions will be assigned. The 
available actions are to Open a Oneline and to Open an Auxiliary File 

Open Oneline 

The following options are available for opening oneline actions: 

Oneline and View: Oneline 
Shows the path and the name of the oneline diagram which will be opened when the 
selected keyboard shortcut is pressed. If the field is blank, then no oneline diagram is 
associated to the keyboard shortcut. You can click Browse to find the oneline diagram. 

Oneline and View: View 

Shows the name of the view belonging to the associated oneline diagram to which the 
user will be taken when the selected keyboard shortcut is pressed. If the field is blank, 
then no view is associated to the keyboard shortcut. 

Action for already open onelines 

If the oneline being requested by the shortcut key is already open, then this option 
determines what should be done. Choices are to close the oneline, bring the oneline to 
the front, or to open a new oneline. 

Where to open oneline 

When opening a oneline via a shortcut key, you may do one of the following: 
• Separate Window (open the oneline as normal) 



Using Oneline Diagrams 

119 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

• Separate Window – Toggle Full Screen (open normal and then toggle it to full 
screen) 

• Embed the Active Oneline Window (opens the oneline and embeds it inside the 
presently active oneline diagram) 

Note: if onelines already exist which have been toggled to full screen, and a short cut 
key is used to open a window that will not be toggled to full screen, then all other 
onelines present open will be switched to normal mode instead of full screen mode. 

Size and Location 

This specifies the relative size and location you would like the oneline to be opened at. 
When opening the oneline normally, the percentage is relative to the size of the 
container window. When opening the oneline embedded in the active oneline, the 
percentage is relative to the size of the active oneline. 

Make embedded oneline borderless 

When embedding the oneline inside the presently active oneline, this option will make 
the embedded oneline borderless. 

Open Auxiliary File 

The following options are available for opening auxiliary file action: 

Filename 
Shows the path and the name of the auxiliary file which will be opened when the 
selected keyboard shortcut is pressed. If the field is blank, then no auxiliary file is 
associated to the keyboard shortcut. You can click Browse to find the auxiliary file. 

Section name 

Shows the name of the script or data section belonging to the associated auxiliary file 
which will be executed when the selected keyboard shortcut is pressed. If the field is 
blank, then no specific section is associated to the keyboard shortcut, so all script and 
data sections will be loaded. 

Create objects if they do not already exist 

Check this box to indicate that new objects in the auxiliary file should automatically be 
created. 

Save/Load shortcuts to/from an Auxiliary File 

Click the Save button to save all the shortcuts to an auxiliary file. Click the Load button to 
load the shortcuts saved in an auxiliary file. The shortcuts saved in the auxiliary file will 
replace the shortcuts saved in the dialog. 

Close 

Closes this dialog. 

  

In addition to the shortcuts displayed on this dialog, Simulator also offers standard windows 
editing shortcuts such as: 

Ctrl + x – Cut Command 

Ctrl + c – Copy Command 

Ctrl + v – Paste Command 
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Printing Oneline Diagrams 

  

To print a oneline diagram, select Print Oneline from the Application Button or right-click on 
the oneline background and select Print Window from the popup menu. This opens the Print 
Options Dialog, which you can use to configure the print job, including its size, orientation, 
border, and title bar. You can even choose to print a oneline to multiple pages using 
Simulator's multi-page printing. 
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Print Options Dialog 

  

The Print Options Dialog is used to configure the printing of oneline diagrams (including bus 
view displays) and of strip charts. To print a oneline diagram, select  Print Oneline from the 
Application Button. To print a strip chart, right-click on it to invoke its local menu, and then 
select Print Window. In both cases, Simulator will open the Print Options Dialog. 
  

The Print Options Dialog has three tabs: 
  

Page Layout 

This tab sheet contains options for how the diagram will appear on the printed page. It 
presents the following controls: 

Margins 

Specify the horizontal and vertical margins in either inches or centimeters. 

Scaling 

Set this option to Proportional to print the oneline diagram or strip chart such that the 
screen’s aspect ratio is maintained. Set this option to Fit to Page to force the printout to 
take up all available space on the page in both horizontal and vertical directions. 

Draw Border 

Places a border to be drawn around the oneline diagram or strip chart. 

The second tab controls the printing of a title bar. Check the Print Title Bar box to print a 
title bar at the bottom of the diagram. Checking this box displays a number of options that 
allow you to specify various items to include in the title bar. If you don’t want to include 
certain items on the plot, simply leave those fields blank. 

The title bar is split horizontally into three sections. If you specify values for all requested 
items, they will be arranged in the title bar as follows: 

Company | Description Line 1 | Date 

Department | Description Line 2 | Drawing # 

Author | Description Line 3 | Title 
  

Title Bar 

This tab is used to specify whether or not to include a title bar on the diagram, along with the 
information that would be contained in the title bar. 

  

Multi-Page 

This tab allows the oneline diagram to be "divided" into a specified number of sections for 
printing the oneline to several pages. A multi-page oneline can be useful for including "close-
up" views of areas of a diagram in a report, or the multiple pages can be cut and combined to 
form a larger printed oneline if a plotter is not available. The Multi-Page tab presents the 
following controls: 

Grid Size 

Choose this value to subdivide the oneline into an N by N grid. You can then choose which 
sections of the oneline to print based on the grid overlay. The maximum size is 10 x 10. 
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Choosing What to Print 

A low resolution picture of your oneline is shown on the Multi-Page tab. Gridlines are 
drawn over the diagram to show where the oneline has been subdivided based on the Grid 
Size chosen. 

To remove a grid section from the printout, click on the oneline image in the corresponding 
section of the grid. The selected section of the grid will become dark to indicate you wish to 
prevent the section from printing. 

To add a grid section back into the print job, click on a darkened section of the grid to allow 
that section of the oneline to be printed. 

The number of pages you have chosen to print will be shown on the dialog. When printing 
out a multi-page oneline with a title bar, the page number will appear on the title bar in the 
form "Column Letter"-"Row Number". For example, if the Grid Size is 4, the pages are 
numbered A-1 through D-4. 

Click Print to send the document to the printer, or Cancel to abort the print. Click Setup to 
view the default Windows printer dialog, which will allow you to specify whether to print the 
figure in portrait or landscape modes and to set various printer-specific properties. 
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Printer Setup 

  

Choose Printer Setup from the Application Button to configure the printer using the standard 
Windows printer setup dialog. This dialog allows you to define which printer to use for printing 
from Simulator, the size of the printed page, the page’s orientation, and additional properties 
that are specific to the printer you are using. 
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Chapter 3: Creating, Loading, and Saving Simulator Cases 

  

This chapter describes the File and Simulation Control Menus. The File Menu is used to open 
and save either full cases or oneline diagrams, or to create new cases or new onelines (Edit 
Mode). The menu is also used to exit Simulator or to validate a case (Edit Mode).  

The Simulation Control Menu controls the actual simulation. You can use this menu to do 
either a time-domain simulation or a single Power Flow Solution.  

The following material is included:  
• File Menu 
• Case Formats 
• Validating a Case 
• Opening Files 
• Creating Files 
• Closing Files 
• Additional File Formats 
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Application File Menu 

  

The Application File menu is used to open and save either full cases or oneline diagrams, to 
create new cases, to open and load auxiliary files, to print and to exit Simulator. To access this 
menu you must click on the Application button in the upper-left corner of the program. 

Application Button:  
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Case Formats 

  

Simulator supports a number of case formats. You can both open and save cases using most 
of the following formats: 

PowerWorld Binary (*.pwb) (Preferred Format) 

For most users, the best choice of power flow case formats is the PowerWorld Binary 
format. This format stores the most complete set of case information but requires the 
smallest file sizes. Information stored in this format includes power flow data, economic 
parameters, case time variation/options values, and screen customizations. The only 
potential disadvantage of this format is that it is stored in binary form, which means that it 
cannot be viewed using a standard text editor. All the other formats are ASCII and thus 
readable in text editors such as Notepad.  

One additional benefit of using the Powerworld Binary format is that with this format the 
case can be password-protected. This setting is available under Misc. Power Flow > Set 
Case Username and Password in the Case Options ribbon group on the Options ribbon 
tab. 

PowerWorld Auxiliary File (*.aux) 

Simulator can now save and load cases using the PowerWorld defined auxiliary file format. 
When the aux file format is chosen as the save file type in Simulator, the data describing the 
entire case is written to a text file described by Simulator’s auxiliary file format. These files 
can be considerably larger than PowerWorld Binary files, and generally should not be used 
unless otherwise necessary. Note that not all auxiliary files represent an entire case, and in 
fact in most cases do not. Only when an auxiliary file is created using the Save Case As 
option in the Application Button  in Simulator does the auxiliary file contain all necessary 
information for loading the complete case in Simulator as an auxiliary file. 

PTI Raw Data Format (*.raw) 

This format is included primarily for interchange of power flow data with other packages. 
The PTI Raw Data format only contains power flow data. When using this format, the 
generator participation factors are automatically set to be proportional to the MVA rating of 
each generator.  

PTI Raw Data Format (*.raw) (with options) 

This format is only available when opening a case. This format is the same as the PTI Raw 
Data Format except that a dialog will open allowing user input on how various options 
should be set. There is currently only one option to set. This option allows the user to select 
if transactions should be created for loads that are in different areas than their terminal 
buses.  

Loads may be assigned to a different area than the load’s terminal bus. PTI offers an option 
that allows the user to ignore this assignment when calculating the tie-line flow for an area.  

(AREA INT CODE = 1 FOR LINES ONLY) 

(AREA INT CODE = 2 FOR LINES AND LOADS) 

Simulator does not allow you to define a load this way and then choose to ignore it. Most 
RAW files that PowerWorld has seen seem to be solved ignoring the loads that are in 
different areas than their terminal bus by using the "lines only" option. To overcome this, 
when PowerWorld reads a RAW file, MW Transactions can be automatically created with the 
ID "RAW_LOAD". These transactions are between the load’s area and its terminal bus and 
are created so that the export from each area correctly matches a case solved using "lines 
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only". If you know that your case was solved using "lines and loads", then do not choose to 
add the transactions when prompted. See the topic Add and Remove transactions due 
to tie-line loads with File Management Options for more information about adding or 
removing these transactions after the case has been loaded. 

If not loading the RAW file with options, the transactions representing loads that are in 
different areas than their terminal buses will be automatically created. 

GE PSLF Format (*.epc) 

This format is included primarily for importing load flow data saved from GE's PSLF program. 
The EPC format is a text file format. This format does contain excess information that 
Simulator does not use, however Simulator does store this information for editing and 
writing back out to EPC format files. 

GE PSLF Format (*.epc) (with options) 

This format is the same as the GE PSLF Format except that the GE EPC File Load Options 
dialog will be opened to allow user input for various options.  

IEEE Common Format (*.cf) 

The IEEE Common Format is used to specify only power flow information. CAUTION: IEEE 
common format does not support many of the formats used in the PowerWorld packages, 
such as multiple loads and generators at a bus. Usually, IEEE Common Format is used only 
for inputting cases.  

PowerWorld Simulator Project Files (*.pwp) 

Project files are described in Overview of PowerWorld Simulator Project Files. 

  

Advanced settings for opening cases are available under the File Management settings. 
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GE EPC File Load Options 

The GE EPC File Load Options dialog will open when choosing to open or save a GE EPC case 
"with options".  

  

 
  

EPC File Version 

Set this to determine what version of the EPC file is being read or saved. 

What To Do With Multi-Section Lines 

Assumed Generator Var Limit Deadband 

GE Base Load Flag Setting 

When opening a file, the GE Base Load Flag setting will be used to set the Post-CTG Prevent 
AGC Response field in Simulator. The caption will be the following: if GE Base Load Flag > 
0, then Post-CTG Prevent Response = YES, else Post-CTG Prevent Response = NO 

When saving a file, the Post-CTG Prevent AGC Response field in Simulator will be used to set 
the Base Load Flag setting in the EPC file. The caption will be the following: if Post-CTG 
Prevent Response = YES, then set GE Base Load Flag = 1, else set GE Base Load 
Flag = 0 

Filter By 
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Validating a Case 

  

Validation checks for both errors that would prevent a case from working properly in Simulator 
and for abnormal setup of model objects. Validation errors and warnings are displayed in the 
Message Log. A sampling of the tasks performed during case validation include: 
• Ensures there is a system slack bus assigned 
• Ensures the slack bus has an attached generator 
• Ensures that no generator is assigned to remotely regulate the slack bus 
• Checks for buses having multiple controllable devices attached (i.e. switched shunts) 
• Checks all max/min enterable fields to ensure that the max value is greater than the min 

value 

Case validation is performed automatically when switching from Edit Mode to Run Mode. If a 
case has validation errors, Simulator will not allow the user to switch to Run Mode. Warnings 
will not prevent switching to Run Mode.  
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Opening a Simulation Case 

  

The most common first step in using Simulator is to open a case. When a case is opened, any 
associated oneline files are also opened. To open a case, either select it from the list of 
recently opened cases  in the file menu or  
• Select Open Case from the Application Button to display the Open Dialog. 
• In the Type of Files box, select the desired file type. By default, the PowerWorld Binary 

type is selected (*.PWB). The PowerWorld Binary is the preferred file type, providing the 
most comprehensive power system information along with the smallest size and quickest 
load time. Other file types include the PowerWorld Case type, PowerWorld Auxiliary file, 
PTI Raw Data formats, GE EPC text format, and IEEE Common Format. Please see Case 
Formats for more details.  

• In the list of cases, click on the desired case.  
• Click OK.  

When opening an existing Simulator case, you may see one or more oneline diagrams pop up. 
When opening a power flow case created with another program, a oneline may not be 
available. However, you can easily create a oneline for such a case using the Edit Mode.  

If you are in the Edit Mode, you can modify the case. See Edit Mode Overview for details.  

If you are in the Run Mode, the Clock Window may be displayed. This window shows the 
simulation start time, end time and current time. You may choose to close or open the clock at 
any time. 

If the case has validation errors, the mode is immediately switched to Edit Mode. You must 
correct the validation errors shown in the message log before you can use the Run Mode to 
solve the case.  



Creating, Loading, and Saving Simulator Cases 

131 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Opening a Oneline Diagram 

  

Simulator supports oneline diagrams that have been developed using its Edit Mode tools. 
PowerWorld can also import PTI Draw Files (*.drw).  

When a case is opened, any associated onelines are usually opened, as well. Additionally, 
oneline diagrams can be opened directly from any existing onelines using oneline links. 
However, you may also directly open a oneline diagram using the following procedure: 
• Select Open Oneline from the Application Button. 
• Choose the file type you would like to open (One Line Display File, PTI Draw File, or 

Display Auxiliary File). 
• In the list of available oneline files, click on the desired oneline. 
• Click OK.  

You may open as many onelines as you like, and even multiple copies of the same oneline.  

The following topics may be helpful when opening onelines created with a different case: 
  

Refresh Anchors 

Bus Renumbering Dialog 
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Recently Opened Cases 

  

A numbered list of the most recently opened cases appears in the Recent Files list when you 
click on the Application Button. Simply choose a case from the list to open the case.  



Creating, Loading, and Saving Simulator Cases 

133 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Building a New Case 

  

To create a new case in Simulator, select New Case from the application file menu. After 
asking you whether or not to save the current working case (if one exists), Simulator will 
automatically switch to Edit Mode. The screen will turn to the default background color, 
indicating that you can begin to build the new case. 

New users may wish to view the tutorial Creating a New Case from Scratch for further 
guidance. 
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Building a New Oneline 

  

This option enables you to create a new oneline diagram. It is accessible from either the Edit 
or Run modes by choosing New Oneline from the application file menu. When you select it, 
the application will automatically switch to Edit Mode, from which you can construct the new 
oneline. 

New users may wish to view the tutorial Creating a New Case from Scratch for further 
guidance. Additionally, the following topics may be of some assistance: 
  

Using the Insert Palettes 

Oneline Conditional Display of Objects 

Using the Oneline Alignment Grid 
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Saving Cases 

  

Simulator allows users to save case information in several different formats. To call up the 
Save As dialog, select Save As from the Application Button. The format in which the file 
will be saved depends upon the value of the Save as Type field of the dialog. Simulator can 
save cases in PowerWorld binary format (the default), PowerWorld Auxiliary file format, PTI 
raw data, GE PSLF format, and the IEEE common format. Please see Case Formats for more 
details on the various case formats available. 
 To convert a case to a different format, follow this procedure:  
• Select Open Case from the Application Button. 
• In the Files of Type box, select the desired file type. By default, the PowerWorld Binary 

type is selected (*.PWB).  
• Select the name of the desired case and click OK.  
• Select Save Case As from the Application Button. 
• Change the Save as Type setting to match the desired file type, designate the name with 

which to save the file, and click OK. 

To simply save the case with its current name and format, select either Save from the 
Application Button or the Save Case button on the Quick Access toolbar. 
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Saving a Oneline 

  

Select Save Oneline from the Application Button to save the currently selected oneline file. 

Select Save Oneline As from the Application Button to save the currently selected oneline file 
with a different name or format. You may overwrite existing files.  

For both the Save Oneline and Save Oneline As options, only the oneline diagram is saved; the 
case (i.e. the power flow model) is not written to disk. 
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Close Oneline 

  

To close a oneline diagram, select to Close Oneline from the Application Button, or right-click 
on the background of the oneline diagram and select Form Control > Close from the local 
menu. This will prompt you to save the oneline if changes have been made since the last save. 
Note that this does not close the current case, just the oneline diagram. The power system 
data is still loaded, and case simulations can be run with the oneline closed. 

 



Creating, Loading, and Saving Simulator Cases 

138 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Auxiliary File Format (*.aux) 

  

Simulator Auxiliary Files have now been greatly enhanced to include both Script sections for 
running Simulator commands in a "batch" process, and Data sections for changing mass 
amounts of load flow information. Many auxilliary file formats used in early versions of 
Simulator can not be saved in current versions. The older formats can still be read into 
Simulator.  

Auxiliary file format and use now has its own help chapter titled Auxiliary Script/Data Files. 

javascript:RelatedTopic1.Click()�
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Generator Capability Curves Format (*.gcp) 

  

These files are outdated for Simulator version 8.0 and later. Their descriptions are still 
maintained here as they can still be read into Simulator. However, they can no longer be 
saved. These records are now stored in Auxiliary Script/Data Files. 

The generator capability curves are used to model the dependence of the generator reactive 
power limits and the generator’s real power output. The generator reactive capability curves 
files have the following format, with one generator per line: 
  

num or name, ID, P1, Q1,max,Q1,min, P2, Q2,max, Q2,min ... Pn, Qn,max, Qn,min 

where 

num/name the generator’s bus number or the bus’ name in single quotes,  

ID  the generator’s single character id,  

Pi  a generator MW output value,  

Qi,max and Qi,min  the associated maximum and minimum reactive power limits.  

Version 11 and later of Simulator allow for an unlimited number of capability curve points to 
be read from the gcp file. Up to 10 different P/Qmax/Qmin values may be specified in older 
versions of Simulator. 
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Generator Cost Data Format (*.gcd) 

  

These files are outdated for Simulator version 8.0 and later. Their descriptions are still 
maintained here as they can still be read into Simulator. However, they can no longer be 
saved. These records are now stored in Auxiliary Script/Data Files. 

The generator cost data file contains the parameters used to model the generator operating 
costs. Each record in the generator cost data file specifies the operating cost model for a 
single generator. The cost model may be either a cubic polynomial or a piecewise linear curve. 
When reading a file of generator cost data records, Simulator will open the Cost Curve Data 
Options Dialog. This dialog gives you additional control over the input and process of 
generator cost information. 
  

Each generator cost data record begins with the fields  

num or name, ID, 

where 

num/name  the generator’s bus number or the bus’ name in single quotes,  

ID  the generator’s single character id, 

Following the ID field is an optional single-character field CostModel that specifies the type of 
cost model. If CostModel is ‘CUBIC’ or is not specified, the record describes a cubic cost 
model and thus concludes with the following fields: 

 ai, bi, ci, di, FuelCost ParFac 

where 

ai, bi, ci, di input-output curve coefficients; see Generator Cost Information  for details, 

fuelcost fuel cost, expressed in price per Mbtu, 

ParFac generator participation factor. 

If, on the other hand, CostModel is ‘PLIN’, the record describes a piecewise linear cost 
model. The remainder of the record specifies pairs of generator output and corresponding 
generator cost: 

 FixedCost MW1 IncCost1 MW2 IncCost2 … MWn IncCostn MWneg ParFac 

where 

FixedCost Operation cost independent of the generator’s MW output; expressed in 
$/Hr, 

MWi, IncCosti  Output/incremental cost data point pairs that define the incremental 
cost model for the generator (note IncCosti has the units $/MWhr),  

MWneg An arbitrary negative value used to terminate the record, 

ParFac generator participation factor. 
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Generator Cost Curve Data Options 

  

The Cost Curve Data Options Dialog gives you additional control over the input and 
processing of generator cost information. It appears when you try to read generator cost 
information from an auxiliary data file (either .aux or .gcd). 

To command Simulator to turn all units onto automatic generation control (AGC) for which it 
reads a cost data record, check the first checkbox. This box has the rather lengthy label "If a 
unit for which a cost curve is read is not on AGC, Simulator should set it on AGC." In other 
words, if a cost curve is read for a particular generator, that generator will be set on AGC if 
this box is checked. 

Cross-compound is a generator architecture sporting a single boiler and two turbines, one 
operating at high pressure and the other operating at low pressure. The existence of cross-
compound units may complicate the modeling of generator cost characteristics, because 
sources for this information tend to describe the cost associated with the tandem, whereas 
Simulator’s economic dispatch will try to dispatch the two parts of the cross-compound unit as 
two separate units. To address this problem, Simulator gives you the option to lump the 
properties of the high- and low-pressure turbines into a single unit. It consolidates the two 
components by adding together their maximum MW outputs, minimum MW outputs, and 
present output levels, assigning these quantities to one of the units, and setting the other unit 
off AGC and at 0 MW of output. To have Simulator perform this function for you, check the 
box in the Cross Compound Units panel. 

To tell Simulator how to identify units that belong to the same cross-compound generator, 
click the box labeled "How To Identify…". This will open the How to Identify Cross-Compound 
Units dialog. 
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Identify Cross Compound Units 

  

Simulator regards cross-compound units as those that are connected to the same bus and that 
have generator id’s that match any of a number of specified pairs. You must define for 
Simulator the pairs of generator id’s that should be used to identify cross-compound units. Use 
the "How to identify cross-compound units" dialog to do this. 

Specify the pair of generator id’s in the small text boxes below the text labeled "Specify a new 
pair of id’s that identify two units that belong to the same cross-compound set." Then, click 
the Add button to include the pair of id’s you just entered in Simulator’s cross-compound 
identification procedure. The box on the right lists all the pairs of identifiers Simulator will use 
to identify parts of a cross-compound set. To remove a pair of identifiers from this list, select it 
from the box and click the Delete key. 

The list of cross-compound identifier pairs is stored in the pwrworld.ini file, so there is no need 
to specify these pairs each time you load in a new case. 
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Injection Groups Format (*.inj) 

  

These files are outdated for Simulator version 8.0 and later. Their descriptions are still 
maintained here as they can still be read into Simulator. However, they can no longer be 
saved. These records are now stored in Auxiliary Script/Data Files. 

The injection group files store the information for defined injection groups (also referred to as 
participation groups). The files have the following format: 
  

 GROUP groupname 

 POINTS 

 Devtype busnum id participation pointtype 

 . 

 . 

 . 
 END 

where 

groupname the name of the injection group, in single quotes, 

devtype either GEN or LOAD, 

busnum bus number of the device, 

id the device’s single character ID, 

participation relative amount each device will contribute during a transfer, 

pointtype either FIXED or DYNAMIC. 

Multiple GROUP sections can be put in the file, each marked with END to signify the end of 
that group’s data. 
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Interface Data Format (*.inf) 

  

These files are outdated for Simulator version 8 and later. Their descriptions are still 
maintained here as they can still be read into Simulator. However, they can no longer be 
saved. These records are now stored in Auxiliary Script/Data Files. 

The interface data files store the interface data. The files have the following format: 
  

 INTERFACE intname lima limb limc 

 Elemtype from to id checktoend fromto 

 . 

 . 

 . 
where 

intname the interface name, in single quotes, 

lima, limb, limc the three limits for the interface, in MW, 

elemtype one of three valid element types: AREA, LINE, or ZONE 

from for AREA and ZONE, the first area or zone number; for LINE, the from bus 
number, 

to for AREA and ZONE, the second area or zone number; for LINE, the to bus number, 

id only included for LINE, the two character circuit identifier; otherwise left blank, 

checktoend only included for LINE, if this field equals 1, the flow is checked at the to 
bus, otherwise the flow is checked at the from bus; otherwise left blank, 

fromto only included for LINE, if this field equals 1, the positive flow is assumed to be 
from the from bus to the to bus, otherwise the flow is assumed to be in the opposite 
direction; otherwise left blank. 

Multiple interface records can be listed in the file, and multiple interface elements can be listed 
in each interface record. 
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Sequence Data Format 

  

The sequence data files store the sequence data needed to run a fault analysis. The sequence 
data format has the following five different types of records: 
• Generator 
• Load 
• Branch 
• Switched Shunt 
• Mutual Impedance 

Each of these four types of sequence data records has a different format, since they each 
store different information for the sequence data. The format of each record is given below: 
  

Generator 

GEN busnum ID Rpos Xpos Rneg Xneg Rzer Xzer RN XN 

where 

busnum generator terminal bus, 

id generator identifier, 

Rpos, Xpos positive sequence resistance and reactance, 

Rneg, Xneg negative sequence resistance and reactance, 

Rzer, Xzer zero sequence resistance and reactance, 

RN, XN neutral-to-ground resistance and reactance. 

  

Load 

LOAD busnum Gneg Bneg Gzer Bzer 

where 

busnum load terminal bus, 

Gneg, Bneg negative sequence total conductance and susceptance for all loads at bus, 

Gzer, Bzer zero sequence total conductance and susceptance for all loads at bus. 
  

Branch 

BRANCH fbusnum tbusnum ckt Rzer Xzer Czer fGzer fBzer tGzer tBzer Xftype 

where 

fbusnum, tbusnum from and to bus numbers for the branch, 

ckt branch circuit identifier, 

Rzer, Xzer zero sequence branch resistance and reactance, 

Czer total zero sequence line charging, 

fGzer, fBzer zero sequence line shunt conductance and susceptance at the from bus 
end of the branch, 

tGzer, tBzer zero sequence line shunt conductance and susceptance at the to bus end 
of the branch, 
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Xftype Transformer configuration, entered as an integer based on the following table. 
Note that the default for a transmission line is 3, since a grounded wye - grounded wye 
transformer connection has the same equivalent model as a transmission line. 

 0 Wye - Wye 

 1 Grounded Wye - Wye 

 2 Wye - Grounded Wye 

 3 Grounded Wye - Grounded Wye 

 4 Wye - Delta 

 5 Delta - Wye 

 6 Grounded Wye - Delta 

 7 Delta - Grounded Wye 

 8 Delta - Delta 

  

Switched Shunt 

SSHUNT busnum numblocks Bzer1 Bzer2 … 

where 

busnum terminal bus number, 

numblocks number of different zero sequence admittance blocks, 

Bzer# zero sequence susceptance for each admittance block, maximum of 8. 

  

Mutual Impedance 

MUTIMP from1 to1 ckt1 from2 to2 ckt2 RM XM start1 end1 start2 end2 

where 

from1, to1 from and to bus numbers of the first mutually coupled branch, 

ckt1 circuit identifier of the first mutually coupled branch, 

from2, to2 from and to bus numbers of the second mutually coupled branch, 

ckt2 circuit identifier of the second mutually coupled branch, 

RM, XM zero sequence mutual resistance and reactance, 

start1, end1 start and end locations of the section of the first line affected by the 
mutual coupling, with each point represented as a percentage of the total line length 
(between 0 and 1), 

start2, end2 start and end locations of the section of the second line affected by the 
mutual coupling, with each point represented as a percentage of the total line length 
(between 0 and 1). 
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Exporting Onelines in Different Graphic Formats 

  

Simulator can export oneline diagrams and other graphical displays as bitmaps, metafiles, or 
jpegs. Select Export Oneline from the Application Button. A save file dialog appears where 
the dropdown menu for files type offers three choices: JPEG, BITMAP, METAFILE. Select the 
file type and choose he name before clicking the save button. 

Exporting an image as a jpeg also requires you to set the compression ratio for the picture. 
See Saving Images as Jpegs for more information. 
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Saving Images as Jpegs 

  

Simulator can save oneline diagrams, bus view displays, and strip charts as jpeg images. To 
save a oneline diagram or bus view display as a jpeg, select Export Oneline from the 
Application Button. This brings up the save file dialog. Choose jpeg as the file type, type the 
file name, and press save. This brings up the Jpeg Options Dialog where you decide the 
picture's resolution. Adjust the resolution control to specify the compression ratio at which to 
save the diagram as a jpeg. The greater the resolution you specify, the larger the resulting file 
will be. Click Save to save the image or click Cancel to terminate the process without saving 
the image as a jpeg. 

To save a strip chart as a jpeg image, right-click on the background of the strip chart and 
select Export Image from the resulting local menu. This brings up the save file dialog. 
Choose jpeg as the file type, type the file name, and press save. Specify the 
compression/resolution in the Jpeg Options Dialog. Click Cancel to terminate the process, or 
click Save to save the jpeg. 
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Saving Admittance Matrix and Jacobian Information 

  

The Save Ybus or Power Flow Jacobian  Dialog is used to store the power system bus 
admittance matrix (Ybus) and/or the power flow Jacobian in a text format that can be easily 
read into other programs such as MATLAB®. This dialog is primarily designed for users doing 
power system analysis research. The dialog has the following fields. 

Ybus in MATLAB Format 

Filename for Saving Ybus 

Enter the name of the file in which to store the Ybus data. The Ybus data is stored using the 
MATLAB sparse matrix format in the matrix Ybus. If the Include Bus Voltages field is 
checked, then the bus voltages are also stored, but in the vector V.  

Save Ybus in MATLAB Format 

Click this button to save the Ybus. 

Power Flow Jacobian in MATLAB Format 

Jacobian Save File 

Enter the name of the file in which to store Jacobian data. The Jacobian is stored using the 
MATLAB sparse matrix format in the matrix Jac.  

Jacobian ID Save File 

Enter the filename to store the text identifier information. This information is used to 
translate the bus numbering convention used in the Jacobian and Ybus files with the actual 
bus number and name in the case. 

File Type 

Choose the type of MATLAB file you wish to save as. The MATLAB .M Format is the more 
common text format used for directly loading MATLAB information. The Text for MATLAB 
Ascii is for use with MATLAB’s ability to read Ascii files. The Ascii file type can be read into 
MATLAB much faster than the traditional .M files.  

Jacobian Form 

Select Rectangular to store the rectangular form of the Jacobian, or Polar to store the 
polar form of the Jacobian. 

Save Jacobian 

Click this button to save the Jacobian and object identifier information.  
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Chapter 4: Building a Oneline Diagram 

  

The oneline objects provide a key means of interacting with the power flow simulation. This 
chapter provides a reference on how to insert each of the different types of objects shown on 
the oneline diagram, and an overview of Edit Mode. Note that when you are using the 
Simulator, you can obtain context sensitive help for oneline objects by positioning the cursor 
on the desired object and pressing the F1 key.  

The following material is included: 
• Edit Mode Overview 
• Areas, Zones and Owners  
• Buses 
• Substations 
• Generators 
• Loads 
• Transmission Lines 
• Transformers 
• Series Capacitors 
• Switched Shunts 
• Interfaces 
• Oneline Links 
• Background Objects and Text 
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Edit Mode Overview  

  

The Edit Mode is used to create and/or modify cases and onelines. You can use the Edit Mode 
to create a case from scratch or to modify existing power flow cases stored in PowerWorld 
PWB or AUX files, in the PTI Raw data format, GE PSLF EPC data format, or the IEEE Common 
Format. New users may wish to view step-by-step tutorials on either 

Creating a New Case from Scratch 

Creating Onelines for an Existing Power Flow Case. 

To enter the Edit Mode, select the Edit Mode button in the Mode ribbon group on any of the 
ribbon tabs. 

A powerful capability of the Simulator is its ability to a case by graphically placing/editing on a 
oneline diagram. These display objects consist of both power system devices, such as buses, 
generators, and transmission lines; and that show various system parameters, provide 
descriptive text, or function as a static background.  

Simulator’s oneline diagrams illustrate the current state of the components of the power 
system. Most display objects correspond to records in the underlying power system model, but 
not all records in the power system model need to have an associated display object. In fact, 
for large system models, it may be that most of the system will not be illustrated. In such 
cases, you will want to devote more detail to the more critical areas of the system so as not to 
clutter the view. Furthermore, it is possible to associate more than one oneline with a single 
power flow case, and a single oneline may be associated with multiple cases. This great 
flexibility can prove to be a big time-saver. Please see Relationship Between Display Objects 
and the Power System Model for a more thorough discussion.  

 



Building a Oneline Diagram 
 

152 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Edit Mode General Procedures  

  

In order to simplify the process of graphically constructing a power flow case, Simulator’s 
drawing interface obeys the following conventions for most objects: 
  

Inserting a New Object  

• Go to the Draw ribbon tab and use the menus on the Error! Hyperlink reference not 
valid. ribbon group to add a single oneline object type you would like to add to the 
oneline.   

• Left-click on the location on the display where you would like to position the object. 
• Once the object is placed, Simulator displays a dialog box that allows you to specify 

various options for the object.  
• If desired, use   all the options available on the Formatting ribbon group on the Draw 

ribbon tab to change the appearance of the object once it has been placed.  

Moving, Resizing, and Rotating an Existing Object 

• Select the object by clicking on the object with the left mouse button. Handles are 
displayed around the object to indicate it has been selected.  

• To move the position of the object, place the mouse anywhere on the object except at a 
handle location. Then drag the object around the screen by holding the left mouse button 
down.  

• To change the size of an object using the mouse, first select the object. Then place the 
mouse on one of the object’s resizing (white) handles. The cursor will change to either a 
horizontal, vertical or diagonal two-headed arrow shape. Then drag the mouse to change 
the object’s size. You can also specify the size of most objects using their dialog boxes.  

• To rotate an object, first select the object. Then place the mouse over the rotation (green) 
handle in the upper left corner of the selected object. The cursor will change to a rotation 
symbol. Clicking and dragging will then rotate the object. Note that if an object (e.g., a pie 
chart or transmission line) does not have a rotation handle in the upper left, the object 
cannot be rotated.  

Viewing/Modifying Object Parameters 

• To view and/or change the options associated with a single object, right-click on the 
object. This either displays the object’s dialog box directly, or it display’s the object, from 
which you can elect to see the object’s dialog box. 

Selecting Several Objects to Modify Their Appearance 

Hold down the Shift key while clicking objects on the screen to select several objects at 
once. You may then change the objects’ attributes, such as , by using all the options 
available on the Formatting ribbon group on the Draw ribbon tab. 

 To move the objects that are selected, click and hold down the left mouse button on any of 
the selected objects, drag the selected objects to a new location, and release the mouse 
button to place them. You can also move the selected objects by holding the SHIFT key and 
simultaneously using the UP, DOWN, LEFT, or RIGHT arrow keys (or use the Home, End, 
Page Up and Page Down keys to move objects). 

To select a set of objects use the many options available on the Select ribbon group on the 
Draw ribbon tab to select a group of objects using a rectangle, ellipse or polygon selector. 
You can also select only objects that meet some given criteria by using Select by Criteria. As 
an example, you can use Select By Criteria to select all the 345 kV transmission lines in a 
case. See Select ribbon group for more detailed help. 

Changing An Object’s Screen Appearance 
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Use all the options available on the Formatting ribbon group on the Draw ribbon tab to 
change the screen appearance of either a selection of objects or the entire display. 
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Draw Ribbon Tab 

  

The Draw ribbon tab is primarily used to draw new oneline diagrams or edit existing onelines 
by adding, moving, formatting, or resizing existing oneline objects. Most of the options on the 
Draw ribbon tab are only available in Edit Mode. The Draw ribbon tab is shown below. 

 
   

The Draw ribbon consists of seven ribbon groups described as follows 

Mode Ribbon Group 

Edit Mode 

Switches the program to Edit Mode, which can be used to build a new case or to 
modify an existing one. 

Run Mode 

Switches the program to Run Mode, which can be used to perform a single Power 
Flow Solution or a timed simulation with animation. 

Quick Insert Ribbon Group 

The Quick Insert ribbon group contains buttons for creating a oneline diagram for a 
system model you have already read into Simulator. If you are building out your 
network (or even substation, area, or zone diagram), then using the Insert Palettes 
along with the Auto Insert routines is most efficient. For detailed help see the Quick 
Insert ribbon group. If you would instead like help on inserting a single object on your 
oneline diagram see the see the Individual Insert ribbon group topic. 

Individual Insert Ribbon Group  

The Individual Insert ribbon group contains menus which provide access to buttons for 
inserting individual oneline objects to the oneline diagram. If you are building out your 
network (or even substation, area, or zone diagram), then it is much more efficient to 
use the Quick Insert ribbon group. However, for complete access to all objects including 
those that can not be "quick - inserted", see the help under the Individual Insert ribbon 
group topic. 

Select Ribbon Group  

The Select ribbon group contains options to help select multiple oneline objects 
simultaneously. For more detailed help see the Selection ribbon group topic for more 
detailed help. 

Formatting Ribbon Group 

The Format ribbon group contains options for formatting the selected objects on your 
active oneline. For more detailed help see the Formatting ribbon group topic for more 
detailed help. 

Clipboard Ribbon Group 

The Clipboard ribbon group contains options for copying and pasting oneline display 
objects. For more detailed help see the Clipboard ribbon group topic for more detailed 
help. 
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 Zoom Ribbon Group 

The Zoom ribbon group contains buttons for navigating a oneline diagram. For more 
detailed help see the Zoom ribbon group topic 
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Oneline Display Options 

  

The Oneline Display Options Dialog allows you to customize the appearance of the presently 
selected oneline diagram. To view this dialog, either select Oneline Display Options from 
the Oneline Options ribbon group on the Options ribbon tab, or choose Oneline Display 
Options from the oneline’s local menu . Please see the Oneline Display Options Dialog help 
for more information.  
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Anchored Objects 

  

While in Edit Mode, Simulator allows certain objects to be attached, or anchored, to another 
object, called the anchor. When an object that functions as an anchor is moved, all objects 
that are anchored to it will move with it. This feature can be very useful when you move 
objects around the oneline diagram in Edit Mode.  

Anchoring has the property of "stacking" in Simulator. In other words, one object is anchored 
to another, which is in turn anchored to yet another. The best way to describe this is by 
example. A generator text field can be anchored to a generator. The generator, in turn, can be 
anchored to its terminal bus. If you move the terminal bus, both the generator and its 
anchored fields also move with the bus. However, if you just move the generator itself, only 
the generator fields will move with it. The bus and all other objects anchored directly to the 
bus remain in their original location. 

If anchors are deleted it is generally necessary to reset anchors on anchored objects go to the 
Draw ribbon tab and choose Refresh Anchors on the Formatting ribbon group. 

There are several types of anchored objects: 

Buses 

Loads, generators, switched shunts, bus fields, interfaces, transformers, transmission lines 
and voltage gauges may be anchored to their associated bus. When the anchor bus is 
moved, these anchored objects will move with it. 

Substations 

Similar to buses, any loads, generators, switched shunts, bus fields, interfaces, 
transformers, and transmission lines may be anchored to their associated substations. When 
the anchor substation is moved, these anchored objects will move with it. 

Generators 

Generator fields may be anchored to their associated generator. When the anchor generator 
is moved, these anchored fields will move with it. 

Loads 

Load fields may be anchored to their associated load. When the anchor load is moved, these 
anchored fields will move with it. 

Switched Shunts 

Switched shunt fields may be anchored to their associated switched shunt. When the anchor 
switched shunt is moved, these anchored fields will move with it. 

Area/Zone/Super Area Objects 

Interfaces can be anchored to area/zone/super area objects.  

Lines and Transformers 

Circuit breakers, line flow pie charts, and line fields may be anchored to their associated 
line/transformer. When the line/transformer is moved, these anchored objects will move 
with it.  

Interfaces 

Interface fields and interface pie charts can be anchored to their associated interface.  
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Inserting and Placing Multiple Display Fields 

  

Simulator provides a convenient method of adding display fields to a variety of oneline display 
objects and placing them in default positions relative to the display object. Unlike the field 
placement implemented by selecting Field from the Individual Insert ribbon group on the 
Draw ribbon tab, the method described here allows you to place multiple fields around a 
display object in a single operation. This option is available for several different types of 
objects, including buses, generators, lines and transformers, shunts, and loads. The option can 
always be accessed by right clicking the display object of interest and selecting the Add New 
Fields Around … option from the resulting local menu. This brings up the Insert New 
Fields around Selected Objects Dialog. This dialog is divided into several tabs by object 
type. Only tabs that correspond to the type of objects you have selected will be available. 

The tabs for inserting and placing multiple display fields for the various display objects (buses, 
generators, lines/transformers, shunts, and loads) are virtually identical in content. The tab 
illustrates the possible locations of the display fields for the various orientations of the display 
object. For example, since buses may be oriented either horizontally or vertically, the dialog 
shows how each of the eight possible bus fields would be positioned for each of the two 
orientations. Generators, loads, and shunts each have four possible orientations, so the dialog 
identifies the locations for the possible fields for each of the four orientations. Transmission 
lines and transformers can assume only one orientation, and the dialog will thus show the 
possible field locations for that single orientation. 

Each field location is identified on the illustrations with a label of the form Pos #. In order to 
modify the settings, move your mouse over the position on the dialog you want to change and 
click. This will bring up the appropriate Field Options Dialog such as the Bus Field Options, 
Generator Field Options, Load Field Options, Switched Shunt Field Options, or the Line Field 
Options. Simply select the field you want and choose OK. If you would like to set a default 
field to "none", click Remove Field instead of OK.  

Click OK to implement your choices for field additions and placement, or click Cancel to 
discard the changes. 

This help topic has gone over how to add new fields to existing display objects. It should be 
noted from this discussion that all objects have an associated set of default fields that will be 
added to the oneline when the objects are originally inserted. You may redefine the default 
fields selecting Default Drawing Values from the Quick Insert ribbon group on the Draw 
ribbon tab and modifying the Default Drawing Options Dialog.  
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Area Display Objects 

  

Area records in the load flow data can be displayed as objects on a Simulator oneline diagram. 
This can be useful for building a diagram on which you also want to include representations of 
groups of devices by area. 

To insert an Area object, select Aggregation > Area from the Individual Insert ribbon group 
on the Draw ribbon tab. Then left-click on a oneline diagram in the location where the Area 
object should be placed. This will open the Area Display Options dialog, which will allow you to 
choose the area information to display, and set parameters for the displayed object. It is 
important to note that area records, unlike other objects like buses and transmission lines, 
cannot be added to the load flow data graphically. To add a new area record to the load flow 
case, you need to change the area designation of a device in the load flow case to a new area 
number, or you need to insert a new area from the Area Records. 

Area objects can also be added by using the Area insert palette. 
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Area Display Options Dialog 

  

When you insert an area display object on a oneline diagram, Simulator opens the Area 
Display Options dialog. This dialog is used to control various display and identity attributes of 
the area display object. The dialog contains the following fields: 
  

Number 

This dropdown box lists the number of all areas in the case. Use this control to associate the 
display object with the correct area. 

Name 

If you would prefer to search through areas by name rather than by number, use the Name 
dropdown box to see a list of names of all the areas in the case. 

Show Record Type Prefix 

Check this box if you wish to place the prefix Area before the name/number caption in the 
object. 

Prefix Text 

Specify additional prefix text to be added before the Record Type prefix. 

  

The remainder of the choices presented on the Area Display Options dialog pertain to the 
object’s display appearance. 

Style 

Choose whether the display object should appear as a rectangle, rounded rectangle, or an 
ellipse. 

Caption 

Indicate how the display object should be identified to the user: by name, number, or both. 

Width, Height 

The dimensions of the new display object. 

Click OK to save your selections and add the object to the oneline, or choose Cancel to 
terminate the addition. 
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Zone Display Objects 

  

Zone records in the load flow data can be displayed as objects on a Simulator oneline diagram. 
This can be useful for building a diagram on which you also want to include representations of 
groups of devices by zone. 

To insert a Zone object, select Aggregation > Zone from the Individual Insert ribbon group 
on the Draw ribbon tab. Then left-click on a oneline diagram in the location where the Zone 
object should be placed. This will open the Zone Display Options dialog, which will allow you 
to choose the zone information to display, and set parameters for the displayed object. It is 
important to note that zone records, unlike other objects like buses and transmission lines, 
cannot be added to the load flow data graphically. To add a new zone record to the load flow 
case, you need to change the zone designation of a device in the load flow case to a new zone 
number, or you need to insert a new zone from the Zone Records. 
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Zone Display Options Dialog 

  

When you insert a zone display object on a oneline diagram, Simulator opens the Zone Display 
Options dialog. This dialog is used to control various display and identity attributes of the zone 
display object. The dialog contains the following fields: 
  

Number 

This drop down box lists the number of all zones in the case. Use this control to associate 
the display object with the correct zone. 

Name 

If you would prefer to search through zones by name rather than by number, use the Name 
drop down box to see a list of names of all the zones in the case. 

Show Record Type Prefix 

Check this box if you wish to place the prefix Zone before the name/number caption in the 
object. 

Prefix Text 

Specify additional prefix text to be added before the Record Type prefix. 

  

The remainder of the choices presented on the Zone Display Options dialog pertain to the 
object’s display appearance. 

Style 

Choose whether the display object should appear as a rectangle, rounded rectangle, or as 
an ellipse. 

Caption 

Indicate how the display object should be identified to the user: by name, number, or both. 

Width, Height 

The dimensions of the new display object. 

Click OK to save your selections and add the object to the oneline, or choose Cancel to 
terminate the addition. 

 



Building a Oneline Diagram 

163 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Super Area Display Objects 

  

Super area records in the load flow data can be displayed as objects on a Simulator oneline 
diagram. This can be useful for building a diagram on which you also want to include 
representations of groups of devices by super areas. 

To insert a Super Area object, select Aggregation > Super Area from the Individual Insert 
ribbon group on the Draw ribbon tab. Then left-click on a oneline diagram in the location 
where the Super Area object should be placed. This will open the Super Area Display Options 
dialog, which will allow you to choose the super area information to display, and set 
parameters for the displayed object. It is important to note that super area records, unlike 
other objects like buses and transmission lines, cannot be added to the load flow data 
graphically. To add a new super area record to the load flow case, you need to insert a new 
super area from the Super Area Records. 
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Super Area Display Options Dialog 

  

When you insert a super area display object on a oneline diagram, Simulator opens the Super 
Area Display Options dialog. This dialog is used to control various display and identity 
attributes of the super area display object. The dialog contains the following fields: 
  

Number 

This field is unused for super area objects. Super areas are identified by a unique super area 
name instead. 

Name 

Use the Name dropdown box to see a list of names of all the super areas in the case. 

Show Record Type Prefix 

Check this box if you wish to place the prefix Super Area before the name/number caption 
in the object. 

Prefix Text 

Specify additional prefix text to be added before the Record Type prefix. 

  

The remainder of the choices presented on the Super Area Display Options dialog pertain to 
the object’s display appearance. 

Style 

Choose whether the display object should appear as a rectangle, a rounded rectangle, or an 
ellipse. 

Caption 

Indicate how the display object should be identified to the user: by name, number, or both. 

Width, Height 

The dimensions of the new display object. 

Click OK to save your selections and add the object to the oneline, or choose Cancel to 
terminate the addition. 
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Owner Display Objects 

  

Owner records in the load flow data can be displayed as objects on a Simulator oneline 
diagram. This can be useful for building a diagram on which you also want to include summary 
objects by owner, in which information about the generation and load of the owner are 
indicated with the object. 

To insert an Owner object, select  Aggregation > Owner from the Individual Insert ribbon 
group on the Draw ribbon tab. Then left-click on a oneline diagram in the location where the 
owner object should be placed. This will open the Owner Display Options dialog, which will 
allow you to choose the owner information to display, and set parameters for the displayed 
object. 
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Owner Display Options Dialog 

  

When you insert an owner display object on a oneline diagram, Simulator opens the Owner 
Display Options dialog. This dialog is used to control various display and identity attributes of 
the owner display object. The dialog contains the following fields: 
  

Number 

The owner number. 

Name 

The owner name. 

Show Record Type Prefix 

Check this box if you wish to place the prefix Owner before the name/number caption in 
the object. 

Prefix Text 

Specify additional prefix text to be added before the Owner prefix. 

  

The remainder of the choices presented on the Owner Display Options dialog pertain to the 
object's display appearance. 

Style 

Choose whether the display object should appear as a rectangle or as an ellipse. 

Caption 

Indicate how the display object should be identified to the user: by name, number, or both. 

Width, Height 

The dimensions of the new display object. 

Click OK to save your selections and add the object to the oneline, or choose Cancel to 
terminate the addition. 
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Area Fields on Onelines 

  

Area fields are used to show various values associated with a particular area of the power 
system. Right clicking on the area field displays the Area Field Dialog.  
  

Edit Mode 

To enter a new area field, first select Field > Area Field from the Individual Insert ribbon 
group on the Draw ribbon tab. Then, click on or near the area object or a bus in the area for 
which you want to add a field. This calls up the Area Field Dialog. Verify that the area 
number is correct. By default, this value is the number of the area associated with the 
closest area object, or if there are no area objects, the closest bus. Enter the total number 
of digits the field should display as well as the number of digits to the right of the decimal 
point. Depending on what the field is designed to display, you may need to enter an 
additional area number. Finally, select the field type. Click OK to save the field or Cancel to 
abort the operation.  

With most types of area fields, an Area Number of 0 is valid and defines the field as 
showing values for the entire system. 

To modify the parameters of an existing area field, position the cursor anywhere on the area 
field and right-click. This again brings up the Area Field Dialog.  Use the Formattingoptions 
to change various display attributes for the area field, including its font and background 
color.  



Building a Oneline Diagram 
 

168 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Zone Fields on Onelines 

  

Zone field objects are used to show different values associated with zones and the system. 
This dialog is used to view (and in a few cases modify) the parameters associated with these 
zone fields. To reach this dialog, select Field > Zone Field from the Individual Insert ribbon 
group on the Draw ribbon tab and click the desired field location on a oneline diagram in Edit 
Mode, or right-click on an existing zone field on a oneline diagram. 
  

Zone Number 

Zone number associated with the field. When you insert fields graphically, this field is 
automatically set to the zone number associated with the closest bus on the oneline. With 
most types of zone fields, a Zone Number of 0 is valid and defines the field as showing 
values for the entire system.  

Find… 

If you do not know the exact zone number you are looking for, you can click this button to 
open the advanced search engine. 

Total Digits in Fields 

Total number of digits to show in numerical fields. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point in numerical fields. 

Rotation Angle in Degrees  

The angle at which the text is to appear on the oneline diagram.  

Other Zone Number 

Some of the fields, such as MW Flow to Other Zone, require that a second area be 
specified. If applicable, enter the second (other) zone here.  

Delta per Mouse Click 

This value is used only with the Sched Flow to Other Zone field type. When there is a 
nonzero entry in this field, and the field type is Sched Flow to Other Zone, a spin button 
is shown to the right of the zone field. When the up spin button is clicked, the flow to the 
other zone is increased by this number of MW; when the down button is clicked, the 
scheduled flow is decreased by this amount.  

Field Value 

Shows the current output for the zone field. Whenever you change the Type of Field 
selection, this field is updated.  

For the Sched Flow to Other Zone field type only, you can specify a new value in MW. 
Exports are assumed to be positive.  

Field Prefix 

An optional string that precedes the field value.  

Anchored   

If the field is associated with a Zone Object on the diagram, the field can be anchored to the 
object so that if the object gets moved on the diagram, the field will move with it. 

Include Suffix 
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If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of zone field to show. 

Name  
Zone name. 

Number  

Zone number (1 - 999). 

MW Load, Mvar Load 

If the zone number is nonzero, then these fields show Total MW or Mvar load for the 
zone. If the zone number is zero, these fields show the total load in the entire system. 

MW Generation, Mvar Generation  

If the Zone Number is nonzero, then these fields show Total MW or Mvar generation for 
the zone. If the Zone Number is zero, these fields show the total generation in the entire 
system. 

MW Shunts, MVR Shunts 

If the Zone Number is nonzero, then these fields show Total MW or Mvar shunt 
compensation for the zone. If the Zone Number is zero, these fields show the total shunt 
compensation in the entire system. 

MW Flow to Other Zone, Mvar Flow to Other Zone 

Total MW or Mvar flow from the zone specified in the Zone Number field to the zone 
specified in the Other Zone Number field. The Zone Number field must correspond to a 
valid zone. If the Other Zone Number field is zero, this field shows the zone's total MW 
or Mvar exports.  

MW Losses, MVAr Losses 

If the Zone Number is nonzero, then these fields show Total MW or Mvar losses for the 
zone. If the Zone Number is zero, these fields show the total real or reactive losses in 
the entire system. 

Load Schedule Multiplier 

Indicates the current value of the MW multiplier applied to the zone's loads. 

Select a Field 

Allows you to choose any other field associated with a zone not explicitly listed as an 
option in the Type of Field selection. 

Select OK to save changes and close the dialog or Cancel to close dialog without saving your 
changes.  
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Super Area Fields on Onelines 

  

To display certain information about a super area, such as MW Load or MVAR losses, insert a 
super area field. This can be done in Edit Mode by selecting Field > Super Area Field from 
the Individual Insert ribbon group on the Draw ribbon tab. This will bring up the Super Area 
Field Information. From here you can choose which super area to describe, how many digits in 
the field, and how many digits to the right of the decimal. There are also 12 different field 
options to choose from. If a field value is not defined, question marks will be shown. 
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Owner Fields on Onelines 

  

Owner field objects are used to show different values associated with owners. This dialog is 
used to view and modify the parameters associated with these fields. To insert an Owner field, 
click on Field > Owner Field in the Individual Insert ribbon group on the Draw ribbon tab. 
  

Owner Number 

Owner number associated with the field. When you insert fields graphically, this field is 
automatically set to the owner number associated with the closest bus on the oneline.  

Find by Number 

To switch to a different owner in the field options dialog, you can enter the number in the 
Owner Number field, and press the Find by Number button to update the dialog with 
information for the new owner. 

Owner Name 

Name of the owner whose information is presently being displayed in the dialog. 

Find by Name 

To switch to a different owner in the field options dialog, you can enter the name in the 
Owner Name field, and press the Find by Name button to update the dialog with 
information for the new owner. 

Total Digits in Fields 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Prefix 

An optional string that precedes the field value.  

Rotation Angle in Degrees 

The angle at which the text is to appear on the oneline diagram. 

Field Value 

Shows the current output for the owner field. Whenever you change the Type of Field 
selection, this field is updated.  

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of owner field to show. You can choose from one of the six 
default fields, or click on the Find Field… button to choose from a list of all available owner 
fields. 
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Bus Display Objects 

  

In power system analysis, the term "bus" is used to refer to the point where a number of 
electrical devices, such as lines, loads or generators, join together. On the oneline diagram, 
buses are usually represented with either a thick horizontal line or a thick vertical line. The bus 
thickness and color can be customized.  

Right-clicking on the bus will display its local menu. The local menu offers you the chance to 
view the corresponding Bus Dialog, the Quick Power Flow List, and the Bus View Display. 
When the application is in Edit Mode, the local menu will also allow you to add bus fields to 
the bus and to insert any undrawn buses connected to the selected bus. Bus Fields are often 
placed close to the bus to indicate its voltage magnitude, voltage angle, and other relevant 
information.  
  

Edit Mode  

To add a new bus to the case graphically, follow this simple procedure:  

• Select Network > Bus from the Individual Insert ribbon group of the Draw ribbon tab. 
This prepares Simulator to insert a new bus. 

• Left-click on the oneline background at the location where you want to place the new bus. 
This invokes the Bus Option Dialog. 

• Use the Bus Option Dialog Box to specify the number, name, size, thickness, orientation, 
area, zone, and nominal voltage of the bus, as well as the load and shunt compensation 
connected to it. Every bus must have a unique number. 

• Click OK on the Bus Option Dialog to finish creating the bus and to close the dialog. If you 
do not wish to add the bus to the case, click Cancel. 

If you are simply adding a symbol to the oneline diagram for a bus that has already been 
defined in the case, many of the parameters you are asked to specify in step three will be 
filled in for you.  

To modify the parameters for an existing bus, position the cursor on the bus and right-click 
to invoke the bus' local menu. From the local menu, choose Bus Information Dialog to 
view the associated Bus Dialog.  You may change any of the parameters specified there. 
When a bus' number is changed, the bus numbers associated with all of the devices 
attached to that bus are also automatically changed. To renumber several buses 
simultaneously, please see Bus Renumbering Dialog. 

To modify any aspect of a bus' appearance, first select the bus, and then click any of the 
format buttons found in the Formatting ribbon group on the Draw ribbon tab. You can 
change the length of the bus (but not its thickness) by dragging the bus' resizing handles.  

In order to delete an existing bus after selecting it, use either the Cut button, found in the 
Clipboard ribbon group on the Draw ribbon tab, to preserve a copy of the bus on the 
Windows clipboard, or Delete button, found in the Clipboard ribbon group on the Draw 
ribbon tab, to remove the bus without copying it to the clipboard. You will be asked whether 
you want to remove both the display object and its associated bus record, or merely the 
display object, leaving the bus in the power flow model. If you will never be deleting a 
record from the power system model, you may also choose the option labeled Always 
Delete Objects Only. Be careful when deleting existing buses with attached devices. An 
error will occur during validation if you do not also delete the attached devices or attach 
them to other buses.  
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Bus Fields on Onelines 

  

Bus field objects are used primarily to indicate various quantities associated with bus devices. 
Furthermore, some bus field types, which are distinguished by an integrated spin button, may 
be used to easily change bus device properties. 
  

Run Mode 

Right clicking on a bus field gives you the option to open the Bus Field Dialog or the Bus 
Information Dialog. 

  

Edit Mode 

Simulator offers two options for adding bus fields to a oneline in Edit Mode. If you need to 
enter only a single field, the easier approach may be to choose Field > Bus Field from the 
Individual Insert ribbon group on the Draw ribbon tab and then select the bus to which you 
want to add the field. This invokes the Bus Field Dialog. Enter the bus number associated 
with the device (the default is the closest bus to the field), the total number of digits to 
show, and the number of digits to the right of the decimal point. An optional Field Prefix can 
be used. Choosing to Include Suffix will include relevant units for the type of field selected. 
The field can be Anchored to the bus that it represents and the field can be rotated by a 
specified Rotation Angle in Degree. Finally, select the type of field to show.  

The second approach for adding new bus fields entails right-clicking the bus and selecting 
Add New Fields Around Bus from the resulting local menu. See Inserting and Placing 
Multiple Display Fields for more details. 

To modify the parameters of an existing bus field, position the cursor anywhere on the 
object and right-click. This brings up the Bus Field Dialog. Choose any of the format buttons 
on the Formatting ribbon group on the Draw ribbon tab to change various display attributes 
of the field, including its font and background color. 
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Old Voltage Gauges 

  

Voltage gauges provide a way to visualize the voltage of a bus relative to its high- and low-
voltage alarm limits. A gauge looks very much like a thermometer. As the temperature 
changes, the height of the mercury in the thermometer moves up and down. One reads the 
temperature measured by the thermometer by noting the marking that matches the top of the 
mercury. Voltage gauges in Simulator work the same way. A voltage gauge has three 
markings on its side, each of which identifies a key per-unit voltage level. Specifically, these 
three markings locate the minimum, maximum, and target per-unit voltages. Often, the target 
voltage level is the nominal voltage, but this is not a requirement. Inside the gauge is a filled 
region. The default color of the filled region is blue, but this can be changed. When you create 
the voltage gauge, you associate it with a bus, and you specify its fill color and its minimum, 
maximum, and target voltage levels. Once the gauge has been placed on a display, it will 
reveal changes in its associated bus’s voltage by varying the height of its filled region. This 
tool was introduced to provide an alternative to voltage contours to show the variation of 
voltage across a region. Contouring can reveal the variation of only a single quantity at a time. 
For example, it is impossible to contour bus voltage magnitude and bus voltage phase angle 
simultaneously. Voltage gauges are helpful because they allow you to show the voltage profile 
superimposed on a contour of some other quantity. 

To add a voltage gauge to a display, switch to Edit Mode and select  Pies / Gauges > Old 
Gauges > Bus from the Individual Insert Ribbon Group on the Draw ribbon tab. The 
cursor will become a crosshair. Click on the oneline diagram where you would like the new 
voltage gauge to appear. The Voltage Gauge Options Dialog will appear. Use this dialog to 
define the minimum, maximum and target voltages for the voltage gauge, as well as its fill 
color and whether it should be anchored to its associated bus. After you click the "OK" button, 
the Voltage Gauge Options Dialog will close, and the new voltage gauge will appear. 

Once a gauge has been placed on the oneline, the height of its filled region will change as the 
voltage of its associated bus changes. To modify any of the characteristics of the gauge, such 
as its key voltage levels, fill color, and anchor setting, simply right-click on the bus voltage 
gauge to open the Voltage Gauge Options Dialog again. 
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Old Voltage Gauge Options Dialog 

  

The Voltage Gauge Options Dialog is used to define and configure a bus voltage gauge. A bus 
voltage gauge is associated with a particular bus and reveals the bus’s voltage relative to 
specified minimum, maximum, and target per-unit voltage levels. The height of the colored 
column in the voltage gauge indicates the bus’s voltage relative to these markings. 

The dialog has the following controls: 

Number, Name, and Find 

Use the Number and Name dropdown boxes to identify the bus to which you want the 
gauge to correspond. Select a bus number from the Number dropdown box to identify the 
bus by number, and a bus name from the Name dropdown box to identify a bus by name. It 
may be more convenient to press the Find to open the Find Dialog, which allows you to 
specify a bus by either name or number using wildcards. When you first open the Bus 
Voltage Gauge Dialog, the bus name and number will correspond to the bus object that was 
closest to the point where you clicked. 

Minimum, Target, and Maximum 

Use these three spin edit boxes in the Voltage levels group box to specify the minimum, 
maximum, and target per-unit voltage levels. These settings determine where on the gauge 
its three markings will be drawn. 

The Minimum and Maximum value will be taken from the Limit Monitoring settings for the 
current bus, unless you uncheck the option "Set Limits According to Current Limit Monitoring 
Settings". 

Fill color 

The Fill color box reveals the color that will be used to paint the filled region of the gauge. 
Click on the Fill color box to open a Color Dialog, which you may then use to specify a 
different color. 

Anchored 

A bus voltage gauge is said to be anchored if, when you move its associated bus object, it 
moves with it. Check the Anchored check box to ensure that the gauge will move with its 
associated bus. Otherwise, when you move its associated bus object, the gauge will stay in 
its current position. 

OK, Help, and Cancel 

Click OK to finalize your settings. This will create a new voltage gauge object if you are 
trying to create one from scratch, or it will modify the appearance and settings of an 
existing one if you have chosen to modify one that has already been defined. Click Cancel to 
dispose of your changes. Click the Help button to reveal this help text. 
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Substation Display Objects 

  

Substations in Simulator define a group of buses that are closely connected. Each bus can 
belong to either one substation or no substation (called unassigned). By default in Simulator, 
all buses are not assigned to a substation. This is done because all traditional text file power 
flow formats do not include information regarding a bus' substation. 

Substations are represented on the oneline as a rectangle with the name of the substation 
inside it. Other information about the substation is also displayed on the rectangle: 
• The upper left corner displays a generator symbol if generation exists in the substation. 
• The upper right corner displays a load symbol if load exists in the substation. 
• The lower right corner displays a shunt symbol if shunts exist in the substation. 
• The lower left corner displays the number of buses inside the substation. 
• The lower middle displays the maximum voltage level in the substation. 

You can also customize the size, colors, and font name and style of a substation object. Note 
however that the font size of the substation object is automatically changed by Simulator as 
you change the size of the rectangle.  

Right-clicking on the substation will display its local menu. The local menu offers you the 
chance to view the corresponding Substation Information Dialog and the Substation View 
Display. 
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Substation Fields on Onelines 

  

To display certain information about a substation, such as MW Load or MVAR losses, insert a 
substation field. This can be done in Edit Mode by selecting  Fields > Substation Field from 
the Individual Insert ribbon group on the Draw ribbon tab. This will bring up the Substation 
Field Options  dialog. From here you can choose which substation to describe, how many 
digits in the field, and how many digits to the right of the decimal. There are also 8 different 
field options to choose from. If a field value is not defined, question marks will be shown. 
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Generator Display Objects 

  

Generators are represented on the oneline as circles with a "dog bone" rotor inside. Multiple 
generators at a bus are allowed, with each being distinguished by a unique character 
identifier.  

Each generator symbol (except that corresponding to the slack) is equipped with a circuit 
breaker that can be used to change the status of the generator. You may toggle the generator 
status by clicking on the circuit breaker while in Run Mode. 

Generator fields are often placed close to the generator on the oneline to indicate the 
generator's MW/Mvar output. 

Run Mode 

When animation is active, the default flow of the arrows emerging from the generator is 
proportional to its MW output. You can customize the appearance of this flow using the 
Animated Flows Tab of the Oneline Display Options Dialog.  

Right clicking on the generator brings up the generator submenu. This menu is used to 
display a variety of information about the generator, including 

• Generator Information Dialog 
• Input-output curve 
• Fuel cost curve 
• Incremental cost curve 
• Heat-rate curve 
• Reactive capability curve 

Edit Mode 

To add a new generator to the case, select  Network > Generator from the Individual 
Insert ribbon group on the Draw ribbon tab. Then, place the cursor on the bus where you 
would like to attach the generator, and click with the left mouse button. This calls up the 
Generator Dialog. The bus number is automatically determined from the bus to which you 
attached the generator. The ID field contains a an alphanumeric ID used to distinguish 
multiple generators at a bus. The default is '1'.  

Enter the size, the thickness of the lines (in pixels) used to display the device, orientation, 
and other parameters for the generator. Each generator automatically contains a switch for 
connecting or disconnecting the device in Simulator. Select OK to add the generator. If you 
do not want to add the generator to the case, select Cancel.  

To modify the parameters for an existing generator, position the cursor on the generator 
and right-click. This again brings up the Generator Dialog. You can then change any 
parameter (be careful in renumbering an existing generator). Use the Formatting ribbon 
group commands to change the color, line thickness, and other display parameters.  
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Generator Fields on Onelines 

  

Generator field objects are used primarily to indicate various quantities associated with 
generation devices. Furthermore, some generator field types, which are distinguished by an 
integrated spin button, may be used to change generation device properties. 

Run Mode 

For generator fields with an associated spin button, clicking on the up/down arrows will 
change the value of the associated field. 

Right clicking on a generator field gives you the option to open the Generator Field Dialog or 
the Generator Information Dialog. 

Edit Mode 

Simulator offers two options for adding generator fields to a oneline in Edit Mode. If you 
need to enter only a single field, the easier approach may be to choose Field > Generator 
Field from the Individual Insert ribbon group on the Draw ribbon tab and click near 
generator for which you want to add the field. This invokes the Generator Field Dialog. Enter 
the bus number associated with the device (the default is the bus associated to the closest 
generator to the field), the ID field, the total number of digits to show, and the number of 
digits to the right of the decimal point. Next, select the type of field to show. For generator 
actual MW and Setpoint MW types and load MW and Mvar fields, specify a nonzero value in 
the Delta per Mouse Click to design a bus field with an integrated spin control. The Gen AGC 
Status field is used to display the automatic generation control status of the generator. The 
user can toggle this status in Simulator by clicking on the field. Likewise, the Gen AVR Status 
field is used to display the automatic voltage regulation status of the generator. Again, the 
user can toggle this status by clicking on the field.  

The second approach for adding new generator fields entails right-clicking the bus and 
selecting Add New Fields Around Generator from the resulting local menu. Please see 
Inserting and Placing Multiple Display Fields for more details. 

To modify the parameters of an existing generator field, position the cursor anywhere on 
the object and right-click. This brings up the Generator Field Dialog. Choose  , or  from the 
Formatting ribbon group to change various display attributes of the field, including its font 
and background color. 
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Load Display Objects 

  

Simulator models aggregate load at each system bus. Multiple loads at a bus are allowed. 
Each load object on the oneline comes equipped with a circuit breaker. The status of the load 
corresponds to the status of its circuit breaker. A circuit breaker is closed if it appears as a 
filled red square, and it is open if it appears as a green square outline. In Run Mode, you may 
toggle the status of the load by clicking on its associated circuit breaker. 

Load fields are often placed close to the loads on the oneline to indicate their MW/Mvar value. 

Run Mode 

When animation is active, the flow of the arrows into the load is proportional to its current 
MW load. You can customize the appearance of this flow using the Animated Flows Tab of 
the Oneline Display Options Dialog. 

Right clicking on a load (bus) field gives you the option to open the Load Field Dialog or the 
Load Dialog.  

Edit Mode 

To add a new load to the case, select Network > Load from Individual Insert ribbon group 
on the Draw ribbon tab. Then, select the bus to which you want to attach the load with the 
left mouse button. This calls up the Load Dialog.  The bus number is automatically 
determined from the bus to which you attached the load. The ID field contains a two-
character ID used to distinguish multiple loads at a bus. The default ID is 1.  

Enter the size, the thickness of the lines [in pixels] used to display the device, the 
orientation, and the base MW and Mvar load values for the device. Usually, only the 
Constant Power fields are specified as nonzero. The Constant Current and Constant 
Impedance fields are used to specify loads that vary with voltage. Constant current loads 
vary proportionally with bus voltage, while constant impedance loads vary with the square of 
the voltage. Specify the constant current and constant impedance values assuming one per-
unit voltage.  

Select OK to add the load. If you do not want to add the load to the case, select Cancel.  

To modify the parameters for an existing load, position the cursor on the load and right-
click. Select Load Information Dialog from the local menu to invoke the Load Dialog. You 
can then change any parameter as desired. You can select  from the Formatting ribbon 
group on the Draw ribbon tab to change the drawing parameters of the load. 
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Load Fields on Onelines 

  

Load field objects are used primarily to indicate various quantities associated with load 
devices. Furthermore, some load field types, which are distinguished by an integrated spin 
button, may be used to change load device properties. 

Run Mode 

For load fields with an associated spin button, clicking on the up/down arrows will change 
the value of the associated field. 

Right clicking on a load field gives you the option to open the Load Field Dialog or the Load 
Information Dialog. 

Edit Mode 

Simulator offers two options for adding load fields to a oneline in Edit Mode. If you need to 
enter only a single field, the easier approach may be to choose Field > Load Field from 
the Individual Insert ribbon group on the Draw ribbon tab and then select the load to which 
you want to add the field. This invokes the Load Field Dialog. Enter the bus number 
associated with the device (the default is the bus associated to the closest load to the field), 
the ID field, the total number of digits to show, and the number of digits to the right of the 
decimal point. Next, select the type of field to show.  

The second approach for adding new generator fields entails right-clicking the bus and 
selecting Add New Fields Around Load from the resulting local menu. Please see Inserting 
and Placing Multiple Display Fields for more details. 

To modify the parameters of an existing load field, position the cursor anywhere on the 
object and right-click. This brings up the Load Field Dialog. Choose , or  from the 
Formatting ribbon group on the Draw ribbon tab to change various display attributes of the 
field, including its font and background color. 

 



Building a Oneline Diagram 
 

182 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Transmission Line Display Objects 

  

Transmission lines are represented on the onelines using multiple segment lines drawn 
between buses. Transmission lines may be equipped with circuit breakers that can be used to 
change the line's status. You can also add pie charts and line fields to transmission lines to 
indicate how heavily loaded the line is. The appearance of transmission lines, including line 
thickness and color, may also be customized. 

Run Mode 

Simulator's animation feature can be used to indicate the magnitude of the flow on the 
transmission line, either in MW or in terms of the line's percentage loading. You can 
customize the line flow animation using the Animated Flows Options on the Oneline Display 
Options Dialog. 

Right-clicking on a transmission line displays the line's local menu, from which you can 
choose to inspect the Line/Transformer Dialog.  

Edit Mode 

To add a new transmission line to the case, first select Network > Transmission Line 
from the Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on 
the first bus for the transmission line (the "from" bus) and click the left mouse button. Add 
more segments to the line by moving the cursor and clicking with the left mouse button. To 
complete adding a new line, place the cursor on the second bus for the line (the "to" bus) 
and double-click with the left mouse button. This calls up the Line/Transformer Dialog. The 
"from" and "to" bus numbers are set automatically provided the line starts and ends on 
existing buses. If there is just one line between the buses, the circuit number should be "1." 
For multiple lines between buses, you must give each a unique circuit number. Enter the 
thickness of the lines [in pixels] used to display the transmission line. Enter the per unit (100 
MVA base) resistance, reactance, total charging susceptance (that is B not B/2) for the line, 
and an MVA rating. Select OK to add the line. If you do not want to add the line to the case, 
select Cancel.  

To modify the parameters for an existing line, position the cursor anywhere on the line and 
right-click. This brings up the Line/Transformer Dialog, which you can use to change various 
line parameters.  

To change the physical appearance of the line (i.e. line color, line thickness, etc.), make use 
of the tools in the Formatting ribbon group. 

To change the shape of the line, first left-click on the line to select it. This causes handles to 
appear at each vertex. You can then move any vertex clicking and holding the left mouse 
button down on the vertex, dragging it to a new location, and then releasing the mouse 
button. To remove a vertex, hold down the CTRL key and then click the vertex you would 
like to delete. To add a vertex, hold down the CTRL key and then click on the line where you 
would like to add a vertex. 
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Line Fields on Onelines 

  

Line field objects are used to show values associated with lines, transformers and dc 
transmission lines.  

Run Mode 

Right clicking on the line field gives you the option to open the Line Field Dialog or the Line 
Information Dialog. 

Edit Mode  

To enter a new line field, select Field > Line Field from the Individual Insert ribbon group 
on the Draw ribbon tab and select the line, transformer, or dc line to which you want to add 
the field. The Line Field Dialog will open. Enter the near and far bus number associated with 
the device (the default values for these fields correspond to the device on which you clicked) 
and the circuit number of the device. The field will display the flow value at the near end of 
the device. Enter the total number of digits to show on the screen and the number of digits 
to the right of the decimal point. Finally, select the desired field type.  

To modify the parameters of an existing line field, position the cursor anywhere on the 
object and right-click. This again brings up the Line Field Dialog. Select  from the 
Formatting ribbon group on the Draw ribbon tab to change many of the line field's display 
attributes. 

Another way to add line fields to the oneline entails right-clicking the line and selecting Add 
New Fields Around Line from the resulting local menu. Please see Inserting and Placing 
Multiple Display Fields for more details.  
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Circuit Breakers on Onelines 

  

Circuit breakers are used to open or close transmission lines and transformers. They are also 
used to place generators, loads and switched shunts in or out of service. By default, closed 
circuit breakers are shown as solid red squares, while open circuit breakers are shown as a 
green square outline. The color and filled or unfilled properties of circuit breakers can be 
modified in the Oneline Display Options under Display Object Options.  

To change the status of a breaker, left-click on the breaker while in run mode. A circuit 
breaker directly controls the status of its associated display object. One breaker is shown on 
the line connecting a generator, load, or shunt to its associated bus. Two breakers are shown 
by default on transmission lines and transformers. Opening either of the line's circuit breakers 
opens the transmission line or transformer; you do not have to open circuit breakers at both 
ends of the line.  

Note: Circuit breakers cannot be placed on dc transmission lines. 

Edit Mode 

By default, when you add a new display object to a oneline diagram, the necessary circuit 
breakers are automatically added at each end of the branch. 

To add a new circuit breaker to the oneline, select Indication > Circuit Breaker from the 
Individual Insert ribbon group on the Draw ribbon tab and then click the line to which you 
want to add the breaker. The Circuit Breaker Options Dialog will appear with the from and to 
bus numbers, and the circuit number automatically set to identify the line you selected. 
Specify the size for the switch and its initial status, as well as whether it will be anchored to 
the line so that it will move with the line. Click OK to add the circuit breaker, or click Cancel 
to abort the process. To add more circuit breakers to the line, simply repeat this procedure. 

To modify the parameters for an existing breaker, position the cursor anywhere on the 
device and right-click. This invokes the Circuit Breaker Options Dialog, from which you can 
change many of the breaker's parameters. Additional display settings for the circuit breaker 
can be accessed by selecting  from the Formatting ribbon group. 

You can toggle the status of Transmission Line and Transformer circuit breakers while in 
Edit Mode by right-clicking on the associated line or transformer and selecting Open Line or 
Close Line from the local menu. 

Run Mode 

Circuit Breaker status can be toggled in Run Mode by Left-Clicking on a breaker to place its 
associated object either in or out of service. If the simulation is currently running, any 
effects of changing a circuit breaker’s status are immediately shown on the oneline. 
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Line Flow Pie Charts on Onelines 

  

The line flow pie charts are used to indicate the percentage MVA, MW, or Mvar loading of a 
transmission line or a transformer. The degree to which the pie chart is filled shows how close 
the device is to its limit (provided the device has a nonzero limit). A line flow pie chart 
becomes completely filled when the device's flow meets or exceeds 100% of its rating.  

For pie charts for objects that are not associated with line flows, see Pie Charts / Gauges. 

Use the Pie Chart Options tab of the Oneline Display Options Dialog to customize various 
attributes of all pie charts. The tab allows you to define a warning level at which the size and 
color of the pie charts will change to a size and color you specify. The tab also allows you 
define a limit percent as well as the size and color to which to change the pie charts when 
their corresponding devices violate their limits. You can also specify whether the pie charts 
should reveal total power flow (MVA), real power flow (MW), or reactive power flow (MVR). 
The oneline display options dialog can be invoked either by selecting Oneline Display 
Options from the Oneline Options ribbon group on the Options ribbon tab or by right-
clicking on the background of the oneline diagram and selecting Oneline Display Options from 
the resulting local menu. 

Right clicking on the pie chart displays the Line Flow Pie Chart Options Dialog. This dialog 
allows you to view the from and to bus numbers and the circuit number of the 
line/transformer associated with the pie chart. You can change the pie chart's size and the 
MVA rating of the line/transformer associated with the pie chart.  

Edit Mode 

To enter a new line flow pie chart, select Pies/Gauges > Line Flow Pie Chart from the 
Individual Insert ribbon group on the Draw ribbon tab_Ref1095648981 and click on the line 
or transformer to which you want to add the pie chart. This opens the Line Flow Pie Chart 
Options Dialog box. Enter the near and far bus number associated with the device (these 
fields default to the terminal bus numbers of the device on which you clicked), the circuit 
number of the device, and the desired size of the pie chart. The field will display the flow 
value at the near end of the device. Enter the size of the device. Select OK to insert the line 
flow pie chart. Otherwise, select Cancel.  

To modify the parameters of an existing line flow pie chart, position the cursor anywhere on 
the object and right-click. This again brings up the Line Flow Pie Chart Options Dialog box.  
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Line Flow Gauges 

  

Line flow gauges provide a way to visualize the flow of a transmission line or transformer 
relative to its thermal rating. A gauge looks very much like a thermometer. As the temperature 
changes, the height of the mercury in the thermometer moves up and down. One reads the 
temperature measured by the thermometer by noting the marking that matches the top of the 
mercury. Line flow gauges in Simulator work the same way. A line flow gauge has two 
markings on its side, one for the designated minimum flow, and one for the designated 
maximum flow (the branch's rating). Inside the gauge is a filled region. The default color of 
the filled region is blue, but this can be changed. When you create the line flow gauge, you 
associate it with a transmission element, and you specify its fill color and its minimum and 
maximum flow levels. Once the gauge has been placed on a display, it will reveal changes in 
its associated branch's flow by varying the height of its filled region. This tool was introduced 
to provide an alternative to line flow pie charts.  

To add a line flow gauge to a display, switch to Edit Mode and select Pies / Gauges > Old 
Gauges > Line from the Individual Insert ribbon group on the Draw ribbon tab. Click on the 
oneline diagram where you would like the new line flow gauge to appear. The Line Flow 
Gauge Options Dialog will appear. Use this dialog to define the minimum and maximum flows 
for the line flow gauge, as well as its fill color and whether it should be anchored to its 
associated transmission element. After you click the "OK" button, the Line Flow Gauge Options 
Dialog will close, and the new line flow gauge will appear. 

Once a gauge has been placed on the oneline, the height of its filled region will change as the 
flow of its transmission element changes. To modify any of the characteristics of the gauge, 
such as its key flow levels, fill color, and anchor setting, simply right-click on the line flow 
gauge to open the Line Flow Gauge Options Dialog again. 
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Line Flow Gauge Options Dialog 

  

The Line Flow Gauge Options Dialog is used to define and configure a Line Flow gauge. A line 
flow gauge is associated with a particular line and reveals the line’s flow relative to specified 
minimum and maximum thermal flow levels. The height of the colored column in the line flow 
gauge indicates the line’s flow relative to these markings. 

The dialog has the following controls: 

Number, Name, and Find 

Use the Number and Name dropdown boxes, in addition to the Circuit field, to identify 
the terminal buses to which the branch desired corresponds. It may be more convenient to 
press the Find button to open the Find Dialog, which allows you to specify the line by either 
bus names or numbers using wildcards. When you first open the Line Flow Gauge Dialog, 
the bus names and numbers will correspond to the transmission line object that was closest 
to the point where you clicked. 

Minimum and Maximum 

Use these two spin edit boxes in the MW Rating values group box to specify the minimum 
and maximum flow levels. These settings determine where on the gauge its two markings 
will be drawn. 

The Minimum and Maximum value will be taken from the Limit Monitoring settings for the 
current transmission line, unless you uncheck the option "Set Limits According to Current 
Limit Monitoring Settings". 

Anchored 

A line flow gauge is said to be anchored if, when you move its associated line object, the 
gauge moves with it. Check the Anchored check box to ensure that the gauge will move 
with its associated line. Otherwise, when you move its associated line object, the gauge will 
stay in its current position. 

OK, Help, and Cancel 

Click OK to finalize your settings. This will create a new line flow gauge object if you are 
trying to create one from scratch, or it will modify the appearance and settings of an 
existing one if you have chosen to modify one that has already been defined. Click Cancel to 
dispose of your changes. 
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DC Transmission Line Display Objects 

  

DC transmission lines are represented on the onelines using multiple segment lines drawn 
between two buses. Line fields are often placed close to dc transmission lines on the oneline 
to indicate the power flow through the device.  

Note that, unlike ac transmission lines, dc transmission lines cannot be equipped with circuit 
breakers. 

Run Mode 

Simulator's animation feature can be used to indicate the magnitude of the flow on the dc 
transmission line, either in MW or in terms of the line's percentage loading. You can 
customize the line flow animation using the Animated Flows Options on the Oneline Display 
Options Dialog. 

Right-clicking on a dc transmission line displays the line's local menu, from which you can 
choose to inspect the DC Transmission Line Dialog. 

Edit Mode 

To add a new dc transmission line to the case, first select Network > DC Transmission 
Line from the Individual Insert ribbon group on the Draw ribbon tab. Then place the 
cursor on the bus you desire to be the rectifier bus for the line and click the left mouse 
button. Add more segments to the line by moving the cursor and clicking with the left 
mouse button. To complete the new line, place the cursor on the second bus for the line, 
which will serve as the inverter bus, and double-click the left mouse button. This calls up the 
DC Transmission Line Dialog. If you successfully selected the rectifier and inverter buses, 
their numbers will be automatically filled in for you when the dialog opens.  

The DC Transmission Line Record Dialog has four separate pages: Line Parameters, Rectifier 
Parameters, Inverter Parameters, and Actual Flows. The separate pages can be accessed 
using the tabs shown at the top of the dialog. These pages are used to set the modeling 
parameters associated with the dc lines.  

To modify the parameters for an existing dc transmission line, position the cursor anywhere 
on the line and right-click. This will provide access to the corresponding DC Transmission 
Line Dialog, from which you can modify any of the dc line's parameters. Select   from the 
Formatting ribbon group on the Draw ribbon tab to change the color and/or line thickness of 
the dc line.  

To change the shape of the line, first left-click on the line to select it. This causes handles to 
appear at each vertex. You can then move any vertex by clicking and holding the left mouse 
button down, dragging the vertex to a new location, and releasing the mouse button. To 
remove a vertex, hold down the CTRL key and then click the vertex you would like to delete. 
To add a vertex, hold down the CTRL key and then click on the line where you would like to 
add a vertex.  
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Multi-section Line Display Objects 

  

Multi-section lines are represented on the onelines using a line segment with intermediate or 
"dummy" bus representations. These objects are not the same as a normal transmission line. 
They do display animated flows in run mode, but do not have pie charts, circuit breakers, or 
text fields currently associated with the objects. 

Run Mode 

Simulator's animation feature can be used to indicate the magnitude of the flow on the 
transmission line, either in MW or in terms of the line's percentage loading. You can 
customize the line flow animation using the Animated Flows Options on the Oneline Display 
Options Dialog. 

Right-clicking on a multi-section line displays the Multi-section Line Information Dialog.  

Edit Mode 

Unlike transmission lines and transformers, multi-section lines CANNOT be inserted in a case 
by adding the mult-section line graphically. Therefore, when inserting a multi-section line 
object, the data for the object must already exist in the case. A list of currently defined 
multi-section lines is found in the model explorer under  Aggregations > Multi-Section 
Lines. Right-clicking and selecting Insert… in the table that opens will allow you to add 
new multi-section line information via the Multi-Section Line Information dialog.  

To insert the multi-section line object, first select Network > MS Transmission Line from 
the Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on the first 
bus for the transmission line (the "from" bus) and click the left mouse button. Add more 
segments to the line by moving the cursor and clicking with the left mouse button. To 
complete adding a new line, place the cursor on the second bus for the line (the "to" bus) 
and double-click with the left mouse button. Completing the multi-section line opens the 
Multi-section Line Information dialog. At the bottom of this dialog are display options for the 
line, such as line pixel thickness, symbol size (for the series capacitor representations, if 
any,) anchored, and options for drawing the buses. 

To change the shape of the line, first left-click on the line to select it. This causes handles to 
appear at each vertex. You can then move any vertex clicking and holding the left mouse 
button down on the vertex, dragging it to a new location, and then releasing the mouse 
button. To remove a vertex, hold down the CTRL key and then click the vertex you would 
like to delete. To add a vertex, hold down the CTRL key and then click on the line where you 
would like to add a vertex. 
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Transformer Display Objects 

  

Transformers are represented as transmission lines with two opposing coils drawn on one of 
the segments. The transformer's line thickness, color, and symbol segment can be customized 
using the Edit Mode. Optionally, circuit breakers and pie charts can be placed on the 
transformer. Clicking on the circuit breakers changes the status of the transformer.  

Line fields are often placed close to transformers on the oneline to indicate the power flow 
through the device. Transformer fields are often placed close to transformers on the oneline to 
indicate and control their tap positions. See Transformer Modeling for details on modeling 
either LTC or phase shifting transformers. 

Run Mode 

Simulator's animation feature can be used to indicate the magnitude of the flow through the 
transmission line, either in MW or in terms of the transformer's percentage loading. You can 
customize the line flow animation using the Animated Flows Options on the Oneline Display 
Options Dialog. 

Right-clicking on a transformer displays the line's local menu, from which you can choose to 
inspect the Line/Transformer Dialog.  

Edit Mode 

New transformers are inserted in much the same way as transmission lines. To add a new 
transformer to the case, first select Network > Transformer from the Individual Insert 
ribbon group on the Draw ribbon tab. Then place the cursor on the first bus for the 
transformer (the from bus) and click the left mouse button. Add more segments to the 
transformer by moving the cursor and clicking with the left mouse button. To complete the 
new transformer, place the cursor on the transformer's other terminal (the to bus) and 
double-click with the left mouse button. This calls up the Line/Transformer Dialog.  The from 
and to bus numbers for the transformer should have been set automatically. If there is just 
one transformer between the buses, the circuit number should be "1." For multiple 
transformers between buses, you must give each a unique circuit number. Enter the 
thickness of the lines [in pixels] used to display the transformer, the number of the line 
segment in which you would like the transformer symbol drawn, and the size of the 
transformer symbol.  

Enter the per unit (100 MVA base) resistance, reactance and charging susceptance for the 
transformer, and an MVA rating. Enter the off-nominal tap ratio and the phase shift angle in 
degrees. (For a transformer without tap or phase control, the off-nominal tap should be 1.0 
and the phase shift angle should be 0 degrees.) 

Select the appropriate Automatic Control Option. If the transformer does not have tap 
control, select No Automatic Control (this is the default). Select AVR (Automatic Voltage 
Regulation) if the transformer changes its tap ratio to control the voltage at user specified 
regulation bus. Select Reactive Power Control if the transformer changes its tap ratio to 
control the reactive power through the transformer. Finally, select Phase Shift Control if the 
transformer changes its phase shift to control the MW flow through the transformer. If you 
need any of the last three options, select the Automatic Control Options button to set the 
parameters associated with the automatic control. 

For AVR control, enter the number of the bus whose voltage is to be controlled, the 
allowable range for the controlled voltage (in per unit), the minimum and maximum tap 
ratios (typical values are 0.9 and 1.1), and the step size for the discrete changes in the tap 
ratio (typical value is 0.00625). 
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For reactive power control, the control variable is always the reactive power measured at 
the from bus (i.e., the tapped side) of the transformer. Positive flow is assumed to be going 
through the transformer to the to bus. Enter the minimum and maximum allowable flows, 
the minimum and maximum tap ratios (typical values are 0.9 and 1.1), and the step size for 
the discrete changes in the tap ratio (typical value is 0.00625). 

For phase shift control, the MW flow through the transformer is the controlled value. Enter 
the bus number of the terminal whose flow is controlled, the allowable range for the 
controlled flow (positive flow is assumed to be into the transformer at the terminal entered 
in the previous field), the minimum and maximum phase angles (typical values are -30° and 
30°), and the step size in degrees (typical values are between 1° and 2°).  

Select OK to save the values and return to the Transformer Options Dialog; otherwise select 
Cancel.  

If you would like the transformer to be initially modeled as being on automatic control at the 
start of the case, select the Automatic Control Active checkbox. 

If you do not want to add the transformer to the case, select Cancel.  

To modify the parameters for an existing transformer, position the cursor anywhere on the 
device and right-click. This brings up the local menu from which you can choose to view the 
Line/Transformer Dialog. Use the Line/Transformer Dialog to adjust many of the 
transformer's electrical properties. The Formatting ribbon group provides tools to change the 
transformer's color and/or line thickness.  

See Transformer Modeling for details on modeling either LTC or phase shifting transformers. 
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Transformer Fields on Onelines 

  

Transformer fields are used to show field values specific to transformers, such as tap position, 
phase angle, and more.  

Run Mode 

If there is a spin control integrated with the field, you can click on the spinner to change the 
field's value by the associated Delta Per Mouse Click. 

Right clicking on the transformer field gives the option to display the Transformer Field 
Dialog or the Line/Transformer Information Dialog. 

Edit Mode 

To enter a new transformer field, select Field > Transformer Field from the Individual 
Insert ribbon group on the Draw ribbon tab, and then click on the transformer object to 
which you want to add the new field. This calls up the Transformer Field Dialog. Enter the 
from and to bus numbers associated with the device (the default values for these fields 
correspond to the transformer on which you clicked), and the circuit number of the device. 
Enter the total number of digits that the field should display, as well as the number of digits 
to the right of the decimal point. Finally, specify what the field should display: the off-
nominal tap ratio, the off-nominal tap position, or the phase shift angle in degrees.  

To modify the parameters of an existing transformer field, position the cursor anywhere on 
the object and right-click to bring up the Transformer Field Dialog. Use the tools of the 
Formatting ribbon group to change various display attributes for the transformer field, 
including its font and background color. 
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Series Capacitor Display Objects 

  

Series capacitors are represented as transmission lines with two opposing parallel bars drawn 
on one of the segments. The series capacitor’s line thickness, color and symbol segment can 
be customized using the Edit Mode. If the series capacitor branch is operating, but the series 
capacitor status is set to Bypassed, a low impedance segment will be drawn around the 
series capacitor symbol to indicate the capacitor has been bypassed. The capacitor status of 
Bypassed or In Service can be toggled in run mode if the Series Capacitor Status field is 
displayed on the oneline diagram. When a left-click is registered on the Series Capacitor Status 
field when in Run Mode, the capacitor status is toggled. Note that this is not the same as the 
overall branch status of Open or Closed.  
Optionally, circuit breakers and pie charts can be placed on the series capacitor. Clicking the 
circuit breakers changes the branch status of the series capacitor. 

Run Mode 

Simulator's animation feature can be used to indicate the magnitude of the flow through the 
series capacitor, either in MW or in terms of the transformer's percentage loading. You can 
customize the line flow animation using the Animated Flows Options on the Oneline Display 
Options Dialog. 

Right-clicking on a transformer displays the line's local menu, from which you can choose to 
inspect the Line/Transformer Dialog.  

Edit Mode 

New series capacitors are inserted in much the same way as transmission lines. To add a 
new series capacitor to the case, select Network > Series Capacitor from the Individual 
Insert ribbon group on the Draw ribbon tab. Then place the cursor on the first bus for the 
series capacitor (the from bus) and click the left mouse button. Add more segments to the 
series capacitor by moving the cursor and clicking with the left mouse button. To complete 
the new series capacitor, place the cursor on the series capacitor's other terminal (the to 
bus) and double-click with the left mouse button. This calls up the Line/Transformer Dialog.  
The from and to bus numbers for the series capacitor should have been set automatically. If 
there is just one branch between the buses, the circuit number should be "1." For multiple 
branches between buses, you must give each a unique circuit number. Enter the thickness 
of the lines [in pixels] used to display the series capacitor, the number of the line segment 
in which you would like the series capacitor symbol drawn, and the size of the series 
capacitor symbol.  

Enter the per unit (100 MVA base) resistance, reactance and charging susceptance for the 
series capacitor, and an MVA rating. On the Series Capacitor tab, check the box labeled Is 
Series Capacitor to indicate that the branch model is a series capacitor device. 

If you do not want to add the series capacitor to the case, select Cancel. Otherwise click OK 
to add the series capacitor to the case.  

To modify the parameters for an existing series capacitor, position the cursor anywhere on 
the device and right-click. This brings up the local menu from which you can choose to view 
the Line/Transformer Dialog. Use the Line/Transformer Dialog to adjust many of the series 
capacitor's electrical properties.  

See Series Capacitor Information for more details on modeling series capacitors. 
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Series Capacitor Fields on Onelines 

  

Series capacitor fields are used to show field values specific to series capacitors.  

Run Mode 

If the Series Capacitor field for capacitor status is displayed, the capacitor status can be 
toggled in run mode when you left-click on the field. 

Right clicking on the series capacitor field gives the option to display the Series Capacitor 
Field Dialog or the Line/Transformer Information dialog. 

Edit Mode 

To enter a new series capacitor field, select Field > Series Capacitor Field from the 
Individual Insert ribbon group on the Draw ribbon tab, and then click on or near the series 
capacitor object for which you want to add the new field. This calls up the Series Capacitor 
Field Dialog. Enter the from and to bus numbers associated with the device (the default 
values for these fields correspond to the series capacitor on which you clicked), and the 
circuit number of the device. Enter the total number of digits that the field should display, as 
well as the number of digits to the right of the decimal point. Finally, specify what the field 
should display: the capacitor status or the series capacitance.  

To modify the parameters of an existing series capacitor field, position the cursor anywhere 
on the object and right-click to bring up the Series Capacitor Field Dialog. 
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Switched Shunt Display Objects 

  

Switched shunts are either capacitors that supply reactive power to the system or reactors 
that absorb reactive power. Simulator represents switched shunts as a number of blocks of 
admittance that can be switched in a number of discrete steps or over a continuous range. 
Switched shunt display objects come equipped with a circuit breaker that indicates the shunt's 
status. If the switched shunt is closed, the circuit breaker appears as a filled red square. If the 
switched shunt is open, the circuit breaker appears as a green square outline. To change the 
status of the switched shunt, click the corresponding circuit breaker. 

Switched shunt fields are often placed next to switched shunts to indicate the amount of 
reactive power supplied by the device. For switched shunts with such a field, you can manually 
increase the reactive power supplied by the device (provided its control mode is discrete) by 
clicking on the up-arrow associated with the device's reactive power field. Likewise, you can 
decrease the reactive power supplied by the device by clicking on the down-arrow. To make 
the up/down arrows visible, set the Delta per Mouse Click on the switched shunt field to a 
nonzero value. 

Right-clicking on the switched shunt displays the Switched Shunt Dialog. Use the Switched 
Shunt Dialog to inspect or modify the model of the switched shunt. 

You can add a new switched shunt to the case in Edit Mode. Select Network > Switched 
Shunt from the Individual Insert ribbon group on the Draw ribbon tab. Then click the bus 
where you would like to attach the device. The Switched Shunt Dialog will appear. The bus 
number is automatically determined from the bus to which you attached the capacitor. Enter 
the size, the thickness of the pen [in pixels] used to draw the device, and its orientation. The 
Nominal Mvar field gives the amount of reactive power the device would supply if its terminal 
voltage were 1.0 per unit. The Control Mode field determines whether the switched shunt has 
a fixed value or will vary discretely or continuously within its operating limits to maintain its 
terminal voltage within the voltage range specified in the Voltage Regulation field.  

The amount of shunt admittance is specified in the Switched Shunt Blocks table. The columns 
in this field correspond to different blocks of admittance. The first row indicates the number of 
steps in each block, and the second row gives the amount of nominal Mvars per step. The 
switched shunts are always switched in the order specified in this field.  

Select OK to add the device. If you do not want to add the switched shunt to the case, select 
Cancel. 

To modify the parameters for an existing switched shunt, position the cursor on the device 
and right-click. This again brings up the Switched Shunt Dialog. You can then change any 
parameter of the switched shunt. Make use of the tools in the Formatting ribbon group to 
change the color and/or line thickness.  

To delete an existing switched shunt, use the Cut or Delete commands in the Clipboard 
ribbon group. 
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Switched Shunt Fields on Onelines 

  

Switched Shunt field objects are used primarily to indicate various quantities associated with 
switched shunt devices. Furthermore, some switched shunt field types, which are 
distinguished by an integrated spin button, may be used to change switched shunt device 
properties. 

Run Mode 

For switched shunt fields with an associated spin button, clicking on the up/down arrows will 
change the value of the associated field. 

Right clicking on a generator field gives you the option to open the Switched Shunt Field 
Dialog or the Switched Shunt Information Dialog. 

Edit Mode 

Simulator offers two options for adding switched shunt fields to a oneline in Edit Mode. If 
you need to enter only a single field, the easier approach may be to choose Field > 
Switched Shunt Field from the Individual Insert ribbon group on the Draw ribbon tab, 
and then select the switched shunt to which you want to add the field. This invokes the 
Switched Shunt Field Dialog. Enter the bus number associated with the device (the default is 
the bus associated to the closest switched shunt to the field), the ID field, the total number 
of digits to show, and the number of digits to the right of the decimal point. Next, select the 
type of field to show.  

The second approach for adding new switched shunt fields entails right-clicking the bus and 
selecting Add New Fields Around Switched Shunt from the resulting local menu. Please see 
Inserting and Placing Multiple Display Fields for more details. 

To modify the parameters of an existing switched shunt field, position the cursor anywhere 
on the object and right-click. This brings up the Switched Shunt Field Dialog. Make use of 
the tools on the Formatting ribbon group to change various display attributes of the field, 
including its font and background color. 
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Interface Display Objects 

  

Interface display objects are used on the onelines to visualize the flow of power through an 
interface record. Interface records are used to show the net real power (MW) flow on a group 
consisting of one or more of the following devices: 1) transmission lines and/or transformers, 
2) total tie-lines between two adjacent areas, and 3) total tie-lines between two adjacent 
zones. Only area-area and zone-zone interface records can be displayed using interface 
display objects. 

Interfaces, like transmission lines, are represented as multi-segment lines, except that they 
may be drawn between area/zone objects in addition to buses. Drawing interface display 
objects involves the same steps as drawing transmission lines and transformers. The line 
thickness and color of interface objects may be customized by selecting  from the Formatting 
ribbon group on the Draw ribbon tab.  

Interface Fields  and Interface Pie Charts  are often placed close to or on the interface to 
indicate the power flow through the device.  

Run Mode 

When animation is active, the flow of the arrows on the interface object may represent 
either the MW flow through the interface or the currently calculated power transfer 
distribution factor (PTDF) pertaining to that interface. You can customize the appearance of 
the animated flows using the Animated Flows Tab of the Oneline Display Options Dialog 
available using the local menu.  

Right-click on the interface to view the Interface Dialog for the interface.  

Edit Mode 

The quickest method of inserting new interface objects is to use the Auto Insert > 
Interfaces from the Quick Insert ribbon group on the Draw ribbon tab. Please see 
Automatically Inserting Interfaces for details.  

To manually add a new interface object to the case, first select Aggregation > Interface 
from the Individual Insert ribbon group on the Draw ribbon tab. Then place the cursor on 
the starting location for the interface (usually an area/zone object or a bus object) and left-
click. Add more segments to the interface by moving the cursor and the left-clicking at the 
end of the segment. To finish adding an interface, place the cursor on the terminal object 
for the interface and double-click. This then calls up the Interface Dialog. Either select an 
existing interface, or define a new interface (see Interface Dialog for details).  

Interfaces can be anchored to either area/zone objects or bus objects.  

To change the shape of the interface, first left-click on the object to select it. This causes 
handles to appear at each vertex. You can then move any vertex by dragging it with the left 
mouse button down. To remove a vertex, hold down the CTRL key and then click the vertex 
you would like to delete. To add a vertex, hold down the CTRL key and then click on the 
interface where you would like to add the vertex. 
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Automatically Inserting Interface Display Objects 

  

The Automatic Insertion of Interfaces Dialog is used to automatically insert interface objects  
on the oneline diagram between existing area/zone display objects. Interface pie chart objects  
can also be inserted as part of this process. The automatic insertion of interface display 
objects greatly accelerates the construction of interface diagrams, which are particularly useful 
for animating the results of PTDF calculations. Area-area and zone-zone interface records can 
be displayed using interface display objects as well as interfaces comprised only of 
transmission branches. 

Note that inserting interface objects on a oneline diagram does NOT add interface objects to 
the load flow case. The interface definitions need to be added to the load flow case prior to 
automatically inserting the graphical interface objects on a oneline diagram. The quickest way 
to add area to area or zone to zone interface definitions in the load flow case is to 
automatically insert the definitions in the interface case information display. 

Once you have the interface definitions defined in the case, you can automatically insert the 
interface objects on a diagram using the following procedure: 
• On a oneline diagram (either an already open diagram or a brand new one created by 

choosing New Oneline from the application button), place area/ zone objects at the 
desired locations if inserting area-area or zone-zone interface records. Otherwise, the 
terminal buses for the branch elements in the interface should be inserted at the desired 
locations on the oneline diagram.  

•  Go to the Draw ribbon tab and choose Auto Insert > Interfaces on the Quick Insert 
ribbon group. 

• Check the Insert Pie Charts on Interfaces box to automatically insert interface pie 
chart objects when the interfaces are inserted. If this option is selected, change the 
Default Size of Interface Pie Charts to specify their size. 

• Choose the type of interfaces to insert. Area to Area or Zone to Zone Interfaces and 
Line/Transformer Interfaces can be inserted. Area-area and zone-zone interfaces will 
be drawn between the respective area and zone objects displayed on the oneline. 
Line/transformer interfaces will be drawn based on the average location of the terminal 
buses of all transmission lines comprising the interface. If inserting line/transformer 
interfaces, the option Minimum Length of Line/Transformer Interfaces can be set to 
prevent interfaces that are too short from being inserted.  

• Select OK to insert the new oneline objects. New interface objects are automatically 
inserted based on the selected criteria for any corresponding interface record that is not 
already represented.   

Note that you can do this automatic insertion as often as you like. The Number of 
Interfaces Not Shown field indicates how many interfaces still need to be added to the 
diagram to represent all defined area-area, zone-zone, or line/transformer interfaces. It is a 
read-only field.  
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Interface Fields on Onelines 

  

Interface field objects are used to show values associated with interface records. 

Run Mode 

Right clicking on the interface field displays the Interface Field Dialog. 

Edit Mode 

To enter a new interface field, select Field > Interface Field from the Individual Insert 
ribbon group on the Draw ribbon tab, and then click on the background of the oneline 
diagram where you want the field placed. This calls up the Interface Field Dialog. Enter the 
name of the interface, the total number of digits desired in the field, and the type of field.  

To modify the parameters of an existing interface field, position the cursor anywhere on the 
object and right-click. This again brings up the Interface Field Dialog. 
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InterArea Flow Options Dialog 

  

This dialog is outdated in PowerWorld Simulator version 5 and later. See help on the Interface 
Field Information Dialog for the updated dialog. 

When viewing an area diagram containing inter-area objects created using PowerWorld 
Simulator version 4.2 or older, this dialog allows you to set text fields displaying either the 
actual or scheduled MW flow on the inter-area object. 
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Interface Pie Charts on Onelines 

  

Interface pie charts are used to graphically show the percentage loading on an interface 
record. The amount of shaded region of the pie chart indicates how close the interface is to its 
limit (provided the interface has a nonzero limit). The appearance of the interface pie charts, 
including their color and the ability to automatically change size based upon loading level, can 
be customized on the Oneline Display Options Dialog.  

Right-clicking on the interface pie chart displays the Interface Pie Chart Dialog. This dialog can 
be used to customize the size of the pie chart, or change the interface's limit.  

Edit Mode 

To enter a new interface pie chart, select Pies/Gauges > Interface Pie Chart from the 
Individual Insert ribbon group on the Draw ribbon tab. Then, click the left mouse on the 
interface object with which you want to associate the pie chart. This calls up the Interface 
Pie Chart Dialog, which is used to customize the appearance of the pie chart.  
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Loading NERC Flowgates 

  

This command reads flowgates from an Excel file and inserts them as interface records. The 
format for this file should be similar to the files found at http://www.nerc.com/~oc/dfwg.html. 
To access this file you must have a NERC-supplied username and password. At the time of 
writing we have not seen an official description of the format -- currently Simulator just mimics 
the format found in this file. Flowgates are used by NERC (under Policy 9) as proxies for 
transmission limitations and transmission service usage on the interconnected electric power 
network. Simulator models flowgates using the interface records. Interface records MAY 
include contingency elements. 

The Load NERC Book of Flowgates  from Excel option is available from the local menu of 
the Interface Records display.  
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Saving NERC Flowgates 

  

This command writes all the interfaces to an Excel spreadsheet using the NERC flowgate 
format. See the files found at http://www.nerc.com/~oc/dfwg.html for an example of the 
NERC format. To access this file you must have a NERC-supplied username and password. 

The Send NERC Book of Flowgates to Excel option is available from the Save As option 
of the local menu of the Interface Records display.  
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Links to Onelines and Auxiliary Files 

  

Run Mode 

Oneline Links 

Oneline links are one of the mechanisms used in Simulator to allow you to view multiple 
oneline diagrams on the same screen. By default, the oneline links are shown as blue 
rectangles surrounding a text identifier of the linked oneline diagram. Double-clicking the left 
mouse button anywhere within the oneline link object will display the linked oneline 
diagram, even if it has not already been opened. 

The ability to associate multiple oneline diagrams with a single case may prove particularly 
helpful when dealing with large cases. If a single oneline diagram is used to display a case 
having many buses, the diagram may become cluttered, and it will be difficult to analyze the 
case in sufficient detail. The ability to associate additional onelines with the case and to call 
up those additional onelines using one-links can significantly enhance your view of the 
system. 

Note that you can also use the Open Oneline command from the Application Button to 
open any oneline diagram (*.pwd) file directly. See Opening a Oneline Diagram for further 
details. 

Auxiliary File Links 

Auxiliary (*.aux) file links are one of the mechanisms used in Simulator to allow you to load 
auxiliary files by simply clicking on a oneline object. By default, auxiliary file links are shown 
as blue rectangles surrounding a text identifier of the linked auxiliary file. Double-clicking the 
left mouse button anywhere within the auxiliary file link object will load the associated 
auxiliary file. 

Note that you can also use the Load Auxiliary File command from the Application Button 
to open any auxiliary file (*.aux) directly. See Auxiliary Files for further details. 

Edit Mode 

Oneline Links 

To add a new oneline link to a oneline diagram, first select Background > Oneline Link 
from the Individual Insert ribbon group on the Draw ribbon tab. Then, click the left mouse 
button at the location where you would like to display the new link. The Oneline Link 
Options Dialog box will open, asking you to enter the name of the file that stores the linked 
oneline and a caption for the clickable oneline link object. Note that you can enter simply 
the name of the oneline file in this location. Simulator will look in the same directory as the 
case file by default. However, you can also specify additional directory locations to search 
for oneline diagrams by opening the Oneline Display Options Dialog (via Oneline Display 
Option from the Oneline Options ribbon group on the Options ribbon tab, or from the 
Active ribbon group on the Onelines ribbon tab), switching to Display Options on the left, 
and using the Edit Oneline Browsing Path option to add additional search locations for 
oneline diagrams. 

Auxiliary File Links 

To add a new auxiliary file link to a oneline diagram, first select Background > Auxiliary 
File Link from the Individual Insert ribbon group on the Draw ribbon tab. Then, click the 
left mouse button at the location where you would like to display the new link. The Oneline 
and Auxiliary Link Options Dialog will open, asking you to enter the name of the file that 
stores the linked auxiliary file and a caption for the clickable auxiliary file link object. Note 
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that you can simply enter the name of the auxiliary file in this location. Simulator will look in 
the same directory as the case file. 

Modifying Existing Links 

To modify the parameters of an existing oneline or auxiliary file link, position the cursor 
anywhere on the object and right-click. This invokes the Oneline Link Options Dialog, 
allowing you to change the identity of the linked file and the caption. Select  from the 
Formatting ribbon group on the Draw ribbon tab to modify various display attributes of the 
oneline link, including font size and background color.  
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Document Links on Onelines 

  

Just as you can link to other oneline displays from a oneline diagram using oneline link 
objects, you can also link to documents and data on the world-wide web using Document Link 
Objects. When you click on Document Link Objects in Run Mode, your system's default 
browser will be launched to retrieve the linked URL address. This feature is not only for web 
URL's, though. Any file can be linked and its associated application will automatically open. 
This means that presentations, documents and spreadsheets can also be linked. 

In addition to linking to objects online via a URL, it’s also possible to put in a local file name 
and have that open when the document link is clicked. The behavior is the same as if you 
were to click on the Windows Start button, then select Run.., then type in the file name. 

To add a Document link to a oneline diagram, select Background > Document Link from 
the Individual Insert ribbon group on the Draw ribbon tab. Then, click the left mouse on the 
oneline diagram at the position where you would link to insert the Document link. The 
Document Link Options Dialog box will appear, asking you to specify the world-wide web 
address to which to link as well as a clickable caption to display on the oneline diagram. Enter 
the requested information and press OK to add the Document link object to the oneline.  

To modify the caption or address for a Document link object, right-click anywhere on its text. 
Specify its new parameters in the Document Link Options Dialog and press OK. You may also 
modify various aspects of its appearance, including the font size, by choosing  from the 
Formatting ribbon group. 

Note that Document links are active only in Run Mode. Clicking on a Document link object 
from the Edit Mode will have no effect other than to select the object for placement, 
formatting, etc. 
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Background Lines on Onelines 

  

The background of an oneline diagram can display added lines, polylines, and filled polygons 
among other items. 

Edit Mode 

To add a new background line, first go to the Draw ribbon tab and select Background > 
Background Line from the Individual Insert ribbon group. Then to draw a series of 
straight line segments on the background, follow these steps: 

• Position the mouse cursor where you want the series to begin and click and release the 
left mouse button.  

• Move the mouse to the desired termination point of the first line segment. A straight 
segment will follow your mouse movements. Click and release the left mouse button to 
complete the line segment and prepare for drawing the next line segment, or double-click 
if this line segment is the last segment you wish to draw. 

To draw a freehand shape rather than a series of straight line segments, click and hold the 
left mouse button where you would like the freehand shape to begin and drag the mouse to 
trace the shape you desire (while holding the left mouse button down). Release the left 
mouse button to complete the section of the freehand shape you have been drawing. At this 
point, you can add either another freehand section or a straight line segment. When you 
have finished drawing in the background, double click the mouse button. 

Note that background display objects composed of straight line segments display 
significantly faster than lines drawn freehand. Lines draw freehand (holding down mouse 
button) leave a vertex point at every point on the screen, where a line composed of 
straight-line segments (left-clicking only where you want a vertex point) takes considerably 
less effort for the PC to draw.  

To change the color, line thickness, and fill color associated with the line, make use of the 
tools in the Formatting ribbon group.  

To change the shape of the line, first left-click on the line to select it. This causes handles to 
appear at each vertex. You can then move any vertex by holding the left mouse button 
down and dragging the vertex to a new location. To remove a vertex, hold down the CTRL 
key and then click the vertex you would like to delete. To add a vertex, hold down the CTRL 
key and then click on the line where you would like to add a vertex. Note that freehand lines 
are nothing more than a continuous series of vertices. 
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Background Rectangles on Onelines 

  

The background of a oneline diagram can display rectangles among other items.  

Edit Mode 

To add a new rectangle, first go to the Draw ribbon tab and select Insert > Background 
Rectangle from the Individual Insert ribbon group. Position the cursor where you would 
like to place the upper left-hand corner of the rectangle and click with the left mouse 
button. A rectangle having the default size is inserted. Drag the rectangle's resizing handles 
to resize/reshape the rectangle. 

To resize or reshape an existing rectangle, click on it to select it. The resizing handles will 
appear, which you can then drag to reshape or resize the rectangle. 

To change the color, line thickness or fill color of the rectangle, first select the rectangleby 
clicking on it on the diagram, and then use the tools in the Formatting ribbon group on the 
Draw ribbon tab, or right-click on it and select Format Background Rectangle from the 
local menu.  
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Background Ellipses on Onelines 

  

The background of a oneline diagram can display ellipses among other items.  

Edit Mode 

To add a new ellipse, first go to the Draw ribbon tab and select Background > 
Background Ellipse from the Individual Insert ribbon group. Then position the cursor 
where you would like to place the upper left-hand corner of the ellipse and click with the left 
mouse button. An ellipse having the default size and shape is inserted. Drag the ellipse's 
resizing handles to resize/reshape it. 

To resize or reshape an existing ellipse, click on it to select it. The resizing handles will 
appear, which you can then drag to reshape or resize the ellipse. 

Right-click on the ellipse and choose Format Background Ellipse, or select the ellipse and 
use the tools in the Formatting ribbon group found on the Draw ribbon tab to change the 
color, line thickness and fill color of the ellipse.  
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Background Pictures on Onelines 

  

The background of an oneline diagram can display a variety of objects, including lines, filled 
polygons, and even pictures. The latter will be discussed in this section. 

Edit Mode 

Simulator can insert bitmaps, jpegs, enhanced and standard metafiles, and icons from files 
into the oneline diagram. These pictures may either serve as a background or appear above 
other objects on the oneline. 

To add a picture object to the oneline diagram, go to the Draw ribbon tab and select 
Background > Picture from the Individual Insert ribbon group. Then, click the oneline 
diagram at the point where you would like the top left corner of the graphic to be placed. 
The Open Picture Dialog will open, asking you to select the graphic file that you want to 
insert. When you select a file from the dialog, the dialog displays a preview image so that 
you can be sure that you are selecting the right file. When you have identified the file to 
insert, click OK. The image will then appear on the oneline. It may be resized by dragging its 
resizing handles.  

By default, pictures are inserted at the middle stack level. Thus, they hide most other 
oneline display objects. To change the stack level of the picture, click it to select it, and then 
select the Levels/Layers button  found in the Formatting ribbon group of the Draw ribbon 
tab. From the Levels/Layers Tab, select the stack level of your choice. The Base stack level 
places the picture below all other oneline display objects, while the Top stack level will cause 
the picture to obscure all other display objects. 

To resize or reshape an existing picture object, click on it to select it and then drag its 
resizing handles.  
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Background Lines Dialog 

  

The Line Options Dialog is available while in edit mode by right-clicking on a background line 
and selecting Open Dialog… This dialog contains options for formatting the selected 
background line. Many of the options listed in this dialog can also be updated on the Format 
dialog.  

Line Thickness 

This field gives the thickness of the line in pixels. 

Line Color 

This field shows the current line color. To change the line’s color, click on the box displaying 
the current color or click the Change button next to the line color. This will display the Color 
Dialog. Select the desired color and select OK to change the color.  

Use Background Fill 

When this option is checked, the selected Fill Color will be used to fill the background of the 
line.  

Fill Color 

This field shows the current fill color. To change the fill color, click on the box that displays 
the current fill color or click the Change button. This will display the Color Dialog. Select the 
desired color and select OK to change the color.  

Immobile 

When this option is checked, the background line will be forced to stay in the same position 
and cannot be moved by dragging it with the mouse.  

List of Vertices 

This grid lists the x,y coordinates for the vertices of the line in the order in which the line is 
drawn. The coordinates will be displayed as longitude,latitude if the option to show 
coordinates in longitiude,latitude is selected on the Oneline Display Options dialog and a 
valid map projection is in use. The values for the coordinates can be changed by entering 
new values in the appropriate position in the grid.  

Shift X/Y Values 

These options provide a means of updating all of the x and/or y values. The X Shift Value 
is the offset by which all of the x values will be shifted. The Y Shift Value is the offset by 
which all of the y values will be shifted. The resulting values will be the original values plus 
the value entered for the shift. The Shift All Values button must be selected for the values 
entered in the shift fields to be applied to the x,y values. After this button is selected, the 
coordinates shown in the grid will be updated with the new values.   

Scale X/Y Values 

These options provide a means of updating all of the x and/or y values. The X Scale Value 
is the value by which all of the x values will be scaled. The Y Scale Value is the values by 
which all of the y values will be scaled. The resulting values will be the original values 
multiplied by the value entered for the scale. The Scale All Values button must be selected 
for the values entered in the scale fields to be applied to the x,y values. After this button is 
selected, the coordinates shown in the grid will be updated with the new values.  

OK, Save and Update Display, and Cancel 
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OK saves the changes and closes the dialog. Save and Update Display saves the changes 
and updates the display without closing the dialog. Cancel closes the dialog without saving 
any changes.  
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Converting Background Lines 

  

Background lines can be converted to other objects by splitting, merging, or converting to 
power system objects. To convert a background line, right-click on a selected background line 
on the oneline display and the local menu will be displayed with the conversion options. Most 
options are available if only a single background line has been selected and no other objects 
are selected. The following options are available for converting a background line: 
  

Split Background Line 

A background line can be split at a vertex or anywhere along the line. Click the point on the 
line where the split should be made and then right-click and select the Split Background 
Line… option from the local menu. Two background lines will result. This option is available 
only if exactly one background line has been selected and no other objects have been 
selected. 

Merge Background Lines 

This option is only available if exactly two background lines have been selected. The two 
selected background lines will be merged at the two closest ends and a single background 
line will result. 

Convert to ac Transmission Line 

After selecting this option, the Line/Transformer Information dialog will be displayed. The 
dialog options can be set the same as they would be set when inserting an ac transmission 
line from the Insert menu. This option is available only if exactly one background line has 
been selected and no other objects have been selected. 

Convert to Bus 

After selecting this option, the Bus Information Dialog will be displayed. The dialog options 
can be set the same as they would be set when inserting a bus from the Insert menu. This 
option is available only if exactly one background line has been selected and no other 
objects have been selected. 

Convert to Substation 

After selecting this option, the Substation Information Dialog will be display. The dialog 
options can be set the same as they would be set when inserting a substation from the 
Insert menu. This option is available only if exactly one background line has been selected 
and no other objects have been selected. 
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Converting Background Ellipses 

  

Background ellipses can be converted to power system objects. To convert a background 
ellipse, right-click on a selected background ellipse on the oneline display and the local menu 
will be displayed with the conversion options. The following options are available for 
converting a background ellipse: 
  

Convert to Bus 

After selecting this option, the Bus Information Dialog will be displayed. The dialog options 
can be set the same as they would be set when inserting a bus from the Insert menu. This 
option is available only if exactly one background ellipse has been selected and no other 
objects have been selected. 

Convert to Substation 

After selecting this option, the Substation Information Dialog will be display. The dialog 
options can be set the same as they would be set when inserting a substation from the 
Insert menu. This option is available only if exactly one background ellipse has been 
selected and no other objects have been selected. 
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Converting Background Rectangles 

  

Background rectangles can be converted to power system objects. To convert a background 
rectangle, right-click on a selected background line on the oneline display and the local menu 
will be displayed with the conversion options. The following options are available for 
converting a background rectangle: 
  

Convert to Bus 

After selecting this option, the Bus Information Dialog will be displayed. The dialog options 
can be set the same as they would be set when inserting a bus from the Insert menu. This 
option is available only if exactly one background rectangle has been selected and no other 
objects have been selected. 

Convert to Substation 

After selecting this option, the Substation Information Dialog will be display. The dialog 
options can be set the same as they would be set when inserting a substation from the 
Insert menu. This option is available only if exactly one background rectangle has been 
selected and no other objects have been selected. 
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Oneline Fields 

  

The Oneline Fields are fields that can be placed on an oneline diagram that display values 
specific to the current display of the diagram, such as x and y coordinate of the mouse cursor, 
animation rate, zoom percentage, and x and y coordinate of the center of the diagram at the 
center of the screen. These fields can be inserted on a oneline diagram by choosing Field > 
Oneline Field from the Individual Insert ribbon group on the Draw ribbon tab. 
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Text on Onelines 

  

Text display objects are used to show single lines of text on the oneline. 

Edit Mode 

To add descriptive text to the oneline, select Background > Text in the Individual Insert 
ribbon group on the Draw ribbon tab, and click the oneline where you would like the text to 
appear. The Text Options Dialog will open, asking you to enter the desired text string, and 
the angle at which the text is to appear on the oneline diagram. 

To modify an existing text object, position the cursor anywhere on the text and right-click. 
The New Text Options Dialog will appear, allowing you to edit the text. Use the font option  
of the Formatting ribbon group to control the font and background color of the text object. 
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Memo Text 

  

Memo Text display objects are used to show several lines of text on the oneline within an 
enclosing box. 

Edit Mode 

To add a Memo Text object to the oneline, select Background > Memo Text from the 
Individual Insert ribbon group on the Draw ribbon tab. Then click and drag to create a 
rectangle on the oneline; this rectangle will contain the lines of text you enter. 

To modify the contents of a Memo Text object, position the cursor anywhere on the object 
and right-click. To change the formatting of a Memo Text object, select the object with a 
left-click, then select  from the Formatting ribbon group on the Draw ribbon tab; this will 
bring up the Font Properties tab of the Format Multiple Objects dialog box. 
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Generic Model Fields 

  

The Generic Model Fields are fields that can be placed on an oneline diagram that display any 
value for any object in the case on the diagram. These fields can be inserted on an oneline 
diagram by choosing Field > Generic Model Field from the Individual Insert ribbon group 
on the Draw ribbon tab. 

This type of field comes in handy when you want to place a variety of fields on the diagram, 
without inserting specific object-type fields. All fields of data are available in one location for 
placement on a diagram. 
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Pie Charts/Gauges: Lines  

  

Pie Chart / Gauge Style 

The Pie Chart Style box determines whether the line flow pie charts show the percentage 
loading of the line based upon the MVA flow, the MW flow, the MVR flow, the line 
amp/transformer MVA flow, the maximum percentage loading under contingency, or the 
PTDF value. The Line Gauge Style box has the same setting options as the line flow pie 
charts. 

Always Use Limiting Flow 

Typically, the flow at opposite ends of a transmission line is slightly different due to losses 
across the line. If this option is checked, the pie chart will correspond to limiting MVA value 
of the line, independent of which end of the line that value occurs. Otherwise, the pie chart 
will always show the MVA value at the from bus for the line. 

Display Gauge Values in Percent 

Check this option to display values in the line gauges as percent of loading instead of actual 
flow values. 

  

Color, Size and Percentage 

This section of the options dialog allows you to customize the appearance of the line flow pie 
charts on the diagram. The default options for the line flow pie charts are set on the MVA tab, 
and are always in force for at least the MVA pie chart / gauge style. However, you can choose 
different settings for the other styles by selecting the corresponding tab under the Color, Size 
and Percentage section. Each of the other five styles can be set to use the same settings as 
defined for MVA by checking the given option on the page. If this option is unchecked for a 
particular style, then any pie chart on the diagram of that style type will use the specifically 
defined appearance options for that style type. 

The following parameters are all available on each of the six style tab pages: 

Show Value Percent 

When a branch's loading exceeds the value specified in the Show Value Percent field, the 
percentage loading is shown as text within the pie chart. The default is 80%. 

Normal Size Scalar, Normal Color 

The standard, pre-warning fill color and scaling factor for pie charts. 

Warning / Limit Scalars and Colors 

The table in this section allows you to choose different settings for the pie chart size and 
color, based on the percentage value represented by the pie chart or gauge. Thus you can 
set up visual clues as to when the flow on lines exceeds specified warning or limit levels. 
You can add and remove points from this table by right-clicking in the table and using the 
Insert and Delete options from the popup menu. 

To modify the Percent and size Scalar for a record in the table, simply click on the value in 
the cell and type in a new value. To change the color associated with the percent value, 
double click in the Color cell to open the Color Chooser dialog. 

Make normal color the same as the line to which the pie chart or gauge is anchored 
(if any) 
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If checked, this option will cause the pie charts to assume the same normal colors as the 
transmission lines to which they are anchored. This may be useful if the transmission lines 
are colored according to their nominal voltage level. 

Only Apply Warning/Limit Colors and Resizing to Monitored Elements 

If this option is checked, then only those pie charts that correspond to branches selected 
using the Limit Monitoring Settings will change appearance to reflect warning and limit 
loading levels. If this option is not checked, then all pie charts will obey the options 
prescribed in this dialog. 

  

Some additional options are available for pie chart appearance in situations where the line 
itself is out of service. Clicking on the tab labeled Open Parameters will display these 
options. You can choose to have special formatting for open devices by checking the available 
option, and then defining the appearance options for the pie charts on the open lines. The 
available options include scaling the size, width of the border, border color, pie chart 
background color, and drawing an "X" symbol through the pie chart. 
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Pie Charts/Gauges: Interfaces  

  

Pie Chart Style 

The Pie Chart Style box determines whether the interface pie charts show the percentage 
loading of the line based upon the MW flow, the maximum percentage loading under 
contingency, or the PTDF value. 

  

Color, Size and Percentage 

This section of the options dialog allows you to customize the appearance of the interface flow 
pie charts on the diagram. The default options for the interface flow pie charts are set on the 
Lines MVA tab. However, you can choose different settings for the interface styles by selecting 
the corresponding tab under the Color, Size and Percentage section. Each of the styles can be 
set to use the same settings as defined for Lines MVA by checking the given option on the 
page. If this option is unchecked for a particular style, then any interface pie chart on the 
diagram of that style type will use the specifically defined appearance options for that style 
type. 

The following parameters are all available on each of the six style tab pages: 

Show Value Percent 

When an interface's loading exceeds the value specified in the Show Value Percent field, 
the percentage loading is shown as text within the pie chart. The default is 80%. 

Normal Size Scalar, Normal Color 

The standard, pre-warning fill color and scaling factor for pie charts. 

Warning / Limit Scalars and Colors 

The table in this section allows you to choose different settings for the pie chart size and 
color, based on the percentage value represented by the pie chart or gauge. Thus you can 
set up visual clues as to when the flow on interfaces exceeds specified warning or limit 
levels. You can add and remove points from this table by right-clicking in the table and using 
the Insert and Delete options from the popup menu. 

To modify the Percent and size Scalar for a record in the table, simply click on the value in 
the cell and type in a new value. To change the color associated with the percent value, 
double click in the Color cell to open the Color Chooser dialog. 

Make normal color the same as the line to which the pie chart or gauge is anchored 
(if any) 

If checked, this option will cause the pie charts to assume the same normal colors as the 
interface to which they are anchored. This may be useful if the interfaces are colored 
differently on the diagram. 

Only Apply Warning/Limit Colors and Resizing to Monitored Elements 

If this option is checked, then only those pie charts that correspond to interfaces selected 
using the Limit Monitoring Settings will change appearance to reflect warning and limit 
loading levels. If this option is not checked, then all interface pie charts will obey the options 
prescribed in this dialog. 
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Pie Charts/Gauges: Pie Chart/Gauge Styles 

  

This section shows the Pie Chart/Gauge styles in a case information display. The user can edit 
several of the fields directly. Otherwise, by right-clicking on any part of the case information 
display and selecting on Show Dialog in the popup menu, the Pie Chart/Gauge Style dialog, 
where all the values can be modified. 
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Pie Charts/Gauges: General Options  

  

Show Limit Set in Header 

If this option is checked, the pie chart will display a text field showing the letter of the limit 
set presently being used for the element. 

Show Style in Footer 

When checked, the pie chart will display a text field showing the style (MVA, MW, etc) that 
the pie chart is set to (refer to the Style property described above.) 

Max. Zoom Percentage for Full Resizing 

The pie charts dynamically resize when you are zooming in and out on a oneline diagram. 
However, you can limit the point at which the pie charts resize when zooming in by setting a 
zoom level in this field. This helps prevent the pie charts from getting so large that they 
occupy the entire screen. 

Min. Pie Chart Font Size for Warning/Limit 

Specifies a minimum font size for displaying text in the pie chart object. This is useful when 
zooming out on the diagram, to keep the text visible by setting a minimum font size. 

Background Color 

The background color for the pie charts is automatically set to be the same as the online 
background. For a different color, select Specific color from the drop-down menu, and then 
click on the rectangle to the right to select the color. For a clear background, select Clear 
from the dropdown menu. 

Pie Chart Relative Font Size 

Slide the slider bar to select the font size for the pie chart. This will determine the size of the 
font indicating the percentage on the pie chart. 

Pie Chart Font Color 

Slide the slider bar to select the font size for the pie chart. This will determine the size of the 
font indicating the percentage on the pie chart. 
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Pie Chart / Gauge Dialogs 

  

There are a number of pie chart/gauge objects that can be added to one-line diagrams. These 
objects are inserted via the Pies/Gauges menu in the Individual Insert ribbon group on the 
Draw ribbon tab and include Areas, Buses, Generators, Injection Groups, Owners, Substations, 
Super Areas, Switched Shunts, Transformers, and Zones. The dialogs for these objects contain 
a common set of options that are required regardless of the object type. These common 
options as well as specific settings for the different object types are detailed below. 

The Pie Chart / Gauge Example shows how the fields in this dialog affect the pie chart or 
gauge display. The items shown in the diagram are explained in more detail throughout this 
section and in the Pie Chart / Gauge Style Dialog description. 

Identification 

All dialogs have a section at the top that identify the pie chart/gauge object based on the type 
of device that the pie chart/gauge represents. The Find…button is available on most dialogs 
to open the Find tool that can be used to advanced search for a device. Specific identifying 
information for the different dialogs is given below: 
• AreaThe area that the pie chart/gauge represents is identified based on Area Number or 

Area Name. To change the area that is represented, select an Area Number or Area 
Name from the dropdown boxes or click the Find button. The dropdown boxes are 
populated with all areas in the case.  

• BusThe bus that the pie chart/gauge represents is identified based on Bus Number or 
Bus Name. To change the bus that is represented, select a Bus Number or Bus Name 
from the dropdown boxes or click the Find button. The dropdown boxes are populated 
with all buses in the case with valid area/zone/owner filters. 

• GeneratorThe generator that the pie chart/gauge represents is identified based on Bus 
Number and Gen ID or Bus Name and Gen ID. To change the generator that is 
represented, select a Bus Number or Bus Name from the dropdown boxes and change 
the Gen ID in the edit box or click the Find button. The dropdown boxes are populated 
with all buses in the case with valid area/zone/owner filters. 

• Injection GroupThe injection group that the pie chart/gauge represents is identified 
based on the Injection Group Name. To change the injection group that is represented, 
select a new name from the dropdown box. The dropdown box is populated with all 
injection groups in the case. 

• OwnerThe owner that the pie chart/gauge represents is identified based on Owner 
Number or Owner Name. To change the owner that is represented, select an Owner 
Number or Owner Name from the dropdown boxes or click the Find button. The 
dropdown boxes are populated with all owners in the case. 

• SubstationThe substation that the pie chart/gauge represents is identified based on 
Substation Number, Substation Name, or Substation ID. To change the substation 
that is represented, select a Substation Number, Substation Name, or Substation 
ID from the dropdown boxes or click the Find button. The dropdown boxes are populated 
with all substations in the case. 

• Super AreaThe super area that the pie chart/gauge represents is identified based on 
Super Area Name. To change the super area that is represented, select a new name 
from the dropdown box or click the Find button. The dropdown box is populated with all 
super areas in the case. 

• Switched ShuntThe switched shunt that the pie chart/gauge represents is identified 
based on Bus Number and ID or Bus Name and ID. To change the switched shunt that 
is represented, select a Bus Number or Bus Name from the dropdown boxes and 
change the ID in the edit box or click the Find button. The dropdown boxes are 
populated with all switched shunts in the case with valid area/zone/owner filters. 
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• TransformerThe transformer that the pie chart/gauge represents is identified based on 
Near Bus Number, Far Bus Number, and Circuit or Near Bus Name, Far Bus 
Name, and Circuit. To change the transformer that is represented, click on the Find 
button to use the Find tool. 

• ZoneThe zone that the pie chart/gauge represents is identified based on Zone Number 
or Zone Name. To change the zone that is represented, select a Zone Number or Zone 
Name from the dropdown boxes or click the Find button. The dropdown boxes are 
populated with all zones in the case.  

Type of Field 

Use this option to select the field to display in the pie chart/gauge. Fields that are deemed 
of more common interest are listed for easy access. Any field associated with a particular 
device can be selected by first choosing Select a Field and then finding the particular field 
in the dropdown listing all available fields or by clicking Find Field and searching for the 
field of interest.  

Current Value 

Percent 
This is the percent value calculated from the current value of the selected field. How the 
percent is calculated is based on the selection of limits and deadband and options 
associated with the Style. Details of the percent calculation are given in the Pie 
Chart/Gauge Style Dialog description.  

Value 

This is the current value of the selected field. 

In-Service 

When checked, the device represented by the pie chart/gauge is in-service. This is given 
for informational purposes only, as the status of devices cannot be changed from this 
dialog. 

Display Information 

Type 

Select to display either a Pie Chart or Gauge. 

Gauge Orientation 

If Type option of Gauge is selected, set this option to draw either a Vertical or Horizontal 
gauge. 

Anchored  

When checked, the pie chart/gauge will be anchored to the display object representing 
the selected device. 

Size, Width, Use Fixed Gauge Width/Size Ratio 
Size determines the size of a pie chart and the vertical side length of a vertical gauge or 
horizontal side length of a horizontal gauge. Width is not applicable to a pie chart but 
determines the horizontal side length of a vertical gauge or the vertical side length of a 
horizontal gauge. Width is not enterable if the option of Use Fixed Gauge 
Width/Size Ratio is checked. This option is checked if the Gauge Width is Always a 
Fixed Proportion of Size option is checked on the Style dialog. The fixed width/size 
ratio is also set on the Style dialog. 

Ignore Dynamic Sizing 
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When checked, any sizing based on the calculated percent will be ignored and the pie 
chart/gauge will stay at the defined size. Options to set the sizing based on calculated 
percent can be found on the Style dialog. 

Ignore Dynamic Open Sizing 
When checked, any sizing of pie chart/gauges based on the device that is represented 
being out-of-service will be ignored and the object will stay at the defined Size. Options 
to set the sizing for open devices can be found on the Style dialog. 

Always Show Value (Percent) 
When checked, the options set on the Style dialog to display the percent on pie 
chart/gauges are ignored and the percent value is always shown. 

Style, Show Style Dialog 

The Style defines the set of generic options that can be applied to any pie chart/gauge. 
An already defined style can be selected from the dropdown. Click Show Style Dialog 
to modify an existing style or to create a new style; this opens up the Pie Chart / Gauge 
Style Dialog. 

Limits 

Low Limit, High Limit 

Determines the low and high values from which the percent will be calculated and the 
gauge fill will be drawn. These values are not enterable if the limits are determined from 
the Style or based on device limits. More information on how these limits are used in 
calculating the percent is given in the Pie Chart Parameters Tab and Gauge 
Parameters Tab sections in the Pie Chart/Gauge Style Dialog description. 

Use Device Low Limit 

When checked, the low limit will be determined from the low limit defined for the device 
for the selected field type. If device limits are not defined for the selected field, this 
option will not be enabled. If not enabled, the low limit will be based on the value 
entered in the Low Limit box.  

Use Device High Limit 

When checked, the high limit will be determined from the high limit defined for the 
device for the selected field type. If device limits are not defined for the selected field, 
this option will not be enabled. If not enabled, the high limit will be based on the value 
entered in the High Limit box.  

Override with Limits from Style 

When checked, the high and low limits from the selected Style will be used.  

Zero Percent Deadband 

Use Style Zero Percent Deadband 

When checked, the zero percent high limit and zero percent low limits from the selected 
Style will be used. 

Zero Percent Low Limit, High Limit 
Determines the low limit and high limit for the zero percent deadband from which the 
percent will be calculated and the gauge fill will be drawn. These values are not 
enterable if the deadband is determined from the Style. The deadband represents the 
range of values for which the calculated percent will be zero. More information on how 
the deadband limits are used in calculating the percent is given in the Pie Chart 
Parameters Tab and Gauge Parameters Tab sections in the Pie Chart/Gauge 
Style Dialog description.  
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Pie Chart / Gauge Style Dialog 

  

The Pie Chart/Gauge Style Dialog is available from any of the pie chart/gauge dialogs by 
selecting Show Style Dialog or from Options > Oneline Display Options… > Pie 
Charts/Gauges on the Pie Charts/Gauge Styles tab. 
This dialog lists options that can be commonly applied to pie chart/gauge objects so that these 
same options do not have to be set for every individual object. The defined styles can be 
applied to any of the new pie chart/ gauge objects that include Areas, Buses, Generators, 
Injection Groups, Owners, Substations, Super Areas, Switched Shunts, Transformers, and 
Zones. These styles are currently not applicable to Lines and Interfaces. Some options are 
related to options that are set for individual pie chart/gauges. More information about 
individual object settings can be found in the Pie Chart/Gauge Dialogs section.  

The Pie Chart / Gauge Example shows how the fields in this dialog affect the pie chart or 
gauge display. The items shown in the diagram are explained in more detail throughout this 
section and in the Pie Chart / Gauge Dialogs description. 

Creating and Saving Styles 

Style Name  

Drop-down box lists all currently defined pie chart/gauge styles. Select Add New to 
create a new style. Select Rename to change the name of an existing style. Select 
Delete to remove an existing style.  

Save AXD 

Save all currently defined pie chart/gauge styles to a Display Auxiliary file.  

Load AXD 

Load pie chart/gauge styles from a Display Auxiliary file.  

Hide all Style Objects (except in edit mode) 

When checked, the pie chart/gauge will not be visible in run mode.  

Show Header (Object ID) 

When checked, the header of the pie chart/gauge will contain identifying information about 
the device that the pie chart/gauge represents. 

Show Footer (Field Type) 

When checked, the field type that is being used in the pie chart/gauge will be displayed in 
the footer of the pie chart/gauge.  

Default Style 

When checked, this style is one of the default styles that are defined. Default styles cannot 
be renamed or deleted. This is an informational field and cannot be changed by the user.  

Limits and Zero Percent Deadband Values 

Define the High and Low Limits to use when the option Override with Limits from Style 
is selected for the pie chart/gauge that is using this style and the High and Low Zero Percent 
Deadbands to use when the option Use Style Zero Percent Deadband is selected for the 
pie chart/gauge that is using this style. The deadband represents the range of values for 
which the calculated percent will be zero. More information is given in the Pie Chart 
Parameters Tab and Gauge Parameters Tab sections on how the limits are used in 
calculating the percent. 

The remainder of the dialog is broken down into four tabs: 
• Standard Parameters 
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• Open Parameters 
• Pie Chart Parameters 
• Gauge Parameters 

 



Building a Oneline Diagram 

231 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Pie Chart / Gauge Style Dialog - Standard Parameters Tab 

  

Normal Scalar, Normal Fill Color 

These are the standard, pre-warning scaling factor and fill color for pie chart/gauges. To 
change the color, click on the color to open the Color dialog. 

Font Color 

Font color of the text displayed in the pie chart/gauge. To change the color, click on the 
color to open the Color dialog.  

Border Width 

Width of any border portion of the pie chart/gauge. The border of a pie chart encloses the 
entire pie chart as well as the filled portion of the pie chart. The border of a gauge encloses 
the entire gauge. The border width also impacts the width of the lines marking the limits 
and deadband on the gauge.  

Border Color 

Color of any border portion of the pie chart/gauge. The border of a pie chart encloses the 
entire pie chart as well as the filled portion of the pie chart. The border of a gauge encloses 
the entire gauge. The border color also is the color used for the lines marking the limits and 
deadband on the gauge. To change the color, click on the color to open the Color dialog. 

Border Color Same as Fill Color 

When checked, the border color will be the same color as the fill color and the color selected 
in the Border Color will be ignored.  

Background Color 

The drop-down box allows selection of three options for the background color: Oneline 
Background, Specific Color, and Clear. Oneline Background will color the pie chart/gauge 
background the same color as the selected background color for the oneline. Specific Color 
will allow the selection of a user specified color. To specify a color, click the box to the right 
of the drop-down to open the Color dialog. The Clear option will not use a background color 
and objects underneath the pie/chart gauge will be visible through the unfilled portions of 
the pie chart/gauge.  

Relative Font Size 

Modify the track bar to adjust the size of the font relative to the size of the pie chart/gauge. 

Max Zoom Percent for Full Resize 

Pie chart/gauges dynamically resize when zooming in and out on oneline diagrams. A limit 
can be placed on the point at which the pie chart/gauges resize when zooming in by setting 
a zoom level in this field. This helps prevent the pie chart/gauges from getting so large that 
they occupy the entire screen.  

Warning/Limit Scalars and Colors 

The table in this section allows the definition of different settings for pie chart/gauge size 
and fill color based on the percent value represented by the pie chart/gauge. Points can be 
added or removed from this table by right-clicking in the table and using the Insert and 
Delete options from the popup menu.  

To modify the Percent and size Scalar for a record in the table, click on the value in the cell 
and type in a new value. To change the color associated with the percent value, double click 
in the Color cell to open the Color dialog. 
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Use Discrete Map 

When checked, discrete colors will be used for the pie chart/gauges based on the colors 
specified in the table. Otherwise, colors will be blended if the percentage represented in the 
pie chart/gauge falls between percentages defined in the table. 
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Pie Chart / Gauge Style Dialog - Open Parameters Tab 

  

Open parameters are applied to any pie chart/gauges when the device that they represent is 
out-of-service. 

Special Formatting for Open Devices 

When checked, the Open Size Scalar, Open Border Width, and Open Border Color 
options are applied when a device is out-of-service. 

Use Special Open Background Color 

When checked, the Open Background Color option is applied. 

Open Symbol 

When an Open Symbol other than None is selected, the symbol will be drawn in the 
selected Open Symbol Color. 
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Pie Chart / Gauge Style Dialog - Pie Chart Parameters Tab 

  

Options given on this tab only apply to how pie charts are displayed. 

Show Value Percent 

When the percent of the pie chart/gauge exceeds the value specified in this field, the 
percent is shown as text within the pie chart/gauge. The default is 80%. 

Display of Values Below the Zero Percent Deadband 

The selection of this option determines how to calculate the percent represented in pie 
charts. Four parameters are required for determining this: low limit, high limit, zero percent 
low limit, and zero percent high limit. These four limits are determined from options set with 
individual pie charts and/or options set with the style. In general, the zero percent low limit 
and zero percent high limit define the deadband in which the percent is zero. The percent is 
then determined based on where the selected field value falls within the high limit and zero 
percent high limit and the low limit and zero percent low limit. The specific calculations used 
for determining the percent is given for the options below. In all cases if the limits are not 
defined correctly (i.e., none of the If..then statements below apply), the percent will be 
returned as zero.  

• Allow negative percent values 
o If (field value) > (zero percent high limit) and (high limit) > (zero percent high 

limit) then  
Percent = ((field value) – (zero percent high limit))/((high limit) – (zero percent 
high limit)) 

o If (field value) < (zero percent low limit) and (low limit) < (zero percent low 
limit) then 
Percent = ((field value) – (zero percent low limit))/((zero percent low limit) – 
(low limit)) 

• Use absolute value (i.e., percent always >= 0) 
o Same calculations as in Allow negative percent values except that the 

absolute value of the calculated percentage is reported. 
• Low limit is zero percent 

o The zero percent deadband limits are ignored in this option and the percent is 
calculated based on the low and high limits only 

o If (high limit) > (low limit) then 
Percent = ((field value) – (low limit))/((high limit) – (low limit)) 

• Treat values below zero deadband as zero 
o If (field value) > (zero percent high limit) and (high limit) > (zero percent high 

limit) then 
Percent = ((field value) – (zero percent high limit))/((high limit) – (zero percent 
high limit)) 

o If (field value) < (zero percent low limit) and (low limit) < (zero percent low 
limit) then 
Percent = 0 
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Pie Chart / Gauge Style Dialog - Gauge Parameters Tab 

  

Options given on this tab only apply to how gauges are displayed. 

Show Limit Labels 

When checked, text labels will be drawn with the gauge showing the four limits in use.  

Include Units in Limit Labels 

When checked, units will be included when the limit labels are shown. 

Numeric Value Type 

This option allows the numeric value to either be displayed as the Actual Value or the 
calculated Percent value. 

Display of Numeric Value 

This option determines when the value of the field is displayed with the gauge. Never will 
not show the value, Always will always show the value, and If Violating Warning/Limit 
Value will only show the value if it is outside of the limit range that is currently in use.  

Digits to Right of Decimal 

This parameter determines how many digits to the right of the decimal are displayed in the 
limit labels and the numeric value when they are shown with the gauge.  

Gauge Width is Always a Fixed Proportion of Size 

When checked, the Gauge Fixed Width/Size Ratio is used to determine the width of the 
gauge as a proportion of the size (height). Note: the size of gauges is specified for individual 
gauges on the pie chart/gauge dialogs.  

Gauge Fixed Width/Size Ratio 

Specifies the ratio of the gauge width to the size when the Gauge Width is Always a 
Fixed Proportion of Size option is checked.  

Percent Overhang on Top of Gauge 

The overhang at the top of the gauge is the region above the high limit line. The size of this 
region is defined as a percentage of the total size of the gauge.  

Percent Overhang on Bottom of Gauge 

The overhang at the bottom of the gauge is the region below the low limit line. The size of 
this region is defined as a percentage of the total size of the gauge. 

Gauge Fill and Percent Calculation 

These options determine how the calculated percent will be displayed and how the gauge 
will be filled. Four parameters are required for determining these: low limit, high limit, zero 
percent low limit, and zero percent high limit. These four limits are determined from options 
set with individual gauges and/or options set with the style. In all cases if the limits are not 
defined correctly, the percent will be returned as zero. 

Use Absolute Value for Percent 
When checked, the displayed percent will be the absolute value of the calculated 
percent. This option does not impact how the gauge will be filled. 

Gauge Fill Options (Zero Percent Reference) 

This option determines how the gauge will be filled. If Fill up or down from 
deadband is selected, the fill will begin at the low or high deadband limit and continue 
up or down depending upon where the field value falls within the defined limits. If Fill 
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up from bottom is selected, the fill will begin at the bottom of the gauge and fill up to 
the field value.  

Regardless of which fill option is selected, the following equations will be used to 
calculate the percent based upon where the field value falls within the defined limits: 

If (field value) > (zero percent high limit) and (high limit) > (zero percent high 
limit) then 

Percent = ((field value) – (zero percent high limit))/((high limit) – (zero percent 
high limit)) 
  

If (field value) < (zero percent low limit) and (low limit) < (zero percent low 
limit) then 

Percent = ((field value) – (zero percent low limit))/((zero percent low limit) – 
(low limit)) 

Ignore Deadband 

When checked, deadband limits are ignored. This effectively forces the fill to start from 
the bottom of the gauge and fill up to the field value. The percent is calculated based on 
the following equation and will always be reported as the absolute value: 

If ((high limit) – (low limit)) <> 0 then 

Percent = ((field value) – (low limit))/((high limit) – (low limit)) 

Override Low Limits with a Value of Zero 

When checked, the low limit value will be set to zero when determining the fill and 
calculating the percent. This option is only applied if the Ignore Deadband check box is 
also checked. The percent is calculated based on the following equation and will always 
be reported as the absolute value: 

If ((field value) > 0) and ((high limit) <> 0) then 

Percent = (field value)/(high limit) 
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Pie Chart / Gauge Example 
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Chapter 5: Edit Mode Tools and Options 

  

Edit Mode provides a number of commands for customizing and modifying the case that are 
different from Run Mode. 

This chapter covers the following: 
• General Edit Mode Tools 
• Insertion Using Palettes 
• Automatic Object Insertion 
• Equivalencing 
• System Scaling 
• Facility Analysis 
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Appending a Case 

  

The Append Case command allows you to append additional power system components to an 
existing case. Unlike the Open Case command, Append Case does not delete the existing case 
(if any) before loading the selected case. To append a case to the existing case, go to the 
Tools ribbon tab and choose Modify Case > Append Case  from the Edit Mode ribbon 
group.   

The Append Case command can be useful when used in conjunction with the Equivalencing 
Display.  
  

Notes 

Appended data completely overwrites an existing record corresponding to the same bus 
number(s). 

Branch elements are appended to a case only if both of their terminal buses exist. 
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Refresh Anchors 

  

The Refresh Anchors option of the Formatting ribbon group on the Draw ribbon tab allows 
you to update or reset the anchoring of objects on a oneline diagram to their respective 
anchor. It can be advantageous to use the Refresh Anchors option when opening onelines that 
were created by another case, copying and pasting data between onelines, or renumbering 
objects on the oneline. This ensures the anchoring of objects to the appropriate anchor on the 
oneline diagram. 
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Bus Renumbering Dialog 

  

The Renumber Buses Display allows you to change the bus numbers for either the entire 
power system case, and/or for any open oneline diagrams. To show this display, while in Edit 
Mode, go to the Tools ribbon tab, and choose Renumber > Renumber Buses from the Edit 
Mode ribbon group. 

The bus renumbering feature is provided because it is sometimes necessary to renumber 
buses in the power system model, either to make room for new buses or to move buses to a 
different zone or area that has a different numbering scheme. It may also be necessary to 
renumber bus display objects on the oneline if you want to use the oneline with a case other 
than the one for which it was originally designed. The bus renumbering feature provides a 
convenient way of accomplishing this. 

The table at the bottom of the Bus Renumbering Dialog is used to manage the lists of current 
bus numbers and any desired changes to the numbering scheme. You can specify the bus 
numbers to change and their new values by directly typing them into the table. Alternatively, 
you can generate the bus list automatically by selecting one of the Automatic Setup of Bus List 
Options and clicking the Setup Bus Swap List button. The Automatic Setup options allow 
you to add to the list all buses in the case, all buses in the case subject to the 
area/zone/owner filter constraints, all buses currently displayed on the oneline, or a set of 
numbers from a text file.  

The table behaves just like a Case Information Display and thus has a local menu that can be 
invoked by clicking the right mouse button. Select Insert from the local menu to insert a new 
bus number to change, or select Delete to delete a bus number that is currently in the list. 
Select Show Dialog to display the Bus Information Dialog corresponding to the bus number 
on which you right-clicked. You may clear the entire list by pressing the Clear Bus List 
button. 

Once you have indicated which buses you would like to renumber in the table, select an option 
from Bus Change Options to specify where you would like to implement the changes (in 
both the case and the oneline, in the case only, or in the oneline only). Make the changes by 
pressing the Change Bus Numbers button. Close the dialog by pressing Close. 

The Automatic Setup of Bus List and Bus Change options deserve further discussion. See for 
further details or click NEXT. 
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Bus Renumbering: Automatic Setup of Bus List Options 

  

This section of the Bus Renumbering Dialog is used to generate automatically a list of the 
buses to be renumbered. Select an option from the list and click on the Setup Bus Swap List 
button to generate the list, or Clear Bus Swap List to clear the list.  
  

Load All Buses in Cases 

Creates entries in the table for every bus in the system. By default the new bus number is 
the same as the old bus number. Of course you do not have to renumber every bus. If you 
would like a bus to keep its same number, either add that bus to the table, or simply have 
an entry with the old and new bus numbers identical. 

Load Buses with Valid Area/Zone Filters 

Same as the Load All Buses In Case option except only those buses with valid 
area/zone/owner filters  are added. This allows you to easily modify the bus numbers in just 
an area or zone.  

Load Only Buses on Oneline 

Creates entries in the table only for those buses on the current oneline. This option is most 
useful when you are just changing the buses on the onelines. 

Load Buses From Text File 

Creates entries in the table using an external text file. The format of this file is as follows: 

1 11  Specifies converting from old bus number 1 to new bus number 11 

2 22  Specifies converting from old bus number 2 to new bus number 22  

etc. 

Freshen Current Oneline 

The Freshen Current Oneline option is designed to help you quickly renumber an existing 
oneline to work with a new numbering scheme. You will find this method helpful if you have 
been using the oneline with a case and now must use it with a different case having a 
different set of bus numbers, but the same bus names. Freshen Current Oneline will try to 
match the buses on the oneline with the buses in the new case by matching bus names and 
kV, rather than by number (which is how Simulator usually tries to link bus display objects 
with bus records in the case). The best way to learn how to use Freshen Current Oneline is 
to consider the following example:  

  

To update an old oneline to work with a new bus numbering scheme:  

• Open the oneline and the old case with which it was used. 
• Choose Renumber > Renumber Buses from the Edit Mode ribbon group on the Tools 

ribbon tab.  
• Select Load Only Buses on Oneline and press the Setup Bus Swap List button. 
• Change the Swap? field values all to Yes.  
• Right click on the table and choose Save List to File. Give the file a name. For this 

example, we'll name the file "oldscheme.txt." This file will contain the list of buses 
represented on the oneline, specifying each bus's number, name, kV, and area.  

• Close the old case.  
• Open the new case and the oneline you wish to renumber. If any other onelines open with 

the case, close them. You want only the oneline you wish to renumber to be shown.  
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• Choose Renumber > Renumber Buses from the Edit Mode ribbon group on the Tools 
ribbon tab.   

• Select Freshen Current Oneline and specify the file "oldscheme.txt" (for this example). 
Click the Setup Bus Swap List button. Simulator will match the old numbering scheme 
used in the oneline with elements in the new case by name and kV. If it finds more than 
one match, it will use the element's area name as a tie breaker. If it still can't reconcile the 
multiple matches, it will add both renumbering options to the table.  

• Go through the new list and make sure that you want to swap the buses that are listed. If 
you do, change the Swap? field value for each to Yes (you can do this quickly for all 
buses by right-clicking on the Swap? column and choosing Toggle All Yes). Be sure to 
reconcile any duplicate bus renumbering suggestions. These are cases for which Simulator 
could not determine how to renumber the buses because a bus on the diagram matches 
more than one bus in the case by name, kV, and area.  

• Click the Change Bus Numbers button at the bottom of the form.   

Once the oneline has been renumbered, save it with the case by selecting Save Case (or 
Save Case As if you wish to give it a different name) from the Application Button. See Bus 
Change Options for additional details. 
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Bus Renumbering: Bus Change Options 

  

This option is used to specify which buses to change.  
  

Change Both Case and Onelines (default) 

Renumbers the buses in both the case and any open oneline diagrams. 

Change Only Case 

Only renumbers the buses in the case. The oneline bus numbers are not changed.  

Change Only Onelines 

Only renumbers the buses on the onelines. The case itself is not changed. You would want 
to select this option if you have already changed the case (or loaded a different one), but 
now have several onelines based on that case that also need to be changed. See Automatic 
Setup of Bus List Options for more details. This is the most commonly used option. 
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Renumber Areas/Zones/Substations Dialog 

  

The Renumber Areas/Zones/Substations Dialog is available while in Edit Mode, by going to the 
Tools ribbon tab, and choosing Renumber > Renumber Areas/Zones/Substations from 
the Edit Mode ribbon group.This dialog allows the renumbering of areas, zones, and 
substations for either the entire power system, and/or for any open oneline diagrams. This 
dialog is similar to the Renumber Buses Dialog.  

This feature is provided because it is sometimes necessary to renumber areas, zones, or 
substations in the power system model, either to make room for new elements or to move 
elements to different area, zones, or substations that have a different numbering scheme. It 
may also be necessary to renumber display objects on the oneline if the oneline is used with a 
case other than the one for which it was originally designed. The areas/zones/substations 
renumbering feature provides a convenient way of accomplishing this. 

The table at the bottom of the Renumber Areas/Zones/Substations Dialog is used to manage 
the list of areas, zones, and substations available for renumbering. This list is populated by 
selecting one of the Automatic Setup of Swap List options. The Automatic Setup options 
allow the addition of all areas, zones, or substations in the case or only those on the oneline. 
An option is also available to read the swap information from a file or to setup the swap list 
based on the current oneline. The Types to Insert option is available for specifying whether 
or not to add areas, zones, and substations to the swap list. Once the swap list option and 
types to insert have been selected, click the Setup Swap List to populate the table.  

The table behaves just like a Case Information Display and thus has a local menu that can be 
invoked by clicking the right mouse button. Select one of the Insert options from the local 
menu to insert a new area, zone, or substation number to change, or select Delete to delete 
an element number that is currently in the list. The entire list may be cleared by clicking the 
Clear Swap List button. The Present Number for the element is specified in the list. 
Change the New Number field to specify the updated number of the area, zone, or 
substation.  

The Renumber Options allows the specification of where the renumbering changes should 
be implemented. The changes can be applied to the power system case only, the oneline only, 
or both the case and the oneline. 

Once the elements to renumber have been specified and the New Number fields have been 
set appropriately, implement the changes by pressing the Renumber button. The changes 
will be applied to the case and/or oneline as specified in the Renumber Options. Close the 
dialog by pressing Close. 
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Merging Buses 

  

Two or more buses can be merged to a new bus in Edit Mode with the loads, generators, and 
shunts of the buses merged moved to the new bus. The transmission lines among the buses 
merged will be deleted while the transmission lines connecting the merged buses and buses 
which are not selected to merge will be moved to the new bus.  

To join two or more buses together using the oneline display, select at least two power system 
elements (at least one of them being a bus), then right click on one of the selected elements 
to invoke the popup menu and select Merge selected buses. In the Bus Merging Dialog, 
specify the buses to merge further if needed by clicking Add and/or Delete button. To add 
buses to merge, click Add and select all the needed buses in the Choose a Bus dialog and 
click OK. To delete from already selected buses, select the buses to delete and click the 
Delete button.  

Once you have the elements to merge selected, enter the number, name, nominal voltage, 
zone number, area number and substation number for the new bus. These properties can be 
set to be the same as one of buses to merge by selecting it in the Specify buses to merge 
box and pressing the Set new bus properties same as selected bus. 

Buses can also be merged in the Bus Case Information Display. To do so, select a cell and 
right click to popup the local menu. Select Merge selected buses. The buses to merge and 
the properties of the new bus can be edited in the Bus Merging Dialog.  

When buses are merged from the oneline diagram, the selected buses will be joined in both 
the PWB case and the oneline. When buses are merged from the bus grid, the selected buses 
will be joined only in the PWB case but not in the oneline. This might result in bus objects not 
connected to bus records in the oneline.  
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Splitting Buses 

  

Simulator assists you in transforming one bus into two connected buses. This process is called 
splitting a bus. In performing the split, the user is able to decide which equipment to keep 
connected to the original bus and which equipment to move to the new bus. Because this 
activity impacts the structure of the power flow equations, bus splitting can be performed only 
in Edit Mode. 

To split a bus from the oneline diagram, right click on the bus you wish to split, and click Split 
Bus from the resulting local menu. To split a bus from the Bus Case Information Display, 
right-click on its corresponding record and again click Split Bus from the resulting local menu. 
In either case, the Split Bus Dialog will appear. 

Multi-section lines merit special consideration during bus split operations. These are the rules 
Simulator follows when you try to split a bus that is part of a multi-section line. If the original 
bus is the endpoint bus of a multi-section line and the ending line segment was transferred to 
the new bus, then the new bus becomes the new ending terminal of the multi-section line. If 
the original bus was a dummy bus of the multi-section line, and if exactly one of the branches 
connected to the original bus is rerouted to the new bus, then both the new bus and the 
original bus will be dummy buses in the reconstituted multi-section line. If neither or both of 
the lines connected to the original dummy bus were rerouted to the new bus, then the multi-
section line definition is eliminated, since Simulator has no way to determine how the multi-
section line should be redefined. 

A final consideration involving bus splits is how sequence data is treated. If you have defined 
sequence data for fault analysis, Simulator will recalculate the sequence data for the original 
and new buses after the split. In this case, the zero sequence impedance for the new branch 
that connects the original and the new bus will be set to j0.0001. 
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Split Bus Dialog 

  

The Split Bus dialog contains two sections labeled Existing Bus and New Bus. These 
sections enable you to designate the bus you want to split and the name and number of the 
new bus created by the bus split operation. If you opened the Split Bus Dialog from either the 
Bus Case Information Display or an oneline diagram, the Existing Bus Name and Number fields 
will be read-only and will identify the bus you selected. However, if you opened the Split Bus 
Dialog from the Modify Case Menu on the Edit Mode ribbon group on the Tools ribbon tab, 
you will first have to choose a bus to split. In this case, use the Find… speed button located 
next to the Existing Bus label to select the bus to split, or simply type its number in the 
Existing Bus Number field. Then, provide the name and number for the new bus to create 
using the New Bus Name and Name fields. The number you specify in the New Bus Number 
field must be unique; it cannot be a number that identifies another bus in the case. If you do 
specify an existing number, Simulator will issue an error message and require you to specify a 
different number. If you choose not to specify a name for the new bus, Simulator will set the 
name of the new bus to be the same as the bus’s number. 

Once you have identified the bus to split and the name and number for the new bus resulting 
from the split, you may then specify whether a bus tie should be inserted between the existing 
bus and the soon-to-be-created new bus. By checking the Insert bus tie between existing 
and new buses checkbox, you command Simulator to place a very low-impedance bus tie 
between the bus to split and its offspring. The new branch will have an impedance of 0.0000 
+ j0.0001 ohms. If the bus tie should be inserted as an open branch, check the Normally 
open checkbox. This option becomes available, of course, only if you elect to have Simulator 
automatically add the new bus tie. 

After you have finished making your selections, click OK. Simulator will create the new bus, 
assign its electrical attributes to match those of the existing bus, and add the bus to the power 
system model. If a oneline diagram is currently active and the existing bus is represented on 
it, Simulator will add a symbol for the new bus to the diagram, placing it immediately to the 
right of the existing bus’s symbol. If you elected to create a bus tie between the existing and 
new buses, Simulator will also add a symbol for the bus tie to the diagram.  

Finally, Simulator will automatically open the Equipment Mover Dialog to help you manage the 
transfer of equipment from the existing bus to the new bus. 
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Equipment Mover 

  

Simulator provides a convenient tool for transferring equipment between buses. Simulator 
allows you to move bus shunts, loads, generators, switched shunts, and transmission lines 
between buses. For loads, generators, and both varieties of shunts, Simulator offers you the 
ability to transfer all or part of the equipment from the origin bus to the destination bus. 

Equipment may be transferred between buses using the Equipment Mover Dialog. The 
Equipment Mover Dialog can be opened in any of four ways: 
  
• Go to the Tools ribbon tab and choose Modify Case < Move Bus Equipment... from 

the Edit Mode ribbon group.  
• On the oneline display right-click on the bus from which you want to move equipment and 

select Move Equipment… from the resulting local menu. 
• From a Bus Case Information Display, right-click on the record corresponding to the bus 

from which you want to move equipment and select Move Equipment … from the 
resulting local menu. 

• As the final step of the Split Bus operation. 

Regardless of the approach you take, Simulator will then open the Equipment Mover Dialog. 
The Equipment Mover Dialog consists of three sections. The top portion of the dialog is split in 
two sections that identify the bus from which equipment will be transferred (on the left) and 
the bus equipment will be transferred to (on the right). If the dialog was opened as the final 
operation of the Split Bus operation, these two buses will be hard-coded to identify the original 
bus and the bus resulting from the split. If the dialog was opened from the main menu, you 
must select both the origin and destination buses from lists that are reminiscent of case 
information displays. If the dialog was opened using one of the other two methods, the origin 
bus will be set to the bus you selected, and you will then have to choose the destination bus. 
To select a bus to be an origin or destination bus, simply select the corresponding record from 
the appropriate list. 

Once the origin and destination buses have been identified, you must then select the 
equipment to transfer from the origin to the destination bus using the case information display 
that occupies the bottom of the dialog. To move a particular piece of equipment, toggle the 
value of the Move Object? field to YES. To move just portions of loads, generators, or shunts 
from the origin to the destination bus, adjust the value of the Move % field from 100.0 to the 
percentage you desire.  

Once you have selected the equipment you wish to transfer, click the Move equipment 
button. Simulator will adjust the power system model to reflect your equipment transfer 
requests. Furthermore, Simulator will provide you an opportunity to manually adjust all open 
oneline diagrams to reflect the equipment transfers. To facilitate this activity, Simulator will 
open a Potential Misplacements Dialog for each oneline that displays the origin bus. The 
Potential Misplacements Dialog lists the display objects associated with the equipment that 
had just been transferred from the origin to the destination bus. By clicking on an entry in this 
list, you can pan the associated oneline diagram to focus on that object. This allows you to 
identify display objects that perhaps should be relocated to reflect their new bus associations. 
Once you have finished addressing these potentially misplaced display objects, click the OK 
button to close the Potential Misplacements Dialog. 

If you find that you would like to reopen the Potential Misplacements Dialog after you have 
closed it, click the List most recent transfers button. This will reopen the Potential 
Misplacements Dialog associated with the most recent equipment transfer operation. 

To conclude the equipment transfer operation, click the Close button. 
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Potential Misplacements Dialog 

  

In the wake of an equipment transfer operation using the Equipment Mover Dialog, some 
oneline display objects may be out of place. To ease the task of correcting these 
misplacements, Simulator provides the Potential Misplacements Dialog. Simulator opens a 
Potential Misplacements Dialog for each oneline that displays the bus that served as the origin 
for equipment transfer. The Potential Misplacements Dialog lists the display objects associated 
with the equipment that had just been transferred from the origin to the destination bus. By 
clicking on an entry in this list, you can pan the associated oneline diagram to focus on that 
object. This allows you to identify display objects that perhaps should be relocated to reflect 
their new bus associations. Once you have finished addressing these potentially misplaced 
display objects, click the OK button to close the Potential Misplacements Dialog. 
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Tapping Transmission Lines 

  

Simulator eases the process of inserting a bus at some location along an existing transmission 
line. This feature can be extremely useful when you want to add a new generation site to a 
model, for example. Rather than having to delete an existing line, place the bus, and draw two 
new transmission lines, Simulator simplifies the task to a one-step process. 

A line can be tapped from a oneline diagram, the transmission line case information display, or 
by going to the Tools ribbon tab and choosing Modify Case > Tap Transmission Line from 
the Edit Mode ribbon group. From the oneline diagram, right-click on a transmission line and 
select Insert Line Tap from the popup menu. From the case information display, simply 
right-click on the corresponding branch record and select Tap Transmission Line from the 
popup menu. Any of these methods will open the Automatic Line Tap Dialog for setting up and 
inserting the new bus. 

Note that transmission lines may be split only from Edit Mode. You cannot access this 
functionality from Run Mode. 
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Automatic Line Tap Dialog 

  

The Automatic Line Tap Dialog will allow you to define the settings to use for inserting a new 
bus along a transmission line. The transmission line to tap will be represented in the panel at 
the top of the dialog, displayed as a Near Bus and Far Bus. If the Automatic Line Tap Dialog 
was opened by right-clicking a line on a oneline diagram, or by right-clicking on a record in the 
case information display, the line will already be selected in the panel. You can change the line 
selection by first choosing the Near Bus you desire, and then selecting the Far Bus from the 
list of possible connections to the chosen Near Bus. Note that the percentage entered in the 
Position along line field will be in relation to the selected Near Bus. The inserted bus and 
new sections of the tapped line will adhere to the following settings: 
  

Position along line 

The field labeled Position along line will indicate the point where you right-clicked the 
mouse relative to the location of the Near Bus to the mouse-click in terms of a percentage of 
the total line length. In other words, if the line is 10 units long, and you clicked the right 
mouse at location 7 units from the Near Bus end of the line, the Position along line will 
indicate 70%. If you opened the Automatic Line Tap Dialog from the case information 
display or the Tools ribbon tab, the Position along Line will be set to 50%. In either case, 
you can adjust this setting to place the new bus more precisely. The placement of the new 
bus controls how the impedances of the new lines are set, as the impedance of each section 
will equal the section’s corresponding percentage length multiplied by the impedance of the 
original line. Note that the original charging capacitance of the line will be reassigned as 
determined by the selection under the Shunt Model option. 

New Bus Number 

By default, Simulator will find and set an unused bus number for you, but you can specify 
the number to be used for the new bus, between 1 and 2147483647. If you enter a bus 
number that already exists, you will be prompted to enter a different number when you click 
the Tap button. 

New Bus Name 

Specify a name to be assigned to the new bus. By default this field is blank, and if left blank 
Simulator will set the name of the bus the same as the new bus number. 

New Bus Area 

You can specify the area for the new bus to be the same as the Near Bus, the Far Bus, or 
another value of your specification. If you select the Specify option, the edit box and find 
button will become enabled. You can then enter an area number manually, or click Find to 
locate an area from the list of areas currently in the case. If you want a new area to be 
assigned to the case for this bus, simply enter an unused area number manually in the box, 
and Simulator will automatically set up the new area record for the case. You can then open 
the Area Information Display and set the name and other values for the new area. 

New Bus Zone 

You can specify the zone for the new bus to be the same as the Near Bus, the Far Bus, or 
another zone of your specification. If you select the Specify option, the edit box and find 
button will become enabled. You can then enter a zone number manually, or click Find to 
locate a zone from the list of zones currently in the case. If you want a new zone to be 
assigned to the case for this bus, simply enter an unused zone number manually in the box, 
and Simulator will automatically set up the new zone record for the case. You can then open 
the Zone Information Display and set the name and other values for the new Zone. 
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Shunt Model 

By default, Simulator will reassign the original charging capacitance as line shunts at the 
original terminal bus ends of the two new line segments. The charging capacitance of the 
two new branch elements will be set to 0. This will result in an exact match of power flows 
before and after the line tap. 

Alternatively, you can choose to have the capacitance converted approximately using 
percentage entered as the Position along line. In other words, the original capacitance 
will be scaled and assigned to the two new segments as charging capacitance. This will 
result in a slightly different power flow result after the line tap, as it is an approximation of 
charging capacitance on the two new segments. 

Treat sections as a multi-section line 

Check the box labeled Treat sections as a multi-section line to force the status of the 
two new line sections to be controlled in unison. Checking this box will cause a multi-section 
line to be created comprised of the two new line sections. See Multi-Section Line 
Information for details. 

Click the Tap button to close the Automatic Line Tap Dialog and perform the line tap. If a 
value on the dialog is not set properly, a warning message will appear, and you will need to 
either change the specified value or cancel the process. 
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Setting Default Drawing Options 

  

The Default Drawing Options Dialog is used to define the default sizes of new display objects, 
as well as various other display parameters. These options are available only in Edit Mode.  

To open this dialog choose Default Drawing Values on the General Options ribbon group 
of the Options ribbon tab. These General Options are also available on the Oneline ribbon tab. 

The Default Drawing Values Dialog is organized using a list showing the types of objects that 
can be added to onelines. To view information about a particular type of object, select that 
object type from the list and tables which describe the defaults available for that object will be 
populated. Two tabs will be available. One will contain the majority of default options that are 
available for the selected display object type, and the other will contain the default positions of 
fields that will be inserted when the object is inserted. 

Generally, the Default Drawing Values apply when you insert new objects on an oneline 
diagram. Changing the Default Drawing Values does not automatically affect the existing 
objects already drawn on the diagram. However, you can select multiple objects on a oneline 
diagram, and right-click on any one object to invoke the object's popup menu. You will find 
the option Apply Default Draw Values, which will modify the formatting of the selected 
objects to meet the default drawing value specifications. 
  

Variable Defaults depending on Voltage Level 

Many kinds of objects can have more than one set of defaults specified depending on their 
voltage level. When more than one set of defaults is specified, the table is always sorted by 
Nom kV. 

A new object is inserted with properties corresponding to the default with the lowest Nom 
kV that the object's nominal kV is larger than. If the object's nominal kV is smaller than all 
defaults, then it will be set according to the default with the lowest nominal kV. 

For instance, assume 4 sets of defaults are defined for buses roughly as follows 

Nom kV Size 

>400  15 

>300  10 

>200  8 

>100  5 

A new bus with nominal voltage of 345 kV is inserted with size 10.  

A new bus with nominal voltage of 299 kV is inserted with size 8. 

A new bus with nominal voltage of 69 kV is inserted with size 5. 

In order to add another set of defaults for a kind of object, right-click on the table and 
choose Insert from the local menu. In order to delete a set of defaults, right-click on the 
table and choose Delete. Once you have inserted a new default, specify the new Nom kV 
for the default along with the new defaults.  

Notes: When you change the Nom kV of a default, the list always sorts itself according to 
Nom kV. Insert will not be enabled in the local menu for objects that cannot have more 
than one set of defaults. Delete will not be enabled if only one set of defaults is defined. 

Modifying Values in the Default Drawing Values Dialog 
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The font colors in tables of this dialog follow the conventions of the Case Information 
Displays. Most default values are enterable and can be modified by selecting the value you 
want to change and then typing in the new value. Other values are toggleable and can be 
changed by double-clicking on the value. For reference regarding what the various "size" 
defaults mean, when the zoom level is at its nominal value (100%), the size of the screen is 
100 by 100. There are also some special kinds of fields in this dialog which are discussed 
next. 

Editing Colors and KV-Based Color Coding 

In order to modify a color value, double-click on the colored rectangle to bring up the Color 
Dialog. Then specify the color you want. For some defaults, such as fill color, it is possible to 
specify the default color to be none. In order to set a color default to none, select the 
colored rectangle and press the Delete key.  

At times, a user may want to see the kV level of screen objects directly from the oneline 
diagam, without having to open a text display. One way to do this is to color code the 
elements on the oneline diagram according to kV level. Right-click on the table and choose 
Insert from the local menu. Specify the Nom kV and color. 

Editing Default Field Positions ("Pos1", "Pos2", etc…) 

Many objects allow you to specify some default fields to be automatically added when a new 
object is drawn. For example, you may want to insert the bus name next to all new Bus 
Objects. For objects that allow the insertion of fields, a tab with field position diagrams will 
be available when that object type is selected. In order to specify the default positions of 
fields, click on the tab showing the field positions and click on the table row corresponding 
to the Nom kV of the defaults of interest. For object types that do not allow specifying the 
defaults by Nom kV, simply update the given position diagram. The position diagram will 
show the present settings for the new fields. Positions that have a default specified will be 
highlighted and the name of the default field will be shown. Positions with no default field 
will not be highlighted and will say "Pos1", "Pos2", etc…. For objects that have more than 
one possible orientation (e.g. generators can be up, right, left or down), there are multiple 
position diagrams showing the positions for each orientation. 

In order to modify the settings, move your mouse over the position on the dialog you want 
to change and click. This will bring up the appropriate Field Options Dialog such as the Bus 
Field Options, Generator Field Options, Load Field Options, Switched Shunt Field Options, 
Line Field Options, Interface Field Options, Substation Field Options, Area Field Options, 
Super Area Field Options, or the Zone Field Options. Simply select the field you want and 
choose OK. If you would like to set a default field to "none", click Remove Field instead of 
OK. You can also modify default fields by double-clicking on the table for "Pos1", "Pos2", 
etc… This brings up the appropriate Field Options Dialog as well. If you press the Delete key 
while on a "Pos" field in the table, it will set the default field to "none".  

Editing Stub Size and Stub Space 

When utilizing the Automatically Insert Transmission Lines feature, the Stub Size and Stub 
Space values are used. Simulator will draw each automatically inserted branch such that it 
emerges from both its terminal buses at right angles. To accomplish this, Simulator draws 
each automatically inserted branch in three segments: two stubs perpendicular to the 
terminal buses having a length specified by the value supplied for Stub Size, and a third 
segment joining the two stubs. The amount of space between lines as they converge into a 
bus is set by Stub Space. 

If you do not want transmission line stubs to be inserted, then set Stub Size to none or to 
a negative number. Note in order to set a value for Stub Space, Stub Size must be set to 
a positive number first. 
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Editing CB Size 

When you insert new transmission lines or transformers, circuit breakers will automatically 
be inserted on the branch with their size specified by CB Size. If you do not want Circuit 
Breakers inserted for a particular voltage level, then set CB Size to none or a negative 
number. 

Editing Pie Size 

When you insert new transmission lines or transformers, pie charts will automatically be 
inserted on the branch with their size specified by Pie Size. If you do not want pie charts 
inserted for a particular voltage level, then set Pie Size to 'none' or a negative number. 

Set Default Font 

Click on this button to set the default font used for new text fields. This is the font which will 
be used for all new text fields. Note however that the default font size set using this dialog 
is not used unless the option Use the default font size for new text objects is selected. 
Otherwise, the specific kind of object and voltage level specifies what the font size should 
be. For example, in the Interface tab, one of the defaults is Font Size. New Interface Fields 
will use this font size. 

Only Cut/Copy Display Objects, Not Power System Records 

When you cut or delete an object from the oneline, Simulator needs to know whether you 
simply want to delete the display object from the oneline or to purge the definition of the 
power system object from the model. Check this box to tell Simulator to assume that it 
should always delete objects just from the oneline display, not from the power system 
model. 

Oneline / Bus View Background Color 

To change the default oneline background color, click on the Change button to select a new 
color. This color applies to both new oneline diagrams and the background color of the bus 
view oneline diagram. 

Recommended Multi-KV Level Defaults 

Click this button to change the default options back to Simulator recommended values. 
Multiple sets of default options will be specified based on voltage level for objects for which 
it is beneficial to do this (i.e. transmission lines). 

Recommended Single-KV Level Defaults  

Click this button to change the default options back to Simulator recommended values. A 
single set of default options will be specified for each object type.  
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Bus Selection Page 

  

The Bus Selection page is currently used with two displays: 
• The Equivalencing Display, to partition the system into the study subsystem ("Study") and 

the external subsystem ("External"). 
• The Facility Analysis Dialog, to determine the buses in the external subsystem from which 

the buses in the facility would be isolated. 

The following description concerns the Equivalencing Display, but the functionality of the Bus 
Selection Page is similar for both applications. 

Buses, Areas, and Zones lists 

For both equivalencing and facility analysis, use these lists to manually change the system 
designation of individual buses, areas, or zones. Note that changing the system designation 
on the area or zone tab is just another form of changing the designation of study / external 
system of individual buses. Click on the Which System? field in each of these tables to 
toggle the object’s affiliation with the study or external systems, subject to the values of the 
Filter by kV option and the Include how many tiers of neighbors? field. 

In addition, the bus selection table for facility analysis contains one additional column 
labeled Selected. This Yes or No field indicates which buses in the Study system belong to 
the Facility being analyzed. Double-clicking one of the fields in this column will toggle the 
value of the field between Yes and No. 

External 

Use these fields to specify a range of areas, zones, or buses to be added to the external 
system. The Filter by kV and Include how many tiers of neighbors? controls will also 
shape the selection of buses to add to the external system. 

Study 

Use these fields to specify a range of areas, zones, or buses to be added to the study 
system. The Filter by kV and Include how many tiers of neighbors? controls will also 
shape the selection of buses to add to the study system. 

Include how many tiers of neighbors? 

This value indicates the number of tiers of neighbors to carry with each selected bus when 
adding the selected bus to either the study or external system. For example, if Neighbor 
Tiers is 1 and we elect to add bus X to the external system, both bus X and its first tier of 
neighbors will be added to the external system. If Neighbor Tiers is 0, only bus X will be 
added to the external system. 

Filter by kV 

If the Filter by kV box is checked, then only buses having a nominal voltage level between 
the values given in the Max kV and Min kV fields can be selected. 

Set All As External 

Click this button to assign all buses to the external system. 

Set Branch Terminals External or Study 

Clicking either of these two buttons allows setting advanced filter criteria which define a 
branch or group of branches. Once the criteria are set, clicking Filter will select the terminal 
buses of all branches meeting the filter criteria, and set those buses to either the External or 
Study system, depending on which button was pressed. 

Select Buses using a Network Cut 
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A custom network cut can be defined for choosing which buses should remain in either the 
Study or External system. 

Save Buses to File 

Once the system has been partitioned, this command allows you to store the numbers of the 
buses of the study system in a text file. 

Load Buses from File 

Click on this button to load a listing of the buses to be included in the study system from a 
text file. You will be prompted to select the text file. The format of this text file is such that 
one bus number occupies each line. Any buses not identified in this file are defined as being 
in the external system. 

Example 

Assume you would like to create an equivalent containing all the buses in areas 1-5 and 10, 
plus any tie buses, and bus number 2050.  

• Since initially all buses are in the study system, first enter 1-1000 in the Areas field of 
Add to External System. Since the area of every bus is within this range, this places 
all the buses in the external system.  Alternatively, click Set All as External to 
accomplish the same objective. 

• Set Include how many tiers of neighbors? to 1. This indicates that all subsequent 
selections will affect the specified buses and their first tier of neighbors.  

• In the Areas field of Add to Study System, enter 1-5,10. This places all the buses in 
these areas, plus any tie buses (since Neighbor Tiers is 1), into the study system.  

• In the Buses list, double-click in the Which System field for bus 2050 to change its 
status from External back to Study.   
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List Unlinked Display Objects 

  

An unlinked object is a display object not linked to a record in the power system model (model 
object). The existence of unlinked display objects on a oneline diagram can be misleading 
because they have zero flows and zero bus voltages associated with them. See Object 
Relationships for more information. 

Go to the Onelines ribbon tab, then on the Active ribbon group choose List Display > 
Unlinked Display Objects from the main menu in Edit Mode to identify unlinked objects. 

 
Unlinked Display Objects Dialog 

  

Total Number of Unlinked Display Objects 

Indicates the total number of unlinked objects on the display. Ideally, this number should be 
zero. If nonzero, the unlinked objects are identified in the table by type, screen location, and 
zoom range over which the object is visible. 

Delete Unlinked Objects 

Click on this button to permanently remove all unlinked objects from the display. Exercise 
this option carefully. Generally, you will want to do this either when you have substantially 
modified a power flow case, such as by creating an equivalent, or when you are using the 
oneline with a new power system case.  

View Options for Highlighting Unlinked Objects on the Oneline 

Click on this button will open the Grid/Highlight Unlinked Objects tab of the Oneline Display 
Options Dialog. 

Type, X/Y Location 

The remainder of the display shows the type, location, identification, layer, applicable zoom 
level, anchored property, and font size for each unlinked object.  This table is a type of Case 
Information Display  and thus behaves similarly to all other case information displays. Right-
click on a record in this table to invoke the local menu. Select Pan to Object on Open 
Onelines to locate and select the unlinked object on the oneline diagram.  
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Set Selected Field 

  

The Set Selected Field option is an often unused featured in Simulator, but can at times prove 
very useful. Each object in Simulator has a property called Selected, which does nothing in 
Simulator other than allow the user to choose a specialized set of objects for some other 
purpose, such as advanced filtering a display. The user can add a column to most types of 
case information displays which shows the value of the Selected property for the type of 
object being observed. By default, this field is always set to No. However, the user can change 
the value of this field, and then sort the column, filter the display, or any other action that can 
normally be performed on a column of a Yes/No type. 

In addition to modifying the Selected property manually in a case information display, it is 
also possible to define a group of buses' Selected property by defining a network cut on the 
system. Choosing the Set Selected Field for Network Cut option from the Tools menu will 
open the network cut dialog automatically for setting the Selected property of a group of 
objects according to a desired cut plane chosen. 
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Network Cut 

  

The Network Cut tool is another method for choosing sets of buses for such features as 
Scaling or Equivalencing. 

The use of the network cut method is to define a set of branches as the "cut" plane, then 
choose a bus on one side or the other of the cut to indicate which side of the cut you are 
interested in. The network cut dialog provides the functionality necessary for defining the 
network cut. 
  

Defining Network Cut 

The first step in defining the network cut is to choose the branches which define the cut 
plane in the system. The one caution is to be sure you select a closed loop cut plane. In 
other words, you must select a set of branches which completely topologically separates two 
portions of the system. If you only choose a partial cut plane, which does not completely cut 
the system in two distinct pieces, then attempted use of the ill-defined cut plane will fail. 

To choose the branches which define the cut plane, simply highlight the branches by clicking 
on them in the list. For each branch you highlight, you must click on arrow button (pointing 
to the box on the right) to add the branch to your cut plane definition. You can make use of 
the control (Ctrl) and shift keys to select multiple branches at one time in the list of 
branches. Note that you can also select a cut plane similarly using interfaces or DC lines. 

Once you have the branches (or interfaces or DC lines) selected which form the cut plane, 
you then need to choose a bus on either side of the cut plane to indicate which side you are 
interested in. The bottom panel on the display allows you to locate and select this bus. 

Require Paths to be Energized 
This option can be checked if the branches forming a network cut should be energized to 
be included. 

Include How Many Tiers of Neighbors 

Once the network cut has been defined by a set of branches and the bus defining which 
side of the cut is being examined has been chosen, this option will then include buses 
within so many tiers of the network cut boundary, on the opposite side of the cut as the 
specified bus. If the number of tiers is set to zero, then the buses examined will only be 
those on the same side of the cut as the bus selected. 
  

Setting the Field 

Once the network cut has been defined and the side of the cut to be examined has been 
chosen, the appropriate field for each bus in the area of interest can be set. If the network 
cut is for the equivalencing tool, then the field to set is the Which System property, which 
defines if a bus is in the external or study system when creating an equivalent. If the 
network cut is for the scaling tool, then the field to set is the Scale property, which defines 
if a bus is to be included in a scaling action. 

Filter by KV 
The buses within the network cut can be filtered by nominal voltage level before the 
field(s) are set. Only buses that are within the network cut and are within the nominal 
KV level specified will have their fields set to the desired value. 

Use Area/Zone Filters 

The buses within the network cut can be filtered by the area or zone in which they are 
contained before the field(s) are set. Only buses that are within the network cut and 
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whose area meets the defined Area/Zone filter specified will have their fields set to the 
desired value. 
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Browse Open Onelines 

  

All the objects in all the open .pwd files can be listed in the Browse Oneline Environment 
dialog. To do so, go to the Onelines ribbon tab, Active ribbon group and choose List Display 
> Browse open onelines in Edit Mode or Run Mode. The power system objects are listed on 
tabs according to their type. For instance, all the buses and bus fields are listed in the Buses 
tab while all the generators and generator fields are listed in the Generators tab. The 
Others tab lists all the objects on the onelines which are not associated with power system 
elements, e.g. background lines or images. The All tab lists all the objects in all the open 
onelines. The default display columns for each grid include the oneline file name of the object 
and the type of the object. Objects that are linked to case elements also have identifying 
information about the data element that they represent. The Others and All pages include 
the default display columns for generic display objects.  

The oneline displays can be panned to the selected object. To do so, select one object from 
the Browse Oneline Environment dialog and right click to invoke the local popup menu. Click 
ScreenObject Records > Pan to Object on Open Onelines. This will bring the oneline 
with the selected object to the front and pan to the selected object. When panning, the 
browsing dialog can be kept on top if Keep browsing dialog on the top when choosing 
Pan Oneline to Object is checked. Otherwise, the dialog will be sent to back when panning. 
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Unused Bus Numbers 

  

When making changes to a power system case, it is often beneficial to know which bus 
numbers are still available. To save a list of unused bus numbers to a text file, while in Edit 
Mode, go to the Tools ribbon tab, and choose Modify Case > List of Unused Bus 
Numbers from the Edit Mode ribbon group. Enter a range of bus numbers in the dialog and 
click OK. In the Save As Dialog, specify the text file where the list of bus numbers should be 
written and click Save. Only those unused bus numbers in the specified range will be listed in 
the file. Clicking Cancel at any point will abort saving the list to a file. 
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Palette Overview 

  

The display object palettes are designed to help you lay out a new oneline diagram for a pre-
existing power flow model as quickly as possible. Display object palettes exist for Areas, 
Buses, Substations and Zones. Palettes list the display objects that you have already added to 
the oneline, the display objects that have not yet been drawn that neighbor those displayed 
objects, and the set of all display objects that have not yet been added to the drawing. By 
selecting and dragging a display object name from either the Undisplayed Neighbors list or 
the All Undisplayed list to a location on the oneline diagram where you would like that 
object to appear, you can add that display object to the drawing with very little effort.  

To see which elements neighboring a particular device are already on the oneline diagram and 
which are not, highlight a device in either the Displayed or All Undisplayed list. The 
Displayed Neighbors and Undisplayed Neighbors columns will list the corresponding 
neighboring devices for the selected device, allowing you to drag the undisplayed neighbors to 
the diagram if you wish. 

The display object palettes, in conjunction with the  of other devices, are especially useful for 
adding a large region of an interconnection in relatively little time. 

To display one of the four available palettes, select Show Insert Palette For from the Quick 
Insert ribbon group on the Draw ribbon tab. To display the palette with the focus set to an 
object already displayed, right-click on that object on the diagram and select *** Palette 
(where *** is the name of the object type) from the popup menu. 
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Using the Insert Palettes 

  

  

 

The display object palettes are designed to help you lay out a new 
oneline diagram for a pre-existing power flow model as quickly as 
possible. Display object palettes exist for Areas, Buses, Substations and 
Zones. To open one of the palettes you must be in Edit Modeand then 
go to the Draw ribbon tab, and choose the Show Insert Palette For 
Menu from the Quick Insert ribbon group. 

  

The Insert Palettes can be used in conjunction with the various auto-
insert capabilities also found on the Quick Insert ribbon group. These 
features allow for the creation of oneline diagrams much more quickly 
than inserting oneline objects one at a time using the Individual Insert 
ribbon group. 

When you choose one of the palettes the dialog which appears will look 
like the image below. The following image shows the Bus Palette. 

 
Palettes list the display objects that you have already added to the oneline, the display objects 
that have not yet been drawn that neighbor those displayed objects, and the set of all display 
objects that have not yet been added to the drawing. 

The display object palettes feature the following controls: 

Displayed 

Lists those objects defined in the power flow case that have already been added to the 
oneline diagram. When you click on an entry in the Displayed list, the contents of the 
Displayed Neighbors and Undisplayed Neighbors lists will be refreshed to identify all 
objects that neighbor the display object you selected. Only the display objects matching the 
type of Insert Palette opened will be shown in the list. 

Double click on an entry in this list to pan to it so that the selected display object appears in 
the center of the screen. If you are looking at the Insert Palette for Buses, you can right-
click on an entry and choose either Quick Power Flow List or Bus View to learn more about 
the selected bus. 

Displayed Neighbors 

Lists those objects defined in the power flow case that neighbor the display object selected 
in the Displayed list that have already been drawn on the oneline diagram. You can make a 
"Displayed Neighbor" the selected "Displayed" object by right-clicking on a display object in 
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the Displayed Neighbor List and selecting Make Current Displayed from the local 
menu. Only the display objects matching the type of Insert Palette opened will be shown in 
the list. 

Undisplayed Neighbors 

Lists those display objects defined in the power flow case that neighbor the object selected 
in the Displayed list that have not yet been drawn. To add the undrawn display object to 
the oneline diagram, select its name with the left mouse button and keep the left mouse 
button pressed as you move the mouse to the point on the oneline where you would like to 
drop the object. When you let go of the left mouse button, the Information Dialog box 
for that display object will appear. (If you do not want the information Dialog box to appear 
the use the right-click local menu to uncheck the option to regarding showing the 
information dialog). Use the Information Dialog to change display parameters for the object 
and click OK to finish dropping the object onto the oneline. The display object you have just 
added will be appended to the end of the Displayed list and will also be added to the 
History List so that you can identify its own undrawn neighbors quickly. Only the display 
objects matching the type of Insert Palette opened will be shown in the list. 

If you are looking at the Insert Palette for Buses, you can right-click on an entry and choose 
either Quick Power Flow List or Bus View Display to learn more about the selected bus. 

All Undisplayed 

Lists those display objects defined in the power flow case that have not yet been added to 
the oneline diagram, regardless of whether the object neighbors a displayed object or not. 
This list functions identically to the Undisplayed Neighbors List. To add the undrawn 
display object to the oneline diagram, select its name with the left mouse button and keep 
the left mouse button pressed as you move the mouse to the point on the oneline where 
you would like to drop the object. When you let go of the left mouse button, the 
Information Dialog box for that display object will appear. (If you do not want the 
information Dialog box to appear the use the right-click local menu to uncheck the option to 
regarding showing the information dialog). Use the Information Dialog to change display 
parameters for the object and click OK to finish dropping the object onto the oneline. The 
display object you have just added will be appended to the end of the Displayed list and 
will also be added to the History List so that you can identify its undrawn neighbors 
quickly. Only the display objects matching the type of Insert Palette opened will be shown in 
the list.  

If you are looking at the Insert Palette for Buses, you can right-click on an entry and choose 
either Quick Power Flow List or Bus View Display to learn more about the selected bus. 

History List 

Identifies the display objects you have added to the oneline diagram using the insert 
palettes since the last time you opened the display object palette. Select a name from this 
list to display the undrawn neighbors of the corresponding display object. Only the display 
objects matching the type of Insert Palette opened will be shown in the list. 

Define a Filter 

The Define a Filter button opens the Advanced Filters dialog. This dialog allows you to 
customize which display objects appear in the various lists. This can be helpful, for example, 
if you wish to add objects to the oneline that reside only in particular areas, or if you don't 
want objects less than a certain voltage level to be listed. 

When you click OK on the Advanced Filters dialog, the display object palette's lists will 
automatically be updated to reflect the filter settings. 

Close 
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Click Close when you are done using the display object palette. 

Right-Click Local Menu of the Palette  

There are several options available on the Right-Click  

Search for : Click this option to search through the lists for a particular object. It will open 
the familiar Find Object dialog. 

Auto-Zoom When Panning : When double-clicking on the displayed objects in the 
palette, you will automatically be panned so that object is in the center of the screen. Check 
this option to also automatically zoom in/out to a reasonable level at the same time. 

Export All Undisplayed List : Choose this option to export this list of undisplayed objects 
to a text file. 

Refresh Status : Choose this option to ensure that the list of Displayed/Undisplayed 
objects is correct. 

Show Dialog after Inserting : check or uncheck this option to control whether the 
information dialog for the object will appear when using the palette 
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Automatically Inserting Buses 

  

Simulator can automatically insert buses on your oneline diagram if you have data regarding 
their spatial or geographic location. To achieve this, go to the Draw ribbon tab and choose 
Auto Insert > Buses on the Quick Insert ribbon group. This opens the Auto Insert Bus 
Dialog. 

Note: Auto-insert buses is only for inserting bus objects on the diagram representing existing 
data. In other words, you cannot use the auto-insert buses routine to add new buses to the 
load flow model. See topics on loading data from auxiliary files or from Excel for creating new 
buses (or other objects) in an existing load flow case. 
  

Insert by longitude, latitude 

If you have stored latitude and longitude information with the Bus records in Simulator, you 
can use that information to automatically insert the buses on a oneline diagram. Select the 
option on the dialog for finding bus locations based on Longitude and Latitude stored 
with data records. When selected, the Map Projection option will become enabled. Choose 
the type of projection you would like to be used for placing the buses on the diagram. 

Insert by locations specified in a file 

You must first specify the file which contains the location data. You must also specify 
whether the file contains x,y coordinates or longitude, latitude coordinates. The format of 
the location data text file is as follows: 

The first line of this text file is ignored by Simulator. The following lines consist of three 
numbers: Bus Number, X location, and Y location. If you are reading longitude, latitude, 
then X signifies longitude and Y signifies latitude. 

Num, X Location, Y Location 

 1, 24001.46, 19715.15  
 3, 24001.46, 19715.15  

16, 24130.91, 19638.99 

17, 24007.31, 19093.09 

21, 23649.27, 18439.07 

22, 23649.27, 18439.07 

etc... 

Simulator will place the buses on the oneline diagram at the X, Y locations given. If you 
specified that the file contained longitude, latitude information, then select the Map 
Projection to use when converting the longitude, latitude values from the file. The buses 
will be drawn according to default bus object information defined in the Default Drawing 
Values for New Objects dialog. 

  

If you would like Simulator to Autoinsert transmission lineswhen finished with the auto 
insertion of your buses, check the box. Transmission lines and transformers will be 
automatically drawn based on the Line/XFMR default options defined in the Default Drawing 
Values for New Objects dialog. 

Check the Insert bus only if not already shown on the oneline to ensure that multiple 
display objects are not inserted for the same element. 
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Clicking the OK button will instruct Simulator to continue by placing the buses according to 
the specified settings on the dialog. Click Cancel to exit the process without inserting the 
buses. 
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Automatically Inserting Transmission Lines 

  

The Automatic Insertion of Lines/Transformers Dialog is used to automatically draw 
transmission lines and transformers on the oneline diagram between existing bus display 
objects. Only branches that are already defined in the power flow case can be added 
automatically; if you need to define a brand new branch, see Transmission Line Display 
Objects. Thus, this option is useful only when you are starting with an existing power flow 
case, not building a case from scratch. 

To insert lines and transformers automatically, you must first have drawn the buses for each 
end of the device. Simulator then draws the branch display objects connecting the buses for 
each transmission line/transformer in the power flow case not already shown on the oneline.  

To display the dialog, in the Edit Mode go to the Draw ribbon tab and choose Auto Insert > 
Lines on the Quick Insert ribbon group. 
  

The dialog has the following options: 

Minimum kV Level 

Simulator will automatically draw line and transformer display objects between terminals 
whose nominal voltages meet or exceed the minimum kV level specified in this field. For a 
branch object to be drawn, either one of its terminals must satisfy this criterion. This option 
is useful for suppressing the automatic addition of generator step-up transformers if that 
kind of detail is not warranted. 

Default Drawing Values 

This button opens the Default Drawing Values Dialog. Options such as the automatic 
insertion of transmission line stubs, text fields, circuit breakers, and pie charts are specified 
in the Default Drawing Values Dialog. 

Insert Text Fields 

If this box is checked, the default fields associated with the transmission line will appear 
around the transmission line. 

Insert Equivalenced Objects 

If this option is checked, equivalenced objects modeled as lines will also be automatically 
inserted with the real transmission lines. 

Use Only Selected Buses 

Instead of having Simulator automatically insert line and transformer display objects 
throughout the oneline diagram, you can force it to insert the new objects only between the 
bus display objects that are currently selected. This option is enabled only when two or 
more bus display objects are currently selected on the oneline. 

Insert Pie Chart for Lines with No Limit and Bus Ties 

If this option is checked, Simulator will add pie chart objects to the lines that have no given 
limit or are bus ties as they are auto-inserted. Typically if a line is a bus tie or has no given 
limit, it is meaningless to include a pie chart on the element, since no relevant information 
about the transmission element can be gained from the pie chart object. 

Insert Multi Section Lines 

Check this option if you wish for Simulator to automatically insert lines designated as multi-
section lines as well. 

Identifying Bus Ties 
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This area deals with lines used as ties between breakers. These lines are modeled as zero 
impedance connections. The identification of a branch as a bus tie depends on the value 
specified as the Maximum P.U. Impedance for Bus Ties. Branches with total P.U. 
impedance below this value will be considered bus ties when auto-inserted. 

In this area two choices are given for how to insert the bus tie breakers: Do not insert 
stubs for bus ties and Only insert a single circuit breaker. The first choice allows you 
to decide if line stubs will be drawn when the tie breaker is inserted. The second sets 
whether or not only one circuit breaker is inserted on the tie breaker. This could be useful 
for determining real lines from bus tie breakers. 
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Automatically Inserting Generators 

  

The Automatic Insertion of Generators Dialog is used to automatically draw generators on the 
oneline diagram on existing bus-display objects. Only generators that are already defined in 
the power flow case can be added automatically; if you need to define a new generator, see 
Generator Display Objects. Thus, this option is useful only when you are starting with an 
existing power flow case, not building a case from scratch. 

To insert generators automatically, you must first have drawn the terminal bus for each 
device. Simulator then draws the generator display objects connected to the buses for each 
generator in the power flow case not already shown on the oneline.  

To display the dialog, in the Edit Mode  go to the Draw ribbon tab and choose Auto Insert > 
Generators on the Quick Insert ribbon group. 
  

The dialog has the following options: 

Minimum kV Level 

Simulator will automatically draw generator display objects at terminal buses whose nominal 
voltages meet or exceed the minimum kV level specified in this field. For a generator object 
to be drawn, its terminal must satisfy this criterion. 

Default Drawing Values 

This button opens the Default Drawing Values Dialog. Options such as the automatic 
insertion of text fields are specified in the Default Drawing Values Dialog. 

Insert Text Fields 

When this box is checked, the default fields associated with the generator will appear 
around the generator, such as voltage, name, and/or MW. 

Insert Equivalenced Objects 

This field is not used when automatically inserting generators. 

Use Only Selected Buses 

Instead of having Simulator automatically insert generator display objects throughout the 
oneline diagram, you can force it to insert the new objects only between the bus display 
objects that are currently selected. This option is enabled only when two or more bus 
display objects are currently selected on the oneline. 
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Automatically Inserting Loads 

  

The Automatic Insertion of Loads Dialog is used to automatically draw loads on the oneline 
diagram on existing bus display objects. Only loads that are already defined in the power flow 
case can be added automatically; if you need to define a brand new load, see Load Display 
Objects. Thus, this option is useful only when you are starting with an existing power flow 
case, not building a case from scratch. 

To insert loads automatically, you must first have drawn the terminal bus for each device. 
Simulator then draws the load display objects connected to the buses for each load in the 
power flow case not already shown on the oneline.  

To display the dialog, in the Edit Mode  go to the Draw ribbon tab and choose Auto Insert > 
Loads on the Quick Insert ribbon group. 

The dialog has the following options: 

Minimum kV Level 

Simulator will automatically draw load display objects at terminal buses whose nominal 
voltages meet or exceed the minimum kV level specified in this field. For a load object to be 
drawn, its terminal must satisfy this criterion. 

Default Drawing Values 

This button opens the Default Drawing Values Dialog. Options such as the automatic 
insertion of text fields are specified in the Default Drawing Values Dialog. 

Insert Text Fields 

When this box is checked, the default fields associated with the load will appear with the 
loads, such as MVAR and/or MW. 

Insert Equivalenced Objects 

If this option is checked, equivalenced objects modeled as loads will also be automatically 
inserted with the real transmission lines. 

Use Only Selected Buses 

Instead of having Simulator automatically insert load display objects throughout the oneline 
diagram, you can force it to insert the new objects only between the bus display objects that 
are currently selected. This option is enabled only when two or more bus display objects are 
currently selected on the oneline. 



Edit Mode Tools and Options 
 

276 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Automatically Inserting Switched Shunts 

  

The Automatic Insertion of Switched Shunts Dialog is used to automatically draw switched 
shunts on the oneline diagram on existing bus-display objects. Only switched shunts that are 
already defined in the power flow case can be added automatically; if you need to define a 
brand new switched shunt, see Switched Shunt Display Objects. Thus, this option is useful 
only when you are starting with an existing power flow case, not building a case from scratch. 

To insert switched shunts automatically, you must first have drawn the terminal bus for each 
device. Simulator then draws the switched shunt display objects connected to the buses for 
each switched shunt in the power flow case not already shown on the oneline.  

To display the dialog, in the Edit Mode  go to the Draw ribbon tab and choose Auto Insert > 
Switched Shunts on the Quick Insert ribbon group. 
  

The dialog has the following options: 

Minimum kV Level 

Simulator will automatically draw switched shunt display objects at terminal buses whose 
nominal voltages meet or exceed the minimum kV level specified in this field. For a switched 
shunt object to be drawn, its terminal must satisfy this criterion. 

Default Drawing Values 

This button opens the Default Drawing Values Dialog. Options such as the automatic 
insertion of text fields are specified in the Default Drawing Values Dialog. 

Insert Text Fields 

When this box is checked, the default fields associated with the switched shunt will appear 
around the switched shunt, such as nominal MVAR. 

Use Only Selected Buses 

Instead of having Simulator automatically insert switched shunt display objects throughout 
the oneline diagram, you can force it to insert the new objects only at the bus display 
objects that are currently selected. This option is enabled only when two or more bus 
display objects are currently selected on the oneline. 
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Automatically Inserting Interface Display Objects 

  

The Automatic Insertion of Interfaces Dialog is used to automatically insert interface objects  
on the oneline diagram between existing area/zone display objects. Interface pie chart objects  
can also be inserted as part of this process. The automatic insertion of interface display 
objects greatly accelerates the construction of interface diagrams, which are particularly useful 
for animating the results of PTDF calculations. Area-area and zone-zone interface records can 
be displayed using interface display objects as well as interfaces comprised only of 
transmission branches. 

Note that inserting interface objects on a oneline diagram does NOT add interface objects to 
the load flow case. The interface definitions need to be added to the load flow case prior to 
automatically inserting the graphical interface objects on a oneline diagram. The quickest way 
to add area to area or zone to zone interface definitions in the load flow case is to 
automatically insert the definitions in the interface case information display. 

Once you have the interface definitions defined in the case, you can automatically insert the 
interface objects on a diagram using the following procedure: 
• On a oneline diagram (either an already open diagram or a brand new one created by 

choosing New Oneline from the application button), place area/ zone objects at the 
desired locations if inserting area-area or zone-zone interface records. Otherwise, the 
terminal buses for the branch elements in the interface should be inserted at the desired 
locations on the oneline diagram.  

•  Go to the Draw ribbon tab and choose Auto Insert > Interfaces on the Quick Insert 
ribbon group. 

• Check the Insert Pie Charts on Interfaces box to automatically insert interface pie 
chart objects when the interfaces are inserted. If this option is selected, change the 
Default Size of Interface Pie Charts to specify their size. 

• Choose the type of interfaces to insert. Area to Area or Zone to Zone Interfaces and 
Line/Transformer Interfaces can be inserted. Area-area and zone-zone interfaces will 
be drawn between the respective area and zone objects displayed on the oneline. 
Line/transformer interfaces will be drawn based on the average location of the terminal 
buses of all transmission lines comprising the interface. If inserting line/transformer 
interfaces, the option Minimum Length of Line/Transformer Interfaces can be set to 
prevent interfaces that are too short from being inserted.  

• Select OK to insert the new oneline objects. New interface objects are automatically 
inserted based on the selected criteria for any corresponding interface record that is not 
already represented.   

Note that you can do this automatic insertion as often as you like. The Number of 
Interfaces Not Shown field indicates how many interfaces still need to be added to the 
diagram to represent all defined area-area, zone-zone, or line/transformer interfaces. It is a 
read-only field.  
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Automatically Inserting Substations 

  

Simulator can automatically insert substations on your oneline diagram if you have data 
regarding their spatial or geographic location. To achieve this, go to the Draw ribbon tab and 
choose Auto Insert > Substations on the Quick Insert ribbon group. This opens the Auto 
Insert Substation Dialog. 
  

Insert by longitude, latitude 

If you have stored latitude and longitude information with the Substation records in 
Simulator, you can use that information to automatically insert the substations on a oneline 
diagram. Select the option on the dialog for finding substation locations based on 
Longitude and Latitude stored with data records. When selected, the Map 
Projection option will become enabled. Choose what type of projection you would like to 
be used for placing the substations on the diagram. 

Insert by locations specified in a file 

You must first specify the file which contains the location data. You must also specify 
whether the file contains x,y coordinates or longitude, latitude coordinates. The format of 
the location data text file is as follows 

The first line of this text file is ignored by Simulator. The following lines consist of three 
numbers: Substation Number, X location, and Y location. If you are reading longitude, 
latitude then X signifies longitude and Y signifies latitude. 

Num, X Location, Y Location 

1, 24001.46, 19715.15 

3, 24001.46, 19715.15 

16, 24130.91, 19638.99 

17, 24007.31, 19093.09 

21, 23649.27, 18439.07 

22, 23649.27, 18439.07 

etc... 

Simulator will place the substations on the oneline diagram at the X, Y locations. If you 
specified that the file contained longitude, latitude information, then select the Map 
Projection you would like to be used when converting the longitude, latitude values from 
the file. The substations will be drawn according to default substations object information 
defined in the Default Drawing Values for New Objects dialog. 

Finally, if you would like Simulator to Auto insert transmission lines when finished with 
the auto insertion of your substations, check this box. Transmission lines and transformers will 
be automatically drawn based on the Line/XFMR default options defined in the Default 
Drawing Values for New Objects dialog. 

Check the Insert substation only if not already shown on the oneline to ensure that 
multiple display objects are not inserted for the same element. 

Clicking the OK button will instruct Simulator to continue by placing the substations according 
to the specified settings on the dialog. Click Cancel to exit the process without inserting the 
substations. 
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Automatically Inserting Borders 

  

PowerWorld Simulator allows you to automatically insert geographic borders, which 
PowerWorld Corporation has drawn. These include the states in the United States of America 
and several international borders as well. You may also define a border in a text file and insert 
this User-Defined border. It is highly recommended that you create a diagram and insert 
borders before you begin adding power system objects to the diagram. 
  

To bring up the Auto Insert Borders Dialog, go to the Draw ribbon tab and choose Auto 
Insert > Borders on the Quick Insert ribbon group. 
  

Options 

The Options tab allows you to set characteristics of the border lines when they are inserted on 
the oneline diagram. Most of these options are available from the Format menu in Edit Mode, 
and can be changed for a border by selecting the border(s) in Edit Mode and then selecting 
the appropriate option from the Format menu to change the desired option(s). 

Make border lines immobile 

This option is very useful for preventing you from inadvertently moving the border lines in 
Edit Mode once they have been placed. 

Automatically link county and state borders to supplemental data 

Background lines created from inserting borders can be linked to Supplemental Data records 
for purposes of further identifying these objects. This is useful when applying filters, 
applying dynamic formatting, using Select By Criteria, or defining custom hints with display 
objects created from inserting the borders. This option is only available when inserting 
United States borders. 

When this option is checked, background lines created for the borders will be automatically 
linked to Supplemental Data records. If necessary, Supplemental Data records will be 
created with the Classification being either State or County, depending on the Border Type 
selected when inserting United States borders, and the Name being the name of either the 
state or county. 

Line Options 

Choose the line thickness and line color for the border lines. 

Fill Options 

Choose the fill options if you wish to "fill in" the border regions with a background fill color. 

Stack Level 

Choose the stack level for the border lines. The stack level affects which objects appear 
"over" or "under" other objects on the diagram. Typically background lines are either placed 
in the Background or Base levels, so that they appear beneath power system objects on the 
diagram. Further we would recommend that if you are using background fill colors for the 
borders that you choose a stack level of Base. The only difference between the Background 
and Base levels is that the Base level objects can be right-clicked on in Run Mode and allows 
the default diagram popup menu to appear. Right-clicking on Background level objects in 
Run Mode will not display the default popup menu. 

Layers 
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When Borders are automatically inserted on a diagram using this tool, a Borders screen 
layer will be added to the layer drop-down box, if a Borders layer does not already exist for 
the oneline diagram. You can choose to leave the borders in the standard Default layer, to 
place the borders in the new Borders layer, or you can create a new custom layer by clicking 
the Define Layers button. If no default borders layer has been previously established 
(borders were previously inserted on the oneline), the Borders layer or selected user created 
layer will be set as the default Borders layer. The default Borders layer is different than the 
standard Default layer for objects. The default Borders layer information is stored in the 
system registry, and is only used to recall which layer borders were assigned to the previous 
time borders were automatically inserted. 

Apply Default Drawing Values 

Click this button to apply the Background line settings from the Default Drawing Values. 

Border File Path 

Designate the border file location. 

  

PowerWorld Library 

United States 

This tab allows you to select states in the United States that you want to insert. (Note: to 
select several states to insert at once, use the Ctrl and Shift keys while clicking with your 
mouse.) These states will be placed on the screen such that as you add new states they will 
be placed geographically appropriately. 

Once you have selected the states you want to insert, Click OK. 

Canada 

This tab allows you to select provinces in Canada that you want to insert. (Note: to select 
several provinces to insert at once, use the Ctrl and Shift keys while clicking with your 
mouse.) These provinces will be placed on the screen such that as you add new provinces 
they will be placed geographically appropriately. 

Once you have selected the provinces you want to insert, Click OK. 

World 

This tab allows to insert borders which PowerWorld Corporation has acquired for countries 
around the world. PowerWorld Corporation will continue to add more border files as we 
receive them. Note: if you have drawn a oneline which contains a geographic border you 
would like us to include in future version of Simulator, please contact us at 
support@powerworld.com and we'll add it to our next release. 

Map Projection 

This setting is important for anyone including border files outside of North America. By 
default, Simulator draws borders using a simple conic projection referenced to North 
America. This can result in border files of other countries being drawn incorrectly if based on 
this reference. To correctly draw borders of other countries around the world, select the 
Entire World setting, which uses a Mercator projection. 

  

User-Defined Borders 

This tab allows you to read in a border from a text file that you create. The first row of this 
text file is a comment row and is ignored when reading it in. After this it reads in the 
description of each background line. This description starts with the number of points in the 
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line followed by a list of x, y coordinates. The file ends when the number of points for a line is 
read as -1. An example file follows: 

Comment row 

5 
 59, 60  
 10, 20  
 40.3, 95.20  
 89.3, 22.11  
 79.5, 34.56  

45 
 40, 66  
 etc…  

-1 this signifies the end of the file 
  

To read the data, first specify the file name and location containing the data using the Browse 
button. Next indicate if the file contains data in Longitude, Latitude or in converted Simulator 
X,Y coordinates. If the data is Longitude and Latitude, then also specify if the map projection 
to use should be North America (simple conic) or Entire World (Mercator). 
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Equivalents 

  

An equivalent power system is a power system model of smaller dimension than the original 
system that approximates the behavior of the original system reasonably well. In reality, most 
power system models are actually an "equivalent" of a much larger interconnected network. 
When performing power system studies, it may be desirable to reduce the size of the system 
model even further so that it may be solved more quickly.  

To bring up the Equivalents Display, while in Edit Mode, go to the Tools ribbon tab, and 
choose Create Equivalent from the Edit Mode ribbon group. 

The most important part of constructing an equivalent is determining which buses should be 
explicitly retained in the equivalent, and which buses should be equivalenced, or removed 
from the case. Several definitions are useful here: 

Study System 

The buses that are to be retained. 

External System 

The buses that are to be equivalenced. 

Boundary Buses 

Any buses in the study system that are connected to buses in the external system.  

How well the equivalent system approximates the behavior of the original system depends 
upon which buses are retained in the study system. Retaining more buses yields results that 
more closely match those of the original case, but at the expense of greater computation time. 
The number of buses to retain in the study system depends upon how the equivalenced 
system will be used. Building system equivalents is as much an art as it is a science, with few 
solid rules of thumb. However, to improve accuracy, you should retain as many generator 
units as possible. 

The actual equivalent is constructed by performing a matrix reduction on the bus admittance 
matrix. A result of this process is the creation of "equivalent" transmission lines that join 
boundary buses equipped with equivalent shunts or loads. Equivalent lines typically have a 
circuit identifier of 99, but have also been seen to have other numerical values between 90 
and 99, or an alphanumeric identifier of EQ. Since many of the equivalent lines created during 
the matrix reduction have very high impedance values, an option is provided to ignore 
equivalent lines with impedances exceeding a specified threshold value. Additionally, an option 
is provided to convert the equivalent shunts added at the boundary buses to constant PQ 
loads. These PQ loads will be given circuit identifiers similar to those given to equivalent 
transmission lines. 
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Equivalents Display 

  

The Equivalents Display is used to construct equivalent systems. An Equivalent System is a 
system of smaller dimension that exhibits similar power flow properties. Equivalent systems 
are constructed to help accelerate computation time without sacrificing a significant amount of 
accuracy. For more information, please see Equivalents. 

To bring up the Equivalents Display, while in Edit Mode, go to the Tools ribbon tab, and 
choose Create Equivalent from the Edit Mode ribbon group. This display contains two pages, 
the Bus Selection Page and the Create Equivalent Page. Use the Bus Selection Page to 
partition the power system into the study system and the external system. Use the Create 
Equivalent Page to  
• Save the external system in a file 
• Extract the external system 
• Build an Equivalent 

Each of these tasks is described below.  

Bus Selection Page 

To perform any of the tasks described on the Create Equivalent Page, you first need to specify 
the study system and the external system. Do this by directly assigning buses to the desired 
system. The Bus Selection Page has been designed to provide a number of powerful and 
complimentary ways of accomplishing this task.  

The most important point to keep in mind when using this page is that membership in the 
study system and the external system is on a bus-by-bus basis (as opposed to by areas or 
zones). Thus, each bus is either in the study system or the equivalent system. Each bus’ 
current assignment is indicated in the Buses list, which is shown on the bottom left corner of 
the page. The Buses list is a Case Information display and can be manipulated similar to other 
displays. By default, all buses initially reside in the study system. Please see Bus Selection 
Page  for more details.  

Create Equivalent Page 

The Create Equivalent Page allows you to save the external system in a file, to delete the 
external system, and to build the power system equivalent. 

Build Equivalent 

This procedure constructs an equivalent system. For background on equivalents, please see 
Equivalents. The following sections contain the options for building an equivalent. 

Delete All External Generators or Retain Generators with Max MW Ratings Above 
If the Delete All External Generators checkbox is checked, the equivalencing routine 
will remove all external generators from the case, regardless of their MW rating. 
Otherwise, the equivalencing routine will add to the study system any generators 
originally in the external system whose real power output exceeds the specified value. 
Retaining large generators often makes an equivalent significantly more accurate. If you 
do not wish to retain any additional generators, check the Delete All External 
Generators checkbox. 

Retain Remotely Regulated Buses 

Some generators and transformers regulate buses other than their terminals. When this 
box is checked, these remotely regulated buses are automatically included in the 
equivalent if the regulating generator or transformer is included. If the box is not 
checked, the regulated bus is set to the terminal of the retained object. It is strongly 
recommended that you leave this box checked at all times.  
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Retain Branch Terminals For 

This section allows you to customize the retention of branch terminals for special-case 
types of branches. You may choose to retain terminal buses for transformers, zero 
impedance ties, area tie lines, and/or zone tie lines. 

Max Per Unit Impedance for Equivalent Lines 

During the equivalencing process, a number of equivalent lines are created joining the 
boundary buses. All equivalent lines with per unit impedance values above this threshold 
are ignored. 

Two Character Circuit ID for New Equivalent Lines 

Choose the circuit identifier to be used for the equivalent lines that are created. Typical 
circuit IDs for equivalent lines are 99 or EQ. 

Remove External Objects from Onelines 

This feature removes display objects associated with the external system from any open 
onelines.  

Convert Equivalent Shunts to PQ Loads 

During the equivalencing process, shunt elements are added at the boundary buses. 
Check this box if you would like these equivalent shunts converted to constant PQ loads. 
If this option is checked, equivalent loads are created with a load ID of 99. 

Remove Radial Systems 

Checking this option results in all radial connections in the network to be reduced to their 
nearest non-radial bus (i.e. node.) The equivalencing routine will iteratively reduce the 
network when this option is checked, until no more radial connections exist in the 
system. 

Delete Empty Areas/Zones/Substations that occur from Equivalencing 

Since equivalencing is a process which ultimately removes buses from the system, and 
Areas, Zones and Substations are system devices which are groups of buses, this option 
will automatically remove the definition of these types of objects when all buses within 
them are removed from the case during the creation of the equivalent. 

Select Build Equivalent System to construct the equivalent system. Constructing an 
equivalent system permanently removes the external system from the case and adds a 
number of equivalent lines and shunts/loads.  

Saving the External System in a File 

This procedure allows an external system to be saved in a file without deleting the 
external system. This option is useful for allowing you to save a portion of the system in a 
file, modify it using perhaps another program, and then use Append Case to append the 
modified file to the original case.  

When saving the external case, there are two options: 1) save just the external case, or 2) 
save the external case and any ties to the original case. Option one just saves the external 
case, while option two saves the external case and any transmission lines or transformers 
that connect the external system to the rest of the system. Save just the external case if you 
are planning to use the external case as a standalone case. Save the external case and its 
ties if you are planning to modify the external case and then to append it back to the 
original case.  

Click Save External System to save the external system in a file. You will be prompted for 
the desired case format. 

Deleting the External System 
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This procedure deletes the external system from the original case. All devices in the external 
system are removed, including any buses and lines/transformers in the external system and 
any lines/transformers that join the external system to the study system. Check the 
Remove External Objects from Onelines to remove any display objects linked to the 
external system from the open onelines.  

This command permanently removes the external system from the case; an equivalent 
system is not created. Select Delete External System to actually delete the system.  
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Scaling 

  

Use the Power System Scaling Dialog to scale the load, generation, or bus shunts 
uniformly for either the entire case or a group of selected buses. This display allows you to 
scale any of the following values: 
• Bus real power load 
• Bus reactive power load 
• Generator real power output 
• Real component of the bus shunt admittance 
• Capacitive component of the bus shunt admittance 
• Reactive component of the bus shunt admittance 

To display the Power System Scaling Dialog, go to the Tools ribbon tab, and choose Scale 
Case from the Other Tools ribbon group. When the dialog appears, you may begin to select 
the buses to be scaled. Buses can be selected individually or in a group by areas or zones. In 
addition, if you already have specific groups of devices defined as an injection group, you can 
choose to scale values associated with the injection group. 
  

Scale by Bus 

The button on the left labeled Bus enables selection of loads, generators and shunts by the 
bus to which the devices are attached. Selection of the buses can be done individually, by 
their area grouping, by their zone grouping, or by their super area grouping. Scaling is done 
on the buses chosen regardless of the area, zone, or super area specification. Options for 
areas, zones, and super areas are included only to aid in selecting and unselecting buses to be 
scaled. This is important to keep in mind if loads or generators are assigned to a different area 
or zone than their terminal bus.  

The Buses Table lists the name and number of all buses in the system and whether or not 
each bus will participate in the scaling. Similarly, the Areas, Zones, and Super Area tables 
list the names and numbers of all areas, zones or super areas in the system and whether or 
not each area will participate in the scaling. Simulator initially assumes that no buses are to be 
scaled. The Power System Scaling Dialog furnishes a number of ways to select the subset of 
buses to be scaled: 
• Use the Add to Scaling fields to enter either a range of areas, zones and/or buses to 

scale. 
• Use the Remove from Scaling fields to enter either a range of areas, zones and/or 

buses to omit from the scaling. 
• Use the Select buses using a network cut button to define a Network Cut to choose a 

custom set of buses within a portion of the system to be scaled or omitted from the 
scaling. 

• Use the Buses,Areas, Zones and Super Areas tables to change the scaling status of 
individual buses. Simply double-click on the Scale field for a bus, area, zone or super area 
to toggle its value. 

• Click the Set All to Yes button to scale the entire case. Click the Set All to No button to 
remove the entire case from scaling. 

Changing the scaling for an area, zone or super area changes the scaling status for all buses in 
the grouping. For example, to scale all the buses in a single area, first click Set All to No. 
Then, click on the Scale field for the desired area in the Area Table. To scale all buses in an 
area except for a select few, repeat the above process, but then click on the Scale field for 
the buses not to scale. 

As you select the buses to be scaled, the fields in the Totals for Selected Buses are 
updated to indicate the total load, generation, or shunt compensation that will be scaled.  
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Once you have selected the buses, you can either use the Scale By fields to enter a new 
scaling factor for each of the quantities or use the New Value fields to specify a new value 
directly. If you do not wish to scale a particular type of device, such as bus shunts, simply 
leave the Scale By field as unity.  

To ensure that the reactive power is scaled proportionately to maintain the current load power 
factor, click the Constant P/Q Ratio option. To enforce generator limits when scaling 
generation, check the Enforce Gen MW Limits option. To scale generation and load to 
enforce ACE, check Scale Gen to Keep ACE Constant. When Simulator scales generation, 
all generator power outputs at the selected buses are scaled by the specified factor, regardless 
of area control. To scale only generators whose AGC field is set to YES, check Scale Only 
AGCable Generation and Load. To scale both in-service and out-of-service loads, check 
Scale Out-Of-Service Loads. 

Finally, click Do Scaling to scale the load, generation, or shunt compensation. 
  

Scale by Area 

The button on the left side of the dialog labeled Area enables the selection of loads, 
generators and shunts based on the area designation of the device itself. Loads, generators 
and shunts can have a different area designation than the terminal bus to which the device is 
attached. In these cases, it is sometimes necessary to use the Scale by Area option to 
choose only the devices that are designated within a certain area, instead of all devices at a 
particular bus. 

To specify the devices within certain areas to be scaled, toggle the Scale property of the 
areas desired in the Areas table, or use the Add to Scaling and Remove from Scaling 
fields to enter ranges of area numbers to be included or excluded from the scaling. 
  

Scale by Zone 

The button on the left side of the dialog labeled Zone enables the selection of loads, 
generators and shunts based on the zone designation of the device itself. This is identical to 
the concept described immediately above in the discussion on Scale by Area. As was the 
case with the area designation, loads, generators and shunts can have a different zone 
designation than the terminal bus to which the devices are attached. 

To specify the devices within certain zones to be scaled, toggle the Scale property of the 
zones desired in the Areas table, or use the Add to Scaling and Remove from Scaling 
fields to enter ranges of zone numbers to be included or excluded from the scaling. 
  

Scale by Injection Group 

If injection groups have been defined for the case, you can scale the generation, load, and 
switched shunt values for the injection group by first clicking on the Injection Groups 
button. The Buses Table will be replaced with a new table listing the Injection Groups in the 
case. To choose the injection groups to scale, double-click the Scale field to toggle the value 
between No and Yes. As Scale fields are toggled to Yes, the Net Injection fields will update 
to display the totals for the selected injection groups. When all of the desired injection groups 
have been selected, either the Scale By or the New Value fields can be modified for a 
desired new value for the selected injection groups. Keep in mind that the scaling is done 
based on net injection and will be done in proportion to the defined participation points.  

To ensure that the reactive power is scaled proportionately to maintain the current load power 
factor, click the Constant P/Q Ratio option. To enforce generator limits when scaling 
generation, check the Enforce Gen MW Limits option. When Simulator scales generation, all 
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generator power outputs at the selected buses are scaled by the specified factor, regardless of 
area control. 

Checking the Scale in Merit Order option will scale generators in the order of highest to 
lowest normalized participation factor. This means that each generator participating in the 
injection group will be moved to either its maximum or minimum limit, depending on the 
direction of the scaling, before the output of the next generator in the list is changed, until the 
total scale amount is achieved. If this option is checked, generator MW limits will be enforced 
regardless of the status of the Enforce Gen MW Limits option. 

Check the Scale Only AGCable Generation and Load option to scale only those generators 
and loads whose AGC field is set to YES. If the Ignore AGC flag to calculate participation 
but use AGC flag to scale individual loads or generators option is checked, the Scale 
Only AGCAble Generation and Load is not enabled and will be ignored. If this option is 
checked, then all generators and loads, regardless of their AGC status, will be used to 
calculate the participation percentages for all participating elements. Only those generators 
and loads whose AGC field is set to YES will actually be scaled. Normally, if choosing to scale 
only AGCable generation and load, only those elements whose AGC status is YES will be used 
to calculate the participation percentages. 

The choice of Scale Starting Point impacts the reference point from which the scaling starts. 
Scale from Present Value scales by adding an incremental change to the present MW 
values based on the difference between the New Value and Original Value. Scale from 
Zero sets all participating elements to zero injection (0 MW load or generation) and then 
scales to the New Value from that starting point. When using the Scale from Zero option, 
only a single injection group can be scaled at a time. The following example explains the 
difference between these two options:  

Suppose that Load 1 is 800 MW and Load 2 is 700 MW. These two loads are the only 
elements in an injection group and they both have a participation factor of 0.5. The 
desired New Value is 1600 MW. Choosing Scale from Present Value will result in 
Load1 being 850 MW and Load 2 being 750 MW. The incremental change in the total 
load is 100 MW and both loads pick up half of this change. Choosing Scale from Zero 
will result in Load 1 being 800 MW and Load 2 being 800 MW. Both loads have been 
scaled to 0 MW initially and they each pick up half of the desired 1600 MW total load.  

The Scale Load Field options provide a way of scaling load that is out-of-service. Selecting 
Actual MW (MW Column) will scale only those loads that are in-service. (The MW column in 
the load case information display reflects the total in-service load at a bus.) Selecting 
Modeled MW (ignore load and bus status) will scale all load regardless of the load and 
bus status.  

Click Do Scaling to scale the selected injection groups. 
  

Scale by Owners 

You can scale the generation and load values by ownership by first clicking on the Owners 
button. The Buses Table will be replaced with a new table listing the Owners in the case. To 
choose the owners to scale, double-click the Scale field to toggle the value between No and 
Yes. As Scale fields are toggled to Yes, the Generator and Load MW and Mvar fields will 
update to display the totals for the selected owner. When all of the desired owners have been 
selected, either the Scale By or the New Value fields can be modified for a desired new 
value for the selected owners. 

To ensure that the reactive power is scaled proportionately to maintain the current load power 
factor, click the Constant P/Q Ratio option. To enforce generator limits when scaling 
generation, check the Enforce Gen MW Limits option. To scale generation and load to 
enforce ACE, check Scale Gen to Keep ACE Constant. When Simulator scales generation, 
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all generator power outputs at the selected buses are scaled by the specified factor, regardless 
of area control. To scale only generators whose AGC field is set to YES, check Scale Only 
AGCable Generation. To scale both in-service and out-of-service loads, check Scale Out-
Of-Service Loads. 

Finally, click Do Scaling to scale the load and generation for the selected owners.  

Note: When scaling generators with multiple owners, the scaling will be done on the entire 
output of these generators, regardless of the fact that not all of the owners have been set to 
scale. If this is not a desired behavior, you can define multiple generators at the bus, each 
with 100% ownership. 
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Overview of Facility Analysis in PowerWorld Simulator 

  

Facility Analysis is used to study the topological redundancy of interconnect-specific electric 
facilities. This application determines the minimum set of AC transmission lines and 
transformers that, when opened or removed from the system, would electrically isolate a set 
of Facility buses from a set of External buses.  

The tool is an application of the augmenting path max flow min cut algorithm  with 
modifications to handle electric networks.  
  

The Facility analysis process has two steps: 
1. The Select the Buses dialog is used to specify the External and Facility buses. Multiple 

selections of the External buses can be done using any of the area or zone selectors. The 
Facility buses are specified by setting the Selected field of buses to YES. 

2. The Facility Analysis dialog is used to determine the Min Cut and visualize the branches 
that belong to the min cut.  

The Facility analysis application runs in Edit Mode and takes into consideration the open or 
closed status of the branches. Open lines are considered as not present in the system. The 
figure below illustrates the functionality of the Facility Analysis tool.  
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Facility Analysis Dialog 

  

This dialog is used to determine the branches that would isolate the Facility from the External 
region as specified in the Select the Busesdialog. When switching to the Facility Analysis page, 
the application builds a graph data structure and reports information regarding the External 
Region and the Facility.  

To access the Facility Analysis Dialog go to the Tools ribbon tab, and choose Connections > 
Facility Analysis Dialog from the Other Tools ribbon group.  
  

Select the Buses 

The options and use of this page are described in their entirety in the topic titled Bus Selection 
Page. 
  

Facility Analysis 

External Region  

The external region is a set of buses from which the Facility would be isolated. Although the 
buses in the external region may not be adjacent to each other, the algorithm will assume 
that any of these buses can supply electricity to the Facility and thus the buses in the 
External region are considered to be connected. The External region is defined using the 
Select the Busesdialog. 

External Region - Number of Buses  

Indicates the number of buses in the External region. This number is equal to the number of 
buses in the system that were labeled as External in the Select the Buses dialog. There 
should be at least one bus in the external region. 

External Region - Capacity 

Indicates the number of branches that connect the external buses to study buses in the 
system. This is the outgoing graph flow capacity from the External region toward the 
Facility. 

Facility  

Is the set of buses that constitute the Facility. Although the buses in the Facility may not be 
adjacent to each other, the algorithm will assume that any of these buses may receive 
power from the External region, and thus the Facility buses are considered to be connected 
to each other.  

Facility - Number of Buses  

Indicates the number of buses in the Facility. This number is equal to the number of buses 
in the system that were labeled as Study and whose Selected field is set to YES. There 
should be at least one bus in the Facility. 

Note that if a bus was specified to be External and its Selected field is YES, then the 
application will issue an error, since Facility buses cannot be in the External region. In such 
cases the status will indicate that the graph structure is incomplete. 

Facility - Capacity 

Indicates the number of branches that connect Facility buses with study buses. This number 
is equal to the outgoing graph flow capacity from the Facility toward the External region. 

Status 
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Shows the status of the Facility Analysis application. If the External region and the Facility 
are specified, the status will indicate that the graph structure is ready. During execution of 
the Min Cut algorithm, the status shows the number of the augmenting paths found so far 
and the number of branches in the current path.  

Find Minimum Cut 

Press this button to initiate the Min Cut algorithm. The button is inactive if the graph 
structure is incomplete, i.e., there is either no external bus or facility bus, or facility buses 
were found inside the External region.  

Show Paths 

Toggle this button to visualize the augmenting paths at the bottom of the form. The 
augmenting paths are listed in the order in which they were found. Note that the first path 
has fewer nodes, since the algorithm uses a shortest (least number of nodes) path routine. 
For each augmenting path the number of buses in the path, as well as the corresponding 
bus numbers are listed in the dialog. This button is enabled only if a min cut has been 
found. 

 



Edit Mode Tools and Options 

293 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Augmenting Path Max Flow Min Cut Algorithm 

  

The augmenting path max flow – min cut algorithm is used to identify the minimum number of 
branches that need to be opened or removed from the system in order to isolate the Facility 
(power system device) from an External region.  

The algorithm is an application of the Max Flow - Min Cut theorem, which states that the 
maximum flow that can be transferred from a set of source nodes to a set of sink nodes 
across a graph equals the capacity of the minimum cut. The facility analysis in Simulator finds 
a min cut, although this cut may not be unique. 
  

The application consists of three stages:  
1. Convert the electric network to a graph structure 

In this stage, each branch of the system is converted to an undirected arc with graph flow 
capacity equal to one. Thus, only one unit of graph flow can be sent through a branch. 
The Facility buses and the External buses are converted to Facility and External 
supernodes, respectively. This effectively reduces the problem to finding the min cut 
between these two supernodes. The number of nodes and capacities of the Facility and 
the External region are also computed during this stage. 

2. Find the Max Flow using the Augmenting Path Algorithm 
This is an iterative process. At each step, the algorithm finds a new augmenting path from 
the Facility to the External region and augments the graph flow along this path in one 
unit. Consequently, the branches in the path won’t be available for flow augmentation in 
the next step. Each new path is determined using a shortest path routine. The algorithm 
stops when no augmenting path from the Facility to the External region can be found. The 
number of units transferred from the Facility to the External region (path augmentations) 
reaches the number of branches in a certain cut. Note that the number of branches in the 
min cut can not exceed the capacity of either the Facility or the External region.  

3. Determine the branches in the min cut 
The identification of the branches that constitute the min cut consists in tracking down 
labels in the buses and branches used during each path augmentation.  
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Graph Flow 

  

Most network and graph theory applications use the concept of flow to represent any object 
that can be transported, such as communication packets or trucks, but also connectivity 
properties of graphs. In the augmenting path max flow min cut algorithm  the flow is an 
artificial concept used to represent topological connectivity of buses. Two buses are adjacent if 
flow can be sent from one to the other through a branch.  
  

Graph Flow Capacity of a Branch 

Networks that transport some flow are said to be capacitated if its arcs (here synonym of 
"branches") have some limit associated to the flow transportation. For instance, capacity of 
a communication channel, or number of trucks that can be simultaneously on a certain road. 
The algorithm used in the Facility Analysis assigns a capacity of one to each branch. This 
means that the branch can be used only once for "connecting" two nodes.  

Graph Flow Capacity of a Cut 

The capacity of a topological cut is equal to the sum of the capacities of its arcs. In the 
Facility Analysis, the capacity of the min cut is equal to the number of branches in the min 
cut, since each branch has a capacity of one. 
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Chapter 6: Editing Oneline Diagrams 

  

The Format Menu is used in the Edit Mode to customize the appearance of the oneline 
diagrams.  

This chapter covers the following: 
• Editing Overview 
• Selecting Objects 
• Changing Basic Display Object Properties 
• Delete, Copy and Undo 
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Clipboard Ribbon Group 

  

The Clipboard ribbon group contains options for copying and pasting oneline objects while 
your are in Edit Mode. It also provides access to the Undo drawing feature. This ribbon group 
is on the Draw ribbon tab. The Group is shown below. 

 

 
Undo 

The Undo command is used in the edit mode to undo the last change made on the 
oneline diagram. The Undo command will only undo graphical changes, and will not 
undo any data changes in the power system model. See Relationship Between Display 
Objects and the Power System Model for information on the display/model 
relationships. 

Paste 

The paste command copies the contents of the paste buffer (if any) onto the display 
at the current cursor location. Use the Paste command from the Edit Menu. Note 
that the paste buffer may contain both display objects and the underlying power 
system records. When pasting, the display objects are pasted regardless of whether 
an identical display object already exists on the oneline. In contrast, duplicate power 
system records are never pasted. This is because, for example, it is acceptable to 
have two display objects referring to the same generator, but the generator exists 
only as a single entity in the power system model. See Relationship Between Display 
Objects and the Power System Model for further details. 

Paste Special 

Paste Special works the same as Paste, however it will also show a dialog asking the 
you to choose between  

Absolute Coordinates : objects will be pasted using the exact same x/y coordinate 
as the copied objects had. This is useful when copying objects between two different 
oneline diagrams which contain the same geographic background. 

Coordinates Relative to Cursor : objects will be pasted relative to cursor instead 
of using the exact x/y coordinates as the copied objects. 

Copy 

The Copy Command copies the currently selected object(s) into the paste buffer 
without deleting them. For power system objects, such as buses, generators or 
transmission lines, you are given an option of whether to copy just the display 
object(s), or copy both the display object(s) and their underlying power system 
records. See Relationship Between Display Objects and the Power System Model for 
further explanation of these choices. To copy only the display object(s) and never the 
power system records from now on, select the Always Copy Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog. 
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Cut 

The Cut Command is used in the Edit Mode to delete the currently selected object(s). 
To delete a set of objects, first select the objects. Then select the Cut command from 
the Edit Menu. For power system objects, such as buses, generators or transmission 
lines, you are given an option of whether to delete just the display object(s), or 
delete both the display object(s) and their underlying power system records. See 
Relationship Between Display Objects and the Power System Model for further 
explanation of these choices. To delete only the display object(s) and never the 
power system records from now on, select the Always Delete Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog.  

Unlike Delete, Cut also copies the selection into the paste buffer. 

Delete 

The Delete Command is used in the Edit Mode to delete the currently selected 
object(s). To delete a set of objects, first select the objects. Then select the Delete 
command from the Edit menu. For power system objects, such as buses, generators 
or transmission lines, you are given an option of whether to delete just the display 
object(s), or delete both the display object(s) and their underlying power system 
records. See Relationship Between Display Objects and the Power System Model for 
further explanation of these choices. To delete only the display object(s) and never 
the power system records from now on, select the Always Delete Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog.  

Unlike Cut, Delete does not copy the selection into the paste buffer. 
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Select by Criteria Dialog 

  

To open the Select By Criteria Dialog go to the Draw ribbon tab and choose Select By 
Criteria from the Select ribbon group.  

The Select By Criteria Dialog provides a way of selecting objects that meet a specific set of 
criteria. The criteria may include Area Numbers, Zone Numbers, Voltage Levels, Zoom Levels, 
and Object Type. 

Use the dialog's controls to specify the selection criteria. Use the Area and Zone fields to 
select the areas and zones in which you want to select display objects. Ranges of area and 
zone numbers can be entered in the usual way, or you can check the All Areas or All Zones 
boxes to select all areas and all zones. You can also use the Area and Zone tab pages to 
check or uncheck areas or zones in which you want to select display objects. 

Specify the max and min voltage levels for selected objects using the boxes that are provided, 
keeping in mind that all voltages are in kV.  

Specify the layers for selected objects in the Layers tab. If not all layers are selected, the 
Layers Range option will be selected. If the All Layers option is clicked, then all the layers 
will be selected.  

Next, select the type of object in which you are interested from the supplied list. To select 
items from this list, check the box next to the type of field(s) you desire. Display object types 
that are followed by a right-arrow, such as Area Fields, are expandable, meaning that they 
have several associated subtypes. If you checked a field type that has subtypes, you can 
highlight the type in the list to see the available subtype list. You can then more specifically 
select subtypes that you wish to include. By default, all subtypes of a general object type are 
selected. You also have the option for the list to display all fields available for a particular 
object type, or to display only the most commonly selected fields. 

You can also choose to associate an advanced filter with a particular type of object in the list 
for selecting only objects of that type that meet the filter. To do so, right-click in the Filter 
column next to the object type for which the filter applies, or click on Add/Modify Filter… 
Some objects cannot be associated with an advanced filter, and the option will be disabled 
when that is the case for an object selected in the dialog. 

Checking the option Group By Object Type will consolidate all the items by categories. All 
subtypes will automatically be included as a consequence. The filters are still available. 

If the box Only Show Objects in Display or Already Selected is checked, only the items 
or categories (depending on whether the Group By Object Type option is checked) of objects 
existing or selected in the respective oneline diagram will be shown in the supplied list. 

The buttons Check All and Uncheck All are useful to select/unselect all the items/groups in 
the list. The button Check Only Text Fields is available only when the Group by Object Type 
is unchecked, and when clicked on all the items that have text associated to them are 
selected, and the rest of the items are unselected. Clicking on the Reset To Defaults button 
will remove all the current selections and reset them to the default settings. 

If you wish to select objects that do not have the chosen criteria, then check Select All 
Except What Meets the Above Criteria. 

If you wish to only select objects that are currently visible on the diagram (due to layering, 
etc.), check the box labeled Select only currently visible objects to apply the criteria 
settings only to objects on the diagram that are currently visible. 

If the Select by Criteria Dialog is open and some display objects have already been selected, 
an advanced selection option becomes available. If the box labeled Use as a filter on 
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presently selected objects is checked, the criteria chosen in the Select by Criteria Dialog 
will only affect the previously selected objects. In other words, only the objects that were 
previously selected AND that match the chosen criteria will remain selected when the OK 
button is pressed. For example, you could use all the options available on the Select ribbon 
group on the Draw ribbon tab to select a group of objects on the oneline. Then using the 
Select by Criteria Dialog, choose the Bus criteria and check Use as a filter on presently 
selected objects to select only the buses from the rectangular selected group of objects. 

Once you have selected the criteria and pressed OK, all objects that satisfy ALL the criteria will 
be chosen. If the Select All Except What Meets the Above Criteria is unchecked, then the 
selected objects will lie within the specified areas AND zones, the specified voltage level, and 
the specified zoom levels, and will be of one of the drawing types specified. 

You can save your settings for your Select by Criteria session with the case by clicking Save 
As to save with a new name or Save to save with the current name. This allows you to re-
open the Select by Criteria dialog, and quickly recover settings you may have previously used. 
Use the Rename to rename an already saved set, or Delete to remove a previously saved set 
of criteria. 

If you have saved different criteria sets, you can export them all to an Auxiliary file by 
choosing Save to AUX file. The Load All from AUX file will load an entire auxiliary file, 
regardless of whether it contains Select by Criteria settings or not. 

If you wish to clear all settings you have modified on the dialog, click the Reset to Defaults 
button. 

Using this dialog in conjunction with the Format Selection Dialog, can be a very fast and easy 
way to customize your displays. 

NOTE: When choosing to select all tie lines, all objects associated with the tie line will also be 
selected. This includes all line fields for the line as well as the two buses that are the 
endpoints of the line. 
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Select Ribbon Group 

  

The Select ribbon group contains options to help select multiple oneline objects simulateously. 
The features in this topic are only available when you are in Edit Mode. This ribbon group is on 
the Draw ribbon tab. The Group is shown below.  

 
The features available on this ribbon group are described below. 

Select by Criteria  

Click on the Select by Criteria button to open the Select by Criteria Dialog. On oneline 
diagrams of even a modest size, this is an extremely useful feature and PowerWorld highly 
encourages you to use this feature. 

Select Region 

Use to select all objects in a particular region of the oneline. When the Region Type is 
Rectangle or Ellipse, then after clicking the button, click and hold the left mouse button 
on the oneline at the point where you would like to begin the selection. Then, drag the 
mouse to size the selection shape. Finally, let go of the mouse button once every object you 
need to select has been selected by the selection rectangle. When the Region Type is 
Polygon, then after clicking this button single click on your oneline diagram for each vertex 
of the polygon. Finally, finish the selection by double-clicking the mouse after which all 
objects inside your polygon will be selected. 

Depending on the Select Mode below, every object located entirely Inside the region, or if 
you have chosen Touching, then every object inside or partially touched will be selected. 
Selected objects will have handles appear indicating that they have been selected. 

Region Type 

Specify a Rectangle, Polygon, or Ellipse. This controls the shape used to select objects 
on the oneline diagram when using the Select Region button above. 

Select Mode 

This combo box specifies how the Select Region  button above works. Choose Inside in 
order to select only the objects completely inside the selection rectangle. Choose Touching 
in order to select every object either partially touched by or completely inside the selection 
rectangle. 

  

There are also other ways to select multiple objects 
• You can also select multiple objects manually by holding down the SHIFT key which 

clicking on objects in Edit Mode. This will also add to your selection. 
• If you hold down the SHIFT and CTRL keys simultaneously and then click on your oneline 

diagram and select a region it has the same affect as click on the Select Region button 
and selecting a region on your oneline 
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Grid/Highlight Unlinked Objects 

  

The Grid/Highlight Unlinked Objects tab is only available in Edit mode. It controls the 
appearance of a grid in the oneline. A grid is not visible by default, but can be setup from the 
Grid/Highlight Unlinked Objects page of the Oneline Display Options dialog. Additional options 
are available from this dialog for disabling anchors and highlighting unlinked objects on 
oneline diagrams. 
  

Snap Objects to Grid 

If checked, new objects placed on the oneline will be aligned with the grid; the grid does not 
need to be visible on the oneline to align objects to it. 

X Grid Spacing, Y Grid Spacing 

These determine the horizontal and vertical spacing of the grid. 

Display Grid Lines on Oneline 

If checked, the grid lines will appear on the oneline 

Horizontal Show Every, Vertical Show Every 

These numbers determine the density of the visible gridlines; for fewer lines enter higher 
numbers. 

Gridline Color 

Click in the rectangle to choose the color of the gridlines. The default is grey. 

Anchor Options 

A check box is available for temporarily disabling anchors on a oneline diagram. This option 
will disable the anchor properties of all objects on the oneline diagram. 

Do not prompt regarding relinking objects after dragging 

Check this check-box to avoid being prompted whether to relink a graphical object after this 
has been dragged. 

  

Highlighting of Unlinked Objects 

Highlight Unlinked Objects with Color 
Checking this box allows for any objects on all open oneline diagrams that are currently 
not linked to any data in the case to be highlighted using the highlight color. To change 
the highlight color used, left-click in the color box to choose a different color. 

Minimum Highlighted Object Pixel Size 

The minimum size, in pixels, of the highlight image. This is to prevent the highlight from 
being unnoticeable when the zoom level is very low. 

Extra Width for Highlighted Lines (pixels) 

Sets an extra width parameter, in pixels, for highlighting line objects. This will make line 
object highlights appear wider than other highlighted objects. 

Display Unlinked Elements in Run Mode 

This option allows the highlighting of unlinked elements when you switch to run mode. 
By default the highlighting of unlinked elements is restricted to edit mode, to avoid 
confusion in run mode, particularly when drawing contours. 
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Using the Oneline Alignment Grid 

  

The oneline alignment grid allows for buses and other objects to be easily aligned when placed 
onto a oneline diagram. The alignment grid for a oneline diagram can be configured in the 
Oneline Display Options dialog under the Grid/Highlight Unlinked page. You can open this 
display by selecting Oneline Display Options from the Active ribbon group on the Onelines 
ribbon tab. 
  

When the alignment grid is enabled most objects will snap to the grid while being moved on 
the oneline. Depending on whether snap to grid is enabled or disabled, objects can individually 
be made to do the opposite of the snap to grid setting by holding down the Alt key while 
dragging the object. 
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Setting Background Color 

  

The Background Color Dialog changes the background color for the display. To view this 
dialog, select Oneline Display Options from the Active ribbon group on the Onelines ribbon 
tab, or right-click in the background of the oneline and select Oneline Display Options from 
the local menu. Switch to the Display Options tab, click Change Background Color, or click 
on the colored rectangle to bring up the Color Dialog, which you can then use to select the 
new background color. Click OK to register the new color. The Oneline Display Options dialog 
will provide a preview of the color you selected. To define this color as the default background 
color to use in all new onelines you create, click the Set as Default Background Color. 
Finally, click OK to save your color selection.  
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Zoom, Pan, and Find 

  

The Zoom, Pan, and Find Options Dialog is used to specify a desired zoom level and screen 
location or to locate a particular bus or area/zone on the oneline. The dialog can be opened by 
right-clicking on the background of the diagram and choosing Pan/Zoom Control from the 
oneline popup menu, or by clicking on the Find button in the Zoom ribbon group on the 
Onelines ribbon tab. The dialog has the following fields: 
  

Find Objects on Oneline 

The Find Object on Oneline section of the dialog is used to pan to any desired bus object ,  
area/zone object , branch object, interface object, or substation object on the oneline. The 
dialog makes use of the advanced find functionality of Simulator to locate a device. 

Only Include Objects Visible at Current Zoom Level 

If checked (the default), then the Object ID combo box only lists those objects that are 
visible at the current zoom level. 

Object Type 

Select the type of object to find: Buses, Areas or Zones, Interfaces, Substations and 
Lines/Transformers. 

Sort By 

Specify whether you are entering the object by its number or by its name by choosing either 
Sort by Name or Sort by Number. This option also determines how the entries in the list 
of objects are sorted (either by number or by name). 

Object ID 

Enter the object’s number or name (depending on the sort type chosen) or select the object 
from the list.  

Allow Auto Updating on Selection 

Check this box to automatically pan to the specified object. The object will be located at the 
center of the oneline diagram. 

Pan to Object on Oneline 

Click this button to pan to the specified object if the Auto Updating box is not checked. The 
object will be located at the center of the oneline diagram. 

Auto-Zoom when Panning 

Check this box to automatically change the zoom when panning to the specified object. 

  

Zoom / Pan 

The Oneline Zoom / Pan tab on this dialog is used to allow the user to specify either a new 
zoom level and/or screen center and to define these as the new display default settings. The 
zoom level and screen center can also be changed from the keyboard. Please see Oneline 
Zooming and Panning  for details.  

Zoom Level 

Enter the desired percentage zoom level (nominal is 100%). 

Horizontal, Vertical  
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Enter a desired location for the center of the screen. The nominal screen center is 50 
horizontal and 50 vertical.  

Pan/Zoom to New Location 

Changes the screen center and zoom level to the values specified in the above fields.  

Restore Default Values  

Resets the zoom level and screen center to the default values. 
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Default Drawing Values 

  

The Default Drawing Options Dialog allows you to see and change the various default values 
used to create new objects. To show this dialog select Default Drawing Values from the 
Quick Insert ribbon group on the Draw ribbon tab. 
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Formatting Ribbon Group 

  

The Formatting ribbon group contains options for formatting the selected objects on your 
active oneline. This group is on the Draw ribbon tab and its options are available only in Edit 
mode. The options allow you to control such display object attributes as font, color, line styles, 
zoom-dependent visibility, and display layer level. The group is shown below. 

  

  

A description of the actions on this group are as follows. 

Refresh Anchors 

Invokes a command to refresh anchors on all oneline objects. 

 Format Buttons  

Clicking any of these five buttons will open the Format Dialog. Each of the buttons opens 
the Format dialog to a specific tab on the Format Dialog, but they all ultimately open the 
same dialog. 

Font  

Select this option to change the font with which the selected objects are displayed. 
The Font Tab of the Format Selection Dialog is displayed. 

Line/Fill 

Select this option to change the line thickness and style with which a display object is 
drawn, or the fill color for closed shapes. The Line/Fill Tab of the Format Selection 
Dialog is displayed. 

Levels/Layers 

Select this option to change the stack level of an object, the layer the object is 
contained in, and optional settings for when an object should resize. The 
Levels/Layers Tab of the Format Selection Dialog is displayed. 

Display/Size 

Simulator can change the attributes of the way multiple objects are displayed using 
this option, which opens the Display/Size page of the Format Selection Dialog. The 
size of the objects can be adjusted, as well as the orientation of the object(s) from 
their terminal buses. Objects can also be Anchored to their terminal buses or devices, 
or marked as Immobile, meaning the object(s) cannot be moved on the oneline 
diagram. 

Field 

Select this option to change the attributes related to object text fields which are 
selected. The Field Tab of the Format Selection Dialog is displayed. 

Copy Format and Paste Format Buttons 
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The button on the left is the Copy Format button. After selecting an object this will copy all 
the format properties of that object into an internal buffer. When you then subsequently 
select other objects, you can click on the button on the right which is the Paste Format 
button. Clicking the Paste Format button will bring up the Paste Format Dialog. 

 Send to Back, Bring to Front Buttons 

After selecting a group of oneline objects using any of the methods described on the Select 
ribbon group, you may then click the Send to Back button to cause all the objects selected 
to move to underneath other objects. Click the Bring to Front button to bring objects to 
the top.  

The Send to Back and Bring to Front menu options govern the visibility of display objects 
that occupy the same screen stack level. All objects have an associated screen stack level, 
which may be one of Base, Background, Middle, or Top. Objects having a screen stack level 
of Top obscure all objects having stack levels of Middle, Background, or Base that occupy 
the same region of the screen. They may or may not obscure objects having the same stack 
level of Top depending on the order in which the objects having the same stack level are 
drawn. Selecting Send to Back for a selected object will cause it to be obscured by all other 
same-level objects that occupy its location. Selecting Bring to Front for a selected object will 
cause it to be drawn above all other same-level objects that occupy the same region of the 
screen. The Send to Back and Bring to Front menu options govern relative placement of 
objects only within stack levels. The Send to Back and Bring to Front options do not affect 
the relative placement of objects having different stack levels. 

Alignment Menu 

The alignment menu provides access to the Alignment Dialog and direct access to options to 
align the selected objects as specified in the menu items. 

Grouping Menu 

Grouping is only available for background oneline objects (background lines, ellipses, text, 
etc...). This menu provides button to Group and Un-Group objects. 

Layers Menu  

The Layers Menus provide access for opening the Define Layers Dialog for the presently 
active oneline diagram. 

Underneath the button for defining layers is a list of the presently defined layers. You may 
check or uncheck the various layers to hide or show the objects in those layers. 
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Format Multiple Objects 

  

The Format Selection Dialog features five tabs of controls for modifying the display attributes 
of selected objects. To open the Format Multiple Options dialog you must first use some of the 
options available on the Select ribbon group on the Draw ribbon tab to select a group of 
objects. Next, right click on any of the selected objects and select Format Selection from the 
local menu. You may also bring up the Format Multiple Objects dialog by going to the 
Formatting ribbon group on the Draw ribbon tab. 
  

Line/Fill 

The Line/Fill Tab is used to change the line size, color, and style and the fill color with which 
the selected objects are drawn. 

Levels/Layers 

The Levels/Layers Tab is used to change the stack level of an object, the layer the object is 
contained in, and optional settings for when an object should resize. 

Display/Size 

The Display/Size Tab controls the size and orientation of the selected objects. 

Font  

The Font Tab is used to change the font used in text/font objects.  

Field 

The Field Tab is used to change selected fields on the diagram to a different field 
designation. If all of the selected fields are for the same type of object and field, you can 
select a different field to be represented by the selected objects from the Field selection. 
You can also set the options for including a suffix, the total digits in the field for numeric 
values, and the number of digits to the right of the decimal. 
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Paste Format Dialog 

  

The Paste Format Dialog appears when you use the Paste Format button on the Formatting 
ribbon group on the Draw ribbon tab. The dialog looks as follows 

 
  

On this dialog check the attributes you would like to paste to the selected objects. Note that 
attributes which are disabled in the Paste Format Dialog represent one of two things 
• The attribute was not relevant to the objects whose format was copied 
• The attribute was not the same for the objects whose format was copied 
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Font Properties 

  

The Font Tab allows you to define the font for the selected objects by choosing Font type, 
size, color and effects. The page also allows you to control the default display font using the 
Make Default button.  

By clicking on Make Default, the current font name, size, and effects will be set as the 
default font for the display. This has the same effect as opening the Default Drawing Values 
and setting the default font.  
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Line/Fill Properties 

  

The Line/Fill Tab is used to customize the line size/color and the fill color of selected objects. 
You can view this tab by selecting  from the Formatting ribbon group on the Draw ribbon tab. 
This tab’s controls can be used to change the appearance of most, but not all, screen objects. 
When you modify the line thickness or color of an object, these new values will be set as the 
default settings for all new line objects. You can view the case defaults using the Default 
Drawing Options Dialog. The Line and Fill Options tab has the following fields/commands: 
  

Line Thickness 

Thickness of the line in pixels.  

Dashed 

Allows setting a line to appear as a dashed line on the diagram. There are three types of line 
dashing to choose from in the drop down menu for this option. 

Note: Due to drawing limitations, the line thickness for a dashed line must be equal to 1. 
Any other line thickness will result in the line being drawn as solid, regardless of the dashed 
setting. 

Line Color 

The Line Color field shows the current line color. To change the line’s color, click on the box 
displaying the current line color, or click the Change Line Color button. This displays the 
Color Dialog. Select the desired color and select OK to change the color, or click Cancel if 
you do not wish to change the color. 

Line Color 2 

The Line Color 2 field applies only to transformer objects. Transformers can be represented 
by different colors on each side of the transformer coils. This is commonly used to color 
match each side of the transformer with the color used to represent the voltage level of the 
transmission system on each particular side of the transformer. However, you can customize 
the colors for selected transformers by modifying them here.  

Note that the Line Color 2 field ALWAYS applies to the high voltage side of the transformer 
when you change 

Use Background Fill 

Click on this field to toggle whether or not to fill the background for the selected objects 
with the selected background fill color. Only text objects such as Text, Bus Fields, Generator 
Fields, Load Fields, Switched Shunt Fields, Line Fields, Transformer Fields,  and Area Fields  
and background objects such as Background Lines and Background Rectangles can be filled.  

Fill Color, Change Fill Color 

The Fill Color field shows the current fill color. To change the fill color, click on the box that 
displays the current fill color, or click the Change button. This displays the Color Dialog. 
Click on the desired color and the select OK to change the color, or click Cancel if you do not 
wish to change the color. 
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Levels/Layers Options 

  

The Levels/Layers Tab is used to customize the stack level or layer an object is contained in. 
To set layers for objects, select the objects on the oneline diagram (edit mode only) and then 
choose . The Levels/Layers Options page of the Format Multiple Objects dialog will be 
displayed, with the following settings available. 
  

Stack Level 

An object’s stack level dictates what objects it will appear above, and which objects it will 
appear below on a oneline diagram. For example, circuit breaker and pie chart objects have 
a default stack level of Top. Therefore anything with a stack level of Middle, Background or 
Base will appear underneath pie charts and circuit breakers on the oneline diagram. Objects 
that are within the same stack level and are drawn in the same location will result in the last 
object drawn being the visible object on the diagram. You can toggle which elements within 
the same stack level at the same location is visible using the Send to Back and Bring to 
Front buttons in the Formatting ribbon group on the Draw ribbon tab. 

Layers 

Layers are different than stack levels in that layers are designed to allow the user to filter 
the elements visible on a diagram (in run mode). Initially all diagram objects are in the same 
layer, called Default. This default layer cannot be modified or deleted. However, you can 
introduce additional layers using either the Add New… or Define… buttons. Clicking on 
Add New… will open a dialog to name the new layer, and will automatically add the new 
layer to the case and change the Layer name in the drop down list to the new layer. Clicking 
on Define… will open the Screen Layers list display, which will allow you to manage the full 
list of layers defined for the diagram. Once layers have been defined, you can choose which 
layer the selected objects belong to by choosing the Layer name from the drop-down list by 
clicking on the down arrow to the right of the layer name. 

Settings for resizing when zooming 

You can modify the maximum and minimum zoom levels at which the selected text fields will 
no longer resize. Thus when zooming in or out on the diagram, text fields will resize 
according to the zoom level until the minimum or maximum zoom level are reached. At that 
point, text fields will no longer resize, but will stay fixed at their current size as you continue 
to zoom. 

Maintain Fixed Screen Location (do not pan) 

This option is available for text fields. When checked for selected text fields, these text fields 
will no longer pan when you pan the rest of the diagram. This allows you to place text that 
will always be visible, regardless of what part of the diagram you are observing. You can still 
move the individual text field itself in edit mode. 

Maintain Fixed Screen Size (do not resize on zoom) 

This option is available for text fields. When checked for selected text fields, these text fields 
will no longer resize when the zoom level of the diagram is changed. This allows you to 
place text that will always be visible at a constant size, regardless of what zoom level you 
are currently observing on the oneline diagram. You can still select the text fields 
themselves in edit mode and change their font size. 
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Screen Layers 

  

The Screen Layers display can be invoked from either the Levels/Layers button in the 
Formatting ribbon group in Edit Mode, or by right-clicking on the oneline diagram background 
and choosing Edit Screen Layers. 

Screen layers provide a method to filter objects on a oneline diagram based on either zoom 
level or to which layer the objects are assigned. Initially each object is in a common layer 
called Default, which cannot be modified or deleted. You can create new layers using the 
Screen Layers display. 

Since the Screen Layers display is a Case Information Display, it shares the of other case 
information displays. You can access many case information display features by right-clicking 
on the display to invoke the local popup menu. Most importantly, this menu contains the 
options to Insert and Delete screen layers.  

To delete a screen layer, right-click on that layer in the display and select Delete from the 
popup menu. The one exception is the Default layer, which cannot be deleted. 

To insert a new screen layer, right-click on a record in the display and choose Insert from the 
popup menu. This will open the Screen Layer Options dialog for defining the options of the 
new layer you are inserting. You can also define a new layer by going to the Onelines ribbon 
tab, then on the Active ribbon group choose Screen Layer > Define Screen Layer. 
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Screen Layer Options 

  

The Screen Layer Options are used to define options for new layers, or modify options for 
existing layers. Devices can be added to a layer by choosing the layer name from the drop-
down list on the Levels/Layers Tab of the Format Multiple Objects dialog.  
  

Name 

Layers can have any name desired to describe the layer. The default naming convention is 
"Layer #". 

Show Layer 

If this box is checked, any objects on the diagram which are contained in this layer may be 
visible. This depends on the settings for low and high zoom level, described below. If the 
box is unchecked, however, then any objects contained in this layer will be hidden. Only 
objects that are visible will be used when calculating contours. Unlike Custom Display Detail, 
layers can be applied in both edit mode and run mode.  

Selectable in Edit Mode 

By unchecking this box the user prevents the objects contained in this layer of being with 
the mouse during Edit Mode. This is behavior is particularly desirable for elements (such as 
borders which are pretty much already fixed) when editing oneline diagrams. 

Use Conditional Display by Zoom Level 

Objects can be displayed or hidden based on the Screen Layer to which they are assigned 
and the current zoom level of the oneline diagram. Checking this box, and setting the Low 
Zoom Level and High Zoom Level fields, dictates at what zoom range the objects contained 
in the zoom level will be visible. If the zoom level is outside the range defined, any objects 
belonging to the screen layer will be hidden. This also applies to both edit mode and run 
mode. 

Memo 

This tab allows the user to enter text in order to describe this layer. 

 



Editing Oneline Diagrams 

316 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Format Field Properties 

  

The Field tab of the Format Multiple Objects dialog can be used to modify the format of the 
selected fields, or to change a set of selected fields from one field representation to another. 
Use the Select by Criteria dialog to select fields of a particular type, right-click on any of the 
selected fields and choose Format Selection from the popup menu. 

Note that this option also applies to objects which display information related to specific object 
fields, such as Line and Interface Pie Charts. 
  

Object Type 

This field will be filled in automatically based on the type of object the selected field(s) apply 
to. You cannot change this field, which means that you can only change the selected field(s) 
to another field for the same type of object. 

Field 

The field type of the selected field(s). To change the selected fields to a new field type, click 
on the drop-down arrow of the combo box, or click on the Find… button, and select a new 
field from the list of fields for the Object Type. 

Include Suffix 

Checking this option will add the unit suffix to the selected fields. 

Total Digits in Field 

Modify the number of digits to display in the field. This number includes the decimal and the 
numbers to the right of the decimal. 

Digits to Right of Decimal 

Modify the number of the total digits that should appear to the right of the decimal. 
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Display/Size Properties 

  

Use the Display/Size Tab of the Format Multiple Objects dialog to change the display size, 
orientation, anchor property of the selected objects.  
  

Size 

This field will change the characteristic display size of the selected objects. The 
characteristic size is normally the vertical size or height of display objects. In objects with 
different orientation choices, the size is the most distinctive dimension of the object (e.g. in 
buses with right or left orientations, the size is the horizontal dimension of the bus bar, but 
in buses with up or down orientations, the size is the vertical dimension of the bus bar). 

Width 

This field will change the characteristic display width of the selected objects. Similarly to the 
size, the width represents the horizontal dimension or width of display objects. In objects 
with different orientation choices, the width is the least distinctive dimension of the object 
(e.g. in buses with right or left orientations, the width is the vertical dimension of the bus 
bar, but in buses with up or down orientations, the width is the horizontal dimension of the 
bus bar). 

Anchored 

To toggle whether or not the selected objects are anchored , check or uncheck this option 

Immobile 

To force the selected objects to stay in the same position, check this option. 

Orientation 

This group will modify the orientation setting of the selected objects. 

Shape 

Use this group to modify the shape of the selected display objects. If the option selected is a 
valid selection for an object, the object shape will be changed; otherwise, the original shape 
will not be modified. For Substation objects, the Use Substation Layout Settings specifies 
that the shape selected in the Substation Display Options will be used. 

Number of Selected Objects 

This field shows the number of objects that are currently selected on the oneline. 
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Align Group Objects 

  

The Align Group feature allows for selecting multiple objects on a oneline diagram and aligning 
them in a specified manner. There are a couple of ways to perform the alignment. 

First, select the objects on the diagram that you wish to align. Once you have selected all 
objects, you can 1) right click on a selected object and choose Align Group Objects from the 
local popup menu or 2) use the Alignment menu found in the Formatting ribbon group on 
the Draw ribbon tab. 

The Align Group Objects option from the local menu will open the Align Dialog, which allows 
for specifying the type of alignment desired. Alignment can be performed horizontally, 
vertically, or both. In addition to alignment of the top, bottom, left and right edges of the 
selected objects, you can also choose to have the objects snap to the drawing grid in the 
horizontal and/or vertical directions as well.  

These alignment actions can also be selected directly from the Alignment menu found on the 
Formatting ribbon group on the Draw ribbon tab. 
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Clipboard Ribbon Group 

  

The Clipboard ribbon group contains options for copying and pasting oneline objects while 
your are in Edit Mode. It also provides access to the Undo drawing feature. This ribbon group 
is on the Draw ribbon tab. The Group is shown below. 

 

 
Undo 

The Undo command is used in the edit mode to undo the last change made on the 
oneline diagram. The Undo command will only undo graphical changes, and will not 
undo any data changes in the power system model. See Relationship Between Display 
Objects and the Power System Model for information on the display/model 
relationships. 

Paste 

The paste command copies the contents of the paste buffer (if any) onto the display 
at the current cursor location. Use the Paste command from the Edit Menu. Note 
that the paste buffer may contain both display objects and the underlying power 
system records. When pasting, the display objects are pasted regardless of whether 
an identical display object already exists on the oneline. In contrast, duplicate power 
system records are never pasted. This is because, for example, it is acceptable to 
have two display objects referring to the same generator, but the generator exists 
only as a single entity in the power system model. See Relationship Between Display 
Objects and the Power System Model for further details. 

Paste Special 

Paste Special works the same as Paste, however it will also show a dialog asking the 
you to choose between  

Absolute Coordinates : objects will be pasted using the exact same x/y coordinate 
as the copied objects had. This is useful when copying objects between two different 
oneline diagrams which contain the same geographic background. 

Coordinates Relative to Cursor : objects will be pasted relative to cursor instead 
of using the exact x/y coordinates as the copied objects. 

Copy 

The Copy Command copies the currently selected object(s) into the paste buffer 
without deleting them. For power system objects, such as buses, generators or 
transmission lines, you are given an option of whether to copy just the display 
object(s), or copy both the display object(s) and their underlying power system 
records. See Relationship Between Display Objects and the Power System Model for 
further explanation of these choices. To copy only the display object(s) and never the 
power system records from now on, select the Always Copy Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog. 
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Cut 

The Cut Command is used in the Edit Mode to delete the currently selected object(s). 
To delete a set of objects, first select the objects. Then select the Cut command from 
the Edit Menu. For power system objects, such as buses, generators or transmission 
lines, you are given an option of whether to delete just the display object(s), or 
delete both the display object(s) and their underlying power system records. See 
Relationship Between Display Objects and the Power System Model for further 
explanation of these choices. To delete only the display object(s) and never the 
power system records from now on, select the Always Delete Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog.  

Unlike Delete, Cut also copies the selection into the paste buffer. 

Delete 

The Delete Command is used in the Edit Mode to delete the currently selected 
object(s). To delete a set of objects, first select the objects. Then select the Delete 
command from the Edit menu. For power system objects, such as buses, generators 
or transmission lines, you are given an option of whether to delete just the display 
object(s), or delete both the display object(s) and their underlying power system 
records. See Relationship Between Display Objects and the Power System Model for 
further explanation of these choices. To delete only the display object(s) and never 
the power system records from now on, select the Always Delete Object(s) Only 
option. You will not be prompted again. You can disable this selection on the Default 
Drawing Options Dialog.  

Unlike Cut, Delete does not copy the selection into the paste buffer. 
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Undo Command 

  

The Undo command is used in the edit mode to undo the last change made on the oneline 
diagram. The Undo command will only undo graphical changes, and will not undo any data 
changes in the power system model. See Relationship Between Display Objects and the Power 
System Model for information on the display/model relationships. 
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Chapter 7: Properties of Simulator Objects 

  

This chapter provides a description of the properties of each of the Oneline Display Objects. 
Note that when you are using the Simulator, you can obtain context sensitive help for oneline 
objects by positioning the cursor on the desired object and pressing the F1 key. Of the many 
properties of the various objects in Simulator, some are relevant only to the Edit Mode, and 
some only to the Run Mode.  

The following material is included: 
• Edit Mode Properties and Information 
• Run Mode Properties and Information 
• General Properties and Information 



Properties of Simulator Objects 

323 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Zone Information (Edit Mode) 

  

The Zone Dialog is used in the Edit Mode to view information about a zone and to move one 
or more buses from one zone to another. (See Zone Information (Run Mode) for help on the 
corresponding Run Mode version.) To view this dialog, open the Zone Records Display by 
clicking on Aggregations > Zones in the Model Explorer. Then, right-click on the desired 
zone record and select Show Dialog to view this dialog.  
  

The dialog has the following fields: 

Zone Number 

Zone number between 1 and 999. You can use the spin button immediately to the right of 
this field to move to either the next zone (click the up arrow) or the previous zone (click the 
down arrow).  

Zone Name 

Alphanumeric identifier for the zone. You can use this field to change the zone's name, 
provided you click either Save or OK.  

Find By Number 

To find a zone by its number, type the number in the Number field and click this button. 

Find… 

If you do not know the exact zone number you are looking for, you can click this button to 
open the advanced search engine. 

Labels 

To assign alternative identifying labels to the zone, click the Labels button, which will open 
the Label Manager Dialog listing all the labels assigned for the selected zone. 

  

OK, Save, Cancel  

OK saves any changes to the zone name and closes the dialog. Save saves any changes to 
the zone name, but does not close the dialog. Cancel closes the dialog ignoring any 
changes.  

  

The zone dialog contains three additional pages of information: 

  

Zone Buses Table 

This table lists all of the buses in the zone. Number, name, voltage, area number, and area 
name are shown for each bus. This table can be used to move buses to a different zone. 
Select the bus or buses you would like to move with the mouse. Then, enter the 
Destination Zone Number, which is the zone to which you want to move the selected 
buses. You may enter a zone number that does not already exist, too, so that the buses will 
be moved to a brand new zone. In this case, be sure to provide the Zone Name, as well. 
Finally, click the Move Selected Bus(es) to Destination Zone button to implement the 
move.  

  

Custom 



Properties of Simulator Objects 
 

324 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

The Custom Page of the Zone Information dialog displays custom numbers or strings 
defined with the viewed zone. The Memo box is simply a location to log information about 
the zone. To log information about the zone, simply start typing your information or 
comments about the zone in the memo box. 
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Bus Information (Edit Mode) 

  

This dialog is used to view/modify information about each bus in the system during Edit Mode. 
It is very similar in content to its Run Mode counterpart. 
  

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus. You can use the spin button immediately to the right of the number to move to the 
next bus (click the up arrow) or the previous bus (click the down arrow). 

Find By Number 

To find a bus by its number, enter the number into the Bus Number field and then click 
this button.  

Bus Name 

Unique alphabetic identifier for the bus.  

Find By Name 

To find a bus by its name, enter the bus name into the Bus Name field (case insensitive) 
and then click this button. 

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Nominal Voltage 

Nominal voltage of the bus in kV. 

Labels 

Clicking on this button will open the Label Manager Dialog listing all of the labels assigned 
for the selected bus. 

Area Number 

Number of the bus’ area. Each bus must be associated with an area record. If a bus is 
specified as belonging to an area that does not already exist in the model, the new area is 
created.  

Area Name 

Alphabetic identifier for the bus’ area. If the area already exists, you do not need to enter 
this value. 

Zone Number 

Number of the bus’ zone, between 1 and 2,147,483,647 (equals 2^31 minus 1). Each bus 
must be associated with a zone record. If a bus is specified as belonging to a zone that does 
not already exist in the model, the new zone is created. Zones provide a useful mechanism 
for breaking up a large system. Buses can be assigned to zones independent of their area 
assignments. Thus, a single area could contain multiple zones, or a single zone could span 
multiple areas. You can use the Zone Dialog  to list the buses in a particular zone and easily 
move a group of buses from one zone to another. 

Zone Name 

Alphabetic identifier for the bus’ zone. If the zone already exists, you do not need to enter 
this value. 
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Owner Number 

The number of the bus’ owner. 

Owner Name 

The name of the bus’ owner. 

Substation Number 

The number of the substation the bus is contained in. This is typically blank in most power 
flow data, unless specifically added to a PowerWorld binary save file. 

Substation Name 

The name of the substation the bus is contained in. This is typically blank in most power 
flow data, unless specifically added to a PowerWorld binary save file. 

OK, Save, and Cancel 

OK saves your changes and closes the dialog. Save saves your changes but does not close 
the dialog; this allows you to use, for example, the Find By Number command to edit 
additional buses. Cancel closes the dialog without saving any changes.  

  

Bus Information 

Voltage (pu), Angle (degrees) 

Current per-unit voltage magnitude and angle for the bus. If you are inserting a new bus 
into an existing system, you should not change the initial per unit voltage values. 
Rather, when you first switch to Run Mode, Simulator will estimate the voltage magnitude 
and angle at the new buses in such a way as to reduce the initial mismatches. This 
automatic estimation is only available if you have not modified the voltage in any 
way. 

System Slack Bus 

Check only if the bus should be modeled as a system slack bus. Each case requires at least 
one slack bus.  

  

Display 

Orientation 

Set the orientation of the bus. The current choices are right, left, up or down. For the 
current bus object shapes of Rectangle and Ellipse, right and left are analogous to 
horizontal, up and down are analogous to vertical. Additional shapes for buses may be 
available in the future for which right, left, up and down may have more specific impact on 
the appearance of the bus object. 

Shape 

Sets the shape of the bus object.   

Width 

Specifies the horizontal axis of an elliptical bus or horizontal side length of a rectangular bus. 

Size 

Specifies the vertical axis of an elliptical bus or the vertical side length of a rectangular bus. 

Scale Width with Size 
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When this option is checked, changing the size will cause the width to automatically adjust 
to keep the same ratio of width to size. To adjust the width independent of the size, 
uncheck this option or adjust the width separately after adjusting the size. 

Link to New Bus 

If you have right clicked on a bus and opened the bus information dialog, you could change 
the bus number in the Bus Number field and press this button to force the bus object on 
the diagram to link to the new bus number and information in the load flow data. 

  

Attached Devices  

Load Summary Information 

Displays the net MW and Mvar load at the bus. You cannot change either of these fields 
from this display. Select the Add or Edit Bus Load Records to view the individual load 
records for the bus via the Load Dialog. 

Shunt Admittance 

The real (G) and reactive (B) components of shunt compensation at the bus, expressed in 
MW and MVR, respectively. 

  

Fault Parameters 

This tab is only visible when viewing the bus information for a bus with attached load. The 
parameters on this tab are used when running a fault analysis study. The values represent the 
total load at the bus for the negative and zero sequence as equivalent admittances. By default, 
these values are zero. For load buses, these values can be changed by the user, or they can 
be specified by loading short circuit data from within the Fault Analysis Dialog. 
  

Custom 

The Custom page of the dialog contains two sections: custom fields and memo.  

The custom fields section allows access to setting and changing the values for custom fields 
that have been defined for the bus. Defining custom fields is detailed in Custom Field 
Descriptions.  

The Memo section of the dialog is simply a location to log information about the bus. Any 
information entered in the memo box will be stored with the case when the case is saved to a 
PWB file. 
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Bus Field Information 

  

Bus field objects are used primarily to indicate various quantities associated with bus devices. 
Furthermore, some bus field types, which are distinguished by an integrated spin button, may 
be used to change bus device properties. 

The Bus Fields Information Dialog can be used to modify the properties of individual bus fields 
on the oneline. The dialog displays the following fields: 
  

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Bus Number 

Number of the bus associated with the field. Use the drop-down box to view a list of all 
buses in the case with valid area/zone/owner filters.  

Bus Name 

Name of the bus associated with the field. Use the drop-down box to view a list of all buses 
in the case with valid area/zone/owner filters.  

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Value 

The current value of the field being displayed. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Delta Per Mouse Click 

This option is currently not used for bus fields. 

Maintain Constant Load Power Factor 

This option is only used for certain fields, such as load fields and generator fields. It is not 
used currently for any bus fields. 

Include Suffix 

If this checkbox is checked, the corresponding field units will be displayed after the current 
value. Otherwise, only the value without units will be shown. 

Anchored 

If this checkbox is checked, the bus field is anchored to its associated bus, which means that 
it will move with the bus. 

Rotation Angle in Degrees 

The angle at which the text will appear on the diagram. 

Type of Field 

Used to determine the type of bus field to show. The following choices are available: 
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Bus Name Name of the bus 

Bus Number Bus number (from 1 to 2,147,483,647 (equals 2^31 minus 1)) 

Bus Voltage Bus voltage magnitude 

Bus Angle Bus voltage angle in degrees 

MW Marginal Cost Bus MW marginal cost in $/MW•hr; available only with OPF 

Mvar Marginal Cost Bus Mvar marginal cost in $/Mvar•hr; available only with OPF 

MW Loss Sensitivity Increase in losses for 1 MW of generation over the nominal  

Select a Field Choose from any defined Bus fields 

Select OK to save changes and to close the dialog, or click Cancel to close the dialog without 
saving your changes.  
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Shortest Path Between Elements 

  

To access the Shortest Path Between Elements go to the Tools ribbon tab, and choose 
Connections > Determine Shortest Path Between...  from the Other Tools ribbon group. 
The Determine Shortest Path Between dialog provides a way to find the shortest electrical 
pathway between two parts of the power system.  

After clicking the Calculate button, the shortest path of AC branches will be determined with 
the first bus being inside the Start Element and the last bus being inside the End Element. 
Options described below allow the user to choose the Start Element, End Element, Distance 
Measure for each branch, and branches that are allowed to be traversed. The results will be 
displayed in a case information display at the bottom of the dialog showing the sequence of 
buses that are traversed between the start and end elements. 

The options on the dialog are described below.   

Start Element Type and Element 

Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection 
Group. Then use the object chooser to choose the particular object to be the starting 
element. For more help on the object choose see the Find Dialog Basics. 

End Element Type and Element 

Choose an element type to be either a Bus, Substation, Area, Zone, Super Area or Injection 
Group. Then use the object chooser to choose the particular object to be the ending 
element. For more help on the object choose see the Find Dialog Basics. 

Distance Measure 

Choose the distance measure that will be used to determine distances between nodes. Each 
branch will be treated as having a length based on the choice below. Note: negative values 
are not allowed, therefore negative values will be treated as extremely small lengths 
instead. 

  X the per unit series reactance.  
  |Z| the magnitude of the series impedance (based on the per unit series 

reactance and resistance) 
  Length the Length Field for each branch  
  Number of 

Nodes 
Length of 1.0 is used for all branches 

  Other When choosing Other, click the Find.. button to choose any numeric field of 
a branch 

Lines to Process 

Regardless of the Distance Measure above, you can choose which branches allowed to be 
traversed when finding the shortest path. 

  All All branches are allowed to be traversed 
  Only 

Closed 
Only branches that are presently closed can be traversed 

  Filter Only branches that meet the Advanced Filter specified can be traversed . Click 
Define... to choose or create an advanced filter. 

  Selected Only branches whose Selected? field is set to YES can be traversed 
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Substation Information (Edit Mode) 

  

The Substation Dialog is used in the Edit Mode to view information about a substation and to 
move one or more buses from one substation to another. (See Substation Information (Run 
Mode) for help on the corresponding Run Mode version.) To view this dialog, first select 
Aggregation > Substations from the Model Explorer to view the Substations Records 
Display. Then, right-click on the desired substation record and select Show Dialog to view 
this dialog.  
  

The dialog has the following fields: 

Substation Number 

An integer identifier for the substation. You can use the spin button immediately to the right 
of this field to move to either the next substation (click the up arrow) or the previous 
substation (click the down arrow).  

Substation Name and ID 

Two alphanumeric identifiers for the substation. You can use these fields to change the 
substation’s name or ID, provided you click either Save or OK. 

Find By Number 

To find a substation by its number, enter the number into the Substation Number field, 
then click this button. 

Find By Name 

To find a substation by its name, enter the name into the Substation Name field, then 
click this button. 

Find By Sub ID 

To find a substation by its substation ID, enter the ID into the Substation ID field, then 
click this button. 

Find… 

If the exact substation number, name and ID are not known, you can use the Find Dialog to 
search for and select a substation from a list of substations. 

Labels 

Clicking this button will open the Subscribed Aliases dialog displaying the list of defined 
labels for the substation. New labels can also be added for the substation from the dialog as 
well. 

Buses 

This table lists all of the buses in the substation. Number, name, voltage, area number and 
name, and zone number and name are shown for each bus. This table can be used to move 
buses to a different substation. Select the bus or buses you would like to move with the 
mouse. Then, enter the Destination Substation Number, which is the substation to which you 
want to move the selected buses. You may enter a substation number that does not already 
exist, too, so that the buses will be moved to a brand new substation. In this case, be sure to 
provide the new substation a name and ID, as well. Finally, click the Move Selected Bus(s) to 
Destination Substation button to implement the move. 

Display Options 
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The Display Options tab of the Substation Information dialog is only visible if an open diagram 
contains an object representing the substation. This tab allows you to choose the general 
appearance of the substation object. Use the Width and Height fields to set the width and 
height of the substation object. The Shape field allows you to choose what shape the 
substation object will take. 

By clicking on Link to New Object, the Choose Object selector will appear, allowing the user 
to select another substation in the load flow data to be linked to this particular graphical 
object.  

The Substation Layout Oneline, URL or Command field allows you to specify the same of 
the Simulator oneline diagram (pwd) file that should be automatically opened if you click on 
the substation object on the diagram in run mode. If no oneline is specified, Simulator will 
search for a default name of the format AreaName_SubstationName. If a diagram cannot be 
found, then Simulator will not attempt to open any oneline diagrams when the substation is 
clicked. Optionally, a HTTP URL can be entered in the form http://example.com. Also, a line 
command can be entered, such as Excel.exe c:\file.xls. 

Substation Generators, Loads, and Switched Shunts Tables 

These tables list all of the generators, loads, and switched shunts in the substation. Number, 
name, ID, status, and additional fields for each type of device are shown. 

Custom 

Enter any text notes you wish in the Memo page. When the case is saved as a Simulator PWB 
file, the memo text will also be saved. Custom fields can also be entered for storage with the 
selected substation. 

Geography 

Displays geographic information about the location of the substation, in Latitude and 
Longitude. 

  

OK, Save, Cancel 

OK saves any changes to the substation name or ID, and closes the dialog.  

Save saves any changes to the substation name or ID, but does not close the dialog.  

Cancel closes the dialog ignoring any changes. 
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Substation Field Options 

  

Substation field objects are used to show different values associated with substations. This 
dialog is used to view and modify the parameters associated with these fields.  

Substation Number 

Select the number of the substation for which you are inserting or viewing information of a 
substation field. 

Find… 

If you do not know the exact substation you are looking for, you can click this button to 
open the advanced search engine. 

Substation Name 

The name of the currently selected substation. 

Substation ID 

The substation ID number. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Rotation Angle in Degrees 

The angle at which the text will appear on the diagram. 

Field Value 

Shows the current output for the super area field. Whenever you change the Type of Field 
selection, this field is updated. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Anchored 

Toggle the anchoring of the field to the substation object of which it is associated. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of super area field to show. The following choices are available: 

Substation Name, Substation Number  

Name or number of the selected substation. 

Substation ID 

ID string for the selected substation. 

Max Nominal Voltage  

Displays the nominal voltage of the highest nominal voltage bus in the substation. 

Substation Load MW, Substation Load Mvar 
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Total Load MW or MVAR in the substation. 

Substation Gen MW, Substation Gen MVAR  

Total Generator MW or MVAR in the substation. 

Select a Field 

Select this option and click Find Field… to display the value of any other substation specific 
field. 
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Generator Information (Edit Mode) 

  

This dialog is used to view and modify the parameters associated with each generator in the 
system. It can also be used to insert new generators and sometimes to delete existing 
generators.  

The Edit Mode version of the Generator Information Dialog is almost identical to the Run Mode 
version.  
  

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus to which the generator is attached. The dropdown list enumerates all generator buses in 
the case that meet the criteria established by area/zone/owner filters. You may select a bus 
number directly from the dropdown list, or you may use the spin buttons to cycle through 
the list of generator buses.  

Bus Name 

Unique alphabetic identifier for the bus to which the generator is attached, consisting of up 
to eight characters. Use this dropdown box to view a list of all generator bus names in the 
case with valid area/zone/owner filters.  

ID 

Two-character alphanumeric ID used to distinguish multiple generators at a bus; ‘1’ by 
default.  

Find By Number 

To find a generator by its number and ID, enter the number into the Bus Number field and 
the ID into the ID field. Then click this button.  

Find By Name 

To find a bus by its name and ID, enter the bus name into the Bus Name field (case 
insensitive) and the ID into the ID field. Then click this button. 

Find… 

If you do not know the exact generator bus number or name you are looking for, you can 
click this button to open the advanced search engine. 

Status 

Status of the generator, either Closed (connected to terminal bus) or Open (not connected). 
You can use this field to change the status of the generator.  

Area Name 

Alphabetic identifier for the terminal bus’ area. 

Labels 

Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases 
assigned for the selected generator. 

Fuel Type 

Type of fuel used by the generator this model represents. In most cases, this field is 
unnecessary for normal load flow analysis, and hence the default value is Unknown. 
However, this value can be useful during the Security Constrained OPF analysis. 

Unit Type 
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The type of unit the generator represents, such as combined cycle, steam, hydro, etc. 

  

There are six additional areas of information on this dialog for specific aspects of generation: 

Display Information 

Power and Voltage Control 

Costs 

Fault Parameters 

Owner, Area, Zone, Sub 

Custom 
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Generator Field Information 

  

Generator field objects are used primarily to indicate various quantities associated with 
generation devices. Furthermore, some generator field types, which are distinguished by an 
integrated spin button, may be used to change generation device properties. 

The Generator Fields Information Dialog can be used to modify the properties of individual 
generator fields on the oneline. The dialog displays the following fields: 
  

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Bus Number 

Number of the bus to which the generator associated with the field is connected. Use the 
dropdown box to view a list of all buses with generators in the case with valid 
area/zone/owner filters.  

Bus Name 

Name of the bus to which the generator associated with the field is connected. Use the 
dropdown box to view a list of all buses with generators in the case with valid 
area/zone/owner filters.  

ID 

ID of the generator associated with the field. Generator ID are two-character alphanumeric 
fields. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Value 

The current value of the field being displayed. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Delta Per Mouse Click 

Generator fields can be used not only to show various fields associated with generation 
devices, but they can also be used to change some values. This is accomplished using spin 
buttons shown to the right of the generator field. When the up spin button is clicked, the 
generator field value is increased by the amount specified in the delta per mouse click field. 
When the down spin button is clicked, the generator field value is decreased by the same 
amount. 

This field is only used for fields of the following types: Setpoint Gen MW, Setpoint Gen Mvar, 
and Gen Setpoint Voltage. Specifying a nonzero value in this field causes the integrated spin 
button to appear as part of the generator field on the oneline. 

Rotation Angle in Degrees 

The rotation angle at which the text field should be displayed. 
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Anchored 

If the Anchored checkbox is checked, the generator field is anchored to its associated 
generator, which means that it will move with the generator.  

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of generator field to show. The following choices are available: 

Gen MW Output MW generation 

Gen Mvar Output Mvar generation 

Gen AGC Status AGC status of generator; status can be toggled in Simulator 

Gen AVR Status AVR status of generator; status can be toggled in Simulator 

Gen Setpoint Voltage Voltage of generator on bus 

Select a Field Choose from any of the different generator fields 

Select OK to save changes and to close the dialog, or click Cancel to close the dialog without 
saving your changes.  
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Generator Options: Display 

  

This information is located on the Generator Information Dialog. 
  

Display Size 

The size of the generator. 

Scale Width with Size 

If checked, the Display Width will automatically be scaled to the appropriate setting when 
the Display Size is changed. If unchecked, then only the length of the generator object will 
be affected by changing the value of the Display Size. 

Display Width 

The width of the display object. This setting is automatically set if Scale Width with Size is 
checked and the value of the Display Size field is changed, or the Display Width value can 
be set manually to a new value. 

Pixel Thickness 

Thickness of the display object in pixels.  

Orientation 

Specifies the direction in which to draw the object.  

Anchored 

If checked, the object is anchored to its terminal bus. See Anchored Objects for details. 

Link to New Generator 

Links the object to a different generator in the data. 
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Generator Options: Power and Voltage Control 

  

This information is located on the Generator Information Dialog. 
  

Power Control 

The Power Control grouping fields are used to show/change the values associated with the 
real power output of the generator.  
  

MW Output 

Current real power output of the generator. 

Minimum and Maximum MW Output 

Minimum and maximum real power output limits for the generator. Simulator will not let the 
MW output go below its minimum value or above its maximum value if the Enforce MW 
Limits option is exercised.  

Available for AGC 

Determines whether or not the generator is available for automatic generation control 
(AGC). Normally this box should be checked. However, there are times when you would like 
to control the generator output manually (such as if you are using the generator to remove 
a line limit violation), in which case you should leave this box unchecked. A generator is also 
placed on "manual" control anytime you manually change its output. You could then place 
the generator back on AGC control if you wish it to participate in an area generation 
dispatch.  

Enforce MW Limits 

If checked, the minimum and maximum MW limits are enforced for the generator, provided 
the Enforce Generator MW Limits field is also checked on the Limits Tab of the Simulator 
Options Dialog. If this box is checked and a generator is violating a real power limit, the 
generator’s MW output is immediately changed.  

Participation Factor 

The participation factor is used to determine how the real power output of the generator 
changes in response to demand when the generator is available for AGC and the area is on 
participation factor control. When you open a case using the PTI Raw Data Format, this field 
is initialized to the per unit MVA rating of the generator, since participation factor 
information is not stored in the PTI format.  

Voltage Control 

The Voltage Control grouping is used to show/change values associated with controlling the 
voltage/reactive power output of the generator.  
   

Mvar Output 

Current reactive power output of the generator. You can manually change this value only if 
Available for  AVR is not checked.  

Min and Max Mvar Output 

Specify the minimum and maximum allowable reactive power output of the generator.  

Available for AVR 
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Designates whether or not the generator is available for automatic voltage regulation (AVR). 
When the AVR field is checked, the generator will automatically change its reactive power 
output to maintain the desired terminal voltage within the specified reactive power range. If 
a reactive limit is reached, the generator will no longer be able to maintain its voltage at the 
setpoint value, and its reactive power will then be held constant at the limit value.  

Use Capability Curve 

If checked, then the generator’s reactive power limits are specified using a reactive 
capability curve that prescribes the dependence of the generator’s reactive power limits on 
its real power output. Otherwise, the fixed values given in the Min Mvar Output and Max 
Mvar Output fields are used. The generator reactive capability can be defined using the 
table that appears at the bottom of the dialog. Please see Generator Reactive Power 
Capability Curve for details.  

Regulated Bus Number 

Number of the bus whose voltage the generator is regulating. This is usually, but not 
always, the generator’s terminal bus. Multiple generators can regulate the same remote bus, 
but the regulated bus must not be another generator bus. If the generator is at a slack bus, 
it must regulate its own terminal voltage. Select  Solution Details > Remotely 
Regulated Buses in the Model Explorer to view the Remotely Regulated Buses display, 
which identifies all buses that are being remotely regulated. 

SetPoint Voltage 

Specifies the desired per unit setpoint voltage value the generator is to regulate at the 
regulated bus. The regulated bus need not be the generator terminal bus. 

Remote Reg % 

This field is only used when a number of generators at different buses are regulating a 
remote bus (i.e., not their terminal buses). This field then specifies the percentage of the 
total reactive power required by the remote bus to maintain its voltage that should be 
supplied by this generator. The default value is 100. If the total value is different from 
100%, then all the regulation factors are normalized to obtain a percentage of regulation. 
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Generator Options: Costs 

  

The Costs tab of the Generator Information dialog (run mode) is used to show/change values 
associated with the cost of operation of the generator. See Generator Cost Information for 
details. Cost data can also be saved/loaded using the Generator Cost Data files.  
  

Output Cost Model 

Cost Model 

Simulator can model generators as not having a cost model, or having either a cubic cost 
model or a piecewise linear model. The cost model type you choose determines the content 
of the remainder of this dialog  

Unit Fuel Cost 

The cost of fuel in $/MBtu. This value can be specified only when you have chosen to use a 
cubic cost model. 

Variable O&M 

The Operations and Maintenance costs. Only used for cubic cost models. 

Fixed Costs (costs at zero MW Output) 

The fixed costs associated with operating the unit. These costs are independent of the 
generator's MW output level and is added to the cost prescribed by the cubic or piecewise 
linear model to obtain the total cost of operating the generator in $/MWHr. The total fixed 
cost is the addition of the fuel cost independent value and the fuel cost dependent value 
multiplied by unit fuel cost. 

Cubic Cost Coefficients A, B, C, D 

For cubic cost models of the form C(Pgi) = (d*Pgi^3 + c*Pgi^2 + b*Pgi ) * (fuel cost) + 
fixed costs (as described above), specify the cost curve's coefficients. The A coefficient is 
historically the fuel cost dependent fixed cost value, which is combined separately now with 
the fuel cost independent value. These coefficients can be specified only when you have 
chosen to use a cubic cost model. 

Piecewise Linear Table 

If you have chosen to use a piecewise linear cost model, a table appears that allows you to 
specify pairs of MW output levels and corresponding generator operating costs. To insert a 
new point on the cost curve, right-click on the table and choose Insert New Point from the 
resulting local menu. To delete an existing point from the cost curve, right-click on the table 
and choose Delete Point from the resulting local menu. To edit an existing point in the table, 
simply enter your changes to the appropriate cells. 

Convert Cubic Cost to Linear 

Use this option to create a piecewise linear cost function from the cubic cost function 
specified by the coefficients A, B, C, and D and the fuel cost. Specify the number of break 
points, and hence the number of segments, in the Number of Break Points field. Click the 
Convert to Linear Cost button to create the piecewise linear function that approximates 
the cubic cost function. This action switches Cost Model option to Piecewise Linear and 
displays the Piecewise Linear Table that identifies the piecewise linear curve’s 
breakpoints. 

Bid Scale / Shift 

Cost Shift, Cost Multiplier  
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The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Marginal Cost (run mode only)  

Shows the marginal cost of producing real power at the generator at its current output level, 
dCi(Pgi)/dPgi. 

ED/OPF Cost (run mode only) 

This is the cost of production for this generator following an economic dispatch or optimal 
power flow solution, including the scaling from the cost shift and cost multiplier fields. 

Unscaled Cost (run mode only) 

The cost of production of the generator, ignoring the cost multiplier and cost shift. This cost 
is the result of the original cost function by itself. 

 



Properties of Simulator Objects 
 

344 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Generator Options: Fault Parameters 

  

The parameters on this tab are used when running a fault analysis study.  
  

Generator MVA Base 

The assumed MVA base for the generator. This value is used when calculating fault analysis 
values for the internal generator parameters. 

Neutral Grounded 

Check this check-box if the generator has the neutral grounded. 

Generator Step Transformer 

The resistance, reactance and tap setting for the generator step-up transformer, if one is 
being modeled internally with the generator. By default, no internal transformer model is 
assumed. 

Internal Impedance 

These fields represent the internal impedance of the generator for all three sequences. By 
default, all three values are initially the same as the load flow internal impedance of the 
generator. All three sets of values can be modified, either manually or by loading values 
from an external file using the Fault Analysis Dialog.  

Neutral-to-Ground Impedance 

Neutral-to-ground impedance for the generator. These values get implemented with the 
zero sequence admittance matrix. Note that the neutral-to-ground impedance will not be 
used, even if specified, if the original model for the generator implicitly models the generator 
step-up transformer. This is because the implicitly modeled transformer is assumed to have 
a delta winding on the generator side of the transformer, which isolates the generator from 
the rest of the zero sequence network. 
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Generator Options: Owners, Area, Zone, Sub 

  

This information is located on the Generator Information Dialog. 

This tab is used to display or change the generator’s owner information, area information, 
zone information, and substation information. 
  

Same Owner as Terminal Bus 

Read-only check-box that indicates whether the generator’s owner is the same than the 
terminal buses’ owner. 

Owners 

Currently, Simulator supports up to four owners for generators. To add an owner of a 
generator, change one of the Owner fields to a new owner number, and update the owner 
percentages accordingly. To modify an owner's percentage of ownership, simply modify the 
value in the percentage field for that owner. If you set the percentage of an owner to 0, that 
owner will be removed from the list of owners for the device. You can also remove an owner 
from owning part of a device by changing the owner field for that owner to 0. Note that if 
you do not set the new owner percentages of all specified owners such that the total is 
100%, Simulator will normalize the percentages such that the total is 100% when you click 
Save or OK on the generator dialog. 

Area Number, Area Name 

The area number and name to which the generator belongs. Note that you can change the 
area of the generator to be different than the area of the terminal bus. If you do so, you will 
be prompted to confirm that you wish to place the generator within a different area than 
that of the bus to which it is electrically connected. 

Zone Number, Zone Name 

The zone number and name to which the generator belongs. Note that you can change the 
zone of the generator to be different than the zone of the terminal bus. If you do so, you 
will be prompted to confirm that you wish to place the generator within a different zone 
than that of the bus to which it is electrically connected. 

Substation Number, Substation Name 

The name and number of the substation to which the generator belongs, and it is the same 
than that of the terminal bus. 
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Generator Cost Description 

  

The cost associated with operating a generator varies according to the output of the 
generator, with the general rule that getting more power out of a generator costs more. In 
Simulator, there are two options for modeling generator cost. The first employs the common 
cubic relationship 

 Ci(Pgi)  = IndFixedCost + ( ai + bi Pgi + ci (Pgi)2 + di (Pgi)3 ) * fuel cost $/Hour 

where Pgi is the output of the generator at bus i in MW. IndFixedCost is the fuel cost 
independent fixed cost, and therefore is not multiplied by the fuel cost. The value ai is the fuel 
cost dependent fixed cost, and is therefore multiplied by the fuel cost. The values bi, ci, and di 
are used to model the generator's input-output (I/O) curve. The I/O curve specifies the 
relationship between how much heat must be input to the generator (expressed in MBtu per 
hour) and its resulting MW output. Normally, the cubic coefficients remain constant for a 
generator. The last term in the equation is the fuel cost, expressed in $/MBtu. This value 
varies depending on the fuel used in a generator. Typical values would be $ 1.25/MBtu for 
coal and $ 2/Mbtu for natural gas. The resultant equation is known as the fuel-cost curve. The 
value of the fixed costs, bi, ci, di, and fuel cost can be viewed and modified using the 
Generator Information Dialog. 

Simulator can also model generator costs using a piecewise linear model consisting of pairs of 
MW output and incremental cost ($/MWhr) of generation, along with a fixed cost. These 
piecewise linear curves must be convex curves, meaning the marginal cost of the current MW 
break point must be higher than the previous MW break point. 

Such curves can be defined using the Generator Information Dialog or by loading data from 
generator cost data files. 
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Set Generator Participation Factors 

  

Participation factor control is another of Simulator’s mechanisms for distributing an area’s 
responsibility to serve its load, losses, and interchange. It is particularly well-suited to 
implementing automatic generation control (AGC) when you do not have good economic 
information for an area’s generators. With participation factor control, the amount of power 
that each generator contributes to meeting its areas load, loss, and interchange responsibilities 
is controlled by the size of its participation factor. The unit that has the largest participation 
factor contributes the most, and the unit that has the smallest participation factor contributes 
the least. 

The Set Generator Participation Factors Dialog gives you a convenient way to define the 
participation factors for multiple generators. You can set the participation factor according to a 
number of different formulae and then apply this prescription to all generators in a specific 
area, all generators in a specific zone, all generators in the system, or all generators whose 
display filters are currently set to true. 

To display the Set Generator Participation Factors Dialog, you first need to open the 
Area Information Dialog and switch to the Area MW Control Options page. The Area 
Information Dialog has a button labeled Set Participation Factors that is enabled only if the 
Participation Factor Control option is selected under the Area Control Options heading. Set the 
area on participation factor control by selecting the Participation Factors option, and then 
press the Set Participation Factors option. 

The Set Generator Participation Factors Dialog is divided into two parts. The first part, which 
occupies the top half of the form, allows you to indicate how the participation factors should 
be calculated or set for each generator. Your options include: 
  

Max MW Rating of Generator The participation factor for each generator is set to the 
generator’s maximum MW capability. 

Difference Between Max and Current Output The participation factor for each 
generator is set to the generator’s reserve power, so that each generator participates in 
proportion to how much it has left to contribute. 

Constant Value of The participation factor for each generator is set to the same hard-
coded value. 

File The participation factor for each generator is read from a file. The first line of the file 
should contain the keyword NUMBERS or NAMES indicating whether generators are 
identified by bus number or by bus name in the file. All subsequent lines should be comma-
delimited and contain three fields: the number or name of the generator’s bus, the 
generator’s id, and the generator’s participation factor. 

  

If you choose any of the first three options, you then must tell Simulator to what generators 
you want to assign the participation factors. To assign the participation factors to all 
generators in a specific area, select the All Generators in Area option, and then choose the 
area from the adjacent dropdown box. If you want to assign the participation factors to all 
generators in a specific zone, select the All Generators in Zone option, and then choose the 
zone from the adjacent dropdown box. If you want to assign the participation factor to all 
generators in the system regardless of their area or zone affiliation, select the All Generators 
in System option. Finally, if you want to assign the participation factor to just those 
generators whose display filter criteria evaluates to true, choose the All Generators With 
Valid Display Filters option. 
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If you instead chose to read participation factors from a file, only those generators whose 
factors you read from the file will have their factors set by this action. However, unless each 
generator’s associated area is set to control generator output using participation factor control, 
this information will be ignored. To make sure that each generator’s area is set to participation 
factor control, check the Set Corresponding Areas to Participation Factor Control box. 
Then, each corresponding area will be set to participation factor control. 
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Generator Reactive Power Capability Curve 

  

The reactive power output of most generators depends on the real power output of the 
generator. This dependence is expressed using a reactive capability curve. Simulator models 
the reactive capability curve using a piecewise linear approximation. The reactive capability 
curve is modified on the generator dialog and can be saved/loaded using the Generator 
Reactive Capability Curve Auxiliary files.  
  

Modeling a Reactive Power Capability Curve From the Generator Dialog 
• Make sure the Use Capability Curve checkbox is checked.  
• In the table immediately below the checkbox, prescribe the reactive capability curve using 

up to 50 points. The points should be ordered by MW, in numerically increasing order. At 
each point specify the MW value, the minimum reactive power value in Mvar, and the 
maximum reactive power value in Mvar. The first point should correspond to the minimum 
MW output of the generator, while the last point should correspond to the maximum MW 
output. 

• To insert a new point, click on the desired column, and then right-click to display the 
table's local menu. Select Insert Point. 

• To remove a point, click on the desired column, and then right-click to display the table's 
local menu. Select Delete Point.  

• When finished be sure to select Save to save your modifications.  

In the Run Mode, you can view the reactive power capability curve graphically by right-clicking 
on the generator to display its submenu and then selecting Reactive Capability Curve.  
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Load Information (Edit Mode) 

  

This dialog is used to view and modify the parameters associated with each load in the 
system. It can also be used to insert new loads and sometimes to delete existing loads. It is 
nearly identical in structure to its Run Mode counterpart. 

The Load Information Dialog can be used to inspect and modify the model of a bus load. To 
view the Load Information Dialog, select the load and choose Show Dialog from the case 
information toolbar or right-click on the load of interest and select Load Information Dialog 
from the resulting local menu. The dialog has the following fields: 
  

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus to which the load is attached. The dropdown box provides a list of all load buses with 
valid area/zone/owner filters. You can use the spin button to cycle through the list of load 
buses.  

When you insert objects graphically, the Bus Number and Bus Name fields are usually set 
automatically to the bus upon which you placed the object.  

Bus Name 

Unique alphabetic identifier for the bus to which the load is attached, consisting of up to 
eight characters. The dropdown box lists the names of all load buses in the case with valid 
area/zone/owner filters.  

ID 

Two-character ID used to distinguish multiple loads at a bus. By default, the load ID is equal 
to "1 ." An identifier of ‘99’ is used to indicate an equivalent load.  

Find By Number 

To find a load by its number and ID, enter the number into the Bus Number field and the ID 
into the ID field. Then click this button.  

Find By Name 

To find a load by its name and ID, enter the bus name into the Bus Name field (case 
insensitive) and the ID into the ID field. Then click this button. 

Find… 

If you do not know the exact load bus number or name you are looking for, you can click 
this button to open the advanced search engine. 

Status 

Status of the load, either Closed (connected to terminal bus) or Open (not connected). You 
can use this status field to change the load’s status.  

Labels 

Clicking on this button will open the Label Manager dialog listing all the labels assigned for 
the selected load. 

Area Number, Area Name 

Number and name of the area the load is a member of. 

Zone Number, Zone Name 

Number and name of the zone the load is a member of. 
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Substation Number, Substation Name 

Number and name of the substation the load and the terminal bus are members of. 

Owner Number, Owner Name 

Number and name of the owner the load is a member of. If the load owner is the same as 
the terminal bus owner, the Same Owner as Terminal Bus box will be checked. Loads 
DO NOT have to be owned by the same owner as the terminal bus. 

OK, Save, Delete, and Cancel 

OK saves your changes and closes the dialog. Save saves your changes but does not close 
the dialog; this allows you to use, for example, the Find By Number command to edit 
additional loads. Delete deletes the current load. Cancel closes the dialog without saving 
your changes. 

  

Specific load information can be found on the following pages of the Load Options dialog: 

Load Information 

OPF Load Dispatch 

Custom 
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Load Options: Load Information 

  

This page of the Load Options dialog contains information on the load magnitude and display 
settings. 

MW and Mvar Value Fields 

The MW and Mvar Value fields are used to represent the amount of base real and reactive 
load at the bus. Usually this load is modeled as being "constant power," meaning that the 
amount of load is independent of the bus voltage magnitude. However, Simulator also 
permits modeling "constant current" load, for which the load varies in proportion to the bus 
voltage magnitude, and "constant impedance" load, for which the load varies in proportion 
to the square of the bus voltage magnitude. Values in these fields are specified in MW and 
MVR assuming one per unit voltage. All six fields can be modified by the user. 

Display Size 

Size of the load. 

Scale Width with Size 

If checked, the Display Width will automatically be scaled to the appropriate setting when 
the Display Size is changed. If unchecked, then only the length of the generator object will 
be affected by changing the value of the Display Size. 

Display Width 

The width of the display object. This setting is automatically set if Scale Width with Size is 
checked and the value of the Display Size field is changed, or the Display Width value can 
be set manually to a new value. 

Pixel Thickness 

Thickness of the display object in pixels. 

Orientation 

Specifies the direction to draw the object.  

Anchored 

If checked, the object is anchored to its terminal bus. See Anchored Objects for details. 

Link to New Load 

Links the object to a different load record in the data. 
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Load Options: OPF Load Dispatch 

  

This tab of the Load Options dialog contains settings for allowing the load to be included as an 
OPF Control. The load(s) can then be dispatched in the OPF algorithm according to the 
assigned costs. 

Benefit Model 

If this field is set to none, the load will not be dispatchable in the OPF solution. If the option 
is set to Piecewise Linear, the load is dispatchable during the OPF, according to the following 
fields. 

Min. and Max. MW Output 

Minimum and maximum load MW demand for OPF dispatch. 

Available for AGC 

If checked, the load will be available for redispatch during the OPF routine. 

Fixed Benefit 

Value of the load benefit at minimum demand. 

Piece-wise Linear Benefit Curve 

This table allows you to specify pairs of MW demand levels and corresponding load benefit 
values, which in turn define the starting points and slopes of the piece-wise linear benefit 
curve segments. To insert a new point on the cost curve, right-click on the table and choose 
Insert New Point from the resulting local menu. To delete an existing point from the cost 
curve, right-click on the table and choose Delete Point from the resulting local menu. To edit 
an existing point in the table, simply enter your changes to the appropriate cells. 
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Load Field Information 

  

Load field objects are used primarily to indicate various quantities associated with load 
devices. Furthermore, some load field types, which are distinguished by an integrated spin 
button, may be used to change load device properties. 

The Load Fields Information Dialog can be used to modify the properties of individual load 
fields on the oneline. The dialog displays the following fields: 
  

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Bus Number 

Number of the bus to which the load associated with the field is connected. Use the 
dropdown box to view a list of all buses with loads in the case with valid area/zone/owner 
filters.  

Bus Name 

Name of the bus to which the load associated with the field is connected. Use the dropdown 
box to view a list of all buses with loads in the case with valid area/zone/owner filters.  

ID 

ID of the load associated with the field. Load ID fields are two characters in length. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Value 

The current value of the field being displayed. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Delta Per Mouse Click 

Load fields can be used not only to show various fields associated with load devices, but 
they can also be used to change some values. This is accomplished using spin buttons 
shown to the right of the load field. When the up spin button is clicked, the load field value 
is increased by the amount specified in the delta per mouse click field. When the down spin 
button is clicked, the load field value is decreased by the same amount. 

This field is only used for fields of the following types: Load MW and Load Mvar. Specifying a 
nonzero value in this field causes the integrated spin button to appear as part of the load 
field on the oneline. 

Note that the Maintain Constant Load Power Factor option will allow you to specify a 
Delta per Mouse-click for the MW load, and when the MW value is changed in run mode, the 
MVAR load will also change in such a way as to keep the power factor of the load constant. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 
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Anchored 

If the Anchored checkbox is checked, the load field is anchored to its associated load, which 
means that it will move with the load. 

Rotation Angle in Degrees 

The angle at which the text is placed on the diagram, in degrees. 

Type of Field 

Used to determine the type of load field to show. The following choices are available: 

Load MW MW load 

Load Mvar Mvar load 

Select a Field Choose from any of the different load fields 

Select OK to save changes and to close the dialog, or click Cancel to close the dialog without 
saving your changes.  
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Load Modeling 

  

Each load can be modeled as having voltage variation. The voltage variation is modeled using 
the Base Load Model fields on the Load Information dialog. Thus the actual real and reactive 
value of each load is determined using the following equation:  

MW = Load MW Multiplier * (SMW + IMW * V + ZMW * V * V) 

Mvar = Load Mvar Multiplier * (SMvar + IMvar * V + ZMvar * V * V) 

where 

MW  current real power load in MW 

Mvar current reactive power load in Mvar 

SMW constant power MW value 

Smvar constant power Mvar value 

IMW constant current MW value (assuming 1.0 per unit voltage) 

Imvar constant current Mvar value (assuming 1.0 per unit voltage) 

ZMW constant impedance MW value (assuming 1.0 per unit voltage) 

Zmvar constant impedance Mvar value (assuming 1.0 per unit voltage) 

V per unit bus voltage magnitude 

Load MW Multiplier = (Area MW Multiplier) * (Zone MW Multiplier) 

Load Mvar Multiplier = (Area Mvar Multiplier) * (Zone Mvar Multiplier) 

  

The Area Multipliers scale all of the loads in an area. The Zone Multipliers scale all of the loads 
in a zone. These are static values that do not vary over time. If a time varying schedule of 
loads is required, the Time Step Simulation tool should be used instead of the static 
multipliers. 
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Line/Transformer Information (Edit Mode) 

  

The Line/Transformer Information Dialog is used to view and modify the parameters 
associated with each transmission line and transformer in the system. You can also insert new 
transmission lines and delete existing transmission lines from this dialog.  

The Edit Mode version of this dialog is very similar in content to its Run Mode counterpart. 
  

The Line/Transformer Information Dialog has the following fields: 

From Bus Number and Name 

From Bus number and name. For transformers, the from bus is the tapped side.  

To Bus Number and Name 

To Bus number and name.  

Circuit 

Two-character identifier used to distinguish between multiple lines joining the same two 
buses. Default is ‘1'.  

Find By Numbers 

To find a line or transformer by its bus numbers, enter the from and to bus numbers and 
the circuit identifier. Then click this button. Use the spin button to cycle through the list of 
lines and transformers in the system. 

Find By Names 

To find a line or transformer by the names of its terminal buses, enter the from and to bus 
names and the circuit identifier. Then click this button. 

Find… 

If you do not know the exact from and to bus numbers or names you are looking for, you 
can click this button to open the advanced search engine. 

From End Metered 

This field is only used for lines and transformers that serve as tie lines, which are lines that 
join two areas. If this field is checked for a tie line, then the from end of the device is 
designated as the metered end. Otherwise the to end is metered. By default, the from end is 
metered. The location of the metered end is important in dealing with energy transactions 
because it determines which party must account for transmission losses. 

Default Owner (Same as From Bus) 

Read-only check-box that indicates whether the line’s owner is the same than the from bus’ 
owner. 

From and To Bus Area Name 

Control area name in which each terminal bus is located. 

From and To Bus Nominal kV 

Nominal voltage level of each terminal bus, in kV. 

Labels 

Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases 
assigned for the selected branch. 

OK, Save, Delete, and Cancel 
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OK saves your changes and closes the dialog. Save saves your changes but does not close 
the dialog; this allows you to use, for example, the Find By Number command to edit 
additional transmission lines. Delete deletes the current transmission line. Cancel closes 
the dialog but does not save any changes.  

  

Display 

See Transmission Line/Transformer Display Options. 
  

Parameters 

See Transmission Line/Transformer Parameters Options. 
  

Transformer Control 

This tab is only visible for transformer objects. See Transformer Modeling for details on 
modeling either LTC or phase shifting transformers. 

  

Series Capacitor 

This tab is only visible for series capacitor objects. See Series Capacitor for details on modeling 
series capacitors. 

  

Fault Info 

The parameters on this tab are used when running a fault analysis study. The values represent 
the zero sequence impedance and zero sequence line shunt admittances for the analysis. By 
default, the positive and negative sequence line impedances and line shunt admittances are 
the same as the load flow impedance. The same fields are used for transformers, along with 
the configuration field. The configuration field defines the winding type combinations for the 
transformer (wye, delta, etc.) As a default, Simulator assumes a grounded wye to grounded 
wye transformer, which has the same model as a transmission line. Usually transformers are 
not of this type, and the proper type would need to be defined either manually or loaded from 
an external file in order for the fault analysis to be accurate. 

  

Owner, Area, Zone, Sub 

The Default Owner (Same as From Bus) read-only check-box indicates whether the line’s 
owner is the same than the from bus’ owner. Transmission elements can have up to four 
different owners, each with a certain owner percentage. To add an owner of a transmission 
element, change one of the Owner fields to a new owner number, and update the owner 
percentages accordingly. Note that if you do not set the new owner percentages of all 
specified owners such that the total is 100%, Simulator will normalize the percentages such 
that the total is 100% when you click Save or OK on the line/transformer dialog. 

The area, zone and substation to which the From and To buses belong, are also shown. 
  

Custom 

This page of the dialog can be used to enter notes about the transmission line. Any 
information entered in the memo box will be stored with the case when the case is saved to a 
PWB file. Custom fields can also be populated with user-specified values and will be saved 
with the case as well. 
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Transmission Line/Transformer Options: Display 

  

Pixel Thickness 

Thickness of the display object in pixels.  

Anchored 

If checked, the object is anchored to its terminal bus, which means that it will move when 
you move the terminal bus. See Anchored Objects for details. 

Link to New Line 

Use the Link to New Line button to create a new line corresponding to the entries you have 
made in the dialog. This button performs the same function as pressing Save. Note that 
adding a new line to the case in this way does not add a transmission line to the oneline 
display; the new line is present only in the model. You may then add the newly modeled line 
to the oneline diagram in the usual way (such as select Network > Transmission Line 
from the Individual Insert ribbon group on the Draw ribbon tab). 

Symbol Segment 

Only visible for transformer and series capacitor objects. This field specifies which "segment" 
of the branch contains the transformer or capacitor symbol. A segment constitutes a section 
of the line between vertex points of the line object, and are numbered starting at the from 
bus. 

Symbol Size 

Only visible for transformer and series capacitor objects. Specifies the size (width) of the 
transformer or capacitor symbol on the branch. 

Symbol Percent Length 

The distance or "length" of the symbol on the segment of the branch which contains it. 

Show Detailed Line Vertices 

When checking this option, a new group of information appears, showing the x,y 
coordinates of every vertex of the line. Additionally to being able to edit those locations, it is 
possible to shift or scale all the values with the buttons Shift All Values and Scale All 
Values, respectively. 
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Transmission Line/Transformer Options: Parameters 

  

Status 

Current status of the device.  

Length 

If the length of the line is known, it can be entered here for informational purposes. 

Per Unit Impedance Parameters 

The series resistance and reactance, the total charging susceptance (that is, B, not B/2) and 
the shunt conductance of the device (in per unit). In the case of transformers, the 
magnetizing conductance and susceptance can also be specified. 

Line Shunts  

Select to view the Line Shunt Dialog. This dialog is used to only view or modify the values of 
the line shunts in Run Mode. Line shunts are expressed in terms of the per-unit conductance 
and susceptance at each end of the line or transformer. If the line has shunts, the check box 
Has Line Shunts is checked. 

MVA Limits 

Ratings for the transmission line or transformer in MVA. Simulator allows the use of up to 
eight different limits. 

Calculate Impedances 

This will display a pop-up menu with the following two options: 

…From Per Distance Impedances 

Clicking this item will open the Line Per Unit Impedance Calculator dialog, which can be 
used to convert actual impedance and current limits to per unit impedance and MVA limits, 
and vice versa. 

…From Conductor Type and Tower Configuration 

Clicking this item will open the Transmission Line Parameter Calculator dialog, which can be 
used to compute per unit impedance values, based on a conductor type and a tower 
configuration. 

Convert Line to Transformer 

Clicking this button turns the currently selected transmission line into a transformer, making 
the transformer specific fields available. 
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Line Shunts Information 

  

The Line Shunts Information Dialog is used to modify the parameters of transmission line 
shunts. The modeling of the line shunts is explained below. 
  

Line Shunts 

Line shunts are included in the model as admittance-to-ground values at either the From 
end or the To end of a transmission line. These values can represent many things, such as 
shunt-to-ground capacitors, reactors, zigzag (or grounding) transformers, or equivalenced 
system values. Line shunt values are entered in per unit, with a positive B corresponding to 
capacitors and a negative B corresponding to reactors. Mathematically, the line shunts are 
included in the algorithm in the same manner that line charging capacitance is included 
using the Pi model. 

Line shunt values can be modified from the Transmission Line Information dialog. 
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Line Per Unit Impedance Calculator Dialog 

  

The Line Per Unit Impedance Calculator Dialog allows to convert actual impedance and current 
limit values to per unit impedance and MVA limit values, and vice versa. 
  

The dialog has the following elements: 

Actual Impedance and Current Limits 

This part of the dialog shows all the impedance related values in Ohms/length-unit as well 
as the transmission line limits specified in Amps. If any of these values is modified, the 
corresponding per unit or MVA value will be changed accordingly, taking into consideration 
the current line length, length units, and system base values. 

Line Length 

This value indicates the length of the line in miles or kilometers, depending on the units 
selected in Length Units. The option When changing convert is used to convert the 
values when the length value is modified. The option PU/MVA --> indicates that the actual 
impedance and current limits will be converted to per unit impedance and MVA limits when 
the length value is changes. The option <-- Electrical specifies that the per unit impedance 
and MVA limits will be converted to actual impedance and current limits when the length 
value is modified. 

Length Units 

This option indicates the length units. Choices are miles and kilometers. When this 
parameter is changed, the user will be prompted to confirm to convert the actual impedance 
and current limits, as well as the line length values, from the old units to the new units. If 
the answer is positive, then the actual impedance and current limits, and the line length will 
be the same but they will be expressed in the new units selected. If the answer is negative, 
the values will not change numerically but they still will be expressed in the new units 
selected. 

System Base Values 

The system base values show the power base, the voltage base, and the impedance base. 
These values can not be modified in this dialog. 

Per Unit Impedance and MVA Limits 

This part of the dialog shows all the impedance related values in per unit as well as the 
transmission line limits specified in MVA. If any of these values is modified, the 
corresponding actual or Amps value will be changed accordingly, taking into consideration 
the current line length, length units, and system base values. 

Conductor Type 

Shows the conductor type selected to compute the per unit impedances in the Transmission 
Line Parameter Calculator dialog. It will be blank if there isn’t any. 

Tower Configuration 

Shows the tower configuration selected to compute the per unit impedances in the 
Transmission Line Parameter Calculator dialog. It will be blank if there isn’t any. 

Calculate PU Impedances From Conductor Type and Tower Configuration 

Clicking this button will open the Transmission Line Parameter Calculator form. 
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Transmission Line Parameter Calculator 

  

The transmission line parameter calculator is a tool designated to compute characteristic line 
parameters give the type of the conductor and the configuration of a three-phase overhead 
transmission line. 

The parameters computed are the resistance R, reactance X, susceptance B, and conductance 
G. These values are computed as distributed (per unit of distance), lumped or total (for a 
specific line distance), and in per-unit. 
  

Calculations 
  

The following controls are part of the calculations section: 
  

Parameters Calculation 

This section is to enter the necessary data to compute the characteristic line parameters 
that are shown in the Results panel. 

  

Input Data 

Conductor Type:  This is the combo box that lists all the conductor types available in the 
Conductors table. To add, remove or edit a specific conductor and its characteristics, see 
Conductor Type section below. 

Tower Configuration: This combo box lists all the tower configurations available in the 
Tower Configurations table. To add, remove or edit a specific tower configuration, please 
go to the Tower Configuration section below. 

Line Length: This is the value of the distance of the transmission line. The units are miles 
when using English system, or kilometers when using the Metric (SI) system. 

Line Length Units: The line length units specify the measurement system to use when 
entering the line length. The options are English system or Metric (SI) system. The final 
and intermediate results will also be shown in the system specified here. 

Power Base: The system voltampere base in MVA. 

Voltage Base: The line-line voltage base in KV. 

Impedance Base: The impedance base in Ohms. This value is automatically computed 
when the power base and the voltage base are entered or modified. 

Admittance Base: The admittance base in Siemens. It is also automatically computed as 
the inverse of the impedance base. 

Final Results 

When all the input data is entered, the results automatically will be displayed. The values 
for R, X, B and G are shown in three different sections, each section corresponding to 
Distributed, Lumped or Total, and Per Unit values, respectively. The Power Surge 
Impedance Loading is calculated only for the lumped section. 

Intermediate Results 
The intermediate values calculated to compute the R, X, B, and G values are displayed 
here. The computed geometric mean radius and geometric mean distance are shown in 
the Distributed values section. The characteristic impedance and propagation factor are 
displayed in the Lumped values section. 
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Note: To see the specific calculations used in this program, see the Calculations section, at 
the end of this document. 

  

Ampere to MVA Limit Conversion 

This section converts the limits of the transmission line from Amperes to MVAs, given the 
voltage base, and vice versa. 

  

Conductor Type 
  

This section is used to add, remove, rename, and edit the information related to the conductor 
types. This can be done in two ways: using the form for an individual conductor type, or using 
the table for all the conductor types available. 
  

Edit By Form 

Conductors are identified by a unique code word. All the available conductors are listed in 
the Conductor Code Word combo box. By selecting one conductor, all its properties are 
displayed in the form. There, the user is able to modify any of those values. After 
modification of any value, the user has to save the changes by clicking on the button Save 
before changing tabs, otherwise the changes will be lost. 

By clicking on New, a message prompting for a name for a new conductor will be shown. 
By clicking on Rename, a new name for the current conductor type is required. In order to 
save the current conductor type with a different name is necessary to click on Save As. 
Finally, to remove the current conductor the user can do so by clicking on the Delete 
button. 

Edit By Table 

In this tab, all the conductor types are shown as records in a table, where every field is a 
characteristic of the conductor. In order to edit the records in this table, use the Database 
button described in the Database section. While editing the table, the user can not change 
of tab until changes are posted or discarded. 

Conductor Properties 

The available properties of the conductors are the following: 

Code Word: Code name for the type of conductor. The names of bird species are 
typically used. Code Word has to be unique. 

Area: The area of aluminum conductor in circular mils. A circular mil is the cross-
sectional area of a circular conductor having a diameter of 1 mil. One mil is one 
thousandth of an inch (0.001"). 

Aluminum strands: Number of aluminum strands. 

Steel layers: Number of steel strands. 

Aluminum layers: Number of aluminum layers. 

External diameter: Outside diameter of the conductor in inches. 

GMR: Geometric Mean Radius in feet. 

DC Resistance: DC resistance of the conductor at 20°C per 1 mile in Ohms. 

AC Resistance 25: AC resistance of the conductor at 60 Hz and 25°C per 1 mile in Ohms. 

AC Resistance 50: AC resistance of the conductor at 60 Hz and 50°C per 1 mile in Ohms. 
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AC Resistance 75: AC resistance of the conductor at 60 Hz and 75°C per 1 mile in Ohms. 

Inductive Reactance: Inductive reactance per conductor at 1 foot spacing at 60 Hz in 
Ohms/mile. 

Capacitive Reactance: Capacitive reactance per conductor at 1 foot spacing at 60 Hz in 
MegaOhms/mile. 

  

Tower Configuration 
  

This part is used to add, remove, rename, and edit the information related to the tower 
configurations. This can be done in two ways: using the form for an individual tower 
configuration, or using the table for all the tower configurations available. 
  

Edit By Form 

Tower configurations are identified by a unique name. All the available tower configurations 
are listed in the Tower Configuration Name combo box. By selecting one specific tower 
configuration, all its characteristics are displayed in the form. There, the user can modify 
any of those characteristics. After modification of any value, the user has to save the 
changes by clicking on the button Save before changing tabs, otherwise the changes will be 
lost. 

By clicking on New, a message prompting for a name for a new tower configuration will be 
shown. By clicking on Rename, a new name for the current tower configuration is required. 
In order to save the current tower configuration with a different name is necessary to click 
on Save As. Finally, to remove the current tower configuration the user can do so by 
clicking on the Delete button. 

Edit By Table 

In this tab, all the tower configurations are shown as records in a table, where every field is 
a value of the tower configuration. In order to edit the records in this table, use the 
Database button described in the Database section. While editing the table, the user can not 
change of tab until changes are posted or discarded. 

Tower Configuration Values 

The values of the tower configuration are the following: 

Name: Name for the tower configuration. Name has to be unique. 

Phase spacing: x and y coordinates of phases A, B and C positions. Values are in feet for 
English system and meters for Metric (SI) system. When these values are modified, the 
phase spacing graph is automatically updated. Draw axis has to be checked for x and y 
axis to be drawn in the graph. 

Conductors per bundle: This section specifies the number of conductors (either single 
conductor or a bundle of conductors) per phase. The maximum number of conductors 
per bundle allowed is 4. 

Use regular spacing: When using a bundle of conductors, checking the Use Regular 
Spacing of check box will use the specified value as a regular spacing among the 
conductors. If the Use Regular Spacing of check box is not checked, then the custom 
conductors spacing section has to be used. 

Conductors spacing: x and y coordinates of the conductors in the bundle. Values are in 
feet for English system and meters for Metric (SI) system. When these values are 
modified, the bundle spacing graph is automatically updated. Draw axis has to be 
checked for x and y axis to be drawn in the graph. 
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Temperature: Assumed temperature in Fahrenheit degrees for English system and 
Celsius degrees for Metric (SI) system. 

Frequency: Frequency of the system in Hertz. 

System of units: The system of units used to specify the values of the tower 
configuration. The options are English system or Metric (SI) system. The units specified 
here not necessarily have to math the units specified in the Input Data section. 

  

Database 
  

The conductor type and tower configurations tables are read by default from the file 
conductors.mbd, which is a MS Access® database. This database can be read from another 
*.mdb file by clicking on the Select Conductors and Configurations Database button. 

Note: The conductors.mdb file can also be viewed and edited in MS Access®. 

In order to edit a record in the database tables, the user can use the toolbar designed to do 
that. Following there is a figure showing this toolbar: 
  

 
  

The First, Prior, Next, and Last buttons are used to move among records. The Insert, 
Delete and Edit buttons are used to insert, delete or edit the current record, respectively. 
While editing a record, the user can not change of tab until modifications are posted through 
the Post edit button or canceled with the Cancel edit button. The Refresh data button just 
refreshed the data of the entire table. 
  

Calculations 
  

Distributed Parameters 

  

Resistance 

 
  

Where: 

Rt AC resistance at temperature t per phase per 1 mile in Ohms 
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t Assumed temperature in Celsius degrees 

R25 AC resistance of the conductor at 60 Hz and 25°C per 1 mile in Ohms 

R50 AC resistance of the conductor at 60 Hz and 50°C per 1 mile in Ohms 

R75 AC resistance of the conductor at 60 Hz and 75°C per 1 mile in Ohms 

N Number of conductors per phase 
  

Inductive Reactance 

 
  

Where: 

XL Inductive reactance in Ohms/meter 

f    Frequency of the system in Hertz 

Geometric mean distance between phases in meters 

Geometric mean radius between conductors of one phase in meters 
  

The geometric mean distance between phases is defined as: 

  

 
Where: 

 Distances between phases a-b, b-c, c-a, respectively in meters 
  

The geometric mean radius between conductors of one phase is defined as: 

  

 For 1 stranded conductor 

For 1 solid cylindrical conductor 

For more then 1 conductor bundle 
  

Where: 

 Geometric mean radius in meters 

r External radius of conductor in meters 

GMR Geometric mean radius given in tables for one stranded conductor 

Distance between conductors k and m in meters.  
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Note: If k = m, then = for one stranded or solid cylindrical conductor. 
  

Susceptance 

  
  

Where: 

B Susceptance in Siemens/meter 

f  Frequency of the system in Hertz 

ε Constant permittivity = 8.85418 × 10-12 

 Geometric mean distance between phases, defined as above 

Geometric mean radius between conductors of one phase using external radius in 
meters 

  

The geometric mean radius between conductors of one phase using external radius is 
defined as: 

  

For 1 conductor 

 For more then 1 conductor bundle 
  

Where: 

 Geometric mean radius in meters 

r External radius of conductor in meters 

 Distance between conductors k and m in meters.  

Note: If k = m, then  = r. 
  

Conductance 
  

Assumed G = 0 
  

Where: 

G Conductance in Siemens/meter 
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Lumped (Total) Parameters 

  

Resistance, Inductive Reactance, Conductance and Susceptance, using the 
equivalent π circuit (long line) 
  

 
  

  
  

Where: 

Z’ Total series impedance of line in Ohms 

Y’ Total series admittance of line in Siemens 

R’ Total series resistance of line in Ohms 

X’ Total series inductive reactance of line in Ohms 

G’ Total series conductance of line in Siemens 

B’ Total series susceptance of line in Siemens 

Zc Characteristic impedance in Ohms 

γ Propagation constant in meters-1 

 Line length in meters 
  

The characteristic impedance and propagation constant are defined as: 

  

 
  

  

Where: 

z Distributed series impedance in Ohms/meter 

y Distributed series admittance in Siemens/meter 
  

The distributed series impedance and distributed series admittance are defined as: 

 
  

Where: 
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R Distributed series resistance in Ohms/meter 

X Distributed series inductive reactance in Ohms/meter 

G Distributed series conductance in Siemens/meter 

B Distributed series susceptance in Siemens/meter 
  

Surge Impedance Loading 
  

The surge impedance loading is defined as the power delivered by a lossless line to a load 
resistance equal to the surge (or characteristic) impedance Zc, and is given by: 

  

 
  

Where: 

PSIL Total surge impedance loading in a three-phase line in VA 

VN Line-line nominal voltage in Volts 
  

Base Values 

  

Impedance Base 
  

 
  

Where: 

 Impedance base in Ohms 

 Power base in VA 

Line-line voltage base in Volts 
  

Admittance Base 
  

 
  

Where: 

Admittance base in Siemens 

Impedance base in Ohms 
  

Per Unit (PU) Parameters 
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Resistance, Inductive Reactance, Conductance, Susceptance 
  

 
  

Where: 

RPU Per unit resistance 

R’ Total series resistance in Ohms 

XPU  Per unit Inductive reactance 

X’ Total series inductive reactance in Ohms 

XPU  Per unit conductance 

G’ Total series conductance in Siemens 

BPU  Per unit susceptance 

B’ Total series susceptance in Siemens 

ZB Impedance base in Ohms 

YB Admittance base in Siemens 
  

MVA To Ampere and Ampere To MVA Limits Conversion 

  

MVA to Ampere Limit Conversion 

  

 
  

Where: 

LimAmp Limit in Amperes 

LimMVA Limit in MVAs 

VN Nominal voltage in Volts 
  

Ampere to MVA Limit Conversion 
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Where: 

LimAmp Limit in Amperes 

LimMVA Limit in MVAs 

VN Nominal voltage in Volts 
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Transmission Line/Transformer Options: Transformer Control 

  

Transformers are used to transfer power between different voltage levels or to regulate real or 
reactive flow through a particular transmission corridor. Most transformers come equipped 
with taps on the windings to adjust either the voltage transformation or the reactive flow 
through the transformer. Such transformers are called either load-tap-changing (LTC) 
transformers or tap-changing-under-load (TCUL) transformers.  

Another type of transformer is known as a phase-shifting transformer (phase shifter or phase 
angle regulator). Phase-shifting transformers, which are less common than LTC transformers, 
vary the angle of the phase shift across the transformer in order to control the MW power flow 
through the transformer.  
  

Off-nominal Turns Ratio and Phase Shift Degrees 

The Line/Transformer Dialog displays several transmission line and transformer properties. 
For transformers, this dialog box also shows information about the LTC or phase shifter 
controls. The Off-nominal Turns Ratio field indicates the voltage transformation, while 
the Phase Shift Degrees field show the phase shift angle. If the transformer is not on 
automatic control, these values can be changed manually. The off-nominal tap ratio 
determines the additional transformation relative to the nominal transformation. This value 
normally ranges from 0.9 to 1.1 (1.0 corresponds to no additional transformation). For 
phase-shifting transformers the phase shift value normally ranges from about -40° to 40°. 
The phase angle field can be non-zero for LTC and fixed transformers, most notably +/- 30° 
if the transformer configuration is a delta-wye or wye-delta configuration. The transformer 
configuration is very important when performing a fault analysis study. 

  

When in Edit Mode, the dialog also reveals the type of transformer. Valid types are 1) No 
Automatic Control (in which the taps are assumed fixed), 2) voltage regulation (AVR), 3) 
Reactive Power Control, and 4) Phase Shift Control. The type of transformer CANNOT be 
modified in the Run Mode.  

Simulator provides you with a great deal of flexibility in being able to specify which 
transformers will actually be used for automatic control in the Power Flow Solution. For a 
transformer to be used for voltage or flow control, three criteria must be met. 
• The transformer's Automatic Control Enabled field must be checked on its 

Line/Transformer dialog. This field can also be modified on the Transformer Records 
display.  

• The transformer's area must have automatic transformer control enabled. This is specified 
on the Options Tab of the Area Records display.  

• Transformer control must not be disabled for the entire case. This is specified on the 
Power Flow Solution Tab of the Simulator Options Dialog. 

The area and case enforcement of transformer control are also accessible from the Run Mode 
Line/Transformer Dialog. 

Automatic Control 

The Automatic Control fields are only visible in Edit Mode when the  Change Automatic 
Control Options button is pressed. 

No Automatic Control 
On this control setting the transformer will operate at the given off-nominal turns ratio 
and phase shift, and will remain fixed at those values during the entire solution process 
unless manually changed by the user. 
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AVR (Automatic Voltage Regulation) 

When on automatic voltage control, the transformer taps automatically change to keep 
the voltage at the regulated bus (usually one of the terminal buses of the transformer) 
within a voltage range between the minimum voltage and maximum voltage values 
(given in per unit). These values can be seen by clicking on the Automatic Control 
Options button. Note that automatic control is possible only if a regulated bus has been 
specified.  

The tap position for an LTC transformer is indicated on the oneline by the number of tap 
step positions from the nominal position (i.e., the position when the off-nominal tap ratio 
is equal to 1.0). When the off-nominal ratio is greater than 1.0, the transformer's tap is 
said to be in the "raise" position, and an 'R' appears after the number. Likewise, when 
the off-nominal ratio is less than 1.0, the transformer's tap is said to be in the "lower" 
position, and an 'L' appears after the number. For example, with a step size of 0.00625 
and an off-nominal ratio of 1.05, the tap would be in position 8R. The tap position can be 
changed manually only when the transformer has been set off automatic voltage control. 

Simulator will also detect instances when controlling transformers are in parallel, and will 
employ checks during the solution routine to prevent the controllers from fighting each 
other and potentially going to opposite tap solutions, which could result in unwanted 
loop flow through the transformer objects. This option is enabled by default, but can be 
turned off in the Power Flow Solution General Options. 

Transformer Reactive Power Control 

When on automatic reactive power control, the transformer taps automatically change to 
keep the reactive power flow through the transformer (measured at the from bus) within 
a user-specified range. The reactive power control parameters can be seen by clicking 
the Automatic Control Options button.  

Phase Shift Control 
When a transformer is on phase shift control, the transformer phase shift angle 
automatically changes to keep the MW flow through the transformer (measured at the 
from bus) between the minimum and maximum flow values (given in MW, with flow into 
the transformer assumed positive). The limits on the phase shifting angles are specified 
in the minimum and maximum phase fields (in degrees). These values can be seen by 
clicking on the Automatic Control Options button. The phase shift angle changes in 
discrete steps, with the step size specified in the Step Size field (in degrees). The MW 
Per Phase Angle  Step Size provides an estimate of the change in the controlled MW 
flow value if the phase angle is increased by the step size value.  

Specify Transformer Bases and Impedances 

Shows the Transformer Bases and Impedances Dialog. This dialog allows the user to specify 
the transformer parameters in per unit on the transformer base (taken as its rating). Click 
OK to convert all the transformer parameters values to the system base specified in the 
General Power Flow Solution Options. 
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Transformer AVR Dialog 

  

The Transformer AVR Dialog is used to view the control parameters associated with load-tap-
changing (LTC) transformers when they are used to control bus voltage magnitudes. To view 
this display, click the Automatic Control Options button on the Line/Transformer Information 
Dialog. 
  

This dialog has the following fields: 

Automatic Control Type 

This section is only visible on the dialog in edit mode. The control type of the transformer 
can be changed between no control, voltage regulation, reactive power control, or phase 
shifter control. 

Regulated Bus Number 

The number of the bus whose voltage is regulated by the control. 

Present Regulated Bus Voltage 

The present voltage of the regulated bus. 

Voltage Error 

If the regulated bus' voltage falls outside the regulating range of the transformer (as defined 
by the Minimum Voltage and Maximum Voltage fields), the Voltage Error field indicates by 
how much the voltage deviates from the control range. 

Regulation Minimum Voltage 

The minimum acceptable voltage at the regulated bus. 

Regulation Maximum Voltage 

The maximum acceptable voltage at the regulated bus. 

Regulation Target Type 

As long as the regulated voltage is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated voltage moves outside of this 
regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated voltage back inside of its range. The Regulation Target Type determines what 
value is used as a target when calculating this change in tap ratio. Middle is the default and 
means that the target is the average of the regulation minimum and maximum regardless of 
whether the voltage is high or low. Max/Min means that the regulation maximum is used 
as the target when the regulated voltage is above the maximum, and regulation minimum is 
used as the target value when the regulated voltage is below the minimum. 

Present Tap Ratio 

The tap ratio of the transformer for the current system state. 

Minimum Tap Ratio, Maximum Tap Ratio 

Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical 
values are 0.9 and 1.1.  

Tap Step Size 

Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either 
incremented or decremented from 1.0 in integer multiples of this value. Default value is 
0.00625.  



Properties of Simulator Objects 
 

376 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Voltage to Tap Sensitivity 

Shows the sensitivity of the voltage magnitude at the regulated bus to a change in the 
transformer's tap ratio. You can use this field to assess whether or not the transformer can 
effectively control the regulated bus voltage. In an ideal case, such as when the LTC 
transformer is being used to control the voltage at a radial load bus, the sensitivity is close 
to 1.0 (or -1.0 depending upon whether the tapped side of the transformer is on the load 
side or opposite side of the transformer). However, sometimes the transformer is very 
ineffective in controlling the voltage. This is indicated by the absolute value of the sensitivity 
approaching 0. A common example is a generator step-up transformer trying to control its 
high-side voltage when the generator is off-line. Simulator automatically disables 
transformer control if the transformer sensitivity is below the value specified on Power Flow 
Solution Tab of the Simulator Options dialog.  

Impedance Correction Table 

This field specifies the number of the transformer's corresponding transformer impedance 
correction table. Transformer impedance correction tables are used to specify how the 
impedance of the transformer should change with the off-nominal turns ratio. If this number 
is 0, then no impedance correction table is associated with the transformer, and the 
impedance of the transformer will thus remain fixed as the tap ratio changes. Valid 
impedance correction table numbers range from 1 to 63. To assign an existing impedance 
correction table to the transformer, enter the existing table's number. To view the existing 
impedance correction tables, click the Insert/View Impedance Correction Table button, 
which brings up the Transformer Impedance Correction Dialog. To define a brand new 
impedance correction table for the transformer, enter an unused table number and then 
click Insert/View Impedance Correction Table to prescribe the correction table. Note that the 
association between a transformer and an impedance correction table is not finalized until 
you select either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transmission Line/Transformer Options: Series Capacitor 

  

The Series Capacitor tab of the Line/Transformer Information dialog displays information 
relating to a series capacitor, including its status. 
  

Status 

The capacitor itself has two status positions, Bypassed and In Service. When the series 
capacitor is in service, the branch is modeled as a reactive branch, using the line parameters 
from the Parameters / Display page. If the capacitor is bypassed, a low impedance branch is 
introduced to bypass the capacitor. Note that this is not the same as the branch status of 
Open or Closed. The branch status is the indicator of whether or not the entire circuit is 
operating (closed), regardless of Bypassed or In Service status on the capacitor itself. 

Is Series Capacitor 

If this box is checked, the branch can be treated as a series capacitor, with the series Status 
of Bypassed or In-Service available. 
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Multi-Section Line Information 

  

Multi-section line records are used to group a number of series-connected transmission lines 
together so that their status is controlled as a single entity. They are usually used to model 
very long transmission lines that require multiple individual transmission line records if they 
are to be modeled accurately. In terms of line status, Simulator then treats each multi-section 
line as a single device. In other words, changing the status of one line in the record changes 
the status of the other lines in the record, as well.  

Multi-section line records are not directly represented on the oneline diagrams. Rather, to 
view this dialog, right-click the record of interest on the Multi-Section Line Records display and 
select Show Dialog from the resulting local menu. To define a new multi-section line, switch 
to Edit Mode and, from the Multi-Section Line Records display, right-click and select Insert 
from the resulting local menu. 

Note: If any of the transmission lines comprising a multi-section line record are deleted, the 
entire multi-section line record is deleted as well.  
  

The Multi-Section Lines Dialog contains the following fields: 

From Bus Number and Name 

Number and name of the from bus for the record. If you are defining a new multi-section 
line, this must be the first data item you specify. 

To Bus Number and Name 

Number and name of the "to" bus for the record. You cannot specify this value directly. 
Instead, use the table at the bottom of the dialog to define the intermediate buses and to 
terminal.  

Circuit 

Two character identifier used to distinguish between multiple records joining the same 
from/to buses. The first character of the circuit identifier must be an "&."  

You can use the spin button immediately to the right of the circuit field to view other multi-
section line records. However if you have changed the record, you must select Save 
before moving to another record. Otherwise, your changes will be lost. 

From End Metered 

If checked, the from end of the record is the metered end; otherwise the to end is metered. 

Multi-Section Line Name 

The name for the multi-section line. 

Table 

The table lists the dummy (or intermediate) buses and the to bus that comprise the record. 
The first column should contain the first dummy bus number and the circuit ID of the 
transmission line joining the from bus with the first dummy bus. The next column should 
contain the second dummy bus number and the circuit id of the transmission line joining this 
bus to the first dummy bus. Continue until the last column contains the to bus and the 
circuit ID of the transmission line joining the last dummy bus with the "to" bus.  

Each transmission line comprising the multi-section line must already exist. If only one 
transmission line joins any two buses, you may omit the circuit identifier.  

OK 

Saves any modifications and closes the dialog.  
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Save 

Saves any modifications but does not close the dialog. 

Cancel 

Closes the dialog without saving modifications to the current record. 

Delete 

Deletes the current multi-section line record. 

Note: If any of the transmission lines comprising a multi-section line record are deleted, the 
entire multi-section line record is deleted as well.  
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Line Field Options 

  

Line field objects are used to show different values associated with transmission lines, 
transformers and DC lines. This dialog is used to view and modify the parameters associated 
with these fields. 
  

Find… 

If you do not know the exact line identifiers you are looking for, you can click this button to 
open the advanced search engine. 

Near Bus Number 

Bus associated with the near end of the object. All fields display values calculated at the 
near  bus end. When inserting fields graphically, this field is automatically set to the closest 
bus on the oneline.  

Far Bus Number 

Bus associated with the far end of the object.  

Circuit 

Two-character identifier used to distinguish between multiple lines or transformers joining 
the same two buses. Default is ‘1’.  

Total Digits in Fields 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Delta Per Mouse Click 

Only used with the MVA Limit field type. Specifying a nonzero value for this field equips the 
MVA Limit Field with an integrated spin button that can be clicked to increment or 
decrement the MVA Limit by the amount of the Delta Per Mouse Click value. 

Field Value 

The current value of the field being displayed. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Rotation Angle in Degrees 

The angle at which the text will appear on the diagram. 

Anchored 

If checked, the line analog is anchored to its associated line.  

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of line field to show. The following choices are available: 

AC Line MW Flow MW flow into the line or transformer at the near bus 

AC Line Mvar Flow Mvar flow into the line or transformer at the near bus 
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AC Line MVA Flow Magnitude of MVA flow into the line or transformer at the near bus 

AC Line Amp Flow Magnitude of Amp flow (in amps) into the line at the near bus 

AC Line MW Losses Real power losses on the line or transformer in MW 

AC Line Mvar Losses Reactive power losses on the line or transformer in Mvar 

DC Line MW Flow MW flow into the DC line at the near bus 

DC Line Mvar Flow Mvar flow into the DC line at the near bus 

MVA Limit MVA limit for the line or transformer 

DC Line Set point Set point value for the DC line; see DC Transmission Line dialog 

Select a Field Choose from over 80 different fields 

Select OK to save changes and close the dialog or Cancel to close the dialog without saving 
your changes.  
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Series Capacitor Field Options Dialog 

  

Series capacitor field objects are used to show field values specific to series capacitors. Use 
Line Fields to show fields generic to transformers, series capacitors and transmission lines, 
such as the flow of power through the device. The series capacitor fields dialog is used to view 
and modify the parameters associated with series capacitor specific fields. 
  

Near Bus Number 

Bus associated with the near end of the series capacitor. 

Far Bus Number 

Bus associated with the far end of the series capacitor.  

Circuit 

Two-character identifier used to distinguish between branches joining the same two buses. 
Default is '1'.  

Anchored 

When checked, the text field will move with the series capacitor if the series capacitor is 
moved on the oneline diagram. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Rotation Angle in Degrees 

The angle at which the text will be placed. 

Field Value 

The value of the currently selected field. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Designates the type of transformer field to show. The following choices are available: 

Status Capacitor status 

Series Capacitance Capacitance of series capacitor 

Select OK to save changes and close the dialog or Cancel to close dialog without saving your 
changes. 
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Transformer Field Options Dialog 

  

Transformer field objects are used to show field values specific to transformers. Use Line 
Fields to show fields generic to transformers and transmission lines, such as the flow of power 
through the device. The transformer fields dialog is used to view and modify the parameters 
associated with transformer-specific fields. 
  

Near Bus Number 

Bus associated with the near end of the transformer. 

Far Bus Number 

Bus associated with the far end of the transformer.  

Circuit 

Two-character identifier used to distinguish between transformers joining the same two 
buses. Default is '1'.  

Find… 

If you do not know the exact transformer you are looking for, you can click this button to 
open the advanced search engine. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Delta per Mouse Click 

This value is used only with the Off-nominal Tap Ratio and Phase Shift Angle field 
types. When there is a nonzero entry in this field, and the field type is valid, a spin button is 
shown to the right of the zone field. When the up spin button is clicked, the field value is 
increased by this number; when the down button is clicked, the field value is decreased by 
this amount.  

Field Value 

Shows the current output for the transformer field. Whenever you change the Type of 
Field selection, this field is updated.  

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Rotation Angle in Degrees 

The angle at which the text is to appear on the oneline diagram. 

Anchored 

When checked, the text field will move with the transformer if the transformer is moved on 
the oneline diagram. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Designates the type of transformer field to show. The following choices are available: 
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Off-nominal Tap Ratio Actual tap ratio 

Phase Shift Angle Actual phase shift in degrees 

Off-nominal Tap Position Tap position in steps, usually ranging from L16 to R16 

Automatic Control Status The status of the control for the transformer 

Select OK to save changes and close the dialog or Cancel to close dialog without saving your 
changes. 
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DC Transmission Line Options 

  

This dialog is used to view and modify the parameters associated with each two-terminal DC 
transmission line in the system. It can also be used to insert new two-terminal DC 
transmission lines or to delete existing ones.  

This dialog has six separate pages: Line Parameters, Rectifier Parameters, Inverter 
Parameters, Actual Flows, OPF and Custom. The Actual Flows page is not used in Edit Mode. 
The separate pages can be accessed using the tabs shown at the top of the dialog. These 
pages can be used to view/change the modeling parameters associated with the DC lines.  
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DC Line Options: Line Parameters 

  

This page is used to enter parameters associated with the DC line itself. 
  

Rectifier and Inverter Bus Numbers and Names 

These fields indicate the numbers and names of the rectifier and inverter ends of the line. 
When graphically inserting a DC line, these fields are automatically determined based upon 
the starting and ending buses used in drawing the line. When investigating existing DC line 
records, you may use the Find By  Numbers button to identify a DC line between a specific 
rectifier - inverter pair. You may also use the spin control to cycle through the list of DC line 
records modeled in the case. 

Circuit ID 

This field is not currently used, since only one DC transmission line can exist between each 
inverter-rectifier pair. It is hard-coded to be 1. 

Find By Numbers 

To find a DC line by its bus numbers, enter the Rectifier and Inverter bus numbers and the 
circuit identifier. Then click this button. Use the spin button to cycle through the list of DC 
lines in the system. 

Area Name 

Names of the areas in which the rectifier and inverter buses are located. 

Labels 

Clicking this button will open the Subscribed Aliases dialog displaying the list of defined 
labels for the DC line. New labels can also be added for the DC Line from the dialog as well. 

Link to New DC Line 

Use the Link to New DC Line button to create a new DC line corresponding to the entries 
you have made in the dialog. This button performs the same function as pressing Save. 
Note that adding a new DC line to the case in this way does not add a DC line to the oneline 
display; the new DC line is present only in the model. You may then add the newly modeled 
DC line to the oneline diagram in the usual way (such as select Network > DC 
Transmission Line from the Individual Insert ribbon group on the Draw ribbon tab). 

  

Line Parameters 

Status 

Operating status of the DC transmission line. If the status is Open, then no power can flow 
on the DC line regardless of the control mode setting. If the status is closed, then the 
control mode will dictate how power flows on the line. 

Control Mode 

The initial control mode for the line. Specify Blocked to disable the DC line, Power to 
maintain specified MW power flow through the line, or Current to maintain specified current 
flow through the line.  

Setpoint 

If the line operates in the Power Control Mode, Setpoint should indicate the desired power 
flow in MW. To specify power flow at the rectifier end, enter a positive value. Enter a 
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negative value to specify power flow at the inverter end. If the DC line operates in Current 
Control Mode, enter the desired line flow in amps.  

Resistance 

Resistance of the DC Line. 

Sched. Voltage 

Scheduled DC line voltage in kV. The value of Rcomp is used to determine whether this 
value specifies the inverter end or the rectifier end. 

Switch Voltage 

When the line operates in the Power Control Mode, this is the inverter voltage level in kV at 
which the line switches from constant power to constant current control.  

RComp 

Compounding resistance. The compounding resistance dictates whether the inverter voltage 
is scheduled (Rcomp = 0), or the rectifier voltage is scheduled (Rcomp = DC line 
resistance). Simulator does not currently support scheduling the voltage at a point along the 
DC line (0 < Rcom < DC line resistance), but instead will treat any non-zero value of Rcomp 
as scheduling the voltage at the rectifier. 

Setpoint Specified At 

Indicates which end of the DC transmission line the Setpoint value is designated. This will be 
the terminal where the setpoint value is maintained. The opposite terminal flow value will be 
a calculated quantity. 

Metered End of Line 

Indicates which end of the DC line is assumed metered for Area interchange calculations. 

 



Properties of Simulator Objects 
 

388 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

DC Line Options: Rectifier Parameters 

  

This page is used to enter parameters associated with the rectifier end of the line. 
  

# of Bridges 

Number of valve bridges in series. 

Base Voltage 

Base AC voltage in kV on primary side of transformer. 

XF Ratio 

Transformer ratio. 

XF Tap 

Transformer tap setting. 

XF Min/Max Tap, XF Tap Step 

Transformer minimum and maximum tap settings, and the tap's step size. 

Commuting XF Resistance and Reactance 

Commuting resistance and reactance for the transformer, in ohms.  

Minimum, Maximum, and Actual Firing Angle 

Minimum, maximum, and actual values of the firing angle for the rectifier.  
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DC Line Options: Inverter Parameters 

  

This page is used to enter parameters associated with the inverter end of the line. Entries are 
identical to the Rectifier Page, except here they are associated with the inverter. 
  

# of Bridges 

Number of valve bridges in series. 

Base Voltage 

Base AC voltage in kV on primary side of transformer. 

XF Ratio 

Transformer ratio. 

XF Tap 

Transformer tap setting. 

XF Min/Max Tap, XF Tap Step 

Transformer minimum and maximum tap settings, and the tap's step size. 

Commuting XF Resistance and Reactance 

Commuting resistance and reactance for the transformer, in ohms.  

Minimum, Maximum, and Actual Firing Angle 

Minimum, maximum, and actual values of the firing angle for the rectifier.  
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DC Line Options: Actual Flow 

  

Shows the actual real and reactive power flows into the line at the rectifier and the inverter, as 
well as the voltage at both ends (in kV) and the line current in amps. The contents of this 
page are valid only when Simulator is in Run Mode. 
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DC Line Options: OPF 

  

This page is used to enter parameters associated with the OPF. 
  

Rectifier/Inverter Bus MW Marginal Costs 

Displays the marginal costs of the branches terminal buses, following the solution of the 
OPF. 

OPF Control 

Minimum and Maximum Setpoint Value 
The minimum and maximum setpoint allowed for the DC Line. When on OPF Control the 
DC Line will be dispatched between these values. 

Current Setpoint Value 

The current Setpoint as found on the Line Parameters Tab. 

Transmission Charge 

This is the cost incurred for moving power across the DC transmission line. The cost is 
zero at a zero MW flow and increases linearly using this charge. 

OPF Control Enabled for this DC line 

This check box must be checked if the DC limit is going to be enforced when running an OPF 
solution. If this box is not checked, the OPF routine will allow the DC line to violate its limits. 

Include Impact of DC Line Marginal Losses 

When dispatching the DC Line this determines whether the marginal losses from the DC line 
are taken into account. 
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Multi-Terminal DC Record Information 

  

This dialog is used to view and modify the parameters associated with multi-terminal DC 
records. It is also used when inserting new multi-terminal DC records. 

The Multi-Terminal DC Record dialog can be used to inspect and modify the model of a multi-
terminal DC network record. To view the Multi-Terminal DC Record, simply right-click on the 
record of interest in the Multi-Terminal DC Record Display and select Show Dialog from the 
resulting popup menu. The dialog has the following fields: 
  

Record Number 

Unique number between 1 and 999 which identifies the current multi-terminal DC record.  

Number of Devices 

Lists the number of DC buses, converters, and DC Lines that form the multi-terminal DC 
network. 

Control 

The control method used when solving the multi-terminal DC network.  

Controlling Converter 

The AC converter bus number where the DC voltage is being controlled. 

MTDC Network Status 

Status of the entire Multi-terminal DC network. If this field is set to Closed, the entire DC 
subnetwork of the MTDC model is considered disconnected in the load flow case. 

DC Buses Tab 

This page of the dialog displays the DC bus records for the multi-terminal DC network. The 
display on this page exhibits the same features as other case information displays. To view 
the specific information for a DC bus, right-click on the record of interest and choose Show 
Dialog from the popup menu. 

DC Converters Tab 

This page of the dialog displays the DC converter records for the multi-terminal DC network. 
The display on this page exhibits the same features as other case information displays. To 
view the specific information for a DC converter, right-click on the record of interest and 
choose Show Dialog from the popup menu. 

DC Lines Tab 

This page of the dialog displays the DC line records for the multi-terminal DC network. The 
display on this page exhibits the same features as other case information displays. To view 
the specific information for a DC line, right-click on the record of interest and choose Show 
Dialog from the popup menu. 

Custom Tab 

Enter any text notes you wish in the Memo page. When the case is saved as a Simulator 
PWB file, the memo text will also be saved. Custom strings and values can also be entered 
and saved with the case file as well. 
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Multi-Terminal DC Bus Information 

  

This dialog is used to view and modify the parameters specific to multi-terminal DC network 
buses. The dialog is also used to enter values for new multi-terminal DC buses when inserting 
a Multi-Terminal DC Record. 

To view the Multi-Terminal DC Bus Record dialog, right-click on a bus record in the DC Buses 
tab of the Multi-Terminal DC Record dialog and select Show Dialog from the resulting popup 
menu. The dialog has the following fields: 
  

DC Bus Number, DC Bus Name 

The number and name identifiers for the selected DC bus. 

AC Bus Number 

The AC bus number connected to the DC bus through an AC/DC converter. If the selected 
DC bus is a bus that is internal to the DC multi-terminal network (not directly connected to 
an AC bus,) this field will be 0. 

Area Number, Area Name 

The number and name identifiers of the control area the DC bus is contained in. 

Zone Number, Zone Name 

The number and name identifiers of the zone the DC bus is contained in. 

Ground Resistance 

Resistance to ground of the DC bus, entered in Ohms. This field is currently only for storage 
of values supported by other load flow formats, and is currently not used by Simulator. 
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Multi-Terminal DC Converter Information 

  

This dialog is used to view and modify the parameters specific to multi-terminal DC network 
buses. The dialog is also used to enter values for new multi-terminal DC buses when inserting 
a Multi-Terminal DC Record. 

To view the Multi-Terminal DC Bus Record dialog, right-click on a bus record in the DC Buses 
tab of the Multi-Terminal DC Record dialog and select Show Dialog from the resulting popup 
menu. The dialog has the following fields: 
  

Converter Parameters 

Number of Bridges 

Number of bridges in series for the selected converter. 

Converter Type 

R for rectifier or I for inverter. 

Commutating Impedance 

Commutating impedance per bridge, in Ohms. 

Firing Angle Limits 

The maximum and minimum firing angle limits, in degrees. 

  

Transformer Parameters 

AC Base 

The primary AC base voltage, in kV. 

DC Base 

The DC base voltage, in kV. 

Transformer Ratio 

Actual transformer ratio. 

Tap Settings 

Displays the actual tap setting, the tap step, and maximum and minimum tap values for the 
converter transformer. 

  

Control Parameters 

Setpoint 

The setpoint control value at the converter. For the voltage-controlling converter, this field is 
set to 0. For the remaining converters, this field displays MW when in Power mode, or Amps 
when in Current mode. 

Margin 

Rectifier margin, entered in per-unit of the DC power or current. This field is currently only 
for support of other load flow formats, and is not used by Simulator. 

DC Participation Factor 

Converter participation factor. This field is currently only for support of other load flow 
formats, and is not used by Simulator. 
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Voltage 

The DC Voltage magnitude at the DC side of the converter. 

  

Solved Parameters 

Firing Angle 

The firing angle of the converter, as determined during the load flow solution. 

DC Current 

The calculated DC current at the converter DC terminal. 

MW, MVAR 

The real and reactive power delivered to (or absorbed from) the AC system by the 
converter. 
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Multi-Terminal DC Line Information 

  

This dialog is used to view and modify the parameters specific to multi-terminal DC network 
buses. The dialog is also used to enter values for new multi-terminal DC buses when inserting 
a Multi-Terminal DC Record. 

To view the Multi-Terminal DC Bus Record dialog, right-click on a bus record in the DC Buses 
tab of the Multi-Terminal DC Record dialog and select Show Dialog from the resulting popup 
menu. The dialog has the following fields: 
  

From and To DC Bus Number 

The DC bus numbers of the From and To buses in the multi-terminal DC network. These 
fields must contain valid DC bus numbers of the selected multi-terminal DC record. AC bus 
numbers from the load flow case are not acceptable bus numbers for a multi-terminal DC 
line. 

DC Circuit 

The circuit identifier for the DC line. 

DC Resitance and DC Inductance 

The resistance and inductance of the DC line. Resistance is in Ohms, and is used for solving 
the load flow of the DC network. The inductance is in milliHenries, and is not used for 
solving the load flow. The inductance field is currently only for support of other load flow 
formats, and is not used by Simulator. 
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Transmission Line/Transformer Options: Transformer Control 

  

Transformers are used to transfer power between different voltage levels or to regulate real or 
reactive flow through a particular transmission corridor. Most transformers come equipped 
with taps on the windings to adjust either the voltage transformation or the reactive flow 
through the transformer. Such transformers are called either load-tap-changing (LTC) 
transformers or tap-changing-under-load (TCUL) transformers.  

Another type of transformer is known as a phase-shifting transformer (phase shifter or phase 
angle regulator). Phase-shifting transformers, which are less common than LTC transformers, 
vary the angle of the phase shift across the transformer in order to control the MW power flow 
through the transformer.  
  

Off-nominal Turns Ratio and Phase Shift Degrees 

The Line/Transformer Dialog displays several transmission line and transformer properties. 
For transformers, this dialog box also shows information about the LTC or phase shifter 
controls. The Off-nominal Turns Ratio field indicates the voltage transformation, while 
the Phase Shift Degrees field show the phase shift angle. If the transformer is not on 
automatic control, these values can be changed manually. The off-nominal tap ratio 
determines the additional transformation relative to the nominal transformation. This value 
normally ranges from 0.9 to 1.1 (1.0 corresponds to no additional transformation). For 
phase-shifting transformers the phase shift value normally ranges from about -40° to 40°. 
The phase angle field can be non-zero for LTC and fixed transformers, most notably +/- 30° 
if the transformer configuration is a delta-wye or wye-delta configuration. The transformer 
configuration is very important when performing a fault analysis study. 

  

When in Edit Mode, the dialog also reveals the type of transformer. Valid types are 1) No 
Automatic Control (in which the taps are assumed fixed), 2) voltage regulation (AVR), 3) 
Reactive Power Control, and 4) Phase Shift Control. The type of transformer CANNOT be 
modified in the Run Mode.  

Simulator provides you with a great deal of flexibility in being able to specify which 
transformers will actually be used for automatic control in the Power Flow Solution. For a 
transformer to be used for voltage or flow control, three criteria must be met. 
• The transformer's Automatic Control Enabled field must be checked on its 

Line/Transformer dialog. This field can also be modified on the Transformer Records 
display.  

• The transformer's area must have automatic transformer control enabled. This is specified 
on the Options Tab of the Area Records display.  

• Transformer control must not be disabled for the entire case. This is specified on the 
Power Flow Solution Tab of the Simulator Options Dialog. 

The area and case enforcement of transformer control are also accessible from the Run Mode 
Line/Transformer Dialog. 

Automatic Control 

The Automatic Control fields are only visible in Edit Mode when the  Change Automatic 
Control Options button is pressed. 

No Automatic Control 
On this control setting the transformer will operate at the given off-nominal turns ratio 
and phase shift, and will remain fixed at those values during the entire solution process 
unless manually changed by the user. 
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AVR (Automatic Voltage Regulation) 

When on automatic voltage control, the transformer taps automatically change to keep 
the voltage at the regulated bus (usually one of the terminal buses of the transformer) 
within a voltage range between the minimum voltage and maximum voltage values 
(given in per unit). These values can be seen by clicking on the Automatic Control 
Options button. Note that automatic control is possible only if a regulated bus has been 
specified.  

The tap position for an LTC transformer is indicated on the oneline by the number of tap 
step positions from the nominal position (i.e., the position when the off-nominal tap ratio 
is equal to 1.0). When the off-nominal ratio is greater than 1.0, the transformer's tap is 
said to be in the "raise" position, and an 'R' appears after the number. Likewise, when 
the off-nominal ratio is less than 1.0, the transformer's tap is said to be in the "lower" 
position, and an 'L' appears after the number. For example, with a step size of 0.00625 
and an off-nominal ratio of 1.05, the tap would be in position 8R. The tap position can be 
changed manually only when the transformer has been set off automatic voltage control. 

Simulator will also detect instances when controlling transformers are in parallel, and will 
employ checks during the solution routine to prevent the controllers from fighting each 
other and potentially going to opposite tap solutions, which could result in unwanted 
loop flow through the transformer objects. This option is enabled by default, but can be 
turned off in the Power Flow Solution General Options. 

Transformer Reactive Power Control 

When on automatic reactive power control, the transformer taps automatically change to 
keep the reactive power flow through the transformer (measured at the from bus) within 
a user-specified range. The reactive power control parameters can be seen by clicking 
the Automatic Control Options button.  

Phase Shift Control 
When a transformer is on phase shift control, the transformer phase shift angle 
automatically changes to keep the MW flow through the transformer (measured at the 
from bus) between the minimum and maximum flow values (given in MW, with flow into 
the transformer assumed positive). The limits on the phase shifting angles are specified 
in the minimum and maximum phase fields (in degrees). These values can be seen by 
clicking on the Automatic Control Options button. The phase shift angle changes in 
discrete steps, with the step size specified in the Step Size field (in degrees). The MW 
Per Phase Angle  Step Size provides an estimate of the change in the controlled MW 
flow value if the phase angle is increased by the step size value.  

Specify Transformer Bases and Impedances 

Shows the Transformer Bases and Impedances Dialog. This dialog allows the user to specify 
the transformer parameters in per unit on the transformer base (taken as its rating). Click 
OK to convert all the transformer parameters values to the system base specified in the 
General Power Flow Solution Options. 
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Transformers Bases and Impedances Dialog 

  

Typically the impedances and tap values of transformers is already assumed to have been 
converted to unity tap base and bus nominal voltage base. However, some load flow formats 
provide the taps and impedances on specific transformer bases, which are different than the 
bus voltage and unity tap base assumptions. In these cases, Simulator will convert parameters 
from the transformer bases to the unity tap and bus nominal voltage base. Display of the 
impedances and tap values normally displayed in the Line/Transformer Options dialog are 
displayed on the Simulator assumed bases. However, if you wish to view the original 
transformer values on the transformer supplied bases, this dialog will display the original 
values. You can modify the original values stored here in this dialog. Note that when you do 
so, the converted values that Simulator stores on the system bases will also be automatically 
updated to reflect the change that has been made to the original values on the transformer 
bases. 
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Transformer Impedance Correction Table Display 

  

The Transformer Impedance Correction Display shows information about all the transformer 
impedance correction tables in the case. The Transformer Impedance Correction Display is 
used to model the change in the impedance of the transformer as the off-nominal turns ratio 
or phase shift angle is varied.  

The Correction Display is a class of Case Information Display and therefore can be used in a 
manner consistent with all other case information displays. It has a local menu from which you 
can print, copy, and modify its information as well as view the information dialog of its 
associated correction tables. When in Edit Mode, you can define new tables using the Insert 
option, or delete existing tables using Delete. You can also sort the transformer impedance 
correction information by clicking on the heading of the field by which you want to sort.  

To show this display select Network > Impedance Correction Tables from the Model 
Explorer. 
  

The display contains the following fields by default: 

Table #, Table Name 

Shows the table number and name for the record. Table number must be between 1 and 
64.  

Transformer Impedance Scaling Factors 

The rest of the default columns show the actual fields in the table. The first field of each 
pair shows the off-nominal turns ratio or phase shift angle, while the second field shows the 
associated scaling factor for the transformer’s impedance.  
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Transformer AVR Dialog 

  

The Transformer AVR Dialog is used to view the control parameters associated with load-tap-
changing (LTC) transformers when they are used to control bus voltage magnitudes. To view 
this display, click the Automatic Control Options button on the Line/Transformer Information 
Dialog. 
  

This dialog has the following fields: 

Automatic Control Type 

This section is only visible on the dialog in edit mode. The control type of the transformer 
can be changed between no control, voltage regulation, reactive power control, or phase 
shifter control. 

Regulated Bus Number 

The number of the bus whose voltage is regulated by the control. 

Present Regulated Bus Voltage 

The present voltage of the regulated bus. 

Voltage Error 

If the regulated bus' voltage falls outside the regulating range of the transformer (as defined 
by the Minimum Voltage and Maximum Voltage fields), the Voltage Error field indicates by 
how much the voltage deviates from the control range. 

Regulation Minimum Voltage 

The minimum acceptable voltage at the regulated bus. 

Regulation Maximum Voltage 

The maximum acceptable voltage at the regulated bus. 

Regulation Target Type 

As long as the regulated voltage is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated voltage moves outside of this 
regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated voltage back inside of its range. The Regulation Target Type determines what 
value is used as a target when calculating this change in tap ratio. Middle is the default and 
means that the target is the average of the regulation minimum and maximum regardless of 
whether the voltage is high or low. Max/Min means that the regulation maximum is used 
as the target when the regulated voltage is above the maximum, and regulation minimum is 
used as the target value when the regulated voltage is below the minimum. 

Present Tap Ratio 

The tap ratio of the transformer for the current system state. 

Minimum Tap Ratio, Maximum Tap Ratio 

Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical 
values are 0.9 and 1.1.  

Tap Step Size 

Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either 
incremented or decremented from 1.0 in integer multiples of this value. Default value is 
0.00625.  
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Voltage to Tap Sensitivity 

Shows the sensitivity of the voltage magnitude at the regulated bus to a change in the 
transformer's tap ratio. You can use this field to assess whether or not the transformer can 
effectively control the regulated bus voltage. In an ideal case, such as when the LTC 
transformer is being used to control the voltage at a radial load bus, the sensitivity is close 
to 1.0 (or -1.0 depending upon whether the tapped side of the transformer is on the load 
side or opposite side of the transformer). However, sometimes the transformer is very 
ineffective in controlling the voltage. This is indicated by the absolute value of the sensitivity 
approaching 0. A common example is a generator step-up transformer trying to control its 
high-side voltage when the generator is off-line. Simulator automatically disables 
transformer control if the transformer sensitivity is below the value specified on Power Flow 
Solution Tab of the Simulator Options dialog.  

Impedance Correction Table 

This field specifies the number of the transformer's corresponding transformer impedance 
correction table. Transformer impedance correction tables are used to specify how the 
impedance of the transformer should change with the off-nominal turns ratio. If this number 
is 0, then no impedance correction table is associated with the transformer, and the 
impedance of the transformer will thus remain fixed as the tap ratio changes. Valid 
impedance correction table numbers range from 1 to 63. To assign an existing impedance 
correction table to the transformer, enter the existing table's number. To view the existing 
impedance correction tables, click the Insert/View Impedance Correction Table button, 
which brings up the Transformer Impedance Correction Dialog. To define a brand new 
impedance correction table for the transformer, enter an unused table number and then 
click Insert/View Impedance Correction Table to prescribe the correction table. Note that the 
association between a transformer and an impedance correction table is not finalized until 
you select either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transformer Mvar Control Dialog 

  

The Transformer Mvar Control dialog is used to view the control parameters associated with 
load-tap-changing (LTC) transformers that are used to control the Mvar flow through the 
transformer. To view this display, click on the Automatic Control Options button on the 
Line/Transformer Information Dialog.  

When used to control reactive power, the LTC transformer always controls the reactive power 
flow at the from end of the transformer (i.e., the tapped side), with positive flow assumed to 
be going through the transformer to the to bus. Therefore the regulated bus field is not used.  
  

The dialog has the following fields: 

Mvar Flow at From Bus 

The current Mvar flow as measured at the from end of the line. This is the parameter the 
transformer tries to control. 

Mvar Error 

If the Mvar flow at the from end violates the limits defined by the Minimum Mvar Flow and 
Maximum Mvar Flow fields, the Mvar Error field indicates by how much the flow falls outside 
the control range.  

Regulation Minimum Mvar Flow, Regulation Maximum Mvar Flow 

Minimum and maximum allowable reactive power flow as measured at the from  bus. The 
transformer attempts to regulate the reactive flow to fall within this range. 

Regulation Target Type 

As long as the regulated Mvar flow is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated Mvar flow moves outside of 
this regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated Mvar flow back inside of its range. The Regulation Target Type determines 
what value is used as a target when calculating this change in tap ratio. Middle is the 
default and means that the target is the average of the regulation minimum and maximum 
regardless of whether the Mvar flow is high or low. Max/Min means that the regulation 
maximum is used as the target when the regulated Mvar flow is above the maximum, and 
regulation minimum is used as the target value when the regulated Mvar flow is below the 
minimum. 

Present Tap Ratio 

The transformer's present off-nominal turns ratio.  

Minimum Tap Ratio, Maximum Tap Ratio 

Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical 
values are 0.9 and 1.1.  

Tap Step Size 

Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either 
incremented or decremented from 1.0 in integer multiples of this value. Default value is 
0.00625.  

Mvar to Tap Sensitivity 

The amount of Mvar shift that would be implemented by switching one tap position from the 
current position. This sensitivity indicates the ability of the transformer to control Mvars. 

Impedance Correction Table 
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Specifies the number of the transformer's corresponding transformer impedance correction 
table. Transformer impedance correction tables are used to specify how the impedance of 
the transformer should change with the off-nominal turns ratio. If this number is 0, no 
impedance correction table is associated with the transformer, and the impedance of the 
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table 
numbers range from 1 to 63. To assign an existing impedance correction table to the 
transformer, enter the existing table's number. To view the existing impedance correction 
tables, click the Insert/View Impedance Correction Table button, which brings up the 
Transformer Impedance Correction Dialog. To define a brand new impedance correction 
table for the transformer, enter an unused table number and then click Insert/View 
Impedance Correction Table to prescribe the correction table. Note that the association 
between a transformer and an impedance correction table is not finalized until you select 
either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transformer Phase Shifting Information 

  

The Transformer Phase Shifting Dialog is used to view the control parameters of phase-
shifting transformers. To view this display, click on the Automatic Control Options button 
on the Line/Transformer Information Dialog, provided that the Phase Shift Control option is 
chosen from the Automatic Control group. 
  

Regulated Bus Number 

Number of the terminal bus of the phase shifter regulated by the phase shifter. When 
control is active, the phase shifter will automatically change its phase shift to keep the MW 
flow at this bus at the desired value. 

Current MW Flow  

Current MW flow through the transformer measured at the regulated bus terminal.  

MW Error 

If the current MW flow falls outside the minimum/maximum MW flow limits, the MW Error 
field indicates by how much the flow violates the regulating range. 

Regulation Minimum MW Flow, Regulation Maximum MW Flow 

Minimum and maximum allowable MW flow through the phase shifter. 

Regulation Target Type 

As long as the regulated MW flow is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated MW flow moves outside of this 
regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated MW flow back inside of its range. The Regulation Target Type determines what 
value is used as a target when calculating this change in tap ratio. Middle is the default and 
means that the target is the average of the regulation minimum and maximum regardless of 
whether the MW flow is high or low. Max/Min means that the regulation maximum is used 
as the target when the regulated MW flow is above the maximum, and regulation minimum 
is used as the target value when the regulated MW flow is below the minimum. 

Present Phase Angle (Degrees) 

The phase angle of the transformer for the current solved system state.  

Minimum Phase Angle, Maximum Phase Angle 

Minimum and maximum allowable phase shift in degrees.  

Step Size (Degrees) 

Phase shift change per step in degrees. 

MW Flow to Phase Sensitivity 

The sensitivity of the controlled MW flow to changes in the transformer's phase. This 
sensitivity indicates the transformer's ability to regulate its MW flow. 

Impedance Correction Table 

Specifies the number of the transformer's corresponding transformer impedance correction 
table. Transformer impedance correction tables are used to specify how the impedance of 
the transformer should change with the off-nominal turns ratio. If this number is 0, no 
impedance correction table is associated with the transformer, and the impedance of the 
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table 
numbers range from 1 to 63. To assign an existing impedance correction table to the 
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transformer, enter the existing table's number. To view the existing impedance correction 
tables, click the Insert/View Impedance Correction Table button, which brings up the 
Transformer Impedance Correction Dialog. To define a brand new impedance correction 
table for the transformer, enter an unused table number and then click Insert/View 
Impedance Correction Table to prescribe the correction table. Note that the association 
between a transformer and an impedance correction table is not finalized until you select 
either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transformer Field Options Dialog 

  

Transformer field objects are used to show field values specific to transformers. Use Line 
Fields to show fields generic to transformers and transmission lines, such as the flow of power 
through the device. The transformer fields dialog is used to view and modify the parameters 
associated with transformer-specific fields. 
  

Near Bus Number 

Bus associated with the near end of the transformer. 

Far Bus Number 

Bus associated with the far end of the transformer.  

Circuit 

Two-character identifier used to distinguish between transformers joining the same two 
buses. Default is '1'.  

Find… 

If you do not know the exact transformer you are looking for, you can click this button to 
open the advanced search engine. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Delta per Mouse Click 

This value is used only with the Off-nominal Tap Ratio and Phase Shift Angle field 
types. When there is a nonzero entry in this field, and the field type is valid, a spin button is 
shown to the right of the zone field. When the up spin button is clicked, the field value is 
increased by this number; when the down button is clicked, the field value is decreased by 
this amount.  

Field Value 

Shows the current output for the transformer field. Whenever you change the Type of 
Field selection, this field is updated.  

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Rotation Angle in Degrees 

The angle at which the text is to appear on the oneline diagram. 

Anchored 

When checked, the text field will move with the transformer if the transformer is moved on 
the oneline diagram. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Designates the type of transformer field to show. The following choices are available: 
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Off-nominal Tap Ratio Actual tap ratio 

Phase Shift Angle Actual phase shift in degrees 

Off-nominal Tap Position Tap position in steps, usually ranging from L16 to R16 

Automatic Control Status The status of the control for the transformer 

Select OK to save changes and close the dialog or Cancel to close dialog without saving your 
changes. 
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Three Winding Transformer Information 

  

The Three Winding Transformer Dialog is used to create, modify or delete three winding 
transformer records in Edit Mode, or to view information for a specific three winding 
transformer record in run mode. Note that all the values displayed on this dialog are on the 
system MVA base. If the records were created them from a file, the values are automatically 
converted to the system base. If a three winding transformer record is entered manually, the 
parameters need to be entered into Simulator computed with the same system MVA base 
Simulator is using.  
  

This dialog has the following controls: 

Primary Winding 

This section of the dialog displays the primary winding terminal bus number, nominal kV, 
and fixed tap value (in per unit). In addition, the automatic tap changer is assumed to be on 
the primary winding of a three winding transformer. Therefore the LTC field displays the tap 
changer tap value (in per unit) on the primary winding. 

Secondary Winding 

This section of the dialog displays the secondary winding terminal bus number, nominal kV, 
and fixed tap value (in per unit). 

Tertiary Winding 

This section of the dialog displays the tertiary winding terminal bus number, nominal kV, 
and fixed tap value (in per unit). 

Star Bus (Internal Node) 

This section of the dialog displays the internal node parameters of the three winding 
transformer model. Three winding transformers are modeled as three two winding 
transformers connected at the three winding transformer terminal buses to a common or 
internal node, referred to as the star bus. The parameters displayed for the star bus are the 
bus number, voltage (in per unit), and angle. 

Primary-Secondary, Secondary-Tertiary, and Tertiary-Primary Impedance 

These are the actual three winding transformer winding to winding impedances, in per unit 
on the system base. These values are used to compute the equivalent two winding 
transformer impedances for the two winding transformers used to model the three winding 
transformer operation. 

Transformer Parameters 

The values for the magnetizing conductance (G) and magnetizing susceptance (G), in per 
unit on the system base. 

Circuit ID 

The circuit identifier for the three winding transformer. 

Status 

The status of the three winding transformer. If checked, the three winding transformer 
model is in service, otherwise the equivalent model is treated as out of service. 

Mathematically equivalent two-winding transformers 

This table displays the three two winding transformers that are mathematically equivalent 
representations of the three winding transformer. If you read the three winding transformer 
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record from a file, the two winding equivalent transformers are created automatically. If you 
are inserting a three winding transformer manually, you can set the parameters for the 
primary, secondary and tertiary windings in the fields above, then click the Set Two-
Winding Equivalent Transformers button to have Simulator automatically create the two 
winding transformer records for you. You can also right-click in this table and insert, modify 
or delete two winding transformers manually if you already have the two winding 
transformer representations created. 

Once you are finished with the dialog, you can click Save or OK to save any changes. If you 
wish to abandon any changes you have made, click Cancel. 
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Switched Shunt Information (Edit Mode) 

  

This dialog is used to view and modify the parameters associated with each switched shunt in 
the system. It can also be used to insert new switched shunts and sometimes to delete 
existing shunts. Only one switched shunt is permitted at each bus. Switched shunts usually 
consist of either capacitors to supply reactive power (in MVR) to the system, or reactors to 
absorb reactive power. The switched shunts are represented by a number of blocks of 
admittance that can be switched in a number of discrete steps. If at least one block is in 
service, the shunt is said to be online. The shunt’s corresponding circuit breaker can be used 
to determine and to toggle the switched shunt’s status. 
  

The Edit Mode version of this dialog is very similar in content to its Run Mode counterpart. 

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus to which the switched shunt is attached. You can use the spin button immediately to the 
right of the number to move to the next switched shunt (click the up arrow) or the previous 
switched shunt (click the down arrow). 

Find By Number 

To find a switched shunt by its bus number, enter the number into the Bus Number field. 
Then click this button.  

Bus Name 

Unique alphabetic identifier for the bus to which the switched shunt is attached, consisting 
of up to eight characters.  

Find By Name 

To find a switched shunt by its bus name, enter the bus name into the Bus Name field (case 
insensitive). Then click this button. 

Shunt ID 

Since multiple switched shunts are allowed on a single bus, each switched shunt has a 
unique Shunt ID. 

Find… 

If you do not know the exact switched shunt bus number or name you are looking for, you 
can click this button to open the advanced search engine. 

Status 

Open or closed status of the switched shunt. 

Labels 

Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases 
assigned for the selected load. 

Area Number, Area Name 

The area number and name to which the switched shunt belongs. Note that you can change 
the area of the switched shunt to be different than the area of the terminal bus. If you do 
so, you will be prompted to confirm that you wish to place the switched shunt within a 
different area than that of the bus to which it is electrically connected. 

Zone Number, Zone Name 
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The zone number and name to which the switched shunt belongs. Note that you can change 
the zone of the switched shunt to be different than the zone of the terminal bus. If you do 
so, you will be prompted to confirm that you wish to place the switched shunt within a 
different zone than that of the bus to which it is electrically connected. 

Substation Number, Substation Name 

The name and number of the substation to which the switched shunt belongs, and it is the 
same than that of the terminal bus. 

  

Display 

Display Size 

Size of the switched shunt. 

Scale Width with Size 

Automatically scales the width of the symbol when the object is resized. 

Display Width 

Width of the switched shunt symbol. 

Pixel Thickness 

Thickness of the display object in pixels.  

Orientation 

Specifies the direction in which to draw the object.  

Anchored 

If checked, the object is anchored to its terminal bus. See Anchored Objects for details. 

Link to New Shunt 

Adds a new record in the data or links the selected shunt to a different record. 

OK, Save, Delete, and Cancel 

OK saves your changes and closes the dialog. Save saves your changes but does not close 
the dialog; this allows you to use, for example, the Find By Number command to edit 
additional switched shunts. Delete deletes the current switched shunt; this option is not 
available when inserting objects graphically – use the cut command instead. Cancel closes 
the dialog but does not save any changes. 

   

Parameters 

Nominal Mvar 

The Nominal Mvar field gives the initial amount of reactive power the device would supply 
(in Mvars) if its terminal voltage were 1.0 per unit. 

Nominal MW 

This field is only visible when a switched shunt object has been read from a file as a Bus 
Shunt. In that case, it is possible for the bus shunt to have both a MW and MVAR 
component. The MW component will be displayed here. In general, switched shunts of other 
control types do not have MW components, and this field will not be displayed. If you 
change a switched shunt read as a bus shunt to another form of control, the MW component 
will remain, but has no controllability. 

Control Mode 
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Determines whether the switched shunt has a fixed value, or whether the amount of 
reactive power supplied by the device changes in either discrete steps or continuously in 
order to maintain its terminal voltage within the voltage range specified in the Voltage 
Regulation fields. This field can be changed (except in Viewer). However, for a switched 
shunt to be used for automatic control, three fields must be set correctly: 1) the Control 
Mode field must be set to either Discrete or Continuous, 2) the corresponding area’s Auto 
Shunts property must be true, and 3) the case-wide Disable Switched Shunt Control option, 
which can be set on the Power Flow Solution Tab of the Simulator Options Dialog, must not 
be checked. 

Note: automatic control of switched shunts is disabled if the voltage regulation 
high value is not greater than the low value; they should not be equal unless in 
the continuous mode.  

Note the additional control mode called Bus Shunt (Fixed). This is analogous to the shunt 
MW and MVAR values that can also be stored at the bus level. The difference is that bus 
shunts stored directly with the bus cannot be turned on and off in the load flow; rather they 
are always included in the load flow solution. Bus shunts that are represented as switched 
shunt objects on Bus Shunt control, however, are mathematically exactly the same and can 
be turned on or off. The reason for the differentiation of the Bus Shunt versus normal Fixed 
control is that the Bus Shunt control type is intended to identify the difference between a 
bus shunt and a transformer that MAY have controllability, but is currently turned of off 
control by being set to a Fixed value.  

Control Regulation Settings 

Voltage Regulation 
When the switched shunt is on automatic control, its reactive power is changed in 
discrete steps or continuously to keep the voltage at the regulated bus within the per 
unit voltage range defined by High Value and the Low Value.  

In the case of discrete control, the amount of reactive power supplied by this device 
changes in discrete amounts, thus the High Value should be greater than the low value. 
The necessary voltage range depends upon the size of the switched shunt blocks. In 
addition to a voltage range for discrete control, a specific Target Voltage can be 
specified as well. The target voltage will try to be met, either approximately under 
discrete control, or exactly under continuous control (either true continuous or discrete 
with a continuous shunt correction element.) The number of the regulated bus is shown 
in the Reg. Bus # field. 

Generator Mvar Regulation 
This option allows switched shunts to control generator Mvar output to better enable full 
var range inside the inner power flow loop. During the first inner power flow loop, 
generator var limit checking is disabled for generators whose Mvar output is controlled 
by switched shunts. This will enable the use of the full reactive range of the switched 
shunts before generators hit their reactive limits. This corrects a problem in which the 
power flow fails to solve because generators are at their Mvar limits even though there is 
still reactive support available from switched shunts. 

Switched Shunt Blocks 

The amount of shunt reactive power (susceptance) is specified in the Switched Shunt Block 
field. The columns in this field correspond to different blocks of reactive power. The first row 
indicates the number of steps in each block, and the second row gives the amount of 
nominal Mvars per step (assuming 1.0 per unit voltage). You may model both capacitors and 
reactors. The reactors should be specified first, in the order in which they are switched in, 
followed by the capacitors, again in the order they are switched in. The sign convention is 
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such that capacitors are positive and reactors negative. Shunt blocks are switched in order 
from left to right. 

  

Control Parameters 

Single Largest Step 

This option only applies when a switched shunt is set on discrete control. If checked the 
switched shunt will switch in EITHER all of the available reactor blocks OR all of the 
capacitor blocks at once when the voltage falls outside the given range. Whether the reactor 
or capacitor blocks switch is determined by which limit is violated. A switched shunt with this 
option checked will only switch ONCE during a load flow solution, and then remains fixed at 
the new output for the remainder of the same solution calculation. 

Allow switching in the inner power flow loop 

This option is available for individual discrete shunts only. If this option is set, discrete 
shunts are treated as continuous in the inner power flow loop. This means that they are 
treated as PV buses in the inner power flow loop. After the first inner power flow loop, the 
shunt nominal Mvar setting is rounded to positive infinity to the next discrete step. If any 
shunts exist that are allowed to switch in the inner power flow loop, the inner power flow 
loop is repeated again with the shunts being treated as discrete in the subsequent inner 
power flow loop. Shunts that are allowed to switch in the inner power flow loop will only 
switch if the global option to "Disable Treating Continuous SSs as PV Buses" is not checked. 

Use Continuous Element 

If this option is checked, then Simulator will use a continuous element to fine-tune a discrete 
controlled switched shunt by injecting or absorbing additional MVARs to try and obtain the 
target voltage of the controlled bus. 

Minimum and Maximum Susceptance 

The minimum and maximum susceptance range for the continuous correction element. 

Use High Target Voltage 

Check this box to use the target voltage specified in the High Target Value edit box when 
the regulated point goes above the High limit. This will give a different target value if the 
voltage goes out of range on the high end than the low end. If the voltage goes out of 
range on the low end, the original target value on the Parameters page will be used. If this 
box is unchecked, only the target value on the parameters page will be used, whether the 
violation is high or low. 

  

Fault Parameters 

Typically switched shunts are treated as open circuits in the zero sequence data for fault 
analysis. However, it is possible to define zero sequence admittance blocks to be used. The 
blocks work similarly to the load flow Switched Shunt Blocks discussed above. Usually there 
will be the same number of blocks in the zero sequence data as in the load flow data. 
Simulator will determine how many blocks were switched in for the power flow solution, and 
then use the zero sequence block data to calculate the zero sequence admittance for the same 
number of blocks. 
  

Custom 
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This page of the dialog can be used to enter notes about the switched shunt. Any information 
entered in the memo box will be stored with the case when the case is saved to a PWB file. 
Custom fields can also be viewed and added from this page as well. 
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Switched Shunt Field Information 

  

Switched shunt field objects are used primarily to indicate various quantities associated with 
switched shunt devices. Furthermore, some switched shunt field types, which are 
distinguished by an integrated spin button, may be used to change switched shunt device 
properties. 

The Switched Shunt Fields Information Dialog can be used to modify the properties of 
individual switched shunt fields on the oneline. The dialog displays the following fields: 
  

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Bus Number 

Number of the bus to which the switched shunt associated with the field is connected. Use 
the dropdown box to view a list of all buses with switched shunts in the case with valid 
area/zone/owner filters.  

Bus Name 

Name of the bus to which the switched shunt associated with the field is connected. Use the 
dropdown box to view a list of all buses with switched shunts in the case with valid 
area/zone/owner filters.  

ID 

ID of the switched shunt associated with the field. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Value 

The current value of the field being displayed. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Delta Per Mouse Click 

Switched shunt fields can be used not only to show various fields associated with switched 
shunt devices, but they can also be used to change some values. This is accomplished using 
spin buttons shown to the right of the switched shunt field. When the up spin button is 
clicked, the switched shunt field value is increased by the amount specified in the delta per 
mouse click field. When the down spin button is clicked, the switched shunt field value is 
decreased by the same amount. 

This field is only used for Switched Shunt Mvar fields. Specifying a nonzero value in this field 
causes the integrated spin button to appear as part of the switched shunt field on the 
oneline. 

Rotation Angle in Degrees 

The angle at which the text is placed on the diagram, in degrees. 
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Anchored 

If the Anchored checkbox is checked, the switched shunt field is anchored to its associated 
switched shunt, which means that it will move with the switched shunt.  

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of switched shunt field to show. The following choices are 
available: 

Switched Shunt Mvar Total Mvar capacitance at the bus 

Select a Field Choose from any of the different switched shunt fields 

Select OK to save changes and to close the dialog, or click Cancel to close the dialog without 
saving your changes.  
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Bus Information (Run Mode) 

  

This dialog is used to view information about each bus in the system. It can be displayed by 
right-clicking on any bus on the oneline and choosing Bus Information Dialog or choosing 
Show Dialog from the Bus Display. This dialog can only be reached in Run Mode, but has a 
similar Edit Mode counterpart. The Bus Information Dialog has the following fields: 
  

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus. You can use the small arrow immediately to the right of the number to view a list of all 
buses in the case with valid display filters. Or you can use the spin button further to the 
right of the number to move to the next bus (click the up arrow) or the previous bus (click 
the down arrow). 

Find By Number 

To find a bus by its number, enter the number into the Bus Number field and then click 
this button.  

Bus Name 

Unique alphabetic identifier for the bus. You can use the small arrow immediately to the 
right of the bus name to view a list of all bus names in the case with valid display filters.  

Find By Name 

To find a bus by its name, enter the bus name into the Bus Name field (case insensitive) 
and then click this button. 

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Nom. Voltage 

Nominal voltage of the bus. 

Labels 

Clicking on this button will open the Label Manager dialog listing all of the labels assigned 
for the selected bus. 

Area Number, Name 

Each bus is associated with an Area record. These fields show the number and name of this 
area. See Area Records Display for more details about areas.  

Zone Number, Name 

Each bus is associated with a Zone record. These fields show the number and name of the 
zone. See Zone Records Display for more details about zones. You can also use the Zone 
Dialog  to list the buses in a particular zone and to easily move a group of buses from one 
zone to another.  

Substation Number, Name 

Each bus can be associated with a Substation record. By default, buses are not assigned to 
substations, and in that case these fields are blank. See the Substation Records Display topic 
for more details on adding substations. 

Owner Number, Name 
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Each bus is associated with an Owner record. These fields show the number and name of 
the owner. See Owner Records Display for more information about Owners. 

Voltage (per unit) 

Bus voltage in per unit notation. You may enter a new per unit voltage magnitude. However, 
the only effect this has is changing the initial voltage guess used in the iterative solution. If 
you would like to change the reference voltage for a generator, please see Generator 
Information Dialog. 

Voltage (kV) 

Bus voltage in actual kilovolts. 

Angle (deg) and Angle (rad) 

Voltage angle at the bus in degrees and radians. You may enter a new voltage angle. 
However, the only effect this has is changing the initial voltage guess used in the iterative 
solution EXCEPT AT THE SLACK BUS. Changing the angle for the slack bus will shift the 
voltage angle for all the buses in the slack bus' island by a similar amount.  

Status 

Status of the bus, either connected or disconnected. A disconnected bus is not energized. 
You can use this field to change the status of the bus. When the bus is initially connected, 
selecting Disconnected opens all of the transmission lines incident to the bus, 
disconnecting the bus from the rest of the system. Selecting Connected closes all of the 
lines incident to the bus unless they attach to another disconnected bus.  

View Substation Dialog 

Clicking on this button will open the substation dialog for the substation the bus is contained 
in. 

View Owner Dialog 

Clicking on this button will open the bus’ owner dialog. 

Slack Bus 

Checked only if the bus is a system slack bus. This value can only be changed in the Edit 
Mode. 

View All Flows at Bus 

Clicking on this button will open a quick power flow list for the current bus. 

  

Device Info  

Generator Information 

Displays the total MW and Mvar generation at the bus. You cannot change either of these 
fields from this display. Select View/Edit Generator Records to view the individual 
generator records for the bus. Selecting this button displays the Generator Dialog for the 
first generator at the bus. 

Load Information 

Displays the total MW and Mvar load at the bus. You cannot change either of these fields 
from this display. Select View/Edit Bus Load Records to view the individual load records 
for the bus. Selecting this button displays the Load Dialog. 

Shunt Admittance 
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Shows the real and reactive components of the shunt admittance to ground. Entered in 
either MW or Mvar, assuming one per unit voltage. B is positive for a capacitor and negative 
for a reactor. If B corresponds to a switched device, consider using a switched shunt. 

Bus Voltage Regulation 

This section lists the devices (if any) that are controlling the voltage at the bus. 

Desired PU Voltage 

If the bus is being regulated by one or more devices, this field will display the desired 
regulated voltage (in per unit) the devices are attempting to maintain. 

  

Fault Analysis Load Parameters 

This page of the display is only available for buses which have one or more load attached to 
the bus. The parameters on this tab are used when running a fault analysis study. The values 
represent the total load at the bus for the negative and zero sequence as equivalent 
admittances. By default, these values are zero. For load buses, these values can be changed 
by the user, or they can be specified by loading short circuit data from within the Fault 
Analysis Dialog. It is also possible to define these values as non-zero at a bus where no load 
exists in the load flow, but it is not usually desirable to do so. 
  

OPF 

This tab is only available if you have the Optimal Power Flow (OPF) add-on tool for 
PowerWorld Simulator. This tab displays the MW marginal cost (Locational Marginal Price) for 
the bus when performing an OPF solution. The page also breaks down the LMP into its cost 
components. 
  

Geography 

The Geography page of the dialog provides information on the geographic location of the bus 
on the currently active oneline diagram. 

Custom 

The Custom page of the dialog contains two sections: custom fields and memo.  

The custom fields section allows access to setting and changing the values for custom fields 
that have been defined for the bus. Defining custom fields is detailed in Custom Field 
Descriptions.  

The Memo section of the dialog is simply a location to log information about the bus. Any 
information entered in the memo box will be stored with the case when the case is saved to a 
PWB file. 



Properties of Simulator Objects 

421 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Substation Information (Run Mode) 

  

This dialog is used in the Run Mode to view and modify information associated with a 
substation record. It displays different information from the Edit Mode version of the 
substation dialog. To display it from Run Mode, first select Aggregation > Substations in 
the Model Explorer to bring up the Substation Records Display. Right-click on the substation of 
interest and choose Show Dialog. The Run Mode Substation Dialog has the following fields: 

Substation Number 

An integer identifier for the substation. You can use the spin button immediately to the right 
of this field to move to either the next substation (click the up arrow) or the previous 
substation (click the down arrow).  

Substation Name and ID 

Two alphanumeric identifiers for the substation.  

Find By Number 

To find a substation by its number, enter the number into the Substation Number field, 
then click this button. 

Find By Name 

To find a substation by its name, enter the name into the Substation Name field, then 
click this button. 

Find By Sub ID 

To find a substation by its substation ID, enter the ID into the Substation ID field, then 
click this button. 

Find… 

If the exact substation number, name and ID are not known, you can use the Find Dialog to 
search for and select a substation from a list of substations. 

Labels 

Clicking this button will open a dialog displaying the list of defined labels for the substation. 
New labels can also be added for the substation from the dialog as well. 

View All Flows at Substation 

Clicking this button will open a quick power flow display listing the buses contained in the 
substation. 

  

Information 

Load and Generation 

Real and reactive load, generation, shunts, losses, and interchange for the substation. 

Bus Voltages 

Summary information on all buses in the substation, including total number of buses, 
number of dead (disconnected) buses, and minimum and maximum bus voltage and angle 
within the substation. 

Available Gen MW/Mvar Ranges 

Total amount of generation increase or decrease available for all generators in the 
substation. 
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Buses 

The Buses table identifies the buses in the substation, and provides summary information on 
each. 
  

Gens 

The Gens table identifies the generators in the substation, and provides summary information 
on each. 
  

Loads 

The Loads table identifies the loads in the substation, and provides summary information on 
each. 
  

Switched Shunts 

The Switched Shunts table identifies the switched shunts in the substation, and provides 
summary information on each. 
  

Tie Lines 

The Tie Line Table identifies the flows on all of the substation's ties to other substation. 
  

Custom 

This page of the dialog can be used to enter notes about the substation. Any information 
entered in the memo box will be stored with the case when the case is saved to a PWB file. 
Custom fields can also be entered for storage with the substation object viewed. 

Geography 

Displays geographic information about the location of the substation, in Latitude and 
Longitude. 
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Generator Information (Run Mode) 

  

This dialog is used to view information about each generator in the system. Many fields on this 
display can also be changed (except in Viewer). Here we describe the Run Mode version of the 
Generator Information Dialog. The Edit Mode version is very similar. 
  

Bus Number 

Unique number between 1 and 99,999 used to identify the bus to which the generator is 
attached. The dropdown list enumerates all generator buses in the case that meet the 
criteria established by display filters. You may select a bus number directly from the 
dropdown list, or you may use the spin buttons to cycle through the list of generator buses.  

Bus Name 

Unique alphabetic identifier for the bus to which the generator is attached, consisting of up 
to eight characters. Use this dropdown box to view a list of all generator bus names in the 
case with valid display filters.  

ID 

Two character alphanumeric ID used to distinguish multiple generators at a bus; '1' by 
default.  

Find By Number 

To find a generator by its number and ID, enter the number into the Bus Number field and 
the ID into the ID field. Then click the Find By Number button.  

Find By Name 

To find a bus by its name and ID, enter the bus name into the Bus Name field (case 
insensitive) and the ID into the ID field. Then click the Find By Name button. 

Find… 

If you do not know the exact generator bus number or name you are looking for, you can 
click this button to open the advanced search engine. 

Status 

Status of the generator, either Closed (connected to terminal bus) or Open (not connected). 
You can use this field to change the status of the generator. 

Area Name 

Name of the area in which the generator's terminal bus is located. 

Labels 

Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases 
assigned for the selected generator. 

Same Owner as Terminal Bus 

Read-only check-box that indicates whether the generator’s owner is the same than the 
terminal bus’ owner. 

Fuel Type 

Type of fuel used by the generator this model represents. In most cases, this field is 
unnecessary for normal load flow analysis, and hence the default value is Unknown. 
However, this value can be useful during the Security Constrained OPF analysis. 

Unit Type 
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The type of unit the generator represents, such as combined cycle, steam, hydro, etc. 

  

There additional sections of generator information available from the Run Mode generator 
dialog: 

Power and Voltage Control 

Generator Cost Information 

OPF 

Fault Parameters 

Owners, Area, Zone, Sub 

Custom 
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Generator Information: Power and Voltage Control 

  

The Power Control grouping fields are used to show/change the values associated with the 
real power output of the generator.  
  

MW Output 

Current real power output of the generator. 

Minimum and Maximum MW Output 

Minimum and maximum real power output limits for the generator. Simulator will not let the 
MW output go below its minimum value or above its maximum value if the Enforce MW 
Limits option is exercised.  

Available for AGC 

Determines whether or not the generator is available for automatic generation control 
(AGC). Normally this box should be checked. However, there are times when you would like 
to control the generator output manually (such as if you are using the generator to remove 
a line limit violation), in which case you should leave this box unchecked. A generator is also 
placed on "manual" control any time you manually change its output. You could then place 
the generator back on AGC control by using this dialog.  

Enforce MW Limits 

If checked, the minimum and maximum MW limits are enforced for the generator, provided 
the Enforce Generator MW Limits field is also checked on the Limits Tab of the Simulator 
Options Dialog . If this box is checked and a generator is violating a real power limit, the 
generator's MW output is immediately changed.  

Participation Factor 

The participation factor is used to determine how the real power output of the generator 
changes in response to demand when the generator is available for AGC and the area is on 
participation factor control. When you open a case using the PTI Raw Data Format, this field 
is initialized to the per unit MVA rating of the generator, since participation factor 
information is not stored in the PTI format.  

Loss Sensitivity 

Shows how the losses for an area will change for an incremental increase in the generation 
at the bus. This information is useful in determining the economic dispatch for the 
generation. The implicit assumption in calculating this field's value is that the incremental 
change in generation will be absorbed by the system "slack bus." This field cannot be 
changed.  

  

The Voltage Control grouping is used to show/change values associated with controlling the 
voltage/reactive power output of the generator.  
  

Mvar Output 

Current reactive power output of the generator. You can manually change this value only if 
Available for  AVR is not checked.  

Min and Max Mvar Output 

Specify the minimum and maximum allowable reactive power output of the generator.  
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Available for AVR 

Designates whether or not the generator is available for automatic voltage regulation (AVR). 
When the AVR field is checked, the generator will automatically change its reactive power 
output to maintain the desired terminal voltage within the specified reactive power range. If 
a reactive limit is reached, the generator will no longer be able to maintain its voltage at the 
setpoint value, and its reactive power will then be held constant at the limit value.  

Use Capability Curve 

If checked, the generator's reactive power limits are specified using a reactive capability 
curve that prescribes the dependence of the generator's reactive power limits on its real 
power output. Otherwise, the fixed values given in the Min Mvar Output and Max Mvar 
Output fields are used. The generator reactive capability can be defined using the table 
that appears at the bottom of the dialog. Please see Generator Reactive Power Capability 
Curve for details.  

Regulated Bus Number 

Number of the bus whose voltage the generator is regulating. This is usually, but not 
always, the generator's terminal bus. Multiple generators can regulate the same remote bus, 
but the regulated bus must not be another generator bus. If the generator is at a slack bus, 
it must regulate its own terminal voltage. Select Solution Details > Remotely Regulated 
Buses from the Model Explorer to view the Remotely Regulated Bus Records Dialog , which 
identifies all buses that are being remotely regulated. 

Desired Reg. Bus Voltage 

Specifies the desired per unit voltage for the generator at the regulated bus. The regulated 
bus need not be the terminal bus of the generator. 

Actual Reg. Bus Voltage 

Shows the actual per unit voltage at the regulated bus. If the generator is on AVR and has 
not reached a reactive power limit, the actual regulated bus voltage should be equal to the 
desired regulated bus voltage. This field cannot be changed.  

Remote Reg % 

This field is only used when a number of generators at different buses are regulating a 
remote bus (i.e., not their terminal buses). This field then specifies the percentage of the 
total reactive power required by the remote bus to maintain its voltage that should be 
supplied by this generator. The default value is 100.  
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Generator Options: Costs 

  

The Costs tab of the Generator Information dialog (run mode) is used to show/change values 
associated with the cost of operation of the generator. See Generator Cost Information for 
details. Cost data can also be saved/loaded using the Generator Cost Data files.  
  

Output Cost Model 

Cost Model 

Simulator can model generators as not having a cost model, or having either a cubic cost 
model or a piecewise linear model. The cost model type you choose determines the content 
of the remainder of this dialog  

Unit Fuel Cost 

The cost of fuel in $/MBtu. This value can be specified only when you have chosen to use a 
cubic cost model. 

Variable O&M 

The Operations and Maintenance costs. Only used for cubic cost models. 

Fixed Costs (costs at zero MW Output) 

The fixed costs associated with operating the unit. These costs are independent of the 
generator's MW output level and is added to the cost prescribed by the cubic or piecewise 
linear model to obtain the total cost of operating the generator in $/MWHr. The total fixed 
cost is the addition of the fuel cost independent value and the fuel cost dependent value 
multiplied by unit fuel cost. 

Cubic Cost Coefficients A, B, C, D 

For cubic cost models of the form C(Pgi) = (d*Pgi^3 + c*Pgi^2 + b*Pgi ) * (fuel cost) + 
fixed costs (as described above), specify the cost curve's coefficients. The A coefficient is 
historically the fuel cost dependent fixed cost value, which is combined separately now with 
the fuel cost independent value. These coefficients can be specified only when you have 
chosen to use a cubic cost model. 

Piecewise Linear Table 

If you have chosen to use a piecewise linear cost model, a table appears that allows you to 
specify pairs of MW output levels and corresponding generator operating costs. To insert a 
new point on the cost curve, right-click on the table and choose Insert New Point from the 
resulting local menu. To delete an existing point from the cost curve, right-click on the table 
and choose Delete Point from the resulting local menu. To edit an existing point in the table, 
simply enter your changes to the appropriate cells. 

Convert Cubic Cost to Linear 

Use this option to create a piecewise linear cost function from the cubic cost function 
specified by the coefficients A, B, C, and D and the fuel cost. Specify the number of break 
points, and hence the number of segments, in the Number of Break Points field. Click the 
Convert to Linear Cost button to create the piecewise linear function that approximates 
the cubic cost function. This action switches Cost Model option to Piecewise Linear and 
displays the Piecewise Linear Table that identifies the piecewise linear curve’s 
breakpoints. 

Bid Scale / Shift 

Cost Shift, Cost Multiplier  
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The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Marginal Cost (run mode only)  

Shows the marginal cost of producing real power at the generator at its current output level, 
dCi(Pgi)/dPgi. 

ED/OPF Cost (run mode only) 

This is the cost of production for this generator following an economic dispatch or optimal 
power flow solution, including the scaling from the cost shift and cost multiplier fields. 

Unscaled Cost (run mode only) 

The cost of production of the generator, ignoring the cost multiplier and cost shift. This cost 
is the result of the original cost function by itself. 
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Generator Information: OPF 

  

The fields on this tab display information regarding the generator’s participation in an OPF 
load flow solution. 
  

OPF MW Control 

The type of control the generator is allowed during an OPF solution. The generator can be 
set to No control during OPF, control only if its AGC property is set to Yes, or to always be 
controlled by the OPF regardless of the AGC status of the generator. 

Fast Start Generator 

The generator is being treated as a fast start generator during the OPF solution. 

Generator MW limits 

The MW limits of a generator can be altered in this location if you wish for the generator to 
use different limits than originally assigned in the load flow case, without actually changing 
the original values. Simply change the Current Min MW Limit and Current Max MW Limit to 
alter the limits observed by the generator during and OPF solution. 

MW Marginal Cost for Generator’s Bus 

The OPF solved marginal cost at the generator’s terminal bus. 

Initial, Final and Delta MW Output 

The MW output information for the generator resulting from the OPF run. 

Initial, Final and Delta Hourly Cost 

The hourly cost information for the generator resulting from the OPF run. 

OPF Results 

This section shows the results of OPF for the generator. 
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Generator Options: Owners, Area, Zone, Sub 

  

This information is located on the Generator Information Dialog. 

This tab is used to display or change the generator’s owner information, area information, 
zone information, and substation information. 
  

Same Owner as Terminal Bus 

Read-only check-box that indicates whether the generator’s owner is the same than the 
terminal buses’ owner. 

Owners 

Currently, Simulator supports up to four owners for generators. To add an owner of a 
generator, change one of the Owner fields to a new owner number, and update the owner 
percentages accordingly. To modify an owner's percentage of ownership, simply modify the 
value in the percentage field for that owner. If you set the percentage of an owner to 0, that 
owner will be removed from the list of owners for the device. You can also remove an owner 
from owning part of a device by changing the owner field for that owner to 0. Note that if 
you do not set the new owner percentages of all specified owners such that the total is 
100%, Simulator will normalize the percentages such that the total is 100% when you click 
Save or OK on the generator dialog. 

Area Number, Area Name 

The area number and name to which the generator belongs. Note that you can change the 
area of the generator to be different than the area of the terminal bus. If you do so, you will 
be prompted to confirm that you wish to place the generator within a different area than 
that of the bus to which it is electrically connected. 

Zone Number, Zone Name 

The zone number and name to which the generator belongs. Note that you can change the 
zone of the generator to be different than the zone of the terminal bus. If you do so, you 
will be prompted to confirm that you wish to place the generator within a different zone 
than that of the bus to which it is electrically connected. 

Substation Number, Substation Name 

The name and number of the substation to which the generator belongs, and it is the same 
than that of the terminal bus. 
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Load Information (Run Mode) 

  

The Load Information Dialog can be used to inspect and modify the model of a bus load. To 
view the Load Information Dialog, select the load and choose Show Dialog from the case 
information toolbar or right-click on the load of interest and select Load Information Dialog 
from the resulting local menu. This is very similar to its Edit Mode counterpart. The dialog has 
the following fields: 
  

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus to which the load is attached. The dropdown box provides a list of all load buses with 
valid display filters. You can use the spin button to cycle through the list of load buses.  

Bus Name 

Unique alphabetic identifier for the bus to which the load is attached, consisting of up to 
eight characters. The dropdown box lists the names of all load buses in the case with valid 
display filters.  

ID 

Two-character ID used to distinguish multiple loads at a bus. By default, the load id is equal 
to "1 ." An identifier of '99' is used to indicate an equivalent load.  

Find By Number 

To find a load by its number and ID, enter the number into the Bus Number field and the ID 
into the ID field. Then click this button. 

Find By Name 

To find a load by its name and ID, enter the bus name into the Bus Name field (case 
insensitive) and the ID into the ID field. Then click this button. 

Find… 

If you do not know the exact load bus number or name you are looking for, you can click 
this button to open the advanced search engine. 

Status 

Status of the load, either Closed (connected to terminal bus) or Open (not connected). You 
can use this status field to change the load's status.  

Labels 

Clicking on this button will open the Label Manager dialog listing all the labels assigned for 
the selected load. 

Area Number, Area Name 

Number and name of the area the load is a member of. 

Zone Number, Zone Name 

Number and name of the zone the load is a member of. 

Owner Number, Owner Name 

Number and name of the owner the load is a member of. Loads DO NOT have to be owned 
by the same owner as the terminal bus. 

Substation Number, Substation Name 
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Number and name of the substation the load is a member of. 

  
 Load Information  

Base Load Model, Current Load 

The Base Load Model fields are used to represent the amount of base real and reactive load 
at the bus. Usually this load is modeled as being "constant power," meaning that the 
amount of load is independent of the bus voltage magnitude. However, Simulator also 
permits modeling "constant current" load, for which the load varies in proportion to the bus 
voltage magnitude, and "constant impedance" load, for which the load varies in proportion 
to the square of the bus voltage magnitude. Values in these fields are specified in MW and 
MVR assuming one per unit voltage. All six fields in the Base Load Model section can be 
changed. 

Load Multiplier 

The actual load at the bus is equal to the base value multiplied by the corresponding load 
multiplier. The load multiplier is a value specifying how the load is scaled. The load multiplier 
depends upon the area load multiplier and the zone load multiplier. See Load Modeling for 
more details. The load multiplier value cannot be changed on this dialog.  

Bus Voltage Magnitude 

Voltage magnitude of the load’s terminal bus. 

  
 OPF Load Dispatch  

The information on this tab displays the load information resulting from the load’s participation 
in an OPF solution 

Benefit Model 

If this field is set to none, the load will not be dispatchable in the OPF solution. If the option 
is set to Piecewise Linear, the load is dispatchable during the OPF, according to the following 
fields. 

Min. and Max. MW Demand 

The minimum and maximum MW demand the load must operate within during the OPF 
solution. 

Available for AGC 

The load is only available for redispatch during the OPF solution if this option is checked. 

Fixed Benefit 

Value of the load benefit at minimum demand. 

Piece-wise Linear Benefit Curve 

This table the MW demand levels and their corresponding load benefit values, which in turn 
define the starting points and slopes of the piece-wise linear benefit curve segments. 

  

Custom 

The Custom page of the dialog contains two sections: custom fields and memo.  

The custom fields section allows access to setting and changing the values for custom fields 
that have been defined for the load. Defining custom fields is detailed in Custom Field 
Descriptions.  
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The Memo section of the dialog is simply a location to log information about the load. Any 
information entered in the memo box will be stored with the case when the case is saved to a 
PWB file. 
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Line/Transformer Information (Run Mode) 

  

The Line/Transformer Information dialog box is used to view information about each 
transmission line and transformer in the system. You may use this dialog also to change many 
of the properties of lines and transformers (except in Viewer). 

The Run Mode version of this dialog is very similar in content to its Edit Mode counterpart. 
  

The Line/Transformer dialog sports the following fields: 

From Bus Number and Name 

From Bus number and name. For transformers, the from bus is the tapped side.  

To Bus Number and Name 

To Bus number and name.  

Circuit 

Two-character identifier used to distinguish between multiple lines joining the same two 
buses. Default is '1'.  

Find By Number 

To find a line or transformer by its bus numbers, enter the from and to bus numbers and 
the circuit identifier. Then click this button. Use the spin button to cycle through the list of 
lines and transformers in the system. 

Find By Name 

To find a line or transformer by the names of its terminal buses, enter the from and to bus 
names and the circuit identifier. Then click this button. 

Find… 

If you do not know the exact from and to bus numbers or names you are looking for, you 
can click this button to open the advanced search engine. 

From End Metered 

This field is only used for lines and transformers that serve as tie lines, which are lines that 
join two areas. If this field is checked for a tie line, then the from end of the device is 
designated as the metered end. Otherwise the to end is metered. By default, the from end is 
metered. The location of the metered end is important in dealing with energy transactions 
because it determines which party must account for transmission losses. 

From and To Bus Area Name 

Names of the areas in which the From and To buses are located. 

From and To Bus Nominal kV 

From and To bus nominal voltage levels. 

From and To Bus Voltage (p.u.) 

The actual terminal bus voltages of the transmission element, in per unit. 

Labels 

Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases 
assigned for the selected branch. 
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Parameters 

Status 

Current status of the device.  

Per Unit Impedance Parameters 

The resistance, reactance, the total charging susceptance (that is, B, not B/2), and the total 
shunt conductance of the device (in per unit).  

Line Shunts  

Select to view the Line Shunt Dialog. This dialog is used to only view the values of the line 
shunts in Run Mode. Line shunts are expressed in terms of the per-unit conductance and 
susceptance at each end of the line or transformer. If the line has shunts, the check box 
Has Line Shunts is checked. 

MVA Limits 

Ratings for the transmission line or transformer in MVA. Simulator allows the use of up to 
eight different limits. 

Flows 

These next fields show the actual real and reactive power flow at both ends of the device 
(because of real and reactive losses these numbers may be different), and its percentage 
MVA loading. 

  

Transformer Info 

This fields on this tab are enabled only if the branch is a transformer. See the Transformer 
Modeling help for more information on transformer types and controls.  

Off-nominal Turns Ratio 

The off-nominal tap ratio for the transformer. 

Phase Shift Degrees 

Phase angle for the transformer. This field is usually non-zero only for phase shifting 
transformers or wye-delta and delta-wye connected transformers, but can be non-zero for 
an LTC or fixed transformer on rare occasions. 

Automatic Control Enabled 

Check this box to enable automatic control of the transformer. Note that automatic control 
will be implemented only if (1) transformer control has been enabled for the transformer's 
area (see Area Display for details) and (2) transformer control has not been disabled for the 
entire case (via the Disable Transformer Control option on the Power Flow Solution tab of 
the Simulator Options Dialog). The Line/Transformer Dialog gives you convenient access to 
these control options through the Case Control Enabled and Area Transformer Control 
Enabled check boxes. 

Automatic Control Type 

Depending on the type of control of the transformer, the Change Automatic Control 
Options button will open up the control options for LTC Control, MVAR Control, or Phase 
Shifter Control. 

Area and Case Control Options 

All these boxes must be checked for a transformer to be controlled. Area Transformer 
Control Enabled has to be checked for any transformer in that area to be controlled; Case 
LTC Transformer Control Enabled has to be checked for any transformer in the entire 
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case to be controlled, and Case Phase Shifter Control Enabled has to be checked for 
any phase shifter in the entire case to be controlled. Checking these does NOT automatically 
make the entire area or entire case on control. 

  

Series Capacitor 

The parameters on this tab are enabled when the selected branch is a series capacitor. If the 
branch is a series capacitor, the Is Series Capacitor box will be checked. In addition, the 
Status field for series capacitors will be enabled, allowing you to change the Bypassed or In 
Service status of the series capacitor. The series capacitor status IS NOT the same as the 
branch status of Open or Closed. 
  

OPF 

The OPF tab is only visible if you have the OPF (Optimal Power Flow) add-on tool for 
PowerWorld Simulator. 

Enforce Line Flow Limit 

This check box must be checked if the branch limit is going to be enforced when running an 
OPF solution. If this box is not checked, the OPF routine will allow the branch to violate its 
branch limits. 

Treat Limit as Equality Constraint 

If checked, the OPF solution will attempt to solve the load flow while keeping the flow on 
the branch at its limit. 

Maximum MVA Flow 

The largest MVA flow value measured on the line, either at the From or To bus. 

Present MVA Limit 

The limit enforced by the OPF for the branch. This is set in the OPF constraint options, and 
is related to the original branch limits. 

Maximum Percentage 

The highest percentage of flow measured on the line, either at the From or To bus. 

Limit Marginal Cost 

The cost of enforcing the branch MVA limit. 

Included in LP 

Specifies whether or not the branch flow and limit was included as a constraint in the OPF 
solution. In general, branches that are not near their limit and do not appear to be changing 
flow dramatically towards their limit will be ignored in the OPF calculation to speed up the 
solution. No and Yes indicate whether or not the OPF process determined that the line 
needed to be included. The user can initially force the branch to be included or not included 
with these two fields. By choosing Always, the branch will be included in the OPF solution 
constraints regardless of the propensity of the line to be approaching it's limit. 

MVA Flow Constraint Status 

The constraint status for the line in the OPF solution will be shown here with the 
corresponding boxes checked by Simulator. These check boxes cannot be changed manually 
by the user. 

From/To Bus MW Marginal Costs 
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Displays the marginal costs of the branches terminal buses, following the solution of the 
OPF. 

  

Fault Info 

The parameters on this tab are used when running a fault analysis study. The values represent 
the zero sequence impedance and zero sequence line shunt admittances for the analysis. By 
default, the positive and negative sequence line impedances and line shunt admittances are 
the same as the load flow impedance. The same fields are used for transformers, along with 
the configuration field. The configuration field defines the winding type combinations for the 
transformer (wye, delta, etc.) As a default, Simulator assumes a grounded wye to grounded 
wye transformer, which has the same model as a transmission line. Usually transformers are 
not of this type, and the proper type would need to be defined either manually or loaded from 
an external file in order for the fault analysis to be accurate. 
  

Owner, Area, Zone, Sub, PTDF 

The Default Owner (Same as From Bus) read-only check-box indicates whether the line’s 
owner is the same than the from bus’ owner. Transmission elements can have up to four 
different owners, each with a certain owner percentage. To add an owner of a transmission 
element, change one of the Owner fields to a new owner number, and update the owner 
percentages accordingly. Note that if you do not set the new owner percentages of all 
specified owners such that the total is 100%, Simulator will normalize the percentages such 
that the total is 100% when you click Save or OK on the line/transformer dialog. 

The area, zone and substation to which the From and To buses belong, are also shown. If a 
PTDF calculation has been performed, the PTDF values for the viewed line will be displayed as 
well. 

  

Custom 

This page of the dialog can be used to enter notes about the transmission line. Any 
information entered in the memo box will be stored with the case when the case is saved to a 
PWB file. You can also enter custom strings and values that are also stored with the case. 
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Transformer AVR Dialog 

  

The Transformer AVR Dialog is used to view the control parameters associated with load-tap-
changing (LTC) transformers when they are used to control bus voltage magnitudes. To view 
this display, click the Automatic Control Options button on the Line/Transformer Information 
Dialog. 
  

This dialog has the following fields: 

Automatic Control Type 

This section is only visible on the dialog in edit mode. The control type of the transformer 
can be changed between no control, voltage regulation, reactive power control, or phase 
shifter control. 

Regulated Bus Number 

The number of the bus whose voltage is regulated by the control. 

Present Regulated Bus Voltage 

The present voltage of the regulated bus. 

Voltage Error 

If the regulated bus' voltage falls outside the regulating range of the transformer (as defined 
by the Minimum Voltage and Maximum Voltage fields), the Voltage Error field indicates by 
how much the voltage deviates from the control range. 

Regulation Minimum Voltage 

The minimum acceptable voltage at the regulated bus. 

Regulation Maximum Voltage 

The maximum acceptable voltage at the regulated bus. 

Regulation Target Type 

As long as the regulated voltage is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated voltage moves outside of this 
regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated voltage back inside of its range. The Regulation Target Type determines what 
value is used as a target when calculating this change in tap ratio. Middle is the default and 
means that the target is the average of the regulation minimum and maximum regardless of 
whether the voltage is high or low. Max/Min means that the regulation maximum is used 
as the target when the regulated voltage is above the maximum, and regulation minimum is 
used as the target value when the regulated voltage is below the minimum. 

Present Tap Ratio 

The tap ratio of the transformer for the current system state. 

Minimum Tap Ratio, Maximum Tap Ratio 

Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical 
values are 0.9 and 1.1.  

Tap Step Size 

Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either 
incremented or decremented from 1.0 in integer multiples of this value. Default value is 
0.00625.  



Properties of Simulator Objects 

439 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Voltage to Tap Sensitivity 

Shows the sensitivity of the voltage magnitude at the regulated bus to a change in the 
transformer's tap ratio. You can use this field to assess whether or not the transformer can 
effectively control the regulated bus voltage. In an ideal case, such as when the LTC 
transformer is being used to control the voltage at a radial load bus, the sensitivity is close 
to 1.0 (or -1.0 depending upon whether the tapped side of the transformer is on the load 
side or opposite side of the transformer). However, sometimes the transformer is very 
ineffective in controlling the voltage. This is indicated by the absolute value of the sensitivity 
approaching 0. A common example is a generator step-up transformer trying to control its 
high-side voltage when the generator is off-line. Simulator automatically disables 
transformer control if the transformer sensitivity is below the value specified on Power Flow 
Solution Tab of the Simulator Options dialog.  

Impedance Correction Table 

This field specifies the number of the transformer's corresponding transformer impedance 
correction table. Transformer impedance correction tables are used to specify how the 
impedance of the transformer should change with the off-nominal turns ratio. If this number 
is 0, then no impedance correction table is associated with the transformer, and the 
impedance of the transformer will thus remain fixed as the tap ratio changes. Valid 
impedance correction table numbers range from 1 to 63. To assign an existing impedance 
correction table to the transformer, enter the existing table's number. To view the existing 
impedance correction tables, click the Insert/View Impedance Correction Table button, 
which brings up the Transformer Impedance Correction Dialog. To define a brand new 
impedance correction table for the transformer, enter an unused table number and then 
click Insert/View Impedance Correction Table to prescribe the correction table. Note that the 
association between a transformer and an impedance correction table is not finalized until 
you select either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transformer Mvar Control Dialog 

  

The Transformer Mvar Control dialog is used to view the control parameters associated with 
load-tap-changing (LTC) transformers that are used to control the Mvar flow through the 
transformer. To view this display, click on the Automatic Control Options button on the 
Line/Transformer Information Dialog.  

When used to control reactive power, the LTC transformer always controls the reactive power 
flow at the from end of the transformer (i.e., the tapped side), with positive flow assumed to 
be going through the transformer to the to bus. Therefore the regulated bus field is not used.  
  

The dialog has the following fields: 

Mvar Flow at From Bus 

The current Mvar flow as measured at the from end of the line. This is the parameter the 
transformer tries to control. 

Mvar Error 

If the Mvar flow at the from end violates the limits defined by the Minimum Mvar Flow and 
Maximum Mvar Flow fields, the Mvar Error field indicates by how much the flow falls outside 
the control range.  

Regulation Minimum Mvar Flow, Regulation Maximum Mvar Flow 

Minimum and maximum allowable reactive power flow as measured at the from  bus. The 
transformer attempts to regulate the reactive flow to fall within this range. 

Regulation Target Type 

As long as the regulated Mvar flow is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated Mvar flow moves outside of 
this regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated Mvar flow back inside of its range. The Regulation Target Type determines 
what value is used as a target when calculating this change in tap ratio. Middle is the 
default and means that the target is the average of the regulation minimum and maximum 
regardless of whether the Mvar flow is high or low. Max/Min means that the regulation 
maximum is used as the target when the regulated Mvar flow is above the maximum, and 
regulation minimum is used as the target value when the regulated Mvar flow is below the 
minimum. 

Present Tap Ratio 

The transformer's present off-nominal turns ratio.  

Minimum Tap Ratio, Maximum Tap Ratio 

Minimum and maximum allowable off-nominal tap ratios for the LTC transformer. Typical 
values are 0.9 and 1.1.  

Tap Step Size 

Transformer off-nominal turns ratio increment. The off-nominal turns ratio is either 
incremented or decremented from 1.0 in integer multiples of this value. Default value is 
0.00625.  

Mvar to Tap Sensitivity 

The amount of Mvar shift that would be implemented by switching one tap position from the 
current position. This sensitivity indicates the ability of the transformer to control Mvars. 

Impedance Correction Table 
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Specifies the number of the transformer's corresponding transformer impedance correction 
table. Transformer impedance correction tables are used to specify how the impedance of 
the transformer should change with the off-nominal turns ratio. If this number is 0, no 
impedance correction table is associated with the transformer, and the impedance of the 
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table 
numbers range from 1 to 63. To assign an existing impedance correction table to the 
transformer, enter the existing table's number. To view the existing impedance correction 
tables, click the Insert/View Impedance Correction Table button, which brings up the 
Transformer Impedance Correction Dialog. To define a brand new impedance correction 
table for the transformer, enter an unused table number and then click Insert/View 
Impedance Correction Table to prescribe the correction table. Note that the association 
between a transformer and an impedance correction table is not finalized until you select 
either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transformer Phase Shifting Information 

  

The Transformer Phase Shifting Dialog is used to view the control parameters of phase-
shifting transformers. To view this display, click on the Automatic Control Options button 
on the Line/Transformer Information Dialog, provided that the Phase Shift Control option is 
chosen from the Automatic Control group. 
  

Regulated Bus Number 

Number of the terminal bus of the phase shifter regulated by the phase shifter. When 
control is active, the phase shifter will automatically change its phase shift to keep the MW 
flow at this bus at the desired value. 

Current MW Flow  

Current MW flow through the transformer measured at the regulated bus terminal.  

MW Error 

If the current MW flow falls outside the minimum/maximum MW flow limits, the MW Error 
field indicates by how much the flow violates the regulating range. 

Regulation Minimum MW Flow, Regulation Maximum MW Flow 

Minimum and maximum allowable MW flow through the phase shifter. 

Regulation Target Type 

As long as the regulated MW flow is inside the regulation minimum and maximum, then the 
transformer will not change its tap ratio. When the regulated MW flow moves outside of this 
regulation range, then Simulator will calculate a new tap ratio in an attempt to bring the 
regulated MW flow back inside of its range. The Regulation Target Type determines what 
value is used as a target when calculating this change in tap ratio. Middle is the default and 
means that the target is the average of the regulation minimum and maximum regardless of 
whether the MW flow is high or low. Max/Min means that the regulation maximum is used 
as the target when the regulated MW flow is above the maximum, and regulation minimum 
is used as the target value when the regulated MW flow is below the minimum. 

Present Phase Angle (Degrees) 

The phase angle of the transformer for the current solved system state.  

Minimum Phase Angle, Maximum Phase Angle 

Minimum and maximum allowable phase shift in degrees.  

Step Size (Degrees) 

Phase shift change per step in degrees. 

MW Flow to Phase Sensitivity 

The sensitivity of the controlled MW flow to changes in the transformer's phase. This 
sensitivity indicates the transformer's ability to regulate its MW flow. 

Impedance Correction Table 

Specifies the number of the transformer's corresponding transformer impedance correction 
table. Transformer impedance correction tables are used to specify how the impedance of 
the transformer should change with the off-nominal turns ratio. If this number is 0, no 
impedance correction table is associated with the transformer, and the impedance of the 
transformer will thus remain fixed as the tap ratio changes. Valid impedance correction table 
numbers range from 1 to 63. To assign an existing impedance correction table to the 
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transformer, enter the existing table's number. To view the existing impedance correction 
tables, click the Insert/View Impedance Correction Table button, which brings up the 
Transformer Impedance Correction Dialog. To define a brand new impedance correction 
table for the transformer, enter an unused table number and then click Insert/View 
Impedance Correction Table to prescribe the correction table. Note that the association 
between a transformer and an impedance correction table is not finalized until you select 
either OK or Save on the Line/Transformer Dialog. 

View Transformer Correction Table or Insert Transformer Correction Table 

Click on this button either to view or to insert transformer correction tables. Clicking on this 
button displays the Transformer Impedance Correction Dialog. Note that the table must 
prescribe at least two points in order to be defined. 
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Transformer Impedance Correction Tables Dialog 

  

The Transformer Correction Tables Dialog is used to view information about the transformer 
impedance correction tables. These tables are used on some LTC or phase shifting 
transformers to model the impedance of the transformer as a function of the off-nominal turns 
ratio or phase shift. The dialog has the following fields: 
  

Transformer Impedance Correction Table Number 

Number of the impedance correction table, between 1 and 63. Use the spin button 
immediately to the right of this field to step through the list of defined tables. If you have 
made changes to a particular table, you must click Save before moving to another correction 
table; otherwise, your changes will be lost. 

Table Name 

The name assigned to the table. 

Table Entries 

Used to insert/edit/delete the actual entries in the impedance correction table. In the first 
row, enter either an off-nominal turns ratio for an LTC transformer, or a phase shift in 
degrees for a phase shifting transformer. The entries in the first row must be entered in 
strictly ascending form. In the second row, enter the scale factor to apply to the transformer 
impedance. The transformer's nominal impedance is multiplied by the scale factor to obtain 
the actual value. Note that at least two columns must be used. 

Right-click on the table to invoke its local menu, which allows you to delete and to insert 
columns. To insert a new column, click on the column before which you want to insert a 
new column and select Insert New Point from the local menu. To delete a column, 
position the cursor on the column you want to delete and select Delete Point.  

Table is Used by the Following Transformers 

Lists all the transformers in the case that use this impedance correction table. A single table 
may be used by any number of transformers. To associate a table with a transformer, use 
the Transformer AVR Dialog for LTC transformers or the Transformer Phase Shifting Dialog 
for phase shifters.  

 



Properties of Simulator Objects 

445 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Switched Shunt Information (Run Mode) 

  

The Switched Shunt Information Dialog box can be displayed by placing the cursor on its 
symbol and right-clicking. This is very similar to its Edit Mode counterpart. The dialog has the 
following fields: 
  

Bus Number 

Unique number between 1 and 2,147,483,647 (equals 2^31 minus 1) used to identify the 
bus to which the switched shunt is attached. This drop down list identifies the buses in the 
case with switched shunts that also have valid display filters. Use the spin button to step 
through the list of shunts in the case. Note that only one switched shunt is allowed at each 
bus.  

Find By Number 

To find a switched shunt by its bus number, enter the number into the Bus Number field. 
Then click the Find By Number button.  

Bus Name 

Unique alphabetic identifier for the bus to which the switched shunt is attached, consisting 
of up to eight characters. This dropdown box lists the names of all the switched shunt buses 
in the case with valid display filters.  

Find By Name 

To find a switched shunt by its name, enter the bus name into the Bus Name field (case 
insensitive). Then click the Find By Name button. 

Shunt ID 

Since multiple switched shunts are allowed on a single bus, each shunt is identified by a 
unique ShuntID. 

Find… 

If you do not know the exact switched shunt bus number or name you are looking for, you 
can click this button to open the advanced search engine. 

Status 

Status of the switched shunt, either Closed (connected to terminal bus) or Open (not 
connected). On the oneline, the switched shunt can be opened by placing the cursor on the 
(red) circuit breaker box and clicking, and it can be closed by placing the cursor on the 
(green) box and again clicking. You can also use this status field to change the switched 
shunt's status. Note that the switched shunt is only available for automatic control when its 
status is closed.  

Labels 

Clicking on this button will open the Subscribed Aliases dialog listing all the labels or aliases 
assigned for the selected load. 

  

Parameters 

Nominal Mvar 

Amount of reactive power that would be supplied by the switched shunt if its terminal 
voltage were one per unit (capacitive is positive). 

Actual Mvar 
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Actual reactive power in Mvar being injected into the system by the switched shunt 
(capacitive is positive). The Actual Mvar field is equal to the Nominal Mvar field multiplied by 
the square of the terminal buses per unit voltage.  

Nominal MW 

This field is only visible when a switched shunt object has been read from a file as a Bus 
Shunt. In that case, it is possible for the bus shunt to have both a MW and MVAR 
component. The MW component will be displayed here. In general, switched shunts of other 
control types do not have MW components, and this field will not be displayed. If you 
change a switched shunt read as a bus shunt to another form of control, the MW component 
will remain, but has no controllability. 

Actual MW 

This field is only visible when a switched shunt object has been read from a file as a Bus 
Shunt. The value displayed is the actual real power in MW being injected into the system by 
the shunt. The Actual MW field is equal to the Nominal MVAR field multiplied by the square 
of the terminal buses per unit voltage. 

Control Mode 

Determines whether the switched shunt has a fixed value, or whether the amount of 
reactive power supplied by the device changes either in discrete steps or continuously in 
order to maintain its terminal voltage within the voltage range specified in the Voltage 
Regulation fields. This field can be changed (except in Viewer). However, for a switched 
shunt to be used for automatic control, three fields must be set correctly:  

1. The Control Mode field must be set to either Discrete or Continuous 
2. The corresponding area's Auto Shunts property must be true, and  
3. The case-wide Disable Switched Shunt Control option, which can be set on the Power 

Flow Solution Tab of the Simulator Options Dialog, must not be checked. 

Note: automatic control of switched shunts is disabled if the voltage regulation 
high value is not greater than the low value; they should not be equal unless in 
the continuous mode.  

Note the additional control mode called Bus Shunt (Fixed). This is analogous to the shunt 
MW and MVAR values that can also be stored at the bus level. The difference is that bus 
shunts stored directly with the bus cannot be turned on and off in the load flow; rather they 
are always included in the load flow solution. Bus shunts that are represented as switched 
shunt objects on Bus Shunt control, however, are mathematically exactly the same and can 
be turned on or off. The reason for the differentiation of the Bus Shunt versus normal Fixed 
control is that the Bus Shunt control type is intended to identify the difference between a 
bus shunt and a transformer that MAY have controllability, but is currently turned of off 
control by being set to a Fixed value.  

Control Regulation Settings 

Voltage Regulation 
When the switched shunt is on automatic control, its reactive power is changed in 
discrete steps or continuously to keep the voltage at the regulated bus within the per 
unit voltage range defined by High Value and the Low Value.  

In the case of discrete control, the amount of reactive power supplied by this device 
changes in discrete amounts, thus the High Value should be greater than the low value. 
The necessary voltage range depends upon the size of the switched shunt blocks. In 
addition to a voltage range for discrete control, a specific Target Voltage can be 
specified as well. The target voltage will try to be met, either approximately under 
discrete control, or exactly under continuous control (either true continuous or discrete 
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with a continuous shunt correction element.) The number of the regulated bus is shown 
in the Reg. Bus # field. 

Generator Mvar Regulation 

This option allows switched shunts to control generator Mvar output to better enable full 
var range inside the inner power flow loop. During the first inner power flow loop, 
generator var limit checking is disabled for generators whose Mvar output is controlled 
by switched shunts. This will enable the use of the full reactive range of the switched 
shunts before generators hit their reactive limits. This corrects a problem in which the 
power flow fails to solve because generators are at their Mvar limits even though there is 
still reactive support available from switched shunts. 

Switched Shunt Blocks 

The amount of shunt reactive power (susceptance) is specified in the Switched Shunt Block 
field. The columns in this field correspond to different blocks of reactive power. The first row 
indicates the number of steps in each block, and the second row gives the amount of 
nominal Mvars per step (assuming 1.0 per unit voltage). You may model both capacitors and 
reactors. The reactors should be specified first, in the order in which they are switched in, 
followed by the capacitors, again in the order they are switched in. The sign convention is 
such that capacitors are positive and reactors negative. Shunt blocks are switched in order 
from left to right. 

  

Control Options 

Single Largest Step 

This option only applies when a switched shunt is set on discrete control. If checked the 
switched shunt will switch in EITHER all of the available reactor blocks OR all of the 
capacitor blocks at once when the voltage falls outside the given range. Whether the reactor 
or capacitor blocks switch is determined by which limit is violated. A switched shunt with this 
option checked will only switch ONCE during a load flow solution, and then remains fixed at 
the new output for the remainder of the same solution calculation. 

Allow switching in the inner power flow loop 

This option is available for individual discrete shunts only. If this option is set, discrete 
shunts are treated as continuous in the inner power flow loop. This means that they are 
treated as PV buses in the inner power flow loop. After the first inner power flow loop, the 
shunt nominal Mvar setting is rounded to positive infinity to the next discrete step. If any 
shunts exist that are allowed to switch in the inner power flow loop, the inner power flow 
loop is repeated again with the shunts being treated as discrete in the subsequent inner 
power flow loop. Shunts that are allowed to switch in the inner power flow loop will only 
switch if the global option to "Disable Treating Continuous SSs as PV Buses" is not checked. 

Use Continuous Element 

If this option is checked, then Simulator will use a continuous element to fine-tune a discrete 
controlled switched shunt by injecting or absorbing additional MVARs to try and obtain the 
target voltage of the controlled bus. 

Minimum and Maximum Susceptance 

The minimum and maximum susceptance range for the continuous correction element. 

Use High Target Voltage  

Check this box to use the target voltage specified in the High Target Value edit box when 
the regulated point goes above the High limit. This will give a different target value if the 
voltage goes out of range on the high end than the low end. If the voltage goes out of 
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range on the low end, the original target value on the Parameters page will be used. If this 
box is unchecked, only the target value on the parameters page will be used, whether the 
violation is high or low. 

  

Fault Information 

Typically switched shunts are treated as open circuits in the zero sequence data for fault 
analysis. However, it is possible to define zero sequence admittance blocks to be used. The 
blocks work similarly to the load flow Switched Shunt Blocks discussed above. Usually there 
will be the same number of blocks in the zero sequence data as in the load flow data. 
Simulator will determine how many blocks were switched in for the power flow solution, and 
then use the zero sequence block data to calculate the zero sequence admittance for the same 
number of steps and blocks. 
  

Owner, Area, Zone, Sub 

This tab is used to display or change the generator’s owner information, area information, 
zone, and substation information 

Area Number, Area Name 

The area number and name to which the generator belongs. Note that you can change the 
area of the generator to be different than the area of the terminal bus. If you do so, you will 
be prompted to confirm that you wish to place the generator within a different area than 
that of the bus to which it is electrically connected. 

Zone Number, Zone Name 

The zone number and name to which the generator belongs. Note that you can change the 
zone of the generator to be different than the zone of the terminal bus. If you do so, you 
will be prompted to confirm that you wish to place the generator within a different zone 
than that of the bus to which it is electrically connected. 

Owner Number, Owner Name 

The owner number and name to which the switched shunt belongs. Note that you can 
change the owner of the switched shunt to be different than the owner of the terminal bus. 
If you do so, you will be prompted to confirm that you wish to place the switched shunt 
within a different owner than that of the bus to which it is electrically connected. 

Substation Number, Substation Name 

The substation number and name to which the switched shunt belongs. Note that you can 
change the substation of the switched shunt to be different than the substation of the 
terminal bus. If you do so, you will be prompted to confirm that you wish to place the 
switched shunt within a different substation than that of the bus to which it is electrically 
connected. 

Custom  

This page of the dialog can be used to enter notes about the switched shunt. Any information 
entered in the memo box will be stored with the case when the case is saved to a PWB file. 
Custom fields can also be viewed and added from this page as well. 
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Zone Information (Run Mode) 

  

This dialog is used in the Run Mode to view and modify information associated with a zone 
record. It displays different information from the Edit Mode version of the zone dialog. To view 
this dialog, open the Zone Records Display by clicking on Aggregations > Zones in the 
Model Explorer. Right-click on the zone of interest and choose Show Dialog. The Run Mode 
Zone Dialog has the following fields: 
  

Zone Number, Zone Name 

Number and name of the associated zone. Use either the combo box or the spin arrows to 
view the different zones.  

Find… 

If you do not know the exact zone number you are looking for, you can click this button to 
open the advanced search engine. 

Labels 

To assign alternative identifying labels to the zone, click the Labels button, which will open 
the Label Manager Dialog listing all the labels or aliases assigned for the selected zone. 

  

The rest of the Run Mode Zone Dialog is divided into multiple pages: 
  

Information 

Load and Generation 

Real and reactive load, generation, shunts, losses, and interchange for the zone. 

Generation AGC Range 

These two fields show the total available MW reserve for generators in the zone that are on 
AGC and have nonzero participation factors. In other words, these fields show the total MW 
by which the generation in the zone can be increased or decreased using only generation 
that is presently on-line. The generator status, AGC status, and participation factor can be 
changed on the Generator Records Display.  

  

Tie Lines 

Zone Tie Lines 

The Zone Tie Line Table identifies the flows on all of the zone's ties to other zones. 

  

OPF 

Average LMP for Zone 

The computed average locational marginal price of all buses contained in the zone. 

LMP Standard Deviation 

The standard deviation of the locational marginal price for all buses contained in the zone. 

Minimum LMP 

The minimum locational marginal price of all the buses in the zone. 
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Maximum LMP 

The maximum locational marginal price of all the buses in the zone. 

  

 Zone Buses, Zone Gens, Zone Loads, Zone Switched Shunts 

These pages show the case information display with the buses, generators, loads and switched 
shunts assigned to the zone. 
  

Custom 

The Custom Page of the Zone Information dialog displays custom numbers or strings defined 
with the viewed zone. The Memo box is simply a location to log information about the zone. 
To log information about the zone, simply start typing your information or comments about 
the zone in the memo box. 
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Labels 

  

Using Labels for Identification 

Most data objects (such as buses, generators, loads, switched shunts, transmission lines, 
areas, zones, and interfaces) may have an alternative names assigned to them. These 
alternative names are called labels. Labels allow you to refer to equipment in the model in a 
way that may be unique to your organization. Labels may thus help clarify which elements 
are described by a particular set of data, especially when the short names employed by the 
power system model prove cryptic. Furthermore, since labels are likely to change less 
frequently than bus numbers, and since a label must, by definition, identify only one power 
system component, they may function as an immutable key for importing data from auxiliary 
files into different cases, even when bus numbering schemes change between the cases. 
Labels must be unique for devices of the same type, but the same label can be used for a 
device of a different type.  

Information dialogs corresponding to buses, generators, loads, switched shunts, 
transmission lines, areas, zones, and interfaces feature a button called Labels. If you press 
this button, the device’s Label Manager Dialog will appear. The Label Manager Dialog lists 
the labels associated with the device and allows adding, deleting, and modifying labels. The 
Labels (All) field (variablename = LabelsAll) in a Case Information Display lists all of the 
labels that have been associated with a device. The device's primary label is the one that is 
listed first in this field. This field lists all labels assigned to a device as a comma-delimited 
string. Even though multiple labels may be assigned to a device, any label can be used to 
import data from auxiliary data files. The Label Manager Dialog can be used to assign labels 
or the string of labels can be entered directly in the Labels (All) field.  

Labels can be used to map data from an auxiliary data file to a power system device. Recall 
that auxiliary data files require you to include a device’s key fields in each data record so 
that data may be mapped to the device. Labels provide an alternative key. Instead of 
supplying the bus number to identify a bus, for example, you can supply one of the bus’s 
labels. The label will enable Simulator to associate the data with the device associated with 
that label. This mechanism performs most efficiently when the primary label is used, but 
other labels will also provide the mapping mechanism. The Label (for use in input from 
AUX or Paste) field (variablename = Label) is used for importing data using labels and is 
blank when viewing in a case information display. Keep in mind that all devices read via an 
auxiliary file using the label field should have a non-blank label. Otherwise, information for 
that device will not be read. Even if the primary or secondary key fields are provided with 
the device, as long as the label field is present, that is the only field that will be used to 
identify the device. New devices cannot be created by simply identifying them by label. 
Either the primary or secondary key fields must be present to create a new device and the 
label field should not be present. 

Again, it is important to remember this: a single power system device may have multiple 
labels, but each label may be associated with only one device of a particular type. This is the 
key to enabling data to be imported from an auxiliary file using labels. 

Saving Auxiliary Files Using Labels 

All devices that can be identified by labels will have the Labels (All) and Label (for use in 
input from AUX or Paste) fields available in their case information displays. In order to 
save auxiliary files that identify devices by label, the two label fields should be added to the 
case information display prior to saving the data in an auxiliary file. Because the Label (for 
use in input from AUX or Paste) field will be blank when saved in the auxiliary file, this 
field must be populated with one of the labels in the Labels (All) field before loading the 
auxiliary file back in. Keep in mind that devices with blank labels cannot be identified when 
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loading in an auxiliary file, so avoid saving auxiliary files by label if all devices do not have 
labels.  

Many devices require SUBDATA sections. These sections have custom formats specific to the 
type of information that they contain. When saving auxiliary files with devices that require 
SUBDATA sections, the user can choose to use primary or secondary key fields or labels to 
identify devices in the SUBDATA sections. The user will either be prompted when saving the 
devices, or there is an option to change the key field to use when saving subdata sections 
on the PowerWorld Simulator Options dialog under the Case Information Displays category. 
When choosing to use labels, if a device has a label, it will be used. If it is a device that can 
be identified by buses and bus labels exist, bus labels will be used. Finally, if the device does 
not have a label and the buses do not have labels, the primary key for the device will be 
used for identification. 

Devices that have SUBDATA sections that contain other devices that can be identified by 
labels include: contingencies, interfaces, injection groups, post power flow solution actions, 
and owners. 

The setting to choose which identifier to use for the SUBDATA sections does not just apply 
to SUBDATA sections. Often when saving groups of options, this setting will apply to 
everything being saved with those options and not just the SUBDATA sections. This includes 
contingency options, ATC options, limit monitoring settings, and PVQV options. In these 
cases, there will be a prompt asking the user to decide which identifier to use in the 
auxiliary file. 

Loading Auxiliary Files SUBDATA Sections Using Labels 

The various SUBDATA sections that represent references to other objects can also be read 
using labels. Examples include contingencies, interfaces, injection groups, post power flow 
solution actions, and owners. When reading a SUBDATA section such as this, PowerWorld 
makes no assumption ahead of time about what identification was used to write this 
SUBDATA section. Instead, an order of precedence for the identification is as follows 

  Identification Explanation Example 

1 Key Fields assumes that the strings represent Key Fields BRANCH 8 9 1 

2 Secondary Key 
Fields 

assumes that the strings represent Secondary 
Key Fields 

BRANCH 
Eight_138 
Nine_230 1 

3 Labels for 
component 
objects 

the key/secondary key fields for some objects 
consist of references to other objects. An 
example of this is the BRANCH object that is 
described by the From Bus, To Bus, and 
Circuit ID. This assumes that labels of the 
component objects are used. 

BRANCH Label8 
Label9 1 

  

4 Labels Assumes that the string represents one of the 
Labels of the object 

BRANCH 
LabelForBranch 

Special Use of Labels 

There are a few special cases where objects have fields that identify other devices. These 
devices can be identified by label but not in the conventional means because the label field 
applies to the object that contains the device and a SUBDATA section is not necessary. 
These special cases include: (Note all fields given below are by variable name because the 
use of labels is most relevant with auxiliary files.) 

ATC Scenarios  
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ATC Scenario change records usually contain primary key fields to identify the devices 
that should be adjusted during the scenario. If using labels, these primary key fields will 
be replaced with a single Label field. The use of this field is different because the Label 
field refers to the device in the change record and not to the change record itself. When 
labels are used with ATC scenarios, device labels only can be used. Bus labels cannot be 
used to identify devices for which no label exists but a bus label does.  

ATC Scenarios are saved in an auxiliary file if choosing to Save Settings on the ATC 
Dialog. 

ATC Extra Monitors 

ATC Extra Monitors identify either branches or interfaces to monitor during the 
ATC analysis. These devices are identified in the WhoAmI field of ATC Extra Monitor 
records. Usually, the WhoAmI field is a special format that contains key field tags. 
Optionally, this field can use the label of the device for the extra monitor. If the device 
label is not available, the standard format will be used. There is no option to use bus 
labels if they exist and the device labels do not.  

ATC Extra Monitors area saved in an auxiliary file if choosing to Save Settings on the ATC 
Dialog. 

Model Conditions 
Devices in Model Conditions are usually identified by the WhoAmI field which is in a 
special format that contains key field tags. Optionally, this field can use the label of the 
device. If the device label does not exist, the standard format will be used. There is no 
option to use bus labels if they exist and the device labels do not. 

Model Expressions 

Model Expressions contain Model Fields. Model Fields are identified by the WhoAmI 
fields in the Model Expressions. Usually, the WhoAmI fields are in a special format that 
contains key field tags. Optionally, these fields can use the label of the device associated 
with the Model Field. If the device does not exist, the standard format will be used. 
There is no option to use bus labels if they exist and the device labels do not. 

Bus Load Throw Over Records 

Bus Load Throw Over Records are used with contingency analysis. These records have 
an option to identify the bus to which the load will be transferred by either number or 
name_kV combination. If choosing to identify objects by label, the 
BusName_NomVolt:1 field will contain the label of the bus instead of the name_kV 
combination.  

Bus Load Throw Over Records will be saved in an auxiliary file if choosing to Save 
settings on the Contingency Analysis dialog. 

Injection Group Participation Points 
All participation points and the injection groups to which they belong can be listed on the 
Injection Group Display. Load, generator, and shunt devices that can be assigned to a 
participation point must be identified by bus and ID. The bus can be identified by either 
the number or name. When identifying by name, the BusName_NomVolt field is used 
to provide the name_kV combination for the bus. If choosing to identify devices by label, 
this field instead will contain the label of the device. If the device does not have a label 
but the bus does, the bus label will be used instead in conjunction with the ID of the 
device. Even if the device does contain a label, the ID field must be included in any 
auxiliary file that is going to be loaded because it is a key field. Injection groups can be 
included in other injection groups. Injection groups can be identified by label, even 
though this is not a normal thing to do. If any injection groups have labels and these 
injection groups are included in other injection groups, their labels will also appear in the 
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BusName_NomVolt field. If they do not have labels, they will be identified by the 
injection group name that appears in the PPntID field.  
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Label Manager Dialog 

  

The Label Manager Dialog allows the creation and modification of labels to identify power 
system devices. Labels can be used for most data objects (such as buses, generators, loads, 
switched shunts, transmission lines, areas, zones, and interfaces) as alternate names for these 
devices. See the Labels topic for more information on how labels can be used. 

  

The Label Manager Dialog can be accessed by clicking the Labels button on any of the 
information displays for objects that allow labels.  

  

 
  

List of Labels 

Multiple labels can be assigned to a single object. The list on the left of the dialog shows all 
of the labels that have been assigned with the primary label listed first and highlighted in 
yellow.  

Add New 

Click this button to add a new label after entering the new label in the box to the right of 
the button. If this new label should be the primary label, check the Primary box. Labels 
must be unique for each type of object. That means that there cannot be two buses labeled 
One. However, there could be objects of different types with the same label. There could be 
a bus and a generator both labeled One. If attempting to label an object with a label that 
has already been used by the same object type, the label will be assigned to the current 
object and removed from the object to which it was previously assigned.  

Delete 

Click this button to delete a label after first selecting the label in the list of labels. 

Make Primary 
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Click this button to make a label the primary label after first selecting the label in the list of 
labels. The primary label will be moved to the top of the list. The primary label will always 
appear at the top of the list and will be used for sorting when sorting by label.  
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Area Information 

  

The Area Information Dialog shows information about each area in the system. It displays an 
area’s load, generation and losses; the area’s scheduled interchange with other areas; options 
for controlling the area’s generators, transformers, and shunts; the flows on its tie lines; and 
its operating cost information. You may view this dialog by doing any of the following: 
• Select Areas from the Model Explorer. This displays the Area Display. Select the desired 

area and click the Show Dialog option on the case information toolbar, or right-click on the 
record corresponding to the desired area to bring up the display’s local menu and choose 
Show Dialog.   

• Right-click in an empty portion of the oneline near a bus in the area of interest to display 
the oneline’s local menu. Select Area Information Dialog.  

• While in Run Mode, right-click on an Area Display Object that represents an area and 
choose Information Dialog. Note: Doing this while in Edit Mode will show the Area 
Display Options dialog instead of the Area Information Dialog. 

The Area Information Dialog contains the following information: 

Number 

A drop-down box that specifies the area number. Select an area from the drop-down box, or 
use the spin button to cycle through the list. 

Find By Number 

To find an area by its number, type the number in the Number field and click this button. 

Name 

A drop-down box that specifies the area’s alphabetic identifier, which may be any length in 
Simulator. When saving area names to other load flow formats, the names are truncated at 
the maximum character length supported by that format. 

Find By Name 

To find an area by its name, type the name in the Name field and click this button. 

Find… 

If you do not know the exact area number or name you are looking for, you can click this 
button to open the advanced search engine. 

Super Area 

To associate an area with a particular super area, either select an existing super area from 
the drop-down box, or type the name of a new super area. 

Area Control Options 

Select to change the area’s method of Automatic Generation Control (AGC.)  

Labels 

To assign alternative identifying labels to the area, click the Labels button. 

The rest of the Area Information Dialog is divided into nine pages of controls: 
• Info/Interchange 
• Options 
• Area MW Control Options 
• OPF 
• Tie Lines 
• Buses 
• Gens 
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• Loads 
• Custom 
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Area Information: Buses 

  

The Area Buses grid shows a list of all buses that are in the area. The grid displays the bus 
number, bus name and other bus information. The Area Buses display is a Case Information 
Display and has options available to these types of displays. 
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Area Information: Gens 

  

The Area Gens grid shows a list of all generators that are in the area. The grid displays the 
bus number, bus name, generator ID and other generator information. The Area Gens display 
is a Case Information Display and has options available to these types of displays. 
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Area Information: Loads 

  

The Area Loads grid shows a list of all loads that are in the area. The grid displays the bus 
number, bus name, load ID and other load information. The Area Loads display is a Case 
Information Display and has options available to these types of displays. 
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Area Information: Area MW Control Options 

  

Set Participation Factors... 

Press this button to open the Generator Participation Factors Dialog, which gives you control 
over how the participation factor for each generating unit is defined. If you decide not to 
prescribe participation factors using this button, the existing participation factors defined 
with each generator will be used. This button will be enabled only if the area has been set to 
Participation Factor area control. 

Area Slack Bus Number 

Identifies which bus to model as the area’s slack bus. 

Injection Group Area Slack 

An additional area generation control option that can be utilized is the ability for Simulator to 
use a defined injection group as the sink for Area Slack control. When an injection group is 
selected, and the area is set on Area Slack control, any needed injection changes in the area 
will be accounted for by the devices in the injection group. 

Some typical injection group options are also available here for handling the injection group 
dispatching during the Injection Group Area Slack Control. These options include: 

Allow only AGC gen/load to vary:  
Only generators and loads in the injection group that are designated as available for AGC 
control will be allowed to participate in injection changes. 

Enforce generator MW limits (ignore case and area options):  

Generators in the injection group can be designated to enforce their MW limits 
independent of the global case and area options for generator MW limit enforcement. 

Do not allow negative loads: 

If loads are decreasing demand as part of an injection group area dispatch, you can 
specify whether or not those loads should be allowed to go below 0 demand. 

How should reactive power load change as real power load is ramped? 

You can choose to keep the ratio of real and reactive power constant for each load that 
is included in the injection group, or you can specify a constant power factor that the 
MVAR value will be determined from when the MW value is changed. 
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Area Information: Info/Interchange 

  

The Info/Interchange Tab serves as an accounting sheet for flows into and out of an area. It 
houses the following controls: 

Load, Generation, Shunts, Losses, Interchange 

These read-only fields express the total real and reactive load, generation, shunt 
compensation, losses, and interchange for the area. 

Interchange 

Interchange in MW between the area and all other areas (exporting power is positive). To 
prescribe an interchange with a specific area, simply enter the amount of power in MW to 
export to that area in the MW Export column. To specify an import, enter a negative value. 
If the recipient of the power is unknown, you may enter the net total in the Unspecified 
MW Interchange field found above the list of transactions. The net value of the MW 
imports and exports is displayed in Transaction MW. 

Check the box Only Show Areas with Nonzero Interchange to display only those areas 
whose interchange is different from zero. 

By default, one interchange record is initially defined between each area. The total 
interchange between two areas can be managed using this single record. However, it is 
possible to define multiple interchange records between the same areas. To do so, you can 
right-click in the interchange table and select Insert from the local menu. This will open the 
Transaction Dialog, which will allow you to insert a new transaction. Transactions between 
the same two areas must have unique transaction IDs. Once you have multiple transactions 
defined between the same two areas, you can choose which transactions are enabled using 
the Enabled property in the Base Interchange table. This field is a toggleable field, meaning 
you can double-click in the field to toggle its value. 

The total interchange defined for an area will be displayed in the summary field labeled 
Interchange in the area summary totals on the left side of the page.  

AGC Tolerance 

The MW tolerance is used in enforcing area interchange. When the absolute value of the 
ACE is less than this value, Simulator considers the area interchange constraint to be 
satisfied. 

ACE (Area Control Error) 

Current area control error (ACE) for the area in MW. Note that, when the constant frequency 
model is used, ACE = area generation - area load - area losses - scheduled area interchange 
- area shunt MW.  

Area Has Multiple Islands 

This is an informational field that cannot be changed. If checked, then Simulator has 
detected that the area has devices in separate electrical islands in the system. This is 
important because it is sometimes impossible for an area using some form of generation 
control (AGC) to solve for the generation dispatch in the entire area (Area Generation = 
Area Load + Area Losses + Area Interchange + Area Shunt MW) when the area is not 
entirely within the same electrical island. If Simulator is unable to solve for areas that span 
multiple islands, the AGC status of the area will automatically be set to "Off AGC" and a 
warning message will be written to the Simulator message log. 
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Area Information: Options 

  

Report Limit Violations 

If checked, limit violations for this area are reported. Limits violations are reported in the 
Limit Violations List. 

Generation AGC Values 

These fields indicate the total available AGC range for all the generators in the area that 
are specified as being on AGC and have nonzero participation factors. That is, 
these fields show the total amount the generation in the area that can be increased or 
decreased using the presently on-line generation. This may be referred to as the spinning 
reserve. The generator status, AGC status, and participation factor can be changed on the 
Generator Records Display.  

Load MW Multiplier Value 

This value is used for scaling the area MW load. The base load remains unchanged. 

Load MVAR Multiplier 

This value is used for scaling the area MVAR load. The base load remains unchanged. 

Automatic Control Options 

The Automatic Control Options section provides a convenient mechanism to enable or 
disable automatic control of switched shunts and transformers in the area.  

This section also provides a check box for setting if the generators in the area should 
enforce their Generator MW Limits or not. Typically this should be checked. Note that even if 
unchecked, the OPF routine will ignore this setting and will always enforce generator MW 
limits during an OPF solution. 

Include Loss Penalty Factors in ED 

If this box is unchecked, then the economic dispatch for the area is calculated assuming that 
the area is lossless. Otherwise, the solution will incorporate losses when computing the 
economic dispatch. The penalty factors gauge the sensitivity of the area’s losses to changing 
injection at specific generators. The option to calculate loss penalty factors is relevant only 
when the area operates according to Economic Dispatch Control. Usually, if the system’s 
cost curves are relatively flat, the inclusion of losses in the solution will not have much of an 
effect on the dispatch. 

Economic Dispatch Lambda 

The lambda value calculated during the economic dispatch computation. This field is valid 
only when the area is on economic dispatch control. 
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Area Information: Tie Lines 

  

The Tie Lines display shows the flow on all of the tie lines for the selected area. This display is 
a case information display and contains many of the options available to these types of 
displays. 

The default fields that are shown in the grid identify each line and show the flow on each line. 

Near Area Name, Near Area Number 

These fields identify the area name and number of the tie line terminal located in the 
selected area. 

Near Number, Near Name 

These fields identify the bus number and name of the tie line terminal located in the 
selected area. 

Far Area Name, Far Area Number 

These fields identify the area name and number of the tie line terminal located in the other 
area. 

Far Number, Far Name 

These fields identify the bus number and name of the tie line terminal located in the other 
area. 

Ckt 

This is the circuit identifier for the tie line. 

Meter MW, Meter Mvar 

These are the real and reactive power flowing on the tie line from the selected area to 
the other area. (Real and reactive power flowing on line from the Near bus to the Far 
bus.) 

Status 

This field gives the status of the tie line as Open or Closed. 

MW Loss, Mvar Loss 

These fields show the real and reactive power losses on the tie line. 
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Area Information: OPF 

  

The OPF Tab contains information regarding the Optimal Power Flow (OPF) solution data for 
an area. It houses the following information: 

Average LMP for Area 

The computed average locational marginal price of all buses contained in the area. 

LMP Standard Deviation 

The standard deviation of the locational marginal price for all buses contained in the area. 

Min/Max LMP 

The minimum and maximum locational marginal price of all the buses in the area. 

Total Generator Production Cost (Scaled) 

The scaled cost includes the Cost Shift and Cost Multiplier. These two values can be defined 
for each generator, and allow the user a way to assess changes to the LMP results when a 
generators cost or "bid" is modified, without actually changing the original generator cost or 
bid curve. The scaled cost function for each generator is equal to: 

(original cost function + cost shift) * cost multiplier 

Total Generator Unscaled Production Cost 

The total unscaled generator production cost, based on the original generator cost or bid 
curves. 

Total Generator LMP Profit 

The profit of the generators in the area based on the Locational Marginal Prices (LMPs) 
determined by the OPF solution. The profit is determined as: 

LMP Price * MW Output – Unscaled Cost Function 

Cost of Energy, Loss, and Congestion Reference 

Specify a reference for determining the cost of energy, loss and congestion. The choices are 
Existing loss sensitivies directly, Area’s Bus’ Loads, Injection Group, or a specific bus. 

 



Properties of Simulator Objects 

467 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Area Information: Custom 

  

The Custom page of the Area Information dialog contains two sections: custom fields and 
memo. 

The custom fields section allows access to setting and changing the values for custom fields 
that have been defined for areas. Defining custom fields is detailed in Custom Field 
Descriptions.  

The Memo section of the Area Information dialog is simply a location to log information about 
the area. To log information about the area, simply switch to the Custom page on the dialog, 
and start typing your information or comments about the area in the memo box. 
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Area Field Options 

  

Area field objects are used to show different values associated with areas and the system. This 
dialog is used to view and modify the parameters associated with these fields. 
  

Area Number 

Area number associated with the field. When you insert fields graphically, this field is 
automatically set to the area number associated with the closest bus on the oneline. With 
most types of area fields, an Area Number of 0 is valid and defines the field as showing 
values for the entire system.  

Find… 

If you do not know the exact bus number or name you are looking for, you can click this 
button to open the advanced search engine. 

Total Digits in Fields 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Rotation Angle in Degrees 

The angle at which the text is to appear on the oneline diagram. 

Other Area Number 

Some of the fields, such as MW Flow to Other Area, require that a second area be 
specified. If applicable, enter the second (other) area here. 

Other Area Transaction ID 

Since it is now possible to have more than one base transaction defined between the same 
two areas, base transactions must now also have a unique ID to distinguish between 
transactions among the same two areas. If you are displaying a field that pertains to the 
display of the scheduled flow between areas, the ID of the transaction in question will also 
need to be entered here. 

Delta MW per Mouse Click 

This value is used only with the Sched Flow to Other Area field type. When there is a 
nonzero entry in this field, and the field type is Sched Flow to Other Area, a spin button 
is shown to the right of the area field. When the up spin button is clicked, the flow to the 
other area is increased by this number of MW; when the down button is clicked, the 
scheduled flow is decreased by this amount.  

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Field Value 

Shows the current output for the area field. Whenever you change the Type of Field 
selection, this field is updated.  

For the Sched Flow to Other Area field type only, you can specify a new value in MW. 
Exports are assumed to be positive.  

Anchored 
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If checked, the area field will be anchored to a corresponding Area Object. If the area object 
is moved on the diagram, the text field will move with it. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of bus field to show. The following choices are available: 

Name Area name (eight characters maximum). The Area Number field must correspond to 
a valid area. 

Number Area number (1 - 999). The Area Number field must correspond to a valid area.  

MW Load, Mvar Load If the area number is nonzero, then these fields show Total MW or 
Mvar load for the area. If the area number is zero, these fields 
show the total load in the entire system. 

MW Generation, Mvar Generation If the Area Number is nonzero, then these fields show 
Total MW or Mvar generation for the area. If the Area Number 
is zero, these fields show the total generation in the entire 
system. 

MW Losses, Mvar Losses If the Area Number is nonzero, then these fields show Total MW 
or Mvar losses for the area. If the Area Number is zero, these 
fields show the total losses in the entire system. 

ACE (MW) Area Control Error in MW for the area. The Area Number field must correspond 
to a valid area.  

Hourly Cost ($/hr) If the Area Number is nonzero, then this field shows the hourly cost 
for the area. If the Area Number is zero, these fields show the 
hourly cost for the entire system. 

Total Cost ($) If the Area Number is nonzero, this field shows the total cost incurred by 
the area since the beginning of the simulation. If the Area 
Number is zero, this field shows the total cost incurred 
throughout the system since the beginning of the simulation. 

MW Flow to Other Area,  

Mvar Flow to Other Area Total MW or Mvar flow from the area specified in the Area 
Number field to the area specified in the Other Area Number 
field. The Area Number field must correspond to a valid area. If 
the Other Area Number field is zero, this field shows the area’s 
total MW or Mvar exports.  

Sched. Flow to Other Area Scheduled MW transaction from the area specified in the Area 
Number field to the area specified in the Other Area Number 
field, and with the Transaction ID given in the Other Area 
Transaction ID field. The Area Number field must correspond to 
a valid area. If the Other Area Number field is zero, this field 
shows the area’s total scheduled MW transactions. If the Delta 
per Mouse Click value is nonzero, you can use the spin arrows 
on the oneline to change this value. Also, you may directly 
enter a new value in the Field Value field.  

Load Schedule Multiplier (MW Only) Indicates the current value of the MW multiplier 
applied to the area’s loads. 

AGC Status Displays the AGC status of the area.  
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Select a Field Choose from all possible information fields that can be displayed for areas. 

Select OK to save changes and close the dialog or Cancel to close dialog without saving your 
changes. 
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Super Area Information Dialog 

  

The Super Area Information Dialog displays information pertaining to Super Area Display. It 
summarizes the super area's real and reactive load and generation, scheduled transactions, 
and constituent areas. It also allows you to manage the list of areas to include in the super 
area and to designate how its generation should be controlled. To display the Super Area 
Information Dialog, right-click on the Super Area Records Display and select Show Dialog 
from the resulting local menu.  

The Super Area Information Dialog has the following fields: 
  

Area in Super Area 

Name 

The list of all super areas that have been defined in the case are listed in this dropdown box. 
Select one of the super areas to display its information, or type a new name in the box and 
click Add New to define a new super area. 

Rename 

Click this button to change the name of the super area specified in the Name field. 

Save 

Saves the super area of the name specified in the list of super areas. 

Delete 

Click this button to delete the super area specified in the Name field. 

Area in Super Area 

Areas in Super Area 

Lists the areas contained in the super area. Right-click on a row and select Remove to 
remove the area from the super area. 

Super Area Control Options 

Specify the type of generation control to employ for the super area. The super area may be 
removed from area control or employ Participation Factor or Economic Dispatch control. See 
Area Control for details on these types of generation control. 

An additional type of control available to Super Areas is to Use Area Participation 
Factors. If the super area is set to participation factor control, and this option is NOT 
checked, then the generators within the super area respond by redispatching to meet the 
entire super area generation change based on their own participation factors.  

However, if this option IS checked, then an additional level of participation control 
complexity is added for the super area. First, the total super area generation change is 
divided across each area forming the super area, according to the participation factors of 
the AREAS, as set in the grid on this dialog. Once the total generation change has been 
determined for each area within the super area, then the generators within each individual 
area are dispatched using area participation factor control to meet each specific area's 
determined generation change. 

Use Area Participation Factors 

If the super area control is set to Participation Factor control, you can specify participation 
factors for each area in the list of areas that indicate how each area should contribute 
towards changes in generation for the super area. For example, if you have three areas in 
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the super area and you set the participation factors to 1, 1 and 2, the three areas will 
contribute to the total change in generation in the super area by ratios of 25%, 25%, and 
50%, respectively. The contribution of each area is then further divided among the 
generators within each area by the participation factors of the individual generators. 

This option will be applied when calculating TLR, PTDF, voltage, and ATC sensitivities. When 
calculating these sensitivities, the assumption is that the super area is on participation factor 
control even if the control method is something other than this. If this option is selected, it 
will be enforced regardless of the control method when calculating these sensitivities.  

New Area Name 

Use the dropdown box to select an area to add to the super area. Click the Add New Area 
by Name to add the selected area to the super area. 

New Area #'s 

Enter in a list of area numbers separated with dashes or commas and click Add New Areas 
by Number button to add the areas to the Super Area 

  

Summary Information 

ACE Total (MW) 

The total area control error for the super area. It is calculated by summing the ACE for all 
areas comprising the super area.  

ACE Tolerance (MW) 

The Area Control Error tolerance observed for the super area during a load flow solution. 

Total Scheduled Transactions 

Lists the total scheduled import or export for the super area. It is computed by summing the 
scheduled interchange for all areas comprising the super area. Exports are positive. 

Lambda 

The marginal cost associated with the super area. Lambda is valid only for super areas that 
are on economic dispatch control. 

Hourly Cost 

Current average hourly cost for the super area in $/hour. 

Load, Generation, Shunts, Losses, Interchange 

The Load and Generation section of the Super Area Information Dialog accounts for the real 
and reactive power flows into, out of, and within the super area. Each quantity is computed 
by summing over the areas comprising the super area. 

  

OPF 

The OPF Tab contains information regarding the Optimal Power Flow (OPF) solution data for a 
super area. It houses the following information: 

Average LMP for Area 

The computed average locational marginal price of all buses contained in the area. 

LMP Standard Deviation 

The standard deviation of the locational marginal price for all buses contained in the area. 

Min/Max LMP 
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The minimum and maximum locational marginal price of all the buses in the area. 

Total Generator Production Cost (Scaled) 

The scaled cost includes the Cost Shift and Cost Multiplier. These two values can be defined 
for each generator, and allow the user a way to assess changes to the LMP results when a 
generators cost or "bid" is modified, without actually changing the original generator cost or 
bid curve. The scaled cost function for each generator is equal to: 

(original cost function + cost shift) * cost multiplier 

Total Generator Unscaled Production Cost 

The total unscaled generator production cost, based on the original generator cost or bid 
curves. 

Total Generator LMP Profit 

The profit of the generators in the area based on the Locational Marginal Prices (LMPs) 
determined by the OPF solution. The profit is determined as: 

LMP Price * MW Output – Unscaled Cost Function 

Cost of Energy, Loss, and Congestion Reference 

Specify a reference for determining the cost of energy, loss and congestion. The choices are 
Existing loss sensitivies directly, Area’s Bus’ Loads, Injection Group, or a specific bus. 

  

Custom 

This page of the dialog can be used to enter notes about the super area. Any information 
entered in the memo box will be stored with the case when the case is saved to a PWB file. 
Custom fields can also be entered on this page in the form of floating point, integer, and string 
fields. These custom fields are stored with the super area and can be used for various tasks in 
Simulator. 
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Super Area Field Information 

  

Super area field objects are used to show different values associated with super areas. This 
dialog is used to view and modify the parameters associated with these fields. Note that the 
super area name itself cannot be changed on this dialog. 
  

Super Area Name 

Select the name of the super area for which you are inserting or viewing information of a 
super area field. 

Find… 

If you do not know the exact super area name you are looking for, you can click this button 
to open the advanced search engine. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Field Value 

Shows the current output for the super area field. Whenever you change the Type of Field 
selection, this field is updated. 

Field Prefix 

A prefix that can be specified and displayed with the selected value. 

Rotation Angle in Degrees 

The angle at which the text will appear on the diagram. 

Anchored 

Toggles if the field should be anchored to an associated super are object on a diagram. 

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Used to determine the type of super area field to show. The following choices are available: 

Name Super area name (eight characters maximum). The super area name field must 
correspond to a valid super area. 

MW Load, Mvar Load Total MW or Mvar load for the super area. 

MW Generation, Mvar Generation Total MW or Mvar generation for the super area. 

MW Losses, Mvar Losses Total MW or Mvar losses for the super area. 

ACE (MW) Area Control Error in MW for the super area. The super area name field must 
correspond to a valid super area. 

MW Exports Total MW exports for the super area. 

Hourly Cost ($/hr) The hourly cost for the super area. 

AGC Status Displays the AGC status of the super area. 

MW Marginal Cost ($ / MWhr) MW marginal cost for the super area. 
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Select OK to save changes and to close the dialog, or click Cancel to close the dialog without 
saving your changes. 
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Interface Information 

  

The Interface Dialog is used to create, modify, or delete interface records in both the Edit and 
Run Modes. This dialog has the following controls: 
  

Interface Name 

An alphanumeric identifier for the interface of up to 24 characters. Use the dropdown box or 
the spin button to navigate through the list of existing interface records. 

Interface Number 

A numeric identifier for the interface, between 1 and 32,767. 

Find Interface… 

If you do not know the exact interface name or number you are looking for, you can click 
this button to open the advanced search engine. 

Add New Interface 

Click the Add New Interface button to define a new interface from the Interface Dialog. 
When you click this button, the Interface Name field and Interface Elements table are 
cleared, requiring you to enter a new name and new elements. 

Delete Interface 

Select this button to delete the currently displayed interface. Once the interface record has 
been deleted, the Interface Name field displays the previous interface record, if any. If 
there are not previously defined interface records, Simulator will close the dialog. 

Interface Limits 

Specify the possible limits for net interface flow. As for transmission lines and transformers, 
up to eight distinct limits can be specified for interfaces. Which limit set is used can be 
controlled from the Limits Tab of the Simulator Options Dialog or the Line and Transformer 
Limit Violations Display. 

Monitoring Direction 

This area allows the user to change the flow monitoring direction. Clicking on the interface 
in the Interface Elements area will bring up the Interface Elements Dialog. This is 
where the default direction is set. To keep this default direction, choose FROM  TO, to 
change this direction, choose TO  FROM, and to monitor both directions, choose Both 
Directions. 

Noncontingent MW Flow Contribution 

Indicates the present net flow through the interface elements, not including affects of 
contingencies, in MW. 

Contingent MW Flow Contribution 

The amount of flow that would be added to the interface flow if the contingency defined 
with the interface were to occur, in MW. 

Total MW Flow 

The sum of the non-contingent MW flow and Contingent MW flow, for the total MW flow 
considered on the interface, in MW. 

PTDF Value (%) 

The Power Transfer Distribution Factor for the interface, if calculated. 
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Interface Elements 

The Interface Elements Table lists each element comprising the interface. If Simulator is in 
Run Mode, the table will also show the present flow through each element. To edit or delete 
an existing element in the table, click on it to bring up the Interface Element Dialog. Use the 
Interface Element Dialog to modify or delete the element. 

Insert New Element 

Click the Insert New Element Dialog to add a new element to the interface using the 
Interface Element Dialog. 

Click OK to save any changes you have made and to close the Interface Information Dialog. 
Click Save to save your changes but to leave the dialog open so that you can view and 
modify other interface records. Click Cancel to close the dialog without saving your latest 
change.  

Element Identifiers 

Choose whether to show the interface descriptions using the interface names, the interface 
numbers, or a combination of both. 

  

OPF 

The OPF page will only be visible if you have the Optimal Power Flow add-on for PowerWorld 
Simulator. This page contains interface information relating to performing an OPF solution. 

Enforce Interface Flow Limit 

If checked, the Interface limit will be checked for enforcement during an OPF solution. 

Treat Limit as Equality Constraint 

If checked, the OPF routine will try and maintain the flow on the interface at its limit value. 
Otherwise the limit will be treated as the maximum for an inequality constraint. 

MW Flow on Interface 

The actual MW flow on the interface. 

Present MW Limit 

The currently defined limit for the interface. 

Percentage of Limit 

The MW flow on the interface as a percentage of the limit. 

Limit Marginal Cost 

The incremental cost of maintaining the flow on the Interface at its limit value. 

MW Flow Constraint 

The constraint status of the interface in the OPF solution is shown here with the 
corresponding boxes checked by Simulator. These boxes can not be changed by the user. 
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Interface Element Information 

  

The Interface Element Dialog is used to redefine or to add the individual elements comprising 
an interface. Individual lines or transformers, inter-area ties, inter-zone ties, line 
contingencies, DC lines, injection groups, generators, and loads may make up an interface. 
The Interface Element Dialog allows you to add all three varieties of interface elements to an 
interface. 

The Interface Element Dialog comes in two very similar forms, depending upon how it was 
invoked. The dialog may be called from the Interface Information Dialog by clicking on either 
the Interface Elements Table or the Insert New Element button. 
  

The Interface Element Dialog contains the following controls: 

Element Type 

Specifies the type of interface element being investigated or added. Interface elements can 
be any line or transformer or, more specifically, they can be groups of lines and 
transformers that tie two areas or two zones together. Interfaces can also contain line 
contingencies, DC lines, generators, loads, and injection groups.  

When the selection for Element Type changes, the available Element Identifiers change 
to allow you to pick the appropriate elements of that type. 

Element Identifiers 

Depending upon the Element Type selection, different element identifiers are required to 
designate the element to add to the interface. You can search through the list of identifiers 
to find the particular elements you wish to include. Note that the flow direction on 
transmission line, transformer, and DC line elements will be dependent on which end of the 
line you choose as the near bus. The flow will always be measured in the direction of near 
bus to far bus. The flow will be positive when flowing from near to far, and negative when 
flow from far to near. In addition, line elements also have an additional setting labeled 
Monitor Flow at To End. This determines which magnitude of flow should be reported. If 
checked, the flow at the To end of the line will be reported, otherwise the flow magnitude at 
the From end is used. 

Insert 

If you came to the Interface Element Dialog by pressing the Insert New Element button on 
the Interface Information Dialog, only the Insert, Cancel, and Help buttons will be 
available. Click the Insert button to add the element you have just defined to the list of 
elements comprising the interface. After you click Insert, the dialog will disappear, and the 
Interface Elements table on the Interface Information Dialog will contain the element you 
just added. 

Replace, Delete 

If you arrived at the Interface Element Dialog by clicking on an element in the Interface 
Elements Table of the Interface Information Dialog, the Replace, Delete, Cancel, and 
Help buttons will be visible. Click Replace to modify the interface element according to 
your specifications on this dialog. Click Delete to remove the element from the interface 
definition. 

Cancel 

Click Cancel to close the Interface Elements Dialog without saving your changes. 
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Interface Field Information Dialog 

  

Interface field objects are used to show the different values associated with interface records. 
This dialog is used to view and modify the parameters associated with these fields. The dialog 
has the following fields: 
  

Interface Name 

Case insensitive name of an existing interface (12 characters maximum). 

Find… 

If you do not know the exact interface name you are looking for, you can click this button to 
open the advanced search engine. 

Total Digits in Field 

Total number of digits to show in the field. 

Digits to Right of Decimal 

Number of digits to show to the right of the decimal point. 

Rotation Angle in Degrees 

The rotation angle at which the text field should be displayed. 

Anchored 

If checked, the interface field is anchored to its associated interface display object.  

Include Suffix 

If the Include Suffix checkbox is checked, the corresponding field units will be displayed 
after the current value. Otherwise, only the value without units will be shown. 

Type of Field 

Type of field to show for the interface record. Interface fields may show the interface's 
name, its MW Limit, MW Flow, percent loading, or any other interface specific field available 
by clicking the Select a field option and choosing a field from the drop-down list. 
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Interface Pie Chart Information Dialog 

  

Interface Pie Chart objects are used to graphically show the percentage flow associated with 
interface records. This dialog is used to view and modify the parameters associated with these 
fields. The dialog has the following fields: 
  

Interface Name 

Case-insensitive name of an existing interface (12 characters maximum). 

Size 

Size of the pie chart. Note that the pie chart's size and color can be set to change 
automatically when the interface's loading is above a specified limit. Please see Oneline 
Display Options for details.  

Actual Value (read-only) 

In Run Mode, this field shows the current MW loading for the interface. 

Percent (read-only) 

In Run Mode, this field shows the current percentage loading for the interface; if the MVA 
rating is zero, the percentage is defined as zero, as well. 

Anchored 

If checked, the interface pie chart object is anchored to its associated interface.  

MW Rating 

MW limit for the interface, using the current limit set for the case.  

Style 

The style of the pie chart. It can be set individually for the particular pie chart, or it can use 
the style specified in the Interfaces Pie Chart Options. 
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Automatically Inserting Interfaces in Case 

  

The Inserting Interfaces Dialog is used to insert a group of interfaces. Only interfaces 
between adjacent areas or adjacent zones can be inserted automatically; single-branch 
interfaces between buses must be inserted with line insertion options. Adjacent areas or zones 
are those that share at least one tie line. To reach this dialog, first open the Interfaces Display 
by selecting Aggregations > Interfaces from the Model Explorer, and then from the case 
information toolbar select Records > Auto Insert Interfaces . This dialog is NOT brought 
up through the menu item Auto Insert > Interfaces found on the Quick Insert ribbon group 
of the Draw ribbon tab, which is for inserting interface objects on an oneline diagram. 
  

The Inserting Interfaces Dialog sports the following fields: 

Type of Interfaces to Insert 

Select the type of interfaces to insert. Area-to-area interfaces join adjacent areas, while 
zone-to-zone interfaces join adjacent zones. The name of the new interface defaults to 
"Area1- Area2" or "Zone1-Zone2" with an Optional Prefix. 

Optional Prefix 

This field allows you to specify an optional prefix of up to three characters. Use this prefix to 
avoid duplicating names, particularly when some of the areas or zones have the same name. 

Delete Existing Interfaces 

If this option is checked, then all existing interfaces are deleted before inserting the new 
interfaces. By default, this option is checked. If this option is not checked, the existing 
interfaces are not deleted. However, new interfaces will automatically overwrite any existing 
interfaces having the same name. 

Only Insert Between Areas/Zones with Area/Zone Filters Set 

If this option is checked, the set of potential areas or zones for inserting interfaces is limited 
to those for which the area/zone filter setting is Yes. 

Limits 

Simulator can either calculate an interface rating based on the ratings of the components 
included in the interface, or the user can specify a set of ratings to be used for the interface. 
If neither of these options is used to set an interface limit, then by default, the interface 
limits are left as 0, indicating no limit has been applied. 

Insert Interfaces 

Click this button to insert the interface records into the case. 

Cancel 

Closes the dialog without modifying the list of interfaces. 
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Nomogram Information Dialog 

  

The Nomogram Dialog is used to create, modify, or delete nomogram records in both the Edit 
and Run Modes. Nomograms are used for combining a pair of interface objects for the purpose 
of monitoring a combined flow restriction on the two interfaces together. 
  

This dialog has the following controls: 

Nomogram Name 

An alphanumeric identifier for the nomogram. 

Interface A 

The first interface forming the interface pair. To add the interface from scratch in the 
nomogram dialog, click on the Insert New Element button. In this manner you will be 
creating the interface from the individual elements, the same as creating an interface on the 
interface dialog. If you already have an interface defined, and wish to clone the elements of 
that interface for this nomogram, use the button labeled Clone Elements From to find the 
interface and copy the element definition. 

Interface B 

The second interface forming the interface pair. To add the interface from scratch in the 
nomogram dialog, click on the Insert New Element button. In this manner you will be 
creating the interface from the individual elements, the same as creating an interface on the 
interface dialog. If you already have an interface defined, and wish to clone the elements of 
that interface for this nomogram, use the button labeled Clone Elements From to find the 
interface and copy the element definition. 

Nomogram Breakpoints 

This section is used for defining the limit boundaries for the interface. The limit boundaries 
are defined by inserting nomogram breakpoints. These breakpoints correspond to a pair of 
MW flows on each interface. In other words, you define the amount of flow allowed on 
Interface B when interface A is at a certain amount. Typically you will have a flow limit on 
Interface B that is constant for a certain range of flow in interface A. However, at some 
point as the flow on Interface A increases, the limit of flow on Interface B can start to 
decrease due to desired flow limit restrictions of the combined interfaces. At some point, the 
limit of Interface A would reach a maximum amount and remain constant, and the range of 
flow on interface B would be fairly small due to the heavy loading in Interface A. 

To build this Nomogram Limiting Boundary, begin by right-clicking in the Nomogram 
Breakpoints list and choose Insert Point. Note that the boundary definition must be a convex 
piecewise linear curve. You would typically being by defining the flow limit allowed on 
Interface B when the flow on interface A is small or zero. Then define breakpoints where the 
limit on B decreases as the flow on A increases. Eventually you will define a point where the 
flow on A reaches a limit as the flow on B continues to decrease towards zero. In short, the 
nomogram limiting boundary is actually a combination of boundary limits that are scaled 
combinations of the individual interface limits. See the image below for an example of a 
nomogram limiting boundary. 
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Chapter 8: Text-based Information Displays 

  

This chapter describes the case information displays. The case information displays are used 
to display information about the case, regardless of whether or not it is shown on the 
onelines.  

The following material is included: 
• Fundamentals 
• Summary Displays 
• Area and Zone Displays 
• Bus Displays 
• Substation Displays 
• Generator Displays 
• Load Displays 
• Line and Transformer Displays 
• Switched Shunt Displays 
• Interface Displays 
• Injection Group Displays 
• Island Displays 
• Transaction Displays 
• Limit Violation Displays 
• Ownership Displays 
• Load Flow Displays 
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Model Explorer 

  

 
Most Case Information Displays are enclosed inside the Model Explorer. To open the Model 
Explorer, click on the Model Explorer button shown above. The Model Explorer button is 
available on both of the Case Information Ribbon Tab and Tools Ribbon Tab by default. It is 
also placed on the Quick Access Toolbar by default. When you open the Model Explorer you 
will see a case information display. In addition to this the model explorer has 5 additional 
regions to help you navigate the model as well as modify the model. 

Explore Pane 

The Explore Pane contains a hierarchical list of most of the objects contained in the power 
system model. Entries in the Explore Pane that are grayed out represent objects that 
presently are not defined in the model. The Explore Pane is separated into eight primary 
folders, with only the Network and Aggregations folder expanded by default. The either 
primary folders are as follows 

• Recent - contains a list of case information displays that have been recently opened. This 
same list of case information displays are depicted on the Recent Tabs across the top of 
the Model Explorer.  

• Network - contains a list of the network model objects. Generally these represent actual 
physical devices such as a generator or transmission line. 

• Aggregations - contains a list of model objects that represent an aggregation of other 
model objects. An example is an interface which represents such as interfaces or injection 
groups 

• Solution Details - provides access to case information displays that provide details 
regarding the power flow solution. It includes displays such as the Y-Bus, Jacobian, or 
summaries of remoted regulated buses 

• Case Information and Auxiliary - contains generic objects that are operate on the 
other objects in the model. This includes filtering, expression, Model Criteria and such.  

• Contingency Analysis - contains a convenient place to access case information displays 
showing options related to contingency analysis. 

• Optimal Power Flow - contains a convenient place to access case information displays 
showing options related to the OPF or SCOPF 

• Transient Stability - contains a convenient place to access case information displays 
showing options related to Transient Stability 

Explore Pane Options 

There are a few options regarding the Explore Pane which can be accessed by right-
clicking on the Explore Pane, Search Bar, or Case Information Toolbar, then you will 
get a local menu that allows you to specify these options 

  Open Multiple Explorers : Choose what to 
do when you choose to open another Model 
Explorer if one is already open. You may 
choose to always open new Model Explorers, 
Never, or have a prompt window appear each 
time you request a new Model Explorer 

Save Recent (Number) : Choose this 
option to change the number of recently 
viewed case information that are kept and 
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shown as tabs in the Recent Tabs 

Show Number of Objects : Check this 
option to show a number next to each entry 
in the Explore Pane 

  

Options Pane 

The Options Pane contains access to the some commonly used case information display 
actions. All of these options can also be accessed from the case information local menu or 
the case information toolbar as well. 

Recent Tabs 

The Recent Tabs represent a list of the most recently viewed case information displays on 
the Model Explorer. You can click on the X to the left of each tab to clear that from the 
recent list. 

Case Information Toolbar 

The Case Information Toolbar contain a graphical representation of all the options and 
actions which can be applied to the case information display. The toolbar is described in 
detail in the case information toolbar topic. Also note that all the options displayed on the 
toolbar are also available by right-clicking on the toolbar and showing the case information 
local menu. 

Search Toolbar 

The Search Toolbar contains a toolbar that allows you to search the active case information 
display for particular text. This toolbar behaves in the same manner as the Search For Text 
Dialog. 

A picture of the Model Explorer as it appears when showing the generator records is shown 
below. Besides showing case information display,  
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Case Information Displays 

  

Simulator offers numerous that provide a convenient, spreadsheet-like view of the power 
system and its components and are available regardless of whether the case has an associated 
oneline diagram or not. Many case information displays are available by using the Model 
Explorer button found on the Case Information ribbon tab, although these spread-sheet like 
views appear throughout the software as stand-alone displays and embedded inside other 
dialogs. Case information displays are available for buses, bus mismatches, generators, 
generator costs, ac lines, transformers, transformer impedance correction tables, dc lines, 
interfaces, areas, zones, schedules, and all other types of objects. Other screens, such as the 
Area/Zone/Owner Filters displays to name a couple, also fall into the category of case 
information displays. There are many different characteristics associated with the Case 
Information Displays, as discussed in the following topics: 

Colors and Cell Styles 

Using Cell Handles 

Case Information Toolbar 

Sorting Records 

Configuring the Case Information Displays 

Finding Records 
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Configuring the Case Information Displays 

  

The content and format of all case information displays can be controlled through the Display / 
Column Options dialog. This dialog can be viewed by clicking Display/Column Options from 
the case information display’s local menu. 

To reset all case information display properties to their default settings, including column and 
data field associations, click the Reset All to Default Values button.  

To save your changes and close the dialog box, click OK. To save your changes without 
closing the dialog box, click Save. To undo the changes you have specified and close the 
dialog box, click Cancel. Finally, click Help to view the corresponding help screen. 
  

Column Options 

Available Fields 

This list contains all the fields available for addition to the respective case information 
display. You may select several entries from this list by holding down the Shift and Control 
keys. Hold down the control key to select several individual fields. Hold down the Shift key 
to select all fields between two successive mouse clicks. You may then add multiple fields to 
the Shown fields (see Add below). 

Show these fields in this order 

This list contains the fields which are presently shown on the respective case information 
display. You may select several entries from this list by holding down the Shift and Control 
keys. Hold down the control key to select several individual fields. Hold down the Shift key 
to select all fields between two successive mouse clicks. You may then remove multiple 
fields (see Remove below) or move the order of fields (see Move below). 

Column Width 

Enter a new value to adjust the physical width of the column. This will affect all fields 
selected in the Show these fields list. 

Total Digits 

The number of digits to use when displaying values in the column (including the decimal 
point.) This will affect all fields selected in the Show these fields list. 

Decimal Places 

Number of total digits to the right of the decimal point. This will affect all fields selected in 
the Show these fields list. 

< Remove (Removing Columns) 

Click the < Remove button to remove the fields that are currently selected in the Show 
these fields list. You may also click on the selected fields in the Show these fields list and 
drag and drop the fields on the Available fields.  

Add > (Inserting Columns) 

Click the Add > button to add all selected available fields to the end of the Show these 
fields list. You may also click on the selected Available fields and drag and drop the field on 
the Show these fields list. When drag/dropping the fields, all selected fields will be inserted 
just before the field that the mouse is over when you drop the fields. Once you have added 
fields you may then utilize the  

Move Up, Move Down (Moving Columns) 
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If you selected a block of fields in the Show these fields list, you may change the order of 
the list by clicking on the Move Up or Move Down button. 

Highlight Key Fields 

Checking this option will highlight the key fields for the type of object displayed in the case 
information display presently being modified. The fields highlighted in Yellow in the two lists 
are either the Primary key fields (numbered) or the Secondary key fields (lettered). Note 
that some key fields, usually the Circuit ID, are both numbered and lettered, meaning they 
are used as both Primary or Secondary key fields. Either ALL numbered key fields OR all 
lettered key fields must be included in the list of shown columns if you intend to export the 
data to either Excel or a text file, modify it, and paste it back into Simulator. 

The fields highlighted in Green are the fields that would be necessary in Excel or an auxiliary 
file in order to create NEW objects of the type displayed when pasting from Excel or reading 
in an auxiliary file. If all of the green highlighted fields are not present in the external 
source, Simulator will not be able to create new objects that may be defined in that source, 
and will only paste information for objects that already exist in the present case. 

Frozen Columns 

The number of columns that are fixed and do not scroll when you scroll left or right in the 
display. Frozen columns will have a background color of gray instead of white. The number 
of frozen columns is 1 by default. 

Show Variable Names 

When this box is checked, the variable name corresponding to each column heading will be 
displayed in the list of available fields alongside the appropriate column heading. 

  

Display Options 

Use Area / Zone Filters 

Check this box to restrict the case information display’s record set to cover only those areas 
and zones specified by the area/zone/owner filters. If this box is unchecked, all records, 
regardless of zone or area, will be displayed. (The area/zone filters option obviously does 
not apply to the Area/Zone Filters information display.) 

Advanced Filter 

Clicking this button will open the Advanced Filters Dialog, which will allow more detailed 
filtering on the display. 

Use Custom Font / Row Height 

If checked, then the Row Height and Custom Font specifications will be used. Changing 
either the Row Height or Custom Font properties will cause this box to become checked 
automatically. If you wish not to apply your custom specifications to the active case 
information display, uncheck this box; the default font and row height settings, as defined 
under the Case Information Displays tab of the Simulator Options dialog box, will be 
reapplied. 

Row Height 

Defines the height of the rows of the case information display. 

Change Custom Font 

Defines the font with which to display the records. 

Set as Default 
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Sets the current Font and Row Height as the defaults. 

Auto Size all Column Widths 

Constrains all field widths to contain the widest data elements in each column. 
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Custom Field Descriptions 

  

Custom Field Descriptions allow specification of custom floating point, integer, and string fields 
with user-defined column headers and field names. These fields can be added to case 
information displays for all power system case data and many supporting data types. Custom 
fields are currently not available for use with case information displays listing display objects. 
By default, there are two custom fields of each type available, but any number of each type of 
field can be defined for each type of data.  

To view the Custom Field Descriptions, open Custom Field Descriptions found under the 
Case Information and Auxiliary folder on the Model Explorer. The table lists the object 
types for which custom fields have been defined, how many of each type of field has been 
defined, and any custom field captions and headers for the fields. By default, there will be 
three entries; there are two fields each for floating point, integer, and string fields for all data 
types. These defaults will be used unless specific custom fields are defined for a particular 
data type. 

To insert a new description, select Records > Insert from the case information toolbar. To 
modify an existing description, choose Show Dialog from the case information toolbar. 
Performing either of these actions will open the Custom Field Description dialog. To remove 
and existing description, choose Records > Delete. Default descriptions cannot be removed. 

The following fields are used for defining the custom field descriptions: 

Object Type 

Type of object for which the field is available. The Default type will be used for any data 
type that does not have its own definition. This field can only be set using the Custom Field 
Description dialog and cannot be changed once a description has been created.  

Field Type 

The three options for this field are Floating Point, Integer, and String. This is the type of 
value that will be used in the custom field. This field can only be set on the Custom Field 
Description dialog when inserting a new custom field description.  

Number of Type 

This value determines how many fields of the particular Field Type will be available. 

Captions for Field (comma-separated) 

Specify the caption to use for each field. These captions will appear in lists of fields for 
objects such as the list of available fields used with Display/Column options. Enter the 
captions as a comma-separated list. Leave an empty entry to not assign a particular caption. 
If a caption is not defined for a particular field, the default will be used. For example, if the 
Field Type is Integer and there are two fields defined, the Field Captions will be Integer 1 
and Integer 2. 

If captions are not defined for the fields and Captions for Headers are defined, the header 
captions will be used instead of the defaults. 

Captions for Header (comma-separated) 

Specify the caption to use for each field column header. These headers appear in the case 
information displays for the particular object type. Enter the captions as a comma-separated 
list. Leave an empty entry to not assign a particular caption. If a header caption is not 
defined for a particular field, the default will be used. For example, if the Field Type is 
Integer and there are two fields defined, the Header Captions will be Cust Int 1 and Cust Int 
2. 
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If captions are not defined for the headers and Captions for Field are defined, the field 
captions will be used instead of the defaults.  
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Custom Field Description Dialog 

  

The Custom Field Description Dialog is used to create and modify custom field descriptions for 
a selected object type. This dialog can be accessed from the Custom Field Descriptions display 
when inserting a new description by selecting Records > Insert or modifying an existing 
description by selecting Show Dialog. 

  

 
  

Object Name 

Type of object for which the field is available. Select the type from the drop-down list or use 
the Find button to search through a list of available types. This field can only be set when 
creating a new description and cannot be changed once a description has been created. 

Field Type 

The three options for this field are Floating Point, Integer, and String. This is the type of 
value that will be used in the custom field. This field can only be set when inserting a new 
custom field description and cannot be changed once a description has been created. 

Number of Type 

This value determines how many fields of the particular Field Type will be available. 

Clear Captions 

Click this button to clear out any previously defined captions. 

Field Captions 

Specify the caption to use for each field. These captions will appear in lists of fields for 
objects such as the list of available fields used with Display/Column options. If a caption is 
not defined for a particular field, the default will be used. For example, if the Field Type is 
Integer and there are two fields defined, the Field Captions will be Integer 1 and Integer 2.  
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If captions are not defined for the fields and Header Captions are defined, the header 
captions will be used instead of the defaults. 

Header Captions 

Specify the caption to use for each field column header. These headers appear in the case 
information displays for the particular object type. If a header caption is not defined for a 
particular field, the default will be used. For example, if the Field Type is Integer and there 
are two fields defined, the Header Captions will be Cust Int 1 and Cust Int 2.  

If captions are not defined for the headers and Captions for Field are defined, the field 
captions will be used instead of the defaults. 

OK, Cancel 

Click OK to accept the changes and close the dialog or Cancel to ignore the changes and 
close the dialog. 
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Calculated Fields 

  

Calculated fields provide a means of performing an arithmetic operation (minimum, maximum, 
sum, average, median, variance, standard deviation) on a group of objects based on a 
selected field. Based on the object type of the group, a calculated field can be added to a case 
information display for a given object. The calculated field value that is displayed is then based 
on the calculated field parameters and how the object type in the calculated field relates to 
the given object.  

For example, suppose that you want to find the largest line flow for all lines connected to a 
bus. A calculated field can be set up using the branch object type with a selected field of MVA 
(maximum) and the maximum operation can be performed on this field. This calculated field 
can then be associated with buses by adding this field to the bus case information display. The 
resulting values for this field will show the maximum MVA flow for all lines connected to a 
given bus. When determining the value, only the branches that have a terminal bus the same 
as the given bus will be considered, and the maximum MVA value for all of those branches will 
be reported.  

Optionally, filters can be associated with calculated fields to further specify what objects 
should be considered in the calculation.  

The calculated fields case information display can be accessed from the Model Explorer under 
Case Information and Auxiliary > Calculated Fields. Existing calculated fields can be 
modified by selecting Show Dialog from the case information toolbar, and new calculated 
fields can be added by selecting Records > Insert from the case information toolbar. Both 
actions will open the Calculated Field dialog shown below.  

  

Calculated Field Dialog 

  

 
  

Calculated Field Name 
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This is the name of the calculated field as it will appear when added to a case information 
display. Use the Save, Save As, Rename, and Delete buttons to create new calculated 
fields without exiting the dialog. Switch between existing calculated fields by choosing a 
name from the drop-down box.  

Object Type 

Type of object that will be included in the calculation. The type of object determines which 
objects this field can be used with. This information is displayed to the right of the Object 
Type option.  

Field 

Select the field to use in the calculation by selecting a field name from the drop-down box or 
by clicking the Find button to use advanced search options to locate the field. Check the 
Use Absolute Value box to use the absolute value of the field in the operation. 

Operation 

Select the type of operation to perform on the object fields.  

Treat Blank Entries 

Depending on the field selected, some objects may not have entries. Select to either treat 
these blank entries As zeros or to Ignore them in the calculation. 

Objects to be included in the operation 

This option determines if All objects of the selected type will be included in the calculation 
or if they will be filtered by Only objects that meet the filter below. 

If choosing to apply a filter, the filter can be defined by using the same options available 
when defining an advanced filter. The Set Filter Same As button can be used to select an 
existing advanced filter whose actions should be applied to this filter.  

  

Keep in mind that objects included in the calculation will first be determined by the object 
type. If for example branch is selected, then all branches will be considered. Setting a filter will 
limit the branches to only those branches that meet the filter. If the calculated field is used 
with buses, then the branches considered for a given bus will be only those branches that 
have a terminal bus the same as the given bus. If the calculated field is used with generators, 
then the branches considered for a given generator will be only those branches that have a 
terminal bus the same as the terminal bus of the given generator.  
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Case Information Customizations Display 

  

To open the Case Information Customizations display, select Case Information and 
Auxiliary > Case Info Customizations from the Model Explorer. If you have customized 
any of the case information displays for your case, you can see a list of the customized 
displays and their settings from this display. 

Case Information Customization settings cannot be inserted manually or modified on this 
display. Those modifications must be done on the actual case information display. The primary 
use of this list display is to provide you a location to save and load case information 
customizations to an auxiliary file. Customizations can be loaded from an auxiliary file by right-
clicking on the grid and choosing to load data from an auxiliary file. To save the 
customizations, right-click on this display and select Save As > Auxiliary Data. 
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Case Information Displays: Local Menu Options 

  

All case information displays have a set of local menu options. The local menu can be brought 
up at any time by right clicking on case information display. Most of the actions and options 
available in the local menu are identical to the options available in the Case Information 
Toolbar. This is depicted in the figure below. 

 
For help on most of the actions and options available in the local menu, please see the Case 
Information Toolbar help. The other options that are also sometimes available on the right-
click menu however are listed below. 

Why is this field or line disabled? 

This option will display a message showing the reason why the field is disabled. This option 
will be enabled only if the field is actually disabled. 

Help 

Display context-sensitive help for the case-information display. 

Form Control 

This menu option allows to control the case information display. 

Print 
You can print the contents of most of the case information displays by selecting Print 
from the local menu. 

Close 
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Closes the case information display. 

Make Top Left of Form Visible 

Makes the top or the left of the case information display visible, if either the top or the 
left are not visible. 

Shift Form Up 

Moves the case information display up so the bottom of the case information display can 
be visible. 

Maximize 

Maximizes the size of the case information display. 

Unmaximize (Restore) 
Restores the size of the case information display. 

Minimize 

Minimizes the size of the case information display. 
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Case Information Displays: Colors and Cell Styles 

  

The case information displays distinguish data field types by text color and cell style. Most of 
the entries on the case information display are colored using the following color convention. 
These colors can be customized using the Case Information Displays tab on theSimulation 
Options Display, which can be invoked by selecting  Simulator Options from the Case 
Options ribbon group on the Options ribbon tab. Simulator Options is also available on the 
Tools and Case Information ribbon tabs. 
  

There are three types of data fields:  

Standard Fields Fields that cannot be modified directly from the case information display 
are colored black by default.  

Enterable Fields Fields that can be modified are colored navy blue by default. When 
selected, a cell containing an enterable field will display a tiny filled square in its bottom 
right corner. This box is called a cell. 

Toggleable Fields Fields whose values can be toggled are colored green by default. The 
values contained in toggleable fields are modified by left-clicking on them. Like cells in 
enterable fields, cells in toggleable fields display a cell handle when selected. 

Besides indicating field type, color coding is also used to highlight violations of branch flow, 
generator MW or MVR output, and bus voltage constraints. Fields that are either at a limit or 
violating a limit are colored red by default. This, too, is configurable from the Case Information 
Displays tab on Simulation Options Display. 
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Case Information Displays: Using Cell Handles 

  

When selected, cells corresponding to enterable and toggleable fields exhibit a small filled 
square in their bottom right corner called a cell handle. The cell handle may be used to 
propagate the value of the selected cell to other cells in the same field.  

Suppose we have selected a toggleable or enterable cell and that we wish to copy its value to 
other records. Call this cell the source cell and its value the source value. To copy the source 
value to another record or records, perform the following steps: 
• Drag the mouse onto the cell handle until the pointer becomes a crosshair.  
• With the mouse pointer showing as a crosshair, click and hold the left mouse button.  
• With the left mouse button depressed, drag the mouse up or down from the source cell to 

select a group of records to which to copy the source value. These destination cells will 
display a yellow background when selected in this manner. 

• When you have finished selecting the destination cells, release the left mouse button. 
• A message box will appear asking whether you want to change the values of the 

destination cells to the source value. Answer Yes to complete the copy. 
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Case Information Displays: Sorting Records 

  

You can sort the entries on the case information displays by just about any field. To sort the 
records by a particular column, left-click on the column’s heading. Left-click the column’s 
heading again to reverse the sort order. 

To sort the records by the absolute value of a field, hold down the shift key as you left-click on 
the field’s heading. 

Simulator also has a more advanced sorting tool, which can be accessed by selecting 
Advanced Sort from the local menu. Advanced sort allows you to sort information based on 
values in more than one column of data. Advanced sort also allows you to sort based on the 
absolute value of numerical fields and by case sensitivity for string fields. 
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Case Information Displays: Finding Records 

  

The Find Dialog is used to find the device of the specified type on the different Case 
Information displays. The Find Dialog is available on most case information displays from the 
local menu, which can be invoked by right-clicking in the grid.  

Different Find dialogs exist for Areas, Buses, Interfaces, Lines and Zones. Note that the Bus 
Dialog is used to locate all bus objects, such as generators, loads, switched shunts and the 
bus itself. In general, the format of each dialog is similar, allowing you to find the desired 
object using either its number or name. The only exception is interfaces, for which no name is 
defined. The basics of the Find dialog are explained in the Find Dialog Basics help topic. 
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Saving Case Information Display Contents as HTML Tables 

  

Simulator's Case Information Displays allow you to save their contents as HTML tables for 
display on the world-wide web. To do this, right-click on any row of the table and select Save 
As HTML from the resulting local menu. This brings up the Table Format Dialog. Set the 
various table formatting options and click OK. Then, select the name of the file to which to 
save the HTML code. Finally, if a region of the table was selected, you will be asked if you 
want to save just the selected region as HTML. Indicate Yes to convert just the selected 
portion of the table, or click No to write the entire table as HTML. 
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HTML Table Format Dialog 

  

The Table Format Dialog allows you to set various formatting options for HTML tables. This 
form is invoked when you try to save a Case Information Displays as HTML. 
  

The Table Format Dialog is divided into two tabs, Table Properties and Table Elements. 
  

Table Properties 

This tab allows you to specify values for options that govern the appearance of the table as a 
whole. Here you can specify the following properties: 

Border Weight 

The thickness of the border to draw around each cell. Specify 0 to suppress the drawing of a 
cell border. 

Horizontal Cell Spacing 

The spacing to employ between cells that neighbor each other horizontally. 

Vertical Cell Spacing 

The spacing to employ between cells that neighbor each other vertically. 

Table Width 

The width of the table. If the Percent checkbox is checked, the width specifies the horizontal 
dimension of the table relative to the object that contains it on the screen. 

Caption 

The table title that will be printed directly above it on the web page. 

  

Table Elements 

These options control how the data will be centered in each cell. Choices include: 

Horizontal Alignment 

Controls how the text in each cell should be positioned horizontally. The default value is 
Left, but you may also choose to center or right-justify the data in each cell. 

Vertical Alignment 

Controls how the text in each cell should be positioned vertically. The default value is 
Middle, but you may also choose to align the text with the top or bottom edges of the cell. 

If any of the numeric entries (Border Weight, Horizontal Cell Spacing, Vertical Cell Spacing, 
Table Width) are left blank or zero, your browser will employ its default settings for these 
values in rendering the table on the screen. 
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Case Information Toolbar 

  

  

Directly above most case information displays , the Case Information Toolbar provides easy 
access to many Case Information Display options for formatting and customizing a list display. 
Note that all of the options are also available from the right-click local menu on the case 
information display as well. 

  

 
  

Show Dialog 

Selecting the Show Dialog option will invoke a dialog box containing more detailed 
information and settings regarding the corresponding system object. For example, clicking 
Show Dialog while a Bus Case Information Display is the active window opens the Bus 
Information Dialog. 

Display/Column Options 

The contents and format of the information display can be controlled using the Case 
Information Display Dialog. See Configuring the Case Information Displays for more details. 

Auto Size all Column Widths 

Constrains all field widths to contain the widest data elements in each column.  

 Increase/Decrease Decimals 

Adjusts the number of displayed decimal places for all cells in the selected column in a case 
information display.  

Find 

Use the Find local menu option to retrieve a record pertaining to a particular element. 
Choosing Find from toolbar opens the Find Dialog Box, which is used to find records 
pertaining to an element identified by either number or name. 

Search 

Invokes the Search for Text dialog; allows you to search for specific text in a case 
information display. 

Bus View Oneline 

On many case information displays click this button to open the Bus View Oneline to the bus 
related to the presently active cell of the case information display.  

Records Menu 

The Records Menu contains actions that apply to the specific kinds of records displayed in 
the active case information display. Custom Expressions, Bus View Oneline, Substation View 
Oneline, Quick Power Flow List and are always shown in this drop-down. For more details 
see the Case Information Toolbar: Records Menu Help. 

Geo Data View Menu 

The Geo Menu is only available on case information displays that show records related to 
the network model. For more details see the Case Information Toolbar: Geo Data Menu 
Help. 
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Set and Columns Menu 

Set contains actions for setting data or toggling data.  

Columns contains actions that act on the column such as Get Column Metrics. For more 
details see the Case Information Toolbar: Set, Toggle, and Column Menu Help. 

Copy, Paste and Send Menu 

The Copy, Paste and Send Menu contains actions that copy and paste data through the 
Windows Clipboard. In addition it contains actions that send data directly to spreadsheet 
software such as Microsoft Excel or Open Office Calc. For more details see the Case 
Information Toolbar: Copy, Paste, and Send Menu Help. 

Save Auxiliary Menu 

The Save Auxiliary Drop-Down contains actions that save data in the case information 
display to various formats. The Auxiliary File Format and Comma-Separate-Variable (CSV) 
formats are always available, but some records show other more specific formats. For more 
details see the Case Information Toolbar Save Auxiliary Files Menu Help. 

Load Auxiliary Menu 

The Load Auxiliary Drop-Down contains actions that load data records related to the active 
case information display. The Auxiliary File Format is always a choice, but some records 
show other more record-specific formats. For more details see the Case Information 
Toolbar: Load Auxiliary Files Menu Help. 

Area/Zone/Owner Filters    

Opens the Area/Zone/Owner Filters display which allows filtering of the case information 
displays by Area, Zone, and Owner. 

Filtering Menu 

The Filtering Drop contains actions related to filtering the records shown in the active case 
information display. For more details see the Case Information Toolbar: Filtering Menu Help. 

Advanced Sort 

Allows the user to custom sort the information in the display based on desired criteria. See 
Case Information Display: Sorting Records for more information. 

Refresh Display 

Select this option to update the currently displayed data to match the present state of the 
system. 

Options Menu 

Invokes a drop down menu similar to the Case Information Display options dialog. See 
Configuring the Case Information Displays for more details. 
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Case Information Toolbar: Copy, Paste and Send Menu 

  

The Case Information Toolbar Copy, Paste and Send Menu displays the identical options as 
shown in the Copy/Paste/Send menu of the case information display local menu. This is 
depicted in the figure below. The options are described below the figure. 

 
Paste 

Select Paste from the local menu to copy a record set from the Windows clipboard into the 
case information display. See Copying Simulator Data to and from Other Applications for 
more details. 

Copy Selection 

The Copy Selection menu option copies the records selected in the case information display 
to the Windows clipboard, from which the selection can be copied into other programs such 
as Microsoft Excel for further analysis. See Copying Simulator Data to and from Other 
Applications for more details. 

Copy All 

The Copy All menu option copies the entire record set contained in the case information 
display to the Windows clipboard, from which it can be copied into other programs such as 
Excel for further analysis. See Copying Simulator Data to and from Other Applications for 
more details. 

Copy / Send Special 



Text-based Information Displays 
 

510 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

The Copy / Send Special menu option will open the a dialog that allows the user to set a few 
custom options before completing the data copy. The user can choose to copy all or a 
selection, and to copy the data either to the Windows clipboard or send it directly to Excel. 
Also, you can choose to copy or send the transpose. In addition, the user can choose 
whether to use the normal column headings or variable names (see the list of fields in Data 
Argument List for Auxiliary Files) as column identifiers. Lastly, the user can specify whether 
or not to include a row containing the type of object the data represents (Object Name) and 
a row containing the column headers for each column of data. Note that for pasting the 
information back into Simulator, the Object Name and Column Heading rows must be 
contained with the data to be pasted. If you have changed the settings on this dialog and 
wish to make them the case default settings, click on the Make Default for all Copy Actions 
button.   

Send All to Excel (or to Open Office Calc) 

The Send All to Excel menu option copies the entire record set contained in the case 
information display and automatically sends it to Excel. The first time this option is selected, 
Simulator will start a new instance of Excel on your machine and paste the data on the first 
sheet. Subsequent calls to Send to Excel will continue to add sheets and paste data to this 
instance of Excel, until the Excel instance is closed manually by the user. This functionality 
works identically for the Open Office Calc spreadsheet as well. 

Send Selection to Excel (or to Open Office Calc) 

The Send Selection to Excel menu option copies the selected record set in the case 
information display and automatically sends it to Excel. The first time this option is selected, 
Simulator will start a new instance of Excel on your machine and paste the data on the first 
sheet. Subsequent calls to Send to Excel will continue to add sheets and paste data to this 
instance of Excel, until the Excel instance is closed manually by the user.This functionality 
works identically for the Open Office Calc spreadsheet as well. 
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Case Information Toolbar: Filtering Menu 

  

The Filtering Menu, contained on the Case Information Toolbar, gives access to several 
options regarding any Advanced Filters that can be applied to the active case information 
display. In addition it provides access to the Area/Zone/Owner Filters. The drop-down menu is 
shown in the following figure. 

 
  

The top of the menu has four primary buttons that appear on all case information displays. 
These four are as follows 

Advanced Filter 

Allows the user to custom filter the information in the display based on desired 
criteria. See Advanced Filtering for more information. 

 Use Area/Zone/Owner Filters  

Filters displayed records by selections made on the Area/Zone/Owner Filters display. 

Area/Zone/Owner Filters 

Opens the Area/Zone/Owner Filters display for setting the areas, zones or owners for 
which the filter should apply. 

Remove Filter 

Click this button to remove the Advanced Filter from the present case information 
display. This does not delete the Advanced Filter definition, but only removes the 
reference to it from the active case information display. The filter can easily to 
reapplied after removing it. If you would like to permanently delete an Advanced 
Filter see Advanced Filtering. 

After the top section of the menu are two sections that may or may not be available for a 
particular case information display 

  

(List of Filters) 

This contains a list of advanced filters for the type of record displayed in the active case 
information display. These filters would have already been created using either the 
Advanced Filtering dialog or by reading them from an Auxiliary File. In the example image 
above the "50" and "50MW+" entries represent filters that apply to a generator object. 

(List of Filters for Related Objects)  
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This contains a list of advanced filters whose object type is related to the type of record 
displayed in the active case information display. For example, the case information display 
shown in the figure above is showing generator records. Generator records allow you to 
filter the generator object using a Bus, Substation, Area, Zone, or Branch Filter. In the 
example above there are 5 filters defined for Bus objects (100kV+, 69, exw, jamie, and 
Loads) which can be used to filter the generator records. For more information on Related 
Object Filtering, see the  Advanced Filtering dialog. 
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Case Information Toolbar: Geo Data View Menu 

  
The Geo Menu, found on the Case Information Toolbar, contains options related to opening 
the Geographic Data View Displays based on the objects selected in the case information 
display. For more information see the help on Geographic Data Views. 
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Case Information Toolbar: Load Auxiliary Files Menu 

  

The Case Information Toolbar Load Auxiliary Menu displays the identical options as shown in 
the Load menu of the case information display local menu. This is depicted in the figure below. 
The options are described below the figure. 

 
This option will load the contents of an external file to the case information display. 

  

Auxiliary File (Any Data) 
This option allows loading an auxiliary file containing any data. 

Auxiliary File (Only Specific Data) 

This option allows loading an auxiliary file containing only data related to the current 
case information display. 

  

At the end of the menu, some case information displays show more specific formats that are 
relevant only for that type of record. For instance in the figure above you can see support for 
loading in older file formats previously supported. 
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Case Information Toolbar: Save Auxiliary Files Menu 

  

The Case Information Toolbar Save Auxiliary Menu displays the identical options as shown in 
the Save As menu of the case information display local menu. This is depicted in the figure 
below. The options are described below the figure. 

 
This option will save the contents of the case information display to an external file.  

Auxiliary File 

This option allows saving all the contents of the case information display to an auxiliary 
file. 

Auxiliary File (only selected records) 

This option allows saving the selected record set in the case information display to an 
auxiliary file. 

Auxiliary File (only selected records/columns) 

This option allows saving the selected record set and the selected columns in the case 
information display to an auxiliary file. 

CSV (Comma Delimited) 
This option allows saving all the contents of the case information display to a comma 
delimited file. 

CSV (only selected records/columns) 
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This option allows saving the selected record set and the selected columns in the case 
information display to a comma delimited file. 

HTML 

You can save the entire table or selected records to an HTML file for viewing from an 
Internet browser. For more information, see Saving Case Information Display Contents 
as HTML Tables. 

Bitmap 

This option allows saving the case information display into a Bitmap picture file. 

JPeg 

This option allows saving the case information display into a JPEG picture file. 

  

At the end of the menu, some case information displays show more specific formats that are 
relevant only for that type of record. For instance in the figure above you can see a specific 
Auxiliary File format options which automatically saves all the data related to the cost 
information of the generator. 
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Case Information Toolbar: Records Menu 

  

The Case Information Toolbar Records Menu displays a combination of the Insert/Delete 
buttons and the Records and Plot menus on the case information display local menu. This is 
depicted in the figure below. The options are described below the figure. 

 
Insert and Delete 

Many records have an Insert and Delete related buttons. These are used for inserting new 
records and deleting records. Note that some records can only be inserted or deleted in Edit 
Mode. In such cases the Insert and Delete button will be grayed out when not in Edit 
Mode.Use the Bus View Oneline local menu option  

Records Menu 

Quick Power Flow List  

Use the Quick Power Flow List local menu option to invoke Simulator’s Quick Power 
Flow List tool. 

Bus View Oneline 

Use the Bus View Oneline local menu option to bring up the Bus View Display, which 
illustrates how the selected bus is connected to the rest of the system.  

Substation View Oneline 

Use the Bus View Oneline local menu option to bring up the Substation View Display, 
which illustrates how the selected substation is connected to the rest of the system.  
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Define Expression  

Allows you to define Custom Expressions that are functions of other fields. 

Pan to Object on Open Onelines 

Selecting this option will move the view on any open oneline diagrams to focus on the 
device clicked in the table, if an object representing the device exists on the diagram. 

Record-Specific Actions 

At the end of the Record Drop-Down will be a list of options that are special for the 
particular kind of record shown in the active case information display. For example, in 
the image above for a generator case information display the option "Create Injection 
Group From Selection..." allows you to create a new injection group containing all of 
the presently selected generator records. 
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Case Information Toolbar: Set, Toggle, and Columns Menus 

  

The Case Information Toolbar Set and Columns Menus display the identical options as shown 
in the Set/Toggle/Columns menu of the case information display local menu. This is depicted 
in the figure below. The options are described below the figure. 

 
 Set All Values To 

Click on this menu item to bring up a dialog which allows you to set all the values in a 
column to the same value. For instance you might change all the buses to have an angle of 
zero degrees.  

A special trick that can be used in conjunction with this option is entering a string of the 
form "@variablename". When entering data into a field, if the string begins with the symbol 
@, then Simulator will parse the remaining part of the string to see if it matches one of the 
variable names associated with that type of object. Variable name strings are what are used 
in the Auxiliary File Format (see the list of fields in Data Argument List for Auxiliary Files). 
Essentially this trick allows you to copy one column to another column. Using this trick, you 
could change the set-point voltage of all the generators in the case to be equal to the 
terminal bus voltage of the generator. 

 Set All Values To Field 

Click on this menu item to bring up a dialog which allows you to select a field of this record 
type and then set all the values in a column to the this field. For instance you might change 
all the generator setpoint voltage to be equal to their present regulated bus voltage. This 
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represents a user-interface method of employing the special trick using the 
"@variablename" string as discussed in the Set All Value To comments above.  

Select Column(s)  

Use this option to quickly select entire columns in the grid. First highlight the cells of a single 
record for the columns you wish to highlight, and then choose this option to highlight the 
entire column. 

Select Row(s)   

Use this option to quickly select entire columns in the grid. First highlight the cells of a single 
record for the columns you wish to highlight, and then choose this option to highlight the 
entire column. 

Get Column Metrics  

This option allows you to compute the metrics for the selected column. Choosing Get 
Column Metrics from the local menu will bring the Grid Metrics Dialog. This option is only 
available for columns whose content is numeric. 

Contour Column 

Use the Contour Column local menu option to contour a column of the list display. Choosing 
Contour Column from the local menu will open the Contour Column Dialog. 

Plot Column(s) 

Select this option to plot the values in any selected columns. 
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Area/Zone/Owner Filters 

  
The Area/Zone/Owner Filters Dialog allows you to filter the information shown on the case 
information displays and other dialogs by area, zone or owner. There are a several ways to 
open the Area/Zone/Owner Filters Dialog. 

• Go to the Case Information ribbon tab, and choose Area/Zone Filters from the 
Case Information ribbon group 

• Click on the button on the Case Information Toolbar 
• There are also many buttons on user interface dialogs throughout the program that invoke 

this dialog as well. 

For small cases, you will usually not need to use this filtering capability, but it can be very 
useful for large cases. The filters display lists each area, zone and owner in the case, the 
number of buses in each, the range of bus numbers contained in each, and whether or not 
information about that area, zone or owner should be displayed. In order for a device to be 
displayed, its area, zone and owner Shown property must be set to yes. For devices which can 
belong to more than one area, zone, or owner (for instance a transmission line that connects 
two areas, i.e. a tie line), then the device will be displayed if any end of the device meets the 
area/zone/owner filter. 

You can switch between displaying the filters for the case areas or the zones by clicking on the 
associated tab. 

The area/zone/owners filters list is itself a case information display and therefore shares many 
of the same local menu options and characteristics. Using the local menu, you can search for 
an area, zone or owner by number or by name, copy records to and from other applications, 
and send the records to a printer. You can inspect an area, zone or owner by selecting Show 
Dialog from the local menu, which invokes the Area Information ,  Zone Information or Owner 
Information Dialogs. You can also change the format and content of the filters display by 
selecting the Display Column/Options item from the local menu. The records can be sorted by 
any of its component fields simply by clicking the corresponding column’s heading. 

The display’s only enterable field is the one entitled Shown, which may assume only the values 
Yes and No. For example, if the Area/Zone/Owner Filters setting for an area is No, then any 
case information display configured to enforce area/zone/owner filters will omit the area’s 
elements from the resulting record set. You can specify whether a particular case information 
display enforces filters using the display’s Display/Column Options Dialog.  

Double-click on a cell in the Shown field to toggle its value. Use the cell handle to propagate a 
particular value to multiple areas, zones or owners, or use the Toggle All Yes or Toggle All No 
local menu options to set the values of all area, zone or owner records. 
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Advanced Filtering 

  

Filtering by areas, zones and owners using Area/Zone/Owner Filtering is a quick and simple 
way to filter, however Simulator also contains the ability to perform custom filtering on case 
information displays as well. Advanced Filtering is accessed by clicking on the Case 
Information Toolbar Filtering Menu and choosing Advanced Filter or right-clicking on a Case 
Information Display and choosing Advanced Filter from the local menu. This brings up the 
Advanced Filters Dialog, which allows you to custom filter the information in the display. 
Advanced Filters are stored with your power system case.  

A Case Information Display will have the phrase "Filter: Name of Filter" in its caption if an 
Advanced Filter has been applied to it. To remove a filter from a Case Information Display, 
choose Remove Filter from the Case Information Toolbar Filtering Menu or bring up the 
Advanced Filters Dialog and click on Remove. Note that Remove does NOT delete the filter, 
but just stops using it to filter the data. You can always remove the filter temporarily and then 
come back and reapply the filter. If you want to Delete a filter, you must bring it up in the 
Advanced Filters Dialog and click on Delete.  
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Advanced Filters Dialog 

  

The Advanced Filters Dialog is shown in the following figure.  

 
When you open this dialog, you will only see filters that have been defined for the type of 
object you are trying to filter (e.g. Bus, Generator, Interface, etc…). You can choose a filter 
from the Filter Name drop-down box showing the list of filters available, or you can create a 
new filter. To make a new filter, simply click on Save As to save a copy of the present filter 
under a new name and then specify the properties of the filter as discussed below. When you 
have specified the filter as you wish, click Filter. 
Note that advanced filters are stored with the case file when the case is saved. In addition, the 
filters can be exported to a Simulator Auxiliary File for storage and import into other cases. A 
list of all advanced filters defined for a case can be viewed in the Advanced Filters case 
information display. 

To create an Advanced Filter you must specify the following things: 

Select Filter Type 

Normally this type is the same as the object type for which your are defining a filter.  

However, by changing the drop-down next to Select Filter Type, it is possible to filter based 
on data for a related object instead of for actual object. For example, an Advanced Filter for 
a Bus may exist to only show buses only with a Nominal Voltage larger than 138 kV. You 
may then want to use this filter on a case information display which shows generators. This 
is possible by changing the Filter Type to be a Bus when showing the Filter Dialog on the 
Generator case information display. Just click the drop-down to see which related objects' 
filters can be used for that particular situation. 

Note Regarding Auxiliary Files: Throughout auxiliary script commands, the ability to 
specify an advanced filter by name is available. In this context, if the use of a bus filter is 
desired in a place where a generator filter is needed, then use the string "<BUS> 
filtername" to represent the filter. 

Filter Name 

A string that describes your filter so that you can call it up from other forms in the future. 
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Condition 1, Condition2, etc… 

Describes the conditions of your filter. To define a condition 

• Specify the field you are filtering. By default, the fields in the drop-down list are limited to 
the fields presently shown as columns in the display. If you wish to choose from a list of 
all fields for the object, change the radio button setting to Show All Fields. It is very 
useful to use the Find… button to more easily search for the field you are interested in. 

• Specify the comparison operation such as "between" or "greater than". 
• Specify the values the field is compared to. Depending on the comparison operation, 

either one or two values are needed. 
• Select ABS to use the absolute value of the field value in the comparison operation. For 

Fields that are strings, select Case Sens. to make the comparison case sensitive. 

Note: The comparison operation "within integer range list" uses the same format as 
described in Entering a Range of Numbers. 

Note: To add or delete conditions click on the Add>> or Delete… button. You can also 
delete an individual condition by clicking on the X button next to the condition. 

Note: There is no limit to the number of comparisons you use for the Advanced Filter. 

Logical Comparison 

The following describes how the Filter uses the Conditions which are specified  

• AND means that all conditions should be true 
• Not AND is the opposite of AND (i.e. any one of the conditions can be false) 
• OR means that any one of the conditions can be true 
• Not OR is the opposite of OR (i.e. all of the conditions must be false) 

For advanced logical comparisons within the same filter, refer to the important note below. 

Pre-Filter using Area/Zone Filters 

When this box is checked, data is filtered first by the Area/Zone/Owner Filters and then by 
the Advanced Filter, therefore the data must meet both the Area/Zone/Owner Filters and the 
Advanced Filters in order to be shown. When this box is unchecked, the Area/Zone/Owner 
Filters are ignored.  

Enable Field to Field Comparisons 

When this box is checked, it is possible to compare two fields of the device. In order to do 
so, select Field and click on Find to select the second field to be compared. The following 
depicts what a particular condition looks like when the enable Field to Field comparisons 
checkbox is checked. 

 
  

  

  

Important Note: Once you choose a condition comparison type, that type is used for all 
conditions in the filter. Therefore if you wish to use the AND condition, all conditions you 
define will be applied using AND. There is a way to combine different conditions within the 
same filter. This is accomplished by allowing nested filters. In other words, one condition of a 
filter can be that another filter is met. To refer to one filter from within another, check the box 
Use Another Filter. Then choose whether the condition is to meet the filter or Not meet the 
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filter, then choose the filter (which must have been previously defined) from the drop down 
list of the third box, or by clicking the Find button. This allows you to define some conditions 
using one logical comparison in one filter, and then use that filter to combine those conditions 
with other conditions using a different logical comparison.  

For example, consider the logical comparison of A and (B or C). To replicate this, you would 
define one advanced filter (AF1) that contains the logic B or C. Then you can define an 
advanced filter (AF2) that uses AF1 as A and (AF1).  
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Advanced Filters Display 

  

The Advanced Filters Display is a Case Information Display available under the folder Case 
Information and Auxiliary on the Model Explorer. The purpose of this display is to list any 
advanced filters you have defined for the current case. Each record will list the name of the 
filter, the type of object the filter is for, filter logic, and whether or not a pre-filter was used. 
Advanced filters cannot be created or deleted manually from this display, but they can be 
saved to an auxiliary file or loaded from an auxiliary file by right-clicking on the display and 
choosing the appropriate Save As or Load option from the popup menu. This feature makes it 
easy to transfer defined Advanced Filters from one case to another. 
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Custom Expressions 

  

Simulator allows you to define Custom Expressions that are functions of other fields. These 
Custom Expressions can then be shown as a column in a Case Information Display. To define 
custom expressions, right-click in a Case Information Display table and choose Records > 
Define Expression from the local menu or choose Records > Define Expression from the 
case information toolbar. This brings up the Define Custom Expressions Dialog. When you 
bring up the dialog you will only see expressions that have been defined for the type of object 
shown on the Case Information Display (e.g. Bus, Generator, Interface, etc…). 

To define a new custom Expression click New.  

You can name the expression for easy identification in the list of fields for the object by filling 
in the Expression Name field. 

To define the Custom Expression, first specify which fields you would like to use in the 
expression and assign them to the variables x1, x2, …, x8. Fields can be chosen that apply to 
the type of object for which the expression is being defined or a Model Expression can be 
chosen. Model Expressions allow using either an expression that applies to model fields or 
simply a single model field. After fields or Model Expressions have been assigned to variables, 
type in the expression as a function of the variables x1, x2, …, x8. For example 

x1 * SIN(x2) + EXP(-x5) 

or 

TAN(x1) + ABS(x6)*8 - 100 

For a complete list of functions and operators that are available to you, see Functions and 
Operators Available. 

Once the Custom Expression has been defined, you may add the expression to the column of 
the Case Information Display from which is was called by clicking on Add Column… For more 
information on how to add columns to a display see Configuring the Case Information 
Displays. 
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Custom Expressions Display 

  

To open the Custom Expressions Display, select Case Information and Auxiliary > 
Custom Expressions in the Model Explorer. If you have defined any custom expressions for 
your case, you can see the list of those expressions in this display. The type of object to which 
the expression applies, the name of the expression, and the custom expression itself are 
given. The display also shows the values being represented by each of the variables in the 
custom expression. 

Custom expressions cannot be inserted manually in this display, but they can be loaded from 
an auxiliary file by right-clicking on the grid and selecting Load > Auxiliary File (any 
data)… from the local menu. Conversely, you can save a list of custom expressions in a case 
to an auxiliary file by right-clicking on the grid and choosing Save As > Auxiliary file. 
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Functions and Operators Available 

  

Below is a list of functions and operators that are available for use in Defining Custom 
Expressions: 
  

Symbol Equivalent   Description Example 

( )     Prioritizes an 
expression 

5*(1+1) = 10 

! FACT   Factorial 5! = 120fact(5) = 
120 

%     Percentage 35% = 0.35 

^ **   Raised to the 
power of 

4 ^ 5 = 1024 

*     Multiply by 3 * 6 = 18 

/     Divide by 9 / 2 = 4.5 

\ DIV   Integer divide by 9 \ 2 = 4 

MOD     Modulo 
(remainder) 

7 mod 4 = 3 

+     Add 1 + 1 = 2 

-     Subtract 9 - 5 = 4 

>     Greater than 9 > 2 = 1 * see 
note 

<     Less than 7 < 4 = 0 

== =   Equal test 5 == 4 = 0 

>= =>   Greater or equal 3 >= 3 = 1 

<= =<   Less or equal #h3E <= 9 = 0 

<>     Not equal #b10101 <> 20 
= 1 

NOT     Bitwise NOT NOT(15) = -16 

AND &   Bitwise AND #b101 AND 
#h1E=4 

OR |   Bitwise OR 13 OR 6 = 15 

XOR     Bitwise Exclusive 
OR 

9 XOR 3 = 10 

EQV     Bitwise 
Equivalence 

6 EQV 9 = -16 

IMP     Bitwise Implication 1 IMP 5 = -1 

IIF     If condition IIf(1+1=2,4,5) = 
4 

MIN     Minimum value min(10,3,27,15) 
= 3 

MAX     Maximum value max(1,9)=9 *see 
note 
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SIN     Sine sin(pi) = 0 *see 
note 

COS     Cosine cos(pi) = -1 

TAN     Tangent tan(pi) = 0 

ASIN     Arc sine asin(1) = 1.570 

ACOS     Arc cosine acos(-1) = 3.141 

ATAN ATN   Arc tangent atan(0) = 0 

SEC     Secant sec(0) = 1 

CSC     Cosecant csc(1) = 1.18 

COT     Cotangent cot(1) = 0.642 

SINH     Hyperbolic sine sinh(3) = 10.01 

COSH     Hyperbolic cosine cosh(2) = 3.76 

TANH     Hyperbolic tangent tanh(1) = 0.76 

COTH     Hyperbolic 
cotangent 

coth(1) = 1.31 

SECH     Hyperbolic secant sech(0) = 1 

CSCH     Hyperbolic 
cosecant 

csch(1) = 0.85 

ASINH     Hyperbolic arc sine asinh(2) = 1.44 

ACOSH     Hyperbolic arc 
cosine 

acosh(9) = 2.89 

ATANH     Hyperbolic arc 
tangent 

atanh(.1) = 0.10 

ACOTH     Hyperbolic arc 
cotangent 

acoth(7) = 0.14 

ASECH     Hyperbolic arc 
secant 

asech(.3) = 1.87 

ACSCH     Hyperbolic arc 
cosecant 

acsch(2) = 0.48 

ABS     Absolute value abs(-8) = 8 

EXP     e to the power of exp(3) = 20.08 

EXP2     2 to the power of exp2(3) = 8 

EXP10     10 to the power of exp10(3) = 1000 

LOG LN   Natural log log(16) = 2.77 

LOG2     Log base 2 log2(8) = 3 

LOG10     Log base 10 log10(100) = 2 

CEIL     Round up ceil(6.2) = 7 

RND     Random number rnd(1) = .969 

INT     Truncate to an 
integer 

int(6.8) = 6 

SGN SIGN   Sign of expression 
(-1, 0, or 1) 

sgn(-9) = -1 
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SQR SQRT   Square root sqr(64) = 8 
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Find Dialog Basics 

  

Many times when working with large load flow cases, it can be somewhat difficult to locate 
devices in the case information displays regarding a specific device. Simulator has many tools 
to facilitate filtering data, such as the Area/Zone/Owner filters and the Advanced Filtering tool. 
Even with these helpful tools, finding a device can still be hampered when the bus number or 
exact spelling of the bus name are not known. 

To facilitate locating devices in Simulator, you can use the Find tool to use Simulator’s 
advanced search engine for finding the device(s) you are looking for. The Find tool is available 
from the popup menus of almost all case information displays, as well as several of the various 
information dialogs in Simulator. Anywhere you see a button or menu option labeled Find… 
you can open the advanced search tool. 

Once the Find dialog has been opened, the dialog will automatically adjust to suit the type of 
device you are searching for. The caption of the dialog should reflect the type of object the 
dialog is currently attuned to locate. For most devices, such as buses, generators, loads, etc., 
there will be one list displayed at the bottom of the dialog containing numbers and names of 
the type of device you are searching for. In some instances, mostly when searching for 
branch-type devices, the bottom panel is split with a second list is displayed in the right side 
panel. This list is used to display the possible connections of the bus selected in the first list. 
For example, if bus number one is selected and it has connections to bus two and bus three, 
the second list will display the information for bus two and bus three. Thus you can search for 
a bus in the first list, then choose from the possible connections in the second list to get a 
specific branch from the list. 

Despite what type of device you are trying to find, the first few options and buttons on the 
dialog will be the same. Sort by Name and Sort by Number allow you to choose how you 
wish to find a device in the list. If you know the bus number you are looking for, choose Sort 
by Number. If you know the name, or at least part of the name, that you are looking for, 
then choose Sort by Name. The list (or first list for branches) will be sorted accordingly. 

If you wish to narrow down the list of devices to search through, you have a couple of options 
for filtering the list before searching through it. First you can make use of the traditional 
Area/Zone/Owner filters by clicking in the associated check box. If you need to set more 
specific conditions for filtering the list, you can instead click the Define Filter button to set up 
an advanced filter. Either one will reduce the number of devices in the list for the search. 

Once you have the list set up for your search, you can type in the number or name you wish 
to find in the text box. If you do not know the exact number or name, you can use wildcards 
to facilitate the search and find all possible matches for a set of characters or numbers. You 
can use a question mark (?) to represent a single character wildcard, or an asterisk (*) to 
represent a multiple character wildcard. 

For example, if you want to find bus number 10005, but all you know is the first four digits are 
1000, you can type in *1000*, and Simulator will search until it finds the first number that 
contains those four digits. You can then use the Search Next button (note that pressing 
Enter is the same as clicking Search Next) to find the next number containing the four 
numbers, and so on. The same goes for searching by name. If you are looking for bus 
ACEONE, but all you know is the name contains the string ACE, then you can type in *ACE* 
and then keep pressing Enter until you find the bus named ACEONE. By using the beginning 
and ending *, we would also find elements such as NEWACE, because the double * looks for 
strings that contain ACE anywhere in the string. Note that if you know the first few letters (or 
numbers), you can narrow down the number of elements found from the search by eliminating 
the first * from the search string. For example, to find bus ACEONE, we could have instead 
used ACE*, and this would have gone through all matches that started with ACE, ignoring 
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other elements such as NEWACE. You can also use wildcards in the middle of a string, such as 
AC*NE, and Simulator will find any name that starts with AC and ends with NE.  

Once you have entered a wildcard search, you can also click the Search All button. This will 
essentially bring up the same Find dialog again, but with the choices narrowed to those that 
meet your wildcard search. 
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Search for Text Dialog 

  

This dialog allows you to search for specific text in a case information display. Specify the text 
you want to search in Search for edit box. Clicking on Search Next will take you to the next 
field whose content matches with the text specified. The search can be made By Rows, in 
which the text is searched first in all the fields of a record, before searching in the next record. 
If the search is made By Columns then the text is searched first in all the fields of a column, 
before searching the text in the next column. If the option Match case is checked, the search 
for text will be case-sensitive. The option Find entire cells only will take you only to fields 
whose entire content matches completely with the text you are searching for. 

When checking the box Search Ignore Filters, Simulator will look through all the records of 
the type on your present case information display, but will ignore any Area/Zone/Owner 
Filtering and any Advanced Filtering specified with that case information display. If text is 
found which matches your wildcard search, but is for a record presently filtered out, then you 
will be prompted to remove the filtering so that the record can be displayed. 

When checking the box Search All Fields, Simulator will look through every available field 
which can be displayed for the type of records presently represented on your case information 
display. If text is found which matches your wildcard search, but is for a field that is not 
presently shown, then you will be prompted to add the field to the columns that are shown. 
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Model Conditions Display and Dialog 

  

Model Conditions are a type of Model Criteria. Model Criteria represent Boolean expressions 
regarding the present state of the power system model. They can be used to create a 
convenient display that shows whether the power system meets a set of criteria. They can 
also be used in conjunction with the definition of a contingency in the Contingency Definition 
Display to create contingency actions that are conditional based on the state of the power 
system. To see a list of Model Conditions, choose Case Information and Auxiliary > 
Model Conditions. 

A model condition contains two parts: a power system element and an advanced filter. The 
model condition will then return true or false depending on the result of applying the advanced 
filter to the power system element specified. Model conditions can also be used as part of a 
Model Filter. 

The Model Conditions Display is a type of Case Information display and has the abilities 
common to this type of display. To delete a model condition, right-click on the display and 
choose Delete. To insert a new model condition, right-click on the display and choose Insert. 
This brings up the Model Conditions Dialog that can be used to create, delete, and modify 
Model Conditions. 
  

Model Conditions Dialog 

The Model Conditions Dialog has three sections. The top section provides the ability to 
Save, Save As, Rename and Delete model conditions. To choose a different Model 
Condition, click on the down arrow next to the Model Condition name. 

The middle section provides a location to specify what power system element this Model 
Condition is related to. On the left is a list of Element Types that are available. When 
clicking on one of these types, the right portion of the dialog will provide you with a list of 
the elements of this type. This list is a familiar Find Dialog and provides you the ability to 
search for the element you are interested in.  

The bottom section provides a location to specify an Advanced Filter which you would like to 
have applied to the power system element chosen in the middle section. The bottom section 
of the dialog behaves identically to the Advanced Filtering Dialog. If an Advanced Filter 
exists for the type of element for which you are creating a Model Condition, you can click 
the Set Filter Same As button to choose this filter. This will then set the parameters of the 
Model Condition to be the same as the Advanced Filter. 
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Model Filters Display and Dialog 

  

Model Filters are a type of Model Criteria. Model Criteria represent Boolean expressions 
regarding the present state of the power system model. They can be used to create a 
convenient display that shows whether the power system meets a set of criteria. They can 
also be used in conjunction with the definition of a contingency in the Contingency Definition 
Display to create contingency actions that are conditional on the state of the power system. To 
see a list of Model Filters, choose Case Information and Auxiliary > Model Filters in the 
Model Explorer. 

A model filter contains a list of Model Conditions and a Boolean operator to apply to these 
model conditions. The model filter then returns true or false depending on the resulting of 
applying the Boolean operator to the Boolean results of the model conditions. 

The Model Filters Display is a type of Case Information display and has the abilities common to 
this type of display. To delete a model filter, right-click on the display and choose Delete. To 
insert a new model filter, right-click on the display and choose Insert. This brings up the 
Model Filters Dialog that can be used to create, delete, and modify Model Filters. 
  

Model Filters Dialog 

The Model Filters Dialog behaves in a manner very similar to the Advanced Filtering Dialog. 
To choose model conditions for the model filter, click the down arrows next to the model 
conditions list. You may also click the Find... button to the left of the list. To insert or delete 
model conditions from the model filter, click the Add>> or Delete button. When specifying 
more than one model condition, choose the Logical Comparison that will be used to 
compare the conditions. Finally, the top of the dialog provides the ability to Save, Save As, 
Rename and Delete model filters. To choose a different Model Filter, use click on the down 
arrow next to the Model Filter name. 

To modify the model conditions in the case, click the Modify Model Conditions Dialog. 
This will open the Model Conditions Dialog. 
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Entering a Range of Numbers 

  

On a number of displays it is often convenient to enter a group of numbers, including ranges. 
Examples include entering buses or areas to scale on the Scaling Display, or buses on the 
Quick Power Flow List. The format for this field is to enter individual numbers separated by 
commas, and/or ranges with a dash between the beginning of the range and the end of the 
range.  

For example the entry  

1-5,21,23-25 

corresponds to numbers 1 through 5, 21 and 23 through 25.  
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Copying Simulator Data to and from Other Applications 

  

You may sometimes find it useful to copy data from Simulator to other applications such as a 
word processor or spreadsheet program. Alternatively, you may want to copy data from other 
applications into Simulator. Simulator’s case information displays provide a convenient way to 
accomplish this. In particular, the Copy All, Copy Selection, and Paste options from the 
local menu allow Simulator to communicate data with other applications. 

To copy a selection of data from a case information display to another application, first select 
the range of cells to copy from the case information display. Then, right-click on the case 
information display to display its local menu, and choose Copy Selection. To copy the entire 
content of a case information display to another application, follow the same procedure, 
except choose Copy All from the local menu instead of Copy Selection. Switch to the 
application that will serve as destination for the data and use that application’s Paste 
command to finish copying the selected Simulator data to that application. Note that not only 
is the data copied, but by default so are the data headings. The data headings are very 
important to maintain if you are planning on copying data from a spreadsheet back into a 
Simulator case information display. Also note that Simulator copies the text to the windows 
clipboard with tabs delimiting each cell. 

Note: Be aware that most programs have limitations on the amount of information you can 
paste. For example, some spreadsheet programs only allow up to 256 columns and 65,000 
rows of information. Some power system information, particularly the Ybus or Jacobian 
matrices, can easily exceed these limitations. 

To paste data from another application into a case-information display, select the data in the 
other application and use that application’s Copy command. In order to paste back into 
Simulator, you must have the record type and data headings selected with the columns of 
data. The record type (or object name) must match the case information display you are 
attempting to paste into, and the data headings (or variable names) tell Simulator which 
columns of data you are pasting. In order for the data to be pasted to the correct records, you 
must include the key field columns in the data to be pasted into Simulator. Also if you are 
attempting to create new data records by pasting back into Simulator then you must include 
the required field columns as well. 

It is not necessary to copy and paste all columns or rows of data back into Simulator, as long 
as the column headings match a valid heading for the case information display. Simulator will 
skip the data under any column headings that are unrecognized. If you wish to copy data from 
a spreadsheet into a Simulator display, you must make sure they are ordered in such a way 
that all the information you wish to paste can be grouped and copied as one block of date 
from the spreadsheet. Once you have copied all the information from the spreadsheet you 
wish to transfer, switch to Simulator, open the case information display in which to paste the 
data, and select Paste from its local menu. 

Note: You can only paste values into the case information displays if the values are enterable 
on the display (shown blue by default). Also, be careful about pasting redundant data. For 
example, in the Bus Records display both voltage in per unit and voltage in kV are enterable, 
but they specify the same information. Make sure you only copy ONE of these columns into 
Simulator. Otherwise you may not get what you expect. Simulator will paste the value in 
twice, and whatever value was pasted 2nd will be used. 
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Save Case Information Data 

  

The Save Data Dialog gives you quick access to saving data from certain Case Information 
Displays in a PowerWorld Simulator Auxiliary File. 

Specify the name of the auxiliary file in which to save the data records in the text box labeled 
Name of File to Save. Instead of typing the name of the file by hand, you can press the 
Browse button to locate it. Then, indicate whether you want the objects whose data you are 
writing to the file to be identified by number or by name. Finally, to ensure that only the 
records currently listed in the Case Information Display are written to the auxiliary file, check 
the Save Only Records Listed in this Display checkbox. Otherwise, data for all such 
objects in the entire system will be saved to the file. 

When you have finished setting these options, click OK. If you changed your mind and do not 
want to save the data to a file, click Cancel. 
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Key Fields 

  

Key fields are necessary fields when attempting to paste data into a Case Information display 
from another data application. Other fields are also considered required fields for the purpose 
of creating new objects in Simulator by pasting or loading information from another source, 
such as Excel or a PowerWorld Auxiliary file. The key fields are easily identified from a few 
different locations. 
  

Column Headings 

The column headings of case information displays are colored to indicate fields that are key 
fields. Any field that is a key fields will be highlighted yellow. Also note that some fields are 
highlighted green. These fields are required fields that are necessary when you are 
attempting to create a new object by pasting or loading the data from another application. If 
the necessary key fields (yellow) are not included in the data loaded from another source, 
the information for that object is ignored. If all of the required fields (green) are not 
included in an object that is detected as new, Simulator will skip it. If all the required fields 
are present, then Simulator can create the new object. Note that for new objects, the key 
fields are necessary as well. 

Display/Column Options 

The Display/Column Options dialog, available by right-clicking on any case information 
display, also has the capability to highlight both the key fields and required fields, as 
described above. The check box labeled "Highlight Key Fields" will enable highlighting of the 
field names in the two lists on the display. 

Export Object Fields 

This option from the Help menu in Simulator allows you to export a list of most fields for 
each type of object in a case. The list also indicates which fields are key fields and required 
fields for each object. You can output this list of fields as either a text file or into Excel. 

  
The following table lists some of the more commonly accessed key fields needed when 
attempting to Paste data into existing objects in a Case Information Displays from another 
data application. 
  

Type of Data Data Description 
  

Necessary Key 
Columns for Paste 

    

Area Area Records Area Num     

Bus Bus Records Number     

DC Line DC Line Records Rectifier Number Inv 
Number 

Num 

Gen Gen Records Number ID   

Interface Interface 
Records 

Name     

Line/Transformers Line Records From Number To 
Number 

Circuit 

Load Load Records Number ID   

Substations Substation 
Records 

Sub Num     
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Switched Shunt Switched Shunt 
Records 

Number ID   

Zone Zone Records Zone Num     
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Required Fields 

  

Required fields are necessary fields when attempting to create new objects by pasting data 
into a Case Information Display or when reading data from an PowerWorld Auxiliary. These 
fields are in addition to the key fields which identify the object.  

There are two purposes of the required fields. First there are some fields for which an 
appropriate default value is not apparent thus by requiring these fields it forces the 
specification of the value. Second, when pasting data into Simulator it is possible that the 
record will not exist in the case. Simulator will then determine whether to create these records 
by looking to see if the required fields are specified. By doing this, it prevents the accidental 
addition of records. For instance you may have an Auxiliary File that sets the Monitor field of 
all branches in your case to Yes or No. If Simulator runs across a branch between two buses 
that exist, but whose circuit ID does not exist, then Simulator will just skip this line from the 
Auxiliary File. It will not be possible to accidentally create a bunch of new transmission lines 
with default impedance parameters because the R and X impedance parameters are required. 

The required and key fields are easily identified from a few different locations. 

Column Headings 

The column headings of case information displays are colored to indicate fields that are key 
fields. Any field that is a key fields will be highlighted yellow. Also note that some fields are 
highlighted green. These fields are required fields that are necessary when you are 
attempting to create a new object by pasting or loading the data from another application. If 
the necessary key fields (yellow) are not included in the data loaded from another source, 
the information for that object is ignored. If all of the required fields (green) are not 
included in an object that is detected as new, Simulator will skip it. If all the required fields 
are present, then Simulator can create the new object. Note that for new objects, the key 
fields are necessary as well. 

Display/Column Options 

The Display/Column Options dialog, available by right-clicking on any case information 
display, also has the capability to highlight both the key fields and required fields, as 
described above. The check box labeled "Highlight Key Fields" will enable highlighting of the 
field names in the two lists on the display. 

Export Object Fields 

This option from the Help menu in Simulator allows you to export a list of most fields for 
each type of object in a case. The list also indicates which fields are key fields and required 
fields for each object. You can output this list of fields as either a text file or into Excel. 

  
An example of required fields for an object is for a Branch object. For a branch object, the key 
fields are the from bus number, to bus number and the circuit ID. Required fields are the 
Impedance Values R, X, and B and the first three ratings A, B, and C. Without specifying 
values for these fields you can not create a new branch. 
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Contour Column Dialog 

  

The Contour Column Dialog allows you to contour case information display columns. 

The Contour Column Dialog has two tabs:  

Contour Type 

Custom Color Map 
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Contour Column Type 

  

Color Map 

Choose from various predefined color maps using the color map combo-box. A color map, 
along with the values specified, defines how values are mapped to a color on the contour 
image. 

If a color map showing both high and low values is desired (such as for bus voltages), use 
of "Blue = Low, Red = High" is recommended. If a color map showing only high values is 
desired (such as for line flows), use of "Weather Radar, Nominal to High" is recommended. 

A user may also define additional color maps by going to the Custom Color Map Tab.  

Reverse Color Map Colors 

Check this box to reverse the colors of the selected color map, so the low color becomes the 
high color, and vice versa. 

Brightness 

Modify the brightness track bar to change the brightness of the color map. 

Use cell values directly 

Select this option to use the cell values to do the contouring. 

Use the specified field below 

Select this option to use a different field value to do the contouring. 

Value 
Select the quantity to use in the contouring from the Value dropdown box or click the 
Find Value button to find the desired field. 

Draw Color Key 

Checking this box will cause the contour to draw a color key showing which colors are 
mapped to which values. You can also give the color key a title, unit label, and specify the 
number of digits to display in numerical values. 

Title 

Title for the color key. 

Entry Labels 

Units of the contoured value displayed on the color key. 

Dec. Pts. 

Number of decimal places of the contoured value displayed on the color key. 

Scalar 

Multiplication factor that can be applied to the values when drawing the color key. 

Use Equal Spacing For Discrete Maps 

This option will draw the color key with equal spacing for all colors in the map, regardless of 
how close or distant the values the colors represent. 

Use absolute value 

Check this check-box to use the absolute values of the quantity selected at the Value 
dropdown box (above). 

Values 
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These values along with the color map define how to convert your values into a color for the 
contour. The values are: 

Maximum  The largest value allowed in the contour. All values above this will be mapped 
to the highest color. This value corresponds to 100% in the color map. 

Break High This value is used by some color maps to highlight a lower limit. This value 
corresponds to 75% in the color map. 

Nominal  This value is the nominal value for the contour. Values around this will be 
mapped to the middle color. This value corresponds to 50% in the color map. 

Break Low This value is used by some color maps to highlight a lower limit. This value 
corresponds to 25% in the color map. 

Minimum The smallest value allowed in the contour. All values below this will be mapped 
to the lowest color. This value corresponds to 0% in the color map. 

Note: a representation of the color map is shown to the right of the values. 
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Grid Metrics Dialog 

  

The grid metrics dialog allows you to determine the metrics for a set of columns. The metrics 
determined include: Sum, Average, Variance, Standard Deviation, Maximum, Minimum, Total 
Items, and Total Non-Zero Items. 

By default the dialog is set to determine the metrics for the whole column of the case 
information display where the option has been selected. However, the selected record set can 
be modified. The Start Column and End Column values specify what columns to include in 
determining the metrics. The Start Row and End Row values specify what records to include 
when computing the metrics. If the option Treat blank cells as zero is checked, then any 
blank cells will be considered as zero when computing the metrics. Instead, if the option 
Ignore blank cells for calculation is checked, any blank cell will be taken out of the 
metrics calculation. Check Use Absolute Values to use the absolute values of field values for 
the metrics computation. Finally, click Update Metrics to determine the metrics with the new 
set of options. 
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Auxiliary File Export Format Description (For both Display and Power System) 

  

Definition of an Export Format Description  

An export format description consists of the following items:  
1. A set of object types 
2. The fields and subdata to be exported for each object type, including how each field 

should be formatted when written (e.g., number of digits, number of decimal places)  
3. The format (comma-delimited, space-delimited, etc.) that should be used when writing the 

object data to disk.  

 For instance, an export format description might have two object types defined—buses 
and generators—with indications to export the bus numbers for each of these objects 
and to write this information to a space-delimited .AUX file.  

Types of Export Format Descriptions 

Export format descriptions can be defined for both the Display Objects and the Power 
System Objects,  

•  Display objects, e.g., background lines, pie charts, displayed fields, etc. Export format 
descriptions for display objects are defined by selecting Display Objects Export Format 
Description… on the Onelines ribbon tab, under the List Display Menu on the Active 
ribbon group.  

• Power system objects, e.g., buses, loads, generators, etc. Export format descriptions for 
power system objects are defined by selecting Power System Objects Export Format 
Description from the Case Information ribbon tab on the Case Data ribbon group.  

The dialogs used to define both types of export format description are very similar; any 
differences between the two dialogs will be clearly noted below. 

Export Format Description Dialog 

Clicking on Display Objects Export Format Description or Power System 
Objects Export Format Description, opens the Export Format Description Dialog. 
There are several buttons at the bottom of the dialog:  

• OK : save the current settings to the selected export format description, and close the 
dialog 

•  Write Current Format Description to File : writes data to a file using the current 
settings. A dialog pops up to select the filename for storing the data. If the file already 
exists, the data is appended; otherwise, a new file will be created 

•  Cancel : do not save the current settings and close the dialog  
• Help : open the help associated with the dialog .  

The other parts of this dialog box are discussed in detail below 

Format Name Section  

The uppermost part of the dialog box is used to manage the set of export descriptions. 
Once one export description has been saved (by clicking Save or Save As, after defining 
some object types), a drop-down box will appear which allows selection of an export 
format description from the set of export format descriptions saved with the case: The 
buttons underneath the drop-down box have the following functions: 

• New : clear the rest of the form in order to define a new export format description  
• Save : save the information in the rest of the dialog box to the export format description 

currently selected in the drop-down box. If no export format description is selected, this is 
equivalent to clicking Save As. 

• Save As : save the information in the rest of the dialog box to a new export format 
description; a dialog will pop-up asking for the name of the new export format description. 
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• Rename : rename the currently selected export format description 
• Delete : delete the currently selected export format description 

The list of export format descriptions for display objects and power system objects is 
kept separate, so the drop-down box will only contain export format descriptions 
defined for the object type selected from the menu (Display Objects Export Format 
Description Dialog or Power System Objects Export Format Description Dialog).  

File Type and Field Defaults  

The next section of the dialog box is used to define the format to save the data, and 
the default formatting of any numeric fields that are to be saved. Currently, there are 3 
options for the file type:  

• AUX (space) : output the data using a space-delimited .aux file format 
• AUX (,) : output the data using a comma-delimited .aux file format  
• CSV : output the data to a comma-separated-values (CSV) file. This type of file can be 

easily imported into any spreadsheet or database software.  

In the Defaults for Exporting Fields section, the up/down arrows can be used to 
change the default number of total digits and digits to the right of the decimal place 
used in exporting numeric values. These values may be overridden in the Select Fields 
form for individual fields. 

Object Type and Filter Method Section  

The two-column section on the left side of the dialog box is used to define object types 
and a filter for each object type.  

Object Type  

The first column is used to specify which object types are to be exported. To 
insert a new object type (corresponding to a new row) into the export format 
description, there are two options—either click the New button above the Object 
Type column heading, or right click on a row and select Insert. Upon doing 
this, a dialog will pop up to choose an object type:  

Type into the text box to search for a particular object type. The list of object 
types depends on the type of export description being defined. When defining 
display object export descriptions, only display object types will show up in this 
list; similarly, when defining power system export descriptions, only power 
system objects will show up.  

Clicking Choose will insert the object type into the list of object types to be 
exported.  

Double-clicking an existing object type will pop-up this same dialog box, allowing 
the object type to be changed. Doing so will empty the exported fields, subdata, 
and filter method.  

Filter Method  

The second column is used to define an object filter. The default behavior is to 
export all objects without any filtering, but this can be changed by double-
clicking on the filter description. Upon double-clicking on the filter description, a 
dialog will appear allowing you to choose the filter. The options available for 
determining which objects are exported are as follows 

• All : export all objects, disregarding any filters defined in the current case 
• Use Area/Zone/Owner Filter : only export those objects that satisfy the currently 

defined area/zone/owner filter. Clicking on Select Area/Zone will pop up the dialog box 
used to define area/zone/owner filters. 
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• Use Selected : only export those objects that have the Selected field set to Yes. Clicking 
on Select pop up the dialog box used to set the Selected flag for each of the objects in 
the case. Note that this particular option does not exist for display objects, because 
display objects do not currently support the Selected field.  

• Meets Filter : only export those objects that meet an advanced filter, which can be either 
selected from the drop-down box or defined using the Define Filter button.  

Fields And Subdata To Be Exported  

After specifying an object type (and, optionally, a filter), selecting the row on the left 
side of the dialog box will allow you to specify the fields and subdata to be exported.  

Fields To Be Exported 

By default, no fields are selected for export. To define fields for export, click on 
the Modify button to the right of the Fields heading the Select Fields dialog 
box will popup. This dialog is used to specify which fields are to be exported, 
along with any field-specific formatting of numerical values . Generally the dialog 
behaves identically to the Configuring Case Information Displays Dialog, so for 
more detailed help see that topic. There are parts of the dialog that behave 
differently however, and these are described as follows. 

• Total Digits / Dec Places : these two boxes are used to set the number of total digits 
and the number of decimal places to use when writing the data for the fields current 
selected in the Selected Fields section. Leaving these two boxes blank means that the 
default number of digits and decimal places should be used. Also, if multiple fields are 
selected that have different settings for the number of digits or number of decimal places, 
these boxes will be grayed out, but still enterable. Once entering a value into either box, 
all selected fields will then have the same setting, and the box will no longer be greyed 
out.  

Subdata To Be Exported  

By default, no subdata is selected to be exported. Also, many objects (e.g., Bus 
and Area) do not have subdata associated with them, so the Modify button will 
be greyed out. If an object type does have subdata, then the SubData definition 
section will be grayed out.  

To add subdata that should be exported, click the Modify button to the right of 
the SubData heading. This brings up the Select SubData dialog. A description of 
the options/settings on this dialog follows. 

• Available SubData : lists the SubData that exist for this object type. If Exclude subdata 
already selected is checked, then only SubData that is not already in the Selected SubData 
section will show up in this list. 

• Exclude subdata already selected : if checked, then the Available SubData section will 
only contain items that are not already in the Selected SubData section 

• Selected SubData : lists the SubData to be exported for this object type 
• Add -> : set the currently selected SubData in the Available SubData section to be 

exported 
• <- Remove : set the currently selected SubData in the Selected SubData section to not 

be exported 
• OK : save the settings and close the dialog 
• Save : save the settings, but leave the dialog open 
• Cancel : do not save the settings and close the dialog 
• Help : click on this to open the help associated with the Select Fields dialog  
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Geographic Data View 

  

Geographic Data Views allow the quick creation and formatting of graphical representations of 
buses, generators, loads, switched shunts, transmission lines, substations, areas, zones, super 
areas, and injection groups. Latitude and longitude coordinates specified with buses and 
substations are used to place objects geographically on a display. The latitude and longitude 
coordinates must be specified in order to use this feature. Object attributes such as color, size, 
rotation rate, rotation angle, and visibility can easily be formatted based on the associated 
data object field values. 

To create a Geographic Data View, open a case information display for the desired element 
type, select the elements for which to add geographic representations, and either right-click 
on the object grid and choose Geographic Data View > Geographic Data View from the 
local menu or choose Geo > Geographic Data View from the case information toolbar. Use 
the Select Column, then Geographic Data View option to select an entire column of 
elements. The column in which the elements are selected determines the initial selection of 
the field to use for attribute settings. The Geographic Data View Customization dialog will 
open. 

  

Geographic Data View Customization Dialog 

  

 
  

Oneline for Geographic Data Addition 
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When creating a new geographic data view, the oneline to which to add the geographic data 
view objects must be set. Choose either to Use Already Open Oneline and then select a 
oneline from the dropdown list of available onelines or choose to Open a Oneline and then 
either type in the name of a PWD file or click Browse to select a one.  

Because geographic data views are dependent on having geographic latitude and longitude 
information available, the oneline that is selected must have a valid map projection in use. 
Only those open onelines that currently have a map projection in use will be listed in the 
dropdown box and any oneline opened from a file will be checked for a valid map projection. 
If a valid map projection does not exist, new geographic data view objects will not be added 
to the oneline. 

Create Oneline with Geographic Borders 

Click this button to create a new oneline diagram with first being prompted to add 
geographic borders. A default name will be assigned to the new oneline and that oneline will 
be added as the selected oneline in the Use Already Open Oneline dropdown.  

Setting Attributes for Geographic Data View Display Objects 

Before adding new geographic data view objects, the attributes associated with the objects 
should be set. These attributes are stored in Geographic Data View Styles. 

Create Empty Oneline 

Click this button to create a new oneline diagram. A default name will be assigned to the 
new oneline and that oneline will be added as the selected oneline in the Use Already Open 
Oneline dropdown. 

Create Geo Data View Display and Close Dialog 

Click this button to accept all of the option settings, add new geographic data view objects 
to the selected oneline, and then close the dialog. 

Cancel 

Click this button to close the dialog without adding and new geographic data view objects. 
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Geographic Data View Styles: Fields and Attributes 

  

The Field and Attributes options associated with Geographic Data View Styles allow the 
formatting of the geographic data view display objects depending on the values of fields of 
their linked data objects.  

  

 
Attribute 

Most of the attributes can have a Default value or a value that is dependent on the value of a 
selected field. When the Use box is checked for a particular attribute, the field selected in the 
Field Lookup is used to determine the value of the attribute based on either a Color Map or 
Value Map lookup. Otherwise, the default value will be used. Line Thickness, Total Area, 
Rotation Angle, and Rotation Rate attributes all use value map lookups. Line Color and Fill 
Color both use color map lookups. When determining the Field Lookup, either select the field 
from the drop-down or use the Find button to open the Find field dialog for easy searching.  

When an attribute is selected, either by clicking on one of the options settings for that 
attribute or just clicking the background box for that attribute, the appropriate color map or 
value map for that attribute will be displayed in the right-hand panel.  

Line Thickness 

Thickness of the line making up the outside border of the display object.  

Line Color 

Color of the line making up the outside border of the display object. 

Fill Color  
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Fill color of the display object. The Fill Color will be used only if the Use Fill box is 
checked. 

There are two choices of Field Lookup for this attribute. The top choice is enabled 
regardless of the choice of object Style. The bottom choice is only enabled when the Kite 
style is chosen. The Kite style allows two different fields to be displayed in one object. 
This is useful for displaying fields like Mvar Maximum and Mvar Minimum. The top field 
indicates what field will be used to format the top half of the Kite, and the bottom field 
indicates what field will be used to format the bottom half of the Kite.  

When using the Kite style, use of the two different Field Lookups can be selected 
independently and each has a separate color map. When not choosing to use one or 
both of the Field Lookups, that appropriate half of the Kite shape will use the default Fill 
Color choice. To switch between color maps for the two Field Lookup choices, either click 
on the field drop-down for the appropriate half of the Kite or click the  button that will 
appear next to the field choices when the Kite style is selected. 

Total Area 

This determines the size of the display object. Check the option to Use Auto Width of 
Objects for the width of the objects to be determined automatically. If this option is not 
checked, the Width can be set manually. The height or size is always determined as a 
function of the width and can be set with the Size to Width Ratio. When using the 
Field Lookup table the total area of the object is determined based on the Characteristic 
Value returned. The dimensions of the object are then determined based on the total 
area and the Size to Width Ratio.  

There are two choices of Field Lookup for this attribute. The top choice is enabled 
regardless of the choice of object Style. The bottom choice is only enabled when the Kite 
style is chosen. The Kite style allows two different fields to be displayed in one object. 
This is useful for displaying fields like Mvar Maximum and Mvar Minimum. The top field 
indicates what field will be used to format the top half of the Kite, and the bottom field 
indicates what field will be used to format the bottom half of the Kite. Even though two 
fields can be chosen when using the Kite style, only one value map is used for the Field 
Lookup. When using the Kite style and using the Field Lookup the total area of the object 
is based on the sum of the lookup values returned for both fields.  

Rotation Angle 

Static angle of rotation of a display object in degrees. 

Rotation Rate 

This value is given in Hz and indicates how many times per second an object should do a 
full rotation. This is used in conjunction with the General Option for Animation Control. If 
animation control is not enabled, the rotation rate has no effect on how the objects are 
displayed. 

Visibility 
This attribute can prevent display objects from being shown if certain conditions are not 
met. Choosing the All Visible option will always show all of the display objects 
associated with this style. If choosing the option Only visible if field is non-zero, 
select a field from the drop-down box. Only those objects whose selected field is non-
zero will be visible. If choosing the option Only visible if filter is met, select a filter 
from the drop-down box or click the Find button to search for an existing filter or create 
a new one. Only those objects that meet the selected filter will be visible. Note that the 
visibility attribute is only applied while in Run Mode. All objects will be visible in Edit 
Mode regardless of how this option is set. 

Color Map  
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Color maps are used with Line Color and Fill Color attributes. The Field Set Metrics section 
simply gives some statistics on the values of the selected field for the data objects. These 
metrics are provided to aid in the setting of the breakpoint values for the color map.  

Color Map 
Choose from the predefined color maps using the drop-down. 

Reverse Color Map Colors 

This checkbox reverses the mapping of the color map, converting the colors 
corresponding to the high values into the colors for the low values, and vice-versa. 

Use Discrete Color Map 

Check this box to make a discrete color map, that is without having smooth transitions 
between colors. 

Brightness 
Modify the brightness track bar to change the brightness of the color map. 

Use Absolute Value 

Check this box to use the absolute values of the field values when mapping the field 
values to colors. 

Breakpoint Values 

The breakpoint values determine how the field values will map to colors.  

Set Breakpoints from Metrics 

As different fields are chosen for attributes, the Field Set Metrics will be updated to 
reflect the field values. Click this button to update the breakpoint values based on a new 
set of Field Set Metrics. 

Value Map 

Value maps are used with Line Thickness, Total Area, Rotation Rate, and Rotation Angle 
attributes. The Field Set Metrics section simply gives some statistics on the values of the 
selected field for the data objects. These metrics are provided to aid in the setting of the 
Field Values and corresponding Characteristic Values.  

The attribute value for a particular display object is set to the Characteristic Value that 
corresponds to the field value of the corresponding data object. Characteristic values will be 
interpolated if the field value does not fall exactly on a value that has been defined in the 
table. To insert entries into the table, right-click on the table grid and choose Insert from the 
local menu. Choose Delete from the local menu to remove entries.  
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Attributes for All Objects In Style 

These attributes apply to all objects independent of any specific field value. 

Layer 
Type in the name of an existing layer to assign the objects to an existing layer, or type in 
the name of a new layer to have that layer created and add the objects to that layer. 

Stack Level 

An object's stack level dictates what objects it will appear above and which objects it will 
appear below on a oneline display. For example, circuit breaker and pie chart objects 
have a default stack level of Top. Therefore, anything with a stack level of Middle, 
Background, or Base will appear underneath pie charts and circuit breakers on the 
oneline display. Objects that are within the same stack level and are drawn in the same 
location will result in the last object drawn being the visible object on the display.  

Line Dashed 

This determines the appearance of the line making up the outside border of the display 
object. This line can be solid or one of the dashed options. 

Immobile 
Check this box to keep the geographic display objects from being moved on the oneline 
diagram. 

Set Font 

Click this button to bring up the Select Font Options dialog. The changes to font are 
limited to Font Name, Font Color, and special Font Effects of Bold, Underline, Italic, and 
Strikeout. There is no option for setting the font size because this is automatically 
determined based on the size of the display object. 
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Geographic Data View Styles: General Display Options 

  

The General Display Options associated with Geographic Data View Styles are applied to all 
geographic data view objects independent of any field value.  

  

 
Style 

The style determines the shape of the geographic data view display object used to represent 
the selected data records. 

Object ID 

Each geographic data view display object can be identified by name, number, or a 
combination of the two. When a choice other than None is selected, the appropriate 
identification for that object will be displayed. When Prefix ID with Class Type is 
selected, the object class type will be prefixed along with the main identifier. This option is 
useful when trying to distinguish between the different types of objects shown on a given 
display. 

Selection Options 

Geographic data view display objects can be formatted differently when they are selected as 
opposed to not selected. Check the option Can Be Selected to allow objects to be 
formatted based on the set options when they are selected. Line Thickness determines the 
thickness of the border line around the outside of the display object when it is selected. 
Line Color determines the color of the border line around the outside of the display object 
when it is selected. 

Animation Control 

Geographic data view display objects are capable of being animated if a Rotation Rate other 
than zero is specified with the attributes. Check the Enable Animation box to animate the 
objects using this style. The Interval determines how often the display is refreshed during 
animation. 
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Geographic Data View Styles 

  

Each geographic data view object has an associated Geographic Data View Style. The style 
determines how the object is going to be displayed and contains options for setting various 
attributes associated with the object. Each style refers to a particular type of object. 
Geographic data view objects cannot be individually formatted; they will always obey the 
formatting of their associated style. 

The Geographic Data View Options dialog is used to create and modify styles that will 
determine the appearance of geographic data view objects. This dialog is part of the 
Geographic Data View Customization dialog when adding new geographic data view objects to 
a display, but it becomes a stand-alone dialog when modifying the styles for existing objects. 
To open as a stand-alone dialog, right-click on an existing geographic data view object and 
choose View Geographic Data View Options from the local menu. 

Usually, groups of objects share the same geographic data view style. Keep in mind that 
changing the options in a style will change all of the objects that use this style. 

  

Geographic Data View Options Dialog 

The Geographic Data View Options dialog is made up of four main sections and tabs: 

Class and Field Display Option Sets 

 
This section allows the saving, renaming, and deleting of Geographic Data View Styles. Only 
those styles for a particular Class Type will be displayed in the Style Name dropdown box. 
Style names must be unique within a Class Type. Geographic data view styles can be stored 
in the standard auxiliary file format. When saving or loading an auxiliary file from this dialog, 
all geographic data view styles will be stored or loaded regardless of the current class type. 
The default is to store the information in a data auxiliary file, .AUX, but these objects are 
also supported in display auxiliary files, .AXD. 

General Display Options 

Fields and Attributes 

Object Records 

The object records tab lists the data objects that are linked to the geographic data view 
style, through their associated geographic data view display objects, selected when the 
dialog is opened. The caption of this tab will be updated to reflect the class type of object 
that is represented. For example, if viewing bus objects, the caption will be Bus Records 
instead of Object Records. These are either the data objects selected before creating a new 
geographic data view or data objects represented by existing geographic data view objects 
that are using the selected style. The format of the display objects represented by these 
data objects will be changed based on any changes made to the options. To assign a group 
of geographic data view display objects to a new style, simply select a different style than 
the style in place when opening the dialog and click either the OK button on the 
Geographic Data View Options dialog (existing data object was selected) or the Create 
Geo Data View Display and Close Dialog button on the Geographic Data View 
Customizations dialog (new geographic data view objects are being created).  

To change the style of a single geographic data view display object and assign it to a new 
style, use the Display Explorer. Within the Display Explorer, case information displays for 
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geographic data view objects are available. The style is given in the field Geographic Data 
View Style Name (variable name GEODATAVIEWSTYLENAME). To change the style, 
change the name listed in this field to a style that is available for the class of object being 
changed.  
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Custom Case Information Display 

  

To open the Custom Case Information Displays, go to the Case Information ribbon tab, and 
choose Custom Case Info from the Case Data ribbon group  
Custom Case Information Displays can be used to create a display very similar in appearance 
to a spreadsheet workbook with several worksheets. This display can show any information 
that can be shown on a case information display, but also allows you to customize the layout 
of the information in any manner.  

There are three buttons which allow you to Rename the present sheet, add a New sheet, or 
Delete the present sheet.  
  

There are three different kinds of cells allowed on this display 
• Blank Cell – contains nothing 
• Plain Text Cell – contains a user-entered string with no link to any data in the model. 
• Model Field Cell – contains a link to model field similar to inserting a model field on a 

oneline diagram 
Each cell of the display will behave differently depending on the Custom Case Info Mode. 
There are four distinct modes that control the user interaction and operation of the custom 
case information display. These four modes and the effect they have on the display are 
described in topics 
• Define Fields/Strings 
• Change Field Data 
• Show Fields Primary 
• Show Fields Secondary 

 



Text-based Information Displays 
 

560 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Define Fields/Strings 

  

The "Define Fields/String" mode is the primary mode for use when setting up a new Custom 
Case Information Display. The three kinds of cells behave as follows in this mode. 

Blank Cell 

To convert to a Plain Text Cell, just type in the cell. To convert to a Model Field Cell, double-
click on the cell to open up a dialog for defining the model field. 

Plain Text Cell 

These cells will appear in the Case Info Display Enterable Color (blue by default). To change 
them just type on the cell. When pasting into such a cell or editing it directly it will parse the 
string entered trying to create a Model Field as though the string represents the model fields 
as shown in the Show Fields modes. If the string does not represent such a field, then it will 
remain a Plain Text Cell 

Model Field Cell 

Model Field cells will not be enterable. In order to edit these fields, you must double-click on 
the cell to open a dialog for defining the model field. 
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Change Field Data  

  

The "Change Field Data" mode can be used to edit the data referred to by the model fields on 
a custom case information display. The three kinds of cells behave as follows in this mode. 

Blank Cell 

Blank cells may not be edited in any manner. 

Plain Text Cell 

Plain Text cells may not be edited in any manner. It will appear in a special color defined for 
the custom case information display which may be specified from the local menu of the 
workbook tabs. By default this color is dark gray. 

Model Field Cell 

Model Field cells will behave according to the field to which they refer. Enterable fields will 
be enterable, toggleable fields will toggleable, etc… When pasting in the sheet in this mode 
you will be modifying the model data directly. In the following picture there are three fields 
in cells C4, C5, and C6 that refer to read-only, enterable, and toggleable field respectively. 
The fields are labeled using the plain text cells in D4, D5, and D6. 
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Show Fields Primary 

  

The "Show Fields Primary" mode is used for interacting with an external spreadsheet to create 
the model field links in custom case information displays. The three kinds of cells behave as 
follows in this mode. 

Blank Cell 

Blank cells behave the same as for the "Define Fields/Strings " mode. 

Plain Text Cell 

Plain Text cells behave the same as for the "Define Fields/Strings " mode. 

Model Field Cell 

Model field cells will display a string which represents information about the model field link. 
The format for this string will be  

‘model field name’ ‘variable name’ totaldigits decimalpoints IncludeUnits 
  

The model field string will use the primary key fields. 

  

When pasting into such a cell or editing it directly it will parse the string entered trying to 
create a Model Field as though the string represents the model fields as shown in the Show 
Fields modes. If the string does not represent such a field, then it will remain a Plain Text 
Cell. 
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Show Fields Secondary 

  

This mode is identical to the Show Fields mode, except that it will show model fields string 
using the secondary key fields. 
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Custom Case Information Display Local Menu 

  

By right-clicking on the tabs representing the various sheets of the custom case information 
display, a local menu appears giving you the following options. 
  
• Rename Sheet – this is only available if you click directly on a specific tab. Choose it to 

rename the sheet. 
• Delete Sheet – this is only available if you click directly on a specific tab. Choose it to 

delete the sheet. 
• New Sheet – Choose this to add a new sheet 
• Save All Sheets… – Choose this save all the information on the sheets to an auxiliary file. 

For the fields one the display, all information will be saved to the auxiliary file using 
Primary Key Fields unless the Custom Case Info Mode is set to Show Fields Secondary. In 
this case, they will be saved using the secondary key fields. 

• Custom Case Info Mode – Choose this to open a submenu that allows you to change the 
mode. 

• Tabs Position – Choose this to open a submenu that allows you to change the location of 
the tabs relative to the sheets 

• Plain Text Change Data Color – Choose this to change the color which is used to denote 
Plain Text cells when the Custom Case Info Mode is set to Change Field Data. The default 
color is dark gray. 

By right-clicking on one of the Custom Case Information Display sheets, you will open a local 
menu that has many options which are the same as other Case Information Displays. There 
are a few extra options listed as follows 
  
• Insert Row – Choose this to insert a new row at the location of the presently selected cell 
• Delete Row – Choose this to delete rows that are part of the present selection 
• Insert Column – Choose this to insert a new column at the location 
• Delete Column – Choose this to delete columns that are part of the present selection 
• Delete Cell – Choose this to delete the presently selected cells 
• Custom Case Info Menu – Choose this to open the same menu available by right clicking 

on the tabs representing the various sheets 
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Case Description 

  

The Case Description Dialog allows you to enter a text description of a case. The portion of the 
description that is saved with the case varies with case type:  

PowerWorld Binary (*.pwb) an unlimited number of lines are allowed 

PTI Raw Data format (*.raw) Two lines of text 

GE EPC Data format (*.epc) The case title and all the pre-title comments are read in as 
the case description 

PowerWorld Case (*.pwc) No case description supported 

IEEE Common Format (*.cf) No case description supported 

In PowerWorld Viewer, these descriptions are read-only.  

To display the Case Description Dialog to the Case Information ribbon tab, and choose Case 
Description from the Case Data ribbon group. 
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Case Summary 

  

The Case Summary Display provides a summary of the current case. Note that there are no 
enterable fields on the display. To display the Case Summary, go to the Case Information 
ribbon tab, and choose Case Summary from the Case Data ribbon group. The fields shown 
on this display include: 
  

Number of Devices in Case shows the number of each of the following device types: 

Buses 

Total number of buses in the case. Use the Bus Display to see a listing of these buses.  

Generators 

Total number of generators in the case. Use the Generator Display to see a listing of these 
generators. 

Loads 

Total number of loads in the case. Use the Load Display to see a listing of these loads. 

Switched Shunts 

Total number of switched shunts in the case. Use the Switched Shunt Display to see a listing 
of these switched shunts. 

Trans. Lines (AC) 

Total number of transmission lines in the case. Use the Line/Transformer Display to see a 
listing of these lines.  

LTCs (Control Volt) 

Total number of Load Tap Changing transformers in the case. Use the Transformer Control 
Display to see a listing of these transformer controls. 

Phase Shifters 

Total number of Phase Shifting transformers in the case. Use the Transformer Control 
Display to see a listing of these transformer controls. 

Mvar Controlling 

Total number of Mvar Controlling transformers in the case. Use the Transformer Control 
Display to see a listing of these transformer controls. 

Series Capacitors 

Total number of Series Capacitors in the case. These devices are treated the same as any 
other transmission line, and therefore can be found listed as a transmission element in the 
Line/Transformer Display. 

2 Term. DC Lines 

Total number of two-terminal dc transmission lines in the case. Use the DC Transmission 
Line Display  to see a listing of these dc lines.  

N-Term. DC Lines 

Total number of multi-terminal dc transmission lines in the case. Use the DC Transmission 
Line Display to see a listing of these dc lines. 

Areas 

Total number of areas in case. Use the Area Display to see a listing of these areas.  
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Zones 

Total number of zones in the case. Use the Zone Display to see a listing of these zones.  

Islands 

Total number of islands in the case. An island is a group of buses that are interconnected 
through ac transmission lines or transformers but are isolated from the rest of the system. 
Each island must have a slack bus. In Simulator, use the Power Flow Solution tab of the 
Simulator Options display to specify whether multiple islands are allowed. 

Interfaces 

Total number of interfaces in the case. An interface is a grouping of tie line objects between 
area objects. In Simulator, use the Interfaces Display to open the Interface Dialog to define 
and modify interface objects. 

Injection Groups 

Total number of injection groups in the case. An injection group is a collection of loads and 
generators (objects that inject power into a network). In Simulator, use Injection Groups 
Display to open the Injection Groups Dialog to define and modify injection groups. 

Case Totals 

Summarizes the total load, generation, shunt compensation, and losses for the case. Positive 
shunt compensation denotes shunt load, whereas negative shunt compensation indicates a 
shunt injection (such as shunt capacitance). The case totals fields are valid only when the 
current case is solved. 

Generator Spinning Reserves 

The total difference between the present total generator output versus the total maximum 
possible output of all in-service generation. 

Slack Buses: 

The slack bus or buses are listed showing the bus name, number, and area name and 
number. One slack bus is required for each island.  

Case Pathname 

Full file name of the current case.  
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Power Flow List 

  

The Power Flow List shows detailed information about the system’s power flows in a more 
traditional text-based form. This information is intended for users who would like detailed flow 
information about the power flow. Including the per unit voltage at the bus, the bus’ load and 
generation, and flows on all lines and transformers emanating from the bus. The content of 
this display (i.e. which buses are included in the list) is governed by the area/zone/owner 
filters. 

To show this display go to the Case Information ribbon tab, and choose Power Flow List 
from the Case Data ribbon group.  

To view flows at just a few select buses you may want to use the Quick Power Flow List 
instead. For large systems with no area/zone filtering set, it may take Simulator a long time to 
generate the complete Power Flow List. Note also that this display can show a maximum of 
32,767 lines of text. If this limit is exceeded, Simulator will generate a resource error. Either 
use the area/zone/owner filters to limit the number of devices shown on this display, or use 
the Quick Power Flow List to focus on a few selected buses of interest. 

The Power Flow List allows you to navigate through the system’s buses rather easily. You can 
also use the display to show the flows for a bus’ neighbor by double-clicking on the line that 
reads "TO nnnnn…," where nnnnn is the number of the bus you would like to see. The display 
is then positioned at this bus. If the bus is in an area and/or zone whose area/zone filter is not 
set, the area/zone filter is set automatically. In this way, you can inspect the system bus by 
bus.  

The display can also be used to quickly display the dialog box associated with different bus 
objects. Place the cursor on the desired device, depress the CTRL key and then left click. The 
corresponding bus, load, generator, or shunt information dialogs will be displayed.  

The Power Flow List also has its own local menu, which can be viewed by clicking the right 
mouse button on the display. Select Change Font to modify the style and size of the display’s 
font. Select Refresh to ensure that the display’s contents concur with the current system 
state. To skip to particular bus in the list, click Find Bus, which will open the Find Bus Dialog. 
To display the information dialog for the currently selected branch, bus, load, or shunt, select 
Display Object Dialog. To print the display, choose the Print local menu option. Choosing 
Copy enables you to copy the display into the Windows clipboard, from where the information 
can be pasted into another application. Finally, select Close to close the display.  

When printing the display you can either send the results directly to the printer or save them 
to a text file. To save the results in a text file on the Print Dialog select the Save to File 
option shown in the lower left corner of the dialog.  
  

For each bus, the following items are shown: 

Bus 

Shows the bus’ number, name, and nominal voltage in kV. The next four fields are the MW, 
MVar, MVA and percentage headers for subsequent rows. The next fields specify the per 
unit voltage magnitude, voltage angle in degrees, the bus’ area number and the bus’ area 
name. Depress the CTRL key and then left click on this line to display the Bus Dialog. 

Generator 

For each generator at the bus, the Power Flow List shows the generator’s ID (immediately 
after the keyword GENERATOR) and the power output of the generator in MW. Following 
this is generator’s reactive power output in Mvar. A single character is shown immediately 
after the Mvar field. An ‘R’ indicates that the generator is regulating the bus voltage, ‘H’ 
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indicates that the generator is at its high reactive power limit, ‘L’ indicates that the generator 
is at its low reactive power limit, and a blank suggests that the generator is set off of AVR. 
The last field in the GENERATOR item is the MVA output of the generator. Depress the CTRL 
key and then left click on this line to display the Generator Dialog. If no generators are 
connected to the bus, this item will be absent from the display. 

Load 

Shows the total power consumed by each load at the bus. If no loads are present at the 
bus, this item will be absent from the display. Depress the CTRL key and then left click on 
this line to display the Load Dialog. 

Shunt 

Shows the total power for the fixed shunts at the bus. Positive shunt values denote shunt 
load, while negative shunt quantities indicate injection. If no shunts are connected to the 
bus, this item will be absent from the display. 

Switched Shunt 

Shows the total power for the switched shunts at the bus. Depress the CTRL key and then 
left click on this line to display the Switched Shunt Dialog. If no switched shunts are located 
at the bus, this item will be absent from the display. 

Lines and Transformers 

For each line or transformer coming into the bus, the Power Flow List shows the line’s flow 
and percentage loading. For transformers, the off-nominal tap ratio and phase shift angle in 
degrees are also shown. Immediately to the right of the off-nominal tap ratio is a two-
character designation indicating the tapped side of the transformer: ‘TA’ indicates that the 
bus is on the tapped side, while ‘NT’ identifies the bus as residing on the side without the 
tap. You can left- click on this field to immediately reposition the bus to the other end of the 
line or transformer.  

Depress the CTRL key and then left click on this line to display the Transmission 
Line/Transformer Dialog. Simply left-click (without holding the CTRL key) to navigate 
through the system from bus to bus. 
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Quick Power Flow List 

  

The Quick Power Flow List provides a convenient means of viewing a listing of the flows at 
individual buses in the system. The format and control of the Quick Power Flow List is 
generally the same as that of the Power Flow List, except that the Quick Power Flow List 
displays results for just the desired bus or  range of buses.  
  

You can access this Quick Power Flow List in a number of different ways: 
• Go to the Case Information ribbon tab, and choose Quick Power Flow List from the 

Case Data ribbon group  
• From most of the Case Information Displays, right-click to invoke the display’s local menu, 

and select Quick Power Flow List. 
• From the Bus Information Dialog click on the View All Flows at Bus button. 
• From the oneline diagram, right-click on the bus symbol to display the bus’ local menu, 

and select Quick Power Flow List. 
  

This display is automatically created if it is not already shown. Information on subsequent 
buses appears at the bottom of the display. 

As with the Power Flow List, you can navigate through the system bus-by-bus by double-
clicking on the lines that begin with "TO nnnnn …," where nnnnn is the number of the bus you 
would like to investigate. Information for that bus will appear at the bottom of the display.  

Like the Power Flow List, the Quick Power Flow List has a local menu that is accessed by right-
clicking on the display. Among the things you can do from the local menu is to display the bus, 
branch, generator, load, or shunt corresponding to the currently selected record by selecting 
Display Object Dialog. You can also navigate through the system bus-by-bus just as you 
can do through double-clicking by choosing Goto  Line Bus from the local menu. 
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Outages 

  

The outages display, available by choosing Solution Details > Outages in the Model 
Explorer, presents a tabular listing of devices that are currently out-of-service in the load flow 
model. The display contains pages that resemble case information displays for branches, 
generators, loads, switched shunts, buses, and Multi-section lines. All devices listed in the 
pages on this display are the out-of-service elements. 
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Area Display 

  

The Area Display houses data about each area in the case. The Area Display is a class of Case 
Information Display and therefore can be used in a manner consistent with all other case 
information displays. It has a case information toolbar from which you can print, copy, or 
modify its records as well as view the information dialog of its associated areas. You can also 
sort the area records by clicking on the heading of the field by which you want to sort.  

To show the area records display, select Aggregations > Areas from the Model Explorer or 
Aggregation > Areas from the Case Information ribbon group under the Case Information 
ribbon tab.  
  

By default, the area records display contains the following fields: 
  

Number, Name 

Area’s number, between 1 and 9999, and its alphanumeric identifier. Simulator supports 
names of any character length. However, when writing out names to file formats with 
limitations on name length, the area names will be truncated at their maximum supported 
length. 

AGC Status 

Area’s automatic generation control status. This field indicates whether or not the area’s 
generation is changing automatically to control the area interchange. See Area Control for 
more details. You can toggle the value of the area’s AGC Status (except in Viewer) by left 
clicking on the entry. Valid entries in this field include: 

Off AGC Area is off AGC. Generation must be adjusted manually to meet changes in load 
and losses. If it is not, the system slack will be forced to pick up the balance. 

Part AGC Area is on AGC, with generation dispatch controlled by its units’ participation 
factors. 

ED Area is on economic dispatch control so that generation is dispatched in order of least 
cost. 

OPF Area is on OPF control (only used with Simulator OPF). This option is only used with 
Simulator OPF. When the case is solved using the OPF the area controls are changed by the 
OPF to maintain area power balance. During non-OPF solutions this option is equivalent to 
Off AGC. 

Area Slack Area is on Area Slack control. This option is only available for an area if you 
have already specified an area slack bus number in the area’s information dialog.  

Gen MW 

Total real power generation in the area in MW. 

Load MW 

Total real power load in the area in MW.  

Tot Sched MW 

The net of the base and scheduled transactions between the area and all other areas, with 
exporting power indicated as a positive value. The interchange for an area is set on the Area 
Information Dialog; the MW transactions for an area can be viewed using the specified MW 
Transactions display. 

Int MW 
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The actual interchange between this area and all other areas, with exporting power positive. 
If an area is on AGC control, its actual interchange should match its scheduled interchange. 

ACE MW 

The area control error in MW. This is the amount of MW flow difference between the actual 
MW interchange and the desired MW interchange. A positive value means the super area is 
generating and exporting excess MW's, and a negative value means the super area is under-
generating and importing too many MW's. 

Lambda 

The area’s marginal cost. This marginal cost is relevant only when an Economic Dispatch 
(not OPF) solution has been run. Theoretically, if losses are ignored, an area operates most 
economically if all generators operate at the same incremental cost. This common 
incremental cost is the area’s lambda, or marginal cost. 

The local menu of the area records display has an additional option labeled All Area Gen IC 
Curves. Select this activity to generate a plot showing the incremental cost curves for all 
units located in a particular area. 

Loss (MW) 

Total real power losses for the area. 

Auto Shunts 

Determines whether switched shunts for the area are available for automatic control. You 
can use this field to disable all the switched shunts in an area. Click on this field to toggle its 
value. Click on the Toggle All Yes or Toggle All No local menu options to set the auto shunts 
property for all switched shunts. Note that a switched shunt is available for automatic 
control only if it meets three conditions: 1) its control mode property is set to Automatic 
(see Switched Shunt Information Dialog); 2) its associated area’s Auto Shunts property is set 
to Yes; and 3) the Disable Switched Shunt Control option on the Power Flow Solution tab of 
the Simulator Options Dialog must not be checked.  

Auto XF 

Determines whether tapped transformers for the area are available for automatic control. 
You can use this field to disable all the transformers in an area. Click on this field to toggle 
its value. Click on the Toggle All Yes or Toggle All No local menu options to set all entries in 
this column. Note that three conditions must be met for a transformer to be used for 
automatic control: 1) its Auto field must be set to Yes (see Transformer Modeling for 
details); 2) its associated area’s Auto XF property is set to Yes; and 3) the Disable 
Transformer Control option on the Power Flow Solution tab of the Simulator Options dialog 
must not be checked.  

Unspec. MW Inter. 

Shows the total amount of interchange for the area that is listed as Unspecified. This means 
that some of the interchange is known in magnitude and direction (import or export) but not 
which other area(s) is involved in the interchange. The sum of all area’s unspecified 
interchange in the case must equal 0 for a balanced system. 
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Zone Display 

  

The Zone Display provides information about all the zones in the case. Similar to the Area 
Display, the Zone Display provides a means of dividing up a power system. System results can 
then be summarized by zones using this display. Buses can be assigned to zones independent 
of their area assignments. Thus a single area could contain multiple zones, or a single zone 
could span multiple areas. The zone number for each bus is shown on the Bus Dialog. In the 
Edit Mode, groups of buses can be easily moved from one zone to another using the Zone 
Dialog.  

The Zone Records Display is a class of Case Information Display and therefore can be used in 
a manner consistent with all other case information displays. It has a local menu from which 
you can print, copy, and modify its records as well as view the information dialog of its 
associated zones. You can call up the Quick Power Flow List or Bus View Display to obtain 
more information about a representative bus in the zone. You can also sort the zone records 
by clicking on the heading of the field by which you want to sort.  

To show this display, click on Aggregations > Zones in the model explorer. 
  

The display contains the following fields by default: 

Zone Number, Zone Name 

Zone’s number, between 1 and 9999, and its alphanumeric identifier. Simulator supports 
names of any character length. However, when writing out names to file formats with 
limitations on name length, the zone names will be truncated at their maximum supported 
length. 

Load MW, Load MVR 

Total real and reactive power load in the zone. 

Gen (MW), Gen (Mvar) 

Total real and reactive power generation in the zone. 

Loss MW, Loss MVR 

Total real and reactive power loss in the zone. Losses are computed by summing the losses 
of the individual transmission lines and transformers in the zone. Because of shunt charging, 
these devices can also generate reactive power. Therefore, reactive power losses may 
actually be negative.  

Int MW, Int Mvar 

Net interchange of real and reactive power with all other zones. Exported power is assumed 
to be positive. 

Load Mult MW 

Shows the current load MW multiplier for the zone. All load in the area is scaled by this 
multiplier. 
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Tie Lines between Areas Display 

  

The Tie Lines between Areas Display identifies all area tie lines in the case. Tie lines are not a 
separate data record that can be created in Simulator, but instead provide a look at all the 
devices that connect two areas together in the power system model. Tie lines are important 
because the Area Control algorithms used by Simulator often enforce a constraint which 
requires that the sum of the flow on the tie lines must equal the net export scheduled by the 
area (This is often called the ACE equation). 

There are several types of devices that can represent tie lines. These include the following: 
• Transmission branch (Branch) : a transmission line that connects two buses which belong 

to two different areas is a tie line. 
• Two-terminal DC transmission lines (DCLine) : a DC transmission line that connects two 

buses which belong to two different areas is a tie line. 
• Multi-terminal DC transmission line (MTDCRecord) : For every multi-terminal DC 

transmission line which has converters connected to more than one area is a tie line. 
• Load (Load): A load can be assigned to a different area than its terminal bus. This is not 

typical but is sometimes done to model loads at lower voltage level where more than one 
entity has load that connects to the same power system bus. In such a situation this load 
represents a tie line.  

• Generator (Gen): Similarly to the load, a generator can be assigned to a different area 
than its terminal bus. Again this is considered a tie line. 

• Switched Shunt (Shunt): Similarly to the load, a switched shunt can be assigned to a 
different area than its terminal bus. Again this is considered a tie line. 

Note: The easiest way to see which loads, generators, or switched shunts are assigned in this 
way is to use this Tie Lines between Areas Display. You can also however add separate 
columns using the display/column options on the Load, Generator or Switched Shunt Case 
Information Display. For instance for loads there area columns for Area Num of Bus and Area 
Num of Load. Normally these are equal, but they will not be for tie line loads. 

Note: Be careful when working with cases opened as RAW files in which there are loads that 
represent tielines. See Add and Remove of transactions due to tie-line loads in Simulator 
Options: File Management for more information. 

The Tie Lines between Areas Display is a class of Case Information Display and therefore can 
be used in a manner consistent with all other case information displays. It has a local menu 
from which you can print, copy, and modify its information as well as view the information 
dialog of its associated device type. You can learn more about a particular shunt’s terminal bus 
by choosing either Quick Power Flow List or Bus View. You can also sort the tie line 
information by clicking on the heading of the field by which you want to sort. Additionally, you 
can choose to restrict the information shown by the Tie Lines Display according to the 
constraints of the area/zone/owner filters.  

To call up the Tie Lines between Areas Display, select  Aggregation > Tie Lines between 
Areas from the Model Explorer. 
  

The Tie Lines between Areas Display contains the following fields by default: 

Tie Type 

Indicates type of device which the tie line represents: Branch, Load, Gen, Shunt, 
MTDCRecord, or DCLine. 

Area Name, Number, Name 

The Bus Number, Name and Area Name of the bus to which the device is attached. 
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Far Area Name, Far Number, Far Name 

The Bus Number, Name and Area Name of the other end of the device. 

Ckt 

The circuit ID for transmission lines or DC Lines, the device ID for generators, loads, and 
switched shunts. 

Meter MW and Mvar 

The MW and Mvar flow from the point represented by Number/Name towards the far 
Number Name. For transmission lines and DC lines the metered point on the line is 
determined by the Metered End which is stored with the device. For instance on a 
transmission line, there is a check box for From End Metered which is available on the 
Transmission Line/Transformer Option (Edit Mode) dialog. Changing this setting with the 
device will affect the Meter values slightly. 

Status 

This is the Open/Closed status of the tie line device. 

Lim MVA 

For tie lines that represent transmission lines this is the limit of the device. 

MW and Mvar Loss 

For tie lines that represent transmission lines this is the MW and Mvar loss across the device. 
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Tie Lines between Zones Display 

  

The Tie Lines between Zones Display is essentially identical to the Tie Lines between Areas 
Display. The only difference is that it displays devices that connect two zones together instead 
of areas. See the Tie Lines between Areas Display for more details. 
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Super Area Display  

  

The Super Area Display identifies any super areas that have been defined for the case. Super 
areas are groups of areas whose generators are dispatched as a coordinated group. Super 
areas can thus be useful for modeling the operation of independent system operators or 
power pools. 

Super areas cannot be inserted into a case from the Individual Insert ribbon group on the 
Draw ribbon tab. Instead, a super area can be defined when modifying or creating an area 
simply by typing the name of a new super area in the Super Area dropdown box on the Area 
Information Dialog. 

The Super Area Records Display is a class of Case Information Display and therefore can be 
used in a manner consistent with all other case information displays. It has a local menu from 
which you can print, copy, and modify its records as well as view the information dialog of its 
associated super areas. You can call up the Quick Power Flow List or Bus View Display to 
obtain more information about representative bus in the super area. You can also sort the 
super area records by clicking on the heading of the field by which you want to sort.  

To show this display select Aggregation > Super Areas in the Model Explorer. 

The display contains the following fields by default: 
  

Super Area 

The name of the super area. 

AGC Status 

The Super Area may operate without automatic generation control (AGC Status = Off AGC), 
with participation factor control (AGC Status = Part. AGC), or according to an economic 
dispatch (AGC Status = ED). This is a toggleable field. 

Use Area PF 

Indicates whether to use the areas participation factors when the super area is to operate 
with participation factor control (Part. AGC). 

Num Areas 

Indicates the number of areas defined as being part of the super area. Areas are added to 
super areas using the Super Area dropdown box on the Area Information Dialog. 

Gen MW 

Total MW injection from all the generators in the super area. 

Load MW 

Total MW load demanded in the super area. 

Tot Sched MW 

Total scheduled MW interchange with other areas or super areas. 

ACE MW 

The area control error in MW. This is the amount of MW flow difference between the actual 
MW interchange and the desired MW interchange. A positive value means the super area is 
generating and exporting excess MW's, and a negative value means the super area is under-
generating and importing too many MW's. 

Lambda 
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The super area’s marginal cost. 

Loss MW 

Indicates the real power losses incurred within the super area. 

ED Use PF 

Indicates whether the power flow engine will calculate loss penalty factors in computing the 
economic dispatch solution for the super area. If loss penalty factors are not calculated, 
then the economic dispatch is calculated assuming that the super area is lossless. 
Otherwise, the economic dispatch solution incorporates losses. The penalty factors gauge 
the sensitivity of the area’s losses to changing injection at specific generators. The option to 
calculate loss penalty factors is relevant only when the super area operates according to 
Economic Dispatch Control. Usually, if the system’s cost curves are relatively flat, the 
inclusion of losses in the solution will not have much of an effect on the dispatch. 
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Bus Display 

  

The Bus Display presents data describing each bus in the case. The Bus Display is a class of 
Case Information Display and therefore can be used in a manner consistent with all other case 
information displays. It has a case information toolbar from which you can print, copy, and 
modify its records as well as view the information dialog of its associated bus. You can also 
sort the bus records by clicking on the heading of the field by which you want to sort. 
Additionally, you can choose to restrict the records shown by the Bus Records Display 
according to the constraints of the area/zone/owner filters. Finally, when Simulator is in Edit 
Mode, the case information toolbar allows you to add new buses to or remove existing buses 
from the system.  

To show the bus records display, select Network > Buses from the Model Explorer or from 
the Case Information ribbon group under the Case Information ribbon tab.  
By default, the bus records display contains the following fields: 

Number and Name 

Bus number between 1 and 2,147,483,647 (equals 2^31 minus 1), and its alphanumeric 
identifier.  

Area Name 

Alphanumeric identifier of the bus’ area. 

Nom kV 

The nominal base voltage of the bus in kV. 

PU Volt 

Bus’ per unit voltage magnitude.  

Volt (kV) 

Bus’ actual voltage magnitude in kV. This is the per unit voltage magnitude multiplied by the 
bus’ nominal voltage. 

Angle (Deg) 

Bus’ voltage angle in degrees.  

Load MW, Load Mvar  

Total real and reactive load at the bus. If no loads are located at the bus, these fields are 
blank. 

Gen MW, Gen Mvar 

Total real and reactive generation at the bus. If no generators are located at the bus, these 
fields are blank. 

Switched Shunt Mvar 

Total switched shunt device reactive power injection at the bus. 

Act G Shunt MW, Act B Shunt Mvar 

Total real and reactive fixed bus shunt injections. 

Area Num 

The area number in which the bus is located. 

Zone Num 

The zone number in which the bus is located. 
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Remotely Regulated Bus Display 

  

The Remotely Regulated Bus Display provides information about all buses that are remotely 
regulated by one or more generators, transformers, or switched shunts. The bus that a 
generator regulates is specified in the Edit Mode using the Generator Dialog. Whenever a 
generator is regulating a bus that is not its terminal, it is considered to be remotely regulating 
that bus. The bus that is remotely regulated, along with the regulating generators, will appear 
on this display. The same logic is true for transformers and switched shunts which may 
regulate remote buses also. 

The Remotely Regulated Bus Display is a class of Case Information Display and therefore can 
be used in a manner consistent with all other case information displays. It has a local menu 
from which you can print, copy, and modify its information as well as view the information 
dialog of its associated buses. You can find a specific remotely regulated bus, and you can 
learn more information about a particular remotely regulated bus by choosing either Quick 
Power Flow List or Bus View. You can also sort the remotely regulated bus information by 
clicking on the heading of the field by which you want to sort. Additionally, you can choose to 
restrict the information shown by the Load Display according to the constraints of the 
area/zone/owner filters. 

To call up the Remotely Regulated Bus Display, open the Model Explorer and select Remotely 
Regulated Buses under the Solution Details folder. 
  

This Remotely Regulated Bus Display contains the following fields by default: 

Number, Name, Area Name 

Number, name, and area name for the bus that is being remotely regulated.  

PU Volt 

Per unit voltage magnitude for the bus. 

Set Volt 

Setpoint voltage for the bus. When a bus is being remotely regulated by a set of generators, 
the generators vary their reactive power output to maintain the voltage at the bus at the 
setpoint value. You can enter a new value for this field. Changing the setpoint voltage here 
changes the setpoint voltage for all the generators that are remotely regulating this bus. 

Volt Diff 

Per unit difference between the actual voltage magnitude and the set point voltage 
magnitude. 

AVR 

Combined automatic voltage regulation (AVR) status for all the generators remotely 
regulating this bus. If AVR is No, no generators regulate voltage; if AVR is Yes, all the 
available generators are regulating; if AVR is Mixed, some generators regulate voltage and 
some do not. Regulation of individual generators can be specified using the Generator 
Display . You can toggle this field between "Yes" and "No" by clicking on it.  

Total Mvar 

Total of the reactive power being supplied by all the generators remotely regulating the bus.  

MVR Min, MVR Max 

Total of the minimum and maximum reactive power limits for all the generators remotely 
regulating the bus.  
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Remote Regs (gen) 

Provides a comma-separated list of all the generators which regulate this bus. 

Rem Regs (XFMR) 

Provides a comma-separated list of all the transformers which regulate this bus. 

Rem Regs (SS) 

Provides a comma-separated list of all the switched shunts which regulate this bus. 
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Bus Mismatches Display 

  

The Bus Mismatches Display lists the real and reactive mismatches at each bus. The bus 
mismatches are defined as the difference between the power entering the bus and the power 
leaving the bus. A power flow case is considered solved when all the bus mismatches are 
below the convergence tolerance specified on the Power Flow Solution page of the Simulator 
Options dialog.  

Most of the time you will not need to be concerned about the bus mismatches. If the power 
flow solves, the mismatches are guaranteed to be below the desired tolerance. However, 
advanced users will find this display useful in determining the cause when a power flow 
diverges. 

The Bus Mismatch Display is a class of Case Information Display and therefore can be used in 
a manner consistent with all other case information displays. It has a case information toolbar 
from which you can print, copy, and modify its information as well as view the information 
dialog of its associated bus. You can find a specific bus mismatch using the name or number 
of the bus, and you can learn more about the bus by choosing either Quick Power Flow List or 
Bus View. You can also sort the bus mismatch information by clicking on the heading of the 
field by which you want to sort.  

To show this display select Solution Details > Mismatches from the Model Explorer. You 
can view bus mismatches only when the application is in Run Mode. 

Also note that there is a special feature in the Records menu of the case information toolbar 
for the mismatch display. This option is Zero-Out Mismatches. Choosing this options will 
cause Simulator to insert fictitious B and G Bus Shunt values to force the mismatch at every 
bus to zero. 

The Bus Mismatch Display contains the following fields by default: 

Number, Name, Area Name 

The number and name of the bus and the name of the area in which it is located. 

MW Mismatch, MVR Mismatch, MVA Mismatch 

The real and reactive mismatches at each bus, and the total complex power mismatch. 
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Substation Records Display 

  

The Substation Records Display presents data describing each substation in the case. The 
Substation Display is a class of Case Information Display and therefore can be used in a 
manner consistent with all other case information displays. It has a local menu from which you 
can print, copy, and modify its records as well as view the information dialog of its associated 
substation. You can also sort the substation records by clicking on the heading of the field by 
which you want to sort. Additionally, you can choose to restrict the records shown by the 
Substation Records Display according to the constraints of the area/zone/owner filters. Finally, 
when Simulator is in Edit Mode, the local menu allows you to add new substations to or 
remove existing substations from the system. Note: a substation is considered in an area/zone 
if any single bus in the substation is in the area/zone.  

To show the substation records display, select Aggregation > Substations in the Model 
Explorer. 
  

By default, the substation records display contains the following fields: 

Sub Num 

An integer identifier for the substation. 

Sub Name, Sub ID 

Two alphanumeric identifiers for the substation. 

Area Name, Zone Name 

The names of the area and zone of the buses in the substation. If some of the buses in the 
substation are in different areas or zones, then this is the most common area or zone. 

# of Buses 

The number of buses inside the substation. 

Nom kV 

Nominal kV of the highest voltage bus(es) in the substation. 

Gen MW, Gen MVR 

Total real and reactive generation at the substation. If no generators are located at the 
substation, these fields are left blank. 

Load MW, Load MVR 

Total real and reactive load at the substation. If no loads are located at the substation, 
these fields are left blank. 

Shunt MW, Shunt MVR 

Total real and reactive shunt values at the substation. If no shunts are located at the 
substation, these fields are left blank. 
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Generator Display 

  

The Generator Display presents data describing each generator in the case. The Generator 
Display is a class of Case Information Display and therefore can be used in a manner 
consistent with all other case information displays. It has a local menu from which you can 
print, copy, and modify its records as well as view the information dialog of its associated 
generators. The Quick Power Flow List and Bus View Display tools are available for finding 
more information on the generator’s terminal bus. You can also sort the generator records by 
clicking on the heading of the field by which you want to sort. Additionally, you can choose to 
restrict the records shown by the Generator Records Display according to the constraints of 
the area/zone/owner filters. Finally, you can use the local menu’s Insert and Delete options 
when the application is in Edit Mode to insert a new generator into the case or to delete an 
existing generator. 

Some columns which can be added to the generator records are related to the post-
contingency solution options. For more information about these columns see the sections 
"Define Generator Line Drop and Reactive Current Compensation" and "Define Generator 
Maximum MW Responses in Post-Contingency" in the Advanced Modeling Options for 
Contingency Analysis. 

To show the generator records display, select Network > Generators from the Model 
Explorer. 
  

By default, the generator records display contains the following fields: 

Number, Name 

Number and name of the bus to which the generator is attached. The display’s local menu 
offers you the opportunity to view the Quick Power Flow List and the Bus View Display  for 
the bus. 

ID 

Single character ID used to distinguish multiple generators at the same bus. This default 
value for this field is ‘1’. 

Status 

Displays the Open / Closed status of the generator. This field is a toggleable field. 

Gen MW, Gen Mvar 

The real and reactive power output of the generator. If the generator is on AVR control, the 
reactive power is set automatically. 

Set Volt 

Per unit setpoint voltage for the generator. When a generator is on AVR control, the reactive 
power output of the generator is varied automatically in order to maintain the regulated bus 
voltage at this value. The regulated bus is usually, but not always, the generator’s terminal 
bus. Use the Generator Dialog to see the regulated bus number. 

AGC 

Designates whether the generator’s real power output is governed by automatic generation 
control. If the AGC field is set to Yes, the generator is on automatic generation control 
(AGC). When a generator is on AGC, its real power output can be varied automatically. 
Usually the purpose for AGC is to keep the area interchange at a desired value. You can click 
on this field to toggle its value (except in Viewer). Please see Area Control for more details. 

AVR 
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Designates whether the generator will vary its reactive power output to maintain a constant 
terminal voltage. If the AVR property is set to Yes, the generator is on automatic voltage 
regulation (AVR) control. When a generator is on AVR control, its reactive power output is 
varied automatically to keep the regulated bus voltage at the Set Volt value. AVR is limited 
by the generator’s reactive power limits. You can click on this field to toggle its value 
(except in Viewer). 

Min MW, Max MW 

Minimum and maximum allowable real power output of the generator. 

Min Mvar, Max Mvar 

Minimum and maximum allowable reactive power output of the generator. 

Cost Model 

The type of cost model the generator is currently set to use. Cost models are necessary for 
performing economic analysis, such as Economic Dispatch or Optimal Power Flow. 

Part. Factor 

Generator’s participation factor. Participation factors are used to determine how AGC 
generators participate in area control when their area is on participation factor control. 
Please see Area Control for more details. 
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Generator/Load Cost Models 

  

The Generator/Load Cost Models option from the Case Information menu allows you to choose 
to view detailed information on generator cost curves or load benefit curves. This cost 
information can be very important when solving an Optimal Power Flow or Security 
Constrained Optimal Power Flow solution.  

The Generator/Load Cost Models option has four submenu options to choose from: 

Generator Cubic Cost Models 

Generator Piecewise Linear Cost Models 

All Generator Cost Models 

All Load Benefit Models 
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Generator Cost Models Display 

  

The Generator Cost Models Display presents detailed cost information for each generator in 
the case, regardless of what type of cost curve has been entered for the generator. The 
Generator Cost Models Display is a class of Case Information Display and therefore can be 
used in a manner consistent with all other case information displays. It has a local menu from 
which you can print, copy, and modify its records as well as view the information dialog of its 
associated generators. The Quick Power Flow List and Bus View Display tools are available for 
finding more information on the generator’s terminal bus. You can also sort the generator 
records by clicking on the heading of the field by which you want to sort. Additionally, you can 
choose to restrict the records shown by the Generator Cost Models Display according to the 
constraints of the area/zone/owner filters. Finally, you can use the local menu’s Insert and 
Delete options when the application is in Edit Mode to insert a new generator into the case or 
to delete an existing generator. 

To show the generator piecewise linear and cubic cost model display, select Network > 
Generators > Cost Curves All from the Model Explorer. 
  

By default, the generator records display contains the following fields: 

Number, Name 

Number and name of bus to which the generator is attached. 

Area Name of Gen 

Name of the area to which the generator belongs. The generator can be assigned to an area 
different than the area to which its terminal bus is assigned. 

ID 

Single character ID used to distinguish multiple generators at the same bus; ‘1’ by default. 

Status 

The Open / Closed status of the generator. This is a toggleable field. 

AGC 

Designates whether the generator’s real power output is governed by automatic generation 
control. If the AGC field is set to Yes, the generator is on automatic generation control 
(AGC). When a generator is on AGC, its real power output can be varied automatically. 
Usually the purpose for AGC is to keep the area interchange at a desired value. You can click 
on this field to toggle its value (except in Viewer). Please see Area Control for more details. 

Gen MW 

Current real power output of the generator. 

Min MW 

Minimum MW output of the generator. 

Max MW 

Maximum MW output of the generator. 

Cost Model 

The type of model this generator is currently using. Can be Cubic, Piecewise Linear or None. 

IOA, IOB, IOC, IOD 
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Parameters used to model the cost characteristic of the generator. Please see Generator 
Cost Information  for details. Please note that these values can be saved/loaded using the 
Generator Cost Data  auxiliary file. 

These fields will be disabled unless the Cost Model type is set to Cubic. 

Fuel Cost 

The fuel cost of the type of fuel for the generator. 

Variable O&M 

Operations and Maintenance costs for the generator. 

This field will be disabled unless the Cost Model type is set to Cubic. 

Fuel Type 

An informational field that can be set to the type of fuel the generator uses. 

Unit Type 

An informational field that can be set to reflect the type of unit the generator is, such as 
combined cycle, steam, hydro, etc. 

Cost Shift $/MWh, Cost Multiplier 

The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Fixed Cost 

The fixed operating cost of the generator. 

MWh Break x, MWh Price x 

The remainder of the display is populated with MWh Break and MWh Price pairs. These pairs 
define the break points of the piecewise linear curve. The MWh Break value is a MW output 
value of the generator. The MWh Price value is the corresponding marginal cost of 
producing an additional MW of power at that MW output level. Therefore entering the break 
points of the piecewise linear curve in this manner defines the slopes of the next section of 
the curve, starting at the current MW Break point and up to but not including the next 
defined break point. The last MWh Break and MWh Price pair defined will define the 
marginal price of the unit from that break point location to the maximum output of the 
generator. 

A requirement of the piecewise linear cost curve is that it must be convex, meaning the next 
MWh Price must be higher than the previous MWh Price. 

These fields will be disabled unless the Cost Model type is set to Piecewise Linear. 
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Generator Cubic Cost Display 

  

The Generator Cubic Cost Display presents detailed cost information for each generator in the 
case set to use a cubic cost model. The Generator Cubic Cost Display is a class of Case 
Information Display and therefore can be used in a manner consistent with all other case 
information displays. It has a local menu from which you can print, copy, and modify its 
records as well as view the information dialog of its associated generators. The Quick Power 
Flow List and Bus View Display tools are available for finding more information on the 
generator’s terminal bus. You can also sort the generator records by clicking on the heading of 
the field by which you want to sort. Additionally, you can choose to restrict the records shown 
by the Generator Cubic Cost Display according to the constraints of the area/zone/owner 
filters. Finally, you can use the local menu’s Insert and Delete options when the application is 
in Edit Mode to insert a new generator into the case or to delete an existing generator. 

To show the generator cubic cost display, select Network > Generators > Cost Curves 
Cubic from the Model Explorer. 
  

By default, the generator records display contains the following fields: 

Number, Name 

Number and name of bus to which the generator is attached. 

Area Name of Gen 

Name of the area to which the generator belongs. The generator can belong to an area 
which is different than the area of which its terminal bus is a member. 

ID 

Alphanumeric ID used to distinguish multiple generators at the same bus; ‘1’ by default. 

Status 

The Open / Closed status of the generator. This is a toggleable field. 

AGC 

Designates whether the generator’s real power output is governed by automatic generation 
control. If the AGC field is set to Yes, the generator is on automatic generation control 
(AGC). When a generator is on AGC, its real power output can be varied automatically. 
Usually the purpose for AGC is to keep the area interchange at a desired value. You can click 
on this field to toggle its value (except in Viewer). Please see Area Control for more details. 

Gen MW 

Current real power output of the generator.  

IOA, IOB, IOC, IOD 

Parameters used to model the cost characteristic of the generator. Please see Generator 
Cost Information  for details. Please note that these values can be saved/loaded using the 
Generator Cost Data  auxiliary file. 

Fuel Cost 

The fuel cost of the type of fuel for the generator. 

Variable O&M 

Operations and Maintenance costs for the generator. 

Fuel Type 
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An informational field that can be set to the type of fuel the generator uses. 

Unit Type 

An informational field that can be set to reflect the type of unit the generator is, such as 
combined cycle, steam, hydro, etc. 

Cost Shift $/MWh, Cost Multiplier 

The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Cost $/Hr 

Operating cost for the generator in $/hr. 

IC 

Incremental cost to produce an additional MWh. This can be expressed as dC(Pgi)/dPgi, 
where C denotes the generator’s cost of operation in $/hr and Pgi expresses the current MW 
output of the unit. In a lossless system, the incremental dispatch is equal to the generator’s 
lambda value. 

LossSens 

Area loss sensitivity - This field is only calculated when the generator’s area is on 
economic dispatch control. This field specifies the incremental change in area losses if 
this generator were to produce one more MW, with the excess generation absorbed by 
the system slack. This may be expressed as ∂Ploss/∂Pgi. The loss sensitivity is used in 
calculating the generator’s lambda value for the economic dispatch activity. 

Generator MW Marg. Cost 

The marginal cost of the generator supplying an additional MW of power to the system.  
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Generator Piecewise Linear Cost Display 

  

The Generator Piecewise Linear Cost Display presents detailed cost information for each 
generator in the case set to use a piecewise linear cost model. The Generator Piecewise Linear 
Cost Display is a class of Case Information Display and therefore can be used in a manner 
consistent with all other case information displays. It has a local menu from which you can 
print, copy, and modify its records as well as view the information dialog of its associated 
generators. The Quick Power Flow List and Bus View Display tools are available for finding 
more information on the generator’s terminal bus. You can also sort the generator records by 
clicking on the heading of the field by which you want to sort. Additionally, you can choose to 
restrict the records shown by the Generator Piecewise Linear Cost Display according to the 
constraints of the area/zone/owner filters. Finally, you can use the local menu’s Insert and 
Delete options when the application is in Edit Mode to insert a new generator into the case or 
to delete an existing generator. 

To show the generator piecewise linear cost display, select Network > Generators > Cost 
Curves Linear in the Model Explorer. 
  

By default, the generator records display contains the following fields: 

Number, Name 

Number and name of bus to which the generator is attached. 

Area Name of Gen 

Name of the area to which the generator belongs. The generator can belong to an area 
which is different than the area of which its terminal bus is a member. 

ID 

Alphanumeric ID used to distinguish multiple generators at the same bus; ‘1’ by default. 

Status 

The Open / Closed status of the generator. This is a toggleable field. 

AGC 

Designates whether the generator’s real power output is governed by automatic generation 
control. If the AGC field is set to Yes, the generator is on automatic generation control 
(AGC). When a generator is on AGC, its real power output can be varied automatically. 
Usually the purpose for AGC is to keep the area interchange at a desired value. You can click 
on this field to toggle its value (except in Viewer). Please see Area Control for more details. 

Gen MW 

Current real power output of the generator. 

Min MW 

Minimum MW output of the generator. 

Max MW 

Maximum MW output of the generator. 

Fuel Cost 

The fuel cost of the type of fuel for the generator. 

Fuel Type 

An informational field that can be set to the type of fuel the generator uses. 
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Unit Type 

An informational field that can be set to reflect the type of unit the generator is, such as 
combined cycle, steam, hydro, etc. 

Cost Shift $/MWh, Cost Multiplier 

The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Fixed Cost 

The fixed operating cost of the generator. 

MWh Break x, MWh Price x 

The remainder of the display is populated with MWh Break and MWh Price pairs. These pairs 
define the break points of the piecewise linear curve. The MWh Break value is a MW output 
value of the generator. The MWh Price value is the corresponding marginal cost of 
producing an additional MW of power at that MW output level. Therefore entering the break 
points of the piecewise linear curve in this manner defines the slopes of the next section of 
the curve, starting at the current MW Break point and up to but not including the next 
defined break point. The last MWh Break and MWh Price pair defined will define the 
marginal price of the unit from that break point location to the maximum output of the 
generator. 
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Load Display 

  

The Load Display presents data describing each load in the case. The Load Display is a class of 
Case Information Display and therefore can be used in a manner consistent with all other case 
information displays. It has a case information toolbar from which you can print, copy, and 
modify its information as well as view the information dialog of its associated loads. The 
toolbar also affords the opportunity to insert new loads into the model or to delete existing 
ones. Moreover, it enables you to invoke the Quick Power Flow List and Bus View Display for 
the load’s terminal bus. You can also sort the load information by clicking on the heading of 
the field by which you want to sort. Additionally, you can choose to restrict the information 
shown by the Load Display according to the constraints of the area/zone/owner filters.  

To show the load display, select Network > Loads in the Model Explorer. 
  

The load display contains the following fields by default: 

Number, Name 

Number and name of bus to which the load is attached.  

ID 

Two-character ID used to distinguish multiple loads at the same bus; ‘1’ by default. 

Status 

Either Closed if the load is connect to its bus, or Open if it is not. You can click on this field 
to toggle its value. If the load is open, the entire load record is dimmed.  

MW, Mvar, MVA 

Total real, reactive, and complex power for the load. Loads may be both voltage dependent. 
The total load is the sum of the constant power, constant current, and constant impedance 
components. See Load Information and see Load Modeling  for more information. 

S MW, S MVAR, I MW, I MVR, Z MW, Z MVR 

These six fields describe the composition of the load at the bus assuming 1 pu bus voltage. 
The SMW and SMVAR fields indicate the constant power portion of the load, the component 
that does not vary with bus voltage magnitude. The IMW and IMVR fields express the 
constant current part of the load, which varies in proportion to the bus voltage magnitude. 
Finally, ZMW and ZMVR indicate the constant impedance portion of the load, which varies 
with the square of the voltage. The sum of the SMW, IMW, and ZMW fields yields the base 
MW load at the bus (assuming 1pu voltage), and the sum of the SMVR, IMVR, and ZMVR 
fields provides the base MVR load at the bus (assuming 1 pu voltage). Please see Load 
Modeling  for more details on how bus load is modeled. 
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Load Benefit Models Display 

  

The Load Benefit Models Display presents detailed cost information for each load in the case 
set to use a piecewise linear benefit model. The Load Benefit Models Display is a class of Case 
Information Display and therefore can be used in a manner consistent with all other case 
information displays. It has a local menu from which you can print, copy, and modify its 
records as well as view the information dialog of its associated loads. The Quick Power Flow 
List and Bus View Display tools are available for finding more information on the load’s 
terminal bus. You can also sort the load records by clicking on the heading of the field by 
which you want to sort. Additionally, you can choose to restrict the records shown by the Load 
Benefit Models Display according to the constraints of the area/zone/owner filters. Finally, you 
can use the local menu’s Insert and Delete options when the application is in Edit Mode to 
insert a new load into the case or to delete an existing load. 

To show the generator piecewise linear cost display, select Network > Loads > Benefit 
Curves Linear in the Model Explorer. 
  

By default, the generator records display contains the following fields: 

Number, Name 

Number and name of bus to which the load is attached. 

Area Name of Gen 

Name of the area to which the load belongs. The load can belong to an area which is 
different than the area of which its terminal bus is a member. 

ID 

Alphanumeric ID used to distinguish multiple generators at the same bus; ‘1’ by default. 

Status 

The Open / Closed status of the load. This is a toggleable field. 

AGC 

Designates whether the generator’s real power output is governed by automatic generation 
control, since effectively dispatching a load can be viewed as dispatching negative 
generation. If the AGC field is set to Yes, the load is on automatic generation control (AGC). 
When a load is on AGC, its real power output can be varied automatically. Usually the 
purpose for AGC is to keep the area interchange at a desired value. You can click on this 
field to toggle its value (except in Viewer). Please see Area Control for more details. 

Gen MW 

Current real power demand of the load. 

Min MW 

Minimum MW demand of the load. 

Max MW 

Maximum MW demand of the load. 

Fixed Benefit 

The fixed benefit of the load. 

Benefit Model 

The type of model this load is currently using. Can be either Piecewise Linear or None. 
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MWh Break x, MWh Price x 

The remainder of the display is populated with MWh Break and MWh Price pairs. These pairs 
define the break points of the piecewise linear curve. The MWh Break value is a MW 
demand value of the load. The MWh Price value is the corresponding marginal benefit of 
extracting an additional MW of load at that MW output level. Therefore entering the break 
points of the piecewise linear curve in this manner defines the slopes of the next section of 
the curve, starting at the current MW Break point and up to but not including the next 
defined break point. The last MWh Break and MWh Price pair defined will define the 
marginal benefit of the load from that break point location to the maximum demand of the 
load. 

A requirement of the piecewise linear benefit curve is that it must be concave, meaning the 
next MWh Price must be lower than the previous MWh Price. In other words, as more load is 
supplied, the less the benefit it is providing. This is how a load can be dispatched along with 
generation, according to marginal costs (and marginal benefits.) 

These fields will be disabled unless the Cost Model type is set to Piecewise Linear. 
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Line and Transformer Display 

  

The Line/Transformer Display presents data describing each transmission line and transformer 
in the case. The Line/Transformer Display is a class of Case Information Display and therefore 
can be used in a manner consistent with all other case information displays. It has a local 
menu from which you can print, copy, and modify its information as well as view the 
information dialog of its associated branches. The local menu also affords the opportunity to 
insert new lines or transformers into the model or to delete existing ones. Moreover, it enables 
you to invoke the Quick Power Flow List and Bus View Display for each branch’s terminal 
buses. You can also sort the line and transformer information by clicking on the heading of the 
field by which you want to sort. Additionally, you can choose to restrict the information shown 
by the Line/Transformer Display according to the constraints of the area/zone/owner filters.  

To show the line/transformer display, select Network > Branches Input or Network > 
Branches State from the Model Explorer. 

The contents of the display depends upon the application’s operating mode.  
  

The line/transformer display shows the following fields by default: 

From Bus Number and Name 

From Bus number and name. For transformers, the from  bus is the tapped side. Right-
clicking on either of these fields brings up the display’s local menu from which you may 
select Quick Power Flow List or Bus View Display to obtain more information about the from 
bus. 

To Bus Number and Name 

To Bus number and name. Right-clicking on either of these fields brings up the display’s 
local menu from which you may select Quick Power Flow List or Bus View Display to obtain 
more information about the to bus. 

Circuit 

Two-character identifier used to distinguish between multiple lines joining the same two 
buses. Default is ‘1’. 

Status 

The service status of the branch. This field is toggleable. 

Xfrmr 

Yes or no field signifying if the branch is a transformer or transmission line. This field cannot 
be changed. 

From MW, From Mvar, From MVA (State display default) 

Real, reactive, and complex power flowing into the line at the from bus. 

Lim MVA, Max Percent (State display default) 

The current MVA limit of the branch, and the amount of the actual flow as a percentage of 
the MVA limit. 

MW Loss, Mvar Loss (State display default) 

Real and reactive power losses on the transmission line or transformer. Since reactive power 
losses include the effect of line charging, the reactive power losses may be negative.  

R, X, B (Input display default) 
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Indicates the branch’s resistance, reactance, line charging susceptance in per unit on the 
system base. 

Lim A MVA, Lim B MVA, Lim C MVA (Input display default) 

Identifies the first three limit settings. Five additional limits can be set, for which the 
columns can be added using the Display/Column options from the local popup menu. All 
limits are expressed in MVA. 

See Transformer Display for viewing transformer specific fields.  
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Multi-Section Lines Display 

  

The Multi-Section Line Display lists the multi-section lines that exist in the case. The Multi-
Section Line Display is used to functionally group a number of transmission lines together. 
They are usually used to model very long transmission lines that require the use of multiple 
individual transmission line information to be modeled accurately. Simulator then treats each 
multi-section line as a single device with regard to line status. That is, changing the status of 
one line in the record changes the status of the other lines in the record as well.  

Each multi-section line record consists of the "from" bus, one or more "dummy" buses and the 
"to" bus. Each dummy bus must have only two lines connected to it, each of which are 
members of the multi-section line record. See Multi-Section Line Information for details.  

The Multi-Section Line Display is a class of Case Information Display and therefore can be 
used in a manner consistent with all other case information displays. It has a local menu from 
which you can print, copy, and modify its information as well as view the information dialog of 
its multi-section line information. The local menu also affords the opportunity to insert new 
multi-section lines into the model or to delete existing ones when the application operates in 
the Edit Mode. Moreover, it enables you to invoke the Quick Power Flow List and Bus View 
Display for the line’s terminal buses. You can also sort the multi-section line information by 
clicking on the heading of the field by which you want to sort. Additionally, you can choose to 
restrict the information shown by the Multi-Section Line Display according to the constraints of 
the area/zone/owner filters.  

To show this display select Aggregations > Multi-Section Lines in the Model Explorer. 
  

The display contains the following fields by default: 

From Bus #, From Name 

Number and name of the multi-section lines from bus. Right clicking on one of these fields 
invokes the display’s local menu from which you can select either Quick Power Flow List or 
Bus View Display to find more information about the from bus. 

To Bus #, To Name 

Number and name of the multi-section lines to bus. Right clicking on one of these fields 
invokes the display’s local menu from which you can select either Quick Power Flow List or 
Bus View Display to find more information about the to bus. 

Circuit 

Two-character circuit identifier for the multi-section line. The first character in the identifier 
should always be an "&."  

Sections 

Number of individual lines within the multi-section line record. 

Allow Mixed Status 

This value defaults to NO and means that all branches in the multi-section line must have 
the same status. Setting this value to YES means essentially means that the multi-section 
line is disabled so that opening/closing a branch in the multi-section line will no longer 
automatically open or close the other lines in the record. 

Status 

Current status of the record. Note, the status is Closed only if all the lines in the record are 
closed, and is Open only if all the lines in the record are open. Otherwise the status is 
Mixed.  
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Transformer Display 

  

The Transformer Display identifies all transformers in the case. The data presented in the 
Transformer Display supplements the data presented in the Line/Transformer Display by 
presenting transformer-specific information. Consult the Line/Transformer Display for the 
transformer flows. 

The Transformer Display is a class of Case Information Display and therefore can be used in a 
manner consistent with all other case information displays. It has a local menu from which you 
can print, copy, and modify its information as well as view the information dialog of its 
associated transformer. You can find a specific transformer using the names or numbers of its 
terminal buses, and you can learn more about a particular transformer’s terminal buses by 
choosing either Quick Power Flow List or Bus View. When in Edit Mode, you can delete an 
existing transformer from the case. You can also sort the transformer information by clicking 
on the heading of the field by which you want to sort.  

To show this display select Network > Transformers Controls in the Model Explorer. 
  

The Transformer Display contains the following fields by default: 

From Bus Number and Name 

From Bus  number and name. The From Bus is the tapped side. You may view either the 
Quick Power Flow List or the bus view display  for the From Bus from the local menu. 

To Bus Number and Name 

To Bus number and name. You may view either the Quick Power Flow List or the bus view 
display  for the To Bus from the local menu.  

Circuit 

Two-character identifier used to distinguish between multiple transformers joining the same 
two buses. 

Status 

The service status of the transformer. This field is toggleable. 

Type 

Type of transformer. Possible values include  

Fixed  The tap positions are fixed  

LTC  The tap ratio changes to regulate bus voltage 

Mvar The tap ratio changes to regulate reactive power flow 

Phase  The phase angle changes to regulate real power flow 

Tap/Phase 

Indicates the tap ratio for LTC and fixed transformers and the phase shift angle in degrees 
for phase-shifting transformers.  

XF Auto 

If the value of this field is Yes, the transformer will automatically change its tap or phase 
angle to keep the regulated value within the specified regulation range, provided that the 
Auto XF field of its associated area is set to Yes and transformer tap/phase control has not 
been disabled for the entire case. The Auto XF field of individual areas is set from the Area 
Display, and case-wide transformer control can be set from the Power Flow Solution tab of 
the Simulator Options Dialog. Click on this field to toggle its values.  
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Reg Bus 

For an LTC transformer, this is the number of the bus whose voltage is controlled by the 
transformer. For phase shifting transformers, the real power is always controlled at the 
tapped bus.  

Reg Value 

For an LTC transformer, this is the present per unit voltage at the regulation bus. For a 
phase shifting transformer, this is the present real power flow through the transformer 
measured on the "from" (tapped) side.  

Reg Error 

The error is the difference between the regulated value and the respective limit of the 
regulation range specified by Reg Min and Reg Max. If the regulated value is within the 
regulation range, then the error is zero. The error is negative if the regulated value falls 
below the regulation range, and it is positive if the regulated value exceeds the regulation 
range. 

Reg Min, Reg Max 

Minimum and maximum values for the regulation range. For LTC transformers, these fields 
represent per unit voltage at the regulated bus. For phase shifting transformers, these fields 
represent actual MW flow through the transformer measured on the "from" (tapped) side. 
Because transformers use discrete control, the maximum regulation value must be 
somewhat greater than the minimum value.  

Tap Min, Tap Max 

For LTC transformers, these fields specify the minimum and maximum tap ranges for the 
transformer. For phase shifting transformers, these fields specify the minimum and 
maximum phase shift angle in degrees. 

Step Size 

The per unit step size for tap changing transformers. This step size is usually determined by 
dividing the total range of transformer operation by the number of tap positions available. 
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Three Winding Transformer Display 

  

The Three Winding Transformer Display shows information about all the three winding 
transformer devices in the case. Three winding transformers are modeled in Simulator as a 
grouping of two winding transformers, connected at a common midpoint or "Star" bus. The 
Three Winding Transformer Display is a way to view all the terminal connection points for the 
three winding transformers and the power delivered at each of the terminals. 

The Three Winding Transformer Display is a class of Case Information Display, and therefore 
can be used in a manner consistent with all other case information displays. It has a local 
menu from which you can print, copy, and modify its information as well as view the 
information dialog of its associated three winding transformers. When in Edit Mode, you can 
define new three winding transformers using the Insert option, or delete existing three 
winding transformers using Delete. You can also sort the three winding transformer 
information by clicking on the heading of the field by which you want to sort. 

To show this display, open the model explorer and click on Network > Three Winding 
Transformers. 
  

This display contains the following fields by default: 

Pri Bus Num, Sec Bus Num, Ter Bus Num 

These are the primary winding, secondary winding and tertiary winding terminal bus 
numbers for the three winding transformer connections. 

Circuit  

The circuit identifier for the three winding transformer. 

Pri, Sec and Ter MW and MVAr 

These fields display the real and reactive power delivered at each of the three winding 
transformer terminals. 

Star Bus Number and Name 

These two fields provide the number and name of the internal node star bus used in the 
three winding transformer equivalent model. 
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Line Shunts Display 

  

The Line Shunts Display identifies all line shunt devices in the case. Line shunts are similar to 
switched shunts in that they are used in power systems either to inject additional MVR into the 
system (capacitive shunts) or to absorb excess reactive power (inductive shunts). However 
instead of being connected to a bus directly, they are instead shunt connected to one of the 
terminals of a transmission line. As a result they can only be in-service if the actual 
transmission line is in-service. Also, Simulator also does not allow the automatic regulation of 
a bus voltage using Line Shunts as is possible using a switched shunt. Simulator does however 
allow line shunts to be individually taken in and out of service. This must be done manually 
however using the status field of the line shunt. 

The Line Shunts Display is a class of Case Information Display and therefore can be used in a 
manner consistent with all other case information displays. It has a local menu from which you 
can print, copy, and modify its information as well as view the information dialog of its 
associated line shunts. You can find a specific line shunt using its bus name or number, and 
you can learn more about a particular shunt’s terminal bus by choosing either Quick Power 
Flow List or Bus View. When in Edit Mode, you can insert a new line shunt into the case or 
delete an existing shunt. You can also sort the line shunt information by clicking on the 
heading of the field by which you want to sort. Additionally, you can choose to restrict the 
information shown by the Line Shunts Display according to the constraints of the 
area/zone/owner filters.  

To call up the Line Shunts Display, click Network > Line Shunts in the Model Explorer. 
  

The Line Shunts Display contains the following fields by default: 

From Number and To Number 

Numbers of from and to bus of the transmission branch to which the line shunt is attached. 
Use the right menu options to inspect either the Quick Power Flow List or the Bus View 
Display  for the terminal buses. 

Circuit 

Circuit identifier for the transmission branch to which the line shunt is attached. 

Bus Number Located At 

Either the From or To Bus number. Specified the end of the transmission branch to which 
the line shunt is attached. 

ID 

A circuit identifier for the actual line shunt. This is needed because there can be multiple line 
shunts at the same end of the same transmission line. 

G, B 

Indicates the line shunts nominal conductance and susceptance in per unit on the system 
base. 

Status 

Line shunts can be individually taken in and out of service. Do this by changing the status 
field to Open or Closed. 
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DC Lines Display 

  

The DC Line Display presents data describing each dc line in the case. The DC Line Display is a 
class of Case Information Display and therefore can be used in a manner consistent with all 
other case information displays. It has a local menu from which you can print, copy, and 
modify its records as well as view the information dialog of its associated dc lines. You can 
also sort the dc line records by clicking on the heading of the field by which you want to sort. 
Additionally, you can choose to restrict the records shown by the DC Line Records Display 
according to the constraints of the area/zone/owner filters.  

To show the dc line records display, select Network > DC Transmission Lines in the Model 
Explorer, and click on the DC Lines tab. 
  

By default, the dc line records display contains the following fields: 

Number 

Each dc line must be assigned a unique number, typically between 1 and 40.  

Rect AC Number, Rect AC Name, Rect MW, Rect Mvar 

Number and name of the rectifier bus, and the real and reactive power flow from the 
rectifier into the dc line. You may right-click on any of the rectifier-related fields and select 
Quick Power Flow List or Bus View from the local menu to view additional information about 
the rectifier bus. 

Inv AC Number, Inv AC Name, Inv MW, Inv Mvar 

Number and name of the inverter bus, and the real and reactive power flow from the 
inverter into the dc line. You may right-click on any of the inverter-related fields and select 
Quick Power Flow List or Bus View from the local menu to view additional information about 
the inverter bus. 

Control Mode 

Specifies how flow on the dc line is controlled. If this field is set to Power, then the line’s 
MW flow is the control parameter. If the control mode is defined as Current, then the line’s 
current is the control parameter. 

Setpoint Magnitude, Setpoint Location 

Specifies the initial value of the control parameter, which is expressed either in MW or in 
amps depending on the dc line’s control mode. The Setpoint Location indicates if the 
setpoint should be set at the Inverter or Rectifier end of the DC line. 

Set kV 

Specifies the voltage of the dc line in kV. 
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Multi-Terminal DC Record Display 

  

The Multi-terminal DC Line Display presents data describing each multi-terminal DC line in the 
case. The Multi-Terminal DC Line Display is a class of Case Information Display and therefore 
can be used in a manner consistent with all other case information displays. It has a local 
menu from which you can print, copy, and modify its information as well as view the 
information dialog of its associated records. The local menu also affords the opportunity to 
insert multi-terminal DC line records into the model or to delete existing ones.  

To show the Multi-Terminal DC Line display, select Network > DC Lines in the Model 
Explorer, and click on the Multi-terminal DC Lines tab of the transformer case information 
display. 
  

The Multi-terminal DC Line display shows the following fields by default: 

Number 

The record number of each multi-terminal DC record. 

Num Conv 

The total number of converters in each multi-terminal DC network. 

Num Buses 

The total number of DC buses in each multi-terminal DC network. 

Num Lines 

The total number of DC lines in each multi-terminal DC network. 

Mode 

The control mode of the multi-terminal DC network: 0 is Blocked control, 1 is Power control, 
and 2 is Current control.  

V. Cont. Bus 

The number of the AC converter bus at which the DC voltage is controlled. 
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Switched Shunt Display 

  

The Switched Shunt Display identifies all switched shunt devices in the case. Switched shunts 
are used in power systems either to inject additional MVR into the system (capacitive shunts) 
or to absorb excess reactive power (inductive shunts). They may also be used to regulate bus 
voltage within some specified range. 

The Switched Shunt Display is a class of Case Information Display and therefore can be used 
in a manner consistent with all other case information displays. It has a local menu from which 
you can print, copy, and modify its information as well as view the information dialog of its 
associated switched shunts. You can find a specific switched shunt using its bus name or 
number, and you can learn more about a particular shunt’s terminal bus by choosing either 
Quick Power Flow List or Bus View. When in Edit Mode, you can insert a new shunt into the 
case or delete an existing shunt. You can also sort the switched shunt information by clicking 
on the heading of the field by which you want to sort. Additionally, you can choose to restrict 
the information shown by the Load Display according to the constraints of the 
area/zone/owner filters.  

To call up the Switched Shunt Display, select  Network > Switched Shunts in the Model 
Explorer. 
  

The Switched Shunt Display contains the following fields by default: 

Number, Name 

Number and name of terminal bus to which the switched shunt is attached. Not that multiple 
switched shunts are allowed at a bus, however only one switched shunt can have a Control 
Mode which is not fixed. Use the right menu options to inspect either the Quick Power Flow 
List or the Bus View Display  for the terminal bus. 

ID 

Circuit identifier for the switched shunt device. 

Reg Bus Num. 

Number of the bus whose voltage is regulated by the switched shunt. If the regulation bus is 
the same as the terminal bus, this field is blank. 

Status 

The service status of the switched shunt. This field is toggleable. 

Control Mode 

Control Mode for the switched shunt. A switched shunt may operate either as Fixed if its 
reactive value is to be held constant, as Discrete if its reactive output is controlled 
automatically in discrete steps to regulate its terminal voltage, or as Continuous if its 
reactive injection is allowed to vary over a continuous spectrum of values to regulate its 
terminal voltage. A shunt will be switched either discretely or continuously to regulate its 
terminal bus’ voltage between its high and low voltage limits provided the Auto Shunt field 
of its corresponding area is set to Yes and switched shunt control has not been disabled for 
the entire case. You may set the value of the Auto Shunt field from the Area Display, and 
you can control case-wide enforcement of shunt switching from the Power Flow Solution tab 
of the Simulator Options  Dialog. This Control Mode field is toggleable. 

Regulates 

Can be set to regulate either bus voltage or generator MVAR output. 

Actual Mvar 
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The reactive power currently supplied by the switched shunt.  

Volt High 

Per unit high-voltage limit for the regulation range. It is important for discrete shunt control 
that Volt High exceed Volt Low by a nontrivial amount; otherwise, the output of the shunt 
may oscillate during the Power Flow Solution. 

Volt Low 

Per unit low-voltage limit for the regulation range. 

Reg Volt 

Actual per unit voltage at the regulated bus. When Control Mode is either Discrete or 
Continuous, this voltage should be between Volt Low and Volt High.  

Deviation 

Deviation of the regulated bus’ actual per unit voltage from the desired regulation voltage. If 
the actual voltage is within the regulation range, this field is zero. If the voltage is greater 
than Volt High, the deviation is positive. It is negative if the actual voltage is less than Volt 
Low. 

Nominal Mvar 

The Nominal Mvar field gives the initial amount of reactive power the device would supply 
(in Mvars) if its terminal voltage were 1.0 per unit. 

Max Mvar, Min Mvar 

The maximum and minimum Mvar range for the switched shunt. 
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Interface Display 

  

The Interface Display is used to show the net real power (MW) flow on a group consisting of 
one or more of the following devices: 1) transmission lines (AC and DC) and/or transformers, 
2) total tie-lines between two adjacent areas, 3) total tie-lines between two adjacent zones, 4) 
Generators and Loads, 5) Injection Groups, 6) multi-section lines, 7) other interfaces and 8) 
Contingency Actions . Interface information is useful because secure power system operation 
often requires that the flow on such groups be less than some limit value. For example, 
interface information could be used as "proxies" for other types of security constraints, such as 
voltage or transient stability limitations. Another major potential use for interfaces is in the 
Optimal Power Flow solution to monitor flows on groups of devices, such as a set of 
transmission lines, generation leaving a plant, load demanded in a certain region, etc. 
Interface information can also be extremely useful for summarizing the flows occurring on a 
large network. Interface flows can be monitored using the Limit Monitoring Settings Display.  

The Interface Display presents more detailed information for each interface that has been 
defined for the case. The Interface Display is a class of Case Information Display and therefore 
can be used in a manner consistent with all other case information displays. It has a local 
menu from which you can print, copy, and modify its information as well as view the 
information dialog of its associated interfaces. The local menu also affords the opportunity to 
insert new interface definitions either singly (Insert) or as a group (Automatic Insertion) into 
the model or to delete existing ones. In addition, PowerWorld has also added options for 
reading NERC flowgate files (Load NERC Flowgates) and writing NERC flowgate files (Save 
NERC Flowgates) to the local menu. 

You can sort the interface information by clicking on the heading of the field by which you 
want to sort. Additionally, you can choose to restrict the information shown by the Interface 
Display according to the constraints of the area/zone/owner filters.  

To show the interface display, select Aggregations > Interfaces in the Model Explorer. 

Interface information can be saved in the "*.aux" auxiliary file format. See Auxiliary Files for 
details.  

The interface Display is divided into two tabs: Interface and Interface Elements.  
  

Interface Elements Tab 

The Interfaces Elements tab has a list of tabs which lists each types of element that can 
belong to an interface. There is a check-box below in the middle of the display which allows 
you to Only show elements that belong to at least one interface. As you select an 
element in the top half of the display, the bottom half of the display will list each interface 
which contains the selected element. Again, these provide a nice way to look through the 
elements that make up each interface.  

Interface Tab 

The Interfaces tab has a list of interfaces at the top of the display. When on the Interface 
tab, in the bottom half of the tab is a set of subtabs which display all the elements of the 
presently selected interface from the top half of the display. This set of sub tabs starts with 
the Elements tab which lists all the elements of the interface regardless of the type of 
element. The remainder of the tabs each lists the interface elements of a specific type of 
interface element such as Branches, Branch Open/Close, DC Lines, Generators, Loads, 
Injection Groups, Multi-Section Lines and other interfaces. These subtabs provide a nice way 
to look through the elements that make up each interface. The top half of the Interface 
display contains the following fields: 

Number 
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Numeric identifier for the interface. 

Name 

Alphanumeric identifier for the interface (24 characters maximum). 

Interface MW 

Current MW flow on the interface. This flow is the sum total of the Base MW Flow and the 
Contingent MW Flow. 

MW Limit 

Current rating for the interface in MW. 

Percent 

The actual MW flow on the interface as a percentage of the MW limit. 

Monitor Direction 

The current direction in which the MW flow is being monitored. The possibilities are From - 
To or To - From. 

Monitor Both 

Toggle this field to Yes in order to monitor the flow on the interface in both directions, 
instead of a single direction as designated by the Monitor Direction field. 

Lim MW A, Lim MW B, Lim MW C 

These three fields display the values of the three possible limits for the interface. 

Has Contingency 

This is a Yes or No field that will be set to Yes if any of the elements making up part of the 
interface are at a device limit. 

Contingent MW Flow 

If the interface defined contains a contingency action, the Contingent MW Flow is the 
approximated flow amount that would be added to the interface should the contingency 
occur. 

Base MW Flow 

The base MW flow is the flow on the interface prior to any considered contingency elements.  
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Nomogram Display 

  

The Nomogram Display is used to modify and create Nomogram definitions. Nomograms are 
combinations of two interfaces for monitoring combined flows on the interfaces concurrently. 
These Nomogram interfaces will have a limit definition that defines a region of allowed flow on 
the interfaces, and can be monitored in many tools in Simulator as potential constraints, such 
as the contingency analysis reporting of interface violations. Another major potential use for 
nomograms is in the Optimal Power Flow solution to monitor the flow on a pair of interfaces. 
Nomogram information can also be extremely useful for summarizing the flows on a pair of 
interfaces whose operation and allowed flow are closely tied together. Nomogram flows can be 
monitored using the Limit Monitoring Settings Display.  

The Nomogram Display presents more detailed information for each nomogram that has been 
defined for the case. The Nomogram Display is a class of Case Information Display and 
therefore can be used in a manner consistent with all other case information displays. It has a 
local menu from which you can print, copy, and modify its information as well as view the 
information dialog of its associated nomograms. 

You can sort the nomogram information by clicking on the heading of the field by which you 
want to sort. Additionally, you can choose to restrict the information shown by the Interface 
Display according to the constraints of the area/zone/owner filters.  

To show the interface display, select  Aggregations > Nomograms in the Model Explorer. 

Nomogram information can be saved in the "*.aux" auxiliary file format. See Auxiliary Files for 
details.  
  

The Nomogram display contains the following fields: 

Name 

Alphanumeric identifier for the nomogram. 

Int A Flow 

Current MW flow on the first interface of the interface pair forming the nomogram. This flow 
is the sum total of the Base MW Flow and the Contingent MW Flow. 

Int B Flow 

Current MW flow on the second interface of the interface pair forming the nomogram. This 
flow is the sum total of the Base MW Flow and the Contingent MW Flow. 

% Limit, Max Nomo-interface 

The actual MW flow on the nomogram as a percentage of the combined nomogram limit. 

Monitor 

Indicates whether or not the nomogram should be monitored either for violations or as a 
constraint in the Optimal Power Flow. 

Limit Group 

The name of the limit group the nomogram is a member of for limit monitoring. 
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Injection Group Display 

  

The Injection Group Records Display presents data describing each injection group in the case. 
This display is available by selecting Aggregations > Injection Groups from the Model 
Explorer. This display is organized into two tabs with various sections available under each of 
the tabs. The tabs and sections provide options for displaying information about injection 
groups and their associated participation points in a manner in which it is most useful to the 
user. Injection groups can be displayed with their associated participation points or 
participation points can be displayed with the injection group to which they belong.  
  

Injection Groups Tab 

This tab is organized into a top and bottom section. The top section contains the Injection 
Groups Case Information Display that lists all of the defined injection groups. The local menu 
is available by right-clicking on the display and contains options available for most case 
information displays as well as the option to Show Dialog to view the Injection Group Dialog.  

By default, the Injection Groups Case Information Display contains the following fields: 

Name 

The name of the injection group. To change the name of an injection group, simply type a 
new name in the corresponding cell. 

Number of Gens 

Identifies the number of generators contained in the injection group. 

% MW Gen ParFac 

Indicates the degree to which generators will contribute to the MW output of the injection 
group relative to loads. An injection group that has a % MW Gen ParFac value of 100% 
receives all of its output from generator points; an injection group that has a % MW Gen 
ParFac of 50% and a % MW Load ParFac of 50% receives equal MW contributions from its 
constituent loads and generators. 

Number of Loads 

Identifies the number of loads contained in the injection group. 

% MW Load ParFac 

Indicates the degree to which MW loads will contribute to the MW output of the injection 
group relative to generators. An injection group that has a % MW Load ParFac value of 
100% receives all of its output from load points; an injection group that has a % MW Load 
ParFac of 50% and a % MW Gen ParFac of 50% receives equal MW contributions from its 
constituent loads and generators. 

% Mvar Load ParFac 

Indicates the degree to which Mvar loads will contribute to the Mvar output of the 
injection group relative to switched shunts. An injection group that has a % Mvar Load 
ParFac value of 100% receives all of its Mvar output from load points; an injection group 
that has a % Mvar Load ParFac of 50% and a % Mvar Shunt ParFac of 50% receives 
equal Mvar contributions from its constituent loads and switched shunts.  

Number of Shunts 

Identifies the number of switched shunts contained in the injection group. 

% Mvar Shunt ParFac 
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Indicates the degree to which switched shunts will contribute to the Mvar output of the 
injection group relative to Mvar loads. An injection group that has a % Mvar Shunt ParFac 
value of 100% receives all of its Mvar output from switched shunt points; an injection 
group that has a % Mvar Shunt ParFac of 50% and a % Mvar Load ParFac of 50% 
receives equal Mvar contributions from its constituent loads and switched shunts. 

Total MW Injection 

Indicates the current total MW injection of all elements in the injection group. 

Total Mvar Injection  

Indicates the current total Mvar injection of all elements in the injection group. 

  

The bottom section contains additional tabs: Participation Points (All), Generators, 
Loads, Switched Shunts, and Injection Groups. These tabs contain tables, which are 
variations of the Participation Point Records Display, that list all of the individual participation 
points for the selected injection group by element type. Participation points can be added, 
deleted, or modified for the selected injection group from any of the tables on these tabs. The 
Participation Points (All) table lists only the fields that are relevant for defining 
participation points while the specific element tables also make available the fields that are 
specific to that element type.  

The Generators, Loads, Switched Shunts, and Injection Groups tabs have the option to 
Show points that are contained by other injection group points. This option is only 
relevant if an injection group contains a participation point that is another injection group. 
When this option is checked, the individual participation points that are contained in the 
injection group point will also be displayed. The Contained by field will list the name of the 
injection group that contains a particular participation point. When this option is not checked, 
the points displayed will be points that are contained in the selected injection group only and 
no additional information will be provided about the points contained inside any injection 
group points belonging to the selected injection group. If the Contained by field is empty, 
this means that the participation point is explicitly defined with the selected injection group 
and does not belong to it through an injection group point.  

  

Participation Points Tab 

This tab is organized into a top and bottom section. The top section contains tabs for 
Generators, Loads, Switched Shunts, and Injection Groups. Tables on these tabs will 
list power system elements of each particular type. If the option to Only show elements 
that belong to at least one injection group is not checked, then all elements of each type 
in the case will be listed on one of these tabs. If this option is checked, then only those 
elements that belong to an injection group will be listed. The tables on these tabs are Case 
Information Displays for each particular type and have the full functionality of case information 
displays.  

The bottom section is an Injection Groups Case Information Display. When an element from 
one of the tables in the top section of the tab is selected, this table will be populated with the 
list of injection groups to which the selected element belongs.  
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Injection Group Dialog 

  

The Injection Group Dialog provides information about injection groups and allows their 
modification. Specifically, the Injection Group Dialog lists the number of generators, loads, and 
switched shunts contained in the group and the percentage contribution of generators, loads, 
and switched shunts to the injection group’s output. The Injection Group Dialog also houses 
the Participation Points Records display, from which points can be added and deleted from the 
injection group’s list of participants and the various attributes of the points can be changed. 

To view the Injection Group Dialog for a particular injection group, open the Injection Group 
Display by selecting Aggregations > Injection Groups from the Model Explorer. Find the 
injection group of interest in the Injection Groups Case Information Display and right-click on 
it. Then select Show Dialog from the resulting local menu. 
  

The Injection Group Dialog contains the following fields and controls: 

Name 

Identifies the injection group whose information is currently displayed. Selecting a different 
name from this dropdown box will display information for another injection group. 

New, Delete 

To insert a new injection group from this dialog, press New, and supply the name for the 
new injection group. To delete the injection group that is currently being shown, click 
Delete. 

Save 

Changes made to injection groups through the Injection Group Dialog are not immediately 
saved with the power system case. This allows the option of canceling any changes without 
impacting the case. Click the Save button to store any updates with the case. 

# Gens 

Displays the number of generators contained in the injection group. 

# Loads 

Displays the number of loads contained in the injection group. 

# Shunts 

Displays the number of switched shunts contained in the injection group. 

% MW Gen Part., % MW Load Part., % MVR Load Part., % MVR Shunt Part. 

Displays the relative contributions of generators, loads, and switched shunts to the output of 
the injection group. 

OK, Cancel 

Changes made to the injection groups through the Injection Group Dialog are not immediately 
saved with the power system case. This allows the option of canceling any changes without 
impacting the case. Click Cancel to close the dialog without saving the changes. Click OK to 
close the dialog and save the changes. 

  

Participation Points 

The tab on the bottom of the Injection Group Dialog lists the points that make up the injection 
group. This display is called the Participation Point Records Display. By right-clicking on this 
display, points can be added and deleted from the injection group. Properties of specific points 
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can be changed by entering changes directly in the table. The Insert Points button will open 
the Add Participation Points Dialog that can also be used for modifying the points. 
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Participation Point Records Display 

  

The Participation Point Records Display shows information about the points that comprise a 
particular injection group. This display can be accessed for a particular injection group from 
the Injection Group Dialog or the Injection Group Display. 

The Participation Point Records Display is a class of Case Information Display and therefore 
can be used in a manner consistent with all other case information displays. It has a local 
menu from which participation points can be deleted or added to the injection group through 
the Add Participation Points Dialog. Selecting Insert from the local menu will open the Add 
Participation Points Dialog that will allow the addition, deletion, and modification of 
participation points in the injection group.  
  

The Participation Point Records Display shows the following fields by default: 

Point Type 

Every participation point is a generator (GEN), load (LOAD), switched shunt (SHUNT), or 
injection group (INJECTIONGROUP). 

Number 

Identifies the number of the bus to which a generator, load, or switched shunt is connected. 

Name 

Identifies the name of the bus to which a generator, load, or switched shunt is connected. 

ID 

Identifies the ID of the generator, load, or switched shunt or the name of the injection 
group.  

AutoCalc? 

If the value of AutoCalc is YES, the participation factor of the point is re-calculated with 
every use to be consistent with the way the point’s participation factor was initially defined. 
If the value of AutoCalc is NO, the participation factor is assumed fixed at its present value. 

Initial Value 

Indicates how the participation factor of the point was originally computed. For generators, 
the possible values of this field are  

SPECIFIED  The participation factor was specified as a constant. 

MAX GEN INC  The participation factor was defined as the difference between the 
generator’s maximum MW output and its present MW output. 

MAX GEN DEC  The participation factor was defined as the difference between the 
generator’s present MW output and its minimum MW output. 

MAX GEN MW  The participation factor was defined as the maximum MW output of the 
generator. 

For loads, the Initial Value property can assume only two possible values: 

SPECIFIED  The participation factor was specified as a constant. 

LOAD MW  The participation factor was defined as the size of the load in MW. 

For switched shunts, the Initial Value property can assume four possible values: 

SPECIFIED  The participation factor was specified as a constant. 
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MAX SHUNT INC  The participation factor was defined as the difference between the 
maximum Mvar output of the switched shunt and its present 
nominal Mvar output. 

MAX SHUNT DEC The participation factor was defined as the difference between the 
present nominal Mvar output and the minimum Mvar output of 
the switched shunt. 

MAX SHUNT MVAR The participation factor was defined as the maximum Mvar output of 
the switched shunt. 

For injection groups, the Initial Value property can assume only one possible value: 

SPECIFIED  The participation factor was specified as a constant. 

The Initial Value field is important if saving the injection groups to an auxiliary file and 
using them with another case that might have a different generation dispatch or load profile. 
If the Initial Value for a point is specified as GEN MAX INC, for example, and the point is 
loaded from an auxiliary file into another case, Simulator will re-calculate the point’s 
participation factor to match the generator’s positive MW reserve in that case.  

The Initial Value field is also important if the AutoCalc field is set to YES, because 
AutoCalc uses the rule defined by the Initial Value field to recalculate the participation 
factor with every use. For example, if the Initial Value is MAX GEN INC and AutoCalc is 
YES, the point’s participation factor will be updated to match the generator’s MW reserve 
every time the point is accessed. 

When the value of the Initial Value field is toggled, the point’s participation factor, shown 
in the ParFac field, will update to match the new definition. The Initial Value field must 
equal SPECIFIED to be allowed to change the value of the point’s ParFac field by typing the 
new value directly into the field. 

If AutoCalc is NO and the injection group is not intended to be used with any other case, 
then the Initial Value field should either be ignored or set to SPECIFIED. 

ParFac 

Indicates the participation factor of the participation point. The participation factor defines 
the relative contribution of the point to the total output of the injection group. The load, 
generation, or switched shunt change associated with each point is calculated based on the 
value of the participation factor, with values for points having the largest participation 
factors experiencing the greatest change. 

The participation factor for injection group participation points indicates the relative 
contribution of the entire injection group to the total output of the injection group to which 
it belongs. The participation factors of the individual points in the injection group point 
further define the relative contribution of these points to the total output of the injection 
group. The following two injection groups provide an example of how injection group points 
impact the injection group to which they belong when the points are normalized for use: 

Injection Group 1    Injection Group 2 

Gen 1, ParFac = 50   Gen 5, ParFac = 40 

Gen 2, ParFac = 30   Load 1, ParFac = 20 

InjectionGroup 2, ParFac = 20  Load 2, ParFac = 20 

Total = 100    Total = 80 

  

When Injection Group 1 is used, the participation factors are normalized so that each 
element provides the following contribution: 
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Gen 1, Normalized ParFac = 50/100 = 0.5 

Gen 2, Normalized ParFac = 30/100 = 0.3 

Gen 5, Normalized ParFac = 20/100 * 40/80 = 0.1 

Load 1, Normalized ParFac = 20/100 * 20/80 = 0.05 

Load 2, Normalized ParFac = 20/100 * 20/80 = 0.05 

Total Normalized = 1.0 

  

To add points to the injection group, right-click on the Participation Point Records Display and 
select Insert from the local menu. This opens the Add Participation Points Dialog. 
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Island Display 

  

The Island Display presents information on the system’s islands. An island consists of a group 
of buses that are electrically connected via ac transmission lines and transformers and thus 
operate in synchronism with one another. Multiple islands can be connected together via dc 
transmission lines. Each island requires a slack bus. All systems have at least one island, which 
may encompass the entire system. 

The Island Display is a class of Case Information Display and therefore can be used in a 
manner consistent with all other case information displays. It has a local menu from which you 
can print, copy, and modify its information. You can also sort the islands information by 
clicking on the heading of the field by which you want to sort.  

To show this display select Aggregations > Islands in the Model Explorer. The display is 
only available in run mode. 

You cannot modify any fields on this display.  
  

The display has the following fields for each island:  

Slack Bus Number, Slack Bus Name, Slack Bus Area 

Number, name and area of the slack bus for the island. Each island requires at least one 
slack bus. 

Total Buses 

Total number of buses in the island.  

Energized 

Indicates whether the island is connected to a source of power. 

Gen MW, Gen Mvar 

Total real and reactive generation for the island.  

Load MW, Load Mvar 

Total real and reactive load for the island. 

Scheduled Exports 

The power scheduled to be provided by the island to other regions of the system. Because 
the island is isolated from the rest of the system, this export requirement is currently not 
met. 

DC MW Exports 

The power provided by the island to other regions of the system across a DC line. 
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MW Transactions Display 

  

The MW Transactions Display is a quick way to view the defined base transactions between 
areas within the load flow case.  

The Matrix of Transactions display is set up as a matrix of transactions, with the areas 
listed as both the column and row identifiers. It is important to note that the direction of the 
transaction is such that the area represented by the row is assumed the exporting area, and 
the area represented by the column is assumed the importing area. For example, if there is a 
50 MW transaction from area one to area two, you will see a +50 in the matrix in row 1, 
column 2. However, if you look at row 2, column 1, you will see a – 50. This is because the 
grid is displaying the EXPORT from area two to area one, but since area two is importing, not 
exporting, the value is represented as negative. 

Each row and column position, with the exception of the diagonal positions (it does not make 
sense for an area to export to itself), can be directly modified by the user in this information 
display. As you type a value in one of the matrix positions, Simulator automatically fills the 
symmetric matrix position with the negative of the value you enter. This makes for a quick and 
easy location for adding and removing transactions from the case. 

Note that you cannot modify Unspecified transactions in the MW Transactions display. This 
makes sense, as the unspecified transactions have only one associated area. To modify 
unspecified transaction amounts, you must open the Area Information Dialog for the area you 
wish to modify, and change the Unspecified transaction amount.  

The List of Transactions is just another way of showing the transactions between areas. 
The List of Transactions Display is a class of Case Information Display and therefore can be 
used in a manner consistent with all other case information displays. It has a local menu from 
which you can print, copy, or modify its records as well as view the information dialog of its 
associated areas. You can also sort the area records by clicking on the heading of the field by 
which you want to sort.  

Note that a special feature is available in the right-click local menu called Clear Transactions 
and auto-insert tieline transactions. By choosing this option all MW transactions in the 
case will be deleted, and all Unspecified MW transactions for each area will be set to zero. 
Then new MW transactions will be created between each pair of areas that area directly 
connect to one another. The amount of the new MW transactions will be set equal to the 
actual sum of the flow on the tielines between the connected areas. 
  

By default, the List of Transactions display contains the following fields: 

Export Area Number, Export Area Name 

Exporting area number and alphanumeric identifier. 

Other Area Number, Other Area Name 

Importing area number and alphanumeric identifier. 

MW Transfer  

Value of the transfer in MW. 
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Transaction Dialog 

  

The Transaction Dialog can be used to modify or create Base Interchange Transactions 
between two areas. This dialog can be opened by right-clicking in the Base Interchange table 
of the Area Information Dialog and choosing Show Dialog to see an existing transaction 
definition, or Insert to add a new transaction. 

The transaction dialog is divided into two pages of controls: 
  

Information 

Transacting Area 

This is the "from" area for the transaction. For an export from this area, the transaction 
value will be positive. For an import into the Exporting Area, the transaction value specified 
would be negative. Flow out (export) of the exporting area is always considered positive. 

Transaction To Area 

This is the "to" area for the transaction. 

Transaction ID 

New in Simulator version 10 is the ability to have multiple transactions defined between the 
same two areas. Because of this, it is now required that transactions also have a Transaction 
ID. 

Rename Transaction ID 

If you wish to change the transaction ID for a particular transaction, enter the new value in 
the Transaction ID field, and press this button. 

Switch Directions 

Press this button if you wish to reverse the defined Exporter and Importer for the 
transaction. 

Transaction MW Amount 

The MW amount of the transaction being defined. This value should be positive for an 
export from the Exporting area to the Importing area. The value can also be entered as 
negative to define a transaction into the Exporting area from the Importing area. 

Transaction Minimum MW 

The minimum transaction amount between the two areas. This field is only enabled if the 
check box labeled Transaction Dispatchable in OPF is checked. 

Transaction Maximum MW 

The maximum transaction amount between the two areas. This field is only enabled if the 
check box labeled Transaction Dispatchable in OPF is checked. 

Exports/Imports Transmission Charge 

The cost to transfer power, in $/MWh. This adds an economic penalty for making the 
transfer, making the transfer less likely to take place. Half the charge is assigned to the 
buyer and half to the seller. 

Transaction Enabled 

Transaction can now be defined and either enabled or disabled. Any disabled transactions 
will be ignored in both a standard power flow solution and an OPF solution. 

Transaction Dispatchable in OPF 
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Checking this box enables the transfer to be dispatched by the OPF algorithm. Dispatching 
the transaction makes the two areas of the transaction appear to be one area for the 
purpose of economically dispatching the generation in the two areas. The transaction can 
have a maximum and minimum transfer amount when dispatchable, and a transmission 
charge associated with the transaction. 

Determine Price in OPF 

Checking this box allows the OPF algorithm to determine the cost associated with the 
transfer. The cost is determined by the marginal cost of enforcing the power balance 
constraint for the combined areas. This is the typical way to implement a transfer if both 
areas are on OPF control. If only one of the two areas are on OPF control, then the area 
which is off of OPF control needs to specify a price for the transfer. This is done by explicitly 
defining a piecewise linear cost curve. 

Piecewise Linear Transaction Cost Curve 

These two curves are only enabled if the option Transaction is Dispatchable in OPF is 
checked and the option Determine Price in OPF is unchecked. These two curves can be 
defined for the purpose of assigning a price to the transfer of power between one area on 
OPF control and another area which is not on OPF control. Separate curves can be defined 
for export transactions (from the Exporter to the Importer) and import transactions. To add 
points to the curves, simply right-click in the grid and choose Insert from the local menu. 
Enter the MW value and corresponding marginal cost for the inserted breakpoint of the 
piecewise linear curve you are defining. To delete a point, right-click on that row in the grid 
and choose Delete from the local menu. 

  

Custom 

The Custom page of the Transaction dialog is simply a location to log information about the 
transaction in the Memo box, and to see the values (if any) stored in some of the custom 
fields for the transaction. To log information about the transaction, simply switch to the 
Custom page on the dialog, and start typing your information or comments about the 
transaction in the page, or enter custom values in one of the custom fields. 
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Limit Monitoring Settings 

  

Simulator offers many tools to study the capabilities of a power system. Examples include: 
• Contingency Analysis 
• Available Transfer Capability (ATC) 
• Optimal Power Flow (OPF) 
• Security Constrained OPF (SCOPF) Overview 
• PV Curve and QV Curve Tool 

All of these tools make extensive use of power system limits. Limits for various power system 
elements include: 
• MVA (or Amp) limits on transmission lines and transformers 
• MW limits on Interfaces 
• High and low voltage limits for Buses 

The accuracy of all these limits is very important, as is the specification of which limits should 
be monitored. While ensuring the accuracy of input data such as power system limits must be 
left to the user, PowerWorld Simulator provides several ways to specify which limits should be 
monitored. Limit Monitoring is specified according to settings for the Area, Zone and Limit 
Group to which the power system element belongs. A power system element is monitored only 
if ALL of the following conditions are met. 
  

Conditions for Monitoring an Element’s Limit 

• Its Monitor field is set to YES 
• Its Limit Group is Enabled 
• Its Area is set to Report Limits and it meets the KV range for reporting  
• Its Zone is set to Report Limits and it meets the KV range for reporting  

The Limit Monitoring Settings Dialog gives you ability to specify all these settings to setup the 
limits you want to monitor, and thus enforce in the various tools that Simulator provides. 
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Limit Monitoring Settings and Limit Violations Dialog 

  

The Limit Monitoring Settings Dialog gives you ability to specify which limits you want to 
monitor, and thus enforce in the various tools that Simulator provides. In general, keep in 
mind that a bus, transmission line/transformer, or interface’s limit is monitored only if the 
following conditions are met. 
  

Conditions for Monitoring an Element’s Limit 

• Its Monitor field is set to YES 
• Its Limit Group is Enabled 
• Its Area is set to Report Limits and it meets the KV range for reporting  
• Its Zone is set to Report Limits and it meets the KV range for reporting  

The following fields are shown on the display: 

Elements To Show 

Change this value to modify which elements are displayed in the Buses, Lines, and 
Interfaces. Set it to… 

All Elements to show all Buses, Lines and Interfaces regardless of monitoring 
settings. 

Monitored Elements to only display Buses, Lines and Interfaces that meet the 
conditions for monitoring. See Limit Monitoring Settings for more information on 
setting which values are monitored. 

Violating Elements to only display Buses, Lines and Interfaces that are violating. 
See Limit Monitoring Settings for more information on setting what is considered a 
violation. 

Number of Violations 

High Voltage Buses and Low Voltage Buses 

Shows the total number of bus voltage magnitude violations. These violations are shown 
on the Bus Voltage Magnitude Limit Violations Display. This field is read-only. 

Low Voltage Suspects 

Shows the total number of buses whose voltages have fallen below a designated threshold 
to indicate a low voltage solution is being reached in some location in the system. 

Line/Transformer Violations 

Shows the total number of violations reported on Line and Transformer Limit Display. 
This field is read-only. 

Interface Violations 

Indicates the total number of interface violations. These violations are shown on the 
Interface Violations Display. This field is read-only. 

Limit Group Values 

This part of the dialog shows information about the Limit Groups with greater description 
shown below.  

Save/Load Monitoring Settings 

The Save and Load Monitoring Settings buttons allow the user to save the current set or 
load a previously saved set of Limit Monitoring Settings options. The options are saved in a 
PowerWorld Auxiliary File text format. 
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Do not monitor radial lines and buses  

Check this box to ignore limits on radial lines and buses throughout the case. In this 
instance a radial bus is defined as a bus that is connected to the rest of the power system 
by a single inservice transmission line. A radial line is the defined as a line connected to a 
radial bus. This means that in a 5 lines in series that connect to a radial load, only the last 
bus and last line will be considered radial.  

If you would like to better determine which lines are "radial" in a more traditional sense, use 
the feature Branches that Create Islands that allows you to easily generate a list of branches 
that if taken out of service will split an existing island into two. These represent lines which 
may be considered radial. 

  

Tabs on the Limit Monitoring Dialog 

The tabs on the Limit Monitoring Settings Dialog allow you to change these settings. These 
tabs contain tables showing lists of the respective elements. Since these tables are another 
variety of the Case Information Displays, you may interact with it in a familiar manner. Click 
on any of the field headings to sort by that field. Right-click on the display to call up the 
display’s local menu. From the local menu, you can print the violations, copy the violation 
records to the Windows clipboard for use with another application, modify the format and 
content of the violations listing, view the information dialog of the respective element, and 
view the Quick Power Flow List or Bus View Display. 
  

Buses Tab 

Each tab shows a list of the respective type of power system element. The important 
columns include 

Number, Name Bus number between 1 and 99,999, and its alphanumeric identifier.  

Area Name Alphanumeric identifier of the bus’ area. 

Monitor : toggle this between YES and NO to set whether the specific element 
should be monitored. 

Limit Group : toggle this value to specify which Limit Groups the element belongs to 

PU Volt Bus’ per unit voltage magnitude.  

Volt (kV) Bus’ actual voltage magnitude in kV. This is the per unit voltage magnitude 
multiplied by the bus’ nominal voltage. 

Note: If Elements to Show is set to Monitored Elements, then only elements which meet the 
conditions for monitoring will be displayed in these lists. 

Lines Tab 

Each tab shows a list of the respective type of power system element. The important 
columns include 

From Bus Number and Name "From" bus number and name. For transformers, 
the from bus is the tapped side. Right- clicking on either of these fields allows you to 
see all the flows measured at the "from" bus using the Quick Power Flow List or Bus 
View Display local menu options.  

To Bus Number and Name "To" bus number and name. For transformers, the to 
bus is the untapped side. Right-clicking on either of these fields allows you to see all 
the flows into the "to" bus using the Quick Power Flow List or Bus View Display local 
menu options. 
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Circuit Two-character identifier used to distinguish between multiple lines joining the 
same two buses. 

Monitor : toggle this between YES and NO to set whether the specific element 
should be monitored. 

Limit Group : toggle this value to specify which Limit Groups the element belongs to 

Used Limiting Flow, Limit, Used % of Limit The flow at the end of the branch 
selected for measurement, and its MVA or Amp limit. The percentage equivalent of 
the flow to it’s limit is given in the Used % of Limit column. 

MVA or Amps? Units used with the Max Flow and the Limit field. All flows are 
expressed either in MVA or amps. 

Note: If Elements to Show is set to Monitored Elements, then only elements which meet the 
conditions for monitoring will be displayed in these lists. 

Interfaces and Nomograms Tab 

Similar to the Buses and Lines Tabs shown above. The important columns are the Monitor 
and Limit Group columns 

Area Reporting and Zone Reporting Tabs 

These tabs display all the Areas and Zones in the system. The important columns are 

Report Limits: toggle this between YES and NO to set whether the specific element 
should be monitored. 

Report Min kV and Report Max kV: Only buses and lines within this kV range will 
be monitored. 

Modify/Create Limit Group Tab 

Every power system elements belongs to a single Limit Group. By default, all power system 
elements are in the same Limit Group that is named "Default". New limit groups can be 
added by right-clicking in the table and choosing Insert from the popup menu. Additional 
limit groups give the flexibility of assigning devices to different groups, where each group 
can have its own set of defined limit information. 

The limit group stores important values regarding the enforcement and monitoring of the 
power system elements within the Limit Group. The values are 

Branch Percentage: The percentage to which Simulator’s study tools will limit a line 
or transformer. Typically this is 100%, but it can be modified. In Contingency 
Analysis, then lines will be flagged as violated if they exceed this percentage. In 
performing an Optimal Power Flow, all attempts will be made to keep the line below 
this percentage. 

Line Rate Set: You may define eight different ratings to transmission lines or 
transformers (for more information see Line/Transformer Information). Change this 
value to specify which rating set should be used for lines/transformers in the limit 
group. 

Amps or MVA:  Limits for transmission lines and transformers are always entered in 
MVA. However, when reporting limit violations, it is common to check transmission 
line limits in terms of their amp loading. If the Treat Line Limits As Equivalent Amps is 
checked, the limits for transmission lines are reported in amps rather than MVA. If 
this box is not checked, limits for both transmission lines and transformers are 
expressed in MVA. 

  For reference, note that the amp rating of a line is derived from the MVA rating 
using the formula  
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Interface Percentage: The percentage to which Simulator’s study tools will limit an 
interface. Typically this is 100%, but it can be modified. In Contingency Analysis, 
then interfaces will be flagged as violated if they exceed this percentage. In 
performing an Optimal Power Flow, all attempts will be made to keep the interface 
below this percentage. 

Interface Rate Set: You may define eight different ratings to an interface. Change 
this value to specify which rating set should be used for interfaces in the limit group. 

Nomogram Percentage: The percentage to which Simulator’s study tools will limit 
a nomogram. 

Low PU Volt: Buses will be flagged as violated if they fall below this per unit 
voltage. 

High PU Volt: Buses will be flagged as violated if they go above this per unit 
voltage. 

Disabled: Set the value to YES to ignore all power system element limits in the Limit 
Group. Set the value to NO to monitor limits according to the settings of the Limit 
Group. 

Contingency Line Rate Set:  This field specifies the rating set used for post-
contingency monitoring of Lines/Transformers. 

Interface Contingency Rate Set: This field specifies the rating set used for post-
contingency monitoring of Interfaces during Contingency Analysis. 

Limiting End: Specified as higher or lower, this field determines whether the higher 
or the lower flow amount on the element is used for reporting a limit violation. If you 
use higher, it is possible that the lower flow is not violating the line limit. If you use 
lower, then you are guaranteed that the element limit is being violated at both ends 
of the element. 

Use Limit Cost: If this field is set to yes, you are enabling the capability to have a 
cost function associated with enforcing constraints. This cost function can be viewed 
as similar to a generator cost function, in that as the constraint becomes overloaded 
by larger amounts, the marginal cost of enforcing the constraint will increase. For 
setting the piecewise linear limit cost curve, right-click and choose show dialog from 
the popup menu to access the Limit Group Dialog. 

Often monitoring elements according to Area and/or Zone is all that you need. However, if 
you need to monitor specific groups of power system elements and not others then you 
need to create some new Limit Groups. 
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Limit Group Dialog 

  

The Limit Group Dialog reflects much of the same information that is summarized in the Limit 
Monitoring Settings Dialog’s Modify/Create Limit Groups page. The same information can be 
changed here as on the previously mentioned display. One important feature that is unique to 
this dialog is the ability to define a piecewise linear limit cost curve, which can be used for 
setting up "soft" constraints used in the Security Constrained Optimal Power Flow. 

Disabled 

Check this option to ignore all power system element limits in the Limit Group. Leave the 
box unchecked to monitor limits according to the settings of the Limit Group. 

Add New Limit Group 

Clicking this button will create a new limit group, displaying a dialog in which the name for 
the new limit group can be specified. 

Rename Limit Group 

Clicking this button will display a dialog in which a new name for the current limit group can 
be specified. 

  

Lines/Interfaces 

% of Limit for Reporting (Branches) 

The percentage to which Simulator’s study tools will limit a line or transformer. Typically this 
is 100%, but it can be modified. In Contingency Analysis, lines will be flagged as violated if 
they exceed this percentage. In performing an Optimal Power Flow, all attempts will be 
made to keep the line below this percentage. 

Line/Transformer Rating Set 

You may define eight different ratings to transmission lines or transformers (for more 
information see Line/Transformer Information). Change this value to specify which rating set 
should be used for lines/transformers in the limit group. 

Line/Transformer Contingency Rating Set 

This field specifies the rating set used for post-contingency monitoring of 
Lines/Transformers. 

Treat Transmission Line Limits as Equivalent Amps 

Limits for transmission lines and transformers are always entered in MVA. However, when 
reporting limit violations, it is common to check transmission line limits in terms of their amp 
loading. If the Treat Line Limits As Equivalent Amps is checked, the limits for transmission 
lines are reported in amps rather than MVA. If this box is not checked, limits for both 
transmission lines and transformers are expressed in MVA. 

 For reference, note that the amp rating of a line is derived from the MVA rating using the 
formula  

   

Limiting End of Line 

Specified as higher or lower, this field determines whether the higher or the lower flow 
amount on the element is used for reporting a limit violation. If you use higher, it is possible 
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that the lower flow is not violating the line limit. If you use lower, then you are guaranteed 
that the element limit is being violated at both ends of the element. 

% of Limit for Reporting (Interfaces) 

The percentage to which Simulator’s study tools will limit an interface. Typically this is 
100%, but it can be modified. In Contingency Analysis, interfaces will be flagged as violated 
if they exceed this percentage. In performing an Optimal Power Flow, all attempts will be 
made to keep the interface below this percentage. 

Interface Rating Set 

You may define eight different ratings to an interface. Change this value to specify which 
rating set should be used for interfaces in the limit group. 

Interface Contingency Rating Set 

This field specifies the rating set used for post-contingency monitoring of Interfaces during 
Contingency Analysis. 

% of Limit for Reporting (Nomograms) 

The percentage to which Simulator’s study tools will limit a nomogram. 

Use Limit Cost 

If this field is checked, you are enabling the capability to have a cost function associated 
with enforcing constraints. This cost function can be viewed as similar to a generator cost 
function, in that as the constraint becomes overloaded by larger amounts, the marginal cost 
of enforcing the constraint will increase. 

Once the box is checked, the table for defining the limit cost function will become enabled. 
The starting point (% Flow) must be at or above 100%. You can then begin inserting 
additional points in the piecewise linear curve by right-clicking in the table and selecting 
Insert Point from the popup menu, followed by entering the new percent flow and marginal 
cost. Note that the cost function must be strictly increasing, meaning the next marginal cost 
value must be equal to or greater than the immediately previous value. 

When constraints are given the ability to use this limit cost curve, it effectively gives the 
optimal power flow the ability to "dispatch" the limit of the elements according to the 
marginal costs of the limit cost curve. You are determining the point on the limit cost curve 
where the shadow price of enforcing the constraint is met. Thus the OPF routine will 
determine how much you will allow the element to be overloaded by giving the element the 
piecewise linear curve. The OPF will solve the problem, and optimize the constraints as it 
determines shadow prices for each constraint and adjusts the limit accordingly during the 
iterations of the routine. Since these are somewhat flexible limit assignments to the 
elements, they are sometimes considered "soft" constraints. 

  

Buses/Summary 

Low Per Unit Limit 

Buses will be flagged as violated if they fall below this per unit voltage. 

High Per Unit Limit 

Buses will be flagged as violated if they fall below this per unit voltage. 

Low-voltage solution flag 

Enter a per unit value at which you wish to measure a voltage and consider the solution to 
be a low voltage solution. 
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Include Out-Of-Service Buses 

Check this check-box to include out-of-service buses. 

Elements using Limit Group 

Lists the number of elements that are members of the selected limit group. 
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Owner Data Information Display 

  

The Owner Data display will display the owners sorted by owner number, and show the total 
number of devices, as well as a breakdown of the number of specific devices. The owner 
display will also summarize the total device output or demand for the owned devices, such as 
generator output and load demand. 

You can right click on the owner grid to open the local menu, from which you can perform 
various actions and view an informational regarding the owner selected in the grid. Once an 
owner dialog is displayed for a particular owner, you can browse through information on all 
the owners. 
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Owner Dialog 

  

The Owner Dialog displays summary information about the devices designated as owned by 
the selected owner. 

The dialog for an individual owner displays each of the elements for that owner, along with 
the percentage of ownership, in the device pages labeled Buses, Loads, Generators, and Lines. 
  

The dialog also contains a memo page for making comments or notes about the selected 
owner. 

General Info 

Load and Generation 
The information in the Load and Generation section provides a summary of the total 
injections of the owned devices. This includes a total of all the load, generation, and 
shunt injections owned. 

Summary of Owner Objects 

This information section simply lists a total number of all owned devices. Note that buses 
and loads do not currently have fractional ownership. However, generators and 
transmission lines do have the capability to be partially owned by more than one owner. 
Therefore it is possible to see fractional ownership amounts for the number or 
generators or lines. 

Generator Costs and OPF Results 

This information provides a summary of LMP and cost information determined by running 
an Optimal Power Flow solution. The information provided is determined only for devices 
owned by the selected owner. 
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Owned Bus Records Display 

  

The Owned Bus Records display is a Case Information Display that allows you many of the 
same options as the Case Information Bus Display. In addition to the information available for 
viewing from the Bus Display, the Owned Bus Records Display also shows the owner number 
and percentage of ownership. Currently, Simulator only allows one owner per bus, so by 
default the ownership percent is always 100%. 
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Owned Load Records Display 

  

The Owned Load Records display is a Case Information Display that allows you many of the 
same options as the Case Information Load Display. In addition to the information available 
for viewing from the Load Display, the Owned Load Records Display also shows the owner 
number and percentage of ownership. Currently, Simulator only allows one owner per load, so 
by default the ownership percentage is always 100%. 
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Owned Generator Records Display 

  

The Owned Generator Records Display is a Case Information Display that allows you many of 
the same options as the Case Information Generator Display. In addition to the information 
available for viewing from the Generator Display, the Owned Generator Records Display also 
shows the owner number and percentage of ownership. Currently, Simulator allows up to four 
owners for one generator, with a total percentage ownership between 0 and 100%. To make 
changes to the owners and ownership percentages for a generator, right-click on the grid and 
choose Show Dialog and select the Owners, Area, Zone tab. 
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Owned Line Records Display 

  

The Owned Line Records Display is a Case Information Display that allows you many of the 
same options as the Case Information Line and Transformer Display. In addition to the 
information available for viewing from the Line and Transformer Display, the Owned Line 
Records Display also shows the owner number and percentage of ownership. Currently, 
Simulator allows up to four owners for one generator, with a total percentage ownership 
between 0 and 100%. The make changes to the owners and ownership percentages for a 
transmission line, right-click on the grid and choose Show Dialog and select the Owners tab. 
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Jacobian Display 

  

The Jacobian display is a matrix showing the system Jacobian matrix for the currently loaded 
Simulator case. This display can be very useful for educational purposes. Keep in mind that for 
a large case, this display can contain a very large matrix. It is possible to right-click on this 
display and save the grid to a Matlab formatted file, or to export the grid to an Excel 
spreadsheet. Be aware that a Jacobian matrix from a large will often exceed the size 
limitations of an Excel spreadsheet. 
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Ybus Display 

  

The Ybus display (bus admittance matrix) is a matrix showing the system Ybus for the 
currently loaded Simulator case. This display can be very useful for educational purposes. 
Keep in mind that for a large case, this display can contain a very large matrix. It is possible to 
right-click on this display and save the grid to a Matlab formatted file, or to export the grid to 
an Excel spreadsheet. However, Excel does have limitations on the number of rows and 
columns that could quickly be exceeded with a Ybus from a large case. 
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Chapter 9: Injection Groups 

  

This chapter describes the setup and use of injection groups. Injection groups are useful for 
modeling generators and loads together like a unit. 

The following topics are covered in this chapter: 
• Injection Group Overview 
• Working with Injection Groups 
• Participation Groups 
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Injection Group Overview 

  

An injection group is a collection of loads, generators, switched shunts, and/or other injection 
groups. In that respect, injection groups are somewhat analogous to areas and zones. 
However, unlike with areas and zones, generators, loads, switched shunts, and injection 
groups can belong to more than one injection group. Moreover, a single injection group may 
contain generators, loads, and switched shunts from several different areas and zones. Thus, 
injection groups are useful when modeling a collection of generators, loads, and switched 
shunts that act together as a unit, regardless of each individual’s area or zone affiliation. The 
most common use for injection groups is to model a transfer of power from one group of 
generators and loads to another for PTDF calculations and for PV/QV analysis. They are called 
injection groups because their components (generators, loads, and switched shunts) are 
objects that inject power into the network. 
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Creating Injection Groups 

   

Injection groups can be created from the Injection Group Display, Injection Group Dialog, 
Generator Display, Load Display, Switched Shunt Display, or by selecting a group of display 
objects on the oneline display.  

To create an injection group from the Injection Group Display, select Aggregation > 
Injection Groups in the Model Explorer to open the Injection Group Display. This display is 
organized into two tab pages with additional tabs and displays available under each. The 
Injection Groups tab lists and provides a summary of all defined injection groups. Click the 
right mouse button on this display, and select Insert from the resulting local menu and the 
Injection Group Dialog will open with a default name assigned to the new injection group. The 
Injection Group Dialog allows the addition of participation points to the new injection group 
and allows updating existing injection groups. The Load option on the local menu of the 
Injection Group Display can also be used to import injection groups from an Injection Group 
Auxiliary Data File and the Auto Insert Injection Groups option can be used to 
automatically insert injection groups based on options set in the Auto Insertion of Injection 
Groups Dialog.  

If the Injection Group Dialog is already open, clicking the button labeled New will create a 
new injection group. A prompt will then ask for the name of the injection group to add.  

To create an injection group from the Generator Display, Load Display, or Switched Shunt 
Display, select the elements to add to the injection group from one of these displays, right-
click on the selection to bring up the local menu, and select Create Injection Group from 
Selection from the local menu. The Injection Group Dialog will open with the selected 
elements added to a new injection group. Any necessary modifications to the group can be 
made from the Injection Group Dialog. 

To create an injection from a selection of display objects, select the objects to add to the 
injection group. Only generators, loads, and switched shunts will be added to an injection 
group, but if other objects are selected, the injection group will still be created. The objects 
that cannot be added to an injection group will simply be ignored. Once all objects are 
selected, right-click on the selection to bring up the local menu. On the local menu select 
Create Injection Group from Selection. The Injection Group Dialog will open with the 
selected objects added to a new injection group. Any necessary modifications to the group can 
be made from the Injection Group Dialog. More than one object must be selected on the 
display for the create injection group option to be available.  
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Auto Insert Injection Groups 

  

Many times injection groups need to be created comprised of generators, loads, or switched 
shunts grouped by areas, zones, super areas, owners, or some other criteria. Injection groups 
can be created automatically by setting the grouping options by using the Auto Insertion of 
Injection Groups Dialog. 

The Auto Insertion of Injection Groups Dialog can be accessed by selecting Records > Auto 
Insert Injection Groups... from the case information toolbar on an Injection Group Display. 
The following options are available: 

Element Type 

This option is used to select the type of element, Generators, Loads, or Switched 
Shunts, to add to the new injection groups. Only a single type of element can be added to 
the new injection groups.  

Group By 

This option dictates the common property by which all elements in the injection group will 
be grouped. Elements can be grouped by Areas, Zones, Super Areas, Owners, or a 
selected Custom Field. If for example the Area option is selected, then injection groups will 
be created for each of the defined areas in the case. The same holds true for Zones, Super 
Areas, and Owners. If the Custom Field option is selected, then injection groups will be 
created for all elements whose Custom Field value is the same. For example, if the Custom 
Field option is selected and Cust Float 1 is set as the field to use, then all of the elements 
whose Cust Float 1 field are the same will be grouped together. If there are elements whose 
Cust Float 1 field is set to 1 and there are elements whose Cust Float 1 field is set to 2, then 
two new injection groups will be created. One will contain all of the elements whose Cust 
Float 1 field is 1 and the other will contain all of the elements whose Cust Float 1 field is 2. 
Elements whose selected Custom Field is blank will not be included in any of the new 
injection groups.  

For Areas, Zones, Super Areas, and Owners, the creation of injection groups can be 
limited by only creating injection groups for which the Selected field is set to YES for these 
groups. To use this option, check the Only Selected checkbox.  

Participation Factor 

The options for specifying participation factor are the same as those used on the Add 
Participation Points Dialog. 

Delete Existing Injection Groups 

When this option is checked, all existing injection groups will be deleted before inserting the 
new injection groups. 

How to Name the Injection Groups 

The new injection groups will be named based on the options set in this section. The Use 
Prefix field determines the prefix that will be used on all injection groups. This field can be 
blank. The Start at field determines what integer to start at when counting the new 
injection groups. The new injection groups will all be numbered in sequential order starting 
at the value specified. The Group By property chosen will also be part of the injection 
group name. The Group By property can be identified based on Numbers, Names, or 
Both. The field at the bottom of this section provides an example of how the injection 
groups will be named based on the option settings.  

Do Insert Injection Groups 

Click this button to implement the options selected and create the injection groups. 
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Save to Aux 

This saves the option settings specified on the dialog to an auxiliary file. 
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Deleting Injection Groups 

  

To delete an injection group, select Aggregations > Injection Groups from the Model 
Explorer to open the Injection Group Display. This display is organized into two tab pages with 
additional tabs and displays available under each. The Injection Groups tab lists all defined 
injection groups. Click the right mouse button on this display on the injection group to delete, 
and select Delete from the resulting local menu. 

Alternatively, if the Injection Group Dialog is open, the injection group listed in the Name 
dropdown box can be deleted by clicking the Delete button. 
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Injection Group Display 

  

The Injection Group Records Display presents data describing each injection group in the case. 
This display is available by selecting Aggregations > Injection Groups from the Model 
Explorer. This display is organized into two tabs with various sections available under each of 
the tabs. The tabs and sections provide options for displaying information about injection 
groups and their associated participation points in a manner in which it is most useful to the 
user. Injection groups can be displayed with their associated participation points or 
participation points can be displayed with the injection group to which they belong.  
  

Injection Groups Tab 

This tab is organized into a top and bottom section. The top section contains the Injection 
Groups Case Information Display that lists all of the defined injection groups. The local menu 
is available by right-clicking on the display and contains options available for most case 
information displays as well as the option to Show Dialog to view the Injection Group Dialog.  

By default, the Injection Groups Case Information Display contains the following fields: 

Name 

The name of the injection group. To change the name of an injection group, simply type a 
new name in the corresponding cell. 

Number of Gens 

Identifies the number of generators contained in the injection group. 

% MW Gen ParFac 

Indicates the degree to which generators will contribute to the MW output of the injection 
group relative to loads. An injection group that has a % MW Gen ParFac value of 100% 
receives all of its output from generator points; an injection group that has a % MW Gen 
ParFac of 50% and a % MW Load ParFac of 50% receives equal MW contributions from its 
constituent loads and generators. 

Number of Loads 

Identifies the number of loads contained in the injection group. 

% MW Load ParFac 

Indicates the degree to which MW loads will contribute to the MW output of the injection 
group relative to generators. An injection group that has a % MW Load ParFac value of 
100% receives all of its output from load points; an injection group that has a % MW Load 
ParFac of 50% and a % MW Gen ParFac of 50% receives equal MW contributions from its 
constituent loads and generators. 

% Mvar Load ParFac 

Indicates the degree to which Mvar loads will contribute to the Mvar output of the 
injection group relative to switched shunts. An injection group that has a % Mvar Load 
ParFac value of 100% receives all of its Mvar output from load points; an injection group 
that has a % Mvar Load ParFac of 50% and a % Mvar Shunt ParFac of 50% receives 
equal Mvar contributions from its constituent loads and switched shunts.  

Number of Shunts 

Identifies the number of switched shunts contained in the injection group. 

% Mvar Shunt ParFac 
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Indicates the degree to which switched shunts will contribute to the Mvar output of the 
injection group relative to Mvar loads. An injection group that has a % Mvar Shunt ParFac 
value of 100% receives all of its Mvar output from switched shunt points; an injection 
group that has a % Mvar Shunt ParFac of 50% and a % Mvar Load ParFac of 50% 
receives equal Mvar contributions from its constituent loads and switched shunts. 

Total MW Injection 

Indicates the current total MW injection of all elements in the injection group. 

Total Mvar Injection  

Indicates the current total Mvar injection of all elements in the injection group. 

  

The bottom section contains additional tabs: Participation Points (All), Generators, 
Loads, Switched Shunts, and Injection Groups. These tabs contain tables, which are 
variations of the Participation Point Records Display, that list all of the individual participation 
points for the selected injection group by element type. Participation points can be added, 
deleted, or modified for the selected injection group from any of the tables on these tabs. The 
Participation Points (All) table lists only the fields that are relevant for defining 
participation points while the specific element tables also make available the fields that are 
specific to that element type.  

The Generators, Loads, Switched Shunts, and Injection Groups tabs have the option to 
Show points that are contained by other injection group points. This option is only 
relevant if an injection group contains a participation point that is another injection group. 
When this option is checked, the individual participation points that are contained in the 
injection group point will also be displayed. The Contained by field will list the name of the 
injection group that contains a particular participation point. When this option is not checked, 
the points displayed will be points that are contained in the selected injection group only and 
no additional information will be provided about the points contained inside any injection 
group points belonging to the selected injection group. If the Contained by field is empty, 
this means that the participation point is explicitly defined with the selected injection group 
and does not belong to it through an injection group point.  

  

Participation Points Tab 

This tab is organized into a top and bottom section. The top section contains tabs for 
Generators, Loads, Switched Shunts, and Injection Groups. Tables on these tabs will 
list power system elements of each particular type. If the option to Only show elements 
that belong to at least one injection group is not checked, then all elements of each type 
in the case will be listed on one of these tabs. If this option is checked, then only those 
elements that belong to an injection group will be listed. The tables on these tabs are Case 
Information Displays for each particular type and have the full functionality of case information 
displays.  

The bottom section is an Injection Groups Case Information Display. When an element from 
one of the tables in the top section of the tab is selected, this table will be populated with the 
list of injection groups to which the selected element belongs.  
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Injection Group Dialog 

  

The Injection Group Dialog provides information about injection groups and allows their 
modification. Specifically, the Injection Group Dialog lists the number of generators, loads, and 
switched shunts contained in the group and the percentage contribution of generators, loads, 
and switched shunts to the injection group’s output. The Injection Group Dialog also houses 
the Participation Points Records display, from which points can be added and deleted from the 
injection group’s list of participants and the various attributes of the points can be changed. 

To view the Injection Group Dialog for a particular injection group, open the Injection Group 
Display by selecting Aggregations > Injection Groups from the Model Explorer. Find the 
injection group of interest in the Injection Groups Case Information Display and right-click on 
it. Then select Show Dialog from the resulting local menu. 
  

The Injection Group Dialog contains the following fields and controls: 

Name 

Identifies the injection group whose information is currently displayed. Selecting a different 
name from this dropdown box will display information for another injection group. 

New, Delete 

To insert a new injection group from this dialog, press New, and supply the name for the 
new injection group. To delete the injection group that is currently being shown, click 
Delete. 

Save 

Changes made to injection groups through the Injection Group Dialog are not immediately 
saved with the power system case. This allows the option of canceling any changes without 
impacting the case. Click the Save button to store any updates with the case. 

# Gens 

Displays the number of generators contained in the injection group. 

# Loads 

Displays the number of loads contained in the injection group. 

# Shunts 

Displays the number of switched shunts contained in the injection group. 

% MW Gen Part., % MW Load Part., % MVR Load Part., % MVR Shunt Part. 

Displays the relative contributions of generators, loads, and switched shunts to the output of 
the injection group. 

OK, Cancel 

Changes made to the injection groups through the Injection Group Dialog are not immediately 
saved with the power system case. This allows the option of canceling any changes without 
impacting the case. Click Cancel to close the dialog without saving the changes. Click OK to 
close the dialog and save the changes. 

  

Participation Points 

The tab on the bottom of the Injection Group Dialog lists the points that make up the injection 
group. This display is called the Participation Point Records Display. By right-clicking on this 
display, points can be added and deleted from the injection group. Properties of specific points 
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can be changed by entering changes directly in the table. The Insert Points button will open 
the Add Participation Points Dialog that can also be used for modifying the points. 
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Import PTI Subsystems Dialog 

  

Injection groups can be created from PTI subsystem definition files from the Injection Groups 
Case Information Display. Click the right mouse button on this display and select Load  > 
Subsystem from *.sub file from the resulting local menu. From the Import Injection 
Groups Dialog, select the file name for the file to import.  

If there is no ambiguity in the import file, new injection groups will be created with the defined 
subsystem names without further prompts to the user. No ambiguity means that either 
participation points are defined for buses that have either load or generation but not both or 
that no participation points are defined and that injection group participation points will be 
defined based on the maximum generation for each on-line generator in the defined 
subsystem. If participation points are defined without ambiguity, each participation point will 
be assigned to either the load or generation at the bus split equally across all loads or 
generators at the bus.  

If there is ambiguity in defined participation points, the Insert PTI Subsystems into Injection 
Groups Dialog will be displayed. This dialog prompts the user how participation points should 
be handled for buses with both load and generation or buses with no load or generation. 

Buses with Load and Generation 

This option allows the user to select how a defined participation point will be assigned if the 
participation point bus has both load and generation.  

Assign Participation Point to Generation 

The participation point will be assigned to generation at the bus. The participation point 
will be split equally across all generators, either on-line or off-line, at the bus. 

Assign Participation Point to Load 

The participation point will be assigned to load at the bus. The participation point will be 
split equally across all loads, either connected or not, at the bus. 

  

Buses with No Load or Generation 

This option allows the user to select how a defined participation point will be assigned if the 
participation point bus has no load or generation. 

Ignore Participation Point 

The participation point will be ignored. 

Add Equivalent Load (closed load with ID=’99’ and 0 MW and 0 Mvar) and Assign 
Participation Point to this Load 

This option adds a connected load at the participation point bus with ID=’99’ and 0 MW 
and 0 Mvar. The participation point is then assigned to this new load.  

  

For each subsystem that is read that is found to have ambiguity in the defined participation 
points, the Insert PTI Subsystems into Injection Groups Dialog will be displayed unless the 
user selects Same Options for All Subsystems (Do not prompt again). 

 



Injection Groups 

651 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Participation Points Overview 

  

A participation point is a member of an injection group. It is a generator, load, switched shunt, 
or another injection group that participates in, or contributes to, the output of an injection 
group. Each participation point record identifies the generator, load, switched shunt, or 
injection group that fills this role, its participation factor, and how that participation factor is 
calculated. A participation point’s participation factor identifies the degree to which the point 
will contribute to its injection group’s output relative to the other points making up the group. 
Participation factors may be defined as having a fixed value, or they may be re-calculated with 
every use to stay true to how they were originally defined. For generators, participation factors 
may be defined as having a fixed value or being equal to the generator’s MW reserve in the 
direction of increasing output (MAX GEN INC), MW reserve in the direction of decreasing 
output (MAX GEN DEC), or their maximum output (MAX GEN MW).  

Each time that an injection group is used, the participation factors for all participation points in 
the group are normalized so that the factors of all participating participation points sum to 
100%. The normalized factors dictate how much a generator, load, or switched shunt 
contributes to the output of an injection group. The normalization accounts for the re-
calculation of the participation factors with each use of the injection groups and the exclusion 
of participation points because of options set with the various tools that use injection groups. 
Participation points can be excluded for various reasons including, but not limited to, the 
exclusion of generator participation points because the generator is not on AGC control or 
because the generator is at a minimum or maximum limit. 

Participation points are added to or deleted from an injection group using the Injection Group 
Dialog. The Injection Group Dialog houses the Participation Point Records Display, which 
allows the addition or deletion of points and opening the Participation Points Dialog to obtain 
more information about the points. 
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Participation Point Records Display 

  

The Participation Point Records Display shows information about the points that comprise a 
particular injection group. This display can be accessed for a particular injection group from 
the Injection Group Dialog or the Injection Group Display. 

The Participation Point Records Display is a class of Case Information Display and therefore 
can be used in a manner consistent with all other case information displays. It has a local 
menu from which participation points can be deleted or added to the injection group through 
the Add Participation Points Dialog. Selecting Insert from the local menu will open the Add 
Participation Points Dialog that will allow the addition, deletion, and modification of 
participation points in the injection group.  
  

The Participation Point Records Display shows the following fields by default: 

Point Type 

Every participation point is a generator (GEN), load (LOAD), switched shunt (SHUNT), or 
injection group (INJECTIONGROUP). 

Number 

Identifies the number of the bus to which a generator, load, or switched shunt is connected. 

Name 

Identifies the name of the bus to which a generator, load, or switched shunt is connected. 

ID 

Identifies the ID of the generator, load, or switched shunt or the name of the injection 
group.  

AutoCalc? 

If the value of AutoCalc is YES, the participation factor of the point is re-calculated with 
every use to be consistent with the way the point’s participation factor was initially defined. 
If the value of AutoCalc is NO, the participation factor is assumed fixed at its present value. 

Initial Value 

Indicates how the participation factor of the point was originally computed. For generators, 
the possible values of this field are  

SPECIFIED  The participation factor was specified as a constant. 

MAX GEN INC  The participation factor was defined as the difference between the 
generator’s maximum MW output and its present MW output. 

MAX GEN DEC  The participation factor was defined as the difference between the 
generator’s present MW output and its minimum MW output. 

MAX GEN MW  The participation factor was defined as the maximum MW output of the 
generator. 

For loads, the Initial Value property can assume only two possible values: 

SPECIFIED  The participation factor was specified as a constant. 

LOAD MW  The participation factor was defined as the size of the load in MW. 

For switched shunts, the Initial Value property can assume four possible values: 

SPECIFIED  The participation factor was specified as a constant. 
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MAX SHUNT INC  The participation factor was defined as the difference between the 
maximum Mvar output of the switched shunt and its present 
nominal Mvar output. 

MAX SHUNT DEC The participation factor was defined as the difference between the 
present nominal Mvar output and the minimum Mvar output of 
the switched shunt. 

MAX SHUNT MVAR The participation factor was defined as the maximum Mvar output of 
the switched shunt. 

For injection groups, the Initial Value property can assume only one possible value: 

SPECIFIED  The participation factor was specified as a constant. 

The Initial Value field is important if saving the injection groups to an auxiliary file and 
using them with another case that might have a different generation dispatch or load profile. 
If the Initial Value for a point is specified as GEN MAX INC, for example, and the point is 
loaded from an auxiliary file into another case, Simulator will re-calculate the point’s 
participation factor to match the generator’s positive MW reserve in that case.  

The Initial Value field is also important if the AutoCalc field is set to YES, because 
AutoCalc uses the rule defined by the Initial Value field to recalculate the participation 
factor with every use. For example, if the Initial Value is MAX GEN INC and AutoCalc is 
YES, the point’s participation factor will be updated to match the generator’s MW reserve 
every time the point is accessed. 

When the value of the Initial Value field is toggled, the point’s participation factor, shown 
in the ParFac field, will update to match the new definition. The Initial Value field must 
equal SPECIFIED to be allowed to change the value of the point’s ParFac field by typing the 
new value directly into the field. 

If AutoCalc is NO and the injection group is not intended to be used with any other case, 
then the Initial Value field should either be ignored or set to SPECIFIED. 

ParFac 

Indicates the participation factor of the participation point. The participation factor defines 
the relative contribution of the point to the total output of the injection group. The load, 
generation, or switched shunt change associated with each point is calculated based on the 
value of the participation factor, with values for points having the largest participation 
factors experiencing the greatest change. 

The participation factor for injection group participation points indicates the relative 
contribution of the entire injection group to the total output of the injection group to which 
it belongs. The participation factors of the individual points in the injection group point 
further define the relative contribution of these points to the total output of the injection 
group. The following two injection groups provide an example of how injection group points 
impact the injection group to which they belong when the points are normalized for use: 

Injection Group 1    Injection Group 2 

Gen 1, ParFac = 50   Gen 5, ParFac = 40 

Gen 2, ParFac = 30   Load 1, ParFac = 20 

InjectionGroup 2, ParFac = 20  Load 2, ParFac = 20 

Total = 100    Total = 80 

  

When Injection Group 1 is used, the participation factors are normalized so that each 
element provides the following contribution: 
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Gen 1, Normalized ParFac = 50/100 = 0.5 

Gen 2, Normalized ParFac = 30/100 = 0.3 

Gen 5, Normalized ParFac = 20/100 * 40/80 = 0.1 

Load 1, Normalized ParFac = 20/100 * 20/80 = 0.05 

Load 2, Normalized ParFac = 20/100 * 20/80 = 0.05 

Total Normalized = 1.0 

  

To add points to the injection group, right-click on the Participation Point Records Display and 
select Insert from the local menu. This opens the Add Participation Points Dialog. 
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Add Participation Points Dialog 

  

The Add Participation Points Dialog enables the addition of participation points to an injection 
group as well as the modification of existing participation points. This dialog is accessed from 
a Participation Point Records Display by right-clicking in the participation points list and 
selecting Insert from the resulting local menu. Participation Point Records Displays are 
available from the Injection Group Dialog or Injection Group Display. 

  

 
  

The Add Participation Points Dialog features four tabs, one for adding generator points, one 
for adding load points, another for switched shunts, and a fourth for adding points from 
injection groups that have already been defined.  

The four tabs are almost identical and contain the following controls: 

Filtering 

If the Use Area/Zone Filters box is checked, the list box beneath it, which lists 
generators, loads, switched shunts or previously defined injection groups depending on the 
tab, will list only those elements contained in areas or zones or by owners whose 
area/zone/owner filter setting is YES. If this box is not checked, all generators, loads, and 
switched shunts in the case will be listed. Injection groups will not be filtered using the 
area/zone/owner filter. 

Alternatively, a custom filter can also be defined by clicking on the Define Filter button. 
This will open the Advanced Filter dialog, which allows the customization of a filter for 
determining the devices to list in the display. 

Once the list of devices has been set, with or without filtering, the list can be searched using 
the advanced search techniques in Simulator. These techniques allow the list to be sorted by 
name or by number and allow the use of wildcard characters. Simply choose Name or 
Number, and type the name or number of interest in the box. Simulator will look for and 
highlight the first matching device in the list. If the first device is not the one of interest, use 
Search Next to find the next device that matches the search criteria. For a comprehensive 
list of all objects matching the search criteria, press Search All. 

Element List 
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The box that occupies the left side of each tab lists the generators, loads, switched shunts, 
or injection groups (depending on which tab is active) that can be added to the injection 
group. Injection groups will only show up in the element list if they do not cause a circular 
reference by being added to the current injection group. This means that any injection 
group that would cause the current injection group to link back to itself will be omitted from 
the list. Multiple elements can be selected from each of these lists. To select several 
elements in a row, drag the mouse to highlight the elements to be added. Alternatively, click 
the first element to add, press and hold the shift key, and click the last element to add. To 
select elements that are not adjacent in the list, click the first element you to add and hold 
down the CTRL key while clicking the other elements to add. 

Once an element is selected in the Element List, it is ready to be added to the injection 
group. 

Participation Factors 

There are several options for defining the participation factors of the selected points.  

For generators, a value can be specified, the generator’s present participation factor (which 
comes from the case and is displayed in the Generator Display) can be used, the 
participation factor can be calculated as the difference between its present output and either 
the unit maximum or minimum, its maximum output capability can be used, or the value 
contained in a selected Custom Field can be used.  

For loads, a value can be specified, the participation factor can be based on the load’s size, 
or the value contained in a selected Custom Field can be used. 

For switched shunts, a value can be specified, the value contained in a selected Custom 
Field can be used, or the factor can be based on positive reserve, negative reserve, or MVAR 
capability. 

For injection groups, a value can be specified to use for every point in the injection group, 
the values already defined for the injection group can be used, or the value contained in a 
selected Custom Field can be used. These three options are available if the option to 
Include Individual Group Points is checked. When this option is checked, copies of the 
participation points from the selected injection groups are made and added to the current 
injection group with the participation factors based on the selected option. When Include 
Individual Group Points is not checked, entire injection groups are included, indicated by 
the Point Type of INJECTIONGROUP in the Participation Point Records Display, in the 
current injection group and the only option for adding the points is to specify the value for 
the participation factor. When including an injection group in another injection group as the 
entire group, the normalization and use of the participation factors follows the discussion of 
ParFac found in the Participation Point Records Display. Including an injection group in 
another injection group as the entire group is useful when the injection of the entire group 
needs to be changed relative to other individual elements or other injection groups. 

Recalculate Factors Dynamically 

If this box is checked, the participation factors of the points being added will be 
automatically updated every time the points are used. Such points will then have an 
AutoCalc value of YES. If this box is not checked, the participation factors of the points 
being added will be fixed at the values defined at the time they were created. 

To add the points that have been selected, click the Add -> button. The new points will be 
added to the list box on the right.  

To update existing points, follow the same process for adding points and simply set the 
participation factors with the new values. When the Add-> button is clicked, the existing 
points will be updated with the new values. 
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The list box that occupies the right side of each tab lists the points that already comprise the 
injection group. To delete specific points from the injection group, select them from this list 
box and click the <-Remove button. 

To close this dialog, click OK. 
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Chapter 10: Solving and Simulating a Case 

  

This chapter describes the controls and general tools for solving a load flow in Simulator. 
These topics are used to customize and control the time domain and single Power Flow 
Solutions in the Run Mode. Additional topics also describe ways to view results and data 
graphically using auto-generated graphical displays. 

The following material is included: 
• Solution Options 
• Solution and Control 
• Transactions 
• Charts 
• Bus View Oneline 
• Substation View Oneline 
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Simulator Options 

  

Simulator provides a flexible environment for simulating power system operation by offering 
you access to a number of customizable options. The Simulator Options Dialog houses 
pages of options that you can customize to tailor the program to your needs.  

To display the Simulator Options Dialog go to the Options ribbon tab, and choose Simulator 
Options from the Case Options Ribbon Group. The Simulator Options button is also available 
on the Tools ribbon tab on the Power Flow Tools ribbon group. 

If a timed simulation is active when you open the dialog, it is automatically paused and will 
not resume until you close the dialog. 

There are seven categories of options for the Simulator Options dialog: 

Case Information Display Options 

Environment Options 

File Management Options 

Limits Options 

Message Log Options 

Oneline Options 

Power Flow Solution Options 
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Power Flow Solution Options 

  

The Power Flow Solution Tab offers various options regarding how Simulator solves the power 
flow problem. There are six sub-categories on the Power Flow Solutions tab: Common 
Options, Advanced Options, Island-Based AGC, DC Options, General, and Storage. Each of 
these categories is shown on tabs. Many of the options in the Power Flow Solution options will 
be of interest only to advanced users of the package. 
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Power Flow Solution: Common Options 

  

The following options are all contained on the Common Options tab after choosing the Power 
Flow Solution page of the Simulator Options. 

Power Flow (Inner) Loop Options (see Solving the Power Flow for information on 
solution loops) 

MVA Convergence Tolerance 

The MVA convergence tolerance serves as a measure for determining when the inner 
power flow loop of the Power Flow Solution process has reached an acceptable solution. 
The MVA mismatch is computed as the maximum real or reactive mismatch at any bus in 
the system. Usually, this value should be around 0.1 MVA. If you are having difficulty 
solving a particular case, it may be helpful to temporarily increase the MVA Convergence 
Tolerance to drive the solution closer to the actual solution, and then re-solve from this 
solution using the smaller MVA tolerance.  

Maximum Number of Iterations 

This option defines the maximum number of iterations Simulator will perform during the 
Power Flow Solution process in an effort to converge to a solution. If Simulator must 
exceed this number of iterations, it assumes that the power flow case is not converging 
and will terminate the solution process. If Simulator is configured to represent non-
converging power flow cases as blackouts, the screen will turn gray and the blackout 
warning message will appear. 

Do Only One Iteration 

If checked, then Simulator will only perform one iteration of the load flow solution process 
when Single Solution is clicked, regardless of the Maximum Number of Iterations 
setting. This is useful when playing with a case with which you are experiencing difficulty. 

  

MW Control (Outer) Loop Options (see Solving the Power Flow for information on 
solution loops) 

Disable Automatic Generation Control (AGC) 

If checked, the enforcement of the Generation Re-dispatch to account for MW interchange 
constraints for all areas is disabled. By default, this option is not checked. 

Enforce Generator MW Limits 

If checked, then generator minimum and maximum MW limits are enforced for all 
generators whose Enforce MW Limits field is set to true. See Generator Information Dialog 
for more information. Otherwise, generator MW limits are not enforced. Note that when 
using the economic dispatch or the Optimal Power Flow, the generator MW limits are 
always enforced regardless of user-settings.  

  

Controller (Middle) Loop Options (see Solving the Power Flow for information on 
solution loops) 

Disable Checking Gen VAR Limits 

If checked, the Mvar limits are ignored for all the generators in the case during a Power 
Flow Solution. By default, this option is not selected. 

Check Immediately 
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Before entering the inner power flow loop to solve the power flow equations, a decision is 
made about each generator in the case as to whether it will be treated as a PV or a PQ 
bus. It is assumed that a PV bus will maintain its setpoint voltage, while a PQ bus will 
maintain a constant reactive power output (for instance when the generator is at a Mvar 
min or max limit). Normally, the power flow equations are completely solved in an inner 
power flow loop using this assumption. After completing the solution, generator Mvar 
limits are checked to see if they have been reached (must change from PV to PQ), or if at 
a limit if the limit may be backed off of (must change from PQ to PV). If any generators 
change PQ/PV status, then the inner power flow loop is resolved. 

When the Check Immediately option is checked, the generator Mvar limits are checked 
after every inner power flow loop iteration instead to see if generator limits have been 
reached, or if a generator limit may be backed off. In some situations performing this 
check inside the inner power flow loop can help with convergence, however performing 
this check does slow down the solution process. By default, this option is not selected. 

Disable Switched Shunt (SS) Control 

If checked, automatic control of switched shunts is disabled in all areas. By default, this 
option is not selected. 

Disable LTC Transformer Control 

If checked, automatic control of LTC transformers is disabled in all areas. By default, this 
option is not checked. 

Disable Phase Shifter Transformer Control 

If checked, then automatic control of phase shifting transformers is disabled in all areas. 
By default, this option is not checked. 

Transformer Stepping Methodology 

Choose either Coordinated Sensitivities or Self-Sensitivity Only. The default value is 
Coordinated Sensitivities. 

When the regulated value of tap-changing or phase-shifting transformers move outside of 
their regulation range, then Simulator attempts to bring those transformers back inside 
their range. By default Simulator determines all the tap-changing and phase-shifter 
transformers which are out-of-range and coordinates the movement of these transformers 
in an attempt to bring all the regulated values back into range. Generally this results in a 
better convergence, however it also can be slower when a large number of transformers 
are out-of-range together.  

Choosing Self-Sensitivity only will modify this methodology so that each transformer only 
looks at the sensitivity of its regulated value with respect to changing its own tap or 
phase. This calculation is faster, but may result in convergence problems due to 
transformers that interact with one another. 

Prevent Controller Oscillations 

Sometimes, a power flow will fail to converge because certain automatic controls such as 
Mvar limit enforcement at generators, transformer tap switching, and shunt switching 
oscillate between their control bounds. These oscillations very often are due to modeling 
inaccuracies. If this option is checked, Simulator will automatically detect such oscillating 
controls and fix them at their current value so that they no longer oscillate. You may find 
this option helpful if you feel that the modeling of automatic controls in your system is 
inaccurate. 

Maximum Number Controller Loop Iterations 
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As part of the solution process, the outer loop of the solution algorithm is a check of any 
necessary controller changes due to changes in controlled values from the last iteration of 
the Newton-Raphson load flow solution. The maximum number of loops through the 
control change algorithm can be set here. This is not the same as the Maximum Number 
of Iterations, which applies to the actual Newton-Raphson inner loop algorithm, which 
solves that actual power flow. 
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Power Flow Solution: Advanced Options 

  

The following options are all contained on the Advanced Options tab after choosing the Power 
Flow Solution page of the Simulator Options. 
  

Dynamically add/remove slack buses as topology is changed (Allow Multiple 
Islands) 

If checked, multiple islands are allowed during the solution by Simulator dynamically 
choosing a new slack bus for the island. If there are no in-service generators in the new 
island, the island cannot be solved and will be isolated and ignored during the load flow 
solution. 

Post Power Flow Solution Actions 

Clicking this option will open the Post Power Flow Solution Actions dialog, where the user 
can specify a list of actions to be executed at the end of every Full AC power flow solution. 

  

Power Flow (Inner) Loop Options (see Solving the Power Flow for information on 
solution loops) 

Disable Power Flow Optimal Multiplier 

If checked, the Newton solution process will not use the optimal multiplier. The optimal 
multiplier is a mathematically calculated step size for the Newton's Method iteration that 
prevents the mismatch equations from increasing between iterations. A small value 
indicates that moving in the direction of the Newton step will increase the mismatch 
equations. When the optimal multiplier becomes too small, this is an indication that the 
power flow is not going to solve successfully and Simulator will stop instead of creating 
extremely large mismatches. If this happens at a point where the solution is not within the 
allowed tolerance for the Newton process, the Newton process will result in a failed 
convergence to a valid solution. 

Initialize From Flat Start Values 

When checked, each Power Flow Solution is started assuming that all voltage magnitudes 
and generator set point voltages are unity and all angles are zero. By default, this option 
is not selected. Some power flow problems can be very difficult to solve from flat start 
assumptions. Therefore, use this option sparingly. 

Minimum Per Unit Voltage for Constant Current Loads 

This option is used to model the impact that falling voltage has on loads throughout the 
system. The default value is 0.5. 

For constant current loads with a terminal bus below this per unit voltage, the value of the 
load will fall off using a sine function so that the load is zero at zero terminal voltage, and 
so that the derivative is continuous at the minimum per unit voltage for constant current 
loads. 

Minimum Per Unit Voltage for Constant Power Loads 

This option is used to model the impact that falling voltage has on loads throughout the 
system. The default value is 0.7. 

For constant power loads with a terminal bus below this per unit voltage, the value of the 
load will fall off using a cosine function so that the load is zero at zero terminal voltage, 
and so that the derivative is continuous at the minimum per unit voltage for constant 
current loads. 
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Control (Middle) Loop Options (see Solving the Power Flow for information on 
solution loops) 

Disable Treating Continuous Switched Shunts (SSs) as PV Buses 

Continuous switched shunts are normally treated the same as a generator bus inside the 
inner power flow loop (they are treated as buses with fixed power and voltage). Checking 
this option will cause the continuous switched shunt to be treats as a constant impedance 
in the inner power flow loop with all switch occuring in conjunction with other switched 
shunts in the voltage control loop instead. 

Disable Balancing of Parallel LTC Taps 

Simulator has the capability to attempt to balance tap positions of parallel transformers, in 
an attempt to avoid parallel transformers from going to opposite tap settings, inducing 
loop flow through the parallel transformers. Checking this option disables the automatic 
balancing of parallel transformers. The only transformers that will be balanced are those 
in parallel between the same terminal buses, or those in parallel between terminal buses 
that are connected with zero impedance branches. 

Model Phase Shifters as Discrete Controls 

If checked, then phase shifters will switch tap positions discretely based on the tap step 
size of the phase shifting transformer. By default, this option is not checked, which means 
the phase shifters will switch continuously, independent of the tap step size. 

Minimum Sensitivity for LTC Control 

This option specifies the minimum-voltage-to-tap sensitivity for LTC transformers. All 
transformers having an absolute value of voltage-to-tap sensitivity below this value are 
automatically disabled from automatic control. This prevents Simulator from changing 
transformer taps that have little effect on their controlling voltage. The Transformer AVR 
Dialog shows the voltage-to-tap sensitivity for each voltage-controlling transformer. 

  

Disable Angle Rotation Processing 

At the end of a power flow solution, by Simulator looks at the bus voltage angles in the case 
to see if any are near +/- 180 degrees. If the angles fall outside of +/- 160 degrees, then all 
angles in the island will be rotated by the same amount so that the angle range in the 
islands is equally spaced around zero degrees. Check this option to disable this feature. 

Sharing of generator Vars across groups of buses during remote regulation 

When several buses have generators that control the voltage at single bus, this option 
determines the method used to determine each buses "share" of the MVar support. There 
are three options 

1. Allocate across buses using the user-specified remote regulation percentages. This 
option is what is used by default and most closely matches the sharing seen in RAW 
files. 

2. Allocate so all generators are at same relative point in their [min .. max] var range. 
This option most closely matches the sharing seen in a few EMS solutions PowerWorld 
has seen. 

3. Allocate across buses using the SUM OF user-specified remote regulation percentages. 
This option most closely matches the sharing seen in EPC files. 

It should be noted, generators at the same bus always allocate vars so they are at the same 
relative point in their [min..max] MVar range. How vars are allocated to generators at the 
same bus has no effect outside of that bus so options are not given for this sharing. 
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Include Loss Penalty Factors in ED 

If checked, the economic dispatch calculation will consider losses in determining the most 
economic generation dispatch. Otherwise, the generation dispatch calculation will disregard 
system losses. 

Enforce Convex Cost Curves in ED 

The economic dispatch algorithm attempts to set the output of all generators that are set to 
be automatically controlled so that the system’s load, losses, and interchange are met as 
economically as possible. The algorithm is guaranteed to reach a unique solution only when 
all generator cost curves, which model the variation of the cost of operating a unit with its 
output, are convex. If this option is checked, Simulator will identify units whose operating 
point is outside the convex portion of the cost curve and set them off automatic control. 
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Post Power Flow Solution Actions Dialog 

  

The Post Power Flow Solution Actions dialog describes a list of actions that are executed at the 
end of every Full AC power flow solution, which means they are not performed for DC 
solutions. Normally, these actions would all have Model criteria specified. 

To open this dialog, select Simulator Options from the Case Options ribbon group on the 
Options ribbon tab. Next, go to the Power Flow Solution category. Then click on the 
Advanced Options. Finally click the button labeled Define Post Power Flow Solution 
Actions. 

Check the Do Not Used Post Power Flow Solution Action List check-box to disable using 
any actions defined in the list. 

The action list display identifies the actions that comprise the post power flow solution action 
list. Actions can be inserted or deleted by using the local menu on the dialog. Right-click on 
the display and select Insert or Delete. Actions are inserted via the Contingency Element 
Dialog. 

The action display is a type of Case Information Display and thus shares many  common to all 
other case information displays. 
  

The Action List Display always contains the following fields: 

Actions 

This shows a string which describes the action. You may customize the format of the string 
that describes the actions by right-clicking on the Action List Display and choosing Display 
Descriptions By, and then choosing either Name, Num, Name/Num, PW File Format by 
Numbers, PW File Format by Name/kV or PTI File Format. 

Model Criteria 

Simulator allows you to define Model Criteria, which consist of both Model Conditions and 
Model Filters. These specify a criteria under which a contingency action would occur. For 
example, you could specify that a generation outage only occur if the pre-contingency flow 
on a line is higher than a specified amount. Normally, no Model Criteria will be specified, and 
this field will be blank. Also, note that Model Criteria can be overridden by the Model 
Condition and Filter option on the Contingency Options Tab. You can open a dialog to define 
Model Filters or Conditions by right-clicking on the Action List Display and choosing Define 
Model Criteria. 

Status 

Three options are available for this field 

• CHECK : The action will be executed only if the Model Criteria is true. It will also be 
executed if no model criteria is specified. This is the default setting 

• ALWAYS: The action will always be executed, regardless of the Model Criteria. 
• NEVER: The action will never by executed, regardless of the Model Criteria. 
• POSTCHECK: This action is checked AFTER the other Check and Always actions have been 

performed and the load flow solution solved. If the criteria specified for the Postcheck 
action are met in the resulting load flow solution, then this action is taken and the load 
flow is again resolved. This will recursively occur for all Postcheck actions until either all 
postcheck actions have been taken, or the criteria for all remaining postcheck actions have 
not been met. 

Note that the Never action allows you to disable a particular action without deleting it. 

Comment 
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A user-specified comment string that can be associated with this action. While this comment 
is not used by Simulator in any way, these comments can be saved to be loaded at a later 
time. This is provided for the user to add comments regarding the action. For example, for 
an action with a Model Criteria you may could add a sentence explaining why the action is 
only performed under the specified criteria. 
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Power Flow Solution: Island-Based AGC 

  

The following options are all contained on the Island-Based AGC tab after choosing the Power 
Flow Solution page of the Simulator Options. 

The Island Based AGC options allow the user to choose to dispatch generation by island 
instead of by area or super area. The options available for dispatch here are: 
  

Disable (Use the Area and Super Area Dispatch Settings) 

When this option is selected, Island Based AGC is being used, and generators are dispatched 
according to the usual area or super area generation dispatch.  

Use Participation Factors of individual generators 

When selected, the island-based AGC is used, based on the individual participation factors of 
each generator within the island. Area and super area ACE requirements will be ignored, and 
all generators in the island will be dispatched to serve load, losses, and any DC transfers to 
other islands. 

Calculate Participation Factors from Area Make Up Power Values 

The AGC will dispatch generation by use area make up power values, instead of by 
individual participation factor. What this means is that each area will be assigned a make up 
power value, similar to assigning a participation factor to a generator. Based on the make up 
power value of each area in the island, the amount of the generation dispatch needed will 
be divided amongst each area based on its value. Higher value will account for more of the 
generation dispatch than areas with smaller values. The within each area, the generation 
dispatch is handled on an individual generator participation factor basis, where each 
generator will account for a portion of the dispatch that was assigned to its area. 

To specify the make up power values for each area, click on the Specify Are Make Up 
Power Values button. Note that these settings are the same as those used by Contingency 
Analysis Options Make Up Power, therefore changing these values will affect the contingency 
analysis. 

For example, three areas have participation factors of 2, 1 and 1, respectively. If the total 
generation redispatch in the island is 100 MW, then area 1 will account for 2 / (2+1+1), or 
50%, of the total. Therefore area 1 is expected to redispatch by 50 MW. If area 1 then has 
two generators with participation factors of 4 and 1, they will account for the 50 MW by 
picking up 4 / (4+1) and 1 / (4+1), or 80% and 20%, respectively, of the 50 MW needed 
from the area. 

Dispatch using an Injection Group (Loads and Generators will respond) 

Checking this option will allow for the island dispatch to be covered by change in generation 
and/or load defined in an injection group. 

Additional options are available when dispatching based on an injection group: 

Allow only AGC Units to Vary 
If this option is checked, only units whose AGC status is turned on will be allowed to 
participate in the injection group dispatch. 

Enforce unit MW limits 

If checked, then each generator’s defined MW limits will be strictly adhered to during the 
redispatch. 

Do not allow negative loads 
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When checked, loads included in the injection group are not allowed to drop below zero 
MW or MVAR load demand. 

How should reactive power load change as real power load is ramped? 

You can choose to keep the ratio of real and reactive power constant for each load that 
is included in the injection group, or you can specify a constant power factor that the 
MVAR value will be determined from when the MW value is changed. 
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Power Flow Solution: DC Options 

  

The following options are all contained on the DC Options tab after choosing the Power Flow 
Solution page of the Simulator Options. 
  

Use DC Approximation in Power Flow 

When this box is checked, Simulator will solve the load flow using the DC Approximation 
method. When not checked, Simulator performs the modified Full Newton AC load flow 
algorithm. Note that once a case, especially a large one, has been solved using a DC 
approximation, it tends to be quite difficult to revert back to the Full Newton AC load flow 
from a solved DC approximation. 

DC Power Flow Model 

Note: These choices also affect the calculation of sensitivities on the PTDF, LODF, and TLR 
dialogs and ATC Tool calculations. 

Generally, the only inputs that affects the DC Power Flow equations are line impedances and 
line status (open/closed). However there are three possible modeling choices (for which 
there is not general agreement in the industry) that will affect the "DC equations" in small 
ways. These choices are made here on the DC Power Flow Model options  

Ignore Series Resistance (r) or Ignore Series Conductance (g) 

The series term of a transmission line consists of an r and x value which represent a 
complex number impedance. In the DC power flow approximation, the value that used is the 
imaginary part of the inverse of impedance (called admittance)  

g + jb = 1 / (r + jx) = r / (r^2 + x^2) – j x / (r^2 + x^2)  

Thus  

g = r / (r^2 + x^2)  

b = – x / (r^2 + x^2) *** This term is used in the DC power flow equations 

The only term that is used in the DC power flow equations is the b term. Some say that a 
DC power flow means that r = 0 which means that b = -1/x and g = 0. Others say that a DC 
power flow only means assuming that g = 0, which means that b = - x / (r^2 + x^2). There 
is not a good consensus in the industry as to what is correct regarding this, so Simulator 
offers an option as to whether you ignore r or ignore g. The default option in PowerWorld is 
to ignore the resistance. 

Ignore Transformer Impedance Correction Tables and Ignore Phase Shift Angle 
Effects  

These are both ignored by default. 

When a transformer impedance correction table is specified for a transformer, then the 
series impedance of the transformer will vary by a multiplier with the tap or phase of the 
transformer. The tap ratio is not generally relevant to a DC power flow, however the phase-
shifter angle could very when using the DC approximation. This option specifies whether to 
ignore the impact of this impedance correction. For phase shifters the multiplier is normally 
between 1.00 and 1.50 and thus tends to increase the impedances as you move away from 
zero degrees.  

As a branches phase shift varies, the DC power flow equations could be modified to take this 
into account. This effect results in the DC power flow equations for which the "b" term 
above is multiplied by the cosine of the phase angle across the line. This effect tends to 
decrease the impedance as you move away from zero degrees. 
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Because the impedance correction tends to increase impedance and the phase effect tends 
to decrease impedance it is reasonable to ignore both of these, and this is done by default. 
The other issue with not ignoring these is that both create a situation where the equations 
for the DC approximation are dependent on the system state. In other words, the matrix 
equations become a function of the phase-shift angle. This results in a situation in which the 
matrices must be recalculated and re-inverted each time a phase angle is moved. This 
removes some of the advantages of the DC approximation. This can be especially 
problematic when using the OPF or SCOPF. 

Compensate for Losses by Adjusting the Load 

Traditionally a DC load flow is treated as lossless. However, you can approximate the loss in 
the load flow by artificially adjusting the load in the case to include estimated losses. To do 
so, click on the DC Loss Setup button to open the DC Power Flow Loss Setup dialog for 
setting the DC Loss Multipliers. 

Compensate for Reactive Power Flows by Adjusting the Branch Limits … 

One issue with DC load flow is how to treat the inclusion of reactive power flows. In a 
standard DC load flow, the reactive flows are typically ignored, and the MW flow of a branch 
is compared to its original MVA branch limit. However, Simulator also gives you the option to 
instead solve the DC load flow and compute approximate MVAR flows by assuming the 
voltages in the system remain constant when the DC load flow is solved. 

Compensate for Dispatch Sensitivities with User-Specified Values 

This option allows for the bus MW loss sensitivities to be used in the OPF and ED dispatch 
algorithms, if the type of loss sensitivity on the General tab is set to User-Specified. 
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DC Power Flow Loss Setup 

  

To open the DC Power Flow Loss Setup dialog, select Simulator Options from the Case 
Options ribbon group on the Options ribbon tab. On the Power Flow Solution page, click on 
the tab labeled DC Options. Next, click the button labeled DC Loss Setup. This button will 
only be enabled when you check the box to Use DC Approximation in Power 
Flow/OPF/SCOPF. 

The DC Power Flow Loss Setup dialog gives you a location to apply approximate losses during 
a DC load flow solution. The losses can be approximated by scaling the loads in the case to 
include an approximation of losses. Loss multiplication factors can be applied individually by 
bus, or as a group by area or by zone. Note that loss multipliers by area or by zone are just 
quick ways for setting the bus multiplication factors for all buses in the group. You will see the 
value reflected for all buses in the Buses page. If you wish to apply the same multiplication 
factor to the entire case, you can simply set the Case DC Loss Multiplier at the bottom of the 
dialog. This will automatically set all buses in the case to have the same DC Loss Multiplier 
specified. 

Once the DC Loss Multipliers have been set, click OK to save the multipliers.  
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Power Flow Solution: General 

  

The following options are all contained on the General tab after choosing the Power Flow 
Solution page of the Simulator Options. 
  

Assumed MVA Per-Unit Base 

This option allows the user to specify the MVA base to be used for the entire case. By 
default, this value is set to 100 MVA. 

Bus Loss Sensitivity Function 

Bus loss sensitivities indicate how island or area losses change with power injection at the 
bus. Here you may choose to forego the calculation of bus loss sensitivities or to base them 
on island losses or area losses. If the case consists of only one island, which, by definition, 
corresponds to the entire system, then the bus loss sensitivities are measured with respect 
to total system losses. If the bus sensitivities are set to User-Specified, the sensitivities will 
remain at their last calculated values, according to the loss function type previously specified 
when the loss sensitivities were calculated. 

Monitor/Enforce Contingent Interface Elements 

This global location allows you to determine how contingency elements in an interface 
should be treated in Simulator. You can choose to never include the impact of contingent 
elements on interface flow, to only include contingent element impacts in the standard 
power flow or optimal power flow routines, or in all solution routines including contingency 
analysis and security constrained OPF. 

It is not uncommon to ignore the impact of contingent elements when using the contingency 
analysis or security constrained OPF tools, as they are already processing lists of 
contingencies and evaluating flows on interfaces. Ignoring contingent elements within 
interface definitions allows for a determination of the impact of other contingencies on the 
flows of the non-contingent elements forming the interface, without impact from additional 
contingent element considerations. 

Power Units for Display 

Allows switching between displaying power values in Mega- units or Kilo- units. 
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Power Flow Solution: Storage 

  

The following options are all contained on the Storage tab after choosing the Power Flow 
Solution page of the Simulator Options. 
  

Simulator offers the ability to restore either the last power flow solution state or the state of 
the system immediately before the last solution attempt. If your system has insufficient 
memory and you are working with large systems, you may wish to disable one or both of 
these options. 

Disable "Restore last solution" 

Restoring the last solution will undo any changes made to the data that were made after the 
last successful solution and return the case to the last valid solution. For large cases, the 
amount of memory required to store the last solution can be significant. If this option is 
checked, Simulator will not store this information in memory, and the last solution cannot be 
restored if a solution fails. 

Disable "Restore state before failed solution attempt" 

Restoring the state before failed solution attempt will undo only the attempted solution, but 
will retain any changes to data that were made before the solution process. This allows the 
user to return to the point just before the solution in order to add or remove changes in an 
effort to obtain a valid solution. For large cases, the amount of memory required to store 
the state before a solution attempt can be significant. If checked, Simulator will not store 
the state information in memory, and the state before the failed solution cannot be restored. 
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Message Log Options 

  

Show Log 

If checked, the message log is displayed. The message log shows detailed results of each 
Power Flow Solution. Usually this log is NOT shown. However, if you are running into 
problems with a simulation case, it can prove useful for debugging the case.  

Show Time Stamps 

Checking this option will display the date and time at which each message is posted in the 
message log. 

In log Messages, Identify buses by 

This option allows the user to specify how to identify the buses in log messages. The options 
are by numbers, by names, or by both numbers and names. 

Include Nominal Voltages in Log 

If checked, this option will make the buses to be displayed with their nominal voltages after 
their name. 

Suppress the following messages in the log 

Checking the check-boxes in this option will remove the corresponding message writing to 
the log, thus speeding up the computation process. The boxes to the right of the messages 
indicate the color with which the messages will be displayed in the log. 
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Environment Options 

  

The Environment page provides you control over a number of display and simulation options. 
The first section of the page contains a list of check boxes that you can use to designate the 
content of the oneline displays.  
  

These options include: 

Show Log 

If checked, the message log is displayed. The message log shows detailed results of each 
Power Flow Solution. Usually this log is NOT shown. However, if you are running into 
problems with a simulation case, it can prove useful for debugging the case.  

Disable Showing Blackouts 

You can dramatize a power flow case’s failure to converge by representing it as a blackout. 
The background of the oneline diagram will become a dark shade of gray, and a message 
box will appear to announce that the system has experienced a blackout. To disable this 
behavior, select the Disable Showing Blackouts box. Representing the failure to converge as 
a blackout can be very helpful for presentation purposes. Very often, the power flow’s failure 
to converge can be traced to the system’s inability to serve the load demand, a situation 
that requires that load be "blacked out," or shed, to restore the system to a viable operating 
state. Thus, displaying the failure to converge as a blackout has physical significance. 

Disable AGC When Manually Changing Generator MW 

When this option is checked, changing the MW output of a generator manually will 
automatically remove a generator from Automatic Generation Control. If you wish for 
generators to maintain their automatic generation control settings following a manual 
change of MW output, you must uncheck this option. 

Open Associated Oneline Diagrams 

By default, Simulator has always attempted to open any diagrams that were open with a 
case file when the case file was last closed. However, now you may uncheck this option and 
Simulator will not attempt to open any oneline diagrams when a case is loaded. 

Auto Open Bus Records if No Oneline 

If a case is opened in Simulator which does not have an associated oneline diagram, then 
Simulator will automatically open the Bus Records case information display if this option is 
checked. 

Allow to Prompt Dialog to Create Oneline Diagram 

If a case is opened in Simulator which does not have an associated oneline diagram, then 
Simulator will prompt a message dialog that allows the user to create a blank oneline 
diagram. 

Auto Set Case as Base Case for Difference Flows when Loaded 

This option allows the case to be set as a base case automatically after being loaded. This 
can be done always or never, or only if the base case has not been set before opening the 
case. 

Recently Used File List Entries 

The maximum number of file names and locations stored in the History List of the File 
menu. 

Undo Memory Limit Per Oneline 



Solving and Simulating a Case 
 
 

678 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

The approximate maximum number of Megabytes allowed to be used in storing actions 
carried out when editing a oneline diagram, which can be undone at any time. 

Custom Colors 

This option allows the user to edit the custom colors used throughout all Simulator color 
dialogs. 

Clock Style 

The clock serves as a timer for timed simulations by showing the current time, the start 
time, and the end time of the simulation. You can choose to hide the simulation clock by 
specifying a clock style of None. Otherwise, to display the clock in its own window, choose 
Dialog, and to display the clock on the program’s status bar, select Status Bar. 

Measurement System 

This option allows the user to choose English (Imperial) or Metric (SI) units for system 
measurements. By default, this option is set to English units. 
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Oneline Options 

  

These options are available on the Oneline tab of the PowerWorld Simulator Options dialog. It 
is important to note that the options on this dialog apply to all oneline diagrams. There are 
also a large number of options which apply only to an individual oneline diagram. The 
diagram-specific options are specified on the Oneline Display Options Dialog. 
  

Do Not Solve While Animating (Display Only) 

If checked, Simulator only displays the case; it does not solve the power flow equations. 
System flows are determined by the initial values in the case file. This option should be 
checked if you simply want to use Simulator to visualize a case that has already been 
solved. The advantage of the display-only mode is that animation is significantly faster, 
particularly for large cases. The drawback to the display-only mode is that the power flow 
equations are not automatically solved at each time step; you must explicitly call for a Power 
Flow Solution using either the Single Solution button in the Power Flow Tools ribbon 
group on the Tools ribbon tab or choose one of the solution options under the Solve menu 
in the Power Flow Tools ribbon group. 

Play/Animation Solution Method 

This option is available only for OPF releases of Simulator. Use it to indicate whether 
Simulator’s repetitive power flow should perform a normal power flow solution or an optimal 
power flow (OPF) solution. 

Solution Animation 

Check Auto Start Solution Animation to automatically start the animation after loading the 
case. 

Check Auto Solve On Load to automatically solve the power flow solution when the case is 
loaded. 

Visualizing out-of-service elements 

These three options allow you to choose how objects on the diagram should appear when 
they are representing a power system device that is currently "open" or "out-of-service." 
The three options are Blink, Use dashed lines, and Draw and X through off-line generators. 
The first two options apply to any oneline object, while the third option is specific to 
generator objects only. 

Main Oneline File 

This option is used to identify the primary oneline diagram to use with the case. The main 
oneline is the file that is displayed when you first open the case. The dropdown box lists all 
the oneline files that reside in the same directory as the case. Select one of these files, or 
enter the full path of the oneline you want to use if it does not appear in the dropdown box. 

Use Default Oneline File 

You can command Simulator to open a particular oneline diagram file if it cannot find a 
oneline diagram file for the case you are trying to open. For example, there is no oneline 
diagram associated with a PSS/E raw data file when you first read it into Simulator. 
However, if your application is such that you will always use the same oneline file whenever 
you open a PSS/E raw file, check the Use Default Oneline File to have Simulator open the 
oneline identified in the Default Oneline File box whenever it encounters a case that has 
no associated oneline. The default oneline must exist in the same directory as the case you 
are trying to open. 
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Show Oneline Hints 

If checked, pop-up hints will appear when you drag the mouse over an object in the oneline. 
These give information about the object; for example, for a generator the pop-up hint 
displays the bus number, generator ID, the MW output and the MVAR output. You may also 
customize the pop-up hints for each kind of display object by choosing Options > Custom 
Hint Values from the menu. 

Show X,Y Coordinates 

If checked, the (x,y) location of the cursor is monitored in the status bar at the bottom of 
the screen. The (x,y) location of the cursor is only shown in Edit Mode. By default, this 
option is selected. 

Save Contour Image with Oneline File 

If checked, and if a contour is being displayed on the oneline diagram, Simulator will store 
the contour with the oneline diagram when you save the case or save the oneline. It will 
store the contour as a bitmap. 

Display Unlinked Elements in Run Mode 

Typically, unlinked graphical objects are not visible in Run Mode. Checking this option will 
allow the display of unlinked elements during Run Mode. 

Enable Mouse Wheel Zooming 

This option allow the use of the mouse wheel to zoom in and out in the currently selected 
oneline diagram. 

Minimum Screen Font Size 

The minimum font size at which text is visible on the screen. When text is rendered to the 
screen, any text which is smaller than this font size will not be rendered. This is useful when 
zooming out on a oneline diagram where a lot of text might become cluttered or hard to 
read on the screen.  

Minimum Print/Copy Font Size 

The minimum font size at which text can be printed or copied. This is useful if the 
application or printer you are sending to can or cannot display smaller fonts. When text is 
printed, any text which is smaller than this font size will not be printed. Normally the 
Minimum Print/Copy Font Size is smaller than the Minimum Screen Font Size because the 
resolution of the printed document is much higher than the screen resolution. 

Transformer Symbol 

Since transformer representation varies in different countries, this option allows the user to 
represent transformers as coils or circles. By default, transformers are represented as coils. 

Save Onelines when Saving Case 

By default, Simulator always saves any oneline diagrams that are open when the user 
chooses to save the case (pwb) file. This option allows you to choose to be prompted to 
save oneline diagrams when a case file is saved, or to never save onelines when the case 
file is saved. 

Edit Oneline Browsing Path 

This option applies when you have Oneline Links included on a oneline diagram. Rather than 
specify the full path and name of a oneline diagram as a oneline link, you can specify the file 
name only. When the link is clicked in Run Mode, Simulator will check all directories listed 
here, in order, to try and find the oneline file name stored with the link. This browsing path 
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is also used when looking up Shapefile Database Rcords and when finding the substation 
layout, URL, or command specified on the Substation Information Dialog. 
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Case Information Display Options 

  

PowerWorld uses numerous case information displays to showjavascript:RelatedTopic1.Click() in 
tabular format. The options presented on this page of the PowerWorld Simulator Options 
Dialog control some of the general features of the case information displays. 

Enterable Field Color 

Fields whose values can be directly entered on the case information displays are colored 
navy blue by default. Click on the color field to change the color of enterable fields, or click 
the Change button. 

Toggleable Field Color 

Fields whose values can be toggled (changed) by left-clicking on them are colored green by 
default. Click on the color field to change the color of toggleable fields, or click the Change 
button. 

At or Exceeding Limit Color 

Fields whose values are at or exceeding a limit, are colored red by default. Click on the color 
field to change the color of such fields, or click the Change button. 

Normal Field 

Fields that cannot be modified directly from the case information display are colored black 
by default. Click on the color field to change the color of such fields, or click the Change 
button. 

Special External FieldError! Hyperlink reference not valid. 

Fields that can be modified through an auxiliary file or by pasting data into a sheet from a 
spreadsheet, but cannot be changed in a case information display, are colored black by 
default. Click on the color field to change the color of such fields, or click the Change 
button.  

Field not presently used 

Fields whose values are overridden by other instances of the program are colored gray by 
default. Click on the color field to change the color of such fields, or click the Change 
button. 

Background 

Background of cells is colored white by default. Click on the color field to change the color of 
the background, or click the Change button. 

Heading Background 

Background of column and row headings is colored light gray by default. Click on the color 
field to change the color of the heading background, or click the Change button. 

Data Fill Background Color 

Background of selected cells when propagating values is colored yellow by default. Click on 
the color field to change the color of the heading background, or click the Change button. 

Set Case Info Factory Default Colors 

Clicking the Dark Colors button will reset the field and background colors to the defaults 
mentioned above, which comprise dark colors for fields, and light colors for backgrounds. 
Clicking the Light Colors button will set field and background colors to a specified set of 
light colors for fields and dark colors for backgrounds. 

Save as Auxiliary File Data Format 

javascript:RelatedTopic1.Click()�
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This option allows the user to decide if the auxiliary files that can be saved from case 
information displays should be space delimited files or comma delimited files. 

Key Fields to Use in Subdata Sections 

This option allows the user to decide whether to use primary or secondary key fields or 
labels for the objects saved in the subdata section of an auxiliary file. In addition to being 
applied to the subdata section of auxiliary files, this option is also used in some special cases 
to dictate how elements are identified. The Labels topic contains additional information 
about this. 

View/Modify Default Font 

Clicking this button brings up a font dialog from which you can choose the font in which 
case information displays should show their data. Selecting a new font, font size, style, or 
color and pressing OK will change the default font, so that all case information displays will 
then employ a font having the selected properties. 

Default Row Height 

This option sets the height of the rows in the case information displays. This field may need 
to be changed depending on the screen size and font size of the computer. By default, the 
height is set to 16. 

Show Grid Lines 

Grid lines are shown by default in case information displays. Unchecking this box will remove 
the grid lines from the displays. 

Column Headings 

This option allows you to choose whether the column headings of the case information 
displays are the normal column headings or are the variable names of the type of data 
stored in each column. Variable names are the strings used when writing data out to an 
Auxiliary File. Change the headings to variable names can be helpful when looking at or 
creating auxiliary files. 

Use Word Wrap 

Check this box to wrap the heading column text, breaking it in several rows to fit the current 
column width. If unchecked, the column heading text will be displayed in only one row. 

Highlight Key and Required Field Column Headings 

If this option is checked, the key fields needed for identifying objects will be highlighted in 
the case information display. These fields are important if you are planning on pasting data 
back into Simulator from Excel or reading data in from an auxiliary file. If the necessary key 
fields are not present in the Excel paste of auxiliary file, the data in those formats cannot be 
processed by Simulator. 

Similarly, the Required Field Column Headings can also be highlighted in the case 
information display. In order for Simulator to create new objects by reading them from an 
auxiliary file or and Excel paste, the required fields must be present in the pasted data or 
the object cannot be created. 

Show Header Hints 

This option allows the hints for the current field to be displayed when moving the cursor 
over the column heading. 

Copy/Send Options 

Typically when you copy information to the clipboard or send data to Excel from a case 
information display, the first two rows of the copied information contain the type of object 
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the data represents (object name) and the column headings for each column of data. These 
rows are necessary if you intend to paste the information back into Simulator, but they are 
unnecessary if you are only exporting data to another program with no intention of pasting 
the information back into Simulator. Thus, these two options allow you to choose which of 
the two rows, if either, you wish to have copied along with the actual data from a case 
information display when pasting in another application. 

Disable Auto Refresh 

This option prevents Simulator from automatically updating the contents of open case 
information displays with each solution. If this option is not checked, the data in all open 
case information displays will be updated automatically to reflect the system state calculated 
from each Power Flow Solution. 

Set Factory Defaults 

Clicking on this button will reset the options to their defaults. 
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Limits Options 

  

These options can be found on the PowerWorld Simulator Options dialog, and are used for 
options specific to limit enforcement or identification. Some of these settings are also available 
in other locations. 

Enforce Generator MW Limits 

If checked, generator MW limits are enforced. 

Enforce Generator Ramp Limits 

If checked, generator MW ramp limits are enforced. 

Automatically Open Overheated Lines During Simulation 

If checked, overheated lines automatically open during simulation. 

Highlight Field of Objects with Limit Violations 

If checked, the fields for objects on the diagram that correspond to device parameters with 
range limits that are violated will be colored according to the High Limit Color and Low 
Limit Color fields. The colors of these two fields can be defined by the user. This 
highlighting applies only to the following fields:  

• Bus voltage 
• Interface MW 
• Line MW, Mvar, MVA and Amp 
• Generator MW and Mvar 
• Load MW 
• Switched Shunt Mvar 
• Transformer Phase and Tap Ratio 

If other highlighting is desired see the more flexible Dynamic Formatting feature. Using 
Dynamic Formatting, much more complex highlighting of any field or object can be 
achieved. 
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File Management Options 

  

There are two sub-categories on the File Management Options tab: PowerWorld Files, and EPC 
and RAW Files. 
  

PowerWorld Files 

Automatic Loading of Auxiliary File 

A default auxiliary file can be loaded when the present case is opened by checking the 
Automatically load an auxiliary file when the present case is opened check box. 
The auxiliary file given under Auxiliary File will then be loaded with the present case. The 
full path needs to be included with the file name. 

Automatic Loading of Auxiliary File with ANY Case  

A default auxiliary file can be loaded when each case is opened by checking the 
Automatically load an auxiliary file when ANY case is opened check box. The 
auxiliary file given under Auxiliary File will then be loaded with each case. The full path 
needs to be included with the file name. 

Automatic Archiving of PWB Files 

This option allows you to effectively make backup copies of your working case every time 
you save the pwb file. For example, assume you have a case named Test Case.pwb. With 
the Automatic Archiving turned on, saving the case will first create a copy of the original file 
and rename it Test Case_1.pwb. The character used as a delimiter can be chosen optionally. 
The case with any changes you have just made will then be saved as the new Test 
Case.pwb file. Each time you save the case, the latest version is named Test Case.pwb, the 
last Test Case.pwb is renamed with the delimiter and 1 appended, and all other archived 
versions will be renamed with their number incremented by 1. The number of archive 
versions to maintain can also be chosen by setting the maximum number of archive files 
property. The automatically archived cases will be saved in the same directory from which 
the last case was opened. 

Autosave Every … Minutes 

This option allows the user to specify how often (in minutes) the case is automatically 
saved. A value of zero means that this option will not be used. 

Save Unlinked Elements of contingency, interface and injection group records in 
the PWB file 

Checking this box allows saving any unlinked contingency, interface, and injection group 
records in the PWB case. The unlinked elements are only created when read from an 
auxiliary file containing unlinked records. 

  

EPC and RAW Files 

Display GE Additional Data in Case Information Displays 

A large amount of data which is not relevant to the Simulator power flow solution is 
contained in the GE EPC file. This data is now all read and stored in Simulator and 
Simulator’s PWB file format. By default columns which represent this extra data are not 
available when choosing Display/Column Options on a Case Information Display. If you 
would like these fields to be available, check this box. 

Load Additional Data from ECF 
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Older versions of Simulator did not read all the extra data from the GE EPC file and instead 
stored it in files with the ECF extension. If you would like to read in one of these old ECF 
files, click this button. 

Remove Additional Data from Case 

Because all of the extra data in the EPC can take up a lot of space (approximately doubles 
the PWB file size and increases the memory foot-print of Simulator itself too), you may want 
to just delete all this information. Click this button to permanently remove this data from 
your case. 

GE EPC Motor Data Table 

Part of the extra data read from the EPC file is Motor Data which does not map to an object 
used inside PowerWorld. To see this information, click on this button. 

PTI RAW Transactions due to tie-line loads 

Loads may be assigned to a different area than the load’s terminal bus. PTI offers an option 
that allows the user to ignore this assignment when calculating the tie-line flow for an area. 

(AREA INT CODE = 1 FOR LINES ONLY) 

(AREA INT CODE = 2 FOR LINES AND LOADS) 

Simulator does not allow you to define a load this way and then choose to ignore it. Most 
RAW files that PowerWorld has seen seem to be solved ignoring the loads that are in 
different areas than their terminal bus by using the "lines only" option. To overcome this, 
when PowerWorld reads a RAW file, MW Transactions are automatically created with the ID 
"RAW_LOAD". (You can optionally choose to load the RAW file "with options". This will allow 
you to choose whether or not the transactions should be added. See Case Formats for more 
information.) These transactions are between the load’s area and its terminal bus and are 
created so that the export from each area correctly matches a case solved using "lines only". 
If you know that your case was solved using "lines and loads", then click the button 
Remove transaction due to tie-line loads. Clicking this will delete all the MW 
Transactions with an ID of "RAW_LOAD". You may also click the button Add transactions 
due to tie-line loads to recreate a list of transaction which represent flows between loads 
with different areas than their terminal bus. 
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Power Flow Tools Ribbon Group 

  

The main function of the PowerWorld Simulator is to simulate the operation of an 
interconnected power system. The simulation is accomplished by selecting Single Solution – 
Full Newton from either the Quick Access Toolbar or the Power Flow Tools ribbon group 
on the Tools ribbon tab. This activity performs a single Power Flow Solution. See Solving the 
Power Flow for more information.  

  

The following tasks are also available from the Power Flow Tools ribbon group on the Tools 
ribbon tab.  

 
Single Solution – Full Newton   

The main function of the PowerWorld Simulator is to simulate the operation of an 
interconnected power system. The simulation is accomplished by selecting Single Solution 
– Full Newton from the Power Flow Tools ribbon group on the Tools ribbon tab. This 
activity performs a single Power Flow Solution. See Solving the Power Flow for more 
information. Also note that if presently in Edit Mode, you wil be automatically taken to Run 
Mode when choosing this. 

 Simulator Options 

When choosing any of the solution methods, the options as specified in the Simulator 
Options will affect what calculation is performed. solves the power flow using the either the 
Full Newton AC load flow or the DC Approximation load flow, as specified in the Simulator 
Options. 

Play Button 

Click this button to cause repeated solutions of the system and to cause the animation of 
oneline diagrams 

Pause/Stop Button 

Click this button to stop the action of the Play button. 

Restore Menu 

The Restore menu offers option to either Restoring a Previous Solution or a Restore a 
Previous State 

Sometimes a power flow attempt won't converge to 
a solution. When this occurs, the voltages and angles calculated by the solution engine will 
not satisfy the real and reactive power balance constraints at each bus. Then, the state 
currently stored in memory will not be an actual system operating point. It is often very 
difficult to coax the system to solve once it has failed to converge. 
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To help you recover from a solution attempt that has failed to converge (both timed 
simulations and single solutions), Simulator offers you two options. 

After Simulator solves a system successfully, it will store the voltages and angles it found 
in memory. If the changes that you then make to the system result in a system that 
can't be solved, you can select Restore > Last Successful Solution from the Power 
Flow Tools ribbon group on the Tools ribbon tab to reload the results of the last 
converged solution. After reloading this information, Simulator will re-solve the system 
and refresh all displays. 

In addition to restoring the last converged solution, Simulator also gives you the ability 
to restore the state of the system as it was just prior to the unsuccessful solution 
attempt. This can be thought of as "un-doing" the effect of the solution attempt. Before 
attempting a solution, Simulator stores the state of the system in memory. If it solves 
the power flow successful, Simulator will discard this pre-solution state. However, it the 
power flow fails to converge, Simulator will keep the state in memory. To recover it, 
select Restore > State Before Solution Attempt from the Power Flow Tools 
ribbon group on the Tools ribbon tab. Simulator will replace the non-converged post-
solution state with the pre-solution state and refresh the displays. You can then play with 
the system to try to make it easier to solve. 

If you are working with large systems, you should be aware that saving these system 
states can consume a lot of memory. Therefore, Simulator offers you the option to 
disable one of both of these features. To do this, select Simulator Options from the 
Case Options ribbon group on the Options ribbon tab to open the Simulator Options 
Dialog, and then go to the Storage sub-tab of the Solution tab. You will see two 
checkboxes there that can be modified to control whether or not these extra system 
states are saved. 

  

Solve Menu 

 
Single Solution – Full Newton   

The main function of the PowerWorld Simulator is to simulate the operation of an 
interconnected power system. The simulation is accomplished by selecting Single 
Solution – Full Newton from the Power Flow Tools ribbon group on the Tools 
ribbon tab, or from the Quick Access Toolbar. This activity performs a single Power 
Flow Solution. See Solving the Power Flow for more information. Also note that if 
presently in Edit Mode, you wil be automatically taken to Run Mode when choosing 
this. 

Polar NR Power Flow 

This perform a Newton Rhapson power flow solution using polar coordinates instead 
of rectangular coordinates as is normally done in Simulator. 

DC Power Flow 
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This automatically change the Simulator Options to use the DC Approximation and 
then immediately performs the DC power flow solution. 

Reset to Flat Start  

Select Solve > Reset to Flat Start from the Power Flow Tools ribbon group on 
the Tools ribbon tab to initialize the Power Flow Solution to a "flat start." A flat start 
sets all the voltage magnitudes and generator setpoint voltages to 1.0 per unit and all 
the voltage angles to zero. Usually, a flat start should be used only if the power flow 
is having problems converging. You can also use the flat start option on the Simulator 
Options Dialog to initialize every solution from a flat start. 

Robust Solution Process 

The Robust Solution Process provides a method to attempt to reach a solution when 
the standard load flow (Newton-Raphson) solution fails. The robust process performs 
a solution in a series of steps. 

First, the robust solution will turn off all controls in the case. Then the load flow will 
be solved using a fast decoupled power flow. If the fast decoupled power flow 
reaches a solution, Simulator then immediately solves the load flow using the 
Newton-Raphson load flow, still keeping the controls turned off. If the Newton-
Raphson solution is also successful, Simulator will begin adding controls back into the 
solution process, one type of control at a time. Thus the generator MVAR controls are 
added back in, and the load flow is resolved. Then the switched shunt controls are 
restored, and the load flow is again resolved. Simulator will continue in this manner 
by reintroducing next the LTC control, followed by the area interchange control, and 
lastly the phase shifter control. Furthermore, when reintroducing the phase shifter 
control, the controls are added one at a time for each phase shifter, with a load flow 
solution occurring after each. 
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Solving the Power Flow 

  

At its heart, Simulator is a Power Flow Solution engine. Power flow is a traditional power 
engineering calculation that is performed to determine the flows on all lines and the voltages 
at all buses in the system given the power injections at all buses and the voltage magnitudes 
at some of them.  

The power flow problem entails solving a system of nonlinear equations. Solving a nonlinear 
system requires the use of an iterative algorithm to hone in on the correct solution. Many 
nonlinear system solvers have been developed, and PowerWorld provides access to the full 
Newton-Raphson method with an optimal multiplier and the fast decoupled method. 

Usually, the power flow computation converges quickly. However, it is certainly possible to 
model conditions for which no Power Flow Solution exists, or for which the algorithm cannot 
converge to the solution within the maximum number of iterations specified. For such 
situations, the message log will provide a message indicating that the computation failed to 
converge. Furthermore, unless blackouts are disabled, the screen is grayed, and a message 
indicating a blackout has occurred is shown. 

In order to calculate the power flow solution, simply press the Single Solution button on the 
main Program Toolbar. Click Single Solution actually results in three nested loops which solve 
the power flow: MW Control (Outer) Loop, Controller (Middle) Loop, and Power Flow (Inner) 
Loop.  

Power Flow (Inner) Loop 

The Power Flow Loop is where the traditional power flow matrix equations are solved.  

Controller (Middle) Loop 

Once the Power Flow Loop is solved, control devices look to see if their control requirements 
are being met. Control devices include load-tap-changing (LTC) transformers, phase-shifting 
transformers, switched shunts, DC transmission lines, and generators hitting max/min var 
limits. If any control devices requiring changes, then these changes are made and the power 
flow loop is resolved. This continues until no more control loop changes are made.  

MW Control (Outer) Loop 

After the Control Loop has completed, the MW Control loop is entered and generation (and 
possibly load) is moved to meet the MW control options set in the case. Normally, MW control 
is done by area control with each area varying generation to meet its own load, losses and 
interchange. However, you may also use island-based control to dispatch MWs by island.  

If any MW control is needed, then the Control Loop and Power Flow Loop interaction must be 
repeated and so on. 
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Area Control 

  

One of the most important aspects of interconnected power system operation is the 
requirement that each operating area changes its total generation to match changes in the 
sum of its load plus losses plus power transactions with other areas. This requirement is 
normally met by Automatic Generation Control (AGC). The purpose of AGC is to ensure that 
the actual MW output of an area is equal to the scheduled MW output of the area. The AGC 
system accomplishes this by first calculating the Area Control Error (ACE), which is defined as 

 ACE = Pactual - Pscheduled  

In Simulator, Pscheduled for an area is made up of the Area’s MW Transactions and the Area’s 
Unspecified MW Export. MW Transactions represent the transfer of power between two areas 
in the power system. This transaction is done presumably under a contract between the two 
areas. The advantage of using MW transactions to describe these is that it ensures that the 
total export of all areas is consistent: if one area is exporting 100 then another area is 
automatically importing that power. However, each area also specifies a value called the 
Unspecified MW Export which can be entered on the Area Information Dialog. The unspecified 
MW export represents an export of power from the area that goes to an unspecified other 
area. When using unspecified MW exports, it is important that the total unspecified MW 
exports in the system sum to zero. PowerWorld highly recommends that care be taken when 
using unspecified exports. 

Whenever the ACE is greater than zero, it means that the area is over generating and thus 
needs either to decrease generation or to sell more. Likewise, whenever the ACE is less than 
zero, the area is under generating and thus needs either to increase generation or to buy 
more. AGC works to keep the ACE close to zero.  
  

In Simulator, there are six options for implementing AGC:  

No area control 

The output of the generators does not change automatically. You must manually change the 
generation to match system load/losses/transaction variation. All change in 
load/losses/transaction in this area will be made up at the islands slack bus. 

Participation Factor Control 

The output of all the area’s generators who have their AGC field set to "YES" change 
automatically to drive the area control error (ACE) to zero. Each generator’s output is 
changed in proportion to its participation factor. Checking this option enables the Set 
Factors button on the Area MW Control Options tab of the Area Information Dialog, which, 
when pressed, opens the Generator Participation Factors Dialog. Participation Factor Control 
only adjusts generation when a change to the system has taken place, such as changing the 
amount of load in the case, or defining new area to area transactions.  

In Participation Factor Control, the ACE is allocated to each AGC generator in the area in 
proportion to that generator’s participation factor divided by the total of the participation 
factors for all AGC generators in the area. A generator’s participation factor cannot be 
negative. By default, a generator’s participation factor equals its current MW setpoint value, 
but individual participation factors can be changed. 

Economic Dispatch Control 

The output of all AGC generators in the area changes automatically to drive the area control 
error (ACE) to zero. Each generator’s output is changed so that the system is dispatched 
economically, based on cost information entered for the generators in the case. Note that 
cost data is not generally included in standard load flow data. Without realistic cost data 
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entered into Simulator, the use of the economic dispatch algorithm may not be very useful. 
Cost data must be obtained from another source and entered into a case in Simulator, either 
manually or through the use of Simulator Auxiliary Files.  

With Economic Dispatch (ED) Control, Simulator tries to change the output of the area’s AGC 
generators economically so that the area’s operating cost is minimized. ED control 
recognizes that some generators are less expensive than others and tries to use the least 
expensive generators to the largest extent possible.  

To do economic dispatch, we need to know how much it would cost to generate one more 
MW at a particular generator. This is known as the incremental or marginal cost. For 
example, for the cubic cost curve model, the incremental cost for each generator is modeled 
using the formula:  

 λi = ICi (Pgi) = ( bi + 2ci Pgi + 3di (Pgi) 2 ) * fuelcost   $/MWH  

The plot of ICi(Pgi) as a function of Pgi is know as the incremental-cost curve. The economic 
dispatch for a system occurs when the incremental costs for all the generators (λi) are 
equal. This value is known as the system λ (lambda) or system incremental cost. Its value 
tells you how much it would cost to generate one more MW for one hour. The system 
lambda becomes important when trying to determine whether or not an area should buy or 
sell power. For example, if an area can buy power for cheaper than it can generate it, it 
might be a good idea for the area to buy power. 

Area Slack Bus Control 

Only the output of the area’s slack bus changes automatically to drive the area control error 
(ACE) to zero. This type of generation control is usually only good for small disturbances to 
the injections and/or transactions in a case, and can often fail to find a solution when larger 
disturbances are examined. 

Injection Group Area Slack Control 

Only the Injection Group specified as the Injection Group Area Slack will change to 
automatically drive the area control error (ACE) to zero. This allows you to be very specific 
with each area as to which generation (or load) should vary to maintain ACE. 

Optimal Power Flow (OPF) 

The OPF option will only be available if you have the OPF add-on for PowerWorld Simulator. 
The OPF control is very similar to the Economic Dispatch control in that it attempts to 
dispatch generation to minimize costs. The additional function of the OPF is to minimize the 
costs while also obeying line, transformer, and interface limit constraints. This option is also 
not useful without realistic generator cost information, which usually must be obtained from 
another source and entered into Simulator to augment a load flow case.  

The OPF control also relies on the cost curve in order to perform an economically optimal 
power flow. However, the OPF routine makes use of piecewise linear curves in its solution 
algorithm. This does not prevent you from entering the cost information as cubic cost 
models, described by the equation above. Rather Simulator’s OPF routine allows you to 
specify how to break up the cubic curve and model it as a piecewise linear curve for the OPF 
algorithm. 

  

In addition, you can also enter piecewise linear curves directly instead of the cubic cost curve 
models. In fact, a mixture of piecewise linear and cubic models is acceptable. For the 
economic dispatch routine, whichever type of model is entered will be used directly for each 
generator. For the OPF routine, all piecewise linear curves entered directly will be used as is, 
and any cubic models entered will be converted to piecewise linear curves internally during the 
processing of the OPF algorithm. 



Solving and Simulating a Case 
 
 

694 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

 



Solving and Simulating a Case 

695 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Set Generator Participation Factors 

  

Participation factor control is another of Simulator’s mechanisms for distributing an area’s 
responsibility to serve its load, losses, and interchange. It is particularly well-suited to 
implementing automatic generation control (AGC) when you do not have good economic 
information for an area’s generators. With participation factor control, the amount of power 
that each generator contributes to meeting its areas load, loss, and interchange responsibilities 
is controlled by the size of its participation factor. The unit that has the largest participation 
factor contributes the most, and the unit that has the smallest participation factor contributes 
the least. 

The Set Generator Participation Factors Dialog gives you a convenient way to define the 
participation factors for multiple generators. You can set the participation factor according to a 
number of different formulae and then apply this prescription to all generators in a specific 
area, all generators in a specific zone, all generators in the system, or all generators whose 
display filters are currently set to true. 

To display the Set Generator Participation Factors Dialog, you first need to open the 
Area Information Dialog and switch to the Area MW Control Options page. The Area 
Information Dialog has a button labeled Set Participation Factors that is enabled only if the 
Participation Factor Control option is selected under the Area Control Options heading. Set the 
area on participation factor control by selecting the Participation Factors option, and then 
press the Set Participation Factors option. 

The Set Generator Participation Factors Dialog is divided into two parts. The first part, which 
occupies the top half of the form, allows you to indicate how the participation factors should 
be calculated or set for each generator. Your options include: 
  

Max MW Rating of Generator The participation factor for each generator is set to the 
generator’s maximum MW capability. 

Difference Between Max and Current Output The participation factor for each 
generator is set to the generator’s reserve power, so that each generator participates in 
proportion to how much it has left to contribute. 

Constant Value of The participation factor for each generator is set to the same hard-
coded value. 

File The participation factor for each generator is read from a file. The first line of the file 
should contain the keyword NUMBERS or NAMES indicating whether generators are 
identified by bus number or by bus name in the file. All subsequent lines should be comma-
delimited and contain three fields: the number or name of the generator’s bus, the 
generator’s id, and the generator’s participation factor. 

  

If you choose any of the first three options, you then must tell Simulator to what generators 
you want to assign the participation factors. To assign the participation factors to all 
generators in a specific area, select the All Generators in Area option, and then choose the 
area from the adjacent dropdown box. If you want to assign the participation factors to all 
generators in a specific zone, select the All Generators in Zone option, and then choose the 
zone from the adjacent dropdown box. If you want to assign the participation factor to all 
generators in the system regardless of their area or zone affiliation, select the All Generators 
in System option. Finally, if you want to assign the participation factor to just those 
generators whose display filter criteria evaluates to true, choose the All Generators With 
Valid Display Filters option. 
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If you instead chose to read participation factors from a file, only those generators whose 
factors you read from the file will have their factors set by this action. However, unless each 
generator’s associated area is set to control generator output using participation factor control, 
this information will be ignored. To make sure that each generator’s area is set to participation 
factor control, check the Set Corresponding Areas to Participation Factor Control box. 
Then, each corresponding area will be set to participation factor control. 
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Transaction Dialog 

  

The Transaction Dialog can be used to modify or create Base Interchange Transactions 
between two areas. This dialog can be opened by right-clicking in the Base Interchange table 
of the Area Information Dialog and choosing Show Dialog to see an existing transaction 
definition, or Insert to add a new transaction. 

The transaction dialog is divided into two pages of controls: 
  

Information 

Transacting Area 

This is the "from" area for the transaction. For an export from this area, the transaction 
value will be positive. For an import into the Exporting Area, the transaction value specified 
would be negative. Flow out (export) of the exporting area is always considered positive. 

Transaction To Area 

This is the "to" area for the transaction. 

Transaction ID 

New in Simulator version 10 is the ability to have multiple transactions defined between the 
same two areas. Because of this, it is now required that transactions also have a Transaction 
ID. 

Rename Transaction ID 

If you wish to change the transaction ID for a particular transaction, enter the new value in 
the Transaction ID field, and press this button. 

Switch Directions 

Press this button if you wish to reverse the defined Exporter and Importer for the 
transaction. 

Transaction MW Amount 

The MW amount of the transaction being defined. This value should be positive for an 
export from the Exporting area to the Importing area. The value can also be entered as 
negative to define a transaction into the Exporting area from the Importing area. 

Transaction Minimum MW 

The minimum transaction amount between the two areas. This field is only enabled if the 
check box labeled Transaction Dispatchable in OPF is checked. 

Transaction Maximum MW 

The maximum transaction amount between the two areas. This field is only enabled if the 
check box labeled Transaction Dispatchable in OPF is checked. 

Exports/Imports Transmission Charge 

The cost to transfer power, in $/MWh. This adds an economic penalty for making the 
transfer, making the transfer less likely to take place. Half the charge is assigned to the 
buyer and half to the seller. 

Transaction Enabled 

Transaction can now be defined and either enabled or disabled. Any disabled transactions 
will be ignored in both a standard power flow solution and an OPF solution. 

Transaction Dispatchable in OPF 
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Checking this box enables the transfer to be dispatched by the OPF algorithm. Dispatching 
the transaction makes the two areas of the transaction appear to be one area for the 
purpose of economically dispatching the generation in the two areas. The transaction can 
have a maximum and minimum transfer amount when dispatchable, and a transmission 
charge associated with the transaction. 

Determine Price in OPF 

Checking this box allows the OPF algorithm to determine the cost associated with the 
transfer. The cost is determined by the marginal cost of enforcing the power balance 
constraint for the combined areas. This is the typical way to implement a transfer if both 
areas are on OPF control. If only one of the two areas are on OPF control, then the area 
which is off of OPF control needs to specify a price for the transfer. This is done by explicitly 
defining a piecewise linear cost curve. 

Piecewise Linear Transaction Cost Curve 

These two curves are only enabled if the option Transaction is Dispatchable in OPF is 
checked and the option Determine Price in OPF is unchecked. These two curves can be 
defined for the purpose of assigning a price to the transfer of power between one area on 
OPF control and another area which is not on OPF control. Separate curves can be defined 
for export transactions (from the Exporter to the Importer) and import transactions. To add 
points to the curves, simply right-click in the grid and choose Insert from the local menu. 
Enter the MW value and corresponding marginal cost for the inserted breakpoint of the 
piecewise linear curve you are defining. To delete a point, right-click on that row in the grid 
and choose Delete from the local menu. 

  

Custom 

The Custom page of the Transaction dialog is simply a location to log information about the 
transaction in the Memo box, and to see the values (if any) stored in some of the custom 
fields for the transaction. To log information about the transaction, simply switch to the 
Custom page on the dialog, and start typing your information or comments about the 
transaction in the page, or enter custom values in one of the custom fields. 
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Calculate MW-Distance 

  

Simulator can estimate MW * Distance quantities for the system’s areas and zones that result 
from a specified transaction. Given a transaction from a specified source to a specified sink, 
Simulator uses power transfer distribution factors (PTDFs) to estimate the change in flow for 
each line in the system that results from the transaction. For each line, multiplying the line’s 
change in flow by its length then gives the MW * Distance index for that line. Simulator then 
sums the MW * Distance indices by area and by zone to obtain the total MW * Distance for 
each area and zone in response to the specified transaction. 

Because the MW * Distance calculations use PTDFs, you must access the MW * Distance 
functionality from the PTDF Dialog. Once you have calculated PTDFs for a particular 
transaction by pressing the Calculate PTDFs button, click the Calculate MW * Distance 
button to bring up the MW * Distance Calculations Dialog. 

The top portion of the MW * Distance Calculations Dialog is used to set the lengths of the lines 
in the case. Although line length is represented as a data element in the power flow case, it 
often is left blank. However, Simulator needs line length information if it is to calculate MW * 
Distance indices. Simulator offers a few options regarding the source of line length 
information. If you do not have access to line lengths, either from the existing case or an 
external text file, Simulator can estimate line lengths for you. It does this by using the 
Ohms/Length values you specify in the table for lines of various kV. Simply indicate the 
voltage levels in the first row of the table, and the corresponding ohms or reactance per 
length in the second column. You do not need to differentiate here between English and 
metric units, because the calculation is independent of the measurement system. If you want 
the length estimates calculated using this table to overwrite any line lengths that may already 
be present in the case, be sure to check the Always Estimate Length checkbox; otherwise, 
the new estimates will set the lengths only of lines whose pre-defined length isn’t greater than 
zero. If you want the estimates to populate the lengths of lines in the model so that, when you 
save the model, the estimated lengths are saved as part of the model, check the Save 
Estimates With Case. (This provides a handy way to set line lengths for a case that might 
not have any defined.) Note that, in performing these estimates, transformers are defined as 
having zero length. If you do not want Simulator to estimate line lengths but instead want to 
use the line lengths that are currently stored in memory, check the Do Not Use Length 
Estimates box. Finally, if you want to load line lengths from a text file, click the Load Line 
Lengths from File button. This file can be either comma- or space-delimited, and each line 
must have the following fields in the order specified: 

 From_Bus_Number  To_Bus_Number  Circuit_ID Length 

Once Simulator knows how to calculate line lengths, it can calculate MW*distance indices for 
each area and zone. Specify the amount of MW that will be transacted in the Size of 
Transaction textbox. You may use the arrows to increase or decrease the size of the 
transaction. Simulator assumes that the transaction is to occur between the source and sink 
groups for which you just calculated PTDFs. Press the button labeled Calculate to compute 
the indices. Two tables are populated with the results of the calculation, one for areas, and 
another for zones. Use the tabs to switch between the two tables. These tables are Case 
Information Displays and thus share common to all case information displays. Thus, you can 
sort the tables, add or delete columns, access the area and zone dialogs, print the tables, and 
save their content as HTML. 

Several options can be set to customize the calculation of MW*Distance. These options are 
reached from the MW*Distance Options Dialog. 
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MW-Distance Options 

  

The calculation of MW*Distance quantities can be customized in a number of ways. These 
options are set from the MW*Distance Options Dialog.  

Include Tie Lines Only 

If this box is checked, then the only branches that contribute to the MW*Distance 
calculation are those that tie two areas together. Otherwise, both tie lines and lines internal 
to areas and zones are included in the calculation. In the latter case, tie lines are assumed 
to belong to the area that owns the metered end of the branch. 

Internal Flows 

If you choose to include both tie line flows and flows internal to areas and zones in 
calculating MW*Distance quantities, you have two options for how to treat internal flows. 
You can ignore flows resulting from the transaction that flow in the reverse direction of the 
existing flow on a branch by checking the Include flow increases only checkbox. You can 
also choose to treat all such counterflows as negative contributions to an area or zone’s MW 
* Distance value by checking the Deduct flow reductions checkbox. 

Omit Branches 

To omit branches for which the PTDF corresponding to the transaction is less than a 
specified value, specify a nonzero percentage in this textbox. 
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Area Control Error (ACE) Chart 

  

The ACE chart plots the area control error for an area over time. For details on ACE, please 
see topic Area Control. To access this display, go to the Tools ribbon tab, and choose Other > 
Charts > ACE Chart from the Other Tools ribbon group. This option is only available in Run 
Mode. You may also press the corresponding button on the Simulation Summary tab of the 
Area Information Dialog. If you use the ribbon to view this chart, it shows information for the 
it shows information for the first area in the case. The strip chart starts to plot the data when 
you open it, with new data appearing on the left. You can change the scale of either the x-axis 
(the time axis) or the y-axis (Scheduled Transactions axis) by right-clicking anywhere on the 
axis itself and specifying the new axis limits and number of intervals.  

Right-click on the display (except on the axes) to view the display’s local menu. The local 
menu is used to print the strip chart, save the strip chart in a file, copy the strip chart to the 
Window’s clipboard, or change the number of the area being displayed.  

Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right 
corner of the form).  



Solving and Simulating a Case 
 
 

702 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Area Load and Generation Chart 

  

The Load and Generation chart plots an area’s load + losses and generation in MW when you 
are animating (playing) and solving the load flow every animation cycle. To access this display, 
go to the Tools ribbon tab, and choose Other > Charts > Area Load and Generation 
Chart from the Other Tools ribbon group. This option is only available in Run Mode. You may 
also press the corresponding button on the Simulation Summary tab of the Area Information 
Dialog. If you use the ribbon to view this chart, it shows information for the first area in the 
case. The strip chart starts to chart the data (if animation is running) when you open it, with 
new data appearing on the left. You can change the scale of either the x-axis (the time axis) 
or the y-axis (Load/Generation MW axis) by right-clicking anywhere on the axis itself and 
specifying the axis limits and number of intervals. 

Right-click on the display (except on the axes) to view the display’s local menu. The local 
menu is used to print the strip chart, save the strip chart in a file, copy the strip chart to the 
Window’s clipboard, or change the number of the area being displayed.  

Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right 
corner of the form).  
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Area Losses Chart 

  

The Area Losses chart plots an area’s real power losses when you are animating (playing) and 
solving the load flow every animation cycle. To access this display, go to the Tools ribbon tab, 
and choose Other > Charts >  Area Losses Chart from the Other Tools ribbon group. This 
option is only available in Run Mode. You may also press the corresponding button on the 
Simulation Summary tab of the Area Information Dialog. If you use the ribbon to view this 
chart, it shows information for the first area in the case. The strip chart starts to chart the 
data (if animation is running) when you open it, with new data appearing on the left. You can 
change the scale of either the x-axis (the time axis) or the y-axis (Load/Generation MW axis) 
by right-clicking anywhere on the axis itself. 

Right-click on the display (except on the axes) to view the display’s local menu. The local 
menu is used to print the strip chart, save the strip chart in a file, copy the strip chart to the 
Window’s clipboard, or change the number of the area being displayed.  

Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right 
corner of the form).  
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Area MW Transactions Chart 

  

The Scheduled MW Transactions chart plots the scheduled real power (MW) transactions for 
an area when you are animating (playing) and solving the load flow every animation cycle. To 
access this display, go to the Tools ribbon tab, and choose Other > Charts > Area MW 
Transactions Chart from the Other Tools ribbon group. This option is only available in Run 
Mode. You may also press the corresponding button on the Simulation Summary tab of the 
Area Information Dialog. If you use the ribbon to view this chart, it shows information for the 
first area in the case. The strip chart starts to chart the data (if animation is running) when 
you open it, with new data appearing on the left. You can change the scale of either the x-axis 
(the time axis) or the y-axis (Scheduled Transactions axis) by right-clicking anywhere on the 
axis itself and specifying the new axis limits and number of intervals. 

Right-click on the display (except on the axes) to view the display’s local menu. The local 
menu is used to print the strip chart, save the strip chart in a file, copy the strip chart to the 
Window’s clipboard, or change the number of the area being displayed.  

Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right 
corner of the form).  
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Area Average Cost Chart 

  

The Average Cost per MWH chart plots the average cost per MWH for an area over time. This 
value is calculated by dividing the total cost of operating the area (generation cost + 
purchased power cost - revenue from power sales) by the MW load in the area. To access this 
display, go to the Tools ribbon tab, and choose Other > Charts >  Area Average Cost 
Chart from the Other Tools ribbon group. This option is only available in Run Mode. You may 
also press the corresponding button on the Simulation Summary tab of the Area Information 
Dialog. If you use the ribbon to view this chart, it shows information for the first area in the 
case. The strip chart starts to plot the data when you open it, with new data appearing on the 
left. You can change the scale of either the x-axis (the time axis) or the y-axis (Scheduled 
Transactions axis) by right-clicking anywhere on the axis itself and specifying the new axis 
limits and number of intervals. Note that as the area’s load increases, the average cost per 
MWH tends to increase. 

Right-click on the display (except on the axes) to view the display’s local menu. The local 
menu is used to print the strip chart, save the strip chart in a file, copy the strip chart to the 
Window’s clipboard, or change the number of the area being displayed.  

Use the display’s control-menu box to close the display (i.e. the ‘X’ button at the top right 
corner of the form).  



Solving and Simulating a Case 
 
 

706 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Bus View Display 

  

The Bus View Display feature provides a graphical display which allows you to quickly 
browse information about a bus and everything connect to that bus. The bus view displays 
enable convenient bus-by-bus navigation through the power system. From the bus view, you 
can find out a bus’ voltage and angle, the load, shunt compensation, and generation 
connected to the bus, and the flows on all lines emanating from the bus. You can also discover 
the bus’ area and zone affiliations, as well as the bus’ marginal cost. Moreover you can find 
out all information about the elements associated with the bus by directly invoking their 
associated information dialogs. The advantage of the bus view displays, is that they are auto-
created oneline diagrams.  

Along the top of the bus view display resides a panel of controls. The buttons labeled Back 
and Ahead allow you to step through the history of buses you have viewed thus far. To move 
the bus view to a particular bus, type a number or name into the edit box next to the caption 
Bus. If a number is typed the case will be scanned for a bus of that number, otherwise the 
case will be scanned for a bus that starts with the string entered. If you’re unsure which bus 
that you are looking for click the Search For… button to bring up a display that allows you to 
search using wildcard strings for the bus. There are also drop-downs in this top panel for 
Options > and Views >. These are discussed below. 

Below this top panel sits the actual bus display. The bus you have chosen to inspect, which we 
shall refer to as the target bus, is represented by a long, thick black horizontal line. Notice that 
the bus’ voltage in kV and per unit, its angle, and its marginal cost are specified to the left of 
the bus. Any loads and generating loads connected to the target bus are drawn above the bus 
symbol, along with their associated annotation. Emanating from the bottom of the bus symbol 
are all transmission lines and transformers that connect the target bus to its neighbors. The 
transmission line and transformer symbols are equipped with pie charts and annotation 
identifying flows as measured at the target bus, as well as arrows to identify the direction of 
MW flow on the branch. Neighboring buses are represented as filled rectangular regions, with 
symbol indicators included if other types of devices, such as loads, generators, etc., are 
attached. When you drag the mouse over one of the neighboring bus symbols, it turns into a 
pointing finger. Clicking the left mouse button when the mouse cursor is in this shape 
redefines the target bus to be the bus whose symbol you just clicked. The bus view display is 
redrawn to show the same sort of display for the newly chosen target. You can go back to the 
previously displayed target bus by clicking the Back arrow, and then return to this record by 
clicking the Ahead arrow. 

It is useful to think of the bus view displays as nothing more than an additional oneline 
diagram. In other words, you interact with the objects drawn on the bus view display in the 
same way you work with objects on a more conventional Simulator oneline. Right-clicking on 
any power system object will bring up that object’s local menu, which includes a link to the 
object’s associated information dialog. As on a conventional oneline diagram, flows on a bus 
view display can be animated. Right-clicking on the bus view display’s background will 
generate the same local menu as other oneline diagrams.  
  

The bus view display can be generated using any of the following methods: 
• Go to the Case Information ribbon tab, and click on the Bus View from the Views ribbon 

group 
• Go to the 3Onelines ribbon tab, and click on the Bus View from the Views ribbon group. 
• Right click on the bus of interest on the oneline diagram to display the bus’ local menu, 

and choose Bus View. The bus view display will open with the selected bus already 
displayed. 
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• From any of the case information displays that convey bus information, right click on a 
record to bring up its local menu, and choose Bus View Oneline. The bus view display will 
open with the corresponding bus already displayed. 

• Click the Bus View Button on the Case Information Toolbar. 

To switch between the bus view and the main oneline, use the Open Windows Menu 
available on the Views ribbon group on the Case Information ribbon tab, Case Information 
ribbon tab,or Windows ribbon tab. To close the bus view display, simply close the form using 
the X button in the top right corner of the bus view display. 
  

Bus View Options 

Number of Tiers 

The bus view can display one or two "tiers" of buses in the display. Use this selection from 
the Options menu to toggle the number of tiers displayed. 

Show Hints 

When this option is checked, holding the cursor over an object will briefly pop up a hint box 
containing information about that object. 

Show Serial Buses 

When putting in the branch connections, the Bus View display will look out into the network 
and find the next bus which has more than two neighbors. It will then make this the 
destination bus for that branch of the Bus View. The intermediate buses will then be shown 
in order above the destination branch. This option works especially well in systems with a lot 
of multi-section lines. 

Show Equivalent Lines 

This option indicates to the Bus View display whether or not to include branches 
representing equivalent circuits as connections in the display. 

Represent Multi-Section Line Objects 

This option indicates to the Bus View display whether or not to draw multi-section line 
display objects when appropriate. If this option is not checked, then the intermediate buses 
of the multi-section lines will be rendered normally. If this option is checked then the 
intermediate buses of multi-section lines will not be rendered on the bus view and only the 
terminals of the multi-section line will appear. 

Default Drawing Values 

Choosing this option will open the Default Drawing Values for New Objects dialog. Changing 
these options can change some of the drawing aspects of the bus view, including device 
color and font size or color. 

Open Multiple Bus Views 

This option indicates whether to open multiple bus views simultaneously. Choices are never, 
always, and prompt for confirmation when a new additional bus view is about to open. 

Include Field Labels 

Selecting this option will place labels for each displayed field on the bus view diagram. 

Change Bus Link Color 

Selecting this option will display the color palette to select the color with which the buses 
linked to the current bus will be displayed. 

Show Field Suffixes 
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This option specifies whether to display the field values units as suffixes. If this option is not 
selected, all the fields will be display as a value without units. 

Dynamic Formatting 

Click on this to bring up the Dynamic Formatting for case information displays, and all views 
and onelines. 

  

Views 

Define Custom View 

The fields displayed on the bus view can be customized using this option. Clicking on this 
option will open a customization settings display, in which you can add and remove field 
definitions for the objects on the bus view display. Customized bus view layouts can be 
saved with the case for recall, identifiable by a custom bus view layout name. Custom 
layouts can also be saved to a file for loading into another load flow case. 

Input Data 

Switching the bus view to Input Data changes the bus view from displaying system state 
information to displaying input data information. For example, switching to Input Data view 
will display line impedances and limits, generator minimum and maximum outputs, etc. The 
default Input Data view fields can be modified using the Define Custom View customization 
dialog. 

System State 

Switching the bus view to System State changes the bus view from displaying Input Data 
information to displaying system state information. This will result in line flows being 
displayed, voltage and angles displayed, etc., of the current solution state of the system. 
The default System State view fields can be modified using the Define Custom View 
customization dialog. 
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Substation View Display 

  

The Substation View Display feature is analogous to the Bus View Display.  

Along the top of the substation view display resides a panel of controls. The buttons labeled 
Back and Ahead allow you to step through the history of substations you have viewed thus 
far. Substation View options are available from the Options menu. To find a substation using 
search tools, click on the Search For button. The next two controls following the Substation 
label allow to specify a substation name (in the first text box) or a number (in the second text 
box). If you type a number or name that does not exist, the substation display will continue 
displaying the current substation.  

Below this top panel sits the actual substation view display.  

Just as with the bus view, it is useful to think of the substation view displays as nothing more 
than a oneline diagram. In other words, you interact with the objects drawn on the substation 
view display in the same way you work with objects on a more conventional Simulator oneline. 
Right-clicking on any power system object will bring up that objects local menu, which 
includes a link to the object’s associated information dialog. As on a conventional oneline 
diagram, flows on a substation view display can be animated. Right-clicking on the substation 
view display’s background will generate the same local menu as other oneline diagrams. The 
substation view can be generated using any of the following methods: 
• Go to the Case Information ribbon tab, and click on the Substation View from the Views 

Ribbon Group 
• Go to the 3Onelines ribbon tab,and click on the Substation View from the Views ribbon 

group. 
• Right click on the substation of interest on the oneline diagram to display the substation’s 

local menu, and choose Substation View. The substation view display will open with the 
selected substation already displayed. 

• From any of the case information displays that convey substation information, right click 
on a record to bring up its local menu, and choose Substation View Oneline from the 
Substation Records menu. The substation view display will open with the corresponding 
substation already displayed. 

• Click the Substation View Button under the Records menu on the Case Information 
Toolbar. 

To switch between the substation view and the main oneline, use the Window menu tree on 
the main menu. To close the substation view display, simply close the form using the X button 
in the top right corner of the substation view display. 
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Chapter 11: Run Mode Tools and Options 

  

Run mode provides a number of commands for simulating and modifying the case that are 
different from Edit Mode. 

This chapter covers the following: 
• General Tools 
• Contingency Analysis 
• Fault Analysis 
• Contouring 
• Distribution Factors 
• Sensitivities 
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Generator Economic Curves 

  

Four characteristic curves describe the efficiency and resulting costs associated with operating 
a particular generating unit. These four curves plot 
• Fuel Cost 
• Heat Rate 
• Input-Output 
• Incremental Cost 

Simulator can display plots of all these curves. To display a particular plot for a generator, 
right-click on the generator in Run Mode to display its local menu, and then select the plot you 
wish to see. The plot will be presented in its own window. The windows for all plots exhibit 
identical characteristics. For example, the current operating point is identified by a red filled 
circle. Right clicking on an open area of the window displays the plot’s local menu which allows 
you to print the plot, save it to a file, or copy it to the clipboard for use in other programs. To 
adjust the length and number of intervals shown on an axis, right-click on the axis (not on the 
numbers) then specify the min and max display values and number of intervals. To close a 
plot window, simply click the X button in its top right corner. 

The Run Mode generator local menu also provides access to a fifth type of plot curve - the "All 
Area Gen IC Curves" plot. This plot simply shows the incremental cost curves and present 
operating points of all generators in the same area as the generator on which you clicked. 
  

Fuel Cost Curve 

The fuel cost curve specifies the cost of fuel used per hour by the generating unit as a 
function of the unit’s MW output. This is a monotonically increasing convex function. 

Heat-rate Curve 

The heat rate curve plots the heat energy required per MWH of generated electrical output 
for the generator as a function of the generator’s MW output. Thus, the heat rate curve 
indicates the efficiency of the unit over its operating range. Generally, units are least 
efficient at the minimum and maximum portions of their MW output capability and most 
efficient somewhere in the middle of their operating range. The vertical axis is plotted in 
MBtu/MWH and the horizontal axis is plotted in MW. You may interpret the heat rate for a 
generator producing X MW as follows: the heat rate indicates the amount of heat input 
energy per MWH of generation required to produce X MW of power. The lower this number, 
the less input energy is required to produce each MWH of electricity. 

Input-Output Curve 

The input-output curve is derived simply from the heat-rate curve by multiplying it by the 
MW output of the unit. This yields a curve showing the amount of heat input energy 
required per hour as a function of the generator’s output. 

Incremental Cost Curve 

By multiplying the input-output curve by the cost of the fuel in $/MBTU, one obtains the cost 
curve for the unit in $/hr. By taking the derivative of the cost curve, one obtains the 
incremental cost curve, which indicates the marginal cost of the unit: the cost of producing 
one more MW of power at that unit.  
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Find Branches that Create Islands 

  

To access the Find Branches that Create Islands, go to the Tools ribbon tab, and choose 
Connections > Find Branches that Create Islands from the Other Tools ribbon group. 

There are several options for selecting which ac lines to process.  
  

Line Processing Options 

All ac Lines 

All ac lines in the power system model will be processed. 

Use Area/Zone/Owner Filter 

All ac lines that meet the defined Area/Zone/Owner Filters will be processed. 

Select Area/Zone… to display the Area/Zone/Owner Filters dialog. 

Use Selected 

All ac lines that have the Selected? field set to ‘YES’ will be processed. 

Click Select Lines… to display all ac lines and change the Selected? field. 

Meets Filter 

All ac lines that meet a selected advanced filter will be processed.  

Use the drop down box to select a defined advanced filter or click Define Filter to display 
the Advanced Filters for Branch Dialog. This dialog will allow you to define a new 
advanced filter for a branch or update an existing filter. 

  

By checking Do not display radial lines creating a single bus island those lines that only 
island a single bus will not be displayed with the results. 
  

Click Determine Branches to start the processing once all options have been set. 
  

Because the processing of ac lines in a large power system may take some time, there is an 
Abort button that is enabled once the line processing has started that will stop the processing 
at any point. 
  

The list of resulting ac lines that create islands will be displayed under Branches that Create 
Islands. To show the list of buses that are islanded by an outage of any line in the list, select 
a line and the Islanded Buses list will be populated.  Both the Branches that Create Islands 
list and the Islanded Buses list are case information displays and have the same local menu 
options and characteristics of other case information displays. 
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Custom Hint Values 

  

Simulator can be configured to show a short hint string when the mouse is hovered over 
objects on the oneline diagrams. This hint string will appear in a yellow box as shown below. 

 
This option must be set first by opening the Simulator Options dialog and then going to the 
Oneline category and finally checking the Show Oneline Hints . The user may then 
customize what text and values appear in the hint by choosing Custom Hint Values on the 
General Options ribbon group of the Options ribbon tab. These General Options are also 
available on the Oneline ribbon tab. 

  

This brings up a dialog on which customizations are made for each type of display object that 
can show a hint.  

 
Choose the type of object on the left side of the dialog. With this display object chosen, 
choose which fields of this dialog you would like to include as part of the custom hint. Click the 
Add, Remove, or Modify buttons to add, remove, or modify a field to the hint. Click the Up 
and Down buttons to change the order in which the fields appear. On the dialog that appears 
after clicking Add or Modify, you may customize the field with a prefix, modify the digits and 
decimal points, and specify whether to show the units as a suffix. The Example column shows 
an example of what text will appear for the hint. 

The Object Identifier is also available that will appear as the first line of the hint if chosen. To 
remove this identifier, click the Remove ID button. When the object identifier is not being 
shown the Remove ID button caption will change to Add ID. Click the Add ID button to add 
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the object identifier back to the hint. You may specify the format of the object identifier by 
setting the Show Object Identifier with the following Identifier Type option 
appropriately. 

The hint customizations are stored with the PowerWorld Binary file (PWB) and in the Windows 
Registry. The customizations affect all oneline diagrams (including the Bus View and 
Substation View). The customizations may also be stored in an Auxiliary File for use in moving 
the customizations between computers and cases. Click the Save All to Aux File button to 
save all these customizations to an Auxiliary File. 
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Line Loading Replicator 

  

The Line Loading Replicator will attempt to set the loading on a transmission line or interface 
to a desired real power flow amount. This is accomplished by calculating distribution factors 
for a selected group of loads and generators to determine how the real power injection of 
these elements can be adjusted to produce the desired flow. If the desired flow cannot be 
met, the new flow amount that can be achieved and the injection changes required to meet 
this flow will be reported. Minimum and maximum MW limits for loads and generators will be 
enforced when calculating the injection changes.  

To open the Line Loading Replicator, go to the Tools ribbon tab, and choose Line Loading 
Replicator from the Run Mode ribbon group. This is only available in Run Mode. 

  

Select Device 

Device Type 

Select whether to adjust the flow on a transmission line/transformer or an interface. All 
devices must already be defined in the case. 

Device Identifier 

Specify the near bus, far bus, and circuit identifier for a branch or the interface name and 
number for an interface. Branches will be monitored in the near bus to far bus direction and 
interfaces will be monitored in the direction in which they are defined to be monitored.  

Present Flow 

Present real power flow on the selected device. 

Desired Flow 

Desired real power flow on the selected device. The difference between the Desired Flow 
and the Present Flow (Desired Flow – Present Flow) will be the flow change for which 
injection changes will be calculated. 

Available Injection Groups 

Injection Group Identifier 

Specify the injection group name and number that contains the loads and generators whose 
injection can be changed to reach the Desired Flow. The injection group must already be 
defined in the case. The injection group definition is used simply for selecting the group of 
elements to be used in the calculations; the participation factors defined with the 
participation points in the injection group are not used in the Line Loading Replicator tool.  

Only Include AGCAble Generation and Load 

If checked, only those loads and generators in the selected injection group whose AGC 
status is YES will be included in the calculations.  

Calculation Method 

Select the method used to calculate the distribution factors used to determine real power 
injection changes. 

Max and Min Load Limits for Injection Changes 

Use Max and Min Load Values 

If checked, the maximum and minimum load values will come from the maximum and 
minimum values defined with each individual load record. 

Set Max and Min Load Values 
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Click this button to show the Load Records Case Information Display. The maximum and 
minimum load values can be defined by displaying the Max MW and Min MW fields and 
setting the values as appropriate.  

Use Multiplier on Present Value 

If checked, the minimum and maximum value for each load will be determined by applying 
the Min Multiplier and Max Multiplier to the present load value. 

Calculate Injection Changes 

Click this button to calculate the injection changes required to meet the Desired Flow on the 
selected device. 

Injection Changes 

This is a case information display that will provide a summary of the injection changes 
needed, and the elements that can effect these changes, in order to meet the Flow Achieved 
on the selected device. The Flow Achieved will differ from the Desired Flow if there are not 
enough injection changes available to meet the Desired Flow.  

The results are reported in terms of injection. For generators, a positive injection means an 
increase in generator output and a negative injection means a decrease in generator output. 
For loads, the opposite is true; a positive injection means a decrease in load and a negative 
injection means an increase in load. 

Injection Change, Present Injection, and New Injection fields will be shown by 
default. These Present Injection and New Injection fields are both calculated based on the 
present injection of the given element with the New Injection value also being dependent on 
the Injection Change value. The Present Injection and New Injection values will be updated 
any time that the present injection for an element changes in the power system. This is 
important to keep in mind if making any changes to the power flow case while the Line 
Loading Replicator dialog is open. 

Injection changes are calculated so that generator and load limits are enforced. Which load 
limits are used is determined in the Max and Min Load Limits for Injection Changes 
option settings. The generator limits used are the minimum and maximum limits defined 
with each generator. These limits can be accessed from the Generator Case Information 
Display. The load and generator limits can also be displayed in the Injection Changes table 
by adding the Min MW and Max MW fields to the table.  

Total Injection Increase/Decrease 

This value is the amount of injection increase and decrease required to meet the Flow 
Achieved. The net injection will be zero. 

Flow Achieved 

Flow amount that can be achieved by implementing the Injection Changes listed. This value 
will differ from the Desired Flow if there are not enough injection changes available to meet 
the Desired Flow. 

Implement Injection Changes 

Click this button to make changes to the power flow case to match the calculated Injection 
Changes. Automatic generation control (AGC) and phase shifter control are disabled for the 
entire case when choosing to implement changes. 

Implement Injection Changes and Solve Power Flow 

Click this button to make changes to the power flow case to match the calculated Injection 
Changes and then solve the power flow. The power flow is solved with the settings that are 
specified in the Power Flow Solution Options specified with Simulator Options. When 
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choosing to implement changes, these options are updated so that automatic generation 
control (AGC) and phase shifter control are disabled globally for the case. The Present Flow 
value is updated after the completion of the power flow solution.  
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Dynamic Formatting Overview 

  

The Dynamic Formatting dialog will allow the specification of how a graphical object will be 
rendered depending on the power system object that is representing. The graphical object 
refers to objects in the oneline diagram, in bus and substation views, as well as to some 
parameters of the case information displays. 

  

The case and the one-line diagrams will have each a list of Dynamic Formatting settings. The 
Dynamic Formatting settings defined in the case are always applied to bus and substation 
views, and optionally they can be applied to the case information displays. The one line 
diagrams will use its own settings, but optionally can use the general settings defined with the 
case.  

  

In general, the oneline dynamic formatting settings have a higher priority, followed by the 
case dynamic formatting settings, and this can't be reversed. Also, inside each of the list of 
dynamic formatting settings, a priority can be specified, so that objects can be rendered 
according to the settings with the highest priority. 

  

In the case of the oneline diagrams, the dynamic formatting settings will only be applied 
during Run Mode. However, these settings can be modified at any time, without regard for the 
mode. 
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Dynamic Formatting Dialog 

  

The Dynamic Formatting dialog for the active oneline can be accessed by: 

• Selecting Dynamic Formatting > Active Oneline on the General Options ribbon 
group of the Options ribbon tab. These General Options are also available on the Oneline 
ribbon tab. 

• Selecting Dynamic Formatting (Active Oneline) from the oneline local menu, or 

The Dynamic Formatting dialog for the general case information displays, bus and substation 
views, and for all onelines can be accessed by: 

• Selecting Dynamic Formatting > Case Info / All Views And Onelines on the 
General Options ribbon group of the Options ribbon tab. These General Options are also 
available on the Oneline ribbon tab. 

• Selecting Dynamic Formatting (All Views) from the bus view local menu or the  
substation view local menu, or 

This dialog presents the following options: 

Set Format Priority 

It is possible to have multiple dynamic format definitions created and stored with a case 
and/or active oneline diagram. This option allows you to set a format priority order for all of 
the dynamic format definitions, so that any diagram objects that meet more than one 
dynamic filter will use the settings of the dynamic filter with the highest set priority. 

Allow Oneline to use dynamic formatting defined with case 

This option will only be available when the dynamic formatting settings correspond to an 
active oneline. It indicates whether or not the oneline diagram will use the dynamic 
formatting definitions specified in the case. 

Object Type 

The type of power system object with graphical representation, such as a bus, a load, a 
generator, etc. 

Filter Criteria 

The filter that applies to the object type defined. The Dynamic Formatting settings will apply 
to the graphical object only if the corresponding power system object meets the specified 
filter. If the criteria box is empty, the Dynamic Formatting settings will assume that all the 
objects of the specified type meet the criteria. 

Formatting Active 

If this option is unchecked, the dynamic formatting definition will be ignored when the 
objects are rendered. Otherwise, it will be applied if there are graphical objects whose 
characteristics match the rest of the characteristics defined in this dialog. 

Force visibility 

When this option is checked, the objects will be displayed (assuming the dynamic formatting 
applies to them) independently of the visibility of the layer to which such objects belong, 
and with no regards of the low and high zoom levels. 

Show Lookup Tables 

Checking this box will display the Use Lookup options with the characteristic settings. The 
Use Lookup option with certain field characteristics allow you to define a table of different 
field values and corresponding characteristic values. If you check Show Lookup tables, and 
then check the Use Lookup field next to one of the characteristics, you will open the Lookup 
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definition table. This table allows you to select a field for the Object Type you have selected. 
This field is the field that you define values for in the left column of the lookup table. To 
insert entries in the lookup table, right-click in the table grid and choose Insert from the 
popup menu. This will place a default record in the table. Modify the Field Value that 
Simulator should look for in the table, and a corresponding Characteristic Value that should 
be used for the field value given. For example, you could use a lookup table with Line 
Thickness for transmission line objects, where the thickness of the line would vary based on 
the amount of flow on the line. Different thicknesses could be assigned to different levels of 
flow using a lookup table. 

Context 

In the Context Objects, the user will specify what specific type of graphical objects the 
dynamic formatting will apply to. This list view will be populated with the Case Information 
Display object (if the dynamic formatting definitions set correspond to the general case), 
plus the several graphical objects related to the Object Type. (For buses, for example, it will 
include the graphical bus, the bus fields, and the bus gauge). 

Fields 

In the Fields list view, the user will be able to select which fields the dynamic formatting 
settings will apply to. This view will be populated only for those context objects with fields, 
such as the Case Information Display and the Object Fields. This list is only visible when you 
choose certain types of context objects in the context objects list. 

Show Only Commonly Used Fields 

If this option is checked, only a reduced list of selected fields will be displayed. Otherwise, 
all the fields belonging to the object will be shown. 

Characteristics 

The characteristics that the user will be allowed to modify dynamically. These include line 
thickness, style, color, and background color; font name, size, color, and style; highlight 
color; surround shape, color and thickness; color and magnification of the ‘X’ on top of the 
objects; and blinking color and interval. 
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Difference Flows 

  

The Difference Flows feature provides an easy mechanism for comparing two power system 
cases. For example, Difference Flows can be used to show the difference in transmission line 
flows and bus voltages resulting from a contingency or a change in power transfer between 
two areas. 

The Difference Flows Dialog can be accessed by: 
• Go to the Tools ribbon tab, and choose Difference Flows > Difference Flows from the 

Run Mode ribbon group. This is only available in Run Mode. 
• Selecting Difference Flows from the oneline local menu in Run Mode. 

Use of this feature affects all aspects of the Simulator environment. When using the Difference 
Flows tool, information shown on oneline diagrams, case information displays, and power flow 
lists is governed by which of the three Difference Flow Case Types (base, current or 
difference) is currently being displayed. 

All Difference Flows Actions are controlled via the Difference Flows Dialog or the drop-down 
list on the Difference Flows toolbar button. 
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Difference Flows: Case Types 

  

When using the Difference Flows tool, information shown on oneline diagrams, case 
information displays, and power flow lists is governed by which of the three case types is 
currently being displayed.  

The case types available are: 
• Base Case – A solved power system that serves as the reference for the difference flows 

tool. To establish a base case, set up a solved power system corresponding to the desired 
operating point. Open the Difference Flows Dialog and click the button labeled Set 
Present as Base Case. 

• Present Case – The operating point used in the Difference Flows comparison. Note: The 
Present Case must have the same numbering scheme as the Base Case for proper 
operation of the Difference Flows tool. See Topological Differences for more information. 

• Difference Case – The difference between the Present Case and the Base Case values. 
The values displayed in the Difference Case are established using the Base Case as the 
reference. 

To toggle between the different case views, open the Difference Flows Dialog and select the 
desired case type. Alternatively, you can click the Difference Flows button in the Run Mode 
ribbon group on the Tools ribbon tab and select the desired case type. 
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Difference Flows Dialog 

  

To display the Difference Flows dialog: 
• Go to the Tools ribbon tab, and choose Difference Flows > Difference Flows from the 

Run Mode ribbon group. This is only available in Run Mode. 
• Select Difference Flows from the oneline local menu in Run Mode. 
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Using Difference Flows 

  

To use the Difference Flows tool: 
• Set up a solved power system corresponding to a desired operating point. This operating 

point will be defined as the Base Case.  
• Select Difference Flows from the Run Mode ribbon group on the Tools ribbon tab, or 

select Difference Flows from the oneline local menu in Run Mode. 
• On the Difference Flows Dialog, click the button labeled Set Present as Base Case. 

This stores the current operating point as the Base Case. 

 
• Define the operating point (Present Case) for which to perform the difference flows 

comparison. The Present Case may be developed either by modifying the Base Case as 
desired and re-solving, or by opening a new case selecting  Open Case from the 
Application Button. In the latter situation, the new case that you open must have the 
same bus numbering scheme as the Base Case.  

• See Difference Flow Case Types for information on toggling between case views. The 
currently displayed case type is shown in the PowerWorld Simulator Status Bar. When 
viewing either the Base Case or Difference Case, the corresponding status bar display will 
be highlighted. 

 
Note that the Difference Flows tool can only be used in Run Mode and the status bar will not 
display a case type while in Edit Mode. 
  

When showing the Difference Case, most of the fields shown on the onelines and case 
information displays show the difference between the present value and its Base Case value. 
For example, on the Generator Records Display, an entry of 0.0 in the MW field indicates that 
the real power output of the generator did not change. An entry of 10.0 in the MW field 
indicates that the present real power output of the generator is 10 MW greater than it was in 
the Base Case.  

At any time during a simulation, you can set the present case as the Base Case by clicking the 
corresponding button on the Difference Flows Dialog. 

 Conversely, if you have made changes to the present case, and you wish to revert to some or 
all of the base case values, you can click on the Reset Case… button. When you click this 
button, the dialog will expand to show you options for resetting specific types of values to 
their base case values.  
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Expanded Difference Flows Dialog 

  

Once you have indicated which types of values you want to reset (by default, all are selected), 
you can click on the Reset Present Case to Base Case Values button to complete the 
process of reverting to base case values. Note: once you have finished resetting to the base 
case values, you can hide the Reset options by clicking the Hide Reset Button in the upper 
right hand corner of the Reset options panel. 

The oneline diagrams and case information displays cannot indicate structural differences in 
the case very well, such as the addition or removal of a device. To identify such differences, 
make use of the Present Topological Differences from Base Case tool to identify topology 
differences. 
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Present Topological Differences from Base Case 

  

The Present Topological Differences from Base Case option provides the users a way to 
compare the topological differences between two difference cases in Simulator. 

To compare two cases topologically, you must load the first case you wish to use as the 
reference into Simulator. Use the Difference Flows tool to set the case as the base case in 
memory. Once the reference case has been stored as the base case, open the second or 
comparison case into Simulator. Now if you check the Tools ribbon tab, and choose 
theDifference Flows Menu on the Run Mode ribbon group, you will see the option Present 
Topological Differences from Base Case. This is only available in Run Mode. Choosing this 
option will open the dialog to display the topological differences. 

 
Topological Differences Dialog 

  

The Topological Differences Dialog contains five tabs. All but the Summary tab are 
instances of Case Information Displays and thus exhibit characteristics and 
controls similar to other displays. 

Summary 

A listing of the types of objects in the case. The first column displays the number of NEW 
devices in the comparison case that were not in the base case. Alternately, the Removed 
column displays the number of devices in the base case that do NOT exist in the comparison 
case. The third column simply displays the number of items that were matched between the 
two cases. 
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Elements Added 

Tabular listings of all objects that exist in the comparison case, but not in the reference 
case. 

Elements Removed 

Tabular listings of all objects that exist in the reference case, but are not present in the 
comparison case. 

Elements in Both 

Tabular listings of all objects present in both cases. 

Create Bus Swap List 

Used for setting up a bus renumbering list. It is possible that discrepancies in topology 
between the comparison case and the reference case can be due to a difference in bus 
numbering between the two cases. Renumbering the buses in the comparison case may 
take care of most of the topology discrepancies that are reported in this instance. 
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Governor Power Flow 

  

The Governor Power Flow dialog shows all information related to solving a governor power 
flow. The dialog is accessed by selecting Other > Governor Power Flow from the Other 
Tools ribbon group on the Tools ribbon tab. Using this dialog, you can modify settings related 
to solving the case while on Governor or "Island-Based Automatic Generation Control (AGC)". 

The Governor Power Flow Dialog has two tabs: Options and Generator Options 
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Governor Power Flow: Generator Options (Ignore Area/Zone/Owner filter) Tab 

This tab sheet presents a case information display with all the generators of the case. The 
columns shown in the display are helpful when looking at solving a Governor Power Flow. 
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Governor Power Flow: Options Tab 

  

This section describes the options available on the Options tab of the Governor Power Flow 
dialog. The dialog is accessed by selecting Other > Governor Power Flow from the Other 
Tools ribbon group on the Tools ribbon tab.  
This tab sheet presents the following controls: 

Disable Automatic Generation Control 

Disables automatic MW generation changes during the power flow solution. 

Island AGC Tolerance 

The ACE mismatch tolerance allowed for the Island to be considered solved in terms of 
generation dispatch. 

Island-Based Automatic Generation Control 

Select how the generations should be controlled for the dispatch. 

• Disabled: The area and super area dispatch settings from the case will be used 
• Use Participation Factors of individual generators: Each generator will have it’s own 

participation factor, and will contribute according to its participation factor divided by 
the sum of all participation factors of all other generators in the same island. 

• Calculate Participation Factors from Area Make Up Power Values: Each area is assigned 
a "factor" as to how it should participate towards the generation dispatch in the island. 
This is similar to participation factors for generators. The total percentage the area 
contributes towards the generation change needed in the island is equal to its individual 
factor divided by the sum of all area make up power factors. Then within each area, the 
generator participation factors determine how the area’s percentage is made up of 
available generation within the area. The area make up power values can be set in the 
table of areas on the right hand side of the dialog. 

• Dispatch using an Injection Group: The island dispatch will be made up by a 
combination of generators and loads, defined in an injection group that can be selected 
from the dropdown list. 

How should reactive power load change as real power load is ramped? 

If you are using an injection group with load as part of the dispatch, then you can specify 
how the reactive power load should respond as the real power demand of loads changes 
with the dispatch. The reactive power can either be kept at the starting ratio of real and 
reactive power of the load, or the MVAR amount can change at each load by a specified 
power factor. 
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Contingency Analysis: An Introduction 

  

Contingency analysis is a vitally important part of any power system analysis effort. Industry 
planners and operators must analyze power systems covering scenarios such as the long-term 
effects on the transmission system of both new generation facilities and projected growth in 
load. Market analysts and planners must make informed decisions regarding transactions for 
energy trade - whether that trade is for the next hour or months down the road. PowerWorld 
Simulator’s Contingency Analysis tools provide the ability not only to analyze a power system 
in its base case topology, but also to analyze the system that results from any statistically 
likely contingent scenario.  

Industry planning and operating criteria often refer to the n-1 rule, which holds that a system 
must operate in a stable and secure manner following any single transmission or generation 
outage. In PowerWorld Simulator, the individual contingency conditions can also be tailored to 
consist of either a single element (such as the loss of a transmission line or transformer), or 
multiple elements (such as the loss of a generator, several buses and a number of branches 
simultaneously). See Available Contingency Actions for a complete list of possible contingency 
actions.  

Simulator can be set to use a Full Newton solution or use a DC Load Flow method to analyze 
each contingency. The Full Newton approach is not as fast as a DC Load Flow, but the results 
tend to be significantly more accurate and allow for gauging voltage/var effects. 

The Tutorial is a great place to start learning about using Simulator’s Contingency Analysis 
Tool. We also recommend reviewing the Terminology used throughout the Contingency 
Analysis help files prior to continuing. 
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Available Contingency Actions 

  

The current edition of Simulator can process lists of contingencies including the following: 

For Transmission Lines and Transformers (Branches) 
• The opening or closing of transmission lines and transformers 

For individual Generators, Loads, or Switched Shunts 
• Loss or recovery of a particular generator, load, or switched shunt 

For all the Generation, Load, or Switched Shunt at a particular bus 
• Movement of generation, load, or switched shunt MWs or Mvars to another terminal bus 
• Changing or setting of load, switched shunt, or generator MWs or Mvars 
• Change or setting of a generator or switched shunt voltage setpoint 

For Buses 
• Opening of all lines connected to a bus 

For Interfaces 
• Opening or closing of all lines or transformers in an interface 

For Injection Groups 
• Opening, closing, or changing of output of all devices in an injection group 
• Setting or Changing the net MW Injection by a Percent or MW value and by proportion or 

by merit order 

Series Capacitors 
• Bypassing or placing series capacitors in service 
• Setting of the Series Reactance by percent or to a particular per unit value 

Phase-Shifting Transformers 
• Changing or setting the Phase-Shifter Regulation MW value 

DC Transmission Lines 
• Opening or closing DC Lines 
• Changing DC Line setpoint MW or Amp values 

Three-Winding Transformers 
• Opening or closing all legs of three winding transformers 

Solving the Power Flow 

Contingency Block 
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Contingency Analysis: Terms 

  

Contingency – Contingencies are the basis of the Contingency Analysis tool. A single 
contingency can contain a single contingency element (referred to as n-1 contingencies) or 
multiple contingency elements. 

Contingency Action - A statistically likely condition that could occur during power system 
operation. See Available Contingency Actions for a listing of actions supported by Simulator. 

Model Criteria – Criteria under which a contingency action will occur. For example, the user 
can specify that a generation outage only occur if the pre-contingency flow on a line is higher 
than a specified amount. Simulator allows you to define Model Criteria, which consist of both 
Model Conditions and Model Filters. Normally, no Model Criteria will be specified for a given 
action. 

Contingency Element – Consists of a single Contingency Action and its associated Model 
Criteria, Status and Comment (optional). Multiple Contingency Elements can be defined for a 
single Contingency. 

Contingency Definition – A listing of the Contingency Elements assigned to a Contingency. 

Global Action – A Global Action is a list of contingency elements that occur for ALL 
contingencies. The elements included in a Global Action do not have to be entered as 
individual elements in each contingency. 

Contingency Block – A list of Contingency Actions. A Contingency Block can be applied to 
individual Contingencies by including the block as a Contingency Element. 
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Contingency Solution Options Dialog 

  

By default, the contingency analysis will use the same options as the power flow algorithm 
when solving each contingency. You may also override these options for all contingencies, 
and/or for a specific contingency. This results in the ability to set the power flow solution 
options in contingency analysis at three different levels 
1. Contingency Specific Options (see Contingency Definition Dialog) 
2. Contingency Analysis Options (see Contingency Options Tab) 
3. General Power Flow Solution Options (see Power Flow Solution Options) 

When Simulator executes a particular contingency, it will first look at options specified for that 
contingency. Any options which are defined for this contingency will be used. Other options 
set as Use Default will look to the Contingency Analysis Options. Again, any options which are 
defined for contingency analysis will be used. Finally, options marked in the Contingency 
Analysis Options as Use Default will be set to the same setting as the power flow solution 
options. 

In order to specify options for a specific contingency, you click on the Define/Modify 
Solution Options button on the Contingency Definition Dialog. In order to specify options for 
all contingencies, you click on the Define/Modify Solution Options button on the 
Contingency Options Tab. Both of these will bring up the Contingency Solution Options Dialog. 

This dialog contains many options regarding the power flow solution. For options which are a 
numerical value, just specify a new value to use. For options which are specified by a check-
box, the check-box will have three settings: use option, do no use option, and use default. For 
a more detailed explanation of each option see the Power Flow Solution Options. 

To set the values to be the same as the present power flow solution options, click the Set 
same as for Power Flow button. To set all options back to use default, click the Clear All 
Settings button. 

 



Run Mode Tools and Options 

735 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Contingency Case References 

  

Contingency Analysis always stores a Reference State or pre-contingency state. The Reference 
State stores information pertaining to: 
• Buses 
• Switched Shunts 
• Limit Groups 
• Loads 
• Branches 
• Generators 
• Areas / Super Areas 
• MW Transactions 
• Power Flow Solution Options 

See Reference State Information for details on the specific information stored. 

The reference state is loaded into memory prior to the execution of each contingency during 
automatic processing of the contingency list. This ensures that all contingencies start from a 
common Base Case. Furthermore, the system is set back to the reference state following 
completion of the automatic processing. Note: The system is not restored to the reference 
state when the Solve Selected Contingency option is selected from the Contingency Record 
Display’s local menu (see Reference State Solution Options for more information). 

The reference state is always stored in Simulator after the first instance of opening the 
contingency analysis form. Therefore, opening the contingency analysis again may result in a 
prompt from the program. This prompt will ask you if you wish to set the contingency analysis 
reference state to the current state of the system (in case you have made changes since the 
last contingency analysis run), or if you wish to keep the existing contingency analysis 
reference state (which was set by previously opening the contingency analysis dialog.) Note 
that if you choose the second option, any changes you may have made to the case outside of 
the contingency analysis will be lost, as the reference state stored with the contingency 
analysis tool will reset the system state to the reference state. 

Click here for information on defining the reference state. 
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Contingency Case References - State Information 

  

Simulator stores the following information with the Contingency Analysis Reference State: 

Bus State 

• In or out of service 
• Voltage Magnitude and angle 
• Boolean expression stating whether any load exists at the bus (this is used because some 

of the contingency actions such as MOVE GEN will create a fictitious load if there is no 
generation at the destination bus) 

• MW Marginal Cost 

Switched Shunt State 

• In or out of service 
• Nom value Mvar 
• Control mode (FIXED/DISCRETE/CONTINUOUS) 
• Nom Value MW 
• All Setpoint Values 
• Description of Blocks 
• Low/high range for voltage control 

Limit Group State 

• Rating sets for normal operation (Line, Interface…A, B, etc…) 

Load State 

• In or out of service 
• Constant power MW and Mvar components of load 
• Constant current MW and Mvar components assuming one per unit voltage 
• Constant impedance MW and Mvar components assuming one per unit voltage 
• MW Scale 
• Mvar Scale 
• AGC Status 
• Min/Max Load MW 

Line State 

• In or out of service 
• Bypassed? 
• Transformer Control? 
• Tap ratio 
• Phase shift 
• High/low desired setpoints 
• Series Reactance X (only for series capacitors because a contingency element can change 

this) 

DC Line State (& Multi-Terminal DC Line State) 

Generator State 

• In or out of service 
• MW Output 
• Mvar Output 
• Max/Min MW Output 
• Participation Factor 
• Max/Min Mvar Output 
• Voltage Setpoint 



Run Mode Tools and Options 

737 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

• AGC Status (YES/NO) 
• AVR Status (YES/NO) 
• Capability Curve 
• Use Capability Curve? 
• Line Drop Compensation Impedance 
• Line Drop Compensation Status (YES/NO/POSTCTG) 

Area State and Super Area State 

• Unspecified MW Transactions 
• MW Scale 
• Mvar Scale 
• AGC Status 
• Use Area Participation Factors? (for Super Area) 

MW Transaction 

• MW Value 
• Enabled Status 

Power Flow Solution Options 
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Contingency Case References - Defining the Reference State 

  

The reference state is initially defined as the power system state that exists when the 
contingency analysis is opened for the first time for a given power flow case during a 
Simulator session. See Reference State Information for details on the specific information 
stored in the reference state. 

 
Setting the reference state 

The reference state can be changed each time that the Contingency Analysis Dialog is opened 
after having already established a reference state. The Setting Reference State When 
Contingency Analysis is Opened option is available for determining how the reference state 
should be set when the dialog is re-opened during a Simulator session. 

To change the reference while the Contingency Analysis Dialog is open, select the Set as 
Reference option from the Other > button on the Contingencies Tab of the Contingency 
Analysis Dialog. The reference state can also be redefined using the Solve and Set as 
Reference option from the Contingency Record Display’s local menu (See Reference State 
Solution Options for more information). 
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Contingency Case References - Reference State Solution Options 

  

 
Contingency Record Display Local Menu 

When you solve contingencies one at a time, you may choose between the Solve Selected 
Contingency and Solve and Set As Reference options from the Contingency Record 
Display's  local menu.  

Solve Selected Contingency causes Simulator to first load the reference state into memory 
then solve the contingency. Following the solution, the reference state is not restored; the 
system state then reflects the power system flows of the post-contingency state. The 
advantage of this approach is the ability to implement a contingency and then modify the 
system looking for possible actions that might mitigate violations caused by the contingency. 
Be aware; however, that prior to solving another contingency, Simulator will reset the system 
state to reference state thereby removing all modifications made following the previous 
contingency solution. The user may also automatically restore the system state to reference 
state by selecting Other > Restore Reference from the Contingency Analysis Dialog. 

Solve and Set As Reference acts the same as Solve Selected Contingency with one 
exception. After executing the contingency, the post-contingency state is automatically set as 
the reference state. As a result, all subsequent contingencies will use the post-contingent state 
as the Reference State. 

Click here for details on the specific information stored in the reference state. 

Click here for information on defining the reference state. 

 



Run Mode Tools and Options 
 

740 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Contingency Analysis: Defining Contingencies 

  

There are four options for defining contingencies. The user may: Load Contingencies from a 
File, Auto Insert Contingencies, or use the local menu to either Insert contingencies or Quick 
Insert a Single Element Contingency. 
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Auto Insert Contingencies 

  

Simulator allows you to automatically generate a contingency list containing branch, generator 
and/or bus outages. To accomplish this, click the Auto Insert button along the bottom of the 
Contingency Analysis Dialog or right-click on the list of contingencies table in the 
Contingencies Tab and select Insert Special > Auto Insert Contingencies…. This opens 
the Auto Insertion of Contingencies Dialog (shown below). 

When automatically inserting contingencies, you must specify the type, options and naming 
conventions you want for the new contingencies. You must also specify whether to delete or 
retain existing contingencies. 
  

 
  

Auto Insertion of Contingencies Dialog 

  

The Auto Insertion of Contingencies Dialog has the following controls: 

Do Insert Contingencies 

Press the Do Insert Contingencies button to generate the contingency list once all other 
options have been set. 

Automatically generate contingency involving a… 

The options available in this box define what to add to each automatically inserted 
contingency element. You can choose single transmission line, transformer, transmission line 
or transformer, generating unit, or bus contingencies. Choosing one of these options results 
in each contingency containing only one element of the specific type.  

You can also define contingencies containing multiple outages by checking the 
Combination of… option, and then specifying how many of each type of element (Lines, 
Transformers, and Generating Units) you want considered in the contingency. When you use 
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the Combination of… option, Simulator will automatically determine all possible 
combinations for the element types specified (based on the settings in Options) and create 
the contingencies. Combination contingencies do not currently allow the inclusion of bus 
contingencies. 

Options 

When Simulator auto-generates the contingency records for the element types specified, the 
options in this section will further determine which elements are included and which 
elements are ignored. 

Delete Existing Contingencies 

When checked, any previously existing contingency records will be deleted before any 
automatically created contingencies are inserted. 

Use Area/Zone Filters 
When checked, the elements included in the auto-generated contingencies will be only 
elements that are within areas and zones defined in the Area/Zone/Owner Filters dialog. 
You may edit the Area/Zone/Owner filters by clicking on the Edit Area/Zone Filters 
button. 

Only include … meeting an advanced filter 

When checked, the branches, generators, or buses included in the auto-generated 
contingencies will be only those elements meeting conditions outlined by an advanced 
filter. To set the conditions to be used, click the respective Define… Filter button. 

Only include elements within X buses of bus 

When checked, only elements that are electrically within X number of buses from the 
specified bus will be included when creating the contingencies. For example, consider 
bus 1 is electrically connected to bus 2, which is in turn connected to bus 3. If we specify 
the bus to be bus 1, and choose to include only elements that are within 0 buses of bus 
1, then the contingency record will include the branch between buses 1 and 2, and if 
desired any generators attached to bus 1. However, the branch between buses 2 and 3 
and any devices attached to bus 2 and 3 will NOT be included in the contingency 
because bus 2 is electrically 1 bus away from bus 1. 

To specify the bus used, you can find the bus by using the search engine. The search 
engine allows you to search by name or number. If you know the bus number, choose 
Sort by Number, and type the bus number in the search box. If you know the name of 
the bus, choose Sort by Name, and type the name of the bus in the search box. If you 
are not sure of the name of the bus, you can use wildcard characters to search through 
the list of buses until you find the desired bus. 

How to name the contingencies 

This section allows you to define how each automatically inserted contingency record will be 
named. 

Identify … using prefix 
These four fields allow you to set a specific prefix for generators, lines, transformers and 
buses so that you can easily determine what type or types of contingencies are modeled 
in the auto-generated contingency records. By default, the prefixes are G for generators, 
L for lines, T for transformers and B for buses. However, you can change these prefixes 
to any character or set of characters you wish. 

Identify buses by 
This field allows you to specify whether each contingency is labeled using the bus 
numbers, bus names, or both as identifiers. Whichever type of identifier you choose here 
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will be combined with the defined prefixes to uniquely define the individual contingency 
elements within each auto-generated contingency record. 

Include Nominal Voltages 

When this check box is checked, the nominal voltage of buses will be included in 
contingency labels.  
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Loading Contingencies from a File 

  

Simulator can load contingency definitions from a text file. The contingencies may be specified 
in one of three formats: 
• Simulator Auxiliary File Format (*.aux) (also see Contingency Subdata) 
• Simulator Version 5-7 Contingency File Format (*.ctg) (see the old users manual, or 

contact PowerWorld Corporation) 
• PTI PSS/E-formatted Contingency Files (*.con). 

To load contingencies from a text file, click the Load button along the bottom of the 
contingency analysis dialog. A dialog box will be provided for you to specify the file from which 
to load the contingency records. Specify the file type in the Files of Type dropdown box, and 
select the appropriate file. If contingency records have already been defined for the case with 
which you are working, you will be asked if you wish to delete the existing contingencies. 
Respond affirmatively to delete the existing contingencies before adding the new ones from 
the specified files. Otherwise, click No, and the contingencies loaded from the file will be 
appended to the already existing list. 

Simulator is also capable of loading bus throw over data from PTI PSS/E-formatted load throw 
over files. 
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PSS/E Contingency Format 

  

Simulator can read and write parts of the contingency format used by Power Technology’s 
PSS/E. The current version of Simulator does support all parts of this format, except it does 
not recognize PTI’s Automatic Contingency Specification flags. If you need Simulator to 
support these keywords, contact PowerWorld Corporation to express your need. Otherwise, 
we recommend you make use of Simulator’s Auto-Contingency creation tool. 

 



Run Mode Tools and Options 
 

746 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

PSS/E Load Throw Over Files 

  

Simulator can read load throw over settings used by Power Technology’s PSS/E. These files 
typically have the extension of *.thr or *.dat. Note, however, that any modifications made to 
load throw over settings cannot be saved back to the PSS/E throw over file (only read access 
is currently available). 
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Saving Contingency Records to a File 

  

Simulator can save contingency definitions to a text file. To save contingencies: 
• Click the Save button on the contingency analysis dialog 
• Select Save As… from the local menu of the contingency records display (only useful for 

saving to Simulator’s Auxiliary File Format). 
• Click the Save to Aux button on the Auto Insertion of Contingencies Dialog. 

The contingencies may be specified in one of three formats 
• Simulator Auxiliary File Format (*.aux) (also see Contingency Subdata) 
• Simulator Version 5-7 Contingency File Format (*.ctg) (see the old users manual, or 

contact PowerWorld Corporation) 
• PTI PSS/E-formatted Contingency Files (*.con).  

To specify the format for the contingency file, set the Save As Type option accordingly. 

Note that there are limitations when saving to the Simulator Version 5-7 format or the PTI 
PSS/E formatted files.  

Limitations on the Simulator Version 5-7 format 

• Does not support the actions SET or CHANGE.  
• Does not support the action MOVE, except for Loads. 
• Does not support any actions regarding an Interface 
• Does not support any actions regarding a Bus 

Limitations on the PTI PSS/E format 

• Does not support any actions regarding an Interface 
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Global Actions 

  

Global actions allow you to define a list of contingency elements that occur for ALL 
contingencies and do not have to be entered as individual elements in each contingency. 
These contingency elements are defined and processed in the same manner as contingency 
elements defined with specific contingencies.  

Global actions are defined by clicking the Contingency Blocks and Global Actions button 
on the Advanced Modeling tab of the Options page of the Contingency Analysis dialog. Click on 
the Global Actions tab of the Contingency Blocks and Global Actions dialog to define Global 
Actions. Adding global actions occurs in a manner identical to that of the Contingency 
Definition Dialog. Right-click in the Actions list to open the Contingency Element Dialog, which 
allows you to add contingency elements to be treated as Global actions. 

The format of the string that describes the actions and the Model Criteria and Status fields 
are set in the same manner as described in the Contingency Definition Display. 

To disable the use of the Global Actions, check the Do Not Use Global Action List option.  

 

 



Run Mode Tools and Options 

749 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Contingency Blocks 

  

Contingency Blocks are very similar to a Contingency Record, however no results can be 
associated with them. Contingency Blocks consist of a list of contingency actions. The block is 
then given a name so that any Contingency Record can call on a Contingency Block. When a 
contingency block is included as part of a contingency, the Contingency Record will 
incorporate all the actions from the contingency block into the actions performed by the 
contingency.  

Contingency blocks are defined by clicking the Contingency Blocks and Global Actions 
button on Advanced Modeling tab on the Options page of the Contingency Analysis Dialog. 
Click on the Contingency Blocks tab of the Contingency Blocks and Global Actions dialog to 
show a display for defining Contingency Blocks. Right-clicking in the Contingency Blocks grid 
and choosing Insert allows you to insert a new Contingency Block. A dialog very similar to the 
Contingency Definition Dialog will open. Use this dialog to insert elements into the contingency 
block, create additional contingency blocks, or modify existing contingency blocks. Once a new 
contingency block has been created, actions can be added to the block by right-clicking in the 
Contingency Definition grid and choosing Insert. This will open the Contingency Element 
Dialog that allows the addition and modification of elements in the contingency block. When 
using the Contingency Element Dialog with Contingency Blocks, the option to insert an 
Element Type of Contingency Block is not available.  

The format of the string that describes the contingency block actions and the Model Criteria 
and Status fields are set in the same manner as described in the Contingency Definition 
Display.  

To disable the use of a Contingency Block, set the Skip field to YES. When a Contingency 
Block is disabled, all of the actions defined in the block will be ignored in all of the 
contingencies in which the block is included.  
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Once Contingency Blocks have been defined, a new Element Type, Contingency Block will 
appear on the Contingency Element Dialog. This is shown in the image below. You may then 
add a contingency block to a contingency by right-clicking on a contingency in the Contingency 
Records list display, choose show dialog (or insert if you are adding a new contingency 
record), click on Insert New Element, and choose Contingency Block from the list of element 
types. 
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Using a contingency block is an easy way to include a set of common actions in multiple 
contingency scenarios, without having to re-define the actions for each contingency. 
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Contingency Analysis Dialog Overview 

  

Simulator’s contingency analysis tools can be accessed only from Run Mode. To access this 
dialog go to the Tools ribbon tab, and choose Contingency Analysis from the Run Mode 
ribbon group. This will open the Contingency Analysis Dialog.  

Each tab of the contingency analysis dialog covers a particular aspect of the analysis.  

The Contingencies Tab is used primarily to manage the contingency list and to learn basic 
information regarding each contingency and the violations that it causes.  

The Lines, Buses, Interfaces Tab is similar to the Contingencies Tab. The Contingencies Tab 
lists each contingency and shows which power system element violations occur under each 
contingency. The Lines, Buses, Interfaces Tab lists each power system element and shows 
which contingencies cause violations on those elements. 

The Options Tab enables you to dictate various parameters for the analysis that govern such 
things as how violations are flagged in both the Base Case and for contingency conditions and 
what information should be included in the contingency report.  

The Summary Tab chronicles the performance of the contingency analysis 

The bottom panel of the dialog houses a row of buttons whose function at any given time 
depends on which of the four tabs is visible. The bottom panel also houses a text status 
indicator to keep you abreast of the current state of the analysis. 
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Running the Contingency Analysis 

  

To run the contingency analysis means to model and solve one or more contingencies from 
the case’s current contingency list. Simulator’s Contingency Analysis Dialog gives you several 
options for running the contingency analysis. You may 
• Run every contingency in the contingency list (except, of course, for those you have 

designated to skip using the Contingency Records Display). 
• Run a selected contingency to identify its limit violations and then leave the system in this 

post-contingency state. (Realize that prior to solving another contingency, Simulator will 
reset the system state to the reference state. For more information see Contingency Case 
References). 

• Run a selected contingency to identify its limit violations and keep the resulting case as 
the new reference point for further contingency analysis runs. 

To run the complete contingency list, do any one of the following: 
• Right-click on the Contingency Records Display to bring up its local menu and select Run 

Contingency Analysis. 
• Click the Start Run button visible from the Contingency Tab. 
• Click the Start button visible from the Summary Tab. 

To pause the contingency run once it has started, click either Pause Run on the Contingency 
Tab or Pause on the Summary Tab. To resume a paused contingency run, click the Continue 
buttons on either the Contingency Tab or the Summary Tab. Finally, to terminate a 
contingency run, click the Abort button on the Summary Tab. The status indicator will inform 
you of the run’s current state. 

To solve a single contingency, identify its violations, and then leave the system in this post-
contingency, select the contingency you wish to model in the Contingency Records Display, 
right-click to invoke the display’s local menu, and select Solve Selected Contingency. 
(Realize that prior to solving another contingency, Simulator will reset the system state to the 
reference state). 

To solve a single contingency and set it as the reference (starting) case for further 
contingency analysis activity, select the contingency you wish to model in the Contingency 
Records Display, right-click to invoke the display’s local menu, and select Solve and Set As 
Reference. Simulator will model the selected contingency, flag its violations, and leave the 
resulting case in memory so your future work will affect the post-contingency system rather 
than the original pre-contingency state. See Contingency Case References for more 
information. 
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Other Contingency Actions 

  

By clicking the Other > button on either the Contingency Tab or the Lines, Buses, Interfaces 
Tab of the Contingency Analysis Dialog, you have access to several actions. 

Delete All Contingencies 

Click this to delete all the contingencies presently stored in memory. 

Clear All Contingency Results 

Click this to clear all the results of the contingencies from memory. This will not delete the 
contingencies. 

Set As Reference 

Click this to set the case presently in memory as the Reference State for contingency 
analysis. For more information on the reference state, see Contingency Case References. 

Restore Reference 

Click this to set the state of the present power system case back to the contingency analysis 
reference state. For more information on the reference state, see Contingency Case 
References. 

Combined Tables 

Contingency Violation Matrices 

Clicking Process Contingency Results will go through the existing contingency analysis 
tool results and build tables showing the limit violation values for all violated lines, 
interfaces, and buses and the contingencies for which each element is violated. Upon 
opening, it is possible to limit processing to branches, buses, and/or interfaces. Also, you 
can specify whether to display percentages or actual flows in the resulting tables. 

Contingency Violation List 

Contingency Violation List lists all violations from the current contingency set in a tabular 
format. This lists eliminates possible clutter by not listing those contingencies for which 
there are no violations. 

Tables 

You can export the following tables to either an Excel spreadsheet or the clipboard. 

Contingency Violation Table 
Choose this option to create a table containing every violation found. The table will 
have the contingency name as the first column. The rest of the columns are 
determined by the columns presently being displayed in the Contingency Violations 
Display on the Contingencies Tab. 

Contingency Definition Table 

Choose this option to create a table containing every contingency definition. The 
table will have the contingency name as the first column. The rest of the columns 
are determined by the columns presently being displayed in the Contingency 
Definition Display on the Contingencies Tab. 

Produce Report 

To produce a detailed report of the results of the contingency analysis, click Produce 
Report. This will launch a save window that will save the information you customized on 
the Contingency Analysis Options: Report Writing page. You will also be given the option of 
viewing the report in WordPad immediately after creating the file. 
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Compare Two Lists of Contingency Results 

Click this to open a dialog which allows you to specify two sets of contingency analysis 
results to compare. For more information on this comparison, see Comparing Contingency 
Analysis Results. 

Filter Results Using Limit Monitoring Settings 

Click this to filter the contingency analysis results using the present Limit Monitoring 
Settings. This action will go through each violation for each contingency and verify that the 
element that was violated is set to be monitored. If the element is not set to be monitored, 
then Simulator will flag the violation internally as inactive. You will then not be able to see 
these violations on any of the displays, although they will still be saved in memory until you 
delete these contingencies, or reprocess them. These violations will also not be saved when 
you choose to save the contingency results. 

Because the violations are saved in memory however, you can get them back without 
reprocessing the contingency list. To do this, change your Limit Monitoring Settings so that 
those violations will be set for monitoring again. Then click this option again. 

When using this option, keep in mind that Simulator cannot filter results that do not exist in 
memory. If the filter is to be used to filter out different percentages of overload, then the 
contingency analysis should be run with the lowest percentage desired. For example, if the 
filter option is to be used to give all of those elements that are loaded above 70% of their 
limit and then those that are loaded above 90% of their limit, the contingency analysis 
should be run with the Limit Monitoring Settings defined to monitor elements that are 
loaded at 70% of their limit. Also, keep in mind that the more elements are monitored the 
slower the processing will be.  

Auto-fill Blank Contingency Element Comments 

Selecting this option will fill the Comment field of the Contingency actions in the Contingency 
Definition table with a copy of the contingency action definition. The action description itself 
cannot be modified, but the comment can be modified to be more descriptive of the action 
being taken, for your own reference. 

Sensitivity Calculations > 

Simulator provides the PTDF tool for calculating the impact of a MW transfer on all the 
transmission lines in the system. The Simulator ATC tool further extends the linearized 
methods by integrating linearized contingency analysis with the PTDF calculations. The 
sensitivity calculations provided here are an extension of this. They allow you to ask the 
question, How will each contingency-caused branch or interface violation be 
affected by a MW transfer?. Note: this calculation is not relevant for bus violations. 

Calculate OTDFs using existing PTDFs 

Before executing this, you must first go to the PTDF Dialog and calculate the PTDFs for 
the transfer direction you are interested in. These PTDF values will then be used 
throughout the OTDF calculation. Click this to calculate OTDFs for each contingency-
caused branch or interface violation. The values calculated will be a measure of what 
percent of a transfer would appear on the branch or interface after the respective 
contingency occurs. Realize for branch violations, that the sign of the OTDF value will be 
relative to the direction of the MW flow found during the contingency analysis (see the 
Element description on the Contingency Violations Display). 

Filter out Violations Using OTDFs 
Once you have calculated the OTDFs using the existing PTDFs, you can then filter the 
results by selecting this option. A dialog will appear for you to enter a minimum OTDF 
value. All violations that have an OTDF smaller than this number will be flagged as 
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inactive and will not show up in the list of violations. See the note above regarding the 
Filter Results using Limit Monitoring Settings to better understand how inactive 
violations are treated. 
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Contingency Analysis Dialog - Contingencies Tab 

  

The Contingencies Tab of the Contingency Analysis Dialog provides tools for managing and 
simulating lists of contingencies. The top portion of the Contingencies Tab lists the 
contingency records that have been defined for the case. This table is called the Contingency 
Records Display. The contingency records display is a type of case information display and 
thus shares many of the properties and controls common to all other case information 
displays. By right-clicking on the display, you gain access to its local menu, which offers 
several choices: 
• Insert allows you to insert a new contingency record 
• Insert Special gives the following options: 

o Quick Insert of Single Element Contingency which allows you to quickly 
specify a single element contingency via the Contingency Element Dialog 

o Auto Insert Contingencies which opens up the Auto Insert Contingencies dialog 
o Merge Pairs of Selected Contingencies which generates every possible pair of 

contingencies based on the selected contingencies. For instance, if you select 4 
contingencies (A, B, C, D), then click Merge Pairs of Selected Contingencies, 6 
new contingencies will be generated: A+B, A+C, A+D, B+C, B+D, and C+D. 

o Clone Contingencies which makes copies of each selected contingency 
• Delete allows you to delete a particular contingency 
• Show Dialog displays the Contingency Definition Dialog corresponding to a particular 

contingency 
• Run Contingency Analysis  (see Running the Contingency Analysis) 
• Filter Results Using Limit Monitoring Settings (see Other Contingency Actions) 
• Solve Selected Contingency (see Contingency Case References - Reference State 

Solution Options) 
• Solve and Set as Reference  (see Contingency Case References - Reference State 

Solution Options) 
• Compare Two Lists of Contingency Results  (see Other Contingency Actions) 
• Many other options (e.g., printing, finding, and sorting) which are characteristic of case 

information displays 

You can also sort the display’s contents by any field just by clicking on the field’s heading. The 
default fields shown in the contingency records display are described at the bottom of this 
page. 

As you scroll through the records in the contingency records display, you will notice that the 
contents of the tables that occupy the middle third of the contingency analysis dialog change. 
These tables are the Contingency Definition Display and the Contingency Violations Display. 
These displays show the violations and definition for the contingency that is selected in the 
contingency records display at the top of the dialog. You may optionally hide the Contingency 
Definition Display by clicking on the X to the upper right of this display. To show the display 
again, click on the O to reopen it. You may change the relative width of the Contingency 
Definition and Violations display by moving your mouse over the line between the displays 
until your cursor changes. Then left click and drag to modify these widths. 

When you first load a new contingency list into memory, the current status indicator along the 
bottom of the display will indicate the contingencies have been Initialized. During a 
contingency analysis run, the current status indicator may take on the values Running, 
Paused, Aborted, or Finished. 

The contingency tab of the contingency analysis dialog offers several ways to run the 
contingency analysis. To start a run, you may click the Start Run button. Alternatively, you 
may choose Run Contingency Analysis from the local menu of the contingency records 
display. Once a contingency analysis run has started, you may pause it at any time by clicking 
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the Pause Run button, after which you may resume the run by clicking Continue. In 
addition to running the full set of contingencies, you may also choose to run just a single 
contingency. See Running the Contingency Analysis for more details. 

Several other actions related to contingency analysis are also available from the Contingencies 
Tab. These are accessed by clicking on the Other Actions > button. They are described on 
the Other Contingency Actions page. 

You may close the Contingency Analysis Dialog at any time either by clicking Close or by 
selecting Close from the local menu of the Contingency Records Display or the Contingency 
Violations Display. 
  

By default, the contingency records display presents the following fields: 

Label 

The name of the contingency. 

Skip 

Indicates whether Simulator should skip the corresponding contingency in performing the 
contingency analysis. If the value of the Skip field is Yes for a contingency, then that 
contingency will not be implemented when performing the contingency analysis. This is a 
toggleable field, which means that you can toggle its value by double-clicking the field. 

Processed 

Indicates whether the contingency has been analyzed yet as part of the current contingency 
run. 

Solved 

If the contingency has not yet been processed, which means that the contingency has not 
yet been implemented, then the value of this field is No. For contingencies that have been 
processed, the Solved field indicates whether the power flow case that resulted from the 
contingency could be solved to within tolerance. If the resulting power flow case could not 
be solved, you should investigate the contingency closely to determine if that contingency is 
indeed harmful to the stability of the system. 

Islanded Load 

Displays the sum of the amount of load that was islanded from the rest of the system due to 
the contingency. This load is inaccessible from the rest of the system. 

QV Autoplot? 

This option must be toggled to Yes if you intend to run a QV Analysis and automatically plot 
the QV curve for one or more contingency scenarios. 

Violations 

Identifies the number of violations caused by the particular contingency. This number 
represents the total number of contingencies (branch thermal violations + bus violations + 
interface violations) that were caused by the contingency. Depending on how you have 
configured the reporting of Base Case violations (see Base Case of the Options Tab), this 
number may include all, some, or none of the violations that were present in the Base Case 
model. 

Max Branch % 

Indicates the percentage overload of the worst-case branch violation. If there are no branch 
violations, this field will be blank. 

Min Volt 
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Indicates the lowest bus voltage resulting from the contingency. If there are no low voltage 
violations, this field will be blank. 

Max Volt 

Indicates the highest bus voltage resulting from the contingency. If there are no high 
voltage violations, this field will be blank. 

Max Interface % 

Indicates the percentage overload of the worst-case interface violation. If there are no 
interface violations, this field will be blank. 

 



Run Mode Tools and Options 
 

760 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Contingency Violations Display 

  

The Contingency Violations Display is used to list the violations that were caused by the 
contingency selected in the Contingency Records Display.  

The contingency violations display lists all of the power system elements that become violated 
as a result of the selected contingency. If you have selected a violation, you may click on the 
Show related contingencies button to view all contingencies that cause a violation on this 
power system element. Clicking this button automatically moves you to the Lines, Buses 
Interface tab, and selects the appropriate power system element. 

If the contingency selected in the Contingency Records Display resulted in no violations or has 
not yet been processed, the Contingency Violations Display will display the words None 
Defined. This display is a type of Case Information Display and thus shares many 
characteristics and controls common to all other case information displays. You can sort the 
list of violations by any field simply by clicking on that field’s caption.  

The Combined Tables button provides access to the Combined Tables options described in 
Other Contingency Actions. In addition to these options, there is one other option for 
displaying What actually occurred? Selecting this will display a dialog box giving the details 
of the actions applied during the contingency and any actions that may have been skipped. 

By default, the Contingency Violations Display contains the following fields: 

Category 

The type of violation that occurred. If the violation is only due to the options set in 
Advanced Limit Monitoring, then the type will start with the word Change. 

Element 

A character string that describes the element that suffered the violation. This can either be a 
branch, a bus, or an interface. When the element is a branch, this string provides you with 
three pieces of information: 

• The branch that was violated 
• The terminal of the branch which had the highest loading 
• The direction of the MW flow on this branch  

Example 1: Jamie (22) -> Amy (33) CKT 1 at Amy (33) 

This means that a branch connecting Jamie(22) to Amy (33) with circuit ID 1 is violated. 
The violation is at the Amy(33) terminal. The -> indicates that the MW flow on this line is 
from Jamie toward Amy. 

Example 2: Xena (55) <- Harley (77) CKT 1 at Harley (77) 

This means that a branch connecting Xena (55) to Harley (77) with circuit ID 1 is 
violated. The violation is at the Harley (77) terminal. The MW flow on this line is from 
Harley toward Xena. 

Value 

Indicates the value of the violating quantity. For example, if the category of the violation is 
Branch Amp and the Value field is x, then the current on the violated element is x. 

Limit 

Identifies the limit value that was violated. For example, if the category of the violation is 
Branch Amp and the Limit field is y, then the limit on the current that may flow through the 
element is y. 

Percent 
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The actual flow value for the element as a percentage of the limit. 

Area Name Assoc.  

Lists the areas with which the violated element is associated. If the element is a branch, 
Area Name identifies the area in which each of the branch’s terminal resides. If the element 
is a bus, Area Name identifies the area in which the bus resides. If the element is an area-
to-area interface, Area Name will identify the areas that the interface ties; otherwise, it will 
read N/A. 

Nom kV Assoc.  

Identifies the maximum voltage level associated with the violated element. If the violated 
element is a branch, then Nom kV lists the nominal voltage of its higher-voltage terminal. If 
the violated element is a bus, then Nom kV simply identifies the bus’ nominal voltage. If the 
violated element is an interface that is made up strictly of branches, Nom kV lists the 
maximum nominal voltage of its terminals; otherwise, it will appear as -9999.9. 
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Contingency Definition Display 

  

The Contingency Definition Display lists the Elements assigned to the selected Contingency. 
This display appears on both the Contingency Tab and the Lines, Buses, Interfaces Tab of the 
Contingency Analysis Dialog, it also appears on the Contingency Definition Dialog.  

Select Insert from the local menu to add elements to the contingency. Right-click on a 
specific element in the display and select Delete from the local menu to remove the element 
from the contingency.  

The contingency definition display is a type of Case Information Display and shares many 
characteristics and controls common to all other case information displays.  

The Contingency Definition Display always contains the following fields: 

Actions 

This shows a string which describes the action. You may customize the format of the string 
that describes the contingency actions by right-clicking on the Contingency Definition 
Display and choosing Display Descriptions By, and then choosing Name, Num, 
Name/Num, PW File Format by Numbers, PW File Format by Name/kV or PTI File Format. 

Model Criteria 

Simulator allows you to define Model Criteria, which can consist of both Model Conditions 
and Model Filters. These specify a criterion under which a contingency action would occur. 
For example, you could specify that a generation outage only occur if the pre-contingency 
flow on a line is higher than a specified amount. Normally, no Model Criteria will be 
specified, and this field will be blank. Also, note that Model Criteria can be overridden by the 
Model Condition and Filter option on the Advanced Modeling tab of the Contingency 
Options page. Model Criteria can be defined from the local menu (Define Model Criteria 
option) on the Contingency Definition Display, from the Add (Model Criteria) button on the 
Contingency Element Dialog, or by using the Model Conditions and Model Filters buttons 
on the Advanced Modeling tab of the Contingency Options page. 

Status 

Double click the Status field to toggle through the available options. The possibilities are: 

• Check : The action will only be executed if the Model Criteria are true or if no Model 
Criteria are specified. Check is the default status setting. 

• Always: The action will always be executed, regardless of the Model Criteria. 
• Never: The action will never by executed, regardless of the Model Criteria. This allows 

you to disable a particular contingency action without deleting it. 
• PostCheck: This action will be considered AFTER all Check and Always actions have 

been performed and the load flow solution solved. If the Model Criteria specified for the 
PostCheck action are met in the solved load flow solution (or if no Model Criteria are 
specified), then this action is taken and the load flow is again resolved. If the model 
conditions are not met, the action is skipped. This process repeats recursively for all 
Postcheck actions until complete. This behavior only occurs when the Calculation 
Method for the analysis is set to Full Power Flow. Because the power flow is not solved 
when either of the two dc methods is selected, the PostCheck status instead acts as a 
Check status. 

Comment 

An optional user-specified data string associated with the action. For example, for an action 
with Model Criteria specified, you could add a sentence explaining why the action is only 
performed under the specified criteria. While this comment is not used by Simulator in any 
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way, it is saved with the contingency element when saving contingency records in 
contingency auxiliary data files.  
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Lines, Buses and Interfaces Tab 

The Lines, Buses and Interfaces Tab contains four sub-tabs: Lines/Transformers, Buses, 
Interfaces, and Nomogram Interfaces. The information contained on each of the sub-tabs 
provides an alternate method of viewing information similar to that contained on the 
Contingencies Tab. The individual tabbed sheets show all model objects defined in the case 
(subject to area/zone/owner and advanced filters) whether each is associated with a specific 
contingency or not. The user can select any model object on its respective sheet to see how 
many times a violation occurred on the device during a run of a set of contingencies. When a 
particular device is selected that had at least one violation during the contingency run, the two 
pages at the bottom give the details of the analysis for the selected device.  

Note: the information contained in the Contingencies and Contingency Definition sections of 
the Lines, Buses and Interfaces tab is object specific. The information present only pertains to 
contingencies that resulted in violations on the selected object. 
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Lines, Buses and Interfaces Tab - Contingencies Section 

The Contingencies section gives a list of all the contingencies that caused a violation on the 
selected device during the analysis. This display is very similar to the Contingency Violations 
Display. While the Contingency Violations Display shows the elements violated under the 
contingency, this display shows the contingencies that caused the violation. If you then select 
one of the contingencies in this list, the Contingency Definition section displays the actions 
that took place during the selected contingency. Also, when you have selected a contingency 
from this list, you can click the Show Other Violations button. This will change your dialog 
to the contingencies tab and select the contingency you have selected, thus allow you to see 
other violations caused by this contingency. 

The Combined Tables button provides access to the Combined Tables options described in 
Other Contingency Actions. In addition to these options, there is one other option for 
displaying What actually occurred? Selecting this will display a dialog box giving the details 
of the actions applied during the contingency and any actions that may have been skipped. 

This page provides an easier way to check the contingency results when you are concerned 
with the results for a specific device in the system. The Lines, Buses and Interfaces Tab 
provides a much easier tool for this kind of examination, as opposed to looking through each 
contingency on the Contingencies Tab and trying to find each instance of a violation on the 
desired element. 
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Contingency Definition Display 

  

The Contingency Definition Display lists the Elements assigned to the selected Contingency. 
This display appears on both the Contingency Tab and the Lines, Buses, Interfaces Tab of the 
Contingency Analysis Dialog, it also appears on the Contingency Definition Dialog.  

Select Insert from the local menu to add elements to the contingency. Right-click on a 
specific element in the display and select Delete from the local menu to remove the element 
from the contingency.  

The contingency definition display is a type of Case Information Display and shares many 
characteristics and controls common to all other case information displays.  

The Contingency Definition Display always contains the following fields: 

Actions 

This shows a string which describes the action. You may customize the format of the string 
that describes the contingency actions by right-clicking on the Contingency Definition 
Display and choosing Display Descriptions By, and then choosing Name, Num, 
Name/Num, PW File Format by Numbers, PW File Format by Name/kV or PTI File Format. 

Model Criteria 

Simulator allows you to define Model Criteria, which can consist of both Model Conditions 
and Model Filters. These specify a criterion under which a contingency action would occur. 
For example, you could specify that a generation outage only occur if the pre-contingency 
flow on a line is higher than a specified amount. Normally, no Model Criteria will be 
specified, and this field will be blank. Also, note that Model Criteria can be overridden by the 
Model Condition and Filter option on the Advanced Modeling tab of the Contingency 
Options page. Model Criteria can be defined from the local menu (Define Model Criteria 
option) on the Contingency Definition Display, from the Add (Model Criteria) button on the 
Contingency Element Dialog, or by using the Model Conditions and Model Filters buttons 
on the Advanced Modeling tab of the Contingency Options page. 

Status 

Double click the Status field to toggle through the available options. The possibilities are: 

• Check : The action will only be executed if the Model Criteria are true or if no Model 
Criteria are specified. Check is the default status setting. 

• Always: The action will always be executed, regardless of the Model Criteria. 
• Never: The action will never by executed, regardless of the Model Criteria. This allows 

you to disable a particular contingency action without deleting it. 
• PostCheck: This action will be considered AFTER all Check and Always actions have 

been performed and the load flow solution solved. If the Model Criteria specified for the 
PostCheck action are met in the solved load flow solution (or if no Model Criteria are 
specified), then this action is taken and the load flow is again resolved. If the model 
conditions are not met, the action is skipped. This process repeats recursively for all 
Postcheck actions until complete. This behavior only occurs when the Calculation 
Method for the analysis is set to Full Power Flow. Because the power flow is not solved 
when either of the two dc methods is selected, the PostCheck status instead acts as a 
Check status. 

Comment 

An optional user-specified data string associated with the action. For example, for an action 
with Model Criteria specified, you could add a sentence explaining why the action is only 
performed under the specified criteria. While this comment is not used by Simulator in any 
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way, it is saved with the contingency element when saving contingency records in 
contingency auxiliary data files.  

 



Run Mode Tools and Options 
 

768 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Contingency Options Tab 

  

The Options Tab enables you to control many parameters that govern how the contingency 
analysis flags violations, deals with violations that appeared in the Base Case, and documents 
the violations in the form of a report.  

The bulk of the Options Tab contains five sub-tabs, each of which concerns a different aspect 
of the contingency analysis. The sub-tabs are: 
• Modeling 
• Advanced Limit Monitoring 
• Advanced Modeling 
• Report Writing 
• Miscellaneous 

Please see the corresponding help sections for assistance with each tab. Once you have 
finished setting the options for the contingency analysis, click Set Options. If, at any time, 
you wish to revert to the set of options that were defined the last time you clicked Set 
Options (or to the default options if you have never clicked Set Options), click Reset. 
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Contingency Options Tab: Modeling 

  

Calculation Method 

The calculation method defines how the power flow is solved during the contingency 
analysis. By default, Simulator uses a Full Power Flow for each contingency. For a large 
set of contingencies and a large case, this can take some time to complete. The Full Power 
Flow option can utilize either an AC solution or DC solution depending on whether or not the 
Power Flow Solution Options are set to use the DC Option. Alternatively, the contingency 
analysis can be done by calculating the linear approximation of the impact of the 
contingencies by choosing either the Linearized Lossless DC or Linearized Lossless DC 
with Phase Shifters method. These two methods will both solve a set of contingencies 
much faster than the full power flow. The Lossless DC methods utilize sensitivities of devices 
to calculate the load flow in a linear fashion. The only difference between the two lossless 
DC methods is that the first method treats all phase shifters as free-flowing, while the 
method with phase shifters will hold all in-service phase shifters at their present MW flow 
value. 

Limit Monitoring Settings 

Click this button to open the Limit Monitoring Settings Dialog to change the limit settings for 
monitored elements. See Limit Monitoring Settings for more details. 

For DC methods, allow amp limits by assuming a constant voltage magnitude 

If a Lossless DC calculation method has been selected from the Modeling Tab, this option 
will become available. If checked, Simulator will allow converting MVA limits to Amp limits by 
assuming constant voltage magnitudes based on the state operating point just prior to the 
contingency calculations. Converting to amp limits is only enforced if the Limit Monitoring 
Settings Option of Treat Line Limits as Equivalent Amps is checked. When this option is 
checked, the contingency loading of the line will be calculated from the post-contingency 
current on the line and the calculated amp limit. 

Retry solution using the Robust Solution Process after a contingency solution 
failure 

Checking this option will force the contingency analysis routine to attempt a robust solution 
following the failure of a standard Newton-Raphson solution. The robust solution attempt 
does not guarantee convergence, but will attempt to slowly approach a convergence 
solution if possible. This process is described in more detail under Simulation Control. 

Use specific solution options for contingencies 

When checked, Simulator will use a different set of Solution Options when solving the 
contingencies defined in the contingency set. To define the solution options used during the 
contingency analysis, click the Define Solution Options button to open the Contingency 
Solution Options Dialog. 

Do Not Use Post Power Flow Solution Action List 

Checking this option prevents any globally defined post power flow solution actions defined 
with the case from being evaluated and performed in the post-contingency power flow 
solution during contingency analysis runs. 

Make-Up Power 

When solving a contingency, the make-up power defines how the post-contingency solution 
accounts for the change in system losses, generation, and load. There are three options for 
this make-up power. 
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Determine make-up using: 

Area Participation Factors specified below 
Simulator models this by temporarily switching to Island-Based AGC and using the 
Calculate Participation Factors from Area Make Up Power Values option during 
the contingency solution. The values specifying the CTG Make Up Gen for each area 
are used to determine the contribution of each area in an island to the amount of make-
up power needed. Within each area, the individual participation factors of generators on 
AGC determine how much power will come from each generator. The Calculate 
Participation Factors from Area Make Up Power Values section of Island-Based AGC 
describes this in further detail.  

Generator Participation Factors From Entire Case Directly 

Simulator models this by temporarily switching to Island-Based AGC and using the Use 
Participation Factors of Individual Generators option during the contingency 
solution. The individual participation factors of each generator within each island are 
used to determine how each generator meets the make-up power needs of the island. 
Area and super area interchange (ACE) requirements are ignored, and all generators on 
AGC are dispatched to account for the changes in system losses, generation, and load. 

Same as Power Flow Case 

This uses the area interchange options specified in the normal power flow. 
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Contingency Options Tab: Limit Monitoring 

  

The Advanced Limit Monitoring Tab allows you to shape how limit violations are detected and 
reported. 
  

Never report violations if… 

This section controls the reporting of violations that should NEVER be reported. Minimum 
changes in branch flows, voltages, and interface flows which must be met before a device is 
reported as violating a limit can be specified. These options will only be used if the checkbox 
is checked at the beginning of this section. The minimum change values may be specified 
for: 

Increase in line/transformer flows – This is the minimum change in percentage points 
that the loading on a line/transformer must increase before the line/transformer gets 
reported as a violation. For example, if this value is set to 2%, line limits are being 
monitored at 100%, and a line has a base case loading of 99% and a post-contingency 
loading of 100%, the line will not get reported as a violation.  

Decrease in low bus voltage – This is the minimum change in a bus voltage that must 
occur for a bus low voltage violation to be reported. For example, if this value is set to 0.05 
pu, the low voltage limit on a bus is 0.90 pu, the base case voltage at the bus is 0.91 pu, 
and the post-contingency voltage at the bus is 0.89 pu, this bus will not be reported as a 
low voltage violation.  

Increase in high bus voltage – This is the minimum change in a bus voltage that must 
occur for bus high voltage violation to be reported. For example, if this value is set to 0.05 
pu, the high voltage limit on a bus is 1.1 pu, the base case voltage at the bus is 1.09 pu, 
and the post-contingency voltage at the bus is 1.11 pu, this bus will not be reported as a 
high voltage violation. 

Increase in interface flows – This is the minimum change in percentage points that the 
loading on an interface must increase before the interface gets reported as a violation. For 
example, if this value is set to 2%, interfaces are being monitored at 100%, and an 
interface has a base case loading of 99% and a post-contingency loading of 100%, the 
interface will not get reported as a violation. 

Always report as a violation if… 

This section allows you to specify the minimum change in flow or voltage at which point any 
device meeting the minimum change requirement will ALWAYS be reported, EVEN if the 
actual device limit (flow or voltage) is NOT violated. In other words, these options allow the 
reporting of large changes in flow or voltage, even if the device's actual limit is NOT itself 
violated. These options will only be used if the checkbox is checked at the beginning of this 
section. The minimum change values may be specified for: 

Increase in line/transformer flows – This is the minimum change in line/transformer 
flow in percentage points that the loading on a line/transformer must increase so that the 
line/transformer gets reported as a violation even if the loading does not exceed the 
element’s limit. For example, if this value is set to 2%, line limits are being monitored at 
100%, and a line has a base case loading of 50% and a post-contingency loading of 63%, 
this line will be reported as a violation even though the post-contingency loading does not 
exceed the limit.  

Decrease in low bus voltage – This is the minimum amount that a bus voltage must 
decrease for a bus low voltage violation to be reported even if the resulting voltage is higher 
than the bus low voltage limit. For example, if this value is set to 0.05 pu, the low voltage 
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limit at a bus is 0.90 pu, the base case voltage at the bus is 1.0 pu, and the post-
contingency voltage at the bus is 0.95 pu, this bus will be reported as a low voltage 
violation. 

Increase in high bus voltage – This is the minimum amount that a bus voltage must 
increase for a bus high voltage violation to be reported even if the resulting voltage is lower 
than the bus high voltage limit. For example, if this value is set to 0.05 pu, the high voltage 
limit at a bus is 1.10 pu, the base case voltage at the bus is 1.0 pu, and the post-
contingency voltage at the bus is 1.05 pu, this bus will be reported as a high voltage 
violation. 

Increase in interface flows – This is the minimum change in interface flow in percentage 
points that the loading on an interface must increase so that the interface gets reported as a 
violation even if the loading does not exceed the interface limit. For example, if this value is 
set to 2%, interface limits are being monitored at 100%, and an interface has a base case 
loading of 75% and a post-contingency loading of 77%, this interface will be reported as a 
violation even though the post-contingency loading does not exceed the limit.  

Caution should be used when using the Always report… options because this may result 
in a very large number of reported violations. 

Report changes in bus dV/dQ sensitivity 

Check this option to enable reporting changes in voltage to reactive power sensitivity for 
buses in the post-contingency solution. Set the sensitivity multiplier to the minimum change 
in sensitivity for reporting the value(s) under contingency. Any sensitivity that changes by 
the given multiple will be reported. You can also define an advanced bus filter using the 
Define Filter button, and choose either the newly defined bus filter or a previously existing 
bus filter for reporting dV/dQ sensitivity changes at only buses that meet the defined filter. 

Also, regardless of the sensitivity multiple setting, any bus that meets the filter and has a 
negative dV/dQ will be reported as a violation. 

Caution should be used when selecting this option. Calculating the dV/dQ sensitivities 
requires more computation time. Define a filter so that the dV/dQ sensitivities are only 
calculated for those buses for which it is important to calculate these values.  

Report as a violations if a bus becomes disconnected 

When checked, buses that become disconnected from the system due to a contingency will 
be reported as violations.  

Re-reporting of base case violations 

This section controls the reporting of Base Case violations. Because the concern of 
contingency analysis often is to identify those limitations that result directly from a particular 
outage or event, you may desire not to report all violations that were present in the Base 
Case with each contingency-specific set of violations. These options allow you to specify just 
how much of the Base Case violation information to report for each contingency. It gives 
you three options: 

Do not report Base Case violations 
When this option is checked, any element that was violated in the Base Case is omitted 
from the set of violations listed for each contingency. 

List all Base Case violations for all contingencies 

When this option is checked, all elements that were violated in the Base Case and are 
still violated post-contingency are included in the set of violations listed for each 
contingency. 

Use these criteria 
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When this option is checked, only those elements that were violated in the Base Case 
and that meet the four criteria listed below will be listed with the contingency-specific 
violations. The four criteria include: 

Minimum % increase in line/transformer flows: Only those branches that were 
violated in the Base Case whose flow has increased by at least this amount as a result of 
the contingency will be listed as contingency violations. 

Minimum per-unit decrease in low bus voltage: Only those bus voltages that were 
violated in the Base Case that have decreased by at least this amount as a result of the 
contingency will be listed as contingency violations. 

Minimum per-unit increase in high bus voltage: Only those bus voltages that were 
violated in the Base Case that have increased by at least this amount as a result of the 
contingency will be listed as contingency violations. 

Minimum % increase in interface flows: Only those interfaces that were violated in 
the Base Case whose flow has increased by at least this amount as a result of the 
contingency will be listed as contingency violations. 

When calculating the percentage for the Base Case violations used in the comparisons, 
the post-contingency rating sets are used. Comparisons made using percentage changes 
for branches are done using percentage points and not as a percentage of the actual 
change. For example, if the value for the minimum percent increase in line flow is 2%, 
lines are monitored at 100%, and a line is loaded at 100% in the base case and, the line 
must be loaded to at least 102% post-contingency to be reported. 

How to Monitor Voltage Changes 

Voltage changes can be monitored either directly on the amount of the bus per unit voltage, 
or based instead on a percentage change in per unit voltage from the base case per unit 
voltage values. 
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Contingency Options Tab: Advanced Modeling 

  

Contingency Blocks and Global Actions 

A contingency block stores a list of contingency actions and has a name (or label) associated 
with it. A contingency block can then be called from a contingency record. This allows you to 
define a block of common actions you wish to have processed during several different 
contingencies, and then assign the block to each contingency instead of constantly 
redefining the same actions for each contingency. 

A global action is an action that will automatically be processed as part of EACH 
contingency. Thus if you have actions that are to be performed in every single contingency 
you define, you can insert it once in the global actions list, and Simulator will automatically 
use the defined action for every contingency it processes. 

Model Expressions 

Clicking this button brings up a list of the model expressions. You may then insert a model 
expression by right-clicking on the list and choosing Insert. This will bring up the Define 
Model Custom Expressions dialog. Model Expressions may be used as part of Model 
Conditions. 

Model Conditions 

Clicking this button allows you to define model conditions. Model Conditions may be used as 
part of the Model Criteria defined with Contingency Elements. 

Model Filters 

Clicking this button allows you to define model filters. Model Filters may be used as part of 
the Model Criteria defined with Contingency Elements.  

Generator Post-Contingency AGC 

Clicking this button opens a dialog that allows the post-contingency AGC response of 
individual generators to be set. Set the Post-CTG Prevent AGC Response field to indicate 
whether or not a generator should be on AGC post-contingency. By default, generators are 
NOT set to prevent AGC response post-contingency. For the post-contingency participation 
factor field, Post-CTG Part. Factor, a value of same indicates that the generator should 
use the same participation factor as set with the generator record. Otherwise, set a 
numerical value for the post-contingency participation factor to use a factor other than the 
normal participation factor.  

Bus Load Throw Over Records 

Clicking this button allows you to define load throw over records in the Bus Load Throw 
Over Records list display. 

Generator Maximum MW Responses in Post-Contingency 

Clicking this button opens a list of generators, with a column, CTG Max Response MW, for 
entering the contingency maximum response. 

During the post-contingency power flow solution, a user may enter a MW amount specifying 
the maximum amount of generator response from a generator. By default, these values are 
blank. If you enter a value in this column, then the generator response will be limited to this 
absolute MW response (response may be either an increase or a decrease). 

Note: The user may also add a column called CTG Max Response % to the generator 
display. When entering data in this column, the CTG Max Response MW values will be set 
at a respective percent of the maximum MW output of the generator. If a generator’s 
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maximum MW output is less than or equal to zero, then the Maximum Response will always 
be set to zero. 

Generator Line Drop and Reactive Current Compensation 

Clicking this button opens a list of generators, with a column, XLDC_RCC, for entering line 
drop and reactive current compensation data. 

Line Drop and Reactive Current Compensation represent an alternative method for 
performing generator voltage control. While on LDC/RCC control, the generator will vary its 
MVAR output in a manner that maintains the bus voltage at a fictitious bus that is a user-
specified electrical impedance of XLDC_RCC away from the generator. This is called Line 
Drop Compensation when the impedance specified is positive, and Reactive Current Drop 
Compensation when the impedance specified is negative. 

The impedance is specified by entering a value for XLDC_RCC and the setpoint voltage is 
the same as used when regulating a generator in the more traditional manner. A generator 
will perform LDC/RCC control when it meets the following conditions: 

• AVR = YES 
• Use LDC_RCC = YES 

Please note that if any generators at a bus are set to Use LDC_RCC, then this action will 
disable all traditional AVR control for generators at that bus. Other generators operating on 
LDC/RCC control are allowed, but no traditional AVR. 

As a third special setting, you may also set the field Use LDC_RCC to PostCTG for use in 
contingency analysis. When a generator is set to PostCTG, while implementing the post-
contingency power flow, the generator will change the Use LDC_RCC value to YES, thereby 
activating this new voltage control method for the generator. After the reference state is 
restored in the contingency analysis however, the generator will return back to a setting of 
PostCTG. 

Post-Contingency Auxiliary File 

The auxiliary file specified here is loaded at the start of each contingency. In this way, very 
specialized post-contingency settings can be specified. An example use of this feature could 
be changing the Generator voltage setpoints or AVR status for the post-contingency solution 
or changing generator AGC status for the post-contingency. 

Note: Only data stored with the contingency reference state will be "reset" when the 
reference state is restored. Therefore, only data stored with the reference state should be 
loaded via a post-contingency auxiliary file. Click here for details on the specific information 
stored with the reference state. 

Model reactive power for DC methods by… 

When you choose to use one of the Lossless DC calculation methods, you can also specify 
how to handle changes in reactive power during the calculations. The lossless DC methods 
are based on the real power MW in the system, thus an assumption needs to be made about 
the reaction of the Mvar flows during the linear calculations.  

The choices are: 

Ignoring reactive power 
Reactive power is completely ignored. This results in the MW flow only being compared 
to the limits of the elements in the system. It is important to recognize this fact, as 
branch and transformer limits are usually given in complex power (MVA) ratings, thus, 
ignoring reactive power results in comparing active power flow (MW) to total complex 
power limits (MVA.). 

Assuming constant voltage magnitude 
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One way to include reactive power in the linearized DC results is to assume the voltage 
magnitudes remain constant during the linearized DC contingency analysis. Thus, the 
MW flows are determined from the linearized calculations, and the MVAR flows are 
calculated from the resulting flows and constant voltage magnitudes. Thus you will still 
receive an approximate complex power flow on each element (MVA), which can then be 
directly compared to the complex power limit of the element. 

Assuming reactive power does not change 

Another way to include reactive power in the linearized DC results is to assume that the 
reactive power magnitudes remain constant during the linearized analysis. Thus, the MW 
flows are determined from the linearized calculations, and the complex power flow of 
each element can be approximated using the calculated MW flows and the assumed 
constant Mvar flows from the base case. This again allows the approximate complex flow 
on each element to be compared to the complex power limit of the element. 

Model Condition and Filter options 

This section allows you to choose how assumptions about Model Conditions and Model 
Filters are made during the contingency analysis. Assumptions about the Model Conditions 
and Model Filters will impact how the Model Criteria are evaluated for contingency elements. 
You can specify to Verify Model Conditions and Filters, Assume Model Conditions 
and Filters are TRUE, or Assume Model Conditions and Filters are FALSE. 
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Model Expressions 

  

Model Expressions can be accessed and created by choosing Case Information and 
Auxiliary > Custom Model Expressions in the Model Explorer. To open the Define Model 
Custom Expressions dialog, right-click and choose Insert, when creating a new expression, or 
Show Dialog to view an existing expression.  

The Save, Save As, Rename, and Delete buttons and the drop-down list of expressions at 
the top of the dialog allow for the additional of new expressions, modification of existing 
expressions, and removal of existing expressions. There are two types of Model Expressions: 
an expression and a lookup table.  

Lookup Tables 

The dialog as configured when creating a lookup table appears as follows: 

 
A lookup table may be either one or two-dimensional by specifying the Lookup Type. The 
Number of Points must be set for each dimension. This will determine the size of the 
table. A Model Field must also be selected for each dimension. Clicking the Define button 
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next to either the x1 or x2 field opens the Model Field Dialog. This dialog allows the 
selection of an Element Type and a specific element of this type. The list of elements 
behaves the same as the Find Dialogs found throughout Simulator. After selecting the 
element, choose the field associated with this element that will be used in the Lookup Table. 
Click OK to accept the element and field selected and close the dialog. 

Fill in the Lookup Table with the desired values. If selecting a one-dimensional table, there 
will be two columns, one containing the values for the x1 Model Field and the other 
containing the Values to return from the Lookup Table when the Model Field is at the 
defined value. There will be one header row plus as many additional rows as defined in the 
Number of x1 Points. If selecting a two-dimensional table, there will be one column for 
the x1 Model Field and as many other columns as selected for the Number of x2 Points. 
There will be one header row for defining the x2 values plus as many additional rows as 
defined in the Number of x1 Points. The cells under the first row and to the right of the 
first column are used for defining the Values to return from the Lookup Table when the 
Model Fields meet the defined values. 

If selecting a one-dimensional table, the returned Value is determined based on the current 
value of the x1 Model Field. The returned value is the Value corresponding with the x1 
value that is less than or equal to the current value of the Model Field. If the current value 
of the Model Field is less than the smallest value of x1 in the table, then the Value returned 
corresponds to the smallest x1 value. If selecting a two-dimensional table, the same rules 
apply except that the Value returned corresponds to the current value of the x1 AND x2 
Model Fields and where these intersect in the table. 

Expressions 

The dialog as configured when creating an expression appears below: 
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To define the Model Expression as an expression, specify the Model Fields that the 
expression should be a function of by clicking the Define button next to the appropriate 
variable. Clicking the Define button opens the Model Field Dialog. This dialog allows the 
selection of an Element Type and a specific element of this type. The list of elements of a 
particular type can be searched, filtered, and sorted to make finding an element easier. After 
selecting the element, choose the field associated with this element that will be used in the 
expression. Click OK to accept the element and field selected and close the dialog. After the 
Model Fields have been defined, enter the function description. See Custom Expressions for 
more information about defining expressions. 

  

After model expressions have been defined, new options will appear on the Contingency 
Element Dialog and on the Advanced Filter Dialog.  

Normally, you may only enter a constant for the comparison value on the Advanced Filter 
Dialog. However, if you select Enable Field to Field Comparisons, the advanced filter 
dialog will feature a drop-down from which you can choose Expression. After choosing 
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Expression, you may select the name of the model expression, or click the Find button to 
search for the name. 

 
Similarly, normally you may only enter a Constant or a Field for the Move, Set To, or Change 
By  Action Types on the Contingency Element Dialog. However, now you will have the option 
to choose Model Expression. To change the type of the Amount, choose Model Expression 
from the second drop-down box. After doing this, enter or choose the name of the model 
expression in the first Amount drop-down box, or click on the Find… button to search for a 
name. 
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Bus Load Throw Over Records 

  

The Bus Load Throw Over list display, which is opened from the Advanced Modeling tab of the 
Contingency Dialog’s Options page, provides you with the capability to define how load at a 
bus should be transferred to a different bus if the original terminal bus becomes disconnected 
from the system. This is referred to in Simulator as "throw over." This tool is most useful when 
performing contingency analysis scenarios in which buses containing loads become 
disconnected and you wish to analyze the impact on the system of switching the load from the 
disconnected bus to another bus that is still in service. 

Load throw over will only attempt to move the load once, from the original bus to the load 
throw over bus. If the load throw over bus is already disconnected from the system, then the 
load will be treated as dropped during the contingency solution. 

NOTE: The load throw over is only used when running the contingency analysis tool to 
analyze contingency effects on the system. Load throw over records are not used during 
manual solution of the power flow, even if you manually disconnect a bus with load and 
perform a load flow solution. 

The Bus Load Throw Over display has the following fields: 

Number, Name 

The bus number and name of the load’s terminal bus. 

Nom kV 

The nominal voltage level of the load’s terminal bus. 

Load Throw Over Bus Number 

Enter the number of the bus you wish to have the load transferred to, should the original 
load terminal bus become disconnected during a contingency in the contingency analysis. 
The Load Throwover Bus Name_kV field will be automatically populated. 

Load Throw Over Bus Name_kV 

Enter the bus name and nominal kV (separated by a _ between the name and nominal kV) 
of the bus you wish the load to be transferred to, should the original load terminal bus 
become disconnected during a contingency in the contingency analysis. The Load Throw 
Over Bus Number will be automatically populated if the corresponding Bus Name_kV is 
found. 

If choosing to identify objects by labels, this field can also be used to display and enter the 
label of the load throw over bus. 
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Contingency Options Tab: Report Writing 

  

Simulator can produce a report that details the results of the contingency analysis (see 
Contingency Analysis Summary Tab to see how to generate the report). The Report Writing 
Tab allows you to control the content and appearance of the report. By default, the report will 
identify each contingency, whether or not it could be solved, and what violations resulted from 
it. By selecting options on this tab, you can include additional information in the report. 

Optional Report Contents 

Case Summary 
The case summary prints the Case Description and then tallies the number of different 
power system components in the model. 

Option Settings 

If this item is checked, the report will list each of the options selected on the Options 
Tab of the Contingency Analysis Dialog. 

Monitored Areas, Monitored Zones 

If either of these items is checked, the report will identify the areas and/or zones in 
which Simulator has looked for limit violations, and over what voltage ranges. 

Line Flow, Interface Flow, and Bus Voltage Extremes 

If one of these items is checked, the report will list the worst-case line flows or voltages 
seen for each monitored element during the contingency analysis. None, one, two, or all 
three of these can be chosen at one time. 

Base Case Outages 

If this item is checked, the report will list the limit violations that existed in the Base 
Case. 

All 

Selecting this option will select all of the other options.  

Identify buses by 

This setting determines how the buses are listed in the data stored in the report. You can 
choose to have the buses displayed by number or name only, or by a combination of the 
number and name. You can also choose to identify with nominal voltage by checking the 
box labeled Identify with Nominal Voltage. 

Show the actions involved in each contingency 

If this box is checked, the definition of each contingency will be included in the report. The 
definition of each contingency simply identifies the actions that were implemented as part of 
the contingency. 

Report only contingencies that cause violations 

Checking this option will cause only the contingencies that cause violations to be shown in 
the report. Any contingency that did not cause a violation will not be included in the report. 
This option is useful if you wish to limit the size of the contingency report. 

Report only limit type with violations for each contingency 

Checking this option will result in reporting only the contingency violations of the type 
checked in the Limit Type Violations to Include box. 

Report Inactive Violations and show all Rating Sets 
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When this box is checked, all violations that are normally being ignored during the 
contingency analysis (for example, base case violations) will be written to the report. 
Included with this option is the ability to show the different rating sets for each violated 
element. 

Limit Type Violations to Include 

Check the boxes of the types of violations you would like to be written to the report. This 
corresponds to the Report only limit type with violations for each contingency 
option above. 

Maximum Violations of a single type to report 

Enter the value of the maximum number of violations of a single type to be written to the 
report. 

Create database-friendly tables 

Checking this box will create three additional files for viewing contingency results: 
FILENAME_ctgelem, FILENAME_ctgviol, and FILENAME_ctgstat where FILENAME is the 
name of the file where the main report is saved. The user can choose which symbol to use 
to separate the columns by choosing a delimiting symbol. These files can be easily imported 
into a database or spreadsheet program such as Access or Excel as delimited text files, 
where they can be analyzed more rigorously. These files will be automatically created and 
saved in the same folder as the main report. 

Produce Report 

Clicking this button will open a Save Dialog for selecting the file to which the report should 
be written. The file is saved as a text file (*.txt). Enter the file path and name and click 
Save to write the report to the selected file. After saving the file, a dialog will provide the 
option of viewing the report file immediately.  
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Contingency Options Tab: Miscellaneous 

  

Always save results with the contingency list when you save it to a file 

If this option is checked, the violation results for each contingency will also be stored in an 
auxiliary file when the list of contingencies is saved to an auxiliary file. This allows for 
recovering the results of a contingency analysis run for a case, without reloading and re-
running all the contingencies saved in the file. 

Save contingency analysis definitions/results in the case PWB file 

If this option is checked, the contingency definitions and any processed results will be saved 
with the load flow case in the PWB file when you save the case. 

Setting Reference Case when Contingency Analysis is Opened 

These options determine how the reference case for the contingency analysis is treated each 
time you re-open the contingency analysis. The first time you open the contingency analysis 
tool for a particular power flow case during a Simulator session, Simulator stores the current 
state of the power flow case as the reference case for the contingency analysis results. (See 
Contingency Case References - Defining the Reference State for more information.) 
However, each subsequent time you open the contingency analysis dialog in the same 
Simulator session, Simulator needs to know how to set the reference state for the case. The 
choices are: 

Always set reference case to the current case 
This option will always assume that any changes you have made to the load flow case 
since the contingency analysis was last opened should be applied and will store the 
current state of the load flow as the new reference state for the contingency analysis. 

Always use the existing contingency analysis reference case 
This option will assume that the original reference case stored when the contingency 
analysis tool was originally launched should always be the reference state for the 
contingency analysis. This means that any changes that have been made to the load flow 
case since the initial launch of the contingency analysis will be lost, as the contingency 
analysis tool will reset the load flow state to the state stored with the first contingency 
analysis instance. 

Prompt for which reference case to use (the current case or the pre-existing 
reference case) whenever the Contingency Analysis Form is opened 

When this option is checked, you will always be prompted when you re-open the 
contingency analysis following the initial instance. You will then have the option to 
choose from one of the two previous settings, to either set the reference state to the 
current case or use the existing reference case currently stored with the contingency 
analysis tool. 
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Contingency Summary Tab 

  

The Summary Tab of the Contingency Analysis Dialog provides additional information on the 
status of the contingency analysis run and allows you to start, pause, resume, and abort the 
contingency run. The top half of the Summary Tab charts the progress of the contingency 
analysis run and issues warning messages when a particular contingency fails to solve. The 
next section features counters that indicate the total number of contingencies that comprise 
the list, the number of these contingencies that have been processed thus far, the number of 
contingencies that failed to solve, and the total number of violations that have been flagged. 
To start the contingency analysis, click Start. To pause the contingency analysis, click Pause. 
To resume a paused contingency run, click Continue. Finally, to abort the analysis, click 
Abort. 
The Refresh Displays After Each Contingency checkbox is used to force a refresh of the 
counters after each contingency, which may slow down processing of the contingency set 
(accordingly, this box is unchecked by default to maximize solution speed). 
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Comparing Contingency Analysis Results 

  

After performing an automated contingency analysis, the results of the analysis can be saved 
to an auxiliary file. Once the results have been saved to a file, they can then be compared to 
different results in another file or to results existing in memory in the Contingency Analysis 
tool. To compare two sets of contingencies, do the following: 
• Process each set of contingencies and save the results for at least one set in an auxiliary 

file.  
o To save a contingency list, right-click on the list of contingencies and choose Save 

As > Auxiliary File.  
o In the Save Contingency File Dialog, choose a name for the file, and then click 

Save.  
o You will then be prompted to choose options for saving the contingency list to an 

auxiliary file. By default, the contingency definitions themselves are saved, along 
with the contingency options. The optional information you may choose to save are 
the Limit Monitoring Settings, General Power Flow Solution Options, List Display 
Settings, and Contingency Results. When saving the contingency results with the 
file, you may also choose to include inactive violations.  
Inactive violations are considered violations on elements for a DIFFERENT limit than 
what is currently being monitored. For example, a branch may have an A limit 
rating of 50 MVA, and a B limit rating of 100 MVA. Consider if the B limits are being 
used to report violations during a contingency. A value of 75 MVA flow on the 
branch would not be reported in the contingency analysis as a violation, considering 
the B limit of 100 MVA is being used. However, Simulator internally will flag the 
element as a potential violation if the limit set used is switched to the A rating set. 
Simulator considers these types of situations as inactive violations. These are kept 
track of to allow the user to easily switch the rating set used for reporting violations 
from one set to another and see the results immediately, without having to re-run 
the entire contingency set to determine the violations for the new rating set. 
Choosing to include the inactive violations when saving an auxiliary file maintains 
this flexibility when the contingency definitions and results are read into a case 
from an auxiliary file. You can also choose for the identifiers used in the file to be 
either the bus numbers or the bus name and nominal kV voltage. 
Note: For comparing two lists of contingency results, you MUST save the 
contingency results with each of the two auxiliary files being compared. 

o Click OK to save the contingencies and the results to the auxiliary file specified. 
• Once you have two different lists of contingency results (at least one of the lists must be 

saved in an auxiliary file), right-click on the contingency list and choose Compare Two 
Lists of Contingency Results  or choose Other > Compare Two Lists of 
Contingency Results. This will bring up a dialog on which you have to specify the 
Contingency Lists you are interested in comparing. You must specify the Controlling 
Contingency List and the Comparison Contingency List. The definitions of these two 
lists are found below. 

• Click on the Browse buttons to specify the two Contingency Lists you would like to 
compare. You can also choose to use the presently open Contingency List as either the 
Controlling Contingency List or the Comparison Contingency List. 

Controlling Contingency List:  

The list that controls what is displayed on the dialog. Only contingencies that are defined 
in this list will be displayed on the form. Only violations that occur for contingencies in 
this list will appear in the Violations List for each contingency. 

Comparison Contingency List:  
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This is the list to which the Controlling Contingencies will be compared. Comparisons will 
occur for those contingencies in the lists that have the same CONTINGENCY NAME. 
Note that contingencies in the Comparison list whose CONTINGENCY NAME does not 
match one of those in the Controlling list will not be displayed. Also, violations which 
occur in a specific Comparison contingency that do not occur in the respective Controlling 
contingency will not be displayed. 

Example: 

A user has a power system case and a list of contingencies. The user runs contingency 
analysis on this system for this list of contingencies. The results are saved in a file called 
comparison.aux. The user now changes the system state, possibly adding in a 500 MW 
transaction between two areas. The contingency analysis is run on this new state of the 
system for the list of contingencies. The results are saved in a file called controlling.aux. 
You should define the contingency results you are more interested in viewing as the 
Controlling List because this list determines what is shown on the dialog. In this case, we 
are more interested in seeing the violations caused when the transaction is in place, so 
that list is defined as the Controlling List. 

The comparison of the two sets of contingencies is now done by right-clicking and 
choosing Compare Two Contingency List Results. The file controlling.aux is set as 
the Controlling List and comparison.aux as the Comparison List. 

• After clicking OK on the dialog, the contingency lists will be read from the specified files or 
from the presently open list. After Simulator has completed reading these files, a prompt 
will appear which asks, "Would you like to set the dialog with default columns for 
comparing contingency lists?". It is recommended that you choose YES so that the 
case information displays on the Contingency Dialog will automatically be set to show 
fields that will help you compare the two lists of contingencies. For information on the 
default fields used when comparing contingencies see Comparing Contingencies List 
Displays. 
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Comparing Contingencies List Displays 

  

When comparing two sets of contingency results, there are several additional default fields 
added to several list displays which help you compare the results. These fields are described 
below for the various list displays. 

Contingencies Records on Contingencies Tab 

Violations 

The total number of violations for this contingency under the Controlling List. 

Comp Violations 

The total number of violations for this contingency under the Comparison List. 

New Violations 

The number of violations which occur in the Controlling List which do not occur in the 
Comparison List. 

Max Branch % (Max Interface %) 

The highest branch (interface) violation caused by this contingency in the Controlling List. 

Comp Max Branch % (Comp Max Interface %) 

The highest branch (interface) violation caused by this contingency in the Comparison List. 

Worst Branch Violation (Worst Interface Violation) 

This is the maximum of the following two values: [Worst Increase Violation] and [Worst 
New Violation - 100%] 

Min Volt (Max Volt) 

The worst violation in the controlling list. 

Comp Min Volt (Comp Max Volt) 

The worst violation in the comparison list. 

Worst LowV Violation (Worst HighV Violation) 

The worst new violation. 

  

Contingency Violations Display on Contingencies Tab and Contingency Violations 
on the Lines, Buses, Interfaces Tab 

Value 

The value of the violation under the controlling list. 

Comp Value 

The value of the violation under the comparison list. 

Diff Value 

The difference between Value and Comp Value 

Limit 

The limit of the element in the controlling list. 

Comp Limit 

The limit of the element in the comparison list. 
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Diff Limit 

The difference between Limit and Comp Limit 

Percent 

The percent violation in the controlling list. 

Comp Percent 

The percent violation in the comparison list. 

Diff Percent 

The difference between Percent and Comp Percent 

  

Line/Transformer (Interface) Records on the Lines, Buses, Interfaces Tab 

Violations 

This shows the number of branch (interface) violations which occurred in the Controlling List 

New Violations 

This shows the number of branch (interface) violations which occurred in the Controlling 
List, but did not occur in the Comparison List. 

Max % Loading Cont. 

The worst branch (interface) violation in the controlling list. 

Max % Ld Cont Comp 

The worst branch (interface) violation which occurred in the comparison list. 

Worst Increased Violation 

The worst increase in a branch (interface) violation from the comparison list to the 
controlling list. 

  

Bus Records on the Lines, Buses, Interfaces Tab 

Violations 

This shows the number of violations which occurred in the Controlling List 

New Violations 

This shows the number of violations which occurred in the Controlling List, but did not occur 
in the Comparison List. 

Max Voltage Cont. 

The worst high voltage violation in the controlling list. 

Max Voltage Cont Comp 

The worst high voltage violation which occurred in the comparison list. 

Worst Max Volt CTG Change 

The worst increase in a high voltage violation. 

Min Voltage Cont. 

The worst low voltage violation in the controlling list. 

Min Voltage Cont Comp 

The worst low voltage violation which occurred in the comparison list. 
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Worst Min Volt CTG Change 

The worst decrease in a low voltage violation. 

  

Nomogram Interfaces Records on the Lines, Buses, Interfaces Tab 

Violations 

This shows the number of violations which occurred in the controlling list. 

Max % Loading Cont. 

The worst nomogram interface violation in the controlling list. 
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Contingency Definition Dialog 

  

The Contingency Definition Dialog (shown below) serves as an information source for 
displaying the Contingency Element (or Elements) associated with individual Contingencies 
defined in the case. You can use the Contingency Definition Dialog to scroll through the list of 
elements, to view and modify their definitions, to insert new elements in a contingency or to 
delete a contingency. You may access this dialog by choosing either Show Dialog or Insert 
from the local menu of the Contingency Records Display.  

After making changes, click OK to save your changes and close the dialog. Click Cancel to 
close the dialog without saving your changes. Click Save to save your changes (including the 
addition of a new contingency) without closing the dialog (this allows you to keep working 
with the dialog). Click Delete to remove the selected contingency from the contingency list. 

 
  

Contingency Definition Dialog 

  
The Contingency Definition Dialog has the following controls: 

Contingency Label 

Identifies the name of the currently displayed contingency. Use the drop-down arrow to 
select a different contingency, or use the scroll buttons to navigate through the list of 
contingencies. When adding a new contingency, Contingency Label will show New 
Contingency. The user can change the Contingency Label by clicking Rename 
Contingency. 

Add Contingency 

Click the Add Contingency button to add a new contingency to the contingency list for the 
case. You will be prompted to enter a unique name for the new contingency. After naming 
the new contingency, the name appears in the Contingency Label and you can insert new 
elements in the contingency definition. 

Insert New Element 

Click this button to add a new element to the contingency. This will open the Contingency 
Element Dialog, used to define the Action, Model Criteria and Comment associated with the 
element. When you return to the Contingency Definition Dialog, the display will contain the 
newly inserted element. 

Clear All 

Removes all elements from the contingency definition. The Contingency Elements Table will 
then appear blank, indicating that the contingency involves no associated actions. 



Run Mode Tools and Options 

793 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Rename Contingency 

Allows you to rename the selected contingency. 

Definitions Display 

The Contingency Definitions Display lists the Elements assigned to the selected Contingency. 
Select Insert from the local menu or click on the Insert New Element button to add 
elements to the contingency. Right-click on a specific element in the display and select 
Delete from the local menu to remove the element from the contingency. For more 
information about this display, see the Contingency Definitions Display. 

Define Solution Options 

Click this button to open the Contingency Solution Options Dialog, used to define specific 
power flow solutions options for use under the selected contingency. 

Use Specific Solution Options 

Check this box to enable the use of Contingency Specific Solution Options (see Define 
Solution Options above). 
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Contingency Element Dialog 

  

The Contingency Element Dialog provides information on the individual elements that comprise 
a contingency definition. You may use this dialog to modify an existing contingency’s definition 
or to add elements to new or existing contingencies.  

There are several ways to open the Contingency Element Dialog: 
• By pressing the Insert New Element button on the Contingency Definition Dialog. 
• By right-clicking on a Contingency Definition Display and choosing Insert or Show 

Dialog. 
• By right-clicking on the Contingency Tab of the Contingency Analysis Dialog and choosing 

Insert Special > Quick  Insert of Single Element Contingency. 
  

After making the desired changes, click OK to save changes and close the dialog or click 
Cancel to close the dialog without saving your changes.  

Click Delete to remove the element from the contingency. 

 
  

Contingency Element Dialog 
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The Contingency Element Dialog has the following controls: 

Element Type 

Indicates whether the element involved in the contingency action is a branch, generator, 
load, switched shunt, bus, interface, injection group, series capacitor, DC line, phase shifter, 
contingency block or solve power flow. The Element Type will dictate what Action Types 
are available, and the selection of the Element Type, in conjunction with the Action Type, 
Amount, and in options settings, determines what actually happens during the 
contingency. 

What actually happens during a contingency action based on the Element Type, Action 
Type, and in options is described in detail below:  

Branch 
Open 

The Open action will set the Status of the selected branch to Open if the branch 
Status is Closed. If the branch Status is already Open, then this action does nothing. 

Close 

The Close action will set the Status of the selected branch to Closed if the branch 
Status is Open. If the branch Status is already Closed, then this action does nothing. 

Generator 

Open 

The Open action will set the Status of the selected generator to Open if the generator 
Status is Closed. If the generator Status is already Open, then this action does 
nothing. 

When using the Open action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in generation due to the 
contingency action.  

Close 

The Close action will set the Status of the selected generator to Closed if the 
generator Status is Open. If the generator Status is already Closed, then this action 
does nothing. 

When using the Close action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in generation due to the 
contingency action.  

Move  

The Move action allows the transferring of generation from an existing generator bus 
to another bus. A generator move is done on a bus basis and impacts the total 
generation of all generators at the selected bus. Generators that are adjusted by the 
Move action will have their AGC Status set to No. If there are no on-line generators at 
the selected generator bus, no generation move will occur. Generation may be moved 
in Percent or MW. A Percent move will move the specified percent of the current 
generator MW and Mvar to the defined Bus to Move to. A MW move will move the 
specified amount of generator MW to the Bus to Move to. The Move amount can be 
either positive or negative. A positive amount will decrease the output of the selected 
generator bus, and a negative amount will increase the output of the selected 
generator bus. The Bus to Move to will respond accordingly.  

If a generator already exists at the bus to which the generation is being moved, the 
generation at that bus is adjusted according to the move amount. If a generator does 
not exist but a load exists, then the load is adjusted by the move amount. If no 
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generator or load exists, then a load is added at the bus and the injection is set 
according to the move amount. In terms of power injection, positive generation is the 
same as negative load.  

Set To 
The Set To action will set the selected bus’ generator parameters to a specified 
Amount. Generator Set To actions are done on a bus basis and impact the total 
generation of all generators at the selected bus. Generators that are adjusted by a 
Set To action will have their AGC Status set to No. If there are no on-line generators 
at the selected generator bus, no generation change will occur. Generator parameters 
can be set in Percent, MW, or Setpoint Voltage. When the generation is set in 
Percent, total generator MW output will be set to a value based on the specified 
percent of the current total generator MW output. When the generation is set in MW, 
total generator MW output will be set to the specified MW amount. When the 
generation is set in Setpoint Voltage, the voltage set-point of all generators at the 
selected bus will be set to the specified amount in per unit.  

When using the Set To action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in generation due to the 
contingency action.  

Change By 

The Change By action will change the selected bus’ generator parameters by a 
specified Amount. Generator Change By actions are done on a bus basis and impact 
the total generation of all generators at the selected bus. Generators that are 
adjusted by a Change By action will have their AGC Status set to No. If there are no 
on-line generators at the selected generator bus, no generation change will occur. 
Generator parameters can be changed in Percent, MW, or Setpoint Voltage. 
When the change is in Percent, total generator MW output will be changed based on 
the specified percent of the total current generator MW output. When the change is 
in MW, total generator MW output will be changed by the specified MW amount. 
When the change is in Setpoint Voltage, the voltage set-point of all generators at 
the selected bus will be changed by the specified amount in per unit.  

When using the Change By action, the Make-up Power Sources button is enabled 
and power sources can be specified to account for the changes in generation due to 
the contingency action.  

Load 

Open 
The Open action will set the Status of the selected load to Open if the load Status is 
Closed. If the load Status is already Open, then this action does nothing. 

When using the Open action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in load due to the 
contingency action.  

Close 
The Close action will set the Status of the selected load to Closed if the load Status is 
Open. If the load Status is already Closed, then this action does nothing. 

When using the Close action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in load due to the 
contingency action.  

Move 
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The Move action allows the transferring of load from an existing load bus to another 
bus. The load move is done on a bus basis and impacts the total of all loads at the 
selected bus. Load may be moved in MW (const pf), Percent, MW, or Mvar. The 
load amount that is moved is the total actual load and may be different than the 
nominal load if the area of the load has a Load MW Multiplier other than 1.0 or the 
load contains constant impedance or constant current components. If there is no on-
line load at the selected load bus or the bus at which the load is located is Open, no 
load move will occur. A MW (const pf) move will move the specified amount of load 
MW to the Bus to Move to while moving a Mvar amount that will maintain a 
constant power factor at the selected load bus. A Percent move will move the 
specified percent of the present load MW and Mvar to the defined Bus to Move to. A 
MW move will move the specified amount of the load MW to the Bus to Move to. A 
Mvar move will move the specified amount of the load Mvar to the Bus to Move to. 
The Move amount can be either positive or negative. A positive amount will decrease 
the load at the selected bus, and a negative amount will increase the load at the 
selected bus. The Bus to Move to will respond accordingly.  

If a load already exists at the bus to which the load is being moved, the load at that 
bus is adjusted according to the move amount. If no load exists, then a load is added 
at the bus and the load is set according to the move amount.  

Set To 

The Set To action will set the selected bus’ load parameters to a specified Amount. 
The load change is done on a bus basis and impacts the total of all loads at the 
selected bus. Load parameters can be set in MW (const pf), Percent, MW, or 
Mvar. The load value that is set for each of these options is the actual constant 
power component of the load. This value may be different than the nominal constant 
power component of the load if the area that contains the load has a Load MW 
Multiplier other than 1.0. If there is no on-line load at the selected load bus and the 
bus at which the load is located is Closed, load status at the selected load bus will 
change so that one load is Closed and the total constant power load at the bus will be 
set to the specified amount. If the bus at which the load is located is Open or there is 
no existing load, either Open or Closed, at that bus, then no load change will occur.  
When the load is set in MW (const pf), the actual constant power MW will be set to 
the specified amount and the actual constant power Mvar will be set so that a 
constant power factor is maintained at the load bus. When the load is set in Percent, 
the actual constant power MW and Mvar will be set to the specified percent of the 
present load MW and Mvar. When the load is set in MW, the actual constant power 
MW at the selected load will be set to the specified amount. When the load is set in 
Mvar, the actual constant power Mvar at the selected load will be set to the specified 
amount.  

When using the Set To action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in load due to the 
contingency action.  

Change By 

The Change By action will change the selected bus’ load parameters by a specified 
Amount. The load change is done on a bus basis and impacts the total of all loads at 
the selected bus. Load parameters can be changed in MW (const pf), Percent, 
MW, or Mvar. The load value that is changed for each of these options is the actual 
constant power component of the load. This value may be different than the nominal 
constant power component of the load if the area that contains the load has a Load 
MW Multiplier other than 1.0. If there is no on-line load at the selected load bus or 
the bus at which the load is located is Open, no load move will occur. When the load 
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is changed in MW (const pf), the actual constant power MW will be changed by the 
specified amount and the actual constant power Mvar will be changed so that a 
constant power factor is maintained at the load bus. When the load is changed in 
Percent, the actual constant power MW and Mvar will be changed by the specified 
percent of the present load MW and Mvar. When the load is changed in MW, the 
actual constant power MW at the selected load bus will be changed by the specified 
amount. When the load is changed in Mvar, the actual constant power Mvar at the 
selected load bus will be changed by the specified amount. 

When using the Change By action, the Make-up Power Sources button is enabled 
and power sources can be specified to account for the changes in load due to the 
contingency action. 

Switched Shunt 
Open 

The Open action will set the Status of the selected switched shunt to Open if the 
switched shunt Status is Closed. If the switched shunt Status is already Open, then 
this action does nothing. 

When using the Open action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in the real power portion 
of the switched shunt due to the contingency action.  

Close 
The Close action will set the Status of the selected switched shunt to Closed if the 
switched shunt Status is Open. If the switched shunt Status is already Closed, then 
this action does nothing. 

When using the Close action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in the real power portion 
of the switched shunt due to the contingency action.  

Move 

The Move action allows the transferring of switched shunt MW and/or Mvar from an 
existing switched shunt bus to another bus. Switched shunt moves are done on a bus 
basis and impact the total value of all switched shunts at the selected bus. During the 
move action, the nominal values of the switched shunts are adjusted, and switched 
shunts that are adjusted have their Control Mode set to Fixed. If there are no 
switched shunts at the selected switched shunt bus with a Status of Closed, no 
switched shunt move will occur. Switched shunt Moves may be done in Percent, 
MW, or Mvar. A switched shunt Move in Percent will move the specified percent of 
present nominal MW and Mvar at the switched shunt bus to the defined Bus to 
Move to. A MW move will move the specified amount of switched shunt MW to the 
Bus to Move to. A Mvar move will move the specified amount of switched shunt Mvar 
to the Bus to Move to. The Move amount can be either positive or negative. A 
positive amount will decrease the nominal MW and/or Mvar at the selected switched 
shunt bus, and a negative amount will increase the nominal MW and/or Mvar at the 
selected switched shunt bus. The Bus to Move to will respond accordingly.  

If a switched shunt exists at the bus to which the switched shunt MW and/or Mvar is 
being moved, the switched shunt at that bus is adjusted according to the move 
amount. If there are existing switched shunts at the Bus to Move to but all of them 
have a Status of Open, the first switched shunt Status will be set to Closed, the 
Control Mode will be set to Fixed, and the nominal MW and/or Mvar will be adjusted 
according to the move amount. If no switched shunt exists at the Bus to Move to, 
then the nominal constant impedance load is adjusted according to the move 
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amount. If no load exists at that bus, then a load is added and the nominal constant 
impedance load is adjusted according to the move amount. 

Set To 

The Set To action will set the selected bus’ switched shunt parameters to a specified 
Amount. Switched shunt changes are done on a bus basis and impact the total 
nominal value of all switched shunts at the selected bus. Switched shunts that are 
adjusted during Set To actions have their Control Mode set to Fixed. Switched shunt 
parameters can be set in Percent, MW, Mvar, or Setpoint Voltage. When a 
switched shunt bus is set in Percent, the nominal MW and Mvar are set to the 
specified percent of the present nominal MW and Mvar of the switched shunt bus. 
When the switched shunt bus is set in MW, the nominal MW is set to the specified 
amount. When the switched shunt bus is set in Mvar, the nominal Mvar is set to the 
specified amount. When the switched shunt bus is set in Setpoint Voltage, the 
Target Value of the controllable switched shunt at the bus is set to the specified 
amount. Switched shunts may either regulate voltage or generator Mvar. The amount 
entered for the Setpoint Voltage is considered to be in per unit when the switched 
shunt is regulating voltage and is considered to be in Mvar when regulating generator 
Mvar. If there are no switched shunts at the selected bus with a Status of Closed 
when setting MW or Mvar amounts, the Status of the first switched shunt at the bus 
will be set to Closed, the Control Mode will be set to Fixed, and the nominal value will 
be set appropriately.  

When using the Set To action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for the changes in switched shunt MW due 
to the contingency action.  

Change By 

The Change By action will change the selected bus’ switched shunt parameters by a 
specified Amount. Switched shunt changes are done on a bus basis and impact the 
total nominal value of all switched shunts at the selected bus. Switched shunts that 
are adjusted during the Change By action have their Control Mode set to Fixed. 
Switched shunt parameters can be changed in Percent, MW, Mvar, or Setpoint 
Voltage. When a switched shunt bus is changed in Percent, the nominal MW and 
Mvar are changed by the specified percent of the present nominal MW and Mvar of 
the switched shunt bus. When the switched shunt bus is changed in MW, the 
nominal MW is changed by the specified amount. When the switched shunt bus is 
changed in Mvar, the nominal Mvar is changed by the specified amount. When the 
switched shunt bus is changed in Setpoint Voltage, the Target Value of the 
controllable switched shunt at the bus is change by the specified amount. Switched 
shunts may either regulate voltage or generator Mvar. The amount entered for the 
Setpoint Voltage change is considered to be in per unit when the switched shunt is 
regulating voltage and is considered to be in Mvar when regulating generator Mvar. If 
there are no switched shunts at the selected bus with a Status of Closed when setting 
MW or Mvar amount, the Status of the first switched shunt at the bus will be set to 
Closed, the Control Mode will be set to Fixed, and the nominal value will be set 
appropriately. 

When using the Change By action, the Make-up Power Sources button is enabled 
and power sources can be specified to account for the changes in switched shunt MW 
due to the contingency action.  

Bus 

Open 
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The Open action will set the Status of all ac branches connected to the selected bus 
to Open. If all of the ac branches are already open, then this action does nothing. 

Interface 

Open 

The Open action will set the Status of all ac branches in the selected interface to 
Open. If all of the ac branches are already open, then this action does nothing. The 
Status of any dc lines, generators, loads, or injection groups that are part of the 
interface will remain unchanged due to the contingency action. If the selected 
interface contains additional interfaces, the Status of all ac branches in the additional 
interfaces will also be set to Open.  

Close 

The Close action will set the Status of all ac branches in the selected interface to 
Closed. If all of the ac branches are already closed, then this action does nothing. 
The Status of any dc lines, generators, loads, or injection groups that are part of the 
interface will remain unchanged due to the contingency action. If the selected 
interface contains additional interfaces, the Status of all ac branches in the additional 
interfaces will also be set to Closed.  

Injection Group 

Open  

The Open action will set the Status of all generators and loads in the selected 
injection group to Open if the Status is Closed. If the Status is already Open, this 
action does nothing. If the injection group contains other injection groups, the Status 
of the generators and loads in the other injection groups will also be set to Open.  

When using the Open action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for real power changes due to the status 
changes of generators and loads in the contingency action.  

Close 

The Close action will set the Status of all generators and loads in the selected 
injection group to Closed if the Status is Open. If the Status is already Closed, this 
action does nothing. If the injection group contains other injection groups, the Status 
of the generators and loads in the other injection groups will also be set to Closed.  

When using the Close action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for real power changes due to the status 
changes of generators and loads in the contingency action. 

Set To 

The Set To action will set the real power injection of the injection group to the 
specified Amount. If loads are included in the injection group, the Mvar load will be 
adjusted by keeping the power factor constant. The injection can be set in Percent, 
MW, Percent (In Merit Order), or MW (In Merit Order). When setting the 
injection in Percent or Percent (In Merit Order), the real power injection is set to 
the specified percent of the present real power injection. The present real power 
injection of the injection group is determined by taking the difference between the 
total generator MW and total load MW in the injection group. When setting the 
injection in MW or MW (In Merit Order), the real power injection is set to the 
specified amount. When selecting either the Percent or MW option, all generators 
and loads in the injection group are adjusted according to their relative participation 
factors. All generators and loads with non-zero participation factors will be adjusted 
to meet the desired injection. When choosing one of the In Merit Order options, 
only generators will be adjusted to meet the desired injection. Generators will be 
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adjusted in order of highest relative participation factor to lowest with each generator 
in the list being adjusted until it hits it hits either its maximum or minimum limit 
before moving on to the next generator. This process continues until the desired 
injection is met.  

When using the Set To action, the Make-up Power Sources button is enabled and 
power sources can be specified to account for real power changes due to the status 
changes of generators and loads in the contingency action. 

Change By 

The Change By action will change the real power injection of the injection group to 
the specified Amount. If loads are included in the injection group, the Mvar load will 
be adjusted by keeping the power factor constant. The injection can be set in 
Percent, MW, Percent (In Merit Order), or MW (In Merit Order). When 
changing the injection in Percent or Percent (In Merit Order), the real power 
injection is changed by the specified percent of the present real power injection. The 
present real power injection of the injection group is determined by taking the 
difference between the total generator MW and total load MW in the injection group. 
When changing the injection in MW or MW (In Merit Order), the real power 
injection is changed by the specified amount. When selecting either the Percent or 
MW option, all generators and loads in the injection group are adjusted according to 
their relative participation factors. All generators and loads with non-zero participation 
factors will be adjusted to meet the desired injection change. When choosing one of 
the In Merit Order options, only generators will be adjusted to meet the desired 
injection. Generators will be adjusted in order of highest relative participation factor 
to lowest with each generator in the list being adjusted until it hits either its 
maximum or minimum limit before moving on to the next generator. This process 
continues until the desired injection change is met. 

When using the Change By action, the Make-up Power Sources button is enabled 
and power sources can be specified to account for real power changes due to the 
status changes of generators and loads in the contingency action. 

Series Capacitor 
Bypass 

The Bypass action will change the Bypass Status of the selected series capacitor to 
Bypassed if the Bypass Status is Not Bypassed. If the Bypass Status is already 
Bypassed, this action does nothing. 

Inservice 
The Inservice action will change the Bypass Status of the selected series capacitor to 
Not Bypassed if the Bypass Status is Bypassed. If the Bypass Status is already Not 
Bypassed, this action does nothing. 

Set To 
The Set To action will set the series reactance of the series capacitor to a specified 
Amount. The reactance may be set in X (percent) or X (per unit). If the 
reactance of the series capacitor is set in X (percent), the per unit reactance is set 
to the specified percent of the present per unit reactance of the series capacitor. If 
the reactance is set in X (per unit), the per unit reactance of the series capacitor is 
set to the specified amount.  

DC Line 

Open 

The Open action will set the Control Mode of the selected dc line to Blocked. If the dc 
line is already blocked, then this action does nothing. 
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Close 

The Close action will set the Control Mode of the selected dc line to either Power or 
Current. When selecting the Close action, the Amount must be specified for the new 
Setpoint of the dc line in either MW or Amps. If specifying the Setpoint in MW, the 
Control Mode of the dc line will be set to Power. If specifying the Setpoint in Amps, 
the Control Mode of the dc line will be set to Current.  

Set To 

The Set To action will set the selected dc line’s Setpoint to a specified Amount and 
could possibly change the Control Mode of the line. The Setpoint can be set in 
Percent, MW, or Amps. When the dc line’s Setpoint is set in Percent, the Setpoint 
is set to the specified percentage of the present Setpoint of the line and the Control 
Mode remains unchanged. If the Control Mode is presently Blocked, the resulting 
Setpoint will be 0 regardless of the Amount entered. When the Setpoint is set in MW, 
the Setpoint is set to the specified MW amount, and the Control Mode is changed to 
Power if the Control Mode is presently Current. If the Control Mode is Blocked or 
Power, then the Control Mode remains unchanged. When the Setpoint is set in 
Amps, the Setpoint is set to the specified current amount, and the Control Mode is 
set to Current if the Control Mode is presently Power. If the Control Mode is Blocked 
or Current, then the Control Mode remains unchanged. 

Change By 

The Change By action will change the selected dc line’s Setpoint by the specified 
Amount and could possibly change the Control Mode of the line. The Setpoint can be 
changed in Percent, MW, or Amps. When the dc line’s Setpoint is changed in 
Percent, the Setpoint is changed by the specified percentage of the present Setpoint 
of the line and the Control Mode remains unchanged. If the Control Mode is presently 
Blocked, the resulting Setpoint will be 0 regardless of the Amount entered. When the 
Setpoint is changed in MW, the Setpoint is changed by the specified MW amount, 
and the Control Mode is changed to Power if the Control Mode is presently Current. If 
the Control Mode is Blockedor Power, then the Control Mode remains unchanged. 
When the Setpoint is changed in Amps, the Setpoint is changed by the specified 
current amount, and the Control Mode is set to Current if the Control Mode is 
presently Power. If the Control Mode is Blocked or Current, then the Control Mode 
remains unchanged. 

When the Control Mode changes from either Power to Current or from 
Current to Power, the appropriate conversions are done so that the 
resulting Setpoint value reflects the original Setpoint and the change in 
Setpoint in the same units.  

Phase Shifter 

Set To 

The Set To action will set the middle of the regulation range of the selected phase 
shifter to the specified Amount. The middle of the regulation range is calculated by 
taking the average of the Regulation Minimum MW Flow and Regulation Maximum 
MW Flow. The middle of the regulation can be set in Percent or MW. If the middle 
of the regulation range is set in Percent, the middle of the range is set to the 
specified percent of the present middle of the regulation range. If the middle of the 
regulation range is set in MW, then the middle of the regulation range is set to the 
specified amount. Regardless of the method used to set the middle of the regulation 
range, the regulation range will remain the same, but the Regulation Minimum MW 
Flow and Regulation Maximum MW Flow will be adjusted so that the specified middle 
of the regulation range is met. 
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Change By 

The Change By action will change the middle of the regulation range of the selected 
phase shifter by the specified Amount. The middle of the regulation range is 
calculated by taking the average of the Regulation Minimum MW Flow and the 
Regulation Maximum MW Flow. The middle of the regulation range can be changed in 
Percent or MW. When the middle of the regulation range is changed in Percent, the 
change is based on the specified percent of the present middle of the regulation 
range. When the middle of the regulation range is changed in MW, the middle of the 
present regulation range is changed by the specified amount. Regardless of the 
method used to change the middle of the regulation range, the regulation range will 
remain the same, but the Regulation Minimum MW Flow and Regulation Maximum 
MW Flow will be adjusted so that the specified middle of the regulation range is met.  

3-Winding Transformer 

Open  
The Open action will set the Status of the selected three-winding transformer to Open 
if the three-winding transformer Status is Closed. If the three-winding transformer 
Status is already Open, then this action does nothing. 

Close 
The Close action will set the Status of the selected three-winding transformer to 
Closed if the three-winding transformer Status is Open. If the three-winding 
transformer Status is already Closed, then this action does nothing. 

Solve Power Flow 
The solve power flow type is unique in that you can include an action that forces 
Simulator to solve the power flow as part of the contingency. There are rare special 
cases of sophisticated contingency definitions this can be used for, as requested by one 
or more PowerWorld customers. The load flow is already generally solved for each 
contingency as part of the processing. 

If a contingency has one or more Solve Power Flow actions, then there will be a few 
changes in how the contingency definition display behaves.  
• Sorting of the list of actions is no longer allowed. This is because the order of the 

actions is now important to how the contingency is processed. 
• When you right-click on the list of contingency actions there will be two new options 

for Move Up and Move Down. These can be used to reorder the actions. 
• On the Contingency Definition Dialog, there will be up/down arrows on the right of 

the dialog that may be used to reorder the actions. 

Contingency Block 

The individual actions of the Contingency Block are applied according to how they are 
defined. There are no Action Types available for a Contingency Block.  

Choose the Element 

Use this portion of the dialog to choose the element involved in this action. This behaves the 
same as the Advanced Find Dialogs used throughout the software. 

Action Type 

Defines the change specified by the contingency action. The Action Types available depend 
on the Element Type selected. Possible Action Types include: Open, Close, Move, Set To, 
Change By, Bypass, and Inservice. The behavior of each of these actions for the different 
elements is described with the Element Types. 

Amount 
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Enterable fields used to specify the quantity of change desired for the contingency element. 
The Amount fields are enabled when the Action Type is set to Move, Set To, or Change By. 
The availability of these Action Type options changes depending on the Element Type 
selected. The top field is used to define a Constant, Field, or Model Expression depending on 
the entry selected in the bottom drop-down box. Use the Find button to display a dialog 
listing Fields or Model Expressions. This dialog behaves the same as the Advanced Find 
Dialogs used throughout Simulator. 

The Amount of change that occurs is based on the value of the top field entry. The top entry 
field is a constant, field name, or model expression name. When this entry is a field name, 
then the value of the change is based on the value of the selected element field when the 
contingency occurs. When this entry is a model expression, then the value of the change is 
based on the value of the selected model expression when the contingency occurs.  

The Amount of change that occurs for the selected element is based on the value entered in 
the top field and the parameter set with the in options. The availability of the in options will 
change based on the Element Type selected and the Action Type selected. The availability of 
these options is described in detail with the Element Types. 

Make-up Power Sources 

Power injection contingency actions result in power imbalances - typically picked up by the 
system slack - that may result in Power Flow Convergence Problems. Simulator provides the 
option of specifying Make-up Power Sources for generation, load, injection group, and 
switched shunt contingencies to both offset the resulting real power imbalance and provide 
a more realistic simulation. See Make-up Power Sources for more information. 

Model Criteria 

Click the Add button to specify a criterion under which the contingency action will occur. 
Either a Model Filter or Model Condition can be selected for the Model Criteria. For example, 
the user can specify that a generation outage only occur if the pre-contingency flow on a 
line is higher than a specified amount. This condition should be specified as a Model 
Condition and then this condition selected as the Model Criteria. Normally, no Model Criteria 
will be specified for a given action and this field will be blank. 

Comment 

An optional user-specified comment string associated with the action. For example, for an 
action with Model Criteria specified, you could add a sentence explaining why the action is 
only performed under the specified criteria. While this comment is not used by Simulator in 
any way, it is saved with the contingency element when saving contingency records in 
contingency auxiliary data files or with the case PWB file.  
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Make-Up Power Sources 

  

Generator, load, injection group, and switched shunt contingencies may cause imbalances 
between generated power and demand. The default way to handle these imbalances is to 
assign them to the system slack. However, this is probably unrealistic and, depending on the 
size of the unit or load involved, convergence problems may result.  

To implement more local compensation for generation, load, injection group, and switched 
shunt changes, use the Make-Up Power Sources Dialog. This dialog can be accessed by from 
the Contingency Element Dialog by clicking the button labeled Make-Up Power Sources. 
Most of the dialog is occupied by a grid that lists bus numbers and relative contributions. This 
grid is a Case Information Display, so its behavior should be familiar. For example, right-click 
on the grid to display its local menu. 

We shall call those buses that must compensate for the changes caused by a generator, load, 
injection group, or switched shunt contingency "compensators". To insert a new compensator, 
select Insert from the grid’s local menu. This opens another dialog, where you should specify 
the bus number of the compensator and its contribution. Specify the contribution of the 
compensator either as a percentage or as a fixed number of MW. If a particular contingency 
has multiple compensators, then the choice of basis for the contribution (either MW or 
percent) should be consistent for each. After identifying the compensator, click OK. The grid 
should update with your newly added compensator. 

To delete an existing compensator, select it from the grid and select Delete from the local 
menu. 

To determine how much each compensator contributes to the imbalance, each contribution 
value is normalized to the total sum of all contribution values. This allows the values to be 
entered in either percent or MW. Keep in mind that when entering the values in percent that 
the sum of all contribution values should equal 100 or the actual contribution amounts will not 
occur in the expected percentages.  

Compensators account for the changes caused by a generator, load, injection group, or 
switched shunt contingency by changing either generation or load to satisfy its defined 
contribution. For example, suppose compensator contributions are specified as percentages, 
and Simulator needs to compensate for 100 MW lost in a particular generation contingency. 
Suppose the contingency has 4 compensators defined as follows: 

Bus Number Contribution 

1  20 

2  30 

3  10 

4  40 

Suppose buses 1 and 2 are load buses, and buses 3 and 4 are generators. Then bus 1’s load 
will decrease by 20 MW, bus 2’s load will decrease by 30 MW, bus 3’s generation will increase 
by 10 MW, and bus 4’s generation will increase by 40 MW. These changes will be instituted 
regardless of the compensators’ operating limits or AGC status. In fact, any compensating 
units will be set off AGC to ensure that the prevailing AGC control does not distort the dictates 
of the contingency. Furthermore, maximum MW limits on generators will not be checked. 

If a compensator has both generators and loads attached to it, the generator will take 
precedence. The generator will function as the compensating device, and the load will be left 
unchanged. 
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Contingency Make-Up Sources Dialog 

  

Simulator allows you to specify buses that will serve as compensators to account for changes 
in the balance between generation and demand caused by generator and load contingencies. 
This dialog allows you to define or adjust the amount of power supplied by a compensator. For 
more information, please see Make-Up Power Sources. 
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Tutorial: Contingency Analysis 

  

This tutorial will walk you through the basic commands necessary to insert contingencies and 
have Simulator automatically analyze the results. Please see Introduction to Contingency 
Analysis for the necessary background information regarding the capabilities and uses of the 
Contingency Analysis tool. 

For this tutorial, we will use an existing 7-bus case.  
• Open case B7SCOPF from the Program Files/PowerWorld/Simulator/Sample Cases 

directory.  
• Ensure Simulator is in Run Mode.  
• Select Contingency Analysis from the Run Mode ribbon group on the Tools ribbon tab. 

Simulator opens the Contingency Analysis Dialog. 
  

The next section of the tutorial discusses Defining Contingencies and provides an example of 
inserting a single element contingency. 

1  2 3 4 5 6 7 8 9 10 11  

Next  
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Tutorial: Contingency Analysis - Page 2 

  

Defining Contingencies 

Contingencies can be either Single Element or Multiple Element. A single element contingency 
has only one associated contingent action. Click here for more information on the terminology 
used. There are four options for defining contingencies. The user may: Load Contingencies 
from a File, Auto Insert Contingencies, or use the local menu to either Insert contingencies or 
Quick Insert of Single Element Contingency. This tutorial will utilize the Auto Insert and 
Quick Insert tools. 
  

Quick Insert of Single Contingency Element 

• Right-click on the grid (as shown below) and select Insert Special > Quick Insertof 
Single Element Contingency from the local menu. Simulator opens the Contingency 
Element Dialog. 

 
  

Contingency Analysis Dialog 
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Contingency Element Dialog 

  
Note: The active fields in this dialog depend upon which Element Type is selected.  

The defined action for this contingency will be to change the load at bus 2 by 25%. 
• Select Load under Element Type and 2 (2) #1 [138 KV] under Choose the Element. 
• Select Change By under Action Type.  
• Enter 25 for Amount, choose Constant from the drop-down box, then select Percent 

under the field labeled in. 

Note that you can enter either positive or negative values in the Amount field to specify the 
direction that you want the change to occur (i.e. for a load contingency, entering a positive 
Amount increases the power consumed by the load, a negative value would decrease the 
load’s power consumption).  

Power injection contingency actions result in power imbalances - typically picked up by the 
system slack - that may result in Power Flow Convergence Problems. Simulator provides the 
option of specifying Make-up Power Sources for generation, load, injection group, and 
switched shunt contingencies to both offset the resulting imbalance and provide a more 
realistic simulation. See Make-up Power Sources for more information. See Model Criteria and 
Comment in the Contingency Element Dialog for more information on those fields. For the 
purpose of this tutorial, we will not use these fields. 
• Click OK to insert the contingency element.  

The lower right portion of the Contingencies Tab contains a Contingency Definition list display. 
This display lists all elements (actions) associated with the selected contingency. Since we 
inserted a single element contingency, there is only one element shown in the Definition.  
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Contingencies Tab – Definition Display 

  
The next portion of the tutorial provides an example of Auto Insertion of Contingency 
Elements. 
  

1 2  3 4 5 6 7 8 9 10 11  

Prev  Next 
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Tutorial: Contingency Analysis - Page 3 

  

Simulator allows you to automatically generate a contingency list containing branch, 
generator and/or bus outages. To accomplish this, right-click in the Contingencies grid on the 
Contingency Analysis Dialog, and select Insert Special > Auto Insert Contingencies from 
the popup menu. This opens the Auto Insertion of Contingencies Dialog. 

  

 
  

Auto Insertion of Contingencies Dialog 

  

We will insert contingencies for all branches and generators. This will require two executions 
of the auto insert tool.  
• Verify that Single Transmission Line or Transformer is selected.  

When using the Auto Insert tool, you can limit the contingencies inserted to only those 
meeting a defined filter. We want to insert contingencies for all branches and generators so no 
filtering is desired. 
• Click to remove the checkmark in Use Area/Zone Filters. 
• Verify that no other options are selected. 
• Click the Do Insert Contingencies button to accept the remaining default values and 

automatically insert the branch contingencies. 
• Click Yes when asked to confirm the insertion of 11 contingencies.  

Note that the Contingencies Tab of the Contingency Analysis Dialog now shows 12 
contingencies.  
• Right-click on the list display of the contingencies tab and select Insert Special > Auto 

Insert Contingencies from the local menu. 
• Select Single Generating Unit then click the Do Insert Contingencies button. Click 

Yes to complete the auto insert of 4 generator contingencies.  
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Note that the Auto Insert tool did not insert a contingency for the generator connected to the 
Slack Bus. You can manually insert slack bus generator contingencies. 

The contingencies tab now shows 16 contingency records. You can click on an individual 
record and view its information in the Contingency Definition section of the Contingencies Tab. 
  

The next section of the tutorial discusses running the contingency analysis. 
  

1 2 3  4 5 6 7 8 9 10 11  

Prev  Next 
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Tutorial: Contingency Analysis - Page 4 

  

When running the Contingency Analysis, the user has three options: 
1. Run every contingency on the list of contingencies (click Start Run on the Contingencies 

Tab, click Start on the Summary Tab or select Run Contingency Analysis from the 
local menu of the list of contingencies) 

2. Run a single contingency (discussed in the advanced tutorial section) or 
3. Run a single contingency then save the post-contingency state as the new reference state 

(also discussed in the advanced tutorial section) 

We will run every contingency in the list for this portion of the tutorial. 
• Press Start Run on the Contingencies Tab. Note: Pause and Abort buttons are available 

on the dialog while the contingency analysis is running. These may prove useful when 
processing a long list of contingencies. 

The results from the run are shown in the Contingency Analysis Dialog. 
  

 
  

Contingency Analysis Dialog – Contingencies Tab 

  

Note: The Refresh Displays after Each Contingency option (lower right) can slow down 
the analysis significantly when running a long list of contingencies. 

The contingency analysis results are sorted on the contingencies tab in descending order by 
worst violation. We see that there were three violations resulting from the contingency 
analysis (one for each of the first three contingency records displayed) and that no unsolvable 
load flows resulted (as shown in the Status Section of the Contingencies Tab.) If you enlarge 
the Contingency Analysis Dialog (by dragging either side or the corner of the pane) you see 
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more information in the Status Window, specifically, "Finished with 3 Violations and 0 
Unsolvable Contingencies. Initial State Restored."  

Contingency Analysis always stores a Reference State or pre-contingency state. The Reference 
State stores information pertaining to: buses, switched shunts, limit groups, loads, branches, 
generators, areas / super areas, and power flow solution options. 

Both prior to and following completion of solving a list of contingencies, the reference state is 
loaded into memory. This ensures that all contingency analysis solutions start from a common 
base case and that the system is restored to its initial state following a solution. The last 
sentence in the Status portion of the dialog, "Initial State Restored," tells the user that the 
simulation case was restored to the reference state upon completion of the Contingency 
Analysis Run. See Contingency Case References for more information on the Reference State. 

The Violations Section (lower left) of the Contingencies Tab provides a description of each 
violation resulting from the execution of the contingency selected in the list of contingencies. 
Scroll through the list of contingencies to view information about the resulting violations for 
each.  

Note: You can hide the Contingency Definition section of the Contingencies Tab by clicking the 

 button. 
  
  

1 2 3 4  5 6 7 8 9 10 11  

Prev   Next 
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Tutorial: Contingency Analysis - Page 5 

  

The Summary Tab of the Contingency Analysis Dialog provides the status of the present 
contingency analysis run.  
  

 
  

Contingency Analysis Dialog – Summary Tab 

  

1 2 3 4 5  6 7 8 9 10 11  

Prev  Next 
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Tutorial: Contingency Analysis - Page 6 

  
• Click on the Lines, Buses, Interfaces Tab of the dialog. 

The Lines, Buses and Interfaces Tab contains four sub-tabs: Lines/Transformers, Buses, 
Interfaces, and Nomogram Interfaces. The information contained on each of the sub-tabs 
provides an alternate method of viewing information similar to that contained on the 
Contingencies Tab. The individual tabbed sheets show all model objects defined in the case 
(subject to area/zone/owner filters) whether each is associated with a specific contingency or 
not.  
  

 
  

Contingency Analysis Dialog – Lines, Buses, Interfaces Tab 

  

The user can select any model object on its respective sheet to see how many times a 
violation occurred on the device during the contingency analysis. When a particular device is 
selected that had at least one violation during the contingency run, the Contingencies and 
Contingency Definition sections give the details of the specific contingencies that caused the 
violation (or violations) on the selected device. For example, on the Lines/Transformers sub-
tab: 
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• Select the line from 2 to 5 as shown above. This line had one violation on the most recent 
contingency analysis run. The contingencies section shows which contingency caused the 
violation and the contingency definition section details the elements that define the 
contingency.  

• Switch back to the Contingencies Tab of the dialog. 
• Scroll down in the list of contingencies and select the contingency labeled CHANGE LOAD 

AT BUS 2 (2) 
• Right-click on the element displayed in the Contingency Definition Section of the 

Contingencies Tab 
• Select Show Dialog from the local menu.  
• Modify the element’s Action to: Set To 600 MW (const pf) using the Action Type, 

Amount, and in fields of the Contingency Element Dialog. 
• Click OK to close the dialog. The Contingency Definition should now show SET LOAD AT 

BUS 2_138 (2) TO 600.00 MW (const pf). 
• Click Start Run on the dialog and Yes when asked to confirm. 
• Following the run, the Status field now shows, "Finished with 7 Violations and…" The 

increase in load resulted in four contingency violations not present during the last run.  
• Again select the contingency labeled SET LOAD AT BUS 2… on the list display. The 

Violations section shows the four branch violations that occurred for the selected 
contingency. 

• Now switch to the Lines, Buses, Interfaces tab.  
• Select the line from 2 to 5. This line experienced violations under two contingencies during 

the run. The Contingencies section now shows the details of both contingencies (opening 
line 5 to 7 and changing the load at bus 2) that caused overloads on the line. Notice that 
the information in the Contingency Definition section is specific to the Contingency 
selected in the Contingencies section. 

Note: The Show Related Contingencies and Show Other Violations buttons (on the 
Contingencies and Lines, Buses, Interfaces tabs respectively) provide a fast method of 
switching between the two tabs and viewing related information. 

  

1 2 3 4 5 6  7 8 9 10 11  

Prev  Next 

 



Run Mode Tools and Options 
 

818 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

 Tutorial: Contingency Analysis - Page 7 

  

You now have enough information to effectively utilize PowerWorld Simulator’s Contingency 
Analysis tool. The remaining portions of the tutorial introduce the full capabilities of the 
Contingency Analysis tool and provide links to the applicable Help files. 

Contingency Records 

There are four methods of defining contingencies. See Defining Contingencies for more 
information. Contingency Records can also be saved to or loaded from a file. 

Contingency Blocks and Global Actions 

The user may desire to have a common set of actions occur during more than one (or all) 
contingencies. Instead of repeatedly defining the same contingency element (or elements) in 
multiple contingencies, Simulator provides the option to use Contingency Blocks and/or Global 
Actions.  

A Contingency Block is a set of contingency actions that can be defined and then called upon 
by individual contingency records. 

Global Actions are actions defined by the user that will occur during all contingencies. 

Contingency Solution Options 

By default, the contingency analysis will use the same options as the power flow algorithm 
when solving each contingency. You may also override these options for all contingencies, 
and/or for a specific contingency. This results in the ability to set the power flow solution 
options in contingency analysis at three different levels 
1. Contingency Specific Options (see Contingency Definition Dialog) 
2. Contingency Analysis Options (see Contingency Options Tab) 
3. General Power Flow Solution Options (see Power Flow Solution Options) 

When Simulator executes a particular contingency, it will first look at options specified for that 
contingency. Any options defined for the contingency will be used. Other options set to use 
default will look to the Contingency Analysis Options. Again, any options defined for 
contingency analysis will be used. Finally, options marked in the Contingency Analysis Options 
as use default will be set to the same setting as the power flow solution options. 
  
  

  

1 2 3 4 5 6 7  8 9 10 11  
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Tutorial: Contingency Analysis - Page 8 

  

Reference State 

The Reference State (introduced on page 4 of the tutorial) can prove very useful to advanced 
users if they know how to exploit its capabilities. When running a list of contingencies the 
reference state is loaded into memory prior to executing each contingency. The system is 
restored to the reference state following the contingency analysis run. In addition to running 
an entire contingency list, the user also has the option to solve individual contingencies by 
right clicking on the desired contingency - on the Contingencies tab of the Contingency 
Analysis Dialog - and selecting either Solve Selected Contingency or Solve and Set as 
Reference from the local menu. 

Solve Selected Contingency causes Simulator to first load the reference state into memory 
then solve the contingency. THE SYSTEM STATE IS NOT RESTORED TO THE REFERENCE 
STATE FOLLOWING THE SOLUTION; the system state then reflects the power system flows of 
the post-contingency state. The advantage of this approach is the ability to implement a 
contingency and then modify the system looking for possible actions that might mitigate 
violations caused by the contingency. Be aware; however, that prior to solving another 
contingency, Simulator will reset the system state to the reference state thereby removing all 
modifications made following the previous contingency solution. The user may also 
automatically restore the system state to the reference state by selecting Other > Restore 
Reference from the Contingency Analysis Dialog. 

Solve and Set As Reference acts the same as Solve Selected Contingency with one 
exception. After executing the contingency, the post-contingency state is automatically set as 
the reference state. As a result, all subsequent contingencies will use the post-contingent state 
as the Reference State. 

Make-up Power Sources 

Power injection contingency actions result in power imbalances - typically picked up by the 
system slack - that may result in Power Flow Convergence Problems. Simulator provides the 
option of specifying Make-up Power Sources for generation, load, injection group, and 
switched shunt contingencies to both offset the resulting imbalance and provide a more 
realistic simulation. See Make-up Power Sources for more information.  
  
  

1 2 3 4 5 6 7 8  9 10 11  
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Tutorial: Contingency Analysis - Page 9 

  

Contingency Elements 

A contingency element consists of a single Contingency Action and its associated Model 
Criteria, Status and Comment (optional). Multiple Contingency Elements can be defined for a 
single Contingency. 

Contingency Action - Click here for a list of available contingency actions. 

Model Criteria - Model Criteria are criteria under which the contingency action will occur and 
consist of both Model Conditions and Model Filters.  

Status – The status field of a contingency element can take one of four values: CHECK, 
ALWAYS, NEVER or POSTCHECK. 
• CHECK - The action will be executed if the Model Criteria are true or if no Model Criteria 

are specified. CHECK is the default status setting. 
• ALWAYS - The action will always be executed, regardless of the Model Criteria. 
• NEVER - The action will never by executed, regardless of the Model Criteria. This allows 

you to disable a particular contingency action without deleting it. 
• POSTCHECK – Following completion of all CHECK and ALWAYS actions, the contingency 

analysis tool runs the load flow solution. POSTCHECK actions are then addressed 
recursively until all are complete. The execution of POSTCHECK actions follows the same 
rules as CHECK actions with the exception of not being checked until the load flow has 
been solved. If the Model Criteria specified for the POSTCHECK action are met in the 
solved load flow solution (or if no Model Criteria are specified), then the action is taken 
and the load flow is again resolved. If the model conditions are not met, the action is 
skipped. 

For more information, see Contingency Definition Display. 
  

1 2 3 4 5 6 7 8 9  10 11  
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Tutorial: Contingency Analysis - Page 10 

  

Contingency Analysis Dialog – Options Tab Overview 

The bulk of the Options Tab contains five sub-tabs, each of which concerns a different aspect 
of the contingency analysis. A brief description of the actions allowed via each sub-tab follows. 
Click on the headings below for more information on each. 

Modeling Sub-tab  

The modeling tab allows the user to: 
• Define the Contingency Analysis Load Flow Calculation Method 
• Specify Limit Monitoring Settings 
• Instruct Simulator to retry the solution using the Robust Solution Process following a 

failure to converge 
• Specify the use of specific solution options for contingencies 
• Specify Make-up Power for the post-contingency solution 

Advanced Limit Monitoring Sub-tab 

The Advanced Limit Monitoring Tab allows you to shape how limit violations are detected and 
reported. 

Advanced Modeling Sub-tab 

The Advanced Modeling tab allows the user to: 
• Define Contingency Blocks and Global Actions (refer to Page 7 of the tutorial) 
• Define Model Criteria (Expressions, Conditions and Filters) 
• Specify Model Criteria Options 
• Define Bus Load Throw-Over Records – BLTRs provide the capability to define how load at 

a bus should be transferred to a different bus if the original terminal bus becomes 
disconnected from the system during a contingency 

• Define Generator Maximum MW Responses in Post-Contingency – allows the user to limit 
the absolute MW response of a generator during a contingency 

• Define Generator Line Drop Compensation (LDC) and Reactive Current Compensation 
(RCC) – LDC and RCC controls allow the user to model the real-time control done at some 
real generators 

• Specify a post-contingency aux file to be loaded at the start of each contingency. This 
allows the setting of very specialized post contingency settings. 

• Specify how reactive power is modeled for DC calculation methods 

Report Writing Sub-tab 

Simulator can produce a report that details the results of the contingency. The Report Writing 
Tab allows you to control the content and appearance of the report. 

Miscellaneous Sub-tab 

The Miscellaneous sub-tab provides options pertaining to the loading and saving of 
contingency records as well as specifying how the reference state should be established when 
the contingency analysis tool is accessed. 
  

1 2 3 4 5 6 7 8 9 10 11  
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Tutorial: Contingency Analysis - Page 11 

  

Contingency Analysis Dialog – Other Contingency Actions 

The Other > buttonon the Contingencies Tab and the Lines, Buses, Interfaces Tab of the 
Contingency Analysis Dialog, provides access to a number of additional contingency actions. 
Some of the actions available include: 
• Deleting all contingencies 
• Clearing contingency results 
• Setting or restoring the reference state 
• Producing combined tables of results 
• Producing detailed reports of results 
• Comparing lists of contingencies 
• Filtering results 
• Auto-filling blank comment fields and performing sensitivity calculations such as OTDFs 

and PTDFs. 

For more information, see Other Contingency Actions. 

  

1 2 3 4 5 6 7 8 9 10 11  
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Fault Analysis 

  

Fault analysis can only be performed when Simulator is in Run Mode. There are three ways to 
start a fault analysis study: 
  
• Go to the Tools ribbon tab, and choose Fault Analysis from the Run Mode ribbon group. 

This is only available in Run Mode. 
• Right click on a bus and choose Fault… to perform a fault analysis at that bus 
• Right click on a line and choose Fault… to perform a fault analysis at that point on the 

line 
  

All of these options will open the Fault Analysis dialog. If you opened the dialog by right-
clicking on a bus or line, the fault information on that bus or line will already be filled in. If you 
selected the Fault Analysis… option from the Tools ribbon tab, the information about the 
location of the fault will need to be provided. 
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Fault Analysis Dialog 

  

The Fault Analysis dialog can be used to perform a fault analysis study on the currently 
loaded power system. A fault study can only be performed while Simulator is in run mode, 
since the load flow must be validated and solved before a fault study can be calculated. If you 
are observing fault analysis results in the fault analysis dialog and switch to edit mode, the 
dialog will automatically be closed and the fault analysis results will be cleared from memory. 

Simulator stores fault data in the PowerWorld binary file along with the load flow data, but by 
default most other load flow formats store fault data in separate files. The fault data can be 
stored in and loaded from an external file, but if no fault data is present in a PowerWorld 
binary file or loaded from an external file before a fault analysis is run, Simulator will use the 
load flow data as default values for the analysis. Fault data values can also be modified for 
specific devices by opening a specific device's information dialog and looking at the Fault… 
tab. Devices that require sequence specific data for fault analysis are buses (for sequence load 
injections), generators, switched shunts, transmission lines, and transformers. 

Phase shifts in a fault analysis calculation can be very important for calculating the correct 
fault currents and voltages throughout the system. The phase shifts that are applied for 
transmission lines and transformers are taken from the load flow values of phase entered with 
each specific transmission element. While transformers can have their transformer 
configurations specified (i.e. Delta-Wye, Grounded Wye-Delta, etc.), these configurations are 
NOT used to determine phase shift angles, ONLY to determine the proper grounding on each 
side of the transformer. The phase shifts that are applied are taken from the load flow data 
phase values for the transmission elements. If no phase shifts are entered in the load flow 
data, the fault analysis will treat all elements as having zero phase shift. Phase shift values can 
be entered manually for each transmission element, but are also included in most load flow 
formats and will be read into Simulator when loading a load flow data file. 

Note that the bus chosen for the fault is always set to a 0 degree reference, and all other 
buses are shifted according to this reference. 
  

Fault Data 

The Fault Data tab is where the type and location of the fault are specified, and where the 
results of the fault analysis can be seen in tabular format. 

Fault Location 

Choose to perform the fault at a bus location, or at a point somewhere on a line. If Bus 
Fault is selected, the only information needed is the bus number, which needs to be entered 
in the Fault Bus field. If an in-line fault is desired, the from and to bus numbers, circuit ID, 
and location of the fault (entered in percent of total line length, measured from the From 
Bus) will need to be given. Selecting the Fault… option from the bus or line local menus will 
automatically set up the Fault Location fields. 

Fault Type 

Choose from one of four types of fault to calculate at the fault location: 

Single Line - to - Ground Computes a single phase line - to - ground fault using a user 
defined ground fault impedance. The phase evaluated is always referenced as phase A. 

Line - to - Line Computes a line - to - line fault, assuming an impedance of 999 + j999 to 
ground. Phases B and C are always referenced as the faulted phases. 

3 Phase Balanced Balanced three-phase line fault - to - ground using a user-defined 
ground fault impedance. 
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Double Line - to - Ground Computes a line - to - line - to - ground fault, using a user 
defined ground fault impedance. 

Current Units 

Allows you to choose to observe the fault currents in per unit current or actual Amps. 

Oneline Display 

The string grids at the bottom of the Fault Analysis dialog will display the fault results in 
tabular format, but the results can also be viewed graphically on the oneline diagram by 
selecting an option from this group of options. Any of the three phase values can be 
selected for display individually, or all three phases can be viewed simultaneously. Viewing 
all three phases of information simultaneously can result in an abundance of information on 
the diagram at one time, so selective placement of the necessary bus and line fields may 
need to be considered when planning on viewing the fault analysis results graphically on the 
oneline diagram. 

The fields necessary on the oneline diagram for display of the fault analysis results are: 

• Bus Voltage and Bus Angle fields need to be present for a bus. When choosing to view 
fault analysis results, these two fields will be identified, and the actual load flow values will 
be replaced by the fault phase voltages (in per unit) and angles (in degrees). 

• AC Line MW Flow and AC Line Mvar Flow fields need to be present for a line. These 
two fields will be identified, and the MW and Mvar values will be replaced by the fault 
phase current magnitudes (in Amps or per unit) and angles (in degrees). 

• Gen MW Output and Gen Mvar Output fields need to be present for a generator. 
These two fields will be identified, and the MW and Mvar values will be replaced by the 
generator terminal fault phase current magnitudes (in Amps or per unit) and angles (in 
degrees). 

Fault Current 

Displays the magnitude and angle of the current at the fault location during the fault. 

Calculate 

Pressing this button will run the fault analysis. In order for the results to be calculated, the 
power flow has to be in a solved state for the results to have any relevance. Therefore the 
first thing performed when Calculate is pressed is to solve the power flow. You can 
observe this by viewing the Message Log when you run the calculation. Once the power flow 
has been solved, then the fault analysis calculations are run and the results displayed. 

Clear 

Pressing Clear will clear any fault analysis results currently in memory and displayed on the 
dialog. 

There are also five informational displays at the bottom of this dialog for showing the fault 
analysis calculation results: 

Buses 

Lines 

Generators 

Loads 

Switched Shunts 
  

Fault Options 
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The Fault Options tab is where an impedance to ground can be defined at the fault location, 
where fault data can be loaded from or saved to an external file, and zero-sequence mutual 
impedances can be viewed or changed. 

Fault Impedance 

For any of the fault types calculated, a Fault Impedance can be included. A Resistance 
and Reactance can be entered as the path to ground of the fault, and is taken into account 
when calculating the fault current used to determine the rest of the fault values. 

Load Data / Save Data 

These two buttons allow loading from and saving to external files. Currently the two types of 
files supported are PSS/E Sequence Data files (.seq) and PowerWorld Simulator Auxiliary 
files (.aux). Either one of these formats can be loaded and saved. 

Zero Sequence Mutual Impedances 

Zero sequence mutual impedances can be stored and modified in the Mutual Impedance 
Records table. Usually the zero sequence mutual impedance parameters are read in from a 
sequence data file. However, it is also possible to insert and delete mutual impedance 
records from this table by right-clicking in the table and selecting Insert or Delete from the 
local menu. When Insert or Show Dialog are chosen from the mutual impedance table 
local menu, the Mutual Impedance Record dialog will open, from which a mutual impedance 
record can be inserted or modified. 

Pre-Fault Profile 

Changing this option determines the pre-fault voltage profile to be used for the fault analysis 
calculations. The pre-fault profile selection affects the sequence Y-bus values, fault currents, 
and post-fault voltages. 

Profile Options 

Additional pre-fault profile options are available when the pre-fault profile selected is either 
Flat IEC-909 or Flat Classical. 

XF Turns Ratios Set to 1 If checked, all transformer tap ratios are assumed at their 
nominal tap position. 

Line Charging Set to 0 If checked, line charging capacitance is ignored in all calculations. 

Shunt Elements Shunt elements (bus and line shunts) can optionally be treated normally, 
ignored in the positive sequence only, or ignored in all sequences. 

IEC Parameters This option only applies to the Flat IEC-909 pre-fault profile. The pre-fault 
voltage magnitude can be specified for each bus. In addition, a generator power factor 
angle (in degrees) can be specified for use when generator currents need to be calculated 
based on bus voltage and power (real and reactive) delivered by the generator. 

  

Matrices 

The Matrices tab is where the positive, negative and zero sequence admittance matrices can 
be viewed for the fault. This tab is only visible when a fault has been calculated. The three 
pages on the Matrices tab each have the same functionality as other Case Information 
displays. The purpose of each display is to show the admittance matrix for the specified 
sequence. One of the most important features of these matrix displays is the ability to right-
click on the display to bring up additional display options in the local menu. Perhaps one of the 
most important options on the local menu is the ability to export the Y-bus admittance matrix 
to a Matlab M file, which allows import of the matrix into Matlab for additional manipulation, 
such as inverting the matrix to get the equivalent sequence Z-bus matrix. 
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Fault Analysis Bus Records 

  

This dialog has the same functionality available as Case Information displays. The purpose of 
this display is to tabulate the results of the fault analysis calculations. By default, the phase 
voltage magnitudes and angles are displayed. In addition, the sequence voltages and angles 
can also be added by modifying the display using the Display/Column Options dialog. 
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Fault Analysis Generator Records 

  

This dialog has the same functionality available as Case Information displays. The purpose of 
this display is to tabulate the results of the fault analysis calculations. By default, the phase 
current magnitudes are displayed for the terminal end of the generator. The phase current 
angles, as well as the sequence current magnitudes and angles, can be added by modifying 
the display using the Display/Column Options dialog. The magnitude and angle direction 
reference is always given as out of the generator and into the terminal bus. 
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Fault Analysis Line Records 

  

This dialog has the same functionality available as Case Information displays. The purpose of 
this display is to tabulate the results of the fault analysis calculations. By default, the phase 
current magnitudes are displayed for each end of the branch. The phase current angles, as 
well as the sequence current magnitudes and angles, can be added by modifying the display 
using the Display/Column Options dialog. The magnitude and angle direction reference is 
always given as out of or away from a bus.  
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Mutual Impedance Records 

  

The Mutual Impedance Records table is a Case Information Display and can be customized 
like any other case information display. The zero sequence mutual impedance records 
displayed in this table can be either read from a sequence data file, or created manually by 
choosing Insert… from the local menu.  
  

The common fields displayed on the Mutual Impedance Records display are: 

L1 From Bus, L1 To Bus, and L1 Ckt ID 

These fields represent the from bus number, to bus number, and circuit identifier for the 
first mutually coupled line. 

L2 From Bus, L2 To Bus, and L2 Ckt ID 

These fields represent the from bus number, to bus number, and circuit identifier for the 
second mutually coupled line. 

Mutual R, Mutual X 

The mutual impedance, in terms of the resistance and reactance (per unit). The dot 
convention of the mutual impedance assumes the From bus of each line to be the dotted 
terminal, with the sign of the mutual impedance values being set according to this 
convention. 

L1 Mut. Start, L1 Mut. End 

The starting point and ending point of the mutually coupled portion of the first mutually 
coupled line. The values are between 0 and 1, and represent a position on the line as a 
percentage of the total line length. These fields are only used when evaluating an in-line 
fault to determine the affect of the mutual impedance on each side of the fault point on the 
line. 

L2 Mut. Start, L2 Mut. End 

The starting point and ending point of the mutually coupled portion of the second mutually 
coupled line. The values are between 0 and 1, and represent a position on the line as a 
percentage of the total line length. These fields are only used when evaluating an in-line 
fault to determine the affect of the mutual impedance on each side of the fault point on the 
line. 
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Mutual Impedance Record Dialog 

  

The Mutual Impedance Record dialog can be used to modify or add zero sequence mutual 
impedance records to the sequence data for a case. When the dialog is opened using the 
Show Dialog… option from the Mutual Impedance Records table local menu, the information 
for the record selected in the table will automatically be displayed. The information for that 
record can be modified, or a different record can be selected by selecting different lines in the 
Line 1 and Line 2 Identifier sections. Note that the drop down list of buses for the From Bus 
fields always contain all the buses in the case. However, once the From Bus has been 
selected, the drop down list of the corresponding To Bus field will only contain bus numbers of 
buses that are connected to the From Bus. If a mutual impedance record already exists for the 
lines selected, the information for that record will be displayed. If a mutual impedance record 
does not exist for the selected lines, then the mutual impedance fields will display default 
values. When the default values are changed, and either Save or OK are selected, a new 
mutual impedance record is added to the data. 
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Fault Analysis Load Records 

  

This dialog has the same functionality available as Case Information displays. The purpose of 
this display is to tabulate the results of the fault analysis calculations. By default, the phase 
current magnitudes are displayed for the terminal end of the load. The phase current angles, 
as well as the sequence current magnitudes and angles, can be added by modifying the 
display using the Display/Column Options dialog. The magnitude and angle direction reference 
is always given as out of the bus and into the load. 
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Fault Analysis Switched Shunt Records 

  

This dialog has the same functionality available as Case Information displays. The purpose of 
this display is to tabulate the results of the fault analysis calculations. By default, the phase 
current magnitudes are displayed for the terminal end of the switched shunt. The phase 
current angles, as well as the sequence current magnitudes and angles, can be added by 
modifying the display using the Display/Column Options dialog. The magnitude and angle 
direction reference is always given as out of the bus and into the switched shunt. 
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Contouring 

  

Simulator can create and animate a contour map of various system quantities, such as voltage 
magnitudes and angles, MW transactions, transmission loading, and real and reactive load. 
Such displays resemble a contour map of temperatures like you might see shown on a 
weather forecast. Contouring can significantly improve understanding of a large 
interconnected system, helping identify congestion pockets and Mvar-deficient regions and 
providing an overview of how power flows through the bulk power system.  

The Contour Options Dialog controls Simulator’s contouring capabilities. To access it, click the 
right mouse button on an empty area of the oneline and choose Contouring from the 
resulting local menu, or choose Contouring from the Active ribbon group on the Onelines 
ribbon tab. 
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Contouring Options 

  

The Contour Options Dialog allows you to draw contour maps of many system quantities, such 
as bus voltages or angles, transmission line and interface MVA loadings, and transmission line 
and interface PTDFs.  

To access this dialog, click the right mouse button on an empty area of the oneline and choose 
Contouring from the resulting local menu, or choose Contouring > Contouring from the 
Active ribbon group on the Onelines ribbon tab. The Contour Options Dialog has three tabs: 
the Contour Type Tab, the Contour Type Options Tab, and the Custom Color Map Tab. 
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Contour Type 

  

Object 

Simulator can contour several different values. To specify what Simulator should contour, 
first choose the type of display object; the options are Bus, Line, Interface, Area, Generator, 
Substation, Zone or Injection Group. Once the object is chosen, you must then choose the 
numerical value to be contoured by specifying it in the Value dropdown box. 

Note: to contour a value for a type of object, representations of that type of object must be 
present on the oneline diagram. Choosing to contour an object type that is not represented 
on the diagram will result in no contour being drawn on the diagram. 

Value 

Select the quantity to contour from the Value dropdown box or click the Find… button to 
find the desired field (it is normally easier to use the Find button). See NOTE at the end of 
this help topic. 

Filter Object Values 

The name of the advanced filter that is currently applied to the contour. Click Define to 
create a new Advanced Filter to use during contouring. Applying a filter means that only 
objects that meet the filter will affect the contour image. Objects which do not meet the 
filter will be ignored. 

Data Points per Line 

This specifies the number of data points used to represent the graphical line. The contouring 
algorithm is based on values at specific coordinates in the oneline space. When contouring 
transmission line or interface objects, the line is represented by a series of points spaced 
equally along the graphical line.  

No Data Color 

This setting allows you to choose the contour color used for parts of the contour for which 
there are not objects or nor data for the type of contour selected. The choices for No Data 
Color are Specific Color, Color Map Percentage, and Background Color. By default, Specific 
Color is selected and set to white. If you wish to change the specific color to use, click on 
the color box to the right and choose a different color from the popup dialog. If you select 
Color Map Percentage, the Color Map % field will become enabled, and you can select a 
value from 0 to 100. The value you enter will associate the No Data Color with the color 
located at that percentage in the selected color map. Lastly, if Background Color is chosen, 
the No Data Color will always be whatever color has been set as the normal background 
color for the oneline diagram. 

Draw Color Key 

Checking this box will cause the contour to draw a color key showing which colors are 
mapped to which values. You can also give the color key a title, unit label, and specify the 
number of digits to display in numerical values. 

Title 

Title for the color key. 

Entry Labels 

Units of the contoured value displayed on the color key. 

Dec. Pts. 

Number of decimal places of the contoured value displayed on the color key. 
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Scalar 

Multiplication factor that can be applied to the values when drawing the color key. Normally 
this value should be 1.0. 

Use Equal Spacing For Discrete Maps 

This option will draw the color key with equal spacing for all colors in the map, regardless of 
how close or distant the values the colors represent. This option only applies to discrete 
color maps. 

Color Map 

Choose from various predefined color maps using the color map combo-box. A color map, 
along with the values specified, defines how values are mapped to a color on the contour 
image. 

If a color map showing both high and low values is desired (such as for bus voltages), use 
of "Blue = Low, Red = High" is recommended. If a color map showing only high values is 
desired (such as for line flows), use of "Weather Radar, Nominal to High" is recommended. 

A user may also define additional color maps by going to the Custom Color Map Tab.  

Reverse Color Map Colors 

Check this check-box to reverse the colors of the selected color map, so the low color 
becomes the high color, and vice versa. 

Brightness 

Modify the brightness track bar to change the brightness of the color map. 

Use absolute value 

Check this check-box to use the absolute values of the quantity selected at the Value 
dropdown box (above). 

Ignore Above Max 

Check this check-box to completely ignore values above the maximum percentage. This 
means that data which is larger than the Max % will not be used in calculating the contour 
image. This is similar to using an Advanced Filter to Filter Object Values, but provides a 
quick way to do so. 

Values 

For all color maps that come with PowerWorld by default, the conversion of a value to a 
color is done in two steps. The value is first interpolated to a percentage by using up to 5 
user-specified values (maximum, break high, nominal, break low and minimum) that 
correspond to specific percentages (100%, 75%, 50%, 25%, and 0%). This percentage is 
then interpolated through the color map and a color is determined. 

 
User may define their own color maps which convert percentage to color, but they may also 
define color maps which directly translate values into colors without the intermediate 
calculation of a percent. For more information on this see the creation of a Custom Color 
Map. 

The value range values are described as follows: 
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Maximum  The largest value allowed in the contour. All values above this will be mapped 
to the highest color. This value corresponds to 100% in the color map. 

Break High This value is used by some color maps to highlight a lower limit. This value 
corresponds to 75% in the color map. 

Nominal  This value is the nominal value for the contour. Values around this will be 
mapped to the middle color. This value corresponds to 50% in the color map. 

Break Low This value is used by some color maps to highlight a lower limit. This value 
corresponds to 25% in the color map. 

Minimum The smallest value allowed in the contour. All values below this will be mapped 
to the lowest color. This value corresponds to 0% in the color map. 

Note: a representation of the color map is shown to the right of the values. 

Ignore Below Min 

Check this check-box to completely ignore values below the minimum percentage. This 
means that data which is smaller than the Min % will not be used in calculating the contour 
image. This is similar to using an Advanced Filter to Filter Object Values, but provides a 
quick way to do so. 

Ignore Zero Values 

Check this box to completely ignore zero values in the contour. This is similar to using an 
Advanced Filter to Filter Object Values, but provides a quick way to do so. If there is a need 
to ignore values that are almost but not exactly zero, then create an Advanced Filter to Filter 
Object Values. 

Interpretation 

This combo box specifies how to interpret the values of the data points. The options are: 

Fixed Values  The data point values are not modified. The maximum, minimum, nominal, 
and break values are the ones entered directly in the units of the value being contoured. 
This is what should normally be used. 

Dynamic Values  The data point values are not modified. However the maximum, 
minimum, nominal, and break values are determined dynamically from the data point values 
as follows: Maximum = Maximum data point value; Minimum = Minimum data point value; 
Nominal = Average data point value; Break High = (Max + Average)/2; and Break Low = 
(Min + Average)/2. 

Standard Deviations All the data point values will be used to determine a mean and 
standard deviation. The data point values will then be converted to represent the number of 
standard deviations they are from the mean. Thus a value equal to the mean will be 
changed to a 0, a value 1.5 standard deviations higher than the mean will be changed to 
1.5, and so on. 

Percentiles  All the data point values will be sorted from lowest to highest. The value will 
then be set equal to the 100 times the sort location divided by the number of data points. 
Thus the highest value will be given a value of 100 and the lowest a value of 1. 

Save Contour Image with Oneline 

Checking this box will allow a displayed contour to be saved with a oneline diagram. If a 
contour is saved with a oneline diagram, the next time the oneline diagram is opened the 
contour will automatically be redrawn as well. The displayed contour is saved as a Bitmap 
image. 

Continuously Update Contours 
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Normally contouring is only done on a snap shot of the power system state. However, you 
can also set PowerWorld to automatically update the contour every time the display is 
redrawn. In this way, an animation of the contour can be created. If you would like to 
create this animation, simply check the Continuously Update Contours checkbox. Note, 
however, that this will slow down the animation of the display, as the program must 
recalculate the contour at each step. If this slows down your display too much, try lowering 
the contour resolution to speed it up. 

Note Regarding Values 

Contours of most values create an image where the color around a data object is primarily 
related to the value of only that object. Some values however create "density-like" contours, 
where the color is related to the sum of the data object's values nearby. These include: 

• Bus / Load MW 
• Bus / Load Mvar 
• Bus / Load MVA 
• Bus / Cust Expr (Density) 
• Area / Pos Spin Reserve 
• Area / Neg Spin Reserve 
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Contour Type Options 

  

Object 

Simulator can contour several different values. To specify what Simulator should contour, 
first choose the type of display object; the options are Bus, Line, Interface, Area, Generator, 
Substation, Zone or Injection Group. Once the object is chosen, you must then choose the 
numerical value to be contoured by specifying it in the Value dropdown box. 

Note: to contour a value for a type of object, representations of that type of object must be 
present on the oneline diagram. Choosing to contour an object type that is not represented 
on the diagram will result in no contour being drawn on the diagram. 

Value 

Select the quantity to contour from the Value dropdown box or click the Find… button to 
find the desired field (it is normally easier to use the Find button). Note: see Contour Type 
for more information. 

Filter Object Values 

The name of the advanced filter that is currently applied to the contour. Click Define to 
create a new Advanced Filter to use during contouring. Applying a filter means that only 
objects that meet the filter will affect the contour image. Objects which do not meet the 
filter will be ignored. 

Influence Region 

This track bar determines how far away each data point influences the contour image. A 
larger influence region results in each data point influencing more of the contour at the 
expense of longer screen refresh times. 

Use Dynamic Influence Region 

Dynamic influence distance determines how far out the contour should go when determining 
which buses influence the contour value for a screen point.  The actual distance is the 
minimum of either 1) a common value for all screen points that depends upon user 
parameters [e.g., the dynamic region points value]), and now 2) the distance that includes 
the number of buses associated with the dynamic influence field.  The primary reason for 
this option is speed, particularly when zoomed in on dense portions of the display.  You 
should not see much impact on the contour itself. 

Kind of Value 

This option allows you to choose to contour based on the Actual Value or the Density Value. 
The Actual Value uses the weighted average of the data for computing the contour. The 
Actual Value method is most commonly used for contouring in Simulator. On occasion, the 
Density of Values method does not work as well. One example is contouring generator MW 
values. If you have four buses in close proximity, each with 100 MW of generation, and 
compare the contour with a single bus with 400 MW of generation, the contour based on the 
weighted average will look drastically different, despite the amount of generation being the 
same in each region. Using the Density Value option will correct the disparity, and the 
contour around these two different groups of generation would look basically the same. 

Use Fade to Value 

Checking this check box will allow to use the Fade to Value and Begin Fade Percentage 
options. 

Fade to Value 
The value to which a data point's value fades as it moves away from its location. 
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Begin Fade Percentage 

While moving away from a data point, the data point’s value decays towards the "Fade 
to" Value. The Begin Fade Percentage specifies when the contour starts to fade as a 
percentage of the largest distance for which this data point influences the contour. 

Contour Resolution 

This value determines the relative resolution of the contour. Increasing the contour 
resolution increases the level of detail represented on the map but will lengthen screen 
refresh times. Reducing the screen refresh time will yield less detail and shorter screen 
refresh times. 

Low Resolution Display when Zooming or Panning 

Do Low Resolution Speedup 
Check this option to enable drawing contours in low resolution while zooming or panning. 
Low resolution images are drawn much faster than high resolution images. 

Low Resolution Normalized Percent 

Set a percentage of resolution between 0.01 (1%) and 1 (100%). A smaller value 
translates to a lower resolution image. 

Time Delay in Seconds before Redrawing at Full Resolution 

Set the number of seconds Simulator will pause before returning the contour to full 
resolution following zooming and panning. 

Minimum Resolution in Pixels for Low Resolution Displays 
Specify the minimum resolution allowed (in pixels) when Simulator draws the low 
resolution image. 

When Animating, Only Update Contour if Something Changed 

As it describes, checking this option will suppress redrawing the contour during animation 
unless one or more of the contoured values changes. 
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Custom Color Map 

  

Color Map 

Choose from various predefined color maps using the color map combo-box. A color map, 
along with the values specified, defines how values are mapped to a color on the contour 
image. 

If a color map showing both high and low values is desired (such as for bus voltages), use 
of "Blue = Low, Red = High" is recommended. If a color map showing only high values is 
desired (such as for line flows), use of "Weather Radar, Nominal to High" is recommended. 

A user may also define additional color maps by going to the Custom Color Map Tab.  

Reverse Color Map Colors 

This check-box reverse the mapping of the color map, converting the colors corresponding 
to the high values into the colors for the low values, and vice-versa. 

Brightness 

Modify the brightness track bar to change the brightness of the color map. 

Make Discrete Color Map 

Check this check-box to make a discrete color map, that is without having smooth 
transitions between colors. 

Contour Type Values to Use 

These check-boxes signify which values from the Contour Type Values Tab are used by the 
Color Map. There must be at least two contour type values checked. 

Color Grid 

The color grid on the right side of this page allows you to change the colors for each 
percentage breakpoint. In addition, you can add or delete breakpoints as well. 

To change the color for a specific breakpoint, simply left-click on the color for the breakpoint 
you want to change. The Color dialog will open, and you can choose a new color for that 
breakpoint. 

To add a breakpoint, right-click on a breakpoint position above or below where you would 
like the new breakpoint inserted. A popup menu will open, and you can select Add Above or 
Add Below, depending on where you wish the new breakpoint to be. Simulator will insert the 
breakpoint, and will automatically set the color and percentage at the midpoint between the 
two breakpoints above and below the inserted breakpoint. You can then click on the color to 
change it, or click on the percentage to type in a new value. The new percentage value 
should be between the values of the adjacent breakpoints. 

To delete a breakpoint, right-click on the breakpoint you wish to delete, and choose Delete 
from the popup menu. 

Color By… 

This option allows the user to interpret the breakpoints values as percentage values or as 
direct values. 

For all color maps that come with PowerWorld by default, the conversion of a value to a 
color is done in two steps. The value is first interpolated to a percentage by using up to 5 
user-specified values (maximum, break high, nominal, break low and minimum) that 
correspond to specific percentages (100%, 75%, 50%, 25%, and 0%). This percentage is 
then interpolated through the color map and a color is determined. 
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Color maps which directly translate values into colors without the intermediate calculation of 
a percent may also be created. This is done by setting Color By to Value. 

Save As… 

To save the present color map as a new color map, click this button. Then specify a name 
for the new color map. 

Save 

To save changes that have been made to the present color map, click this button. 

Rename 

To rename the present color map, click this button. 

Delete 

To delete the present color map, click this button. 

Store Color Maps in File 

To store all custom color maps in a file for loading into another case, click this button. If you 
have saved any custom color maps with the current case, you will be prompted to choose a 
file name and location for saving the custom color maps. Color Maps are saved in the 
Auxiliary File Format. 

Load Color Maps from File 

If you have created custom color maps in a different case and saved them to a file, you can 
click this button to load those color maps into your current case. Color Maps are loaded in 
the Auxiliary File Format. 
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Functional Description of Contour Options 

  

Functional Description of the Contour Options 
  

The previous help topics discussed basic contour options in the order they are arranged on the 
dialog. The dialog is arranged so that the most important options are on the first tab and other 
on the Contour Type Options tab. This help topic discusses the options in a manner which 
better describes how the contour is actually created. A contour is calculated generally by a 
five-step process 
  
1. Build a list of all possible data points (graphical locations) 
2. Remove items that meet criteria from the list of data points 
3. Assign a value to each data point 
4. Calculate "virtual values" on a grid of points 
5. Convert each "virtual values" into a color to create the contour image 

  

Step 1: Build a list of data points (graphical locations) 

  

The following options determine a list of potential data points (could also be called graphical 
locations) which will be used to calculate the contour image. 

   

Object - Simulator can contour several different values. To specify what Simulator should 
contour, first choose the type of object. This corresponds to the type of display object that is 
drawn on the oneline diagram. For instance if you want to contour a substation value, then 
you must have substations drawn on your diagram. This selection narrows the set of 
quantities that can be contoured, which is specified in the Value dropdown box.  

  

Data points Per Line - The contouring algorithm for lines is no different than for points, 
except that each line is represented by several points. For objects which are represented by 
graphical lines, this option will specify the number of data point which should be used to 
represent the line.  

  

Step 2: Remove items that meet criteria from the list of data points 

  

After a complete list of potential data points is made, there are then several options for 
filtering out things from this list which you do not want to effect the calculation of the 
contour image. 

  

Filter - If you wish for the contour to be limited to only certain devices that meet specific 
criteria, click on this button to define an Advanced Filter for the contour 

  

Ignore Above Max - Check this check-box to completely ignore values above the 
maximum percentage. This means that data which is larger than the Max % will not be used 
in calculating the contour image 
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Ignore Above Min - Check this check-box to completely ignore values below the minimum 
percentage. This means that data which is smaller than the Min % will not be used in 
calculating the contour image 

  

Ignore Zero Values - Check this check-box to completely ignore values that are zero. 

  

Step 3: Assign a value to each data point 

  

After Step 2, a list of potential data points has been created and a value must now be 
assigned to each data point. The following options specify how this is done. 

  

Value - select the quantity to contour from the Value dropdown box or click the Find Value 
button to find the desired field. 

  

Use absolute value - This check-box will modify the Value specified so that it uses the 
absolute value. 

  

Interpretation – When interpretation is set to either Standard Deviations or Percentiles, then 
the value of the data point will be modified.  

  

If Standard Deviations is chosen, then all the data point values will be used to 
determine a mean and standard deviation. The data point values will then be converted 
to represent the number of standard deviations they are from the mean. Thus a value 
equal to the mean will be changed to a 0, a value 1.5 standard deviations higher than 
the mean will be changed to 1.5, and so on. Similar,  
  

If Percentiles is chosen, then all the data point values will be sorted from lowest to 
highest. The value will then be set equal to the 100 times the sort location divided by the 
number of data points. Thus the highest value will be given a value of 100 and the 
lowest a value of 1. 

  

Step 4. Calculate "virtual values" on a grid of points 

  

After Step 3, we now have a list of data points and a value assigned to each data point. We 
now must create a grid of points that represents "virtual values" throughout the entire 
graphical space. The values on this grid will be calculated based on the data point values  

  

Contour Resolution - setting determine the size of the grid of points which will be 
superimposed on the present oneline diagram. The higher the resolution the more number 
of grid points will be used to represent the contour (and thus make the calculation of the 
contour image slower) 

  

Influence Region - each data point value will effect only the grid locations that are "near" 
it. The distance that is considered "near" is determined by the Influence Region. Setting the 
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influence region higher will result in each data point effecting a larger portion of the contour 
image (and thus making the calculation of the contour image slower) 

  

Kind of Value - The calculation of the virtual value at a particular grid point is done by first 
building a list of data points that are within the "influence distance" of the grid point. The 
Kind of Value setting determines what process is used to calculate the virtual value from this 
list of values.  

  

Actual Value (Weighted Average) - The virtual value is calculated as the weighted 
average value, weighted by the distance from the grid point. This means that virtual 
value half-way between two data points will be the average of the two data point values. 
  

Density of Values (Weighted Sum) - The virtual value is calculated as the sum of 
value that within the influence region. This means that virtual value half-way between 
two data points will be the sum of the two data point values. 
  

Actual Value (Only Closest) - The virtual value is assigned as the value of the closest 
data point. 

 
  

Fade to Value and Begin Fade Percentage - In the middle of a contour image the colors 
look consistent because the virtual values are calculated using a good number of data points 
which surround it. Sometimes at the edge of a contour image however, the colors can 
become skewed because there are very few data points influencing it. Using a fade to value 
can help this situation, but will skew the entire contour image in general instead. Without 
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using the fade to value, the raw data point values will be used when calculating virtual 
value.  

  

When using the fade to value, while moving away from a data point, the data point’s value 
decays towards the "Fade to" Value. The Begin Fade Percentage specifies when the contour 
starts to fade as a percentage of the largest distance for which this data point influences the 
contour. 

  

Step 5. Convert each "virtual values" into a color to create the contour image 

  

After Step 4, a grid of virtual values has been calculated. At this point, must specify how 
these numbers map to colors. This done through the user of a Color Map. 

  

Color Map - Choose from various predefined color maps using the color map combo-box. A 
color map, along with the values specified, defines how values are mapped to a color on the 
contour image. A user may also define additional color maps by going to the Custom Color 
Map Tab. 

  

Brightness - this value is used to brighten or darken the colors specified in the color map. 

  

Values - These values along with the color map define how to convert your values into a 
color for the contour. The values are: 

  

Maximum - The largest value allowed in the contour. All values above this will be 
mapped to the highest color. This value corresponds to 100% in the color map. 

Break High - This value is used by some color maps to highlight a lower limit. This 
value corresponds to 75% in the color map. 

Nominal - This value is the nominal value for the contour. Values around this will be 
mapped to the middle color. This value corresponds to 50% in the color map. 

Break Low - This value is used by some color maps to highlight a lower limit. This value 
corresponds to 25% in the color map. 

Minimum - The smallest value allowed in the contour. All values below this will be 
mapped to the lowest color. This value corresponds to 0% in the color map. 

  

Interpretation - Most frequently this option will be set to Fixed Values meaning values 
for maximum, break high, etc… are entered directly in the units of the value being 
contoured. If Interpretation is set to Standard Deviations or Percentiles then as 
mentioned earlier the values mean something different. The options Dynamic Values will 
process this list of data point values and automatically set the values as follows: Maximum = 
Maximum data point value; Minimum = Minimum data point value; Nominal = Average data 
point value; Break High = (Max + Average)/2; and Break Low = (Min + Average)/2. 

  

No Data Color - It is likely that some the grid points will not be within the influence of any 
of the data points. The color of these points is determined by no data color setting. 
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Power Transfer Distribution Factors 

  

The Power Transfer Distribution Factor (PTDF) display is used to calculate the incremental 
distribution factors associated with power transfers between two different areas or zones. 
These values provide a linearized approximation of how the flow on the transmission lines and 
interfaces change in response to transaction between the Seller and the Buyer. These values 
can then be visualized on the onelines using animated flows (see below for details). The 
transaction for which the PTDFs are calculated is modeled by scaling the output of all 
generators on AGC in the source and sink areas in proportion to their relative participation 
factors. Generators in the source area increase their output, while generators in the sink area 
decrease their output. 

An important aspect to consider in calculating the PTDF is how the losses associated with the 
transfer are allocated. Simulator assumes that the Seller increases the output of its generators 
by 100% of the transfer amount, while the Buyer decreases the output of its generators by 
100% minus any change in system losses. In other words, the Buyer accounts for the 
entire change in the system losses. Of course it is possible that a transfer may result in 
decreased system losses; for that case, the Buyer’s generation will be greater than 100% of 
the transfer.  

To Calculate the Power Transfer Distribution Factors: 
• Perform an initial Power Flow Solution. 
• In Run Mode, click on the Tools ribbon tab and select  Power Transfer Distribution 

Factors (PTDFs) from the Sensitivities menu on the Run Mode ribbon group to open 
the Power Transfer Distribution Factors Dialog. 

• Supply the requested information on the Power Transfer Distribution Factors Dialog and 
click the Calculate PTDFs button. The distribution factors are calculated and displayed 
for the element set of your choice in the table at the bottom of the dialog. 

The animated flows that appear on the oneline diagram may represent either actual flows or 
PTDF values. To specify that the display should show distribution factors, click the button 
labeled Visualize PTDFs. Once this button is clicked, the flow arrows on all open onelines 
will represent distribution factors, and the caption of the button will change to Visualize 
Actual Power Flows. Click the button again to visualize actual power flows instead of 
distribution factors. 

Note that when calculating PTDF values for interfaces that include contingent elements, the 
PTDF values reported are actually what are referred to as an Outage Transfer Distribution 
Factor (OTDF). See Line Outage Distribution Factors (LODFs) for more information. 
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Power Transfer Distribution Factors Dialog 

  

The PTDF Dialog enables you to control and to view the results of power transfer distribution 
factor calculations. To access this dialog go to the Tools ribbon tab, and choose Sensitivities 
> Power Transfer Distribution Factors from the Run Mode ribbon group. This is only 
available in Run Mode. 

  

The dialog has the following options: 

Linear Calculation Method 

PTDFs may be calculated using either the full power flow Jacobian or only a portion of it. If 
you select the Linearized AC Approximation option, the sensitivity of the monitored 
element’s flow will be calculated as a function of both its real and reactive power 
components to the voltage magnitude and angle of its terminal buses. When using the AC 
method, losses are included in the calculation. Simulator assumes that the change in losses 
is taken care of by the Buyer. 

If you instead select the Lossless DC Approximation option, branch flow sensitivity is 
calculated by estimating the real power that flows through the monitored element only from 
the difference in angles measured across its terminals. This method assumes that there are 
no losses.  

The Lossless DC with Phase Shifters Approximation option is similar to the Lossless 
DC, except additional constraints are placed on the calculations that assume that the 
change in flow across active phase-shifting transformers is zero. 

Note: The Lossless DC methods will be affected by the DC Power Flow Model settings in 
Power Flow Solution: DC Options. Click on the DC Model Options button to open the 
dialog which sets these options. 

Directions 

This option allows you to choose to define a single direction PTDF using the Seller and 
Buyer Type related fields, or to define multiple transfer directions between many different 
entities. If you choose to use multiple directions, the Seller and Buyer Type fields are 
replaced by the Direction Records display for viewing and defining directions. 

For Single Direction: Seller Type, Buyer Type 

Distribution factors can be calculated for power transfers between combinations of areas, 
zones, super areas, participation groups, or to a slack bus. Use the seller type and buyer 
type options to indicate the type of the selling and purchasing entities. These fields are only 
present for single direction PTDFs. When choosing Area, Zone, or Super Area, this really 
means all generators in the Area, Zone or Super Area weighted by the generator 
participation factor. 

For Single Direction: Seller, Buyer 

These dropdown boxes allow you to select the selling and buying entities. Their contents are 
filled when you select the seller and buyer types. These fields are only present for single 
direction PTDFs. 

For Single Direction: Reverse Buyer/Seller 

Click this button to re-calculate PTDFs for the direction that is the reverse of the direction 
currently shown. For example, if you have just calculated PTDFs for a transaction from area 
A to area B, press this button to calculate and display PTDFs for a transaction from area B to 
area A. This option is only present for single direction PTDFs. 
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Calculate PTDFs 

Click on this button to update the PTDF values. The results table will reveal the latest 
calculations. 

Automatically Recalculate 

If checked, the PTDFs are automatically recalculated every time the power flow is solved.  

Calculate MW-Distance 

Click this button to open the MW * Distance Calculations form. This form allows you to 
calculate MW * Distance values for the transaction for which you calculated PTDFs. See MW-
Distance Calculations for more information. 

Increase in Losses 

This is a read-only field that indicates the change in system losses caused by the transfer 
from the selling area to the buying area. The change is expressed as a percentage of the 
transfer amount. This will only be non-zero when using the Linearized AC calculation 
method. 

Use Area/Zone Filters 

If this box is checked, then the results table at the bottom of the dialog will include only 
records associated with devices located in areas or zones included in the area/zone/owner 
filter set.  

Only Show Above % 

Restricts the result set to show only those PTDFs that exceed a specified value.  

Visualize Actual Power Flows, Visualize PTDFs 

Select to toggle the onelines between showing the actual power flows and the PTDF flows. 
Selecting this button changes the Flow Visualization field for all the visible onelines. You can 
also change this field manually using the Oneline Display Options Dialog.  

Tables of Results 

The tables of results occupy the bottom of the PTDF Dialog. They are a set of case-
information displays and thus share many characteristics common to all other case 
information displays. The tables will show results for lines/transformers, interfaces, areas, 
zones, generators, and phase shifters. The tables feature a local menu from which you can 
print, copy, or modify its records as well as view the information dialog of its associated 
element. You can also sort the area records by clicking on the heading of the field by which 
you want to sort. 

Lines/Transformers 

Shows the transaction distribution factors for the lines and transformers. The following fields 
are shown: 

From Bus #, From Bus Name, To Bus #, To Bus Name, Circuit 
Identifiers for the transmission line or transformer. 

From % PTDF 

Distribution factor associated with the MW flow at the "from bus" end of the line or 
transformer, specified as a percentage of the transaction amount.  

To % PTDF 

Distribution factor associated with the MW flow at the "to bus" end of the line or 
transformer, specified as a percentage of the transaction amount. 

% Losses 
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Shows the percentage of the PTDF assigned as losses. 

Nom KV (Max) and Nom KV (Min) 

Displays the maximum and minimum nominal voltages for the line. This is useful for 
identifying transformers and which end of the PTDF relates to which nominal voltage. 

Interfaces 

Shows the transaction distribution factors for the interface records. The following fields are 
shown: 

Interface Name  
Alphanumeric identifier for the interface. 

Interface Number 
Numeric identifier for the interface. 

% PTDF 

Distribution factor associated with the MW flow through the interface, specified as a 
percentage of the transaction amount. A positive value indicates the transaction would 
result in an increase in the flow through the interface. 

Interface MW Flow 

Amount of real power flowing on the interface. 

Has Contingency 

Signifies if an element of the interface is violating a limit. 

Areas and Zones 

Shows the impact the transaction has on the losses for the area or zone. The following fields 
are shown: 

Area/Zone Number and Name 
Number and name identifiers for the area or the zone 

Losses % 

Change in the losses in the area or zone, specified as a percentage of the transaction 
amount. A positive number indicates that the transaction would result in increased 
losses in the area or zone, while a negative number indicates that the transaction 
would result in decreased losses.  

Gen Chg % 

Total change in all of the generators in area or zone, specified as a percentage of the 
transaction amount. For areas, this field should show 100% in the selling area, and 
100% minus the change in system losses in the buying area.  

Generators 

Shows the marginal participation of each generator in the transaction. The following fields 
are shown: 

Bus Number, Bus Name, Gen ID 
Generator’s terminal bus number and alphanumeric identifier, and the id for the 
generator. 

Area Number, Area Name 

Name and number of the generator’s area. 

Gen Change % 
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Assumed participation of the generator in the transaction, specified as a percentage of 
the transaction amount. This value is directly proportional to the participation factor for 
the generator, provided the generator is available for AGC and is free to move in the 
specified direction (i.e., is not at a MW limit). The generator’s participation factor and 
AGC status are modified on the Generator Dialog, which can be displayed by right-
clicking anywhere in the record’s row in the table and selecting the Show Dialog option. 

Phase Shifters 

Shows the transaction distribution factors for the phase shifters. This applies when using the 
Lossless DC with Phase Shifters calculation method. The following fields are shown: 

From Number, From Name, To Number, To Name, Circuit 
Identifiers for the phase shifter. 

Status 
Indicates whether or not the phase shifter is in-service. 

Phase (Deg) 

The current phase angle of the transformer. 

XF Auto 

Indicates if the phase shifter is currently enabled for automatic control. 

Deg per MW 
This field indicates the amount of angle change, in degrees, that would be required to 
keep the flow across the transformer constant for a one MW transfer between the seller 
and the buyer. 

Tap Min, Tap Max 
The minimum and maximum tap positions for the phase shifter. 
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Line Outage Distribution Factors (LODFs) 

  

Line Outage Distribution Factors (LODFs) are a sensitivity measure of how a change in a line’s 
status affects the flows on other lines in the system. On an energized line, the LODF 
calculation determines the percentage of the present line flow that will be show up on other 
transmission lines after the outage of the line. For example, consider an energized line, called 
LineX, whose present MW flow is 100 MW. If the LODFs are found to be  

LODFs for LineX outage 

LineX  -100%  

LineY  + 10% 

LineZ  - 30% 

This means that after the outage of LineX, the flow on LineX will decrease by 100 MW (of 
course), LineY will increase by 10 MW, and LineZ will decrease by 30 MW. The "flow on Line 
X" here means the flow at the from bus going toward the to bus.Error! Hyperlink reference 
not valid. 
Similarly, sensitivities can by calculated for the insertion of a presently open line. In this case, 
the LODF determines the percentage of the post-insertion line flow that will come from the 
other transmission line after the insertion. The "LODF" might better be named a Line Closure 
Distribution Factor (LCDF) in this case. 
  

To calculate the LODFs: 

• Perform an initial Power Flow Solution. 
• In Run Mode, select Sensitivities > Line Outage Distribution Factors (LODFs) from 

the Rune Mode ribbon group on the Tools ribbon tab to open the Line Outage 
Distribution Factors Dialog. 

• Supply the requested information on the Line Outage Distribution Factors Dialog and click 
the Calculate LODFs button. 

  

What else are LODFs used for? 

LODFs are used extensively when modeling the linear impact of contingencies in Simulator. 
This is true for the calculation of PTDFs for interfaces which contain a contingent element, 
as well as when performing Linear ATC analysis that includes branch contingencies. 

When calculating "PTDF" values for interfaces that include contingent elements, the PTDF 
values reported are actually what are referred to as an Outage Transfer Distribution Factor 
(OTDF). An OTDF is similar to PTDF, except an OTDF provides a linearized approximation of 
the post-outage change in flow on a transmission line in response to a transaction between 
the Seller and the Buyer. The OTDF value is a function of PTDF values and LODF values. For 
a single line outage, the OTDF value for line x during the outage of line y is  

OTDFx = PTDFx + LODFx,y * PTDFy 

where PTDFx and PTDFy are the PTDFs for line x and y respectively, and LODFx,y is the 
LODF for line x during the outage of line y. More complex equations are involved when 
studying contingencies that include multiple line outages, but the basic idea is the same. 

When performing Linear ATC analysis along with calculating OTDFs, Simulator determines 
the linearized approximation of the post-outage flow on the line. This is similarly determined 
as 

OutageFlowX = PreOutageFlowX + LODFx,y* PreOutageFlowY 
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where PreOutageFlowX and PreOutageFlowY are the pre-outage flow on lines x and y. 
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Line Outage Distribution Factors Dialog 

  

The LODF Dialog enables you to control and to view the results of Line Outage Distribution 
Factor calculations. You access this dialog by selecting Sensitivities > Line Outage 
Distribution Factors (LODFs) from the Run Mode ribbon group on the Tools ribbon tab in 
Run Mode only.  
  

The dialog has the following options: 

Output Option 

Choose Single LODF to calculate only the sensitivities related to the status change of a 
single transmission line. Choose LODF matrix to calculate a matrix of sensitivities. 

For Single LODF: Specify Near Bus, Far Bus  

Specify the line whose status modification you would like to determine sensitivities to. The 
direction of the near/far chosen is important. Switching the near and far bus around will 
change the sign of all the LODF sensitivities. 

For Single LODF: Action 

Check Outage Sensitivities to determine sensitivities for the outage of a line. 

Check Closure Sensitivities to determine sensitivities for the closure of a presently outaged 
line. The LODF might better be named a Line Closure Distribution Factor (LCDF) in this case. 

For LODF Matrix: Specify Lines to Process (Outage or Closure) and Lines to Monitor 

Choose which lines to process and which lines to monitor by choosing either all AC lines, 
only those that meet the area/zone/owner filters, only lines with Selected field set to YES, or 
only those lines that meet an Advanced Filter. After choosing Calculate LODFs, each row 
of the results represents the line being outaged/closed. Each column of the results represent 
the line begin monitored and the corresponding LODF/LCDF for that line. 

Linear Calculation Method 

Linearized AC 
This calculation method is not available for LODF sensitivities. 

Lossless DC 

Uses the DC power flow approximation. 

Lossless DC with Phase Shifters 

Check this to include the impact of phase shifter controllers with the Lossless DC 
calculation. By checking this, it is assumed that operating phase shifters will maintain 
their control requirements after the line outage. 

Note: The Lossless DC methods will be affected by the DC Power Flow Model settings in 
Power Flow Solution: DC Options. Click on the DC Model Options button to open the 
dialog which sets these options. 

Calculate LODFs 

Click this to calculate the LODFs and update the display. 

Advanced LODF Calculation 

Opens the Advanced LODF Calculation dialog for setting additional options for the 
calculation. 
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LODFs Tab 

After calculating a LODF Matrix, each row of the results represents the line being 
outaged/closed. Each column of the results represent the line begin monitored and the 
corresponding LODF/LCDF for that line. 

When calculating LODFs for a single branch, This tab contains a table showing a list of the 
lines in the case. Since this table us another variety of the Case Information Displays, you may 
interact with it in a familiar manner. Click on any of the field headings to sort by that field. 
Right-click on the display to call up the display’s local menu. From the local menu, you can 
print the violations, copy the violation records to the Windows clipboard for use with another 
application, modify the format and content of the listing, view the information dialog of the 
respective element, and view the Quick Power Flow List or Bus View Display. 

The default fields for the tab are as follows 

From Bus Number and Name 

"From" bus number and name. Right- clicking on either of these fields allows you to see all 
the flows measured at the "from" bus using the Quick Power Flow List or Bus View Display 
local menu options.  

To Bus Number and Name 

"To" bus number and name. Right-clicking on either of these fields allows you to see all the 
flows into the "to" bus using the Quick Power Flow List or Bus View Display local menu 
options. 

Circuit 

Two-character identifier used to distinguish between multiple lines joining the same two 
buses. 

%LODF 

The LODF value for the line. 

From MW, To MW 

The present MW flows on the line at the "from" bus and the "to" bus. 

From CTG MW, To CTG MW 

The projected MW flows after the change in line status on the line at the "from" bus and the 
"to" bus. 

Note: LODFs are always calculated using a DC power flow technique. 
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Advanced LODF Calculation Dialog 

  

The Advanced LODF Calculation Dialog can be opened by clicking on the 
Advanced LODF Calculation button found on the Line Outage Distribution Factors (LODFs) 
dialog. The advanced calculation dialog allows you to calculate the LODFs for several different 
contingent lines in one batch process. First, you need to use the Contingency Analysis Tool to 
define which contingent lines to use (all contingencies that contain a single branch outage will 
be used.) Also, only lines that are being monitored will have their LODFs calculated. See Limit 
Monitoring Settings to change which lines are monitored. 

  

The output from the advanced LODF calculation process is saved to a file for import into 
another program for analysis. This dialog defines how to save the Advanced LODF results to a 
file for importing in another program. 

Format to Save in 

You can choose to save the advanced LODF results as "Monitored Branch, Contingency" 
pairs for PROMOD, or as a matrix in a comma-delimited text file. The comma-delimited text 
file is useful for loading the results into a spreadsheet program. 

Only save pairs with an LODF whose absolute value is greater than 

This field allows you to filter out elements whose LODF is below a certain value. 

Only Include Monitored Branches whose MW flow increases 

This field allows you to filter out monitored elements whose MW flow did not increase in the 
LODF calculation. 

Maximum Columns Per Text File 

This field is important when you are saving a matrix in a comma-delimited text file. Most 
spreadsheet programs have limits on the number of columns they can display. The default is 
256, which happens to be the maximum number of columns allowed in Excel. 

LODF Number Format 

You can choose to have the LODF values stored in either scientific notation, or as a specified 
length decimal number. 

File Name 

You must enter a file name and location or Browse for a file for saving the LODF data. 
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Directions Display 

  

The Directions Display appears in the upper-right corner of the PTDF window when you select 
Multiple Directions for the PTDF Type. The Directions Display is a case information display that 
allows directions to be defined for performing multiple direction Power Transfer Distribution 
Factors. The Directions Display allows you to insert, delete, and modify directions using 
options available from the display's local menu. When directions are modified or inserted 
individually, the Directions Dialog will be displayed for entering the information. In addition to 
individually defining directions, they can also be automatically inserted using the Auto Insert 
Directions dialog.  
  

Each record in the display shows the following default information: 

Number, Name 

A unique number and name given to the defined direction. 

Source Type, Source Name 

The name and type of the direction source. 

Sink Type, Sink Name 

The name and type of the direction sink. 

Include 

Determines if the direction is to be analyzed when calculating the multiple direction PTDFs. 

Processed 

Displays if the direction has already been processed for a multiple direction PTDF analysis. 
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Directions Dialog 

  

Directions are objects that are defined and used when computing a Power Transfer 
Distribution Factor using multiple directions. 

The Directions Dialog can be used to insert a new direction or to modify the information for 
an existing direction. This dialog can be called by choosing Insert or Show Dialog from the 
Directions Display local menu.  
  

The options that can be set from this dialog include: 

Name of Direction 

The name for the direction. If you are entering a new direction, you can enter a new 
direction name. If you are modifying an existing direction, the name of the currently viewed 
direction will be displayed. A drop down list shows a list of currently defined direction 
names, and choosing one from the list will display that direction's information in the dialog. 
The up and down arrows next to the field also allow you to scroll through the list of defined 
directions. 

Direction Number 

If you are entering a new direction, you can put in a new direction number. If you are 
viewing or modifying an existing direction, the direction's number will be displayed. 

Source 

Select the type of the transfer direction source. Once the type has been selected, the 
advanced find list will be enabled, allowing you to search for the specific object or group of 
objects to set as the direction source. 

Sink 

Select the type of the transfer direction sink. Once the type has been selected, the advanced 
find list will be enabled, allowing you to search for the specific object or group of objects to 
set as the direction sink. 

Include in list of monitored directions 

Determines if the direction is to be analyzed when calculating the multiple direction PTDF's. 
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Auto Insert Directions 

  

Multiple directions can be automatically inserted for PTDF studies using the Auto Insert 
Directions dialog. This option can be selected from the local menu of the Directions Display 
by right-clicking and choosing Direction Records > Auto Insert Directions.  
  

The layout of the dialog is as follows: 

Type of Direction 

There are six types of directions that can be automatically defined. Area to Slack,  Zone 
to Slack and Injection Group to Slack will define directions from areas, zones or 
injection groups to the slack bus of the system. Area to Area, Zone to Zone and Inj. 
Group to Inj. Group will define directions from areas to other areas, zones to other zones, 
or injection groups to other injection groups. 

Delete Existing Directions 

When checked, any previously defined directions will be deleted before the new directions 
are automatically inserted. If not checked, then automatically inserted directions will be 
added to the list of previously defined directions. By not deleting existing directions before 
automatically inserting new directions, it is possible to have more than one direction defined 
with the same source and sink. 

Only Insert for Areas or Zones with Display Filters Set 

If checked, then only Areas and Zones with their Area/Zone/Owner Filters set to Yes will be 
used when automatically inserting directions. 

Starting Number, Increment By 

The Starting Number will be the first number used when automatically numbering the 
automatically inserted directions. Each subsequent direction added will be numbered 
according to the Starting Number and the Increment By value. 

Insert Directions 

Insert Directions will perform the automatic insertion routine for the directions, according 
to the defined options. 
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Flow and Voltage Sensitivities 

  

To access the Flows and Voltages Sensitivities dialog go to the Tools ribbon tab, and choose 
Sensitivities > Flows and Voltages Sensitivities from the Run Mode ribbon group. This is 
only available in Run Mode. 

Single Meter, Multiple Transfers 

The Single Meter, Multiple Transfers Tab of the Flows and Voltages Sensitivities Dialog 
shows the effect an additional injection of real or reactive power at a bus has on real, 
reactive, or complex power flow on a particular line or interface, or on the voltage of a 
selected bus. The grid that occupies the bottom of the dialog lists each bus in the system, 
subject to the Area/Zone/Owner Filter settings. This grid is a case information display and 
thus shares properties and controls common to all other case information displays. The P 
Sensitivity field indicates the effect a 1 MW increase in real power at the bus has on the flow 
(either MW, Mvar, or MVA flow, as dictated by the Flow Type setting) or voltage on the 
device identified by the Device Identifier. Likewise, the Q Sensitivity field indicates the 
effect a 1 Mvar increase in reactive power at the bus has on the flow (either MW, Mvar, or 
MVA flow, as dictated by the Flow Type setting) or voltage (in per unit) on the device 
identified by the device identifier. All injections assume that the power is absorbed at the 
island slack bus. 

Use the Device Type control to indicate whether the sensitivities are to be calculated for a 
line/transformer, an interface, or a bus. Use the Flow Type control to specify the type of 
power flow for which the sensitivities will be calculated. Finally, select the line/transformer, 
interface or bus. 

Whenever you make a change to any of these settings, click Calculate Sensitivities to 
update the grid with the new sensitivities. 

The bus columns (to add see Display/Column Options) of interest after this calculation 
include: 

• Sensitivity: Injection dValue/dP gives the sensitivity of per unit voltage magnitude to an 
injection of real power at the bus chosen in the Select Device section. 

• Sensitivity: Injection dValue/dQ gives the sensitivity of per unit voltage magnitude to an 
injection of reactive power at the bus chosen in the Select Device section. 

• Sensitivity: Injection dValue/dVsetpoint (for PV bus) gives the sensitivity of per unit 
voltage magnitude to an injection of reactive power at the bus chosen in the Select 
Device section. 

• Sensitivity: Injection dAngle/dP (radians/MW) gives the sensitivity of voltage angle 
magnitude to an injection of real power at the bus chosen in the Select Device section. 

• Sensitivity: Injection dAngle/dQ (radians/MVar) gives the sensitivity of voltage angle to 
an injection of reactive power at the bus chosen in the Select Device section. 

The option labeled Set Out-Of-Service allows you to approximate the sensitivities at out-
of-service buses with the sensitivity of the closest bus. Otherwise the out-of-service buses 
will display sensitivities of 0 when the sensitivities are calculated. 

Single Transfer, Multiple Meters 

The Single Meter, Multiple Transfers Tab of the Flows and Voltages Sensitivities Dialog show 
the effect of a single transfer of real or reactive power on all the voltages in the system. To 
specify the transfer choose the Seller and Buyer in the same manner done on the Power 
Transfer Distribution Factors dialog. The specify whether the calculation of Real Power (P), 
Reactive Power (Q), or both are of interest.  

Click Calculate Sensitivities to perform the calculations.  
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After clicking Calculate Sensitivities, each row of the results gives the sensitivity of 
voltage at the respective bus to the power transfer defined by the seller and buyer. The bus 
columns (to add see Display/Column Options) of interest after this calculation include: 

• Sensitivity: Transfer dV/dP gives the sensitivity of voltage to a real power transfer  
• Sensitivity: Transfer dV/dQ gives the sensitivity of voltage to a reactive power transfer 
• Sensitivity: Transfer dAngle/dP gives the sensitivity of voltage to a real power transfer  
• Sensitivity: Transfer dAngle/dQ gives the sensitivity of voltage to a reactive power 

transfer 

The check box option Turn off generator AVR control for generators participating in 
transfer is also available. Selecting this option will turn off AVR control for only those 
generators participating in the transfer with a non-zero participation factor, resolve the 
power flow, calculate the voltage sensitivities, turn the AVR control back on for those 
generators for which it was changed, and then resolve the power flow. Stated another way, 
this option assumes that all generators maintain a constant reactive power output and do 
not maintain their voltage setpoint. 

Self Sensitivity 

The Self Sensitivity Tab of the Flows and Voltages Sensitivities Dialog shows the affect an of 
an injection of real or reactive power at a bus on its own voltage (assuming everything is 
absorbed at the island slack bus). It processes through each bus calculating its own self-
sensitivity only. 

Each row of the results gives the sensitivity of voltage at the respective bus to a power 
injection at the same bus. dV/dP gives the sensitivity of voltage to real power injection and 
dV/dQ gives the sensitivity of voltage to reactive power injection. To speed up the 
calculation, sensitivities are calculated only for the buses displayed in the Bus Sensitivities 
grid. The bus columns (to add see Display/Column Options) of interest after this calculation 
include: 

• Sensitivity: Self dV/dP (per unit/MW) gives the sensitivity of voltage magnitude to an 
injection of real power. 

• Sensitivity: Self dV/dQ (per unit/MVar) gives the sensitivity of voltage magnitude to an 
injection of reactive power 

• Sensitivity: Self dAngle/dP (radians/MW) gives the sensitivity of voltage angle to an 
injection of real power. 

• Sensitivity: Self dAngle/dQ (radians/MVar) gives the sensitivity of voltage angle to an 
injection of reactive power. 

Click Close to close the Flows and Voltages Dialog. 
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Loss Sensitivities 

  

To access the Loss Sensitivities dialog go to the Tools ribbon tab, and choose Sensitivities > 
Loss Sensitivities from the Run Mode ribbon group. This is only available in Run Mode. 

The Bus Marginal Loss Sensitivities Dialog is used to calculate and display the sensitivity 
of a real power loss function, PLosses, to bus real and reactive power injections. Stated 
mathematically, the display calculates d PLosses/d Pi and d PLosses/d Qi , where Pi and Qi are the 
real and reactive power injections at bus i, respectively.  

Stated less formally, the display indicates how losses would change if one more MW or Mvar of 
power were injected at bus i. Simulator can calculate the losses for a bus relative to losses in 
the bus’ island or area, to losses in a select group of areas, or, if the bus belongs to a super 
area, to losses in the bus’ super area. How Simulator computes the losses is governed by the 
value of the Loss Function  Type option.  
  

The Loss Function Type may assume one of the following six values: 

Do Not Calculate Bus Loss Sensitivities 

No Losses are calculated because a loss function is not specified. 

Each Electrical Island  

Losses are calculated with respect to the losses in bus’ island. If the power system consists 
of only one island, losses are computed with respect to the total system losses.  

Each Area  

Losses are calculated with respect to the total losses for the area containing bus i. This is 
probably the most common loss function because usually one is concerned with minimizing 
losses for a particular area rather than for the entire case. 

Each Area or Super Area  

Losses are calculated with respect to the total losses for the area containing bus i if bus i 
does not belong to a super area, and with respect to the total losses for the super area 
containing bus i if bus i does belong to a super area. When a case contains Super Areas this 
is more commonly done. When Simulator calculates loss sensitivities internally for use in the 
Economic Dispatch or the Optimal Power Flow calculation, this is the option which is used. 

Areas Selected on Loss Sensitivity Form 

Losses are calculated with respect to the total losses for a group of areas, specified in the 
Selected Areas table.  

User-Specified 

If you select User-Specified as the loss function type, the values last calculated using a 
different loss function type will become fixed. Thus you can force the loss sensitivities to 
remain constant when used in other features and tools of Simulator. 

In steady-state power system operation, total generation must always equal total load plus 
losses. Therefore, the real power injection at a single bus cannot be changed arbitrarily; it 
must be met by a corresponding change somewhere else in the system so that the total power 
remains balanced. In other words, the change in power injection must somehow be absorbed. 
How the injection is absorbed depends on the Loss Function Type. If the Loss Function Type is 
Each Island, the injection is absorbed by the island slack. For the Each Area and Selected 
Areas loss functions, the injection is absorbed at the area tie-lines.  

The loss sensitivities are calculated by modeling an injection of power at a bus and then 
assuming that this injection is absorbed by the island slack bus. The sensitivity then shows 
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how much the losses (for the region of interest) increase when you transfer 1 MW at the 
injection bus to the island slack. The "region of interest" is what was chosen as Island, Each 
Area, or Selected Areas. 

Therefore, the "absolute numbers" given by the loss sensitivity dialogs are not directly 
meaningful because we are always assuming that the absorbing point is the island slack bus. 
What is meaningful is the "difference" between sensitivity numbers. 

Example: 

 Assume the sensitivities are calculated to be 

 Bus A Loss MW Sensitivity = -0.04 = Asens 

 Bus B Loss MW Sensitivity = -0.02 = Bsens 

 Bus C Loss MW Sensitivity = +0.03 = Csens 

Using these we can then look at the sensitivity of generic transfers between these buses by 
using "superposition". 

Consider the following change in injections modeling a transfer of power from Bus A to Buses 
B and C. 

 Bus A injection = +10 MW = AMW 

 Bus B injection = - 6 MW = BMW 

 Bus C injection = - 4 MW = CMW 

An estimate of the change in losses can then be calculated as  

 Loss Change  = (AMW)(Asens) + (BMW)(Bsens) + (CMW)(Csens) 

   = (+10)(-0.04) + (- 6)(-0.02) + (- 4)(+0.03) 

   = -0.4 MW 

The Bus Marginal Loss Sensitivities Dialog houses the following controls: 

Selected Areas Table 

This table is used only when the Loss Function Type is set to Selected Areas; otherwise, it 
is ignored. Left-click on the Include field to include or exclude areas from the loss function.  

Calculate Marginal Loss Sensitivities Button 

Once the loss function type has been specified, click this button to calculate the bus 
marginal loss sensitivities and update the Bus Marginal Loss Sensitivities table.  

Bus Marginal Loss Sensitivities Table 

This table shows the bus marginal loss sensitivities for all buses with valid Area/Zone/Owner 
filters. The Bus Marginal Loss Sensitivities Table is a type of Case Information Display and 
thus exhibits features and behavior similar to all other case information displays. It has a 
local menu from which you can choose to find out more about a particular bus. You can sort 
records by any of the listed fields by clicking on the column headings. The table contains the 
following fields: 

Number, Name Number and name of the bus. 

Area Number, Area Name  Number and name of the bus’ area. 

Loss MW Sens. Sensitivity of the loss function to an increase in the real power injection 
(generated power assumed positive) at the bus. 

Penalty Factors Computed penalty factor of each bus. 

MVR Sens.  Sensitivity of the loss function to an increase in the reactive power injection 
(generated power assumed positive) at the bus.  
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Just Generators Marginal Loss Sensitivities Table 

This table shows the bus marginal loss sensitivities for only the generator terminal buses 
with valid Area/Zone/Owner filters. This table is otherwise identical to the displayed values 
and table operation as the Bus Marginal Loss Sensitivities Table described above. 
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Transmission Loading Relief Sensitivities 

  

Transmission Loading Relief (TLR) Sensitivities are similar to the Power Transfer Distribution 
Factors. Both TLR Sensitivities and PTDFs measure the sensitivity of the flow on a device to a 
transaction. To calculate PTDFs, you specify a source group and a sink group, and Simulator 
determines the percentage of a single transfer between the source and sink that flows on each 
of several monitored elements. For TLR sensitivities, you specify a single device, such as a 
transmission line, to monitor, and a group that serves either as source or as sink. Simulator 
then determines the sensitivity of the flow on the single monitored element to many different 
transactions involving the group you specified as the source or sink. To summarize, PTDFs 
express the sensitivity of many monitored elements to a single transaction, whereas TLR 
sensitivities gauge the sensitivity of a single monitored element to many different power 
transfers. 

"TLR" stands for "Transmission Loading Relief." TLR is an industry-wide tool for managing 
transmission utilization to prevent overload situations that put the system at risk. For example, 
suppose a particular line is loaded beyond its thermal limit. Its owner will request that a TLR 
program be initiated, which dictates that all transactions for which 5% or more of the 
exchanged power flows on the overloaded element be curtailed. The TLR sensitivity tool in 
Simulator is useful for pinpointing those transactions that would be curtailed. Suppose we use 
the TLR tool to determine where area A can purchase power from while the TLR for the 
overloaded element is in place. We specify area A as the buyer area, identify the overloaded 
line, and tell Simulator to perform the calculation. Simulator will then list the sensitivity of the 
flow on the overloaded line to power exchanges between all other generators, areas, and 
buses to area A. Any transaction for which the sensitivity exceeds 5% would be curtailed; 
anything below 5% would be allowed to continue. 

To calculate TLR Sensitivities, select Tools > Sensitivities > TLR Sensitivities from the 
main menu. This will open the TLR Sensitivities dialog, which will allow you to set TLR 
Sensitivities options and then calculate the sensitivities. 
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TLR Sensitivities Dialog 

  

The TLR Sensitivities dialog allows you to calculate Transmission Loading Relief Sensitivities for 
the load flow case at its solved load flow point. To access this dialog go to the Tools ribbon 
tab, and choose Sensitivities > TLR Sensitivities / Generation Shift Factors from the 
Run Mode ribbon group. This is only available in Run Mode.   
  

The following describes the sections of the dialog: 

Device Type 

Select whether you want to calculate the sensitivities for a transmission line/transformer, for 
an interface, or for multiple elements. To calculate sensitivities for an interface, you must 
have the interface defined in the case. 

When you choose an individual line/transformer or interface, you need to specify the device 
by selecting it from the list of devices. In this case you specify the From Bus, To Bus, and 
circuit identifier for a branch, or the interface name or number. When you select the Multiple 
Elements option, the device selection area of the dialog changes to allow you to select a TLR 
Multiple Device Type. The TLR results display changes accordingly in order to accommodate 
TLR sensitivities for multiple elements. 

Line/XFMR or Interface Only: Choose device 

Specify the From Bus, To Bus, and circuit identifier for a branch, or the interface name, 
number, and monitored flow direction. 

For multiple elements, specify the multiple device type. Choices are: selected 
lines/transformers, selected interfaces, overloaded lines/transformers in the base case, 
overloaded interfaces in the base, overloaded lines/transformers during the set of 
contingencies, and overloaded interfaces during the set of contingencies. 

Multiple Elements Only: Select Lines/XFMRs 

Opens the case information display for lines/transformers. To include a line/transformer in 
the TLR study, set the Selected? field to Yes. 

Multiple Elements Only: Select Interfaces 

Opens the case information display for interfaces. To include an interface in the TLR study, 
set the Selected? field to Yes. 

Transactor Type 

Specify if the sensitivities will be calculated for the transactor being the buyer or the seller. 

Transactor Object 

Specify what the transactor will be. The choices are Area, Zone, Super Area, Slack, Injection 
Group, and Bus. When choosing Area, Zone, or Super Area, this really means all generators 
in the Area, Zone or Super Area weighted by the generator participation factor. 

TLR Sensitivities 

Specify if the next set of calculated TLR sensitivities should replace the currently calculated 
values, or be appended to the current values. The normal option is to Clear before Calculate. 
When choosing to Append, then as new calculations are performed, the results will only 
replace the existing sensitivity value store if the new value is larger than the old value. 
(Note: in this situation, negative values are considered smaller than positive values). 

PTDF Calculation Method 
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Choose the solution method to use for calculating the sensitivities similar as done on the 
PTDF Dialog. 

Note: The Lossless DC methods will be affected by the DC Power Flow Model settings in 
Power Flow Solution: DC Options. Click on the DC Model Options button to open the 
dialog which sets these options. 

Calculate TLR Sensitivities  

Click the button to calculate the sensitivities. The calculation processing through each bus 
and determines the sensitivity of the MW flow of selected device with respect to a change of 
real power at each bus. When the transactor type is buyer, then the assumption is that 
power is injected at each bus and absorbed at the transactor object. When the transactor 
type is seller, then the assumption is that power is injected at each transactor object and 
absorbed at each bus.  

DC Model Options 

Click this button to open the _Ref1351865574DC Options page. Here you can adjust the 
DC options you want used if you are computing the PTDFs with a Lossless DC 
approximation. 

Include only AGCAble Generators 

If checked, then only generators available for generation control will be included in the TLR 
sensitivity calculations. 

Set Sensitivities At Out-Of-Service Buses Equal to Closest 

Click this button to approximate the sensitivities at out-of-service buses with the sensitivity 
of the closest bus. Otherwise the out-of-service buses will display sensitivities of 0 when the 
sensitivities are calculated. 

Line/XFMR or Interface Only: Generator, Area, and Bus Sensitivities 

The Bus Sensitivities show the values calculated at each bus. Generator sensitivities who the 
same information but have only a list of generators with the P Sensitivity column showing 
the sensitivity calculated at the terminal bus. The Area Sensitivities calculated represent a 
weighted average of the generator buses in the area with the weighting done by generator 
participation factor. 

Multiple Elements Only: Mult. Bus Sensitivities and Gen Sensitivities 

The Bus Sensitivities show the values calculated at each bus. Generator sensitivities who the 
same information but have only a list of generators with the P Sensitivity column showing 
the sensitivity calculated at the terminal bus.  
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TLR Multiple Device Type 

  

The Multiple Device Type selector allows you to specify a group of elements for which 
Transmission Loading Relief (TLR) sensitivities will be calculated. The Multiple Device Type 
selection is accessible only when you chose the Multiple Elements option from the Device Type 
in the TLR Sensitivity Dialog. 

Selected Devices 

Select Lines/XFMRs 
Select the Selected Devices option, and click on this button to open a dialog to choose 
the lines and transformers to be included in the calculation. Toggle the Selected field in 
the Lines and Transformer Case Information Display to Yes for the branches you wish to 
include. If the Selected field is not available in the information display, add that column 
to the display by right-clicking in the display and selecting Display/Column Options. The 
ETLR of selected Lines/XFMRs is the algebraic sum of the TLRs of each individual 
element. The WTLR uses as weight the current MW flow in the element.  

Select Interfaces 

Select the Selected Devices option, and click on this button to open a dialog to choose 
the interfaces to be included in the calculation. Toggle the Selected field in the interfaces 
Case Information Display to Yes for the interfaces you wish to include. If the Selected 
field is not available in the information display, add that column to the display by right-
clicking in the display and selecting Display/Column Options. The ETLR of the selected 
interfaces is the sum of the TLRs of the interfaces that have a limit different from zero. 
The WTLR uses as weight the MW flow in the interface. 

Overloaded Devices 

Select this option to include in the multiple element TLR calculation the branches and/or 
interfaces that are overloaded in the present case based on the Limit Monitoring Settings 
and Limit Violations Dialog. The list of the overloaded branches and interfaces is available in 
the Limit Monitoring Settings and Limit Violations information display.  

CTG Overloaded Devices 

Select this option to include in the multiple element TLR calculation the branches and/or 
interfaces that were identified as overloaded by the Contingency Analysis tool. A branch or 
interface is included in the calculation if it has been overloaded during at least one 
contingency. The list of branches and interfaces identified as overloaded can be accessed 
from the Lines, Buses and Interfaces Tab in the Contingency Analysis Dialog.  

The ETLR of the CTG overloaded lines and transformers is the algebraic sum of the 
individual TLRs. The WTLR uses as weight the Aggregate MVA Overload of each 
transmission line and transformer, which is defined as the sum of the MVA overload in the 
line or transformer across the contingencies that caused a violation in that particular line or 
transformer. The Aggregate MVA Overload and a related field, the Aggregate Percent 
Overload of a line or transformer, are measures of the weakness of that transmission line on 
the grid. The Aggregated MVA Overload and the Aggregate Percent Overload are line and 
transformer fields that can be displayed in the Case Information Display, used in Contouring, 
etc.  

The ETLR of the CTG overloaded interfaces is the algebraic sum of the individual TLRs. The 
WTLR uses as weight the Aggregate MW Overload of each interface, which is defined as the 
sum of the MW overload of the interface across the contingencies that caused a violation in 
that interface. The Aggregate MW Overload and a related field, the Aggregate Percent 
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Overload of an interface are measures of the weakness of the interface. These two interface 
fields can be displayed in the Case Information Display, used in Contouring, etc. 

Effective Transmission Loading Relief (ETLR) 

In the same manner as the TLR represents the MW increase in an element per MW transfer, 
the ETLR column in the Mult. Bus Sensitivity table represents the total MW increase in all the 
elements in the set per MW increase of the transaction. Let us suppose that the set contains 
two transmission lines: A and B and assume that for a 1 MW transfer from bus i to the 
transactor, the flow in line A increases in 0.5 MW and the flow in line B decreases in -0.3. 
Then the ETLR of bus i is +0.2 since that is the total MW increase in the elements in the set. 
The ETLR provides a measure of the simultaneous MW change in multiple elements, and 
thus the overall effect in flows on the element of the set. The ETLR is a bus field that can be 
included in the bus Case Information Display, used in Contouring, etc.  

Weighted Transmission Loading Relief (WTLR) 

The WTLR column in the Mult. Bus Sensitivity table weights the sensitivities based on the 
flow or overload flow values of the element. It is a measure of the value of a certain bus to 
relief transmission loading. The buses with the highest WTLR (or lowest WTLR, depending 
on the transactor type) are identified as the most effective buses to mitigate transmission 
loading considering multiple elements. The WTLR is a bus field that can be included in the 
bus Case Information Display, used in Contouring, etc.  
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Generation Shift Factor Sensitivities 

  

Generation Shift Factor (GSF) Sensitivities are a specific kind of TLR calculation. GSFs always 
involve a transfer with the slack bus being the Buyer. Other than this, GSF and TLR 
calculations are identical. See TLR Sensitivities for more information. 
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Chapter 12: Time Step Simulation 

  

This chapter contains information on the new Time Step Simulation tool. This tool allows you 
to set up multiple solution runs with changing input data. This can be useful for running 
several OPF or SCOPF solutions in sequence, and storing information from each solution in 
tabular format. 

This tool can also be handy as a training tool as well. As an instructor, you can set up a 
scenarios that the student can interact with, and have changes occur at prescribed intervals 
during their interaction. 
• Time Step Simulation Overview 
• Setup and Control 
• Schedules 
• Running the Simulation 
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Time Step Simulation 

  

The Time Step Simulation tool allows you to specify operating conditions and obtain power 
flow solutions for a set of points in time. It provides the tools needed to analyze the operation 
of a power system hour by hour. 

Time Step Simulation is available in the base Simulator package. If you own Simulator, you 
can start taking advantage of this valuable tool right away. In addition, if you own Simulator 
OPF or SCOPF licenses, you can solve hourly OPF and SCOPF scenarios and use the tool to 
evaluate the behavior of prices and operating constraints. The tool will obtain the optimized 
generation dispatch for each hour of the analysis horizon.  

In order to access the Time Step Simulation, go to the Tools ribbon tab, and choose Time 
Step Simulation from the Run Mode ribbon group. This is only available in Run Mode. Please 
continue reading the following topics and take full advantage of this powerful tool. 
  

Time Step Simulation Quick Start 

Time Step Simulation Dialog 

Specifying and Maintaining a List of Time Points 

Loading Hourly Input Data 

Setting up Scheduled Input Data 

Storing Input Data and Results 

Running a Timed Simulation 

Time Step Simulation Toolbar 

Running OPF and SCOPF Time Step Simulations 
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Time Step Simulation: Quick Start 

  

The first time you access the Time Step Simulation by selecting Time Step Simulation from 
the Run Mode ribbon group on the Tools ribbon tab, you will see the Time Step Simulation 
Dialog, which contains several pages. The Hourly Summary page is used to define and 
control the time points you want to analyze. As an example, we will assume that you have 
hourly load data for tomorrow and that you want to determine the system bus voltages for 
each hour. You would do the following: 

Step One: Set the List of Points 

In order to create a list of points, right click on the Hourly Summary page and select 
Insert New Timepoint(s), which brings up the New Timepoint Dialog. In this dialog, 
select tomorrow’s date from the drop down calendar component. Set the field Total 
Number of Timepoints to Enter to 24. Assume the other default values and click OK. 
This will insert 24 timepoints one for each hour starting tomorrow at 1: 00 AM.  

Step Two: Specify Input Data 

Input data is specified in the Input Page. In this example your input data corresponds to 
hourly loads. Select the Hourly MW Loads sub-page. In order to specify hourly load values 
you have to insert a column for each load. Right Click on the grid and select Scale/Insert 
Load  Column(s) to bring up the Insert/Scale Column Dialog. In the selector component, 
select the load for which you want to specify hourly values. You can press the shift key to 
select multiple elements. Then press the blue Arrow Button to pass the selected loads to 
the right side of the selector. Select OK to insert the new column(s). Now you can specify 
the hourly MW values for those loads.  

Step Three: Specify the Custom Results 

Obtaining solutions for a large number of timepoints has the potential to create unnecessary 
burden in memory and storage due to the large amount of data that can be generated. For 
this reason, the Time Step Simulation Tool allows you to explicitly specify what quantities 
you want to display and store. This is done in the Results Page. This page contains grids for 
many devices including Generators, Lines, etc. In this example we want to analyze the bus 
voltage magnitudes. We specify what quantities we want to store as results for each object 
by clicking the View/Modify button, which brings up the Custom Results Selection Dialog. 
In this dialog select the Buses page and in the Available Bus Fields section check the Per 
Unit Voltage field. Results will be saved only for those buses that have the Time Selected 
field on the grid set to YES. Set this field to YES for the buses that you want to save. Click 
the Save and Close button to save the custom results settings, i.e., which objects, fields 
and records are to be kept during the solution; in this case bus voltages. 

Step Four: Run the Simulation 

The upper part of the Time Step Simulation form contains buttons used to control the 
simulation. To do a full run of the 24 hours click the Do Run button. The Last Result box 
shows the progress of the simulation as each time point is being solved. If you are in the 
Results – Buses page, you will see that a column was added for each bus set to YES in the 
Custom Results Selection Dialog. Each column shows the bus per unit voltage. Recall 
that you can Right Click on any Simulator grid and select Plot Column to obtain a plot of 
the column values. If you select cells spanning all the bus per unit voltage columns, you will 
obtain the voltage profiles for each bus, versus time. 

If you are in the Hourly Summary page, the Processed column shows that each point 
was in fact processed and solved.  

Step Five: Save the Results 
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Once you have completed the simulation, you can save the results in a Time Series Binary 
(tsb) file by pressing the Save Data Binary button. This file will contain all the input data, 
the simulation options, the custom results settings, and the results. You can reload this tsb 
file any time by pressing the Read Data Binary button.  
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Time Step Simulation Dialog 

  

The Time Step Simulation Dialog is used to control and visualize the time simulation. The top 
section of the form contains buttons for data input/output and buttons to control the progress 
of the simulation. The main part of the form has a number of Time Step Simulation Pages that 
contain grids where input data can be specified and simulation results can be examined.  
  

Input/Output Buttons 

Read TSB File 

Press this button to read a Time Series Binary file (.tsb File). This files stores hourly and 
scheduled input data, the simulation options and the hourly results. 

Read Load Format 

Reads a .csv file containing hourly load MW and MVar values. The CSV format of this file is: 

  
BUS_NUMBER,BUS_NAME,VST bus numbers,DPID,YrMoDay,Hr,KW,KV 

446,ANAME,18803,506520,20041001,1,1970,769 

446,ANAME,18803,506520,20041001,2,2005,821 

  

Save TSB File 

Press this button to save the hourly and scheduled input data, the simulation options, and 
the hourly results in a Time Series Binary file (tsb file).  

Read Excel Data 

Reads hourly load and generation data from Excel: The formats for generator and load data 
are: 

Generators: 

GEN DATA         

Date Hour BusNameGen1 BusNameGen2 . . . 

Bus Numbers (s)   19306 100370 . . . 

10/01/05 1 522 340 . . . 

10/01/05 2 522 340 . . . 

. . .         

Loads: 
BUS_NUMBER BUS_NAME VST bus 

numbers 
DPID YrMoDay Hr KW KV 

2192 3BLUFF C 19306 100370 20050101 1 307 177 

2192 3BLUFF C 19306 100370 20050101 2 311 -
180 

. . .               

  

Simulation Control Buttons 
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During the solution, the Time Step Simulation solves each timepoint in a sequential manner. 
During this process, the Simulation can be in one of three states: 
1. Reset: When the simulation has not started, when it has been completed, or when it has 

been paused and then reset.  
2. Running: When the simulation is solving time points sequentially. 
3. Paused: When the user has paused the simulation. The simulation actually waits until the 

present time point is solved in order to pause. If the simulation includes a SCOPF solution, 
then all the contingencies are processed and the system is optimized before the simulation 
is paused. Note that once a time point is solved its results are available on the various 
grids.  

The user controls the Time Step Simulation by means of the following control buttons: 

Starting Time 

Use this selector to specify a start time point other than the first time point in the list. The 
simulation will disregard the time points before the selected start time point.  

Ending Time 

Use this selector to specify an end time point other than the end time point in the list. The 
simulation will stop right after the selected end time point.  

Do Run [Pause Solution, Continue Solution] 

Press this button to initialize the Time Step Simulation and go through all the timepoints 
until the last time point or a time point with Pause field set to YES is found. As the 
simulation takes place, the Last Result Box will be updated with messages. In addition, 
the Hourly Summary Page will change the Processed and Solved fields from No to Yes, 
reflecting the simulation progress. The result grids will be updated once the solution for a 
timepoint has been found.  

When the Simulation starts, the simulation status changes to Running, and the Do Run 
button changes its caption to Pause Solution. Press this button to pause the Solution. The 
simulation will continue until the current time point is solved entirely. Once the Simulation 
status is set to Paused, the Do Run button caption changes to Continue Solution. Press 
this button to continue the solution.  

Do Single Point 

Use this button to solve the next time point. You can see the last processed point in the 
Last Result box. You can also select a specific starting point by using the Start Time 
Point Selector.  

Reset Run 

Use this button to go back to the first time point and initialize the simulation. This action 
does not delete the results of the time points processed so far, but it resets all the 
processed fields to No. 

Last Result  

The last result box in the lower left corner of the dialog is used to show solution progress 
messages. The messages indicate correct solutions or errors in the solution of the particular 
time point. It also shows the progress of the contingency analysis during a SCOPF solution. 

Present Time 

If you are solving the timepoints using a scaled time delay, the Present Time of the process 
is displayed in this field. 
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Time Step Simulation Toolbar 

  

The purpose of this toolbar (besides providing shortcuts) is to command a Time Step 
Simulation without having to keep the Time Step Simulation Dialog open. This is particularly 
important during a Timed Simulation, in which you want to see the changes on the oneline 
diagram as they occur in time.  
  

 
  

The Figure shows the main functions of the toolbar. [Show/Hide the Time Simulation Form; 
Play/Pause/Reset/Next Time Control Buttons; Last Result Box; Present Time; Progress Bar, 
and Timed Simulation Options]. All the buttons, except the Show/Hide Time Simulation Form 
are disabled until a list of time points have been defined in the Hourly Summary Page. The 
Time Step Simulation Toolbar is available in Run Mode and it is visible only when the 
Time Step Simulation Dialog is open.  
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Time Step Simulation Pages 

  

The Time Step Simulation Dialog contains a number of pages used to specify hourly and 
scheduled input data, and to examine the results of the simulation. Please continue reading 
the following sections for a detailed explanation of each page: 

Hourly Summary Page 

Input Page 

Results Page 

Results: Constraints Page 

Options Page 

TSB Description Page 
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Hourly Summary Page 

  

The Hourly Summary Page of the Time Step Simulation Dialog is used to define the time 
points and to display a summary of the simulation. Most of the commands to manage time 
points can be accessed form the Hourly Summary Page Local Menu. 

Once timepoints are defined, the Summary Page presents the following columns for each time 
point: 

Date 

The date of the time point. To modify the date, Right Click and select Change Timepoint  
Time on the Local Menu. 

Hour 

The time of the time point to the minute. To modify the time, Right Click and select Change 
Timepoint Time.  

Skip 

This field is set to YES to include the time point in the Simulation. If set to NO, the hourly 
input data and any schedule action that occurs at this time point is not to the power system.  

Processed 

This field is set to yes if the simulation has processed the time point. This includes applying 
the hourly input data, applying the scheduled actions and solving the power flow for that 
particular time point. 

Solution Type 

The time point can be solved using one of the following Solution Types: Single Solution, 
Unconstrained OPF, optimal power flow (OPF), and security-constrained optimal power flow 
(SCOPF). The last three solution types require the Simulator OPF/SCOPF add-ons.  

Run Contingencies 

If the case has a defined set of contingencies, you can choose to run the contingency 
analysis for each time point by setting this option to YES. 

Solved 

YES if a solution was obtained for the timepoint under the specified solution type. 

Num Loads 

Total number of loads for which hourly input data has been specified.  

Total MW Load 

Total MW load specified as hourly input data for the timepoint 

Total Mvar Load 

Total reactive load specified as hourly input data for the timepoint 

Num Gens 

Total number of generators in the system for which hourly input data has been specified 

Total MW Gen 

Total MW of generation specified in the hourly input data.  

Pre Script Cmd 
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The Time Step Simulation has the capability of running a pre script command before each 
time point. The pre script command is run right before the time point is solved. Please check 
the Script Command section to learn the details about performing Simulator actions using 
script commands.  

Post Script Cmd 

The Time Step Simulation has the capability of running a post script command right after 
the time point is solved. Please check the Script Command section to learn the details about 
performing Simulator actions using the script language.  
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Hourly Summary Page: Local Menu 

  

The Hourly Summary Page Local Menu is used to perform a number of logical actions on the 
timepoint grid and is, as every Simulator local menu, accessed by right clicking anywhere on 
the grid. When selected from the Hourly Summary Page, the local menu shows the following 
additional time step simulation specific options: 

Apply Time Point 

Simulator applies the hourly input data of that particular time point to the power system 
model, without solving the time point. Upon selection of this option, the timepoint 
information can be visualized in the Case Information Displays.  

Solve Time Point 

This option applies the time point hourly and the scheduled input data to the power system, 
and solves the timepoint after the specified solution type.  

Change Time Point Time 

This option allows the user to modify the date time of the selected timepoint. If the new 
date time belongs to an existing point in the list, an error message is displayed. The 
timepoints can be specified with an accuracy of up to one minute.  

Display/Column Options 

Select this option to add or remove columns to the hourly summary grid. 

Set/Toggle/Columns > Select Column(s) 

This option is normally used to select the entire column. You can drag the mouse across 
several columns in a row, and use this option to select multiple columns. Then you can for 
instance copy the entire column data to the clipboard, or plot all the selected columns.  

Set/Toggle/Columns > Select Row(s) 

This options is normally used to select an entire row. You can drag the mouse across several 
rows within a column, and use this option to select multiple rows. Once the rows are 
selected, you can perform actions with the selected rows, such as copying data to the 
clipboard. 

Set/Toggle/Columns > Contour Column 

Use this option to contour a column in the data grid. 

Insert New Timepoint(s) 

Use this option to insert new timepoints into the timepoint list. This selection brings up the 
New Timepoint Dialog. 

Set/Toggle/Columns > Plot Column(s) 

Use this option to automatically generate column plots. By default, in the Time Step 
Simulation grids, the column plots display graphs of column data versus the datetime 
column (the combination of the date and hour columns). 

Delete Entire Timepoint Record 

Use this option to delete the selected timepoint and all the hourly input data and custom 
results of that timepoint.  

 



Time Step Simulation 

883 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Input Page 

  

The Time Step Simulation Input Page is used to specify hourly input data and scheduled data. 
This requires that the list of timepoints have been created. Please read the Specifying and 
Maintaining a List of Timepoints for details on managing the list of time points.  

The Input Page contains several pages that can be grouped in two types: Hourly Input Pages 
and Schedule Pages.  

Hourly Input Pages 

The hourly input pages (Hourly MW Loads, Hourly Mvar Loads, Hourly Actual MW 
Generation, Hourly Maximum Generation, Hourly Line Status, Hourly Area Loads, and Hourly 
Zone Loads) are Matrix Grids that are used to specify data on an hour by hour manner. In 
order to tell Simulator that we want to specify hourly data for a load, generator, or line, we 
need to add that particular object to the corresponding grid. For instance, suppose that you 
want to specify hourly MW data for Load 1 at bus 1. Then go to the Hourly MW Loads page, 
right click and select Insert/Scale Load Column(s) to bring up the Insert/Scale Column 
Dialog. In this dialog, you can select the load and add it as a column to the Load grid. The 
corresponding values for that particular load can then be entered.  

A similar process is followed to add one or multiple hourly MW generation outputs or hourly 
line statuses.  

Use the Hourly Area Loads and Hourly Zone Loads pages to specify the hourly MW load for 
an entire Area or Zone. When Simulator applies the input data to solve a timepoint, it will 
scale the load of the specified area or zone to match the value entered for that hour.  

Schedule Pages 

The schedule pages (Schedules Page and Sched Subscriptions Page) are used to specify 
scheduled input data, i.e., data that does not follow an hour by hour format. Examples of 
data that can be scheduled are scheduled transactions, generator statuses, line statuses, 
etc. For a detailed explanation on how to set up scheduled data, please read the Setting Up 
Scheduled Input Data section.  
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Matrix Grids 

  

Matrix Grids are a special type of data grids used in the input and results pages of the Time 
Step Simulation tool. In these grids, the time dimension is assigned to the rows and the object 
fields (load MW, generator MW output, etc) are assigned to the columns. The column header 
corresponds to the ID of the object. The number of columns of the grid depends on the user 
options and simulation results: 

Hourly Input Pages 

In the case of input pages, the user has to specify hourly data for each object, e.g., load, 
generator, area. Thus the user adds each column to the grid explicitly.  

Custom Result Pages 

In the custom result pages, a column is created for each object whose results have been 
specified to be stored. 

Constraint Pages 

Since the constraints are determined at solution time, the columns appear only when 
constraints have been detected during the solution.  
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Results: Constraints Page 

  

This page is only available in OPF and SCOPF versions of Simulator. When the OPF solution 
type is used to solve a timepoint, the status of the system during that particular hour is 
optimized so that the total operating cost of the system is minimized and the normal operation 
constraints are enforced. In addition, the SCOPF solution type enforces contingency 
constraints. The OPF and SCOPF solutions contain information about the elements that 
determine the LMPs, the binding constraints, the violating contingencies, and changes in the 
control settings.  

The information related to contingencies on these pages is available only in the SCOPF 
Simulator add-on. 

The pages of the Results: Constraints Page are: 
  

Results Summary 

This page is similar to the Hourly Summary Page, except that it contains additional operating 
information such as: 

Initial Cost: The cost of operating the system given the initial generator set points and a 
standard power flow solution. No controls are moved to minimize cost 

Unconstrained Cost: Is the total operating cost after the controls are moved to minimize 
cost, without enforcing any normal operation or contingency constraint. The result is an 
operating cost that corresponds to an Economic Dispatch solution.  

Unconstrained LMP: Is the average marginal price of the system under unconstrained 
optimization. 

Final Cost: Is the total operating cost after a constrained (OPF or SCOPF) solution has been 
obtained. 

LMP (Average, Standard Deviation, Minimum and Maximum): Metrics of the LMP values. 

Binding Lines: Number of transmission lines and transformers that are binding after the 
OPF/SCOPF solution has been determined. 

# CTGs Unsolvable: Number of unsolvable contingencies. These are severe contingencies 
that would cause the power flow solution to fail for that particular time point scenario. 
Unsolvability of the power flow case is related to maximum loadability conditions.  

  

Hourly Binding Lines  

This is a Matrix Grid that shows information for transmission lines and transformers that 
become binding constraints during the OPF or SCOPF solutions. A similar page is available 
for binding interfaces. 

When transmission lines or transformer thermal ratings become binding constraints for a 
timepoint, a column is automatically added forming in this manner the matrix grid. You can 
access the details of the binding line or transformer by right clicking and selecting Show 
Binding Constraint Dialog on the Local Menu. The grid shows also the following summary 
columns.  

Processed: YES if the time point was correctly processed.  

CTGs with Viols: Number of contingencies that presented one or more violations (violating 
contingencies)  

# CTGs Unsolveable: Number of unsolvable contingencies for the timepoint 
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BC Line Viols: Number of transmission line and transformer violations that were identified 
in the base case.  

# Line Viol: Number of transmission line and transformer thermal violations.  

Binding Lines: Number of binding lines in the OPF/SCOPF solution. 

Line Unenforceable: Number of lines with unenforceable limits.  

  

Hourly Binding Interfaces 

This is a Matrix Grid that shows information for interfaces that become binding constraints 
during the OPF or SCOPF solutions. A similar page for lines is available. 

When interfaces become binding constraints for a timepoint, a column is automatically 
added to the matrix grid. You can access the details of the binding interface by right clicking 
and selecting Show Binding Constraint Dialog on the Local Menu The grid shows also the 
following summary columns.  

Processed: YES if the time point was correctly processed.  

CTGs with Viols: Number of contingencies that presented violations (violating 
contingencies)  

# CTGs Unsolveable: Number of unsolvable contingencies for the timepoint 

BC Interface Viols: Number of interface violations that were identified in the base case.  

# Interface Viol: Number of interface violations. 

Binding Interface: Number of binding interfaces in the OPF/SCOPF solution 

Interface Unenforceable: Number of interfaces with unenforceable limits. 

  

Hourly Binding Contingencies 

This Matrix Grid shows information similar to that found on the Hourly Binding Lines and 
Hourly Binding Interfaces pages. Here though the data is organized by contingencies, which 
allows easy identification of the most severe contingencies. Each column of the matrix grid 
corresponds to a contingency. The grid shows also the following summary columns.  

Processed: YES if the time point was correctly processed.  

CTGs with Viols: Number of contingencies that presented violations (violating 
contingencies)  

# Line Viol: Number of transmission line and transformer thermal violations.  

Binding Lines: Number of binding lines in the OPF/SCOPF solution 

Binding Interfaces: Number of binding interfaces in the OPF/SCOPF solution 

Base Case: Shows the number of violating contingencies in the base case. 

  

Binding Line Summary Matrix 

This Matrix Grid shows the number of hours that a line has been binding due to each 
contingency. In this case, the rows correspond to binding lines, and the columns to violating 
contingencies. You can access the details of the binding element by right clicking and 
selecting Show Binding Constraint Dialog on the Local Menu The grid shows also the 
following summary columns 

From Number: Binding line from bus number 



Time Step Simulation 

887 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

To Number: Binding line to bus number 

Circuit: Binding line circuit ID 

Total Hrs: Total number of hours the line was binding (in the overall simulation). 

Total Hrs Unenforceable: Total number of hours the line constraint was unenforceable (in 
the overall simulation) 

Basecase: Number of hours the line was binding in base case solutions.  

  

Binding Line Summary List 

Shows information similar to the Binding Line Summary Matrix but in form of a List. The 
same line may appear several times under different contingencies. Besides the information 
on the Binding Line Summary Matrix, this grid shows the following fields.   

Contingency Name: Contingency that causes the line constraint to be binding 

Avg MC: Time Average MVA Marginal Cost   

Max MC: Time Maximum MVA Marginal Cost 

Min MC: Time Minimum MVA Marginal Cost  
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Binding Elements Dialog 

  

This dialog is called from the Results: Constraints Page of the Time Step Simulation dialog. 
Right-click on a time point record in the Results: Constraints table, and select Show Dialog 
from the popup menu. The dialog shows the binding line and interface constraints determined 
by the OPF/SCOPF solution. The Time selector allows easy navigation through the list of time 
points. 

The grid section of the dialog shows the following: 

Type: Either line or interface flow 

Constraint ID: Line or Interface ID 

Contingency Name: Name of the contingency under which the constraint becomes binding. 

MVA Marg. Cost.: Marginal cost of enforcing the constraint. For lines, the limit corresponds 
to the thermal (MVA) limit. For interfaces, it is given by a MW limit. 
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Results Page 

  

The results of the Time Step Simulation are presented on the grids of the Results Page. The 
Time Step Simulation allows you to specify what objects (buses, lines, generators, loads, etc) 
and what object fields (bus voltage, bus LMP, gen MW, etc) should be displayed on the result 
grids. This gives the user the flexibility needed to explore the relevant results, avoiding at the 
same time the problem of storing a massive amount of results, most of which may not be 
relevant. Storage is a critical aspect of the Time Step Simulation, since a set of results 
comparable to full a PF/OPF/SCOPF solution is generated for each timepoint. 

The Results Page has two sections: The top section is used to set up the options needed to 
customize the results display. The grid section is used to display the actual results.  

Results Page: Top Section 

This section includes the following options: 

View/Modify 

Press this button to access the Custom Results Selection Dialog. This dialog is used to 
specify the objects and object fields for which results will be stored. 

Load 

The custom result definitions set up in the Custom Results Selection Dialog can be saved in 
a Results File in order to use them with different tsb files or Simulator cases. Press this 
button to Load the Results File and apply the result definitions to the current Time Step 
Simulation. 

Save 

Press this button to save the result definitions in a Results File. 

Group Results by 

The Result Grids for Areas, Buses, etc are Matrix Grids that present the hourly results for 
each type of object. For instance, suppose that we want to store the bus voltage magnitude 
and angle. The Buses grid will show columns for the hourly values of voltage magnitude and 
voltage angle of each bus. 

Objects: The columns will be grouped by objects, e.g., all the fields of bus 1, then all the 
fields of bus 2, etc. 

Fields: The columns will be grouped by fields, e.g. all the bus p.u. voltages, then all the bus 
LMPs, etc. 

Identify Results by 

The Result Grids for Areas, Buses, etc. create one column for each object field specified in 
the Custom Results Selection Dialog. The column header thus identifies the particular object 
for which hourly results are displayed. This identification can be made based on the object 
Number, Name or Number + Name combination. 

Results Page: Grid Section 

This grid section is used to display the results of the Custom Results Grid Pages. 
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Custom Results Selection Dialog 

  

This dialog is used to specify what objects and object fields will be stored during the Time 
Step Simulation and will be displayed on the Results Grid Pages. This dialog is opened using 
the View/Modify button on the Results page of the Time Step Simulation dialog. 

In order to tell the Time Step Simulation that you want to store a particular field for a certain 
object, you need to: 
1.  Click on the page of the object type you need to store (Area, Bus, etc) 
2.  Set to YES the Time Selected field of those objects for which you want to store 

information. 
3.  Check the boxes corresponding to those fields you want to store (bus LMP, bus p.u. 

voltage, etc) 

Once you are done with the selections, press the Save and Close button to apply the 
customization. The Custom Results Grid Pages will be filled with the corresponding columns 
after the Time Step Simulation starts.  

Note that the actual results and the result customization will be stored in the tsb file. For more 
information about saving the Time Step Simulation results, please read the Storing Input Data 
and Results section. 

  

The following object's fields can be specified to be displayed on the grids and stored in the tsb 
file. 

Areas  

Buses 

Generators 

Injection Groups 

Interfaces 

Lines 

Owners 

SuperAreas 

Transformers 

Zones 

  

To choose the fields for a specific type of object, click on the Add/Remove Fields button 
and select the fields from the list of available fields on the left side of the Select Fields 
dialog, and move them to the Selected Fields list on the right side of the dialog. Click OK to 
choose the selected fields. 
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Results Grid Pages 

  

These are the Pages of the Results Page that show the results of the Time Step Simulation 
after the results definitions specified in the Custom Results Selection Dialog.  

There is one page for each type of object: Areas, Buses, Generators, Injection Groups, 
Interfaces, Lines, Owner, Superareas, Transformers and Zones.  

These pages are all Matrix Grids. Each column of the grid corresponds to a field of a specific 
object of the power system, e.g., KV voltage of bus 1. Each row of the grid corresponds to a 
timepoint.  

Note that you can plot the results of the grid versus the timepoint date time by selectiing Plot 
Column(s) on the Local Menu. 
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Time Step Simulation Options 

  

The Time Step Simulation is controlled through as set of options specified in the Options 
Page. The Result Options and the Pricing Options are available on this page only in the 
OPF/SCOPF Simulator add-ons. 

Area and Zone Load Scaling 

In many practical studies, hourly data of individual MW load may not be available for all the 
loads in a control area. In order to simulate load variations, Simulator allows you to specify 
the hourly Area or Zone Total MW Load values in the Hourly Area Loads and Hourly Zone 
Loads page of the Input Page. Thus the Time Step Simulation load data may be a 
combination of: 

• Areas or zones where each individual load is specified 
• Areas or zones where only the total hourly MW load is known. 
• Areas or zones where some individual loads and the total area load are known. 

If you have specified individual load values for a load within an area or zone that is also set 
to be scaled to a total MW value, Simulator will adjust the individual load to the individual 
value first, and then the load will be scaled with the rest of the loads in the area or zone to 
achieve the total MW value desired for the hour. The final load will be the total value 
specified for the area or zone. 

When hourly values are specified for areas and zones within the same time step input, only 
one or the other can be used. This can be set in the Use Hourly Values of option. 

You can also specify in the Reactive Power Scaling option how the reactive power is 
treated when the load is scaled. You can choose to have the reactive power scaled to keep 
the power factor constant, or for the reactive power to remain fixed at its original value. 

Solution Options 

These options control the solution process. 

Pause if Power Flow Does Not Solve: The Time Step Simulation is stopped at the 
timepoint where a power flow solution cannot be obtained. This is an indication of wrong 
data or a system brought to its loadability or transfer capability limit.  

Enable Power Flow Area Interchange: This option ensures that the area interchange 
control, if possible, is enforced in the case.  

Use Parallel Contingency Analysis (on Dual CPU Machines): Use this option to speed 
up the computation of the contingency analysis by distributing the processing time on 
several processors. This option is available for SCOPF. 

Pricing Options  

These options are available only in the OPF/SCOPF add on. 

Solve Unconstrained Case: Select this option when you want an unconstrained solution 
to be obtained before an OPF or SCOPF solution for each time point. When combined with 
the Results Options -> Save Unconstrained Generator MW Outputs, the MW 
Generator outputs obtained in the unconstrained solutions are saved. 

Price Hydro Generation at Marginal Cost: During OPF and SCOPF simulation, hydro 
generation may experience large changes in output due to its low marginal cost. However, 
hydro generation is often not as cheap if limited water levels and dam restrictions are 
observed. These considerations are usually taken care of in the hydro-thermal coordination 
solution, outside of Simulator. In the OPF and SCOPF solutions it is important to assign a 
reasonable price to hydro generation to avoid large generation output deviations. A common 
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mechanism to do that is to first obtain the system marginal cost, and then assign this cost to 
the hydro units.  

Reset Hydro Generation Price at the End of Time Period: Choose this option to make 
the hydro generation price be reset for the next time point solution.  

Save Binding Constraints: The binding constraints determined in the OPF/SCOPF are 
stored. 

Time Step Simulation Options 

The Time Step Simulation can be performed in two ways: 

Continuous: In this case Simulator solves one time point after another immediately. The 
purpose of the simulation is to obtain the solutions for all time points as quickly as possible.  

Timed: The purpose is to simulate the solutions as they would occur in actual time. In this 
case, the difference in date time between two time points in the list defines a delay to start 
the solution of the second point. A Time Scale is used to set the speed of the simulation 
with respect to actual time. Suppose that you have 3 time points defined at the following 
date times: 

1/20/05 1:00 AM 

1/20/05 2:00 AM 

1/20/05 4:00 AM 

Assume also that the Time Scale is 1 hour runs in 10 seconds. If you start the Timed 
Simulation you would see the conditions of the first time point applied to the power 
system immediately, the conditions of the second time point applied 10 seconds later, and 
those of the third point applied 20 seconds after the second point. The delays on the 
simulation allow you to see how the quantities evolve in actual time. In addition, you can 
animate the time simulation while each time point is being solved. The visualization of the 
Timed Simulation is enhanced when you use the Time Step Simulation Toolbar. 

Step Type: This section of options allows you to specify if the data for each time point 
should be applied only, or if the data should be applied and the load flow solved. You can 
also specify if the specified hourly data in the Input page should be applied, if schedules 
should be applied, and if the solution of the previous time step should be applied as the 
starting point for the next time step. 

Auto Contouring Options 

The Time Step Simulation allows you to contour quantities on the oneline diagram using 
Simulator Contouring at each timepoint. Optionally, these contour diagrams can be saved in 
different formats.  

No Auto Contouring: Contouring is not used during the Time Step Simulation. Although 
using the Timed Simulation you can see the quantities change and the animation take 
place on the diagrams, the contouring is not displayed.  

Contour but Do not Save: Contouring takes place at each timepoint, but the diagrams are 
not saved. 

Save in File as Bitmap: The contouring diagrams generated at each timepoint are saved 
in Bitmap format. 

Save in File as JPEG: The contouring diagrams generated at each timepoint are saved in 
JPEG format. 

Contour File Name Format: The Bitmap or JPEG contouring diagrams are saved using the 
specified format, which includes the timepoint date time.  
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Auto Load TSB File Options (saved in case pwb file) 

These are options that relate the power system case (.pwb File) to the time series binary file 
(.tsb file). These options are saved with the .pwb case.  

Automatically Load Default *.tsb File: The tsb file specified in the Default *.tsb file is 
loaded automatically when opening the .pwb case. If the file cannot be found, a message 
will be issued.  

Automatically Run Simulation after Loading *.tsb: This option is only relevant if the 
tsb file was automatically loaded, and instructs the TSS form to solve the load flow 
immediately following loading the tsb file. 

Automatically Set Default *.tsb File to Current *.tsb File: When leaving Simulator, 
the current time series information is saved in the Default *.tsb file.  

Default *.tsb File: Default path and name of the *.tsb file.  

Run Pre-Script Command 

This option allows you to choose if script actions specified to be run before solving the load 
flow for certain hours should be implemented before or after specific input data designated 
for that hour is applied. 

 



Time Step Simulation 

895 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Specifying and Maintaining a List of Timepoints 

  

The list of timepoints is the basis for the Time Step Simulation. Simulator will go through the 
list of timepoints and solve each one of them in sequence. Results will be available only for 
those timepoints specified in the list.  

Whether you start with an empty list or you already have time points in it, you can insert new 
time points by Right-Clicking in the Hourly Summary page and selecting Insert New 
Timepoint(s). This will bring up the New Time Point Dialog.  

The list of timepoints will be always sorted based on the date time shown on the date and 
hour column in the Hourly Summary Page. Thus, if you crate a new time point with an 
intermediate date time, Simulator will insert it at the appropriate place in the list. If you need 
to change the date time of a timepoint you can Right-Click in the Hourly Summary grid 
and select Change Timepoint Time to bring up the Change Timepoint Time Dialog. This 
dialog is similar to the New Timepoint Dialog, with the exception that instead of specifying the 
date time for a new timepoint, you will be modifying the date time of an existing time point. If 
the date time matches the date time of an existing time point, a warning message is issued.  

Each timepoint is linked to its hourly data in what is called a Timepoint Record. The 
Timepoint Record contains the date and time of the time point, all the input hourly data 
specified for that point, and if any, the results that have been obtained for that timepoint. If 
you delete a timepoint, the entire record is deleted with it. In order to delete the timepoint 
you can Right Click in the Hourly Summary grid and select Delete Entire Timepoint 
Record. Note that you can vertically select cells in this grid and delete several timepoints 
records at a time. 

Suppose that you have a 1:00 AM and a 3:00 AM timepoints that have associated with them 
hourly MW load data. If you insert a 2:00 AM data, the 2:00 AM cell of the MW load will 
appear empty. If you run a study, no data will be applied to the power system at 2:00 AM, but 
you will get a result (identical to the one of 1:00 AM). You need to fill the 2:00 AM cells with 
data in order for the values to be applied at that timepoint and obtain the correct results for 
2:00 AM. 
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New Timepoint Dialog 

  

The New Timepoint Dialog is used to define new timepoints. One or multiple timepoints can be 
defined at once. Use the date drop-down box to bring up a calendar for easy selection of the 
date. Note that the calendar has visual controls that allow you to navigate through months or 
years, which allows you to set the desired date easily. 

If this is the first timepoint you will insert in the list, then by default the dialog is populated 
with today’s date at 1:00 AM. If there are other points in the list, the default is one hour after 
the date time of the last time point.  

The other options in this dialog are: 

Date 

Use this control to select the date of the time point. You can use the visual controls or the 
up or down arrow keys to modify the date. 

Time 

Use the control to enter the hour, minute and AM/PM description of the time. Once you are 
positioned on the hour, minute or AM/PM values, you can use the up/down arrow buttons 
for easy selection without having to type. Note that the timepoints are specified with an 
accuracy of up to minutes. 

Total Number of Timepoints to Enter 

By default this field is set to one, meaning that you will enter only one timepoint with the 
specified date and time. If the value is more than one, several time points will be inserted in 
the list at the interval defined in the next two fields.  

New Timepoint Interval: Hours 

If the Total Number of Timepoints to Enter is more than one, this field is used to 
specify the hour(s) of the interval between each time point. Timepoints will be Hours + 
Minutes + Seconds apart. Default is one hour.  

New Timepoint Interval: Minutes 

If the Total Number of Timepoints to Enter is more than one, this field is used to 
specify the minute(s) of the interval between each time point. Timepoints will be Hours + 
Minutes + Seconds apart. Default is zero minutes. 

New Timepoint Interval: Seconds 

If the Total Number of Timepoints to Enter is more than one, this field is used to 
specify the second(s) of the interval between each time point. Timepoints will be Hours + 
Minutes + Seconds apart. Default is zero minutes. 
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Change Timepoint Time Dialog 

  

The Change Timepoint Time Dialog is used to modify the date time of a time point. Only one 
time point time can be changed at a time. If the new time assigned to the timepoint already 
exists, a warning message is generated asking to input a different date time. If the new date 
time does not exist, Simulator moves the time point to the correct position in the timepoint 
list.  

Date 

Use this control to select the date of the time point. Besides the visual controls, you can use 
the up or down arrow keys to modify the date. 

Time 

Use the control to enter the hour, minute, seconds and AM/PM description of the time. Once 
you are position on the hour, minute, seconds or AM/PM value, you can use the up/down 
buttons for easy selection without having to type. Note that the timepoints are specified with 
an accuracy of up to seconds.  
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TSB Case Description Page 

  

This page is used to describe the time series binary file (tsb file) for information purposes. 
Simulator shows also the Version Used to Store the TSB File and the Simulator Build 
Date.   

 



Time Step Simulation 

899 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Insert/Scale Column Dialog 

  

The Insert/Scale Column Dialog is called from the Input Page grids. These Matrix Grids are 
used to specify hourly input data for Load MW, Load Mvar, Generator MW, Generator 
Maximum MW and Area Total MW Load. Hourly data of each particular object is specified in 
columns. When no column has been added to the grid, the Insert/Scale Column Dialog allows 
you only to select the new object. On the other hand, when there are existing columns on the 
grid, the Dialog allows you to insert a New Column either alone or based on the values of 
the existing columns. This option is available because values such as hourly load MW data 
tend to experience similar fluctuations in time.  

Current Column: If there are exiting columns and the Insert/Scale Column Dialog is 
called from an hourly input data column, this field shows the position of that column. This field 
tells the user what column the New Column will be based on. 

Action:  

These options tell how the new column will be inserted.  

Scale Entire Current Column: This option is available only when the current column 
corresponds to an existing hourly data column. When applied, the new column takes the 
values of the current column scaled by the Scaling Factor.  

Scale Selected Rows of Current Column: The Time Step Simulation allows you to select 
a group of contiguous rows of a column and scale only those rows of the New Column.  

Insert New Column Derived From Current Column: This options copies the values of 
the Current Column to the New Column.  

Scaling Factor: Factor used to scale the new column. 

Load Scaling: These options are available only when inserting Load columns and are used 
to scale Real and Reactive Load, Just Real Load, or Just Reactive Load. 

New Columns: Use this selector to specify the ID of the object that will be added as new 
column to the grid.  

Selector: The bottom section of the dialog is a selector that allows you to specify one or 
multiple objects at a time and add columns for them by passing the objects from the left 
side to the right side. This selector has the following controls: 

Sort by Name: Check this option to sort the list of available objects by name 

Sort by Number: Check this option to sort the list of available objects by number 

Define Filter: Press this button to filter the list of available objects using an Advanced 
Filter. 

Use Area/Zone Filters: Check this box to filter the list of available objects using the 
Area/Zone filters. 

Search Next: By typing the start of the name of an object in the edit line, you can search 
the next object or all the objects available which match the search pattern. You can also use 
wildcards to search for objects.  

List of Objects: The objects in the list are selected by clicking on them. Multiple objects 
that are together can be selected by clicking the mouse while holding the SHIFT key. 
Multiple objects that are not contiguous in the list can be selected by clicking the mouse 
while holding the CONTROL key. 

Select Button: Press the blue arrow button to pass the selected objects on the left to the 
right.  
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Remove Button: Press the trash can button to remove the objects from the selected list 
on the right side. 

For more information about methods to specify hourly input data, please read the Loading 
Hourly Input Data section.  
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Loading Hourly Input Data 

  

The Time Step Simulation allows you to specify the operating conditions of your power system 
through input data. The input data can be of two types: 

Scheduled Data, which is specified for data that is not hourly by nature. To set up schedule 
data please read the Setting up Schedule Input Data section.  

Hourly Data, or more precisely time point-based data, is specified for each time point in the 
Input Pages. There are several ways to specify hourly input data: 
• By entering data manually on the Input Pages. 
• By deriving or scaling values from another column using the Insert/Scale Column Dialog. 
• By loading previously formatted data from Excel or .csv files through the Read Buttons in 

the Time Step Simulation Dialog. 
• By pasting data from Excel directly to the grid. A common way to do that is to: 

o Set up the desired timepoints and data columns on the grids of the Input Pages 
o Copy the template to Excel by selecting Copy on the Local Menu 
o Fill the Excel sheet with the appropriate data 
o Paste the data back to the data grid by selecting Paste on the Local Menu  
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Setting up Scheduled Input Data 

  

There area two types of input data for the Time Step Simulation: 

Hourly Data, which is described in the Loading Hourly Input Data section; and, 

Scheduled Data, which is specified for data that is not hourly by nature. In this section we 
describe how to specify this type of input data. 

Although it is possible to specify the operating conditions of a power system exclusively by 
hourly quantities, there are several quantities that are not hourly by nature, and whose hourly 
specification would be redundant and would require significant memory storage. Examples of 
such quantities are: 
• The status of a transmission line that is taken out of service on a particular date and time 

for maintenance.  
• The status of a generator, which follows a particular maintenance schedule. 
• A generator’s voltage set point that is different during the day or at night. 
• A scheduled transaction between to areas that has different MW set points applied at 10 

am, 4 pm and 10 pm. 
• A capacitor connection status for a Mvar block that is used only during the day. 
• An industrial load that operates at different levels for different shifts. 
• A peaker generating unit that operates only during certain hours of the day 

And many others. All these quantities can be specified by introducing the concept of 
Schedule. A schedule is a list of pairs (Date Time, Value), where the value can be 
numerical, conditional (Yes/No or Closed/Open) or text. The Schedule can have any number of 
time points and can be periodic. The schedule defines the "shape" of how a quantity varies in 
time. In order to define a schedule, go to the Schedules Page of the Input Page, and select 
Insert New Schedule to bring up the Schedule Dialog. Please follow this link for a detailed 
explanation on how to define a schedule.  

Once a schedule has been created, we can assign an object field, such as the status of a 
transmission line or the MW output of a generator to the schedule by means of a Schedule 
Subscription. The object field will follow the schedule "shape" in time. The use of Schedule 
and Schedule Subscription objects gives us great flexibility in specifying how quantities should 
vary. In particular, it is possible to assign many fields to the same schedule. In order to define 
a Schedule Subscription, go to the Sched Subscriptions Page of the Input Page, and 
select Insert New Subscription to bring up the Sched Subscription Dialog. In this dialog you 
will encounter a detail explanation of the Schedule Subscription use and capabilities.  

An important feature of the Schedules is that their date times don’t need to match the date 
times of the list of timepoints (time points listed in the Hourly Summary Page). Suppose that 
your list of time points are defined hourly for the next day: 1am, 2am, etc. up to 11pm. You 
can schedule a particular action to take place at 2:35 am and see the results of that action in 
the next time point, i.e., 3 am. A special logic takes care of applying scheduled action at 
appropriate time points asynchronously.  
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Schedule Dialog 

  

The Schedule Dialog is called from the Schedules Page and is used to define a schedule. A 
schedule is a list of time points together with a numeric, conditional (Yes/No or Closed/Open) 
or text value that defines the "shape" of how a quantity should vary in time. The timepoints 
are listed on the grid section of the dialog. The Schedule Dialog also contains a number of 
options that define the schedule.  

When a schedule is created, the time step Simulation inserts by default four timepoints for the 
current date with a numeric value of zero in every point. You can then change the date and 
times of the schedule timepoints and specify different values.  

  

Schedule Dialog Local Menu Actions 

The Schedule Dialog grid, as any other Simulator Grid has a Local Menu that is accessed by 
right-clicking on any cell. The most important options of this dialog are: 

Insert New Point(s): Select this option to bring up the New Schedule Point Dialog. This 
is the same New Time Point Dialog but is used here to insert Schedule timepoints.  

Change Time(s): Select this option if you want to change the date time of a schedule 
timepoint. The selection brings up the Change Time Dialog, which is the same Change 
Timepoint Time Dialog used here to change the date time of a schedule time point.  

Delete: Use this option to delete the current schedule time point 

Select Column(s): Use this option to select an entire column. Note that you can use this 
option and then delete all the timepoints.  

Copy: Use this option to copy the values in the Schedule grid to the clipboard. If you are 
using Excel, you can modify the values and then Paste back the new schedule points into 
Simulator.  

  

Timepoint List Options 

These options provide shortcuts to some of the Local Menu actions related to the 
maintenance of the list of Schedule time points: 
Add Point: Adds a new timepoints at the end of the list. By default the date time of the new 
timepoint is one hour after the last time point. If there are no timepoints in the list, a 
timepoint is inserted with today’s data at 1:00 AM. 

Delete Point: Deletes the selected timepoint(s). 

Shift Date Time Buttons: Use these buttons to move by one week, day, hour, minute or 
second the date time of the selected time point.  

  

Schedule Options 

The upper part of the Schedule Dialog is used to define other Schedule Options: 

Schedule Name: Enter here the name you want to give to the schedule. This is how you will 
identify the schedule when you set up schedule subscriptions. If the user does not specify 
otherwise, Simulator assigns names Sched1, Shced2, etc. as new schedules are created.  

Name Suffix: This is a string automatically generated by Simulator, which is used to display 
the main characteristics of the Schedule together with the name. The Name Suffix is 
composed of three strings separated by points: 

[Num, Y/N or Txt]: Indicates whether the schedule values are numeric, conditional or text.  
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[NPER or PERxdyh]: The string indicates whether the schedule is non-periodic (NPER) or 
periodic (PER). If it is periodic, it indicates the days (x) and hours (y) of the period. 

[Nn]: Indicates the number of timepoints (n) of the Schedule.  

By looking at the Schedule suffix, the user effective avoids writing long names for the 
Schedule to characterize its properties.  

Value Type: Numeric, conditional (Yes/No or Closed/Open) or Text. When you toggle this 
selection, the value column in the Schedule grid changes its heading from Numerical Value to 
Yes/No value to Text Value, and the numerical cells (blue) are changed to Yes/No cells 
(green), indicating that you can toggle the cell value, to blank for Text Value. Note that 
numeric fields, such as Load MW, Schedule Transactions MW etc, will subscribe to a Numeric 
Schedule, whereas fields such as Line Status will subscribe to a Yes/No Schedule. Text 
schedules can be subscribed to custom string and memo fields. For more details on Schedule 
Subscriptions, please read the Sched Subscriptions Dialog.  
  

Periodic Options 

A schedule becomes periodic when its values are repeated every certain period specified in 
days, hours, minutes and/or seconds. A logic condition for a schedule to be periodic is that its 
period be larger than the time span between the date time of the last time point and the first 
time point in the schedule. For instance, if the schedule has three time points at 1 am, 2 am 
and 4 am, the span is 3 hours. Thus the schedule period must be 4 hours or more. If this 
condition does not hold, Simulator issues a warning message.  

Repeat Every: Check this box to make the schedule periodic. The schedule must have a total 
period greater than 0 to be considered periodic. The schedule period is the number of days 
plus the number of hours specified. 

Days: A positive integer that specifies the number of days of the schedule period. 

Hours: A positive integer from 0 to 23 that specifies the number of hours of the schedule 
period.  

Minutes: A positive integer from 0 to 59 that specifies the number of minutes of the 
scheduled period. 

Seconds: A positive integer from 0 to 59 that specifies the number of seconds of the 
scheduled period. 

Valid From: When checked, this option sets a validity date for the schedule, whether it is 
periodic or not. No schedule actions will be applied to the power system before this date. By 
default, the Valid From date is set to Jan 01, 2000, at 12:00 am. 

Valid Until: When checked, this option sets a validity date for the schedule, whether it is 
periodic or not. No schedule actions will be applied to the power system after this date. By 
default, the Valid Until date is set to Dec 31, 2030, at 12:00 am. 
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Schedules Page 

  

The Schedules Page is used to display all the defined schedules and their properties. The 
most relevant options of Local Menu of this page are: 

Schedules Page Local Menu Actions 

Insert New Schedule: This option is used to define a new schedule through the Schedule 
Dialog 

Delete: Use this option to delete the current Schedule. 

Show Dialog: Select this option to bring up the Schedule Dialog with the information of the 
current Schedule. 
  

Schedule Page Fields 

The Schedules Page shows the following information about schedules: 

Name: Schedule Name 

Suffix: Schedule Suffix. For a description on how the suffix is created, please see the 
Schedule Dialog section.  

Periodic: Whether the schedule acts as periodic or not. 

Period Days: Number of days in the schedule period. 

Period Hours: Number of hours in the schedule period.  

Period Seconds: Number of seconds in the schedule period. 

Valid From: Whether a start validity date is used for the schedule. 

Period Start Date: Start validity date. 

Period Start Hour: Start validity time 

Valid Until: Whether an end validity date is used for the schedule 

Period End Date: End validity date 

Period End Hour: End validity time 
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Schedule Subscription Dialog 

  

This dialog is used to define and display the options of a Schedule Subscription. Schedule 
Subscriptions tell the Time Step Simulation that a specific object field (Gen MW, Line Status, 
Scheduled Transaction MW, etc) should vary according to the "shape" specified in a Schedule.  

Simulator objects have a large number of fields, which can be classified as numeric, Boolean, 
or text. Numeric fields, whether integer or real, can subscribe to Numeric Schedules, Boolean 
fields can subscribe to Yes/No Schedules, and text fields can subscribe to text schedules. Thus 
a condition for a field to subscribe to a schedule is that a schedule of its type be already 
defined.  
 The Dialog includes the following options:  

Active: Indicates that the schedule subscription is active. If this box is not checked, the 
schedule subscription is defined, but no schedule action will be applied to the power system.  

Object Type: Use this selector to specify the object type that you want to subscribe to a 
schedule. Currently, Simulator supports Generators, Loads, Line/Transformers, Shunts, Areas, 
Zones and Transactions. When you select an Object Type, three things happen: 
• The Object ID list is populated with the elements of the object type present in the power 

flow case and the first element is displayed by default.  
• The Field selector is populated with the enterable fields corresponding to that particular 

Object Type and the first field is displayed by default.  
• The type of the first field (Numeric, Yes/No or text) is identified and the Schedule 

selector is populated with the existing schedules of that type. 

Object ID: Use this selector to specify the particular object of a particular Object Type 
whose field you want to subscribe to a schedule. The Object ID has above it a string that 
indicates how the ID of the object is built depending on the Object Type. For instance, when 
the Object Type is Generator, the Object ID is specified as the Bus Number and then the 
Gen ID.  

Select/View Objects: Press this button to bring up the Add Schedule Subscribers Dialog. 
This dialog is used to select multiple objects of the specified type, for which a field will 
subscribe to the schedule. When multiple objects are selected, the Object ID indicates 
"Multiple Objects" followed by the number of objects that will be selected. If there are objects 
whose fields are subscribed to a schedule, these objects will appear in the right side selection 
list, because they are currently subscribing to the schedule.  

Field: Use this selector to indicate the particular Field that you want to subscribe to a 
schedule. Depending on the type, the Dialog indicates whether the Field should subscribe to a 
Numeric, Yes/No, or text schedule. Once you have selected the Field, the Schedule selector 
is populated only with the schedules of that particular type. 

Schedule: Use this selector to specify the schedule to which the Field should be subscribed 
to.  

Time Shift: The time shift options can be used to delay applying the scheduled actions by the 
specified Delay Days, Delay Hours, Delay Minutes, or Delay Seconds. For instance, 
suppose that you have setup a schedule so that a new 100MW generating unit enters online 
on March 10th. The entering schedule is complex and consists of increasing the output in steps 
of 20MW each hour starting at 10 am. Suppose that due to unexpected events, the connection 
of the unit must be put off by two days. Instead of modifying the entire schedule, you could 
set a 2 day (positive) delay so that the unit enters online on March 12th at 10 am.  

Subscription Type: In addition to the time shift, the value "shape" defined by a numeric 
schedule can be altered by making the subscription Relative.  
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Absolute: Select this option so that the field takes the exact value specified in the 
schedule. 

Relative: The numeric values of the schedule can be altered by a Multiplier and a Value 
Shift. In this linear modification, the value of the field that is applied to the power system 
will be equal to:  

Actual Field Value = Multiplier * Schedule Value + Value Shift 
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Schedule Subscriptions Page 

  

The Schedule Subscriptions Page of the Input Pages is used to display all the schedule 
subscriptions and their properties.  

Schedule Subscriptions Page Local Menu Actions 

Insert New Subscription: Use this option to define a new subscription through the 
Schedule Subscription Dialog 

Delete: This option deletes the current Subscription. 

Show Dialog: This option brings up the Schedule Subscription Dialog with the information of 
the current Schedule Subscription.  
  

Schedule Subscriptions Page Fields 

The Schedule Subscriptions Page shows the following information: 

Object: Object Type: Generator, Load, Line/Transformer, Shunts, Areas, Transactions 

Object IDs: Are explained in the following Table: 
  

Object Type Object ID1 
(Numeric) 

Object ID2 
Numeric 

Object ID3 
String[2] 

Generator Bus Number   Gen ID 

Load Bus Number   Load ID 

Line/Transformer From Bus Number To Bus Number Circuit ID 

Shunt Bus Number   Shunt ID 

Area Area Number     

Transaction From Area Number To Area Number ID 
  

Object Field: Field that subscribes to the schedule 

Schedule Name: Name part of the schedule 

Suffix: Suffix part of the Schedule Name 

Active: If not active, then the schedule values are not applied to the power system 

Relative: If not relative the field takes the exact schedule values. If relative the schedule 
takes the value of the schedule scaled by a multiplied and added a Value Shift.  

Multiplier: Scaling factor used when the subscription is Relative. 

Value Shift: Shift value used when the subscription is Relative.  

Delay/Advance?: Indicates if the schedule should be delayed or advanced to a new point 
indicated by the shift values.  

Day Shift: Number of days of the schedule time delay  

Hour Shift: Number of hours of the schedule time delay 

Minute Shift: Number of minutes of the schedule time delay 

Second Shift: Number of seconds of the schedule time delay 
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Running a Timed Simulation 

  

The Timed  Simulation is set up in the Options Page  Time Step Simulation Options 
subsection.  

By default, the Do Run button of the Time Step Simulation Dialog will run a Continuous 
Simulation, i.e., a simulation in which each time point is solved immediately after the 
previous time point. In this case the purpose of the Simulation is to obtain solution for the 
time points as fast as possible. As the solution progresses, the results for each hour in every 
hourly grid are refreshed, showing the user the evolution of the Simulation. Please read the 
Time Step Simulation Quick Start section for a quick introduction on how to run a Continuous 
Simulation.  

On the other hand, the Time Step Simulation tool can also be used to run a Timed 
Simulation. In this case, the Simulation takes place according to a time scale proportional to 
the date times of the time points. When you click the Do Run Button, the Simulation 
progresses as if it was running in actual time. The simulation can also be paused and reset at 
any time by using the Pause and Reset Buttons of the Time Step Simulation Dialog.  

The following are some of the things you can do with the Timed Simulation: 
• You can hide the Time Step Simulation Dialog and control the simulation by using the 

Time Step Simulation Toolbar, which contains buttons such as Do Run, Pause, Reset, 
etc. which mimic the control buttons of the Dialog. 

• You can visualize how the quantities vary proportionally to actual time after each time step 
is applied. Recall that the Time Scale defined in the Options Page indicates the 
relationship between the actual time and the time scale defined for the time points in 
Seconds per Hour. Thus a Time Scale value of 60 will indicate that one hour of time span 
between two time points will occur in 60 seconds of actual time in the Timed 
Simulation.  

• You can also animate the flows of the solution of a time point while you wait for the 
solution of the next one.  

• You can contour the online diagrams. And see how the visualization changes as the 
quantities vary in time, and in addition, you can save those contour diagrams as JPEG or 
bitmaps for each timepoint.  

• Finally, you can act on the system (by closing capacitors, changing generator outputs, etc) 
before the next time point is applied simulate operating actions in response to system 
conditions.  

All these actions can be combined in outstanding presentations to your colleagues or clients on 
how the system would evolve in time across different scenarios.  
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Running OPF and SCOPF Time Step Simulations 

  

Besides obtaining hourly power flow solutions for multiple time points, users that own the OPF 
and the SCOPF add-ons can obtain hourly optimal power flow and security-constrained optimal 
solutions. In the Hourly Summary Page, you can specify the following solution types: 
• Power Flow  
• Unconstrained Optimal Power Flow, which is equivalent to Economic Dispatch 
• Optimal Power Flow (OPF) 
• Security-Constrained Optimal Power Flow.  

Note that different timepoints can be solved by any of the previously listed solution methods in 
the same Time Step Simulation. However, the solution settings of the previous timepoints 
are used as initial conditions for the solution of the next time point.  

Simulator OPF and SCOPF tools are among the most advanced optimization packages for 
power systems. They have been extended in the latest versions of Simulator with many 
features, and have become complex analysis system. We recommend the user unfamiliar with 
OPF/SCOPF solutions to read the sections on Optimal Power Flow and Security-Constrained 
Optimal Power Flow before setting up OPF/SCOPF Time Step Simulations. 

  

Power Flow Time Step Simulation 

The hourly power flow simulation allows the user to obtain AC or DC power flow solutions for 
a set of timepoints. During the Time Step Simulation all the power flow options defined in the 
Simulator Options page as well as in other dialogs are used for the solution. A key concept of 
the Time Step Simulation is that if you select Solve Time Point from the Hourly Summary 
Page or from the grids of the Input Page, you would obtain the same solution that if you 
would hit the Single Solution Button. This is true, when the input data does not contain 
schedule data but only hourly input data. If your Simulation contains schedule data, there may 
have been scheduled actions that were applied in previous timepoints that are not being 
applied when you select the Solve Time Point option. 

The power flow solution will observe all the power balance constraints, control limits and area 
interchange constrained defined in the power flow settings.  

  

Unconstrained OPF Time Step Simulation 

In the unconstrained OPF solution, the Time Step Simulation removes all the constraints that 
would normally act in the OPF and optimizes the system to find the minimum operating cost 
settings. In doing so, Simulator will change the set points of the specified controls (generators 
and phase shifters) to minimize the cost of all Areas and Superareas set to OPF AGC control.  

Besides the power flow solution options, the Unconstrained OPF simulation will take all the 
options that have been defined for a regular OPF solution. Most of these options are defined in 
the OPF-Options Dialog, which is accessed using the OPF Options and Results button on 
the Add Ons Ribbon tab. All the settings such as objective function, cost of unenforceable 
constraints, control available, prices for controls, etc are defined in this dialog. Other options 
are defined for each particular object such as generators, loads, areas, lines, interfaces, etc. 

  

OPF Time Step Simulation 

When using the OPF solution type, the Time Step Simulation applies the hourly and schedule 
input data and optimizes the control areas set to OPF to minimize cost while enforcing normal 
operation constraints: transmission line thermal limits, interface limits, generator control limits, 
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and load control limits. In doing so, the OPF algorithm detects the controls that need to be 
moved, the constraints that are binding at the solution point, and the unenforceable 
constraints, i.e., constraints that cannot be enforced with the available controls. 

Some of the quantities that are of interest in the solution of the OPF algorithm are: 
• Unconstrained Generator MW Output. Displayed in the Hourly Unconstraint Gen MW 

page of the Input Page 
• Final generator MW Output: Optimal generator output at the solution points, displayed 

in the Hourly Final Generator MW Page 
• Change in Generator MW: Difference between the unconstrained and constrained 

generator optimum settings, displayed in the Hourly Delta Gen MW Page.  
• Locational Marginal Prices: These are displayed in the Hourly Final Bus LMP Page. 

Average LMP prices and other LMP metrics are also displayed in the Results Page for 
Areas, Injection Groups, Super Areas, and Zones.  

• Binding Constraints as well as Marginal Cost of Limit Enforcement for lines and 
interfaces. These fields can be seen in the Results: Constraints Page and in the Results 
Page for Lines, Transformers, and Interfaces.  

• Unconstrained, Final and Congestion Cost, displayed in the Results Summary Page 
for the entire system. These costs are also displayed for displayed for Areas, Owners, 
Superareas and Zones in the Results Page. 

• LMP Profit for Generators, Owners, and Zones are displayed in the corresponding grids 
of the Results Page. 

  

SCOPF Time Step Simulation 

The SCOPF combines the power of Simulator’s OPF with the Contingency Analysis Tool to 
optimize a system for minimum cost while enforcing both normal operation and contingency 
constraints. At each time point, the SCOPF solution provides the optimal operation of the 
system so that if contingencies occur they would not create security violations. The locational 
marginal prices created in this manner are security-constrained signals to the market.  

The solution of SCOPF Time Step Simulation depends on the options that have been set up for 
the following tools: 
• Power Flow 
• Optimal Power Flow 
• Contingency Analysis  
• Security Constrained Optimal Power Flow 
• Time Domain OPF Options 

The SCOPF Time Step Simulation does the following for each timepoint: 
• Applies the hourly input data to the power system 
• Applies scheduled actions determined by the schedule input data. 
• Solves a power flow 
• If specified, solves an unconstrained optimal power flow (economic dispatch) 
• Initializes the base case of the security constrained OPF by solving a power flow or an OPF 
• For the initialization system conditions, solves the list of contingencies 
• Solves the SCOPF optimization problem: minimizes operating cost while enforcing normal 

and contingent constraints.  
• Displays the results in all the result grids.  

The SCOPF is on its own a complex computation that often requires significant computer 
resources. This is due mostly to the solution of the list of contingencies and the calculation of 
their sensitivities. The size of the problem can be dimensioned by: 
• Size of the system, given by the number of buses and the areas to be optimized. This is 

difficult to reduce since the optimization problem is normally defined for a certain region.  
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• Number of contingencies, which can be reduced by developing a contingency screening 
using peak loading conditions.  

• Number of constraints (monitored elements), which can be reduced by selecting critical 
element, e.g. interfaces and higher voltage transmission lines. 

• Number of timepoints in the list.  

Another mechanism to speed up the computation of the PF/OPF/SCOPF Time Step Simulation 
is to use DC solutions in some of the internal routines: 
• AC or DC power flow 
• AC or DC contingency analysis. This one will produce the larger time savings.  
• AC or DC SCOPF 
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Storing Input Data and Results 

  

In large cases, the amount of data that can be potentially generated by a Time Step 
Simulation in significant since basically a full PF/OPF/SCOPF solution is available for each hour. 
A convenient method to store large amounts of data is to save the data in a binary file. The 
input data, both hourly and scheduled data, as well as the results can be stored in a Time 
Series Binary File, referred to in this help guide as the .tsb file.  

Here is a summary of what will be stored in the .tsb file when you click the Save Data 
Binary button in the Time Step Simulation Dialog: 
• All hourly input data, defined in the Input Pages for hourly Load MW, Load Mvar, 

Generator MW, Generator Maximum MW, Area Total MW Load and Hourly Line Status.  
• All scheduled input data, defined by the combination of Schedules and Schedule 

Subscriptions specified in the corresponding Input Pages.  
• The values displayed on the grids of the Results: Constraints Page for hourly Binding 

Lines, Binding Interfaces, Binding Contingencies, and the Binding Line Matrix and List.  
• The customization settings defined in the pages of the Custom Results Selection Dialog for 

the hourly results of Areas, Buses, Generators, Injection Groups, Interfaces, Lines, Owner, 
Superareas, Transformers, and Zones.  

• The customized results in the pages of the Results Page for hourly field values of Areas, 
Buses, Generators, Injection Groups, Interfaces, Lines, Owner, Superareas, Transformers, 
and Zones. Recall that many fields can be defined for each type of object.  

• The options defined in the Options Page, except the options set up in the Auto Load TSB 
File Options, which are saved with the .pwb case. 

• The data of the last solution run contained in the Hourly Summary Page: Skip, Processed 
and Solved fields. 

• The .tsb file description 
  

Note: Recall that the data of any Simulator grid can be copied to the clipboard and to Excel 
by selecting the options on the grid Local Menu.  
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Chapter 13: PowerWorld Simulator Add-On Tools 

  

This chapter contains information on the tools available for purchase for adding additional 
functionality to the Simulator base package. 
• Voltage Adequacy and Stability Tool (PVQV) 
• Optimal Power Flow (OPF) 
• Security Constrained Optimal Power Flow (SCOPF) 
• Available Transfer Capability Analysis (ATC) 
• Simulator Automation Server (SIMAUTO) 
• Simulator Automation Server (SIMAUTO) for Simulator version 9 
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Introduction to Simulator Add-On Tools 

  

In addition to the features of the base Simulator package, various add-on tools are available. 
A brief introduction to each follows:  

Voltage Adequacy and Stability Tool (PVQV) 

The purpose of the PVQV add-on is to allow the user to analyze the voltage stability 
characteristics of a system. After the PVQV simulation is complete, the user can graph various 
system parameters. For more information, see the PVQV Overview. 

Optimal Power Flow Tool (OPF) 

The purpose of an OPF is to minimize an objective (or cost) function . In Simulator OPF the 
Linear Programming OPF algorithm (LP OPF) determines the optimal solution by iterating 
between solving a standard power flow and solving a linear program to change the system 
controls thereby removing any limit violations. For more information see the OPF Overview. 

Security Constrained Optimal Power Flow Tool (SCOPF) 
The OPF tool minimizes an objective function (usually total operation cost) by changing 
different system controls while meeting power balance constraints and enforcing base case 
operating limits. The SCOPF tool takes it one step further by considering contingencies that 
may arise during system operation and ensuring that in addition to minimizing the objective 
function, no unmanageable contingency violations occur. For more information see the SCOPF 
Overview. 

Available Transfer Capability Analysis Tool (ATC) 
ATC analysis determines the maximum MW transfer possible between two parts of a power 
system without violating any limits. For more information see the ATC Analysis Overview. 

Transient Stability (TS) 
Transient Stability analysis allows the analysis of system dynamic response to a fault on the 
system. The Transient Stability module has not yet been released with version 13. 

PowerWorld Simulator Automation Server (SimAuto) 

SimAuto provides PowerWorld customers the ability to access PowerWorld Simulator 
functionality within a program written externally by the user. The Simulator Automation Server 
acts as a COM object, which can be accessed from various programming languages that have 
COM compatibility. Examples of programming tools with COM compatibility are Borland® 
Delphi, Microsoft® Visual C++, Microsoft® Visual Basic, and Matlab® (among others). For 
more information on SimAuto, see the SimAuto Overview. 
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PowerWorld Simulator PV/QV Overview 

  

The PVQV tool is only available if you have purchased the PVQV add-on to the base 
Simulator package. Contact PowerWorld Corporation for details about ordering the 
PVQV version of Simulator. 
PVQV, PowerWorld's voltage adequacy and stability assessment tool, is used to analyze the 
voltage characteristics of a power system. 

PowerWorld Corporation also offers Optimal Power Flow (OPF), Available Transfer Capability 
ATC, Simulation Automation Server (SimAuto), and Security Constrained Optimal Power Flow 
(SCOPF) add-ons. For more information see . 
  

The PowerWorld Simulator (Simulator) is an interactive power system simulation package 
designed to simulate high voltage power system operation. In the base package, Simulator 
solves the power flow equations using a Newton-Raphson power flow algorithm. However, 
with the voltage adequacy and stability tool (PVQV) add-on the user can solve multiple power 
flow solutions in order to generate a PV curve for a particular transfer or a QV curve at a given 
bus. 

The PVQV functionality is accessed using the PVQV main menu item. The commands available 
from this menu are Refine Model, PV Curves, and QV Curves. 

The purpose of the PVQV add-on is to allow the user to monitor any system parameter while 
automatically increasing a user-defined transfer. The PVQV module uses the Simulator built-in 
Newton Raphson power flow algorithm to accomplish this task. After the PVQV simulation is 
completed, the user can choose to graph any of the Monitored system parameters, designated 
in Quantities to Track. 
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PV/QV PV Curves 

  

The voltage stability function of Simulator provides the ability to compute PV curves for any 
bus in the system. Select  PV Curves on the Add Ons ribbon group to open the PV Curve 
dialog. The PV Curve dialog allows you to specify the elements to be tracked, set defaults for 
the PV curves, and run the PV analysis. 
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PV/QV PV Curve Dialog 

  

To display this dialog, go to the Add Ons ribbon tab and select PV Curves from the PVQV 
ribbon group. 

The integrated PV / QV PV dialog contains all of the setup and controls for processing and 
analyzing the PV and QV curve analysis. The dialog is broken down into several pages: 

Setup 

Quantities to track 

Limit violations 

PV output 

QV setup 

PV results 
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PV/QV Setup 

  

The first step in the setup process is to define the source and the sink for the study 
transaction. The PV/QV tool expects the source and the sink to be injection groups defined by 
the user. If injection groups have been previously created, they can be selected by clicking on 
the drop-down list arrow of the Source and Sink boxes. If the injection groups have not been 
previously defined in the current case, they can be created by clicking the View / Define 
Groups button, right-clicking on the resulting list display, and choosing Insert from the 
popup menu. Alternatively, if a list of injection groups has been previously saved in a 
Simulator Auxiliary file, they can be loaded into the current case by again clicking the View / 
Define Groups button, right-clicking on the injection group list display, and choosing Load > 
Auxiliary File from the popup menu. 

Once the source and sink points have been defined, the PV study will model an increasing 
transfer of power from these source points to the sink points. The transfer process is 
performed incrementally, based upon user specified options on how the transfer should vary 
during the solution process. 

Note that options can be saved to or loaded from an auxiliary file using the Save options and 
Load options buttons, located at the bottom of the display. 

Manage contingency list 

Clicking this button will open the contingency analysis dialog for managing or inserting 
contingencies to be processed during the PV/QV analysis. Contingencies defined and marked 
for processing in the contingency analysis dialog will be included. 

To globally omit the inclusion of contingencies during the PV/QV analysis, check the box 
labeled Skip Contingencies. 

Base Case Solution Options 

Clicking this button will open the Simulator Options Dialog, allowing the customization of the 
solution options prior to processing the PV/QV analysis. 

Run base case to completion 

Check this box if you wish to find the critical transfer point of the base case condition, in 
addition to the specified number of critical cases for the defined contingency scenarios. By 
default, the PV analysis will process until the number of critical cases (or scenarios) as 
specified on the PV Results page have been found, and will halt the process at that point. If 
the base case transfer scenario is not one of the critical cases, then checking this option 
indicates that you want the PV analysis to continue incrementing transfers for the base case 
condition to find the critical point of the base case, IN ADDITION to the number of critical 
cases specified. 

  

The remainder of the setup options are found under the PV/QV Options to Control the 
Transfer Increase. 
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PV/QV Options to Control the Transfer Increase 

  

These options are located on the Setup tab of the PV Study Form. 
  

Source 

Use this dropdown box to identify the source injection group. To model an increase in 
transfer, generator points in the source injection group will increase their output, and load 
points will decrease their magnitude in amounts proportional to their participation factors.  

Sink 

Use this dropdown box to identify the sink injection group. To model an increase in transfer, 
generator points in the sink injection group will decrease their output, and load points will 
increase their magnitude in amounts proportional to their participation factors. 

Initial Step Size (MW) 

This option indicates the initial rate at which the transfer will be increased following each 
successful iteration. The default value is 100 MW. This tells Simulator to begin studying the 
transaction in 100 MW increments. 

Minimum Step Size (MW) 

Whenever Simulator fails to solve the system at a given transfer level, it will return to the 
previously solved transfer level, reduce the step size by specified factor, and then try to 
solve the system with the transfer incremented by the newly reduced step size. The 
Minimum Step Size option specifies the minimum size this increment can be. Once the 
system fails to solve when the step size is at this value, Simulator will conclude that we have 
come very close to the voltage collapse point and terminate the analysis. So, the minimum 
step size essentially functions as a tolerance for computing the voltage collapse point. The 
default value is 10 MW. 

When convergence fails, reduce step by a factor of… 

Whenever Simulator fails to solve the system at a given transfer level, it will reduce the 
transfer step size by the value specified for this option. The default value is 2. Therefore, 
Simulator will start incrementing the transfer in 100 MW steps. When it reaches a transfer 
level that it cannot solve, it will return to the last solved transfer level, reduce the step size 
to 50 MW, increment the transfer by 50 MW, and attempt to solve the case again. The next 
time it fails to solve, it will reduce the step size to 25 MW, and then to 12.5 MW, and finally 
to 6.25 MW. Since 6.25 MW is less than the Minimum Step Size value of 10 MW, it will 
instead use a final step size of 10 MW. Once the system fails to converge with this step size, 
the analysis will terminate, since it will conclude that it has arrived at the voltage collapse 
point, within the specified tolerance. 

Stop when transfer exceeds 

Provide a MW transfer limit between the source and the sink. When the PV analysis reaches 
a transfer amount equal to this value, the PV analysis will terminate. 

How should reactive power load change as real power load is ramped? 

This option controls how reactive load should vary as real load is changed during the 
analysis. Selecting Maintain the MW/MVAR ratio at each load will maintain the same 
ratio of real to reactive power load prior to starting the analysis. Selecting Maintain the 
MW/MVAR ratio at each load, but then scale MVAR by a factor of will maintain the 
same ratio of real to reactive power load prior to starting the analysis but will then scale the 
Mvar load by the specified factor. To change the reactive load by a specified power factor, 
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select As MW changes, change the MVAR at a power factor of and enter the power 
factor.  

Proportions for load components 

When the option to Vary Active Load Components by Proportion is checked, the 
proportions for constant power, constant current, and constant impedance loads can be 
specified for both the source and the sink. The total load change is then distributed among 
the components based on their specified proportion.  

Allow only AGC units to vary 

Control areas in Simulator may practice some type of automatic generation control. When an 
area is on AGC control, all generators in the area that are, in fact, AGC-able will participate 
in the area's automatic generation control program. Thus, Simulator distinguishes individual 
generating units according to whether they do or do not participate in their area's AGC 
effort. By checking this option, Simulator will allow only those generators that are eligible to 
participate in AGC to contribute to the power transfer being studied. Otherwise, all units in 
the injection groups will be allowed to participate regardless of their AGC status. 

Enforce unit MW limits 

If this option is checked, the output of any participating generating unit will be kept within 
its designed operating range of MinMW < Output < MaxMW. When a unit is pegged at one 
of its limits, participation factors of the other points in the limited generator's injection group 
will be adjusted to pick up the difference.  

Do not allow negative loads 

This is the analog of the previous option for loads. If a load is used as a source point, it will 
be decreased to make power available for the transfer. Checking this option will instruct 
Simulator to keep loads from falling below 0 MW. If a particular load is capped at 0 MW, 
participation factors for the remaining points in its injection group will be recalculated to 
make up the difference. This option is irrelevant if loads are not being used as source points. 

Dispatch generators in merit order 

When choosing to dispatch in merit order, injection groups with generators will be 
dispatched by moving individual generators to their maximum/minimum outputs in 
succession based on their relative participation factors. 

Skip contingencies 

The PV Curve tool computes PV curves for both the base topology and for any contingencies 
that have been defined, unless the Skip contingencies checkbox is checked. If the Skip 
contingencies checkbox is checked, a PV curve will be computed only for the model in its 
present topology. 

Manage contingency list… 

Click the Manage contingency list… button to open the contingency analysis dialog. This 
will enable the creation, modification, and removal of contingencies from the list of 
configurations the PV curve tool will process. 

Run base case to completion 

The PV curve tool is designed to ramp a transfer until the prescribed number of unsolvable 
cases, including both unsolvable contingencies and an unsolvable base topology, have been 
found. If the requested number of unsolvable cases have all been identified as being 
associated with contingencies, the tool will not reveal how much a transfer can be ramped 
for the base topology, unless the Run base case to completion checkbox is checked. 
Checking this checkbox forces the tool to continue to ramp the transfer until the base case 
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can no longer be solved, regardless of whether the requested number of unsolvable transfer 
level / topology combinations have been found. 

Base Case Solution Options … 

Click this button to bring up the Simulator Options Dialog. This allows the specification of 
the solution options to use for solving pre-contingency cases. 
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PV/QV Quantities to Track 

  

This section of the PV/QV dialog allows the definition of quantities to monitor (store) as the 
transfer is increased. Any unselected system parameters will not be saved. The Quantities to 
Track page contains several sub-tabs that allow the monitoring of different types of objects 
including: buses, generators, injection groups, lines, transformers, shunts and interfaces. 
There is also a sub-tab for monitoring Devices at Limits.  
  

Buses 

For buses, the following can be monitored during the PV analysis: voltages, angles, MW 
load, Mvar load, shunts, the sensitivity of the voltage to changes in reactive power (dV/dQ), 
and the sensitivity of voltage changes to the transfer (VP Sensitivity). In addition, whether 
or not a QV curve should be generated for the bus can be specified. The default value of all 
bus quantities is NO, indicating that the analysis will not monitor any bus-related quantities. 
To monitor a particular quantity, double-click the corresponding value to toggle it to YES. 

Generators 

For generators, the following can be monitored: MW output, Mvar output, and Mvar reserve. 
The display operates exactly like the bus display.  

Groups 

The Groups sub-tab allows the monitoring of the total generator MW and Mvar for the 
group, the total load MW and MVAR, and the Mvar reserve for the group. This display 
operates like the bus display. 

Lines 

Note: all branches (whether transmission lines or transformers) appear on the Lines sub-
tab. The Lines sub-tab allows the monitoring of real, reactive, and MVA flow (in either the 
FROM-TO or the TO-FROM direction), the MW and Mvar losses, and the PTDF value on any 
branch. For the flow fields, double-clicking on a particular entry will toggle its value from NO 
to FROM-TO, and double-clicking again will toggle its value to TO-FROM. Double-clicking the 
losses or PTDF value field will toggle the value between YES and NO. If the branch contains 
a transformer, the XFMR Tap can also be monitored. 

Transformers 

Note: all branches (whether transmission lines or transformers) appear on the Lines sub-
tab. See Lines above for setting up common branch quantities. For branches containing 
transformers, the Transformers sub-tab is used to set the transformer type (Fixed, LTC, 
Mvar or Phase) and set monitoring for Regulated Value, Tap Position and Regulation Error. 
If no transformers exist in the case, this option cannot be used. 

Shunts 

The Shunts sub-tab allows the monitoring of Actual and Nominal Real(P) and Reactive(Q) 
Power, as well as the Regulation Error and Regulated Value. Double-click the value fields to 
toggle between YES and NO. If no shunts exist in the case, this option cannot be used. 

Interfaces 

Simulator allows the definition of groups of branches that together comprise an Interface. 
The Interfaces sub-tab allows the monitoring of real, reactive, and MVA flow, the MW and 
Mvar losses, and the PTDF value on any interface that has been defined. This option cannot 
be used if no interfaces have been defined. 

Devices at Limits 
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The Devices at Limits sub-tab allows the selection of various options to track devices that 
hit or back off limits during the PV analysis. Generators and switched shunts at var limits, 
LTC transformers at tap limits, and lines and interfaces at thermal limits can all be tracked. 
To track the limits of any of these devices, check the appropriate checkbox. Next to each 
checkbox there is a dropdown box for selecting an advanced filter to apply to the tracking. A 
new filter can be defined for a particular device by clicking the Define button next to that 
device. The filter will limit the number of devices that get tracked. It is a good idea to define 
a filter for tracking devices so that all elements in the case will not be tracked. Keep in mind 
that tracking any quantities will take up space in the computer memory. If too many devices 
are tracked, it is possible to run out of memory.  

 



PowerWorld Simulator Add-On Tools 

925 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

PV/QV Limit Violations 

  

The Limit Violations tab allows the definition of what should be considered a violation of a 
monitored voltage. 
  

Identify bus voltages 

The Low Voltage and High Voltage options should be checked in order to see which of 
the buses are violating their voltage limits at the end of the PV/QV analysis. The limits used 
are those defined using the limit monitoring settings. To examine the limit monitoring 
settings, press the Limit Group Definitions button to open the Limit Monitoring Dialog.  

When choosing the identify limit violations, the Overview table on the Results tab will 
contain information about the number of violations (#Viol), worst voltage violation (Worst V 
Viol), and bus at which the worst voltage violation occurs (Worst V Bus). Also, for any 
scenario in which a violation occurs, the Show Violations option is enabled on the local 
right-click menu of the Overview table. Choosing this option will open a table detailing all of 
the violations. 

Inadequate voltage level 

This option allows the specification of the value at which a monitored voltage is determined 
to be "inadequate". The results of the PV/QV analysis will report the transfer level at which 
the first instance of a voltage below the inadequate level was detected. There are three 
options for specifying the inadequate voltage. A voltage can be specified by selecting 
Specify voltage for all buses in pu and then entering a voltage. Low voltage limits can 
be specified with each bus. To use the values specified with each bus, select Use Low 
Voltage Violation Limits for each bus. Different sets of limits can also be specified with 
each bus. To use a particular limit set, select Use a specified Low Voltage Limit Set and 
select the limit set from the dropdown box. 

The PV/QV analysis can be halted when it first detects the inadequate voltage. Checking 
Stop when voltage becomes inadequate will force the PV/QV analysis to do so. 

To ignore the inadequate voltage feature of the PV/QV analysis, uncheck the Identify 
inadequate voltage checkbox. 
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PV/QV PV Output 

  

Simulator records the value of each monitored quantity at each transfer level. However, unless 
you tell Simulator where to write the data, it will be present only in memory. The Output Tab 
allows you to designate where the data should be logged. 

Click the Save Results to File option to indicate that you want to write results to a file. 
Then, in the adjacent text box, supply the complete path for the output file. You may use the 
Browse button to locate the place where you want the file to be written. The results can 
either be saved as a text file with .TXT extension or a comma-separated variable file with .CSV 
extension. The file type should be set in the save dialog under the Save as type option. If 
saving results to file, a log file will also be created that indicates how long the entire PV curve 
process took and the different base case and contingency scenarios examined at each nominal 
shift level. If running multiple instances of Simulator for PV analysis, a unique file name must 
be given to each set of results to avoid overwriting existing results.  

Two file formats are available when saving results to file. If choosing to use a Single Header 
File, only a single field header will be shown at the top of the file. The first line of the file 
indicates that these are the results for a PV study. Following the header are lines indicating 
scenarios that have become critical during the analysis. Following this information is the single 
header line that indicates what fields are provided with the results. Following the header are 
the results for each scenario. An example is given below: 

  

Example Single Header File Output (CSV): 

RESULTS FOR PV STUDY "PVSTUDY"  

"Newly Critical","L_00002Two-00006SixC1 (Reached Nose)"  

"Scenario","Export","Import","Bus 3 (Three_138.0) PU Volt","Bus 5 (Five_138.0) PU Volt"  

base case, 0.0000, 0.0000, 0.9927, 1.0066  

base case, 100.0000, -98.7366, 0.9928, 1.0062  

base case, 200.0000,-193.4267, 0.9928, 1.0054  

base case, 300.0000,-278.6272, 0.9928, 1.0043  

base case, 400.0000,-365.9344, 0.9927, 1.0031  

base case, 500.0000,-449.7524, 0.9926, 1.0015  

base case, 599.9999,-525.2494, 0.9924, 0.9996  

base case, 650.0000,-563.8935, 0.9923, 0.9986  

base case, 674.9999,-582.8201, 0.9923, 0.9980  

L_00001One-00002TwoC1, 0.0000, 0.0000, 0.9906, 1.0067  

L_00001One-00002TwoC1, 100.0000, -98.7366, 0.9882, 1.0062  

L_00001One-00002TwoC1, 200.0000,-193.4267, 0.9849, 1.0053  

  

If using the default output format and not using the single header file, each scenario will be 
written as a section with a header line at the beginning of each section indicating what fields 
are included. Scenarios that become critical during the analysis will only be listed with the base 
case scenario and will be listed at the shift level at which they became critical. An example of 
this file format is given below: 
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Example for Default PV Output (CSV): 

RESULTS FOR PV STUDY "PVSTUDY" * 

*Scenario** "base case"  

"Export", "Import","Bus 3 (Three_138.0) PU Volt","Bus 5 (Five_138.0) PU Volt","Newly Critical"  

 0.0000, 0.0000, 0.9927, 1.0066,  

100.0000, -98.7365, 0.9928, 1.0062, 

200.0000,-193.4265, 0.9928, 1.0054,  

 300.0000,-278.6270, 0.9928, 1.0043,  

 400.0000,-365.9341, 0.9927, 1.0031,  

 500.0000,-449.7520, 0.9926, 1.0015,  

 599.9999,-525.2490, 0.9924, 0.9996,  

650.0000,-563.8931, 0.9923, 0.9986,  

 674.9999,-582.8196, 0.9923, 0.9980,L_00002Two-00006SixC1 (Reached Nose)  

  

In addition to recording how the monitored quantities vary with the transfer, you can instruct 
Simulator to save the entire system state at regular intervals during the analysis. This can be 
helpful if you want to analyze particular transfer levels more closely after the analysis is 
complete. To archive all system states, click the option labeled Save all states, then, supply 
the directory where the states should be written, and a prefix to use in naming the state files. 
You can use this prefix to distinguish the states of different runs that might have been written 
to the same directory. If you do decide to use this option, keep in mind that, depending on the 
size of your system, archiving states frequently can require significant disk space and delay 
the process. However, it can be quite helpful if previous analyses have shown interesting 
behavior at a particular transfer level. 

You may also save only the base case for each critical contingency, or save no system states 
at all, by checking the appropriate option.  
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PV/QV PV Results 

  

To start the PV study, switch to the PV Results tab, the last page of the form. From this tab, 
you can control the progress of the run by initiating, pausing, or aborting it. You can even 
reset the process to the beginning. This tab also gives you a few different views of the run's 
output, including the ability to plot various quantities.  

To begin the PV analysis, click Run. The status field will update with the progress of the 
analysis. Totals of the Gen MW and Load MW by component for the source and sink will 
update as these values change during the analysis. To terminate the analysis at any time, click 
Stop.  

As the analysis continues, the scenario list on the Overview sub-tab will keep you informed of 
its progress. Present step size identifies the current size of the increment the application is 
using to increase the transfer. Present Nominal Shift indicates the size of the transfer that 
was most recently solved.  

The Save Results button can be used to save the results to an auxiliary file. The Load 
Results button can be used to load previously saved results from an auxiliary file. The View 
detailed results button opens a text file that contains the detailed results including the 
values of the tracked quantities at each step for each scenario.  

The Other actions button provides access to other options available with the PV analysis. 
The Save critical contingencies option will save to an auxiliary file all of the contingencies 
that were found to be critical for some reason during the analysis. Restore initial state will 
restore the power system to the state when the PV analysis was first started. The remainder 
of the actions available under Other actions are self-explanatory.  

The Plot sub-tab provides access to the application's data plotting functions. Any of the values 
designated to monitor can be plotted using this display. To produce a plot, the Horizontal 
axis value and Vertical axis value must be specified, the scenarios to plot must be selected 
in the PV Scenario table by setting the Plot field to YES, and the elements for which to plot 
values must be selected under Plot values for these elements by setting the Plot field to 
YES. An optional Plot title can be specified. Once the options are set, click the Plot button to 
produce the plot. The Clear button will clear all of the options.  

The plot will appear in its own window. You can produce as many plots as the memory on 
your system will allow. Right-clicking on a plot will expose a local menu with several options. 
You can send the plot to your printer by clicking Print. You can change the printer 
configuration by selecting Printer Setup. You can save the plot as a bitmap, Windows 
metafile, JPEG, or text file by clicking Save and selecting the appropriate file type. Use Copy 
to make a copy of the plot that can be pasted into other applications. Finally, to close the plot 
window, click Close. 

Note that the plot tab also has an option for plotting pre-contingency values and for always 
including the plot of the base case conditions. 

The Track Limits sub-tab has additional tabs listing the device types that have been selected 
for tracking. Each of these tabs contains a table of the elements tracked and where that 
element was located relative to its limits during each step of the analysis using the indicators 
of Within Limits, Within Range, At Max, and At Min. 
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PV/QV QV Setup 

  

The PV curve tool stresses the system by increasing a transfer between injection groups. 
Eventually, the transfer is increased so much that the power flow can no longer be solved. 
Under the assumptions of static voltage stability assessment, the point at which the system 
becomes unsolvable is regarded as the point of voltage collapse. Voltage collapse tends to be 
a localized phenomenon associated with a lack of reactive voltage support at a bus or group of 
connected buses. It is important to identify this group of stressed buses so that you can 
properly direct efforts to reinforce the system. QV analysis is often used to identify the buses 
that are most prone to a voltage collapse because they are close to having insufficient reactive 
support.  

The design of the PVQV add-on to Simulator acknowledges the important role that QV analysis 
plays in identifying the buses that are most heavily stressed by a transfer. The approach is 
straightforward. First, perform a PV curve analysis that models a transfer from source to sink 
for both base and contingency topologies. This will yield a number of PV curves that terminate 
at a transfer level that causes the system to become unsolvable for each topology. For each of 
these critical transfer level / contingency pairs, perform a QV analysis at a set of buses to try 
to determine which area or areas constitute the epicenter of the collapse. The set of buses at 
which the QV analysis is performed can be predefined by the user and supplemented by the 
list of buses that have the lowest voltage magnitudes or the highest VQ sensitivities.  

To specify that Simulator should automatically launch a QV analysis after finishing a PV study, 
check the box labeled Automatically launch QV analysis at end of PV computation. 
After the PV curve has found all the critical cases it has been asked to identify, it will launch 
the QV Curve Tool. The buses the QV Curve Tool will analyze will then come from two groups: 
those that the user has pre-selected, and those that tool automatically identified because they 
are among the lowest-voltage buses or have the highest VQ sensitivities. To pre-select buses 
for the QV analysis, switch to the Buses sub-tab of the Quantities to track tab and toggle 
the Draw QV? field of each bus for which you want to compute a QV curve to YES. Whether 
other buses are automatically selected in light of their voltage or VQ sensitivity is governed by 
settings stored in the QV options file. 
  

We now continue our look at the QV Setup tab of the PV Curve Tool by describing the use of 
the remaining controls. 

QV options file 

Specify the name of the file that contains settings for a variety of options associated with 
the QV study in this text box. Use the Browse button to locate this file using a file dialog. 
Among the topics that may be addressed by the QV options file is whether buses should be 
automatically selected as buses for which to draw QV curves based on their voltage or VQ 
sensitivity. The easiest way to build a QV options file is to use the QV Curve Tool to specify 
the settings of the various options and to save these settings in a file. 

How should scenarios be handled? 

QV curves can be drawn for the selected buses either for all the scenarios that the PV tool 
has processed, or just for the scenarios for which the PV Curve Tool found an unsolvable 
transfer level. Select the option that describes how you wish the QV Curve Tool to process 
scenarios from this option group. If you select the Consider just the unsolved scenarios 
option, the QV tool will compute QV curves for the selected buses at the last transfer level at 
which each scenario was successfully solved. Otherwise, the tool will compute QV curves for 
the selected buses for each scenario at either the last transfer level at which the scenario 
was successfully solved or the last transfer level that the PV tool attempted to model. 



PowerWorld Simulator Add-On Tools 
 
 

930 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

QV accelerator settings 

This group of controls enables you to define a voltage window over which each QV curve 
should be calculated. If you select Do not use shortcuts; trace the entire QV curve, 
each QV curve will be computed over the voltage range specified for the bus in the QV 
options file. This voltage range may be specific to that bus or may be a window that has 
been defined for the entire run. If, on the other hand, you select Trace abbreviated QV 
curves using these settings…, the voltage range over which each bus’s QV curve will be 
computed will be customized for each bus according to the values you specify for Max 
voltage increase and Max voltage decrease. For example, if a bus is currently at 0.9 
per-unit voltage for a particular scenario and you specify the max voltage increase and 
decrease to be 0.1 and 0.3, respectively, then the QV curve for that bus for that scenario 
will be traced over the voltage range 0.6 pu to 1.0 pu. 
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PV/QV QV Curves 

  

Another voltage stability function currently included is the ability to compute QV curves for any 
bus in the system. Simply select QV Curves on the PVQV ribbon group on the Add Ons 
ribbon tab. The QV Curve dialog allows you to specify the buses to be monitored, set defaults 
for the QV curves, and run the QV analysis. These three topics are handled on the following 
pages of the QV Curve dialog: 

Buses 

Quantities to Track 

Options 

Results 

When all options have been set, click Run to start the QV analysis. The progress of the 
analysis can be monitored from the Results tab.  

When you are finished, simply click Close. The results will remain in memory as long as the 
case remains in memory. Please note that QV curve results and option settings are not saved 
with the case. 
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PV/QV QV Curve Buses 

  

To designate the buses for which you would like to calculate QV curves, toggle the Selected? 
field to YES. If you would like to specify specific solution parameters (min volt, max volt, and 
step size) for any bus, simply type the numbers in the appropriate cells. If you leave any cells 
blank, default values will be used for those parameters. Only non-default values will be shown 
in these cells. If you change a value in these cells to a default setting, the cell will be 
automatically set blank. 

Alternatively, you may type a range of bus numbers to add them to the list of buses that will 
have a QV curve calculated, or you may type the name of a bus. Furthermore, you may load a 
list of buses, as well as other option settings, from an auxiliary data file. To create such a file 
to store your option settings, press the Save button that appears near the bottom of the 
display. 

To load settings you saved previously in an auxiliary data file, click the Load button. You can 
search for the file instead of typing its name. Once the name of the file appears in the text 
field, press Open to import the settings stored in the file. 

You also can check the box Additionally, automatically draw curves for… and then the 
number of lowest-voltage buses and highest dv/dq buses that you require. These buses 
will be selected from the limit group indicated in the field from limit group. 
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PV/QV QV Curve Options 

  

The Options page of the QV Curve dialog contains three tabs labeled Solution, Output and 
Contingencies. 
  

Solution 

In the three text fields enclosed in the Default solution parameters group box, specify 
the values of voltage step size, minimum voltage, and maximum voltage to use when 
computing QV curves for buses that do not have specific values set for these parameters.  

If you do not understand the meaning of these parameters, consider how a QV curve is 
computed: a fictitious generator (i.e. voltage source) is placed at the monitored bus. Its set 
point voltage is varied in steps of the specified size between the specified maximum and 
minimum voltages, and the Mvar injection at the bus is calculated and recorded at each 
step. 

To make the changes that you have made register with the QV curve calculation, click the 
Set Options button. To restore the factory-default settings, click Restore Defaults. 

To set power flow solution parameters, click the Global solution options button. Be aware 
that the changes you make in the resulting dialog affect all power flow computations in 
Simulator. 

Contingencies  

QV curves can be calculated for the specified buses for both base and contingency 
conditions. To analyze a set of contingencies, you must define the contingency set using the 
separate Contingency Analysis Dialog, which you can access from run mode by selecting  
Contingency Analysis from Tools ribbon tab. In order to have the QV curves drawn 
automatically for a contingency, the QV Autoplot field belonging to the contingency must 
be set to YES.  

To have the QV curve calculation analyze these contingencies for each bus, check the box 
labeled Process each of the currently defined contingencies. Check the box labeled 
Skip base case for avoiding the computation of QV curves for base conditions.  

Output 

The Output tab allows you to set a location for saving the results of the QV analysis to a 
file. To save the QV analysis to a text file, you must first check the box labeled Save 
results in file. Once this box is checked, you can then either type in a directory location for 
saving the data, or click the Browse button and select a file to save as. You can also 
customize the file prefix and extension to be used when Simulator names the output files. 

Another option on the Output tab is the check box labeled Plot curves as they are 
computed. When this option is checked, the QV curve displays will be updated and drawn 
during each step of the QV analysis process. In order to have the QV curves updated and 
drawn for a contingency during each step of the analysis, the QV Autoplot field belonging 
to that contingency must be set to YES on the Contingency Analysis Dialog. 

When plotting the QV curves, there are two options for how to treat the Mvar portion of the 
curve. Q can either represent The output of the fictitious synchronous condenser or 
The total reactive injection at the bus, including shunts but excluding load.   
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PV/QV QV Curve Results 

  

To perform the QV curve calculations, switch to the Results tab and press the Run button. 
The QV curve calculation will respond by calculating QV curves for each of the specified 
scenarios (i.e. for each bus / contingency pair). When it finishes the QV curve calculation for a 
scenario, it will record the critical points for the curve in a case information display found on 
the Listing sub-tab. These critical points include (V0, QV0), (Vmin, QVmin), (Vmax, QVmax), 
and (VQmin, Qmin).  

Each scenario can be identified using the bus number and name fields together with the case 
name field, which simply specifies either BASECASE or the name of the contingency. As with 
all case information displays, the QV Results case information display has a local menu that 
offers a number of options. From the local menu, you can plot the QV curve for a scenario, 
record the (Q, V) pairs that comprise each curve to a text file or to an Excel spreadsheet, and 
clear the results. 

The Plots sub-tab allows plotting any values that have been set with Quantities to Track. The 
plots can be created in the same manner as described for the Plot sub-tab of the PV Results. 

The information contained in the Track Limits sub-tab contains the same type of information 
as described in the Track Limits sub-tab of the PV Results. 

The QV curve calculation interface remains active while the curves are calculated. You can 
terminate the run at any time by clicking Stop. 
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PV/QV Refine Model 

  

Simulator PVQV has the ability to refine the system model to fix modeling idiosyncrasies that 
cause premature loss of convergence during the PV and QV curve studies. This option is 
available on the Add Ons ribbon tab in the PVQV ribbon group.  

The user can refine the case in the following ways: 

Fix transformer taps 

If there are transformers that have Vmax and Vmin that are very close together, the power 
flow may have a difficult time converging. This option allows the user to fix all transformer 
taps at their present values if their Vmax - Vmin is less than or equal to the user specified 
tolerance. 

Fix shunts 

If there are shunts that have Vmax and Vmin that are very close together, the power flow 
may have a difficult time converging. This option allows the user to fix all shunts at their 
present values if their Vmax-Vmin is less than or equal to the user specified tolerance. 

Take units off AVR control 

If there are generators that have Qmax and Qmin that are very close together, the power 
flow may have a difficult time converging. This option allows the user to remove these units 
from AVR control, thus locking their MVAR output at its present value, if their Qmax - Qmin 
is less than or equal to the user specified tolerance. 

These refinements will only be applied to those areas or zones that have the Apply? field set 
as YES in this dialog box. This field can be changed by right-clicking on it and selecting Toggle 
all to YES/NO or by double-clicking on the field. 
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PowerWorld Simulator Optimal Power Flow Overview 

  

Note: The OPF option in PowerWorld Simulator is only available if you have 
purchased the OPF add-on to the base package. To learn more about the OPF, 
please feel free to read through the information contained in these help files. 
Contact PowerWorld Corporation for details about ordering the OPF version of 
Simulator. 

The PowerWorld Simulator (Simulator) is an interactive power system simulation package 
designed to simulate high voltage power system operation. In the standard mode Simulator 
solves the power flow equations using a Newton-Raphson power flow algorithm. However with 
the optimal power flow (OPF) enhancement, Simulator OPF can also solve these equations 
using an OPF. In particular, Simulator OPF uses a linear programming (LP) OPF 
implementation.  

All of the OPF commands and options are accessed using the LP OPF main menu item. Other 
commands in this menu are used to specify input options, see results, and store/retrieve OPF 
specific data into auxiliary files.  

The purpose of an OPF is to minimize an objective (or cost) function  by changing different 
system controls  taking into account both equality and inequality constraints  which are used 
to model the power balance constraints and various operating limits. 

In Simulator OPF the LP OPF determines the optimal solution by iterating between solving a 
standard power and then solving a linear program to change the system controls to remove 
any limit violations. See OPF Primal LP for more details.  
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OPF Objective Function 

  

The objective of the OPF algorithm is to minimize the OPF objective function, subject to 
various equality and inequality constraints. Since the objective of the OPF is to minimize an 
objective function, what objective function is used has a significant impact on the final 
solution.  

Currently two objective functions are available in Simulator OPF: Minimum Cost and Minimum 
Control Change. Minimum Cost attempts to minimize the sum of the total generation costs in 
specified areas or super areas. Minimum Control Change attempts to minimize the sum of the 
absolute values of the changes in the generation in the specified areas or super areas.  

To include an area or super area in the OPF objective function, simply change the Area AGC 
Status field to "OPF" on the OPF Area Records Display or the Super Area AGC Status field to 
"OPF" on the OPF Super Area Records Display. This gives you great flexibility in defining the 
OPF study. For example you can set the OPF to minimize costs for the entire system, or just 
selected areas or super areas.  
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OPF Equality and Inequality Constraints 

  

In solving a constrained optimization problem, such as the OPF, there are two general classes 
of constraints, equality and inequality. Equality constraints are constraints that always have to 
be enforced. That is, they are always "binding". For example in the OPF the real and reactive 
power balance equations at system buses must always be satisfied (at least to within a user 
specified tolerance); likewise the area MW interchange constraints. In contrast, inequality 
constraints may or may not be binding. For example, a line MVA flow may or may not be at its 
limit, or a generator real power output may or may not be at its maximum limit. 

An important point to note is because the OPF is solved by iterating between a power flow 
solution and an LP solution, some of the constraints are enforced during the power flow 
solution and some constraints are enforced during the LP solution. The constraints enforced 
during the power flow are, for the most part, the constraints that are enforced during any 
power flow solution. These include the bus power balance equations, the generator voltage 
set point constraints, and the reactive power limits on the generators. What differentiate the 
LP OPF from a standard power flow are the constraints that are explicitly enforced by the LP. 
These include the following constraints: 

Equality Constraints 

Inequality Constraints 
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OPF Equality Constraints 

  

Area MW Interchange  

The area MW interchange constraints are enforced during the LP for those areas that have 
an AGC Status equal to "OPF" provided the area is not part of a super area that is also set 
on AGC. The AGC Status field for an area can be set using the OPF Area Records display, 
while the AGC Status field for the super area (if any) is set using the OPF Super Area 
Records display. Areas whose interchange is enforced during the LP do not have their 
interchange enforced during the power flow solution; during the power flow these areas are 
treated as though they were off of AGC (and hence the output of generators in that area is 
not varied during the power flow). 

It is perfectly acceptable to have some areas on "OPF" AGC control and to have other areas 
on the more traditional power flow area AGC such as "ED" or "Part. AGC." The interchange 
for such areas is controlled during the power flow solution. 

Following a successful solution, marginal costs are calculated for the area interchange 
constraints; these values are displayed on the OPF Area Records display and can be 
contoured. See OPF Marginal Costs for details.  

Bus MW and Mvar power balance  

Enforced during the power flow solution. Following a successful solution, marginal costs are 
calculated for the bus MW (real power) balance constraint; these values are displayed on 
the OPF Bus Records display and can be contoured.  

Generator Voltage Setpoint 

Enforced during the power flow solution. Following a successful solution, marginal costs are 
calculated for the voltage setpoint constraint; these values are displayed on the OPF Bus 
Records display .  

Super Area MW Interchange 

Super area interchange constraints are enforced similar to the area constraints. That is, 
super area interchange constraints are enforced during the LP only for those super areas 
that have an AGC Status equal to "OPF." The AGC Status field can be set using the OPF 
Super Area Records display. During the power flow solution such super areas are treated as 
though they were off of AGC. 

Interface MW limits when treated as Equality 

Interface MW limits are enforced during the LP solution. Interface MW limits are normally 
treated as inequality constraints (see Inequality Constraints ), however they can optionally 
be treated as equality constraints. See the Interface Dialog for information on how to treat 
the limit as an equality constraint. 

Transmission Line and Transformer (Branch) MVA limits 

Branch MVA limits are enforced during the LP solution. Branch MVA limits are normally 
treated as inequality constraints (see Inequality Constraints ), however they can optionally 
be treated as equality constraints. See the Line Transformer Dialog for information on how 
to treat the limit as an equality constraint. 
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OPF Inequality Constraints 

  

The following classes of inequality constraints are enforced during the OPF solution.  

Generator real power limits  

Generator real power limits are enforced during the LP solution.  

Generator reactive power limits  

Generator reactive power limits are enforced during the power flow solution.  

Interface MW limits 

Interface MW limits are enforced during the LP solution. In short, interface records are used 
to represent the aggregate flow through a number of different devices (see Interface 
Records for details). During the LP the MW flow through the interface is constrained to be 
less than or equal to a user specified percentage of its limit, provided the interface is active 
for enforcement. For an interface to be active for enforcement the following three conditions 
must be met: 

• Interface enforcement must not be disabled for the case. This field can be set from 
either the OPF Options and Results dialog or the OPF Interface Records display. The 
default is that case interface enforcement is not disabled. Also note that interface flow is 
limited to a percent of its limit as specified by the interface's Limit Monitoring Settings. 

• Interface enforcement must be active for at least one of the interface's areas. Note, an 
interface is assumed to be in each area that contains at least one of its components. 
This field can be set from the OPF Area Records display. Note: the default is that 
interface enforcement is not active, so be sure to activate this if you want these 
constraints enforced. 

• Enforcement must be active for each individual interface. This field can be set from the 
OPF Interface Records display or in the Limit Monitoring Settings Dialog. The default is 
active. 

Each interface that is active for enforcement is modeled as an inequality constraint, which 
may be either binding or not binding. If the constraint is not binding then it does not impact 
the solution. If a constraint is binding then it has an associated marginal cost of 
enforcement, which is shown on the OPF Interface Records display.  

Transmission Line and Transformer (Branch) MVA Limits  

Transmission line and transformer (branch) MVA limits are enforced during the LP solution. 
During the LP the branch line flow is constrained to be less than or equal to a user specified 
percentage of its limit, provided the branch is active for enforcement. For a branch to be 
active for enforcement the following three conditions must be met: 

• Line/Transformer enforcement must not be disabled for the case. This field can be set 
from either the OPF and Results Options dialog or the OPF Line/Transformer Records 
display. The default is that case line/transformer enforcement is not disabled. Also note 
that the branch flow is limited to a percent of its limit as specified by the branche's Limit 
Monitoring Settings. 

• Branch enforcement must be active for the branch's area. For tie-lines enforcement 
must be active for either area. This field can be set from the OPF Line/Transformer 
Records display. The default is that branch enforcement is not active, so be sure to 
activate this if you want these constraints enforced.  

• Enforcement must be active for each individual branch. This field can be set from the 
OPF Line/Transformer Records display or in the Limit Monitoring Settings Dialog. The 
default is active. 
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Each branch that is active for enforcement is modeled as an inequality constraint, which 
may be either binding or not binding. If the constraint is not binding then it does not impact 
the solution. If a constraint is binding then it has an associated marginal cost of 
enforcement, which is shown on the OPF Line/Transformer Records display.  
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Determining Set of Active Inequality Constraints 

  

A key issue in quickly solving the OPF is for the LP to effectively determine the set of active 
inequality constraints. Currently this includes the line MVA limits and the interface MW limits. 
Because the speed of the LP varies as the cube of the number of constraints active in the LP 
basis, it is extremely important to keep this number as small as possible. Therefore it would be 
very computationally prohibitive to setup an inequality constraint for each transmission line 
and interface (except in very small systems.)  

The solution of setting up constraints only for those inequality constraints that are actually 
violating their limits is a step in the right direction, but suffers from the problem that during a 
solution a line may initially be violating its limit and then after the first iteration it is no longer 
violating. However if it is not subsequently included as a constraint during the next iteration 
the solution may simply oscillate between enforcing/unenforcing this constraint. This problem 
can be resolved by keeping that constraint in the basis even though it is no longer binding.  

However this raises a question about how to handle these constraints during future OPF 
solutions. For example what would happen if a user solved the OPF, and then immediately 
resolved the OPF. Following the first solution the constraint would be enforced so that it may 
actually be less than its limit. However if this constraint is not included in the LP basis during 
the next solution the constraint may immediately violate during the first iteration, requiring a 
number of iterations just to return to the original initial solution.  

Simulator solves this issue by keeping track of the enforced constraints from one solution to 
the next. Constraints are only removed from the basis if they the fall below a specified 
percentage of their limit. This percentage is enterable on the Constraint Options page of the 
OPF Options and Results Dialog. This prevents the set of constraints in the basis from building 
up over time as a number of different system conditions (and hence constraints) are studied. 
Also, at any time this set of constraints can be cleared using the Initialize OPF Button on 
the OPF Options and Results Dialog. 

Also, the user is free to specify that a particular constraint always be included in the basis. 
This is done by toggling the Constraint field to "Always" on the OPF Line/Transformer 
Records or OPF Interface Records displays.  
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OPF Unenforceable Constraints 

  

The goal of the LP OPF is to minimize the objective function subject to the user specified 
constraints. However there is no guarantee that it is even possible to simultaneously satisfy all 
of the specified constraints. In fact, it is quite easy to create a system in which all of the 
constraints cannot be enforced. A simple example is a two bus system consisting of a single 
generator supplying a single load through a transmission line. If the transmission line MVA 
rating is below the MVA of the load then it is impossible to supply this load while 
simultaneously satisfying the transmission line constraint. In Simulator OPF such a situation is 
known as an unenforceable constraint. In studying large systems, such as the U.S FERC 715 
cases, such situations actually appear to be quite common. Seemingly unenforceable 
constraints are often due to a lack of controls available to the LP OPF or due to faulty limits 
entered in the case. In such cases unenforceable constraints can be corrected by making more 
controls available to the LP OPF or correcting the limits.  

Simulator OPF allows you to solve systems with unenforceable constraints by only enforcing 
those constraints that have a marginal cost below a user specified tolerance. These tolerances 
are specified on the OPF Options Constraint Options Page. Any constraints that have marginal 
costs above these values are not enforced, including any unenforceable constraints. This 
functionality is implemented in Simulator OPF through the use of slack variables. Slack 
variables are artificial variables introduced during the LP solution in order to satisfy the 
constraints with the slack variable costs equal to the user specified values. Then, during the LP 
solution the slack variables are usually removed from the LP basis. The only time this does not 
occur is if the constraint can not be enforced with a marginal cost less than the specified 
value. The number of unenforceable constraints are shown on the OPF Option Solution Results 
Page.  
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OPF Marginal Costs 

  

During any constrained minimization there is a cost associated with enforcing the equality 
constraints and the binding inequality constraints. These costs are known as the marginal 
costs.  

In Simulator OPF marginal costs are calculated for the following record types: 

Bus MW Equality Constraints 

The Bus MW marginal costs tell the incremental cost to supply one additional MW of load at 
the specified bus. These values can be viewed on the OPF Bus Records display; they can 
also be contoured or viewed on the one-lines using bus fields. 

In the absence of any binding inequality constraints (such was Line MVA constraints) all of 
the bus marginal costs in an area should be identical. Bus marginal costs can only be 
determined for buses that are in areas or super areas on OPF control.  

Area MW Equality Constraints 

The Area MW marginal costs tell the incremental cost for the specified area to import one 
additional MW of load from the system slack bus. These values can be viewed on the 
OPF Area Records display; they can also be contoured or viewed on the one-lines using area 
fields. In the absence of any binding inequality constraints the area MW marginal cost is 
identical to the bus MW marginal costs for all the buses in the area. When there are binding 
inequality constraints this is no longer the case.  

Super Area MW Equality Constraints 

The Super Area MW marginal costs are identical to the area marginal costs except they 
apply to super areas rather than areas.  

Interface MW Constraints 

The Interface MW marginal costs tell the incremental cost of enforcing the interface MW 
constraints. These values are only nonzero if the interface constraint is actually active 
(binding); they can be viewed using the OPF Interface Records display.  

Line/Transformer MVA Constraints 

The Line/Transformer marginal costs tell the incremental cost of enforcing the line or 
transformer MVA constraint. These values are only nonzero if the line or transformer 
constraint is actually active; they can be viewed using the OPF Line/Transformer Records 
display.  
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OPF Primal LP 

  

Go to the Add Ons ribbon tab and select Primal LP from the OPF ribbon group to solve the 
OPF using the primal LP algorithm.  

In Simulator OPF the LP OPF determines the optimal solution by iterating between solving a 
standard power flow and then solving a linear program to change the system controls to 
remove any limit violations. The basic steps in the LP OPF algorithm are 
1. Solve the power flow 
2. Linearize the power system about the current power flow solution. Both constraints and 

controls are linearized.  
3. Solve the linearly-constrained OPF problem using a primal LP algorithm, computing the 

incremental change in the control variables. Slack variables are introduced to make the 
problem initially feasible. That is, the slack variables are used to satisfy the equality and 
inequality constraints. The slack variables typically have high costs so that during the 
iteration the slack variables change to satisfy the constraints. The LP then determines the 
optimal, feasible solution for the linear problem.  

4. Update the control variables and resolve the power flow. 
5. If the changes in the control variables are below a tolerance then the solution has been 

reached; otherwise go to step 2. 
6. Finish by resolving the power flow.  
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OPF Future Enhancements 

  

While we certainly plan on introducing additional functionality in future releases, we do want 
to be as clear as possible about what functionality is not currently provided. 

The current version of Simulator OPF allows users to calculate the optimal solution to a power 
system using generator real power MW outputs and phase shifters as controls, while enforcing 
area, super area, interface MW and line/transformer MVA constraints. Marginal losses can also 
be included in the OPF calculation.  

Some functionality that is not included in the current version of Simulator OPF, and which we 
hope to include in future versions, include the following: 
• Enforcing bus low/high voltage magnitudes as limits 
• Including additional devices as controls, such as generator voltage setpoints, LTC 

transformers, switched shunts.  
• Allowing the optimization of different cost functions. 
• Additional functionality as suggested by customers.  
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OPF Options and Results 

  

The OPF Options and Results dialog allows you to customize the OPF solution. To display this 
dialog, go to the Add Ons ribbon tab and select Options and Results from the OPF ribbon 
group. The dialog consists of three general pages; Options, Results and LP Solution Details.  

The Options page has four tabs as well, Common Options, Constraint Options, Control 
Options, and Advanced Options 

The Results page has four tabs, Bus MW Marginal Price Details, Bus Mvar Marginal Price 
Details, Bus Marginal Controls, and Solution Summary.  

The LP Solutions Page has five tabs, All LP Variables, LP Basic Variables, LP Basis Matrix, 
Inverse of LP Basis, and Trace Solution. 

The dialog also has several buttons at the bottom of the display: 

OK, Cancel 

Select to close the dialog. Selecting OK saves your changes while Cancel does not. Note 
that changes are also saved anytime you select Solve LP OPF or Single Outer Loop.  

Solve LP OPF 

Solves the OPF using the Primal LP algorithm. Equivalent to selecting Primal LP from the 
Optimal Power Flow ribbon group on the Add Ons ribbon tab.  

Single Outer Loop 

Does a single outer loop of the Primal LP algorithm.  

Initialize LP OPF 

Returns the LP OPF variables to their original states. 

Print 

Prints the selected page of the dialog. 

Help 

Displays this help page. To view help for a particular page place the cursor on the page and 
press the F1 key.  
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OPF Options: Common Options 

  

The OPF Dialog, Common Options page displays general options associated with the OPF 
solution. The display contains the following fields: 
   

Objective Function 

Allows a choice of solving the LP using either a minimum cost or a minimum control change 
objective function. 
  

 LP Control Variables 

Disable All Phase Shifter Controls 

Prevents phase shifters from attempting to control devices during the OPF solution. 

Disable All Generator MW Controls 

Prevents generators from shifting MW output during the OPF solution. 

Disable All Load MW Controls 

Prevents loads from shifting MW demand during the OPF solution. 

Disable Area-toArea MW Transaction Controls 

Prevents MW transactions between areas from being dispatched during the OPF solution. 

Disable DC Transmission Line MW Controls 

Prevents shifting of DC Transmission Line MW transfers during the OPF solution. 

  

LP Options 

Maximum Number of LP Iterations 

Maximum number of allowable iterations for the LP portion of the LP OPF. How many 
iterations are required to obtain a solution depends, among other things, upon the number 
of breakpoints in the control cost models. Since each LP iteration can only move from one 
breakpoint to the next, the finer the model the more iterations required. However the LP is 
quite fast so a large number of iterations can be performed quite quickly. Default = 1000.  

Phase Shifter Cost ($ / Degree) 

Specifies the assumed cost for moving phase shifting transformer taps away from their initial 
values. The purpose for this fictitious cost is approximate the cost of actually changing the 
angle of a phase shifting transformer, and to avoid large changes in phase shifter angles 
that have very little impact on the system. This field may be zero. Default = $ 0.10 / 
Degree. 

Calculate Bus Marginal Cost of Reactive Power 

When this option is checked, the OPF algorithm will also calculate the marginal cost of 
reactive power at each bus. Typically the result of interest from the OPF algorithm is the MW 
marginal cost of each bus (the LMP), but the MVAR marginal cost can be determined as 
well. 

Save Full OPF Results in PWB File 

When checked, Simulator will store the full set of results, including the LP matrix, in the 
PowerWorld Binary case file. 

Do Detailed LP Logging 
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When checked, Simulator will write details on the LP algorithm solution during each pivot of 
the LP matrix. This is useful for debugging LP solution issues when running a LP OPF 
solution. 

Start with Last Valid OPF Solution 

When checked, Simulator will start the LP OPF solution process using the most recent OPF 
solution as the initial conditions. 
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OPF Options: Constraint Options 

  

The OPF Dialog, Constraint Options page displays options associated with the enforcement of 
the constraints by the OPF. The display contains the following fields: 
  

Line/Transformer Constraints 

Disable Line/Transformer MVA Limit Enforcement 

Select to disable enforcement of Line/Transformer MVA constraints for the entire case.  

Percent Correction Tolerance 

Specifies a tolerance for the enforcement of line/transformer MVA flows. The tolerance is 
necessary to prevent solution oscillations due to the non-linear nature of the actual 
constraints.  

Violated elements are always enforced to their limits multiplied by the MVA Enforcement 
Percentage. If power systems were completely linear then following the LP solution the 
constraint would actually be equal to this value. However because of nonlinearities, the 
constraint is close to this value but usually not identical to the value. The Percent Correction 
Tolerance is used to tell the OPF how close is close enough. Provided all the constraints are 
violating their limits by less than the correction tolerance percentage the optimal solution is 
assumed to have been found. You may set this value as low as you like, but setting it too 
close to zero may result in convergence difficulties. The default is 2 percent.  

MVA Auto Release Percentage 

Specifies a MVA level at which transmission lines can be released as an OPF constraint 
equation if the branch MVA flow falls below the level specified. 

Maximum Violation Cost ($/MWhr) 

If a branch MVA limit cannot be enforced during an OPF solution, the branch will be 
assigned a fictitious cost of enforcement equal to this value. This value is usually rather 
large in order to easily determine where the unenforceable constraint is occurring. The 
default value is 1000 $/MWhr. 

Enforce Line/Transformer MW Flow Limits (Not MVA) 

Checking this box will cause Simulator to treat the limits of the transmission elements as 
MW limits instead of MVA limits. Thus Simulator will report violations on these elements in 
the OPF based on the MW flow of the element versus the element’s MVA rating. 

  

Interface Constraints 

Disable Interface MW Limit Enforcement 

Select to disable enforcement of Interface MW constraints for the entire case. 

Percent Correction Tolerance, MW Auto Release Percentage, Maximum Violation 
Cost ($/MWhr) 

These fields are equivalent to the entries described above for Line/Transformer MVA 
Constraints except that they apply to Interface MW constraints. 

Monitor/Enforce Contingent Interface Limits 

This option allows you to choose if contingency elements in interfaces should be enforced 
during the OPF solution. Even if they are not enforced, the flows on the remaining elements 
in the interface will be monitored. The choices you have for enforcing contingency elements 
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in interfaces during the OPF are Never, Power Flow/OPF but not CA/SCOPF, or All 
Applications including CA/SCOPF. The reason CA (contingency analysis) and SCOPF (Security 
Constrained OPF) are singled out is because those two tools are already looking at 
contingency actions separately, outside of the interface definitions. Therefore it may be 
desired to ignore the inclusion of contingency elements within an interface definition when 
using these two tools. 

Phase Shifting Transformer Regulation Limits 

Disable Phase Shifter Regulation Limit Enforcement 

Select to disable enforcement of Phase Shifter regulation limit constraints for the entire 
case.  

For a phase shifter, there are two limits which can be enforced during the OPF—the MVA 
branch rating, and the regulation minimum and maximum MW flow. Checking this option will 
globally disable the enforcement of the regulation minimum and maximum MW flow for all 
phase shifters. 

In Range Cost ($/degreehr) 

The cost of changing a phase shifter angle away from zero degrees in $/degreehr, when the 
angle is within the allowable range of the phase shifter. 

Maximum Violation Cost ($/MWhr) 

If a phase shifter regulation limit cannot be enforced during an OPF solution, it will be 
assigned a fictitious cost of enforcement equal to this value. This value is usually rather 
large in order to easily determine where the unenforceable constraint is occurring. The 
default value is 1000 $/MWhr. 

Limit Monitoring Settings… 

This button opens the Limit Monitoring Settings dialog, which allows you to change the 
enforcement percentages for monitored elements. 
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OPF Options: Control Options 

  

The LP OPF Dialog, Control Options page displays options for generator control and power 
flow solution. The display contains the following options: 
  

Generator Control Options 

Allow Commitment of Fast Start Generators 

If this option is checked, then generators designated as Fast Start generators can be turned 
on or "committed" if the OPF routine determines that doing so would reduce the overall 
generating costs of the system. 

See the Fast Start description in the help on OPF Generator Records for a more detailed 
description of the Fast Start option of generators. 

Allow Decommitment of Fast Start Generators 

If this option is checked, then generators designated as Fast Start generators can be turned 
off or "de-committed" if the OPF routine determines that doing so would reduce the overall 
generating costs of the system. 

See the Fast Start description in the help on OPF Generator Records for a more detailed 
description of the Fast Start option of generators. 

Modeling Generators without Piecewise Linear Cost Curves 

The following fields specify how the OPF should handle generators that are specified as having 
a cubic cost model. Because the OPF is based upon an LP implementation, all control costs 
must be modeled using piecewise linear cost curves. These options permit an automatic 
conversion of cubic models to piecewise linear models. Alternatively, you can very easily 
convert the cubic models manually using the # Cost Curve Points field on the OPF 
Generator Records display or using the generator dialog.  

Generators Cost Models 

This field specifies how generators with cubic cost models should be handled in the OPF. 
The field has three values 

Ignore Them -  Generators with cubic cost models are Ignored during the OPF solution. 
That is, they are considered as though their AGC status was off.  

Change to Specified Points per Curve - A piecewise linear cost model is automatically 
inserted for the generator with a fixed number of points specified in the Total Points Per 
Cost Curve field described below. This curve will approximate the generator's cubic cost 
model as closely as possible; the existing cubic model is not modified. This is the default 
value. 

Change to Specified MWs per Segment - A piecewise linear cost model is automatically 
inserted for the generator such that each segment in the cost model covers the amount of 
MWs specified in the MWs per Cost Curve Segment field described below. This curve will 
approximate the generator's cubic cost model as closely as possible; the existing cubic 
model is not modified.  

Total Points Per Cost Curve 

Specifies the total number of segments that should be automatically inserted into the 
piecewise linear cost models for those generators that are modeled using cubic cost 
functions. This is only done if the Generator Cost Modeling field is Change to Specified 
Points per Curve. Default = 5.  
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MWs per Cost Curve Segment 

Specifies the number of MWs for each segment of the piecewise linear cost models that are 
automatically inserted for those generators that are modeled using cubic cost functions. This 
is only done if the Generator Cost Modeling field is Change to Specified MWs per 
Segment. Default = 10 MW.  

Save Existing Piecewise Linear Cost Curves 

Generators that are modeled with cubic cost curves may have existing piecewise linear cost 
curves which may have been manually entered by the user. These curves may or may not 
resemble the cubic cost function. During the OPF solution the existing piecewise linear cost 
curves are replaced with the auto-created cost curves. If this option is checked then the 
existing piecewise linear cost curves are restored at the end of the OPF. The default and 
recommended option is false since this allows one to view the actual cost curves used by the 
OPF. 

If you would like to use a particular piecewise linear cost function simply make sure that the 
generator is modeled using the piecewise linear model, which can be set on the OPF 
Generator Records display.  

  

Modeling of OPF Areas/Superareas 

During the Initial OPF Power Flow Solution 

Choose what manner of generation control you wish to be employed in the FIRST power 
flow solution the OPF will perform, which will establish the base case load flow condition for 
performing the subsequent OPF generation dispatch. 

During Stand-Alone Power Flow Solutions 

Choose what manner of generation control you wish to be employed in all load flow 
solutions FOLLOWING the initial load flow solution. In other words, after the LP OPF routine 
has determined the new generation dispatch, what type generation dispatch should be used 
during the normal load flow solution. 

NOTE: it is NOT recommended that you use Economic Dispatch in this case, although it is an 
available option. The reason it is not recommended is that you will remove the optimal 
dispatch (including constraints) just determined by the OPF in favor of lowest cost economic 
dispatch, which will likely result in the re-introduction of overloaded elements that were 
corrected by the OPF dispatch in the first place. 

  

Treat Area/Superarea MW Constraints as unenforceable even when the ACE is less 
than the AGC Tolerance (default is checked) 

This option by default is checked, which means that if Simulator solves an OPF and the 
generators in an area or super area are all either at their minimum or maximum outputs, 
and the area control error is still not 0, then the area MW constraint is considered 
unenforceable and Simulator will assign a large penalty cost (usually $5,000/MWhr) to the 
LMP's of the area. However, if you deselect this option, you give Simulator the additional 
control of checking the ACE mismatch against the AGC tolerance for the area, and if the ACE 
mismatch is less than the AGC tolerance, Simulator will "acquire" the mismatch amount from 
the system slack bus for the area, and the area will not be considered unenforceable in the 
OPF solution. The AGC tolerance is usually small, and therefore the amount of power taken 
from the system slack bus will also be small. The purpose of this option is to allow for valid 
LMP solutions in an area that is meant to reach its full minimum or maximum generator 
capability, but that losses and numerical rounding results in the ACE mismatch deviating 
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slightly from 0. It is not advised to uncheck this option if you have areas with large AGC 
tolerances. 
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OPF Options: Advanced Options 

  

Detection of LP Cycling 

This option allows for advanced tweaking of when cycling is detected in the LP. It is 
recommended that users leave the default settings in place. 

Minimum Number of Degenerate Iterations to Assume Cycling 

To prevent inaccurate identification of cycling in the LP solution, the minimum number of 
degenerate iterations before cycling is identified can be specified manually in this box.  

Minimum Number of Degenerate Iterations Multiplied by Number of Tableau 
Rows 

To prevent inaccurate identification of cycling in the LP solution, the minimum number of 
degenerate iterations as a multiple of the number of tableau rows can be specified 
manually in this box.  

Number of Sequential Degenerate Iterations for Last Case 

This displays the number of degenerate iterations detected when performing the most 
recent OPF solution. 

Power Flow Recalculation  

Choose one of the options to determine how often the power flow is resolved. The three 
options are, "When total generator MW change > than tolerance"; "After each LP solution"; 
and "Only at end of LP OPF". If the power flow is not resolved, linear sensitivities are used 
to determine which constraints enter the LP tableau. 

Total Generator Change Tolerance (MW) 

Specifies the total generator change tolerance. The default is 500 MW. 

After each LP solution 

Resolves the power flow upon completion of each LP solution 

Only at end of LP OPF 

Resolves the power flow only after the LP OPF has completed. 
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OPF Options: Solution Summary 

  

The OPF Dialog, Solution Summary page displays general results from the last OPF solution. 
Click the Save as Aux button to save these results to a Simulator Auxiliary file.  

The display contains the following fields, none of which can be directly changed: 
  

General Results 

Solution Start Time, Solution End Time 

The starting time and ending time of the OPF solution algorithm. 

Total Solution Time, Last Solution Status 

Time and status of the last OPF solution.  

Number of LP Iterations 

Total number of LP iterations used during the last OPF solution. The maximum number of 
iterations is specified in the Maximum Number of Iterations field of the General Options 
page.  

Initial Cost Function Value 

Initial value of the OPF cost function. During the OPF the solution algorithm seeks to 
minimize the cost function, subject to the equality and inequality constraints. 

Final Cost Function Value 

Final value of the OPF cost function. 

Final Slack Cost Value 

The slack cost value is an artificial cost that is only non-zero when there are one or more 
unenforceable constraints.  

Final Total Cost Value 

The addition of the final cost function value and the final slack cost value. 

Number of Buses in OPF 

This field contains the total number of buses that are in areas or super areas that are on 
OPF control. Thus this field need not be equal to the total number of buses in the case. 
Marginal costs are only calculated for buses in OPF controlled areas or super areas. 

Highest Bus Marginal Cost, Lowest Bus Marginal Cost, Average Bus Marginal Cost 

Highest, lowest and average marginal cost for the buses that are in OPF controlled areas or 
super areas. 

Bus MC Standard Deviation 

The standard deviation of the Bus Marginal Cost. 

  

Area and Superarea Constraints  

Unenforceable Area Constraints 

Number of unenforceable area constraints.  

Unenforceable Superarea Constraints 

Number of unenforceable superarea constraints.  
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Line MVA Constraints 

The Line MVA Constraints fields present results associated with the enforcement of the line 
MVA constraints. 

Number of Initial Violations, MVA Sum of Initial Violations 

Total number of lines that initially exceeded their MVA limits and were eligible for 
enforcement by the OPF. For these lines only, the MVA Sum of Initial Violations field 
contains sum of the absolute values of the line's actual MVA flow minus the line's MVA limit.  

Number of Binding Lines 

Total number of lines that are constrained to their limit value. 

Highest Line MVA Marginal Cost 

The highest Marginal Cost for an MVA change on a line. 

Number of Unenforceable Violations 

Total number of lines whose MVA flows can not be enforced by the OPF using the available 
controls.  

MVA Sum of Unenforceable Violations 

For all the unenforceable lines, this field contains the sum of the absolute values of the line's 
actual MVA flow minus the line's MVA limit.  

  

Interface MW Constraints 

The Interface MW Constraints field present results associated with the enforcement of the 
interface MW constraints. 

Number of Initial Violations, MW Sum of Initial Violations 

Total number of interfaces that initially exceeded their MW limits and were eligible for 
enforcement by the OPF. For these interfaces only, the MW Sum of Initial Violations 
field contains the sum of the absolute values of the interface's actual MW flow minus the 
interface's MW limit.  

Number of Binding Interfaces 

Total number of interfaces that are constrained to their limit value. 

Highest Interface MW Marginal Cost 

The highest Marginal Cost for an MVA change on an interface. 

Number of Unenforceable Violations 

Total number of interfaces whose MW flows can not be enforced by the OPF using the 
available controls.  

MW Sum of Unenforceable Violations 

For all the unenforceable interfaces, this field contains the sum of the absolute values of the 
interface's actual MW flow minus the interface's MW limit.  

Generator MW Control Limit Violations 

The Generator MW Control Limit Violations fields present results associated with the 
enforcement of the generator MW limit constraints. 

Number of Initial Violations, MW Sum of Initial Violations 
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Total number of generators that initially exceeded their MW limits and were eligible for 
enforcement by the OPF. For these generators only, the MW Sum of Initial Violations 
field contains the sum of the absolute values of the generators’ actual MW output minus the 
generators’ MW limits.  

Number of Unenforceable Violations 

Total number of generators whose MW limits can not be enforced by the OPF using the 
available controls.  

MW Sum of Unenforceable Violations 

For all the generators with unenforceable limits, this field contains the sum of the absolute 
values of the generators’ actual MW output minus the generators MW limits.  

  

Transformer Regulation Constraints 

The Transformer Regulation Constraints fields present results associated with the 
enforcement of phase shifting transformer regulation. 

Number of Initial Violations 

Total number of phase shifting transformers that initially exceeded their MW set point limits 
and were eligible for enforcement by the OPF.  

Number of Binding Constraints 

Total number of phase shifting transformers that are set at their minimum or maximum 
regulation value. 

Number of Unenforceable Violations 

Total number of phase shifting transformers whose MW regulation limits can not be 
enforced by the OPF using the available controls.  

Fast Start Generators 

The Fast Start Generators fields present results associated with the 
commitment/decommitment of fast start generators. 

Number of Generators Turned On 

Total number of fast start generators turned on during the OPF solution 

Number of Generators Turned Off 

Total number of fast start generators turned off during the OPF solution 
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OPF Options: All LP Variables 

  

The OPF Dialog, All LP Basic Variables page displays the basic and non-basic variables 
associated with the final LP solution. This page is usually only of interest to users interested in 
the specifics of the LP solution. Right click anywhere in the display to copy a portion or all of 
the display to the Window's clipboard, or to print the results.  
  

The display lists each of the LP variables, showing the following fields for each: 

ID 

Variable identifier. 

Original Value 

The initial value of the LP variable before OPF optimization. 

Value 

The final value of the LP variable after OPF optimization. 

Delta Value 

The difference between the original value field and the value field. 

BasicVar 

Shows the index of the basic variables in the LP basis. If the value is zero, the variable is 
non-basic. 

NonBasicVar 

Shows the index of the non-basic variable. If the value is zero, the variable is basic.  

Cost(Down) 

The cost associated with decreasing the LP variable. The field will also show if the variable is 
at its max or min limit. 

Cost(Up) 

The cost associated with increasing the LP variable. The field will also show if the variable is 
at its max or min limit. 

Down Range 

The available range to decrease the basic variable before a new constraint is hit.  

Up Range 

The available range to increase the basic variable before a new constraint is hit.  

Reduced Cost Up 

The cost reduction that would be experienced if an LP variable increases. If a constraint is at 
the limit, the field shows the change in cost of constraint enforcement.  

Reduced Cost Down 

The cost reduction that would be experienced if an LP variable decreases. If a constraint is 
at the limit, the field shows the change in cost of constraint enforcement.  

At Breakpoint? 

Yes, if the LP variable is at a break point. 
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OPF Options: LP Basic Variables 

  

The OPF Dialog, LP Basic Variables page displays the basic variables associated with the final 
LP solution. This page is usually only of interest to users interested in the specifics of the LP 
solution. Right click anywhere in the display to copy a portion or all of the display to the 
Window's clipboard, or to print the results.  

The display lists each of the basic variables, showing the following fields for each: 

ID 

Basic variable identifier. 

Original Value 

The initial value of the basic LP variable before the OPF optimization. 

Value 

The final value of the basic LP variable after the OPF optimization. 

Delta Value 

The difference between the original value field and the value of the basic variable. 

Basic Var 

Shows the indices of the basic variables in the LP basis.  

Cost(Up) 

The cost associated with increasing the basic variable.  

Down Range 

The available range to decrease the basic variable before a new constraint is hit.  

Up Range 

The available range to increase the basic variable before a new constraint is hit. 
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OPF Options: LP Basis Matrix 

  

The OPF Dialog, LP Basis Matrix page displays the basis matrix associated with the final LP 
solution. This page is usually only of interest to users interested in knowing the specifics of the 
LP solution. Knowing the basis matrix can be helpful in figuring out why a particular power 
system is exhibiting a particular behavior. The rows of the basis matrix are the binding 
constraints, while the columns of the basis matrix are the basic variables. The entries in the 
basis matrix then give the sensitivity of each constraint to each of the basic variables. The 
width of the columns in the matrix can also be adjusted using the Column Widths field. 
Finally, you can right-click anywhere in the matrix to copy the matrix to the Window's 
clipboard or to print the matrix. 
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OPF Options: Bus MW Marginal Price Details 

  

The Bus MW Marginal Price Details page displays a grid containing the MW marginal prices 
computed for an OPF solution. If no OPF solution has been run, the values will all be zero. The 
grid used for displaying the information is a Case Information Display, which can be modified, 
sorted, printed, etc., as described in the discussion of Case Information Displays. 

One key feature of this display is the breakdown in the bus MW marginal cost into three 
components: the cost of energy, the cost of congestion, and the cost of losses. Also, while the 
bus MW marginal cost does not change based on the reference, the costs of energy, 
congestion, and losses are reference dependent. This reference is set on a per-area (or per-
super area) basis in the Area information dialog OPF tab (or the Super Area information dialog 
OPF tab). 
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OPF Options: Bus MVAR Marginal Price Details 

  

The Bus MVAR Marginal Price Details page displays a grid containing the MVAR marginal prices 
computed for an OPF solution. If no OPF solution has been run, or if the option to compute 
MVAR marginal prices has not been selected, the values will all be zero. The grid used for 
displaying the information is a Case Information Display, which can be modified, sorted, 
printed, etc., as described in the discussion of Case Information Displays. 
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OPF Options: Bus Marginal Controls 

  

This display shows the sensitivities of the controls with respect to the cost at each bus. A 
change in a system control will have the indicated effect in the marginal cost at the system 
buses. Vice-versa, the marginal cost at a bus is affected by changes in the value of the basic 
variables. 
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OPF Options: Inverse of LP Basis 

  

The OPF Dialog, LP Basis Matrix page displays the inverse of the basis matrix. The width of the 
columns in the matrix can also be adjusted using the Column Widths field. Finally, right-click 
somewhere in the matrix to copy the matrix to the Window's clipboard or to print the matrix. 
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OPF Area Records 

  

Displays OPF specific information about each area record in the case. To show this display 
select Optimal Power Flow > Results > Areas in the Model Explorer. The OPF Area 
Records Display is a class of Case Information Display and therefore can be used in a manner 
consistent with the other case information displays. Specific formatting options are available 
from the local menu, which can be accessed by right-clicking on any field in the display.  

By default the display contains the following fields: 

Number, Name 

Area’s number, between 1 and 999, and its alphanumeric identifier, eight characters 
maximum. 

AGC Status 

Area's automatic generation control status. This is the same field shown on the Area 
Records Display. The field indicates whether or not the area's generation is changing 
automatically to control the area interchange.  

To be included in the OPF, this field MUST be "OPF". The generation costs for areas that are 
on "OPF" control are included in the OPF objective function; otherwise they are not. Note 
that if the area is part of a super area that is on AGC control, this field value is ignored.  

Double-click on the field to toggle its value. 

XF Phase 

Specifies whether phase shifting transformers in the area are available as controls. If "Yes" 
then all transformers in the area which have their Automatic Control Active are available for 
control; the Automatic Control status for a transformer is set on the Line/Transformer 
Dialog. If "No" then no transformers in the area are available for control. 

Branch MVA 

Specifies whether or not the MVA limits should be enforced for transmission lines and 
transformers that have at least one terminal in this area. For a transmission line or 
transformer to be included Line/Transformer constraints must not be disabled on the OPF 
Options and Results Dialog, and the individual line/transformer must be enabled for 
enforcement on the OPF Line/Transformer MVA Constraints display.  

Interface MW 

Specifies whether or not the MW limits should be enforced for interfaces that have at least 
one element in this area. For an interface to be included Interface constraints must not be 
disabled on the OPF Options and Results Dialog, and the individual interfaces must be 
enabled for enforcement on the OPF Interface MW Constraints display. 

Load MW Dispatch 

Specifies whether or not the MW load demand in an area should be included as available for 
re-dispatch during an OPF solution. In order for loads to be included in OPF re-dispatch, 
each individual load within the area must be available for control, and have either a fixed 
cost benefit or a piecewise-linear cost benefit curve provided. 

DC Line MW Control 

Specifies whether or not DC line MW setpoints can be modified for DC lines that have at 
least one terminal in this area. 

Include Marg. Losses 
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Specifies whether or not marginal losses should be included for the area during the OPF 
solution. 

MW Marg. Cost Ave 

For an OPF solved case this field shows the average of the bus MW marginal costs for all the 
buses in the area. If there is no congestion then all of the marginal costs should be equal.  

MW Marg. Cost St.Dev., Min., Max. 

For an OPF solved case these fields show the standard deviation of the bus MW marginal 
costs for all the buses in the area, the minimum and the maximum bus MW marginal costs.  

Report Limits 

Specifies whether or not the kV limits should be reported. 

Report Min kV, Report Max kV 

Specifies the values for minimum and maximum kV levels to report. Defaults are 0 and 
9999. 
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OPF Bus Records 

  

Displays OPF specific information about each bus record with a valid area/zone/owner filter. 
To show this display select Optimal Power Flow > Results > Buses in the Model Explorer. 
The OPF Bus Records Display is a class of Case Information Display and therefore can be used 
in a manner consistent with the other case information displays. Specific formatting options 
are available from the local menu, which can be accessed by right-clicking on any field in the 
display. The columns can also be sorted by right-clicking on the heading of the field.  
  

By default the display contains the following fields 

Number, Name 

Bus’s number, between 1 and 2,147,483,647 (equals 2^31 minus 1), and its alphanumeric 
identifier.  

Area Name 

Name of the bus's area. 

MW Marg. Cost 

Marginal change in the objective function for a one MW change in the real power load at the 
bus.  

MVR Marg. Cost 

Marginal change in the objective function for a one Mvar change in the reactive load at the 
bus.  

Volt Marg. Cost 

Marginal change in the objective function for a 0.01 per unit change in the voltage setpoint 
for the bus. This field is only valid at bus’s whose terminal voltage is controlled by one or 
more generators.  

Note from the developers – this field is still under construction – do not use it yet. 
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OPF Generator Records 

  

Displays OPF specific information about each generator record with a valid area/zone/owner 
filter. To show this display select Optimal Power Flow > Results > Generator Records in 
the Model Explorer. The OPF Generator Records Display is a class of Case Information Display 
and therefore can be used in a manner consistent with the other case information displays. 
Specific formatting options are available from the local menu, which can be accessed by right-
clicking on any field in the display.  

By default the display contains the following fields: 

Number, Name 

Number and name of the bus to which the generator is attached. The display's local menu 
offers you the opportunity to view the Quick Power Flow List and the Bus View Display for 
this bus. You can also use the local men to view the generator's dialog.  

ID 

Alphanumeric ID used to distinguish multiple generators at the same bus. 

Area Name of Gen 

Name of the generator's area. 

AGC 

Designates whether the generator's real power output is governed by automatic generation 
control (AGC). If the AGC field is set to Yes the generator is on AGC in the standard power 
flow. When a generator is on AGC its real power output is varied automatically, provided the 
generator is part of an area or super area that is also on automatic control.  

In Simulator OPF the default operating mode is that only generators on AGC control are 
eligible to be OPF controls. In addition, the generator's area or super area must have AGC 
Status of "OPF". However in rare instances you may wish to always make a generator 
available for control or never make the generator available for control. This value is specified 
using OPF MW Control field. 

Fast Start 

Designates whether the generator is available as a Fast Start generator during the OPF 
solution process. Fast start generators are another type of control available to the Optimal 
Power Flow solution routine. The OPF routine can determine if a generator labeled as a fast 
start generator would be beneficial in reducing the overall system costs of generation 
dispatch. If a fast start generator is off-line, but could reduce the cost of the system, then 
the OPF routine will turn on the generator, and increase the generator's dispatch towards 
optimizing the system generating cost. Conversely, if a fast start generator is on-line, and 
the OPF routine determines that reducing the generator's output to 0 would reduce the total 
generation cost, then the OPF routine will shut off the generator. 

Generally speaking, the fast start options should only be used with units with zero Minimum 
MW limits.  Hence it is really aimed at hydro units, or small units which do not need a non-
zero minimum MW output for valid operation.  This requirement is needed because changing 
a unit's status is only valid in the OPF routine if it is determined that the unit should dispatch 
0 MW to optimize the generating costs of the system. 

OPF MW Control 

Designates whether the generator's real power output should be included as a control 
variable in the OPF. This field, which can be toggled, has three possible values: 

• "If AGCable" - Generator's control availability depends upon its AGC status. 
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• "Yes" - Generator is available as a control, regardless of its AGC status. 
• "No" - Generator is NOT available as a control, regardless of its AGC status.  

Note: in order to be a control the generator must also be in an area or super area on "OPF" 
control.  

Gen MW 

The real power output of the generator. 

Cost Shift $/MWh, Cost Multiplier 

The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Cost $/Hr 

The total cost of the generator, including the impact of the cost shift and cost multiplier. 

MW Marg. Cost 

Tells the marginal cost, in $ / MWhr, to supply one additional MW of load at this bus. If a 
generator is available as a control and is not at either its minimum or maximum limit or a 
cost model breakpoint, then the MW Marg. Cost field will be identical to the generator's 
current marginal cost. However the usual case is for the generator to be at either a limit or a 
cost model breakpoint so the usual situation is that the MW Marg. Cost field values IS NOT 
equal to the generator's marginal cost.  

IC for OPF 

Incremental cost of the generator at its current operating point. 

Initial MW 

The initial real power output of the generator at the beginning of the OPF solution. You can 
reset the case back to these values by selecting the LP OPF, Restore Previous Control 
Settings menu item. This menu item is only available following a successful OPF solution.  

Initial Cost 

The initial generator cost at the beginning of the OPF solution. 

Delta MW 

Change in the generator's real power output as a result of the OPF.  

Delta Cost 

Change in the generator's cost as a result of the OPF. 

Min MW, Max MW 

Minimum and maximum real power output of the generator.  

Cost Model 

The current cost model being used for the generator. The field value is either "Cubic", 
indicating that the generator's operating costs are being modeled using a cubic cost 
function, or "Piecewise Linear", indicating the operating costs are being modeled using a 
piecewise linear cost function. Toggle the field to change the model. Note that a generator 
may simultaneously have a cubic model and a piecewise linear model.  

Because the OPF uses a linear programming approach, the generator's operating costs are 
ALWAYS modeled using the piecewise linear model. Generators with an existing cubic cost 
model are either 1) ignored as OPF controls, or 2) have a piecewise linear cost model 
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automatically created from the cubic model, depending upon the values specified on the 
OPF Options and Results Dialog.  

# Cost Curve Points 

Shows the number of segments in the piecewise linear model. If no piecewise linear model 
exists then this field is zero; the generator's costs are being modeled using the cubic 
function. For such generators you can automatically setup a piecewise linear model simply 
by entering a non-zero value for the number of points. A piecewise linear model is created 
that matches as closely as possible the existing cubic model.  

Fuel Type 

Specifies the fuel type of the generator, if it is known; double-click to toggle through the 
options. Options are Unknown, Coal, Gas, Hydro, Hydro Pumped, Nuclear, Petroleum, Solar, 
Wind, and Other. 

Profit $/hr 

Shows the profit of the generator. Profit is calculated using this equation:  

Profit = (GenMW * MW Marg Cost ) – [ Evaluation of the Generator Cost Function ] 
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OPF Interface Records 

  

Displays OPF specific information about the interface records in the case. To show select 
Optimal Power Flow > Results > Interfaces from the Model Explorer. This display is 
actually a page of a display showing all the potential inequality constraints in the power 
system. The top portion of the display repeats the fields shown on the Constraint Options 
page of the OPF Options and Results dialog.  

To view the Interface records click on the Interfaces tab. This displays the interfaces page 
which is a class of Case Information Display and therefore can be used in a manner consistent 
with the other case information displays. Specific formatting options are available from the 
local menu, which can be accessed by right-clicking on any field in the page.  

By default the Interface Records page contains the following fields: 

Name 

Name of the interface. 

Monitor 

Specifies whether or not the interface MW limit is enforced in the OPF solution. 

Interface MW 

The amount of MW flow on the interface. 

MW Limit 

The interface MW limit. 

Percent 

The amount of MW flow on the interface as a percentage of the limit. 

Monitor Direction 

The direction on the interface in which the flow is being monitored. 

Monitor Both Directions 

If set to YES, then the interface flow will be monitored in both directions. Otherwise, it will 
only be monitored in the Monitor Direction. 

MW Marg. Cost $ / MWh 

The marginal cost of enforcing the limit on the interface. 

Constraint Status 

This field will be set to Binding if the interface limit is a binding constraint in the OPF 
solution, or Unenforceable if the interface limit is unenforceable with the available control 
set. 
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OPF Nomogram Records 

  

This list displays OPF specific information about the nomogram records in the case. To show 
the list, select Optimal Power Flow > Results > Nomograms in the Model Explorer. This 
display is actually a page of a display showing all the potential inequality constraints in the 
power system. The top portion of the display repeats the fields shown on the Constraint 
Options page of the OPF Options and Results dialog.  

To view the nomogram records click on the Nomogram Interfaces tab. This displays the 
nomogram interfaces page which is a class of Case Information Display and therefore can be 
used in a manner consistent with the other case information displays. Specific formatting 
options are available from the local menu, which can be accessed by right-clicking on any field 
in the page. 

By default the Interface Records page contains the following fields: 

Nomo. Name 

Name of the nomogram. 

Nomo. Seg. 

The segment of the nomogram. Each segment of the nomogram is treated as a separate 
constraint in the OPF, and therefore is listed individually in the OPF nomogram table. 

Monitor 

This field will be set to YES if the nomogram segment is monitored during the OPF. 

Interface MW Flow 

The total MW flow for the segment of the nomogram. 

MW Limit 

The segment MW limit. 

Percent 

The amount of MW flow on the segment as a percentage of the segment’s limit. 

Monitor Direction 

The direction on the segment in which the flow is being monitored. 

Monitor Both Directions 

Yes or No field indicating if both directions should be monitored at the same time. 

MW Marg. Cost $ / MWh 

The marginal cost of enforcing the limit on the segment. 

Constraint 

This field will be set to Binding if the nomogram limit is a binding constraint in the OPF 
solution, or Unenforceable if the nomogram limit is unenforceable with the available control 
set. 
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OPF Line/Transformer Records 

  

Displays OPF specific information about the line and transformer records in the case. To show 
the display select Optimal Power Flow > Results > Branches in the Model Explorer. This 
display is actually a page of a display showing all the potential inequality constraints in the 
power system. The top portion of the display repeats the fields shown on the Constraint 
Options page of the OPF Options and Results dialog. 

To view the Line and Transformer records click on the Line/Transformers tab. This displays the 
Line/Transformer page which is a class of Case Information Display and therefore can be used 
in a manner consistent with the other case information displays. Specific formatting options 
are available from the local menu, which can be accessed by right-clicking on any field in the 
display.  

By default the display contains the following fields: 

From Number, From Name, From Area Name 

Number, Name, and Area Name of the From bus. 

To Number, To Name, To Area Name 

Number, Name, and Area Name of the To bus. 

Circuit 

Circuit identifier for the branch. 

Monitor 

Specifies whether or not the branch's MVA limit will be enforced in the OPF solution. 

Max MVA 

The maximum MVA flow on the branch. Value is determined based on the end of the branch 
with the higher MVA flow. 

% of MVA Limit (Max) 

The maximum MVA flow as a percentage of the branch MVA limit. Value is determined 
based on the end of the branch with the higher MVA flow. 

Lim MVA 

The MVA limit for the branch. 

MVA Marg. Cost ($/MVAhr) 

The marginal cost of changing the MVA flow on the branch (i.e., if the line rating were to 
increase by 1 MVA, what savings could be had). 

Constraint 

This field will be set to Binding if the branch limit is a binding constraint in the OPF solution, 
or Unenforceable if the branch limit is unenforceable with the available control set. 
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OPF DC Lines Records 

  

Displays OPF specific information about the DC lines in the case. To show select Optimal 
Power Flow > Results > DC Lines in the Model Explorer. This display is a class of Case 
Information Display and therefore can be used in a manner consistent with the other case 
information displays. Specific formatting options are available from the local menu, which can 
be accessed by right-clicking on any field in the display.  

By default the display contains the same fields as the normal DC Line Records case 
information display, with the following additional fields: 

OPF Control 

Set to YES if the DC line is to be controlled during the OPF. To be controlled, at least one of 
the terminals of the DC line must lie in an area that is on OPF control and this must be set 
to YES.  

Min MW or amps, Max MW or amps 

The minimum and maximum power (or current) setpoints allowed for the DC line. 
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OPF Load Records 

  

Displays OPF specific information about each load record with a valid area/zone/owner filter. 
To show this display select Optimal Power Flow > Results > Loads in the Model Explorer. 
The OPF Load Records Display is a class of Case Information Display and therefore can be 
used in a manner consistent with the other case information displays. Specific formatting 
options are available from the local menu, which can be accessed by right-clicking on any field 
in the display.  

By default the display contains the following fields: 

Number, Name 

Number and name of the bus to which the load is attached. The display's local menu offers 
you the opportunity to view the Quick Power Flow List and the Bus View Display for this bus. 
You can also use the local menu to view the generator's dialog.  

ID 

Alphanumeric ID used to distinguish multiple loads at the same bus. 

Area Name of Load 

Name of the load’s area. 

AGC 

Designates whether the load’s real power demand is governed by automatic generation 
control (AGC). If the AGC field is set to Yes the load is on AGC in the standard power flow. 
When a load is on AGC its real power output is varied automatically during an OPF or SCOPF 
solution ONLY, provided the load is part of an area or super area that is also on OPF control. 
Loads will not be dispatched if the area is on some other form of AGC control. 

In Simulator OPF the default operating mode is that only loads on AGC control are eligible to 
be OPF controls. In addition, the load’s area or super area must have AGC Status of "OPF", 
and the area must have its Load MW Dispatch set to YES. 

MW 

The real power output of the load. 

Cost Shift $/MWh, Cost Multiplier 

The cost shift and cost multiplier allow you to easily apply a shift to the cost function for the 
purpose of assessing how variations in bids impact profit. The cost function is affected 
based on the following equation: 

(Original Cost Function + Cost Shift) * Cost Multiplier 

Hourly Benefit 

The total benefit of the load, including the impact of the cost shift and cost multiplier. 

MW Marg. Cost 

Tells the marginal cost, in $ / MWhr, to reduce one additional MW of load at this bus. If a 
load is available as a control and is not at either its minimum or maximum limit or a cost 
model breakpoint, then the MW Marg. Cost field will be identical to the load’s current 
marginal cost. However the usual case is for the load to be at either a limit or a cost model 
breakpoint so the usual situation is that the MW Marg. Cost field value IS NOT equal to the 
load’s marginal cost.  

Inc. Benefit 

Incremental benefit of the load at it’s current operating point. 
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Initial MW 

The initial real power demand of the load at the beginning of the OPF solution.  

Initial Cost 

The initial load cost at the beginning of the OPF solution. 

Delta MW 

Change in the load's real power output as a result of the OPF.  

Delta Cost 

Change in the load's cost as a result of the OPF. 

Min MW, Max MW 

Minimum and maximum real power demand of the load.  

# of Benefit Curve Points 

Shows the number of segments in the piecewise linear model. If no piecewise linear model 
exists then this field is zero.  

Profit $/hr 

Shows the profit of the load. 
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OPF Super Area Records 

  

Displays OPF specific information about each super area record in the case. To show this 
display select Optimal Power Flow > Results > Super Areas in the Model Explorer. The 
OPF Super Area Records Display is a class of Case Information Display and therefore can be 
used in a manner consistent with the other case information displays. Specific formatting 
options are available from the local menu, which can be accessed by right-clicking on any field 
in the display.  

By default the display contains the following fields: 

Super Area 

Alpha-numeric identifier of the super area.  

AGC Status 

Super area's automatic generation control status. This is the same field shown on the Super 
Area Records display. The field indicates whether or not the super area's generation is 
changing automatically to control the super area's interchange. 

The super area AGC Status field always overrides the AGC Status for the individual areas, 
except when it is set to "Off AGC".  

To be included in the OPF this field MUST be "OPF". In that case the generation costs for all 
the areas in the super area are included in the OPF objective function. Otherwise they are 
only included if the super area AGC Status is "Off AGC" and their particular area's AGC 
Status is on "OPF". Double-click on the field to toggle its value.  

Num Areas 

Number of areas in the super area. To see the individual areas use the local menu to view 
the Super Area dialog.  

Include Marg. Losses 

Specifies whether or not to include marginal losses in OPF calculations for this super area. 

MW Marg. Cost Ave. 

If the super area is on "OPF" control then for a solved case this field shows the average of 
the bus MW marginal costs for all the buses in the super area. If there is no congestion then 
all of the marginal costs should be equal. 

MW Marg. Cost St. Dev. 

Standard deviation of the bus MW marginal costs for the buses in the super area.  

ACE MW 

Area control error for the super area. 

Gen MW, Load MW 

Total real power generation and load in the super area.  

Total Sched MW, Int MW 

Scheduled and actual interchange real power interchange between the super area and the 
rest of the system. Both of these fields are the algebraic summation of the scheduled and 
actual interchange for the areas in the super area.  

Loss MW 

Total real power losses for the super area.  
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MW Marg. Cost Min, MW Marg. Cost Max 

Minimum and maximum of all the bus MW marginal costs for the buses in the super area.  
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OPF Controls 

  

The following classes of controls are available during the OPF solution. Note, individual classes 
of controls can be enabled/disabled for the entire case using the OPF Options and Results 
dialog and for particular areas using the OPF Area Records display. Also, all classes of controls 
have associated minimum/maximum limits which are always enforced.  

Generator MW output and Fast Start commitment 

The generator MW outputs are the major control for controlling the MW flow in the network 
and for minimizing the objective function. Only generators in areas or super areas that are 
on "OPF" control are eligible for control; otherwise the generator's MW output remains fixed 
at its initial value. Whether a particular generator is available for control also depends upon 
the status of its AGC and OPF MW Control fields. These fields are set on the OPF Generator 
Records display. For Fast Start Generators, it is also possible to use the startup and 
shutdown of these generators as a control. See OPF Options: Control Options for more 
details. 

Phase shifting Transformer tap position 

Phase shifting transformers are used primarily to control the flow of real power in the 
network. When phase shifting transformers are controlled in the OPF routine, the phase 
angle is allowed to move anywhere within the phase angle range of the device in order to 
help alleviate violations on other branches in the system. The flow on the phase shifter is 
allowed to violate the prescribed MW range given for the phase shifter, but is NOT allowed 
to violate the MVA rating of the device. 

Additionally, in order for a phase shifter to be included in the OPF solution dispatch, the XF 
Phase property of the area must be set to YES. Each individual phase shifter also has a 
property for being included in the OPF control that must be turned on in order for the phase 
shifter to participate in the OPF dispatch. This option can be set for a phase shifting 
transformer by opening its Information Dialog and checking the OPF Phase Shifter Control 
options on the OPF page of the dialog. 

Load MW Dispatch 

The load MW demands can also be included as controls for re-dispatch during an OPF 
solution. The concept of controlling a load is generally the same as controlling a generator. 
Loads can be assigned piecewise linear benefit curves, and included in the OPF dispatch 
algorithm. Only areas whose AGC control is set to "OPF" are eligible for control. 
Furthermore, the OPF area’s Load MW Dispatch property must also be set to YES. Each area 
load that is to be included for OPF dispatch must have a benefit model defined, and have its 
Available for AGC field set to YES. These fields can be set in the OPF Load Records display. 

DC Line MW setpoint 

DC Line MW setpoints can be used as controls in the OPF. See OPF DC Lines Records. 
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OPF Phase Shifter Records 

  

Displays OPF specific information about each phase shifter record in the case. To show this 
display, select Optimal Power Flow > Results > Phase Shifters in the Model Explorer. 
The OPF Phase Shifter Records display is a class of Case Information Display and therefore 
can be used in a manner consistent with the other case information displays. Specific 
formatting options are available from the local menu, which can be accessed by right-clicking 
on any field in the display. The columns can also be sorted by right-clicking on the heading of 
the field.  

By default the display contains the following fields: 

From Number, From Name 

The name and number of the bus at the From end of the phase shifter. 

To Number, To Name 

The name and number of the bus at the To end of the phase shifter. 

Circuit 

The circuit identifier for the phase shifter. 

OPF Control 

Specifies whether or not the phase shifter is available for control during an OPF solution. 

Area PS Control 

Specifies if automatic phase shifter control has been enabled for the area containing the 
particular phase shifting transformer. If the area phase shifter control is disabled, all phase 
shifting transformers within the area will remain fixed at their initial settings during the 
entirety of the OPF solution process. This setting overrides the individual automatic control 
settings of each phase shifting transformer within the area. 

XF Auto 

Specifies if the transformer automatic control is enabled. If an individual transformer's 
automatic control is disabled, it will remain at it's initial settings during the entirety of the 
OPF solution process. 

Phase (Deg) 

The actual phase shift of the phase shifter, in degrees. 

Initial Degrees 

The initial phase angle before the OPF solution was calculated. 

Delta Degrees 

The change in the phase angle during the OPF solution. 

Tap Min, Tap Max 

The minimum and maximum tap positions allowed for the phase shifter operation. 
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OPF Example - Introduction 

  

As a simple example of using the OPF, consider the seven bus, three area system contained in 
the file B7OPF.pwb (included with the PowerWorld Simulator). For this case all three areas are 
initially on Economic Dispatch (ED) AGC control and hence by default would not be included in 
the OPF solution. Also, the initial interchange between the areas is equal to zero and the 
generators are modeled using cubic cost functions.  

To initially solve the case using the standard power flow, select Single Solution in the 
Power Flow Tools ribbon group on the Tools ribbon tab. The case should look like the 
following figure: 
  

 
B7OPF Case Solved using Economic Dispatch  

  

Now we'll modify the case to set the three areas for OPF control. To do this, select Optimal 
Power Flow > Results > Areas in the Model Explorer to display the OPF Area Records 
display. Toggle the AGC status for each of the three areas to change it to "OPF". Now select 
Primal LP in the OPF ribbon group on the Add Ons ribbon tab to solve the case using the LP 
OPF. The results should look similar to the figure below. The one-line shows the hourly cost 
for each area and the total case hourly cost, equal to $ 16,888 / hr. 
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B7OPF Case Solved using LP OPF 

  

Note that the results are very similar but not identical to the economic dispatch case. We 
would expect the cases to be similar since for cases with no congestion the OPF solution 
should be (ideally) equal to the economic dispatch solution. The difference between the two is 
because in the LP OPF the generator cost functions are converted from a cubic model to a 
piece-wise linear model using a user specified number of segments, which is 5 segments by 
default. This value can be viewed/modified from the Control Options page of the OPF Options 
and Results display.  

Change the Total Points Per Cost Curve field to 100 and resolve. The results are shown in 
the figure below, which now are almost identical to the economic dispatch results. The 
disadvantage in using a large number of cost segments is that it degrades the performance of 
the LP OPF slightly on larger cases. 
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B7OPF Case Solved using LP OPF with 100 Cost Segments for Generators 
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OPF Example - Marginal Costs 

  

Using the OPF solution from the previous page, select Optimal Power Flow > Results > 
Buses in the Model Explorer to view the bus marginal costs and Optimal Power Flow > 
Results > Areas in the Model Explorer to view the area marginal costs. The results should be 
as shown below.  
  

 
Seven Bus Case Bus Marginal Costs 

  

 
Seven Bus Case Area Marginal Costs 

Note that the marginal costs for all the buses in an area are identical to the area's MW 
marginal cost. This is the expected result for systems without any line congestion. The area 
MW marginal costs are not identical. This is because currently each area is independently 
enforcing its own MW interchange. In the next example we'll jointly dispatch the three areas 
by combining them into a single super area.  
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OPF Example - Super Areas 

  

To jointly dispatch the three areas we'll first combine them into a single super area. To setup 
the super area first select Optimal Power Flow > Results > Super Areas from the Model 
Explorer to display the OPF Super Area Records display (alternatively you could also use the 
Aggregations > Super Areas display). To enter a new super area, right click on the "None 
Defined" entry in the first row of the display to show the display's local menu. Select Insert. 
This displays the super area dialog. Select Rename and enter a name for the new super area, 
"ThreeAreas." To add the three areas to the new super area enter "1-3" in the New Area #'s 
field and then select Add New Areas by Number (alternatively you could select the areas 
from the New Area Name list). Also, to enable the super area for control, set the Super 
Area Control Options field (AGC Status) to Optimal Power Flow Control. Select the Ok 
button to save the new super area. 

Before resolving the OPF, let’s temporarily disable enforcement of line MVA constraints. You 
can do this from the Constraint Options page of the OPF Options and Results dialog. Check the 
Disable Line/Transformer MVA Limit Enforcement. 
Also, now would be a good time to save the changes. To avoid overwriting the existing B7OPF 
file, select Save Case As from the Application button to save the case (pwb and pwd files) 
with a different name, say B7OPFSA (SA for super area).   
Select Primal LP from the OPF ribbon group on the Add Ons ribbon tab to resolve the OPF. 
The results should be as shown below.  

 
OPF Solution with Super Area WITHOUT Enforcing Line MVA Constraints 

With the super area the individual area interchange constraints are no longer enforced. This 
permits the free interchange of power between the areas, resulting in an overall decrease in 
the total case hourly cost from $ 16,887 / hr to $ 16,227 / hr. View the OPF Bus Records 
display to verify that all the bus marginal costs are identical, equal to $ 17.10 / MWh. Of 
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course the key problem with solving the system using the super area is that now there are line 
violations. These violations will be removed next by enforcing the line MVA constraints.  
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OPF Example - Enforcing Line MVA Constraints 

  

To remove the line MVA violations go back to the Constraint Options Page of the OPF Options 
and Results dialog. Uncheck the Disable Line/Transformer MVA Limit Enforcement. 
Now resolve the LP OPF, enforcing the line constraints. The resultant solution is shown below.  

 
OPF Solution with Super Area WITH Line MVA Constraint Enforcement 

With line constraint enforcement active the OPF optimally redispatches the generation taking 
into account the line MVA limits. However, enforcing these line constraints comes at a cost. 
Notice that the total case hourly cost has increased from $ 16,227 / hr to $ 16,548 / hr, which 
is still substantially less than the $ 16,887 / hr figure we had for the case without the 
superarea. 

Enforcing the line constraints also has an impact on the bus marginal costs, shown below.  

 
Impact of Line MVA Enforcement on the Bus Marginal Costs 
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The actual marginal cost of enforcing the line constraint can also be viewed on the OPF 
Line/Transformer MVA Records display. The MVA Marg. Cost tells the marginal cost of 
enforcing the constraint, expressed in units of $ / MVA / hr. Left-click on the MVA Marg Cost 
field header to sort the display using this field.  
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Security Constrained Optimal Power Flow Overview 

  

Note: The SCOPF option in PowerWorld Simulator is only available if you have 
purchased the SCOPF and OPF add-ons to the base package. To learn more about 
the SCOPF, please feel free to read through the information contained in these help 
files. Contact PowerWorld Corporation for details about ordering the SCOPF and 
OPF versions of Simulator. 

The optimal power flow (OPF) algorithm has the purpose of minimizing an objective function 
(usually total operation cost) by changing different system controls while meeting power 
balance constraints and enforcing base case operating limits. Normally however, the secure 
operation of a power system requires that there be no unmanageable contingency violations. 
Thus, the minimization of the objective function requires considering contingencies. This is 
achieved using a security constrained optimal power flow (SCOPF) algorithm.  

While the optimal power flow (OPF) algorithm determines the optimal state of the system by 
iterating between solving a power flow and solving a linear program that changes the system 
controls, during the SCOPF solution process in addition to solving the base case power flow, all 
contingencies must also be solved. The linear program which then runs changes the system 
controls to remove contingency violations as well as base case operating violations.  

The SCOPF algorithm makes control adjustments to the base case (pre-contingency condition) 
to prevent violations in the post-contingency conditions. If enough controls are available in the 
system, the solution minimizes the objective function and the system enforces contingency 
violations. If the system does not have enough controls, then some violations may be 
persistent under certain contingencies. Those represent unenforceable constraints, which 
result in high bus marginal costs.  

The commands and options for the SCOPF are accessed by selecting the SCOPF option from 
the OPF ribbon group on the Add Ons ribbon tab. The SCOPF function uses the OPF options 
defined in the OPF Options and Results dialog and the contingency settings specified in the 
contingency analysis dialog. Please read through the OPF and the contingency analysis help 
for more information about these settings. We encourage you to become familiar with 
Simulator OPF and the contingency analysis tool before running SCOPF simulations. Other 
commands in the SCOPF dialog are used to specify the base case solution process and for 
accessing the SCOPF results. 
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SCOPF Objective Function 

  

The SCOPF objective function uses the function defined in the OPF settings. There are two 
objective functions in Simulator: Minimum Cost and Minimum Control Change. Minimum Cost 
attempts to minimize the sum of the total generation costs in specified areas or super areas. 
Minimum Control Change attempts to minimize the sum of the absolute value of the change in 
the generation in the specified areas or super areas. The objective function is set up in the 
OPF Options and Results dialog. 

The result of the SCOPF will be different from the OPF solution because the SCOPF meets 
additional inequality constraints associated with the contingency violations. 
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SCOPF Dialog 

  

The SCOPF dialog allows the user to control options of Security Constrained OPF, as well as to 
access the optimization results. 

The SCOPF can be run from this dialog using the Run Full Security Constrained OPF 
button at the top of the form. 

There are three pages of information included in this form: 

Options 

Results 

LP Solution Details 
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SCOPF Solution Process 

  

The SCOPF involves three major steps that can be solved either automatically or manually 
from the SCOPF control dialog:  
• Initialization to setup the SCOPF LP tableau and the control structures 
• Contingency analysis calculation and storage of control sensitivities associated with each 

contingency violation 
• SCOPF iterations, which include an LP solution and a power flow solution. During each LP 

step in the LP routine, the algorithm enforces the newest most severe contingency 
violation. After each violation is processed, all of the unprocessed violations are updated. 
This step is crucial since often resolving the most severe violation resolves numerous other 
violations. For instance, a single line might be overloaded in a number of contingencies: 
fixing the worst contingency fixes the others as well. On the other hand, processing some 
violations may result in new violations. In order to verify that no new violations have been 
created by the control changes made, the SCOPF will go back to step two and reprocess 
all the contingencies and the new base solution. The number of times this iteration occurs 
is determined by the Maximum Number of Outer Loop Iterations. 

The SCOPF terminates when all the contingency violations have been processed. Note that the 
user can rerun the SCOPF by repeating the solution process if they want to verify the 
contingency violation enforcement at the new optimal operating point. 



PowerWorld Simulator Add-On Tools 
 
 

994 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

SCOPF Results 

  

The Results page of the Security Constrained Optimal Power Flow form provides information 
on the results of the latest SCOPF solution, including the contingency violations included, the 
marginal price details, and the marginal control details. 
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SCOPF Equality and Inequality Constraints 

  

Two general types of constraints are involved in the SCOPF solution: equality and inequality 
constraints. Equality constraints are constraints that have to be enforced. That is, they are 
always "binding". For example in the SCOPF, as well as in the OPF and in the power flow, the 
real and reactive power balance equations at system buses must always be satisfied (at least 
to within a user specified tolerance). In contrast, inequality constraints may or may not be 
binding. For example, a line MVA flow under a certain contingency may or may not be at its 
limit. 

The SCOPF problem is solved by iterating between a power flow solution and a contingency 
constrained LP solution, some of the constraints are enforced during the power flow solution 
and some constraints are enforced during the LP solution. The constraints enforced during the 
power flow are, for the most part, the constraints that are enforced during any power flow 
solution. These include the bus power balance equations, the generator voltage set point 
constraints, and the reactive power limits on the generators. What differentiates the SCOPF 
from a standard power flow and from the OPF are the constraints that are explicitly enforced 
by the LP solver. These include the following constraints: 

Equality Constraints 

Inequality Constraints 

 



PowerWorld Simulator Add-On Tools 
 
 

996 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

SCOPF Equality Constraints 

  

The SCOPF equality constraints are the same as the OPF equality constraints: Area MW 
interchange, bus MW and Mvar power balance, Generator voltage setpoint and super area MW 
interchange. 
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SCOPF Inequality Constraints 

  

The following classes of inequality constraints are enforced during the SCOPF solution.  

Generator real power limits 

Generator real power limits are enforced during the SCOPF LP solution.  

Generator reactive power limits  

Generator reactive power limits are enforced during the SCOPF LP solution.  

Interface MW Limits  

Interface MW limits are enforced during the SCOPF solution. Interfaces are used to 
represent the aggregate flow through a number of different devices. During the SCOPF the 
MW post-contingency flow through the interface is constrained to be less than or equal to a 
user specified percentage of its limit, provided the interface is active for enforcement. For an 
interface to be active for enforcement the following three conditions must be met: 

• Interface enforcement must not be disabled for the case. This field can be set from 
either the OPF Constraints Dailog or the OPF interfaces records. As default, the interface 
enforcement is not disabled. Note that interface flow is limited to a percent of its limit as 
specified by the interface's Limit Monitoring Settings. 

• Interface enforcement must be active for at least one of the interface's areas. Note, an 
interface is assumed to be in each area that contains at least one of its components. 
This field can be set from the OPF Area Records display. Note: the default is that 
interface enforcement is not active, so be sure to activate this if you want these 
constraints enforced. 

• Enforcement must be active for each individual interface. This field can be specified 
from the OPF interfaces records display or in the Limit Monitoring Settings dialog. The 
default is active. 

Each interface that is active for enforcement is modeled as an inequality constraint, which 
may be either binding or not binding. If the constraint is not binding then it does not impact 
the solution. If a constraint is binding then it has an associated marginal cost of contingency 
enforcement. When manually solving the SCOPF one can skip a contingency violation 
associated to the interface by setting the Include field of the SCOPF CTG Violations dialog to 
No.  

Transmission Line and Transformer (Branch) MVA Limits 

Transmission line and transformer (branch) MVA limits are enforced during the SCOPF 
solution. During the LP the post-contingency branch line flow is constrained to be less than 
or equal to a user specified percentage of its limit, provided the branch is active for 
enforcement. For a branch to be active for enforcement the following three conditions must 
be met: 

• Line/Transformer enforcement must not be disabled for the case. This field can be set 
from either the OPF constraints dialog or the OPF Line/Transformer Records display. The 
default is that case line/transformer enforcement is not disabled. Also note that the 
branch flow is limited to a percent of its limit as specified by the branch's Limit 
Monitoring Settings. 

• Branch enforcement must be active for the branch's area. Enforcement for tie-lines must 
be active for either area. This field can be set from the OPF Line/Transformer Records 
display. The default is that branch enforcement is not active, so be sure to activate this 
if you want these constraints enforced.  
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• Enforcement must be active for each individual branch. This field can be set from the 
OPF Line/Transformer Records display or in the Limit Monitoring Settings Dialog. The 
default is active. 

Each branch that is active for enforcement is modeled as an inequality constraint, which 
may be either binding or not binding under contingency conditions. If the constraint is not 
binding then it does not impact the solution. If a constraint is binding then it has an 
associated marginal cost of enforcing the contingency constraint, which is shown on the 
SCOPF Bus Marginal Price Details dialog. When manually solving the SCOPF one can skip a 
contingency violation associated to the branch by setting the Include field of the SCOPF CTG 
Violations dialog to No. 
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SCOPF Control 

  

The control dialog allows the user to manually or automatically run a SCOPF simulation and 
visualize the execution of the simulation. The SCOPF solution process involves three steps: 
base case solution and initialization, contingency analysis, and SCOPF iterations. 

Run Full Security Constrained OPF 

Press this button to run the three steps of the SCOPF solution automatically. The SCOPF will 
solve the base case using the selected method, will use the currently stored list of 
contingencies during the contingency analysis step, and will take the CA results and 
sensitivities to iterate in order to obtain the optimal solution that minimizes cost and 
enforces contingency violations.  

  

Options 

Maximum Number of Outer Loop Iterations 

Indicates the number of maximum outer loop iterations. The outer loop iterations 
determines how many times the contingency analysis will be re-run following a successful 
SCOPF dispatch. In this manner, Simulator will look for new violations that may occur due to 
the new generation dispatch.  

Consider Binding Contingent Violations from Last SCOPF Solution 

When checked, this option ensures that the contingent violations from the last SCOPF 
solution are included in the current SCOPF solution. This option is helpful in preventing the 
SCOPF from hunting between having a constraint binding in one solution, and resolving with 
it not binding in a later solution because it was previously remedied. This option should 
generally always be checked, unless the user is sure that the previous solution has no 
bearing on the current solution, such as having made major changes to the system since the 
previous solution. 

Initialize SCOPF with Previously Binding Constraints 

When checked, this option results in the SCOPF solution process starts with the exact same 
LP tableau from the last solution. This can make for fairly fast solutions (recognizing that the 
contingency analysis needs to be resolved) when the changes to the system are small. 
Simulator automatically uses this option when doing multiple outer loops of the SCOPF. This 
option allows the user to solve the outer loops (set the outer loop counter to 1) by 
repeatedly solving the SCOPF manually, potentially making modifications between solutions 
if desired. 

Set Solution as Contingency Analysis Reference Case 

Check this field to set the solution of the SCOPF as the contingency analysis reference. If the 
system has enough controls to remove all the contingency violations, a rerun of the 
contingency analysis using the SCOPF solution as the reference should report no branch 
violations. 

Maximum Number of Contingency Violations Allow Per Element 

Specify the maximum number of contingency violations that the SCOPF analysis should allow 
per element. After completing the power flow solutions for the base case and the 
contingencies, only this number of contingency violations per element are then passed to 
the linear programming algorithm. The assumption is that if you fix the 10 worst 
contingency violations for an element then the others will also be fixed. 

Basecase Solution Method  
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Specifies whether the solution of the base case is performed using the power flow algorithm 
or the optimal power flow algorithm. The selection will affect the initial conditions of the 
system and consequently the contingency analysis results and the sensitivities used by the 
LP solver. Currently the SCOPF does not resolve the contingency analysis during the 
optimization since this is computationally expensive. See the SCOPF solution process for 
details. 

Handling of Contingent Violations Due to Radial Load 

It is often common when computing a security constrained OPF to have violations occur on 
branches due to radial load. In these instances, there is no way to adjust controls to 
continue to serve the load, without overloading the serving element. Therefore you can 
choose how contingent violations of this type should be handled by the SCOPF. You can 
choose to flag them but not include them in the SCOPF, ignore them completely, or include 
the violations in the SCOPF. Note that if you include the violations in the SCOPF, the SCOPF 
algorithm will not be able to remove the violation on the element via generation dispatch. 
However, it may be able to do so if the load in question has a load benefit curve defined and 
is available for load shed dispatch in the SCOPF routine. 

DC SCOPF Options 

The DC options given for the SCOPF revolve around the treatment of Line Outage 
Distribution Factors (LODF) during the DC SCOPF solution. You can choose to discard the 
LODFs when the SCOPF is finished, store them in memory (lost when Simulator is closed,) 
or in memory and in the PWB file (if saved.) 

If the LODFs have been stored and you wish to clear them (they can require quite a bit of 
RAM depending on the number of contingencies and size of the case,) you can press the 
button labeled Clear Stored Contingency Analysis LODFs. 

SCOPF Results Summary 

Number of Outer Loop Iterations 

The number of outer loop iterations required to solve the SCOPF. 

Number of Contingent Violations 

Number of violations from the contingency analysis portion of the solution, which are used 
to attempt to determine the security constrained dispatch. 

SCOPF Start Time, SCOPF End Time 

Physical time when the SCOPF solution process started and finished. 

Total Solution Time (Seconds) 

Length of time needed to determine the SCOPF solution. 

Total LP Iterations 

Total number of Linear Programming iterations necessary to determine the SCOPF 
solution. 

Contingency Analysis Input 

Number of Active Contingencies 

The number of contingencies included in the SCOPF simulation. Specific contingencies 
may be excluded from the simulation in the contingency analysis dialog  by changing the 
skip field of a contingency to YES. The contingency analysis dialog can be conveniently 
accessed from the SCOPF control dialog. 

View Contingency Analysis Form 
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Clicking this button shows the contingency analysis dialog.  

Contingency Analysis Results  

This window allows the user to monitor the details of the contingency analysis step. During 
contingencies, the outage actions, the solution of each contingency, and the solution of the 
CA run are reported. 
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SCOPF CTG Violations 

  

The contingency violations page is available from the Results tab of the Security Constrained 
Optimal Power Flow form. The display lists the results from the latest contingency analysis run 
including the violations that were included in the SCOPF and the final error for each violation. 
This dialog may change if the user reruns the SCOPF by solving the contingency analysis using 
the SCOPF solution as contingency analysis reference. Right click any where in the display to 
copy a portion or all of the display to the Window's clipboard, or to print the results.  

The display shows the following fields: 

Contingency Name 

This is the contingency label. By default single line contingencies start with an "L", single 
generator outages with a "G", and single transformer outages start with an "X".  

Category 

Currently, the SCOPF considers only branch and interface violations. Thus, the category of 
the contingencies should be branch MVA or Interface. 

Element 

Shows information about the specific element that presented the violation. When the 
violation occurs in a branch, this column includes the identifiers of the sending and receiving 
ends of the branch, the circuit, and the direction of the violating flow. Since Interfaces are 
directed, this field will present only the interface name in the case of violating interfaces.  

Value 

The percentage flow that appears in the branch during the contingency prior to optimization. 
If this number is larger than the scaled limit, the violation needs to be removed. 

Scaled Limit 

The scaled limit corresponds to the Line/Transformer Percentage specified in the limit 
monitoring settings dialog. By specifying this limit to be higher than 100% some of the 
contingency violations might be effectively relaxed. Sometimes this helps the OPF and the 
SCOPF obtain a feasible solution. On the other hand, it is often required to analyze the 
performance of the system if branches would have higher ratings.  

New Value 

The percentage flow that appears in the branch during the contingency after SCOPF 
optimization. If this number is larger than the scaled limit, the contingency violation has not 
been removed and it is therefore unenforceable. If the value is equal to the scaled limit, 
then the contingency violation constraint would be binding. If the value is smaller than the 
scaled limit, the contingency violation has been removed. 

Error  

The difference between the new value and the scaled limit. If the error is positive, the line is 
unenforceable. If the error is zero, the constraint has been corrected.  

Included 

Indicates if the contingency violation was included as a constraint in the SCOPF solution. 

Marginal Cost 

Indicates the cost associated with the contingency violation. If the constraint is 
unenforceable, the marginal cost is assigned arbitrarily as a high value in the OPF constraint 
options  dialog.  
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Unenforceable 

Indicates whether the contingency violations is unenforceable, i.e., the system has not 
enough controls to relieve the branch overload when the contingency occurs. 

Skip Violation? 

Change this field to NO if the contingency violations should not be included as a SCOPF 
constraint. This is sometimes useful in order to analyze the effect of the contingency 
violation in the SCOPF solution. This field may be toggled when doing a manual SCOPF 
solution. 
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SCOPF LP Solution Details 

  

The LP Solution Details page of the Security Constrained Optimal Power Flow form provides 
information on the linear program solution of the SCOPF, including a list of All LP Variables, LP 
Basic Variables, and LP Basis Matrix. This information applies to the linear programming 
tableau solution method. 
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SCOPF All LP Variables 

  

The SCOPF All LP Variables dialog displays the basic and non-basic variables associated with 
the final LP SCOPF solution. Users interested in the specifics of the LP SCOPF can access this 
page to obtain internal information about the SCOPF solution. To see the display, open the 
Security Constrained Optimal Power Flow form, click on the LP Solution Details tab, and access 
the All LP Variables page. 

Right click any where in the display to copy a portion or all of the display to the Window's 
clipboard, or to print the results.  
  

The display lists each of the LP variables with the following fields: 

ID 

Variable identifier. 

Org. Value 

The initial value of the LP variable before SCOPF optimization. 

Value 

The final value of the LP variable after SCOPF optimization. 

Delta Value 

The difference between the original value field and the value field. 

Basic Var 

Shows the index of the basic variables in the LP basis. If the value is zero, the variable is 
non-basic. These values are set up after the SCOPF calculates the contingency violation 
sensitivities.  

NonBasicVar 

Shows the index of the non-basic variable. If the value is zero, the variable is basic.  

Cost(Down) 

The cost associated with decreasing the LP variable. The field will show if the variable is at 
its max or min limit. 

Cost(Up) 

The cost associated with increasing the LP variable. The field will show if the variable is at 
its max or min limit. 

Down Range 

The available range to decrease the basic variable before a new constraint is hit under a 
contingency condition.  

Up Range 

The available range to increase the basic variable before a new constraint is hit under a 
contingency condition.  

Reduced Cost Up 

The cost reduction that would be experimented if a LP variable increases. If a constraint is 
at the limit, the field shows the change in cost of constraint enforcement.  

Reduced Cost Down 
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The cost reduction that would be experimented if a LP variable decreases. If a constraint is 
at the limit, the field shows the change in cost of constraint enforcement.  

At Breakpoint 

Yes, if the LP variable is at a break point. 
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SCOPF LP Basic Variables 

  

The LP Basic Variables (from the SCOPF LP Solution Details page) displays the basic variables 
of the final LP solution. The basic variables may correspond to controls that can be altered to 
minimize the objective function, or slack variables associated with unenforceable constraints. 
Users interested in the specifics of the LP SCOPF can access this page to obtain internal 
information about the SCOPF solution. Right click any where in the display to copy a portion or 
all of the display to the Window's clipboard, or to print the results.  
  

The display lists each LP variable with the following fields: 

ID 

Basic variable identifier. 

Org. Value 

The initial value of the basic LP variable before the SCOPF optimization. 

Value 

The final value of the basic LP variable after the SCOPF optimization. 

Delta Value 

The difference between the original value field and the value of the basic variable. 

Basic Var 

Shows the indices of the basic variables in the LP basis.  

Cost(Up) 

The cost associated with increasing the basic variable.  

Down Range 

The available range to decrease the basic variable before a new constraint is hit under a 
contingency condition.  

Up Range 

The available range to increase the basic variable before a new constraint is hit under a 
contingency condition. 
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SCOPF LP Basis Matrix 

  

The LP Basis Matrix page of the SCOPF LP Solution Details tab displays the basis matrix 
associated with the final SCOPF LP solution. There is one row per constraint and one column 
per basic variable. Additional columns summarize information associated with each constraint. 
This page is usually only of interest to users interested in knowing the specifics of the SCOPF 
solution. Knowing the basis matrix can be helpful in figuring out why a particular SCOPF 
solution exhibits a certain behavior. The entries in the basis matrix give the sensitivity of each 
constraint to each of the basic variables.  

As any case info display in simulator, right click to see options to copy information to the 
clipboard and to perform standard windows actions, such as printing. 
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SCOPF Bus Marginal Price Details 

  

This display (from the SCOPF Results page) shows information about the components of the 
marginal cost at each bus. The display is relevant to see how the bus marginal cost depends 
on the cost of enforcing system constraints such as branch limits and area equality constraints. 
This display is useful for indicating which constraints are contributing towards the 
determination of the marginal price at each bus. 

As any case info display in Simulator this display can be customized and the information 
copied, printed, and saved by accessing the local menu option with the mouse right click. 

One key feature of this display is the breakdown in the bus MW marginal cost into three 
components: the cost of energy, the cost of congestion, and the cost of losses. Also, while the 
bus MW marginal cost does not change based on the reference, the costs of energy, 
congestion, and losses are reference dependent. This reference is set on a per-area (or per-
super area) basis in the Area information dialog OPF tab (or the Super Area information dialog 
OPF tab). 
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SCOPF Bus Marginal Controls 

  

This display (from the SCOPF Results page) shows the sensitivities of the controls with respect 
to the cost at each bus. A change in a system control will have the indicated effect in the 
marginal cost at the system buses. Vice-versa, the marginal cost at a bus is affected by 
changes in the value of the basic variables. 

The Marginal Controls page can be accessed by opening the Security Constrained Optimal 
Power Flow form, and clicking on the Results tab. 
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SCOPF Example: Introduction 

  

In this section we introduce an example of using the SCOPF. Consider the seven bus, three 
area system contained in the file B7SCOPF (included with the PowerWorld Simulator). This 
case is the same case used in the OPF example, except that the line from bus 2 to 3 has now 
a 100MVA rating, lines 1 to 2, 1 to 3 and 2 to 5 have a 120MVA rating, and all three areas are 
initially on OPF control. To initially solve the case using the optimal power flow, select Primal 
LP in the OPF ribbon group on the Add Ons ribbon tab. The solution obtained is shown below. 
The total case hourly cost is $16,011 / hr.  
  

 
B7SCOPF Case Solved using OPF  

  

We are interested in determining an optimal solution that meets security constraints under 
contingency conditions. In order to show that the current OPF solution does not enforce 
contingency violations, take line 1 to 2 out of service by clicking in a circuit breaker. Then 
solve the power flow by pressing the Single Solution button. The result indicates that line 1 
to 2 is overloaded 32%. The SCOPF algorithm will attempt to move the operating solution 
such that no contingency violation occurs in the system. Close line 1 to 2 back in service. 
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B7SCOPF Power Flow Solution with line 1-2 open 

  

The next step is to specify the contingency conditions that the system should withstand. In 
order to do that, we access the Contingency Analysis dialog under Tools. Note that we can 
also access this dialog from the SCOPF control dialog by selecting Add Ons > Security 
Constrained OPF and pressing the View Contingency Analysis Form button on the 
Options page. The B7SCOPF case does not have contingencies associated with it. Insert 
single line contingencies in the contingency list by pressing the Auto Insertbutton located at 
the bottom left of the Contingency Analysis dialog. in the Auto Insert Dialog select the option 
for Single Transmission Line or Transformerand select Numbers under the Identify 
buses by field. Select Do Insert Contingencies. This will prompt to insert 11 single line 
contingencies corresponding to all the lines in the system. Select Yes. You can now close the 
Contingency Analysis dialog.  

Return to the Security Constrained Optimal Power Flow Form.  You can set the SCOPF 
to use the OPF solution as the base by selecting Solve base case using optimal power 
flow.  

You can now solve the SCOPF by pressing the Run Full Security Constrained OPF. This will 
process the contingency violations and iteratively solve the LP program and the power flow 
equations to minimize the objective function and enforce equality and inequality constraints. 
The solution is shown below. The total operating cost is now $16,048 /hr. The increase in 
operating cost is due to enforcing security constraints. If a new contingency analysis is 
performed using the optimal solution as the reference, it will be found that no contingency 
violations occur for the contingencies in the list, i.e., branch flows are less than (or equal to) 
100% in the post contingency condition. Thus, the system meets all the specified constraints. 
You can analyze the SCOPF results by browsing the information in the SCOPF tabs. Note that 
the CTG Constraints dialog does not show unenforceable constraints, but the branch 
violation of line 2 to 5 due to the contingency 5 to 7 is now binding.  
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B7SCOPF Case Solved using SCOPF: The system now meets the contingency constraints. 
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SCOPF Example: Marginal Prices 

  

Using the SCOPF solution from the previous page, select the Bus Marginal Price Details 
from the Results page of the SCOPF Dialog to view the detail of the marginal price 
components. Note in the following Figure that each area constraint contributes equally to the 
marginal cost of the buses in that area. The binding inequality constraint from bus 2 to 5 
makes further contribution to the bus marginal price of buses in area Top.  

  

 
Seven Bus Case SCOPF Bus Marginal Price Details 
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SCOPF Example: Unenforceable Constraints 

  

Using the same example as above, reduce the MVA rating of line 2 to 5 to 90 MVA. The initial 
base case LP OPF solution is the same as in the previous example. Consider the same 
contingency list. When the contingencies are solved using the initial OPF solution as the 
reference, seven contingency violations need to be removed. The CTG dialog after simulation 
is presented in the following figure. 

  

 
CTG Dialog after SCOPF Solution 

  

We note that the constraint from bus 2 to 5 under a contingency from 5 to 7 is unenforceable. 
There are not enough system controls to enforce the contingency constraint. A $ 1,000 / hr 
cost is assigned to unenforceable constraints in this case. The cost of not enforcing constraints 
can be specified in the OPF Constraint Options Dialog. 
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Available Transfer Capability (ATC) Analysis 

  

The ATC Analysis tool is only available if you have purchased the ATC add-on to the 
base Simulator package. Contact PowerWorld Corporation for details about 
ordering the ATC version of Simulator. 
  

Available Transfer Capability (ATC) analysis determines the maximum incremental MW transfer 
possible between two parts of a power system without violating any specified limits. Most 
often, this transfer is between two areas in the system, but can be customized to specific 
groups of system devices.  
  

Simulator’s ATC analysis makes use of several tools that are available elsewhere in Simulator. 
These include: 
• Power Transfer Distribution Factors (PTDFs): determine the linear impact of a transfer (or 

changes in power injection) on the elements of the power system. 
• Line Outage Distribution Factors (LODFs): determine the linear impact of a line outage on 

the elements of the power system. 
• Contingency Analysis: studies the impact of a list of contingencies on the power system. 
• Limit Monitoring Settings: control which elements of the system are monitored for limit 

violations. 

You do not directly use these other tools when using Simulator’s ATC analysis tool, but 
Simulator uses the settings and algorithms in the background to determine ATC. Thus, it is 
helpful to be knowledgeable on their use, as it will help you in interpreting the results of an 
ATC analysis. 
  
• Simulator provides three methods of determining the ATC for a transfer direction. See : 

ATC Solution Methods 

For information on how to use the Simulator ATC tool, see Available Transfer Capability Dialog. 
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Available Transfer Capability Dialog 

  

The Available Transfer Capability Dialog provides an interface for performing and viewing the 
results of Available Transfer Capability Analysis. ATC analysis is typically only done on the 
present power system state or scenario (called Single Scenario ATC Analysis). Click here for 
information on performing multiple scenarios analysis. 

To open the ATC Dialog, go to the Add Ons ribbon tab and select Available Transfer 
Capability (ATC) from the ATC ribbon tab. The dialog opens to the Single Scenario ATC 
Analysis version with the Options tab, Common Options sub-tab visible.  

 
  

ATC Dialog 

  
The ATC Dialog is divided in three tabs: Options tab, Analysis tab, and Result tab. If Analyze 
Multiple Scenarios has been checked on the Advanced Options sub-tab of the Options tab, the 
layout of the ATC Dialog is slightly different—see Multiple Scenarios ATC Dialog. 

In addition, the following buttons can be used to save/load ATC analysis settings: 

Save/Load Settings 
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ATC Analysis settings can be saved by selecting Save Settings on the ATC dialog. This 
allows you to repeat the analysis without having to reconfigure the settings. Select Load 
Settings to retrieve previously saved settings. 
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ATC Dialog: Options Tab 

  

The Options Tab of the ATC Dialog is subdivided in four sub tabs: Common Options, Define 
Contingencies, Advanced Options, and Memo. They have the following controls: 
  

Common Options 

 
Seller Type, Buyer Type 

For the ATC Solution Method of Single Linear Step (SL), ATC can be calculated for transfers 
between combinations of areas, zones, super areas, injection groups, buses, or to the 
system slack bus. For the iterated linear step ATC Solution Methods (IL and IL then full 
contingency solution), ATC can be calculated for transfers between areas, super areas or 
injection groups only. Use the seller type and buyer type options to indicate the type of the 
selling and purchasing entities. 

Seller, Buyer 

These dropdown boxes allow you to select the selling and buying entities. The contents of 
each depend on the Seller/Buyer Types selected. Clicking the Find Seller and Find Buyer 
buttons allows you to use Simulator’s Advanced Search Engine to locate the desired entities. 

The Seller defines where power is injection into the system and the Buyer defines where 
power is taken out of the system. The transfer is simulated by increasing generation or 
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decreasing load in the Seller and decreasing generation or increasing load in the Buyer. The 
ATC Analysis Methods - Solution Methods go into greater detail about how the impact of the 
transfer is actually determined. When areas, zones, or super areas are selected to be either 
the Seller or Buyer, only on-line generators in the defined group that are on AGC control are 
allowed to participate in the transfer. Each generator participates in the transfer in 
proportion to its participation factor. When injection groups are selected to be either the 
Seller or Buyer, only on-line generators and loads defined with the injection group are 
allowed to participate in the transfer. Each element participates in the transfer in proportion 
to the participation factor defined with its participation point in the injection group. When a 
single bus is selected as the Seller or Buyer then all of the power injection change needed 
for the transfer comes from that bus. It does not matter if there is a generator or load at 
that bus. When the slack is selected for the Seller, then all of the power injection change 
needed for the seller side of the transfer comes from the island slack bus for the island in 
which the Buyer belongs. When the slack is selected as the Buyer, then all of the power 
injection change needed for the buyer side of the transfer comes from the island slack bus 
for the island in which the Seller belongs.  

Generator and load MW limits are not enforced regardless of the type of buyer and seller. 
Error messages will be displayed if the Seller and Buyer are not both completely contained 
within the same electrical island.  

Reverse Buyer/Seller Button 

Click this button to reverse the direction currently shown. The buyer becomes the seller, and 
the seller the buyer. 

Linear Calculation Method 

The ATC analysis tool can use either a Lossless DC or Lossless DC with Phase Shifters 
calculation method for obtaining the ATC results. 

If you select the Lossless DC option, branch flow sensitivity is calculated by estimating the 
real power that flows through the monitored element only from the difference in angles 
measured across its terminals. 

The Lossless DC with Phase Shifters method, a modification to the lossless dc 
approximation, takes into account phase shifter operation. It is especially useful when the 
ATC tool continually reports overloads on branches that obviously will not overload because 
of the operation of a phase shifting transformer. This method assumes that the phase shifter 
angles may change to any value to ensure that the line flow on those lines does not change. 

The Linearized AC method is not yet available. 

Enable Phase Shifters Post-Contingency 

This option becomes enabled when you choose the Lossless DC with Phase Shifters 
linear calculation method. It allows you to choose whether or not phase shifter control 
should be enforced during post-contingency ATC calculations. When this option is checked, 
it is assumed that phase shifter angles may change to keep the line flow from changing after 
the contingency has been applied. Otherwise, it is assumed that phase shifters only maintain 
the flow in the pre-contingency state and the angles do not change in the post-contingency 
state. Base case (pre-contingency) transfer limiters will still be determined with phase 
shifters enforced, regardless of the setting of this option when the Lossless DC with Phase 
Shifters option is checked.  

Include Contingencies Check Box 

Check this box to include contingencies (inserted or loaded using the Contingency Analysis 
Tool) in the ATC analysis. Note that minimizing the number of contingencies considered 
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greatly improves solution speed as well as computer memory requirements for doing ATC 
Analysis. Therefore, be careful in choosing which contingencies to use with the ATC tool. 

The ATC tool uses the same contingency records as the contingency analysis tool. 
Contingency results may be invalid following ATC analysis. If necessary, save contingency 
results to an auxiliary file prior to running the ATC analysis. 

Report Base Case Limitations Check Box 

When checked, the ATC tool will report transfer limitations from the base case (pre-
contingency). 

Report Generation Reserve Limitations Check Box 

When checked, the ATC tool will report transfer limitations from generation reserve.  

Generator and load MW limits are not enforced when calculating linear sensitivities used to 
determine the transfer MW limits. However, checking this option provides an indication of 
when power transfers are limited based on generator maximum or minimum MW limits or 
the amount of load that is on-line. When this option is checked and there are limitations to 
how much power can be transferred because of max/min generator limits or the on-line 
load, additional Transfer Limiters will be present in the results. The Limiting Element will 
indicate either the Buyer or Seller and the Transfer Limit in MW will be the amount of 
transfer that can be achieved before the Buyer or Seller exceeds some limitation to 
generation or load. When considering reserve limits for the Seller, generators will be 
included in the reserve limit by taking the difference between the generator maximum MW 
limit and the present output and loads will be included in the reserve limit by the present 
amount of on-line load. When considering reserve limits for the Buyer, generators will be 
included in the reserve limit by taking the difference between the present output of the 
generators and the minimum MW limit and loads will be included by an arbitrary value of 
9999.9 MW. Loads are included in this manner because maximum and minimum limits on 
loads are not currently used in the ATC tool. 

For example, assume than an area that currently has 200 MW on-line and a total maximum 
MW output of 250 MW for all on-line generators that are on AGC control is defined as the 
Seller. A 50 MW generation reserve limitation will be reported for this area. As another 
example, assume that an injection group currently has 50 MW of on-line generation with a 
total maximum MW output of 150 MW and 50 MW of on-line load is defined as the Seller. A 
150 MW reserve limitation will be reported for this injection group.  

No generation reserve limitations are reported when the seller or buyer type is a bus or the 
slack.  

If using one of the iterated methods, this option will be ignored except during the first single 
linear step. Reserve limitations may be reported from this step, but limitations of this type 
will not be iterated on during the individual iteration process. If choosing to enforce 
generator MW limits appropriately with the type of transactors that are defined, reserve 
limits will still be reported, regardless of this option setting, if they are hit during any step of 
the iterative process when ramping is occurring. See the detailed descriptions of either the 
Iterated Linear Step (IL) or Iterated Linear Step (IL) then Full CTG Solution method for more 
information about how reserve limits are checked during the iterated methods. 

Limit Monitoring Settings Button 

Click this button to open the Limit Monitoring Settings Dialog. Limiting Elements will only be 
reported for those elements that are selected to be monitored. Note that minimizing the 
number of monitored power system elements greatly improves solution speed as well as 
computer memory requirements for doing ATC Analysis. 

Transfer Result Reporting Options 
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The options in this section of the ATC dialog are discussed in detail in the topic on Transfer 
Result Reporting Options. 

  

Define Contingencies 

The Define Contingencies tab is similar to the Contingencies Tab of the 
Contingency Analysis Dialog. The user can insert, auto-insert, define and/or delete 
contingency records. See Contingency Analysis for detailed information on defining 
contingencies. 

  

Advanced Options 

 
ATC Solution Method 

One of the solution methods for determining the ATC of a specified transfer direction. 

Define Extra Monitors 

Simulator’s ATC tool determines the maximum amount of MW transfer between the seller 
and buyer. If you would like to also determine the flow on additional lines or interfaces at 
the transfer levels determined by the ATC tool, you can utilize Extra Monitors. Click the 
Define Extra Monitors button to open the ATC Extra Monitors Dialog. The flow on the 
extra monitors will be reported for each transfer limiter determined. 

Analyze Multiple Scenarios 
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Check Analyze Multiple Scenarios to perform ATC Analysis on several scenarios. See 
ATC Dialog for Multiple Scenarios for more information on Multiple Scenario Analysis. 

Model Reactive Power for Linear Methods By… 

The linearized methods used in the ATC tool are based only on the changes in real power 
MW in the system, thus an assumption needs to be made about the reaction of the Mvar 
flows during the linear calculations. The chosen assumption allows a MW limit to be 
calculated from the specified MVA limit for use in determining the ATC values. The choices 
are: 

• Ignoring reactive power – reactive power is completely ignored. The MW limit of a line 
is assumed to be the MVA limit of the line.  

• Assuming constant voltage magnitude – reactive power is adjusted to hold voltage 
magnitudes constant 

• Assuming reactive power does not change – reactive power is held at pre-ATC 
solution levels. The MW limit for each line is calculated from the MVA limit and the reactive 
power at the pre-ATC solution level. 

For Linear Methods, Allow Amp Limits by Assuming a Constant Voltage Magnitude 

If checked, Simulator will allow converting MVA limits to Amp limits by assuming constant 
voltage magnitudes based on the base case full AC load flow operating point just prior to the 
ATC linear calculations. This option will only be used if the Limit Monitoring Settings Option 
of Treat Line Limits as Equivalent Amps is checked. 

This option will cause the ATC tool to internally use a modified MVA limit which is equal to 
the user-specified MVA rating multiplied by the actual terminal voltages of the line. This 
results in a modified MVA rating which is higher than the user-specified MVA rating when the 
voltage on the line is higher than nominal and lower when the voltage is lower than 
nominal. For purposes of calculating the ATC values, a MW limit is determined from the MVA 
rating based on how this option is set and how the reactive power is modeled.  

Transfer Calculation Options 

Note: The Transfer Calculation Options section is disabled if the Single Linear Step Solution 
Method is selected. 

Transfer Tolerance 

This is the tolerance used during the Iterated Linear Step or (IL) then Full CTG Solution 
methods. The iterated methods will finish if the transfer step amount for the next 
iteration is less than this tolerance. The default is 10 MW. 

Max. Iterations 

This is the maximum number of iterations used in the Iterated Linear Step or (IL) then 
Full CTG Solution methods. The default is 10. 

When Iterating, Ignore Limiters below 

The iterated techniques perform additional analysis on individual transfer limitations in 
the order of increasing Transfer Limit in MW. When using one of the iterated techniques, 
transfer limitations with Transfer Limit values below a certain threshold can be ignored 
for the iterated portion of the process. Transfer limitations with Transfer Limit values 
equal to or below the value set with this option may still appear in the results, but they 
will not be iterated on individually.  

Once an individual limiter is being iterated on, this value will no longer be used. This 
means that during the individual iteration process, the transfer level for a limiter can fall 
below this threshold.  

Transfer Limiters to Iterate on 
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This is the number of transfer limiters to iterate on in the Iterated Linear Step or (IL) 
then Full CTG Solution methods. The default is 1. The transfer limiters actually iterated 
on are determined by selecting the number of limiters set in this option in ascending 
order of Transfer Limit with the Transfer Limit at or above the value set in the When 
Iterating, Ignore Limiters below option. 

Power Flow Solution Options 

This button brings up the Power Flow Solution Options Dialog. 

Injection Group Options 
This button brings up a dialog from which options associated with injection groups can 
be set. These are the same options that get set for injection groups when using Island-
based AGC and dispatching using an injection group; the ATC process switches to using 
an island-based AGC when iterating and using injection groups for the seller and buyer. 
The options that can be set are Island AGC Tolerance, Allow only AGC units to vary, 
Enforce unit MW limits, Do not allow negative loads, and how reactive power load should 
change as real power load is changed. 

Define Contingency Solution Options 
Click this button to open the Contingency Solution Options Dialog. 

Use Specific Solution Options for Contingencies 

When checked, the ATC tool will use the solution options defined by pressing the Define 
Contingency Solution Options button for contingency analysis. When not checked, all 
solutions will use the options defined by pressing the Power Flow Solution Options 
button. 

Force all transfer ramping to occur in pre-contingency states and repeat full CTG 
solutions 

When using the iterated solution methods, the typical iterated operation is to solve for 
the transfer step amount in the post-contingency state, and then apply the transfer step 
amount to the post-contingency state and resolve for the next transfer step amount. 
When this option is checked, the transfer step amount for each iteration is calculated in 
the post-contingency state, but the power flow state is restored to the pre-contingency 
state before the transfer step amount is applied. The contingency is then applied after 
the transfer step amount has been ramped and the transfer step amount for the next 
iteration is calculated after the contingency has been applied. The purpose of this is to 
take into account the possibility of conditional actions in the contingency definitions that 
may not be active in the early steps of the iterated calculations, but may become active 
at some point during the application of the iterated steps.  

Iterate on failed contingency 

This option is only enabled when the option to Force all transfer ramping to occur in 
pre-contingency states and repeat full CTG solutions is selected. When this option 
is checked and the power flow fails to solve after the contingency has been applied, a 
new iteration loop is entered to determine the highest transfer level at which the 
contingency can be solved. This loop attempts to determine a more accurate transfer 
level at which the contingency fails to solve rather than simply reporting the transfer 
level at which the last power flow was successful regardless of the current step size. To 
start the iterative process, the current step size is reduced by half. The ramping is 
performed and the contingency is solved. The step size will remain the same as long as 
the contingency can be solved. If the contingency fails to solve, the step size will be 
reduced by half again. The ramping will continue until the contingency no longer solves, 
the accumulated transfer during the process meets the original step size, or the step size 
becomes smaller than the step size tolerance. 
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An additional check is done during the iterative process on the failed contingency. When 
the contingency does solve, the flow on the monitored element is checked to determine 
if it exceeds its limit. If it is overloaded, the step size will be reduced by half until the 
monitored element is no longer over its limit. While this check is being done on the 
monitored element limit, the ramping continues out to the specified amount and the 
contingency is solved. 

During the entire iterative process on a failed contingency solution, the step size is 
limited to be between zero and the step size which was ramped when the contingency 
failed to solve for the first time.  

Memo 

The Memo tab allows you to enter a note related to the ATC analysis. 
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Transfer Result Reporting Options 

  

Transfer Limiters To Save 

This value tells Simulator how many total Transfer Limiters to save. Simulator will save those 
Transfer Limiters with the lowest Transfer Limitation. An explanation of a Transfer Limiter 
follows: 

During Linear ATC Analysis, Simulator determines the Transfer Limitation (See Available 
Transfer Capability Analysis) for each transmission line and interface during each contingency 
and the base case. From this Simulator develops a list of Transfer Limiters. A Transfer Limit 
contains three key pieces of information: 
• Transfer Limit in MW 
• Limiting Element: Transmission branch (or interface) that causes the limit 
• Limiting Contingency: Contingency that is applied to cause the Limiting Element to 

overload (if it is a limit without any contingency applied, then the contingency will say 
Base Case)  

Thus if we are monitoring 1000 transmission lines during 99 contingencies plus 1 base case, 
there would be 100,000 Transfer Limiters calculated. We are not concerned with all 100,000 
limitations, therefore, only the limitations with the smallest Transfer Limit in MW are reported. 

Max Limiters per CTG 

When analyzing a long list of contingencies, the worst transfer limitations may all occur during 
the same contingency. Set this value to limit the number of Transfer Limiters saved that are 
associated with one contingency. 

Max Limiters per Element 

When analyzing a long list of contingencies, the worst transfer limitations may all be overloads 
of the same limiting element. Set this value to limit the number of Transfer Limiters saved that 
are associated with one Limiting Element. 

Max MW Limitation 

This value defines the maximum transfer to report between the buyer and seller. Simulator will 
compute the ATC analysis results until the transfer amount reaches the value in this field and 
only report the results meeting the other reporting criteria up to this MW limitation. 

When using one of the iterated methods, this option is only applied during the initial Single 
Linear Step portion of the method. Once individual limiters are being iterated on, this option 
will be ignored.  

Ignore Elements with OTDFs below 

Simulator will not report Transfer Limitations for elements with OTDF values (or PTDF values if 
there is no Limiting Contingency) less than this user-specified value. The default value is 
0.5%, meaning that for a 100 MW transfer, there would be only a 0.5 MW increase in flow on 
the Limiting Element. 

The transfer limitation functions involve dividing by the PTDF or OTDF values for each branch 
or interface to calculate the Transfer Limit. This leads to two facts: 
• The accuracy of the transfer limitation is less for lines that have very small PTDF or OTDF 

values.  
• A very small PTDF or OTDF value means that the transfer has very little impact on the 

line.  

These two facts often result in Linear ATC analysis reporting inaccurate transfer limitations for 
lines that are largely unaffected by the transfer. It is not uncommon to have a transfer 
limitation report an extremely negative transfer limit (e.g. -1.9E28 MW). A branch which is 
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overloaded by a very small percentage, but which has a very small OTDF value often causes 
this. If the OTDF value is 0.001%, then a branch overloaded by 1 MW will result in a transfer 
limitation of -100,000 MW. 

This motivates the usefulness of ignoring elements with small PTDFs and OTDFs.   

Ignore Elements with PTDFs below 

Simulator will not report Transfer Limitations for elements with PTDF values less than this 
user-specified value. The default value is 0.5%. 

  

Both the PTDF and OTDF cuttoff values are applied for each monitored element to determine 
if it should be ignored. If an element is monitored in the base case, the PTDF must be meet 
the PTDF cutoff AND the OTDF cutoff values. If an element is being monitored for a 
contingency condition, the OTDF for the monitored element with the contingency in place 
must meet the OTDF cutoff, and the PTDF for the monitored element without the contingency 
in place must meet the PTDF cutoff. 
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ATC Dialog: Analysis Tab 

  

The Analysis Tab of the ATC Dialog is used to control the analysis process. The scrollable 
window displays a record of user-initiated actions relating to the analysis. 
  

 
  

Analysis Tab 

  
The Analysis tab has the following controls: 

Start Analysis 

The Start Analysis button begins the ATC Analysis using the settings and options defined 
by the user in the ATC Analysis Dialog. Progress of the ATC Analysis is shown in the 
scrollable pane of the ATC Dialog – Analysis Tab window. 

Abort Calculation 

When using one of the iterative ATC Solution Methods, or while analyzing Multiple Scenarios, 
click this button to abort the calculation.  

Note: This does not immediately abort the solution. Simulator must restore the system state 
before completing the abort. 
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Show Log 

Click this button to show the Power Flow Solution Message Log. 

Restore Initial State 

Click this button to restore the system state to the state when the dialog was first opened. 

Increase Transfer 

Click this button to open the Ramp Transfer Up dialog in order to increase (or decrease) the 
transfer level manually. This transfer remains in the system state if the dialog is closed 
without restoring the initial state. 

Additional analysis can be done on a case that has had the transfer increased by using the 
ATC tool; however, the control method used in the ATC tool may differ from that in use 
once the ATC tool has been exited. When injection groups are used to increase the transfer, 
the AGC method that is used is island-based AGC. If this same method is not used for 
subsequent analysis, the dispatch and system state will be modified from the state with the 
transfer applied. When using areas or super areas for increasing the transfer, the area or 
super area is put on participation factor control for the ramping. The same problem can exist 
as with the injection groups if the same AGC method is not in use with subsequent analysis 
after the transfer ramping.  
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ATC Dialog: Result Tab 

  

When performing ATC Analysis on a single system state, the Result Tab is visible. The Result 
Tab consists of two sections: A Transfer Limiters Display and a Contingency Definition Display. 
  

 
  

Result Tab 

  

The Transfer Limiters Display contains tabbed sheets containing information on Branch, 
Interface, and Nomogram Limiters. The user can also choose to display All Limiters. See 
Transfer Limiters for more information. 

The Contingency Definition section displays information on the limiting contingency for 
selected transfer limiter if the user checked Include Contingencies on the Common Options 
tab. 
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ATC Extra Monitors Dialog 

  

Simulator’s ATC tool determines the maximum amount of MW transfer between the seller and 
buyer. If you would like to also determine the flow on additional lines or interfaces at the 
transfer levels determined by the ATC tool, you can utilize ATC Extra Monitors. To open the 
Extra Monitors dialog, click the Define Extra Monitors button on the Advanced Options tab 
of the ATC Analysis Dialog. 

The ATC Extra Monitors Display lists all of the ATC Extra Monitors defined. This list display is a 
Case Information Display, and therefore has the same functionality as other common displays. 
See Adding and Removing Extra Monitors below. 
  

 
  

Extra Monitors Dialog 

  
The default fields shown on this display are: 

ATC ExMon Desc 

This is a description of the monitored value. Presently, this is always MW flow. 

ATC ExMon Obj 

The power system element that is being monitored. This will be either a transmission branch 
or an interface. 

Monitor Limit 

This is the MW limit of the element being monitored. 

Relative Monitor 

Set this to a positive value to further filter the Transfer Limitations reported on the Transfer 
Limiters Display. By default, Relative Monitor is set to none, and no additional filtering of 
limitations is performed. If this value is greater than zero, only Transfer Limitations that 
meet the following condition are included in the results. 

 
  

This provides a measure of how much an interface or branch is affected by the transfer 
relative to its MW limit. 

  

Adding and Removing Extra Monitors 

To delete an Extra Monitor, right-click on the desired record on the list display and select 
Delete. 
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To insert an Extra Monitor, right-click on the list display and select Insert. This opens the 
insert dialog.  

  

 
Insert Extra Monitors Dialog 

  

Choose whether you want to monitor an Interface or Line MW flow. Next choose the 
interface or branch to be monitored. Note that the insert dialog allows the use of Simulator’s 
Advanced Search Engine and techniques to aid in locating the desired interface or branch. 
Click OK to insert the record. 
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Multiple Scenario Available Transfer Capability Dialog 

  

To perform Available Transfer Capability Analysis for several system scenarios, check Analyze 
Multiple Scenarios on the Advanced Options tab of the Available Transfer Capability 
Dialog. When Analyze Multiple Scenarios is not checked, the available tabs are Options, 
Analysis and Result. When Analyze Multiple Scenarios is checked then the following changes 
occur: 
• Scenarios Tab appears 
• Results Tab appears 
• Result Tab is removed (replaced by Results) 

  

  

Analyze Multiple Scenarios Dialog 

  
By defining multiple scenarios, Simulator allows you to calculate ATC values for several 
different power system states automatically. Scenarios can be modified along three axes: 
• Line Rating/Zone Load Scenarios (weather-related scenarios) 
• Generation Scenarios (generation profiles) 
• Interface constraints 

See Scenarios Tab for more information. 

javascript:RelatedTopic1.Click()�
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Multiple Scenario ATC Dialog: Scenarios Tab 

  

By defining multiple scenarios, Simulator allows you to calculate ATC values for several 
different power system states automatically. Scenarios can be modified along three axes: 
• Line Rating/Zone Load Scenarios (weather-related scenarios) 
• Generation Scenarios (generation profiles) 
• Interface constraints 

  

 
Analyze Multiple Scenarios Dialog: Scenarios Tab 

  

Each tab contains a list of the power system elements that will be modified during different 
scenarios. These lists are a familiar Case Information Display providing the same functionality 
as other displays 

To insert a new power system element into the list, right-click on the list (below the headings) 
and choose Insert.  
The Scenarios Tab has the following controls: 
  

Tabs and Sub-Tabs 

The Scenarios Tab contains three tabbed sheets: Line Ratings/Zone Loads, Generator 
Outputs and Interface Ratings. 
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Line Ratings and Zone Loads are varied together when analyzing scenarios. This was chosen 
because they often vary together as a function of the weather. Notice that three sub-tabs 
(labeled Line Ratings A, Line Ratings B, and Zone Loads) appear at the bottom of the Line 
Ratings/Zone Loads tab. The A rating is typically used as a base case ratings, whereas the B 
limit is typically used as a line rating under contingency. The way line ratings are utilized is 
defined in Limit Monitoring Settings. 

Number of Defined Scenarios per Element Type 

On each tab, you may enter how many different scenarios should be defined for that kind of 
power system element. For instance if you set Generation Scenarios to 5, then list display on 
the Generation Tab will provide 5 columns labeled G0, G1, G2, G3, and G4. Generation 
outputs should then be entered into each cell representing the generation output in each 
scenario. 

Total Scenarios 

Once you have specified the scenarios, Simulator is able to perform ATC Analysis on every 
combination of the axes. For example, assume you have the following: 

• 10 sets of line ratings and zones load  
• 8 sets of generation profiles 
• 3 interface constraints 

This yields a total of 240 different scenarios to calculate (10*8*3 = 240 ). Be warned that 
that the more scenarios you analyze the longer the computation will take. 

Set Scenario Names 

This button will bring up the Scenario Names dialog, where the user is able to assign a 
different name to the scenarios. 

Assume Constant Power Factor 

This option is only available in the Zone Loads sub-tab of the Line Ratings/Zone Loads 
tab. If selected, it specifies that the Mvar will be ramped as the load MW is ramped, 
maintaining a constant power factor. 

No Change in MVAR 

This option is only available in the Zone Loads sub-tab of the Line Ratings/Zone Loads 
tab. If selected, it specifies that the load Mvar is kept constant, independently of the 
variations of the load MW. 

Modified Elements 

Each tab contains a list of the power system elements that will be modified during different 
scenarios. These lists are a familiar Case Information Display providing the same 
functionality as other displays. 

To insert a new power system element into the list, right click on the list (below the 
headings) and choose Insert. 

If a power system element does not show up in one of the lists of elements for a particular 
scenario, then it will retain its base case value during that scenario.  

When saving or loading scenario elements in an auxiliary file, the elements are usually 
identified by primary key fields. Optionally, these elements can be identified by label. See 
the Label topic for more information about this. 
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Multiple Scenario ATC Dialog: Results Tab 

  

Once you have defined your scenarios and started the ATC Analysis, you can switch to the 
Results Tab to see the progress that ATC Analysis is making.  

 
  

Multiple Scenario Results Tab 

  

The primary part of the Results tab contains a spreadsheet-like look-up table display. The 
layout of the display is dictated by the Axis Order selected. Note that because there are three 
axes possible, the row and column entries represent the first two axes while the third axis is 
represented by tabs at the bottom of the table. See Local Menu Options for information 
regarding the options available when right-clicking within the table. 

This dialog has the following controls: 

Show Transfer Limiters Button 

Click the Show Transfer Limiters button to view the Transfer Limiters found under each 
scenario. This will open a separate dialog that displays a list of the Transfer Limiters. To see 
the Transfer Limiters for a particular scenario, click on the workbook cell that represents the 
scenario you are interested in and the separate dialog will update appropriately. 

Axis Order 

This menu is used to select the desired axis order. The three axes correspond to the three 
Scenarios Tabs.  

• One axis has heading labels G0, G1, … for the Generation Scenarios,  
• Another with heading labels RL0, RL1, … for the Rating/Load Scenarios,  
• A third with heading labels I0, I1, … for the Interface Scenarios. 
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Results Display 

The primary part of the Results tab contains a spreadsheet-like look-up table display. The 
values shown in the table for each scenario are the most limiting Transfer Limit in MW. 

Write to Excel 

This button will send the results to an Excel spreadsheet. 

Save to Text Files 

This option will allow the user to save the results in an auxiliary file. 
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Multiple Scenario ATC Analysis - Results Tab: Local Menu Options 

  

If you right-click on the table contained on the Results Tab, you will bring up a local menu 
containing several options. The first several options are only enabled if you right-click on a cell 
representing a scenario. These options will perform an operation with respect to the Scenario: 

Take me to Scenario … 

Implements the changes in the Scenario resulting in a modified system state. 

Determine Transfer Limit For Scenario … 

Calculates the ATC for the Scenario, and then sets the system state back to the Initial State. 

Take me to the Transfer Limit For Scenario … 

Performs ATC analysis for the Scenario, and then ramps the transfer to this limit. 

Other options on this local menu are not related to the Scenario you have clicked on.  

Increase Transfer for Present System State 

Increments the transfer level for the present system state by a user-defined amount. 

Return to Initial State 

Returns the system state to the Initial State. 
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Transfer Limiters Display 

  

The Transfer Limiters Display shows the results of ATC Analysis. This display appears either on 
the Result Tab of the Available Transfer Capability Dialog or as a separate window when 
performing Multiple Scenario Available Transfer Capability Analysis. 

The display contains four different tabs: All Limiters, Branch Limiters, Interface Limiters, and 
Nomogram Interface Limiters. 

The Contingency Definition Display at the bottom of the window shows information on the 
defined contingency that caused the limitation selected from one of the four tabbed pages of 
limiters. For more information on this display, see Contingency Analysis - Contingency 
Definition Display. 

  

 
  

Transfer Limiters Display 

  

The Transfer Limiters Display has the following controls: 

All Limiters Tab 

The All Limiters tab shows a list of all the transfer limitations found. This includes limitations 
on branches, interfaces, areas, zones, etc… 

Branch Limiters Tab 

The Branch Limiters tab only shows those limitations with a transmission line or transformer 
as the limiting element. The limiting element description for the Branch Limiters tab is 
replaced by the bus numbers and names of the limiting element. 
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Interface Limiters Tab 

The Interface Limiters Tab only shows those limitations with an interface as the limiting 
element. The limiting element description is replaced by the name of the interface. 

Nomogram Interface Limiters Tab 

The Nomogram Interface Limiters Tab only shows those limitations with a nomogram 
interface as the limiting element. The limiting element description is replaced by the name 
and segment of the nomogram interface. 

Limiters Fields 

Transfer Limit Field 
The Transfer Limit Field shows the Transfer Limit in MW for the Limiting Element during 
the Limiting Contingency. This value depends on the ATC Solution Method Used: 
• Single Linear Step (SL): Only one Linear ATC step is performed. The Transfer Limit 

values are those found during this step. 
• Iterated Linear Step (IL): The Single Linear Step method is iterated during this 

method.  The Transfer Limiters shown are those found during the final step 
performed.  The actual Transfer Limit values are the values found at the last step 
plus the accumulated amount the transfer has been ramped.  The Transfer 
Limitation(s) that were iterated on individually are highlighted in yellow. 

• Iterated Linear Step (IL) then Full CTG: The Transfer Limits shown for the Transfer 
Limitation(s) that were used when iterating are equal to the accumulated amount 
that the transfer was ramped during the initial Iterated Linear Step and then the 
contingency analysis step.  These limitations are highlighted in cyan.  The Transfer 
Limits shown for all other limiters are the results of the initial Iterated Linear Step 
calculation performed before iterating on individual limitations for the contingency 
analysis. 

For the iterated methods there are color indicators used to highlight the Transfer 
Limitations when certain situations are encountered: 
• Fuchsia – Indicates that the power flow failed to converge as the transfer is ramped 

out in the iterated methods.  The Transfer Limit that is reported is the accumulated 
transfer amount that has been ramped as of the last successful solution.  When this 
situation is encountered, the top five dV/dQ sensitivities of all monitored buses in the 
case are also reported in the Transfer Limiters list. Limiting Element field will contain 
POWERFLOW DIVERGENCE. 

• Lime Green – Indicates that the number of iterations has exceeded the maximum 
number of allowed iterations.  The Transfer Limit that is reported is the accumulated 
transfer amount that has been ramped as of the last successful solution. Limiting 
Element field will contain OSCILLATING. 

• Yellow – Indicates the Transfer Limitation(s) that were iterated on individually during 
the Iterated Linear Step (IL) method. Iteratively Found field will contain YES. 

• Cyan – Indicates the Transfer Limitation(s) that were iterated on individually during 
the Iterated Linear Step (IL) then Full CTG method. Iteratively Found field will 
contain FULL. 

• Orange – Indicates that the contingency failed to solve at some point during the 
Iterated Linear Step (IL) then Full CTG method.  The Transfer Limit value that is 
reported is the accumulated transfer amount that has been ramped as of the last 
successful solution. Iteratively Found field will contain CTG_FAIL_IN_FULL. 

• Gray – Indicates that the power flow failed to converge while ramping the transfer 
amount during the Iterated Linear Step (IL) then Full CTG method while forcing the 
transfer ramping to occur pre-contingency. This indicates that the solution failed 
because of the transfer amount being ramped and not because the contingency 
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failed to solve.  The Transfer Limit that is reported is the accumulated transfer 
amount that has been ramped as of the last successful solution.  When this situation 
is encountered, the top five dV/dQ sensitivities of all monitored buses in the case are 
also reported in the Transfer Limiters list. Iteratively Found field will contain 
RAMP_FAIL_IN_FULL. 

Limiting Element Field 

Shows a text description of the limiting element. 

Limiting CTG Field 
Shows the name of the limiting contingency. 

% OTDF Field 

This is the OTDF (or PTDF if the Limiting CTG is Base Case) on the Limiting Element for 
the transfer direction that is being studied. In other words, this is a linear estimate of the 
percent of the transfer that will appear on the Limiting Element if the Limiting CTG 
occurs.  

Note: For iterated techniques, this is the PTDF or OTDF at the last Linear Iteration.  

Pre-Transfer Value Estimate Field 

If a contingency is not included in the Limiter, this is equal to the Initial Value. When a 
contingency is included in the Limiter, this is the linear estimate of the post-contingency 
flow before any transfer occurs. See Available Transfer Capability Analysis.  

Note: For iterated techniques, this is the estimate at the last Linear Iteration.  

Limit Used Field 

This is the value of the Limit being used by the ATC for the Limiting Element during the 
Limiting CTG. It reflects what is specified in Limit Monitoring Settings and options set on 
the Advanced Options tab. 

Contingency Definition Display 

This display shows information on the defined contingency that caused the limitation 
selected from one of the four tabbed pages of limiters. For more information on this display, 
see Contingency Analysis - Contingency Definition Display. 
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ATC Analysis Methods - Solution Methods 

  

Simulator provides three methods of determining ATC. 
• Single Linear Step (SL) 
• Iterated Linear Step (IL) 
• Iterated Linear Step (IL) then Full Contingency Solution 
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ATC Analysis Methods - Single Linear Step (SL) 

  

The Single Linear Step approach is the most common ATC method. This method of ATC 
analysis uses only information about the present system state and sensitivities (mathematical 
derivatives) about the present system state. These sensitivities are embodied in the PTDF and 
LODF calculations. 

Consider a transmission line with a limit of 10 MW, present loading of 5 MW and a PTDF of 
10%. The estimated maximum transfer without causing an overload on the line is  
  

Transfer Limitation = (Limit – Present Loading) / PTDF = (10 – 5) / 0.1 = 50 MW 
  

When including contingency analysis, the OTDF (Outage Transfer Distribution Factor) and 
linearized estimates of post-contingency flows are used to determine the Transfer Limitation. 
  

Transfer Limitation = (Limit – Post-Contingency Loading) / OTDF 
  

If we find the Transfer Limitation for every transmission branch (and interface) during each 
contingency, then the ATC is equal to the smallest Transfer Limit value. 

Note: Simulator also monitors the possibility that a transfer will reduce the flow on a line until 
the line reaches its limit for flow in the opposite direction. 
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ATC Analysis Methods - Iterated Linear Step (IL) 

  

The Single Linear Step is an extremely fast method for determining the ATC. However, 
because it only uses present operating point information, controller changes are not taken into 
account. The linearization assumes that all controllers are fixed. The Iterated Linear Step (IL) 
method provides an alternative to the Single Linear Step that allows controller changes, but 
still performs its analysis in a reasonable amount of time. The (IL) method operates as follows: 
• Perform Single Linear Step  
• Set the Stepsize = Minimum Transfer Limitation found in Single Linear Step which is 

greater than the specified When iterating, Ignore Limiters below value  
• If [abs(Stepsize) <= Tolerance] or [Iterations >= Max Iterations] then stop 

o If the maximum number of iterations is reached, a transfer limitation will be 
reported highlighted in lime green indicating that the iterated process is oscillating. 
The Transfer Limit that is reported is the accumulated transfer amount that has 
been ramped as of the last successful solution.  

o The iteration count is reset at the beginning of the iteration process.  
• Implement transfer by amount of Stepsize and resolve power flow 

o The power flow is solved according to the options set with the Power Flow Solution 
Options. 

o When calculating a transfer between injection groups, the Island-Based AGC Power 
Flow Solution Options applicable to dispatch using an injection group are used 
when determining which generators and loads will participate in the transfer. These 
options include whether or not AGC status should be considered when determining 
which units will participate in the ramping, whether or not to enforce generator MW 
limits, and whether or not to allow negative loads. The power factor to use when 
adjusting load is also specified with these options. 

o To prevent oscillation of the solution, the Stepsize may be limited if the sign of the 
Stepsize changes throughout the iterations. At each iteration, the direction of the 
Stepsize is checked and the Stepsize is bounded based on the accumulated transfer 
at each iteration. The accumulated transfer is the total amount that the transfer 
between the seller and buyer has been ramped. The accumulated transfer is 
updated with the current Stepsize once it has been determined that Stepsize can be 
achieved. At the start of the iterated process, LowBound is initialized to a large 
negative number and HighBound is initialized to a large positive number. At each 
iteration the following checks are performed: 

If Stepsize > 0 then LowBound = (Accumulated Transfer) 

Else If Stepsize < 0 then HighBound = (Accumulated Transfer) 

If Stepsize >= (HighBound - Accumulated Transfer)*0.7 

Then Stepsize = (HighBound – Accumulated Transfer)*0.7 

Else If Stepsize <= (LowBound - Accumulated Transfer)*0.7 

Then Stepsize = (LowBound – Accumulated Transfer)*0.7 
o During the implementation of the transfer, if the full Stepsize cannot be achieved, 

an attempt is made to implement as much of the transfer as possible in smaller 
stepsizes. The first attempt is to cut the Stepsize in half. If that succeeds then an 
iterated process occurs where the difference between the original full Stepsize and 
the successful stepsize is ramped. This process continues with the incremental 
stepsizes until as much of the original Stepsize ramping as possible is achieved.  

o The ramping of the transfer is done so that each step adjusts injection from a 
common starting point so that the ramping is effectively done in the same direction 
even if the Stepsize backs off the transfer. At the start of the iterated process, the 
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base case generation and load values are stored. At each step where transfer 
ramping occurs, the generation and load values are returned to their base case 
levels and the transfer ramping is implemented from that point. As an example, 
take the situation where 1000 MW is ramped. The next Stepsize is calculated to be 
-100 MW. The total transfer amount achieved is then 900 MW. If ramping does not 
proceed in the same direction, generators that hit maximum limits when ramping 
out to 1000 MW will back off from these limits when ramping the -100 MW 
Stepsize. Ramping out to the total transfer amount of 900 MW in one step causes 
generators to hit their limits and stay there. If the ramping does not proceed in the 
same direction, ramping out by the total amount in one step and ramping by 
backing off the transfer will yield different results because some generators will no 
longer be at limits when ramping in steps. Ramping in the same direction is 
intended to prevent this discrepancy with generators at limits.  

o If the power flow fails to converge at this step, the iterated process will stop and a 
transfer limitation will be reported highlighted in fuchsia. The Transfer Limit that is 
reported is the accumulated transfer amount that has been ramped as of the last 
successful solution.  

o Reserve limits on generators and loads participating in the transfer will be checked 
if the option to enforce limits is active for the selected transactors. Reverse limits 
are checked regardless of how the option to Report Generation Reserve Limits 
is set with the Common Options. For areas and super areas this means that the 
global enforcement of generator limits is active, the area enforcement of limits is 
active, and there is at least one generator whose enforcement of limits is active and 
this generator is on AGC control. For injection groups this means that the 
enforcement of limits for the injection group is active. When a reserve limit is 
found, the current iterations will stop and a transfer limit will be reported with the 
reserve limit and the area, super area, or injection group that is at a limit. If a 
reserve limit is encountered during the step where all transfer limiters are iterated 
on together, the entire ATC process will stop. If a reserve limit is encountered 
during the step where a limiter is being iterated on individually, the iterations will 
only stop for that limiter; other limiters will be processed if they do not hit a reserve 
limit as well.  

• At new operating point, go back to first step and repeat 

As the initial iteration process is performed, the transfer limiter may be different (i.e. the 
contingency and limiting element pair may be different) during each iteration. Once the 
Stepsize is determined to be less than or equal to the tolerance (or the maximum number of 
iterations is met) the order of the limiters is set. 

At this point, the first user specified Transfer Limiters to Iterate On are taken from the list 
of limiters and the above process is repeated for each limiter individually, with the contingency 
and limiting element pair of each limiter remaining set as determined in the initial process. 
Transfer limitations for transfer limits found in this manner will be highlighted in yellow in the 
results.  

This method takes into account controller changes that occur as you ramp out to the transfer 
level, but still avoids the full simulation of contingencies. 

This method can be applied between combinations of areas and super areas, OR between two 
injection groups. Combinations of areas/superareas and injection groups are not allowed. 
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ATC Analysis Methods - Iterated Linear Step (IL) then Full CTG Solution 

  

This method takes the solution process a step further than just the Iterated Linear (IL) 
method. Instead of using linear sensitivities to calculate the impact of contingencies on the 
transfer limits, full contingencies are implemented and solved with a full power flow solution. 
Be aware however, that this calculation method can be extremely slow.  

The initial iteration process of (IL) then Full CTG Solution method starts by performing the 
steps outlined in the Iterated Linear (IL) process. As the initial iteration process is performed, 
the transfer limiter may be different (i.e. the contingency and limiting element pair may be 
different) during each iteration. Once the Stepsize is determined to be less than or equal to 
the tolerance (or the maximum number of iterations is met) the order of the limiters is set. 

At this point, the first user specified Transfer Limiters to Iterate On are taken from the list 
of limiters and the steps outlined in the Iterated Linear (IL) process are repeated for each 
limiter individually, with the contingency and limiting element pair of each limiter remaining set 
as determined in the initial process. 

Once the iterated process has been repeated for an individual limiter, there are two different 
ways that the processing of the full contingency can proceed. If choosing to NOT Force all 
transfer ramping to occur in pre-contingency states and repeat full CTG solutions, 
the contingency of each transfer limiter is then enforced in the power flow topology, and a 
power flow solution is performed to give a new contingency power flow solution to use as the 
base for each transfer limiter. If the option to Use Specific Solution Options for 
Contingencies is checked, then the power flow is solved with the options defined with the 
Contingency Solution Options. Otherwise, the power flow is solved with the options specified 
with the Power Flow Solution Options. In either case, the Make-Up Power option specified with 
the contingency analysis options is used when applying the contingency. The iterative process 
outlined in the Iterated Linear (IL) method is then repeated again for each individual transfer 
limiter with the specified contingency of each limiter actually in place in the power flow 
solution. If the contingency solution fails to converge, the transfer limitation will be reported 
highlighted in orange and the Transfer Limit that is reported will be the value determined from 
the iterated process performed on the individual limiter before the contingency was applied.  

If choosing to Force all transfer ramping to occur in pre-contingency states and 
repeat full CTG solutions, after the iterated process is complete for an individual limiter, the 
contingency of each transfer limiter is fully implemented in the following steps: 
• Store the system state following the iterated process on the individual limiter 

o At this point the accumulated transfer amount is the total amount that has been 
transferred following completion of the iterated process on the individual limiter.  

o The Stepsize is zero for the first iteration. 
• Apply the contingency and perform full power flow solution 

o If the option to Use Specific Solution Options for Contingencies is checked, 
then the power flow is solved with the options defined with the Contingency 
Solution Options. Otherwise, the power flow is solved with the options specified 
with the Power Flow Solution Options. In either case, the Make-Up Power option 
specified with the contingency analysis options is used when applying the 
contingency. 

o If the option to Iterate on failed contingency is NOT checked and the power 
flow fails to solve, the iterated process for the individual limiter will stop and a 
transfer limitation will be reported highlighted in orange. The Transfer Limit that is 
reported is the accumulated transfer amount that has been ramped as of the last 
successful solution.   
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o If the option to Iterate on failed contingency IS checked and the power flow 
fails to solve, a new iteration loop is entered to determine the highest transfer level 
at which the contingency can be solved. This loop attempts to determine a more 
accurate transfer level at which the contingency fails to solve rather than simply 
reporting the transfer level at which the last power flow was successful regardless 
of the current Stepsize. To start the iterative process, the current Stepsize is 
reduced by half. The ramping is performed and the contingency is solved. The 
Stepsize will remain the same as long as the contingency can be solved. If the 
contingency fails to solve, the Stepsize will be reduced by half again. The ramping 
will continue until the contingency no longer solves, the accumulated transfer 
during the process meets the original Stepsize, or the Stepsize becomes smaller 
than the Stepsize tolerance. An additional check is done if the contingency does 
solve during this process; the flow on the monitored element is checked to 
determine if it exceeds its limit. If it is overloaded, the Stepsize will be reduced by 
half until the monitored element is no longer over its limit. While this check is being 
done on the monitored element limit, the ramping continues out to the specified 
amount and the contingency is solved. During this entire process, the Stepsize is 
limited to be between zero and the Stepsize that was ramped when the contingency 
failed to solve for the first time. When the iterative process on the failed 
contingency completes, the iterations are done for this particular limiter. The 
Transfer Limit that is reported is the accumulated amount that is possible without 
overloading the monitored element and in which the contingency solves. The limiter 
will be reported highlighted in orange. 

o If the power flow solution is successful, update the accumulated transfer with the 
Stepsize. 

• Perform Single Linear Step on the individual limiter  
o The Stepsize is the Transfer Limit found for the individual limiter. If the Stepsize is 

less than the specified When iterating, Ignore Limiters below value minus the 
accumulated transfer amount, it is set to zero. 

• If [abs(Stepsize) <= Tolerance] or [Iterations >= Max Iterations] then stop 
o If the maximum number of iterations is reached, a transfer limitation will be 

reported highlighted in lime green indicating that the iterated process is oscillating. 
The Transfer Limit that is reported is the accumulated transfer amount that has 
been ramped as of the last successful solution. 

o The iteration count is reset at the beginning of the contingency iteration process for 
each individual limiter. 

• Restore system to the state stored in the first step 
o This step removes the contingency that was implemented so that the transfer 

ramping occurs prior to the contingency being applied. 
• Implement transfer by amount of Stepsize and resolve power flow 

o The power flow is solved according to the options set with the Power Flow Solution 
Options. 

o When calculating a transfer between injection groups, the Island-Based AGC Power 
Flow Solution Options applicable to dispatch using an injection group are used 
when determining which generators and loads will participate in the transfer. These 
options include whether or not AGC status should be considered when determining 
which units will participate in the ramping, whether or not to enforce generator MW 
limits, and whether or not to allow negative loads. The power factor to use when 
adjusting load is also specified with these options. 

o To prevent oscillation of the solution, the Stepsize may be limited if the sign of the 
Stepsize changes throughout the iterations. At each iteration, the direction of the 
Stepsize is checked and the Stepsize is bounded based on the accumulated transfer 
at each iteration. The accumulated transfer is the total amount that the transfer 
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between the seller and buyer has been ramped. The accumulated transfer is 
updated with the current Stepsize once it has been determined that Stepsize can be 
achieved. At the start of the iterated process, LowBound is initialized to a large 
negative number and HighBound is initialized to a large positive number. At each 
iteration the following checks are performed: 

 If Stepsize > 0 then LowBound = (Accumulated Transfer)  

Else If Stepsize < 0 then HighBound = (Accumulated Transfer) 

If Stepsize >= (HighBound - Accumulated Transfer)*0.7 

Then Stepsize = (HighBound – Accumulated Transfer)*0.7 

Else If Stepsize <= (LowBound - Accumulated Transfer)*0.7 

Then Stepsize = (LowBound – Accumulated Transfer)*0.7 
o During the implementation of the transfer, if the full Stepsize cannot be achieved, 

an attempt is made to implement as much of the transfer as possible in smaller 
stepsizes. The first attempt is to cut the Stepsize in half. If that succeeds than an 
iterated process occurs where the difference between the original full Stepsize and 
the successful stepsize is ramped. This process continues with the incremental 
stepsizes until as much of the original Stepsize ramping as possible is achieved. 

o The ramping of the transfer is done so that each step adjusts injection from a 
common starting point so that the ramping is effectively done in the same direction 
even if the Stepsize backs off the transfer. Additional details about this are provided 
in the steps of the Iterated Linear (IL) process. 

o If the power flow fails to solve at this point, the iterated process for the individual 
limiter will stop and a transfer limitation will be reported highlighted in gray. This 
Transfer Limit that is reported is the accumulated transfer amount that has been 
ramped as of the last successful solution. 

o Reserve limits on generators and loads participating in the transfer will be checked 
if the option to enforce limits is active for the selected transactors. Reverse limits 
are checked regardless of how the option to Report Generation Reserve Limits 
is set with the Common Options. For areas and super areas this means that the 
global enforcement of generator limits is active, the area enforcement of limits is 
active, and there is at least one generator whose enforcement of limits is active and 
this generator is on AGC control. For injection groups this means that the 
enforcement of limits for the injection group is active. When a reserve limit is 
found, the current iterations will stop and a transfer limit will be reported with the 
reserve limit and the area, super area, or injection group that is at a limit.  

• Go back to second step and repeat 

Transfer limitations found by implementing the full contingency solution are highlighted in 
cyan in the results. 

This method can be applied between combinations of areas and superareas, OR between two 
injection groups. Combinations of areas/superareas and injection groups are not allowed. 
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Simulator Automation Server (SimAuto) Overview 

  

The SimAuto tool is only available if you have purchased the SimAuto add-on to the 
base Simulator package. Contact PowerWorld Corporation for details about 
ordering the SimAuto version of Simulator. 
PowerWorld Corporation also offers Optimal Power Flow (OPF), Available Transfer Capability 
ATC, Simulation Automation Server (SimAuto), and Security Constrained Optimal Power Flow 
(SCOPF) add-ons. For more information see. 
  

SimAuto provides PowerWorld customers the ability to access PowerWorld Simulator 
functionality within a program written externally by the user. The Simulator Automation Server 
acts as a COM object, which can be accessed from various programming languages that have 
COM compatibility. Examples of programming tools with COM compatibility are Borland® 
Delphi, Microsoft® Visual C++, Microsoft® Visual Basic, and Matlab® (among others). For 
more information on COM Objects and Automation Servers, see the help for Microsoft 
Windows. 

The Automation Server of Simulator works very well in combination with Simulator Script 
Commands and Auxiliary Files. It is beneficial to become familiar with these topics when 
considering using the Simulator Automation Server. 

Note that previous users of SimAuto in Version 9 will need to update their function calls to 
SimAuto functions. PowerWorld Corporation found it imperative to change the function calls 
for SimAuto, in order to remedy irreconcilable problems when using SimAuto with some 
programming languages. The documentation provided should provide adequate help on the 
changes needed, but as always, if any questions arise, please contact PowerWorld Corporation 
for more information. 
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Installing Simulator Automation Server 

  

Note that previous users of SimAuto in Version 9 will need to update their function calls to 
SimAuto functions. PowerWorld Corporation found it imperative to change the function calls 
for SimAuto, in order to remedy irreconcilable problems when using SimAuto with some 
programming languages. The documentation provided should provide adequate help on the 
changes needed, but as always, if any questions arise, please contact PowerWorld Corporation 
for more information. 

Installing the Simulator Automation Server requires no additional steps beyond installing 
PowerWorld Simulator as normal. When a version of PowerWorld Simulator containing the 
Simulator Automation Server is installed on your computer, the install program automatically 
adds the information needed by the Simulator Automation Server to the registry. 

If for some reason the registration fails, be sure you have the SimAuto add-on for Simulator 
and you have either run the application on the computer or run the command pwrworld / 
regserver at the command line. If instead you would like SimAuto to un-register itself as a 
COM object, run the command pwrworld /unregserver at the command line. 
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Including Simulator Automation Server Functions 

  

Before you can access the functions defined by the Simulator Automation Server when writing 
the code for your external program, you must first include the library of functions defined for 
the Simulator Automation Server. This kind of library is referred to as a Type Library, which 
describes the available functions in a manner that can be interpreted by different 
programming languages. Importing a Type Library from another program is usually fairly 
simple, but the procedure does vary depending on the programming tool you are using. Please 
see the help for your programming tool of choice on how to import a Type Library or COM 
functions from another program. 
  

Examples 

The following examples are just a few specific examples for certain programming media. 
The procedure may be different for other programming media not listed. In addition, a 
procedure given for a certain type of programming media may be one variation from several 
possible procedures for accomplishing the same task. 

Borland Delphi 
• Install the version of PowerWorld Simulator with the Simulator Automation Server 

included. 
• In Delphi, choose Import Type Library… from the Project menu. 
• In the list of libraries, search for and choose pwrworld Library. 
• If pwrworld Library is not in the list, click Add. Find and choose the Pwrworld.exe file 

from the PowerWorld Simulator directory, and click Open. 
• You should see the class name TSimulatorAuto in the list of Class names. 
• Click Install to include the PowerWorld Simulator Type Library. 

Microsoft Visual Basic for Applications 
• No additional tasks are necessary 
• Importing Type Library still works (See Including Functions for version 9). 

Microsoft Visual C++ 
• Install the version of PowerWorld Simulator with the Simulation Automation Server 

included. 
• Add #import "…\powerworld.exe" in your external program code, using the full 

path to the PowerWorld Simulator executable program. 
• Add using namespace pwrworld in your external program code. 

Matlab v.6.5 r.13 
• No additional tasks are necessary. 
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Connecting to Simulator Automation Server 

  

Once the Type Library or COM functions have been included in your programming 
environment, the Simulator Automation Server can be handled as any other object in your 
code. The method for assigning and connecting to the Simulator Automation Server can vary 
depending on the programming environment used, but the idea is basically the same. You 
define a variable in your program to point to the server object, which is called SimulatorAuto. 
If the Type Library was imported properly, you should have full access to the SimulatorAuto 
object and its defined functions. Again, the procedure for creating the object and connecting 
to SimulatorAuto may vary for different programming languages. Check the help for your 
programming environment on connecting to COM or Automation servers. 
  

Examples 

The following examples are just a few specific examples for certain programming media. 
The procedure may be different for other programming media not listed. In addition, a 
procedure given for a certain type of programming media may be one variation from several 
possible procedures for accomplishing the same task. 

Borland Delphi 5 
• Add pwrworld_TLB to the uses section of your unit. 
• Declare a variable globally or as part of another object: A : ISimulatorAuto 
• Initialize the variable: A := nil 
• To connect to the Simulator Automation Server, create the connection: A := 

CoSimulatorAuto.create 
• Perform function calls to the Simulator Automation Server: Output := 

A.SomeFunction(parameters) 
• To close the connection to the Simulator Automation Server, remove the reference by 

again setting: A := nil 
Microsoft Visual Basic for Applications 

Early Binding: 

• To connect to the Simulator Automation Server, create the connection initializing the 
variable: 

Dim A as New pwrworld.SimulatorAuto 

Late Binding: 

• Declare a variable globally or as part of another object or function: Dim A As Object 
• To connect to the Simulator Automation Server, create the connection: 

Set A = CreateObject("pwrworld.SimulatorAuto") 

Both Early and Late Binding: 

• Perform function calls to the Simulator Automation Server: Output = 
A.SomeFunction parameters 

• To close the connection to the Simulator Automation Server, remove the reference: Set 
A = Nothing 

• If Type Library was imported, connection can also be achieved as in version 9 (See 
Connecting to Simulator Automation Server in version 9). 

Microsoft Visual C++ 
• Declare a variable globally or as part of another object or function: IsimulatorAutoPtr 

*A 
• Declare a variable globally or as part of another object or function: CLSID clsid 
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• Declare a variable globally or as part of another object or function: HRESULT hr 
• Obtain the class identifier (clsid) with the following command: 

hr = CLSIDFromProgID(L"pwrworld.SimulatorAuto", &clsid) 
• Initialize variable A: A = new IsimulatorAutoPtr 
• To connect to the Simulator Automation Server, create the connection: 

hr = A>CreateInstance(clsid, NULL, CLSCTX_SERVER) 
• Perform function calls to the Simulator Automation Server: Output = 

A.SomeFunction(parameters) 
• To close the connection to the Simulator Automation Server, release the reference: 

hr = A>Release() 

Matlab v.6.5 r.13 
• To connect to the Simulator Automation Server, create the connection: 

A = actxserver(‘pwrworld.SimulatorAuto’) 
• Perform function calls to the Simulator Automation Server: Output = 

A.SomeFunction(parameters) 
• To close the connection to the Simulator Automation Server, delete the connection: 

delete(A) 
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Passing Data to the Simulator Automation Server 

  

Passing Data to the Simulator Automation Server 

All data to the Simulator Automation Server is passed by value rather than by reference (in 
pointer terminology, this corresponds to sending data instead of pointer to data; in Microsoft 
Visual Basic®, this corresponds to sending data ByVal instead of ByRef). This makes the 
marshalling of data between client software and the COM object much easier. 
  

No Optional Parameters 

There are no optional parameters for any of the Simulator Automation functions. All functions 
must be called with every argument filled. 
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Getting Data from the Simulator Automation Server 

  

The Output Structure 

Every function called on the SimulatorAuto object returns the same value, Output, which has a 
well-defined structure. 

Output is of type VARIANT, and is an array of VARIANTs. Output is zero-indexed. 

The first element always contains any errors occurring during execution. For those functions 
returning more than one element in the Output array (e.g. ListOfDevices), explanation is 
provided below when discussing the specific method. 
  

Error Handling 

As mentioned above, the first item in the Output VARIANT array, Output[0], contains any 
errors occurring during the function’s execution. If no errors occurred during the function’s 
execution, Output[0] will be set to an empty BSTR (string) represented in most languages by 
either ‘’ or "". 
  

Error Format 

If an error string is returned, it will be in the following format: 

[method name]: [error_explanation] 

e.g. RunScriptCommand: Error occurred processing script command – check 
command syntax 
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Simulator Automation Server Functions 

  

The following list of functions is currently available once the SimulatorAuto object is set in your 
code. Check the help sections on these functions to see more detail on the particular function. 

ChangeParameters 

ChangeParametersSingleElement 

ChangeParametersMultipleElement 

ChangeParametersMultipleElementFlatInput 

CloseCase 

GetParametersSingleElement 

GetParametersMultipleElement 

GetParametersMultipleElementFlatOutput 

GetParameters (for compatibility with version 9) 

ListOfDevices 

ListOfDevicesAsVariantStrings 

ListOfDevicesFlatOutput 

OpenCase 

ProcessAuxFile 

RunScriptCommand 

GetFieldList 

SaveState 

LoadState 

SaveCase 

SendToExcel 

WriteAuxFile 
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ChangeParameters Function 

  

The ChangeParameters function has been replaced by the ChangeParametersSingleElement 
function. ChangeParameters can still be called as before, but will now just automatically call 
ChangeParametersSingleElement, and pass on the parameters to that function. 
  

Function Prototype 

ChangeParameters(ObjectType, ParamList, Values) 

  

Parameter Definitions 

ObjectType : String The type of object you are changing parameters for. 

ParamList : Variant A variant array storing strings (COM Type BSTR). This array 
stores a list of PowerWorld® object field variables, as defined in the section on 
PowerWorld Object Fields. The ParamList must contain the key field variables for the 
specific device, or the device cannot be identified. 

Values : Variant A variant array storing variants. This array can store any type of 
information (integer, string, etc.) in each array position. A value should be passed for 
each field variable given in the ParamList. The Values array must contain the key field 
values for the specific device, or the device cannot be identified. 
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ChangeParametersSingleElement Function 

  

The ChangeParametersSingleElement function allows you to set a list of parameters for a 
single object in a case loaded into the Simulator Automation Server. In addition to changing 
parameters for objects, this function can also be used to set options for some of the Simulator 
tools, such as ATC and OPF. This function is identical in setup to the 
GetParametersSingleElement function, with the exception that the Values array must contain a 
value for each field variable given in the ParamList array. 
  

Function Prototype 

ChangeParametersSingleElement(ObjectType, ParamList, Values) 

  

Parameter Definitions 

ObjectType : String The type of object you are changing parameters for. 

ParamList : Variant A variant array storing strings (COM Type BSTR). This array 
stores a list of PowerWorld® object field variables, as defined in the section on 
PowerWorld Object Fields. The ParamList must contain the key field variables for the 
specific device, or the device cannot be identified. 

Values : Variant A variant array storing variants. This array can store any type of 
information (integer, string, etc.) in each array position. A value should be passed for 
each field variable given in the ParamList. The Values array must contain the key field 
values for the specific device, or the device cannot be identified. 

  

Output 

ChangeParametersSingleElement only returns the first element in Output, the error 
string. 

  

Notes 

The ParameterList and Values arrays must be the same size, as each parameter must 
have a corresponding value to be assigned. 
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ChangeParametersSingleElement Sample Code 

  

Borland® Delphi 

Var ParamList, ValueList : OLEVariant 
  

// Set ParamList up to modify the maximum number of iterations 

// and the system base for the power flow simulations 

ParamList := VarArrayCreate([1,2], varOleStr); 

ParamList[1] := 'MaxItr'; 

ParamList[2] := 'SBase'; 
  

// ValueList is setup with 41 and 410 for MaxItr and SBase, 

// respectively 

ValueList := VarArrayCreate([1,2], varOleStr); 

ValueList[1] := 41; 

ValueList[2] := 410; 
  

// Make the ChangeParametersSingleElement call 

Output = SimAuto.ChangeParametersSingleElement('Sim_Solution_Options', _ 
 ParamList, ValueList)  

  

Microsoft® Visual Basic for Applications 

' Set ParamList up to modify the maximum number of iterations 

' and the system base for the power flow simulations 

Dim ParamList As Variant 

ParamList = Array("MaxItr", "Sbase") 
  

' ValueList is setup with 41 and 410 for MaxItr and SBase, 

' respectively 

Dim ValueList As Variant 

ValueList = Array(45, 90) 
  

' Make the ChangeParametersSingleElement call 

Output = SimAuto.ChangeParametersSingleElement("Sim_Solution_Options", _ 
 ParamList, ValueList)  

  

Matlab® 

% Set ParamList up to modify the maximum number of iterations 

% and the system base for the power flow simulations 

ParamList = {'MaxItr' 'Sbase'}; 
  

% values is setup with 41 and 410 for MaxItr and SBase, 
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% respectively 

values = [41 410]; 
  

% Convert the values matrix to a set of cells for passing 

% through the COM interface 

ValueList = num2cell(values); 
  

' Make the ChangeParametersSingleElement call 

Output = SimAuto.ChangeParametersSingleElement('Sim_Solution_Options', _ 
 ParamList, ValueList)  
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ChangeParametersMultipleElement Function 

  

The ChangeParametersMultipleElement function allows you to set parameters for multiple 
objects of the same type in a case loaded into the Simulator Automation Server. This function 
is very similar to the ChangeParametersSingleElement, but allows for modifying multiple 
elements with a single function call. The advantage of this function is that it is much faster to 
change multiple elements with a single function call than it is to repeatedly call 
ChangeParametersSingleElement multiple times. 
  

Function Prototype 

ChangeParametersMultipleElement(ObjectType, ParamList, Values) 

  

Parameter Definitions 

ObjectType : String The type of object you are changing parameters for. 

ParamList : Variant A variant array storing strings (COM Type BSTR). This array 
stores a list of PowerWorld® object field variables, as defined in the section on 
PowerWorld Object Fields. The ParamList must contain the key field variables for the 
specific device, or the device cannot be identified. 

ValueList : Variant A variant array storing arrays of variants. This is the difference 
between the multiple element and single element change parameter functions. This 
array stores a list of arrays of values matching the fields laid out in ParamList. You 
construct ValueList by creating an array of variants with the necessary parameters for 
each device, and then inserting each individual array of values into the ValueList array. 
SimAuto will pick out each array from ValueList, and calls 
ChangeParametersSingleElement internally for each array of values in ValueList. 

  

Output 

ChangeParametersMultipleElement only returns the first element in Output, the error 
string. 

  

Notes 

The ParameterList and each array of values stored in ValueList must be the same size, 
as each parameter must have a corresponding value to be assigned. 
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ChangeParametersMultipleElement Sample Code  

  

Borland® Delphi 

Var ParamList, ValueList : OLEVariant 
  

// Set ParamList up to modify the MW output of generators 

ParamList := VarArrayCreate([1,3], varOleStr); 

ParamList[1] := 'BusNum'; 

ParamList[2] := 'GenID'; 

ParamList[3] := ‘GenMW’; 
  

// ValueList is setup with MW values for generators at buses 1 and 2 

ValueList := VarArrayCreate([1,2], varOleStr); 

For k := 1 to 2 do begin 

IndValueList := VarArrayCreate([1,3], varOleStr); 

IndValueList[1] := k; 

IndValueList[2] := ‘1’; 

IndValueList[3] := k*10; 

ValueList[k] := IndValueList; 

End; 
  

// Make the ChangeParametersMultipleElement call 

Output = SimAuto.ChangeParametersMultipleElement('Sim_Solution_Options', _ 
 ParamList, ValueList)  

  

Microsoft® Visual Basic for Applications 

' Set ParamList up to modify the MW output of generators 

Dim ParamList As Variant 

ParamList = Array("BusNum", "GenID", "GenMW") 
  

' ValueList is setup with MW values for generators at buses 1 and 2 

Dim ValueList(2) As Variant 

For k = 0 to 1 

Dim IndValueList As Variant 

IndValueList = Array(k+1,"1",(k+1)*10) 

ValueList(k) = IndValueList 

Next 
  

' Make the ChangeParametersMultipleElement call 

Output = SimAuto.ChangeParametersMultipleElement("Sim_Solution_Options", _ 
 ParamList, ValueList)  
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ChangeParametersMultipleElementFlatInput Function 

  

The ChangeParametersMultipleElementFlatInput function allows you to set parameters for 
multiple objects of the same type in a case loaded into the Simulator Automation Server. This 
function is very similar to the ChangeParametersMultipleElement, but uses a single 
dimensioned array of values as input instead of a multi-dimensioned array of arrays. The 
advantage of this function is that it is much faster to change multiple elements with a single 
function call than it is to repeatedly call ChangeParametersSingleElement multiple times. An 
additional advantage over ChangeParametersMultipleElement is that you can still take 
advantage of the speed improvement, even if the programming language you are using does 
not support multi-dimensioned arrays. 
  

Function Prototype 

ChangeParametersMultipleElement(ObjectType, ParamList, NoOfObjects, 
ValueList) 

  

Parameter Definitions 

ObjectType : String The type of object you are changing parameters for. 

ParamList : Variant A variant array storing strings (COM Type BSTR). This array 
stores a list of PowerWorld® object field variables, as defined in the section on 
PowerWorld Object Fields. The ParamList must contain the key field variables for the 
specific device, or the device cannot be identified. 

NoOfObjects You must pass an integer number of devices that are passing values for. 
SimAuto will automatically check that the number of parameters for each device 
(counted from ParamList) and the number of objects integer correspond to the number 
of values in value list (counted from ValueList.) 

ValueList : Variant A variant array storing a list of variants. Value list can be an array 
with many values, as it is a single dimensioned array of all values for all devices that 
are being changed. The structure of the ValueList array is such that all of the 
parameters for the first object are listed first, then all parameters for the second object, 
and so on. The parameters must be in the same order as given in ParamList. In other 
words, your array would look like: 
 
ValueList = Array(Obj1Param1, Obj1Param2, Obj2Param1, Obj2Param2,Obj3Param1, 
…, ObjNParam1, ObjNParam2) 

  

Output 

ChangeParametersMultipleElementFlatInput only returns the first element in Output, 
the error string. 

  

Notes 

If the number of parameters given in ParamList multiplied by the number of objects 
passed does not equal the total number of values in ValueList, SimAuto will abort the 
function call. 
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ChangeParametersMultipleElementFlatInput Sample Code  

  

Borland® Delphi 

Var ParamList, ValueList : OLEVariant 
  

// Set ParamList up to modify the MW output of generators 

ParamList := VarArrayCreate([1,3], varOleStr); 

ParamList[1] := 'BusNum'; 

ParamList[2] := 'GenID'; 

ParamList[3] := ‘GenMW’; 
  

// ValueList is setup with MW values for generators at buses 1 and 2 

NumObjects := 2; 

NumFields := NumObjects * 3; 

ValueList := VarArrayCreate([1,NumFields], varOleStr); 

For k := 0 to 1 do begin 

ValueList[3*k+1] := k; 

ValueList[3*k+2] := ‘1’; 

ValueList[3*k+3] := k*10; 

End; 
  

// Make the ChangeParametersMultipleElementFlatInput call 

Output = SimAuto.ChangeParametersMultipleElementFlatInput('Sim_Solution_Options', _ 

 ParamList, NumObjects, ValueList) 

  

Microsoft® Visual Basic for Applications 

' Set ParamList up to modify the MW output of generators 

Dim ParamList As Variant 

ParamList = Array("BusNum", "GenID", "GenMW") 
  

' ValueList is setup with MW values for generators at buses 1 and 2 

NumObjects = 2 

NumFields = NumObjects * 3 

Dim ValueList(NumObjects) As Variant 

For k = 0 to 1 

ValueList(3*k+1) = k 

ValueList[3*k+2] := ‘1’; 

ValueList[3*k+3] := k*10; 

Next 
  

' Make the ChangeParametersMultipleElementFlatInput call 
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Output = SimAuto.ChangeParametersMultipleElementFlatInput("Sim_Solution_Options", _ 

 ParamList, NumObjects, ValueList) 
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CloseCase Function 

  

The CloseCase function is used to close a load flow case loaded in the Simulator Automation 
Server. This function should be called at some point after the OpenCase function. 
  

Function Prototype 

CloseCase() 
  

Parameter Definitions 

No parameters are passed. 

  

Output 

CloseClase returns only one element in Output—any errors which may have occurred 
when attempting to close the case. 
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CloseCase Function: Sample Code  

  

Borland® Delphi 

Output := SimAuto.CloseCase(); 

  

Microsoft® Visual Basic for Applications 

Output = SimAuto.CloseCase() 

  

Matlab® 

Output = SimAuto.CloseCase 
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GetFieldList Function 

  

The GetFieldList function is used to find all fields contained within a given object type. 
  

Function Prototype 

GetFieldList(ObjectType) 
  

Parameter Definitions 

ObjectType : String The type of object for which the fields are requested. 

  

Output 

GetFieldList returns two elements of the Output array. The first element, as with the 
other functions, returns any errors that might have occurred. The second element of 
the Output array contains an n x 4 array of fields. The layout of this array is virtually 
identical to the output obtained by going to Help > Export Case Object Fields from 
the main menu of Simulator. The first column, corresponding to the (n,0) column in the 
field array, specifies which fields are key fields for the object. The second column, 
(n,1), contains the internal name of the field. The third column, (n,2), contains the type 
of data stored in the string (e.g. String, Integer, Real). The fourth column, (n,3), 
contains the display-friendly name of the field. 
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GetFieldList Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

Dim objecttype As String 
  

' Object type to obtain 

objecttype = "branch" 
  

' Make the GetField call 

Output = SimAuto.GetFieldList(objecttype) 
  

Matlab® 

% Object type to obtain 

objecttype = 'branch'; 
  

% Make the GetField call 

Output = SimAuto.GetFieldList(objecttype); 
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GetParametersSingleElement Function 

  

The GetParametersSingleElement function is used to request the values of specified fields for a 
particular object in the load flow case. For returning field values for multiple objects, you can 
use a loop to make repeated calls to the GetParametersSingleElement function, and pass the 
object and desired field information for each object. This function is identical in setup to the 
ChangeParameters function, with the exception that the Values array will be updated with the 
values for the field variables defined in ParamList. 
  

Function Prototype 

GetParametersSingleElement(ObjectType, ParamList, Values) 
  

Parameter Definitions 

ObjectType : String The type of object you are changing parameters for. 

ParamList : Variant A variant array storing strings. This array stores a list of 
PowerWorld® object field variables, as defined in the section on PowerWorld Object 
Fields. The ParamList must contain the key field variables for the specific device, or the 
device cannot be identified. The remaining field variables in the array define which 
values to retrieve from Simulator. 

Values : Variant A variant array storing variants. This array can store any type of 
information (integer, string, etc.) in each array position. Values must be passed for the 
key field variables in ParamList, in the same array position. The remaining field positions 
in the Values array should be set to zero. 

  

Output 

GetParametersSingleElement returns both the first element in Output—containing any 
errors occurring during execution of the function—and a second element in Output. The 
second element returned in the Output structure is a one dimensional array containing 
the values corresponding to the fields specified in ParamList. 

The Output structure of GetParametersSingleElement is shown in the following figure. 
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GetParametersSingleElement Function: Sample Code Borland® Delphi  

  

// This example retrieves some parameters for bus 2 of the loaded 

// case, using the GetParametersSingleElement function, as well as 

// the old GetParameters function 
  

procedure TMainForm.RunGPSEClick(Sender: TObject); 

var 
 Output : OLEVariant;  
 FieldBusArray, ValueBusArray : OLEVariant;  
 i : Integer;  

begin 
 // Declares fields array to be sent to Excel  
 FieldBusArray := VarArrayCreate([1,5], varOleStr);  
 FieldBusArray[1] := 'pwBusNum';  
 FieldBusArray[2] := 'pwBusname';  
 FieldBusArray[3] := 'pwBusKVVolt';  
 FieldBusArray[4] := 'pwBusPUVolt';  
 FieldBusArray[5] := 'pwBusAngle';  
 ValueBusArray := varArrayCreate([1,5],varOleStr);  
 ValueBusArray[1] := 2; // To get parameters for bus 2  
 ValueBusArray[2] := 0;  
 ValueBusArray[3] := 0;  
 ValueBusArray[4] := 0;  
 ValueBusArray[5] := 0;  
  
 // Gets parameters with GetParametersSingleElement function  
 Output := SimAuto.GetParametersSingleElement('bus', FieldBusArray, ValueBusArray);  
 if (string(Output[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])  
 else  
 begin  
 StatusBar1.Panels[1].Text := 'Parameters got.';  
 Memo1.Lines.Add('== GetParametersSingleElement ==');  
 Memo1.Lines.Add('Value : Output[1][i]');  
 for i := VarArrayLowBound(Output[1],1) to VarArrayHighBound(Output[1],1) do begin  
 Memo1.Lines.Add(FieldBusArray[i] + ' : ' + string(Output[1][i]));  
 end;  
 Memo1.Lines.Add('');  
 end;  
  
 // Gets parameters with old function GetParameters  
 Output := SimAuto.GetParameters('bus', FieldBusArray, ValueBusArray);  
 if (string(Output[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])  
 else  
 begin  
 StatusBar1.Panels[1].Text := 'Parameters got.';  
 Memo1.Lines.Add('== GetParameters ==');  
 Memo1.Lines.Add('Value : Output[1][i]');  
 for i := VarArrayLowBound(Output[1],1) to VarArrayHighBound(Output[1],1) do begin  
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 Memo1.Lines.Add(FieldBusArray[i] + ' : ' + string(Output[1][i]));  
 end;  
 Memo1.Lines.Add('');  
 end;  

end; 
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GetParametersSingleElement Function: Sample Code Matlab®  

  

% This example loads all buses in the case, and then gets 

% some parameters of the last bus in the list 
  

% validcase is a global variable – check case is open 

if validcase  
 % Gets all buses in the case  
 output = simauto.ListOfDevices('bus','');  
 if ~(strcmp(output{1},''))  
 disp(output{1})  
 validbusarray = false;  
 else  
 % Puts the buses in row vector busarray  
 for i=size(output{2}{1},1):size(output{2}{1},2)  
 busarray(i,1) = output{2}{1}(i);   
 end  
 disp('Succesful ListOfDevices')  
 disp(busarray)  
 validbusarray = true;  
 end  

end 
  

% validbusarray is a global variable – check buses are loaded 

if validcase & validbusarray 
 % Gets parameters for last bus of busarray  
 fieldarray = {'pwbusnum' 'pwbusname' 'pwbusvolt' 'pwbusangle'};  
 valuearray = [busarray(size(busarray,1)) '0' '0' '0'];  
 valuelist = num2cell(valuearray);  
 output = simauto.GetParametersSingleElement('bus',fieldarray,valuelist);  
 if ~(strcmp(output{1},''))  
 disp(output{1})  
 else  
 % Puts the buses in row vector busparam  
 paramlist = transpose(output{2});  
 for i=size(paramlist,1):size(paramlist,2)  
 busparam(i,1) = paramlist(i);   
 end  
 disp('Succesful GetParameters for Bus')  
 disp(fieldarray)  
 disp(busparam)  
 end  

end 
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GetParametersSingleElement Function: Sample Code Microsoft® Visual Basic for 
Excel  

  

Private Sub btnGetParametersSingleElement_Click() 

Dim objtype, filter As String 

Dim xlWB As Excel.Workbook 

Set xlApp = Excel.Application 
  

' Checks connection and open case 

' SimAuto and caseopen are global variables 

If Not SimAuto Is Nothing And caseopen Then 
 objtype = "bus"  
 Dim fieldArray As Variant  
 fieldArray = Array("pwBusNum", "pwBusName", "pwBusKVVolt", _  
 "pwBusPUVolt", "pwBusAngle")  
 Dim ValueArray As Variant  
 ValueArray = Array(1, 0, 0, 0, 0)  
 output = SimAuto.GetParameters(objtype, fieldArray, ValueArray)  
 If output(0) <> "" Then  
 DisplayErrorMessage output(0)  
 Else  
 DisplayMessage "Succesful GetParametersSingleElement"  
 ' Prepares additional worksheet  
 Set xlWB = xlApp.Workbooks.Add  
 ' Copies list of devices in worksheet  
 With xlWB  
 Sheets("sheet2").Activate  
 Sheets("sheet2").Name = "GetParametersSingleElement"  
 With Sheets("GetParametersSingleElement")  
 Dim i As Integer  
 Range(Cells(1, 5), Cells(200, 7)).Clear  
 Cells(1, 1) = "List of Devices for " + objtype + ":"  
 ' Setup fields as subheader  
 For i = LBound(fieldArray) To UBound(fieldArray)  
 Cells(2, i + 1) = fieldArray(i)  
 Next i  
 ' Determine number of fields retrieved  
 Dim lowfld, highfld As Integer  
 lowfld = LBound(output(1), 1)  
 highfld = UBound(output(1), 1)  
 DisplayMessage "Number of Fields: " + Str(lowfld) + Str(highfld)  
 For i = lowfld To highfld  
 Cells(j + 3, i + 1) = output(1)(i)  
 Next i  
 End With  
 End With  
 End If  

End If 

End Sub 
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GetParametersMultipleElement Function 

  

The GetParametersMultipleElement function is used to request the values of specified fields for 
a set of objects in the load flow case. The function can return values for all devices of a 
particular type, or can return values for only a list of devices of a particular type based on an 
advanced filter defined for the loaded case. 
  

Function Prototype 

GetParametersMultipleElement(ObjectType, ParamList, FilterName) 

  

Parameter Definitions 

ObjectType : String The type of object you are changing parameters for. 

ParamList : Variant A variant array storing strings. This array stores a list of 
PowerWorld® object field variables, as defined in the section on PowerWorld Object 
Fields. The ParamList must contain the key field variables for the specific device, or the 
device cannot be identified. The remaining field variables in the array define which 
values to retrieve from Simulator. 

FilterName : String The name of an advanced filter defined in the load flow case open 
in the Simulator Automation Server. If no filter is desired, then simply pass an empty 
string. If a filter name is passed but the filter cannot be found in the loaded case, the 
server will default to returning all objects in the case of type ObjType. 

  

Output 

GetParametersMultipleElement returns a set of nested arrays containing the parameter 
values for the device type requested. The number of arrays of values returned depends 
on the number of fields in ParamList. 

The Output structure of GetParametersMultipleElement is shown in the following figure. 
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As you can see, to access the first parameter value for the first device, Output[1][0][0] 
would be the correct array index. For example, the bus number for the first bus would be 
stored at Output[1][0][0] after calling 
Output = GetParametersMultipleElement('Bus',fieldarray, ''), and 
assuming that we have fieldarray = Array(pwBusnum, pwBusName). 
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GetParametersMultipleElement Sample Code Borland® Delphi  

  

// This example retrieves some parameters for all buses of the 

// loaded case, using the GetParametersMultipleElement function 
  

procedure TMainForm.RunGPMEClick(Sender: TObject); 

var 
 FieldBusArray : OLEVariant;  
 i,j : Integer;  

begin 
 // Declares fields array to be sent to Excel  
 FieldBusArray := VarArrayCreate([1,5], varOleStr);  
 FieldBusArray[1] := 'pwBusNum';  
 FieldBusArray[2] := 'pwBusname';  
 FieldBusArray[3] := 'pwBusKVVolt';  
 FieldBusArray[4] := 'pwBusPUVolt';  
 FieldBusArray[5] := 'pwBusAngle';  
  
 // Gets parameters with Multiple Element function  
 Output := SimAuto.GetParametersMultipleElement('bus', FieldBusArray, '');  
 if (string(Output[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])  
 else  
 begin  
 StatusBar1.Panels[1].Text := 'Parameters got.';  
 Memo1.Lines.Add('== GetParametersMultipleElement ==');  
 Memo1.Lines.Add('Value : Output[1][i][j]');  
 for i := VarArrayLowBound(Output[1],1) to VarArrayHighBound(Output[1],1) do begin  
 for j := VarArrayLowBound(Output[1][i],1) to VarArrayHighBound(Output[1][i],1)   
 do begin  
 Memo1.Lines.Add(FieldBusArray[i] + '(' + IntToStr(j) + ') : ' +   
 string(Output[1][i][j]));  
 end;  
 end;  
 Memo1.Lines.Add('');  
 end;  

end; 
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GetParametersMultipleElement Function: Sample Code Matlab®  

  

% This example loads all buses in the case, and then gets 

% some parameters of such buses 
  

% validcase is a global variable – check case is open 

if validcase  
 % Gets all buses in the case  
 output = simauto.ListOfDevices('bus', '');  
 if ~(strcmp(output{1},''))  
 disp(output{1})  
 validbusarray = false;  
 else  
 % Puts the buses in row vector busarray  
 for i=size(output{2}{1},1):size(output{2}{1},2)  
 busarray(i,1) = output{2}{1}(i);   
 end  
 disp('Succesful ListOfDevices')  
 disp(busarray)  
 validbusarray = true;  
 end  

end 
  

% validbusarray is a global variable – check buses are loaded 

if validcase & validbusarray 
 % Gets parameters for all buses  
 fieldarray = {'pwbusnum' 'pwbusname' 'pwbusvolt' 'pwbusangle'};  
 output = simauto.GetParametersMultipleElement('bus', fieldarray,' ');  
 if ~(strcmp(output{1},''))  
 disp(output{1})  
 else  
 % Puts the buses in matrix busesparam  
 paramlist = transpose(output{2});  
 for i=size(paramlist,1):size(paramlist,2)  
 for j=size(paramlist{i},2):size(paramlist{i},1)  
 busesparam(j,i) = paramlist{i}(j);  
 end  
 end  
 disp('Succesful GetParametersMultipleElement')  
 disp(fieldarray)  
 disp(busesparam)  
 end  

end 
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GetParametersMultipleElement Function: Sample Code Microsoft® Visual Basic for 
Excel  

  

Private Sub btnGetParametersMultiple_Click() 

Dim objtype, filter As String 

Dim xlWB As Excel.Workbook 

Set xlApp = Excel.Application 
  

' Checks connection and open case 

' SimAuto and caseopen are global variables 

If Not SimAuto Is Nothing And caseopen Then 
 objtype = "bus"  
 filter = ""  
 Dim fieldArray As Variant  
 fieldArray = Array("pwBusNum", "pwBusName", "pwBusKVVolt", _  
 "pwBusPUVolt", "pwBusAngle")  
 output = SimAuto.GetParametersMultipleElement(objtype, fieldArray, filter)  
 If output(0) <> "" Then  
 DisplayErrorMessage output(0)  
 Else  
 DisplayMessage "Succesful GetParametersSingleElement"  
 ' Prepares additional worksheet  
 Set xlWB = xlApp.Workbooks.Add  
 ' Copies list of devices in worksheet  
 With xlWB  
 Sheets("sheet2").Activate  
 Sheets("sheet2").Name = "GetParametersSingleElement"  
 With Sheets("GetParametersSingleElement")  
 Dim i, j As Integer  
 Range(Cells(1, 5), Cells(200, 7)).Clear  
 Cells(1, 1) = "List of Devices for " + objtype + ":"  
 ' Setup fields as subheader  
 For i = LBound(fieldArray) To UBound(fieldArray)  
 Cells(2, i + 1) = fieldArray(i)  
 Next i  
 ' Determine number of fields retrieved  
 Dim lowfld, highfld As Integer  
 lowfld = LBound(output(1), 1)  
 highfld = UBound(output(1), 1)  
 ' Determine number of objects retrieved  
 Dim lowobj, highobj As Integer  
 lowobj = LBound(output(1)(lowkeyf), 1)  
 highobj = UBound(output(1)(lowkeyf), 1)  
 DisplayMessage "Number of Fields: " + Str(lowfld) + Str(highfld)  
 DisplayMessage "Number of objects: " + Str(lowobj) + Str(highobj)  
 For i = lowfld To highfld  
 For j = lowobj To highobj  
 Cells(j + 3, i + 1) = output(1)(i)(j)  
 Next j  
 Next i  
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 End With  
 End With  
 End If  

End If 

End Sub 
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GetParametersMultipleElementFlatOutput Function 

  

This function operates the same as the GetParametersMultipleElement function, only with one 
notable difference. The values returned as the output of the function are returned in a single-
dimensional vector array, instead of the multi-dimensional array as described in the 
GetParametersMultipleElement topic. The function returns the parameter values for the device 
type requested, and the number of values returned depends on the ParamList and any 
advanced filter that impacts the number of devices returned.  

The format of the output array is the following: 
  

[errorString, NumberOfObjectsReturned, NumberOfFieldsPerObject, Ob1Fld1, Ob1Fld2, …, 
Ob(n)Fld(m-1), Ob(n)Fld(m)] 
  

The data is thus returned in a single dimension array, where the parameters 
NumberOfObjectsReturned and NumberOfFieldsPerObject tell you how the rest of the array is 
populated. Following the NumberOfObjectsReturned parameter is the start of the data. The 
data is listed as all fields for object 1, then all fields for object 2, and so on. You can parse the 
array using the NumberOf… parameters for objects and fields. 
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GetParameters Function 

  

This function is maintained in versions of Simulator later than version 9 for compatibility with 
Simulator version 9. This function is replaced by GetParametersSingleElement. See also 
GetParametersMultipleElement. 
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ListOfDevices Function 

  

The ListOfDevices function is used to request a list of objects and their key fields from the 
Simulator Automation Server. The function can return all devices of a particular type, or can 
return only a list of devices of a particular type based on an advanced filter defined for the 
loaded case. This function is best used in conjunction with a looping procedure and the 
ChangeParameters or GetParametersSingleElement functions to process a group of devices. 
  

Function Prototype 

ListOfDevices(ObjType, filterName) 
  

Parameter Definitions 

ObjType : String The type of object for which you are acquiring the list of devices. 

FilterName : String The name of an advanced filter defined in the load flow case open 
in the Simulator Automation Server. If no filter is desired, then simply pass an empty 
string. If the filter cannot be found, the server will default to returning all objects in the 
case of type ObjType. 

  

Output 

ListOfDevices returns a set of nested arrays containing the key field values for the device 
type requested. The number of arrays of values returned depends on the object type 
selected. For instance, buses have only one key field (the bus number) so calling 
ListOfDevices for buses will return only one array of values—the bus numbers. On the 
other hand, calling ListOfDevices for branches will return three arrays of values—the 
"From" bus, "To" bus, and ID—for each branch in the case meeting the specified filter. 

The arrays containing the key field values for each device are arranged as shown in the 
following figure. 
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As you can see, to access the first key field value for the first device, Output[1][0][0] 
would be the correct array index. For example, the bus number (which is the bus key 
field) for the first bus would be stored at Output[1][0][0] after calling Output = 
ListOfDevices('Bus', ''). 

One unique limitation of the ListOfDevices function from other SimAuto functions is that 
this is the only function that returns the output as strongly typed variables. The bus 
numbers are always returned as Long Integers, and the Circuit ID values are returned as 
strings. This was actually an oversight during the design of SimAuto. In all other SimAuto 
functions, the values are returned as Variant types, with each value within the variant 
being a string. This was the intended operation for this function as well. Since the 
Automation Server interface was released with the errant inclusion of the ListOfDevices 
function, it could not be modified. Therefore, another function, 
ListOfDevicesAsVariantStrings, has been created. This function returns all values in 
variant variables, with each as a string within the variant type. 
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ListOfDevices Function: Sample Code for Borland® Delphi  

  

Sample Code 

// Runs Available Transfer Capability Routine 

// Executes ATC Calculations among all areas 

// and sends results to Excel 

procedure TMainForm.RunATCClick(Sender: TObject); 

var 
 i, j, LowB, HighB : Integer;  
 ValuesAreaArray : OLEVariant;  

begin 
 // Obtain all the areas  
 Output := SimAuto.ListOfDevices('area', '');  
 if (string(Output[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])  
 else  
 begin  
 ValuesAreaArray := Output[1][0];  
 LowB := VarArrayLowBound(ValuesAreaArray, 1);  
 HighB := VarArrayHighBound(ValuesAreaArray, 1);  
 // Executes loop  
 for i := LowB to HighB do  
 for j := LowB to HighB do begin  
 if (i <> j) then begin  
 // Runs ATC calculations  
 OutputATC := SimAuto.RunScriptCommand('entermode(atc); ' +   
 'atcdetermine([Area ' + IntToStr(ValuesAreaArray[i]) +   
 '], [Area ' + IntToStr(ValuesAreaArray[j]) + '])');  
 if (string(OutputATC[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(OutputATC[0])  
 else begin  
 // Sends ATC results to Excel  
 Output := SimAuto.SendToExcel('transferlimiter', '', 'all');  
 if (string(Output[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0])  
 else  
 StatusBar1.Panels[1].Text := 'ATC calculations done.';  
 end;  
 end;  
 end;  
 end;  

end; 
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ListOfDevices Function: Sample Code for Matlab®  

  

Sample Code 

%A list of branches is desired, without using any filter 

DeviceType = 'Branch'; 

FilterName = ''; 

%Execute the ListOfDevices command 

Output = SimAuto.ListOfDevices(DeviceType,FilterName); 

%If the first cell in SimAutoOutput ~= '', then that means an error 

%occurred. 

if ~(strcmp(SimAutoOutput{1},'')) 
 disp(SimAutoOutput{1})  

else 
 %Otherwise, no errors. Display the branch information.  
 disp('ListOfDevices successful')  
   
 %Devicelist1 contains the From: bus number  
 %Devicelist2 contains the To: bus number  
 %Devicelist3 contains the Bus identifier  
 devicelist1 = double(transpose(SimAutoOutput{2}{1}));  
 devicelist2 = double(transpose(SimAutoOutput{2}{2}));  
 devicelist3 = SimAutoOutput{2}{3};  
  
 %If the device list is greater than 25, don't bother attempting to  
 %display it on the screen.  
 if (size(devicelist1,1) > 25)   
 disp('Device list exceeds 25; use ''devicelist'' to manage list of devices')  
 else   
 %Otherwise, display the branches' information.  
 disp(DeviceType)  
 disp('From/To/Identifier')  
 for counter = 1:size(devicelist1,1)  
 %num2str converts the numbers within devicelist1 and  
 %devicelist2 to strings for output with disp(). the char()  
 %function is called on devicelist3's members because the  
 %SimAuto object returns a character array (as opposed to a  
 %properly Matlab-format string) and this array must be  
 %converted to a Matlab-format string.  
 disp([num2str(devicelist1(counter)) ' ' ...  
 num2str(devicelist2(counter)) ' ' ...  
 char(devicelist3(counter))])   
 end  
 end  

end 

 



PowerWorld Simulator Add-On Tools 
 
 

1090 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

ListOfDevices Function: Sample Code for Microsoft® Visual Basic for Excel  

  

Sample Code 

Private Sub DisplayMessage(ByVal SentText As String) 
 TextBox.Text = TextBox.Text + SentText + vbCrLf + vbCrLf  

End Sub 
  

Private Sub btnListOfDevices_Click() 

Dim objtype, filter As String 

Dim xlWB As Excel.Workbook 

Set xlApp = Excel.Application 
  

' Checks connection and open case 

' SimAuto and caseopen are global variables 

If Not SimAuto Is Nothing And caseopen Then 
 objtype = "branch"  
 filter = ""  
 output = SimAuto.ListOfDevices(objtype, filter)  
 If output(0) <> "" Then  
 DisplayMessage output(0)  
 Else  
 DisplayMessage "Succesful List Of Devices"  
 ' Prepares additional worksheet  
 Set xlWB = xlApp.Workbooks.Add  
 ' Copies list of devices in worksheet  
 With xlWB  
 Sheets("sheet1").Activate  
 Sheets("sheet1").Name = "ListOfDevices"  
 With Sheets("ListOfDevices")  
 Dim i, j As Integer  
 Range(Cells(1, 5), Cells(200, 7)).Clear  
 Cells(1, 1) = "List of Devices for " + objtype + ":"  
 Cells(2, 1) = "From Bus Num"  
 Cells(2, 2) = "To Bus Num"  
 Cells(2, 3) = "ID"  
 ' Determine number of key fields retrieved  
 Dim lowkeyf, highkeyf As Integer  
 lowkeyf = LBound(output(1), 1)  
 highkeyf = UBound(output(1), 1)  
 DisplayMessage "Number of Key Fields: " + Str(lowkeyf) + Str(highkeyf)  
 ' Determine number of objects retrieved  
 Dim lowobj, highobj As Integer  
 lowobj = LBound(output(1)(lowkeyf), 1)  
 highobj = UBound(output(1)(lowkeyf), 1)  
 DisplayMessage "Number of objects: " + Str(lowobj) + Str(highobj)  
 For i = lowkeyf To highkeyf  
 For j = lowobj To highobj  
 Cells(j + 3, i + 1) = output(1)(i)(j)  
 Next j  
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 Next i  
 End With  
 End With  
 End If  

End If 

End Sub 
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ListOfDevicesAsVariantStrings Function 

  

This function operates the same as the ListOfDevices function, only with one notable 
difference. The values returned as the output of the function are returned as Variants of type 
String. The ListOfDevices function was errantly released returning the values strongly typed as 
Integers and Strings directly, whereas all other SimAuto functions returned data as Variants of 
type String. This function was added to also return the data in the same manner. This solved 
some compatibility issues with some software languages. 
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ListOfDevicesFlatOutput Function 

  

This function operates the same as the ListOfDevices function, only with one notable 
difference. The values returned as the output of the function are returned in a single-
dimensional vector array, instead of the multi-dimensional array as described in the 
ListOfDevices topic. The function returns the key field values for the device, typically in the 
order of bus number 1, bus number 2 (where applicable), and circuit identifier (where 
applicable). These are the most common key fields, but some object types do have other key 
fields as well. 
  

The format of the output array is the following: 
  

[errorString, NumberOfObjectsReturned, NumberOfFieldsPerObject, Ob1Fld1, Ob1Fld2, …, 
Ob(n)Fld(m-1), Ob(n)Fld(m)] 
  

The data is thus returned in a single dimension array, where the parameters 
NumberOfObjectsReturned and NumberOfFieldsPerObject tell you how the rest of the array is 
populated. Following the NumberOfObjectsReturned parameter is the start of the data. The 
data is listed as all fields for object 1, then all fields for object 2, and so on. You can parse the 
array using the NumberOf… parameters for objects and fields. 
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LoadState Function 

  

LoadState is used to load the system state previously saved with the SaveState function. Note 
that LoadState will not properly function if the system topology has changed due to the 
addition or removal of the system elements. 
  

Function Prototype 

LoadState() 
  

Parameter Definitions 

No parameters are passed. 

  

Output 

LoadState returns only one element in Output—any errors which may have occurred 
when attempting to execute the function. 
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LoadState Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

' Make the LoadState call 

Output = SimAuto.LoadState() 

  

Matlab® 

% Make the LoadState call 

Output = SimAuto.LoadState(); 
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OpenCase Function 

  

The OpenCase function will load a PowerWorld® Simulator load flow file into the Simulator 
Automation Server. This is equivalent to opening a file using the File > Open Case menu 
option in Simulator. 
  

Function Prototype 

OpenCase(FileName) 
  

Parameter Definitions 

FileName : String The name of the PowerWorld® Simulator case file to be loaded into 
the Simulator Automation Server. This string includes the directory location and full file 
name.  

  

Output 

OpenCase returns only one element in Output—if the file cannot be found or an error 
occurs while reading the file. 
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OpenCase Function: Sample Code  

  

Borland® Delphi 

Output := SimAuto.OpenCase('c:\simauto\examples\b7opf.pwb'); 

if (string(Output[0]) <> '') then  
 StatusBar1.Panels[1].Text := 'Error: ' + string(Output[0]);  

else 

begin 
 StatusBar1.Panels[1].Text := 'Open Case successful.';  
 // Perform activities with opened case  

end; 

  

Microsoft® Visual Basic for Applications 

Output = SimAuto.OpenCase("c:\simauto\examples\b7opf.pwb") 

If output(0) <> "" Then 
 MsgBox(output(0))  

Else 
 ' Perform activities with the opened case  

End If 

  

Matlab® 

Output = SimAuto.OpenCase('c:\simauto\examples\b7opf.pwb') 

%If the first cell in Output ~= '', then that means an error 

%occurred. 

if ~(strcmp(Output{1},'')) 
 disp(Output{1})  

else 
 %Otherwise, no errors. Perform activities.  
 disp('Open Case successful')  

end 
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ProcessAuxFile Function 

  

The ProcessAuxFile function will load a PowerWorld® Auxiliary file into the Simulator 
Automation Server. This allows you to create a text file (conforming to the PowerWorld® 
Auxiliary file format) that can list a set of data changes and other information for making batch 
changes in Simulator 
  

Function Prototype 

ProcessAuxFile(FileName) 
  

Parameter Definitions 

FileName : String The name of the PowerWorld® Auxiliary file to be loaded into the 
Simulator Automation Server. This string includes the directory location and full file 
name. 

  

Output 

ProcessAuxFile returns only one element in Output—any errors which may have occurred 
when attempting to load the file. 
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ProcessAuxFile Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

Dim filename As String 
  

' Setup name of aux file to run 

filename = "c:\b7opf_ctglist.aux" 
  

' Make the processAuxFile call 

Output = SimAuto.ProcessAuxFile(filename) 

  

Matlab® 

% Setup name of aux file to run 

filename = 'c:\b7opf_ctglist.aux'; 
  

% Make the processAuxFile call 

Output = SimAuto.ProcessAuxFile(filename); 

 



PowerWorld Simulator Add-On Tools 
 
 

1100 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

RunScriptCommand Function 

  

The RunScriptCommand function is used to execute a list of script statements. The script 
actions are those included in the script sections of the Auxiliary Files. If an error occurs trying 
to run a script command, an error will be returned through EString. 
  

Function Prototype 

RunScriptCommand(Statements) 
  

Parameter Definitions 

Statements : String The block of script actions to be executed. Each script statement 
must end in a semicolon. The block of script actions should not be enclosed in curly 
braces. 

  

Output 

RunScriptCommand returns only one element in Output—any errors which may have 
occurred when attempting to load or run the auxiliary file. 
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RunScriptCommand Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

Dim scriptcommand As String 
  

' Set script command to cause Simulator to enter Run Mode 

scriptcommand = "EnterMode(RUN)" 
  

' Make the RunScriptCommand call 

Output = SimAuto.RunSCriptCommand(scriptcommand); 
  

' Set script command to cause Simulator to perform a single, 

' standard solution 

scriptcommand = "SolvePowerFlow(RECTNEWT)" 
  

' Make the RunScriptCommand call 

Output = SimAuto.RunSCriptCommand(scriptcommand); 

  

Matlab® 

% Set script command to cause Simulator to enter Run Mode 

scriptcommand = 'EnterMode(RUN)'; 
  

% Make the RunScriptCommand call 

Output = SimAuto.RunSCriptCommand(scriptcommand); 
  

% Set script command to cause Simulator to perform a single, 

% standard solution 

scriptcommand = 'SolvePowerFlow(RECTNEWT)'; 
  

% Make the RunScriptCommand call 

Output = SimAuto.RunSCriptCommand(scriptcommand); 
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SaveCase Function 

  

The SaveCase function is used to save a case previously loaded in the Simulator Automation 
Server using the OpenCase function. The function allows you to specify a file name and a 
format for the save file. 
  

Function Prototype 

SaveCase(FileName, EString, FileType, Overwrite) 
  

Parameter Definitions 

FileName : String The name of the file you wish to save as, including file path. 

FileType : String A string indicating the format of the written case file. An empty string 
will return an error. The following list is the currently supported list of string identifiers 
and the file types they represent. 
 
"PTI23"  PTI version 23 (raw) 
"PTI24"  PTI version 24 (raw) 
"PTI25"  PTI version 25 (raw) 
"PTI26"  PTI version 26 (raw) 
"PTI27"  PTI version 27/28 (raw) 
"PTI29"  PTI version 29 (raw)  
"PTI30"  PTI version 30 (raw) 
"GE"  GE PSLF (epc) 
"IEEE"  IEEE common format (cf) 
"PWB70"  PowerWorld Binary version 7.0 (pwb) 
"PWB"  PowerWorld Binary (most recent) (pwb) 

Overwrite : Boolean A Boolean value which indicates whether to overwrite a file if 
FileName already exists. If Overwrite is set to false and the file specified by FileName 
already exists, SaveCase will return an error message and do nothing to the file. 

  

Output 

SaveCase returns only one element in Output—any errors which may have occurred 
when attempting to save the case. 
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SaveCase Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

' Save the case as a PWB file 

Output = SimAuto.SaveCase("c:\b7opfcopy.pwb", "PWB", true) 
  

' Save the case as a PTI file 

Output = SimAuto.SaveCase("c:\b7opfcopy.raw", "PTI", true) 

  

Matlab® 

% Setup name of PWB file to write 

filenamepwb = 'c:\b7opfcopy.pwb'; 
   

% Setup name of PTI file to write 

filenamepti = 'c:\b7opfcopy.raw'; 
  

% Make the SaveCase call for the PWB file 

Output = SimAuto.SaveCase(filenamepwb, ‘PWB’, true); 
  

% Make the SaveCase call for the PTI file 

Output = SimAuto.SaveCase(filenamepti, ‘PWB’, true); 
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SaveState Function 

  

SaveState is used to save the current state of the power system. This can be useful if you are 
interested in comparing various cases, much as the Difference Flows feature works in the 
Simulator application. 
  

Function Prototype 

SaveState() 
  

Parameter Definitions 

No parameters are passed. 

  

Output 

SaveState returns only one element in Output—any errors which may have occurred 
when attempting to execute the function. 

 



PowerWorld Simulator Add-On Tools 

1105 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

SaveState Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

' Make the SaveState call 

Output = SimAuto.SaveState() 

  

Matlab® 

% Make the SaveState call 

Output = SimAuto.SaveState(); 
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SendToExcel Function 

  

The SendToExcel function can be called to send data from the Simulator Automation Server to 
an Excel spreadsheet. The function is flexible in that you can specify the type of object data 
you want to export, an advanced filter name for a filter you want to use, and as many or as 
few field types as desired that are supported by the type of object. The first time this function 
is called, a new instance of Excel will be started, and the data requested will be pasted to a 
new sheet. For each subsequent call of this function, the requested data will be pasted to a 
new sheet within the same workbook, until the workbook is closed. 
  

Function Prototype 

SendToExcel(ObjectType, FilterName, FieldList) 
  

Parameter Definitions 

ObjectType : String A string describing the type of object for which your are 
requesting data. 

FilterName : String The name of an advanced filter which was previously defined in 
the case before being loaded in the Simulator Automation Server. If no filter is desired, 
then simply pass an empty string. If a filter name is passed but the filter cannot be found 
in the loaded case, no filter is used. 

FieldList : Variant This parameter must either be an array of fields for the given object 
or the string "all". As an array, FieldList contains an array of strings, where each string 
represents an object field variable, as defined in the section on PowerWorld Object 
Variables. If, instead of an array of strings, the single string "all" is passed, the Simulator 
Automation Server will use predefined default fields when exporting the data. 

  

Output 

SendToExcel returns only one element in Output—any errors which may have occurred 
when attempting to execute the function. 
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SendToExcel Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

Dim FieldList As Variant 
  

' Setup fieldlist to send the bus number, gen id and gen agc to Excel 

FieldList = Array("pwBusNum", "pwGenID", "pwGenAGCAble") 
  

' Make the SendToExcel call 

' By specifying the parameter FieldList, only the three fields 

' for each generator will be returned 

Output = SimAuto.SendToExcel("gen", "", "FieldList") 
  

' Sending the string "all" instead of a fieldlist array 

' writes all predefined fields to the Excel spreadsheet 

Output = SimAuto.SendToExcel("gen", "", "all") 
  

Note:  This function call will send the values of the fields in FieldList to an Excel workbook for 
all the generators in the load flow case. If a filter name had been passed instead of an empty 
string, Simulator would have located and used a pre-defined advanced filter and applied it to 
the information if it was found.  
  

Matlab® 

% Setup fieldlist to send the bus number, gen id and gen agc to Excel 

fieldlist = {'pwBusNum' 'pwGenID' 'pwGenAGCAble' }; 
  

% Make the SendToExcel call 

Output = SimAuto.SendToExcel('gen', '' , FieldList); 
  

% Sending the string 'all' instead of a fieldlist array 

% writes all predefined fields to the Excel spreadsheet 

Output = SimAuto.SendToExcel('gen', '', 'all'); 
  

Note:  This function call will send the values of the fields in FieldList to an Excel workbook for 
all the generators in the load flow case. If a filter name had been passed instead of an empty 
string, Simulator would have located and used a pre-defined advanced filter and applied it to 
the information if it was found.  
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WriteAuxFile Function 

  

The WriteAuxFile function can be used to write data from the case in the Simulator 
Automation Server to a PowerWorld® Auxiliary file. The function is flexible in that you can 
specify the type of object data you want to export, an advanced filter name for a filter you 
want to use, and as many or as few field types as desired that are supported by the type of 
object. In addition, you can specify a new file name for each call to WriteAuxFile, or you can 
specify the same file name and append the data to the file. 
  

Function Prototype 

WriteAuxFile(FileName, FilterName, ObjectType, EString, ToAppend, FieldList) 
  

Parameter Definitions 

FileName : String The name of the PowerWorld® Auxiliary file you wish to save. 

FilterName : String The name of an advanced filter which was previously defined in 
the case before being loaded in the Simulator Automation Server. If no filter is desired, 
then simply pass an empty string. If a filter name is passed but the filter cannot be found 
in the loaded case, no filter is used. 

ObjectType : String A string describing the type of object for which your are 
requesting data. 

ToAppend : Boolean If you have given a file name of an auxiliary file that already 
exists, then the file will either be appended to or overwritten according to the setting of 
this parameter. If ToAppend is False and the file already exists, WriteAuxFile will return 
an error message and do nothing to the file. 

FieldList : Variant This parameter must either be an array of fields for the given object 
or the string "all". As an array, FieldList contains an array of strings, where each string 
represents an object field variable, as defined in the section on PowerWorld Object 
Variables. If, instead of an array of strings, the single string "all" is passed, the Simulator 
Automation Server will use predefined default fields when exporting the data. 

  

Output 

WriteAuxFile returns only one element in Output—any errors which may have occurred 
when attempting to execute the function. 
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WriteAuxFile Function: Sample Code  

  

Microsoft® Visual Basic for Applications 

Dim FieldList As Variant 

Dim auxfilename As String 
  

' Setup FieldList to send the bus number, gen id and gen agc 

FieldList = Array("pwBusNum", "pwGenID", "pwGenAGCAble") 
  

' Aux file to write to 

auxfilename = "c:\businfo.aux" 
  

' Make the WriteAuxFile call 

' By specifying the parameter FieldList, only the three fields 

' for each generator will be returned 

Output = SimAuto.WriteAuxFile(auxfilename, "", "gen", true, FieldList) 
  

' Sending the string "all" instead of the FieldList array 

' writes all predefined fields to the Excel spreadsheet 

Output = SimAuto.SendToExcel(auxfilename, "", "gen", true, "all") 
  

Note:  This function call will send the values of the fields in FieldList to an auxiliary file for all 
the generators in the load flow case. If a filter name had been passed instead of an empty 
string, Simulator would have located and used a pre-defined advanced filter and applied it to 
the information if it was found.  

  

Matlab® 

% Setup FieldList to send the bus number, gen id and gen agc 

fieldlist = {'pwBusNum' 'pwGenID' 'pwGenAGCAble' }; 
  

% Aux file to write to 

auxfilename = 'c:\businfo.aux'; 
  

% Make the WriteAuxFile call 

Output = SimAuto.WriteAuxFile(auxfilename, '', 'gen', true, FieldList); 
  

% Sending the string 'all' instead of the FieldList array 

% writes all predefined fields to the .aux file 

Output = SimAuto.WriteAuxFile(auxfilename, '', 'gen', true, 'all'); 
  

Note:  This function call will send the values of the fields in FieldList to an auxiliary file for all 
the generators in the load flow case. If a filter name had been passed instead of an empty 
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string, Simulator would have located and used a pre-defined advanced filter and applied it to 
the information if it was found.  
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Simulator Automation Server Properties 

  

The following list of parameters is currently available once the SimulatorAuto object is set in 
your code. Check the help sections on these properties to see more detail on the particular 
property. 

ExcelApp 

CurrentDir 

ProcessID 

RequestBuildDate 
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ExcelApp Property 

  

The Simulator Automation Server has the ability to send data from Simulator to an Excel 
spreadsheet using the SendToExcel. By default, the Simulator Automation Server starts an 
instance of Excel the first time one of the above functions is called. Each subsequent call to 
these two functions will then send data to the same instance of Excel, until it is manually 
closed by the user. The ExcelApp property allows the user to gain access to the instance of 
Excel used by the Simulator Automation Server from within its own code. Thus the user can 
write code to manipulate the external instance of Excel. In addition, the ExcelApp property can 
be set by the user’s code, meaning that the user can initialize an external instance of Excel 
from within their own code and set the ExcelApp property to their external instance of Excel. 
Simulator itself is limited to starting only one instance of Excel on its own, but with the 
ExcelApp property allowing you to set the instance of Excel that Simulator uses on the fly, you 
can generate multiple instances of Excel within your code, and handle setting the ExcelApp 
property of the Simulator Automation server to the desired Excel instance depending on the 
data you want to send to Excel. 

The ExcelApp property is a variable of type Variant that returns the pointer to an object 
representing the external instance of Excel. 

ExcelApp : Variant 

To gain access to the external instance of Excel stored in the ExcelApp property, you first need 
to initialize a variable as an object. The following are a couple of examples in Borland Delphi 
and Microsoft Visual Basic. 
  

Examples 

Borland Delphi 5 
• Var MyExc : TObject 
• MyExc = SimAuto.ExcelApp{Makes the connection to the external instance} 
• {Perform activities with the Excel instance} 
• MyExc.Quit{Closes the external instance if called; do not call if you wish the instance 

to remain open} 
• MyExc.Free{Removes the connection to the external instance} 

Microsoft Visual Basic 
• Dim MyExc As Variant 
• Set MyExc = SimAuto.ExcelApp{Makes the connection to the external instance} 
• {Perform activities with the Excel instance} 
• MyExc.Quit{Closes the external instance if called; do not call if you wish the instance 

to remain open} 
• Set MyExc = Nothing{Removes the connection to the external instance} 
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ExcelApp Property: Sample Code  

  

Microsoft® Visual Basic for Applications 

Dim ExcelObject As Variant 

If Not (IsEmpty(SimAuto.ExcelApp)) Then 
 Set ExcelObject = SimAuto.ExcelApp  
 ExcelObject.DisplayAlerts = False  
 ExcelObject.Quit  

Else 
 MsgBox("Attempted to obtain Excel COM object from " + _  
 "Simulator, but there is not one open.")  

End If 
  

Matlab® 

MATLAB is currently unable to handle COM object properties returning COM objects 
themselves, such as the ExcelApp property of Simulator. 
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CurrentDir Property 

  

The CurrentDir property of the Simulator Automation Server allows you to retrieve or set the 
working directory for the currently running SimulatorAuto process. This is most useful if using 
relative filenames (e.g. "relativename.aux" versus "C:\Program 
Files\PowerWorld\Working\abosultename.aux") when specifying files. 
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CurrentDir Property: Sample Code  

  

Microsoft® Visual Basic for Applications 

' Display the current directory 

MsgBox(SimAuto.CurrentDir) 
  

' Set the current directory to c:\ 

SimAuto.CurrentDir = "c:\" 

  

Matlab® 

% Display the current directory 

disp(SimAuto.CurrentDir) 
  

% Set the current directory to c:\ 

SimAuto.CurrentDir = 'c:\'; 
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ProcessID Property 

  

The ProcessID property of the Simulator Automation Server allows you to retrieve the process 
ID of the currently running SimulatorAuto process, as can also be seen through the Task 
Manager in Windows® NT 4, 2000 and XP. This information can be useful if a forced 
shutdown of the SimulatorAuto object is needed, as all calls to the SimulatorAuto object are 
synchronous. This means the SimulatorAuto object will not be destroyed until all calls, no 
matter the time of execution, have completed. 
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ProcessID Property: Sample Code  

  

Microsoft® Visual Basic for Applications 

' Display the process ID 

MsgBox(SimAuto.ProcessID) 

  

Matlab® 

% Display the process ID 

disp(num2str(SimAuto.ProcessID)) 
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RequestBuildDate Property 

  

The RequestBuildDate property of the Simulator Automation Server allows you to retrieve the 
build date of the PowerWorld Simulator executable currently running with the SimulatorAuto 
process. The property returns an integer value that represents a date. This information is 
useful for verifying the release version of the executable.  
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PowerWorld Object Variables 

  

The ability to access power system data for different objects through various Simulator 
Automation Server Functions is based on variables defined in Simulator that can be referred to 
as Object Field Variables. Each object (i.e. bus, generator, etc.) can have numerous fields 
associated with it. Each of these fields, in turn, has a variable associated with the field to 
enable access to the field for the purpose of acquiring or changing data. For example, the 
GetParametersSingleElement function has a parameter called ParamList, which is intended to 
store a list of Object Field Variables for a particular type of object. When the function is called, 
the Simulator Automation Server will return the values associated with each particular field 
variable for the type of object specified. These field variables allow for complete flexibility by 
the user in specifying as many or as few fields for a particular object when acquiring or 
changing data. 

Examples of Field Variables 

BusGenMW 

BusNum 

  

Simulator has literally hundreds of parameters spanning numerous types of device and option 
specifications. Rather than list all of the field variables and the value they represent in this 
help file, we have enabled Simulator to automatically generate a text file containing the field 
variables and a description of what value the variable represents. PowerWorld Corporation 
highly recommends that you examine this list. To generate this text file, run PowerWorld 
Simulator and access the Help menu. Choose the option Export Case Object Fields… The 
list of fields can either be saved to a text file or sent to Excel. The list will consist of the field 
variables, the type of variable (string, integer, etc.), and a description of the value the field 
variable represents, with key fields for different objects marked with an asterisk. The field 
variables will also be split into sections based on the type of object they are valid for. Note 
that the same field variable may be available for more than one object, but that the value 
represented by the field variable might vary for different objects. 

Examples of Field Variables in Listing 

BusGenMW Real 'Bus Gen MW' 

* BusNum Integer 'Bus Number' (* denotes key field in text file) 

ATC_MaxLimElements Integer 'Max # Limiting Elements' 

  

The last note on the Object Field Variables is that some of the object field variables are reused 
for more than one value for an object. For example, a transmission line has "from" and "to" 
buses associated with the line. Rather than have separate field variables for values at each 
terminal bus, the same field variable is used for both, with a colon followed by a number 
appended to the variable to signify which bus the value represents. As an example, consider 
the field variable for bus per unit voltage, which is BusPUVolt. Since there are two buses per 
line, the "From" bus voltage would be represented as BusPUVolt:0, and the "To" bus voltage 
would be represented as BusPUVolt:1. The enumeration of the field variables always starts 
with 0 for the first instance. You may note that in the text file of field values that you don't see 
any field variables with :0 appended to them. Since we did not want you to have to always 
append the :0 on all field variables, the default for a field variable with no appended :# is 0. 
Thus you would only need to be concerned with appending the :# for field variables that 
require a number greater than 0. 
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Simulator Automation Server (version 9)  

  

NOTE: The function calls for version 9 of SimAuto have become obsolete in version 
10. The reason for the change was due to problems that arose with the structure of 
the functions in certain programming languages. The function structures have 
been modified for version 10 of Simulator. If you have code written that uses 
version 9 SimAuto function structures, it is fairly straightforward to convert the 
function calls from version 9 to version 10. Please see the updated section on the 
Simulator Automation Server for version 10. If you still have questions, please 
contact PowerWorld Corporation. 
  

The PowerWorld® Automation Server is only available to customers who have purchased the 
SimAuto add-on for PowerWorld® Simulator. The PowerWorld Simulator Automation Server is 
intended for enabling a PowerWorld customer with the ability to access PowerWorld Simulator 
functionality from within a program written externally by the user. The Simulator Automation 
Server acts as a COM object, which can be accessed from various different programming 
languages that have COM compatibility. Examples of programming tools with COM 
compatibility are Borland® Delphi, Microsoft® Visual C++, and Microsoft® Visual Basic, just to 
name a few. For more information on COM and Automation servers, see the help for Microsoft 
Windows. 

The Automation Server of Simulator works very well in combination with Simulator Script 
Commands and Auxiliary Files. It is beneficial to become familiar with these topics when 
considering using the Simulator Automation Server. 
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Installing Simulator Automation Server (version 9)  

  

Installing the Simulator Automation Server requires no additional steps beyond installing 
PowerWorld Simulator as normal. When a version of PowerWorld Simulator containing the 
Simulator Automation Server is installed on your computer, the install program automatically 
adds the information needed by the Simulator Automation Server to the registry. 
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Including Simulator Automation Server Functions (version 9)  

  

Before you can access the functions defined by the Simulator Automation Server when writing 
the code for your external program, you must first include the library of functions defined for 
the Simulator Automation Server. This kind of library is referred to as a Type Library, which 
describes the available functions in a manner that can be interpreted by different 
programming languages. Importing a Type Library from another program is usually fairly 
simple, but the procedure does vary depending on the programming tool you are using. Please 
see the help for your programming tool of choice on how to import a Type Library or COM 
functions from another program. 
  

Examples 

The following examples are just a few specific examples for certain programming media. 
The procedure may be different for other programming media not listed. In addition, a 
procedure given for a certain type of programming media may be one variation from several 
possible procedures for accomplishing the same task. 

Borland Delphi 5 
• Install the version of PowerWorld Simulator with the Simulator Automation Server 

included. 
• In Delphi 5, choose Import Type Library… from the Project menu. 
• In the list of libraries, search for and choose pwrworld Library. 
• If pwrworld Library is not in the list, click Add. Find and choose the Pwrworld.exe file 

from the PowerWorld Simulator directory, and click Open. 
• You should see the class name TSimulatorAuto in the list of Class names. 
• Click Install to include the PowerWorld Simulator Type Library. 

Microsoft Visual Basic 
• Install the version of PowerWorld Simulator with the Simulator Automation Server 

included. 
• In VB, choose References… from the Tools menu. Find and choose pwrworld Library 

from the list of references. 
• If pwrworld Library is not in the list, click Browse. Change the file type to *.exe, find and 

choose the Pwrworld.exe file from the PowerWorld Simulator directory, and click Open. 
• Click OK to install the Simulator Type Library reference. 

Microsoft Visual C++ 
• Install the version of PowerWorld Simulator with the Simulation Automation Server 

included. 
• Add #import "…\powerworld.exe" in your external program code, using the full 

path to the PowerWorld Simulator executable program. 
• Add using namespace pwrworld in your external program code. 
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Connecting to Simulator Automation Server (version 9)  

  

Once the Type Library or COM functions have been included in your programming 
environment, the Simulator Automation Server can be handled as any other object in your 
code. The method for assigning and connecting to the Simulator Automation Server can vary 
depending on the programming environment used, but the idea is basically the same. You 
define a variable in your program to point to the server object, which is called SimulatorAuto. 
If the Type Library was imported properly, you should have full access to the SimulatorAuto 
object and its defined functions. Again, the procedure for creating the object and connecting 
to SimulatorAuto may vary for different programming languages. Check the help for your 
programming environment on connecting to COM or Automation servers. 
  

Examples 

The following examples are just a few specific examples for certain programming media. 
The procedure may be different for other programming media not listed. In addition, a 
procedure given for a certain type of programming media may be one variation from several 
possible procedures for accomplishing the same task. 

Borland Delphi 5 
• Add pwrworld_TLB to the uses section of your unit. 
• Declare a variable globally or as part of another object: A : ISimulatorAuto. 
• Initialize the variable: A := nil. 
• To connect to the Simulator Automation Server, create the connection: A := 

CoSimulatorAuto.create. 
• Perform function calls to the Simulator Automation Server: 

A.SomeFunction(parameters). 
• To close the connection to the Simulator Automation Server, remove the reference by 

again setting: A := nil. 
Microsoft Visual Basic 
• Declare a variable globally or as part of another object or function: Public A As 

SimulatorAuto. 
• To connect to the Simulator Automation Server, create the connection: Set A = New 

SimulatorAuto. 
• Perform function calls to the Simulator Automation Server: A.SomeFunction 

parameters. 
• To close the connection to the Simulator Automation Server, remove the reference: Set 

A = Nothing. 

Microsoft Visual C++ 
• Declare a variable globally or as part of another object or function: IsimulatorAutoPtr 

*A. 
• Declare a variable globally or as part of another object or function: CLSID clsid. 
• Declare a variable globally or as part of another object or function: HRESULT hr. 
• Obtain the class identifier (clsid) with the following command: hr = 

CLSIDFromProgID(L"pwrworld.SimulatorAuto", &clsid). 
• Initialize variable A: A = new IsimulatorAutoPtr. 
• To connect to the Simulator Automation Server, create the connection: hr = 

A>CreateInstance(clsid, NULL, CLSCTX_SERVER). 
• Perform function calls to the Simulator Automation Server: 

A.SomeFunction(parameters). 
• To close the connection to the Simulator Automation Server, release the reference: hr = 

A>Release(). 
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Simulator Automation Server Properties (version 9)  

  

The following list of parameters is currently available once the SimulatorAuto object is set in 
your code. Check the help sections on these properties to see more detail on the particular 
property. 

ExcelApp 
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ExcelApp Property (version 9)  

  

The Simulator Automation Server has the ability to send data from Simulator to an Excel 
spreadsheet using the SendToExcel. By default, the Simulator Automation Server starts an 
instance of Excel the first time one of the above functions is called. Each subsequent call to 
these two functions will then send data to the same instance of Excel, until it is manually 
closed by the user. The ExcelApp property allows the user to gain access to the instance of 
Excel used by the Simulator Automation Server from within their own code. Thus the user can 
write code to manipulate the external instance of Excel. In addition, the ExcelApp property can 
be set by the user’s code, meaning that the user can initialize an external instance of Excel 
from within their own code and set the ExcelApp property to their external instance of Excel. 
Simulator itself is limited to starting only one instance of Excel on its own, but with the 
ExcelApp property allowing you to set the instance of Excel that Simulator uses on the fly, you 
can generate multiple instances of Excel within your code, and handle setting the ExcelApp 
property of the Simulator Automation server to the desired Excel instance depending on the 
data you want to send to Excel. 

The ExcelApp property is a variable of type Variant that returns the pointer to an object 
representing the external instance of Excel. 

ExcelApp : Variant 

To gain access to the external instance of Excel stored in the ExcelApp property, you first need 
to initialize a variable as an object.  
  

The following are a couple of examples in Borland Delphi and Microsoft Visual Basic. 

Examples 

Borland Delphi 5 
• Var MyExc : TObject 
• MyExc = SimAuto.ExcelApp{Makes the connection to the external instance} 
• {Perform activities with the Excel instance} 
• MyExc.Quit{Closes the external instance if called; do not call if you wish the instance 

to remain open} 
• MyExc.Free{Removes the connection to the external instance} 

Microsoft Visual Basic 
• Dim MyExc As Object 
• Set MyExc = SimAuto.ExcelApp{Makes the connection to the external instance} 
• {Perform activities with the Excel instance} 
• MyExc.Quit{Closes the external instance if called; do not call if you wish the instance 

to remain open} 
• Set MyExc = Nothing{Removes the connection to the external instance} 
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Simulator Automation Server Functions (version 9)  

  

The following list of functions is currently available once the SimulatorAuto object is set in your 
code. Check the help sections on these functions to see more detail on the particular function. 

ChangeParameters 

CloseCase 

GetParameters 

ListOfDevices 

LoadContingencies 

OpenCase 

ProcessAuxFile 

RunScriptCommand 

SaveCase 

SendToExcel 

WriteAuxFile 
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ChangeParameters Function (version 9)  

  

The ChangeParameters function allows you to set a list of parameters for a specific object in a 
case loaded into the Simulator Automation Server. In addition to changing parameters for 
objects, this function can also be used to set options for some of the Simulator tools, such as 
ATC and OPF. This function is identical in setup to the GetParameters function, with the 
exception that the Values array must contain a value for each field variable given in the 
ParamList array. 

ChangeParameters(tObjectType, ParamList, Values, EString) 
  

Parameter Definitions 

TobjectType : String The type of object you are changing parameters for. No default. 

ParamList : Variant A variant array storing strings. This array stores a list of 
PowerWorld® object field variables, as defined in the section on PowerWorld Object 
Fields. The ParamList must contain the key field variables for the specific device, or the 
device cannot be identified. No Default. 

Values : Variant A variant array storing variants. This array can store any type of 
information (integer, string, etc.) in each array position. A value should be passed for 
each field variable given in the ParamList. The Values array must contain the key field 
values for the specific device, or the device cannot be identified. No Default. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

Example 

ChangeParameters("gen", [pwBusNum, pwGenID, pwGenAGCAble], [1, "1", 
"Yes"], EString) 
This function call will change the AGC Status of bus number one, generator ID number 
1, to "Yes", meaning the generator will be included in AGC if it's area is on AGC control. 
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CloseCase Function (version 9)  

  

The CloseCase function is used to close a load flow case loaded in the Simulator Automation 
Server. This function should be called at some point after the OpenCase function. An error will 
be returned through the EString parameter if an error occurred while trying to close the case. 

CloseCase(EString) 
  

Parameter Definitions 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 
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GetParameters Function (version 9)  

  

The GetParameters function is used to request the values of specified fields for a particular 
object in the load flow case. For returning field values for multiple objects, you can use a loop 
to make repeated calls to the GetParameters function, and pass the object and desired field 
information for each object. This function is identical in setup to the ChangeParameters 
function, with the exception that the Values array will be updated with the values for the field 
variables defined in ParamList. 

GetParameters(tObjectType, ParamList, Values, EString) 
  

Parameter Definitions 

TobjectType : String The type of object you are changing parameters for. No default. 

ParamList : Variant A variant array storing strings. This array stores a list of 
PowerWorld® object field variables, as defined in the section on PowerWorld Object 
Fields. The ParamList must contain the key field variables for the specific device, or the 
device cannot be identified. The remaining field variables in the array define which 
values to retrieve from Simulator. No Default. 

Values : Variant A variant array storing variants. This array can store any type of 
information (integer, string, etc.) in each array position. Values must be passed for the 
key field variables in ParamList, in the same array position. The remaining field positions 
in the Values array can initially be filled with either empty strings or zeroes, as the values 
will be replaced when the function is processed. No Default. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

Example 

GetParameters("gen", [pwBusNum, pwGenID, pwGenAGCAble], ValArray = 
[1, "1", ""], EString) 
This function call will return the AGC Status of bus number one, generator ID number 1, 
in the ValArray variable. Note that the generator bus number and ID had to be passed 
into the function, while the remaining field could be assigned an empty string. If the bus 
number and ID had not been passed, an error would have been returned since Simulator 
would not be able to identify a generator. With a valid bus number and ID for the 
generator, the ValArray variable would have returned an array of the following format: 
ValArray = [1, "1", "Yes"]. 
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ListOfDevices Function (version 9)  

  

The ListOfDevices function is used to request a list of objects and their key fields from the 
Simulator Automation Server. The function can return all devices of a particular type, or can 
return only a list of devices of a particular type based on an advanced filter defined for the 
loaded case. This function is best used in conjunction with a looping procedure and the 
ChangeParameters or GetParameters functions to process a group of devices. 

ListOfDevices(tObjType, EString, filterName, objList1, {objList2}, {objList3}) 
  

Parameter Definitions 

TobjType : String The type of object for which you are acquiring the list of devices. No 
default. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

FilterName : String The name of an advanced filter defined in the load flow case open 
in the Simulator Automation Server. If the filter cannot be found, the server will default 
to returning all objects in the case of type TobjType. 

ObjList1 : Variant This parameter must be assigned a variable declared as a Variant. 
The Simulator Simulation Server will return a variant array filled with the first key field 
for the devices of type TobjType. This parameter is required for all types of devices. 

ObjList2 : Variant This parameter may be optional. For device types that only have 
one key field, you can omit passing a variable for this parameter. If the device type 
requested has two or more key fields, then this parameter must be assigned a variable 
declared as a Variant. The Simulator Simulation Server will return a variant array filled 
with the second key field for the devices of type TobjType. 

ObjList3 : Variant This parameter may be optional. For device types that have one or 
two key fields, you can omit passing a variable for this parameter. If the device type 
requested has three key fields, then this parameter must be assigned a variable declared 
as a Variant. The Simulator Simulation Server will return a variant array filled with the 
third key field for the devices of type TobjType. 

Example 

ListOfDevices("gen", EString, "", objList1, objList2) 

This function call will return a list of all generators in the load flow case. By passing an 
empty string as the filter name, Simulator will not use an advanced filter before returning 
the generator key fields. Since generators have two key fields, bus number and ID, it 
was required to pass two variant array variables to receive the key fields. Each generator 
in the case would have its bus number returned in objList1 and ID in objList2. The 
corresponding bus number and ID are stored in the same index position in the two 
arrays. If only one variant array, objList1, had been passed in this instance, an error 
would have been returned stating more arrays were necessary. If the third variant array, 
objList3, had been included, Simulator would have still returned the key fields in objList1 
and objList2, and would have returned objList3 as an empty variant. 
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LoadContingencies Function (version 9)  

  

The LoadContingencies function can be used to read a set of predefined contingencies from a 
PowerWorld® Auxiliary Contingency file. Thus once you have defined a set of contingencies in 
Simulator and saved the list to a PowerWorld® Auxiliary file, you can specify the filename with 
this function and the Simulator Automation Server will load the contingencies into memory. 

LoadContingencies(fileName, EString, {tAppend}) 
  

Parameter Definitions 

Filename : String The name of the PowerWorld® Auxiliary file containing the defined 
contingencies. If the file cannot be found, and error will be returned through EString. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

TAppend : Boolean This parameter is optional. If you have more than one list of 
contingencies in separate files, you can append the lists together in the Simulator 
Automation Client by passing the Boolean value True in this parameter. The default if not 
passed is False, meaning any existing contingencies in the Simulator Automation Client 
would be cleared prior to loading the new list. 

Example 

LoadContingencies("c:\my files\ctgfile.aux", EString, True) 
This function call will load a previously created list of contingencies that was saved in the 
PowerWorld Auxiliary file format. The file name string identifies the location and name of 
the auxiliary file. By passing the value True in the optional parameter tAppend, Simulator 
will read the list of contingencies and add them to any existing contingencies already 
loaded in Simulator. Contingencies in the list existing list with the same name as 
contingencies in the appending list will be replaced by the records in the appending list. 
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OpenCase Function (version 9)  

  

The OpenCase function will load a PowerWorld® Simulator load flow file into the Simulator 
Automation Server. If an error occurs trying to open the case, an error message will be 
returned through EString. 

OpenCase(filename, EString) 
  

Parameter Definitions 

FileName : String The name of the PowerWorld® Simulator case file to be loaded into 
the Simulator Automation Server. This string includes the directory location and full file 
name. If the file cannot be found or an error occurs while reading the file, an error 
message will be returned through EString. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 
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ProcessAuxFile Function (version 9)  

  

The ProcessAuxFile function will load a PowerWorld® Auxiliary file into the Simulator 
Automation Server. This allows you to create a text file (conforming to the PowerWorld® 
Auxiliary file format) that can list a set of data changes and other information for making batch 
changes in Simulator. If an error occurs while processing the auxiliary file, an error message is 
returned through EString. 

ProcessAuxFile(filename, EString) 
  

Parameter Definitions 

FileName : String The name of the PowerWorld® Auxiliary file to be loaded into the 
Simulator Automation Server. This string includes the directory location and full file 
name. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 
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RunScriptCommand Function (version 9)  

  

The RunScriptCommand function is used to execute a list of script statements. The script 
actions are those included in the script sections of the Auxiliary Files. If an error occurs trying 
to run a script command, an error will be returned through EString. 

RunScriptCommand(Statements, EString) 
  

Parameter Definitions 

Statements : String The block of script actions to be executed. Each script statement 
must end in a semicolon. The block of script actions should not 
be enclosed in curly braces. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the 
passed variable a string representing an error that may have 
occurred in the Simulator Automation Server. If no error 
occurred, the EString variable will return an empty string. 

Example 

RunScriptCommand("Entermode(PowerFlow); SolvePowerFlow;", EString) 
This function call will switch to the PowerFlow submode and then will solve the power 
flow of the present case. 

 



PowerWorld Simulator Add-On Tools 

1137 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

SaveCase Function (version 9)  

  

The SaveCase function is used to save a case previously loaded in the Simulator Automation 
Server using the OpenCase function. The function allows you to specify a file name and a 
format for the save file. If an error occurs while trying to save a case, an error message is 
returned through EString. 

SaveCase(fileName, EString, {fileType}, {Overwrite}) 
  

Parameter Definitions 

fileName : String The name of the file you wish to save as, including file path. No 
default. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

fileType : String This parameter is optional. If you desire to save the case in a format 
other than the current PowerWorld Binary (pwb) format, you must specify the type of 
format in this parameter as a string. If the parameter is not passed, the format type 
defaults to the most recent version of PowerWorld binary (pwb) file. If a string is passed 
for this parameter, it must at least be the "PWB" string. An empty string will return an 
error. The following list is the currently supported list of string identifiers and the file 
types they represent. 
 
"PTI23"  PTI version 23 (raw) 
"PTI24"  PTI version 24 (raw) 
"PTI25"  PTI version 25 (raw) 
"PTI26"  PTI version 26 (raw) 
"PTI27"  PTI version 27 (raw) 
"GE"  GE PSLF (epc) 
"IEEE"  IEEE common format (cf) 
"PWB70"  PowerWorld Binary version 7.0 (pwb) 
"PWB"  PowerWorld Binary (most recent) (pwb) 

Overwrite : Boolean This parameter is optional. If you do not want to overwrite a file 
with the same name as passed in filename, you must specify this parameter as False. 
Default is True. 
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SendToExcel Function (version 9)  

  

The SendToExcel function can be called to send data from the Simulator Automation Server to 
an Excel spreadsheet. The function is flexible in that you can specify the type of object data 
you want to export, an advanced filter name for a filter you want to use, and as many or as 
few field types as desired that are supported by the type of object. The first time this function 
is called, a new instance of Excel will be started, and the data requested will be pasted to a 
new sheet. For each subsequent call of this function, the requested data will be pasted to a 
new sheet within the same workbook, until the workbook is closed. If an error occurs while 
trying to send data to Excel, an error message is returned through EString. 

SendToExcel(tObjectType, filterName, EString, {tFieldList}) 
  

Parameter Definitions 

tObjectType : String A string describing the type of object for which your are 
requesting data. No Default. 

filterName : String The name of an advanced filter which was previously defined in the 
case before being loaded in the Simulator Automation Server. If no filter is desired, then 
simply pass an empty string. If a filter name is passed but the filter cannot be found in 
the loaded case, no filter is used. Default is an empty string. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

TFieldList : Variant This parameter is optional. A variant array of strings, where each 
string represents an object field variable, as defined in the section on PowerWorld Object 
Variables. If no array is passed, the Simulator Automation Server will use predefined 
default fields when exporting the data. 

Example 

SendToExcel("gen", "", EString, [pwBusNum, pwGenID, pwGenAGCAble]) 
This function call will send the values of the fields in tFieldList to an Excel workbook for 
all the generators in the load flow case. If a filter name had been passed instead of an 
empty string, Simulator would have located and used a pre-defined advanced filter and 
applied it to the information if it was found. By specifying the fields in the optional 
parameter tFieldList, only the three field values for each generator will be returned. If 
the optional parameter tFieldList had been omitted, Simulator would have returned 
internally defined default information for the generators. 
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WriteAuxFile Function (version 9)  

  

The WriteAuxFile function can be used to write data from the case in the Simulator 
Automation Server to a PowerWorld® Auxiliary file. The function is flexible in that you can 
specify the type of object data you want to export, an advanced filter name for a filter you 
want to use, and as many or as few field types as desired that are supported by the type of 
object. In addition, you can specify a new file name for each call to WriteAuxFile, or you can 
specify the same file name and append the data to the file. If an error occurs while trying to 
write the auxiliary file, an error message is returned through EString. 

WriteAuxFile(fileName, filterName, tObjectType, EString, {tAppend}, 
{tFieldList}) 
  

Parameter Definitions 

FileName : String The name of the PowerWorld® Auxiliary file you wish to save. No 
default. 

filterName : String The name of an advanced filter which was previously defined in the 
case before being loaded in the Simulator Automation Server. If no filter is desired, then 
simply pass an empty string. If a filter name is passed but the filter cannot be found in 
the loaded case, no filter is used. Default is an empty string. 

tObjectType : String A string describing the type of object for which your are 
requesting data. No Default. 

EString : Variant This parameter must be assigned a variable declared as a Variant. 
This parameter is for a return value only, and will assign the passed variable a string 
representing an error that may have occurred in the Simulator Automation Server. If no 
error occurred, the EString variable will return an empty string. 

TAppend : Boolean This parameter is optional. If you have given a file name of an 
auxiliary file that already exists, then the file will either be appended to or overwritten 
according to the setting of this parameter. If the parameter is not passed, the Simulator 
Automation Server assumes false. 

TFieldList : Variant This parameter is optional. A variant array of strings, where each 
string represents an object field variable, as defined in the section on PowerWorld Object 
Variables. If no array is passed, the Simulator Automation Server will use predefined 
default fields when exporting the data. 

  

Example 

WriteAuxFile("c:\my files\myauxfile.aux", "", "gen", EString, False, 
[pwBusNum, pwGenID, pwGenAGCAble]) 
This function call will send the values of the fields in tFieldList to a PowerWorld Auxiliary 
file for all the generators in the load flow case. If a filter name had been passed instead 
of an empty string, Simulator would have located and used a pre-defined advanced filter 
and applied it to the information if it was found. By specifying the fields in the optional 
parameter tFieldList, only the three field values for each generator will be returned. If 
the optional parameter tFieldList had been omitted, Simulator would have returned 
internally defined default information for the generators. Since the tFieldList optional 
parameter was included, the tAppend optional parameter also had to be included, even 
though it's default value is already False. 
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PowerWorld Object Variables (Version 9)  

  

The ability to access power system data for different objects through various Simulator 
Automation Server functions is based on variables defined in Simulator that can be referred to 
as Object Field Variables. Each object (i.e. bus, generator, etc.) can have numerous fields 
associated with it. Each of these fields, in turn, has a variable associated with the field to 
enable access to the field for the purpose of acquiring or changing data. For example, the 
GetParameters function has a parameter called ParamList, which is intended to store a list of 
Object Field Variables for a particular type of object. When the function is called, the Simulator 
Automation Server will return the values associated with each particular field variable for the 
type of object specified. These field variables allow for complete flexibility by the user in 
specifying as many or as few fields for a particular object when acquiring or changing data. 
  

Examples of Field Variables 

PWBusGenMW 

PWBusNum 

  

Simulator has literally hundreds of parameters spanning numerous types of device and option 
specifications. Rather than list all of the field variables and the value they represent in this 
help file, we have enabled Simulator to automatically generate a text file containing the field 
variables and a description of what value the variable represents. PowerWorld Corporation 
highly recommends that you examine this list. To generate this text file, run PowerWorld 
Simulator and access the Help menu. Choose the option Export Object Fields… Specify a 
file name and location for saving the file, and click Save. Simulator will save out the field 
variables, the type of variable (string, integer, etc.), and a description of the value the field 
variable represents, with key fields for different objects marked with an asterisk. The field 
variables will also be split into sections based on the type of object they are valid for. Note 
that the same field variable may be available for more than one object, but that the value 
represented by the field variable might vary for different objects. 
  

Examples of Field Variables in Listing 

PwBusGenMW Real 'Bus Gen MW' 

* PwBusNum Integer 'Bus Number' (* denotes key field in text file) 

ATC_MaxLimElements Integer 'Max # Limiting Elements' 

  

The last note on the Object Field Variables is that some of the object field variables are reused 
for more than one value for an object. For example, a transmission line has "from" and "to" 
buses associated with the line. Rather than have separate field variables for values at each 
terminal bus, the same field variable is used for both, with a colon followed by a number 
appended to the variable to signify which bus the value represents. As an example, consider 
the field variable for bus per unit voltage, which is PWBusPUVolt. Since there are two buses 
per line, the "From" bus voltage would be represented as PWBusPUVolt:0, and the "To" bus 
voltage would be represented as PWBusPUVolt:1. The enumeration of the field variables 
always starts with 0 for the first instance. You may note that in the text file of field values that 
you don't see any field variables with :0 appended to them. Since we did not want you to have 
to always append the :0 on all field variables, the default for a field variable with no appended 
:# is 0. Thus you would only need to be concerned with appending the :# for field variables 
that require a number greater than 0. 
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Chapter 14 : Auxiliary Script/Data Files 

  

Auxiliary Script and Data files are used to automatically change data and control the Simulator 
in a batch mode fashion.  

This chapter covers the following: 
• Overview of Auxiliary Files 
• Script Command Execution Dialog 
• Quick Auxiliary Files Dialog 
• Script Section 
• Data Section 
• Data Section for Display Auxiliary Files 
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Auxiliary Files 

  

PowerWorld has incorporated the ability to import data from data sources other than power 
flow models into PowerWorld Simulator. Simulator has always had the ability to import 
supplemental data into a power flow model, but this facility was limited to ten or twelve native 
data formats targeted to specific applications for which the data had to have a precise format. 
The extensions described in this help document provide a more versatile interface to data from 
non-power-flow sources. 

In addition to developing auxiliary data formats, a script language was also developed. The 
script language and auxiliary data formats are incorporated together. This format is described 
in this help document. 

Script/Data files are called data auxiliary files in Simulator and typically have the file extension 
.AUX. These files mostly contain information about power system elements and options for 
running the various tools within Simulator. They do not contain any information about 
individual display objects contained on a one-line diagram. There are separate files called 
display auxiliary files that are available for importing/exporting display data from/to Simulator 
in a text format. These files are distinguished from the data auxiliary files by using the 
extension .AXD. The format for these two types of files is similar, but different object types are 
supported by each and require that the files be read separately. Currently, there are no script 
commands that are available for display auxiliary files. 

Both file types will be generically referred to as auxiliary files. An auxiliary file may be 
comprised of one or more DATA or SCRIPT sections. A DATA section provides specific data for 
a specific type of object. A SCRIPT section provides a list of script actions for Simulator to 
perform.  
  

These sections have the following format:  

SCRIPT ScriptName1 

{ 

script_statement_1 

 .  

script_statement_n 

} 

  

DATA DataName1(object_type, [list_of_fields], file_type_specifier) 

{ 

data_list_1 

 .  

data_list_n 

} 

  

DATA DataName2(object_type, [list_of_fields], file_type_specifier) 

{ 

data_list_1 
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 .  

data_list_n 

} 

  

SCRIPT ScriptName2 

{ 

script_statement_1 

 .  

script_statement_n 

} 

Note that the keywords SCRIPT or DATA must occur at the start of a text file line. Auxiliary 
files may contain more than one DATA or SCRIPT section. These sections always begin with 
the keyword DATA or SCRIPT. DATA sections are followed by an argument list enclosed in ( ). 
The actual data or script commands are then contained within curly braces { }. 
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Script Command Execution Dialog 

  

The Script Command Execution dialog provides a location for the user to enter script 
commands manually, or to load auxiliary files containing Script and/or Data sections previously 
defined. This dialog is opened by pressing the Script button in the Log ribbon group on the 
Tools ribbon tab. 
  

Loading Auxiliary Files 

The first feature of the Script Command Execution dialog is that it provides a location to load 
previously defined auxiliary files for the currently loaded case. The Auxiliary File menu 
provides a location for loading an auxiliary file, or simply validating that the Script and/or 
Data sections of an Auxiliary file are correctly formatted in the file. 

The Quick Aux option allows you to open the Quick Auxiliary Files dialog for creating a list 
of auxiliary files to be opened and processed en masse. 

Lastly, you can export the Simulator recognized objects and object fields using the Export 
Field Names option. You can export the field names to a text for or to Excel. 

Running Script Commands 

The second feature of the Script Command Execution dialog is that you can run script 
commands manually. To run a script command, type the command into the display, and 
press the Execute button. Note that if the Execute on ENTER key option is checked, the 
command will also be processed when ENTER is pressed. Note that similar to script 
command syntax in the Script section of auxiliary files, script commands must be ended with 
a semi-colon (;) in the Script Command Execution dialog as well.  

You can enter multiple script commands to be processed in sequence in this display. To do 
so, you must uncheck the option Execute on ENTER key. Then you can press enter after 
each script command to move to the next line and enter another command. Use the 
Execute button to process the sequence of script commands. 

If you are running a sequence of script commands and wish to abort the run, use the Abort 
button. 

If you wish to view the message log while script commands are processing, open the log 
using the Show Log button. 
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Quick Auxiliary Files Dialog 

  

The Quick Auxiliary Files dialog can be accessed from the Quick Aux Files menu option of 
the Script Command Execution dialog. This dialog gives you a location for creating a list of 
auxiliary files to be processed en masse for the currently loaded case. 

Using the Define option of the Quick Aux Files menu, the Quick Auxiliary Files dialog will 
open. Use this dialog to Add previously defined auxiliary files to the list of files to be 
processed. You can rearrange the order of the files by selecting a file and using the up and 
down arrows on the right to move the selected file within the list, or you can sort them 
alphabetically using the Sort button. To remove an auxiliary file from the list, use the Delete 
button. 

Once the list of auxiliary files to process is complete, press the Execute button to process the 
list of auxiliary files. 
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Script Section 

  

The SCRIPT section begins with a left curly brace and ends with a right curly brace. 
  

SCRIPT ScriptName 

{ 

script_statement_1 

script_statement_2 

 .  
 .  
 .  

script_statement_n 

} 

Scripts may optionally contain a ScriptName. This enables you to call a particular SCRIPT by 
using the LoadScript action. After the optional name, the SCRIPT section begins with a left 
curly brace and ends with a right curly brace. Inside of this, script statements can be given.  
  

In general, a script statement has the following format:  

Keyword(arg1, arg2, ...); 

• Statement starts with a keyword. 
• The keyword is followed by an argument list which is encompassed in parentheses ( ).  
• The arguments are separated by commas. 
• If a single argument is a list of things, this list is encompassed by braces [ ]. (eg. 

SetData) 
• Statements end with a semicolon. 
• Statements may take up several lines of the text file.  
• You may put more than one statement on a single text line. 

Some features in Simulator are available exclusively in either RUN mode or EDIT mode. This 
functionality is preserved in the script language, but with the addition of a submode feature. 
Submodes limit what script commands can be called. Only those commands available to the 
current submode can be executed. You will always be in one of the submodes when executing 
a script. If the Script Command Execution Dialog is opened from Edit Mode, Simulator defaults 
to the EDIT, CASE submode. If the Script Command Execution Dialog is opened from Run 
Mode (or when a script is initially started), Simulator defaults to the RUN, POWERFLOW 
submode. 

To switch submodes, use the EnterMode (mode or submode) script command. Available 
submodes include:  

Edit Mode  

Case Submode 

Run Mode 

PowerFlow Submode 

Contingency Submode 

ATC Submode 

Fault Submode 
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PV Submode 

QV Submode 
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Script General Actions 

  

The following actions are available to you regardless of the Mode or SubMode:  
  

RenameFile  ("oldfilename", "newfilename"); 

CopyFile ("oldfilename", "newfilename"); 

DeleteFile ("filename");   

LoadAux ("filename", CreateIfNotFound); 

LoadScript ("filename", ScriptName); 

 

LoadData ("filename", DataName, CreateIfNotFound); 

 

SelectAll (objecttype, filter); 

UnSelectAll (objecttype, filter); 

Delete (objecttype, filter); 

DeleteIncludingContents (objecttype, filter); 

 

SaveData("filename",filetype,objecttype,[fieldlist],[subdatalist],filter,[SortFieldList]); 

SaveDataWithExtra("filename",filetype,objecttype,[fieldlist],[subdatalist],filter,[SortFieldList],[Header_List],[Head

SaveDataUsingExportFormat("filename",filetype,FormatName); 

 

SetData (objecttype, [fieldlist], [valuelist], filter); 

 

CreateData (objecttype, [fieldlist], [valuelist]); 

 

ChangeData (objecttype, [fieldlist], [valuelist], filter); (NOT 
AVAILABLE 
YET) 

 
      

WriteTextToFile ("filename", "text…"); 

SetCurrentDirectory ("filedirectory", CreateIfNotFound); 

ExitProgram;     

NewCase;     

OpenCase ("filename"); // assumes to open as 
PWB 
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OpenCase ("filename", openfiletype); 

    PWB, GE, PTI, or CF 

SaveCase ("filename"); // assumes to save as 
PWB 

SaveCase ("filename", savefiletype); 

    PWB, PWB5, PWB6, 
PWB7,PWB8, PWB9, 
PWB10, PWB11, PWB12 

    PTI23, PTI24, PTI25, 
PTI26, PTI27,PTI28, 
PTI29, PTI30 

    GE, GE14, GE15 

    CF 

EnterMode (mode or  submode); 

  EDIT CASE 

  RUN POWERFLOW 

    CONTINGENCY 

    ATC 

    FAULT 

    PV 

    QV 

 

OpenOneLine ("filename", "view", FullScreen); 

ExportOnelineAsShapeFile ("filename", "OnelineName", "ShapeFileExportDescriptionName", Use

    YES

 

LogClear;     

LogSave ("filename", AppendFile); 

    YES or NO 

LogAdd ("string…");   

 

LogAddDateTime ("label", IncludeDate, IncludeTime, IncludeMilliseconds); 

    YES or NO YES or NO YES or NO 
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CaseDecsriptioClear;     

CaseDescriptionSet ("text…", Append 

    YES or NO 

      

SaveYbusInMatlabFormat ("filename", IncludeVoltages); 

    YES or NO 

 

SaveJacobian ("Jacfilename", "JIDfilename", filetype, JacForm); 

      M R 

      TXT P 

 

SetParticipationFactors (Method, ConstantValue, Object); 

  MAXMWRAT   [Area num] 

  RESERVE   [Zone num] 

  CONSTANT value SYSTEM 

      AREAZONE or 
DISPLAYFILTERS 

 

GenForceLDC_RCC (filter);   

 

CalculateRXBGFromLengthConfigCondType (filter); 

 

DirectionsAutoInsert (Source, Sink, DeleteExisting, UseDisplayFilters, 

  AREA AREA YES or NO YES or NO 

  ZONE ZONE     

  INJECTIONGROUP INJECTIONGROUP     

    SLACK     

 

DeterminePathDistance ([start], BranchDistMeas, BranchFilter, BusField); 

 

DetermineShortestPath ([start], [end], BranchDistMeas, BranchFilter, FileName); 

RenameFile("oldfilename", "newfilename"); 

Use this action to rename a file from within a script. 
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"oldfilename":  The present file name. 

"newfilename":  The new file name desired. 
  

CopyFile("oldfilename", "newfilename"); 

Use this action to copy a file from within a script. 

"oldfilename":  The present file name. 

"newfilename":  The new file name desired. 
  

DeleteFile("filename"); 

Use this action to delete a file from within a script. 

"filename":  The file name to delete. 
  

LoadAux("filename", CreateIfNotFound); 

Use this action to load another auxiliary file from within a script. 

"filename":  The filename of the auxiliary file being loaded. 

CreateIfNotFound:  Set to YES or NO. YES means that objects that cannot be found 
will be created while reading in DATA sections from filename. If this parameter is not 
specified, then NO is assumed. 
  

LoadScript("filename", ScriptName); 

Use this action to load a named Script Section from another auxiliary file. This will open the 
auxiliary file denoted by "filename", but will only execute the script section specified. 

"filename":  The filename of the auxiliary file being loaded. 

ScriptName:  The specific ScriptName from the auxiliary file which should be loaded. 
  

LoadData("filename", DataName, CreateIfNotFound); 

Use this action to load a named Script Section from another auxiliary file. This will open the 
auxiliary file denoted by "filename", but will only execute the script section specified. 

"filename":  The filename of the auxiliary file being loaded. 

DataName:  The specific ScriptName from the auxiliary file which should be loaded. 

CreateIfNotFound:  Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections from filename. If this parameter is not 
specified, then NO is assumed. 
  

SelectAll(objecttype, filter); 

Use this to set the selected property of objects of a particular type to true. A filter may 
optionally be specified to only set this property for objects which meet a filter. 

objecttype:  The objecttype being selected. 

filter:  There are three options for the filter:  

SelectAll(objecttype);:  No filter specified means to select all objects of this type.  

SelectAll(objecttype, "filtername");:  "filtername" means select those that meet 
the filter. 
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SelectAll(objecttype, AREAZONE);:  AREAZONE means select those that meet the 
area/zone filters. 

  

UnSelectAll(objecttype, filter); 

Same as SelectAll, but this action sets the selected properties to false. 

  

Delete(objecttype, filter); 

Use this to delete objects of a particular type. A filter may optionally be specified to only 
delete objects that meet a filter. 

objecttype:  The objecttype being selected. 

filter:  There are four options for the filter:  

Delete(objecttype);:  No filter specified means to delete all objects of this type.  

Delete(objecttype, "filtername");:  "filtername" means delete those that meet 
the filter. 

Delete(objecttype, AREAZONE);:  AREAZONE means delete those that meet the 
area/zone filters. 

Delete(objecttype, SELECTED);:  SELECTED means delete those objects whose 
selected field is set to YES. 

  

DeleteIncludingContents(objecttype, filter);  

Use this to delete objects of a particular type and other objects that these contain. 
Currently, only multi-section lines (objecttype = MultiSectionLine) can be used with this 
command. The branches and dummy buses that belong to multi-section lines will also be 
deleted along with the multi-section lines. A filter may optionally be specified to only delete 
objects that meet a filter. 

objecttype:  The objecttype being selected (presently we only support objecttype = 
MultiSectionLine. 

filter:  There are four options for the filter:  

DeleteIncludingContents(objecttype);:  No filter specified means to delete all 
objects of this type.  

DeleteIncludingContents(objecttype, "filtername");:  "filtername" means 
delete those that meet the filter. 

DeleteIncludingContents(objecttype, AREAZONE);:  AREAZONE means delete 
those thsat meet the area/zone filters. 

DeleteIncludingContents(objecttype, SELECTED);:  SELECTED means delete 
those objects whose selected field is set to YES. 

  

SaveData("filename", filetype, objecttype, [fieldlist], [subdatalist], filter, 
[SortFieldList]); 

Use this action to save data in a custom defined format. A filter may optionally be specified 
to save only objects which meet a filter, and a sort order list may also optionally be specified 
that will allow saving the objects in a particular order. 

"filename":  The file to save the data to 

filetype:   
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AUX (or AUXCSV): save as a space-delimited (or comma-delimited) auxiliary data file. 
CSV: save as a normal CSV text file, without the AUX file formatting. The first few 
lines of the text file will represent the object name and field names. 

objecttype:  The objecttype being saved. 

[fieldlist]:  A list of fields to save. For numeric fields, the number of digits and the 
number of decimal places (digits to right of decimal) can be specified by using the 
following format for the field, variablename:location:digits:rod. 

[subdatalist]:  A list of the subdata objecttypes to save with each object record.  

filter:  There are four options for the filter:  

SaveData(…);:  No filter specified means to save all objects of this type.   

SaveData(…, "filtername");:  "filtername" means save those that meet the filter. 

SaveData(…, AREAZONE);:  AREAZONE means save those that meet the 
area/zone filters. 

SaveData(…, SELECTED);:  SELECTED means save those objects whose selected 
field is set to YES. 

[SortFieldList]: This allows the specification of a sort order in which the data will be 
saved. The format is: 

[variablename1:+:0, variablename2:-:1]  

where 

variablename is the name of the field to sort by. There is no limit to how many 
fields can be specified for sorting. For fields that require a location other than zero , 
variablename can be in the format fieldname:location.  
+ or - for the second parameter indicates sort ascending for + and sort descending 
for -. This parameter must be specified. 

0 or 1 for the third parameter indicates: 0 - case insensitive and do not use absolute 
value, 1 - case sensitive or use absolute value. This parameter is optional. 

  

SaveDataWithExtra("filename", filetype, objecttype, [fieldlist], [subdatalist], filter, 
[SortFieldList], [Header_List], [Header_Value_List]);  

Use this action to save data in a custom defined format. User-specified fields and field 
values can also be specified in the output. Optional parameters are filter, SortFieldList, 
Header_List, and Header_Value_List. 

"filename":  The file to save the data to 

filetype:   

CSV: save as a normal CSV text file, without the AUX file formatting. The first few 
lines of the text file will represent the object name and field names. 

CSVNOHEADER: save as a normal CSV text file, without the AUX file formatting. The 
object name and field names are NOT included. This option is useful when appending 
data of the same object type and field list into a common file. 

Data cannot be saved using the AUX filetype with this command. 

objecttype:  The objecttype being saved. 

[fieldlist]:  A list of fields to save. For numeric fields, the number of digits and the 
number of decimal places (digits to right of decimal) can be specified by using the 
following format for the field, variablename:location:digits:rod. 

[subdatalist]:  A list of the subdata objecttypes to save with each object record. 
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filter:  There are four options for the filter:  

SaveData(…);:  No filter specified means to save all objects of this type.   

SaveData(…, "filtername");:  "filtername" means save those that meet the filter. 

SaveData(…, AREAZONE);:  AREAZONE means save those that meet the 
area/zone filters. 

SaveData(…, SELECTED);:  SELECTED means save those objects whose selected 
field is set to YES. 

[SortFieldList]: This allows the specification of a sort order in which the data will be 
saved. The format is: 

[variablename1:+:0, variablename2:-:1]  

where 

variablename is the name of the field to sort by. There is no limit to how many 
fields can be specified for sorting. For fields that require a location other than zero , 
variablename can be in the format fieldname:location. 
+ or - for the second parameter indicates sort ascending for + and sort descending 
for -. This parameter must be specified. 

0 or 1 for the third parameter indicates: 0 - case insensitive and do not use absolute 
value, 1 - case sensitive or use absolute value. This parameter is optional. If it is not 
specified, the default is 0.  

[Header_List]: This allows the specification of user-defined fields that will appear in 
the output. Headers should be specified as a list of comma delimited strings. A string 
should be enclosed in double quotes if the string contains a comma. Header strings 
cannot be blank. 

[Header_Value_List]: Allows the specification of the values that should be assigned to 
the user-defined fields specified by Header_List. Specifying the values is optional. If 
specified, there must be as many values specified as there are headers. If not specified, 
all values are blank. Each object will use the same specified value for the specified field. 
To use different values for different objects and save these in the same file, make use of 
the CSVNOHEADER file format and filtering. 

  

SaveDataUsingExportFormat("filename", filetype, FormatName);   

Use this action to save data in a user-defined format that has previously been defined. 

"filename":  The file to save the data to 

filetype:   

AUX (or AUXCSV): save as a space-delimited (or comma-delimited) auxiliary data file. 
CSV: save as a normal CSV text file, without the AUX file formatting. The first few 
lines of the text file will represent the object name and field names. 

FormatName:  The name of the Object Export Format Description to use. 

  

SetData(objecttype, [fieldlist], [valuelist], filter); 

Use this action to set fields for particular objects. If a filter is specified, then it will set the 
respective fields for all objects which meet this filter. Otherwise, if no filter is specified, then 
the keyfields must be included in the field list so that the object can be found. 

objecttype:  The objecttype being set. 

[fieldlist]:  A list of fields that you want to save. 
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[valuelist]:  A list of values to set the respective fields to. 

filter:  There are four options for the filter:  

SetData(…);:  No filter specified: set data only for the object described by the 
[fieldlist] and [valuelist] parameters.  

SetData(…, "filtername");:  "filtername": set data for all objects that meet the 
filter. 

SetData(…, AREAZONE);:  AREAZONE: set data for all objects that meet the 
area/zone filters. 

SetData(…, SELECTED);:  SELECTED: set data for all objects whose selected field 
is set to YES. 

  

CreateData(objecttype, [fieldlist], [valuelist]); 

Use this action to create particular objects. Note that the key fields for the objecttype must 
be specified. 

objecttype:  The objecttype being set. 

[fieldlist]:  A list of fields that you want to save. 

[valuelist]:  A list of values to set the respective fields to. 
  

WriteTextToFile("filename", "text…"); 

Use this action to write text to a file. If the specified file already exists, the text will be 
appended to the file. Otherwise, it creates the file and writes the text to the file. 

"filename":  The file path and name to save. 

"text…":  The text to be written to the file. 
  

SetCurrentDirectory("filedirectory", CreateIfNotFound); 

Use this action to set the current working directory. 

"filedirectory":  The path of the work directory. 

CreateIfNotFound:  Set to YES or NO. YES means that if the directory path can not be 
found, the directory will be created. If this parameter is not specified, then NO is 
assumed. 
  

ExitProgram; 

Immediately exits the program with no prompts. 

NewCase; 

This action clear out the existing case and open a new case from scratch. 

  

OpenCase("filename", OpenFileType); 

This action will open a case stored in "filename" of the type OpenFileType; 

"filename":  The file to be opened. 

OpenFileType:  An optional parameter saying the format of the file begin opened is. If 
none is specified, then PWB will be assumed. It may be one of the following strings:  

PWB, PTI, GE, CF, AUX. 
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SaveCase("filename", SaveFileType); 

This action will save the case to "filename" in the format SaveFileType. 

"filename":  The file name to save the information to. 

SaveFileType:  An optional parameter saying the format of the file to be saved. If none 
is specified, then PWB will be assumed. It may be one of the following strings:  

PWB, PWB5, PWB6, PWB7, PWB8, PWB9, PWB10, PWB11, PWB12 

PTI (means PTI30), PTI23, PTI24, PTI25, PTI26, PTI27, PTI28, PTI29, PTI30 

GE (means GE15), GE14, GE15 

 CF 

AUX 
  

EnterMode(mode or submode); 

This action will tell Simulator what mode or submode to enter before performing the next 
script command. 

SubMode:  The submode to enter. A parameter stating what submode to put the 
program in. Options available are CASE, POWERFLOW, CONTINGENCY, ATC, FAULT, PV, 
QV. One may also put in RUN or EDIT which will place the program in the POWERFLOW 
or CASE respectively. 
  

OpenOneline("filename", "view", FullScreen); 

Use this action to open a oneline diagram. 

"filename":  The file name of the oneline diagram to open. 

"view":  The view name that should be opened. Pass an empty string to denote no 
specific view. 

FullScreen:  Set to YES or NO. YES means that the oneline diagram will be opened in 
full screen mode. If this parameter is not specified, then NO is assumed. 

  

ExportOnelineAsShapeFile("filename", "OnelineName", 
"ShapeFileExportDescriptionName", UseLonLat);  

Use this action to save an open oneline diagram to a shapefile. 

"filename":  The file name of the shapefile to save. 

"OnelineName":  The name of the oneline diagram to save to a shapefile. The oneline 
diagram must be open. Use the OpenOneline script command if necessary to open the 
appropriate oneline. 

"ShapeFileExportDescriptionName":  Name of the ShapeFile Export Description to 
use when saving the shapefile. 

UseLonLat: Set to YES or NO. YES means that the coordinates of objects on the oneline 
diagram will be saved using longitude,latitude. This will only be true if a valid map 
projection is in use with the oneline diagram. Otherwise, the coordinates will be saved in 
x,y. If this parameter is set to NO, the coordinates will be saved in x,y. If this parameter 
is not specified, YES is assumed. 

  

LogClear; 
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Use this action to clear the Message Log. 

  

LogSave("filename", AppendFile); 

This action saves the contents of the Message Log to "filename". 

"filename":  The file name to save the information to. 

AppendFile:  Set to YES or NO. YES means that the contents of the log will be 
appended to "filename". NO means that "filename" will be overwritten. 
  

LogAdd("string…"); 

Use this action to add a personal message to the MessageLog. 

"string…":  The string that will appear as a message in the log. 
  

LogAddDateTime("label", IncludeDate, IncludeTime, IncludeMilliseconds); 

Use this action to add a personal message to the MessageLog, including the posting 
date/time. 

"label":  A string that will appear at the start of the line containing the date/time. 

IncludeDate:  Set to YES or NO. YES means that the date will be added after the string 
specified. If this parameter is not specified, then YES is assumed. 

IncludeTime:  Set to YES or NO. YES means that the time will be added after the date. 
If there’s no date, then it will be added after the string specified. If this parameter is not 
specified, then YES is assumed. 

IncludeMilliseconds:  Set to YES or NO. YES means that the time including 
milliseconds will be added after the date or string specified. This is valid only if the 
IncludeTime is set to YES. If this parameter is not specified, then YES is assumed. 
  

CaseDescriptionClear; 

Use this action to clear the case description of the presently open case. 

  

CaseDescriptionSet("text…", Append); 

Use this action to set or append text to the case description 

"text…":  Specify the text to set/append to the case description 

Append:  YES will append the text to the exisiting case description. NO will replace the 
case description 

  

SaveYbusInMatlabFormat("filename", IncludeVoltages); 

Use this action to store the power system bus admittance matrix (Ybus) in a text format that 
can be easily read into other programs such as MATLAB®. 

"filename":  The file name to save the information to. The Ybus data is stored using 
the MATLAB sparse matrix format in the matrix Ybus. 

IncludeVoltages:  Set to YES or NO. YES means that the bus voltages are also stored 
but in the vector V. 
  

SaveJacobian("filename", IncludeVoltages); 
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Use this action to store the power flow Jacobian in a text format that can be easily read into 
other programs such as MATLAB®. 

"Jacfilename":  The file name to save the Jacobian data to. The Jacobian is stored 
using the MATLAB sparse matrix format in the matrix Jac. 

"JIDfilename":  The file name to save the text identifier information to. This 
information is used to translate the bus numbering convention used in the Jacobian and 
Ybus files with the actual bus number and name in the case. 

filetype:  A parameter saying the format of the file to be saved. It may be one of the 
following strings:  

M: MATLAB .M Format. 

TXT: ASCII format. 

JacForm:  Specifies the form of the Jacobian. It may be one of the following strings:  

R: Rectangular form 

P: Polar form. 
  

SetParticipationFactors(Method, ConstantValue, Object); 

Use this action to define the participation factors for multiple generators. 

Method:  The formula used to calculate the participation factors for each generator. It 
may be one of the following strings:  

MAXMWRAT: The participation factor for each generator is set to the generator’s 
maximum MW capability. 

RESERVE: The participation factor for each generator is set to the generator’s reserve 
power, so that each generator participates in proportion to how much it has left to 
contribute (Max MW rating - Present MW). 

CONSTANT: The participation factor for each generator is set to the same specified 
value. 

ConstantValue:  The value used if CONSTANT method is specified. If CONSTANT 
method is not specified, enter 0 (zero). 

Object:  The set of generators to which the participation factors will be assigned. It may 
be one of the following settings:  

[Area num], [Area "name"] [Area "label"]: For all the generators in area  

[Zone num], [Zone "name"] [Zone "label"]: For all the generators in zone  

SYSTEM: For all the generators in the system regardless of their area or zone 
affiliation.  

AREAZONE or DISPLAYFILTERS: For just the generators whose area/zone/owner filter 
criteria evaluates to true. 

  

GenForceLDC_RCC(filter); 

Use this action to convert the voltage setpoint for Line Drop and Reactive Current 
Compensation (LDC/RCC) for multiple generators. 

filter:  There are four options for the filter:  

GenForceLDC_RCC;:  No filter specified means to convert voltage setpoint for 
LDCC/RCC on all the generators of the system. 
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GenForceLDC_RCC ("filtername");:  "filtername" means to convert voltage 
setpoint for LDCC/RCC on those generators that meet the filter. 

GenForceLDC_RCC (AREAZONE);:  AREAZONE means to convert voltage setpoint 
for LDCC/RCC on those generators that meet the area/zone filters. 

GenForceLDC_RCC (SELECTED);:  SELECTED means to convert voltage setpoint 
for LDCC/RCC on those generators whose selected field is set to YES. 

  

CalculateRXBGFromLengthConfigCondType(filter);  

Use this action the go through branches in the power system and automatically recalculate 
the per unit R, X, G, and B values using the TransLineCalc tool. The branches Conductor 
Type, Tower Configuration, and Line Length will be passed to the TransLineCalc tool and 
new R, X, G and B values will be calculated. This is only available if you have installed the 
TransLineCalc tool. 

filter:  There are four options for the filter which operate identically to the option for the 
GenForceLDC_RCC action above. 

CalculateRXBGFromLengthConfigCondType;:  No filter specified means to 
perform calculation on all branches. 

CalculateRXBGFromLengthConfigCondType ("filtername");:  "filtername" 
means to perform calculation on those branches that meet the filter. 

CalculateRXBGFromLengthConfigCondType;:  AREAZONE means to perform 
calculation on those branches that meet the area/zone filters. 

CalculateRXBGFromLengthConfigCondType:  SELECTED means to perform 
calculation on those branches whose selected field is set to YES. 

  

DirectionsAutoInsert(Source, Sink, DeleteExisting, UseDisplayFilters, Start, 
Increment); 

Use this action to automatically insert multiple directions for PTDF studies. 

Source, Sink:  The type of object used as the source/sink of the directions. Currently, 
only the following types of directions can be automatically defined:  

AREA SLACK: Directions from areas to slack bus of the system. 

ZONE SLACK: Directions from zones to slack bus of the system. 

INJECTIONGROUP SLACK: Directions from injection groups to slack bus of the 
system. 

AREA AREA: Directions from areas to other areas of the system. 

ZONE ZONE: Directions from zones to other zones of the system. 

INJECTIONGROUP INJECTIONGROUP: Directions from injection groups to other 
injection groups of the system. 

DeleteExisting:  Set to YES or NO. YES means that previously defined directions will be 
deleted before the new directions are automatically inserted. NO means automatically 
inserted directions will be added to the list of previously defined directions. If this 
parameter is not specified, then YES is assumed. 

UseDisplayFilters:  Set to YES or NO. YES means that only Areas and Zones with their 
Area/Zone filters set to YES will be used when automatically inserting directions. NO 
specifies all Areas and Zones will be used to automatically insert directions regardless of 
their Area/Zone filters. If this parameter is not specified, then NO is assumed. 
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Start:  Integer value that specifies the first number used when automatically numbering 
the automatically inserted directions. If this parameter is not specified, then 1 is 
assumed. 

Increment:  Integer value that will be used as increment in numbering the subsequent 
automatically inserted directions. If this parameter is not specified, then 1 is assumed. 

   

DeterminePathDistance([start], BranchDistMeas, BranchFilter, BusField); 

Use this action to calculate a distance measure at each bus in the entire model. The distance 
measure will represent how far each bus is from the starting group specified. The distance 
measure can be related to impedance, geographical distance, or simply the number of 
nodes. 

[start] : is an the starting place which is enclosed in brackets. The starting place may 
be either an Area, Zone, SuperArea, SUbstation, Injection Group, or Bus.  

BranchDistMeas : is either X, Z, Length, Nodes, or a variable name for a branch.  

X : means use the series reactance,  

Z : means use sqrt(X^2 + R^2), 

Length : means us the Length field, and 

Nodes : means treat each branch as a length of one.  

variablename : Otherwise use any Branch object variable name.  

BranchFilter : is either All, Selected, Closed or the name of a branch Advanced Filter. 
This parameter is used to specify which branch can be traversed at all.  

All : means all branches can be traversed 

Selected : means only branch whose Selected field is YES can be traversed 

Closed  : means only branches that are CLOSED can be traversed.  

Filtername : means only branches who meet the Advanced Filter named can be 
traversed.  

BusField : is the variablename of a Bus field. This field is populated with the minimum 
distance from the Start Place to that bus. All buses in the start group will have a distance 
measure of zero. Buses which can not be reached from the start group will have a 
distance measure of -1.  

  

DetermineShortestPath([start], [end], BranchDistanceMeasure, BranchFilter, 
Filename); 

Use this action to calculate the shortest path between a starting group and an ending group. 
The results will be written to a textfile specified by filename. In the text file, the first bus 
listed will be in the end grouping and the last bus listed will be the start grouping. The result 
text file will have a line for each bus passed. Each line will contain three entries delimited by 
a space: “Number DistanceMeasure Name”.  

[start] : same as the starting place for the DeterminePathDistance script command 

[end] : same as the starting place for the DeterminePathDistance script command 

BranchDistanceMeasure : same as for DeterminePathDistance script command 

BranchFilter : same as for DeterminePathDistance script command 

Filename : is a filename (may need to be enclosed in quotes) to which the results will 
be written. 
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Script Edit Mode Actions 

  

The following script commands are available during the Case submode of Edit mode:  
  

Equivalence; 

DeleteExternalSystem; 

 

SaveExternalSystem ("filename", Savefiletype, withties); 

 

Scale (scaletype, basedon, [parameters], ScaleMarker); 

  LOAD MW [P,Q] BUS 

  GEN FACTOR [P] (means constant 
pf) 

AREA 

  INJECTIONGROUP     ZONE 

  BUSSHUNT   [P, +Q, -Q]   

Move ([elementA], [destination 
parameter]); 

  

  [GEN numA idA] [numB idB]   

  [LOAD numA idA] [numB idB] // NOT AVAILABLE 
YET 

  [BRANCH numA1 numA2 cktA] [numB1 numB2 
cktB] 

// NOT AVAILABLE 
YET 

 

Combine ([elementA], [elementB]);   

  [GEN numA idA] [GEN numB idB]   

  [LOAD numA idA] [LOAD numB idB] // NOT AVAILABLE 
YET 

  [BRANCH numA1 numA2 
cktA] 

[BRANCH numB1 numB2 cktB] // NOT AVAILABLE 
YET 

        
 

SplitBus ([element], NewBusNumber, InsertBusTieLine, LineOpen); 

  [BUS num] num YES or NO YES or NO 

 

MergeBuses (NewBusNumber, filter); 
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  num   

 

TapTransmissionLine ([element], PosAlongTheLine, NewBusNumber, ShuntModel, TreatA

  [BRANCH 
numA1 
numA2 
cktA]; 

Value in % num LINESHUNTS YES or

        CAPACITANCE   

            
 

InterfacesAutoIns
ert 

(Typ
e, 

DeleteExistin
g, 

UseDisplayFilte
rs, 

Prefix
, 

Limits)
; 

  AREA YES or NO YES or NO "strin
g" 

AUTO 

  ZON
E 

      ZEROS 

          [value
1, … 
value 
8] 

  

Equivalence 

This action will equivalence a power system. All options regarding equivalencing are handled 
by the Equiv_Options objecttype. Use the SetData() action, or a DATA section to set these 
options prior to using the Equivalence() action. Also, remember that the property BusEquiv 
must be set true for each bus that you want to equivalence. 

  

DeleteExternalSystem 

This action will delete part of the power system. It will delete those buses whose property 
BusEquiv must is set true. 

  

SaveExternalSystem("filename", SaveFileType, WithTies) 

This action will save part of the power system to a "filename". It will save only those buses 
whose property BusEquiv must is set true.  

"filename":  The file name to save the information to. 

SaveFileType:  An optional parameter saying the format of the file to be saved. If none 
is specified, then PWB will be assumed. My be one of the following strings: 

 PWB, PWB5, PWB6, PWB7. PWB8, PWB9, PWB10, PWB11, PWB12 

PTI (means PTI30) PTI23, PTI24, PTI25, PTI26, PTI27, PTI28, PTI29, PTI30 

GE (means GE15), GE14, GE15 

CF 
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AUX 

WithTies:  An optional parameter. One must specify the file type explicitly in order to 
use the WithTies parameter. Allows one to save transmission lines that tie the a bus 
marked with BusEquiv as false and one marked true. This must be a string which starts 
with the letter Y, otherwise NO will be assumed. 
  

Scale(scaletype, basedon, [parameters], scalemarker); 

Use this action to scale the load and generation in the system.  

scaletype:  The objecttype begin scaled. Must be either LOAD, GEN, INJECTIONGROUP, 
or BUSSHUNT. 

basedon:  MW: parameters are given in MW, MVAR units. 

FACTOR: parameters a factor to multiple the present values by. 

[parameters]:  These parameters have different meanings depending on ScaleType.  

LOAD: [MW, MVAR] or [MW]. If you want to scale load using constant power factor, 
then do not specifying a MVAR value.  

GEN: [MW]. 

INJECTIONGROUP: [MW, MVAR] or [MW] . If you want to scale load using constant 
power factor, then do not specifying a MVAR value. 

BUSSHUNT: [GMW, BCAPMVAR, BREAMVAR]. The first values scales G shunt values, 
the second value scales positive (capacitive) B shunt values, and the third value 
scales negative (reactive) B shunt values. 

scalemarker:  This value specifies whether to look at an element’s bus, area, or zone to 
determine whether it should be scaled. 

BUS: Means that elements will be scaled according to the BusScale property of the 
element’s terminal bus.  

AREA: Means that elements will be scaled according to the BGScale property of the 
element’s Area. Note that it is possible for the area of a load, generator, or switched 
shunt to be different than the terminal bus’s area. 

ZONE: Means that elements will be scaled according to the BGScale property of the 
element’s Zone. Note that it is possible for the zone of a load, generator, or switched 
shunt to be different than the terminal bus’s zone. 

OWNER: Means that the elements will be scaled according to the BGScale property of 
the element’s Owner. 

  

Move([elementA], [destination parameters]); 

NOTE: THIS ACTION IS ONLY AVAILABLE FOR GENERATORS. 

Use this action to move a generator, load, or transmission line.  

[elementA]:  the object that should be moved. Must be one of the following formats. 

[GEN busnum id], [GEN "name_nomkv" id], [GEN "buslabel" id], [GEN "label"] 

[LOAD busnum id], [LOAD "name_nomkv" id], [LOAD "buslabel" id], [LOAD "label"] 

[BRANCH busnum1 busnum2 ckt], [BRANCH "name_kv1" "name_kv2" ckt], 

[BRANCH "buslabel1" "buslabel2" ckt], [BRANCH "label"] 

[destination parameters]:  These parameters have different meanings depending on 
object type of the element. Bus numbers must be used here. 
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GEN: [busnum id] 

LOAD: [busnum id]  

BRANCH: [busnum1 busnum2 id] 
  

Combine([elementA], [elementB]); 

NOTE: THIS ACTION IS ONLY AVAILABLE FOR GENERATORS.  

Use this action to combine two generators, two loads, or two transmission line. Note that 
elementA and elementB must be of the same object type. You can not combine a BRANCH 
and a LOAD. 

[elementA]:  The object that should be moved. Must be one of the following formats. 

[GEN busnum id] 

[LOAD busnum id] 

[BRANCH busnum1 busnum2 ckt] 

[elementB]:  The object that element A should be combined with. Must the same 
format as for elementA. 
  

SplitBus([element], NewBusNumber, InsertBusTieLine, LineOpen); 

Use this action to transform one bus into two connected buses. 

[element]:  The bus that should be split. Must be of the following format:  

[BUS num] 

[BUS "name_nomkv"] 

[BUS "buslabel"] 

NewBusNumber:  The number of the new bus resulting from the split. Must be unique, 
that is, it cannot be a number that identifies another number in the case. 

InsertBusTieLine Set to YES or NO. YES means to insert a very low-impedance bus tie 
between the bus to split and its offspring. The new branch will have an impedance of 
0.0000 + j0.0001 ohms. NO means that no bus tie will be inserted. If this parameter is 
not specified, then YES is assumed. 

LineOpen Set to YES or NO. YES means that the bus tie should be inserted as an open 
branch. NO means that the bus tie will be inserted as a closed branch. This options is 
valid only if InsertBusTieLine is set to YES. If this parameter is not specified, then NO is 
assumed. 
  

MergeBuses([element], filter); 

Use this action to merge a set of buses into a single bus. 

[element]:  The number of the new bus resulting from the merging. It should be a 
number of a bus that is part of the set of buses to be merged, or it should be unique, 
meaning that it cannot be a number that identifies another number in the case. Must be 
of the following format:  

[BUS num] 

filter:  There are four options for the filter:  

MergeBuses(…);:  No filter specified means to merge all the buses of the system. 

MergeBuses(…, "filtername");:  "filtername" means to merge those buses that 
meet the filter. 
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MergeBuses(…, AREAZONE);:  AREAZONE means to merge those buses that meet 
the area/zone filters. 

MergeBuses(…, SELECTED);:  SELECTED means to merge those buses whose 
selected field is set to YES. 

  

TapTransmissionLine([element], PosAlongTheLine, NewBusNumber, ShuntModel, 
TreatAsMSLine); 

Use this action to insert a bus at some location along an existing transmission line. 

[element]:  The transmission line to tap. Must be of the following format:  

[BRANCH busnum1 busnum2 ckt] 

[BRANCH "name_kv1" "name_kv2" ckt] 

[BRANCH "buslabel1" "buslabel2" ckt] 

[BRANCH "label"] 

PosAlongTheLine:  The value that indicates the point where the new bus is to be 
inserted relative to the location of the nearest of the two buses in terms of a percentage 
of the total line length This value controls how the impedances of the new lines are set, 
as the impedance of each section will equal the section’s corresponding percentage 
length multiplies by the impedance of the original line. 

NewBusNumber:  The number of the new bus resulting from the tapping. Must be 
unique, that is, it cannot be a number that identifies another number in the case. 

ShuntModel:  The way the original charging capacitance of the line is reassigned. The 
choices are:  

LINESHUNTS: The original charging capacitance is reassigned as line shunts at the 
original terminal bus ends of the two new line segments. The charging capacitance of 
the two new branch elements will be set to 0. 

CAPACITANCE: The original charging capacitance of the line is converted 
approximately using percentage entered as PosAlongTheLine. In other words, the 
original capacitance will be scaled and assigned to the new segments as charging 
capacitance. 

The default ShuntModel is LINESHUNTS. 

TreatAsMSLine:  Set to YES or NO. YES means that a new multi-section line will be 
created that is comprised of the two new lines. NO means that the two new lines will be 
controlled independently of each other. 
  

InterfacesAutoInsert(Type, DeleteExisting, UseDisplayFilters, Prefix, Limits); 

Use this action to automatically insert a group of interfaces. The new of the new interfaces 
defaults to "Area1-Area2" or "Zone1-Zone2" with an optional Prefix. 

Type:  The type of interfaces to insert. Choices are:  

AREA: Area-to-area interfaces join adjacent areas (those that share at least one tie 
line). 

ZONE: Zone-to-zone interfaces join adjacent interfaces (those that share at least one 
tie line). 

DeleteExisting:  Set to YES or NO. YES means that previously defined interfaces will be 
deleted before the new interfaces are automatically inserted. NO means automatically 
inserted interfaces will be added to the list of previously defined interfaces. If this 
parameter is not specified, then YES is assumed. 
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UseDisplayFilters:  Set to YES or NO. YES means that only Areas and Zones with their 
Area/Zone filters set to YES will be used when automatically inserting interfaces. NO 
specifies all Areas and Zones will be used to automatically insert interfaces regardless of 
their Area/Zone filters. If this parameter is not specified, then NO is assumed. 

Prefix:  An optional prefix of up to three characters. Use this prefix to avoid duplicating 
names, particularly when some of the areas or zones have the same name. If this 
parameter is not specified, then "" is assumed. 

Limits:  Specifies the way the interfaces rating are set. Choices are:  

AUTO: The interface rating is calculated based on the ratings of the components 
included in the interface. 

ZEROS: All the interface limits are set to zero. 

[value1, …, value8]: The set of rating values to be used for the interfaces. The eight 
values must be specified, separated by commas. 

The default parameter is ZEROS. 
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Script Run Mode Actions 

  

The following script commands are available during any of the submodes of Run Mode:  
  

Animate;       

CalculatePTDF  ([transactor seller], [transactor buyer], LinearMethod)

   [AREA num]  [AREA num] AC 

   [ZONE num]  [ZONE num] DC 

   [SUPERAREA "name"]  [SUPERAREA name] DCPS 

   [INJECTIONGROUP 
"name"]  

[INJECTIONGROUP 
name] 

  

   [BUS num]  [BUS num]   

   [SLACK]  [SLACK]   

CalculatePTDFMultipleDirections (StoreValuesForBranches, StoreValuesForInterfaces, LinearMethod)

  YES or NO YES or NO AC 

      DC 

      DCPS 

 

CalculateLODF  ([BRANCH nearbusnum farbusnum 
ckt], 

LinearMethod); 

 

CalculateTLR  ([flowelement], direction, [transactor], LinearMet

   [INTERFACE "name"]  BUYER same as above for 
PTDFs 

  

  [BRANCH nearbusnum farbusnum 
ckt] 

SELLER     

 

CalculateTLRMultipleElement (TypeElement WhichElement, 

  
direction,  [transactor], LinearMet

  BRANCH SELECTED BUYER same as 
above for 
PTDFs 

  

  INTERFACE OVERLOAD SELLER     

  BOTH CTGOVERLOAD       
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CalculateVoltSense  ([BUS 
num]); 

 

CalculateFlowSense ([flowelement], FlowType); 

   [INTERFACE 
"name"]  

MW 

   [BRANCH busnum1 
busnum2 ckt]  

MVAR 

MVA 

 

CalculateLossSense  (FunctionType); 

  NONE 

  ISLAND 

  AREA 

  AREASA 

  SELECTED 

 

CalculateVoltToTransferSense ([transactor seller], [transactor buyer], TransferType TurnOffAV

  [AREA num] [AREA num] [P, Q, or PQ] YES or NO

  [ZONE num] [ZONE num]     

  [SUPERAREA 
"name"] 

[SUPERAREA 
name] 

    

  [INJECTIONGROUP 
"name"] 

[INJECTIONGROUP 
name] 

    

  [BUS num] [BUS num]     

  [SLACK] [SLACK]     

 

CalculateVoltSelfSense (filter); 

 

SetSensitivitiesAtOutOfServiceToClosest; 

 

ZeroOutMismatches; 

  

Animate(DoAnimate); 

Use this action to animate all the open oneline diagrams. 

DoAnimate:  Set to YES or NO. YES means to start the animation of the open oneline 
diagrams, while NO means that the animation will be paused. 
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CalculatePTDF([transactor seller], [transactor buyer], LinearMethod); 

Use this action to calculate the PTDF values between a seller and a buyer. You may 
optionally specify the linear calculation method. Note that the buyer and seller must not be 
same thing. If no Linear Method is specified, Lossless DC will be used. 

[transactor seller]:  The seller (or source) of power. There are six possible settings:  

[AREA num], [AREA "name"], [AREA "label"] 

[ZONE num], [ZONE "name"], [ZONE "label"] 

[SUPERAREA "name"], [SUPERAREA "label"] 

[INJECTIONGROUP "name"], [INJECTIONGROUP "label"] 

[BUS num], [BUS "name_nomkv"], [BUS "label"] 

[SLACK] 

[transactor buyer]:  The buyer (or sink) of power. There are six possible settings, 
which are the same as for the seller. 

LinearMethod:  The linear method to be used for the PTDF calculation. The options 
are:  

AC: for calculation including losses. 

DC: for lossless DC. 

DCPS: for lossless DC that takes into account phase shifter operation. 
  

CalculatePTDFMultipleDirections(StoreValuesForBranches, 
StoreValuesForInterfaces, LinearMethod); 

Use this action to calculate the PTDF values using multiple directions. Only directions with 
the field INCLUDE set to YES will be analyzed when calculating the multiple direction PTDF’s. 
You may optionally specify the linear calculation method. If no Linear Method is specified, 
Lossless DC will be used. 

StoreValuesForBranches:  Set to YES or NO. YES means that the PTDF’s for 
lines/transformers will be stored. 

StoreValuesForInterfaces:  Set to YES or NO. YES means that the PTDF’s for 
interfaces will be stored. 

LinearMethod:  The linear method to be used for the PTDF calculation. The options 
are:  

AC: for calculation including losses. 

DC: for lossless DC. 

DCPS: for lossless DC that takes into account phase shifter operation. 
  

CalculateLODF([BRANCH nearbusnum farbusnum ckt], LinearMethod); 

Use this action to calculate the Line Outage Distribution Factors (or the Line Closure 
Distribution Factors) for a particular branch. If the branch is presently closed, then the LODF 
values will be calculated, otherwise the LCDF values will be calculated. You may optionally 
specify the linear calculation method as well. If no Linear Method is specified, Lossless DC 
will be used. 

[BRANCH nearbusnum farbusnum ckt]:  The branch whose status is being changed. 
Can also use strings 
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[BRANCH "nearbusname_kv" "farbusname_kv" ckt] 

[BRANCH "nearbuslabel" "farbuslabel" ckt] 

[BRANCH "label"] 

LinearMethod:  The linear method to be used for the LODF calculation. The options 
are:  

DC: for lossless DC. 

DCPS: for lossless DC that takes into account phase shifter operation. 

Note: AC is NOT an option for the LODF calculation. 
  

CalculateTLR([flow element], direction, [transactor], LinearMethod); 

Use this action to calculate the TLR values a particular flow element (transmission line or 
interface). You also specify one end of the potential transfer direction. You may optionally 
specify the linear calculation method. If no Linear Method is specified, Lossless DC will be 
used. 

[flow element]:  This is the flow element we are interested in. Choices are:  

[INTERFACE "name"] 

[INTERFACE "label"] 

[BRANCH nearbusnum farbusnum ckt] 

[BRANCH "nearbusname_kv" "farbusname_kv" ckt] 

[BRANCH "nearbuslabel" "farbuslabel" ckt] 

[BRANCH "label"] 

direction:  the type of the transactor. Either BUYER or SELLER. 

[transactor buyer]:  the transactor of power. There are six possible settings. 

[AREA num], [AREA "name"], [AREA "label"] 

[ZONE num], [ZONE "name"], [ZONE "label"] 

[SUPERAREA "name"], [SUPERAREA "label"] 

[INJECTIONGROUP "name"], [INJECTIONGROUP "label"] 

[BUS num], [BUS "name_nomkv"], [BUS "label"] 

[SLACK] 

LinearMethod:  The linear method to be used for the calculation. The options are:  

AC: for calculation including losses. 

DC: for lossless DC. 

DCPS: for lossless DC that takes into account phase shifter operation. 
  

CalculateTLRMultipleElement(TypeElement, WhichElement, direction, [transactor], 
LinearMethod); 

Use this action to calculate the TLR values a multiple elements similar to as is done on the 
TLR multiple elements dialog. You also specify one end of the potential transfer direction. 
You may optionally specify the linear calculation method. If no Linear Method is specified, 
Lossless DC will be used. 

TypeElement : May be either INTERFACE, BRANCH, or BOTH 
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WhichElement : There are three choices which represent which elements of the 
TypeElement specified will have TLR calculations performed. 

SELECTED : Only branches or interfaces with their Selected Field = YES will be used. 

OVERLOAD : Only branches that are presently overloaded using their normal ratings 
will be used 

CTGOVERLOAD : You must have first run the contingency analysis. A branch or 
interface is included in the calculation if it has been overloaded during at least one 
contingency. 

direction:  the type of the transactor. Either BUYER or SELLER. 

[transactor buyer]:  the transactor of power. There are six possible settings. 

[AREA num], [AREA "name"], [AREA "label"] 

[ZONE num], [ZONE "name"], [ZONE "label"] 

[SUPERAREA "name"], [SUPERAREA "label"] 

[INJECTIONGROUP "name"], [INJECTIONGROUP "label"] 

[BUS num], [BUS "name_nomkv"], [BUS "label"] 

[SLACK] 

LinearMethod:  The linear method to be used for the calculation. The options are:  

AC: for calculation including losses. 

DC: for lossless DC. 

DCPS: for lossless DC that takes into account phase shifter operation. 
  

CalculateVoltSense([BUS num]); 

This calculates the sensitivity of a particular buses voltage to real and reactive power 
injections at all buses in the system. (Note: this assumes that the power is injected at a 
given bus and taken out at the slack bus). 

[BUS num]:  The bus to calculate sensitivities for. 
  

CalculateFlowSense([flow element], FlowType); 

This calculates the sensitivity of the MW, MVAR, or MVA flow of a line or interface to real 
and reactive power injections at all buses in the system. (Note: this assumes that the power 
is injected at a given bus and taken out at the slack bus). 

[flow element]:  This is the flow element we are interested in. Choices are:  

[INTERFACE "name"] 

[INTERFACE "label"] 

[BRANCH busnum1 busnum2 ckt] 

[BRANCH "name_kv1" "name_kv2" ckt] 

[BRANCH "buslabel1" "buslabel2" ckt] 

[BRANCH "label"] 

FlowType:  The type of flow to calculate this for. Either MW, MVAR, or MVA. 
  

CalculateLossSense(FunctionType); 

This action calculates the sensitivity of a real power loss function, PLosses, to bus real and 
reactive power injections. Stated mathematically, this action calculates d PLosses/d Pi and d 
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PLosses/d Qi , where Pi and Qi are the real and reactive power injections at bus i, 
respectively. Stated less formally, this action indicates how losses would change if one more 
MW or Mvar of power were injected at bus i. 

FunctionType:  Specifies how the losses are computed. Choices are:  

NONE: No losses are calculated because a loss function is not specified. 

ISLAND: Losses are calculated with respect to the losses in bus’ island. If the power 
system consists of only one island, losses are computed with respect to the total 
system losses.  

AREA: Losses are calculated with respect to the total losses for the area containing 
bus i. This is probably the most common loss function because usually one is 
concerned with minimizing losses for a particular area rather than for the entire case. 

AREASA: Losses are calculated with respect to the total losses for the area containing 
bus i if bus i does not belong to a super area, and with respect to the total losses for 
the super area containing bus i if bus i does belong to a super area. 

SELECTED: Losses are calculated with respect to the total losses for a group of areas 
whose selected field is set to YES.  

  

CalculateVoltToTransferSense([transactor seller], [transactor buyer], 
TransferType, TurnOffAVR); 

This calculates the sensitivity of bus voltage to a real or reactive power transfer between a 
seller and a buyer. The sensitivity is calculated for all buses in the system. 

[transactor seller]:  This is the seller (or source) of power. There are six possible 
settings:  

[AREA num], [AREA "name"], [AREA "label"] 

[ZONE num], [ZONE "name"], [ZONE "label"] 

[SUPERAREA "name"], [SUPERAREA "label"] 

[INJECTIONGROUP "name"], [INJECTIONGROUP "label"] 

[BUS num], [BUS "name_nomkv"], [BUS "label"] 

[SLACK] 

[transactor buyer]:  This is the buyer (or sink) of power. There are six possible 
settings, which are the same as for the seller. 

TransferType:  The type of power transfer. The options are:  

P – real power transfer 

Q – reactive power transfer 

PQ – both real and reactive power transfer. (Note: Real and reactive power transfers 
are calculated independently, but both are calculated.) 

TurnOffAVR:  Set to YES or NO. Set to YES to turn off AVR control for generators 
participating in the transfer. Set to NO to leave the AVR control unchanged for 
generators participating in the transfer. 

  

CalculateVoltSelfSense(filter); 

This calculates the sensitivity of a particular bus’ voltage to real and reactive power 
injections at the same bus. (Note: This assumes that the power is injected at a given bus 
and taken out at the slack bus.) 

filter:  There are four options for the filter:  
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CalculateVoltSelfSense; : No filter specified means to merge all the buses of the 
system. 

CalculateVoltSelfSense("filtername"); : "filtername" means to merge those 
buses that meet the filter. 

CalculateVoltSelfSense(AREAZONE); : AREAZONE means to merge those buses 
that meet the area/zone filters. 

CalculateVoltSelfSense(SELECTED); : SELECTED means to merge those buses 
whose selected field is set to YES. 

  

SetSensitivitiesAtOutOfServiceToClosest; 

This will take the P Sensitivity and Q Sensitivity values calculated using CalculateTLR, 
CalculateFlowSense, or CalculateVoltSense actions and then populate the respective values 
at out-of-service buses so that they are equal to the value at the closest in service bus. The 
"distance" to the in-service buses will be measured by the number of nodes. If an out-of-
service bus is equally close to a set of buses, then the average of that set of buses will be 
used. 

  

ZeroOutMismatches; 

With this script command, the bus shunts are changed at each bus that has a mismatch 
greater than the MVA convergence tolerance so that the mismatch at that bus is forced to 
zero. 

  

In addition to the general run mode actions, there are specific actions for the following 
submodes: PowerFlow, Contingency, ATC, Fault, PV and QV. 
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Script PowerFlow Submode Actions 

  

The following actions are specific to the Run Mode submode PowerFlow:  
  

DoCTGAction([contingency action]); 

SolvePowerFlow(SolMethod, "filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

ResetToFlatStart(FlatVoltagesAngles, ShuntsToMax, LTCsToMiddle, PSAnglesToMiddle); 

SolvePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2); 

InitializePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2); 

SolveSinglePrimalLPOuterLoop("filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

SolveFullSCOPF(BCMethod, "filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

OPFWriteResultsAndOptions ("filename"); 

DiffFlowSetAsBase; 

DiffFlowClearBase; 

DiffFlowMode (diffmode); 

  PRESENT 

  BASE 

  DIFFERENCE 

  

DoCTGAction([contingency action]); 

Call this action to use the formats seen in the CTGElement subdata record for Contingency 
Data. Note that all actions are supported, except COMPENSATION sections are not allowed. 

  

SolvePowerFlow(SolMethod, "filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

Call this action to perform a single power flow solution. The parameters are all optional and 
specify a conditional response depending on whether the solution is successfully found. If 
parameters are not passed then default values will be used. 

SolMethod The solution method to be used for the power flow calculation. The options 
are:  

RECTNEWT: For Rectangular Newton-Raphson method. 

POLARNEWTON: For Polar Newton-Raphson method. 

GAUSSSEIDEL: For Gauss-Seidel method. 

FASTDEC: For Fast Decoupled method. 

DC: For DC method. 

ROBUST: For ROBUST method. 

The default method is RECTNEWT. 
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"filename1" The filename of the auxiliary file to be loaded if there is a successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename1. Default Value is NO. 

CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename2. Default Value is NO. 
  

ResetToFlatStart (FlatVoltagesAngles, ShuntsToMax, LTCsToMiddle, 
PSAnglesToMiddle); 

Use this action to initialize the Power Flow Solution to a "flat start." The parameters are all 
optional and specify a conditional response depending on whether the solution is 
successfully found. If parameters are not passed then default values will be used. 

FlatVoltagesAngles Set to YES or NO. YES means setting all the voltage magnitudes 
and generator setpoint voltages to 1.0 per unit and all the voltage angles to zero. Default 
Value is YES. 

ShuntsToMax Set to YES or NO. YES means to increase Switched Shunts Mvar half way 
to maximum. Default Value is NO. 

LTCsToMiddle Set to YES or NO. YES means setting the LTC Transformer Taps to 
middle of range. Default Value is NO. 

PSAnglesToMiddle Set to YES or NO. YES means setting Phase Shifter angles to 
middle of range. Default Value is NO. 
  

SolvePrimalLP("filename1", "filename2", CreateIfNotFound1, CreateIfNotFound2); 

Call this action to perform a primal LP OPF solution. The parameters are all optional and 
specify a conditional response depending on whether the solution is successfully found. If 
parameters are not passed then default values will be used. 

"filename1" The filename of the auxiliary file to be loaded if there is a successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename1. Default Value is NO. 

CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename2. Default Value is NO. 
  

SolveSinglePrimalLPOuterLoop("filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

This action is basically identical to the SolvePrimalLP action, except that this will only 
perform a single optimization. The SolvePrimalLP will iterate between solving the power flow 
and an optimization until this iteration converges. This action will only solve the optimization 
routine once, then resolve the power flow once and then stop. 
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InitializePrimalLP("filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

This command clears all the structures and results of previous primal LP OPF solutions. The 
parameters are all optional and specify a conditional response depending on whether the 
solution is successfully found. If parameters are not passed then default values will be used. 

"filename1" The filename of the auxiliary file to be loaded if there is a successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename1. Default Value is NO. 

CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename2. Default Value is NO. 

  

SolveFullSCOPF (BCMethod, "filename1", "filename2", CreateIfNotFound1, 
CreateIfNotFound2); 

Call this action to perform a full Security Constrained OPF solution. The parameters are all 
optional and specify a conditional response depending on whether the solution is 
successfully found. If parameters are not passed then default values will be used. 

BCMethod The solution method to be used for solving the base case. The options are:  

POWERFLOW – for single power flow algorithm. 

OPF – for the optimal power flow algorithm. 

Default Value is POWERFLOW. 

"filename1" The filename of the auxiliary file to be loaded if there is a successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

"filename2" The filename of the auxiliary file to be loaded if there is a NOT successful 
solution. You may also specify STOP, which means that all AUX file execution should stop 
under the condition. Default Value is "". 

CreateIfNotFound1 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename1. Default Value is NO. 

CreateIfNotFound2 Set to YES or NO. YES means that objects which can not be found 
will be created while reading in DATA sections of filename2. Default Value is NO. 
  

OPFWriteResultsAndOptions("filename"); 

Writes out all information related to OPF analysis as an auxiliary file. This includes Limit 
Monitoring Settings, options for Areas, Buses, Branches, Interfaces, Generators, SuperAreas, 
OPF Solution Options. 

  

DiffFlowSetAsBase; 

Call this action to set the present case as the base case for the difference flows abilities of 
Simulator. 
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DiffFlowClearBase; 

Call this action to clear the base case for the difference flows abilities of Simulator. 

  

DiffFlowMode(diffmode); 

Call this action to change the mode for the difference flows abilities of Simulator.  

diffmode:  
String that starts with ‘P’ changes it to PRESENT 
String that starts with ‘B’ changes it to BASE 
String that starts with ‘D’ changes it to DIFFERENCE 
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Script Contingency Submode Actions 

  

The following actions are specific to the Run Mode Submode Contingency:  
  

CTGSolveAll; 

CTGSolve("ContingencyName"); 

CTGSetAsReference; 

CTGRestoreReference; 

CTGProduceReport("filename"); 

CTGWriteResultsAndOptions("filename"); 

CTGAutoInsert; 

CTGCalculateOTDF( [transactor seller], [transactor buyer], LinearMethod); 

 [AREA num] [AREA num] AC 

 [ZONE num] [ZONE num] DC 

 [SUPERAREA "name"] [SUPERAREA "name"] DCPS 

 [INJECTIONGROUP "name"] [INJECTIONGROUP "name"] 

 [BUS num] [BUS num] 

 [SLACK] [SLACK] 

  

CTGSolveAll; 

Call this action to solve all the contingencies which are not marked skip. 

  

CTGSolve("ContingencyName"); 

Call this action solve a particular contingency. The contingency is denoted by the 
"Contingency Name". 

  

CTGSetAsReference; 

Call this action to set the present system state as the reference for contingency analysis. 

  

CTGRestoreReference; 

Call this action to reset the system state to the reference state for contingency analysis. 

  

CTGProduceReport("filename"); 

Produces a text-based contingency analysis report using the settings defined in 
CTG_Options. 

  

CTGWriteResultsAndOptions("filename"); 
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Writes out all information related to contingency analysis as an auxiliary file. This includes 
Contingency Definitions, Limit Monitoring Settings, Contingency Results, Solution Options, 
CTG Options as well as any Model Criteria that are used by the Contingency Definitions. 

  

CTGAutoInsert; 

Automatically generates a contingency list using the settings defined in CTG_Options. 

  

CTGCalculateOTDF([transactor seller], [transactor buyer], LinearMethod); 

This action calculate OTDFs for each contingency-caused branch or interface violation. The 
values calculated will be a measure of what percent of a transfer would appear on the 
branch or interface after the respective contingency occurs. Realize for branch violations, 
that the sign of the OTDF value will be relative to the direction of the MW flow found during 
the contingency analysis. 

The parameters will be used to calculate the PTDFs for the transfer direction you are 
interested in. These PTDF values will then be used throughout the OTDF calculation. Note 
that the buyer and seller must not be same thing. If no Linear Method is specified, Lossless 
DC will be used. 

NOTE: All the parameters are optional. If they are not specified, then the existing PTDFs will 
be used. 

[transactor seller]:  The seller (or source) of power. There are six possible settings:  

[AREA num] 

[ZONE num] 

[SUPERAREA "name"] 

[INJECTIONGROUP "name"] 

[BUS num] 

[SLACK] 

[transactor buyer]:  The buyer (or sink) of power. There are six possible settings, 
which are the same as for the seller. 

LinearMethod:  The linear method to be used for the PTDF calculation. The options 
are:  

AC: for calculation including losses. 

DC: for lossless DC. 

DCPS: for lossless DC that takes into account phase shifter operation. 
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Script ATC Submode Actions 

  

The following actions are specific to the Run Mode Submode ATC:  
  

ATCDetermine  ([transactor seller], [transactor buyer]); 

   [AREA num]  [AREA num] 

   [ZONE num]  [ZONE num] 

   [SUPERAREA "name"]  [SUPERAREA name] 

   [INJECTIONGROUP 
"name"]  

INJECTIONGROUP 
name] 

   [BUS num]  [BUS num] 

   [SLACK]  SLACK] 

 

ATCRestoreInitialState;         

ATCIncreaseTransferBy (amount);       

ATCTakeMeToScenario (RL, G, I);   

ATCDetermineATCFor (RL, G, I, ApplyTransfer); 

ATCWriteResultsAndOptions ("filename");       

ATCWriteToExcel ("worksheetname");       

  

ATCDetermine([transactor seller], [transactor buyer]); 

Use this action to calculate the Available Transfer Capability (ATC) between a seller and a 
buyer. Note that the buyer and seller must not be same thing. Other options regarding ATC 
calculations should be set using a DATA section via the ATC_Options object type. 

[transactor seller]:  The seller (or source) of power. There are six possible settings 

[AREA num], [AREA "name"], [AREA "label"] 

[ZONE num], [ZONE "name"], [ZONE "label"] 

[SUPERAREA "name"], [SUPERAREA "label"] 

[INJECTIONGROUP "name"], [INJECTIONGROUP "label"] 

[BUS num], [BUS "name_nomkv"], [BUS "label"] 

[SLACK] 

[transactor buyer]:  The buyer (or sink) of power. There are six possible settings 
which are the same as for the seller. 

  

ATCRestoreInitialState; 

Call this action to restore the initial state for the ATC tool. 
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ATCIncreaseTransferBy(amount); 

Call this action to increase the transfer between the buyer and seller. 

  

ATCTakeMeToScenario(RL, G, I); 

Call this action to set the present case according to Scenario RL, G, I. 

  

ATCDetermineATCFor(RL, G, I, ApplyTransfer); 

Call this action to determine the ATC for Scenario RL, G, I. 

ApplyTransfer: Set this value to YES to leave the system state at the transfer level that 
was determined. When using the Iterated Linear then Full Contingency solution method, 
the system state will retain the transfer level but the contingency will not be applied.  

  

ATCWriteResultsAndOptions("filename"); 

Writes out all information related to ATC analysis as an auxiliary file. This includes 
Contingency Definitions, Limit Monitoring Settings, Solution Options, ATC Options, ATC 
results, as well as any Model Criteria that are used by the Contingency Definitions. 

  

ATCWriteResultsAndOptions("worksheetname"); 

Sends ATC analysis results to an Excel spreadsheet. This script command is available only 
for Multiple Scenarios ATC analysis. 

"worksheetname"  The name of the Excel sheet where the results will be sent to. 
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Script Fault Submode Actions 

  

The following actions are specific to the Run Mode Submode Fault:  
  

Fault ([BUS num],   faulttype, R, X); 
Fault ([BRANCH nearbusnum farbusnum ckt], faultlocation, faulttype,  R, X) ; 

      SLG     
      LL     
      3PB     
      DLG     

  

Fault([Bus num, faulttype, R, X]); 

  

Fault([BRANCH nearbusnum farbusnum ckt], faultlocation, faulttype, R, X]); 

Call this function to calculate the fault currents for a fault. If the fault element is a bus then 
do not specify the fault location parameter. If the fault element is a branch, then the fault 
location is required. 

[Bus num]:  This specifies the bus at which the fault occurs. You may also specify the 
bus using secondary keys or labels: 

[BUS "name_nomkv"] 

[BUS "label"] 

[BRANCH nearbusnum farbusnum ckt]:  This specifies the branch on which the fault 
occurs. You may also specify the branch using secondary keys or labels: 

[BRANCH "name_kv1" "name_kv2" ckt] 

[BRANCH "buslabel1" "buslabel2" ckt] 

[BRANCH "label"] 

Fault location:   This specifies the percentage distance along the branch where the 
fault occurs. This percent varies from 0 (meaning at the nearbus) to 100 (meaning at the 
far bus) 

Faulttype:  This specified the type of fault which occurs. There are four options:  

SLG: Single Line To Ground fault 
LL: Line to Line Fault 
3PB: Three Phase Balanced Fault 
DLG: Double Line to Group Fault. 

R, X:  These parameters are optional and specify the fault impedance. If none are 
specified, then a fault impedance of zero is assumed. 
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Script PV Submode Actions 

  

The following actions are specific to the Run Mode Submode PV:  
  

PVCreate ("name", [element source], [element sink]); 

    [INJECTIONGROUP 
"name"] 

[INJECTIONGROUP 
"name"] 

PVSetSourceAndSink ("name"); [element source], [element sink]); 

    [INJECTIONGROUP 
"name"] 

[INJECTIONGROUP 
"name"] 

 

PVRun ("name"); 

PVClearResults ("name"); 

PVStartOver ("name"); 

PVDestroy ("name"); 

PVWriteResultsAndOptions ("filename"); 

 

RefineModel (objecttype, filter, Action ForWhichValue); 

  AREA   TRANSFORMERTAPS   

  ZONE   SHUNTS   

      OFFAVR   

  

PVCreate("name", [elementSource], [elementSink]); 

Call the function to create a PV study with "name" as identifier. You may optionally specify 
the source and sink elements for the study transaction. 

"name":  String that identifies the PV study to be created. 

[element source]:  The source of power for the PV study. There is only one possible 
setting:  

[INJECTIONGROUP "name"] or [INJECTIONGROUP "label"] 

[element sink]:  The sink of power for the PV study. There is only one possible setting, 
which is the same as for the source. 
  

PVSetSourceAndSink("name", [elementSource], [elementSink]); 

Call the function to specify the source and sink elements to perform the PV study called 
"name". 

"name":  String that identifies the PV study for which the source and sink elements are 
to be assigned to. 
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[element source]:  The source of power for the PV study. There is only one possible 
setting:  

[INJECTIONGROUP "name"] or [INJECTIONGROUP "label"] 

[element sink]:  The sink of power for the PV study. There is only one possible setting, 
which is the same as for the source. 
  

PVRun("name"); 

Call the function to start the PV study called "name". 

"name":  String that identifies the PV study. 
  

PVClearResults("name"); 

Call the function to clear all the results of the PV study called "name". 

"name":  String that identifies the PV study. 
  

PVStartOver("name"); 

Call the function to start over the PV study called "name". This includes clear the activity log, 
clear results, restore the initial state, set the current state as initial state, and initialize the 
step size. 

"name":  String that identifies the PV study. 
  

PVDestroy("name"); 

Call the function to destroy the PV study called "name". 

"name":  String that identifies the PV study. 
  

PVWriteResultsAndOptions("filename"); 

Call this action to save all the PV results and options in the auxiliary file "filename". 

  

RefineModel(objecttype, filter, Action, Tolerance); 

Call this function to refine the system model to fix modeling idiosyncrasies that cause 
premature loss of convergence during PV and QV studies. 

objecttype:  The objecttype being selected. 

AREA 

ZONE 

filter:  There are three options for the filter:  

RefineModel(…, "", …);: No filter specified means to select all objects of this type.  

RefineModel(…, "filtername", …);: "filtername" means select those that meet the 
filter. 

Action:  The way the model will be refined. Choices are:  

TRANSFORMERTAPS Fix all transformer taps at their present values if their Vmax –
 Vmin is less than or equal to the user specified tolerance. 

SHUNTS Fix all shunts at their present values if their Vmax – Vmin is less than or 
equal to the user specified tolerance. 
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OFFAVR Remove units from AVR control, thus locking their MVAR output at its 
present value if their Qmax – Qmin is less or equal to the user specified tolerance. 

Tolerance:  Tolerance value. 
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Script QV Submode Actions 

  

The following actions are specific to the Run Mode Submode QV:  
  

QVRun ("filename", InErrorMakeBaseSolvable); 

    YES or NO 

NOTE: The QV study is always performed on selected 
buses. 

 

QVWriteResultsAndOptions ("filename"); 

 

RefineModel (objecttype, filter, Action ForWhichValue); 

  AREA   TRANSFORMERTAPS   

  ZONE   SHUNTS   

      OFFAVR   

  

QVRun("filename", InErrorMakeBaseSolvable); 

Call the function to start a QV study for the list of buses whose SELECTED? field is set to 
YES. 

"filename":  This specifies the file to which to save a comma-delimited version of the 
results.  

InErrorMakeBaseSolvable:  This specifies whether to perform a solvability analysis of 
the base case if the pre-contingency base case can not be solved. If not specified, then 
YES is assumed. 
  

QVWriteResultsAndOptions("filename"); 

Call this action to save all the QV results and options in the auxiliary file "filename". 

  

RefineModel(objecttype, filter, Action, Tolerance); 

Call this function to refine the system model to fix modeling idiosyncrasies that cause 
premature loss of convergence during PV and QV studies. 

objecttype:  The objecttype being selected. 

AREA 

ZONE 

filter:  There are three options for the filter:  

RefineModel(…, "", …);:  No filter specified means to select all objects of this type.  

RefineModel(…, "filtername", …);:   "filtername" means select those that meet 
the filter. 

Action:  The way the model will be refined. Choices are:  
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TRANSFORMERTAPS Fix all transformer taps at their present values if their Vmax –
 Vmin is less than or equal to the user specified tolerance. 

SHUNTS Fix all shunts at their present values if their Vmax – Vmin is less than or 
equal to the user specified tolerance. 

OFFAVR Remove units from AVR control, thus locking their MVAR output at its 
present value if their Qmax – Qmin is less or equal to the user specified tolerance. 

Tolerance:  Tolerance value. 
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Data Section 

  

The Data Section of the script file format can contain numerous functions for modifying the 
data of a power system case. The DATA section begins with a left curly brace and ends with a 
right curly brace. 
  

DATA DataName (object_type, [list_of_fields], file_type_specifier) 

{ 

data_list_1 

 .  
 .  
 .  

data_list_n 

} 

Immediately following the DATA keyword, you may optionally include a DataName. By 
including the DataName, you can make use of the script command LoadData("filename", 
DataName) to call this particular data section from another auxiliary file. 

The first line of the DATA section is referred to as the Data Argument List. The Data Argument 
List defines the type and format of the data contained in the following section enclosed in 
curly braces. 

Inside of each DATA section, data lists are given according to the data definition given in the 
Data Argument List. 
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Data Argument List 

  

The DATA argument list identifies what the information section contains. A left and right 
parenthesis "( )" mark the beginning and end of the argument list.  

The file_type_specifier parameter distinguishes the information section as containing 
custom auxiliary data (as opposed to Simulator’s native auxiliary formats), and indicates the 
format of the data. Currently, the parser recognizes two values for file_type_specifier:  

(blank) or AUXDEF  Data fields are space delimited 
CSV, AUXCSV, or CSVAUX  Data fields are comma delimited 

  

The object_type parameter identifies the type of object or data element the information 
section describes or models. For example, if object_type equals BUS, then the data describes 
BUS objects. Below is a list of many of the object types recognized by Simulator:  

3WXFormer DefDrawSuperArea OPF_Options_and_Results 

Area DefDrawZone OPFSolutionSummary 

ATC_Options Direction Owner 

ATCExtraMonitor DynamicFormatting PieSizeColorOptions 

ATCGeneratorChange Equiv_Options PostPowerFlowActions 

ATCInterfaceChange ExportBidCurve PTDF_Options 

ATCLineChange Filter PVCurve_Options 

ATCLineChangeB GEMotor PWCaseInformation 

ATCScenario Gen PWFormOptions 

ATCZoneChange GeoDataViewStyle PWLPOPFCTGViol 

AuxFileExportFormatData GlobalContingencyActions PWLPTabRow 

AuxFileExportFormatDisplay GScenarioName PWOPFTimePoint 

BGCalculatedField HintDefVAlues PWPVResultListContainer 

Branch IG_AutoInsert_Options QVCurve 

Bus ImportBidCurve QVCurve_Options 

BusGroupSwapRec ImportExportBidCurve RLScenarioName 

BusNumberSwap InjectionGroup Scale_Options 

BusViewFormOptions Interface Schedule 

CaseInfo_Options InterfaceAElement ScreenLayer 

ColorMap InterfaceBElement SelectByCriteriaSet 

Contingency IScenarioName ShapefileExportDescription 

Ctg_AutoInsert_Options Limit_Monitoring_Options ShortCut 

Ctg_Options LimitCost Shunt 

CTGElementBlock LimitSet Sim_Environment_Options 

CustomCaseInfo Load Sim_Misc_Options 

CustomCaseInfoRow LODF_Options SimSimulation_Options 

CustomColors LPOPFMarginalControls Sim_Solution_Options 

CustomExpression LPVariable StudyMWTransactions 
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DataGrid MessLog_Options Substation 

DCTransmissionLine ModelCondition SuperArea 

DefDrawArea ModelExpression TLR_Options 

DefDrawBackground ModelFilter TransferLimiter 

DefDrawBus MTDCRecord Transformer 

DefDrawGen MultiSectionLine TSSchedule 

DefDrawInterface MvarMarginalCostValues UC_Options 

DefDrawLineTransformer MWMarginalCostValues ViolationCTG 

DefDrawLoad MWTransaction WhatOccurredDuringContingency 

DefDrawShunt Nomogram XFCorrection 

DefDrawSubstation NomogramInterface Zone 

  

The list of object types Simulator’s auxiliary file parser can recognize will grow as new 
applications for the technology are found. Within Simulator, you will always be able to obtain a 
list of the available object_types by going to the Auxiliary Files ribbon group on the 
Window ribbon tab and choosing Export Object Fields.  

The list_of_fields parameter lists the types of values the ensuing records in the data section 
contain. The order in which the fields are listed in list_of_fields dictates the order in which 
the fields will be read from the file. Simulator currently recognizes over 2,000 different field 
types, each identified by a specific field name. Because the available fields for an object may 
grow as new applications are developed, you will always be able to obtain a list of the 
available object_types by going to the Auxiliary Files ribbon group on the Window ribbon 
tab and choosing Export Object Fields. Certainly, only a subset of these fields would be 
found in a typical custom auxiliary file. In crafting applications to export custom auxiliary files, 
developers need concern themselves only the fields they need to communicate between their 
applications and Simulator. A few points of interest regarding the list_of_fields are:  
• The list_of_fields may take up several lines of the text file.  
• The list_of_fields should be encompased by braces [ ]. 
• When encountering the PowerWorld comment string ‘//’ in one of these lines of the text 

file, all text to the right of this is ignored.  
• Blank lines, or lines whose first characters are ‘//’ will be ignored as comments. 
• Field names must be separated by commas. 

Example DATA Argument List 

DATA (BUS, [BusNomKV, Bus, // comment here 

 ABCPhaseAngle: 1, ABCPhaseAngle: 2, ABCPhaseV, ABCPhaseV: 1,  

 // comments allowed here to  
  
 // note that blank rows are ignored  
 AreaNum, BusAngle, BusB, BusCat, BusEquiv, BusG,   
 BusGenericSensV, BusKVVolt, BusLambda, BusLoadMVA, // more comment  
 BusLoadMW, BusLongName])  

One general note regarding the field names however. Some field names may be augmented 
with a field location. One example of this is the field LineMW. For a branch, there are two MW 
flows associated with the line: one MW flow at the from bus, and one MW flow at the to bus. 
So that the number of fields does not become huge, the same field name is used for both of 
these values. For the from bus flow, we write LineMW: 0, and for the to bus flow, we write 
LineMW: 1. Note that fieldnames such as LineMW: 0 may simply leave off the: 0. 
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Data Key Fields 

  

Simulator uses certain fields to identify the specific object being described. These fields are 
called key fields. For example, the key field for BUS objects is BusNum, because a bus can be 
identified uniquely by its number. The key fields for GEN objects are BusNum and GenID. To 
properly identify each object, the object’s key fields must be present. They can appear in any 
order in the list_of_fields (i.e. they need not be the first fields listed in list_of_fields). As 
long as the key fields are present, Simulator can identify the specific object. By going to the 
Auxiliary Files ribbon group on the Window ribbon tab and choosing Export Case Object 
Fields you will obtain a list of fields available for each object type. In this output, the key 
fields will appear with asterisks *. 
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Data List 

  

After the data argument list is completed, the Data list is given. The data section lists the 
values of the fields for each object in the order specified in list_of_fields. The data section 
begins with a left curly brace and ends with a right curly brace. A few points of interest 
regarding the value_list:  
• The value_list may take up several lines of the text file.  
• Each new data object must start on its own line of text. 
• When encountering the PowerWorld comment string ‘//’ in one of these lines of the text 

file, all text to the right of this is ignored.  
• Blank lines, or lines whose first characters are ‘//’ will be ignored as comments. 
• Remember that the right curly brace must appear on its own line at the end of the 

data_list. 
• If the file_type_specifier is CSV, the values should be separated by commas. Otherwise, 

separate the field names using spaces. 
• Strings can be enclosed in double quotes, but this is not required. You should however 

always enclose strings that contain spaces (or commas) in quotes. Otherwise, strings 
containing commas would cause errors for comma-delimited files, and spaces would cause 
errors for space-delimited formatted files. 
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Data SubData Sections 

  

The format described in the Data Section works well for most kinds of data in Simulator. It 
does not work as well however for data that stores a list of objects. For example, a 
contingency stores some information about itself (such as its name), and then a list of 
contingency elements, and possible a list of limit violations as well. For data such as this, 
Simulator allows <SubData>, </SubData> tags that store lists of information about a 
particular object. This formatting looks like the following:  

  

DATA (object_type, [list_of_fields], file_type_specifier) 

{ 

value_list_1 

 <SUBDATA subobject_type1> 

 precise format describing an object_type1  
 precise format describing an object_type1  
 .  
 .  
 .  

 </SUBDATA> 

<SUBDATA subobject_type2> 

 precise format describing an object_type2  
 precise format describing an object_type2  
 .  
 .  
 .  

 </SUBDATA> 

value_list_2 

 .  
 .  
 .  

value_list_n 

} 

Note that the information contained inside the <SubData>, </SubData> tags may not be 
flexibly defined. It must be written in a precisely defined order that will be documented for 
each SubData type.  
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Data ATC_Options 

  

RLScenarioName 

GScenarioName 

IScenarioName 

These three sections contain the pretty names of the RL Scenarios, G Scenarios, and I 
Scenarios. Each line consists of two values: Scenario Number and a name string enclosed in 
quotes. 

Scenario Number: The scenarios are number 0 through the number of scenarios minus 
1. 

Scenario Name: These represent the names of the various scenarios. 
  

Example: 

<SUBDATA RLScenarioName> 

//Index Name 
 0 "Scenario Name 0"  
 1 "Scenario Name 1"  

</SUBDATA> 
  

ATCMemo 

This section contains the memo text for the ATC analysis. 

  

Example: 

<SUBDATA ATCMemo> 

//Memo 

"Comments for the ATC analysis" 

</SUBDATA> 
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Data ATCExtraMonitor 

  

ATCFlowValue 

This subdata section contains a list of a flow values for specified transfer levels. Each line 
consists of two values: Flow Value (flow on the monitored element) and a Transfer Level (in 
MW).  

Flow Value: Contains a string describing which monitor this belongs to. 

Transfer Level: Contains the value for this extra monitor at the last linear iteration. 
  

Example: 

<SUBDATA ATCFlowValue> 

//MWFlow TransferLevel 
 94.05 55.30  
 105.18 80.58  
 109.02 107.76  

</SUBDATA> 
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Data ATCScenario 

  

TransferLimiter 

This subdata section contains a list of the TransferLimiters for this scenario. Each line 
contains fields relating one of the Transferlimiters. The fields are writen out in the following 
order:  

  

Limiting Element:  Contains a description of the limiting element. The possible values 
are 

   "PowerFlow Divergence" 

   "AREA num" 

   "SUPERAREA name" 

   "ZONE num" 

   "BRANCH num1 num2 ckt" 

   "INJECTIONGROUP name" 

   "INTERFACE name" 

Limiting Contingency:  The name of the limiting contingency. If blank, then this 
means it’s a limitation in the base case. 

MaxFlow:  The transfer limitation in MW. 

PTDF:  The PTDF on the limiting element in the base case (not in percent). 

OTDF:  The OTDF on the limiting element under the limiting contingency. 

LimitUsed:  The limit which was used to determine the MaxFlow in per unit. 

PreTransEst:  The estimated flow on the line after the contingency but before the 
transfer in per unit. 

MaxFlowAtLastIteration:  The total transfer at the last iteration in per unit. 

IterativelyFound:  Either YES or NO depending on whether it was iteratively 
determined. 

  

Example: 

<SUBDATA TransferLimiter > 
 "BRANCH 40767 42103 1" "Contin" 2.84 -0.0771 -0.3883 -4.35 -4.35 -0.01 "-55.88" 
YES  
 "BRANCH 42100 42321 1" "Contin" 4.42 0.1078 0.5466 6.50 5.64 1.57 " 22.59" NO   
 "BRANCH 42168 42174 1" "Contin" 7.45 -0.0131 -0.0651 -1.39 -1.09 4.60 "-33.31" NO   
 "BRANCH 42168 42170 1" "Contin" 8.54 0.0131 0.0651 1.39 1.02 5.69 " 26.10" NO   
 "BRANCH 41004 49963 1" "Contin" 9.17 -0.0500 -0.1940 -4.39 -3.16 6.32 " 68.73" NO   
 "BRANCH 46403 49963 1" "Contin" 9.53 0.0500 0.1940 4.46 3.16 6.68 "-68.68" NO   
 "BRANCH 42163 42170 1" "Contin" 10.14 -0.0131 -0.0651 -1.39 -0.92 7.29 "-15.58" NO 
  

</SUBDATA> 
  

ATCExtraMonitor 

This subdata section contains a list of the ATCExtraMonitors for this scenario. Each line 
contains three fields relating one of the ATCExtraMonitors. The first field describes the 
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ATCExtraMonitor which this subdata corresponds to. The second and third variables are the 
initial value and sensitivity for this extra monitor for the scenario. An option fourth field may 
be included if we are using one of the iterated ATC solution options. This field must be the 
String "ATCFlowValue". 

Monitor Description:  Contains a string describing which monitor this belongs to. 

Initial Value:  Contains the value for this extra monitor at the last linear iteration. 

Sensitivity:  Contains the sensitivity of this monitor. 

ATCFlowValue:  A string which signifies that a block will follow which stores a list of 
flow values for specified transfer levels. Each line of the block consists of two values: 
Flow Value (flow on the monitored element) and a Transfer Level (in MW). The block is 
terminated when a line of text that starts with ‘END’ is encountered. 

  

Example: 

<SUBDATA ATCExtraMonitor> 
 "Interface<KEY1>Left-Right</KEY1>" 40.0735 0.633295  
 "Branch<KEY1>2</KEY1><KEY2>5</KEY2><KEY3>1</KEY3>" 78.7410 0.266589   

</SUBDATA> 
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Data AuxFileExportFormatData 

  

 DataBlockDescription 

This subdata section is used to define the objects that should be included in an auxiliary file 
along with their fields, subdata sections, and any filter used to specify which objects should 
be included. Each line contains the following: 

ObjectType: Name of the object to include in the auxiliary file. 

[FieldList]: List of fields to include. Must be enclosed in brackets. This list can either be 
space-delimited or comma-delimited. 

[SubdataList]: List of subdata sections to include. This list must be enclosed in 
brackets and can be either space-delimited or comma-delimited. Include empty brackets 
to not include subdata or for objects that do not have any subdata sections.  

"Filter": Description of the filter to use for determining which objects to include. This 
must be enclosed in double quotes. If no filter is to be used, empty double quotes should 
be included. Valid entries are: "", "filtername", "AREAZONE", and "SELECTED". 

  

Example: 

<SUBDATA DataBlockDescription> 

// ObjectType [FieldList] [SubdataList] "Filter" 

Area [AreaName, AreaNum] [] "SELECTED" 

Gen [BusNum, BusName, GenID] [BidCurve, ReactiveCapability] "" 

</SUBDATA> 
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Data AuxFileExportFormatDisplay 

  

DataBlockDescription 

This subdata section is used to define the objects that should be included in an auxiliary file 
along with their fields, subdata sections, and any filter used to specify which objects should 
be included. Each line contains the following: 

ObjectType: Name of the object to include in the auxiliary file. 

[FieldList]: List of fields to include. Must be enclosed in brackets. This list can either be 
space-delimited or comma-delimited. 

[SubdataList]: List of subdata sections to include. This list must be enclosed in 
brackets and can be either space-delimited or comma-delimited. Include empty brackets 
to not include subdata or for objects that do not have any subdata sections.  

"Filter": Description of the filter to use for determining which objects to include. This 
must be enclosed in double quotes. If no filter is to be used, empty double quotes should 
be included. Valid entries are: "", "filtername", "AREAZONE", and "SELECTED". 

  

Example: 

<SUBDATA DataBlockDescription> 

// ObjectType [FieldList] [SubdataList] "Filter" 

DisplayArea [AreaName, AreaNum, SOAuxiliaryID] [] "" 

DisplayTransmissionLine [BusNum, BusNum:1, LineCircuit, SOAuxiliaryID] [Line] 
"Nominal Voltage > 138 kV" 

</SUBDATA> 
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Data BGCalculatedField 

  

Condition 

Bus Group Calculated Fields are used for creating a calculation that operates on the buses in 
a area, zone, or substation. Part of the definition is a filter which specifies which buses to 
operate over. This subdata section is identical to the Condition subdata section of the Filter 
object type. 
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Data Bus 

  

MWMarginalCostValues 

MvarMarginalCostValues 

LPOPFMarginalControls 

These three sections contain specific values computed for an OPF solution. In 
MWMarginalCostValues or MvarMarginalCostValues these specific values are the MW or Mvar 
marginal prices for each constraint. In LPOPFMarginalControls the values are the sensitivities 
of the controls with respect to the cost of each bus. 

  

Example: 

<SUBDATA MWMarginalCostValues> 
 //Value  
 16.53  
 0.00  
 21.80  

</SUBDATA> 
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Data BusViewFormOptions 

  

BusViewBusField 

BusViewFarBusField 

BusViewGenField 

BusViewLineField 

BusViewLoadField 

BusViewShuntField 

The values represent specific fields on the custom defined bus view onelines. Each line 
contains two values: 

  

Location : The various locations on the customized bus view contain slots for fields. 
This is the slot number. 

FieldDescription : This is a string enclosed in double quotes. The string itself is 
delimited by the @ character. The string contains five 
values: 

Name of Field: The name of the field. Special fields 
that appear on dialog by default have 
special names. Otherwise these are 
the same as the fieldnames of the AUX 
file format (for the "other fields" 
feature on the dialogs). 

Total Digit:  Number of total digits for a numeric field. 

Decimal Points:  Number of decimal points for a 
numeric field. 

Color:  This is the color of the field. It is not presently 
used. 

Increment Value:  This is the "delta per mouse" click 
for the field. 

  

Example: 

<SUBDATA BusViewLineField> 
 0 "MW Flow@6@1@0@0"  

 1 "MVar Flow@6@1@0@0" 
 2 "MVA Flow@6@1@0@0"  
 3 "BusAngle:1@6@2@0@0"  

</SUBDATA> 
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Data ColorMap 

  

ColorPoint 

A colorpoint is simply described by a real number (between 0 and 100) and an integer 
describing the color written on a single line of text 

cmvalue cmcolor (Example:  100 56648) 
cmvalue:  Real number between 0 and 100 (minimum to maximum value). 

cmcolor:  Integer between 0 and 16,777,216. Value is determined by taking the red, 
green and blue components of the color and assigning 
them a value between 0 and 255. The color is then equal 
to red + 256*green + 256*256*blue. 

  

Example: 

<SUBDATA ColorPoint> 
 // Value Color  
 100.0000 127  
 87.5000 255  
 62.5000 65535  
 50.0000 8388479  
 37.5000 16776960  
 12.5000 16711680  
 0.0000 8323072  

</SUBDATA> 
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Data Contingency 

  

CTGElement 

A contingency element is described by up to four entries. All entries must be on a single line 
of text. 

  

"Action" "ModelCriteria" Status //comment  

Action:  String describing the action associated with this element. See below for actions 
available. 

ModelCriteria:  This is the name of a ModelFilter or ModelCondition under which this 
action should be performed. This entry is optional. If it is not specified, then a blank (or 
no criteria) is assumed. If you want to enter a Status, then use must specify "" as the 
ModelCriteria. 

Status:  Three options  
 CHECK: perform action if ModelCriteria is true. 
 ALWAYS: perform action regardless of ModelCriteria. 
 NEVER: do not perform action. 
This entry is optional. If it is not specified, then CHECK is assumed. 

Comment:  All text to the right of the comment symbol (//) will be saved with the 
CTGElement as a comment. 

  

Possible Actions:  

Calling of a name ContingencyBlock 

CONTINGENCYBLOCK | name 

Calls a ContingencyBlock and executes each of the actions in that block. 

Transmission Line or Transformer outage or insertion 

BRANCH | bus1# bus2# ckt | OPEN 

    | CLOSE 

Takes branch out of service, or puts it in service. Note: bus# values may be 
replaced by a string enclosed in single quotes where the string is the name of 
the bus followed by an underscore character and then the nominal voltage of the 
bus. These values may also be replaced by a string enclosed in single quotes 
which represents the label of the bus. Also, the entire sequence [bus1# bus2# 
ckt] may be replaced by the label of the branch. 

Series Capacitor Bypass or In Service 

SERIESCAP | bus1# bus2# ckt | BYPASS 

     | INSERVICE 

Bypasses a series capacitor, or puts it in service. Note: bus# values may be replaced 
by a string enclosed in single quotes where the string is the name of the bus 
followed by an underscore character and then the nominal voltage of the bus. These 
values may also be replaced by a string enclosed in single quotes which represents 
the label of the bus. Also, the entire sequence [bus1# bus2# ckt] may be replaced 
by the label of the branch. 

DC Transmission Line outage or insertion  
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DCLine | bus1# bus2# ckt | OPEN 

     | CLOSE 

Takes DC Line out of service, or puts it in service. Note: bus# values may be 
replaced by a string enclosed in single quotes where the string is the name of the 
bus followed by an underscore character and then the nominal voltage of the bus. 
These values may also be replaced by a string enclosed in single quotes which 
represents the label of the bus. Also, the entire sequence [bus1# bus2# ckt] may 
be replaced by the label of the dc transmission line. 

DC Line set a specific value  

DCLINE | bus1# bus2# ckt | SET_P_TO | value | MW 

| | CHANGE_P_BY | | PERCENT 

| | SET_I_TO | | AMPS 

| | CHANGE_I_BY 

Use to set the DC line setpoint to a particular value. Note: bus# values may be 
replaced by a string enclosed in single quotes where the string is the name of 
the bus followed by an underscore character and then the nominal voltage of the 
bus. These values may also be replaced by a string enclosed in single quotes 
which represents the label of the bus. Also, the entire sequence [bus1# bus2# 
ckt] may be replaced by the label of the dc transmission line.  

Phase Shifter set a specific value  

PHASESHIFTER | bus1# bus2# ckt | SET_P_TO | value | MW 

| | CHANGE_P_BY | | PERCENT 

Use to set the phase shift angle to a particular value. Note: bus# values may be 
replaced by a string enclosed in single quotes where the string is the name of 
the bus followed by an underscore character and then the nominal voltage of the 
bus. These values may also be replaced by a string enclosed in single quotes 
which represents the label of the bus. Also, the entire sequence [bus1# bus2# 
ckt] may be replaced by the label of the branch.  

3-Winding Transformer outage or insertion   

3WXFORMER | bus1# bus2# bus3# ckt | OPEN 

| CLOSE 

Takes all three windings of a 3-winding transformer out of service, or puts them 
in service. Note: bus# values may be replaced by a string enclosed in single 
quotes where the string is the name of the bus followed by an underscore 
character and then the nominal voltage of the bus. These values may also be 
replaced by a string enclosed in single quotes which represents the label of the 
bus. Also, the entire sequence [bus1# bus2# bus3# ckt] may be replaced by the 
label of the three winding transformer.  

Interface outage or insertion 

INTERFACE | name | OPEN 

   | CLOSE 

Takes all monitored branches in the interface out of service, or puts them all in 
service. Note: the [name] may be replaced by the label of the interface. 

Bus outage causes all lines connected to the bus to be outage 

BUS | bus# | OPEN 
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Takes all branches connected to the bus out of service. Also outages all 
generation, load, or shunts attached to the bus. Note: bus# values may replaced 
by a string enclosed in single quotes where the string is the name of the bus 
followed by an underscore character and then the nominal voltage of the bus. 
These values may also be replaced by a string enclosed in single quotes which 
represents the label of the bus. 

Generator, Load, or Switched Shunt outage or insertion 

GEN | bus# id | OPEN 

LOAD | bus# id | CLOSE 

SHUNT | bus# 

INJECTIONGROUP | name 

Takes a generator, load, or shunt out of service, or puts it in service. If 
specifying an injection group, the status of all devices in the injection group will 
be changed. Note: bus# values may be replaced by a string enclosed in single 
quotes where the string is the name of the bus followed by an underscore 
character and then the nominal voltage of the bus. These values may also be 
replaced by a string enclosed in single quotes which represents the label of the 
bus. Also, the sequence [bus1# ckt] or [name] may be replaced by the label of 
the device. 

Generator, Load or Switched Shunt movement to another bus 

GEN | bus1# | MOVE_PQ_TO | bus2# | value | MW 

LOAD | | MOVE_P_TO |   | MVAR 

SHUNT | | MOVE_Q_TO | PERCENT 

Use to move generation, load or shunt at a bus1 over to bus2. Note: bus# 
values may be replaced by a string enclosed in single quotes where the string is 
the name of the bus followed by an underscore character and then the nominal 
voltage of the bus. These values may also be replaced by a string enclosed in 
single quotes which represents the label of the bus. 

Generator, Load or Switched Shunt set or change a specific value 

GEN | bus#  | SET_P_TO | value | MW 

LOAD | | SET_Q_TO | | MVAR 

SHUNT | | SET_PQ_TO | PERCENT 

   | SET_VOLT_TO | 

   | CHANGE_P_BY  | 

   | CHANGE_Q_BY  | 

   | CHANGE_PQ_BY  | 

   | CHANGE_VOLT_BY  | 

Use to set the generation, load, or shunt at a bus to a particular value. Also can 
use to change by a specified amount. The voltage setpoints only apply to 
SHUNTs and GENs. Note: bus# values may be replaced by a string enclosed in 
single quotes where the string is the name of the bus followed by an underscore 
character and then the nominal voltage of the bus. These values may also be 
replaced by a string enclosed in single quotes which represents the label of the 
bus. 

Injection Group set a specific value 
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INJECTIONGROUP | name | SET_P_TO | value | MW 

       | PERCENT 

Use to set the MW generation/load in an injection group to a particular value. 

Injection Group change specific value 

INJECTIONGROUP | name | CHANGE_P_TO | value | MW 

       | PERCENT 

       | MWMERITORDER 

       | PERCENTMERITORDER 

Use to change the MW generation/load in an injection group by a particular 
value. Note that MW and PERCENT OPTIONS will change each point in the 
injection group by a value in proportion to the participations factors of the 
group. MWMERITORDER and PERCENTMERITORDER will modify points in the 
injection group by closing or opening points in the group in order of descending 
participation factors until the total change greater than or equal to the requested 
change has been achieved. Note: the [name] may be replaced by the label of 
the injection group. 

Execute a Power Flow Solution  

SOLVEPOWERFLOW 

Include this action to cause the solution of the contingency to be split into 
pieces. Actions that are listed before each SOLVEPOWERFLOW call will be 
performed as a group. 

Make-Up Power Compensation. 

Only valid immediately following a SET, CHANGE, OPEN or CLOSE action on a 
Generator, Shunt or Load. This describes how the change in MW or MVAR are 
picked up by buses throughout the system. The values specify participation 
factors  

COMPENSATION 

bus#1 value1 

bus#2 value2 

... 

END 

Example:  

<SUBDATA CTGElement> 

 // just some comments   
 // action   Model 

Criteria  
Status  comment 

 "BRANCH 40821 
40869 1 OPEN"  

"" ALWAYS  //Raver - Paul 
500 kV 

 "GEN 45041 1 OPEN"  "" ALWAYS  //Trip Unit #2 
 "BRANCH 42702 
42727 1 OPEN"  

"Line X 
Limited"  

CHECK  //Open Fern Hill 

 "GEN 40221 1 OPEN"  "Interface 
L1"  

CHECK  //Drop ~600 
MW 

 "GEN 40227 1 OPEN"  "Interface CHECK  //Drop ~1200 
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L2"  MW  
 "GEN 40221 1 OPEN"  "Interface 

L3"  
CHECK  //Drop ~600 

MW  
 "GEN 40227 1 OPEN"  "Interface 

L3+"  
CHECK  //Drop ~1200 

MW 

</SUBDATA> 

Note: ContingencyElement object types can also be created inside their own DATA section 
as well. One of the key fields of the object is then the name of the contingency to which the 
ContingencyElement belongs. 

LimitViol 

A LimitViol is used to describe the results of a contingency analysis run. Each Limit Violation 
lists eight values:  

ViolType ViolElement Limit ViolValue PTDF PTDF InitialValue Reason 

ViolType:  One of five values describing the type of violation  
BAMP: branch amp limit violation. 
BMVA: branch MVA limit violation. 
VLOW: bus low voltage limit violation. 
VHIGH: bus high voltage limit violation. 
INTER: interface MW limit violation. 

ViolElement:  This field depends on the ViolType.  
for VLOW, VHIGH: "bus1#" or "busname_buskv" or "buslabel" 
for INTER: "interfacename" or "interfacelabel" 

for BAMP, BMVA: "bus1# bus2# ckt violationbus# MWFlowDirection" 

violationbus# is the bus number for the end of the branch which is violated 

MWFlowDirection is the direction of the MW flow on the line. Potential values are 
"FROMTO" or "TOFROM" 

Note: each bus# may be replaced with the name underscore nominal kV string 
enclosed in single quotes, or bus# values may be replaced by a string enclosed in 
single quotes representing the label of the bus. Also, the entire sequence [bus1# 
bus2# ckt] may be replaced by the label of the branch. 

Limit:  This is the numerical limit which was violated. 

ViolValue:  This is the numerical value of the violation. 

PTDF:  This field is optional. It only makes sense for interface or branch violations. It 
stores a sensitivity of the flow on the violating element during in the base case with 
respect to a transfer direction This must be calculated using the Contingency Analysis 
Other Actions related to Sensitivities. 

OTDF:  This field is optional. It only makes sense for interface or branch violations. It 
stores a sensitivity of the flow on the violating element during this contingency with 
respect to a transfer direction. This must be calculated using the Contingency Analysis 
Other Actions related to Sensitivities. 

InitialValue: This stores a number. This stores the base case value for the element 
which is being violated. This is used to compare against when looking at change 
violations. 

Reason: This will say whether this was a pure violation or is being reported as a 
violation because the change from the base case is higher than a specified threshold. 

LIMIT - means this is a violation of a line/interface/bus limit 
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CHANGE - means this is being reported as a limit because the change from the initial 
value is higher than allowed 

  

Example:  

<SUBDATA LimitViol> 
 BAMP "1 3 1 1 FROMTO" 271.94031 398.48096 10.0 15.01 // Note OTDF/PTDF  
 INTER "Right-Top" 45.00000 85.84451 // Note OTDF/PTDF not included  

</SUBDATA> 

Note: ViolationCTG object types can also be directly created inside their own DATA section 
as well. One of the key fields of the object is then the name of the contingency to which the 
ViolationCTG belongs. 

Sim_Solution_Options 

These describe the power flow solution options which should be used under this particular 
contingency. The format of the subdata section is two lines of text. The first line is a list of 
the fieldtypes for Sim_Solution_Options which should be changed. The second line is a list of 
the values. Note that in general, power flow solution options are stored at three different 
locations in contingency analysis. When implementing a contingency, Simulator gives 
precendence to these three locations in the following order:  

1. Contingency Record Options (stored with the particular contingency) 
2. Contingency Tool Options (stored with CTG_Options) 
3. The global solution options 

WhatOccurredDuringContingency 

Each line of this subdata section is part of a text description of what actually ended up being 
implemented for this contingency. This will list which actions were executed and which 
actions ended up being skipped because of their model criteria. Each line of the subdata 
section must be enclosed in quotes. 
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Data CTG Options 

  

Sim_Solution_Options 

These describe the power flow solution options which should be used under this particular 
contingency. The format of the subdata section is two lines of text. The first line is a list of 
the fieldtypes for Sim_Solution_Options which should be changed. The second line is a list of 
the values. Note that in general, power flow solution options are stored at three different 
locations in contingency analysis. When implementing a contingency, Simulator gives 
precendence to these three locations in the following order:  

• Contingency Record Options (stored with the particular contingency) 
• Contingency Tool Options (stored with CTG_Options) 
• The global solution options 
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Data CTGElementBlock 

  

CTGElement 

This format is the same as for the Contingency objecttype, however, you can not call a 
ContingencyBlock from within a contingencyblock. 

  

CTGElementAppend 

When a subdata section is defined as CTGElementAppend rather than CTGElement, the 
actions of this subdata section will be appended to the contingency actions, instead of 
replacing them. This format is the same as for the Contingency objecttype, however, you 
can not call a ContingencyBlock from within a contingencyblock. 

Note: CTGElementBlockElement object types can also be directly created inside their own 
DATA section as well. One of the key fields of the object is then the name of the 
contingency block to which the CTGElementBlockElement belongs. 
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Data CustomCaseInfo 

  

ColumnInfo 

Each line of this SUBDATA section can be used for specifying the column width of particular 
columns of the respective Custom Case Information Sheet. The line contains two values – 
the column and then a column width. This is shown in the following example. 

  

Example: 

<SUBDATA ColumnInfo> 
 "SheetCol" 133  
 "SheetCol:1" 150  
 "SheetCol:2" 50  

</SUBDATA>  
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Data CustomColors 

  

CustomColors 

These describe the customized colors used in Simulator, which are specified by the user. A 
custom color is an integer describing a color. Each custom color is written on a single line of 
text and is an integer between 0 and 16,777,216. The value is determined by taking the red, 
green, and blue components of the color and assigning them a value between 0 and 255. 
The color is then equal to red + 256*green + 256*256*blue. Each line contains only one 
integer that corresponds to the color specified. 

  

Example: 

<SUBDATA CustomColors> 

 9823301 

 8613240 

</SUBDATA>  
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Data DataGrid 

  

ColumnInfo 

Contains a description of the columns which are shown in the respective data grid. Each line 
of text contains four fields: VariableName, ColumnWidth, TotalDigits, DecimalPoints 

Variablename:  Contains the variable which is shown in this column. 

ColumnWidth:  The column width. 

TotalDigits:  The total digits displayed for numerical values. 

DecimalPoints:  The decimal points shown for numerical values. 
  

Example: 

DATA (DataGrid, [DataGridName]) 

{ 
 BUS   
 <SUBDATA COLUMNINFO>  
 BusNomVolt 100 8 2  
 AreaNum 50 8 2  
 ZoneNum 50 8 2  
 </SUBDATA>  
  
 BRANCHRUN  
 <subdata COLUMNINFO >  

 BusNomVolt: 0 100 8 2 

 BusNomVolt: 1 100 8 2 

 LineMW: 0 100 9 3  
 </SUBDATA>  

} 

 



Auxiliary Script/Data Files 
 

1216 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Data DynamicFormatting 

  

DynamicFormattingContextObject 

This subdata section contains a list of the display object types which are chosen to be 
selected. Each line of the section consists of the following: 

DisplayObjectType: The object type of the display object. These are generally the 
same as the values seen in the subdata section 
SelectByCriteriaSetType of SelectByCriteriaSet object types. 
The only exception is the string CaseInfo, which is used for 
formatting applying to the case information displays. 

(WhichFields) : For display objects that can reference different fields, this sets which of 
those fields it should select (e.g. select only Bus Name 
Fields). The value may be either ALL or SPECIFIED. 

(ListOfFields) : If WhichFields is set to SPECIFIED, then a delimited list of fields follows. 

  

Example: 

<SUBDATA DynamicFormattingContextObject>  
 // Note: CaseInfo applies to case information displays  

 CaseInfo "SPECIFIED" BusName  

 DisplayAreaField "ALL" 
 DisplayBus  
 DisplayBusField "SPECIFIED" BusName BusPUVolt BusNum  
 DisplayCircuitBreaker  
 DisplaySubstation  
 DisplaySubstationField "SPECIFIED" SubName SubNum BusNomVolt BGLoadMVR  

 DisplayTransmissionLine 

 DisplayTransmissionLineField "ALL" 

</SUBDATA> 
  

LineThicknessLookupMap 

LineColorLookupMap 

FillColorLookupMap 

FontColorLookupMap 

FontSizeLookupMap 

BlinkColorLookupMap 

XoutColorLookupMap 

FlowColorLookupMap 

SecondaryFlowColorLookupMap 

The values of the lookup table for the characteristics that can be modified by the dynamic 
formatting tool. The first line contains the two following fields: 

fieldname: It is the field that the lookup table is going to look for. 

usediscrete: Set to YES or NO. If set to YES, the characteristic values will be discrete, 
meaning that the characteristic value will correspond exactly to the one specified in the 
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table. If set to NO, the characteristic values will be continuous, which means the 
characteristic value will be an interpolation of the high and low closest values specified in 
the table. 

  

The following lines contain two fields: 

fieldvalue: The value for the field. 

characteristicvalue: The corresponding characteristic value for such field value. 
  

Example: 

<SUBDATA LineColorLookupMap>  

 // FieldName UseDiscrete 
 BusPUVolt YES  
 // FieldValue Color  
 1.02 16711808  
 1.05 8454143  

 1.1 16744703 

</SUBDATA> 
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Data Filter 

  

Condition 

Conditions store the conditions of the filter. Each condition is described by one line of text 
which can contain up to five fields. 

Variablename condition "value" ("othervalue") (fieldopt) 

Variablename:  It is one of the fields for the object_type specified. It may optional be 
followed by a colon and a non-negative integer. If not specified, 0 is assumed. 

  Example: on a LINE, 0 = from bus, 1 = to bus 

   Thus: LineMW: 0 = the MW flow leaving the from bus 

   LineMW: 1 = the MW flow leaving the to bus 

Condition:  Possible Values Alternate1 Alternate2 Requirements 

 between ><   requires other value 

 notbetween ~><   requires other value 

 equal = == 

 notequal <> ~= 

 greaterthan > 

 lessthan < 

 greaterthanorequal >= 

 lessthanorequal <= 

 contains 

 notcontains 

 startswith 

 notstartswith 

 inrange 

 notinrange 

meets 

notmeets 

isblank 

notisblank 

value:  The value to compare to.  

 For fields associated with strings, this must be a string 

 For fields associated with real numbers, this must be a number. 

 For fields associated with integers, this is normally an integer, except when the 
Condition is "inrange" or "notinrange". In this case, value is 
a comma/dash separated number string. 

(othervalue):  If required, the other value to compare to. 

(FieldOpt):  Optional integer value with following meanings. 

 0 - strings are case insensitive, use number fields directly 

  (0 is the default value if not otherwise specified) 
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 1 - strings are case sensitive, take ABS of field values 
  

Example:  

DATA (FILTER, [objecttype, filtername, filterlogic, filterpre]) 

{ 

BUS "a bus filter" "AND" "no" 
 <SUBDATA CONDITION>  
 BusNomVolt > 100  
 AreaNum inrange "1-5 , 7 , 90-95"  
 ZoneNum between  
 </SUBDATA>  
  

BRANCH "a branch filter" "OR" "no" 
 <subdata CONDITION>  

 BusNomVolt: 0 > 100 // Note location 0 means from bus 

 BusNomVolt: 1 > 100 // Note location 1 means to bus 

 LineMW: 0 > 100 1 // Note, final field 1 denotes absolute value 
 </SUBDATA>  

} 
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Data Gen 

  

BidCurve 

BidCurve subdata is used to define a piece-wise linear cost curve (or a bid curve). Each bid 
point consists of two real numbers on a single line of text: a MW output and then the 
respective bid (or marginal cost). 

  

Example: 

<SUBDATA BidCurve> 
 // MW Price[$/MWhr]  
 100.00 10.6  
 200.00 12.4  
 400.00 15.7  
 500.00 16.0  

</SUBDATA> 
  

ReactiveCapability 

Reactive Capability subdata is used to the reactive capability curve of the generator. Each 
line of text consists of three real numbers: a MW output, and then the respective Minimum 
MVAR and Maximum MVAR output. 

  

Example: 

<SUBDATA ReactiveCapability> 
 // MW MinMVAR MaxMVAR  
 100.00 -60.00 60.00  
 200.00 -50.00 50.00  
 400.00 -30.00 20.00  
 500.00 -5.00 2.00  

</SUBDATA> 

Note: ReactiveCapability object types can also be directly created inside their own DATA 
section as well. Two of the key fields of the object are then the bus number and generator 
ID of the generator to which the ReactiveCapability point belongs. 
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Data GeoDataViewStyle 

  

TotalAreaValueMap 

This subdata section is used to define the lookup table for determining the total area size of 
geographic data view objects based on the value of a selected field. Two values are entered 
for each mapping: 

FieldValue: Value of the field selected for the Total Area attribute. 

TotalArea: The total area size of the object. 

  

Example: 

<SUBDATA TotalAreaValueMap> 

// FieldValue TotalArea 

1.000 0 

4.000 23 

7.000 46 

</SUBDATA> 

  

RotationRateValueMap 

This subdata section is used to define the lookup table for determining the rotation rate of 
geographic data view objects based on the value of a selected field. Two values are entered 
for each mapping: 

FieldValue: Value of the field selected for the Rotation Rate attribute. 

RotationRate: The rotation rate of the object. Entered in Hz. 

  

Example: 

<SUBDATA RotationRateValueMap> 

// FieldValue RotationRate 

1.000 0.00 

4.000 0.10 

7.000 0.20 

</SUBDATA> 

  

RotationAngleValueMap 

This subdata section is used to define the lookup table for determining the rotation angle of 
geographic data view objects based on the value of a selected field. Two values are entered 
for each mapping: 

FieldValue: Value of the field selected for the Rotation Angle attribute. 

RotationAngle: The rotation angle of the object. Entered in degrees. 

  

Example: 

<SUBDATA RotationAngleValueMap> 
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// FieldValue RotationAngle 

1.000 -90.0 

4.000 0.0 

7.000 90.0 

</SUBDATA> 

  

LineThicknessValueMap 

This subdata section is used to define the lookup table for determining the thickness of the 
border line around geographic data view objects based on the value of a selected field. Two 
values are entered for each mapping: 

FieldValue: Value of the field selected for the Line Thickness attribute. 

LineThickness: The line thickness of the border line around the object. This should be 
an integer value. 

  

Example: 

<SUBDATA LineThicknessValueMap> 

// FieldValue LineThickness 

1.000 1 

4.000 2 

7.000 3 

</SUBDATA> 
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Data GlobalContingencyActions 

  

CTGElementAppend 

This format is the same as for the Contingency objecttype 

CTGElement 

This format is the same as for the Contingency objecttype 

Note: GlobalContingencyActionsElement object types can also be directly created inside their 
own DATA section as well. 
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Data HintDefValues 

  

HintObject 

Stores the values for the custom hints. Each line has one value: 

FieldDescription: This is a string enclosed in double quotes. The string itself is 
delimited by the @ character. The string contains five values: 

Name of Field:  The name of the field. Special fields that appear on dialog by default 
have special names. Otherwise these are the same as the fieldnames of the AUX file 
format (for the "other fields" feature on the dialogs). 

Total Digit:  Number of total digits for a numeric field. 

Decimal Points:  Number of decimal points for a numeric field. 

Include Suffix:  Set to 0 for not including the suffix, and set to 1 to include it. 

Field Preffix:  The prefix text. 
  

Example: 

<SUBDATA HintObject> 
 "BusPUVolt@4@1@1@PU Volt ="  
 "BusAngle@4@1@1@Angle ="  

</SUBDATA> 
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Data InjectionGroup 

  

PartPoint 

A participation point is used to describe the contents of an injection group. Each 
participation point lists six values:  

PointType PointBusNum PointID PointParFac ParFacCalcType 
ParFacNotDynamic 

PointType:  One of two values describing the type of violation:  

GEN: a generator 

LOAD: a load 

INJECTIONGROUP: another injection group 

PointBusNum:  The bus number of the partpoint if the type is GEN or LOAD. Value will 
be blank for an injection group type. Note: bus# values may be replaced by a string 
enclosed in double quotes where the string is the name of the bus followed by an 
underscore character and then the nominal voltage of the bus. These values may also be 
replaced by a string enclosed in double quotes that represents the label of the bus or a 
string representing the label of the generator or load. 

PointID:   For a GEN or LOAD type, this is the id for the partpoint. For an 
INJECTIONGROUP type, this is the name or label of the injection group. 

PointParFac:  The participation factor for the point. 

ParFacCalcType:  How the participation point is calculated. There are several options 
depending on the PointType. 

 Generators:  SPECIFIED, MAX GEN INC, MAX GEN DEC, or MAX GEN MW 

 Loads:  SPECIFIED or LOAD MW 

Injection Groups: SPECIFIED 

ParFacNotDynamic:  Should the participation factor be recalculated dynamically as the 
system changes. 

  

Example: 

<SUBDATA PartPoint 
 "GEN" 1 "1" 1.00 "SPECIFIED" "NO"  
 "GEN" 2 "1" 5.00 "SPECIFIED" "NO"  
 "GEN" 4 "1" 104.96 "MAX GEN INC" "NO"  

 "GEN" 6 "1" 50.32 "MAX GEN DEC" "YES" 

 "GEN" 7 "1" 600.00 "MAX GEN MW" "NO" 
 "LOAD" 2 "1" 5.00 "SPECIFIED" "NO"  
 "LOAD" 5 "1" 130.00 "LOAD MW" "NO"  
 "LOAD" 6 "1" 200.00 "LOAD MW" "YES"  

</SUBDATA> 

Note: PartPoint object types can also be directly created inside their own DATA section as 
well. One of the key fields of the PartPoint object is then the name of the injection group to 
which the participation point belongs. 
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Data Interface 

  

InterfaceElement 

An interface’s subdata contains a list of the elements in the interface. Each line contains a 
text description of the interface element. Note that this text description must be 
encompassed by quotation marks. There are five kinds of elements allowed in an interface. 
Please note that the direction specified in the monitoring elements is important. 

"BRANCH num1 num2 ckt"  Monitor the MW flow on the branch starting from bus 
num1 going to bus num2 on the branch this branch. (order of bus numbers defines the 
direction) 

"AREA num1 num2" Monitor the sum of the AC tie line MW flows from area num1 to 
area num2. 

"ZONE num1 num2" Monitor the sum of the AC tie line MW flows from zone num1 to 
zone num2. 

"BRANCHOPEN num1 num2 ckt" When monitoring the elements in this interface, 
monitor them under the contingency of opening this branch. 

"BRANCHCLOSE num1 num2 ckt" When monitoring the elements in this interface, 
monitor them under the contingency of closing this branch. 

"DCLINE num1 num2 ckt" Monitor the flow on a DC line. 

"INJECTIONGROUP 'name'" Monitor the net injection from an injection group 
(generation contributes a positive injection, loads negative). 

"GEN num1 id" Monitor the net injection from a generator (output is positive injection). 

"LOAD num1 id" Monitor the net injection from a load (output is negative injection). 

"MSLINE num1 num2 ckt" Monitor the MW flow on the multi-section line starting 
from bus num1 going to bus num2 with circuit ckt. 

"INTERFACE 'name'" Monitor the MW flow on the interface given by name. 

  

Note: bus# values may be replaced by a string enclosed in single quotes where the string is 
the name of the bus followed by an underscore character and then the nominal voltage of 
the bus. Labels may also be used as follows: 

• bus# values for all element types may be replaced by a string enclosed in single 
quotes where the string is the label of the bus 

• for GEN or LOAD elements, the section num1 id may be replaced by the device's 
label 

• for MSLINE, DCLINE, or BRANCH elements, the num1 num2 ckt section may be 
replaced by the device's label 

For the interface element type "BRANCH num1 num2 ckt" and "DCLINE num1 num2 ckt", an 
optional field can also be written specifying whether the flow should be measured at the far 
end. This field is either YES or NO. 

  

Example: 

<SUBDATA InterfaceElement 
 "BRANCH 8 9 1" NO // monitor the flow from bus 8 to bus 9 on this branch  
  
 "BRANCH 12 33 1" YES // monitor the flow from bus 12 to bus 33 on branch  
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 // measurefarend is set to true, therefore, we are   
 // monitoring the MW flow that arrives at bus 33  
  
 "AREA 2 1" // monitor tie line flow from area 2 to area 1  
 "ZONE 66 53" // monitor tie lines flows from zone 66 to zone 53  
 "BRANCHOPEN 5 6 1" // doe monitoring after branch opens  
 "BRANCHCLOSE 7 10 1" // doe monitoring after branch closes  

</SUBDATA> 

  

Note: InterfaceElement object types can also be directly created inside their own DATA 
section as well. One of the key fields of the InterfaceElement object is then the name of the 
interface to which the interface element belongs. 



Auxiliary Script/Data Files 
 

1228 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Data LimitSet 

  

LimitCost 

LimitCost records describe the piece-wise unenforceable constraint cost records for use by 
unenforceable line/interface limits in the OPF or SCOPF. Each row contains two values 

PercentLimit:  Percent of the transmission line limit. 

Cost:  Cost used at this line loading percentage value. 
  

Example: 

<SUBDATA LimitCost> 
 //Percent Cost [$/MWhr]  
 100.00 50.00  
 105.00 100.00  
 110.00 500.00  

</SUBDATA> 
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Data Load 

  

BidCurve 

BidCurve subdata is used to define a piece-wise linear benefit curve (or a bid curve). Each 
bid point consists of two real numbers on a single line of text: a MW output and then the 
respective bid (or marginal cost). These costs must be increasing for loads. 

  

Example: 

<SUBDATA BidCurve> 
 // MW Price[$/MWhr]  
 100.00 16.0  
 200.00 15.7  
 400.00 12.4  
 500.00 10.6  

</SUBDATA> 
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Data LPVariable 

  

LPVariableCostSegment 

Stores the cost segments for the LP variables. Each line contains four values: 

Cost (Up): Cost associated with increasing the LP variable. 

Minimum value: Minimum limit of the LP variable. 

Maximum value: Maximum limit of the LP variable. 

Artificial: Whether the cost segment is artificial or not. 
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Data ModelCondition 

  

Condition 

ModelConditions are the combination of an object and a Filter. They are used to return when 
the particular object meets the filter specified. As a results, the subdata section here is 
identical to the Condition subdata section of a Filter. See the description there. 
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Data ModelExpression 

  

LookupTable 

LookupTables are used inside Model Expressions sometimes. These lookup table represent 
either one or two dimensional tables. If the first string in the SUBDATA section is "x1x2", the 
this signals that it is a two dimensional lookup table. From that point on it will read the first 
row as "x2" lookup points, and the first column in the remainder of the rows as the x1 
lookup values.  

  

Example: 

DATA (MODELEXPRESSION, [CustomExpression,ObjectType,CustomExpressionStyle, 
CustomExpressionString,WhoAmI,VariableName,WhoAmI:1,VariableName:1], AUXDEF) 

{ 

// The following demonstrated a one dimensional lookup table 

22.0000, "oneD", "Lookup", "",  

"Gen<KEY1>1</KEY1><KEY2>1</KEY2>", 
"Gen<KEY1>1</KEY1><KEY2>1</KEY2><VAR>GenMW</VAR>",  

"", ""  
 <SUBDATA LookupTable>  
 // because it does not start with the string x1x2 this will   
 // represent a one dimensional lookup table  
 x1 value  
 0.000000 1.000000  
 11.000000 22.000000  
 111.000000 222.000000  
 </SUBDATA>  
  

0.0000, "twod", "Lookup", "",  

"Gen<KEY1>1</KEY1><KEY2>1</KEY2>", 
"Gen<KEY1>1</KEY1><KEY2>1</KEY2><VAR>GenMW</VAR>",  

"Gen<KEY1>6</KEY1><KEY2>1</KEY2>", 
"Gen<KEY1>6</KEY1><KEY2>1</KEY2><VAR>GenMW</VAR>" 
 <SUBDATA LookupTable>  
 // because this starts with x1x2 this represent a two dimensional  
 // lookup table. The first column represents lookup values for x1.  
 // The first row represents lookup values for x2  
 x1x2 0.100000 0.300000 // these are lookup heading for x2  
 0.000000 1.000000 3.000000  
 11.000000 22.000000 33.000000  
 111.000000 222.000000 333.000000  
 </SUBDATA>  

} 
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Data ModelFilter 

  

ModelCondition 

A Model Filter’s subdata contains a list of each ModelCondition in the it. Because a list of 
Model Conditions is stored within Simulator, this subdata section only stores the name of 
each ModelCondition on each line. 

  

Example: 

<SUBDATA ModelCondition> 
 "Name of First Model Condition"   
 "Name of Second Model Condition"   
 "Name of Third Model Condition"   

</SUBDATA> 
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Data MTDCRecord 

  

MTDCBus 

For this SUBDTA section, each DC Bus is described on a single line of text with exactly 8 
fields specified. 

DCBusNum: The number of the DC Bus. Note the DC bus numbers are independent of 
the AC bus numbers. 

DCBusName: The name of the DC bus enclosed in quotes. 

ACTerminalBus: The AC terminal to which this DC bus is connected (via a 
MTDCConverter). If the DC bus is not connected to any AC buses, then specify as zero. 
You may also specify this as a string enclosed in double quotes with the bus name 
followed by an underscore character, following by the nominal voltage of the bus. 

DCResistanceToground:  The resistance of the DC bus to ground. Not used by 
Simulator. 

DCBusVoltage: The DC bus voltage in kV. 

DCArea: The area that this DC bus belongs to. 

DCZone: The zone that this DC bus belongs to. 

DCOwner: The owner that this DC bus belongs to. 

Note: MTDCBus object types can also be directly created inside their own DATA section as 
well. One of the key fields of the object is then the number of the MTDCRecord to which the 
MTDCBus belongs. 

MTDCConverter 

For this SUBDTA section, each AC/DC Converter is described by exactly 24 field which may 
be spread across several lines of text. Simulator will keep reading lines of text until it finds 
24 fields. All text to the right of the 24th field (on the same line of text) will be ignored. The 
24 fields are listed in the following order: 

BusNum: AC terminal bus number. 

MTDCNBridges: Number of bridges for the converter. 

MTDCConvEBas: Converter AC base voltage. 

MTDCConvAngMxMn: Converter firing angle. 

MTDCConvAngMxMn:1: Converter firing angle max. 

MTDCConvAngMxMn:2: Converter firing angle min. 

MTDCConvComm: Converter commutating resistance. 

MTDCConvComm:1: Converter commutating reactance. 

MTDCConvXFRat: Converter transformer ratio. 

MTDCFixedACTap: Fixed AC tap. 

MTDCConvTapVals: Converter tap. 

MTDCConvTapVals:1: Converter tap max. 

MTDCConvTapVals:2: Converter tap min. 

MTDCConvTapVals:3: Converter tap step size. 

MTDCConvSetVL: Converter setpoint value (current or power). 

MTDCConvDCPF: Converter DC participation factor. 
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MTDCConvMarg: Converter margin (power or current). 

MTDCConvType: Converter type. 

MTDCMaxConvCurrent: Converter Current Rating. 

MTDCConvStatus: Converter Status. 

MTDCConvSchedVolt:  Converter scheduled DC voltage. 

MTDCConvIDC: Converter DC current. 

MTDCConvPQ: Converter real power. 

MTDCConvPQ:1: Converter reactive power. 

Note: MTDCConverter object types can also be directly created inside their own DATA 
section as well. One of the key fields of the object is then the number of the MTDCRecord to 
which the MTDCConverter belongs. 

MTDCTransmissionLine 

For this SUBDTA section, each DC Transmission Line is described on a single line of text with 
exactly 5 fields specified: 

DCFromBusNum: From DC Bus Number. 

DCToBusNum: To DC Bus Number. 

CKTID: The DC Circuit ID. 

Resistance: Resistance of the DC Line in Ohms. 

Inductance: Inductance of the DC Line in mHenries (Not used by Simulator). 

  

Example: 

DATA (RECORD, [Num,Mode,ControlBus]) 

{ 

//-------------------------------------------------------------------------- 

// The first Multi-Terminal DC Transmission Line Record 

//-------------------------------------------------------------------------- 

1 "Current" "SYLMAR3 (26098)" 
 <SUBDATA Bus>  
 //-------------------------------------------------------------------   
 // DC Bus data must appear on a single line of text  
 // The data consists of exactly 8 values  
 // DC Bus Num, DC Bus Name, AC Terminal Bus, DC Resistance to ground,   
 // DC Bus Voltage, DC Bus Area, DC Bus Zone, DC Bus Owner  

 //-------------------------------------------------------------------  
 3 "CELILO3P" 0 9999.00 497.92 40 404 1  
 4 "SYLMAR3P" 0 9999.00 439.02 26 404 1  
 7 "DC7" 41311 9999.00 497.93 40 404 1  
 8 "DC8" 41313 9999.00 497.94 40 404 1  
 9 "DC9" 26097 9999.00 439.01 26 404 1  

 10 "DC10" 26098 9999.00 439.00 26 404 1 
 </SUBDATA>  

 <SUBDATA Converter> 

 //-------------------------------------------------------------------  
 // convert subdata keeps reading lines of text until it has found   
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  // values specified for 24 fields. This can span any number of lines 

  // any values to the right of the 24th field found will be ignored 

  // The next converter will continue on the next line. 
 //-------------------------------------------------------------------   
 41311 2 525.00 20.25 24.00 5.00 0.0000 16.3100   
 0.391048 1.050000 1.000000 1.225000 0.950000 0.012500  
 1100.0000 1650.0000 0.0000 "Rect" 1650.0000 "Closed"   
 497.931 1100.0000 547.7241 295.3274  
 41313 4 232.50 15.36 17.50 5.00 0.0000 7.5130   
 0.457634 1.008700 1.030000 1.150000 0.990000 0.010000  
 2000.0000 2160.0000 0.1550 "Rect" 2160.0000 "Closed"   
 497.940 2000.0000 995.8800 561.8186  
 26097 2 230.00 20.90 24.00 5.00 0.0000 16.3100   
 0.892609 1.000000 1.100000 1.225000 0.950000 0.012500  
 -1100.0000 1650.0000 "" "Inv" 1650.0000 "Closed"   
 439.009 1100.0000 -482.9099 274.5227  
 26098 4 232.00 17.51 20.00 5.00 0.0000 7.5130   
 0.458621 1.008700 1.100000 1.120000 0.960000 0.010000  
 439.0000 2160.0000 "" "Inv" 2160.0000 "Closed"   
 439.000 1999.9999 -878.0000 544.2775  
 </SUBDATA>  
 <SUBDATA TransmissionLine>  
 //-------------------------------------------------------------------   
 // DC Transmission Segment information appears on a single line of   
 // text. It consists of exactly 5 value  
 // From DCBus, To DCBus, Circuit ID, Line Resistance, Line Inductance  
 //-------------------------------------------------------------------   
 3 4 "1" 19.0000 1300.0000  
 7 3 "1" 0.0100 0.0000  
 8 3 "1" 0.0100 0.0000  
 9 4 "1" 0.0100 0.0000  
 10 4 "1" 0.0100 0.0000  
 </SUBDATA>  
  

//-------------------------------------------------------------------------- 

// A second Multi-Terminal DC Transmission Line Record 

//-------------------------------------------------------------------------- 

2 "Current" "SYLMAR4 (26100)" 
 <SUBDATA Bus>  
 5 "CELILO4P" 0 9999.00 497.92 40 404 1  
 6 "SYLMAR4P" 0 9999.00 439.02 26 404 1  
 11 "DC11" 41312 9999.00 497.93 40 404 1  
 12 "DC12" 41314 9999.00 497.94 40 404 1  
 13 "DC13" 26099 9999.00 439.01 26 404 1  
 14 "DC14" 26100 9999.00 439.00 26 404 1  
 </SUBDATA>  
 <SUBDATA Converter>  

 41312 2 525.00 20.26 24.00 5.00 0.0000 16.3100  
 0.391048 1.050000 1.000000 1.225000 0.950000 0.012500  
 1100.0000 1650.0000 0.0000 "Rect" 1650.0000 "Closed"   
 497.931 1100.0000 547.7241 295.3969  
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 41314 4 232.50 15.45 17.50 5.00 0.0000 7.5130   
 0.457634 1.008700 1.030000 1.150000 0.990000 0.010000  
 2000.0000 2160.0000 0.1550 "Rect" 2160.0000 "Closed"   
 497.940 2000.0000 995.8800 562.9448  
 26099 2 230.00 20.90 24.00 5.00 0.0000 16.3100   
 0.892609 1.000000 1.100000 1.225000 0.950000 0.012500  
 -1100.0000 1650.0000 "" "Inv" 1650.0000 "Closed"   
 439.009 1100.0000 -482.9099 274.5227  
 26100 4 232.00 17.51 20.00 5.00 0.0000 7.5130   
 0.458621 1.008700 1.100000 1.120000 0.960000 0.010000  
 439.0000 2160.0000 "" "Inv" 2160.0000 "Closed"   
 439.000 1999.9999 -878.0000 544.2775  
 </SUBDATA>  
 <SUBDATA TransmissionLine>  
 5 6 "1" 19.0000 1300.0000  
 11 5 "1" 0.0100 0.0000  
 12 5 "1" 0.0100 0.0000  
 13 6 "1" 0.0100 0.0000  
 14 6 "1" 0.0100 0.0000  
 </SUBDATA>  

} 

Note: MTDCTransmissionLine object types can also be directly created inside their own 
DATA section as well. One of the key fields of the object is then the number of the 
MTDCRecord to which the MTDCTransmissionLine belongs. 
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Data MultiSectionLine 

  

Bus 

A multi section line’s subdata contains a list of each dummy bus, starting with the one 
connected to the From Bus of the MultiSectionLine and proceeding in order to the bus 
connected to the To Bus of the Line. Note: bus# values may be replaced by a string 
enclosed in double quotes where the string is the name of the bus followed by an 
underscore character and then the nominal voltage of the bus, or the string may represent 
the label of the bus. 

  

Example: 

//----------------------------------------------------------------------------------------------------------
- 

// The following describes a multi-section line that connnects bus  

// 2 - 1 - 5 - 6 - 3 

//----------------------------------------------------------------------------------------------------------
-- 

DATA (MultiSectionLine, [BusNum, BusName, BusNum: 1, BusName: 1, 
 LineCircuit, MSLineNSections, MSLineStatus] )  

{ 

2 "Two" 3 "Three" "&1" 2 "Closed" 
 <SUBDATA Bus>  
 1  
 5  
 6  
 </SUBDATA>  

} 
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Data Nomogram 

  

InterfaceElementA 

InterfaceElementB 

InterfaceElementA values represent the interface elements for the first interface of the 
nomogram. InterfaceElementB values represent the interface elements for the second 
interface of the nomogram. The format of these SUBDATA sections is identical to the format 
of the InterfaceElement SUBDATA section of a normal Interface. 

  

NomogramBreakPoint 

This subdata section contains a list of the vertex points on the nomogram limit curve. 

Example: 

<SUBDATA NomogramBreakPoint> 
 // LimA LimB  
 -100 -20  
 -100 100  
 80 50  
 60 -10  

</SUBDATA> 
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Data Owner 

  

Bus 

This subdata section contains a list of the buses which are owned by this owner. Each line of 
text contains the bus number. As an alternative to specifying the bus number, a string 
enclosed in double quotes may be used where the string represents the name of the bus 
followed by an underscore character and then the nominal voltage of the bus, or the string 
may represent the label of the bus. 

  

Example: 

<SUBDATA Bus> 
 1  
 35  
 65  

</SUBDATA> 
  

Load 

This subdata section contains a list of the loads which are owned by this owner. Each line of 
text contains the bus number followed by the load id. As an alternative to specifying the bus 
number, a string enclosed in double quotes may be used where the string represents the 
name of the bus followed by an underscore character and then the nominal voltage of the 
bus, or the string may represent the label of the bus. Also, instead of specifying the bus and 
load id, the label of the load enclosed in double quotes may be used. 

  

Example: 

<SUBDATA Load> 
 5 1 // shows ownership of the load at bus 5 with id of 1  
 423 1  

</SUBDATA> 
  

Gen 

This subdata section contains a list of the generators which are owned by this owner and 
the fraction of ownership. Each line of text contains the bus number, followed by the gen id, 
followed by an integer showing the fraction of ownership. As an alternative to specifying the 
bus number, a string enclosed in double quotes may be used where the string represents 
the name of the bus followed by an underscore character and then the nominal voltage of 
the bus, or the string may represent the label of the bus. Also, instead of specifying the bus 
and generator id, the label of the generator enclosed in double quotes may be used. 

  

Example: 

<SUBDATA Gen> 
 78 1 50 // shows 50% ownership of generator at bus 78 with id of 1  
 23 3 70  

</SUBDATA> 
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Branch 

This subdata section contains a list of the branchs which are owned by this owner and the 
fraction of ownership. Each line of text contains the from bus number, followed by the to 
bus number, followed by the circuit id, followed by an integer showing the fraction of 
ownership. As an alternative to specifying the bus numbers, strings enclosed in double 
quotes may be used where the string represents the name of the bus followed by an 
underscore character and then the nominal voltage of the bus, or the string may represent 
the label of the bus. Also, instead of specifying the two numbers and a circuit id, the label of 
the branch enclosed in double quotes may be used. 

  

Example: 

<SUBDATA Branch> 
 6 10 1 50 // shows 50% ownership of line from bus 6 to 10, circuit 1  

</SUBDATA> 
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Data PieChartGaugeStyle 

  

ColorMap 

This is a lookup table by percentage of scalar and color values. This lookup table will consist 
of consecutive lines of text with exactly three values: 

Percentage: This is the percentage at which the following scalar and color should be 
applied. 

Scalar: A scalar (multiplier) on the size of the pie chart/gauge. 

Color: A color for the pie chart/gauge. 
  

Example: 

<SUBDATA ColorMap> 

//Percentage Scalar Color 
 85.0000 1.5000 33023  
 100.0000 2.0000 255  

</SUBDATA> 
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Data PostPowerFlowActions 

  

CTGElementAppend 

This format is the same as for the Contingency objecttype. 

  

CTGElement 

This format is the same as for the Contingency objecttype. 

Note: PostPowerFlowActionsElement object types can also be directly created inside their 
own DATA sections as well. 
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Data PWCaseInformation 

  

PWCaseHeader 

This subdata section contains the Case Description in free-formatted text. Note: as it is read 
back into Simulator all spaces from the start of each line are removed. 
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Data PWFormOptions 

  

PieSizeColorOptions 

There can actually be several PieSizeColorOptions subdata sections for each PWFormOptions 
object. The first line of each subdata section, the first line of text consist of exactly four 
values 

ObjectName: The objectname of the type of object these settings apply to. Will be 
either be BRANCH or INTERFACE. 

FieldName: The fieldname for the pie charts that these settings apply to. 

UseDiscrete: Set to YES to use a discrete mapping of colors and size scalars instead of 
interpolating for intermediate values. 

UseOtherSettings: Set to YES to default these settings to the BRANCH MVA values for 
BRANCH object. This allows you to apply the same settings to all pie charts. 

  

After this first line of text, if the UseOtherSettings Value is NO, then another line of text will 
contain exactly three values:  

ShowValue: This is the percentage at which the value should be drawn on the pie 
chart. 

NormalSize: This is the scalar size multiplier which should be used for pie charts below 
the lowest percentage specified in the lookup table. 

NormalColor: This is the color which should be used for pie charts below the lowest 
percentage specified in the lookup table. 

  

Finally the remainder of the subdata section will contain a lookup table by percentage of 
scalar and color values. This lookup table will consist of consecutive lines of text with exactly 
three values 

Percentage: This is the percentage at which the follow scalar and color should be 
applied. 

Scalar: A scalar (multiplier) on the size of the pie charts. 

Color: A color for the pie charts. 
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Data PWLPOPFCTGViol 

  

OPFControlSense 

OPFBusSenseP 

OPFBusSenseQ 

This stores the control sensitivities for each contingency violation during OPF/SCOPF 
analysis. Each line contains one value: 

Sensitivity: The value of the sensitivity with respect to each control in OPFControlSense 
or with respect to each bus in OPFBusSenseP and OPFBusSenseQ. 

  

Example: 

<SUBDATA OPFControlSense> 
 // Value  
 1.000441679  
 2.447185E-7  

 -1.1109307E-6  

 1.6427327E-7  
 0  

</SUBDATA> 
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Data PWLPTabRow 

  

LPBasisMatrix 

This subdata section stores the basis matrix associated with the final LP OPF solution. Each 
line contains two values: 

Variable: The basic variable. 

Value: The sensitivity of the constraint to the basic variable. 
  

Example: 

<SUBDATA LPBasisMatrix> 
 // Var Value  
 1 1.00000  
 2 1.00000  
 5 1.00000  
 6 1.00000  

</SUBDATA> 
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Data PWPVResultListContainer 

  

PWPVResultObject 

This subdata section contains the results of a particular PV Curve scenario (a particular 
contingency or the base case). The data consists of two general sections: the first three 
rows of text contain the "independent axis" of the PV Curve. The first row starts with the 
string INDNOM and is followed by a list of numbers representing the nominal shift, the 
second row starts with INDEXP and is followed by the export shift, and the third row starts 
with INDIMP and is followed by the import shift. Following After these rows is a list of all the 
tracked quantities. Each tracked quantity row consists of three parts which are separated by 
the strings ?f= and &v= . The first part of the string represents a description of the power 
system object being tracked, the second part represents the field name being tracked, and 
the third contains a list of all the values at the various shift levels. 

  

Example: 

<SUBDATA PWPVResultObject> 

 INDNOM 0.00 500.00 1000.00 1500.00 1750.00 1875.00 1975.00  

 INDEXP 0.00 500.00 1000.00 1500.00 1750.00 1875.00 1975.00  

 INDIMP 0.00 -417.23 -701.58 -890.58 -952.60 -975.35 -990.43  

 Bus '3'?f=BusPUVolt&v= 0.993 0.983 0.964 0.939 0.926 0.919 0.914 

 Bus '5'?f=BusPUVolt&v= 1.007 1.000 0.982 0.956 0.940 0.932 0.926 

 Gen '4' '1'?f=GenMVR&v= 19.99 245.27 523.62 831.13 986.84 1060.6 1118.7 

 Gen '6' '1'?f=GenMVR&v= -6.59 -120.84 -131.37 -39.53 48.35 103.8 154.5 

</SUBDATA> 
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Data QVCurve 

  

QVPoints 

This subdata section contains a list of the QV Curve points calculated for the respect 
QVCurve. Each line consists of exactly four values: 

PerUnitVoltage: The per unit voltage of the bus for a QV point. 

FictitiousMvar: The amount of Mvars injected by the fictitious generator at this QV 
point. 

ShuntDeviceMvar: The Mvars injected by any switched shunts at the bus. 

TotalMvar: The total Mvars injected by switched shunts and the fictitious generator. 
  

Example: 

DATA (QVCURVE, 
[BusNum,CaseName,qv_VQ0,qv_Q0,qv_Vmax,qv_QVmax,qv_VQmin,qv_Qmin, 
 qv_Vmin,qv_QVmin,Qinj_Vmax,Qinj_0,Qinj_min,Qinj_Vmin])  

{ 

5 "BASECASE" 0.880 0.000 1.100 312.490 0.480 -221.072  
 0.180 -86.334 191.490 -77.373 -244.075 -89.562  
 <SUBDATA QVPoints>  
 // NOTE: This bus has a constant impedance   
 // switched shunt value of -100 Mvar at it.  

 1.1000, 312.4898, -121.0000, 191.4898 

 0.9800, 124.6619, -95.9656, 28.6963 

 0.7800, -96.6202, -60.7808, -157.4010 

 0.5800, -206.9895, -33.5960, -240.5855 

 0.3800, -207.4962, -14.4113, -221.9075 

 0.1800, -86.3336, -3.2284, -89.5620 
 </SUBDATA>  

} 
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Data QVCurve_Options 

  

Sim_Solution_Options  

This subdata section contains solution options that will be used when running QV Curves. 
See explanation under the CTG_Options object type for more information. 
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Data SelectByCriteriaSet 

  

SelectByCriteriaSetType 

This subdata section contains a list of the display object types which are chosen to be 
selected. Each line of the section consists of the following: 

DisplayObjectType: The object type of the display object. 

(FilterName): A filter to apply to these types of objects. This field is optional, but must 
be given if either of the following fields are given. 

(WhichFields): For display objects that can reference different fields, this sets which of 
those fields it should select (e.g. select only Bus Name Fields). The value may be either 
ALL or SPECIFIED. 

(ListOfFields): If WhichFields is set to SPECIFIED, then a delimited list of fields follows. 
  

Example: 

<SUBDATA SelectByCriteriaSetType> 
 DisplayAreaField "" "ALL"  
 DisplayBus ""  

 DisplayBusField "Name of Bus Filter" "SPECIFIED" BusName BusPUVolt BusNum 
 DisplayCircuitBreaker ""  
 DisplaySubstation ""  
 DisplaySubstationField "" "SPECIFIED" SubName SubNum BusNomVolt BGLoadMVR  

 DisplayTransmissionLine "" 
 DisplayTransmissionLineField "" "ALL"  

</SUBDATA> 
  

Area 

This subdata section contains a list of areas which were chosen to be selected. Each line of 
the section consists of either the number or the name. When generated automatically by 
PowerWorld we also include the other identifier as a comment. 

  

Example: 

<SUBDATA Area> 
 18 // NEVADA  
 22 // SANDIEGO  
 30 // PG AND E  
 52 // AQUILA  

</SUBDATA> 
  

Zone 

This subdata section contains a list of zones which were chosen to be selected. Each line of 
the section consists of either the number or the name. When generated automatically by 
PowerWorld we also include the other identifier as a comment. 

  

Example: 
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<SUBDATA Zone> 
 680 // ID SOLUT  
 682 // WY NE IN  

</SUBDATA> 
  

ScreenLayer 

This subdata section contains a list of screen layers which were chosen to be selected. Each 
line of the section consists of either the name. 

  

Example: 

<SUBDATA ScreenLayer> 
 "Border"  
 "Transmission Line Objects"  

</SUBDATA> 
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Data ShapeFileExportDescription 

  

This object uses the same subdata sections as SelectByCriteriaSet. The only 
distinction is that only buses and lines can be exported. 
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Data StudyMWTransactions 

  

ImportExportBidCurve 

This subdata section contains the piecewise linear transactions cost curves for areas 
involved in a MW transaction. Costs are only for areas that are not on OPF control. Curves 
must be monotonically increasing. Each line corresponds to a point in the cost curve, and it 
has two values: 

MW: The MW value. Use negative values for imports (purchase) and positive values for 
exports (sales). 

Price: The price in $/MWh. 
  

Example: 

<SUBDATA ImportExportBidCurve> 
 //MW Price[$/MWh]  
-20.00 5.00 
-10.00 10.00 
 0.00 15.00  
 10.00 20.00   
 20.00 45.00  
 30.00 70.00  

</SUBDATA> 



Auxiliary Script/Data Files 

1255 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Data SuperArea 

  

SuperAreaArea 

This subdata section contains a list of areas within each super area. Each line of text 
contains two values, the area number followed by a participation factor for the area that can 
be optionally used. 

  

Example: 

<SUBDATA SuperAreaArea> 
 1 48.9  
 2 34.2  
 25 11.2  

</SUBDATA> 
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Data TSSchedule 

  

SchedPointList 

This section stores the schedule time points used in Time Step Simulation. Each line contains 
seven values: 

Date: The date of the point. 

Hour: The hour of the point. 

Pointtype: An integer specifying the point type. 

  0 – Numeric 

  1 – Boolean (Yes/No, Closed/Open) 

  2 – Text 

Numeric Value: The numeric value if point type is Numeric. Otherwise it is just zero. 

Boolean Value: The boolean value if point type is Boolean. Otherwise it is just false. 

Text Value: The text value if point type is Text. Otherwise it is just an empty string. 

Audiofilename: The audio filename associated to the point. If none, it is just an empty 
string. 

  

Example: 

<SUBDATA SchedPointList> 
 //Date Hour PointType NValue BValue TValue AValue  
 5/8/2006 0 1.00 NO  
 5/8/2006 6:00:00 AM 0 1.10 NO  
 5/8/2006 12:00:00 PM 0 1.25 NO  

</SUBDATA> 
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Data View 

  

ScreenLayer 

This is a list of screen layer names that are hidden in the current view. Each screen layer 
name is on a separate line of text. 

  

Example: 

<SUBDATA ScreenLayer> 

//These are hidden screen layers 
 "pie layer"  

</SUBDATA> 
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Data Section for Display Auxiliary File 

  

The Data Section of the script file format can contain numerous functions for modifying the 
data of a power system case. The DATA section begins with a left curly brace and ends with a 
right curly brace. 
  

DATA DataName (object_type, [list_of_fields], file_type_specifier) 

{ 

data_list_1 

 .  
 .  
 .  

data_list_n 

} 

Immediately following the DATA keyword, you may optionally include a DataName. Currently, 
this is not used for anything because there are no script commands that are supported with 
the display auxiliary files. 

The first line of the DATA section is referred to as the Data Argument List. The Data Argument 
List defines the type and format of the data contained in the following section enclosed in 
curly braces. 

Inside of each DATA section, data lists are given according to the data definition given in the 
Data Argument List. 
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Data Argument List for Display Auxiliary File 

  

The DATA argument list identifies what the information section contains. A left and right 
parenthesis "( )" mark the beginning and end of the argument list.  

The file_type_specifier parameter distinguishes the information section as containing 
custom auxiliary data (as opposed to Simulator’s native auxiliary formats), and indicates the 
format of the data. Currently, the parser recognizes two values for file_type_specifier:  

(blank) or AUXDEF  Data fields are space delimited 
CSV, AUXCSV, or CSVAUX  Data fields are comma delimited 

  

The object_type parameter identifies the type of object or data element the information 
section describes or models. For example, if object_type equals DISPLAYBUS, then the data 
describes DISPLAY BUS objects. Below is a list of many of the object types recognized by 
Simulator:  

CaseInformationMemo DisplayLineFlowArrow DisplayTransmissionLineField 

ColorMap DisplayLoad DisplayZone 

Contour DisplayLoadField DisplayZoneField 

CustomColors DisplayMultiSectionLine DisplayZonePie 

DisplayArea DisplayMultiSectionLineField DocumentLink 

DisplayAreaField DisplayMultiSectionLinePie DynamicFormatting 

DisplayAreaPie DisplayOwner Ellipse 

DisplayBranchGauge DisplayOwnerField Filter 

DisplayBranchPie DisplayOwnerPie GeoDataViewStyle 

DisplayBus DisplaySeriesCapacitor GeographyDisplayOptions 

DisplayBusField DisplaySeriesCapacitorField Group 

DisplayBusPie DisplayShunt Line 

DisplayCircuitBreaker DisplayShuntField OnelineField 

DisplayDCTransmissionLine DisplayShuntPie OnelineLink 

DisplayDCTransmissionLineField DisplaySubstation Picture 

DisplayGen DisplaySubstationField PieChartGaugeStyle 

DisplayGenericModelField DisplaySubstationPie PWFormOptions 

DisplayGenField DisplaySuperArea Rectangle 

DisplayGenPie DisplaySuperAreaField Screenlayer 

DisplayInjectionGroup DisplaySuperAreaPie SelectByCriteriaSet 

DisplayInjectionGroupPie DisplayTransformer Text 

DisplayInterface DisplayTransformerField TextBox 

DisplayInterfaceField DisplayTransformerPie View 

DisplayInterfacePie DisplayTransmissionLine   

  

The list of object types Simulator’s auxiliary file parser can recognize will grow as new 
applications for the technology are found. Within Simulator, you will always be able to obtain a 
list of the available object_types by going to the Auxiliary Files ribbon group on the 
Window ribbon tab and choosing Export Display Object Fields.  
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The list_of_fields parameter lists the types of values the ensuing records in the data section 
contain. The order in which the fields are listed in list_of_fields dictates the order in which 
the fields will be read from the file. Simulator currently recognizes over 2,000 different field 
types, each identified by a specific field name. Because the available fields for an object may 
grow as new applications are developed, you will always be able to obtain a list of the 
available object_types by going to the Auxiliary Files ribbon group on the Window ribbon 
tab and choosing Export Display Object Fields. Certainly, only a subset of these fields 
would be found in a typical custom auxiliary file. In crafting applications to export custom 
auxiliary files, developers need concern themselves only the fields they need to communicate 
between their applications and Simulator. A few points of interest regarding the 
list_of_fields are:  
• The list_of_fields may take up several lines of the text file.  
• The list_of_fields should be encompased by braces [ ]. 
• When encountering the PowerWorld comment string ‘//’ in one of these lines of the text 

file, all text to the right of this is ignored.  
• Blank lines, or lines whose first characters are ‘//’ will be ignored as comments. 
• Field names must be separated by commas. 

Example DATA Argument List 
DATA (DISPLAYBUS, [BusNom, SOAuxiliaryID, // comment here 
 SOX, SOY, SOThickness, SOColor, SOUseFillColor, SOFillColor,  
 // comments allowed here too  
  
 // note that blank rows are ignored  
 SOSize, SOWidth, SOOrientation, SOLevel, SOImmobile,  
 SLName, SOStyle, SODashed, // more comments  
 SOBelongsToGroup])  

One general note regarding the field names however. Some field names may be augmented 
with a field location. One example of this is the field BusNum when identifying branches. Bus 
numbers must be used to identify the from and the to end of branches. To keep the number 
of fields from becoming too large, the same field name is used for both of these values. The 
from bus number is written as BusNum:0 and the to bus number is written as BusNum:1. Note 
that the :0 may be left off of field names. 
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Data Key Fields for Display Auxiliary File 

  

Simulator uses certain fields to identify the specific object being described. These fields are 
called key fields. For example, the key field for DISPLAYBUS objects is BusNum, because a bus 
can be identified uniquely by its number. The key fields for DISPLAYGEN objects are BusNum 
and GenID. To properly identify each object, the object’s key fields must be present. They can 
appear in any order in the list_of_fields (i.e. they need not be the first fields listed in 
list_of_fields). As long as the key fields are present, Simulator can identify the specific 
object.  

Display objects have an additional key field used for identification because multiple objects can 
be present on the same one-line diagram that represent the same power system element. This 
extra key field is SOAuxiliaryID. This is a field that is unique for each type of display object 
and other key field combination. If there are two display buses that represent bus one in the 
power system, the SOAuxiliaryID field will be different for both. Simulator will 
automatically create unique identifiers when these objects are created graphically. They can 
also be user specified but are forced to be unique. This field does not need to be present 
when reading in a display auxiliary file, but if it is missing, Simulator assumes that the ID is 
"1". This field is the only key field identifier for objects that do not link to power system 
elements such as background lines and pictures, and therefore, should always be included 
when reading in these objects or the expected results may not be achieved.  

By going to the Auxiliary Files ribbon group on the Window ribbon tab and choosing Export 
Display Object Fields you will obtain a list of fields available for each object type. In this 
output, the key fields will appear with asterisks *. 
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Data List for Display Auxiliary File 

  

After the data argument list is completed, the Data list is given. The data section lists the 
values of the fields for each object in the order specified in list_of_fields. The data section 
begins with a left curly brace and ends with a right curly brace. A few points of interest 
regarding the value_list:  
• The value_list may take up several lines of the text file.  
• Each new data object must start on its own line of text. 
• When encountering the PowerWorld comment string ‘//’ in one of these lines of the text 

file, all text to the right of this is ignored.  
• Blank lines, or lines whose first characters are ‘//’ will be ignored as comments. 
• Remember that the right curly brace must appear on its own line at the end of the 

data_list. 
• If the file_type_specifier is CSV, the values should be separated by commas. Otherwise, 

separate the field names using spaces. 
• Strings can be enclosed in double quotes, but this is not required. You should however 

always enclose strings that contain spaces (or commas) in quotes. Otherwise, strings 
containing commas would cause errors for comma-delimited files, and spaces would cause 
errors for space-delimited formatted files. 
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Special Data Sections 

  

There are several object types that should be noted here because they can impact the reading 
of an entire display auxiliary file, overall look of the resulting one-line diagram, or require 
special input to properly import/export the object. 
  

GeographyDisplayOptions 

Most objects supported in the display auxiliary file have coordinates that can be specified in 
the appropriate data sections. What these coordinates specify can be controlled by the 
GEOGRAPHYDISPLAYOPTIONS object. This object has only two fields available: 
MapProjection and ShowLonLat. There are three possible settings for MapProjection: "x,y", 
"Simple Conic", and "Mercator". The choice of projection will determine how the x,y 
values for display objects are interpreted. ShowLonLat can be either "YES" or "NO". If 
ShowLonLat is "YES", the setting specified for the MapProjection will be the 
longitude,latitude projection used when reading/writing the object x,y values. If ShowLonLat 
is "NO", the x,y values will always be interpreted as x,y regardless of the MapProjection 
setting. This object should be placed in the display auxiliary file before any other objects 
containing coordinates are read. If this object is not included in the auxiliary file, the 
coordinates will be interpreted based on the current settings of map projection and whether 
or not coordinates are showing longitude,latitude. 

Picture 

PICTURE objects represent background images that cannot be stored in a text file format. 
To properly include a PICTURE object in a display auxiliary file, the file containing the image 
must be saved and read along with the auxiliary file. The FileName field indicates the 
name and location of the image file. If the image file cannot be found when reading in a 
display auxiliary file and attempting to create a new object, no PICTURE object will be 
created. If attempting to update an existing object and the image file cannot be found, the 
object will not be updated with a new image, but the FileName field will be updated with 
the specified file name. 

PWFormOptions 

One-line display options that affect the current display settings can be changed by using the 
PWFORMOPTIONS object. Usually, this object specifies named sets of options that can be 
selected and used to change the various one-line display options through the GUI. By 
including a specially named object, the current options can be changed through a display 
auxiliary file. PWFORMOPTIONS are named using the OOName field. Setting this field to 
"THESE_OPTIONS_ARE_APPLIED_TO_THE_CURRENT_DISPLAY" will apply the specified set 
of options to the current one-line when the file is read. When saving the entire one-line to a 
display auxiliary file, a PWFORMOPTIONS object with this name is added to the file by 
default. 

View 

Different views can be specified in the display auxiliary file using the VIEW object. Usually, 
this object is used to specify named sets of options used to select and change the view 
through the GUI. By including a specially named object, the current view can be changed 
through a display auxiliary file. VIEW objects are named using the ViewName field. Setting 
this field to "THIS_VIEW_IS_APPLIED_TO_THE_CURRENT_DISPLAY" will apply the specified 
set of view options to the current one-line when the file is read. When saving the entire one-
line to a display auxiliary file, a VIEW object with this name is added to the file by default. 
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Data Subdata Sections for Display Auxiliary File 

  

The format described in the Data Section works well for most kinds of data in Simulator. It 
does not work as well however for data that stores a list of objects. For example, a 
contingency stores some information about itself (such as its name), and then a list of 
contingency elements, and possible a list of limit violations as well. For data such as this, 
Simulator allows <SubData>, </SubData> tags that store lists of information about a 
particular object. This formatting looks like the following:  

  

DATA (object_type, [list_of_fields], file_type_specifier) 

{ 

value_list_1 

 <SUBDATA subobject_type1> 

 precise format describing an object_type1  
 precise format describing an object_type1  
 .  
 .  
 .  

 </SUBDATA> 

<SUBDATA subobject_type2> 

 precise format describing an object_type2  
 precise format describing an object_type2  
 .  
 .  
 .  

 </SUBDATA> 

value_list_2 

 .  
 .  
 .  

value_list_n 

} 

Note that the information contained inside the <SubData>, </SubData> tags may not be 
flexibly defined. It must be written in a precisely defined order that will be documented for 
each SubData type.  
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Data Common Sections 

  

ColorMap 

Same format as in data auxiliary files. 

CustomColors 

Same format as in data auxiliary files. 

DynamicFormatting 

Same format as in data auxiliary files. 

Filter 

Same format as in data auxiliary files. 

GeoDataViewStyle 

Same format as in data auxiliary files. 

PWFormOptions 

Same format as in data auxiliary files. 

SelectByCriteriaSet 

Same format as in data auxiliary files. 
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Data DisplayLine 

  

DisplayDCTramisssionLine 

DisplayInterface 

DisplayMultiSectionLine 

DisplaySeriesCapacitor 

DisplayTransformer 

DisplayTransmissionLine 

Line 

This is a list of points defining the graphical line used to represent the object. Each set of 
coordinates can be enclosed in square brackets, [ ], or the brackets can be eliminated. The 
brackets will be included when Simulator generates an auxiliary file. The individual 
coordinates are separated by the specified delimiter, either a space or a comma, and if the 
brackets are included, the same delimiter should be used to separate sets of coordinates. 
The list of points is in a somewhat free form and sets of coordinates can span multiple lines. 
Each point should either be in x,y coordinates or longitude,latitude coordinates. Which 
coordinates should be used depends on the current option settings for map projection and 
whether or not coordinates should be shown in longitude,latitude. If the display auxiliary file 
is automatically generated by Simulator, a comment will be included in the subdata section 
indicating the coordinate system in use during file creation. 

  

Example using brackets and a comma delimiter: 

<SUBDATA Line> 

//Coordinates are x,y 
 [14.00000000, 63.00000000], [14.00000000, 60.00000000],  
 [20.00000000, 45.00000000], [20.00000000, 42.00000000]  

</SUBDATA> 
  

Example with no brackets and a space delimiter: 

<SUBDATA Line> 

//Coordinates are x,y 
 14.00000000 63.00000000 14.00000000 60.00000000  
 20.00000000 45.00000000 20.00000000 42.00000000  

</SUBDATA> 
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Data PieChartGaugeStyle 

  

ColorMap 

This is a lookup table by percentage of scalar and color values. This lookup table will consist 
of consecutive lines of text with exactly three values: 

Percentage: This is the percentage at which the following scalar and color should be 
applied. 

Scalar: A scalar (multiplier) on the size of the pie chart/gauge. 

Color: A color for the pie chart/gauge. 
  

Example: 

<SUBDATA ColorMap> 

//Percentage Scalar Color 
 85.0000 1.5000 33023  
 100.0000 2.0000 255  

</SUBDATA> 

 



Auxiliary Script/Data Files 
 

1268 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Data View 

  

ScreenLayer 

This is a list of screen layer names that are hidden in the current view. Each screen layer 
name is on a separate line of text. 

  

Example: 

<SUBDATA ScreenLayer> 

//These are hidden screen layers 
 "pie layer"  

</SUBDATA> 
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Chapter 15 : PowerWorld Simulator Project Files 

  

PowerWorld Project Files provide the user an easy way consolidate and manage files from any 
application, including PowerWorld binary and display files. 

This chapter covers the following: 
• Overview of PowerWorld Simulator project files 
• Creating a New Project File 
• Opening a Project File 
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Overview of PowerWorld Simulator Project Files 

  

Performing a simulation using PowerWorld Simulator sometimes requires using a number of 
different files. In addition to the case file that stores the model of the system, there may be 
one or more oneline diagrams depicting various regions of the system. These oneline diagrams 
might feature document links that connect to files that were created using other applications, 
as well as oneline links, which open other oneline diagrams when they are clicked. For these 
links to function properly, the documents and oneline displays to which they connect must be 
available. A simulation might also employ a template file that is used to load in a predefined 
set of solution, environment, and display options. Furthermore, the simulation might make use 
of data stored in auxiliary data files to supplement the data stored in the case file. Finally, a 
simulation might utilize a script file to perform some automated sequence of tasks, or even to 
display a movie of system conditions. Having to deal with so many files may make it difficult to 
transfer the case to another computer, or to share the model with a colleague. PowerWorld 
Simulator Project files provide a solution. 

PowerWorld Simulator Projects have the extension *.pwp. A project serves as a container for 
all the files that might comprise a simulation, including the case file, one or more oneline 
diagrams, a script file, one or more auxiliary data files, and a case template, as well as any 
other support files you may wish to include. A project is actually a compressed file archive that 
is compatible with the widely available PKZip and WinZip file compression utilities. It is 
strongly recommended, however, that you work with project files strictly within the 
PowerWorld Simulator environment, as Simulator can automatically perform the file 
compression and extraction functions and process the contents of the included files in a single 
step. (Note: Simulator performs file compression and extraction using software components 
available from http://www.cdrom.com/pub/infozip/ and 
http://www.geocities.com/SiliconValley/Orchard/8607/ main.html). 
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PowerWorld Project Initialization Script 

  

Included in every project file is an initialization script file called OPENPWB.SCP. This is a 
special type of PowerWorld script file that is used to unload the contents of the project that 
are used in the simulation. This file must begin with the keyword "INITIALIZATION" and 
terminate with the keyword "END". Between these two lines, OPENPWB.SCP identifies the 
name of the case, any oneline diagrams that should be opened immediately, a template file (if 
any), a script file (if any), and one or more auxiliary data files (if any) to open and read into 
memory after extracting the files. The file might also contain the keyword "AUTOSTART", 
indicating that the simulation of the system described by the project file should commence 
immediately after it is read into memory. The OPENPWB.SCP is generated for you 
automatically when you save a new project file. Here is an example that loads the case 
B7FLAT.PWB (in PowerWorld binary format) along with oneline diagram B7FLAT.PWD, the 
template B7FLAT.PWT, the script B7FLAT.SCP, and the auxiliary file B7FLAT.AUX, and then 
starts the simulation immediately after all contents are extracted and read: 
  

INITIALIZATION 

CASE PWB B7FLAT.PWB 

ONELINE B7FLAT.PWD 

TEMPLATE B7FLAT.PWT 

SCRIPT B7FLAT.SCP 

DATAFILE B7FLAT.AUX 

AUTOSTART 

END 

  

Again, all projects must contain the file OPENPWB.SCP. If a project does not contain this file, 
an error message will be shown. Simulator automatically includes an OPENPWB.SCP file with 
every project it creates. Therefore, unless you try to create a project file outside of Simulator, 
you will not have to worry about this requirement. 
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Associating Project Files with Simulator 

  

PowerWorld Simulator can automatically open and load the contents of a project if the proper 
file associations have been made. When Simulator is installed on a computer, it registers the 
file extension *.pwp in the Windows registry. Then, whenever you double-click on an icon for 
a project file or download a project file from a web site, Simulator will start, extract the 
contents of the project file, and read them into memory. The power system will then be 
displayed exactly as the author of the project file intended it to be displayed. 

If the file association is somehow destroyed (i.e. Windows no longer recognizes that *.pwp 
files should be associated with and opened by Simulator), you can re-establish the association 
manually using the following procedure: 
• Windows 95/98/NT 

o Open Windows Explorer. 
o Select View > Folder Options from Windows Explorer’s main menu. 
o Switch to the tab labeled "File Types." 
o Click the button labeled "New Type." 
o For "Description of Type," specify "PowerWorld Project." 
o For "Associated Extension," specify "PWP". 
o For "ContentType (MIME)," specify "application/powerworld_project." 
o For "Default Extension," specify ".PWP". 
o Under "Actions," click the button labeled "New." 
o Specify the "Action" as "open." 
o Specify the "Application used to perform action" as the path to the Simulator 

executable file, followed by a space and the string "%1" (including the quotation 
marks). For example, if the path of the PowerWorld Simulator executable is 
"c:\program files\PowerWorld\pwrworld.exe," then you should specify the following 
string: 
   c:\program files\PowerWorld\pwrworld.exe "%1" 

o Click OK to close the Action dialog. 
o Click OK to complete the definition of the file association. 

• Windows XP 
o Open Windows Explorer 
o Select Tools > Folder Options from Windows Explorer’s main menu. 
o Switch to the tab labeled "File Types" 
o Click the button labeled New 
o For "File Extension", enter "PWP", then click OK. 
o Find the PWP entry in the Registered file types list, then click on it. 
o Next, with the PWP entry selected, click on Advanced. 
o In the box to the left of the "Change Icon…" button, type in "PowerWorld Project" 
o Click on the "New…" button on the right-hand side of this dialog, which will pop up 

a "New Action" dialog 
o In the New Action dialog, click "Browse…" 
o Navigate to and select the PowerWorld program binary (pwrworld.exe); the default 

location is c:\Program Files\PowerWorld\pwrworld.exe 
o In the New Action dialog, enter "Open the project" in the field labeled "Action" 
o Click OK in the New Action dialog and in the Edit File Type dialog 
o Click Close when you are back to the main File Types dialog. 

The *.pwp file type will now be recognized on your system as being associated with 
PowerWorld Simulator. Again, you will need to perform this procedure only if the association 
somehow gets removed. 
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Creating a New Project File 

  

Creating a new project file in Simulator is fairly simple. First, make sure that the case for 
which you want to create the project is open in Simulator, as well as any oneline diagrams 
that you wish to open automatically whenever the user opens the project. Then select Save 
As Project from the Application Button. This opens the Create Project Dialog, which you can 
use to specify the contents of the project file. When you click OK on the Create Project Dialog, 
the files you identified will be compressed into a single file, along with the project initialization 
script that tells Simulator how it should import the contents of the project. 
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Create Project Dialog 

  

The Create Project Dialog enables you to create a new PowerWorld Simulator Project by 
specifying the files that should be included in the project. To open the Create Project Dialog, 
select Save As Project from the Application Button. When it opens, the dialog will 
automatically include the case file, all open oneline diagrams, all documents and onelines 
linked to the display by document links and oneline links, the current case template file, and 
the current script in its list of files to add to the project. You can then use this dialog to add 
files to or delete files from the list of project contents. 

The Create Project Dialog features the following controls: 

Case 

Identifies the name of the case file that is currently open in Simulator. The case file may be 
in PowerWorld binary format, in PTI Version 23 - 29 .raw format, or in GE PSLF .epc format. 
You cannot change this field, because it must be set to whatever case is currently open. 

Open these oneline diagrams automatically 

Lists the names of the oneline diagrams that will automatically open whenever a user opens 
the project file. This is also a read-only control and lists the names of all oneline diagrams 
that are currently open in Simulator. Therefore, before you start to create a project using 
the Create Project dialog, make sure that only those oneline diagrams you wish to open 
automatically with the project are currently open in Simulator. 

Use this script file 

Identifies a script file that should be opened automatically when the project is open. Scripts 
are text files that contain commands in PowerWorld's scripting language that Simulator 
interprets to perform a predefined set of tasks during the simulation. If a script file is in use 
when you try to create the project, its name will automatically appear in this text box. To 
specify a different script file, either type its full path in the text box, or press the adjacent 
Browse button to search for it on your machine. 

Load data from auxiliary files 

Lists the auxiliary data files that should be automatically read when the project is open. 
Auxiliary data files are text files that contain data that supplement or supersede the 
information in the case file. You may include as many automatically loading auxiliary data 
files in the project as you like. To add an auxiliary file to the project contents, click the 
adjacent Add button and locate the file on your machine. To remove an auxiliary file from 
the list, select it and click the adjacent Remove button. 

Also include these files 

Lists any other files you may wish to include in the project. Use this control to include 
supplementary documents, pictures, or even other PowerWorld project files, in the project. 
To add a file to the contents, click Add a File. To remove a file from the list, select it and 
press the adjacent Remove button. 

Automatically start the simulation after opening the project 

Check this button to cause Simulator to start the simulation immediately after opening the 
project. This saves the user who opens the project the step of switching to run mode and 
clicking the play button in the Power Flow Tools ribbon group on the Tools ribbon tab. This 
option is particularly effective, for example, if you want to display a "movie" of system 
conditions when the project is open. By including a script file in the project that tells 
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Simulator how to modify the system and view over time, you create a project that, when 
opened or downloaded, animates the scenario you are trying to model. 

Save this project as 

Identifies the name of the project that should be saved. By default, the project name is the 
same as that of the case except that it has the extension "pwp". To specify a different 
name, either type it directly in the text box, or click the adjacent Browse button and specify 
the full path. 

When you have finished specifying the contents of the project file, click the OK, save the 
project button. If you wish to cancel the operation without creating the project, click Cancel. 



PowerWorld Simulator Project Files 
 

1276 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Opening an Existing Project 

  

To open an existing PowerWorld Simulator Project file, select Open Project from the 
Application Button, and select the name of the project you wish to open. Alternatively, you 
may select Open Case from the Application Button, change the Files of Type setting to 
"PowerWorld Project (*.pwp)," and select the project you wish to open. Simulator will extract 
the contents of the project file into the project file’s folder and input the information it needs 
to display the case, oneline diagrams, and other associated files. 
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Chapter 16 : Tutorials 

  

This chapter contains tutorials on building a new case in Simulator and starting from an 
existing case in Simulator. They were originally created for use from the on-line help, although 
they can be used in text format as reproduced here. 
• Creating a New Case 
• Starting with an Existing Case 
• OPF 
• Contingency Analysis 
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Tutorial: Creating a New Case Page 1 of 13 

  

This procedure describes how to create a simple power system model using PowerWorld 
Simulator. This procedure was developed for use with version 13 of the package. If you have 
an earlier version, please contact PowerWorld Corporation at info@powerworld.com for 
information on upgrading, or visit the website at http://www.powerworld.com.  

To begin, double-click on the PowerWorld Simulator icon.  This starts Simulator. 
Simulator is used to create new cases, modify existing cases, and (of course) simulate power 
systems. In this example, we will build a new case from scratch. To create a case from an 
existing power flow case instead, please see Creating a Case from an Existing Power Flow File.  

To create a new case, select New Case from PowerWorld icon in the upper left corner 
of the program. The screen background will turn white, the default background color for new 
PowerWorld oneline diagram. Oneline diagrams are used in power system analysis to 
represent the actual three-phase power system using a single line to represent each three-
phase device. 
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Tutorial: Inserting a Bus Page 2 of 13 

  

The most important component of the power system model is the bus. Buses are used to 
represent junction points in the power system where a number of devices are connected 
together. In building a power system model using Simulator, you will draw buses onto the 
oneline diagram, attach devices such as generators and loads to the buses, and connect 
different buses together with transmission lines and transformers. 

To insert a bus: 
• Select Network > Bus from the Individual Insert ribbon group on the Draw ribbon tab. 

This prepares Simulator to insert a new bus. 
• Left-click on the oneline background at the location where you want to place the new bus. 

This invokes the Bus Option Dialog (pictured below), which is used to specify the name, 
orientation, shape, size, width, area, zone, and nominal voltage of the bus, as well as the 
load and shunt compensation connected to the bus . 
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• The Bus Number field automatically displays ‘1’. Simulator requires that each bus have a 

unique number. For convenience, accept the default value. Historically, the Bus Name field 
was limited to eight characters. That limitation is no longer imposed in Simulator. Many 
users still choose to limit the bus name to eight characters by convention and for ease in 
converting cases to other formats (such as .epc or .raw). For this example, enter ‘One’. 

• Next, check the System Slack Bus field, which is located in the Bus Voltage portion of the 
Bus Information Tab. The Slack Bus is a modeling construct that ensures that the power 
system has enough generation to meet the load. In other words, the slack bus "picks up 
the slack" caused by system losses or unbalanced generation and load.  

• Click OK on the Bus Option Dialog to finish creating the bus and to close the dialog. After 
the dialog box closes, the new bus appears on the oneline at the location you specified.  
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Tutorial: Inserting a Generator Page 3 of 13 

  

Next we are going to attach a generator to the bus. Generators may be inserted in a manner 
similar to inserting a bus: 
• Select Network > Generator from the Individual Insert ribbon group on the Draw 

ribbon tab. 
• Left-click the bus on the oneline diagram to which you want to attach the generator (for 

this example, click on the slack bus – bus One.) The Generator Option Dialog (pictured 
below) will automatically open. The dialog is used to specify the new generator’s unit 
identifier, display size, orientation, MW output and limits, reactive power limits, set point 
voltage, and cost model. 

 
• Every generator must have a MW Output specified when the generator is inserted. Make 

sure the MW and Voltage Control tab is selected. Enter ‘413’ in the MW Output Field. 
Note: the MW Output specified for a generator connected to the system slack bus is 
arbitrary because the generator’s true output depends on system load and losses. 

• Select the Display Information tab. The Orientation field is used to specify the direction 
the generator will extend from the bus. The Anchored checkbox forces the generator to 
move with its specified bus when repositioning the bus on the oneline. 

• Click OK on the Generator Option Dialog to accept the default values for all other fields. 
After the dialog box closes, the new generator will appear on the oneline attached to the 
previously selected bus. The oneline diagram should resemble the image shown below. 
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Tutorial: Saving the Case Page 4 of 13 

  

To save the work that we have done so far, select Save Case from the Application Button, or 

click on the Save Case  button. Before the case is saved, Simulator validates the case to 
make sure that it does not contain any errors. Results from this validation are displayed in the 
Message Log display, usually shown in the lower right-hand corner of the display. If the log is 
not visible, click the Log on the Log group under Tools. Since we have not yet named the 
case, the Save As dialog is displayed. Enter a file name and select OK. By default the case is 
saved using the PowerWorld Binary format  (*.pwb). When saving the case in the future, you 
will not have to reenter its name. Simulator also asks you to supply a name for saving the 
oneline diagram we have been drawing. The oneline diagram files have a default extension of 
*.pwd, which identifies them as PowerWorld Display files. Supply the same name as you gave 
to the case. Note that, because the case and the oneline are stored in separate files, multiple 
onelines can be assigned to the same case, and the same oneline can be used by many cases.  
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Tutorial: Entering a Second Bus with Load Page 5 of 13 

  

To enter the second bus: 
• Select Network > Bus from the Individual Insert ribbon group on the Draw ribbon tab.  
• Click on the oneline diagram somewhere to the right of the first bus. In the Bus Options 

Dialog (pictured below) leave the bus number at the default value of 2, and enter the 
name ‘Two’ in the Bus Name field. 

• We will model a 200 MW, 100 Mvar load at the bus. Select the Attached Devices tab. 
Under the Load Summary Information heading enter ‘200’ in the Base MW field and ‘100’ 
in the Base Mvar field. 

• Click OK to accept all other default values, close the Bus Options Dialog, and insert the 
bus.  

 
  

At this point, the oneline diagram does not show the load at bus 2, even though it is 
represented in the power system model (you can confirm this by right-clicking on bus 2, 
selecting Bus Information Dialog from the resulting local menu, and inspecting the Load 
Summary Information fields again).  

To draw the load on the oneline diagram: 
• Select Network > Load from the Individual Insert ribbon group on the Draw ribbon tab.  
• Left-click in the center of this bus. The Load Options Dialog box (pictured below) 

automatically opens. The Constant Power MW and Mvar fields confirm that the load is 200 
MW and 100 Mvar. In addition to constant power loads, Simulator also allows the 
modeling of voltage dependent loads. 
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• Select Up in the Orientation field under the Load Information tab to make the load point 
up. Verify that the anchored box is checked to force the load to move with the selected 
bus. 

• Click OK to accept the default values for all remaining fields, close the Load Options 
dialog, and insert the load. A circuit breaker symbol is automatically included with each 
load.  

To move objects on the oneline: 
• Left-click on the desired object. Drag and drop the object to the new location by holding 

the left mouse button down while moving the mouse. Note: you can also move all objects 
on the oneline simultaneously by left-clicking on the diagram (not on a specific object) 
then dragging and dropping in the desired location. 

• To move bus 2, left click on bus 2 (not on the attached load). Drag the bus to a new 
location. Note that the load moves with the bus because it is anchored. You can change 
the location of attached devices connected to a bus, such as generators and loads, by the 
same procedure.  

The oneline diagram should now resemble the image shown below. 
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Tutorial: Inserting a Transmission Line Page 6 of 13 

  

Transmission lines are used to connect buses together. To insert a transmission line: 
• Select Network > Transmission Line from the Individual Insert ribbon group on the 

Draw ribbon tab. 
• Left-click at the point where you want the new line to originate. This point is usually 

located on one of the proposed line’s terminal buses. For this example, originate the line 
at bus One. 

• Transmission lines and transformers are drawn as a series of line segments. Without 
holding down the mouse button, drag the mouse up. Notice that a line segment connected 
to the point of origin will follow your mouse movements. To terminate a line segment, 
click the left mouse button. Each time you click the mouse to terminate a line segment, a 
new vertex is defined for the line. To draw the next line segment, move the mouse to the 
desired location of the next vertex. Note: the vertices may later be moved or deleted to 
reshape the line. To create curved lines, hold the left mouse button down while dragging. 

• To terminate the final line segment and conclude drawing the line, double click the left 
mouse button at the desired termination point (bus Two for this example). The 
termination point is usually the transmission line’s other terminal bus.  

• The Transmission Line/Transformer Dialog automatically appears (shown below). The 
dialog should already contain a 1 in the From Bus Number field and a 2 in the To Bus 
Number Field. If not, you probably did not have the cursor directly on the bus when you 
were drawing the line. If this is the case, simply enter the correct bus numbers in the 
corresponding fields.  

 
• The Series Resistance, Series Reactance, and Shunt Charging fields are used to enter the 

per unit parameters associated with the line. The Shunt Charging field contains the total 
per unit charging capacitance for the line. Enter 0.02 in the Resistance field, 0.08 in the 
Reactance field and 0.1 in the Shunt Charging field.  
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• The Limit (MVA) fields contain the MVA ratings for the line; enter a value of 1000 in the 
Limit A (MVA) field. 

• Click OK to accept all remaining field default values, close the Transmission 
Line/Transformer Dialog, and insert the new line. 

By default, the transmission line is anchored to both terminal buses. If you try to move bus 2, 
the transmission line should move with it.  
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Tutorial: Inserting a Line Flow Pie Chart on a Transmission Line Page 7 of 13 

  

When the line is drawn it automatically it has a line flow pie chart included. You can include 
additional line flow pie charts by selecting Pies/Gauges > Line Flow Pie Chart from the 
Individual Insert ribbon group on the Draw ribbon tab, and then clicking near a line. The 
Line/Transformer Flow Pie Chart dialog box appears (shown below). Make sure that the From 
Bus and To Bus have the correct numbers, that the MVA rating is correct, and that Anchored is 
checked. You may change the size of the pie chart by typing in a value or using the arrows.  

 
  

Color and behavior of pie charts are set in the Oneline Display Options display; right-click 
anywhere in the background of the oneline, select Oneline Display Options from the pop-up 
menu, then select the Pie Charts tab (pictured below). 
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Tutorial: Inserting Circuit Breakers Page 8 of 13 

  

Circuit breakers are used to control the status of the line. (If the line already has circuit 
breakers at each end, then Simulator has been instructed to insert circuit breakers 
automatically. You can configure this option from the Default Drawing Options Dialog).  
  

To insert a Circuit Breaker: 
• Click somewhere on the line near bus One then select Indication > Circuit Breaker 

from the Individual Insert ribbon group on the Draw ribbon tab, then click on the line near 
bus One. You should immediately see the Circuit Breaker Options dialog (shown below) 
with the From Bus and To Bus fields correctly set to ‘1’ and ‘2’. If they are ‘0’, enter the 
correct value. Set the Size field to ‘1’ (you can either enter a 1, or use the spin arrows in 
change the value).  

• Click OK to insert the circuit breaker. 

 
  

In Simulator, the location of the circuit breaker does not matter, because changing the status 
of the circuit breaker changes the status of the entire line. However, since most transmission 
lines have circuit breakers at each end, we will also place a circuit breaker near bus 2. To 
accomplish this, repeat the above process near bus 2.  

Save your case. Your oneline should now look similar to the image below. 
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Tutorial: Inserting a Transformer Page 9 of 13 

  

To insert a transformer we first need to insert a bus at a different voltage level. Insert a new 
bus in the bottom of the oneline, named Three, and enter 69 KV for its nominal voltage in 
the Bus Options dialog box.  
  

To insert a transformer between buses 2 and 3: 
• Either go to Network > Transformer from the Individual Insert ribbon group on the 

Draw ribbon tab. 
• Click on bus 2, and then draw a line to bus 3 as you did for a transmission line. The 

Transmission Line/Transformer Dialog automatically appears.  

 
• On the Parameters tab, enter 0.02 for Series Resistance, 0.08 for Series Reactance, 0.1 

for Shunt Charging and 1000 for Limit A (MVA). 
• Select the Transformer Control tab. Note that the Off-nominal Turns Ratio displays 

1.000. The true transformer turns ratio does not need to be specified as it is 
automatically determined by the ratio of nominal voltages between the From Bus and To 
Bus. The Off-nominal Turns Ratio is used to adjust the transformer tap setting on per-unit 
values of bus voltages as referenced to their respective base values for per-unit 
calculation. 

• Click OK to accept the default values, close the dialog and insert the transformer. 
• Repeat this procedure to add a transformer between buses 1 and 3. 

Add a 400 MW, 200 Mvar load to bus 3: 
• Right-click on bus 3 and select Bus Information Dialog. Select the Attached Devices 

tab. Click Add or Edit Bus Load.  
• Under Constant Power enter 400 in the MW Value field. Enter 200 in Mvar Value field. 

Click OK. 
• Note that Base MW and Base Mvar display the respective values. Click OK. 
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The load is now attached to the bus even though it is not displayed on the oneline. To display 
the load as an object on the oneline, you can either use the Auto Insert feature or follow the 
procedure utilized earlier. To Auto Insert the load: 
• Select Auto Insert > Loads… from the Quick Insert ribbon group on the Draw ribbon 

tab. The Automatic Insertion of Loads dialog opens automatically.  
• Click OK to accept the default values and insert the load object on the oneline.  

Note that Lines, Loads, Interfaces, Generators and Switched Shunts can all be inserted as 
objects on a oneline using the Auto Insert tool if a record already exists for the device. 

• Left-click and drag the load to the desired location on bus 3. Note: you can resize the bus 
object on the oneline by left-clicking on the bus then dragging either end-point vertex to 
the desired bus size. 

• Right-click on the load and select Load Information Dialog. You can change the load 
orientation and verify all load parameters in this dialog. 

• Click OK. 
Next we are going to attach a 300 MW generator to the bus 3: 
• Select Network > Generator from the Individual Insert ribbon group on the Draw 

ribbon tab. 
• Left-click on bus 3. The Generator Option Dialog opens.  
• Select the Power and Voltage Control tab. Enter ‘300’ in the MW Output Field.  
• Click OK on the Generator Option Dialog to accept the default values for all other fields. 

After the dialog box closes, the new generator appears on the oneline attached to bus 3.  

Your oneline should now resemble the image shown below. 



Tutorials 

1295 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

 



Tutorials 

1296 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Tutorial: Inserting a Switched Shunt Page 10 of 13 

  

Switched shunts usually consist of either capacitors to supply reactive power (in MVAR) to the 
system, or reactors to absorb reactive power. The switched shunts are represented by a 
number of blocks of admittance that can be switched in a number of discrete steps. If at least 
one block is in service, the shunt is said to be online. The shunt’s corresponding circuit breaker 
is used to determine and / or toggle the switched shunt’s status.  
• To insert a switched shunt at bus 3, select Network > Switched Shunt from the 

Individual Insert ribbon group on the Draw ribbon tab.  
• Click on or near bus 3. The Switched Shunt Options dialog box appears (pictured below).  
• Verify that the bus number is 3; if it is not, change it.  
• Enter 10 for the Nominal Mvar.  
• Click OK to accept the default values of the remaining fields, close the dialog, and insert 

the switched shunt. 
  

 

Your oneline should now look similar to the image below. 
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Tutorial: Inserting Text, Bus and Line Fields Page 11 of 13 

  

Informational fields can be entered directly on the oneline to allow for ease of monitoring 
when a case is animating. 

To insert a general text field: 
• Select Background > Text from the Individual Insert ribbon group on the Draw ribbon 

tab. Left-click on the oneline in the desired text location to bring up the Text Object 
Dialog. (For this example, left-click in the top center of the oneline.) 

• Type the string "First Case" in the Enter the text field. Click OK.  
• To format the text, ensure the text is selected on the one-line then select  from the 

Formatting ribbon group on the Draw ribbon tab. This displays the Font Tab of the Format 
Selection Dialog.  

• Set the font size to 26 and the font color to blue.  
• To change the text background color, select  from the Formatting ribbon group on the 

Draw ribbon tab, which summons the Line/Fill Options Tab . If the format menu is already 
open, click on the Line/Fill Options Tab of the Format Selection Dialog. Check the Use 
Background Fill box to give the text a white background, and then click OK.  

• Inserted text can be moved using the same method as any other object on the oneline 
  Fields can also display object-related quantities. By default, Simulator has inserted the bus 
names, generator and load MW and MVAR, and switched shunt MVAR. For this example, we 
will add a Bus Voltage Magnitude field to each bus and fields showing the power flow on the 
transmission line and the transformers. Note that object fields can be formatted just like text 
fields by using the Format menu. 
  

To add additional fields to the display of a particular bus: 
• Right-click on the bus to bring up the bus’ local menu. 
• Select Add New Fields Around Bus from the local menu. This opens the Insert Bus Fields 

Dialog (pictured below). You may add up to 8 fields per bus. Select the position where you 
would like to add the new field (position 5 for this example) then click OK.  
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• This opens the Bus Field Options dialog (shown below); select the field Bus Voltage to 
add in the selected position and click OK.  
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• The parameter and position are displayed as highlighted in the Insert New Fields dialog. 
Click OK. Note that the specified bus field has been added to the oneline diagram. 

• Repeat this procedure for the other two buses. If necessary, you may move fields 
manually with the mouse.   

Fields can also be inserted using the Background > Field option from the Individual Insert 
ribbon group on the Draw ribbon tab.  
  

Next, we will insert fields showing the power flow at each end of the transmission line.  
• Select Field > Transmission Line Field from the Individual Insert ribbon group on the 

Draw ribbon tab. 

Line fields show information about transmission lines and transformers. For line fields, flow is 
always specified at an end of the transmission line or transformer. The end is normally 
determined automatically by the insertion point.  

• Left-click near both bus 1 and the transmission line between buses 1 and 2 in the location 
you want the power flow text to appear. The Line Field Options dialog (shown below) 
opens automatically. 

• The Near Bus and Far Bus fields should show 1 and 2  respectively. If they do not, enter 
the correct values. 

• Select MW Flow then click OK. The field is displayed on the oneline in the location you 
specified. Note that the field can be moved and formatted as previously discussed. 

• Select Field > Transmission Line Field from the Individual Insert ribbon group on the 
Draw ribbon tab. 

• Left-click near both bus 2 and the transmission line between buses 1 and 2 in the location 
you want the power flow text to appear. The Line Field Options dialog (shown below) 
opens automatically. 

• Now the Near Bus and Far Bus fields should show 2 and 1 respectively. If they do not, 
enter the correct values. 

• Select MW Flow then click OK.  
• Repeat the procedure to insert Mvar Flow fields for the two locations. 

We also desire to monitor the MW and Mvar flows on the lines joining buses 1 and 3 and 
buses 2 and 3 via the transformers. The same commands are used as those used to insert 
fields for the transmission line. 

• Repeat the above steps to insert MW (and Mvar) Flow fields on the lines joining buses 1 
and 3 and buses 2 and 3 via the transformers.  

• At this point, your first oneline diagram should resemble the one shown below. 
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• Save the case. 
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Tutorial: Solving the Case Page 12 of 13 

  

To solve a case, you must be in run mode: 
• Click on Run Mode button in the Mode ribbon group. Note that if the case has validation 

errors, a warning will appear. You will need to rectify the problems before you can enter 
Run Mode.  

• Press the Play  button in the Power Flow Tools ribbon group on the Tools ribbon 
tab to begin the simulation. Alternatively, to perform a single Power Flow Solution, click 
the Single Solution - Full Newton button in the Power Flow Tools ribbon group on 
the Tools ribbon tab. Your case should look similar to the case shown below. If it does, 
congratulations! You have completed building your first case.  

 
  

Try clicking on the load circuit breaker to toggle the load’s status. A solid red circuit breaker 
indicates that it is closed, a hollow green box indicates it is open. While the simulation is 
running, click on the circuit breakers and note the nearly instantaneous change in system 
flows. If the Log window is visible, you will get a "backstage" view of what Simulator is doing. 



Tutorials 

1303 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Feel free to close the log. To re-open the log, click the Log button in the Log ribbon group on 
the Tools ribbon tab.  

With the load circuit breaker closed, open the circuit breaker between bus 3 and its connected 
generator. Now open any of the transmission line or transformer circuit breakers. 

Congratulations, you’ve just blacked-out your case! 
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Tutorial: Adding a New Area Page 13 of 13 

  

Next, we will create a second operating area for the case. Large interconnected systems 
usually have a number of control areas, with each control area responsible for the operation of 
a particular part of the system. Often, a single control area corresponds to a single owner 
(such as an investor-owned utility), but it is not unusual for a single control area to have more 
than one owner. Control areas are connected to neighboring areas through tie lines. A tie line 
is a transmission line that has one end in one control area and the other end in another. The 
total amount of power flowing out of a control area is the algebraic sum of the power flowing 
out on all the area’s tie lines. Each control area is responsible for procuring enough power to 
meet its own load plus losses. The control area can get this power either by generating it 
itself, or by buying it from another area. This ability to buy and sell power (i.e., power 
transactions) is one of the principal advantages of interconnected operation.  

To create another control area: 
• Change to Edit Mode. Right click on bus 3 and select Bus Information Dialog from the 

drop down menu. 
• Entering a number for an area that does not already exist automatically creates a new 

area. Enter ‘2’ in the Area Number field. Enter ‘TWO’ in the Area Name field. Click OK. 
• To verify that the case now has two areas, select Case Summary from the Case Data 

ribbon group on the Case Information ribbon tab. The Case Information Displays allow you 
to view the entire case using non-graphical displays. The Case Summary dialog (shown 
below) shows the number of buses, generators, lines/transformers, and control areas in 
the case. You cannot modify any of these values.  

 
  

Now we will make sure that both of the control areas are initially set as being on automatic 
generation control (AGC). AGC insures that the generation in the area is equal to the load plus 
losses plus and scheduled transactions.  
• Select Case Information > Aggregation > Areas. The Area display (pictured below) 

provides a convenient summary of all the control areas in the case. Similar displays exist 
for buses, generators, lines/transformers, etc.  

javascript:RelatedTopic0.Click()�
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• Right-click anywhere on the record for the first area and select the Show Dialog option. 
The Area Display Dialog is shown (as below).  

 

• Change the Area Name to ‘One’ and set the AGC Status under Area MW Control sOptions 
to Economic Dispatch Control. Select SAVE to save this information.  

• Next click on the up arrow next to the right of the Area Number field. This displays the 
Area Record dialog for the next area. Set the AGC Status to Economic Dispatch 
Control, and select OK to save your changes and close the dialog.  

• Note the AGC Status field in the Area Records Display now shows ED in the AGC Status 
fields. Close the Area Records display.  
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Starting with an Existing Case Page 1 of 15 

  

This procedure describes how to create a power system model from an existing power flow file 
using PowerWorld Simulator. This tutorial assumes that you have at least some familiarity with 
PowerWorld Simulator. If you need a more general introduction, please see Creating a New 
Case tutorial.  

PowerWorld cases can be easily created from existing power flow cases stored in PTI RAW 
versions 23-30, GE PSLF text format (EPC version 11.X and later), and IEEE common format.  

Simulator provides a static model of a power system. The power flow data is a subset of the 
system model. For some studies this model is sufficient. For other studies the model needs to 
be augmented by adjusting: generator cost information, the reactive capability curve, 
PowerWorld Simulator case options, interface definitions, injection group definitions, 
contingency definitions, the time variation of the load, etc…. 

To begin, double-click on the PowerWorld Simulator icon. This starts Simulator. In this 
example we will be building a case from an existing power flow file. 
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Once Simulator has been started, set Simulator to Edit Mode by clicking on the Edit Mode 
button. Select Open Case from the Application Button. An Open dialog box will appear on 
the screen. To select a power flow file, click on the Type of File field in the lower left hand 
corner of the dialog box. A list of file formats will appear. Choose the appropriate format, and 
the available files of the type selected will appear in the box above Type of File. Choose the 
desired file from the list of available files and select OK. In this example, we will be building a 
oneline for the 3990 bus MAIN 1998 summer case saved in PTI version 23 format as 
mdb98s.raw. When prompted to create a oneline, select ‘yes’. Your display should immediately 
turn white. This shows the blank background upon which you will be drawing the oneline 
diagram for your case. Onelines are used in power system analysis to represent the actual 
three-phase power system using a single line to represent each three phase device. The 
information from the power flow file is now accessible to Simulator. 
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Simulator presents many different Case Information Displays to provide a text-based view of 
the case. For example, to view or modify the description of the case, select Case Description 
from the Case Data ribbon group on the Case Information ribbon tab. The Case 
Description Dialog should appear, showing the text description of the power flow case. In 
PowerWorld, this text description may be arbitrarily long.  

You can also obtain a case summary by selecting Case Summary from the Case Data 
ribbon group on the Case Information ribbon tab. The summary dialog will appear. It provides 
a summary of the case and of the total case load and generation. None of the fields in this 
dialog can be changed, as they are intended for informational purposes only. 

The Area/Zone Filters information display is another important article. The Area/Zone/Owner 
Filters feature restricts the contents of other case information displays to certain areas or 
zones. This is particularly useful for large cases. Open the Area/Zone Filters display by 
selecting Area/Zone Filters from the Case Information ribbon group on the Case 
Information ribbon tab. As with all Case Information Displays, you can click on a column 
heading to sort the list on a particular field; click on that same column heading again to 
reverse the sort order. To change a particular area’s area/zone filter status, simply left-click on 
the area’s area/zone filter status field. To change the filter status for all areas in the case, 
right-click on the display to bring up its local menu (all case information displays have a local 
menu), and select either Toggle All Yes or Toggle All No.For our example, set all areas to 
‘no’ except WUMS. 

Another important text-based display is the Power Flow List. The power flow list shows the 
complete power flow information for all areas whose area/zone filter is set to ‘yes’. To display 
the power flow list, select Power Flow List from the Case Data ribbon group on the Case 
Information ribbon tab. The power flow list has other options that can be accessed by right-
clicking anywhere on the list. If you wish to view more details about a particular device, you 
can do so by holding down the Ctrl key and left-clicking on the device. To move through the 
list of buses, you can use the arrow keys or the scroll bar. If you are viewing a particular bus 
and you wish to view a bus connected to it, double-click on the line connecting the two buses 
to view the flows at the other bus. Note that some of the transmission lines have a circuit 
identifier of ‘99’. Whenever a ‘99’ is used for an identifier, it usually means that the 
transmission line is an equivalent line. 

A shorter version of the power flow list can often be more useful. Such a display is offered by 
the Quick Power Flow List. The Quick Power Flow List is similar to the power flow list except 
that it shows flows at individual buses or a set of buses, regardless of area/zone filter settings. 
You can view flows at any bus in the case. To display the quick power flow list, select Quick 
Power Flow List from the Case Data ribbon group on the Case Information ribbon tab. 
Identify the buses of interest In the Bus Number field by entering the number of either a 
single bus, a set of buses separated by commas, or a range of buses specified using a hyphen. 
Again you can double-click to move to a desired bus, or choose Show Object Dialog from 
the display’s local menu to see the information dialog for any object. 
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To solve the power flow case we have been using in this example, press the Single Solution 
- Full Newton button in the Power Flow Tools ribbon group on the Tools ribbon tab, or press 
the Single Solution icon on the Quick Access toolbar. You may wish to show the Message Log 
before you solve the case so as to monitor the solution process. When you choose to perform 
a Single Solution, the application automatically switches to Run Mode if it is not already there. 
The system has initial mismatches because of voltage truncation in the power flow file. The 
case should converge quickly, perhaps in 2 or 3 iterations. After the single solution has been 
performed, Simulator now has the solved power flow in memory, and you are ready to build 
the oneline. 

It is not necessary that the power flow case be solved before you create the oneline. However, 
we recommend that you solve the existing case first to make sure that it is valid. 
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PowerWorld Simulator makes the power system case easier to analyze by presenting results 
visually using a oneline diagram. You do not need to represent every bus in the power flow 
model on the oneline; a oneline diagram need be created only for the desired portion of a 
system under study. Simulator can automatically link the constructed oneline diagram to the 
existing power system model. The following sections of this tutorial will discuss placing various 
visual components onto a oneline diagram. In all of the following sections the actions 
described will relate to the aforementioned MAIN example. 
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The most important component of the power system model is the bus. Buses are used to 
represent junction points in the power system where a number of devices connect together. 
To build a oneline diagram, you draw the buses, attach devices such as generators and loads 
to the buses, and connect the buses together with transmission lines and transformers. 

To begin entering devices onto the blank oneline, you must first switch to Edit Mode. If you 
are not already in Edit Mode, switch back to Edit Mode now. Show the Quick Power Flow List 
and move it towards the bottom of the screen. Show bus 39820 by typing that number in the 
Bus Number field. Select Network > Bus from the Individual Insert ribbon group on the 
Draw ribbon tab. Click on the oneline towards the top center to define the point at which the 
new bus will be added. The Bus Information Dialog will appear. In the Bus Number field 
enter 39820. Select Find by Number to view the bus information. You should see the 
information appear in the Bus dialog fields that corresponds with the MAIN power flow case. 
Select OK to place the bus. The bus should now appear on your screen.  

If it has not already been done for you automatically, add a bus field identifying the new bus’ 
number immediately to the left of the new bus. To do this, click on or to the left of the display 
object that represents bus 39820 and select Field > Bus Field from the Individual Insert 
ribbon group on the Draw ribbon tab. The Bus Field Options Dialog will appear for you to fill 
out. Designate the type of field as Bus Number and close the dialog. Simulator will add a text 
object showing the bus number at the point where you had clicked.  

Repeat this procedure to place buses 39881 and 39821 on the oneline, along with their bus 
numbers. 
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Transmission lines between buses can be inserted manually by choosing Network > 
Transmission Line from the Individual Insert ribbon group on the Draw ribbon tab and 
clicking on the beginning bus. Vertices may be defined along the way by clicking the mouse on 
the diagram where vertices should appear. However when creating a case from an existing 
power flow file, you also have the option to insert transmission line display objects 
automatically. To do this, select Auto Insert > Lines from the Quick Insert ribbon group on 
the Draw ribbon tab. Accept the default options and click OK. The lines joining the visible 
buses on the display are automatically added, along with circuit breakers and pie charts, 
provided those options are set. Simulator will draw only transmission lines that link buses that 
have already been drawn on the oneline diagram. If you add another bus to the diagram, you 
can again auto-insert lines, and Simulator will only insert lines that are not already present on 
the display. 
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Two features of Simulator are indispensable when you have a large, detailed oneline: panning 
and zooming. To pan from side to side or up and down, either use the arrow keys or the 
scrollbars on the sides of the oneline. To zoom in or out of the oneline, hold the Ctrl key down 
and press the up arrow to zoom in and the down arrow to zoom out. For the example, pan up 
and insert buses 39819 and 39841, again with bus fields showing their numbers. Again use 
Auto Insert > Lines from the Quick Insert ribbon group on the Draw ribbon tab to add the 
transmission lines. 
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Sometimes you may wish to insert background elements on a oneline such as bodies of water 
or state lines to convey geographic location. To show static background elements on the 
oneline, select Background > Background Line from the Individual Insert ribbon group on 
the Draw ribbon tab. Click on the diagram to start the background line, and click at other 
points on the diagram to add segments. Double click to terminate the background line. If you 
wish to fill in the area inside the background line or change the background line’s color, select 
the background line and choose Line/Fill    from the Formatting ribbon group on the Draw 
ribbon tab and make the appropriate choices in the resulting dialog. You may wish to 
experiment now with drawing background lines or objects and with adding fill color. 
Additionally, some political and geographic borders can be inserted by selecting Auto Insert 
> Borders from the Quick Insert ribbon group on the Draw ribbon tab. 
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Once you have constructed a oneline diagram showing the area of interest, you can simulate 
the case. Simulator does not only show the magnitude and direction of flows on transmission 
lines, but can also animate them. To configure the animated flows, switch to Edit Mode and 
choose Oneline Display Options from the Active ribbon group on the Onelines ribbon tab. 
This dialog box also allows you to change the size, density, and fill color of the animated flows 
for easier visualization. At this point, just click OK. Next, save your case by selecting Save 

Case from the Application Button or by pressing the Save Case  button on the Quick 
Access Toolbar. If you have not already saved the case, a Save As dialog will prompt you to 
select a name. Both the oneline diagram and the case will use this name.  

To begin solving and animating the load flow solution, switch to Run Mode and then press the 
Play button in the Power Flow Tools ribbon group on the Tools ribbon tab. You should now see 
Simulator modeling the 3990-bus case. 
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While the animation ensues, you might want to view or change some study parameters. To do 
this, first pause the animation. (Note that you do not have to pause the animation to tweak 
parameters. You can adjust anything in the case while the animation runs, too.) Then, right-
click on any of the objects on the display, and choose Show Dialog from the popup menu. This 
will bring up the run-time dialog for the object. Many of the parameters on this dialog can be 
modified, and the new settings will take effect when the animation is restarted. 
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Several options are available at run time from the oneline diagram’s local menu. To call up the 
menu, right-click on an empty portion of the oneline. The local menu will appear. Use it to 
print the oneline, save it as a metafile, or copy it to the clipboard. You can also find a 
particular bus on the oneline, access panning and zooming options, set oneline display 
options, view information about the power system area in which you clicked, create a contour 
plot, and use the difference flows activity, all from the oneline local menu. 
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Often, system data is most conveniently displayed by area. To view the Area Records Display, 
select Aggregation > Areas from the Model Explorer. The resulting display summarizes 
information about all the areas in the case. You can sort the entries by clicking on the column 
labels. 
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You can view a report of limit violations by selecting Limit Monitoring Settings from the 
Other Tools ribbon group on the Tools ribbon tab. A display showing bus voltage violations, 
line/transformer violations or interface violations will appear. To show only violations, select 
Violating Elements from the Elements to Show options. If the Use Area / Zone Filters 
on List Displays is checked, then the displayed violations will correspond only to areas 
whose Shown field is set to Yes on the Area/Zone/Owner Filters display. 

If you wish to see more information on a bus that appears in the violation list, right-click on 
the bus number and select Quick Power Flow List from the resulting local menu. If the Case 
Information Display is set to refresh automatically, the list of bus voltage violations will update 
as new violations occur.  
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In addition to the few displays discussed in this tutorial, Simulator offers many other Case 
Information Displays. In most cases, you can view information about buses, generators, lines, 
transformers, loads, and zones simply by right-clicking on the object in question and choosing 
the appropriate option from the object’s local menu. The best way to become more familiar 
with the displays and the information contained in them is simply to play with a Simulator case 
and oneline. Simulator’s interface has been designed to be simple and intuitive. If you run into 
problems, consult the On-line Help for assistance. 
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Note: The OPF option in PowerWorld Simulator is only available if you have 
purchased the OPF add-on to the base package. Please contact PowerWorld Corporation 
at info@powerworld.com or visit the website at http://www.powerworld.com for details about 
ordering the OPF version of Simulator. 

The PowerWorld Simulator (Simulator) is an interactive power system simulation package 
designed to simulate high voltage power system operation. In the standard mode, Simulator 
solves the power flow equations using a Newton-Raphson power flow algorithm. With the 
optimal power flow (OPF) enhancement, Simulator OPF can also solve many of the system 
control equations using an Optimal Power Flow algorithm. Specifically, Simulator OPF uses a 
linear programming (LP) OPF implementation.  

The purpose of an OPF is to minimize an objective (or cost) function  by changing different 
system controls, taking into account both equality and inequality constraints. These constraints 
are used to model the power balance constraints and various operating limits. 

In Simulator OPF, the LP OPF determines the optimal solution by iterating between solving a 
standard power and then solving a linear program to change the system controls to remove 
any limit violations. See OPF Primal LP for more details.  
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For this tutorial, we will start with a provided three-bus case (B3LP) found in the 
PowerWorld\Simulator\Sample Cases directory. Bus 1 is the system slack bus. All buses are 
connected via 0.1 pu reactance lines, each with a 100 MVA limit. There is a single 180 MW 
load at bus 3. The generator marginal costs are: 
• Bus 1: 10 $/MWhr; Range = 0 to 400 MW 
• Bus 2: 12 $/MWhr; Range = 0 to 400 MW 
• Bus 3: 20 $/MWhr; Range = 0 to 400 MW 

To begin: 
• Load B3LP case.  
• Verify the above system specifications by right clicking on each line, bus, and generator 

and selecting its respective Line/Bus/Generator Information Dialog from the drop 
down menu. 

• Select Run Mode. 
• To be included in the OPF, all required area AGC status fields must be selected to OPF. To 

set area AGC to OPF: Select OPF Case Info > OPF Areas from the OPF ribbon group on 
the Add Ons ribbon tab. The OPF Area Records display automatically opens. Verify the 
AGC Status field is set to OPF. If it is not, double click on the field to change its value. 
Close the OPF Area Records display. 

• Select Add Ons > Primal LP from the OPF ribbon group on the Add Ons ribbon tab to 
solve the case. Note: line limits are not initially enforced. 

Your display should look similar to the following: 

  

 
B3LP Solved Using Add Ons > Primal LP 

Note the line from Bus 1 to Bus 3 is overloaded and that all buses have the same marginal 
cost.  
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• Select OPF Case Info > OPF Areas from the OPF ribbon group on the Add Ons ribbon 

tab.  

The Branch MVA column specifies whether or not the MVA limits should be enforced for 
transmission lines and transformers that have at least one terminal in this area. For a 
transmission line or transformer to be included in the OPF constraints, Line/Transformer 
constraints must not be disabled on the OPF Options and Results Dialog, and the 
individual line/transformer must be enabled for enforcement on the OPF Line/Transformer 
MVA Constraints display. 
• Double click on the Branch MVA field to change the value to YES. Close the OPF Area 

display 
• Select OPF Options and Results from the OPF ribbon group on the Add Ons ribbon tab.  
• The LP OPF Dialog opens automatically. Select the Constraint Options tab then click 

Disable Line/Transformer MVA Limit Enforcement to remove the checkmark. 
• Click Solve LP OPF then click OK. 

 
B3LP Solved with Line Limit Enforcement Enabled 

The LP OPF re-dispatches to remove the line limit violation. Bus marginal costs have changed 
from the initial example. The new bus marginal cost at Bus 3 is 14 $/MWh. To verify this: 
• Increase the load at Bus 3 by 1 MW. Right click on the load, enter "181.0" in the Constant 

Power / MW Value field in the Load Options dialog. Click OK. 
• Select Primal LP from the OPF ribbon group on the Add Ons ribbon tab.  

The Total Cost increased to 1935 $/hr from the previous value of 1921 $/hr, a difference of 14 
$/hr when Bus 3 load was increased by 1 MW.  
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Explanation of Bus 3 LMP = 14 $/MWh (from previous page): 

  

 
B3LP Solved with Line Limit Enforcement Enabled 

All lines have equal impedance. Power flow in a simple network distributes inversely to 
impedance of the path. 
• For Bus 1 to supply 1 MW to Bus 3, 2/3 MW will take the direct path from 1 to 3, while 1/3 

MW will take the path from 1 to 2 to 3. 
• Likewise, for bus 2 to supply 1 MW to Bus 3, 2/3 will go from 2 to 3, while 1/3 will go from 

2 to 1 to 3. 
• To supply one additional MW to Bus 3, we need the change in power of generator 1 (Pg1) 

plus the change in power of generator 2 to equal 1 MW.  

Pg1 + Pg2 = 1 MW 
• With the line from 1 to 3 limited, no additional power flows are allowed on it. 

(2/3)Pg1 + (1/3)Pg2 = 0 
• Solving the above system of equations results in: 

Pg1 = -1 MW and Pg2 = 2 MW 

Δcost = Σ(ΔPg*LMP) = [(-1 MW)*(10.00 $/MWh) + (2 MW)*(12.00 $MW/h)] = 14.00 $/hr 
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Similar to the bus marginal cost, you can also calculate the marginal cost of enforcing a line 
constraint. For a transmission line, this represents the amount of system savings that could be 
achieved if the MVA rating was increased by 1.0 MVA. 
• Select OPF Case Info > OPF Lines and Transformers from the OPF ribbon group on 

the Add Ons ribbon tab. The OPF Constraints Records dialog opens.  

Note the column displaying MVA Marginal Cost displays 6.0 for the line from Bus 1 to Bus 3. 
This is determined based on the following: 
• With no change in system load:  

Pg1 + Pg2 = 0 
• If we allow one additional MVA to flow on the line from Bus 1 to Bus 3: 

(2/3)Pg1 + (1/3)Pg2 = 1 
• Solving the above system of equations results in: 

Pg1 = 3 MW and Pg2 = -3 MW 

Δcost = Σ(ΔPg*LMP) = [(3 MW)*(10.00 $/MWh) + (-3 MW)*(12.00 $MW/h)] = -6.00 $/hr, a 
net savings of 6.00 $/hr. 
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Next we will consider a case with unenforceable constraints. To begin, increase the load at Bus 
3 to 250 MW then run the LP OPF again: 
• Right-click on the load at Bus 3. Enter 250 in the Constant Power / MW Value field.  
• Select Primal LP from the OPF ribbon group on the Add Ons ribbon tab. 

 
B3LP with Bus 3 Generator Carrying Load 

Note that the transmission lines connecting Bus 3 to the other buses are both at their 
respective MVA limit and that the generator at Bus 3 is supplying the load in excess of the 
transmission line limits. Next we will open the generator at Bus 3 thereby inserting an 
unenforceable constraint: 
• Left-click on the red breaker symbol connecting the generator to Bus 3 to open the 

breaker. 
• Select Primal LP LP from the OPF ribbon group on the Add Ons ribbon tab. 
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B3LP Solved with Unenforceable Constraints 

Both constraints cannot be enforced. If a constraint cannot be enforced due to insufficient 
controls, the slack variable associated with enforcing that constraint can not be removed from 
the LP basis.  

Note the new LMP value for bus 3 exceeds 1000 $/MWh. The marginal cost depends on the 
arbitrary cost of the slack variable. This value is specified in the Marginal Violation Cost field of 
the Add Ons > OPF Options and Results dialog. See OPF Options and Results dialog for 
more details. 

  

Additional Example 

To see another OPF example select PowerWorld Simulator Add-on Tools > Optimal 
Power Flow (OPF) > Examples from the table of contents in the on-line help file. 



Tutorials 

1329 
 

PowerWorld Simulator Version 13 User’s Guide - September 26, 2007 

Tutorial: Contingency Analysis 

  

This tutorial will walk you through the basic commands necessary to insert contingencies and 
have Simulator automatically analyze the results. Please see Introduction to Contingency 
Analysis for the necessary background information regarding the capabilities and uses of the 
Contingency Analysis tool. 

For this tutorial, we will use an existing 7-bus case.  
• Open case B7SCOPF from the Program Files/PowerWorld/Simulator/Sample Cases 

directory.  
• Ensure Simulator is in Run Mode.  
• Select Contingency Analysis from the Run Mode ribbon group on the Tools ribbon tab. 

Simulator opens the Contingency Analysis Dialog. 
  

The next section of the tutorial discusses Defining Contingencies and provides an example of 
inserting a single element contingency. 

1  2 3 4 5 6 7 8 9 10 11  

Next  
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